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License Agreement i

CHROMELEON Software  
Individual License Agreement 

This legal document is an agreement between you, the end user, and 
Dionex Corporation. The CHROMELEON Chromatography Management 
System is provided to you only on the condition that you agree to become 
bound by the terms of this agreement, which includes the software license 
and the software disclaimer warranty. If you do not agree to the terms of 
this agreement, promptly return the disk package(s) and the accompanying 
items (including printed materials and binders or other containers) to 
Dionex for a full refund. 

INDIVIDUAL CHROMELEON LICENSE 

1. GRANT OF LICENSE   In exchange for the payment of the LICENSE 
FEE, Dionex grants the LICENSEE a non-exclusive right to use and display 
the CHROMELEON software (the "SOFTWARE") provided with this LICENSE 
in accordance with the terms and restrictions below. The LICENSEE is the 
end-user organization and its subsidiaries (excluding sub-contractors) 
billed by Dionex for this LICENSE. If the organization billed is not the end-
user, the LICENSEE is the first end-user organization. 

2. OWNERSHIP OF THE SOFTWARE   The LICENSEE owns the 
magnetic or other physical media on which the SOFTWARE is originally or 
subsequently recorded, but Dionex retains title and ownership of all 
SOFTWARE recorded on such media, regardless of the form in which it is 
recorded. This license is not a sale of the SOFTWARE or any copy. 

3. COPY RESTRICTIONS   The SOFTWARE and all accompanying written 
materials are copyrighted, and may contain proprietary and confidential 
information of Dionex. 

The LICENSEE may make one (1) copy of the original SOFTWARE 
diskettes provided with this LICENSE for backup purposes only. Any such 
copy automatically becomes the property of Dionex, and the LICENSEE 
must include the copyright notice and any confidentiality or proprietary 
legend with any such copy. The LICENSEE may copy the SOFTWARE 
from the original or backup diskettes to the computers used in accordance 
with the use restrictions below. 
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All other copying of the SOFTWARE and the accompanying materials is 
expressly forbidden. The LICENSEE may be held legally responsible for 
any copyright infringement that is caused or encouraged by the failure of 
the LICENSEE to abide by the terms of this license. 

4. USE RESTRICTIONS   Under this LICENSE, the LICENSEE may use 
the SOFTWARE on one (1) single-user computer, or one (1) terminal of a 
multi-user computer. The LICENSEE must purchase a CHROMELEON Data 
Processing License for each additional computer on which the 
SOFTWARE provided under this LICENSE is used. 

The SOFTWARE may be stored on the computer's local mass storage 
device, on a network file server, or both, as long as the above use 
restrictions are satisfied. 

The LICENSEE may not modify, adapt, translate, reverse engineer, 
decompile nor disassemble the SOFTWARE, nor create derivative works 
based on it. The LICENSEE may not merge the SOFTWARE with another 
program. The LICENSEE may not modify, adapt, translate, or create 
derivative works based on the written materials without prior consent from 
Dionex. 

5. TRANSFER RESTRICTIONS   The SOFTWARE is licensed only to the 
LICENSEE, and may not be transferred to anyone else without the prior 
written consent of Dionex. Any authorized transfer of the SOFTWARE shall 
be bound by the terms and conditions of this LICENSE. 

6. TERMINATION   This LICENSE is effective until terminated. It will 
terminate automatically without notice from Dionex if the LICENSEE fails to 
comply with any of its provisions. Upon termination, the LICENSEE shall 
destroy the written materials and all copies of the SOFTWARE. The 
LICENSEE may terminate this LICENSE by destroying all copies of the 
software and accompanying written materials. 

7. UPDATE POLICY   Dionex may (but is not obliged to) release updated 
versions of the SOFTWARE. One copy of any such versions will be 
provided to the LICENSEE at no additional charge for each registered 
SYSTEM that has a valid CHROMELEON Subscription Agreement 
("SUBSCRIPTION") in effect at the time of the release. Any such software 
update that is provided under a SUBSCRIPTION may be used to collect 
data only on the one SYSTEM to which the SUBSCRIPTION applies. All 
terms of this LICENSE shall apply to any updates provided to the 
LICENSEE. 
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8. MISCELLANEOUS   This LICENSE, including the disclaimer of warranty 
and limited warranty, is governed by the laws of the State of California, 
excluding its choice of law rules. 

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY 
The SOFTWARE and the accompanying materials (including instructions 
for use) are provided "as is" without warranty of any kind. Further, Dionex 
does not warranty, guarantee, or make any representations regarding the 
use, or the results of the use, of the SOFTWARE or written materials in 
terms of correctness, accuracy, reliability, currentness, or otherwise. The 
entire risk as to the results and performance of the SOFTWARE is 
assumed by the LICENSEE. 

Dionex warrants to the original LICENSEE that the disks on which the 
software is recorded are free from defects in material and workmanship 
under normal use and service for a period of 90 days from the date of 
delivery of this individual LICENSE as evidenced by a copy of the receipt. 

The entire liability of Dionex and the exclusive remedy to the LICENSEE 
shall be, at the discretion of Dionex, either (a) return of the purchase price 
or (b) replacement of any defective disks that are returned to Dionex with a 
copy of the receipt. If failure of the disks has resulted from accident, abuse, 
or misapplication, Dionex shall have no responsibility to replace the disks 
or refund the purchase price. Any replacement disk shall be warranted for 
the remainder of the original warranty period or thirty (30) days, whichever 
is longer. 

THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND AND 
DIONEX HEREBY DISCLAIMS ALL OTHER WARRANTIES, EITHER 
EXPRESSED OR IMPLIED, INCLUDING (BUT NOT LIMITED TO) THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, THAT ARE MADE BY DIONEX ON THIS 
PRODUCT. No oral or written information or advice given by Dionex, its 
dealers, distributors, agents, or employees shall create a warranty or in any 
way increase the scope of this warranty, and the LICENSEE may not rely 
on such information or advice. 

NEITHER DIONEX NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN 
THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE 
SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, 
OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF OR 
INABILITY TO USE THIS SOFTWARE, EVEN IF DIONEX HAS BEEN 
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ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN THE EVENT 
THAT ANY LIABILITY IS IMPOSED ON DIONEX, THE LIABILITY OF 
DIONEX TO THE LICENSEE OR ANY THIRD PARTY SHALL NOT 
EXCEED THE PURCHASE PRICE OF THE SOFTWARE. 

Some states do not allow exclusion or limitation of the duration of the 
implied warranties or exclusion or limitation of liability for incidental or 
consequential damages, so that the above limitations may not apply to you. 
This warranty gives you specific legal rights, and you may have other 
rights, which vary from state to state. 
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Trademarks and Product Names 
Below please find a list containing various trademarks and product names. 
All trademarks (™) and registered trademarks (®) belong to Dionex 
Corporation unless indicated otherwise. All other trademarks or registered 
trademarks are the property of their respective owners. 

 

A 
AAA-Direct™ Amino Acid Analysis System 

AAA-Certified™ 

AAES™ 

Acclaim® columns 

Acrodisk® (Gelman Sciences, Inc.) 

Acurate™ Flow Splitter 

Advanced Computer Interface (ACI) 

Advanced Gradient Pump (AGP) 

AD20 UV/Vis Absorbance Detector 

AES® Atlas Electrolytic Suppressor 

Alliance® (Waters Corp.) 

AminoPac® Columns 

AminoTrap™ Columns 

AMMS®-ICE, AMMS-ICE II Anion MicroMembrane Suppressor 

AnchorChips™ (Bruker BioSciences) 

Anion Atlas® Electrolytic Suppressor 

Anion Self-Regenerating Suppressor® 

Anotop™ (Whatman) 

AppliCard™ 

AQA™ Mass Spectrometer (Thermo Electron Corp.) 
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ARC™ Automated Run Completion 

Aroclor™ (Monsanto Corp.) 

AS Autosampler 

AS40, AS50 Automated Sampler 

AS3500 Autosampler 

ASE® 100, 200, or 300 Accelerated Solvent Extractor or Solvent Controller 

ASI-100™, ASI-100T™, ASI-100P™, or ASI-100PT™ Automated Sample 
Injector 

ASRN™ Anion Self-Regenerating Neutralizer 

ASRS®, ASRS® II, or ASRS® ULTRA Anion Self-Regenerating 
Suppressor 

Atlas® Suppressor 

Auto OnGuard™ (but OnGuard®) 

AutoASE® software 

autoflex™ (Bruker BioSciences) 

Autoion® 

AutoNeutralization™ system or technology 

AutoQ™ 

AutoRegen® System 

AutoSelect™ 

AutoSuppression® device 

AXIMA-QIT™ (Shimadzu Biotech) 
 

B 
BAKER INSTRA-ANALYZED® Acids (J. T. Baker) 

Biodialyser™ (AmiKa, Inc.) 

BioLC® System 

BioPlus™ Columns 

BioSelect™ (The Separations Group) 

BorateTrap™ Column 
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C 
CA Carbamate Analyzer  

CAES® Cation Atlas® Electrolytic Suppressor 

CarboPac™ MA1, PA1, PA10, PA-100 columns 

Cation Atlas™ Electrolytic Suppressor 

Cation MicroMembrane Suppressor® 

Cation Self-Regenerating Suppressor® 

CD20 Conductivity Detector 

CD Builder™ (AppletWare, Inc.) 

Chemraz® (Greene, Tweed & Co.) 

ChromatoCritters™ 

CH-2 Column Heater 

CHX650 Column Temperature Controller 

CHROMELEON® Chromatography Management Software 

CMD™ Carbohydrate Membrane Desalter 

CMMS® Cation MicroMembrane Suppressor 

Continuously Regenerating Anion Trap Column (CR-ATC) 

Continuously Regenerating Cation Trap Column (CR-CTC) 

CSRN™ Cation Self-Regenerating Neutralizer 

CSRS®, CSRS® II, CSRS® ULTRA Cation Self-Regenerating Suppressor 

CMMS® II Cation MicroMembrane Suppressor® 

Cryptand columns 
 

D 
DataDetective™ (AppletWare Inc.) 

dBASE® (Borland International, Inc.) 

Dequest® (Monsanto Corporation) 

Dionex® 
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DNAPac® column (for NucleoPac) 

DNAPhor™ SB1.5 kB Sieving Buffer Kit (for NucleoPhor) 

Dowex® (Dow Chemical Company) 

DX-80 Ion Analyzer 

DX-120 Ion Chromatograph 

DX-320 Ion Chromatograph 

DX-500 or DX-600 Ion Chromatography System or HPLC System 

DX-800 Process Analyzer 

DX-LAN™ Instrument Interface 
 

E 
ED40, ED50 Electrochemical Detector 

EG40, EG50 Eluent Generator 

Electrochrom 

EluGen® 

EO1 Eluent/Solvent Organizer 
 

F 
FAMOS™ Fully Automated Micro Autosampler 

FastLoc™ (Thermo Electron Corp.) 

Finnigan AQA™, Finnigan MSQ™  

Flarefit® 

FluoBoost Micro Fluorescence Flow Cell 

Foxy® (Isco, Inc.) 

FPLC® (Pharmacia LKB) 

Freon® (E.I. du Pont de Nemours & Co.) 

Fusica columns 
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G 
GM-2, GM-3, or GM-4 Eluent Gradient Mixers 

GP40, GP50 Gradient Pump 

GS50 Gradient Pump 
 

H 
HPICE® (mostly replaced by IonPac® ICE) 

Hydromatrix™ (Varian Associates, Inc.) 
 

I 
ICE (ion-exclusion columns, e.g., ICE-AS6) 

ICS-90, ICS-1000, ICS-1500, ICS-2000, ICS-2500  

ICS-3000 Conductivity Detector 

ICS-3000 Detector/Chromatography 

ICS-3000 Dual Pump 

ICS-3000 Electrochemical Detector 

ICS-3000 Eluent Generator 

ICS-3000 Single Pump 

InkJet® (Hewlett-Packard) 

IonPac® columns 

IonPhor™ Electrolyte Buffers 

IonSep® reagents 

IP20 Isocratic Pump 

Irganox® (Ciba) 
 

J 
Just Add Water 
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K  
Kalrez® (E.I. du Pont de Nemours & Co.) 

KEL-F® (3M Corporation)  

 

L 
LANtastic® (Artisoft, Inc.) 

LaserJet® (Hewlett-Packard Corporation)  

LC5 Injection Module 

LC10 Chromatography Organizer 

LC20 Chromatography Enclosure 

LC25, LC30 Chromatography Oven 

 

M 
Mascot® (Matrix Science Ltd.) 

MassLynx™ (Micromass) 

µ-Guard™ columns 

µ-Dumper 

µ-Fluidics 

MetPac™ Reagents 

MFC-1 (Metal-Free Column) 

MICRO® (International Products Corp.) 

Micro Precolumn 

MicroBead™ resin  

MicroInjection valve  

MicroMembrane™ Suppressor 

Millennium® (Waters Corp.) 

Milli-Q® (Millipore) 

MMS™ MicroMembrane™ Suppressor 
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Monolithic capillary column 

Mono Q® (Pharmacia LKB)  

MonoStandard® 

M Path™ (Thermo Electron Corp.) 

MPIC® (Mobile Phase IC) 

MRA™ Active Flow Splitter (Rheodyne) 

MS-DOS® (Microsoft Corporation) 

MSQ™ Mass Spectrometer (Thermo Electron Corp.) 
 

N 

Nano precolumn 

N-EVAP® (Organomation Associates, Inc.) 

NovaPak® (Waters Corp.) 

NucleoPac (now DNAPac®) 

NucleoPhor (now DNAPhor™) 
 

O 
OligoStandards™ 

OmniFLEX™ (Bruker BioSciences) 

OmniPac® Columns 

OnGuard®, OnGuard® II Sample Prep Station (but Auto OnGuard™) 

Optima™ (Fisher Scientific) 

ORBO™ (Supelco, Inc.) 
 

P 
P680 HPLC Pump 

PaintJet® (Hewlett-Packard) 

PC10 Postcolumn Pneumatic Controller  
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PC10 Reagent Delivery Module 

PD40 Diode Array Detector 

PDA-100 Photodiode Array Detector  

PeakNet® Chromatography Workstation 

Pentium® (Intel) 

PepMap™ 

Pico-Buffer® 

PicoView™ (New Objective, Inc.) 

PolyVial™ 

PowerPoint® (Microsoft) 

Probot™ Microfraction Collector 

Process 450 (Datensystem für 8200er-Serie) 

ProPac® Columns 

ProteinChips® (Ciphergen) 

Purification Suite™ 

PWA™ Purification Workflow Automation 
 

Q 
QSTAR® (Applied Biosystems) 
 

R 
Reacti-Therm™ (Pierce Chemical Company) 

Reagent-Free™ 



Abbreviations xiii

S  
SC-CSRS® 

SELDI ProteinChips® (Ciphergen) 

Self-Contained Cation Self-Regenerating Suppressor 

SelectaPore™ Columns (The Separations Group) 

Self-Regenerating Suppressor® 

SEQUEST® (University of Washington, Seattle, USA) 

Series 600 SFC and SFC/GC Systems 

SFE-723 Supercritical Fluid Extractor 

SFM™ Sample and Fraction Manager 

SmartFlow™ 

SP10 AutoNeutralization™ System 

SpeedVac™ (Savant Corp.) 

SRC SRS Controller) 

SRN™ Self-Regenerating Neutralizer 

SRS® Self-Regenerating Suppressor 

Summit® HPLC System 

SUPELCOSIL™, Supelguard™ (Supelco, Inc.) 

Superba columns 

Superose® (Pharmacia) 

Supor® (Pall Corporation) 

SupraPur® (EM Industries, Inc.) 

Switchos™ Microcolumn Switching Device 

 
T 
TAC-1 (Trace Anion Concentrator) 

TCC-1 (Trace Cation Concentrator) 

TCC-100 (Thermostatted Column Compartment) 



Abbreviations xiv

Teflon®, Tefzel® (E.I. du Pont de Nemours & Co.) 

ThermoFlare™ 

Thermos Column Oven 

Triton® X-100 (Rohm & Haas)  

TurboVap® (Zymark Corporation) 

Tween® 20 (Atlas Chemical Co.) 

 
U 
UCI-100 or UCI-50 Universal Chromatography Interface 

UI20 Universal Interface 

ultraflex (Bruker BioSciences) 

UltiChrom™ software 

UltiMate™ 

Ultrex® (J.T. Baker) 

UV-Booster 

UVD 170S/170U UV/Vis Detector 

UVD 340S/340U Photodiode Array Detector 

U-Z View™ Capillary Flow Cell 

 
V 
Vespel® (E.I. du Pont de Nemours & Co.) 

VHP™ (The Separations Group, Inc.) 

Vortex-Genie® (Scientific Industries, Inc) 

Voyager™ (Applied Biosystems) 

Vydac® columns (The Separations Group, Inc.) 

 



Abbreviations xv

W 
Windows® 2000/XP (Microsoft Corporation) 

Windows NT® (Microsoft Corporation)  

Wonderware InTouch® (Wonderware Corporation) 

 

Z  
Zitex® (Norton Chemplast) 

Zorbax® (E.I. du Pont de Nemours & Co.) 
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Abbreviations 
Below please find a list of the most frequently used abbreviations in 
Chromeleon, the online Help, and the manual: 

APS Automated Purification System 
ARC Automated Run Completion 
AIA Analytical Instrument Association 

BCD Binary-Coded Decimal Code 
BOOTP Bootstrap Protocol (Internet protocol) 
CAN Controller Area Network 
CD Compact Disk 
CDS Chromatography Data System 
CE Capillary Electrophoresis 
CFR Code of Federal Regulations  

(often synonymous with 21 CFR Part 11) 
CM Chromeleon® Chromatography Management System 
CMB Backup container/file (file extension) 
CMS Chromatography Management System 
CS Cluster Server 
DHCP Dynamic Host Communication Protocol 
DNS Domain Name Server 
DX Dionex 
GC Gas Chromatography 

GLP Good Laboratory Practice 
GMP Good Manufacturing Practice 
GPIB General Purpose Interface Bus 
HPLC High Performance Liquid Chromatography 
IC Ion Chromatography 



Abbreviations xviii

IPC Chromeleon Instruments Server or Instruments PC 

IQ Installation Qualification 

ISTD Internal Standard 

LAN Local Area Network 
LIB UV Spectra Library (file extension) 

LIC Chromeleon License Server 

LIMS Laboratory Information Management System 

LOD Limit of Detection 
MAC Media Access Control address  

(unique address of each network interface card) 
MRA Mass Rate Attenuation (Flow Splitter) 
MS Mass Spectrometer 

MSV Motorized switching valve 
NFP Network Failure Protection 

ODBC Microsoft Open Database Connectivity 

OQ Operational Qualification 

PAN Control Panel for chromatographic system control  
(file extension) 

PDA Photodiode Array Detector 

PGM Control program for chromatographic system control  
file extension) 

PN PeakNet® Chromatography Management System 

PPA Peak Purity Analysis 

PPI Peak Purity Index 

PQ Performance Qualification 

PWA Purification Workflow Automation  

QNT Quantification method for signal interpretation and evaluation (file 
extension) 



Abbreviations xix

QRF Query file (file extension) 
RDF Report Definition File; includes the layout definition for the 

report and export (file extension)  
RPC Remote Procedure Call 

RSD Relative Standard Deviation 

SDK Software Development Kit for Chromeleon 

SEQ Sequence; that is, the sequence of samples plus the 
corresponding files (file extension) 

SFM  Sample and Fraction Manager  
(in the Administrator Help section) 

SIM Selected Ion Monitoring (MS channel for specific masses) 

SOR Signed Off Results (File) = signed sequence 

SQL Structured Query Language (computer language) 

SSM Safety and Solvent Monitor 

SST System Suitability Test  

TCP/IP Transmission Control Protocol/Internet Protocol  
(class of Internet protocols) 

TIC Total Ion Current  
(MS channel for the entire mass range or a part thereof) 

TTL Transistor-Transistor Logic 

UDP User Datagram Protocol (IP communication protocol) 

UDC User-Defined Column 

USB Universal Serial Bus 

VCD Virtual Channel Driver (driver for virtual devices) 
WSP Workspace; that is, the definition of a screen layout  

(file extension)  
 
For a list of the Institutes and Institutions for Industry Standards, refer to 
the Glossary section. 



Abbreviations xx

 



 
 
 
 
 
 

 

 

 

 

 

 

Tutorial 
 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Doc.: CM_Tutorial_670.doc 



 Table of Contents T-I 

Table of Contents 
 

Chromeleon - Tutorial................................................. T-1 
 

Table of Contents........................................................ T-2 
 

Sequence - Flow Chart ............................................... T-4 
 

I. Starting Chromeleon ............................................... T-5 
 

II. The Browser ............................................................ T-9 
 

III. Online Help ........................................................... T-13 

1. Context-sensitive Online Help..................................................... T-13 
 

2. Systematic Online Help ................................................................ T-14 

IV. Control .................................................................. T-17 

1a) The Control Panel ....................................................................... T-17 
 

1b) Connecting a Control Panel to a Timebase ............................. T-19 
 

1c) Using the Control Panel............................................................. T-22 
 

2. The Control File (PGM File).......................................................... T-26 
 

3. The Program Wizard ..................................................................... T-27 
 

4. Editing the Control File ................................................................ T-38 



T-II Table of Contents 

V. The Analysis.......................................................... T-39 

1. The Sample List (Sequence)........................................................ T-39 
 

2. Starting the Analysis .................................................................... T-47 

VI. Quantification Method (QNT File) ...................... T-51 

1. Detecting Peaks (Detection Tab)................................................. T-53 
 

2. Graphical Input of Detection Parameters................................... T-58 
 

3. Automatically Generating the Peak Table.................................. T-60 
 

4. Identifying Peaks (Peak Table Tab)............................................. T-62 
 

5. Quantifying Substances (Amount Table/Peak Table Tabs)...... T-63 
 

6. Defining the Calibration Mode and Calibration Type ................ T-67 

VII. Data Analysis ...................................................... T-71 

1. The Integration Window ............................................................... T-74 
 

2. Modifying the Chromatogram...................................................... T-76 
 

3. Report Tables ................................................................................ T-77 
 

4. Modifying a Report Table ............................................................. T-79 
 

5. Saving Changes ............................................................................ T-80 



 Table of Contents T-III 

VIII. Printing Results ................................................. T-81 

1. Creating a Print Template (Printer Layout) ................................ T-81 
 

2. Printing........................................................................................... T-83 

IX. Special Functions................................................ T-87 

1. Installing Datasources.................................................................. T-87 
 

2. Finding Samples (Query) ............................................................. T-90 
 

3. Backup and Restore ..................................................................... T-91 
 

4. Signing Sequences Electronically .............................................. T-93 
 

5. Modifying a Control Panel............................................................ T-98 
 

6. Internal and External Standards................................................ T-100 
 

7. Spectra Library Screening ......................................................... T-101 
 

8. Defining the Workspace............................................................. T-103 

Addendum: Keyboard Shortcuts/Short Glossary T-105 

Datasource and Database.............................................................. T-108 
 

Raw Data.......................................................................................... T-109 
 

Sequence ......................................................................................... T-109 
 

(Chromatography) Server .............................................................. T-110 
 

Timebase.......................................................................................... T-111 
 



T-IV Table of Contents 

 

 

 



 Chromeleon - Tutorial T-1 

Chromeleon - Tutorial 
Welcome to Chromeleon, the innovative chromatography management 
system.  

Use this tutorial to become familiar with Chromeleon.  

Learn how to 

• Start the program 

• Perform an analysis 

• Reprocess your data 

For an overview of the topics, refer to the Table of Contents. 

 Tip: 
The arrow ( ) references topics in the Tutorial. 
There are no references between the Tutorial and the User and/or 
Administrator Manual. 

Tutorial 
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Table of Contents 
 

I. 

 

Starting Chromeleon: If your computer is 
running under Windows, you can start 
Chromeleon by clicking Start > Programs > 
Chromeleon on the task bar.     

II. 

 

Managing Data: Chromeleon allows you to 
manage data in folders and directories similar to 
Microsoft Windows. The tool that helps you to 
handle your chromatography data is the 

Browser.    
III. 

 

Online Help: The Tutorial can only deal with 
selected aspects of Chromeleon. For more 
information, refer to Online Help and/or to the 
User Manual.    

IV. 

 

Controlling your HPLC system: Make sure that 
your chromatography or CE instruments are 
correctly connected to the PC via a serial port. If 
the instruments are connected correctly, you can 
operate the pump, autosampler, detector, etc. 
from a Control Panel on your PC. In addition, 
you can create a Control File (PGM File) to 
control your system automatically.    

V. 

 

Analyzing Samples: Can you control your 
instruments from the PC? If you can, you can 
start the chromatographic analysis. To use all 
functions provided by Chromeleon, we 
recommend that you create a Sample List 
(Sequence) first: 
Use the Sequence Wizard to include the 
samples to process in the sample list. The wizard 
guides you in defining the number of samples, 
the order of sample processing, the injection 
volumes, the sample type (analysis or standard), 
and the location where Chromeleon finds 
information about how to perform the analysis.  
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V. 
(Cont'd) 

 To make this information available to 
Chromeleon, create the corresponding files 
(PGM File, QNT File, see below) and enter a 
program and a method name. 
When you have created the sample list, you can 
start the Analysis. The resulting data is 
automatically saved.    

VI. 
 

Quantifying: The Quantification Method (QNT 
Method) allows you to minimize the reprocessing 
effort for single chromatograms. The QNT 
Method defines the detection parameters, the 
peak identification, and the calibration of the 
substances in several samples.     

VII. 
 

Data Analysis: You can display the result of a 
chromatographic analysis on the screen. Data 
Analysis allows you to manually change 
integration limits directly in the single 
chromatogram or to re-evaluate samples based 
on new parameters ("offline.")     

VIII. 
 

Printing Results: You can print your analysis 
data immediately after data acquisition or at any 
time later. For perfect adjustment to your 
personal requirements, create your own report 
templates in the Printer Layout, define your 
own result variables, or embed your company 
logo.    

IX. 
 

Managing Data (Special Functions): In addition 
to the basic functions, the Chromeleon provides 
various special functions. For example, you can 
search samples according to defined criteria 
(query), backup and restore data, electronically 
sign sequences, and search spectra. For more 
information, refer to Special Functions. 

For an overview of the most important steps in Chromeleon, see 
Sequence - Flow Chart. 
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Sequence - Flow Chart 
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I. Starting Chromeleon 
Objectives of this chapter: 
• To make you familiar with the basics of a client/server software 

• To start the client and server programs 

Chromeleon is a client/server program, operable under Windows 2000 and 
Windows XP. The two independent program parts, the client and the 
server, allow you to operate the program from different PCs on a network:  

 

Server: The server PC is directly connected to the different modules of the 
chromatography systems. The server communicates with the individual 
modules of a Timebase and controls them actively. You usually perform 
only two actions in the server program: you start and stop the server. In the 
client program, you specify which control actions the server shall perform. 
Client: The client program allows you to work offline, i.e., to perform certain 
tasks independent from the server, for example, creating sequences, 
processing data, searching single spectra in a spectra library, etc. The 
client can be installed locally. In this case, the client and server programs 
can be installed on the same PC that is connected to the chromatography 
system. This is typical for a single-site installation (one timebase only). 

In addition, remote client PCs can be connected to the chromatography 
server on the company network. You can then perform client functions on a 
PC that is not connected directly to the chromatography system but to the 
server PC on the network. 
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A characteristic of client/server systems is that certain processes are 
performed on the client, while others run on the server. The cooperation 
between the client and the server is crucial to the full functionality of the 
program.  

Since the client and the Server are independent programs, you have to 
start them separately. 

Starting the Client Program 
• Click Start > Programs > Chromeleon to start the Chromeleon client. 

 

• If User Management was created and enabled during installation, a 
logon dialog box appears. In this case, enter your user ID and personal 
password. 

Starting the Server Program 
If you do not only want to view data but control an entire chromatography 
system and perform your own analyses, start the Server Monitor program. 
The server controls all connected instruments and allows direct instrument 
operation and control via the PC.  
• Select Server Monitor to start the Server Monitor program. The 

Chromeleon icon appears on the Windows task bar next to the Windows 
system clock.  
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 Tip: 
During installation, Chromeleon usually creates a link in the Autostart group 
and the corresponding icon is displayed. You can also configure the 
program in such a way that it starts whenever the computer is started. 

• Move the mouse cursor to the icon. You will see the quick info message: 
CHROMELEON Server is not running. 

• Open the context menu (right-click) and select Start Server (or double-
click the icon and click Start). The icon can have different colors. Gray 
coloring indicates that the server is running idle. 

 

• Both, the client program and the server program are active now. The 
client control panel allows direct access to all instruments that are 
connected to the server.  

 

 Note: 
The instruments of a system are combined in a common Timebase. 
Instruments and timebases are installed and configured in the Server 
Configuration program. Since your Dionex Service Representative usually 
performs this task during the initial installation of Chromeleon, the Tutorial 
does not provide more information about this. 
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II. The Browser  
The Browser window loads automatically whenever Chromeleon is started. 

Opening the Browser 
 
• Click the Browser icon  to open the Browser window or to display it 

on top. 
 

Browser Appearance and Functions 
The Browser, which is the "control room" of Chromeleon, serves for data 
management, storage, and retrieval. The Browser's appearance and 
functions are similar to the Windows Explorer. 

 Caution: 
Although the Browser is very similar to the Windows Explorer, you should 
not confuse these two windows! Do not use the Windows Explorer for 
operations within the Chromeleon datasources! Usually, your administrator 
will prohibit these operations! 

The left window section shows a tree structure with different levels. The 
right window section shows detailed information about the currently 
selected item.  
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The Datasources, for example, ComputerName_local , are the top 
level of the structure and serve to store data and results.  
• Click the + or - character next to a datasource to expand or collapse the 

corresponding directory structure (yellow folders).  

The lowest levels contain the Sequences (blue folders: ) created by 
the user. During installation, one directory is created. The directory name 
corresponds to the name of the timebase. The timebase contains a 
sequence that stores manually acquired data. Thus, it is called manual.  
• Select a directory to display its subdirectories in the right window 

section.  

• Select a sequence to view files and samples contained in the 
sequence.  

When you click a sequence, the upper part of the right windows displays 
the files contained in the sequence. The different icons indicate the file 
types: 

Symbol File Extension File Type 

 *.pgm Control file or PGM File 

 *.qnt Quantification method 

 *.rdf Report template or report definition 

 *.pan Control panel 
 
The lower part of the right window displays the sample list showing the 
individual samples of the sequence. The different icons indicate up to 
seven different sample types:  
 
Symbol Name Sample Type 

 Unknown Unknown sample 

 Blank Run Blank 

 Validation Validation sample 

 Standard  Standard sample  

 Matrix Matrix blank sample 

 Spiked Spiked sample 

 Unspiked Unspiked sample 
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Opening Files 
Double-click to open a file name in the Browser. Chromeleon loads the 
appropriate chromatographic environment according to the file type: 
• Double-click a control file (PGM File) to open the PGM Editor. 

• Double-click a quantification method (QNT File) to open the QNT editor. 

• Double-click a PAN file to open a control panel. 

• Double-click a report template (report definition file = RDF) to open the 
Printer Layout. 

Opening Samples 
When opening samples, consider the following (independent of the file 
type):  
• If raw data exist for several channels of a processed sample (Status = 

finished, multiple, or interrupted), double-clicking the sample opens one 
channel only (for example, a UV channel at a wavelength of 254 nm).  

• Right-click a sample (here: sample1) and select Open from the context 
menu. A submenu is opened on which Chromeleon lists all channels 
that exist for this sample: 
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If you record four different channels of a sample with a diode array detector 
when you process the sample (as was in this example), a separate 
chromatogram will be available for each channel (here: 3DFIELD and 
UV_VIS-1 to UV_VIS-4).  

• Select the channel or the chromatogram to display.  

The highlighted channel (here: UV_VIS-1) is used as the "preferred 
channel." The preferred channel automatically opens when you double-
click a sample. Select Preferences on the File menu, and then specify 
which channel Chromeleon shall use as the preferred channel. 

Moving and Copying Items 
Different ways are available to move or copy a subdirectory, sequence, or 
file: 
• Left mouse button: Use this button to move or copy the element 

according to the settings made for the Left mouse button Drag/Drop 
behavior on the Browser tab page (click Preferences on the File 
menu). 

• Right mouse button: Use this button to move or copy the element as 
desired. 

• Keyboard shortcut: Use keyboard shortcuts to perform the desired 
action, for example, <Crtl> <C>, to copy the element or <Crtl> <V> to 
paste the element. 
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III. Online Help 
There may be issues and questions that are not discussed in this Tutorial. 
In this case, refer to the User Manual and the online Help for more 
information. You can access online Help anywhere in the program:  

• Context-sensitive Help answers your questions that may occur at the 
current cursor position. 

• Systematic Help allows you to  

• Select an interesting topic on the Contents tab page 

• Search the index for any required information 

• Search for specific words and phrases in help topics by 
searching the entire text of the help system. 

1. Context-sensitive Online Help 
Access to the online Help depends on your current cursor position. Usually, 
a window opens from which you can access systematic online Help. In 
other cases, a popup window opens providing a short context-sensitive 
description and links for access to related topics.  

Help via the Context Menu  
Right-click to open the context menu:  
 

  
Select How to ... to display detailed information about actions that can be 
performed at the current cursor position. Select What’s this? for a 
description of the selected item, command, etc. In some cases, What’s 
this? topics provide information that is more general. Usually, links are 
available for specific information. 
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Help via the Help Button and Icon 

First, click the  icon on the toolbar to display a question mark 
appended to the cursor, and then click the item of interest for specific 
information. 

In some cases, a Help button is available instead of the context menu or 
the question mark. Click Help to display information about the current 
screen.  

In some windows in which you can enter parameters and variables, such as 
in the QNT Editor, click Explain Param. or Explain Variable for 
information about your selection. 

Help via the F1 Key 
In addition, you can always press the F1 key. This help information 
corresponds to the context-sensitive help information that is available via 
the question mark cursor or the Help button. 

2. Systematic Online Help 
Select Index on the Help menu for an overview of the topics that are 
available in the online Help. The help window provides the following tabs: 

• Contents 

• Index 

• Find 

Contents Tab 
The Contents tab page contains the table of contents of the online Help. 
Double-click a book symbol to display the topic titles. Double-click an open 
book symbol to close the book again. 

Topic titles are marked by a page symbol with a blue question mark. 
Double-click to open the topic. 
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Index Tab 
The Index tab page enables you to find a specific term by searching the 
index entries. Type the first few letters of the word you are looking for in the 
first field until the desired term appears in the second field. Click the index 
entry you want, and then click Display to open the desired topic. If several 
topics are found, the Topics Found window opens. Select an entry and 
then click Display.  

Find Tab 
The Find tab page enables you to search for specific words and phrases in 
help topics by searching the entire text of the help system. (The query is 
not limited to the index entries.) First, Chromeleon generates a list that 
contains every word from the online Help file. You can then search the 
resulting list for a specific term. The procedure is similar to searching for a 
specific term on the Index tab page. 
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The query finds all topics that contain the entered word(s). That is why the 
Topics Found list is far more extensive than the one found when searching 
the index. To narrow the search, you can select matching words in the 
second field: 
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IV. Control 
Objectives of this chapter: 
• To describe the purpose and functions of a control panel 

• To connect the devices to Chromeleon, using a control panel  

• To display the current chromatogram  

1a) The Control Panel 
A control panel (often just called panel) allows you to control an entire 
chromatography system from your PC. The system may consist of one or 
several analytical instruments that are installed under the same timebase. 
The control panel comprises the different elements required to control your 
system and to display the current chromatogram.  

 

The above image shows a control panel for controlling the basic functions 
of a pump, an autosampler, and a two-channel UV detector. On the right, 
you see the detector signal.  

Chromeleon includes more than a hundred default control panels that cover 
most applications. Although it is possible to change the existing panels, you 
rarely have to do so. For more information, see Modifying a Control 
Panel in the Special Functions section. 
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Opening a Default Control Panel 
From the Browser 
• Open the Dionex Templates > Panels directory and select the control 

panel that corresponds to your system.  

• Double-click to open the panel. 

 
 
From the File or context Menu 
• Select Open on the File or context menu. 
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• In the Open dialog box, select Control Panel in the Object of type 

field. 

• In the Look in field, select the local Datasource of the system. This 
datasource is automatically saved on your computer during the 
Chromeleon installation. The datasource is named <NAME_LOCAL>, 
wherein <NAME> is the computer name. If the Look In field contains 
further datasources, you can also search here for an appropriate control 
panel.  

• Open the Dionex Templates > Panels directory and select one of the 
default control panels (*.pan). 

• Double-click to open the panel.  

As soon as a control panel has been opened, Chromeleon tries to connect 
to the Timebase that is linked to this control panel. 

If the connection cannot be established, the control elements are grayed 
and an error message is displayed. In this case, connect the control panel 
to the timebase as described in the next topic (see below). 
 

1b) Connecting a Control Panel to a 
Timebase 
When a control panel is open, you can connect to any Chromeleon 
timebase at any time. However, verify that the server on which the 
timebase is installed has been started as described in Starting 
Chromeleon. 
• Select Connect to Timebase on the Control menu to create and/or to 

change the timebase assignment. 

• In the dialog box that opens, determine the Server and the 
Timebase to which you want to connect the control panel. 
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• If the server is started locally on your computer, click the + character to 
open the My Computer submenu. If the server is running, the names of 
all timebases that are installed on the respective server will be 
displayed. If the server is not running, a corresponding message will 
appear. In this case, start the server first and then select a timebase, for 
example, HPLC. The Computer field will automatically show your PC, 
that is, the name that was specified during the Windows installation. The 
Protocol field shows the entry My Computer. 

• If your PC is connected to other computers via a network or modem, 
you can also access a server that was not started on your local 
computer, but on another PC. To do so, the select the network protocol 
under Protocol. (Access to other computers and timebases is usually 
via the Internet TCP/IP protocol.) Open the Network Neighborhood to 
browse for the required timebase.  

• Chromeleon remembers the servers accessed on other computers. 
These servers are listed under Favorites. 

As soon as you complete the dialog, Chromeleon tries to access the 
selected timebase. If communication fails, this may be due to several 
reasons. 
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Possible Problems when Connecting to a Timebase 

Cannot connect to timebase "..."  

⇒ The error message indicates that the corresponding server is not 
running, that the selected timebase does not exist on this server, or that a 
wrong communication protocol has been selected.  
• Start the server as described in Starting Chromeleon or select the 

required timebase or protocol.  
 

 Tip: 
Chromeleon can communicate via various network protocols such as IPX, 
TCP/IP, or NetBEUI. Communication between two stations is possible only 
if the same (!) network protocol is installed and selected. Generally, it is 
sufficient to install the corresponding Microsoft ("IPX/SPX-compatible 
protocol"; "NetBEUI"; "TCP/IP") or Novell ("Novell IPX ODI Protocol") 
network protocols via Settings > Control 
Panel > Network > Configuration. The protocol that is actually used 
depends on the current network installation. Please contact your network 
administrator.  
 

This timebase contains no device/object named "..." 

⇒ The control panel tries to access an instrument (or a function of this 
instrument) that is not part of the current installation environment. The 
control panel and installation environment do not match. Load the 
appropriate control panel or change the existing configuration of the 
timebase in the Server Configuration program. For more information, refer 
to the online Help and/or the User Manual. 
 

Device is not remote. 

⇒ The control panel tries to access an instrument that is currently not 
ready for operation. Check whether all instruments listed in the 
configuration are actually connected to the server PC and that they are 
turned on. It may be necessary to restart the instrument to ensure proper 
functionality. 
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The connection is established correctly (no error message), but the 
controls are inactive. 

⇒ The Monitor Only mode is enabled. It is not possible to actively operate 
the control panel. The Monitor Only mode is always enabled when the 
selected timebase is already controlled by a different workstation. Disable 
the Monitor Only mode on the Control menu. You can now actively 
control the timebase. (This is indicated by the controls on the control 
panel.) Simultaneously, the previously controlling workstation loses the 
control rights and is in Monitor Only mode. 
 

 Tip: 
Have a look at the Audit Trail entries. They often provide useful 
information that helps you to correct the error.  
 

1c) Using the Control Panel 
As soon as a control panel is correctly connected to a timebase, you can 
operate the individual instruments of this timebase using the controls 
provided on the panel. 

Depending on the control panel that is currently defined as default, various 
active and passive controls and display elements (Lamp, ... Signal Plot) 
are available for controlling instruments and displaying system functions. 
You can change the appearance of the controls (size, shape, and color).  
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For example, the above control panel allows you to control an HPLC 
system that consists of a pump, an autosampler, a UV detector, and a 
fluorescence detector. In this example, all modules except the fluorescence 
detector are connected. Different buttons are available for issuing control 
commands such as Inject+Acq.On (for injection and data acquisition), 
autozero, etc. In addition, the current protocol data (Audit Trail) are 
displayed. After data acquisition has been started, the current 
chromatogram is displayed in the signal plot. 

The control panel is usually configured during installation. We recommend 
storing the control panels in the directory of the corresponding timebase. 
(You cannot store them in the Dionex Templates directory because this 
directory is read-only). 

Online-Toolbar: The basic commands such as the pump flow control, the 
inject command, or the start of the data acquisition are available on a 
separate toolbar. The toolbar is only active when a control panel is open.  
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The functions of the single buttons are as follows (from left to right): 
• Flow...: Define the flow and gradient composition and start the flow 

• Inject... 

• Acquisition on/off: Start and stop data acquisition 

• Stop Flow: Stop the flow, interrupt data acquisition, and hold the sample 

• Hold: Freeze the solvent composition and hold data acquisition and the 
sample 

• Continue: Continue the flow, gradient, and sample 

• Edit Batch: Edit the order in which the samples are processed 

• Start/Stop Batch 

However, how does the system know that moving a slider should change 
the pump flow, and not the oven temperature? In addition to changing the 
size, color, and shape of each control, you can also change its functionality. 
These assignments are preset for the controls provided on the standard 
control panels. Although you can adapt them to your requirements, this is 
seldom required. For more information, see Modifying a Control Panel in 
the Special Functions section. 
 

Manual Sample Processing/Starting the Analysis 
If the panel is connected to the corresponding timebase, you can use the 
Online toolbar to start sample analysis: 
• Open the control panel and connect to the desired timebase. 

• Select Flow... on the Control menu (or click the  icon on the Online 
toolbar). Enter the flow rate and the solvent composition the pump shall 
deliver. The pump immediately adjusts to the selected settings. 

• Select Inject... on the Control menu (or click the  icon on the 
Online toolbar). Specify the position from which to draw the solvent and 
the quantity (in µl) you want to draw and inject. This command, too, is 
executed immediately. Injection is performed directly after the command 
is issued. 

• Select Acquisition On on the Control menu (or click the  icon on 
the Online toolbar). Define the signals to record and click OK to start 
data acquisition. Chromeleon records the data supplied by the detector.  
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You can also execute these commands directly from the control panel if 
your panel supports the corresponding option. 
• To finish data acquisition and to complete the analysis, select 

Acquisition Off on the Control menu or click the Acquisition on/off 
icon again on the Online toolbar.  

If your control panel is connected to a timebase on the local server, the 
recorded data is usually saved to the Manual sequence in the <Timebase 
Name> directory of the local datasource. This sequence is automatically 
generated during installation; it contains one sample only.  
 

 Note:  

With each new manual sample processing, the existing data is overwritten 
by the data of the newly analyzed sample (default setting). However, using 
the Save to sequence command, you may also save the data to any other 
sequence after data acquisition. Use this type of sample processing only for 
test runs etc.! 

You will usually want to analyze several samples automatically one after 
another. To do so, you have to define both the order in which the different 
samples shall be processed and the commands that are required at the 
respective time. In Chromeleon, the processing information is contained in 
a Sample List (Sequence). The information about the command order is 
part of a Control File (PGM File). 
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2. The Control File (PGM File) 
Objectives of this chapter: 
• To describe the definition and purpose of the program 

• To introduce the Program Wizard that guides you through program 
creation 

• To describe the functions for program reprocessing 

The different commands instruct the single instruments of a 
chromatography system to perform specific tasks. Enter the commands via 
the controls on the control panel or by clicking the corresponding buttons 
(for more information, see the Control Panel section). 

For automatic and synchronized operation, the single commands must be 
listed in a file. When starting the file, the listed commands are executed 
consecutively, observing the relative time differences. This type of file is 
called control file or PGM File. 
 

Control File Properties 
For a very simple control file, the PGM Editor could look like this, for 
example:  

 
 



 IV. Control T-27 

In the Command view, the various commands of the PGM File are listed 
on the right below the Title line. The commands are assigned to the 
corresponding retention time. For information about how to create a 
program, refer to the following sections.  

3. The Program Wizard 
Creating a Program 
We recommend that you use the Chromeleon Program Wizard to create a 
basic program structure and thus, avoid syntax errors when you enter the 
commands.  
• Verify that the server is running. If the server is not running, start the 

server as described in Starting Chromeleon.  

• Select New on the File menu.  

• Select Program File from the list and click OK to start the Program 
Wizard. 

 

Depending on the installed instruments, the Program Wizard provides 
various steps. Below please find an example describing the different steps 
required to create a program for a typical HPLC timebase that contains the 
following devices: 
• P680 Pump 

• ASI-100 Autosampler (without cooling option) or AS50 Autosampler 

• TCC-100 Thermostatted Column Compartment 

• UVD340U Photodiode Array Detector 

For more information about the wizard pages, press the F1 key or click the 
Help button. Click Back or Next to toggle between the pages.  
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Step 1: Timebase and Server 
Determine the server and the timebase to be used:  
• If the server was started locally, click the + character to display the items 

under My Computer, and then select a timebase. Select My Computer 
in the Protocol field. If you want to access a server that was not started 
on your computer but on a remote PC, click the + character to display 
the items under Network Neighborhood, and then select the 
appropriate timebase. In this case, you also have to select a network 
protocol in the Protocol field. For more information, press the F1 key.  

 
 

Clicking Next takes you to the next wizard page. Click Finish to 
generate a program with the settings selected on the different wizard 
pages.  
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Step 2: ColumnOven Options (here: Dionex TCC-100) 
Set the nominal temperature and the upper and lower temperature limits: 
 

 

Step 3: Pump Options (here: Dionex P680) 
Define how to operate the pump:  
• From the Type drop-down list, select Isocratic to deliver a constant 

solvent composition. If more than one solvent is used, the Start field 
determines the solvent composition in percent (for example: B = 45%, 
C = 0%, D = 5%). %A is calculated by the system from the portions of B, 
C, and D. Enter the flow rate in the Start field under Total Flow. 
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• If you select Ramp instead of Isocratic, use the Start and End input 

fields to set the start and end time of the gradient ramp. You can also 
select a Multi-Step Gradient. In this case, clicking Next opens an 
additional wizard page. 

 

Step 3a: Flow Gradient Options (here: Dionex P680) 
If you selected Multi-Step Gradient from the Type drop-down list, use this 
wizard page to specify the desired gradient by entering the:  
• Retention time 

• Flow  

• Solvent composition  

 Tip:  
Before you enter a multi-step gradient, determine the flow rate and the start 
composition for the solvent on the previous wizard page. This facilitates the 
entry. 
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To append lines to the table, place the cursor in the last line of the table 
and press the arrow down key on the keyboard. The window will show the 
graphical representation of your gradient. A blue line indicates the flow, 
while the area represents the gradient composition. The following example 
shows a gradient at a flow rate of 1 ml/min, with a constant 5%D during the 
entire gradient. The portion of solvent B changes according to the entries 
made in the %B column. 

 
 

 Note:  
If you have a Dionex GP40, GP50, or GS50 pump installed, you can 
program curved or linear gradients. The default is Curve 5, that is, a linear 
gradient. Curves 1 to 4 result in a convex gradient. Use curves 6 to 9 for a 
concave gradient. 
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Step 4: Sampler Options (here: Dionex ASI-100) 
Determine the autosampler options:  
 

 

• Determine the syringe and sample options:  

• Dispense Speed: Enter the speed with which the injection shall be 
performed.  

• Draw Speed: Enter the speed with which the syringe is filled.  
• Sample Height: Enter the height at which the sample is drawn, 

measured from the vial bottom to the needle tip.  
• Syringe Delay: Enter the time that the needle will remain in the vial 

after loading.  
• Determine the speed for the needle movements: 

• Up/Down Speed: Enter the speed for moving the needle up and 
down.  

• Radial Speed: Enter the speed for moving the needle radially.  
• Select the Synchronize injection with pump check box to synchronize 

injection with the pump cycle.  
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Or else: Steps 4 + 4a: Sampler Options (here: Dionex 
AS50) 
If you have an AS50 autosampler installed, use this wizard page to define 
the autosampler options that do not change during the program: 

 
 
• If you have the respective option installed, define the Column 

Temperature and the Tray Temperature. Select the Wait for stable 
temperature check box to wait before the injection until the temperature 
is stable.  

• In the Cycle Time field, enter the time between two injections. 

• In the Syringe Speed field, define the speed for drawing the sample. 

• In the Sample Needle Height field, define how deep the needle will dip 
into the vial, that is, the position from which the sample is drawn.  

• In the Cut Volume field, enter the sample volume that is finally 
dispensed into the waste. 

• In the Flush Volume field, specify the volume for flushing the injection 
port. 
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Also, define the different AS50 sample preparation steps:  

 

 Note:  
In the example, the different functions have been entered one after the 
other. A "real" application would look different, of course. 
 
• First, select a function in the Function column. Seven different functions 

are available.  

• Determine the desired parameters. (For example, for the Dispense 
function these are the Source, the Volume, and the Destination 
parameters.) 

• Click Insert to enter the sample preparation step. To delete an existing 
sample preparation step, select the respective step and click Delete. 
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Step 5: Acquisition Options (here: esp. Dionex UVD 
340U) 
Determine the signals to be recorded during sample processing.  

 

• Select the signals. Under Acquisition Time, specify how long the 
individual sample shall be analyzed.  

For a photodiode array detector, for example, an entire 3D field and the 
UV_VIS_1 and UV_VIS_2 channels are recorded for 10 minutes (From 
0.000 min to 10.000 min). 0.000 means that data acquisition starts 
immediately after injection (t = 0.000 min).  
 

Step 6: Signal Parameters (here: esp. Dionex UVD 
340U) 
Define the signal parameters for each signal selected in step 4.  
• Depending on the signal type, you must set various parameters (for 

example, Excitation Wavelength for the fluorescence detector). In the 
case of a UV detector, specify the wavelength, the bandwidth, and the 
step used for recording (for example: Wavelength = 225nm, 
Bandwidth = 1nm, Step = Auto, Average = On (selected)).  
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• In case of ECD channels, specify the Data Collection Rate (= number 
of collected data points per second) and the SRS Current (= suppressor 
current).  

• In addition, enter the temperature compensation factor and the cell 
temperature as desired. 
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Step 7: Completing and Saving the Program 
• Click Finish to complete the Program Wizard. In addition to your input, 

the complete program displayed in the PGM Editor also includes 
commands that are automatically added by Chromeleon, such as the 
Inject and End commands. These commands are required to execute 
the file. When these commands are missing, the program can be 
executed in exceptions only. The complete program could look as 
follows: 

 
 
• You can edit a program later, as necessary. If you enter invalid 

commands, Chromeleon recognizes them and marks the respective line 
in red color (Glow instead of Flow in the above example). For more 
information about the error, refer to the status bar. 

• Select Save as on the File menu to save the PGM File under a 
descriptive name. 
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4. Editing the Control File 
You can edit each line directly via the keyboard. Make sure that the control 
file is connected to a timebase. If it is not, Chromeleon cannot perform the 
Ready Check and input via the F8 key (see below) is not supported.  
• To open the PGM File, select Open on the File menu or double-click the 

corresponding file name directly in the Browser.  

• Verify that your server is running. If the server is not running, start the 
server as described in Starting Chromeleon.  

• Select Connect to Timebase on the Control menu.  

 Note:  
If the timebase to which the program is connected is not available, select 
Connect to Timebase on the Control menu to connect the program to a 
different timebase. 

You can now edit the program. Instead of overwriting the command syntax 
directly in the PGM File, we recommend to proceed as follows: 
• Move the mouse cursor in the line to edit and press <F8 key>. 

Chromeleon opens the Commands dialog box for the currently selected 
command. You can now edit the input by selecting defined values, 
without having to worry about the correct command syntax.  

• Save the edited PGM File using the Save as command. 
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V. The Analysis 
1. The Sample List (Sequence) 
Objectives of this chapter: 
• To describe the definition and purpose of a sequence  

• To introduce the Sequence Wizard that guides you through sequence 
creation 

• To describe the functions for sequence reprocessing  

• To automate the analysis by using a sample batch  

To allow a chromatographic system to process several samples one after 
another without interruption, you have to define the order and the program 
to be used for sample processing. Chromeleon stores this information in a 
sequence. 

Blue folders mark sequences in the left Browser pane (see "Isocratic" in the 
following picture). When you click a sequence, the right pane displays all 
files and samples contained in the sequence. The upper right Browser pane 
is reserved for files that are required for sample processing. The lower 
section lists all samples of the selected sequence. This section is referred 
to as Sample List.  

 



T-40 V. The Analysis 

Sample List Contents 
The sample list forms the basis for sample processing. It lists the samples 
intended for processing (one line corresponds to one sample) and indicates 
how processing is or was performed (contents of individual columns).  
 
No. Number of the sample in the sequence. 
Name Sample name. The symbol indicates the sample type.  
Type Sample type. 

Unknown: unknown sample (symbol in front of the 
sample name: )  

Standard: calibration sample ( ) 
Validate: sample for validating the calibration ( )  
Blank: blank value (usually without injection) ( ) 
Matrix: blank value of the sample matrix ( ) 
Spiked: spiked sample ( ) 
Unspiked: unspiked sample ( ) 

Position Sample position in the autosampler.  
Inj. Vol. Injection volume in µl 
Program Control File (PGM File) 
Method Quantification Method File (QNT Method) 
Status Sample status 

Single: The sample has not yet been processed. 
Multiple: The sample can be analyzed several times 

(the old sample will be overwritten). 
Finished: The sample has already been processed. 
Running: The sample is currently being processed 

(green background). 
Interrupted: The sample was interrupted during 

processing.  
Inj. Date/Time Injection date and time 
Weight Sample weight 
Dil. Factor Dilution factor 
ISTD Amount Amount (quantity or concentration) of the used internal 

standard 

Samples are always processed in the order of their appearance in the 
sample list.  
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1.a) Creating a New Sequence 
The easiest way to create a new sequence is to use the Sequence Wizard. 
As an alternative, you may as well save an existing sequence under a new 
name and then modify the sequence as desired. 

Start the Sequence Wizard to create the basic structure of a sample list. 

Starting the Sequence Wizard  
• Select New on the File menu. 

• From the list, select Sequence (using Wizard). 

• Click OK to start the Sequence Wizard. 

 

A sequence is created in five steps: Each step is performed on a separate 
page. For each page, detailed information is available via the F1 key or the 
Help button. Click Back or Next to toggle between the pages.  

Step 1 
Specify the timebase on which the sequence to be created shall run. Select 
a timebase in the right window section. The corresponding entries for 
Computer and Protocol are automatically made. 
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Step 2 
Create all unknown samples to be processed.  
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• Select Use Template. 

• Enter a sample name and complete the name using the arrow key to 
add, for example, #n. This is to number the samples consecutively, for 
example, sample#n. If you want to inject several times from the same 
vial, it may make sense to use the position number (#p) and the 
injection number (#r) as well (see the example above). 

• Enter the number of injections (Injections per Vial). 

• Specify the position of the first sample (Start position). 

• Specify the sample volume to inject (Injection Volume). 

• Click Apply to display the result of your input in the sample list 
(Sequence Preview). If the result requires editing, for example, 
because the injection volume should vary or individual vials are not 
positioned consecutively, you can change the information manually in 
the Browser after closing the Sequence Wizard. The Rack Preview 
displays the positions of the samples in the rack. 

Step 3 
Create all standard samples to process. 
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• Proceed as described in step 2. In addition, specify any number of 
standards (Variation:) that shall be analyzed after a specified number of 
samples (after each). 

Step 4 
Determine how to process, evaluate, and print the sequence. 

 

• Enter the name and the directory of the PGM File and the QNT File 
to be used in the Program and Quantification Method fields. Or else, 
click Browse... and navigate to the desired file. If you have not 
generated a new PGM File or QNT File before, you can leave these 
fields empty for now.  

• For ion chromatography systems, you can select an application 
template instead. This template provides the appropriate PGM and QNT 
files. First, specify the suppressor type you are using:  
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• For HPLC, IC, and GC sequences, select the DEFAULT.RDF report 
template in the Preferred Report field. The template is provided in the 
REPORT directory of the local database. The Preferred Channel field 
determines the channel for which data are displayed. 

 

 Note: 
You can leave the Quantification Method, Preferred Report, and 
Preferred Channel fields empty here. Any input is optional only. 
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Step 5 
Specify the name for the sequence to create and where to save it.  

 

• Enter any name in the Sequence Name field and select, for example, 
the local data <USERNAME_LOCAL> from the Datasource field. 
Generate a separate sequence directory by specifying a directory name 
in the Directory field (you can also create a new directory). 

 

 Tip: 
Do not use special characters (such as an umlaut) in sequence and 
directory names as this may cause problems in Novell networks! 
 
• On the last Wizard page, click Done to complete your input. 
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1. b) Editing an Existing Sequence 
After you have clicked Done, Chromeleon generates a sequence based on 
the entered information. The sequence is displayed in the Browser. As 
mentioned before, the sequence is a basic structure that needs to be 
adjusted to special requirements.  

For example, if you wish to inject different volumes, you can edit the 
sequence later accordingly. Or else, if you have not specified the PGM 
and/or QNT file in step 4 of the Sequence Wizard, you can select this file 
later. Edit the sequence afterward in the Browser. 
• In the sample list, change individual fields directly via the keyboard or 

open an edit box by pressing the F8 key. 

• You may add additional samples. (Select Append Sample or Insert 
Sample on the context menu. Or else, place the cursor in the last line, 
and then press the arrow down key.)  

• Of course, you can also copy and paste or delete samples via the 
corresponding commands on the context menu. 

 Note: 
If you did not specify a control file when you created a sequence (Step 4 of 
the Sequence Wizard), the Program column cells on the sample list are 
empty! In this case, copy the required PGM File to the sequence directory. 
For each sample, select the PGM File to be used for processing.  

2. Starting the Analysis 
Analyzing one sample can be performed manually. For several samples, 
automatic sample processing is recommended. This requires a PGM 
File, a Sequence, and a Quantification Method (if possible). 

Automatic Sample Processing 
You can start automatic sample processing as soon as the 
chromatographic conditions, the samples to process, and their order have 
been defined during sequence creation. 

Automatic sample processing is also called Online Batch or Batch 
Processing. 
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• Open a Control Panel. Select Edit on the Batch menu. Or else, click the 

following icon on the Online toolbar:  

 
 
• On Batch List tab page, click Add to open the Browse dialog box. 

Under Object of Type, select Sequence from the drop-down list box. 
Select a sequence in your datasource and click Open.  

This action enters the path and the name of the sequence in the Batch 
dialog box. If a sequence contains a sufficient number of samples, 
sample processing is possible around the clock. Instead of listing all 
samples in one sequence, you can create several sequences. In this 
case, enter all required sequence names in the Batch List. 

• Repeat adding sequences until all required sequences are listed in the 
display field. 

The order of the listed sequences determines the order of sample 
processing: When starting a batch, samples 1 to n of the first sequence are 
analyzed, followed by samples 1 to n of the second sequence, etc.  
• Select a sequence and change the processing order by clicking the 

Move Up and Move Down buttons.  
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• Click Ready Check to check whether automatic sample processing 
(batch) is possible; i.e., Chromeleon checks whether all devices to be 
used are ready for use (turned on, connected, lamp switched on, etc.) In 
addition, this action verifies that all data are available and the memory 
capacity is sufficient.  

• Click Start to start the analysis. 

As soon as the online batch starts, all samples of the sequence(s) that 
have the status Single and Multiple (depending on the setting those with 
the status Interrupted as well) are analyzed in the listed order. During a 
running batch, the currently processed sequence is labeled with a green 
triangle in the batch list.  
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VI. Quantification Method (QNT File) 
Objectives of this chapter: 
• To define a method for peak detection and recognition, quantification, 

and evaluation 

• To use this method for many samples and sequence and thus, save 
time  

Introduction 
After a chromatogram has been recorded, you need to integrate and assign 
the peaks first before you can quantify them. It would be a time-consuming 
task to do this in the report for each single sample. That is why all these 
steps are combined and saved in the QNT Method. Nevertheless, it is 
possible to edit a single sample in the report later. However, the better the 
QNT Method evaluates your samples, the less effort will be necessary for 
reprocessing the samples.  

Strictly speaking, the QNT File is required after the analysis only. However, 
we recommend creating the file earlier. This allows you to follow and 
evaluate the course of the analysis. 

Creating a Quantification Method 
• Select New on the File menu. 

• Select Method File as file type and click OK to create a new method. 

 
 



T-52 VI. Quantification Method (QNT File) 

The QNT File Window 
The QNT File window contains various worksheets (General, Detection, 
Peak Table, Amount Table, Peak Tracking, MS Tracking, Calibration, 
Spectra Library Screening, SST, and MS). Open the required worksheet 
by clicking the respective tab on the lower window bar.  

 
 
To create a simple evaluation method, it is sufficient to enter the Peak 
Table settings.  

Creating a Peak Table 
The peak table allows you to recognize peaks (= Detecting Peaks), 
assigning names to the peaks in a chromatogram (= Identifying 
Substances), and converting the determined peak areas into substance 
amounts (= Quantifying Substances and Defining the Calibration Mode 
and Calibration Type). The required information is usually entered before 
the analysis.  
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Saving the QNT File 
Use the Save as command to save the quantification method under a 
separate name.  

Editing the QNT File  
When the QNT File is edited, all changes will be implemented immediately 
in all involved components (only if the Auto Recalibrate check box has 
been selected on the General tab page).  

If you have opened a channel of a specific sample (see: The Browser - 
Appearance and Functions (Part b)) and you see the corresponding 
chromatogram, this representation is updated immediately after changing 
the QNT File. The same applies to the representation of numerical values 
as they appear in any report. 

 Caution: 
If you have not specified a quantification method when creating a sequence 
(Step 4 of the Sequence Wizard), the Method column cells in the sample 
list will be empty! Enter the name of the desired QNT File for each of the 
samples. To evaluate all samples of a sequence with the same QNT File, 
select the QNT File for the first sample, and then copy the entry for all 
entries using the F9 key.  

1. Detecting Peaks (Detection Tab) 
Before peaks can be identified and quantified, they have to be detected. 
Based on default values for the peak recognition algorithm, Chromeleon is 
able to detect even the smallest peaks. Normally, however, you will not be 
interested in these small peaks so that you may want to include certain 
filters to exclude them from being displayed. This and other detection tasks 
are defined on the Detection tab page. 
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Double-click the default parameter (Minimum Area = 0.001 {Signal)*min) to 
open the Edit detection parameter dialog box: 
 

 
 

Frequently used Detection Parameter 

Minimum Area  
Usually, the Minimum Area default parameter will be sufficient as filter. 
Minimum Area defines the area threshold, below which peaks are not 
identified during peak detection or integration. In HPLC-UV, 1.000 
mAU*min usually is an appropriate value. Set the parameter to the desired 
value and click OK to accept the changes. This action usually suppresses 
the small peaks that are of no interest:  
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To add more detection parameters, select the Lines command, and then 
select Append Lines. You can also use the Minimum Height, Minimum 
Width, Maximum Peak Height, and Maximum Width detection 
parameters as additional filters. 

 Tip:  
Changing the Minimum Area, Minimum Height, or Minimum Width 
parameters influences the baseline; changing the Maximum Area Reject 
or Maximum Height Reject parameter does not. If you change the 
Maximum Area Reject or Maximum Height Reject parameters, it may 
happen that the corresponding peaks are no longer displayed. 

Inhibit Integration 
Use the Inhibit Integration detection parameter to disable peak 
integration. If the parameter is set to On, peak detection is disabled. This 
may be useful for disabling the integration of injection peaks. Negative 
injection peaks may cause an undesired baseline; for example the Water 
Dip peak in ion chromatography. Enable the Inhibit Integration detection 
parameter to avoid this effect:  
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If the value is set to On before the first peak to be inhibited, peak detection 
is disabled until the parameter is disabled (Off), i.e., no peaks are 
recognized. The chromatogram is drawn on the screen but it is not 
integrated in this area.  

Inhibit Integration can be used to inhibit the injection peak by enabling the 
parameter at the start time of the chromatogram and by disabling it shortly 
after the void time. (In the above example, the retention time of the 
negative peak is 2.513 min.) 

If the first peak follows shortly after the negative water peak and if the 
retention times of the separate chromatograms show considerable 
fluctuations it may be difficult to set the end time for Inhibit Integration 
exactly. If the end time is set too early or too late, the first peak may not be 
integrated as desired. 

In this case, use the Void Volume Treatment parameter instead. If the 
peak start is still set too early, use the Fronting Sensitivity parameter to 
remedy the situation. 
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 Note:  

The Void Volume Treatment parameter only inhibits integration of the 
negative peak with the lowest signal value. 
 

Detect Negative Peaks 
The default setting is that negative peaks are not detected. Negative peaks, 
for example, the negative water peak in ion chromatography, may cause an 
undesired baseline. Enable the Detect Negative Peaks detection 
parameter to avoid this: 
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To detect a negative peak this switch must be activated before the peak 
start. To correct the baseline without labeling the peaks or including peaks 
in the peak list, select Don't label.  

 Note:  
In the result report, the area of negative peaks is indicated as a positive 
value.  
 

More Detection Parameters 
Use the Rider Threshold and Maximum Rider Ratio detection 
parameters to define the peaks that shall be classified as riders. Use Rider 
Skimming to define how to divide a rider peak from the main peak. 

Besides, you can use the Valley to Valley parameter to enforce valley-to-
valley integration, and the Fronting Sensitivity Factor or Tailing 
Sensitivity Factor parameters to influence the determination of the peak 
start and peak end. 

2. Graphical Input of Detection Parameters 
Click the detection parameter tool to display the position of the detection 
parameters in the chromatogram. 

This is especially useful if you want to change the position of detection 
parameters or graphically insert additional parameters. Use the Detection 
Parameter Tool to change the position of detection parameters. Open the 
tool by selecting the respective command on the context menu or by 

clicking the  icon. In the chromatogram, the parameters are marked by 
a dotted line at which the abbreviation for the parameter and the respective 
parameter value is indicated. For example, the figure below shows the 
values for the Rider Threshold (in short: RidThd), Rider Skimming (RidSki), 
and Maximum Rider Ratio (RidRat) at 1.000 min. Position the mouse on a 
detection parameter in the chromatogram to activate the detection 
parameter tool so that you can move this parameter via the left mouse 
button.  
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To insert a detection parameter at the position of the mouse cursor, select 
Detection Parameters on the context menu:  
 

  
For example, this setting enforces valley-to-valley integration as from the 
selected time. 

You can also enter detection parameters graphically by holding down the 
right mouse button and selecting a chromatogram area. The context menu 
provides the following options: 
• Set Averaged Baseline Start and Set Average Baseline End 

• Set Background Subtraction Range 

• Set Minimum Area  

• Set Minimum Height 

• Set Minimum Width 

• Set Peak Slice & Sensitivity 

• Set Inhibit Integration Range 
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 Tip: 
You can undo the graphical input of detection parameters. Click one of the 
QNT editor tables and select Undo on the Edit menu. (In the 
chromatogram itself, you can only undo changes that were made in 
currently open chromatograms.) In the Detection table of the QNT Editor, 
you may just as well delete the parameters that are no longer required. 

3. Automatically Generating the Peak Table 
You can create the peak table manually by entering the single peak names 
and retention times. However, generating the peak table automatically by 
using the Autogenerate Peak Table command considerably facilitates this 
task. (For more information, refer to Automatically generating the Peak 
Table.) 

Select Autogenerate Peak Table on the context menu. Chromeleon 
automatically generates the peak table and enters the retention times of all 
peaks detected in the currently open chromatogram as set times in the 
QNT Method. You only have to complete the table by entering component 
names and altering the default window and other values as necessary. 
Peaks, which are not of interest, can be deleted from the table. These will 
consequently be excluded from the report if the Including all not detected 
peaks of the peak table parameter in the Integration Report Properties 
has been disabled. (To change the setting of this parameter, select Table 
Properties on the Edit or context menu.) 
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During automatic table generation, the variables described below are set as 
follows: 
• The Peak Names are constructed from the name of the QNT Method, 

for example, in the Anion Qnt method, detected peaks will be assigned 
the names Anion Qnt -1, Anion Qnt -2, Anion Qnt -3, etc. 

• The Window values are entered as absolute values (indicated by the 
suffix A). 

• No Group. 

• The Amount values and the Response Factors are set to 1.0. 

• The Peak Type is Auto (i.e., based on the peak, it is determined by 
Chromeleon). 

• The entry in the Comment column is Autogenerated. 

When you generate peak tables via the Autogenerate Peak Table from 
the Edit menu, all peaks in the chromatogram are usually enumerated 
(type Enumerate peaks of current chromatogram). However, you can also 
use the results of the spectra library screening (see Spectra Library 
Screening) for peak naming (type: Use spectra library screening results).  
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4. Identifying Peaks (Peak Table Tab) 
The Peak Table is used to assign peak names to all peaks of interest in a 
chromatogram. Peaks are typically identified by the retention time. 
However, it is also possible to identify peaks by the corresponding spectra. 
• Select the Peak Table tab to open the peak table.  

• Enter the names of all peaks to be identified in the Peak Name column. 
Assign the expected retention time to each peak in the Ret.Time 
column (= nominal retention time (Tret)). (You can add additional lines 
using the Lines .../ Append Line commands on the context menu). 

 
 
If a peak is detected at the specified time, the name is assigned 
automatically (fig. a). An additional tolerance range for peak detection is 
defined in the Window column (fig. b). The width corresponds to the double 
Window value. To determine the retention time area, this value is added or 
subtracted from the retention time. If a peak is detected in this range, it is 
identified even if the actual retention time does not correspond exactly to 
the entered nominal retention time (fig. c). If several peaks are detected 
within this range, the Chromeleon identifies the greatest, the first, or the 
nearest peak to the retention time (fig. d), depending on the extension of 
the Window parameter. 
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• In the Window column, enter, for example, 0.25 AG, for each peak to 

identify the largest peak within a 30-second window. Time input is in 
industry minutes. For example, the value 1.00 corresponds to 60 s. The 
value 0.25 thus corresponds to 15 s, which means a window range of 
±15 s. The setting 0.25AF identifies the first peak; the setting 0.25AN 
identifies the nearest peak to the set retention time.  

 

5. Quantifying Substances (Amount Table 
and Peak Table Tabs) 
You can use standard samples (sample type: Standard) to quantify 
unknown samples. To do so, you have to enter the known substance 
amount of these standard samples in the amount table together with the 
standard method. Enter this information in the Amount and Standard 
columns. 

Amount Column 
• Search the amount table for the name of the standard substance(s). If 

the required names are not listed, enter the names and the retention 
times as described Identifying Peaks. 

• Move along the line to the Amount column. 

• Enter the amount values of the substances (Substance A, Substance B, 
etc.).  
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Enter a concentration value, such as, µg/µl, or an absolute value,, such as, 
µg. (Enter the used dimension in the Amount Interpretation section on the 
General tab.)  

Multi-Point Calibration 
Multi-point calibration can be achieved by  
• Using different standards with different concentrations 

• Injecting different volumes from a single sample vial  

Different standards with different concentrations  
If standards are available in various concentrations, i.e., in several vials, 
enter the concentrations of all substances to be calibrated in a separate 
Amount column. Do this for each vial from which injection is performed.  
• To add additional Amount columns, select Columns.../Edit Amount 

Columns... on the context menu: 

 

• Standard samples, validation samples, and spiked samples are 
available for this. 

• Click New to create a new amount column. Enter any name of your 
choice.  
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• Select Unassigned from the left list box and then move the desired 
sample to the new column. (For example, Sample 2 in the above 
image.) 

• Enter the concentration value of the second vial in the new Amount 
column. 

 
 
Injecting different volumes from a single sample vial 
If the range to calibrate does not contain several powers of ten, you can 
inject different volumes from the same vial. Chromeleon automatically 
considers the different volumes. In this case, you only need one Amount 
column, as the concentration is constant. 

For this type of multi-point calibration, the decisive column of the sample list 
in the Browser is the Inj. Vol. column. The column could look as follows: 

 

If you enter the Amount as amount value (and not as concentration value), 
make sure that the amount corresponding to the reference injection volume 
is entered in the Amount column. The reference injection volume does not 
have to equal the actual injection volume, i.e., the injection volume 
specified in the sample list of the Browser. Enter the reference injection 
volume on the General tab page of the QNT Editor: 
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"Standard" Column 
The standard method determines how a calibration is performed. A general 
distinction is made between calibrations based on external or internal 
standards.  

An external standard refers to a calibration that is performed based on one 
or several standard samples (normal case). An internal standard is the 
known amount of a standard substance that is added to the unknown 
sample. (The Tutorial provides only a short description for this special case. 
For more information, see Internal and External Standard in the Special 
Functions section.) 
• Make sure that the correct standard method for each peak to calibrate is 

entered in the Standard column (= External = default value).  

For information about further calibration options (Internal or 
Internal/External), see the online Help or the User Manual (for example, in 
the Calibration section).  

Further Columns  
All other peak table columns determine how the determined area values 
are converted into the resulting substance amount values. Generally, the 
standard settings can be used. No changes are required. 

Verify that the following default settings in your QNT Method are correct for 
your application:  
• Calibration Type = Lin 

• Integr. Type = Area 

• Response Factor = 1,000 
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6. Defining the Calibration Mode and 
Calibration Type 
The Quantifying Substances topic already described the basic elements 
of the calibration with Chromeleon. However, Chromeleon provides many 
more calibration functions. The complete description of these functions 
would go beyond the scope of this Tutorial. Nevertheless, the most 
important functions are described below. 

Calibration Mode 
The calibration mode allows you to define which standard samples shall be 
used for calibrating which unknown samples. Define the calibration mode 
on the General tab page. The following options are available: 

 

Select the Total mode to use all standard samples for calibrating all 
unknown samples. Use the Fixed mode to use certain standards (also from 
previous sequences) for calibrating all unknown samples. Select the 
Standard Addition mode to analyze unknown spiked or unspiked samples. 
For more information about the Group, Additional and Bracketed modes, 
see below: 
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Calibration Type 
The calibration type defines and weighs the calibration function to be used 
as necessary. Enter the calibration type on the Peak Table tab page of the 
QNT Editor: 
• Press the F8 key in the Cal.Type column to open the Calibration Type 

for <Peakname> dialog box. 

 

• In the Calibration Function section, select a calibration function for the 
current peak. This is usually the Linear or Linear with Offset function (if 
the calibration function does not pass the origin). However, quadratic 
and exponential functions and a polygon (Point-to-Point) through the 
calibration points are available as well. 

• In the Weights section, define the weights for the single calibration 
points. If you selected No Weights, higher amounts/signal values are 
weighted more. Select 1/Amount or 1/Response for proportionate 
weighting of small and high amounts/signal values. Select 1/Amount^2 
and 1/Response^2 to weight smaller values more than high values. 
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• In the Further Options section, more options are available. Select 
Average all response values for each calibration level before curve 
fitting to average the calibration points of each calibration level before 
calculating the calibration curve. Select Include point (0.0) for curve 
fitting to include the origin as calibration point into the calibration if you 
selected a calibration function with offset. However, this does not mean 
that the calibration curve runs through the origin. 

• Special rules apply to calibrations that use the Standard Addition 
function. For more information, refer to the corresponding sections in the 
Chromeleon online Help. 
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VII. Data Analysis 
Objectives of this chapter: 

• To describe the chromatogram, calibration curve, and spectra views 

• To display the sample results in report tables 

• To evaluate and edit single chromatograms  

Introduction 
Chromeleon allows you to display sample data under various aspects. You 
can: 
• Display a single chromatogram.  

• Compare several chromatograms.  

• Check the peak purity.  

• Display calibration curves.  

• Search single spectra in a spectra library.  

Each action is performed in a separate window or pane. Each pane is 
intended for a specific task and has its own window arrangement and menu 
structure.  

Data Representation 
To display data, select the corresponding data first: 
• In the Browser, click the sequence of interest. 

• Open a sample in the sequence by double-clicking the sample name.  

• The sample opens in the Integration window. The Integration window 
usually displays the chromatogram and the report table. Sometimes, 
only the chromatogram is opened. This depends on the report definition 
file (RDF): 
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Use the icons on the Method toolbar to quickly change from one view to 
another: 

 
 
The first five icons open a separate window each: 
• Integration (opens the screen report and displays the results of the 

analysis) 

• PPA (opens a window that displays the data of a diode array detector) 

• QNT-Editor (opens the view for editing the quantification method) 

• Printer Layout (opens the view for preparing the printout) 

• Signed Results (opens the signed results for the current sample) 
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The following icons open an additional part window:  
• Show Report (displays the report table) 

• Show Trend (displays the trend plot--changes of variables are 
graphically displayed from sample to sample) 

• Show Chromatogram/Split Zoom (displays the chromatogram in two 
panes: complete view and enlarged view) 

• Show Spectra (displays the UV spectrum) 

• Show Calibration Curve (displays the calibration curve) 

• Show Mass Spectra (displays the mass spectrum) 

Click the four icons on the very right to:  
• Display the Previous Chromatogram or the Next Chromatogram 

• Display the Previous Channel or the Next Channel 

The Integration window is the most important window for data 
representation. For more information, see The Integration Window 
below. For information about the QNT Editor and the Printer Layout 
windows, see the associated sections in this Tutorial. 
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1. The Integration Window 
• To open a sample chromatogram, double-click the sample name in the 

Browser. In the easiest case, you will only see the chromatogram of the 
sample. For example: 

 

• Select Decorations on the context menu to change the appearance of 
the chromatogram. You can change the captions, axis ratios, and 
coloring as well as the actual chromatogram representation (display of 
peak heights, additional chromatograms, or grid).  

• Double-click an individual peak to display its properties: 
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• Select a peak and click on the corresponding icons to display the 
Spectra Plot and the Report.  

 

If the analysis was performed with a diode array detector, the spectrum of 
the selected peak, for example, anthracene, is displayed on the top right; 
the lower section displays part of the integration report (four lines, the line 
with the currently selected peak is highlighted by a different background 
color). You can change the Spectra Plot window via the Decorations 
command as described above. Select Decorations to display the available 
options. This command also minimizes the spectrum in the chromatogram.  

The displayed default report contains information about various 
parameters. Each worksheet has a number of default variables that are an 
integral part of the specific report type. For example, the integration report 
contains the Ret.Time, Area and Amount columns; the calibration report 
includes the Offset (c0), Slope (c1), and Curve (c2) columns, etc.  

Double-click a peak name in a report window to change the selection of the 
current peak. Instead of anthracene, pyrene is highlighted by a different 
color. The spectra representation is updated as well.  
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2. Modifying the Chromatogram 
In some cases, it may be useful to change the sample integration that was 
performed manually, for example, by moving peak delimiters. To do this, 
use the icons on the Integration toolbar:  

 
Use the Automatic Tool to perform the most important actions. The shape 
of the mouse cursor indicates the performed action. 
 

   Move left/right peak delimiter 
     Change baseline point (left/right/center) 
     Move baseline point (left/right/center) 
 Move perpendicular line 
 Move baseline segment 

 Change retention window 
 Move detection parameter 
 Insert peak 
 Display spectra 
 Zoom out an area 
 Action not possible 

 
The action that can be performed at the current position is indicated on the 
status bar. 

Example: 
The mouse cursor changes its shape when it is near the blue peak 
delimiters.  indicates the peak start, while  marks the peak end. 
• Left-click to change the integration limits of a peak by moving the peak 

delimiters.  

It is not possible to "run over" another peak delimiter. After moving a peak 
delimiter, Chromeleon draws a new baseline between the peak start and 
the peak end. All peak properties such as area, width, substance amount 
etc. are recalculated. The integration report is immediately updated.  
• Select Save Manipulations on the context or Edit menu to save the 

reprocessed results.  

Similar to moving peak delimiters, you can perform other actions. For 
example, you can insert or delete peaks or change the baseline. 
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3. Report Tables  
The default report (default.rdf) contains five tabs. The Integration tab 
mentioned above describes the general characteristics of the respective 
peaks in the current sample such as the Ret. Time, Area, and Amount 
columns or the concentration of the respective substance. The Calibration 
tab displays the calibration data of the current sample: 
 

 
The Calibration tab page includes by default: 
• The calibration type and the number of calibration points in the 

calibration curve 

• The relative standard deviation (of the points from the calibration curve) 

• The correlation coefficient (independent of the calibration curve) 

• The calibration curve parameters (Offset, Slope, and Curve) 
 
The Peak Analysis tab provides a summary of the characteristics of the 
single peaks such as the peak width, peak height, peak type, resolution, 
asymmetry, and the number of theoretical plates. 

In contrast to the first three tabs, the summary includes all samples in the 
sequence: 
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The Summary always refers to the current peak. To display the summary 
for any other peak, click the corresponding peak in the chromatogram. 

The last report tab (Audit Trail) displays the corresponding sample 
protocol: 
 

 
 
It lists all commands sent to the corresponding timebase during the 
analysis including time and retention time. 
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4. Modifying a Report Table 
The individual report sheets are designed such that they contain the most 
important peak and sample characteristics for most applications. 
Nevertheless, it may be possible that you do not need an existing column 
or that you want to add a new one. 
• Double-click the column to be changed. The Properties Report 

Column dialog box is opened: 

 

The report columns are listed under Categories. Under Variables, all 
result variables calculated and evaluated by Chromeleon are listed. Select 
a variable to display its properties (Formula, Header, Dimension, Format). 

Header shows the text of the column header. Dimension shows the 
dimension name. Format defines the number of decimal places. Select the 
Selected Channel option to display the values of the current channel. Or 
else, select Fixed Channel to display the data of a specific channel 
independently of the representation in the integration window. 
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• Click OK to replace the selected column with the newly defined column.   

• Select a column, and then select Delete Column(s) to remove the 
column.  

 Note: 
These report options influence the on-screen representation only. In the 
Printer Layout, define the appearance of the printout! 

5. Saving Changes 
Select Save Report Definition.. to save all changes within a report as a 
separate report definition file (RDF). The arrangement and the appearance 
of the individual report window sections are saved plus the variables to be 
displayed.  

With each new start of Chromeleon, the report opens just as it was saved 
last. If you have created your own Report Definition Files (RDF), you can 
select a different appearance via Load Report Definition. 
Keep in mind that each sequence is saved with a preferred profile. Upon 
opening a sample of the corresponding sequence, it is not the appearance 
of the window saved last that is used but the appearance of a specific 
report definition file (RDF). Proceed as follows to define a sequence for a 
preferred report: 
• Select a sequence in the Browser and then select Properties on the 

context menu.  

• Under Preferred RDF File, enter the name of the report definition to 
load. 
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VIII. Printing Results 
1. Creating a Print Template (Printer 
Layout) 
The Printer Layout window displays custom print templates. To open a 
print template for a specific sample:  
• Double-click a sample name in the Browser. Chromeleon displays the 

chromatogram in the Integration plot window. 
• Select Printer Layout on the View menu to change from the 

Integration plot to the Printer Layout.  

 Tip: 
The Method toolbar allows you to quickly change from one view to another 
(for more information, see Data Analysis). Place the mouse cursor on an 
icon to read its label in the quick info field.  
 

 
The image shows part of a report based on the default report template 
(DEFAULT.RDF): 
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The Integration, Calibration (Curr. Peak), Calibration (Batch), Peak 
Analysis, SST, Summary, and Audit Trail worksheets are part of the 
DEFAULT.RDF report template. 
• Select one of the tabs on the window bottom to open the corresponding 

sheet of the report. 

The appearance and the structure of the individual worksheets are very 
similar to Microsoft Excel spreadsheets. Each sheet consists of a large 
number of columns (256) and lines (16000) and thus is much larger than a 
single printed page. A worksheet can consist of many horizontally or 
vertically arranged printed pages. Chromatograms or tables that exceed 
one printed page are automatically printed on two or more pages. Define 
the order in which the pages are printed in the Page Setup (on the File 
menu).  

 
 

Editing an Existing DEFAULT.RDF Template 
It is less effort to change an existing report template than to create a 
completely new one. Different templates, such as the DEFAULT.RDF and 
the DEFLTDAD.RDF templates, are available on the Chromeleon software 
CD. Copy any template you wish to use as the basis for a new template to 
a different and writable directory.   
• Select Save Report Definition on the context or Workspace menu and 

save the template to a different and writable directory.  

You can now edit and save the copied template. For information about how 
to proceed and the available options, see below. For more information 
about the individual steps, refer to How to ...: Actions in the Window 
Printer Layout section in the User Manual or the online Help. 
• Select Layout Mode on the Edit menu.  

• Select the worksheet you wish to edit or add an additional (empty) 
worksheet by selecting Insert Sheet on the Edit menu.  

• Select Delete Sheet on the Edit menu to delete an unnecessary 
worksheet. 

• Double-click a tab page to change its name, for example, Integration 
Special. 
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• Select Insert Row(s)/Column(s) or Delete Row(s)/Column(s) to add 
or remove single rows or columns on the worksheet. 

• Select a field, a column, or an area, and select then Clear ... on the 
context menu to remove unnecessary information from the worksheet.  

Having removed all unnecessary parts, you can fill cells, columns, or areas 
of the worksheet with new contents. You can either use the Windows 
clipboard (copy & paste) or the Insert ... command from the context menu. 
Follow the steps below: 
• Select Insert ... to further specify the desired command, for example: 

• Insert ... Chromatogram inserts a chromatogram. 

• Insert ... Calibration Plot inserts a calibration curve. 

• Insert ... Spectra Plot inserts a UV spectrum, etc.  

• Use the small cross to mark the area where to insert the desired 
element. The element is automatically inserted at the desired position. 

• If you want to insert a report table or a single report variable, mark an 
empty field first. Then, use the corresponding command to insert the 
table or variable at the selected position. 

• Report columns can be inserted only in existing tables.  
 
• Select Save Report Definition on the context menu or the Workspace 

menu and save your changes. 
 

2. Printing 
Printing in Automatic Batch Operation 
You can start printing the results during automatic sample processing 
(Online Batch). Make the corresponding settings in the Batch dialog box. 

• Select Reporting on the Batch menu in the Browser or on a control 
panel.  

• Enable the Print/Export Report check box to print or export the sample 
processing results.  

• Select Print each sample immediately to start printing immediately 
after the sample has been analyzed. Select Print when the entire 
batch has finished to print all sample results after the entire sequence 
is completed.  
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• To specify the report type and the extent of the printed output, click the 
Report Setup button. The Batch Report dialog box is opened:  
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Select a report template in the Use Report Definition field. The default 
report Chromeleon templates, i.e., DEFAULT.RDF and DEFLTDAD.RDF, 
are available in the Dionex Templates > Reports directory. 
• From the With Selected Channel field, select the channel to print, for 

example, UV_VIS_1. If the field remains empty, the preferred channel is 
printed (see The Browser: Appearance and Function (Part b)). 

• Select the Printout option to print the sheets.  

• The Printer field shows the name of the previously selected default 
printer. Select Setup to select another printer.  

You have now specified the channel, the printer, and the report definition 
for the printed output. The Printer Layout allows you to determine the 
appearance of the report and to specify the information to be printed. 

As described in detail in the Creating a Print Template (Printer Layout) 
topic, a report template contains several special sheets for different print 
data. The sheets included in the selected report template are listed in the 
Selected sheets to be printed field. The Integration, Calibration 
(Curr.Peak), Calibration (Batch), Peak Analysis, Summary, and Audit 
Trail sheets are included in the default report template. 
• Under Selected sheets to be printed, select the worksheets of the 

report template you wish to print.  

• Determine for each worksheet whether all samples or only samples of a 
specific type shall be printed.  

• Select Print for every sample to print the results for each sample.  

• Select Print under certain conditions to print the results only when a 
certain condition is met (for example, only for a specific sample type). 

For example, if you want to print the Calibration (Batch) worksheet for the 
last standard sample only, select the Print under certain conditions 
option and then click Conditions. In the dialog box that opens, enable the 
Last Sample in a List of Standards check box. 
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• Click OK to return to the Batch Report dialog box and define the other 

worksheets. 

• Click Start as described in Starting the Analysis to start sample 
processing. 

Printing Samples 
Of course, sample-processing results can also be printed independently of 
the online batch. This applies to all samples for which raw data are 
available. Chromeleon assigns Finished as sample status in the sample 
list. Proceed as follows to print the results of any samples.  
• Open the Browser and select Print Setup on the File menu. Select a 

printer for printing the results and exit the dialog box by clicking OK. 

• Select the name of a sequence to print the results of all included 
samples.  

• If you only want to print specific samples of a sequence, select them 
one by one with the mouse. Simultaneously press the CTRL key and 
left-click to select several samples. 

• Select Batch Report... on the File or context menu and determine how 
to print the report (see Printing in Automatic Batch Operation). 
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IX. Special Functions 
In the previous chapters, the Tutorial described the basic Chromeleon 
functions. Most users for routine operation use these functions. In addition, 
Chromeleon provides many special functions that can save time for special 
operations. However, these functions will certainly not be relevant for all 
users.  

Below please find a short introduction to the most important special 
functions and the actions they perform: 

In the Browser: 
Installing Datasources 

Finding Samples (Query) 

Backup and Restore 

Signing Sequences Electronically 

On the Control Panel: 
Modifying a Control Panel 

In the QNT Editor: 
Internal and External Standards 

Spectra Library Screening 

In addition: 
Defining the Workspace 

 

1. Installing Datasources 
Datasources represent the top level in the Browser. Each user can access 
at least one datasource that is the default datasource created during 
installation (<PC-NAME_LOCAL>).  

Creating additional datasources or accessing datasources on other 
computer in the network is often useful. Therefore, these options are 
supported as well. The section below describes how to create links to other 
datasources (For more information about how to create a new datasource, 
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refer to How to ...: Actions in the Browser/Setting up a Datasource in 
the User Manual and the online Help).  

All steps required for setting up datasources start with the Datasources 
command on the File menu. 
 
• Open the Browser and select Datasources. 

The Datasource Manager shows all datasources that the client can 
currently access.  

 
 

Connecting an Existing Datasource ("Connect") 
If you know the directory in which the other datasource is located, you can 
connect to this datasource.  
• Click the Connect button of the Datasource Manager to establish the 

connection.  

• Select the format of the underlying database.  
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Usually, you will select Chromeleon datasources (Native Chromeleon 
Data Source). Other supported formats include default Microsoft Access 
databases (mdb container), SQL server, and Oracle databases. 
• Select the appropriate datasource type and click OK. 

• In the following dialog box, navigate to the network folder that houses 
the datasource.  

 
 
• Select the folder and click Open.  
 

 Note: 
If the folder and the datasource are located on a remote computer, the user 
of that computer must share the corresponding folder! If (s)he does, you 
can connect to the selected datasource. The name and the type icon of the 
datasource will appear in the Browser. 
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2. Finding Samples (Query) 
You will often have to find samples according to defined problems. Instead 
of endlessly poring over old folders, you can use the query function of the 
Browser to do so easily, fast, and purposefully. Select New on the File 
menu to start the Query Wizard: 

 

On the first query page, define whether to perform the query in the current 
datasource or in a fixed one. Also, define whether to search for sequence 
properties, sample properties, or any other properties of samples.  

On the next pages, define in the Data Field the variable whose properties 
you want to find. Select an operator and define the value. The combo box 
next to the respective line allows you to enter a logical connective with 
another query property. Only after having entered AND or OR, you can 
enter another property: 
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The following query searches for all samples with  
• Sample type = Matrix Blank and 

• Whose comments start with Charge 123456 or 

• An injection date between 2/2/2000 and 2/3/2000. 

On the next page, enter the following settings in order to restrict the query 
to samples  
• Containing an Anthracene peak or 

• Containing more than 10 calibration points 

 
 

3. Backup and Restore 
In the course of time, large amounts of data will result, especially when 
PDA detectors are used, but also when a great number of sequences is 
recorded. To ensure that you can continue to store data on your hard disc, 
you have to delete some of your data from time to time. However, do not 
destroy these data permanently. They still have to be available for future 
use. Of course, you can save the respective sequences and datasource on 
your network as well. 
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However, Chromeleon provides the possibility to backup sequences, 
directories, or entire datasources and save these backup files (which can 
also be compressed), for example, on CD. Proceed as follows: 
• Select the object to save. 

• Select Export/Backup on the File menu and then, select Backup.  

• Indicate where to save the backup file and define all further backup 
options: 

 
• Start the backup to create the backup file. The extension of the backup 

file is cmb. 

• You can then, for example, burn the backup file to a CD or attach it to 
an Email. 

Data that were saved in this way can be used again via the Restore 
function. Select Import/Restore on the File menu, and then select 
Restore. Find the respective backup file and indicate where to restore it. 
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The Backup and Restore functions are an easy way to save large amounts 
of data in such a way that they can be quickly accessed later. Structure and 
cross-references remain intact. In addition, these functions facilitate 
exchanging data via E-mail. 
 

4. Signing Sequences Electronically 
Electronic Signature allows you to sign the results that have been 
generated from your Raw Data. This function is important aspect for 
quality assurance and GLP. When User Mode is enabled, you can sign and 
protect Sequence reports that have been accepted as correct. In this 
way, it is possible to review and reproduce the results at any time later.  

Electronic Signature includes three steps: 
• Submit  

• Review 

• Approve 

Typically, the user who created the report signs and submits it. Afterward, 
for example, the laboratory manager reviews the report and signs it as 
well. Finally, the quality assurance manager approves the results.  

 Note: 
Enable User Mode. If User Mode is disabled, electronic signature will not 
be possible. Besides, electronic signature is available only for user 
databases that have been created with a CmUser program version 6.10 or 
higher. Update your database if an error message notifies you that 
electronic signature will not be possible. 

To sign a sequence proceed as follows:  
• Click the sequence and select Submit Results (first signature step) on 

the context menu. 

• Select the Report Definition file (RDF) to be used for displaying the 
sequence, select the channel for which you want to show the results, 
and select the report sheets to be signed: 
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• The Check Signed Results dialog box appears. This dialog box allows 
you to check the report to be signed. Use the arrow keys to toggle 
between different sequence samples. For each sample, the tab pages 
for the selected report sheets are displayed. Click OK when you have 
finished checking the report.  
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• The Submit Signature dialog box is opened. To sign the SOR file, 
enter your User ID and the signature password: 

 

• The extension of the newly created file is .SOR. The SOR file is stored 
in the signed sequence. 

• In this way, the sequence and its samples are protected against 
changes. 

• Select Electronic Signature on the File menu and then select Verify to 
have Chromeleon check the signed sequence report once again, i.e., 
the sequence, the corresponding files (pgm, qnt, rdf, sor), and the 
individual samples. 

To view the signature status of a sequence, select the sequence and select 
Properties on the context menu. The Signature tab page indicates the 
status of the selected sequence: 
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You can only remove a signature if you are authorized by the 
corresponding privileges. Removing the signature also deletes the 
corresponding SOR File.  
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5. Modifying a Control Panel  
Chromeleon includes more than a hundred default control panels for 
different devices and functions. If you do not find a control panel for your 
requirements, we recommend modifying the panel that is closest to your 
requirements. You can add further controls or change the functionality and 
appearance of existing ones.  

 Note: 
If you cannot perform the following steps, you do not have the user 
privileges required for these actions. In this case, contact your system 
administrator. 

Enabling the Layout Mode 
• Enable Layout Mode on the context menu. You can modify the control 

panel only in the Layout Mode. 

Adding a control 
• Move the cursor on the Layout toolbar. 

 

• The Quick Info provides a brief description for the control on which the 
cursor is currently positioned. 

• Select a control by clicking. The corresponding object is now attached to 
the cursor.  

• Place the cursor on the location where to add the new object and left-
click. 

Functionality and appearance of the control  
• Right-click the control for which you want to change the functionality 

and/or appearance. 

• Select Properties to open the Properties dialog box. 
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Depending on the selected control, the Properties dialog box includes 
various tabs. For a slider, the Style tab looks as follows:  

 

• Select the General, Color, or Style tab to change the appearance such 
as the color, the shape, or the caption of the control.  

• Select the Link tab to determine the function and the instrument to be 
operated via the control. 
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• From the Object list, select the instrument itself. From the Object 
Property list, select the instrument's function. Instrument and function 
selection depend on the components installed with the timebase.  

With the settings shown above, you can use a slider to control the pump 
flow rate.  

6. Internal and External Standards 
Substances in unknown samples are usually quantified using external 
standard samples. However, it is also possible to add a known amount of a 
standard substance (= internal standard, ISTD) to an unknown sample and 
then use this standard for calibration. Use the Standard column on the 
Peak Table tab page to specify whether you want to calibrate a substance 
using an external or internal standard. 
• Press the F8 key to open the Standard Method for <Peakname> 

dialog box. 

 
• Select External to use external standard samples for calibration.   

• Select Internal to use internal standard samples for calibration.  

• If you use several sample preparation steps during which substance 
may be lost, correct this using the Internal/External method: Add to 
your unknown sample a known amount of a substance that originally 
was not part of the sample (= ISTD). Be sure that the chemical behavior 
of the substance is similar to the behavior of the substances to quantify. 
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During sample preparation, a corresponding amount of this standard 
substance will be lost as is for the substances to quantify. In this case, 
you can use the known internal standard in the Internal/External 
method to correct the external calibration. First, define a substance as 
internal standard (Use this peak as Internal Standard) and then use 
this substance as Associated ISTD Peak. 

• If you did not add exactly the same amount of internal standard to all 
samples, select the Use sample amount as reference option. In this 
case, you have to enter the amount of internal standard that was added 
to the sample in the sample list of the Browser. This entry is then used 
for the calculation (instead of the entry made in the Amount column of 
the QNT editor).  

For an example of the possible settings in the Standard column, see the 
image below: 

 

Dimethylfluoranthene and Chrysene are calibrated, using external 
standards. Naphthalene and Fluoranthene are used as internal standards 
with Naphthalene being used for internal calibrations and Fluoranthene for 
internal/external calibrations. Phenanthrene and Anthracene are calibrated, 
using Naphthalene as internal standard, whereas the internal/external 
method is used with Fluoranthene as internal standard to quantify Pyrene. 

7. Spectra Library Screening 
The Spectra Library Screening tab page of the QNT editor allows 
searching spectra libraries for reference spectra for the different peaks of 
the current chromatogram. As the chromatographic conditions considerably 
influence the spectra, we recommend filling your spectra library with 
spectra from chromatograms that were recorded under the same conditions 
as the current chromatogram. 
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 Note:  
To create a new library, select New on the File menu in the Browser and 
then copy the desired spectra in the spectra plot (Ctrl + C) and paste them 
into the library (Strg + V). 

On the Spectra Library Screening tab page, select the spectra library in 
which to search for the reference spectra. In addition, enter the comparison 
criteria for the spectra search. Normally, the default values of the Match 
Criterion (Least Squares) and Hit Threshold (950) will be sufficient. 
However, you can also specify many additional search criteria.  

 

Click Apply to start the spectra search. The retention spectrum of the 
actual peaks is compared to the reference spectrum that was found. To the 
top right of the spectra plot, the corresponding match factor is displayed.  
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The match factor indicates the correspondence of the two spectra. A value 
of 1000 indicates that the spectra are identical. If the match factor were 0, 
they would be completely different. If no corresponding spectrum is found 
based on the selected criteria, the following message appears: No spectra 
library hits found! 

 Note: 
You can use the spectra library screening results for automatic peak table 
creation (see Automatically Generating the Peak Table). 

8. Defining the Workspace 
Chromeleon allows you to save the window arrangement of any work 
situation, i.e., the combination of different windows, in a workspace.  

This facilitates opening single files or windows and allows you to work in 
whatever work environment you prefer.  

The information about the windows involved is stored in a WSP file. If you 
want to start working using a specific workspace, open the corresponding 
WSP file or generate it by storing the screen contents. The following 
commands are available on the Workspace menu: 
• Select Open Workspace to open an existing workspace.  

• Select Save Workspace to save the current workspace.  

• Select Save Workspace as to save the current workspace with a new 
name.  

• Select Autosave Workspace to always save the most recent 
workspace as the default workspace.  

There is no restriction on the number of windows that can be saved with 
each workspace 

A useful workspace arrangement might combine, for example, the report, a 
control panel, and the Browser (refer to the picture). 
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 Tip:  
When Chromeleon is started, the most recently used workspace is loaded. 
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Addendum: Keyboard Shortcuts + 
Short Glossary 

Quick Access Keys (Shortcut Keys) 
Quick access keys and/or shortcut keys are provided for many operations, 
especially in online control:  
 
 Action Where Description 
General ESC or  

right-click 
 Aborts the drag/move 

action. 

 F1 
F2 

 Opens the context-
sensitive Help; 
Enables the Edit mode. 

 F3  After the Find command: 
Find Next. 

 F4 
SHIFT+F4 
 
Alt+F4 

Chromatogram Takes you to the next 
sample. 
Takes you to the previous 
sample. 
Exits Chromeleon. 

 F5 
F6 
 
SHIFT+F6 

 Updates all windows. 
Takes you to the next 
partial window. 
Takes you to the previous 
partial window. 

 F10 
SHIFT+F10 

 Takes you to the next 
channel. 
Takes you to the previous 
channel. 

 F7 
 
SHIFT+F7 

Browser (F7 
key only) + 
QNT Editor 

Optimizes the column 
width. 
Optimizes the line height. 

 F8 
F10 or ALT 

 Opens an edit dialog box 
for the respective field. 
Shows the hotkey 
underlines. 
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 Action Where Description 
General 
(Cont'd) 

SHIFT+F5 Browser Displays the 
chromatogram. 

 ALT+ENTER Browser + 
Control Panels 

Opens the associated 
Properties. 

 CTRL+TAB  Toggles between open 
windows.  

 CTRL Signal plot in 
the report and 
in the QNT 
Editor 

Allows zooming (the cursor 
becomes a zoom cursor). 

 CTRL+N 
CTRL+O 
CTRL+S 
CTRL+R 
CTRL+P 

 
 
 
 
Report + Printer 
Layout 

Creates a new file. 
Opens the file. 
Saves the file. 
Opens the batch report. 
Prints the selected 
object(s). 

    
Edit CTRL+Z 

CTRL+Y 
CTRL+X 
CTRL+C 
CTRL+V 
CTRL+F 
F3 
 
CTRL+H 
F9 
 
 

 Undoes the previous 
action. 
Repeats the previous 
action. 
Cuts the selected 
object(s). 
Copies the selected 
object(s). 
Pastes the selected 
object(s). 
Finds a string of 
characters. 
Finds the next string of 
characters. 
Replaces the entry in the 
field. 
Fills the column and/or 
selected cell(s) with the 
first value of the selection. 
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 Action Where Description 
Edit 
(Cont'd) 

INSERT 
DELETE 

 Inserts the selected 
object(s). 
Deletes the selected 
object(s). 

    
Sample List CTRL+I 

CTRL+D 
CTRL+A 

 Inserts a sample. 
Deletes a sample. 
Adds a sample. 

    
Control CTRL+F 

CTRL+I 
CTRL+Break 
Break 
Ctrl+A 
Ctrl+B 

 Changes the pump's 
settings 
Injects 
Stops the pump. 
Turns on the Hold mode. 
Turns on data acquisition. 
Edits the batch.  

    
Signal plot Double-click... - Overview 

window  
- Time axis 
- Signal axis 
- Plot range 
(- or else:…) 

Unzooms. 
Auto Plot Speed 
Autoscale 
Signals... 
Axis/decoration 

 SHIFT - when zooming Retains the scale ratio 
between signal and value 
axis. (The shape of 
chromatograms is 
maintained.) 

    
Gauge/ 
Slider 

CTRL key Press when 
dragging 

Toggles the Snap To 
Scale option. 

    
Script 
Button 

Click Button 
 

Indicates whether the 
program is still running. 
Stops the program upon 
confirmation.  
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 Action Where Description 
Edit Field TAB/ENTER  Sends the new value. 
 ESC  Aborts the input.     
Layout 
Mode 

ALT + Click On the selected 
panel 

Draws a selection frame 
on the control panel. 

 ALT + Drag  Temporarily toggles the 
Snap To Grid option. 

 ESC  Deselects all. 
 ARROW keys  Drags the selection pixel 

by pixel. 
 SHIFT + 

ARROW keys
 Increases/reduces the 

selection pixel by pixel. 

 SHIFT+SELE
CT 

 Extends the selection.  

 CTRL+SELE
CT 

 Highlights the selected 
control (the highlighted 
control is used in Align..). 

 CTRL+Drag  Copies controls. 
 Double-

clicking 
On the online 
signal plot on 
the control 
panel 

Opens the Properties 
dialog box. 

 

Datasource and Database 
A database that is mounted to the Chromeleon client is referred to as a 
datasource. To mount a datasource, select Mount Datasource on the File 
menu in the Browser and then specify the format and location of the 
database. 

During the initial installation of Chromeleon, a local default datasource is 
created on each client PC. In network operation, the datasource name is 
composed of the computer name and the extension LOCAL (<PC 
name>_local). On a local station that is not available on a network, the 
name stated under Control Panel > Network > Identification in the 
operating system is used. If no identification is entered, the datasource is 
named DEFAULT_LOCAL. 
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Chromeleon data is usually stored in an Access database, that is, in an 
MDB (Microsoft Data Base) container. The default datasource is based on 
an Access database, too. The ODBC capability of Chromeleon allows you 
to use various other formats (SQL, Oracle, etc.) as well. Both, Sample data 
and Sequence data are saved in a datasource, independently of the 
chosen format. You can save a database on a local hard disk or any other 
mass storage device. 

Select New Directory on the File menu in the Browser to create individual 
subdirectories under a datasource. You can then use these directories to 
save Sequences and the corresponding data and programs. 

If the datasource is located on a centralized network PC, all clients with the 
appropriate access rights, which have been assigned by the system 
administrator, can access the database. If the datasource is stored on a 
local hard disk, the corresponding client grants database access via the 
Windows File Sharing option. Chromeleon also allows you to lock 
datasources, directories, or sequences. 

Raw Data 
Raw data refers to all analog and digital data points that are digitally stored 
on a PC. That is why raw data exists for signals or channels only selected 
by the user before data acquisition. 

The scope and accuracy of the stored raw data depends on the selected 
Sampling Rate, the Step, and the resolution of the detector signal. 

Sequence 
A sequence combines samples that belong together due to their origin or 
processing. The names of all samples belonging to one sequence are 
entered in the sample list (also called sequence table). Thus, a sequence is 
a container for various samples. 

Theoretically, the number of samples is not limited, but use more than 100 
sample entries in exceptions only. Create additional sequences to reduce 
the number of samples included in one sequence and thus to accelerate 
access to the individual samples. In this way, it is also easier for you to 
keep track of the processed samples. 

The sequence table also defines how to process a sample. It includes 
information about the sample itself (name, injection volume, position, 
sample weight, dilution factor, etc.) and references chromatographic 
methods that specify the program (PGM File) to be performed for the 
analysis and the evaluation parameters to be used (QNT Method). 
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The entire data collected in connection with creating and processing a 
sequence is saved in the associated sequence. This also includes the raw 
data and protocol data recorded during the analysis. 

Similar to Datasources, sequences can be "locked." In this status, data 
and results are read-only. You cannot modify or extend them. 

(Chromatography) Server 
PCs connected to the components of a system via interfaces can be used 
as chromatography servers. 

A chromatography server is automatically installed on the PC during 
installation. The chromatography server controls the data exchange 
between the chromatographic system and the PC. Upon starting, each 
server is capable of serving up to six controlled or 16 non-controlled 
systems ( Timebases). The server receives the commands that have 
been entered on the control panel of a client PC and executes them at the 
specified time, for example, by transmitting them to the corresponding 
device driver of the HPLC system. The server also assumes this function in 
the opposite direction. Thus, the raw data of each system is stored at the 
location specified by the client and the entire system-relevant data is 
forwarded to the client. 

Configure the server and install the timebase(s) in the Server Configuration 
program. 

If the Chromeleon server and client software are located on the same PC, 
the installation is called a local installation or referred to as workstation. If 
they are not, the installation is called network installation. 
 

 Tip: 
In case of manual data acquisition, Raw Data is always stored in the 
manual sequence of the timebase directory (if not otherwise defined). This 
directory is available only in the local datasource of a local installation. In 
the case of a batch, the user can decide where to store the data.  
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Timebase 
All components that are combined in a chromatography system to enable 
the chromatographic separation and related in a time context with each 
other are assigned to the same timebase. 

A timebase can be a very complex system. For example, it can consist of 
two pumps, one autosampler, one column oven, two detectors switched in 
series, and one fraction collector. However, an isolated gas chromatograph 
can also represent a timebase.  

Any other system that is completely independent from the first one 
represents a new timebase. Administration of different timebases is on one 
or several Chromatography Servers. 

Create your timebase(s) in the Server Configuration program.  
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Introduction 

Using the User Help and Manual 
• Although the User Help section of the Chromeleon online Help and the 

User Manual differ only slightly in content, they are intended for 
different situations. 

• Refer to the User Help section in the Chromeleon online Help to look 
up the meaning of unknown terms or to learn how to use the 
application in a specific situation on-screen. The easiest and quickest 
way to access the online Help is to press the F1 Key. For more 
information, refer to  Activating Online Help. 

• Look up information in the User Manual to become familiar with the 
fundamental features and operating procedures of the system. 
Dionex recommends that you read the first two sections and look up 
unfamiliar terms in the glossary.  

 Note:  
For more information about the contents and structure of the User Help 
and/or Manual, refer to  The User Help (Overview). 

In addition to the User Help section, the Chromeleon online Help includes 
an Administrator Help section. For more information, refer to  The 
Administrator Help.  

The Administrator Help 

In addition to the User Help section, the Chromeleon online Help includes 
an Administrator Help section. The User Help section provides useful 
information for the Chromeleon end user. The Administrator Help section is 
intended for system administrators and Dionex Service. 

For an overview of the topics described in the User Help section, refer to 
the Table of Contents.  



2 Introduction 

The Administrator Help section provides information about the different 
Chromeleon management tools and the hardware installation procedures: 

 Software Installation and Communication 

 Validation and Qualification 

 Working with Files, Databases, and Networks 

 Installing and Configuring Mass Spectrometers 

 Configuring the Chromeleon Server 

 Starting and Monitoring the Server, Setting Up the Server for 
Network Access 

 21 CFR Part 11 and Electronic Signature  
 Chromeleon User Management (covering the User Manager 

(CmUser) and Security Activation Tool (CmSecure)) 

 Hardware Installation. This section includes among others the 
following topics: 

 Installing Dionex Devices 

 Installing and Controlling Third-Party Devices 

The Online Help (Overview) 

As with most Windows programs, the online Help features various windows 
and levels. These largely correspond to the various parts of the User 
Manual, such as the table of contents, main section, appendix, and index. 
In addition to the manual, the online Help provides many context-sensitive 
tips that open only from the respective program window. 

The Contents tab provides an overview of the different Help sections. This 
information corresponds to the table of contents in the User Manual: 
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• Double-click a book symbol to display the topic titles. 
• Double-click a question mark symbol to open the corresponding 

topic. 
• The Index tab page enables you to find a specific term by searching 

the index entries. 
• The Find tab page enables you to search for specific words and 

phrases in the Help topics by searching the entire text of the Help 
system. 

The selected topic appears in a separate Help window. The window has a 
white background if the topic deals with questions regarding theory, 
installation, and operation. The background color is yellow if the topic 
provides tips that are more practical (How to …:). Both windows can be 
displayed simultaneously. 

 Tip: 
Online Help is automatically displayed in the language (German or English) 
of the active language setting (see Windows Control Panel > Regional 
Options). The English version is loaded by default.  



4 Introduction 

The User Help (Overview) 

 Note:  
The structure of the User Manual mainly corresponds to the structure of the 
User Help section. 

The User Help section in the Chromeleon online Help is divided into 
different sections. The Table of Contents provides an overview of the 
various topics.  

When appropriate, there are references to related topics. These references 
are indicated as follows: 
 

 Jump term References technical terms in the Glossary.  

⇒ Jump term References topics in the Reference Information section. 

 Shortcut 
link 

References topics in the Overview, Operation, and Data 
Management and How to …: sections.  
In addition, this link references related topics in the Administrator 
Help section.  

 CmUser link  
 

References topics in the Chromeleon User Management section 
of the Administrator Help section. 

 Installation 
link  

References topics in the Hardware Installation of the 
Administrator Help section.  

1. Section: General Information, Overview, Operation, and Data 
Management 
This section describes the structure and functions of Chromeleon, as well 
as basic chromatographic facts and methods.  

2. Section: How to …: 
The How to section provides helpful answers to frequently asked 
questions, such as:  

"How do I perform external calibrations?" 

"How do I generate program files?" 

"How do I re-integrate chromatograms manually?" 
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3. Section: Device Control 
This section provides information about the commands supported for 
controlling Dionex and/or third-party devices, as well as practical tips for 
device control. 

4. Section: Reference Information 
This section describes commands, parameters, variables, and report 
categories in table form. 

5. Section: Glossary and Index 

Glossary  
The glossary is an alphabetical list of chromatographic and program-related 
terms. Consult the glossary for the exact definition of 
• A technical term; for example, Blank Run Subtraction. 

• A command; for example, Draw. 

• A parameter; for example, Skewness. 

Index 
Consult the index to locate information about a specific term. In the User 
Manual, ordinary page numbers refer to the first four manual sections, while 
page numbers preceded by the letter A refer to the glossary section; for 
example: 
 
Command 

Reconnect..... A-93 
Wait ………A-147 
Wash...........A-147 

Comment............ A-30 
Communication 11; 21 
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Activating Online Help 

There are several ways how you can access online Help:  
 

F1 Key Press the F1 key to display context-sensitive 
information.  

  

 

Select How to on the context menu to display 
detailed information about how to perform a 
particular task. Select What’s this? to display a 
short description of the corresponding control or 
active window. 

  
Help menu Select Index on the Help menu to open the 

Chromeleon online Help. The Contents tab 
provides an overview of the different Help 
sections and topics. The Index tab displays an 
alphabetical list of terms that are explained in 
the Help. To find a specific term, enter the term 
of interest in the input field. The Find tab 
enables you to search for specific words and 
phrases in the Help topics by searching the 
entire text of the Help  
Select Using Help on the Help menu for more 
information about how to use the online Help. 

  

 
Clicking this icon on the standard toolbar 
changes the appearance of the mouse pointer: 
a question mark is appended to the pointer. To 
display information about an on-screen item, 
click this icon, and then click the item of 
interest.  

  

 
Click Help in a dialog box for more information 
about the dialog box.  

 
Online Help topics often include links that jump to other Help topics. To 

jump to another Help topic, click the green underlined hyperlink or click a 
shortcut symbol. 
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Overview, Operation, and Data Management 

Overview, Operation, 
and Data Management 
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Chromeleon (Overview) 

Chromeleon (Overview) 

Chromeleon is a modern Chromatography Management System that 
allows you to control and monitor chromatography installations and to 
backup, evaluate, and reprocess data. Chromeleon provides various sub-
programs, making it very flexible and GLP conforming, and offering you 
numerous options for operating effectively and productively:  

  

The sub-programs support the following functions: 
 
Icon Description Function 

 Chromeleon (Client) Device control, data backup, reprocessing and 
evaluation, validation (user) 

 Installation Qualification Verification and documentation of the installation 
(administrator) 

 Server Configuration Device configuration (administrator) 

 Server Monitor Interface between the installation and the 
Chromeleon Client (administrator)  

The Server Configuration and Server Monitor programs allow you to create 
a client/server structure, thus adding to the networking capability of 
Chromeleon. 
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In addition, there are two User Management programs available to the 
administrator in the Chromel\CmUser directory: 
Program Description 

 Enabling and disabling User Management (administrator) 

 Installing User Management (administrator) 
 
As a user, you will almost exclusively work with the Chromeleon Client 
program. The different windows support all required functions. 

Also, refer to: 

 Chromeleon Windows 
 Chromeleon Features 
 Chromeleon Licenses 
 Installing Chromeleon 

 
 Chromeleon Windows 

You can open the various windows of the Chromeleon Client Program via 
the associated icons or by double-clicking the respective directory: 

Click an icon to open one of the following windows: 
 
Symbol Description Function 

 Browser Data administration and storage 

  Panel Tabset  Control of all configured devices 

 Integration Chromatogram display and reprocessing 

 PPA Peak Purity Analysis:  
3D Field (only for PDA data) 

  3D Amperometry 3D amperometry data display and evaluation  

 QNT Editor Quantification Method editing 

 
Printer Layout Printer Layout creation and/or modification 

 Signed Results Electronically signed sequence ( SOR File) 
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Double-click the associated file to open these windows: 
Symbol Description Function 

 Panel Control of a specific device or system 

 PGM Editor Processing of a control file  

  Panel 
Tabset  

Control of all configured devices 

 
The Integration window and QNT Editor support different panes; click the 
associated icon on the Method toolbar: 
Symbol Description Function 

 Report Display of various report tables 

 Trend Plot Display of trends in data series 

 
Spectrum UV spectrum (only for PDA data) 

 
Calibration 
Curve 

Calibration curve 

 
MS Spectrum Mass Spectrum 

 
For more information about the different windows, refer to: 

 The Browser 
 The Control Panel 
 The Panel Tabset 
 The QNT Editor 
 The PGM Editor 
 The Integration Window 
 The Printer Layout 
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 Chromeleon Features 
Chromeleon supports a wide variety of features, including: 
• Modern control technology via client/server architecture and Windows 

RPC technology. (For more information, refer to  The Network.) 

• Complete  Network Installation. 

• Separate User Manager (CmUser program) for user management 
(refer to  Chromeleon User Management in the Administrator 
Help section). 

• Query-based data access via an integrated Database. 

• Connection to standard ODBC and/or SQL databases. 

• Tele-service (remote maintenance). 

• Freely definable workspace on the  Control Panel. 

• Mass Spectrometer control and MS data evaluation. 

• Sample-Oriented Operation. 

• Electronic Signature of sequences. 

• Compliance with GLP through automated Instrument Qualification 
(IQ) and Operational Qualification (OQ), as well as Instrument OQ 
and Performance Qualification (PQ). 

 
The user interface and operation correspond to the standard Windows 
requirements: 
• Comprehensive Online Help. 

• Easy operation based on Toolbars and assisting Wizards. 

• Comprehensive context menus via the Right Mouse Button. 

• Drag & Drop functionality (refer to How to …: Creating and 
Managing Files and Data  Moving and Copying Elements). 

• Real Multi-Tasking and Multi-Threading. 
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In addition, the chromatographic interface features these special 
enhancements:  
• Optical representation of the gradient profile. 

• Online zooming beyond the current time. 

• Grid in online window. 

• Additional peak variables. 

• Determination of reference wavelength for individual channels. 

• Wavelength compensation via holmium oxide filter. 

• Enhanced data compression and restoration of old data. 

• Baseline subtraction can be undone at any time.  

• Base area correction/base area recognition.  

 Chromeleon Licenses 
Chromeleon can be configured to satisfy the requirements of many different 
applications. In addition to the basic software package, various options are 
available from Dionex.  

The set of licensed capabilities for a Chromeleon station is controlled by 
means of a serial number and the corresponding license key. The serial 
number is coded on a software protection device that is installed locally, 
together with the license key, or managed by a License Server. (For more 
information, refer to Software Installation and Communication  The 
Software License in the Administrator Help section.) Chromeleon can 
only be started with the full range of features if a protection device (such as 
a Dongle on the parallel or USB PC interface or a PAL on the A/D 
converter card) is detected, or if a license provided by the license server is 
detected. 

For information about which Chromeleon licenses are available from 
Dionex, see the table below. 

 Tip:  
To check the licenses after the installation, select About Chromeleon on 
the Help menu. 
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Server Features   
Server 
License: 

The base server license enables control and data acquisition for 
instruments attached directly to the PC that has the license. The server 
must always be configured with one or more timebases; other server 
features are optional.   

Timebases 
Class 1 to 3: 

Each Timebase license enables control of one chromatography 
system (defined as a set of instrument components that operate 
according to the same elapsed-time clock).  
The timebase class determines which instruments can be controlled: 

 Timebase Class 1 License: Supported Devices  

 Timebase Class 2 License: Supported Devices  

 Timebase Class 3 License: Supported Devices 

 Tip: 

All Dionex and LC Packings instruments are controlled by a Timebase 
Class 1 license. 

The Timebase Class 2 and Timebase Class 3 licenses allow you to 
control additional chromatography instruments that are not supported 
by the Timebase Class 1 license. Please note: 

 License Also Supports Devices of 
 Timebase Class 2 Timebase Class 1 
 Timebase Class 3 Timebase Classes 1 and 2 
 Up to six timebases can be configured on one server PC, of which up to 

four can be fully-controlled LC or IC systems. However, only two 
Timebase Class 2 or Timebase Class 3 licenses are allowed.   

Multiple Network  
Control: 

This license enables the server's timebases to be controlled by other 
Chromeleon client stations across a network. In addition, this license 
supports the Online Transfer Agent (OTA) and Network Failure 
Protection (= NFP). One separate license is required for each installed 
chromatography Server.   

MS Control: Additional license for a Mass Spectrometer on a chromatography 
server: enables MS control, digital data acquisition of a three-
dimensional data field, and analysis of MS data. The MS Control license 
is required for spectra and channel acquisition. One license is needed 
on each chromatography server.   

IC Control SE: Special low-cost control license for operating a single DX-120, ICS-90, 
or ICS-1000 stand-alone ion chromatography system. Also supports the 
AD25, AS50, and UCI modules.   
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3-D Data 
Acquisition 

Additional license that enables a chromatography server to acquire 
digital 3-D data from Photodiode Array Detectors and the ICS-3000 
Electrochemical Detector (ED). For details, see the Additional Notes at 
the end of this topic. 

 Note: 

This license does not enable collection of mass spectrometry data. The 
MS Control license is required for acquisition and analysis of MS data.   

ICS-2000 Gradient 
Generation 

Additional license that enables electrolytic eluent gradient generation 
with the ICS-2000 Ion Chromatography System.   

Fraction 
Collection 

Additional license that enables intelligent fraction collection based on up 
to two detector signals, with wizard-based program setup and complete 
fraction reporting.   

Purification Additional license for Autopurification. (The Purification license 
includes the Fraction license.) The license supports control of 
automatic sample purification via the associated Post-Acquisition 
Steps, color-coded sample and fraction assignment, special 
chromatogram views, and sophisticated fraction collection algorithms 
with peak shoulder detection. More than two detection channels are 
allowed. 

  
Control-Only This license is for Chromeleon Xpress only. It enables full instrument 

control and monitoring, but does not allow storage of data channels.     
Client Features   
Client License: License for data reprocessing on a network PC without control. The 

license supports multitasking and reports from single- and multiple-point 
calibration with various fit models, integration, ratio test, user programs, 
etc.   

Server Control: License that enables the Client to connect to local or remote 
Chromeleon servers for real-time system control and status monitoring. 
For control across networks, the Chromeleon servers must have the 
Multiple Network Control license. 

 Note: This license is available only with a Client License. 
  
Concurrent 
Clients: 

Number of client sessions that can be used concurrently on a PC. A 
maximum of three Concurrent Clients can be established and licensed 
on one PC. For a License Server, the number of floating licenses 
allowed on one PC depends on the INI file (see Hardware Installation 

 Installing the License Server in the Administrator Help section).   
Report  
Publisher: 

This license extends Chromeleon’s reporting capabilities by enabling 
use of custom formulas (written in standard Excel syntax) and custom 
charting. For more information, see Additional Functions.   
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GLP Compliance: This license supports additional capabilities required for GLP features:  
• File History 
• Electronic Signature 
• User Management (see User Management: User Manager and 

Security Activation Tool) 
  
Virtual Column Additional license options for the Virtual Column IC Separation 

Simulator tool. The Isocratic license enables modeling of isocratic 
separations only; the Linear Gradient license enables modeling of 
isocratic and linear gradient separations. (The Linear Gradient license is 
sold only in a Virtual Column Complete package that also includes the 
Isocratic license.)   

Xpress mode Provides a simplified interface for operating and monitoring instruments. 
Does not provide any data review or data management functions.    

SDK Features 
 
ASAP: Additional license for the ASAP open-access option.   
Analyzer: Additional license for controlling the DX-800 process analyzer. 
   

Additional Notes about the 3-D Data Acquisition License 
Each 3-D license applies to one chromatography server. A maximum of 
one 3-D photodiode array channel and one 3-D amperometry channel can 
be configured on a timebase. The total number of 3-D data channels one 
server can acquire simultaneously is limited by the computer performance. 
(No special client license is required for reviewing and processing acquired 
3-D data.) 

With photodiode array detectors, 3-D data provides spectral information 
that can be used for peak purity analysis and compound identification using 
spectral library matching. With the ICS-3000 ED, the 3-D option enables 
capabilities such as cyclic voltammetry and post-run adjustment of the 
waveform integration period. These types of 3-D data can be viewed in 
wireframe or iso-response projections, and chromatograms can be 
extracted from the 3-D data set.  

For more information about 3-D amperometry data and the ICS-3000 ED, 
refer to How to …:  Analyzing 3-D Amperometry Data. 
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 Timebase Class 1 License: Supported Devices  

 Tip:   

To control the Dionex and/or LC Packings devices a Timebase Class 1 
License is required. 
 

Manufacturer 
(See the Administrator Help 
section.) 

Device (Driver Name) 
 
 

 Agilent (formerly HP) 5890 Gas Chromatograph 
6850 Gas Chromatograph 
6890 Gas Chromatograph 
7673A GC Autosampler (also for 7683 GC Autosampler) 
1050 Autosampler 
1050 Gradient Pump 
1050 UV VWD Detector 

 CTC Analytics CTC PAL Sampler for GC 
CTC_A200S_Sampler 

 Dionex All devices 

 Dostmann Thermometer Series P500/P600 

 Fisons AS800 Autosampler 
8000 Gas Chromatograph (+ Mega 2 GC) 
A200S: see CTC_A200S_Sampler 

 Isco Foxi 200 Fraction Collector 
Foxy Jr. Fraction Collector 

LC Packings (see  Dionex) All devices 

 Perkin Elmer Autosystem(XL) Gas Chromatograph 
TurboMatrix Headspace Sampler 

 Rheodyne LabPro Valve 
RV/EV Valve 

 Shodex RI-101/102/104 RI Detector 

 ThermoFinnigan/ 
ThermoQuest/TSP 

ThermoFinnigan aQA MS 
ThermoFinnigan MSQ MS 
Thermoquest_AS2000 
TQ Trace 2000 Gas Chromatograph 
TSP AS3000/AS3500 Autosampler 

 Valco Multi-Position Valve 
Two-Position Valve 
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Manufacturer 
(See the Administrator Help 
section.) 

Device (Driver Name) 
 
 

 Varian 3400 Gas Chromatograph  
3600 Gas Chromatograph  
3800 Gas Chromatograph 

 Waters 717 Plus Autosampler 
 

 Timebase Class 2 License: Supported Devices 
 

 Tip:   

To control the Dionex and/or LC Packings devices a Timebase Class 1 
License is required. 
 
Manufacturer 
(See the Administrator Help 
section.) 

Device (Driver Name) 
 
 

 ABI ABI_785A_UV_VIS_Detector 

 Agilent (formerly HP) 1100 HPLC System 

 Berthold Berthold_LB_507_509 

 Bio-Rad AS 100 Sampler 

 CTC Analytics A200S Autosampler 

Jetstream Jetstream_2_Column_Oven 

 Knauer 2600 UV Detector 

 Kontron 360/560 Autosampler 
420 Pump (also for 422 Pump) 
425 Gradient Former 
460 Autosampler 
465 Autosampler 
565 Autosampler 
Pumps 32X and 52X 
UV Detector 430 
UV Detector 432 (also for 332 UV Detector) 
UV Detector 535 
SFM 25 UV Detector 
CO200: seeJetstream_2_Column_Oven 
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Manufacturer 
(See the Administrator Help 
section.) 

Device (Driver Name) 
 
 

 Kratos Spectroflow 783 UV Detector 

Linear Instruments  
(see  ThermoFinnigan/ 
ThermoQuest/TSP)  

Linear 205 UV-Det.: see TSP UV2000/UVIS205 Detector 
Linear 206 UV-Det.: see TSP UV3000 Detector 

LKB (see  Pharmacia ) 2150 Pump 
Superrac 2211 Fraction Collector 

 Nelson/Perkin Elmer 941 Interface (also, for the 901 Interface) 
950/960/970 Interface 

 Pharmacia  2150 Pump 
Superrac 2211 Fraction Collector 

 Soma 3710-178 Detector 
3710 Detector (new) 

 ThermoFinnigan/ 
ThermoQuest/TSP  

TSP FL2000 Fluorescence Detector  
TSP FL3000 Fluorescence Detector  
TSP P2000 Pump 
TSP P4000 Pump 
TSP UV1000 Detector 
TSP UV2000/UVIS205 Detector 
TSP UV3000 Detector 
TSP UV6000 PDA 

 Waters 2487 Detector 
2690/2695 Separation Module 
2790/2795 Separation Module 
996/2996 PDA  
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 Timebase Class 3 License: Supported Devices 
 

 Tip:   

To control the Dionex and/or LC Packings devices a Timebase Class 1 
License is required. 
 

Manufacturer 
(See the Administrator Help 
section.) 

Device (Driver Name) 
 
 

 Antec Decade ECD 

 CTC Analytics CTC PAL Sampler for LC 

 ESA CouloChem II ECD 

 Gilson 116 UV Detector 
117/118 UV Detector 
119 UV Detector 
152 UV Detector 
201/202 Fraction Collector 
202 Fraction Collector (ext.) 
204 Fraction Collector 
206 Fraction Collector 
215 Liquid Handler 
231 Autosampler (also used for the 231A autosampler) 
231XL Autosampler 
232 Bio Autosampler 
234 Autoinjector 
235 Autoinjector 
302 Pump (also for 303 Pump) 
305/306/307 Pump 
333/334 Pump 
Valve Modules: 817, 819, UVSM, and ValveMate 
XL Sampler Series (Extended): 221XL, 222XL, 231XL, 
232XL, 233XL, and ASPEC XL 

 Jasco 980/1580 Pump 
1520_Fluorescence_Detector 
920_Fluorescence_Detector 
970_UV_VIS_Detector 
950/1555_Sampler 
975/1575_UV_VIS_Detector 
970_UV_VIS_Detector 
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 Merck Hitachi  AS2000 Autosampler 
AS4000 Autosampler 
L4250 Detector 
L6200/L6210 Pump 
L6250 Pump 
L7250 Autosampler 
LaChrom HPLC System 

 Shimadzu LC 10A HPLC System 
LC 2010 HPLC System 

 Varian ProStar215/218 
SD-1 Pump 
SD-200/SD-300 Pump 

 

 Installing Chromeleon 
Usually, Dionex Service or a network administrator installs the Chromeleon 
software. Therefore, refer to Software Installation and Communication 

 Software Installation and Communication in the Administrator Help 
section for a more detailed description of the installation procedure.  
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Components of a Chromatography 
System 

Components of a Chromatography System  

Modern HPLC or IC systems consist of the following components (HPLC: 
High Pressure/Performance Liquid Chromatography; IC: Ion 
Chromatography): 

a b c d e f g

h

 
The pump (b) draws up to four solvents from one or several reservoirs (a), 
mixes them as defined, and then directs this mixture through the system. 
The solution of interest (= the sample) is injected into this flow via an 

Autosampler (c) and separated into its individual fractions or substances 
on the column (d). Using a thermostatted column compartment can 
optimize the separation process. When a substance reaches the detector 
flow cell (e), a signal is produced that is proportional to the concentration of 
the substance. The signal whose profile corresponds to a Gaussian 
distribution is referred to as a peak. The exact quantity of each substance 
can be calculated by determining the peak area and by means of a 
previously acquired calibration curve (quantitative analysis).  

In suppressed conductivity mode IC, a Suppressor is installed before the 
detector. As an option, a fraction collector (f) can be installed after the 
detector to distribute individual substances or fractions to different 
containers (g). 
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The peak area is determined by the chromatography data system that is 
installed on a PC (h). In addition, the data system 
• Controls and monitors all connected chromatography instruments.  

• Collects data and status messages. 

• Enables quantitative and qualitative evaluation of the data, using 
Photodiode Array Detectors or Mass Spectrometers.  

The chromatography instruments communicate with the computer and the 
data system via special interfaces, such as the UCI Universal 
Chromatography Interface, via serial interfaces, or via additional cards, 
e.g., an A/D converter card. 

If several PCs are connected via a network, the systems can be controlled 
from remote locations on the network. In addition, data can be managed 
centrally and/or retrieved from any workstation.  

For more information about the components of a chromatography system, 
refer to: 

 Chromatography Instruments 
 The Chromatography Data System 
 The PC  
 The Operating System 
 The Network 

Chromatography Instruments 

Chromeleon is especially designed to control and monitor the following 
Dionex devices:  
 
Eluent Generator EG, EG40, or EG50  
Micro Pump LPG-3x00 
HPLC Pump P680 
IC Pump DP, GP40, GP50, GS50, IP20, IP25, IS25, SP 
Flow Manager FLM-3x00 
Well-Plate Micro Autosampler WPS-3000 
Autosamplers AS, ASI-100, AS50, AS3500 
Autosampler and Fraction 
Collector 

SFM Sample and Fraction Manager 
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Column Thermostats DC, TCC-100, LC25, LC30, AS50 Thermal 
Compartment 

UV/VIS Detectors  
     Single wavelength AD20, AD25 
     Multiple wavelength UVD 170U 
     Full-spectrum (PDA) UVD-3000, UVD 340U, PDA-100 
Electrochemical Detectors CD, CD20, CD25, CD25A, ED, ED40, ED50, ED50A 
Fluorescence Detector RF2000 
Mass Spectrometer (Thermo Finnigan MSQ (also included in the Dionex 

APS) and aQa) 
Refractive Index Detector Shodex RI-101 
Instrument/PC Interfaces UI20 Universal Interface, UCI Universal 

Chromatography Interface 
System Modules DX-120, IC20, IC25, IC25A, ICS-90, ICS-1000, ICS-

1500, ICS-2000  
The HPLC instruments are part of the UltiMate 3000, Summit, and 

APS (autopurification) system series. (Appropriate instrument control 
options may need to be purchased and installed in order to control these 
instruments.) 

Third-party analytical instruments are also supported. See the following 
examples:  
 
Gas Chromatographs Such as, the Agilent (or HP) 6890 GC 
HPLC Systems Such as, the Agilent (or HP) 1100 HPLC System 
HPLC Modules Such as, the Waters Alliance 2690 HPLC Module 
Radioactivity Detectors Such as, the Berthold LB507A detector  

Appropriate instrument control options may need to be purchased and 
installed in order to control these instruments. 

For more installation information, refer to Hardware Installation 
 Installing Dionex Devices in the Administrator Help section. 
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The Chromatography Data System 

The data system is the control center of a modern chromatography system.  

Tasks of a Data System 
The data system 
• Converts user input into time-precise control commands.  

• Monitors the state of the connected chromatography instruments.  

• Logs all user entries and modifications to the system.  

• Saves and archives all data.  

• Graphically represents data and allows you to check the system status 
and system results. 

• Allows you to thoroughly check and evaluate data.  
 

Components 
• The basis for precise control and key component of the system is an 

 Operating System that is capable of performing all operations in 
real time. 

• The components of the chromatography system are installed and 
configured in the Server Configuration Program. 

•   Device Drivers and other drivers, for example,  Virtual Channel 
Drivers, enable communication with the different instruments and 
device types. (For more information, refer to the related sections in 
Special Drivers in the Administrator Help section.)  

• Each event (for example, execution of a command or appearance of an 
error message) is logged in the  Audit Trail.  

• Depending on the required scope of performance, Chromeleon 
supports various options. (For more information, refer to Chromeleon 
(Overview)  Chromeleon Licenses.)  
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Chromeleon User Interface 
• Chromeleon supports all typical Windows properties, such as menu 

structure, screen elements, and operation. A homogeneous, situation-
related menu structure is as evident as the Windows technology, 
toolbars, and context-sensitive use of the right mouse button. (For 
more information, refer to  The Client User Interface.) 

• Each user can save and activate a "personal" screen. (For more 
information, refer to  User Profiles (Workspaces).) 

• The user can modify the graphical representation of the online control 
windows to suit his(her) specific needs. (For more information, refer to 
Control  The Control Panel.)  

Operation 
• Before starting Chromeleon (see  Starting the Program), verify that 

the hardware configuration is correct and that the PC is connected with 
the system and a datasource. 

• In network operation (see  The Network), the client PC can control 
systems and datasources that are not directly connected with the PC.  

• Various assistants, the Wizards, facilitate operation of Chromeleon. 

The PC 

Overview of the minimum PC requirements 
 
 Windows 2000 Windows XP 
Service Pack SP4 SP1 
CPU Pentium III 800 Pentium III 800 
RAM 256 MB 256 MB 
Hard Disk 20 GB 20 GB 
Display 1024 x 768 x, minimum 256 colors  
For better software performance, Dionex recommends a Pentium 4 with a 
CPU of at least 1 GHZ and 512 MB RAM. For applications with several 
windows and control panels, for example, in mass spectrometry, Dionex 
recommends using a higher screen resolution.  
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The Operating System 

Chromeleon supports the following operating systems: 
• Windows XP SP1  

• Windows 2000 SP4 

These operating systems are 32-bit Multi-Tasking operating systems, 
which means that several programs can be executed simultaneously. This 
is especially important for instrument control, data acquisition, and 
comfortable printer support. 
 

 Tip: 
For more information, refer to Software Installation and Communication 

 Chromeleon and Windows Operating Systems in the Administrator 
Help section. 

The Network 

The network capability of Chromeleon allows you to operate the data 
system within local and global networks, also referred to as LAN (Local 
Area Network) or WAN (Wide Area Network). 

Chromeleon can be operated either locally in a single-user installation or on 
a network. This includes data transfer and remote operation via ISDN. The 
Chromeleon stations can be linked around the world (Wide Area Network). 

To use all advantages and possibilities provided by network operation, such 
as centralized data storage, backup, and administration, shared access to 
methods and worldwide availability, safe and fast data exchange is 
essential.  

Sometimes, even state-of-the-art networks have difficulty coping with the 
enormous amount of data. That is why client/server systems provide 
decisive advantages by specifically selecting transferred data. 

Client/Server System 
On a decentralized PC (client), RPC commands (Remote Procedure 
Calls) are used to start sub-programs on a central computer ( Server or 
Chromatography Server). The server performs the actual "work." For 
example, the server searches for data in a database or runs an application. 



 Components of a Chromatography System 29 

The client only receives the search result or the status of the application. 
This means that the client provides the user interface while the actual 
operation is remotely performed on the server. Chromeleon, too, uses this 
"division of labor." 

After starting Chromeleon on a local PC, the Client, the user can perform 
all server-independent tasks; for example, re-process raw data, create 
sequences, or search for individual spectra in a library.  

If a chromatography Server is running, it is also possible to control and 
monitor the chromatography instruments connected to this server. 
Theoretically, each client connected to a running server via a Control 
Panel can do this. In practice, only the first client is allowed to control the 
instruments connected to the timebase. All other Chromeleon users can 
only monitor the system status. 

Via device drivers, the server converts the control commands entered on 
the first client PC for the analytical instruments. Inversely, the server 
receives information from the system and forwards it to the appropriate 
locations. Thus, status information, such as the current flow rate, appears 
on all client PCs connected with this chromatography system. Raw data is 
automatically stored in the directory of a Datasource and the underlying 
database.  

The installation type determines whether the client and the server are 
located on the same PC (local client/server installation) or on different PCs 
in a network (network installation). For more information, refer to: 

 Local Client/Server Installation 
 Network Installation 

 

 Local Client/Server Installation 
The Client and the (Chromatography) Server are located on the same 
PC. They must be started separately. 

The controlled instruments in the chromatography system can be 
connected with the PC, e.g., via RS-232 ports, a DX-LAN, or a USB 
(Universal Serial Bus) connection. Additional interface cards can supply a 
sufficient number of ports. Each chromatography server can control a 
maximum of six controlled Timebases (chromatography systems). 
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The data is saved on the local PC. During initial installation of Chromeleon, 
a local datasource is installed on each local computer. 

If the PC is part of a local network (LAN = Local Area Network or WAN = 
Wide Area Network), data can also be saved externally. In the same way, 
external data can be used for data editing.  

RS232

Operating 
SystemClient

Server
Data 
Sources

 
 
If the local PC is connected to a network, all options of a  Network 
Installation are available. 

 

 Network Installation 
The Client, the Chromatography Server, and the Datasource can be 
installed on different computers. They are connected via the network and 
the corresponding network server. Each chromatography server can 
operate up to six chromatography systems ( Timebases). 

The client, server, and datasource are independent units on the network. 

ISDN

WAN

Network
Server

Client

Server

Chrom. System
 

On each PC, a server, client, and local datasource are set up during the 
installation of Chromeleon. Independently of this, each PC can act as 
"server only" or "client only." Theoretically, each client can access each 
datasource and each server. In practice, this may not be desirable for 
safety reasons.  
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Therefore, various options are available to restrict user access:  
• The Server Configuration program allows you to define the extent of 

network operation for each Server and each timebase. A server can 
be made available for the entire network or for certain Access Groups 
only. The server can be locked either partly or completely. If the server 
is partly locked, for example, it is still possible to monitor the server, but 
control of the connected instruments is disabled. In this case, control is 
reserved for the local client. This distinction also applies to the 
timebases. If three timebases (TIME1, TIME2, and TIME3) are installed 
on a server, TIME1 could be completely shared, TIME2 could be 
excluded from network operation, and TIME3 could be shared for 
monitoring only.  

• Datasources and/or their subdirectories can also be protected from 
undesired access. Depending on the location of the corresponding 
database (on the local hard disk or a network PC), the respective user 
or the network administrator decides (by "sharing" a directory) which 
data can be accessed and by whom. In addition, datasources shared in 
Windows can be locked in Chromeleon. 

• In addition, access can be restricted via Passwords or the 
Chromeleon User Management. If the administrator has enabled 
access control (in the Security Activation Tool (CmSecure program)), 
the user must enter a password before being allowed to perform 
specific operations. The system administrator determines these 
operations in the User Manager (CmUser program). In this way, the 
administrator can deny controlling rights or prohibit "locking" of 
datasources. 

• Besides, access is not possible if the appropriate license is missing. 
For example, if a server does not have a Multiple Network Control 
license and/or if the client does not have a Server Control license, the 
server cannot be controlled on the network. 

Important data are often stored on central data server PCs. If, during data 
acquisition, the network connection is interrupted or the data server PC 
crashes, data acquisition should continue, nevertheless. All data that are 
relevant for the Chromeleon server are locally stored on the server's hard 
disk, thus ensuring that data acquisition will not be interrupted in case of a 
network failure (see Network Failure Protection). 
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In addition to allowing data exchange within a local area on a Windows, 
Novell, DEC, or UNIX network (LAN), it is possible to transfer data across 
huge distances (WAN) via ISDN. The basic requirement for any type of 
network operation is the availability of the corresponding network drivers for 
Windows 2000/XP. 

 Tip: 
The Administrator Help section provides more information; refer to How 
to …: Working with Files, Databases, and Networks: 

 Sharing the Local Datasource on the Network 
 Creating a Network Datasource 
 Saving Chromatography Data on the Network 
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Basic Operation 

Operation via the Keyboard 

All commands and menu options are accessible from the keyboard. Press 
the ALT key to display the underlined access letters. To open a menu from 
the keyboard, press ALT and the underlined letter. To select a command or 
option on the menu, press another underlined letter. Alternatively, use the 
arrow keys to move to the desired option and then confirm your selection 
by pressing the Enter key.  

Example:  To left align several objects on a control panel, select 
Align on the Edit menu, and then select Left. 
Alternatively, hold down the ALT key and press A+L. 
Else, press ALT+E, and then select an option, using the 

 and  arrow keys. Confirm your selection by pressing 
<Enter>. 

Important commands can also be accessed via shortcuts. The shortcuts 
are displayed next to commands and menu options. Enter the key 
combination to directly execute the corresponding function. 

Example:  Hold down the Control key and then press C (CTRL+C) 
to copy a selected item.  

 
For a list of available shortcuts, refer to Operation  Quick Access Keys 
(Shortcuts). 
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Quick Access Keys (Shortcut Keys) 

Quick access keys and/or shortcut keys are provided for many operations, 
especially in online control:  
 
 Action Where Description 
General ESC or  

right-click 
 Aborts the drag/move action. 

 F1 
F2 

 Opens the context-sensitive Help; 
Enables the Edit mode. 

 F3  After the Find command: Find 
Next. 

 F4 
SHIFT+F4 
 
Alt+F4 

Chromatogram Takes you to the next sample. 
Takes you to the previous 
sample. 
Exits Chromeleon. 

 F5 
F6 
 
SHIFT+F6 

 Updates all windows. 
Takes you to the next partial 
window. 
Takes you to the previous partial 
window. 

 F10 
SHIFT+F10 

 Takes you to the next channel. 
Takes you to the previous 
channel. 

 F7 
SHIFT+F7 

Browser (F7 key 
only) + 
QNT Editor 

Optimizes the column width. 
Optimizes the line height. 

 F8 
F10 or ALT 

 Opens an edit dialog box for the 
respective field. 
Shows the hotkey underlines. 

 SHIFT+F5 Browser Displays the chromatogram. 
 ALT+ENTER Browser + Control 

Panels 
Opens the associated 
Properties. 

 CTRL+TAB  Toggles between open windows.  
 CTRL Signal plot in the 

Report and in the 
QNT Editor 

Allows zooming (the cursor 
becomes a zoom cursor). 

 CTRL+N 
CTRL+O 
CTRL+S 
CTRL+R 
CTRL+P 

 
 
 
 
Report + Printer 
Layout 

Creates a new file. 
Opens the file. 
Saves the file. 
Opens the batch report. 
Prints the selected object(s). 
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 Action Where Description 
Edit CTRL+Z 

CTRL+Y 
CTRL+X 
CTRL+C 
CTRL+V 
CTRL+F 
F3 
 
CTRL+H 
F9 
 
 

 Undoes the previous action. 
Repeats the previous action. 
Cuts the selected object(s). 
Copies the selected object(s). 
Pastes the selected object(s). 
Finds a string of characters. 
Finds the next string of 
characters. 
Replaces the entry in the field. 
Fills the column and/or selected 
cell(s) with the first value of the 
selection. 

 INSERT 
DELETE 

 Inserts the selected object(s). 
Deletes the selected object(s).     

Sample List CTRL+I 
CTRL+D 
CTRL+A 

 Inserts a sample. 
Deletes a sample. 
Adds a sample. 

    
Control CTRL+F 

CTRL+I 
CTRL+Break 
Break 
Ctrl+A 
Ctrl+B 

 Changes the pump's settings 
Injects 
Stops the pump. 
Turns on the Hold mode. 
Turns on data acquisition. 
Edits the batch.      

Signal plot Double-click... - Overview window  
- Time axis 
- Signal axis 
- Plot range 
(- or else:…) 

Unzooms. 
Auto Plot Speed 
Autoscale 
Signals... 
Axis/decoration 

 SHIFT - when zooming Retains the scale ratio between 
signal and value axis. (The shape 
of chromatograms is maintained.)     

Gauge/Slider CTRL key Press when 
dragging 

Toggles the Snap To Scale 
option.     

Script Button Click Button 
 

Indicates whether the program is 
still running. Stops the program 
upon confirmation.      
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 Action Where Description 
Edit Field TAB/ENTER  Sends the new value. 
 ESC  Aborts the input.     
Layout Mode ALT + Click On the selected 

panel 
Draws a selection frame on the 
control panel. 

 ALT + Drag  Temporarily toggles the Snap To 
Grid option. 

 ESC  Deselects all. 
 ARROW keys  Drags the selection pixel by pixel. 
 SHIFT + 

ARROW keys 
 Increases/reduces the selection 

pixel by pixel. 

 SHIFT+SELECT  Extends the selection.  
 CTRL+SELECT  Highlights the selected control 

(the highlighted control is used in 
Align..). 

 CTRL+Drag  Copies controls. 
 Double-clicking On the online signal 

plot on the control 
panel 

Opens the Properties dialog box. 

 
Especially in the chromatogram, many additional keys and key 
combinations are available. For more information, refer to How to …: 
Working with Chromatograms  Using Keyboard Keys in the 
Chromatogram. 

Operation via the Mouse 

Chromeleon supports all Windows-typical properties and capabilities of a 
two-button mouse. 

The left mouse button allows you to select menus, commands, and icons. 
It also allows you to operate display and control elements and to modify 
windows (increase or reduce the window size, zoom, modify display and 
control elements, etc). Double-click the left mouse button (= left-click) to 
execute the selected function. 

Hold down the SHIFT key and left-click to select several cells in a table. 
Left-click in the first cell, hold down the SHIFT key, and select a new cell. 
All cells between these two cells will be selected. 
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Hold down the CTRL key and left-click to select non-adjacent cells in a 
table. Left-click in the first cell, hold down the CTRL key, and then select a 
new cell. Hold down the CTRL key and repeat left-clicking until all required 
cells are selected.  

Left-click an object and drag it to the desired position (Drag and Drop). 
This action allows you to move selected text or samples. To copy the 
corresponding object, hold down the CTRL key while performing the Drag 
and Drop operation. 

The right mouse button (= right-click) allows you to open context-sensitive 
menus. Context-sensitive menus provide functions that are required or 
allowed in the current situation.  

For more information, refer to your Windows manual.  

Undo and Redo Commands 

Chromeleon "remembers" the user's last modification: 

• Select Undo on the Edit menu to cancel the last operation.  

• Select Redo to cancel the Undo operation. 
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Starting the Program 

Chromeleon runs on client PCs with Windows 2000 or Windows XP 
operating systems. To start Chromeleon:  
• Click Start to open the Start menu. Point to Programs and wait until 

the submenus appear.  

• Point to Chromeleon. Another submenu appears:  

 

Client 
• Click Chromeleon to start the Chromeleon software so that you can 

begin with data evaluation.  

• If Chromeleon has been installed with integrated access control, you 
must enter your user name and password for identification. If you have 
any questions regarding system access, please contact your system 
administrator. 

 Tip: 
To control a chromatography system with Chromeleon, you must also start 
the Chromeleon server.  
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Server (Server Monitor) 

 Tip: 
During installation, Chromeleon usually includes a link to the Server 
Monitor program in the Autostart group. Thus, the program is started when 
you start your computer. The Server Monitor icon appears on the taskbar.  

• If the icon does not appear on the taskbar, click Start, point to 
Programs > Chromeleon, and select Server Monitor to start the 

Server Monitor Program. The Chromeleon icon will appear next to the 
Windows system clock on the Windows taskbar.  

• Point to the icon. The Chromeleon Server is not running quick info 
message appears. 

• Select Start Server on the context menu (or double-click the icon and 
then click Start). The color of the icon indicates the status of the server 
monitor. Gray coloring indicates that the server is running (the quick-
info message reads: Chromeleon Server is running idle). You can 
now open a control panel and directly access the devices installed in 
the selected timebase. If the devices have been installed correctly, you 
can operate them online. 

 Tip: 
Any problems occurring when controlling single instruments may be caused 
by an incorrect server configuration. Start the Server Configuration 
program to check the configuration.  

The Client User Interface 
The Chromeleon user interface supports all known Windows elements, 
such as menu bar, Toolbar, and Status Bar.  
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To display the toolbars listed below, select them on the View > Toolbars 
menu:  
 
Standard 
Toolbar for 
various standard 
functions  

 

Online Tools for 
using the control 
panel  

 

Layout Tools for 
designing the 
control panel 

 

Method Tools for 
selecting a 
method window 

 

Integration Tools 
for the most 
important 
operations in the 
Chromatogram 

 

 
For descriptive information about a toolbar, point to the related icon. 

The space between the task bar and the status bar represents the 
workspace, allowing you to display the different  Windows supported by 
Chromeleon. 

The Windows  

The appearance of the different windows can vary considerably. A window 
can have various window sections (panes) whose borders can be moved 
(a). If the window section is too small to display the entire information, use 
the scroll arrows or scroll bars to view the hidden area (b). 
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The window content depends on the type of the represented data. It is also 
possible to integrate table editors as a window section in a method window. 
For window sections with graphical representation, the coordinates of the 
mouse pointer appear on the status bar. 

Window Types 
In addition to the Browser and the control panels, Chromeleon supports the 
following method windows: 

• QNT Editor (see Data Representation and Reprocessing  The 
QNT Editor) 

• Integration  

• Peak-Purity-Analysis (PPA) 

• 3D Amperometry  

• Printer Layout 

• Signed Results 

• Virtual Column 

Only one method window is enabled by default. To use several method 
windows simultaneously, select Preferences on the File menu of the 
Browser. On the Browser tab page, clear the Open only one method 
window check box. This allows you to open each window any number of 
times.  
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The Table Editor 

Table editors serve to enter and represent various parameters and 
variables. For example, one table editor is available in the Browser. This 
editor allows you to list or edit single samples or sample data, or to display 
numerical results in a report. It also serves to determine integration, 
calibration, and peak table parameters.  
• Appearance and use of all tables correspond to the Windows standard. 

Editing is by cell, column, or line.  

• It is possible to move or hide selected columns and to make them 
visible again at the active cursor position. Adjust the column width by 
moving the left or right delimiter. Or else, select Optimum column 
width, e.g., on the View menu in the Browser. 

• You can add additional lines or remove selected lines anywhere in the 
table.  

• Most of the described functions are available on the context menu.  

• You can change the font size. For example, select a smaller size to 
display more on-screen information. 

• Press the F1 key for online Help information about a specific column. 

• Press the F8 key to open an edit dialog box for a specific field. This 
prevents input of incorrect or invalid values and names. 

• Press the F9 key to fill an entire column with the value of the current 
field. In this way, you can also extend logical rows of numbers. For 
example, if the input in the first three fields is 2, 4, and 6, the row is 
continued with 8, 10, 12, etc. 

Working with Several Windows 

Chromeleon not only supports working efficiently with several open 
windows, as is typical in Windows programs, but it also introduces what has 
become possible with object-oriented programming of applications and was 
not common before: 

Data representation is always updated in all windows. 

For the examples below, the sample chromatogram was integrated and 
analyzed, using specific detection parameters.  
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Example 1: If you correct the ⇒Minimum Area detection parameter in 
the QNT Method by entering a smaller value, the related 
chromatogram in the Integration window is immediately 
updated. Peaks with an area smaller than the minimum 
area are not considered for integration. 

Example 2: Similarly, the result of a baseline that has been modified 
manually is displayed immediately in the Integration 
report window. 

User Profiles (Workspaces) 

Chromeleon allows you to save the window arrangement of any work 
situation, i.e., a combination of the different windows, in a workspace.  

This facilitates opening single files or windows and allows you to work in 
whatever work environment you prefer.  

The information about the windows is stored in a WSP file. If you want to 
use a specific workspace when you start working, open the corresponding 
WSP file, or generate a new WSP file by storing the screen contents. The 
following commands are available on the Workspace menu: 

• Select Open Workspace to open an existing workspace.  

• Select Save Workspace to save the current workspace.  

• Select Save Workspace as to save the current workspace with a new 
name.  

• Select Autosave Workspace to always save the most recent 
workspace as the default workspace.  

There is no restriction as to the number of windows that can be saved with 
each workspace. (Also, see Basic Operation  The Windows.)  
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A useful workspace arrangement might combine, for example, the report, a 
control panel, and the Browser:  

 

The appearance of each window is stored in the related file. For example, 
the appearance of the on-screen report and the Printer Layout is stored in 
the  Report Definition file. 

 Tip: 
When Chromeleon is started, the most recently used workspace is loaded. 

Report Definitions 

The Report Definition File (RDF) comprises the current settings, such as, 
the names and scaling of axes, representation of chromatograms and 
spectra, display of additional information or auxiliary lines, font settings, 
styles, and sizes, as well as the column arrangement in a table. The report 
definition also determines how the screen contents (hardcopy) or online 
batch results are printed. (For more information, refer to Basic Operation 

 Printing.) 
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Unlike a workspace, a report definition can be used for individual windows. 
If no workspace is loaded, each new window is opened based on the most 
recently used report definition. If you have not yet stored a report definition 
file, the default Chromeleon RDF is used. The default report definition file 
(DEFAULT.RDF) is available in the Report directory. 
• Select Save Report Definition on either the context or View menu to 

save the current settings. 

• Select Load Report Definition on either the context or View menu to 
open a previously saved Report Definition File. 

Create or Open Files, Windows, and Templates 

There are several ways to open or create files, windows, and templates. 
Frequently, additional information is required, also.  

For example, when you open a control panel, the control panel searches 
"its" timebase, i.e., the correct link between the client PC and a certain 
chromatography system ( Timebase) and each method window searches 
data from a specific Datasource. 
 

 Tips: 
If problems arise, they mainly occur because timebases or datasources 
were renamed that were correctly installed before by Dionex Service.  

Similar problems may occur if databases are located on a network PC to 
which you currently cannot connect or for which you do not have share 
authorization. 

In this case, refer to How to …: Working with Files, Databases, and 
Networks  Connecting a Datasource in the Administrator Help 
section. 
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Automatically Loading the Most Recent User Profile 
Chromeleon automatically loads the most recently used workspace. If this 
is not possible, Chromeleon opens the Browser. 

Opening Existing File Types and Windows 
Select Open on the File menu, and then select the datasource and the 
directory containing the file to be opened and the file type. Refer to the 
online Help for more information about this dialog box.  

Or else, double-click to open a file in the Browser.  

Open Most Recent Files and Templates 
The lower section of the File menu and the Workspace menu list the most 
recently used templates and files. Click to open a template or file. This is 
the simplest and quickest way to continue an interrupted task. 

New 
Select New on the File menu to receive a list of all possible file types and 
chromatographic operations. 
• Select Control Panel to open a window from which you can control the 

chromatography devices of a specific timebase.  

• Select Sequence File (using Wizard) to start the  Sequence 
Wizard. The wizard guides you through the creation of a Sequence. 

• Select Sequence (from LIMS Worklist) to include the data and 
Sequence of a LIMS in the Worklist format.  

• Select Program File to start the  Program Wizard. The wizard 
guides through the creation of a  Control Program (PGM File). A 

PGM File includes all ⇒Control Commands that must be 
communicated to the different chromatography devices so that they 
can process a sample or a series of samples.  

• Select Method File to create a new quantification method.  

• Select Spectra Library to create a new spectra library. 
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Printing 

The Chromeleon Printer Layout provides numerous options for the 
presentation of the results. Similar to a word processor, you can choose 
between printing the on-screen contents and printing based on defined 
templates.  

Printing from the Browser 
If you have selected one or several samples or sequences in the Browser, 
you can select Batch Report on the File menu to start the printout. Use the 
Batch Report dialog box to determine which Report Definition File (RDF) 
is used, which pages of the printer layout are printed, and for which sample 
type and channel the printout is performed. The single pages are created in 
the Printer Layout. (See Data Representation and Reprocessing  The 
Printer Layout for more information.) 

 Note: 
Click Setup in the Printer Layout to define the page format. (For more 
information, refer to How to …: Preparing the Printout  Changing the 
Page Format.) 

Printing from an Online Batch 
If several samples are processed in an automatic sample batch ( Batch 
Processing), you can determine which pages of the Printer Layout are 
printed. Printing can start either immediately after a sample has been 
processed or after the entire sequence has been processed.  

 Note: 
The report template used for printing is stored with other settings (such as 
screen settings) in the Report Definition File (RDF). Future Chromeleon 
versions will save the screen and the print settings separately. 
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Printing the Screen Contents  
To print the contents of the active window, select the related Print 
command. Select Print Sequence to print the current sample list from the 
Browser, with either the corresponding PGM File or QNT File. If a PGM 
File is open, you can print the required views by selecting the Print 
command. In the same way, you can print the selected pages of a 

Quantification Method (QNT Method) from the QNT Editor by selecting 
Print QNT Method. 
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Control 

Control (Overview) 

Chromeleon supports controlling instruments from different HPLC, IC, and 
GC device manufacturers. The prerequisite is that the instrument to be 
controlled is installed and configured in Chromeleon. For more information, 
refer to  Control Requirements.  

In principle, there are two ways a sample is analyzed: 

1. Automatic analysis of many samples in a sequence 

2. Manual analysis of single samples 

Automatically analyzing many samples in a sequence 
If you want to process many samples one after the other, you have to 
determine in a  Control Program how the single samples are to be 
analyzed.  

First, use the  SmartStart Wizard to create an equilibration program for 
preparing a Dionex Summit system for sample analysis.  

The  Program Wizard assists you in creating typical control programs. If 
you want to edit the program later, use the  PGM Editor.  
In addition, you have to determine in a Sequence in which order the 
samples are analyzed and which program is used. For more information, 
refer to  The Sample List (Sequence). 

Manually analyzing single samples 
To create a new chromatographic method, you can control the instrument 
directly from the Control Panel, which means that the single devices and 
device functions are controlled directly and interactively from the control 
panel. (Also, see Basic Operation  The Control Panel.) 
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Control Requirements 

To control devices make sure that 

• The appropriate  Chromeleon License is available. 

• The controlled instruments are correctly installed and configured in the 
Server Configuration program. 

 Tips:   

Dionex Service or a network administrator usually performs installation. 
The Administrator Help section provides more information; refer to 
Hardware Installation: 

 Installing Dionex Devices 

 Installing and Controlling Third Party Devices 

• A connection exists between the PC and the Chromatography Server.  

• A connection has been established between the chromatography 
server and the chromatography system via a serial interface, a DX-
LAN, or any other interface (TCP/IP, GPIB, USB). (For more 
information, refer to Software Installation, Communication, and 
Validation  The Serial (RS-232) Interface and/or  The DX-LAN 
in the Administrator Help section.) 

The Control Program 

Modern analytical laboratories usually analyze many samples. These 
samples are grouped in Sequences and processed with a 
chromatographic control Program. The control program is part of the 
PGM File. When creating a program, you include a list of commands and 
the times when the commands will be executed (relative to the time of 
injection). Chromeleon automatically adds the ⇒Inject and ⇒End 
commands. The Program is displayed in the Commands view of the 
PGM Editor:  
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 Tip:  
Dionex recommends always editing programs in the associated Device 
view. The Device view is easy to use and ensures correct command 
syntax. Use the Commands view only if the desired parameters are 
unavailable in the Device view. 

When starting the program, all commands are executed precisely at the 
defined time. 
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For more information, refer to: 

 The SmartStart Wizard  

 The Control Program (Details) 

 The Program Wizard 

 The PGM Editor 

 The Program Syntax 

 

 The SmartStart Wizard 
Dionex recommends that you equilibrate the chromatography system with a 
special equilibration program before starting sample analysis. The 

SmartStart Wizard assists you in creating such a program for the 
Summit HPLC system and allows you to define the necessary 

equilibration steps. You may extract these steps from an existing program 
or use the current instrument settings, instead, and edit them if necessary. 
The wizard includes the following steps: 
 
Step 1: Select a Timebase (if no timebase is selected in the current 

window) 

Step 2: Extract the equilibration conditions 

Step 3: Edit the equilibration conditions 

Step 4: Start equilibration 
 
After the wizard is finished, Chromeleon generates an equilibration program 
and sample. Besides, a Control Panel is opened, displaying the progress 
of equilibration. The control panel contains one stripe for each device. In 
addition, the Start Batch on …? dialog box is opened. The equilibration 
sequence is added at the top of the Batch list. When you start the batch, 
the system will be equilibrated first. When equilibration was successful, 
Chromeleon continues with processing any other sequences in the batch. 

For more information about how to equilibrate the Dionex chromatography 
system with Chromeleon, refer to How to ...:  Equilibrating the 
Chromatography System. 
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 The Control Program (Details) 
The control program, which is often referred to as the Program or PGM 
File, includes the user's list of time-precise ⇒Control Commands. The 
purpose of a control program is the automatic and repeated execution of 
specific routine tasks, such as processing samples automatically or 
conditioning a column by rinsing with various solvents. In addition, the 
control program allows monitoring certain parameters or limits, or triggering 
reactions when these limits are exceeded. 

A Wizard (see  Program Wizard) assists you in creating a program by 
automatically converting your entries into the appropriate Chromeleon 
program commands. In this way, you can create a program even if you do 
not know the command syntax. 

To edit an existing program, double-click the program name in the Browser 
to open the program in the most recently used view of the PGM Editor (see 
Control  The PGM Editor). 
To edit the control settings for a device, click the associated device icon on 
the left pane. This view provides the corresponding pages of the Program 
Wizard. Enter new parameters or change existing parameters according to 
your requirements. 

 Tip:  
Dionex recommends always editing programs in the associated Device 
view. The Device view is easy to use and ensures correct command 
syntax. Use the Commands view only if the desired parameters are 
unavailable in the device view. 
 

 Tip:  
Similar to a control panel, you can edit a PGM File only if it is connected 
with a Timebase while the server is running. Therefore, verify that the 
server is running. Start the server in the Chromeleon Monitor Program if 
necessary. To connect the PGM File with a timebase, select Connect to 
Timebase on the Control menu. 

If the PGM File is correctly connected with a timebase, icons for all devices 
in that timebase are provided, allowing you to access the associated PGM 
Wizard pages. 
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For more information about how to create a program, refer to  The 
Program Wizard. For information about how to edit a program with the 
PGM Editor, refer to  The PGM Editor. 
 
For practical tips, refer to:  

How to …: Creating and Modifying Programs  Creating a Program  

Device Control  Practical Tips for Device Control (Overview) 

 The Program Wizard 
The Program Wizard guides you through Program creation. To start the 
Program Wizard, select New on the File menu, and then select Program 
File.  

The Program Wizard systematically collects all information required to 
generate a basic program. Each step provides a template, allowing you to 
enter or select data. It depends on the installation which steps are required. 
For a typical HPLC or IC timebase, the Program Wizard includes the 
following steps: 

Step 1: Select a Timebase 

Step 2: Select the tandem program (if a tandem timebase is installed) 

Step 3: Select the temperature settings (if supported) 

Step 4: Define a flow system 

Step 5: Determine a gradient or ramp profile (optional) 

Step 6: Define the tandem operation (if a tandem timebase is installed) 

Step 7: Enter the autosampler settings (if supported) 

Step 8: Determine channels and the duration of data acquisition 

Step 9: Determine signal parameters for the individual channels 

Step 10: Define the peak detection parameters for fraction collection  
              (optional) 

Step 11: Complete the Program Wizard 
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Chromeleon completes the information entered in steps 1 through 10 by 
adding the ⇒Inject and ⇒End commands, thus creating an operable 
program. The program is displayed in the Commands view of the PGM 
Editor. (For more information about the PGM Editor, refer to  The PGM 
Editor.) 

To edit the basic program, use the  Device Views. 

The PGM Editor (Overview) 

The PGM Editor allows you to edit the control programs ( PGM Files). To 
open the different views of the PGM Editor, click the icons on the left pane 
(the shortcut bar): 
View* Icon Description 
   
Commands 

 

Displays the program  

(see  The Commands View) 
   
Post-acquisition 
steps 

 

Determine the steps for data reprocessing  

(see  The Post-Acquisition Steps View) 
   
If the respective instrument is installed, the associated icon is available: 
   
Surveyor MSQ or 
Finnigan AQA  

  

Enter or edit MSQ or AQA parameters (see 

 Surveyor MSQ or Finnigan AQA Views) 

   
ColumnOven  

  

Enter or edit thermostat or GC oven 

parameters (see  Device Views) 

   
Pump  

  

Enter or edit pump parameters  
(see Device Views) 

   
x2 Tandem 
Operations  

  

Enter or edit Tandem Operation parameters 
(see Device Views) 

   
GC  

   

Enter or edit GC parameters  
(see Device Views) 
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View* Icon Description 
   
Sampler  

   

Enter or edit autosampler or GC injector 
parameters (see Device Views) 

   
UV  

   

Enter or edit UV or GC detector parameters  
(see Device Views) 

   
RI  

   

Enter or edit refractive index detector 
parameters (see Device Views) 

   
Emission  

   

Enter or edit fluorescence detector parameters  
(see Device Views) 

   
Fraction  
Collection  
(FCA_Multi)    

Enter or edit fraction collection parameters (see 

How to ...:  Collecting Fractions). 

   
Relay and State 
Devices    Enter or edit relay and condition parameters  

(see Device Views)  

*   Note:   

The Device Name used in the Server Configuration program determines 
the Device Views name. For example, if you have named your pump HPLC 
Pump, the Device View is named HPLC Pump, also. (It is not named 
Pump, as stated in the above table.) The names in the table refer to the 
default names for Dionex devices, mass spectrometers, and GCs in the 
Server Configuration program. 

 The Device Views 

The different device views in the  PGM Editor provide a user-friendly 
way to edit an existing program at any time according to your requirements.  

The device views contain the related pages of  The Program Wizard. 
To modify existing commands or to enter new commands for a device, click 
the device icon on the left pane. In the device view, the respective page of 
the Program Wizard is re-opened.  
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Neither the device view nor the Program Wizard supports some of the 
special commands. Only use the Commands view to define these 
commands. For more information, refer to  The Commands View. 

 Tip:  
Dionex recommends always editing programs in the associated Device 
view. The Device view is easy to use and ensures correct command 
syntax. Use the Commands view only if the desired parameters are 
unavailable in the device view. 

 The Surveyor MSQ or Finnigan AQA Views 

These views of the  PGM Editor are part of Xcalibur. They allow you to 
specify the method used by the Surveyor MSQ or aQa mass spectrometer. 

AQA: On the Ionization Mode tab page, specify the mode of ionization 
(Electrospray/APCI). On the Analysis tab page, specify the sensitivity and 
fine-tune the mass spectrometer.  

 Caution: 
When using the Xcalibur method editor, disregard the Other detectors 
section and perform data acquisition as usual. Do not use this section for 
data acquisition with other detectors (such as the UV detector)!  

On the Acquisition tab page, set the aQa-specific signal parameters for 
Mass Spectra acquisition. 

Surveyor MSQ: The view displays the selected chromatogram, if available. 
Specify the Ionization Mode and, in the Full/SIM Scan Events section, 
specify the device parameters for mass spectra acquisition. 

 Tip: 
These views of the PGM Editor are part of the Xcalibur program. The 
Xcalibur Help system provides detailed information about mass spectra 
acquisition. If you use an aQa mass spectrometer, open the Xcalibur Help 
system via the Help menu or by clicking Help. If you use the MSQ, first 
click the question mark (at the top right) and then click the option of interest 
to open the corresponding Help topic.  

For more information about how to create an MS method, refer to How 
to …: Using Mass Spectrometers:  Creating a PGM File for the aQa 
MS and/or  Creating a PGM File for the MSQ. 
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 The Commands View 

The Commands view in the  PGM Editor shows the actual program, 
listing the various commands in chronological order. To facilitate orientation 
within a program, control commands are in black, comments in green, and 

Triggers in blue. 

 Tip:  

Dionex recommends always editing programs in the associated Device 
view (see Control/The PGM Editor  The Device Views). The Device 
view is easy to use and ensures correct command syntax. Use the 
Commands view only if the desired parameters are unavailable in the 
Device view. 

A control command starts with the time at which the command is 
executed. The time appears in Decimal Minutes, i.e., "2.500" means "2 
minutes, 30 seconds". The actual program instruction, such as 
⇒AcqOn/Off, appears after the time. 

 Note:  
You can integrate control commands into a program or perform them 
separately either from the Online toolbar or via the script buttons on the 
control panels. 

If the program instruction requires parameter input, enter the parameter(s) 
next in the text line. Use a point (".") to separate the parameter from the 
instruction. If several parameters are required, specify them in the following 
lines. Each parameter is identified by its parameter name, followed by "=" 
and the parameter value. Example: 

2.500 Pressure.LowerLimit = 10   

 Pressure.UpperLimit = 250 

You may include any number of comment lines between the instruction 
lines. Start each comment line with a semicolon.  
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 Note:  
If you want to edit your program later in the Device views, Dionex 
recommends entering all comments right at the beginning of the program. 
In some cases, Chromeleon cannot assign comments to the associated 
commands when re-sorting. Thus, it may happen that some comments 
appear at the wrong position after you have edited the program in the 
Device views. 

 Tip: 
By definition, the injection, i.e., the Inject command, is performed at 
retention time = 0. All preceding commands have negative times; all 
following instructions have positive times. 

The advantage is that the PGM time corresponds to the retention time of 
data reduction, e.g., integration, and thus, avoids errors such as falsely 
interpreted gradient profiles. The times of the AcqOn and AcqOff 
commands similarly coincide with the time axis of the reduction method. 

Select Command on the Control menu or press the F8 key to open a 
dialog box that assists you in editing the control commands. You can enter 
all instruction components (time, instruction, instrument, parameter, 
comment) separately. The system configuration determines which 
instructions and instruments are listed in the dialog box: 
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 Note:  
If the PGM File and the timebase are not connected correctly, the F8 box is 
not available and the program lines are displayed in gray.  

The input procedure via the respective device icons or the F8 key prevents 
entering invalid command syntax. If Chromeleon finds a command with 
unknown or incorrect syntax, the corresponding line appears red. 
• Press <F4> or <SHIFT> + <F4> to browse through the errors and 

correct any invalid input.  

When you edit a program file in the PGM Editor, the editor checks the 
validity of the instructions, also. You only have to enter the commands and 
their parameters and Chromeleon takes care of the rest. This means that 
Chromeleon:  
• Arranges the lines in chronological order. (Select Sort by Retention 

Time on the Control menu.) 

• Checks whether the input is valid. (Select Check on the Control 
menu.) For example: 

• Does the file contain at least one ⇒Inject command?  

• Is the first Inject command at time 0.000?  

• Does the file contain at least one Acquisition On command after 
the first inject? (If it does not, a warning appears) 

• Is a Acquisition Off command present for each Acquisition On 
command? (This input is compulsory.)  

• Are total and partial flow rates set at the beginning of the file 
(required for clearly defined gradients)? 

• Are the execution times of preceding instructions considered in the 
start times of program instructions? (If they are not considered, the 
start times in the program file do not coincide with the actual start 
time.) 

• Is the final instruction an end command? 

Before a program is started, Chromeleon performs a Ready Check to check 
the program for validity. In case of logical errors, for example, when 
Pressure.LowerLimit exceeds Pressure.UpperLimit, the program cannot 
start and a message appears, such as:  
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In case of errors, which may affect the course of the program without being 
critical, a warning appears. In this case, you can start the batch, 
nevertheless: 
 

 
 
If you are familiar with the  Program Syntax, you can change or extend 
your program directly from the keyboard. After editing, save the PGM File 
by selecting Save on the File Menu. 

For more information about how to create and/or edit a PGM File, refer to 
Control:  

 The Control Program 
 The Program Syntax 
 The Program Wizard 

For information about the different ⇒Control Commands, refer to:  

How to …: Creating and Modifying Programs  Creating a Program 
Device Control  Practical Tips for Device Control (Overview) 
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 The Post-Acquisition Steps View 

Use the Post-acquisition steps view of the  PGM Editor to define 
extraction and smoothing steps that are performed by the PGM File after 
data acquisition. In addition, you can copy existing channels or combine 
them using arithmetic operations. A new data channel is created for each 
step. The individual steps can be performed online after data acquisition, or 
offline of the chromatogram, UV spectrum, or mass spectrum.  

Therefore, the Post-acquisition steps view is one of many data 
reprocessing tools in Chromeleon, but it is not part of the actual control. For 
more information, refer to  Post-Acquisition Steps.  

For more information about post-acquisition, refer to How to …: Creating 
and Modifying Programs  Adding Post-Acquisition Steps. 

 

 The Program Syntax (Experts Only) 

 Tip:  
Dionex recommends always editing programs in the associated Device 
view (see Control/The PGM Editor  The Device Views). The Device 
view is easy to use and ensures correct command syntax. Use the 
Commands view only if the desired parameters are unavailable in the 
device view. To enter the commands, use the F8 dialog box as described in 
the Commands view (see Control/The PGM Editor  Commands View). 
Enter commands directly only if you know the correct syntax. 

For uniform operation by different users, ⇒Control Commands are in 
English. The syntax for the Program commands is as follows:  
Retention Time DeviceName.Command   

or 
Retention Time DeviceName.Property = Value 
 
If you are not familiar with the syntax, use the  Program Wizard and the 
different Device Views that guide you through program creation. 
For a list of the general commands and the commands supported for 
Dionex and third-party devices, refer to  Device Control (Overview). 
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Time (Retention Time) 
The time appears at the beginning of the control command and determines 
when the command will be executed. The time is in Decimal Minutes, for 
example, 
  

2.500 
 
This input is optional. If no time is entered, the time specified in the 
previous program line will be used.  

Device 
Devices are all instruments, channels, relays, or remote inputs that are 
available in the active timebase. You can identify them in the F8 dialog box 
by the device icon ( ). Each Device has a number of commands and/or 
properties.  

Various instruments can have the same commands or properties. 
Therefore, add the device name in front of the command to identify the 
instrument. The syntax is as follows:  
 
Retention Time DeviceName.Command  

or 
Retention Time DeviceName.Property = Value 
 
If no confusion occurs with other commands or properties, the device name 
can be omitted. For example, you can omit the device name in the Flow 
command when only one pump is installed. The syntax is as follows: 
 
Retention Time Flow = Value 
 

Command 

In the F8 edit box, commands are marked by an exclamation mark ( ). If a 
command exists for only one instrument, the name is sufficient for 
identification: 
 

2.500 NeedleUp   
 
The ⇒NeedleUp command exists only for the Dionex Autosampler 
GINA 50. In this case, the device name can be omitted. This is in contrast 
to:  
 

2.500 UV_VIS_1.AcqOn   
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The ⇒AcqOn command is not unique if there is more than one channel in 
the system. To address a specific channel, you have to add the channel 
name to the command.  

In addition, commands can be extended by additional parameters; for 
example: 
 

2.500 ⇒Inject Position = 20, Volume = 30 or 

2.500 Relay1.On Duration = 20  
 
The possible command extensions and their order are predefined. They are 
listed in the F8 edit box. As confusion is impossible, you can also use the 
following syntax: 
 

2.500 Inject 20, 30 or 
2.500 Relay1.On 20  

 

Device-Independent Control Commands 
Commands that are independent from a device appear as main entries in 
the F8 box. These are, for example  ⇒Branch, ⇒Log, ⇒Message, 
⇒Protocol, ⇒Wait, ⇒Delay, ⇒Trigger, ⇒EndTrigger, and ⇒End. 

For more information, refer to Practical Tips for Device Control  

 Trigger Commands 

 Mixed Commands 

Property 
Properties are distinguished by their value. An I/0 icon ( ) in the F8 edit 
box indicates that the value is predefined by the system. The  icon 
indicates that the values are freely selectable. A command string is also 
considered a property ( ). For example: 
 

2.500 UV.Lamp = On or 
2.500 UV_VIS_1.Wavelength = 300  
2.500 %A.Equate = "%A"  

 
If a property reports an actual value (for example, Pressure (bar), %A (%), 
Signal (mAU), etc.), the icon looks as follows: ( ). Properties related to the 
actual value are subordinate to it. For example, Chromeleon enables the 
output of the current system pressure (  pressure) and the definition of an 
upper and lower pressure limit (  UpperLimit and  LowerLimit).  
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Solvent names are assigned in the same way. (  %B,  Value, Equate). 
The syntax is as follows: 
 

2.500 pressure.UpperLimit = 350  
2.500 pressure.LowerLimit = 20  
2.500 %B.Value = 30  
2.500 %B.Equate = "Methanol"  

 
If the syntax is not clear, the device name must precede the command or 
property. For example: 
 

2.500 UV_VIS_1.Signal.UpperLimit = 500  
 

Text, Names 
Comments on the program or individual commands can be included before, 
after, or between individual commands. Comment lines always start with a 
semicolon ";" and appear green: 
 

; The following program ... 
 
Text that appears on the screen due to a command (as with the ⇒Protocol 
and ⇒Message commands) and that is logged in the Audit Trail, must be 
entered in quotation marks: 
 

2.500 Protocol  "Test program"  
 
When you enter these commands in the F8 edit box, the quotation marks 
are added automatically. 
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The Control Panel 

You can control the different devices of a timebase directly from a Control 
Panel (in short: panel; also referred to as online plot or online window). A 
control panel controls and monitors the chromatography instruments 
configured in a Timebase. With regard to appearance and function, it is a 
special type of window. In accordance with the Chromeleon philosophy, 
you are free to design its appearance in any way to meet your 
requirements. For more information, refer to: 

 Control Panel: Appearance 
 Control Panel: Function 
 Control Panel: The Signal Plot 
 Control Panel: The Audit Trail 
 Control Panel: The Trend Plot 

 Control Panel: Appearance 
Control Panels do not have a uniform user interface. A combination of 

various default controls determines the appearance of the control panel. 

Control panels can include, for example:  
• A slider to change the pump flow or any other variable parameter.  

• A separate field to display status information, such as the running 
retention time. 

• A "screen" LED to indicate whether the detector lamp is burning.  

• A script button to execute the inject command.  

• A signal plot to monitor the detector signal.  

• The current 3D Field and Mass Spectrum. 

• The current Trend Plot and 3D_Amp plot. 

• The Audit Trail to track the execution of an operation.  

You are free to determine the number of controls and their functionality to 
suit your needs. The functionality of the analytical instruments installed in 
the timebase determines which functions are available. For example, if the 
system includes a controllable column oven, the oven temperature can be 
controlled.  
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The system administrator assigns user-specific Privileges in the User 
Manager (CmUser program) to determine whether a user is authorized to 
create his or her personal user interface. The organization of the panel 
allows locking certain functions on the user interface or hiding irrelevant 
information. 

You can save a new user interface as a separate file (*.pan). Each user 
who can access the directory containing the file can select and use the file 
by clicking Open on the File menu.  

In addition, Chromeleon provides many default control panels, which 
cannot be modified by the user. These panels do not only cover all 
standard control functions but they can also be used easily and intuitively.  

For more information about how to create a control panel, refer to How 
to …:  Controlling Devices from the Control Panel. 

 

 Control Panel: Function 
Control Panels allow you to control and monitor the different 
Timebases. When you create a control panel, you specify which timebase 

shall be controlled from this panel. When you open the control panel, 
Chromeleon tries to connect to the specified timebase. A message appears 
if Chromeleon cannot connect to the timebase, for example, because it was 
renamed or because the related chromatography Server is not running. In 
this case, change the assignment manually:  
• Open the control panel by selecting Open on the File menu. 

• Select Connect to Timebase on the Control menu. Enter the name of 
the timebase to be connected with the control panel or select a name 
from the list. 

The new assignment is valid until you close the window. Save the window 
to have the current assignment available when you reopen the window the 
next time.  

The status bar indicates the selected timebase. 

 Tip: 
Select Integrate on the View menu to display the report for the running 
sample from the control panel. 
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 Control Panel: The Signal Plot 

The signal plot is an essential part of the  Control Panel. The Signals 
of the channels, which have been selected by the user, appear online, i.e., 
during data acquisition. 

Different commands are available on the context menu (right-click). They 
allow you to define how the signals are displayed:  
 
Autoscale Each time when performed, Autoscale adjusts the scaling of the signal 

axis exactly to the open chromatogram or to a section thereof. You can 
perform the command either from the context menu or by double-clicking 
the signal axis.   

Auto Autoscale Auto Autoscale automatically adjusts the scaling of the signal axis 
exactly to the open chromatogram or to a section thereof whenever the 
signal leaves the signal plot.   

Auto Plot Speed Auto Plot Speed prolongs the time axis automatically by the period 
defined on the Axis/Decoration tab page when the end of the signal plot 
is reached.   

Replot from 
Beginning 

When the signal reaches the right border of the signal plot, Replot from 
Beginning enlarges the window by the period defined on the 
Axis/Decoration tab page. Thus, the entire chromatogram is displayed, 
always. 

 

 Control Panel: The Audit Trail 
The Audit Trail on a Control Panel logs all commands performed during 
sample processing and saves information regarding the entire system. This 
includes graphical and text information. Chromeleon classifies ⇒Control 
Commands, status information, and error messages.  

When data acquisition is started, the Audit Trail reports the start time and 
all commands that are performed afterward (⇒AcqOn/Off, ⇒Inject, etc.). 

Each event that appears in the Audit Trail is stored. Storage is very precise 
and comprehensive, allowing you to track how a sample was processed 
and which events occurred during sample processing. For more 
information, refer to Data Management  Audit Trails. 

For documentation purposes, the  Sample Audit Trail is included in a 
report, by default. For more information, refer to How to …: Creating and 
Using Report Tables  Displaying an Audit Trail. 
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 Control Panel: The Trend Plot 

When included in a  Control Panel, the Trend Plot provides the ability 
to monitor impending problems by viewing a plot of module-specific data. 

 Tip: 
The Dionex Templates > Panels > Wellness directory of the local 

Datasource includes several examples of control panels with trend plots 
of module-specific data. 

The following commands are available via the context menu (right-click to 
select a command). The commands allow you to define the appearance of 
the trend plot. 
 
Full Size Displays the full-size plot of all trend data. 
  

Autoscale Scales the trend plot for optimal fit of the y values. 
  

Auto 
Autoscale 

Automatically adjusts the scaling of the trend plot for 
optimal fit of the y values. 

  
Unzoom Restores the previous zoom position. 
  
Flow Change 
Marks 

Displays vertical solid lines on the trend plot to indicate a 
change in flow rate. 

  
Eluent 
Change 
Marks 

Displays vertical solid lines on the trend plot to indicate a 
change in eluent. 

  
Module 
Change 
Marks 

Displays vertical solid lines on the trend plot to indicate that 
different serial numbers were found in sample sets with the 
same device name. 

  
Consumable 
Change 
Marks 

Displays vertical solid lines on the trend plot to indicate a 
change in a consumable part (for example, a column or 
suppressor). 

  
Calibration 
Marks 

Displays vertical solid lines on the trend plot to indicate that 
calibration was performed. 
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Statistics 
From 

Defines how statistics are calculated on the trend plot. 
Select one of these options: 
• All Data: Statistics are calculated from all data points. 
• Data in Viewed Range: Statistics are recalculated as 

soon as the currently viewed time axis changes. 
• Control Chart: Statistics are calculated from the target 

and 1s values entered on the Statistics tab page in 
the Trend Properties dialog box.  

  
Trend 
Variable 

Opens a dialog box in which you can select the properties 
of the plot, including the events, statistics, and data to 
display. 

 
For information about how to add a trend plot to a control panel, refer to 
How to …:  Modifying a Control Panel. 

The Panel Tabset 

A panel tabset provides a convenient interface for controlling and 
monitoring a Timebase. A panel tabset provides (on one window) a set of 
Chromeleon Control Panels for controlling the individual devices in the 
timebase and for performing system-wide functions (for example, creating 
and running sequences). To move from one control panel to another you 
click the corresponding tab. If multiple timebases are connected to a 
chromatography Server, the window is divided into panes, with each pane 
containing a panel tabset for one timebase.  

The default set of control panels in a panel tabset typically includes one 
panel for each device in the timebase and one or more panels for system-
wide controls. You can use these panels to perform the following tasks: 
• Operate system instruments manually (direct control) 

• Operate system instruments automatically (programmed control) 

• Monitor instrument status  

• View real-time data 

• Collect and view the system event log ( Audit Trail) 

• Perform calibration and diagnostic functions ( System Wellness) 
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Additional characteristics of the panel tabset: 
• Clicking a panel highlights its border and makes it the active panel. 

• Commands selected on the Chromeleon main menu apply to the active 
panel. 

• You can expand a panel tabset (and thus hide the other tabsets), split 
the window to view all tabsets at one time, or change the width of a 
panel. 

• You can add, delete, or rename individual panels within a panel tabset. 

 Tip: 

To open a default panel tabset, click the  icon on the standard toolbar. 

Also, refer to How to …:  Controlling Devices from the Panel Tabset. 
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Data Management 

Data (Overview) 

Input Data 
For the analysis of a sample and for documentation and archiving 
purposes, various types of input data are required, which you have to 
determine or enter before you can start the analysis.  

The required input includes, for example, the sample name, weight, 
injection volume, chromatographic conditions (solvent, flow, detection 
wavelength, connected devices, etc.), as well as the run time. Distinguish 
between: 
• Data describing a sample ( Sample Data),  

• Data describing a sequence ( Sequence Data, usually entered 
automatically), and 

• Data describing the chromatographic treatment of a sample 
( Chromatographic Methods).  

The user input is the basis for the analytical process.  

Input Data Output Data

Raw Data,
Protocol Data

Sample Data,
Chromatographic Method Analysis

 
  

Output Data 
The data recorded during analysis is referred to as output data. Output data 
includes: 
• Data provided by the analysis (analysis and/or Raw Data)  

• Protocol data on the analysis ( Audit Trail).  

Due to this variety of data types, systematic data organization and storage 
is especially important (see Data Management  Data Storage). 
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The Browser 

The Browser, Chromeleon's main tool for file management, lists all 
directories containing chromatographic data that you can access. 

In the Browser, you can open, move, and/or delete chromatographic data. 
In addition, you can search various databases for specific data. To open 
and view a file in a separate window, select the file by its name. 

 Caution: 
Browser functions and structure are similar to the Windows Explorer. 
However, do not confuse the Browser with the Windows Explorer. Do not 
use the Windows Explorer for operations within Chromeleon 

Datasources. Administrators can prevent these operations by selecting 
the Protect Datasource Directory option on the General tab page (via the 
Properties option on the datasource context menu). 

 

For more information, refer to:  

 Common Features with the Windows Explorer 
 Differences from the Windows Explorer 
 Function 
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 Common Features with the Windows Explorer 
Similar to the Windows Explorer, the Browser window has two separate 
panes: The left pane shows the directory structure in which the directories 
and folders are arranged. Detailed information about the files and 

Sequences appears on the right. You can handle the Brower items in the 
same way as you handle the items in the Windows Explorer:  
• On the left pane: Click the "+" sign beside a directory name to display 

the items underneath. Click the "-" sign to hide the items.  

• On the left pane: Click a directory to view its contents on the right pane. 
Files and samples appear on the right pane, as well. 

• On the right pane: Double-click a file open the appropriate editor for the 
file. Double-click a sample to open the chromatogram.  

A type-specific icon allows easy identification of the file types (sequence, 
PGM File, Quantification Method, etc.). Chromeleon automatically 

recognizes the ⇒Type (Sample Type) (standard sample, unknown sample) 
and/or the data format (e.g., 3D field) and displays the data in the 
appropriate chromatographic environment. 
• To drag a subdirectory, sequence, or file to a different directory, select 

the item. When you drag the selected item while holding down the right 
mouse key, a context menu opens. Select an option to copy or move 
the item to the new location. When you drag the selected item while 
holding down the left mouse key, the action, which was defined as the 
default action (Ask, Copy, or Move), is performed. 

 Differences from the Windows Explorer 

Structure 
Only chromatographic data that is part of a Datasource is presented in 
the Browser. (For more information, refer to the Data Management 
section.)  

The top-level item in the Browser hierarchy is the datasource. A datasource 
can be created only in the Browser; it is not a standard subdirectory in the 
Windows Explorer. A small icon indicates the type of data on which the 
datasource is based (e.g., Chromeleon data or GynkoSoft data). You can 
see only those datasources for which you have the appropriate access 
rights.  
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The directory structure underneath the datasource is similar to the directory 
structure in the Windows Explorer (yellow file icons), allowing you to 
organize the different Sequences in the datasource (identified by blue file 
icons). It is not possible to create a subdirectory underneath a sequence.  

Operation 
• Select a datasource, subdirectory, or sequence to display its contents 

on the right Browser pane. 

For a datasource or subdirectory, you see the usual list of all directories 
and files. If you select a sequence, the right pane is divided horizontally into 
two panes, providing information about the general properties of the 
selected sequence (header) and listing all analysis and standard samples 
and their sample data (Sequence Editor). 

 Caution: 
It is possible to edit the sample data right here. For GynkoSoft users, this 
corresponds to the Sample (SMP) File. You can add additional samples to 
the sequence, modify existing sample data, or remove old samples. For 
more information about the sequence editor, refer to the Samples and 
Sequences section. 

• To search for specific sequences, data, or samples, select Query on 
the context menu. It is possible to search several datasources 
simultaneously. A Query allows you to search both across several 
datasources and for specific properties, for example, "all samples 
starting with PAK." 

Moving, deleting, or copying directories, data, and/or files is very similar to 
these actions in the Windows Explorer. (For more information, refer to The 
Browser  Common Features with the Windows Explorer.) However, 
keep the following in mind: 

 Caution: 
Move, delete, or open chromatographic files only in the Browser. The 
reason is that, except for the visible results, processes are performed below 
the surface.  
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 Function 
In the Browser, you can: 

• Set up Datasources, create subdirectories, copy or move files via 
Drag & Drop, or remove files with the Cut command.  

• Select a Sequence on the left pane (blue folder icon) to display the 
contents, header, and sequence editor on the right pane.  

• Double-click a sample name to display the associated chromatogram.  

• Double-click a PGM File name to open the PGM Editor.  

• Select a file and right-click for more functions.  

• Select several files (as in the Windows Explorer) and right-click to 
perform a command for several files simultaneously.  

• Select a file, right-click, and start a Query for several sequences 
and/or datasources. The result of the query, which means the different 
files or samples with at least one common feature, is displayed on the 
right pane. 

The Datasource 

Top-level directories in the directory structure of the Browser are referred 
to as Datasources. The tool for datasource handling is the Browser. Each 
datasource is based on a separate database. When setting up a 
datasource, a path to an existing database is entered or a new database is 
created. 

• Select Datasources on the File menu to set up a datasource. For 
more information about the required steps, refer to How to …: 
Working with Files, Databases, and Networks  Setting up a 
Datasource in the Administrator Help section. 

The Browser indicates only the name of the datasource, but not the name 
of the underlying database. The type and number of the datasources visible 
to the user determine which data that can be accessed by the user. The 
advantages are as follows:  
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• Users access all data in the same way. They do neither have to worry 
about the data’s actual storage location on the network nor do they 
have to enter the entire path. The location is specified when the 
datasource is created. 

• Each user can take advantage of a database without having to deal 
with special database programs.  

Database Formats of a Datasource 
Chromeleon supports several database formats. In addition to the most 
frequently used Access database format (mdb container), Chromeleon’s 

ODBC Capability allows handling SQL ("Structured Query Language") 
and database formats, such as Oracle and SQL servers. "Old" GynkoSoft 
directories ("drives") and third-party data can be displayed as if they were 
datasources with an underlying database. Different icons allow easy 
identification of GynkoSoft and Chromeleon: 

GynkoSoft - Datasource
local CHROMELEON datasource

 
When Chromeleon is installed, a default datasource is automatically 
created on each client PC. The datasource name is the computer name 
(assigned during the installation under Windows) plus _Local. In this way, 
each user has a separate datasource in which (s)he can store his(her) 
"personal" results and data. For single systems and for users who do not 
have additional access rights on a network, this is the only way to store 
their data. The raw data of manually performed analysises are stored in this 
datasource, also. Therefore, do not delete the <PC NAME_Local> 
datasource. 

Directory Structure of a Datasource 
Each datasource can have any number of subdirectories organized in a 
hierarchical structure. To create a subdirectory, select the datasource in the 
Browser, and then select New Directory on the File menu. The data tree 
structure is similar to the MSDOS data tree. 

 Caution: 
Do not use special characters (such as the umlaut) for new directory names 
or sequences. This may cause problems in Novell networks! 
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Actions performed in the Browser, for example, creating datasources or 
directories, require complex operations below the user interface. They are 
different from actions in the Windows Explorer and therefore, they should 
not be performed from the Windows Explorer. The representation of 
directories and data differs considerably from the Windows Explorer, also. 

See the image below for examples of datasources and their different 
directory structures: 

Subdirectories

Sequences

Default Sequence
 

The SOURCE1 datasource has three subdirectories: LAB201, LAB202, and 
DYES. The DYES directory contains three Sequences: SEQ1, SEQ2, and 
SEQ3. 

The default PC Name_local datasource has one subdirectory. The name of 
the subdirectory corresponds to the name of the timebase installed on this 
computer. The default sequence (named manual) is located in this 
subdirectory.  

When a sequence is selected, its "inner life" is visible on the right Browser 
pane: file structure (control Program ( ), Quantification Method (QNT 
Method) ( ), Report Definition Files (RDFs), etc.), sequence information, 
and samples (standard samples ( ), and unknown samples ( ), etc.). For 
information, refer to Data Management  The Browser. For information 
about the functions and significance of sequences, refer to the Samples 
and Sequences section; especially, refer to  The Sample List 
(Sequence). 
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Drag & Drop allows you to move subdirectories, sequences, and 
chromatographic methods both in a datasource and between datasources 
of different types. Note that the items are copied and that this may change 
the underlying database. If you want to actually move a sample, first copy 
the sample to the new location, and then delete the original sample in the 
Browser.  

 Caution:  
Perform drag & drop operations only in the Browser. Performing these 
operations outside Chromeleon, for example, in the Windows Explorer, will 
result in the loss of data. 

Locking Datasources, Directories, and Sequences 
To protect data and results, you can lock datasources, directories, or 
sequences. It is not possible to modify Locked objects or any object under 
the locked one. For example, if a datasource is locked, all subdirectories 
and all sequences therein are locked as well. Locked objects are identified 
in the Browser by the red lock on the corresponding icon ( ). 
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How To 
• Select the object in the Browser. 

• Select Properties on the context menu. 

• Select the Locked check box.  

To remove the lock, return to the Properties dialog box and clear the 
Locked check box. 

 Note: 
Locking and sharing objects is subject to access control. (The 
Administrator Help section provides more information; refer to Software 
Installation and Communication  Access Control.) Only users who 
have the corresponding privilege can lock and/or share objects. 

In addition to locking datasources and directories by the Locked check 
box, access to these items can be controlled by adding them to Access 
Groups or removing them. 
• Select the datasource or directory in the Browser. 

• Select Properties on the context menu. On the Access Control tab 
page, define the Access Group assignment, using the Add and 
Remove buttons.  

Only users who are members of an Access Group listed in the Access 
Groups are authorized to access datasources and directories. 

Data Acquisition 

Even the best method of  Data Storage is only as good as the quality of 
the stored data. Therefore, data acquisition is a very important process, 
from the quality of the detector through all components participating in the 
data flow to data processing in Chromeleon.  

A distinction has to be made between detectors supplying digital data and 
detectors supplying analog data. The best results are obtained with 
detectors that are capable of communicating digital signals via a serial 
interface. (The Administrator Help section provides more information; 
refer to Software Installation and Communication  The Serial (RS-
232) Interface.)  
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Detectors that supply analog signals have to rely on precise conversion of 
the signals. The product range available from Dionex includes an extremely 
sensitive and low-noise UCI Universal Chromatography Interface for 
converting analog signals to digital signals. The UCI guarantees highest 
precision with minimum noise. 

The following terms are important for data acquisition: Data Collection 
Rate, Sampling Rate, and Step. However, sometimes it may be difficult 
to understand the relationship between these terms. 

If the detector directly supplies digital data to the PC, this is referred to as 
Data Collection Rate. In contrast, the term Sampling Rate is used if an 
A/D converter, such as a UCI Universal Chromatography Interface, 
supplies the data. Both terms describe the number of data recorded per 
second. 

Step describes the time interval between two data points. By default, the 
step is the reciprocal value of the data collection rate or the sampling rate. 
Nevertheless, it is possible to select a different step. There is nothing 
particular you need to observe if an A/D converter supplies the data. 
However, for detectors supplying digital data make sure to define the Step 
command after the Data Collection Rate command. 

Data Acquisition with Detectors without Separate 
Drivers 

In addition to the Device Drivers for controlling Dionex detectors, 
Chromeleon supports many drivers to control third-party detectors. For an 
overview of the different manufacturers whose devices can be controlled by 
Chromeleon, refer to Hardware Installation  Installing and Controlling 
Third-Party Devices in the Administrator Help section. 

In addition, it is also possible to acquire data using detectors for which 
separate device drivers are not available. In this case, install the 

Integrator Driver. 

For information about how to install the device drivers, refer to How to …: 
Configuring the Chromeleon Server  Adding, Configuring, or 
Deleting Components in the Administrator Help section. 
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Data Storage 

Intelligent data storage and organization is a prerequisite for fast and 
efficient access to specific data. That is why Chromeleon stores data and 
files in different locations. Databases and sequence directories, which are 
both part of the  Datasource, are available for this. 

Storing data in a database 
Data that can be compared across sequences is stored and managed in a 
relational, ODBC-capable database. This applies to all Sample and 

Sequence Data. The advantages of this type of data management are 
comfortable integration in other applications, such as Excel, Access, 
dBase, etc., and efficient searching and sorting capabilities. 

Therefore, you can perform, for example, a Query to find all samples 
processed on a certain day, created by a certain user, and/or having a 
certain name.  

Storing data together with the sequence 
The entire data describing the chromatographic treatment of a sample or 
recorded during the analysis is stored in a Sequence, including control 
files ( PGM File), evaluation parameters (QNT Method), and the entire raw 
and protocol data (see Data Management  Raw Data Storage). 

History (Modification History) 
For the datasources, you can enable the modification history (in short: 

History). This allows you to document all modifications together with the 
user name and the object name.  

Objects can be samples, sequences or datasources, Control Panels, 
Report Definition Files (RDFs), PGM Files and/or QNT files, and 

modified chromatograms. 

For more information, refer to How to …: Working with Files, Databases, 
and Networks  Tracking File Modifications (History) in the 
Administrator Help section. 
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Data Export 

Chromeleon supports various data export options for communication with 
other programs: 

1.  You can export report pages from the Browser, by selecting Batch 
Report on the File menu. In the Export options section, select the 
Export check box. The Export Wizard is opened automatically 
(otherwise, click Export Settings to open the Export Wizard manually). 
Chromeleon supports the following formats for data export:   

a)  ANDI/Chromatography - AIA (*.cdf) 

b)  ASCII text format (*.txt) 

c)  Excel file format (*.xls) 

d)  Adobe Acrobat file format (*.pdf) 

e)  Chromeleon Archive format (*.cmb = Backup files) 

For more information, refer to How to …: Creating and Managing 
Files and Data  Exporting Data During or After a Batch. 

2.  In the Printer Layout, you can open a dialog box that similar to the 
Export Wizard. First, enable the Layout Mode on the Edit menu. Then, 
select Batch Report Setup on the File menu to open the Batch Report 
Setup dialog box. Via the Printer Layout, you can export data from 
different samples in a single data file (refer to How to …: Creating and 
Managing Files and Data  Exporting Data from Different Samples 
to a Single File). 

3.  You can also open the Export Wizard from a Control Panel. Select 
Reporting on the Batch menu and select the Print/Export Report 
check box.  

4.  In addition, you can export raw data in the AIA format. To do so, select 
Export/Backup on the File menu in the Browser, and then select 
ANDI/Chromatography (AIA). (Also, refer to Data Management 

 Raw Data Export.) 
5.  If you wish to send Chromeleon data to another laboratory, for example, 

via e-mail, Dionex recommends that you perform a  Backup first and 
then transmit the compressed data as *.cmb file, which is the 
Chromeleon archive format. 



 Data Management 85 

You can also start the Chromeleon export function from a separate 
program, using the command line under Start > Run or a DOS command 
prompt. For more information, refer to How to …: Working with Files, 
Databases, and Networks  Using Chromeleon Data in an External 
Program in the Administrator Help section. 

Backup 

To avoid loss of data (for example, due to a defective hard disk), Dionex 
recommends that you back up your data to a different data medium at 
regular intervals, using the Backup command on the File menu in the 

Browser. 

Backup data is compressed, which means that the data is "packed" and 
stored in a different location. For security reasons (GLP does not allow 
modification of backup data), direct access to the data is not possible. To 
unpack the data, select the Restore command on the File menu in the 
Browser. 

The backup logs the files that are copied and issues warnings if an error 
occurs. The directory structure is maintained. 

For more information, refer to How to …: Creating and Managing Files 
and Data: 

 Creating Backup Files 

 Restoring Backup Files 

Raw Data 

Data generated by the system is referred to as raw data. Data entered by 
the user is referred to as user data. The user is not allowed to change the 
raw data, e.g.: 
• Sample data recorded on different channels (see Signal) 

•  Audit Trails 

• Injection times (see ⇒Inj. Date/Time) 

• History 
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In a narrower sense, all analog or digital values that are measured by a 
detector and stored digitally on the PC are referred to as raw data. Raw 
data exists only for signals or channels that were selected by the user 
before data acquisition. 

The selected Sampling Rate and/or the ⇒Step determine the extent and 
precision of the stored raw data. 
 
For more information, refer to  

 Raw Data Storage 
 Raw Data Compression 

Raw Data Storage 

Saving detector signals in digital form is referred to as raw data storage. 
However, raw data storage also includes other important data, such as the 
analysis time, signal unit, number of data points, etc. 

If a detector is equipped only with an analog output, the data must be 
converted into digital signals--a task performed by the A/D converter card.  

Storage Procedure 
With conventional data systems, an analog value is digitized at a fixed time 
interval, for example, every second, and stored with a defined accuracy. 
The number of values stored per second is referred to as the Sampling 
Rate. The inverse of the sampling rate (the time interval between two data 
points) is referred to as ⇒Step.  

The higher the sampling rate is (i.e., the smaller the step is), the more data 
points are stored and the more exactly the original signal can be restored 
from the stored data. However, a higher sampling rate has higher memory 
requirements. Therefore, Chromeleon supports the Step=Auto setting. It is 
true that this setting requires high algorithmic resources in real time, but it 
provides the following advantages: 
• Raw data files are as small as possible. Fewer data points would result 

in a loss of precision. If an analysis requires a conventional step width 
of 0.5 seconds, Chromeleon can typically acquire such chromatograms 
with an average step width (= chromatogram length divided by the 
number of data points) of 2 seconds. Thus, the compression factor is 
4:1, making optimum use of the available storage capacity. 
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• Despite the minimal file size, maximum integration accuracy is ensured 
for the given chromatographic conditions, as the continuous signal is 
approximated to the optimum. Generally, each peak includes more 
data points than with conventional acquisition methods. 

• The processing speed, for example, for peak detection, re-integration, 
graphical output, etc., is significantly higher due to the reduced number 
of data points. 

Storage Location 
Raw data is stored in the directory of the current sequence. A separate 
subdirectory is created for each channel specified during the installation of 
Chromeleon. An audit trail directory is created, also. The directories are not 
visible in the Browser. 

The reason is that Chromeleon manages raw data automatically. The user 
does not need to access the raw data directly at any time. 

You can view this type of data only in the Windows Explorer, but this is 
possible only if the datasources are not locked. Besides, the datasource 
names are not displayed in the Explorer. Therefore, you must follow the 
path to the corresponding sequence directory (see figure). 
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In the example, the 3dfield, Ext228nm, Uv_vis-1, and Uv_vis-2 channels 
were defined. An Audit Trail directory (Audit_Tr) is available, also. Click the 
"Plus" sign (+) beside a directory name to display the raw data of the 
corresponding channel.  

A separate raw data file is created for each sample in a sequence, for 
which raw data of a specific channel was recorded. 

 Caution: 
Do not modify these directories! Operations outside Chromeleon are not 
permitted! Dionex recommends that you protect your datasources to 
prevent access from the Windows Explorer. Select Properties on the 
context or File menu of the datasource and then select the Protect 
Datasource Directory check box.  

Raw Data Compression 

Storing raw data automatically compresses the data. For the signal value, 
this is achieved by storing the difference to the next data point instead of 
storing each data point separately. The actual value is stored only at 
intervals. In this way, the compression can be increased by 50%. This 
effect is especially noticeable in the case of 3D Fields.  

The size of the raw data file of a 3D field increases with the number of 
recorded data points. These depend on the Optical Resolution of the 
detector, the field size (area between the upper and lower limit of the 3D 
field) as well as the selected Sampling Rate. 

At a sampling rate of, for example, two spectra per second (step = 0.5) and 
an optical resolution of 2nm, this means that 2 x 60 x 70 = 8400 data points 
per minute must be recorded for the UV range from 200 to 340nm. As each 
absorption value is recorded with an accuracy of 25bits, a hard disk storage 
capacity of m x (N+1) x 4 = 70 x ((2x60)+1) x 4 = 33.88kByte per minute is 
required. The storage requirement for the 3D field of a "normal" (20-minute) 
chromatogram is thus 0.678 MByte! 

However, by skillful data compression procedures, it is possible to reduce 
the required storage capacity by approximately 50-60%. This is possible by 
completely storing approximately each eighth spectrum. Of all other 
spectra, only the difference to the previous one is stored and is re-
calculated, when needed. This procedure is a good compromise between 
optimum data compression and the required time for restoring a 3D field.  
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 Note: 
The compression procedure is not destructive, that is, the complete data is 
stored. The 3D field thus contains the complete information provided by the 
detector. The data can be restored at any time. 

Further, there are three ways to minimize storage capacity requirements:  
• Limit the wavelength range to the necessary range.  

• Reduce the sampling rate (step) so that no more than 10 to 20 spectra 
are below the narrowest peak, or select an automatic sampling rate 
(step). 

• Use the possibilities of the ⇒Diode Bunching. 

Restoring a Chromatogram from Raw Data 

When restoring a chromatogram from the raw data, equidistant data points 
are joined with straight lines. A diagram "resembling" the recorded analog 
signal is thus created.  

Clearly, the resemblance (and thus the precision of integration) is increased 
with an increasing sampling rate. However, a higher sampling rate requires 
more storage capacity. When using a fixed sampling rate, the sampling rate 
must be set so that a minimum of 10 datapoints is stored during the 
smallest peak in order to integrate the smallest peaks of a chromatogram 
(generally the earlier peaks) with the same precision as the larger peaks. 
This results, however, in huge data volumes especially in the case of wide 
peaks and long baseline sections. 

Using a dynamic sampling rate can solve this problem. Chromeleon is 
capable of continuously optimizing the sampling rate during an analysis. 
That is few data points are stored during baseline sections, whereas many 
are stored below peaks. The local sampling rate is set according to the 
actual information volume such that the deviation between the resulting 
diagram and the actual analog signal is never greater (or smaller) than the 
actual noise component of the signal. This method ensures that neither too 
many nor too few data points are stored, but always the optimum. The 
⇒Step values vary between 0.01 and 5 seconds (sampling rate: 0.2 to 
100 Hz). 
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Raw Data Export 

Chromeleon supports exporting raw data by conversion into AIA and 
ASCII formats. In addition, you can export raw data as Backup file 
(*.cmb). Select Export/Backup on the File menu in the Browser to export 
the data as an AIA or backup file. 
  
Format Description 
ANDI Cat.     2 Samples and peak variables are stored in the AIA format. 
ANDII Cat. 1+2 In addition to samples and peak variables, the raw data of a 

chromatogram (each stored data point) is stored in the ANDI format. 
Chromeleon 
backup (*.cmb): 

All data of a Sequence or a Datasource are stored in the cmb format.  

ASCII Raw data may be exported in the ASCII format as well. Select Batch 
Report on the File or context menu. Click Export in the dialog box and 
then select the ASCII export format. All raw data from the channels 
selected for the actual sequence are stored in the ASCII format.  

 Tip:  
If you intend to export raw data to other applications or other computers, it 
may be necessary to use a fixed ⇒Step (= equidistant raw data storage) 
instead of a dynamic step.  

It is also possible to export report data sheets in different formats (see Data 
Management  Data Export). 

Raw Data Import 

Importing the following raw data is possible: 
• • ANDI data (*.cdf) (see AIA) 

• Agilent/HP ChemStation 

• HP1100 LAS data 

• LIMS/ Worklist data (*.wle) 

• PeakNet (up to version 5.2) data 

• Files in the Chromeleon archive format (*.cmb) 
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On the File menu of the Browser, select Import/Restore and the 
corresponding option. Select Restore to import Chromeleon Backup 
data.  

In addition, it is possible to install databases from third-party 
chromatography data systems.  

How To 
• Open the Browser and select Datasource on the File menu.  

• Follow the instructions described in How to …: Working with Files, 
Databases, and Networks  Connecting a Datasource in the 
Administrator Help section.  

For details on importing PeakNet 5.2 or earlier data files, refer to How to 
…: Creating and Managing Files and Data  Importing PeakNet 
(Release 4.5 through 5.2) Data Files. 

Raw Data Storage in Case of Power Failure  

The raw data of a sample interrupted by a power failure is not lost, as a raw 
data autosave is performed continuously during sample processing. 
Autosave ensures that the raw data is stored on the hard disk in short 
intervals. The user can reduce the time intervals to approximately 30 
seconds. In the case of a power failure, the maximum data loss is thus 30 
seconds.  

If a power failure interrupts the automatic sample batch, the Power 
Failure Protection and the power failure handling ensure that processing is 
continued at the same position after starting the system anew. In addition, 
you can run a power failure program before to reset the system to a defined 
state. 

If processing is interrupted by warnings or error messages, it is possible to 
react with an appropriate Emergency Program. The system is then in a 
defined state that is recorded in the Audit Trail.  

For information about how to develop appropriate programs for both cases, 
refer to How to …: Creating and Modifying Programs:  Creating an 
Emergency Program and  Creating a Power Failure Program. 
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Audit Trails 

In addition to raw data, Chromeleon maintains an event log called the Audit 
Trail. An audit trail includes the following information:  

Audit Trail entries for Preconditions: 
 

 Device settings before a sample run, such as the temperature of a column oven.  

 Note: 
These entries can be displayed only in the daily audit trail and in the 
sample audit trail. 

Audit Trail entries for a sample run: 
 

 System messages, such as 
• Restart of Chromeleon after booting the computer 
• Start of sample processing 

 Warning 

 Error 

 Abort Error (batch or program is aborted) 

 Next command in the batch  
 

 Executed instruction. The color indicates the filter level. The message is displayed 
from this level on: 

 Green: Normal 
 Yellow: Advanced 
 Red: Expert 

This color code is not yet valid for manual and triggered commands. 

 Command executed manually from the control panel or the F8 box. 

 Triggered command 

 Fulfilled ⇒Trigger condition 

 ⇒Protocol; comments program steps or describes chromatographic conditions 

 ⇒Message on the screen that must be confirmed by the user 

 ⇒Log (performed by either the user or the Device Driver)  
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• Each item is stored with the current time of the Chromeleon server PC. 
Information gathered while recording data and/or processing a sample 
batch contain the associated retention time, also. 

• The Audit Trail information is stored continuously both over a whole 
workday and for the duration of processing a single file. Two different 
Audit Trails are available: 

 The Daily Audit Trail 
 The Sample Audit Trail 

 
Audit trails can be displayed in the Browser (as daily or sample audit trails), 
on a control panel, or in a report or Printer Layout (only as sample log). 

To define the extent and the type of the audit trail display, select the display 
filter (Normal, Advanced, Expert, and Error, or Warning) on the context 
menu. The Advanced and Expert display options are not available for 
audit trails created with Chromeleon 4.0 or lower. 

In addition, you can select one of the following options on the context 
menu: 
• Preconditions only to display only the conditions before a sample run  

• Preconditions and Run to display all entries 

• Run only to display only the entries for the sample run 

 

 The Daily Audit Trail 

The daily  Audit Trail records all events related to a specific timebase, 
thus facilitating compliance with GLP (Good Laboratory Practice). The 
information is displayed in the Audit Trail on the control panel (refer to The 
Control Panel  The Audit Trail). The Daily Audit Trail also records the 
preconditions before the sample run. 

When the Chromeleon Server is started, Chromeleon creates an AUDIT 
directory for the corresponding timebase in the server's standard 
datasource. The server saves the daily audit trail for the timebase to this 
directory. The name under which the file is saved is the current date. For 
example, the audit trail file for March 5, 2005, is named 20050305.slg. A 
separate file is created for each day. 
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In the Browser, the daily audit trails are listed on the right pane with their 
names and the time of the last change. Double-click a file name to open the 
related audit trail in a separate window. The information in the file 
corresponds to the information in the audit trail section on the control panel. 
However, the file also includes the preconditions. It is also possible to print 
the daily audit trail.  

Copy, move, rename, and delete daily audit trails in the Browser. The user 
rights required to perform these actions are defined in the User Manager 
(CmUser program). 

 Note: 
Chromeleon generates a new file for each daily audit trail. Therefore, 
periodically transfer files that are no longer required to an external storage 
device. 

 Tip:  
You can also open a daily audit trail from the panel tabset (refer to Control 

 The Panel Tabset). Go to the Sequence Control panel and click Daily 
Audit Trail under System Maintenance.  

In addition to the daily audit trail, a  Sample Audit Trail exists for each 
sample. 

 The Sample Audit Trail 
The sample audit trail contains all information that was recorded for the 
specific sample in the daily audit trail (see  Audit Trails). The sample 
audit trail is part of the default reports. For more information, refer to How 
to …: Creating and Using Report Tables  Displaying an Audit Trail. 
To display a sample audit trail, select one of the following options: 
• To view the audit trail information for the current sample, display a 

report in any method window and select the Audit Trail worksheet. 

• To view the audit trail information for a specific sample, right-click the 
sample of interest in the Browser and select Audit Trail on the context 
menu. 

If you do not find a specific entry in the sample audit trail, check the 
 Daily Audit Trail. 
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Samples and Sequences 

Sample Preparation 

Sample preparation is a major part of the chromatographic analysis. It can 
include simple procedures as weighing, solving, and diluting a sample, as 
well as more complicated physical (filtration, centrifugation etc.) and 
chemical separation procedures (liquid-liquid-extraction, fixed phase 
extraction). Generally, the careful performance contributes substantially to 
the quality and the reproducibility of chromatographic separations.  

In addition, Chromeleon provides two correction factors: Sample Weight 
Factor (Weight) and Dilution Factor. They allow you both to use the 
"approximates weight" and to define dilution steps. Thus, they can be used 
to consider sample preparation during data evaluation. 

Sample Processing 

Sample processing includes three major steps: 
• Sample definition (single samples and Sequence and/or Batch)  

• Analytical procedure (manual or automatic control - PGM File) 

• Evaluation ( QNT Methods and reports) 

The performance of each step depends on the methods that are used and 
the available instruments. The working environment could range from a 
fully automatic sample laboratory with large quantities of samples to single-
user applications in a research lab. Easy and quick analysis procedures 
may be the focus in the first case, while special methods and parameters 
for peak recognition may have priority in the latter case. Thus, it is not 
surprising that functions crucial to one group of users may be irrelevant to 
others.  

Keep this in mind when you read the information in the following sections.  
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Sample Definition 

In Chromeleon, the term sample is defined as follows:  

Each injection is defined as an individual "sample"! 
Multiple injections from the same sample vial under similar conditions are 
considered several samples. 

Defining a sample means the process of determining how much of a 
substance is injected from which vial and under which conditions, and 
which evaluation parameters are used. A distinction is made between a 
single sample and a sample series (= sequence). 

Single Sample 
A sample can be analyzed individually by entering all required information 
and user commands via the keyboard or the mouse.  

For manual injections, click the Inject icon on the Online toolbar, enter the 
injection volume, and perform the injection via a hand-operated valve. If an 

Autosampler is available, determine the sample location via the ⇒Inject 
command. Afterward, data acquisition is started (via the ⇒AcqOn/Off 
command). When the end of the sample is reached, you may end data 
acquisition by clicking the Acq Off icon on the Online toolbar.  

The recorded data is temporarily saved to the manual sequence of the 
default Datasource of the system. In network operation, this datasource is 
identified by the name of the computer with which the user is logged on to 
the  Network. 

When data acquisition has ended, you are prompted to enter the final 
storage location for the temporarily saved data. 

Sequence/Batch 
If several samples are to be processed successively, they are included in a 
sample list (sequence), together with the instrument control and evaluation 
information. 

The samples are then processed automatically. (For more information, refer 
to Batch.) 

For more information about how to create a sample list, refer to  The 
Sample List (Sequence). 
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The Sample List (Sequence) 

The sample list is part of the Browser. (For information about the Browser, 
refer to Data Management  The Browser). When you select a 

Sequence, the sample list is displayed on the lower right of the Browser 
window. One line corresponds to one sample. During the chromatographic 
analysis, the samples to be analyzed are processed from the top to the 
bottom of the sample list. Thus, the sample list also determines the order 
(= sequence) in which the analysis is performed. 

The entire data collected for creating and processing a sequence, including 
the raw data and protocol data recorded during the analysis, is saved in the 
sequence directory of a Datasource or in the underlying database. This 
also includes the raw and protocol data recorded during the analysis: 

 

A sample is characterized by various column entries. You may add or 
delete columns or change their order. In addition, you can use User-
defined Columns and Sequence Report Columns and thus, adapt the 
appearance of the table according to your specific requirements. The layout 
is saved as well. Therefore, if you reedit the sequence later, the 
representation will correspond to the one of your last access. The order in 
which the samples appear in the table is identical to the order in which they 
are to be processed. 
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The entries are managed in a database; they are referred to as Sample 
Data. For a short explanation of the columns, press the F1 key. For more 
information about the columns, refer to ⇒Sample Variables. 

Before each new analysis, you have to enter all samples to be processed 
and the characteristic sample data into the sample list. There are two 
options:  

1. Manually change an existing sequence, and then save it under a new 
name. 

2. Have Chromeleon create a new sequence automatically via the 
 Sequence Wizard. 

For more information, refer to How to …: Creating and Managing Files 
and Data  Creating a Sample List.  
In addition to "real" sample data (such as the sample name, the injection 
volume, the vial, and the sample type (unknown or standard)), the sample 
list also contains the Program File and Method columns. The entries 
made in these columns refer to specific Chromatographic Methods 
determining the performance of the analysis. They include the control 
program (see Control  The Control Program) required for fully 
automatic control of analytical instruments as well as evaluation instructions 
(see The QNT Editor  The Quantification Method (QNT Editor)) 
determining the integration and calibration. In addition, the sample list can 
contain User-defined Columns and Sequence Report Columns. 

The number of samples per sequence is virtually unlimited, but more than 
100 samples should be an exception. The fewer samples are added to a 
sequence, that is, the more sequences are created, the faster single 
samples can be accessed and the easier it is for the user to keep track of 
the processed samples. Criteria for combining several samples in one 
sequence could be, for example, the same analysis conditions, the same 
origin, the samples of the same day, etc. 
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The Sequence Wizard 

The Sequence Wizard helps you to quickly create a basic sample list 
consisting of analysis and standard samples. To open the Sequence 
Wizard, select New on the File menu in the Browser. Follow the steps 
below to create a Sequence: 
• Timebase: Select the timebase.  

• Unknown Samples: Generate the analysis samples.  

• Standard Samples: Generate the standard samples. 

• Methods and Reporting: Determine the PGM File and the analysis 
method.  

• Saving the Sequence: Name and save the sequence.  

Each step is performed on a separate wizard page. Clicking <Back or 
Next> takes you to the previous or next page.  

In the last step, click <Finish> to save the sequence and close the wizard.  

 Caution:  
Do not use special characters (such as the umlaut) for new directory names 
or sequences, as this may cause problems on Novell networks! 

 Note: 
The Timebase step is not included in Chromeleon Xpress. In addition, in 
the Methods and Reporting step, only a PGM file is selected. 

 Note: 
In future Chromeleon versions, it will be possible to include validation 
and/or blank run samples with the Sequence Wizard.  

For information about how to create a sample list, refer to How to …: 
Creating and Managing Files and Data  Creating a Sample List. 
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The Application Wizard 

The Application Wizard helps you to quickly generate a PGM File and a 
QNT Method for a Timebase, using parameters from either an 

application template or a Virtual Column template. You can then use the 
wizard to create a new Sequence, if desired.  

To open the wizard, select Application Wizard on the Tools menu in the 
Browser. The Application Wizard includes the following steps: 

• Step 1: Choose a timebase 

• Step 2: Choose an application tool 

• Step 3: Choose how program and method files are generated 

• Step 4: Generate and store the files for the application 

Each step is performed on a separate wizard page. Clicking <Back or 
Next> takes you to the previous or next page. 

 Note: 
Steps 1 and 4 are not included in Chromeleon Xpress. In addition, 
method files are not created in Chromeleon Xpress. 

Automatic Batch Processing 

The enormous technical complexity of modern chromatography systems, 
the resulting high purchasing costs, and the constantly increasing number 
of samples in analysis laboratories make continuous operation a necessity. 
Thanks to Autosamplers, very efficient PCs, and modern data systems, 
this has become routine. The user merely provides "replenishment."  

When the actual sample preparation is completed, the chromatographic 
conditions of processing, the samples to be processed and in which order 
must be communicated to Chromeleon. This is performed in the sample list. 
The result is stored as a Sequence.  

Independently processing one or several sequences is known as Batch. 
To start processing, the following steps are required:  
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Starting the Automatic Batch  
After data input is completed, the analytical process can be started in an 
online batch. 
• Open a control panel and select Edit on the Batch menu. (This 

command is also available on the Batch menu in the Browser.) 

• Enter the names of the sequences containing the samples to be 
analyzed. 

• Perform a Ready Check. 

• Start the analysis process by clicking Start. 

Online Batch: During the chromatographic analysis of the batch 
As soon as the online batch is started, all samples of the sequence with the 
status single or multiple are analyzed successively. If a sequence 
contains a sufficient number of samples, sample processing "around the 
clock" is possible.  

Instead of including all samples in one sequence, they can be distributed 
among several sequences. Accordingly, more sequences are entered in the 
batch dialog. 

This list is considered a batch; it is also referred to as online sample batch 
or online batch. The order of the sequences determines the order of 
processing: When starting the batch process, samples 1 to n of the first 
sequence, then samples 1 to n of the second sequence, etc. are analyzed. 

Offline Batch: After the chromatographic analysis  
The data acquisition results of the batch are saved with the individual 
samples. When the results are processed offline, e.g., printed, exported, 
signed, etc., after data acquisition is finished, a batch is called an offline 
batch. 
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Sample Evaluation 

In spite of largely automated work processes and intelligent pre-settings, it 
is within the responsibility of each user to set the framework conditions for 
sample evaluation. 

Calculations 
Sample processing is performed based on a PGM File that was 
previously created and included in the sample list. Similar to this, the 
analysis results are calculated based on the evaluation method indicated in 
the sample list. The method itself is created in the QNT Editor (see Data 
Representation and Reprocessing  The QNT Editor). For more 
information, refer to How to …:  Integrating Chromatograms and 
Identifying Peaks.  

Result Output 
The result of sample processing can be represented in graphics and tables, 
either on the screen or in a printed output. Chromeleon provides method 
windows for generating this output. Use the Printer Layout to define 
templates standardized presentations of the sample results. For more 
information, refer to How to …:  Creating and Using Report Tables 
and  Preparing the Printout. 

Overview of the Most Important Results in the Browser 
To take an overview of the sequence results already in the sample list, add 
the desired Sequence Report Columns to the list. For more information, 
refer to How to …: Creating and Managing Files and Data  Creating a 
Sequence Report Column. 
 
For more information about the available method windows, refer to  Data 
Representation and Reprocessing.  
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Electronic Signature 

During the last decades, quality assurance and GLP have become 
increasingly important. Data verification is one of the key aspects. That is 
why it is especially important to ensure that Raw Data is not modified 
later. In addition, the results generated from this raw data must not be 
modified without authorization once they have been accepted. Contrary to 
a data system, printed records can ensure this in part only. 

If User Mode is enabled, Chromeleon allows you to electronically sign the 
results generated from your raw data. This is an important aspect for quality 
assurance and GLP. Electronic Signature allows you to sign and to protect 

Sequence reports that have been accepted as correct and thus, to 
'freeze' the current state of your results.  

 Note: 
Electronic signature is only available for user databases that were created 
with a User Manager (CmUser) program version 6.10 or higher. Update 
your database if an error message notifies you that electronic signature is 
not supported. 

Electronic signature includes three steps: 
• Submit  

• Review 

• Approve 

Typically, the user who created the report signs and submits it. Afterward, 
for example, the laboratory manager reviews the report and signs it as well. 
Finally, the quality assurance manager approves the results. 

For information about how to sign reports electronically, refer to How 
to …: Creating and Managing Files and Data  Signing Sequences 
Electronically. 



104 Samples and Sequences 

 



 Theory of Calibration 105 

Theory of Calibration 

Calibration (Overview) 

If the signal of a chromatography detector is proportional to the 
concentration of a substance in the flow cell, it is suitable for quantitative 
determination. This is a characteristic, for example, of the absorption 
supplied by a UV detector in the scope of the Lambert-Beer law. 

The proportionality constant depends on the chemical quality of the 
substance of interest and on the physical properties of the used detector. 
For UV detectors these are mainly the optical wavelength and the spectral 
bandwidth. As integration programs can only determine the area (and 
height, respectively) below a peak, conversion into absolute amount or 
concentration units is possible only if a calibration was executed before the 
analysis.  

For more information, refer to: 

 Calibration Principle 

 Calibration Types (Linear) 
 Calibration Types (Non-linear) 
 Using the Calibration Curve 
 Calculating the Calibration Curve 
 Standard Methods  
 Evaluation with Various Standard Methods 
 Evaluation with the Standard Addition Method 
 Implementation 

 
At the end of a calibration, Chromeleon creates calibration curves from the 
available calibration points for each calibrated substance. Representing 
and evaluating the curves is performed in the calibration curve method 
window (see Data Representation and Reprocessing  The 
Calibration Curve). 
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 Calibration Principle 
The principle of the calibration is based on that one or several samples of 
known composition are analyzed by chromatography and a conversion 
factor amount (or concentration)/ area is calculated from the detected areas 
below the individual peaks and the known amounts or concentrations. This 
factor can then be used to multiply the area of the respective peak of an 
unknown sample. The result is the corresponding amount of the substance 
(or concentration of the substance). However, this simple method will work 
only, 
• If the relation between amount and area is strictly linear, i.e., if the 

Lambert Beer Law is applicable for UV detectors. 

• If the area zero equals the amount zero, i.e., if the calibration line leads 
through the origin (no offset) and 

• If matrix effects can be neglected 

If the detector signal S is proportional to the concentration (K) of a 
dissolved substance, the proportionality factor c1 applies: 

S  =  c1 * K 

Under certain conditions, the area F(x) corresponding to a certain amount 
(x) is proportional to the contained amount. 

F(x)  =  c1 * x  

If a sample of the substance A of known concentration (the standard or 
calibration sample) is analyzed chromatographically, the result is a specific 
ratio between the injected amount and the determined area value. The 
result can be graphically presented by entering the value pair in an 
amount/area diagram. In this diagram, each injection corresponds to one 

Calibration Point. 

Ideally, all calibration points are located on a straight line, and there is a 
direct ratio between the amount and the determined area. The "conversion 
factor" corresponds to the slope of the calibration line (left fig. "ideal"). 
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During each calibration, deviations from the ideal behavior might occur 
which are above all caused by weight and/or dilution errors. This causes 
scattering of calibration points. Therefore, the Gaussian method of the least 
squares (see  Calculating the Calibration Curve) is used to calculate a 
regression line. This line is defined as the best approximation to the 
existing calibration points and, usually, it does not go through the origin 
(right fig. "real"). 

If the various calibration points are not located on a straight line, but show a 
parabola or exponential shape, the slope of the curve and the distance to 
the zero point (offset) describe the corresponding (approximate) curve 
(calibration curve). The basic mathematical function is referred to as 

Calibration Function; the coefficients are the calibration coefficients.  

By selecting the ⇒Calibration Type peak table variable, the user decides 
whether a linear or a non-linear calibration curve is calculated from the 
existing calibration points. Distinguish between the following calibration 
types: 

 Calibration Types (Linear) 

 Calibration Types (Non-linear)  



108 Theory of Calibration 

 Calibration Types (Linear) 
If one calibration sample of a standard substance is analyzed for calibration 
only, the user enters exactly one concentration value in the first ⇒Amount 
column on the Amount tab page of the QNT Editor the peak table. (For 
more information about the editor, refer to Data Representation and 
Reprocessing  The QNT Editor.) The result is exactly one Calibration 
Point. Connecting the calibration point with the origin then forms the 
calibration curve. It is described by the function derived from the Lambert 
Beer law: 

xcxF *)( 1=  
The slope of the line corresponds to the proportionality factor c1 (leftmost 
image). c1 is also called RF value. 
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If one calibration sample is analyzed several times, several points can be 
entered in the amount/area diagram. The points of one concentration are 
called replicates. With an increasing number of available replicates, the 
impact of imprecision decreases after averaging. In spite of several 
replicates, only one amount/area ratio is determined. This is referred to as 
multi-point calibration on one calibration level (center image). 

The result is better secured if several concentrations are measured instead 
of one. Of course, several replicates can be used per concentration. As a 
result, calibration points at different concentrations are received in addition 
to the replicates of one concentration. This is called a multiple point 
calibration on several levels (for example, 3-level calibration (see the 
rightmost image)). The calibration curve does not necessarily have to go 
through the origin. The linear Calibration Function is therefore corrected 
by an offset.  

xccxF *)( 10 +=  
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 Caution:  
The decision whether a calibration type differing from the linear default is 
physically sensible, is within the responsibility of the user, not of 
Chromeleon! 

 Note:  
If you calibrate using the Standard Addition method and if no calibration 
points are available with Amount = 0 (only Spiked samples), Chromeleon 
calibrates with an offset. 

If calibration points with Amount = 0 are available (also Unspiked samples) 
and if you calibrate using the Linear calibration method, the calibration 
curve does not go through the origin. Instead, it is forced through the mean 
of all samples for which Amount = 0; i.e., all unspiked samples for this 
substance. Please note that the results may be different from those 
obtained by calibrating using the Linear with Offset calibration method. 

 Calibration Types (Non-linear) 
In (the more general) case of a non-linear calibration, more terms are 
added to the linear Calibration Function.  

Parabola-shaped curves are described as follows: 

2
21 **)( xcxcxF +=  (Quadratic) 

2
210 **)( xcxccxF ++=  (Quadratic with offset) 

 
In some cases, especially in gas chromatography, there is cubic 
relationship: 

3
3

2
21 ***)( xcxcxcxF ++=  (Cubic) 

3
3

2
210 ***)( xcxcxccxF +++=  (Cubic with offset) 

 
To calculate curves of this type, a minimum of two (quadratic), three 
(quadratic with offset or cubic), or four (cubic with offset) calibration 
samples must be available (for the quadratic relationship, see the leftmost 
picture).  
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 Note:  
If you calibrate using the Standard Addition method and if no calibration 
points with Amount = 0 are available (only Spiked samples), Chromeleon 
also calibrates with an offset when the Quadratic or Cubic calibration 
method is used.  

If calibration points with Amount = 0 are available (also Unspiked samples) 
and if you calibrate using the Quadratic or Cubic calibration method, the 
calibration curve does not go through the origin. Instead, it is forced through 
the mean of all samples for which Amount = 0; i.e., all unspiked samples for 
this substance. Please note that the results may be different from those 
obtained by calibrating using the Quadratic with Offset or Cubic with 
Offset calibration method. 

The power function is described as follows:  
1*)( 0

cxcxF =  
To calculate curves of this type, a minimum of two calibration samples must 
be available (see the image in the center). 

 Note:  
If you calibrate using the Standard Addition method and if you use the 
Exponential calibration function, the expected offset value is subtracted 
from all calibration points with positive amount values (i.e., from all 

Spiked Samples). Thus, the following formula applies: 

1*~)( 0
cxccxF +=  
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Distinguish between the following cases: 

a) If no calibration points with Amount = 0 are available (only Spiked 
samples), the expected offset is calculated using the Linear with Offset 
method, i.e.:  

0
~ cc =  

b) If calibration points with Amount = 0 are available (also Unspiked 
samples), the expected offset is the average of all samples with 
Amount = 0. 

If none of the above functions can be applied to the available Calibration 
Points, the calibration curve can be described as a polygon, that is, a linear 
interpolation between two adjacent calibration points (Point to Point). If 
several replicates of one calibration level are available, these are averaged 
before interpolation.  
 

 Caution:  
The decision whether a calibration type differing from the linear default is 
physically sensible is within the responsibility of the user. 

A large number of replicates increases the precision and the reliability of 
the curve at this point (on the calibration level), but is not decisive for the 
entire curve. The more calibration levels are examined, that is, the more 
standards of different concentrations are measured, and the more precise 
is the area/amount allocation for a larger range. To be exact, the calibration 
is valid for the range of the calibration samples only and not beyond it. 

 Using the Calibration Curve 
If the calibration coefficients are known, the amount value can be 
calculated for any area value by inserting the coefficients in the formula of 
the respective calibration type.  

Within the range of the curve that is covered by the calibration points, it is 
possible to convert any peak area into the corresponding amount. This is 
shown in the following example: 
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Standard Sample 
The user enters the amounts (x1 to x4) of the different standard samples 
and determines the Calibration Function by selecting the calibration type 
(here: linear with offset). Depending on the selected integration type, area 
values (F1 - F4) are established from the detected peaks. One area and 
one substance amount value form one calibration point. The positions of 
the calibration points determine the curve that Chromeleon calculates with 
an approximate method. The final course of the calibration curve is 
determined by the calibration coefficients (here: c0, c1). 

F = c0 + c1 * x x = + * F

0
c0

F4
F3
F2

F1

x1
c0

c0 1

c1

c1 c1

0
x3 x4x2
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Unknown Sample (Analysis Sample) 
In the case of an unknown sample, the previously calculated calibration 
coefficient and one or several area values are known. The area value is 
now a known parameter and is thus drawn in x-direction. In the diagram, 
the two axes must be exchanged for one another. As a result, the 
calibration function must be converted in its inverse function. This is also 
performed by Chromeleon. Now, the amount can be calculated by inserting 
the calibration coefficients and area values. 

Furthermore, the exclusion of outliers, the different weighting of calibration 
points, and the formation of "averaged" calibration points from one 
calibration level, are alternative ways of how to calculate the calibration 
curve.  
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 Calculating the Calibration Curve 
Calculation of the calibration curve ( Calibration Function) is based on the 
method of least squares. With a given calibration type (linear, linear with 
offset, etc.), the parameters of the calibration curve F(a), that is, c0, c1, c2, 
and c3 are determined so that the sum of the squared distances of all 
measured points becomes negligible. For this purpose, the following 
optimization problem is solved:  

∑
=

→−
n

i
iii aFxw

1

2 min))((*
 

(xi- F(ai)) refers to the distance of the xi-value from the calibration curve 
F(a), wi is the selected weighting (see Weights, for example, wi=1, 
wi=1/Amount or wi=1/Amount2) and xi is the actual value. 

The formula used for calculating the calibration curve depends on the 
 Standard Method (External/Internal…). For information about these 

formulas, refer to  Evaluation with Various Standard Methods. 

 

 Standard Methods 
Calibrations can be based on external or Internal Standards ("ISTD"). 
External standard means that there is a separate standard sample. Using 
an internal standard means adding the standard to the unknown sample. 
This can be either before (External/Internal) or after (Internal) sample 
preparation. 
 
Standard Description 
external = Default setting. Calibration is via one or several standard samples. Via the 

amount values entered in the Amount column, a ratio is established between 
the area and the amount. On this basis, the amount in samples of unknown 
concentration is determined via the peak area. 
With an increasing number of different amounts, the area/amount ratio 
(=calibration curve) can be determined more exactly.  
If different amounts are obtained by diluting the original substance, a Dilution 
Series is resulting. The amount of each concentration is entered in a separate 
amount column in the corresponding line of the amount table. 
If the calibration is performed with a single standard sample by injecting 
different volumes (Var.InjectVol.), only the amount of the original sample is 
stored in an amount column. Chromeleon calculates the remaining amount 
values (for the different injection volumes). 
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Standard Description 
internal/ 
external 

Choose a substance as Internal Standard ("ISTD") whose retention time 
behavior is similar to the behavior of the substances to be analyzed. Before the 
sample preparation, an internal standard is added to all samples (unknown and 
standard samples) in exactly the same amount so that the concentration is 
identical in all samples. For example, diluting the sample or performing a pre-
column derivatization later will change the concentration of the internal 
standard. During calibration, the internal standard and the substances to be 
determined are calibrated. 

  
internal In the pure internal standard method, calculation is via area and amount ratios 

instead of absolute areas and amounts. For this procedure, it is necessary to 
inject a constant amount of the Internal Standard ("ISTD"). The internal 
standard is added before the sample preparation. In a dilution series, the 
standard does not have to be diluted (Const. Internal Standard). Due to the 
equivalent amount of added internal standard, the same ISTD result should be 
achieved for all samples. Forming the ratio of ISTD values allows you to draw 
conclusions about the precision of the analysis and calculating the actual result.  
Due to the intense experimental procedure, this type of calibration is rarely used 
in HPLC.   

For examples of the different standard methods, refer to How to …: 
 Calibrating. 

 

 Evaluation with Various Standard Methods 
Below please find a description of how Chromeleon calculates calibration 
points, which form the basis for any calibration function F. Please note that 
the formula used for the calculation depends on the selected  Standard 
Methods (External, Internal/External (with/without var. ISTD), Internal 
(with/without var. ISTD)). 

For evaluating unknown samples, that is, calculating the ⇒Amount values, 
the inverted form of the corresponding Calibration Function F is used 
(=inverted function A). This means that the c0, c1, c2, and c3 calibration 
coefficients form function A that is inverted for amount calculation. The 
result is F(x). 

 Tip: 

For the formulas for the Standard Addition method, refer to  Evaluation 
with the Standard Addition Method. 
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'External' Evaluation: 
Calibration: 
• Y(i,k) = RESPONSE(i,k) 

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ WEIGHT(k)/DILFAC(k) ∗  
           INJECTVOL(k)/REFINJECT 

 
Evaluation: Calculation of the Amount peak variable for peak i in the 
sample x 
• AMOUNT(i,x) = DILFAC(x)/WEIGHT(x) ∗ RSP-FACTOR(i) *  

                        F[RESPONSE(i,x)] 

Description: see below. 

'Internal' Evaluation: 
Calibration: 
• Y(i,k) = 100 ∗ RESPONSE(i,k)/RESPONSE(ISTD,k) 

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ WEIGHT(k)/DILFAC(k) 
 
Evaluation: Calculation of the Amount peak variable for peak i in the 
sample x 
• AMOUNT(i,x) = DILFAC(x)/WEIGHT(x) ∗ RSP-FACTOR(i) ∗ F[100 ∗  

                        (RESPONSE(i,x)/RESPONSE(ISTD,x)] 

The ISTD peak itself will not be evaluated! 

Description: see below. 

'Internal' Evaluation (with variable ISTD): 
Calibration: 
• Y(i,k) = AMOUNT_NOMINAL(ISTD) ∗ RESPONSE(i,k)/ 

           RESPONSE(ISTD,k) 

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ WEIGHT(k)/ DILFAC(k) ∗  
          INJECTVOL(k)/REFINJECT 

 
Evaluation: Calculation of the Amount peak variable for peak i in sample x 
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• AMOUNT(i,x) = DILFAC(x)/WEIGHT(x) ∗ RSP-FACTOR(i) ∗  
                        F[AMOUNT_SOLL(ISTD) ∗  
                        (RESPONSE(i,x)/RESPONSE(ISTD,x)] 

The Internal Standard ("ISTD") peak itself is not evaluated! 

Description: see below. 

'Internal/External' Evaluation: 
Calibration: 

'External' calibration, including the ISTD peak! (Also, refer to 'External') 
 
Evaluation: Calculation of the Amount peak variable for peak i in the 
sample x 
• The ISTD peak itself is evaluated 'Externally'! 

• FACTOR_IS(x) = AMOUNT_NOMINAL(ISTD)/AMOUNT(ISTD,x) 

• AMOUNT(i,x) = DILFAC(x)/WEIGHT(x) ∗ RSP-FACTOR(i) ∗  
                        FACTOR_IS(x) ∗ F[RESPONSE(i,x)] 

Description: see below. 

'Internal/External' Evaluation (with variable ISTD): 
Calibration: 

Calibration is 'External', including the ISTD peak! However, the nominal 
amount for the ISTD peak from the sample list (ISTD Amount) is used. The 
sample weight of the ISTD peak is not considered. 
• Y(i,k) = RESPONSE(i,k) 

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ WEIGHT(k)/DILFAC(k) ∗  
           INJECTVOL(k)/REFINJECT 

• X(ISTD,k) = AMOUNT_NOMINAL(ISTD,k) ∗ 1/DILFAC(k) ∗  
                  INJECTVOL(k)/REFINJECT 
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Evaluation: Calculation of the Amount peak variable for peak i in the 
sample x 
• The ISTD peak itself is evaluated 'Externally', but without Weight 

correction. 

• AMOUNT(ISTD,x) = DILFAC(x) ∗ RSP-FACTOR(ISTD) 
                                F[RESPONSE(ISTD,x)] 

• FACTOR_IS(x) = AMOUNT_NOMINAL(ISTD,x)/AMOUNT(ISTD,x) 

• AMOUNT(i,x) = DILFAC(x)/WEIGHT(x) ∗ RSP-FACTOR(i) ∗  
                        FACTOR_IS(x) ∗ F[RESPONSE(i,x)] 

Description: 
 
F: Calibration function 
X(i,k): X-coordinate of a calibration point for peak i for the standard 

sample k  
Y(i,k): Y-coordinate of a calibration point for peak i for the standard 

sample k  
k: Calibration sample (standard) 
x: Unknown sample (analysis sample) 
RESPONSE(i): Reference variable (Int.Type; that is, Area, Height, CE-Area)  

of peak i in a sample 
RESPONSE(ISTD): Reference variable (Int.Type; that is, Area, Height, CE-Area)  

of the corresponding ISTD peak of a sample 
AMOUNT_NOMINAL(i): Amount of peak i from the amount table for the standard 

sample k 
AMOUNT_NOMINAL(ISTD): ⇒ISTD Amount for the sample k from the sample list 
AMOUNT(ik): Calculated amount of the peak i for the sample k 
WEIGHT: ⇒Weight (Sample Weight Factor) for a sample 
DILFAC: ⇒Dil. Factor (Dilution Factor) for a sample 
INJECTVOL: ⇒Inj. Vol. (Injection Volume)  
REFINJECT: Injection volume of the first sample in a calibration series 
RSP-FACTOR(i): ⇒Response Factor of the peak i from the QNT amount table  
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 Evaluation with the Standard Addition Method 
For the Standard Addition method, calibration and evaluation are slightly 
different from "normal" calibration. One reason is that the original sample 
has a spiked amount = 0. Therefore, multiplication with factors it not 
possible. 

 Caution:  
Only if the calibration curve is forced through the origin (i.e., in this case, 
through the calibration point of the original, unspiked sample), the amount 
of this sample corresponds to the negative intercept on the x-axis, i.e., to 
the average of all values based on this sample. For all other calibration 
types, the calculated amount of the original, unspiked sample may deviate 
from the negative intercept on the x-axis of the calibration curve.  

'External' and 'Internal/External' Evaluation: 
Calibration: 
• Y(i,k) = RESPONSE(i,k) / DILFAC(x)/WEIGHT(x) ∗  

            INJECTVOL(k)/REFINJECT) 

• X(i,k) = AMOUNT_NOMINAL(i,k) 
 
Evaluation: Calculation of the Amount peak variable for peak i in the 
sample x 
• AMOUNT(i,x) = RSP-FACTOR(i) ∗ F[RESPONSE(i,x) ∗  

                         DILFAC(x)/WEIGHT(x)] 

Description: see  Evaluation with Various Standard Methods. 

'Internal' Evaluation: 
Calibration: 
• Y(i,k) = 100 ∗ RESPONSE(i,k)/RESPONSE(ISTD,k) 

• X(i,k) = AMOUNT_NOMINAL(i,k) ∗ WEIGHT(k)/DILFAC(k) ∗ 
            DILFAC(x)/WEIGHT(x) 
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Evaluation: Calculation of the Amount peak variable for peak i in the 
sample x 
• AMOUNT(i,x) = RSP-FACTOR(i) ∗ F[100 ∗  

                          RESPONSE(i,x)/RESPONSE(ISTD,x) ∗  
                          DILFAC(x)/WEIGHT(x)]  

The ISTD peak itself will not be evaluated! 

'Internal' Evaluation (with variable ISTD): 
Calibration: 
• Y(i,k) = AMOUNT_NOMINAL(ISTD) ∗ 

RESPONSE(i,k)/RESPONSE(ISTD,k) / DILFAC(x)/WEIGHT(x) ∗ 
(NJECTVOL(k)/REFINJECT) 

• X(i,k) = AMOUNT_NOMINAL(i,k) 
 
Evaluation: Calculation of the Amount peak variable for peak i in sample x 
• AMOUNT(i,x) = RSP-FACTOR(i) ∗ F[AMOUNT_SOLL(ISTD) ∗  

                         RESPONSE(i,x)/RESPONSE(ISTD,x) ∗  
                         DILFAC(x)/WEIGHT(x)]  

The Internal Standard ("ISTD") peak itself is not evaluated! 

'Internal/External' Evaluation (with variable ISTD): 
Calibration: 

Calibration is 'External', including the ISTD peak! However, the nominal 
amount for the ISTD peak from the sample list (ISTD Amount) is used. The 
sample weight of the ISTD peak is not considered. 
• Y(i,k) = RESPONSE(i,k) ∗ DILFAC(k)/WEIGHT(k) ∗  

           REFINJECT/INJECTVOL(k) 

• X(i,k) = AMOUNT_NOMINAL(i,k) 

• Y(ISTD,k) = RESPONSE(i,k) ∗ DILFAC(k) ∗ REFINJECT/INJECTVOL(k) 

• X(ISTD,k) = AMOUNT_NOMINAL(ISTD,k) 
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Evaluation: Calculation of the Amount peak variable for peak i in the 
sample x 
• The ISTD peak itself is evaluated 'Externally', but without Weight 

correction. 

• AMOUNT(ISTD,x) = RSP-FACTOR(ISTD) ∗ F[RESPONSE(ISTD,x) ∗  
                                 DILFAC(x)]  

• FACTOR_IS(x) = AMOUNT_NOMINAL(ISTD,x)/AMOUNT(ISTD,x) 

• AMOUNT(i,x) = RSP-FACTOR(i) ∗ FACTOR_IS(x) ∗ F[RESPONSE(i,x)  
                         ∗ DILFAC(x)/WEIGHT(x)]  

 Implementation 
Follow the description below to implement and perform calibration: 

Sample List 
• Enter the available standard samples in the  Sample List 

(Sequence), similar to unknown samples.  

• To facilitate and automate the input, use the  Sequence Wizard. 

• Each sample in the sample list can be converted into a standard 
sample by assigning the Sample Type STD. Note that the position 
(line number) in the sample list determines the order of processing. If a 
standard sample is to be injected several times, a separate line is 
created in the sample list for each injection.  

• In the Method column, specify the quantification method to be used for 
evaluating the sample. 

• Input in the remaining fields of the sample list is analog to each 
unknown sample (Position, Injection Volume, etc.).  

• For a detailed description of the procedure, refer to How to …: 
Creating and Managing Files and Data  Creating a Sample List. 
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Quantification Method (QNT Editor) 
• Open the General tab page and check the current settings. Define the 

calibration⇒ Mode to be used.  

• Enter the names and the retention times of the peaks to be determined 
on the Peak Table tab page. If a processed sample refers to a QNT 
File with an "empty" peak table, the peak table can be automatically 
filled with the retention times of the integrated peaks after the analysis 
by selecting the Autogenerate Peak Table command. Each peak 
contains a successively numbered default name.  

• Enter the amount values of the standard substances in the amount 
columns.  

• Determine the standard method, the calibration type, and the 
integration type to be used for the calibration.  

• For more information, refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Creating a Peak Table. 
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Validation, AutoQ, and System 
Wellness 

Validation and Qualification 

Analysis data from various workstations or laboratories can only be 
compared if it is possible to determine the quality of the results produced 
with a chromatography system.  

Validation (Definition) 
The process of ensuring that a system and its analysis procedures supply 
reproducible and reliable results is referred to as validation. This includes 
above all procedures regarding the planning, implementation, and 
documentation of an analytical method. Thus, validation is an integral part 
of GLP ("Good Laboratory Practice").  

Qualification (Definition) 
First, the manufacturer validates the single devices and the data system. 
During qualification, the user checks whether a device or data system 
works according to its specification. This includes procedures guaranteeing 
the optimum technical condition of instruments (hardware and firmware) 
and of computers (hardware and software). Thus, qualification, too, is an 
integral part of Good Laboratory Practice. 

When is qualification necessary? 
Instruments should be qualified before setting them into operation and at 
regular intervals thereafter; especially after exchanging worn-out parts, 
performing repair work, or replacing an instrument by a new one. Also, 
perform system qualification procedures after you have updated the 
software of your data system. 

In addition, the data system itself should be qualified at least after an 
update. Installation Qualification and Operational Qualification are 
available for this. In addition, you can check the datasource performance (= 
datasource Performance Qualification (PQ)). Performing the different 
qualifications is usually the task of the system administrator.  
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For more information, refer to  Validation and Qualification in the 
Administrator Help section. 

Many instruments perform an automatic self-test upon startup to ensure 
optimum function. For example, for the Dionex UVD 340U Photodiode 
Array Detector, spectra calibration is performed automatically via the 

Holmium Oxide Filter whenever the detector is started. 

When is validation necessary? 
The analytical method and the PGM File should be validated before they 
are used in daily laboratory procedures. As modifying single parameters 
can already be of great importance, validation is also necessary in the daily 
routine. On the SST tab page of the QNT Editor (see Data Representation 
and Reprocessing  The QNT Editor), define System Suitability Tests 
to check whether your analytical method and your program file are suitable 
for analyzing special samples. 

How is validation performed? 
The focus of an analysis procedure is on Calibration (see Theory of 
Calibration  Calibration (Overview)). Within the scope of validation, it 
is then important to check whether calibration has been performed 
correctly. The precision, Limit of Detection, dynamic work range, and 
robustness of a procedure and the involved components have to be 
determined. The following features are available for this: Validation 
Samples, Blank Run Samples, Matrix Blank Samples, Confidence 
Interval/Range, averaging, normal distribution, outlier tests, detection of 
statistical and systematic errors, Correlation Coefficient, Standard 
Deviation, Relative Standard Deviation, etc. 

Chromeleon provides numerous options to meet all GLP, qualification, and 
validation requirements. For more information, refer to: 

 AutoQ Equipment Qualification 
 The System Suitability Test (SST) 
 System Wellness for IC Devices (Overview) 
 System Wellness for HPLC Devices  
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 AutoQ Equipment Qualification 
Dionex AutoQ is a comprehensive range of user-friendly Chromeleon 
qualification tools. These tools help you quickly and easily perform 
qualification tasks that would otherwise be troublesome and time-
consuming. In addition, they simplify compliance with qualification 
standards and qualification rules. AutoQ qualification tests are available for 
Chromeleon software and for several HPLC and IC systems. The following 
tasks can be automated with AutoQ test procedures. 

For Chromeleon software: 
• Installation Qualification (IQ)  

• Operational Qualification (OQ) 

For instruments: 
• Installation Qualification (IQ) 

• Operational Qualification (OQ) 

• Performance Qualification (PQ) 

What is unique about Dionex AutoQ? 
Dionex AutoQ is a comprehensive suite of qualification procedures for 
instruments from several manufacturers. AutoQ is available for the 
following systems: 
• Dionex IC modules and Summit HPLC modules 

• Agilent 1100 HPLC System modules 

• Shimadzu LC10 and LC2010 HPLC instruments 

• Shodex RI-101 HPLC Refraction Index Detector 

• TSP HPLC modules 

• Waters HPLC modules (including the Alliance 2690/2695 Systems 
and the 996/2996 PDAs) 
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Which standards and regulations does Dionex AutoQ help you to 
meet? 
The following standards and regulations are important in a validated 
environment: 
• Good Laboratory Practice ( GLP)  

• Current Good Manufacturing Practice (cGMP) 

• 21 CFR Part 11  

• ISO 9000  

What are the benefits of AutoQ? 
• Most AutoQ tests run automatically most of the time. Therefore, they 

require very little operator time. For example, it only takes about 30 
minutes to prepare the Instrument OQ, after which Chromeleon runs 
the test automatically. In comparison, the conventional test routines 
used in many validated laboratories typically require a full day of the 
analyst's time. 

• The high level of automation reduces the risk of errors and ensures 
comparable results.  

• Chromeleon automatically documents the results. The reports created 
by the system include charts, calculations, and the single results 
(Passed/Failed). 

• AutoQ is virtually identical for all instruments, regardless of the 
manufacturer. This means: 

- Considerable time savings for the creation and maintenance of 
SOPs (Standard Operating Procedures) for laboratories using 
instruments from different manufacturers. 

- Only one test procedure to learn and work with.  

- Test reports have the same format for all instruments. 

- All reports can be easily managed, saved, and stored as electronic 
documents, using Chromeleon electronic reports and Electronic 
Signatures. 
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• AutoQ instrument qualification tests can be adapted for use with 
instruments from other manufacturers.  

 Tip: 
This requires advanced knowledge of report creation in Chromeleon.  

• AutoQ qualification procedures are included in every Chromeleon 
software package. 

 Note: 
Certified standard solutions, which are available from Dionex, are 
needed to run AutoQ qualification tests. 

 Instruments Operational and Performance Qualification 
After the instruments of a chromatography system have been installed, 
Installation Qualification should be performed. Usually, the system 
administrator performs this check. Therefore, refer to Validation and 
Qualification  Instruments Installation Qualification in the 
Administrator Help section for more information. Afterward, perform 

Operational and/or Performance Qualification for the instruments. 

The Qualification menu in the Chromeleon Browser provides the following 
options: Instruments PQ and PQ Setup and Instruments OQ and OQ 
Setup. Select Instruments PQ (or Instruments OQ) to perform the 
performance (operational) qualification. Select PQ Setup (or OQ Setup) to 
create the templates required for performing the performance (operational) 
qualification. Usually, this is necessary only during the initial installation of 
the system or if the configuration has been changed. 

 Tip: 
Only qualified Dionex service personnel should perform the Performance 
and Operational Qualification checks. For more information, please contact 
Dionex Service.  

For information about performance qualification, refer to  Operational 
and Performance Qualification for HPLC Systems and/or 

 Performance Qualification (PQ) for IC Systems. 

In addition, you can perform operational qualification for the UCI 
Universal Chromatography Interface. For more information, refer to the UCI 
Operational Qualification Operating Instructions. 
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 Operational and Performance Qualification for HPLC 
Systems 
Chromeleon provides a datasource with a master template in the Template 
directory on the Chromeleon software CD. This template is designed for 
Performance (Operational) Qualification in a standard HPLC configuration. 
In addition to various sequences, the template contains a Report 
Definition File (RDF) for OQ and PQ, providing the following pages: 

SPECIFICATION: On the SPECIFICATION page, enter the system 
specifications (instruments, fluidics, and limits). 

COLUMN OVEN: The COLUMN OVEN page indicates whether the column 
oven temperature corresponds to the selected temperature (within the 
specified limits). 

INJ_REPRO_AND_RET_REPRO and 
ASI_100_REPRO_AND_RET_REPRO, respectively: On the 
INJ_REPRO_AND_RET_REPRO page, serves for checking the 
reproducibility of the injector and the retention time. If the result is within the 
specified limits, the Result column indicates OK. 

INJ_CARRY_OVER: The INJ_CARRY_OVER page supplies a measure 
for the carry over in your system. If the result is within the specified limits, 
the Result column indicates OK. 

INJ_LINEARITY: The INJ_LINEARITY page supplies a measure for the 
linearity of injection volume and peak area. 

PUMP_GRADIENT: On the PUMP_GRADIENT page serves for checking 
the gradient precision. The limits of the Specification page are included. If 
the values are within the specified limits, the last column (Result) indicates 
OK. The Result of all tests column indicates Test passed. 

PUMP_GRADIENT_REPRO: The PUMP_GRADIENT_REPRO page 
serves for checking the gradient reproducibility (with 3 repetitions in this 
example). The limits of the Specification page are included. If the values 
are within the specified limits, the last column (Result) indicates OK. The 
Result of all tests column indicates Test passed. 

RI_NOISE_AND_DRIFT and RI_LINEARITY: These pages serve for 
evaluating the noise, drift, and linearity of the Shodex Refractive Index 
Detector. 
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DET_NOISE_AND_DRIFT: The DET_NOISE_AND_DRIFT page serves 
for checking whether noise and drift in your system correspond to the limits 
on the SPECIFICATION page. If the values are within the specified limits, 
the Result column indicates OK. 

DET_WAVELENGTH: The DET_WAVELENGTH page supplies a measure 
for the wavelength precision of the corresponding detector. 

DET_LINEARITY: The DET_LINEARITY page serves for checking the 
detector linearity. From five different injections at different concentrations, 
the correlation coefficient (supplied in %) between the peak height and the 
concentration is determined. If the value is above the specified limit, Test 
passed is returned as the result. 

RF_DET_NOISE and RF_DET_WAVE: These pages evaluate the 
noise and the wavelength precision of the fluorescence detector. 
Audit Trail: The Audit Trail page displays the audit trail for the analyzed 
sample. 

 Caution: 
Do not edit the report pages (except the Specification page), even if 
editing is possible! Chromeleon automatically reads the corresponding 
values. Within the report, individual data sheets are very often accessed via 
references. If you insert or delete lines and columns, these references will 
be lost. Thus, the calculations will be wrong! 

The report must be printed as Batch Report from the browser to make 
sure that, in the report, the data are read in and processed correctly. Select 
the sequence for which to print the report. Make sure that no sample is 
selected. Select Batch Report on the File menu and click OK to start 
printing. 

 Tip: 
Enter the actual concentrations of the used standards in the Amount 
columns of the QNT File for evaluating the detector linearity. 

For more information about Operational and Performance Qualification, 
refer to the Operational Qualification/Performance Qualification 
Operating Manual that is available from Dionex Service. 
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 Performance Qualification (PQ) for IC Systems 
Validation is becoming increasingly important to analytical laboratories. 
Documented evidence must be provided to demonstrate the integrity of 
data collected and validate the results obtained on laboratory 
instrumentation. 

The Qualification menu in the Chromeleon Browser includes options for 
Instruments PQ and PQ Setup. Instruments PQ is used to perform the 
performance qualification. PQ Setup is used to generate the templates 
required for performing the performance qualification. (This is generally 
necessary only after a new installation or after changes to the 
configuration.) The Chromeleon CD provides a datasource with a master 
template in the PQ\Templates\PQ directory. 

PQ should be performed at regular intervals after the initial installation and 
Operational Qualification (OQ). Dionex recommends performing PQ every 
six months. A qualified Dionex Service Representative should perform all 
tests, in accordance with the instructions in the IC System Operational and 
Performance Qualification User’s Guide. The user’s guide is included in the 
IC OQ/PQ Kit with Test Cells (P/N 057599) and the IC OQ/PQ Basic/Refill 
Kit (P/N 057608). 

The PQ procedure used to qualify Dionex Ion Chromatography Systems 
meets the requirements established by the National Institute of Standards 
and Technology (NIST) and the American Society for Testing and Materials 
(ASTM). This PQ procedure provides qualification testing for ICS-3000, 
ICS-2500, ICS-2000, ICS-1500, ICS-1000, DX-600, DX-500, DX-320, DX-
120, and BioLC systems. 

 The System Suitability Test (SST) 
On the SST tab page in the QNT Editor (see Data Representation and 
Reprocessing  The QNT Editor), define a System Suitability Test 
(SST) to check whether the quantification method and the PGM File are 
suitable for analyzing special samples. (For more information, refer to How 
to …: Performing Validation and Qualification  Defining System 
Suitability Tests.) 

The System Suitability Test can already be performed while the 
chromatogram is recorded. The corresponding QNT Method needs to be 
available in the sample list (in the Browser). As Fail Action, select Abort 
Batch to automatically abort the sample Batch if a test condition is not 
met.  
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 System Wellness for IC Devices (Overview) 

What is System Wellness? 
System Wellness monitors the overall "health" of a chromatographic 
system. It provides built-in diagnostic and calibration features that help 
prevent unscheduled system shutdowns and assure reliable operation of 
system devices. Calibration and diagnostic commands are available from 
Wellness control panels and Help topics are provided for performing the 
various tasks. 

Supported Devices 
For System Wellness support, a device must have a version of 

Moduleware installed that supports System Wellness. The following 
devices are supported: 
 

Device Moduleware Version Required 
IC Pumps   
 GP40/IP20 3.46 (or higher) 
 GP50/IP25 3.46 (or higher) 
 GS50/IS25 1.00 (or higher)   
Detectors  
 AD25 1.02 (or higher) 
 CD 1.0.0 (or higher) 
 CD20/ED40 3.05 (or higher) 
 CD25/ED50 1.05 (or higher) 
 CD25A/ED50A 1.00 (or higher) 
 ED 1.0.0 (or higher) 
 PDA-100 (DX-LAN) 1.04 (or higher) 
 PDA-100 (USB) 1.0.0 (or higher)   

Autosampler  
 AS 2.0.0 (or higher) 
 AS50 (DX-LAN) 1.05 (or higher) 
 AS50 (USB) 1.00 (or higher)   

Eluent Generator  
 EG40 2.23 (or higher) 
 EG50 2.26 (or higher) 
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Device Moduleware Version Required 
System Modules  
 IC20 3.08 (or higher) 
 IC25 1.04 (or higher) 
 IC25A 1.00 (or higher) 
 ICS-90 1.00 (or higher) 
 ICS-1000 1.1.0 (or higher) 
 ICS-1500 1.1.0 (or higher) 
 ICS-2000 1.1.0 (or higher)   

System Wellness Features 
• System Wellness control panels, which allow easy access to diagnostic 

and calibration commands and data 

• Download of current, previous, or factory calibration data 

• Leak detector testing and calibration 

• Wavelength verification and calibration for UV and PDA detectors 

• Cell calibration for conductivity detectors 

• pH calibration for amperometry detectors 

• Warning when Flow = 0 while the detector lamp is burning. This is to 
prevent damage resulting from running the flow cell dry. 

• Pressure offset and degas calibration for pumps 

• Flow rate calibration for pumps 

• Solvent and waste level monitoring 

For instructions on setting up and using System Wellness features, refer to 
How to …: Performing Validation and Qualification  Ensuring 
System Wellness. 
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 System Wellness for HPLC Devices (Overview) 
Chromeleon provides several system wellness features for the Summit 
HPLC modules.  

 Tip:  
The user does not have to calibrate these modules because either they 
have been calibrated in the factory (e.g., the pump flow) or calibration is 
performed automatically (for example, for the UV detector via a Holmium 
Oxide Filter).  
 
Device Feature Description 
   
P680 Leak detector Reliable operation 
 Monitoring of piston seal tightness Reliable operation 
 Pressure limits Prolongs the life of HPLC columns, 

reliable operation 
 Total workload monitoring Allows you to schedule the next 

service date.  
 Degasser vacuum level monitoring Reliable operation 
 Active rear-seal wash system Prolongs the life of the consumable 

parts 
 Monitoring of the liquid level for rear-seal 

washing 
Reliable operation 

 Solvent and waste level monitoring Reliable operation    
ASI-100 Leak detector Reliable operation 
 Injection counter Allows you to schedule the next 

service date.  
 Needle seal wear monitoring Allows you to schedule the next 

service date.  
 Rotor wear and stator wear monitoring for 

the internal motorized switching valve 
Allows you to schedule the next 
service date.  

 Needle port wear monitoring Allows you to schedule the next 
service date.  

 Synchronization of injection and pump cycle Injection reproducibility    
TCC-100 Gas and leak detectors Reliable operation 
 Column identification features Tracking and troubleshooting 
 Temperature limit monitoring Tracking and troubleshooting    
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Device Feature Description 

UVD340U Lamp ignition counter Allows you to schedule the next 
replacement date 

 Lamp age monitoring Allows you to schedule the next 
replacement date 

 Minimum lamp intensity monitoring Reliable operation 
 Warning when Flow = 0 when the detector 

lamp is burning. 
Avoids damage resulting from 
running the flow cell dry.    

System Documentation when new wear parts have 
been installed. 

Tracking and troubleshooting 

 Documentation when the solvent has been 
changed 

Tracking and troubleshooting 
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Data Representation and 
Reprocessing 

Data Representation and Reprocessing 

Chromeleon allows you to represent your raw data under various aspects. 
It depends on the aspect of interest and on the type of data reprocessing 
you wish to perform, which window or pane is most appropriate. For 
example, you can reintegrate a chromatogram manually, compare several 
chromatograms, analyze the peak purity, calculate calibration curves, or 
search single spectra in a spectra library. 

Each operation is displayed in a separate window. Each window is intended 
for one specific task and has its own window arrangement and menu 
structure. 

Immediately after data acquisition, you can perform certain steps for data 
reprocessing. You can define these steps in the Program in the PGM 
Editor; see  Post-Acquisition Steps. 

You can perform all other steps of data reprocessing at any time. Use the 
following windows (or panes): 

 The Quantification Method 
 Integration 
 Report Tables 
 Calibration (Overview) 
 The Printer Layout 
 PPA: Peak Purity Analysis 
 Spectra Libraries 

 
After the raw data has been acquired, the Quantification Method 
determines how the data is evaluated. Thus, the QNT Editor with the 
Integration window is the most important window for data reprocessing. 
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If, after the analysis, the detection and peak table parameters chosen in the 
QNT Method prove to be inappropriate for the sample and/or sequence, 
you can change them in the QNT Editor at any time. You do not need to 
analyze the corresponding sample again.  

All modifications are immediately and globally effective. All modified 
variables are immediately re-calculated and the new values are displayed 
on the screen. The modifications are finally accepted by selecting the Save 
or Save Manipulations command.  

If the modified quantification method is saved, the results of all samples 
evaluated by this method will be adjusted. 

Post-Acquisition Steps (PGM Editor) 

Immediately after data acquisition, you can perform certain data 
reprocessing steps. You can use the Post-acquisition steps view to 
define these steps in the Program via the PGM Editor. (Also, refer to 
Control  The PGM Editor.) 
The following data reprocessing steps are available in the Post-acquisition 
view: 
• Arithmetic combination of channels (arithmetic combination of 2D 

channels - see  Combining Channels via Arithmetic Operations) 

• Copy Channel (see  Copying a Channel) 

• Create Fraction Analysis Samples (see How to …: Collecting 
Fractions Automatically (Autopurification)  Creating Fraction-
Type Samples) 

• Create Purification Samples (see How to …: Collecting Fractions 
Automatically (Autopurification)  Creating Preparation-Type 
Samples) 

 Tip: 
The Create Fraction Analysis Samples and Create Purification 
Samples options are part of Autopurification. They are visible only if 
the Purification license is installed and if a connection to the server 
exists. A connection exists if a PGM File is associated with a timebase, 
the server on which this timebase resides is running, and the client is 
connected to this server. 
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• Extract ED channel (for extracting an ED channel – only possible if 
3D_Amp data is available) 

• Extract MS channel (for extracting a Mass Trace - only possible if 
MS data is available; see How to …: Using Mass Spectrometers 

 Extracting Mass Traces Afterward) 

• Extract optimum integration path (for extracting the Optimum 
Integration Path - only possible if a 3D field is available; see How to …: 
Creating and Using Spectra Libraries  Selecting the Optimum 
Integration Path) 

• Extract UV channel (for extracting a UV channel - only possible if a 3D 
field is available; the procedure is similar to selecting the optimum 
integration path) 

• Smooth data (for chromatogram Smoothing - see How to …: 
Working with Chromatograms  Performing Data Smoothing) 

For more information, refer to How to …: Creating and Modifying 
Programs  Adding Post-Acquisition Steps. 
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The QNT Editor 

The Quantification Method  

In Chromeleon, all instructions and parameters representing the basis of 
calculation for the sample evaluation are included in the Quantification 
Method (QNT File). This refers for example to the following questions:  

• Below which height, width, or area a peak will be ignored? 

• Which course has the baseline?  

• Which peaks are classified as Riders?  

• What is the ⇒Amount of the standard samples?  

• Which Calibration Function is used for creating a calibration curve?  

• Which peaks are identified by name?  

Before the actual analysis, these evaluation parameters are defined in the 
Quantification method (QNT File).  

• Select File > New > Method File to generate a new QNT File.  

• Alternatively, select a sequence in the Browser and double-click the 
corresponding QNT File to open it. 

• To open the QNT Editor from a method file, click the QNT Editor icon 

 on the toolbar. This allows you to display the QNT File data of the 
current sample.  

For more information about the QNT Editor, refer to  The QNT Editor. 
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The QNT Editor 

The QNT Editor allows you to create a method for evaluating 
chromatographic results of different samples. The QNT Editor usually 
provides:  
• The chromatogram of the current sample 

• The calibration curve of the current peak 

• Various tab pages: 

 

Instead of the calibration curve, you can display the following items: 

•  The Trend Plot (refer to the Control section; similar functionality as 
the control panel)  

• UV spectrum (if available) 

• Mass Spectrum (if available) 
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In addition, you can include report tables in the tab pages.  

The QNT Editor is divided in two window sections. The upper section 
serves for information purposes. To create a QNT File, use only the lower 
window section. 

Upper Pane 
The upper pane serves to display additional plots:  
• Select Show Chromatogram or Show Calibration Curve on the View 

menu to enable or disable the display of the chromatogram and/or the 
calibration curve.  

• Press F4 or SHIFT+F4 or select the Next Chromatogram or Previous 
Chromatogram option on the File menu to toggle between the 
chromatograms of the individual samples.  

• Select the Show Spectra option to enable or disable the display of the 
spectrum of a single peak. 

Lower Pane 
The lower pane serves to determine the evaluation parameters.  
• Select a specific tab to open a worksheet, similar to Microsoft Excel.  

• You can freely select the names of the worksheets. Double-click the 
corresponding name, and enter a new name in the edit dialog box.  

For more information, refer to  Function of the QNT Editor. 
 
The following worksheets are available by default: 

 The General Tab Page 

 Detection Parameters 
 Peak Table, Amount Table, Peak Tracking, and MS Tracking 
 Calibration Settings 
 Spectra Library Screening 
 System Suitability Test 
 Mass Spectra 
 UV Spectra 
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If you do not need a special tab, select Select Sheet on the View menu. In 
the dialog box, clear the check box for the tab to hide. To rename a tab 
page, double-click the tab and enter a new name. 

 Tip:  
These topics describe the structure and functions of the individual 
worksheets. For detailed information about how to enter data, refer to How 
to …:  Integrating Chromatograms and Identifying Peaks. 

 Function of the QNT Editor 
The QNT Editor allows you to define the quantification method (also 
referred to as QNT Method or method). The quantification method defines 
parameters for identifying the peaks within a chromatogram (assigning 
substances) and for calculating the amount/concentration from the 
recorded peak areas (calibration). 

Peak Identification 
Chromeleon supports two ways for identifying detected peaks, i.e., for 
assigning substance names. 

Generally, peaks are identified by their ⇒Retention Times. If a peak elutes 
within a defined time window, it is assigned the corresponding name, 
calibration function, etc. 

If many peaks elute in rapid succession or if their order is changed by 
varying chromatographic conditions (for example, pH value), identification 
by the UV spectrum or the Mass Spectrum is more reliable. 

 Note:  
Peak identification by UV spectra requires use of a Photodiode Array 
Detector, such as the Dionex UVD 340 or PDA-100, and the appropriate 
software configuration. 

For mass spectra acquisition, a Mass Spectrometer and the Xcalibur 
software are required in addition to the Chromeleon software. 
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Calibration 
The peak table provides all information for the calibration. The Amount 
columns and the recorded peak areas are used to calculate the offset, 
slope, and curve parameters. 

 Tip:  
With each new calibration, the results are automatically recalculated for the 
report as the integration programs update the pea table with the calibration 
constants and the recorded integration values.  

To save you from having to determine the retention time of each peak 
manually, Chromeleon peak tables can be generated automatically. (For 
more information, refer to How to …: Integrating Chromatograms and 
Identifying Peaks  Autogenerating the Peak Table.)  

 The General Tab Page 

The General tab page contains global settings for the following worksheets: 
 Peak Table ("Retention Time Settings"), Amount Table ("Amount 

Interpretation"), and  Calibration ("Global Calibration Settings"). Enter a 
name for the current QNT File in the Title field. The name appears in the 
Browser and can be included in a Report when printing data of the QNT 
Editor. Click Unidentified Peaks to determine how to quantify unidentified 
peaks. 
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Retention Time Settings 
• Select the Use Recently Detected Ret. Times check box to use the 

⇒Retention Time of the preceding sample to identify a peak via a 
retention time window (⇒Window). You can also use the retention time 
of the last standard. Select Standard from the of last drop-down list. 
Click Options… to display more options. (For more information, refer to 
⇒Use Recently Detected Retention Time.) This function allows the 
system to automatically react to changing retention times that are, for 
example, due to column trends. If the option is disabled, the actually 
determined retention time listed in the peak table is used for identifying 
the peak.  

• Use the Peak retention time determination section to specify how the 
retention time of peaks shall be determined: Select Use absolute 
greatest signal value to use the retention time of the greatest absolute 
signal value. Select Use relative greatest signal value over the 
baseline to use the retention time of the greatest relative signal value, 
i.e., of the largest distance to the baseline. 

Dead/Delay time(s) 
• Enter the ⇒Dead Time in the Dead Time field. The dead time is used 

for calculating the Capacity Factor k' and the ⇒Kovats Indexes. 

• Select the name of any further detector from the 2nd Detector and/or 
3rd Detector drop-down list and enter the ⇒Delay Time in the min 
field. (Also, refer to How to …: Integrating Chromatograms and 
Identifying Peaks  Defining the QNT Method for Several 
Detectors.) 

Amount Interpretation 
• For documentation purposes (exclusively), the physical dimension 

(amount or concentration) that is used for the amount values can be 
included in the field ⇒Dimension of Amounts. Amount values are not 
automatically converted into concentration values or vice versa. 

• In addition, the reference injection volume is defined on this page. 
Either select the injection volume of the first standard (Use inject 
volume of first standard) or enter any volume via Fixed. 
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Global Calibration Settings 

• Use the Mode field to determine how the samples of a sequence are 
calibrated and on which ⇒Calibration Mode the calibration is based. 
For example, this allows you to calibrate certain samples as a group or 
to include calibration samples for samples that are analyzed later. For 
more information, refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Calibrating. 

• When Auto Recalibrate is enabled, each modification within a 
chromatogram such as moving peak delimiters results in automatic 
recalculation of the Calibration Coefficient and all derived calibration 
data. Disable Auto Recalibrate in the peak table to include the c0, c1, 
c2, and/or c3 columns. Perform recalibration by clicking Recalibrate. 
You may enter the corresponding values manually, as well.  

• Curve Fitting allows you to determine dependent and independent 
variables for calibration: Select Normal to accept normal evaluation 
and the axis settings of the calibration curve (x-axis = amount, y-axis = 
measured value). Select Inverted to use inverted evaluation and to 
invert the axes (x-axis = measured value, y-axis = amount). For more 
information, refer to How to …: Calibrating  Inverting Dependent 
and Independent Variables. 

Blank Run & Matrix Blank Subtraction 

In the Blank Run & Matrix Blank Subtraction section, determine whether 
the absorption values of a Blank Run Sample are considered 
(= subtracted) in the sample evaluation (= Blank Run Subtraction). You 
can also subtract the results of a single Matrix Blank Sample. 

• Select No Blank Run Subtraction if no correction is to be performed.  

• Select Subtract Recent Blank Run Sample in Corresponding 
Sequence to use a finished blank run sample of the current sequence 
for the subtraction. The chromatogram of the blank run sample is 
subtracted point by point from the active chromatogram. 

• Select Subtract a Fixed Sample to perform the correction with any 
sample. Click Browse to search for the sample. 
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• Select Enable Matrix Blank Subtraction to enable the subtraction of 
matrix blank samples. Contrary to the other options the resulting peak 
areas or peak heights are subtracted. 

Also, refer to How to …: Integrating Chromatograms and Identifying 
Peaks  Subtracting a Blank Run Sample. 

 

 Detection Parameters (Detection) 
Detection parameters serve, for example, to recognize, classify, and 
suppress peaks as well as to determine the baseline. 

The default values are normally suitable for optimum integration of 90% of 
all recorded chromatograms.  

In critical cases (for example, with wavelength switching), the user can 
improve the integration results by modifying the parameters.  

Detection parameters are time-dependent. Each parameter can be 
enabled, disabled, or changed in its value at a specific time. The time when 
the parameter shall change, the parameter name and its value are entered 
in the corresponding column of the first line. It is possible to change a 
parameter several times in succession. 

Detection parameters are defined in the QNT Editor. You can either enter 
them in the table of the Detection tab page or define them graphically in 
the chromatogram. 

 

In the example above, integration is inhibited (⇒Inhibit Integration 
command) at the time t = 0.000 (On). After three minutes (t = 3.000), 
integration is enabled again (Off). It is also stipulated that peaks with a 
minimum area of 1 x [Signal] *min only are recognized as peaks.  
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The last defined value of each parameter is valid until the sample run is 
completed. After that, the parameters assume their preset (default) values. 

If a parameter value changes at a specified time, this is referred to as 
event. You can have Chromeleon list these events in the report at the time 
of the change with a short description and the numerical value. 

You are not required to enter the events in chronological order. 
Chromeleon sorts them in ascending order before saving them. 

The meaning of the parameter table columns is as follows: 

No. Line number: The number is read-only.  

Ret. Time [min] Retention time in minutes. The allowed range is 
0.000 - 999.999 minutes.  

Param. Name Parameter name: The dialog box lists all 
available parameters. To open the dialog box, 
press the F8 key or double-click the column. 

Param. Value Parameter value: The dialog box provides exact 
information about which values are allowed for 
the selected parameter.  

Channel Channel: Click the arrow or press the F8 to open 
the dialog box and select an option, i.e., either All 
Channels or one of the recorded channels. 

 
Usually, the chromatogram and the report table are immediately updated 
when the detection parameters have been changed. However, you may 
disable this function by deselecting Autom. Re-Integerate on the View 
menu of the QNT Editor. If this option is disabled, save either the QNT 
Method or select Start Integration on the View menu to start re-integration 
with the new integration parameters. 

 Tip:  
The setting for this option is saved in the corresponding Report Definition 
File. 
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For more information and examples, refer to How to …: Integrating 
Chromatograms and Identifying Peaks  Defining Detection 
Parameters and ⇒Detection Parameters (Overview). 

In many cases, it is easier to define the detection parameters graphically in 
the chromatogram. For more information, refer to How to …: Working with 
Chromatograms  Defining Detection Parameters Graphically. 

 Peak Table, Amount Table, Peak Tracking, and MS 
Tracking 
The peak table contains all parameters required to identify a peak and to 
determine the amounts of the substances serving as standards. The peak 
table contains a minimum of 26 columns (the Amount, C0, C1, and C2 
columns are duplicated as required, depending on the number of different 
standards). By default, the peak table consists of four tabs: Peak Table, 
Amount Table, Peak Tracking, and MS Tracking. Individual columns and 
entire pages can be displayed and hidden. 

The peak table is usually created manually; i.e., the user enters the names 
and retention times of the expected peaks. In addition, peaks serving as 
standard peaks must be labeled as such in the ⇒Standard column. The 
(known) concentration of a standard is indicated as the ⇒Amount in the 
Amount column. These values form the basis for any type of calibration.  

Select Autogenerate Peak table on the Edit menu to automate peak table 
creation. There are two ways to create a peak table: 
• Select Enumerate peaks of current chromatogram to include all 

peaks integrated in the current sample in the peak table. The peak 
name is the sequence name plus a consecutive number. 

• Select Use Spectra Library Screening results to use reference 
spectra found via  Spectra Library Screening for automatic peak 
table creation.  

In both cases, the values in the Retention Time and Window columns are 
recalculated and default settings replace all other entries (see How 
to …: Integrating Chromatograms and Identifying Peaks 

 Autogenerating the Peak Table). 
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 Caution:  
All previous entries are overwritten. Thus, they are lost when you save the 
peak table or the QNT File! 

For more information, refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Creating a Peak Table 
 

Peak Identification/Peak Tracking and MS Tracking 
Peak identification refers to the following procedure: A previously unknown 
peak is recognized due to peak-specific properties, such as the retention 
time or its UV spectrum, and is then labeled with a characteristic substance 
name.  

Peaks are usually identified by their retention times. If you know the exact 
retention time of a peak, enter the retention time and the Substance name 
in the corresponding columns of the peak table. If a peak is detected at the 
specified time, the name is automatically assigned (Fig. a).  

To ensure peak identification even if there are retention time fluctuations or 
neighboring peaks, use the ⇒Window peak table parameter to define a 
tolerance range (fig. b). If a peak is detected within the tolerance range, it is 
identified, even if the set (nominal) and the actual retention time do not 
match exactly (fig. c). If several peaks are detected within this range, 
Chromeleon identifies the "greatest," the "first," or the "nearest" peak, 
depending on the selected extension for the window parameter (fig. d). 
  

Tret (g)

Tret (n)

Tret (f)

Tret

a) b) c) d)

peak name window

set

actual

 
The retention time value previously entered in the peak table is corrected 
accordingly!  
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Peaks can also be identified by the UV spectrum. You can use the 
Spectrum alone, or the spectrum and the retention time (Spectrum and 
time). This method requires a Photodiode Array Detector, such as the 
Dionex UVD 340U. For each peak, the substance spectrum is recorded and 
compared to the library spectra, using certain criteria (see How to …: 
Integrating Chromatograms and Identifying Peaks  Peak Tracking). 
If the spectra match, the peak is identified. This method is very reliable. 

If you use a Mass Spectrometer, peak identification can be based on 
Mass Spectra. Use the MS Tracking tab page to select different options 

(see How to …: Integrating Chromatograms and Identifying Peaks 
 Identifying Peaks via Their Mass Spectra (MS Tracking)). This 

method is also very reliable. 

Calibration/Amount Table 
During calibration, the peak area of a known standard amount is 
determined. The result is used for calculating the amount of unknown 
samples via the area to amount ratio.  

Enter the amount contained in the different substances. In addition, 
determine the calibration function and specify whether external and/or 
internal standards will be used. 

This is performed via the Amount, Standard, Cal.Type, and Integration 
Type columns in the Amount Table and/or Peak Table. For a description 
of the columns and for details on the required column input, refer to How 
to …: Calibrating: 

 Entering Amount Values (Amount Column) 
 Selecting the Standard Method (Standard Column) 
 Selecting the Calibration Function (Cal. Type and Int. Type 

Columns) 
 

 Tip:  
For background information about calibration, refer to Theory of 
Calibration  Calibration (Overview). For information about how to 
perform calibration, refer to How to …: Integrating Chromatograms and 
Identifying Peaks  Calibrating. 
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 Calibration Settings (Calibration) 
In the simplest case of a chromatographic analysis, first one or several 
standard samples and then the unknown samples are analyzed. All 
samples of a sequence are evaluated based on the same standard 
samples. If the quality of the column changes between processing the first 
and the last sample, this will not be considered. 

That is why Chromeleon allows sample evaluation via specific patterns or 
based on any selected standard samples. The settings are determined via 
the ⇒Calibration Mode on the General tab page of the QNT Editor.  
The Calibration tab page indicates which standard samples are used for 
calibrating the current sample. When you change from the current sample 
to another sample by pressing the F4 or SHIFT+F4 keys, the list of the 
displayed standard samples is updated.  

If you notice that a specific standard sample falsifies your calibration 
results, you can disable this sample in the Enabled column. The standard 
sample is then excluded from the calculation. The corresponding calibration 
points are then highlighted in the curve by a different color. 

For more information, refer to How to …: Calibrating  Disabling 
Calibration Samples. 

 Spectra Library Screening 
To identify substances, spectra can be compared to library spectra. The 
spectra search can be performed via the Spectra Library Screening sheet 
of the QNT Editor. For more information about Spectra Library Screening, 
refer to How to …: Displaying and Using UV Spectra  Searching 
Reference Spectra. 

 The System Suitability Test 

The aim and objective of the System Suitability Test (SST) is to ensure 
that the operational conditions required for a specific measurement are 
achieved. Specify the conditions for the SST on the SST tab page in the 
QNT Editor. For more information about System Suitability Testing, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining System Suitability Tests. 



152 The QNT Editor 

 Mass Spectra (MS, MS Tracking) 
If you have a Thermo Finnigan Mass Spectrometer installed, you can 
acquire mass spectra using Chromeleon. For more information about how 
to install the spectrometer and acquire data, refer to How to …:  Using 
Mass Spectrometers. 

In HPLC MS, mass spectra especially serve for peak identification. Using 
mass spectra for identifying substances is via the MS Tracking tab page. 
For more information, refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Identifying Peaks via Their Mass Spectra. 

As MS chromatograms normally show increased noise, you have to 
process Mass Spectra before you can use them. On the MS tab page, 
define the number of single peak spectra to be averaged. Also, define how 
many background spectra shall be aggregated into a total background 
spectrum that is then subtracted from the averaged peak spectrum.  

For more information, refer to How to …: Using Mass Spectrometers 
 Processing Mass Spectra. 

 UV Spectra  
On the UV tab page, you can process UV spectra before you use them. 
Define the number of single peak spectra to be averaged. Also, define how 
many background spectra shall be aggregated into a total background 
spectrum that is then subtracted from the averaged peak spectrum.  

For more information, refer to How to …: Displaying and Using UV 
Spectra  Processing UV Spectra. 
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Integration 

Integration (Overview) 

The chromatographic process of converting peak areas below peaks in 
amount or concentration values is referred to as integration.  

Amount and concentration values are calculated based on the calibration, 
which supplies the calibration curve and the Calibration Coefficient. (For 
more information about calibration, refer to Theory of Calibration 

 Calibration (Overview).) 
To calculate the amount concentration for a single peak area, the 
calibration coefficients are inserted in the Formula for Amount 
Calculation. Chromeleon automatically performs this process for all peaks 
found. 

A

A A

Integration

Standard sample/~s
(known amount)

Analysis sample/~s
(Amount = ?)

Determine
peak area

Determine
peak area

   Amount
Substance A

Calibr. Curve /
Calibr. coeff.

Calibration

 
 
It depends on the  Quantification Method (QNT File) specified for each 
sample before the analysis how many peaks are detected and whether at 
least part of these peaks can be identified. The results of the area 
calculation and peak identification processes are represented graphically in 
the Integration window (chromatogram) and as a table (Report) on the 
Integration plot. 

For more information, refer to: 

 The Integration Window 
 Report Tables (Overview)) 
 The Calibration Curve 
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The Integration Window 

Chromatographic results are displayed in the Integration window. In 
addition, you can use the window to reprocess single chromatograms. 
Usually, the following items are displayed:  
• The chromatogram of the current sample  

• Various report tables 

 

In addition, you may display: 
• The calibration curve of the current peak (see the image above) 

•  The Trend Plot (refer to the Control section; similar functionality as 
in the control panel) 

• UV spectrum (if available) 

• Mass Spectrum (if available) 
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Settings in the Integration window are saved together with the  Printer 
Layout in the Report Definition File (RDF).  

For more information, refer to: 

 Opening a Sample 
 Operation 
 Manual Re-Integration 
 Chromatogram Comparison 
 Data Smoothing  
 Peak Ratio 
 The UV Spectra Plot 
 The Mass Spectra Plot 

 Opening a Sample 
When you open a sample, this action automatically opens the integration 
method window and displays the sample chromatogram. There are three 
options: 
• Select a sample and select Open on the File menu, or 

• Double-click a sample of a specific sequence in the Browser, or 

• Select a sample in the Browser, right-click to open the context menu, 
select Open, and then select a channel of the sample.  

Samples are usually opened after they have been completely processed. 
However, you may open samples while they are being analyzed, that is, 
while they are in the Running ⇒Status, provided that a certain amount of 
data has already been acquired. Depending on the ⇒Step and other 
detector settings, the sample must have run for several minutes. There are 
two ways to open a running sample: 
• In the Browser, using the different options described above, or 

• On a Control Panel, by selecting Integrate on the View menu. 
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 Operation 

Modifying the Appearance 
You can change the appearance of each chromatogram by enabling and 
disabling the display of various elements and by modifying them. 
• Double-click a peak to display the Peak Properties.  

• Draw a frame around the chromatogram section to be enlarged.  

• Select Decoration on the View menu to modify the window 
background, the different axes, the layout of individual peaks as well as 
the color, shape, and size of their captions.  

• Select Spectra Tool on the context menu (or click the corresponding 
icon on the Integration Toolbar to display a spectrum from the 
chromatogram at time t. When the spectrum symbol is added to the 
mouse pointer, you can click anywhere to extract and display a 
spectrum on the spectra plot if the corresponding data exists. A 
minimized representation of the spectrum itself is displayed in the 
chromatogram. To overlay single spectra, hold down the SHIFT key 
and repeat the operation. Alternatively, select Overlay Spectra on the 
context menu. Hide Time Spectra will remove the overlaid spectra. 

Opening Additional Window Sections 
Select one of the following commands to display more window sections:  
• Select Split Zoom on the View menu to split the window. By drawing a 

frame, you can zoom a window section. The left window shows the 
entire chromatogram and the frame; the right window displays the 
zoomed section. Use the mouse to move and position the frame in the 
left window section. The shape of the mouse pointer ( ) indicates that 
this mode is enabled. You can also draw a new frame at any time.  

• Select Report on the View menu to display the integration report (see 
Report Tables  The Integration Report).  

• Select Show Spectra on the View menu to display the peak spectrum 
of the currently selected peak (see  The Spectra Plot).  

• Compare two chromatograms by enabling the display of an additional 
chromatogram (see  Chromatogram Comparison). 
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 Manual Re-Integration 
Chromeleon largely automates sample integration. However, in special 
cases, the user may prefer to perform the changes manually. Chromeleon 
allows you to move peak delimiters manually, to insert and delete peaks, or 
to modify the baseline, etc.  

Select the Automatic Tool on the context menu to perform these changes 
directly in the chromatogram. The shape of the mouse pointer indicates 
which operation can be performed.  
 

   Move left or right peak delimiter 
     Change baseline point (left/right/center) 
     Move baseline point (left/right/center) 
 Move  
 Move baseline segment 

 Move ⇒Detection Parameter 
 Insert peak 
 Zoom out an area 
 Display UV spectrum 
 Operation not possible 

 
Select the individual commands such as Baseline Tool, Insert Peak Tool, 
or Zoom Tool, if you only need a specific scope of functions. For more 
information about the operations that can be performed, refer to How 
to …: Working with Chromatograms  Manual Re-Integration. 
 

 Tip:  
If manual modifications are performed, display the integration report to see 
the numerical results (see Report Tables  The Integration Report). 



158 Integration 

 Chromatogram Comparison 
The most exact method to compare two or more samples or 
chromatograms is to compare their numerical results. However, in many 
cases, it may be sufficient to overlay the chromatograms. This is referred to 
as a chromatogram comparison. 

What can be compared? 
Chromatogram comparison always compares single channels. It is 
irrelevant whether these channels are from the same sample or from 
different samples. Theoretically, an unlimited number of chromatograms 
can be displayed simultaneously in Chromeleon. 

However, the presentation becomes confusing when many chromatograms 
are displayed. That is why Chromeleon prompts the user to confirm that 
more than 20 chromatograms shall be displayed. This is to prevent that too 
many chromatograms are displayed due to an operator error, which may 
result in a decrease of system performance.  

How are chromatograms compared and displayed? 
To compare chromatograms, display them in the Integration window. One 
chromatogram is the active chromatogram. To make a chromatogram the 
active chromatogram, select it with the mouse. Only for the active 
chromatogram, additional information, such as the decoration, etc. is 
displayed. The names of all chromatograms displayed are indicated above 
the Integration window. The name of the active chromatogram is written in 
a different color. Click the name of any chromatogram to select it as the 
active chromatogram.  

Select Decoration on the context menu to edit the appearance of the 
window and the active chromatogram. 

How do I select the chromatograms or channels to be compared? 
• Select one or several samples in the Browser and drag them into the 

open Integration window. Chromeleon automatically attempts to load 
the Channel of the current sample. If this is not possible, for example, 
because the channel does not exist, the system loads the default 
channel. The default channel is the first channel that appears in the list 
when you open a sample. (Select Open on the context menu in the 
Browser.)  
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• Select Add Overlay on the File menu to display a specific channel of 
any sample in an opened integration window.  

• Select Open > All Channels to compare all channels of a single 
sample.  

• Select Compare to compare a specific channel in several selected 
samples.  

• Perform a query to specifically compare samples with certain 
properties.  

• Hold down the CTRL key and click the Next Chromatogram icon ( ) 
to display the chromatogram of the next sample in addition. 

• Hold down the CTRL key and click the Previous Chromatogram icon 

( ) to display the chromatogram of the previous sample in addition.  

• Hold down the CTRL key and click the Next Channel icon ( ) to 
display the next channel of the same sample in addition.  

• Hold down the CTRL key and click the Previous Channel icon ( ) to 
display the previous channel of the same sample in addition.  

For more information, refer to How to …: Working with Chromatograms 
 Comparing Chromatograms. 

Placing chromatograms and channels in relation to each other 
External factors such as the flow rate, solvent, column quality, detector 
amplification, etc. considerably influence the appearance of the 
chromatogram. 

As you cannot modify these conditions later, other ways must be used to 
perform the comparison as exact as possible. This is achieved by adapting 
the position and the size of a chromatogram to match another. Chromeleon 
provides several options. You can:  

• Assign chromatograms an offset in x- and y-direction. 

• Normalize the chromatogram time, i.e. you can overlay the 
chromatograms at a specific retention time. 
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• Normalize the peak height, i.e., you can adjust the height of a specific 
peak.  

• Stretch and compress chromatograms. 

• Subtract chromatograms from each other. 

Select Decoration on the context menu of the active chromatogram and 
enter the settings in the Comparison tab page.  

For more information, refer to How to …: Working with Chromatograms 
 Comparing Chromatograms. 

 

 Data Smoothing 
Data smoothing applies a digital filter to sample data to reduce signal noise 
and helps improve chromatogram appearance and reproducibility of peak 
baselines. Data smoothing is performed in the integration window. (For MS 
chromatograms, data smoothing is defined in the PGM File or during 

Mass Trace extraction.) After smoothing, the smoothed chromatogram is 
displayed overlaid over the original chromatogram. The original sample 
data file is not altered and the smoothed data file is stored separately. 

Filter Types 
The Savitzky-Golay filter smoothes to least-squares fit, using a weighting 
function based on second-degree and third-degree polynomials. Savitzky-
Golay smoothing is useful for reducing high-frequency noise of a data set 
that is continuous (such as a chromatogram) without significantly degrading 
the underlying signal. 

The Moving Average (= Boxcar) filter is a simple algorithm that produces 
a set of output values in which each output value is equal to the average of 
n points centered around the corresponding input value, where n 
represents the filter size. Because the Moving Average filter equally 
weights each point, its ability to discriminate between noise and signal is 
limited. 

The Olympic filter is very similar to the Moving Average filter, except that 
the maximum and minimum points of each input data set are rejected 
before the average is calculated. This provides better rejection of impulse 
noise (spikes) than the moving average filter. 
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In addition, the Gaussian filter is available for acquiring MS 
chromatograms and extracting a mass trace (in the Mass Spectra window). 
This filter applies the Gaussian distribution for chromatogram smoothing. 

Filter Size  
Filter size is the number of input data points used to generate each output 
data point. The filter size is an odd number between 5 and 999. Use a 
narrow filter size if desired peaks are narrow, and a wider filter size for 
wider peaks. As a rule of thumb, select a filter size that approximately 
equals the peak's half width. Note that too narrow a filter results in 
insufficient smoothing while too wide a filter can lead to distorted data. 

 Tip:  
Distortion of data during data smoothing mainly affects the peak height. 
Therefore, it is generally better to evaluate smoothed chromatograms by 
area rather than height. 

Iterations 
If a filter is applied several times, by far the highest smoothing result 
(>95%) is achieved when the filter is applied the first time. Thus, normally a 
single smoothing step is sufficient. However, applying a narrower filter 
multiple times often provides improved noise reduction without the signal 
degradation that can occur when using a wider filter size. This requires 
additional processing time, however, so a wider filter size may be 
preferable if its results are acceptable. 

For additional details, refer to How to …: Working with Chromatograms 
 Performing Data Smoothing.  

For MS Chromatograms, refer to How to …: Using Mass Spectrometers 
 Extracting Mass Traces afterward. 
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 Combination of Channels 
Chromeleon allows you to combine two 2D channels using arithmetic 
operations. Each data point is created by combining the associated two 
data points from the existing channels (i.e., the data points at the 
corresponding time), using the desired operation. The resulting channel is a 
2D channel, too. 

 Note: 
If there is a data point for channel A at a specific time but not for channel B, 
the missing data point is calculated by linear interpolation. That is why the 
resulting chromatogram may be shorter than the two original 
chromatograms. 

You can combine channels: 

• In the chromatogram: The resulting channel is calculated immediately. 

• As Post-Acquisition-Step in the PGM Editor: The resulting channel is 
calculated immediately after data acquisition is complete. 

Arithmetic combinations are not restricted to chromatograms in the strict 
sense. They can be used for all 2D channels, except for temporary 
channels. 

 Peak Ratio 
If the baseline-corrected signals of two channels (of the same sample!) are 
related to each other, a rectangular curve results. This curve is referred to 
as peak ratio. It is based on the observation that the ratio between two 
detector signals must be constant, as according to the Lambert-Beer law 
the detector signal (S) is always be proportional (c1) to the concentration 
(K) of a dissolved substance. 

S c xK= 1  

If the quotient q is formed of the two channels, the substance concentration 
K is reduced. The quotient now only depends on the ratio of the two 
wavelengths, and not of the time. 
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If q is entered against the time, the (theoretical) result for each peak of the 
sample is a horizontal line of the height c1(λ1)/c1(λ2).  

The baseline and the ⇒Peak Purity Threshold parameter determine the 
width of the rectangle. The ratio is only formed where both (!) peaks have a 
baseline and where the intensity of both (!) peaks is above the defined 
peak purity threshold. Thus, the range to be actually overlaid (= width of the 
rectangle) is the intersection of the baseline and Peak Purity Threshold 
condition. The default Peak Purity Threshold value is 10% of the peak 
maximum. You can change this value in the QNT Editor.  

The rectangle heights of two adjacent peaks differ if the corresponding 
peaks have different spectra and if the two wavelengths are selected so 
that the absorption quotient is significantly different.  

Consider the following limitations and requirements:  
• The detector may not drift. 

• The correlation only applies to the linear range of the Lambert-Beer law 
(<2000 mAU). 

• The solvent composition may not be altered (isocratic conditions).  

• The solvent only slightly contributes to the absorption. Baseline 
correction allows you to eliminate the solvent absorption. 

 Note: 
A peak ratio can only be formed with the signals of the same detector. 

Forming the Peak Ratio 
• In the Integration window, overlay two channels of the same sample, 

for example, by simultaneously clicking the Next/previous channel 
icon while pressing the CTRL key.  

• Select Decoration on the context menu to open the Chromatogram 
Decoration dialog. 

• Under Peak Decoration, select the Peak Ratio check box. 

In addition to the two chromatograms, a rectangle curve should appear in a 
different color should appear in any place in the Integration window where 
two peaks are overlaid. 
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Result  
A regular rectangle shape, as shown at 12.70min in the illustration, can 
serve as a criterion for evaluating the peak purity. The more the curve 
deviates from the rectangle shape, the higher is the probability that the 
overlaid peaks do not originate from the same substance. If the rectangle 
slightly overshoots on the right or on the left, this is tolerable due to the 
lower signal intensity at the peak start and the peak end.  

Select the Peak Ratio Mean Value and RSD Peak Ratio report variables 
from the ⇒Peak Purity and Identification category to numerically express 
the result of the peak ratio.  

 The UV Spectra Plot 

Overview 
The Spectra Plot enables the display of UV spectra. The prerequisite for 
the spectra plot is that the corresponding raw data is available. Raw data is 
generated by recording a 3D field, using a Photodiode Array Detector. 
Open the spectra plot from the Integration method.  
• To open the spectra plot window, select Show Spectra on the View 

menu or click the following icon: .  
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The representation of a spectrum in the Spectra Plot is usually (height) 
normalized: The height of the spectrum is represented in percent. Thus, it is 
independent of the concentration (also, refer to Normalization). As a 
default, normalization is by the greatest relative maximum within the 
spectrum. 

Normalization allows you to objectively compare two spectra of different 
concentrations. If spectra of the same peak, but with different peak heights 
are overlaid, these will generally coincide despite the differences in 
concentration.  

• Select Decorations on the View or context menu. On the Frame & 
Axes tab page, determine the type of normalization that shall be 
applied to the spectrum.  

Normalized spectra representation allows you to perform the following 
tasks:  

• Compare two spectra such as a standard and a sample 

• Determine the number and position of minima and maxima, even with 
less distinct spectra at low concentrations 

• Select an appropriate type of normalization 

• Enable or disable baseline correction  

• Determine exact integration limits by checking peak purity at various 
wavelengths and peak heights  

• Identify components 

Displaying Spectra of one Peak 
• In the chromatogram plot, select the peak for which to display the peak 

spectrum (= spectrum in the peak maximum). 

• If several peak heights were enabled on the Peak Spectra tab page in 
the Decoration dialog box of the spectra plot, the spectra of different 
peak heights are simultaneously displayed when you click the peak.  
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Displaying any Spectra of a Chromatogram 
To extract any spectra of a chromatogram via mouse-click, follow the steps 
below:  
• Select Tools on the context menu and enable Spectra Tool option or 

click the corresponding icon on the Integration Toolbar. A spectra 
symbol that is added to the mouse points indicates that the mode has 
been changed.  

• Click anywhere in the chromatogram to display the corresponding 
spectrum.  

• Repeat the operation while pressing the SHIFT key to overlay several 
spectra.  

Displaying Spectra of Different Samples 
To objectively compare spectra of different samples: 
• Select Decoration on the context menu of the spectrum to open the 

Decoration dialog box and select the Peak Spectra tab page. 

• Select the Retention time spectrum of a fixed sample option and 
click Browse to navigate to the desired sample. 

• Alternatively, you may also use the retention time spectrum of the last 
standard (= Retention time spectrum of recent standard), the 
reference spectrum of the peak table (= Reference spectrum in 
corresponding peak table), or any spectra that was found during 
library screening (Spectra library screening result). 

Match Factor, Difference Spectra, and 1st and 2nd Derivative of Spectra 
As soon as two or more spectra are represented on the spectra plot, a 
frequent question is the similarity between the various spectra.  

The similarity is indicated by the Match Factor, the formation of difference 
spectra or by representing the first or second derivative of a spectrum.  
• Select Decorations on the View or context menu of the spectrum, and 

then select the Show match check box on the Label tab page. 
Chromeleon returns a value for each represented spectrum specifying 
the match degree relative to the main spectrum (0 = no match; 1000 = 
perfect match).  
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• On Analysis tab page, select whether the difference spectrum or the 
first or second derivative of a spectrum shall be displayed in a second 
window in addition to the actual spectra. 

In the case of the match factor and the difference spectrum, the question 
which spectrum is considered a main spectrum is especially important, as 
this is the basis for the comparison and for all calculations. 

The main spectrum is usually the peak spectrum extracted at the retention 
time. If there is no peak spectrum, distinguish the following cases: If you 
used the Spectra Tool to extract the single spectra from the chromatogram, 
the spectrum that was extracted first is the main spectrum. If the spectra 
were automatically extracted at different peak heights (see Displaying 
Spectra of one Peak), the spectrum with the "oldest" retention time is 
considered the main spectrum. When representing difference spectra, the 
Difference to entry indicates the basis for calculation. 

Comparing a Spectrum with Spectra of an Existing Spectra Library 
To clearly identify a spectrum, compare it to a reference spectrum stored in 
a Spectra Library. 
• On the context menu, select Library Search to start the comparison. 

The  Spectra Library window lists all library spectra with a minimum 
similarity to the (normalized) spectrum. For more information about how 
to perform library screening, refer to How to …: Displaying and Using 
UV Spectra  Searching Single Reference Spectra. 

If the spectra plot contains more than one starting spectrum, Chromeleon 
always uses the spectrum displayed first and then compares it to library 
spectra.  

 The Mass Spectra Plot 

General 
The Mass Spectra Plot enables the display of Mass Spectra. The 
prerequisite for opening the mass spectra plot is that the corresponding raw 
data recorded by a Mass Spectrometer are available. Open the mass 
spectra from the Integration method. 
• To open the spectra plot, select Show Mass Spectra on the View 

menu or click the following icon: .  
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The representation of a mass spectrum is height normalized: The height of 
the spectrum is represented in percent and thus independent of the 
concentration (also, refer to Normalization). As a default, this 
normalization is by the Base Peak of the spectrum. 

Normalization allows you to objectively compare two spectra of different 
concentrations. If mass spectra of the same peak, but from different peak 
heights are overlaid, these will generally coincide despite the differences in 
concentration. Due to their higher information density, mass spectra are 
displayed in Chromeleon below each other, which is contrary to the display 
of UV spectra that are overlaid. 

Displaying Mass Spectra of one Peak 
• In the chromatogram plot, select the peak for which to display the mass 

spectrum (= spectrum in the peak maximum). 

• If several peak heights were enabled on the Peak Spectra tab page in 
the Decoration dialog box of the mass spectra plot, the mass spectra 
from different peak heights are displayed simultaneously when you 
click a peak. 

Displaying Mass Spectra of Different Samples 
To objectively compare mass spectra of different samples: 
• Select Decoration on the context menu of the spectrum to open the 

Decoration dialog box and select the Peak Spectra tab page. 

• Select the Retention time spectrum of fixed sample option and click 
Browse to navigate to the desired sample. 

• Alternatively, you may also use the retention time spectrum of the last 
standard (= Retention time spectrum of recent standard), the 
reference spectrum of the peak table (= Reference spectrum in 
corresponding peak table), or any spectra that was found during 
library screening (Spectra library screening result). 
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 The Autopurification Tray View 
Chromeleon supports two Autopurification tray views: Inject Trays and 
Fraction Racks. To open the associated view and display the different 
samples and/or fractions, click the related button: 

 opens the Inject Trays view, showing the analytical and preparative 
samples. 

 opens Fraction Racks view, showing the tubes of the fractionated 
samples. 

 

The default setting is that an overview of the single racks is displayed 
below the title line, also showing the racks that do not contain samples 
and/or fractions. The racks and their samples are displayed below this 
general overview. The samples and/or fractions are color-coded, based on 
their ⇒Type (Sample Type) and ⇒Status. 
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Report Tables 

Report Tables (Overview) 

The report (or on-screen report, to distinguish it from the Printer Layout 
that defines the printout) includes several graphics and tables for displaying 
all relevant sample data on the screen. The report is saved in the Report 
Definition File (RDF), together with the printer layout. 

To open the report tables, either select Show Report on the View menu or 
click the following icon: . The report is usually displayed in the 
Integration window. However, you can also have the report tables 
displayed in the QNT Editor to directly check the effects of the changes 
made in the QNT Method. (For more information about the editor, refer to 
Data Representation and Reprocessing  The QNT Editor.) 
You can add, edit, or extend the individual report tables as required. 
Chromeleon provides the following tables when you select Insert Report 
on the Table menu: 
 
Result Tables    
Peak Results These reports combine data of the current sample.    

Calibration 
Report 

Displays all variables required for creating a calibration report. 

  
Integration 
Report 

Displays all variables required for creating an integration report.  

  
Sample Results These reports combine data of the entire sequence.    

Calibration 
History 

Displays all variables documenting the course of the calibration. 

  
Peak Summary Displays those variables for the entire sequence that are required for 

creating a peak summary.   
SST Summary 
Report 

Documents the results of the System Suitability Test for the entire 
sequence.   
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Audit Trails    

Audit Trail 
(Commands, 
SST, ...) 

Displays the Audit Trail of the current sample. (Also, see Data 
Management  Audit Trails).  

  
MS Instrument 
Info Report 

Displays information about the Mass Spectrometer. 

  
MS Status Log 
Report 

Displays the mass spectrometer settings. 

  
MS Tune Data 
Report 

Displays the tune data of the Xcalibur raw data file. 

  
MS Instr. Method 
Report (XRaw) 

Indicates the MS method. 

  
Spectra Results    

MS Raw Report Displays the raw data of the current Mass Spectrum.   
Fraction Collection Results    

Fraction Report Displays all variables required to create a fraction report.    
Tube Report Displays the different variables describing the single fraction 

collection tubes. This also includes the fraction report variables. 
However, please note that these variables are not selected by 
default.   

QNT Tables These reports combine data of the current sample.   
Detection 
Parameter  

Displays all ⇒Detection Parameters of the current sample. 

  
Peak Table Displays all variables that are required for displaying the peak table 

of the QNT Editor.   
SST Table Lists variables of the System Suitability Test for the current 

sample.   
PGM Tables    

Commands Displays the Program for the current sample.   
Post Acq. 
Processing 

Displays the Post-Acquisition Steps for the current sample.  

  
MS Method Displays information about the current method of the Mass 

Spectrometer   
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Miscellaneous Tables    
Database Query Inserts any kind of database queries into the report.   
History Report Displays all variables required for creating a History report. 

 

Tip: 
Select Print on the File menu to print chromatograms, spectra, report 
tables, etc. at any time. The pages defined in the Printer Layout will be 
printed. This also applies when you print from an on-screen report. 
 
For more information about some of the reports mentioned above, refer to: 

 The Integration Report 
 The Calibration Report 
 The Peak Summary Report 
 The History Report 
 Special Report Tables 

 
For information about how to create a report, refer to How to …: 

 Creating and Using Report Tables. 

 

 The Integration Report 
The Integration Report (or more precise, the Integration Report Table) is 
usually the first table of a report. For example, the defltdad Report 
Definition File (RDF) includes the following integration report tables: 
• Integration 

• Peak Purity 

• Peak Analysis 
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Contents 

• The integration report contains all relevant numeric data for the active 
sample, such as the retention time, peak area and height, amount, 
peak type, and other ⇒Peak Variables.  

• The individual columns contain variables of the ⇒Peak Results report 
category. Nevertheless, you can add more columns from other 
⇒Report Categories. 

• If the chromatogram is modified, for example, by manual re-integration 
of a peak, this is reflected immediately by the changed report data.  

• Via the Windows clipboard, data of the report table can be integrated 
directly in other Windows applications.  

• In the report, the values of different cells are added, subtracted, 
multiplied, or divided in the same way as in MS Excel. Enable Layout 
Mode on the Table menu.  

Formatting 
You can adapt the integration report to your requirements by selecting the 
corresponding format commands on the context or Table menu. (The 
format commands are only available after you have enabled Layout Mode 
on the Table menu.) For more information, refer to How to …:  Creating 
and Using Report Tables. 

 The Calibration Report 
The Calibration Report (or more precise, the Calibration Report Table) is 
very similar to the  Integration Report: 
• Similar to the integration report, the calibration report displays data of 

the current sample. However, in the calibration report table, this data 
refers to the calibration of the current sample. 

• The individual columns contain variables of the ⇒Peak Calibration 
report category. Nevertheless, you can add more columns from other 
⇒Report Categories. 
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• The calibration report table allows you to understand changes made 
during the calibration (in the QNT Method). 

For more information, refer to How to …:  Creating and Using Report 
Tables. 

 The Peak Summary Report 

Commonly used reports such as the  Integration Report and the 
 Calibration Report contain data of one sample only. In case of a 

chromatogram comparison, only the data of the selected (active) 
chromatogram is displayed. 

Comparing peak data from different samples is possible via the (peak) 
Summary report table. 

Sample Selection 
• If one sample is selected and opened from the Browser, the peak 

summary is based on the corresponding Sequence.  

• If several samples are selected in the Browser, these selected 
samples only will be part of the Summary report table.  

• If a Query is started in the Browser, the search result forms the basis 
for the Summary. In this way, it is possible to compare peaks from 
different sequences. 

Peak Selection 
• Normally, no peak is selected in the chromatogram of the sample. The 

Peak Summary Report therefore contains no entries. All fields are 
marked n.a. (not available) or Div/0 (Division/0). Only when a peak is 
selected manually within a chromatogram, the Peak Summary Table 
receives entries. As soon as this is performed, this peak is searched in 
all previously selected samples. The search result is displayed in the 
Summary Report.  

• For each Peak Summary column (!), it is possible to define whether the 
values of the currently selected (Selected Peak) or one specific peak 
(Fixed Peak) are displayed. Access these options by selecting 
Column Properties on the context menu.  
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• If the currently selected peak is an identified peak, that is, if the peak 
is labeled with its name in the peak table, all involved samples are 
searched for this peak name. The corresponding values of all found 
peaks are displayed in the Summary.  

• If the currently selected peak is a non-identified peak, that is, if the 
peak is not labeled with its name in the peak table, a "fixed time 
window" (± 2.5% of the detected retention time) is calculated for this 
peak. This calculated time window appears in the header instead of the 
peak name. If two or more peaks are detected in the time window, the 
peak that is nearest to the specified retention time will be selected.  

Creating a Summary 
• Double-click one of the samples to open the Integration window.  

• Display the Report and select the default Summary worksheet 
available Chromeleon. It contains a selection of the most important 
default ⇒Peak Variables. For each sample that is part of the Summary, 
a separate line is reserved in the report.  

• If the default Summary Report is not available, a new worksheet can be 
defined. Proceed as described in: How to …: Creating and Using 
Report Tables  Adding and/or Renaming a Worksheet.  

As in all reports, the currently selected sample in the chromatogram 
window is highlighted in the Summary Table. 

 The History Report 
The standard Report Definition Files (RDFs) include both, an 

 Integration Report and a  Calibration Report but no history report 
table. However, you can easily include the History Report table (see How 
to …: Creating and Using Report Tables  Adding and/or Renaming a 
Worksheet). 
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Contents 
• By default, the history report displays the History of the current 

sample. In order to display the histories of other objects, select Table 
Properties on the context menu and make your selection on the 
History Objects tab page. 

• In addition, you can limit the displayed history as to time and/or certain 
actions and/or users. 

Formatting 
• You can sort the history report entries according to specific details, 

such as Time, Name, Version, etc. 

• The history mode includes a special Layout Mode. Enable this mode 
on the Layout tab page by selecting the Design template mode check 
box.  

 Special Report Tables 
The standard Report Definition Files (RDFs) include both, an 

 Integration Report and a  Calibration Report but none of these 
special reports. However, you can easily include them (see How to …: 
Creating and Using Report Tables  Adding and/or Renaming a 
Worksheet). 
 

MS Reports 
 
MS Instrument Info Report Information about the Mass Spectrometer. 
MS Instrument Method Report MS method. 
MS Raw Report Raw data of the current Mass Spectrum. 
MS Status Log Report Mass spectrometer settings. 
MS Tune Data Report Tune data of the Xcalibur raw data file.  

 Note: 
If you do not have the MS Control option enabled on your PC, MS reports 
will not be displayed in the Insert Report dialog. 
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Other Special Report Tables 
 
Database Query Results of a database query.  
Detection Parameter Report Indicates the⇒ Detection Parameters. 
Program Report Program of the current sample. 
SST Report System Suitability Test.  

 Note: 
All MS report tables as well as the Database Query, Detection 
Parameter, and Program report tables comprise only the default columns. 
It is not possible to add more columns.  
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The Calibration Curve 

The Calibration Curve 

The Calibration Curve method window allows you to evaluate the 
calibration. For more information about the calibration, refer to Theory of 
Calibration  Calibration (Overview). 
• Open the window from a different method, for example, from the 

Integration window, by selecting Show Calibration Curve on the 
View menu. 

• Or else, click the corresponding icon on the toolbar.  

As described for the QNT Editor and Integration methods, various window 
sections can be displayed. The window arrangement usually comprises the 
Chromatogram, Calibration curve, and Report windows. 
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• Press F4 or SHIFT+F4 to change to the chromatogram of a different 
sample. Generally, all chromatograms of a sequence can be thus 
displayed on after the other.  

• In the chromatogram, select the peak for which you want to display the 
calibration curve. The peak will be indicated by a different background 
color. 

• The Calibration tab page of the Report window shows the most 
important calibration data, such as ⇒Calibration Type, number of 
calibration points, Relative Standard Deviation  (Rel.Std.Dev), 

Correlation Coefficients as well as the following calibration 
coefficients: Offset (c0), Slope (c1), Curve (c2), and Cubic 
Coefficient (C3). In addition, you can display, for example, the 

Variance or Standard Deviation (Std.Dev). 

• Select Decoration on the context menu to change the colors and the 
captions of various window elements. 

• Select Column Properties or Table Properties on the context menu 
to change the contents and the layout of the table. For more 
information, refer to How to …:  Creating and Using Report 
Tables. 

For more information about the calibration curve, refer to How to …: 
 Displaying Calibration Curves.  

 

 Note: 
We would like to point out that the default use of the report variables in the 
Integration, Calibration, and Peak Summary reports is not binding in 
Chromeleon. You can freely configure each of the three reports, use any 
variables, or rename the report as desired. 
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The Printer Layout 

The Printer Layout (Overview) 

The increasing number of samples makes printing analytical results a 
complex and time-consuming procedure, especially because results are not 
only required on hardcopy but in all types of presentations. 

Chromeleon considers this and emphasizes flexible report generation that 
meets all your requirements. The Printer Layout is the appropriate tool for 
this.  

With each Chromeleon installation, different Report Definition Files 
(RDFs) are stored in the Dionex Templates > Reports directory of the 
client PC. 

• Click the  icon on the Method toolbar to open the Printer Layout. 

 Note: 
For more information about the printing options, refer to Basic Operation 

 Printing. 

The Printer Layout represents a type of folder for various worksheets. 
Each sheet describes one or several printed pages (size of the 
chromatogram, where to position it, columns included in the numerical 
report, results represented in a chart, what is included in headers and 
footers). 

The Printer Layout is saved together with the (on-screen) report of the 
 Integration Window in the Report Definition File. With an increasing 

number of worksheets in the Printer Layout of a Report Definition File, the 
printing possibilities increase as well. For example, if you want to print all 
samples of one sequence, it may be a good idea to present the results of a 
calibration sample differently from the unknown samples, and the lines of a 

PGM File or summary report in yet another way. Specify which sample or 
file type should be printed and the worksheet to be used. 
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The Printer Layout of the default.rdf report definition file contains, for 
example, the Integration, Calibration (Curr.Peak), Calibration (Batch), 
Peak Analysis, Summary, and Audit Trail worksheets. Thus, it covers all 
default requirements.  

For more information, refer to: 

 Appearance and Function 
 Creating Your Own Templates and Worksheets 
 Printing 

For information about how to create a printer layout, refer to How to …: 
 Preparing the Printout. Also, refer to  Specifying the Printout for 

printing your results. 

 Appearance and Function 
Important features of the Printer Layout are: 
• The appearance and the structure are similar to Microsoft Excel. The 

functional scope is similar to Excel as well. To enter formulas and to 
create diagrams, use the Report Publisher, which is a Chromeleon 
add-on product. 

• Toggle between the individual sheets of a Printer Layout by clicking the 
tabs provided on the bottom of the window bottom. 

• Double-click the name of a tab to change its name, for example, to 
change Integration to Integration Special. 

• Each sheet consists of a large number of columns (256) and lines 
(16000).  

• Select Insert Row(s)/Column(s) or Delete Row(s)/Column(s) to 
insert columns or to delete columns or lines on the worksheet. 

• Single areas or cells of a worksheet can be "filled" using the Windows 
clipboard (Copy and Paste commands) or via the Insert command on 
the context menu. (For more information, refer to The Printer Layout 

 Creating Templates and Worksheets.) 
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• If the Layout Mode is enabled on the Edit menu, Chromeleon objects 
are marked by a red triangle. Chromatograms, tables, calibration 
curves, etc., have a red triangle in all four corners. For cells with single 
variables, the red triangle appears only in the upper right corner of the 
cell. 

 

 Tip: 
Note that you can place several report tables on a worksheet. The tables, 
however, must be positioned one below the other, not next to each other!  
 
The worksheets that are virtually unrestricted in horizontal and vertical 
direction, allow creating page layouts larger that one printed page. 
Depending on the selected page size on the printer, one or several pages 
are required for printing this type of page layout. The worksheet is divided 
in many invisible horizontally and/or vertically positioned print pages. 

If the user, for example, inserts a chromatogram that does not fit on one 
page, the rest is printed on a new page. 
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• Select Page Setup on the File menu to specify the order ("from left to 
right" or "top to bottom") in which to print the printed pages of a 
worksheet. 

 

 Creating Templates and Worksheets 
In addition to the default report templates provided in the Dionex 
Templates > REPORTS directory, Chromeleon allows you to create your 
own templates: 

• Click the  icon on the Method toolbar to open the Printer Layout 
from your currently selected view. Chromeleon automatically opens the 
report template of the current sequence. Select the Load Report 
Definition command on the context menu to open a specific report 
template. 

 

 Note: 
If only the default report templates are available in your system, save it 
under a new name via the Save Report Definition command. Afterward, 
you can edit the duplicate as follows: 
 
• Enable Layout Mode on the Edit menu to perform manual changes on 

the report template. 

• Select the worksheet you wish to edit, or insert an additional (empty) 
worksheet via the Insert Sheet command (Edit menu). 

• Select Delete Sheet on the Edit menu to delete a superfluous 
worksheet. 

• Select Insert on the context menu to insert chromatograms, tables, 
diagrams, report variables, or other elements. 
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 Caution:  
Note that you can place several report tables on a worksheet. The tables, 
however, must be positioned one below the other, not next to each other!  
 
Each element inserted in this way reserves a specific area on the 
worksheet. If a report template or a single worksheet serves as a print 
template, these areas are "filled" with the values or graphics of the current 
sample. It is also possible to determine whether the printed output includes 
data and chromatograms of all channels of a sample or only of one 
channel. 
 

 Note: 
In addition to report variables that can be combined to form new functions 
via the four basic arithmetical operations (plus powers), it is possible to 
calculate additional functions known from Microsoft Excel. For a list of 
supported functions, refer to Additional Functions in the Glossary. 
 
For more information about how to create worksheets and report templates, 
refer to How to …:  Preparing the Printout. 

 Printing 

From the Printer Layout 
The Printer Layout allows you to print the created report template at any 
time. 
• Select Print on the File menu to start printing. 

• Click Preview in the Print dialog box to preview the layout of the 
printed output.  

The printed output uses the data of the current sample with the layout of 
the currently opened sheet.  
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From the Browser 
You can print larger quantities of data, either single samples or even entire 
sample series, from the Browser:  
• Use the mouse to select the samples to be printed. If you want to print 

all samples of one or several sequences, select the associated 
sequence(s).  

• To print samples from several sequences, perform a Query  

• Afterward, select Batch Report on the context menu and select the 
Report Definition to be used for the printed output. In addition, select 
the channel to be printed and specify the printer. 

In addition to the results, it is possible to print sample data, that is, the 
information in the sample list. 
• Open a sample list and select Print Table on the context menu. 
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Peak Purity Analysis 
 

PPA: Peak Purity Analysis 

 Caution:  
The basic requirement for using the PPA method is the availability of a 
Dionex Photodiode Array Detector. In this case, the data supplied by a 
detector can be "read" and viewed on any client PC. The most common 
method to relate chromatograms to spectra is the representation of data in 
a 3D Field in the method PPA. The 3D field is the default view in the iso-
pixel plot representation.  

Use one of the following methods to display a sample (for which you have 
the corresponding 3D raw data) in the method PPA: 
• Select the sample in the Browser, and then select Open > 3DFIELD on 

the context menu. 

--Or-- 
• Change from a different method to the PPA method. Click the PPA icon 

or select PPA on the View menu.  

View and Operation 
In the default view, the method window is divided in four sections. The 3D 
field window (A3) is the most important section. Select either Iso Pixel Plot 
or 3D plot (see 3D Field Presentation Modes). 

The cross-wires that are freely positioned via the left mouse button or the 
arrow keys "extract" a chromatogram at a specific wavelength in horizontal 
orientation from the plot representation. In vertical orientation, a spectrum is 
extracted at the time t and is displayed above (A1) or next (A2) to the 3D 
field (A3). Select the Zoom function for a more detailed view. 
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The display of the window sections A1 and A2 can be enabled or disabled 
via the Show Chromatogram or Show Spectra options. Optionally, an 
additional numeric report (PPA report) can be displayed (Show Report). 
The line of the currently selected peak is highlighted by a different color.  

In addition to the context menu commands that allow undoing a Zoom 
operation, restoring the original 3D field, selecting a different 3D 
representation, or displaying additional information such as the PPI Index, 

Match Factor, etc., there are additional operations that can be executed 
via the keyboard or a mouse-click. 
 
• Double-click to open the 3D field Decorations dialog box. 

• Right-click while the 3D field is redrawn to stop redrawing. This option 
is useful when the wrong zoom area was chosen. 

• Double-click the time axis of the window to execute the Full Size 
command. In the wavelength scaling, the same operation performs the 
Autoscale command.  

• Press the CTRL key to make the currently displayed spectrum in the 
spectra window "permanent," so that it is still displayed even when 
moving the cross-wires. The spectrum extracted via the cross-wires is 
displayed in addition. If the operation is performed several times, any 
number of individual spectra can be displayed in the spectra window.  
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• It is also possible to combine pressing the CTRL key and moving the 
cross-wires: Position the x-axis of the cross-wires on the required 
wavelength and press the CTRL key. Then move the y-axis over a 
peak in the chromatogram. The spectra window now shows all spectra 
within the covered range. This procedure can be performed for various 
peaks in a chromatogram. Release the CTRL key between the 
individual peaks to represent each peak in a different color. For each 
peak, a number of spectra can thus be displayed.  

• If the y-axis of the cross-wires is located on a peak, the peak spectrum 
(= spectrum in the peak maximum) can be copied to the Windows 
clipboard via the Copy command. From there, the spectrum can be 
included in the spectra library. For this operation, approximately 
positioning the y-axis is sufficient.  

• Select one of the Extract: commands to extract the active 
chromatogram, the optimum integration path, the current spectrum or 
the 3D field data and save the item under a separate name. For a 
description of the required steps, refer to How to …: Displaying and 
Using UV Spectra  Extracting Spectra, Chromatograms, 3D 
Field Data and  Selecting the Optimum Integration Path.  

 

 Note: 
Copying or printing a 3D plot is more time-consuming than copying or 
printing the Iso plot!  
 
• Select Library Search on the context menu to search the spectra 

library for the displayed spectrum. For more information, refer to How 
to …: Displaying and Using UV Spectra  Searching Single 
Reference Spectra.  

Function 
Use the PPA method  
• To analyze the peak purity (see How to …: Displaying and Using UV 

Spectra  Analyzing the Peak Purity).  

• To assign peaks interactively via the spectrum. 

• To extract chromatograms, spectra, and the optimum integration path. 
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• To visualize chromatograms for presentation and archiving purposes. 

• To evaluate baseline effects. 

• To check the Lambert-Beer linearity range. 

• To perform quantitative analysis of overlapping peaks. 

These methods are completed by various procedures and calculations for 
result interpretation and/or comparison. These include: 

Baseline Correction of Spectra 

Blank Run Subtraction 

Normalization 

PPI: Peak Purity Index 

PPI: Match Factor 
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Spectra Libraries 

Spectra Libraries 

The Spectra Library pane allows you to compare Normalized and single 
baseline-corrected spectra with spectra from various libraries. There are 

three sections: 

Spectra Table 
The upper section lists all spectra that are contained in a Spectra Library, 
as well as their data.   
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Spectra Plot 
The spectra plot is displayed at the bottom left, underneath the table, 
showing the spectra of all substances selected in the spectra table. 

Data Window 
The bottom right section is reserved for data representation, showing 
important data related to the spectrum that is selected in the spectra table. 
 
For more information about Spectra Libraries, refer to How to …: 
Displaying and Using UV Spectra: 

 Creating and Using Spectra Libraries 
 Creating a New Library 
 Comparing Spectra 
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3D Amperometry 

The 3D Amperometry Window 

The 3D Amperometry window displays a sample's 3D_Amp data, which is 
collected using an ICS-3000 ED electrochemical detector in integrated 
amperometry mode. 

Use one of the following methods to display 3D amperometry data: 
• Select the sample in the Browser and then select Open>3D_Amp from 

the context menu. 

• If the sample is already open in another window (for example, the 
Integration window), select 3D Amperometry from the View menu or 
click the following icon on the Method toolbar . 

 Tip: 
A real-time plot of the 3D amperometry data can be displayed online during 
a run. See How to …:  Controlling Devices from the Control Panel 
for more information.  

The window is divided into several display areas: 
• The main area in the lower right displays the raw 3D amperometry 

data.  

• The area above the 3D data displays a chromatogram of selected data.  

• The area to the left of the 3D data displays an I-t plot (current vs. 
waveform time) of selected data.  
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You can use several methods to select the data displayed on the plots: 

• Drag the horizontal and vertical line cursors. 
• Use the mouse to zoom into a selected area. 
• Select a command (for example, Zoom to Integration Interval) from 

the View or context menu.  

To select various plot options (for example, to switch from integrated to raw 
data view), select Decoration from the View or context menu. 

For more information, refer to  Display Areas and  Data Selection. 
Also, refer to How to …:  Analyzing 3D Amperometry Data. 

 Display Areas 
The 3D Amperometry window displays three plots of the 3D_Amp data: 

Chromatogram Plot 
The chromatogram plot is generated either by retrieving one raw data point 
per Waveform from the selected 3D data (if raw data is displayed) or by 
calculating one integrated data point per waveform cycle from the selected 
3D data (if integrated data is displayed). The x-axis is the retention time 
(min) and the y-axis is the response (nA for raw data or nC for integrated 
data). 
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Raw 3D Data Plot 
The raw 3D amperometry data plot can be viewed as either an 
isoamperometric or a 3D (wire frame) plot. For both plot types, colors are 
used to represent the ranges of response values.  

The isoamperometric view is the default view for the 3D raw data. This is a 
top-down view of the data (imagine you are looking down on the data from 
above the plot). The x-axis is the retention time (min) and the y-axis is the 

Waveform Period (ms). The z-axis, which is not visible on the plot, is the 
response (nA). Different levels of response are represented by different 
colors. 

       

The 3D view projects the response values in the third-dimension, which 
allows you to see the height of responses and well as the color mappings. 
For this view, imagine you are standing in front and slightly to the left of the 
plot.  
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I-t Plot 
The I-t plot is a plot of current (I) vs. waveform time (t). To better visualize 
this plot, imagine that a vertical slice of the 3D amperometry data is taken 
at retention time (T) and then the slice is laid flat. The left axis is the 
waveform period (ms) and the bottom axis is the current (nA). A waveform 
can optionally be overlaid on the plot. When the waveform is displayed, the 
top axis indicates the applied voltage (mV).  

  

Also, refer to  Data Selection and How to …:  Analyzing 3D 
Amperometry Data. 
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 Data Selection 
The 3D Amperometry window provides the following data selection 
features:  
• If integration is enabled, parallel horizontal line cursors on the 3D and I-

t plots select the Integration Interval. You can move the integration 
interval by dragging the top line on either the 3D or I-t plot. You can 
also increase or decrease the width of the interval by dragging the 
bottom line. Changing the integration interval selects new data to be 
integrated. This generates a new chromatogram, which is displayed on 
the chromatogram plot. 

 Tip: 
If multiple integration intervals are present, select the interval that you want 
to change by dragging the vertical retention time line cursor into the 
interval's time range.  

 

• If integration is disabled, a single horizontal line cursor on the 3D and I-
t plots selects a waveform time slice. The selected waveform time 
determines which data points are used to plot the chromatogram. You 
can drag the cursor to select a different waveform time and generate a 
new chromatogram. 
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• The vertical line cursor on the 3D and chromatogram plots selects a 
retention time slice. The selected retention time determines which data 
points are used to create the I-t plot. You can drag the cursor to select 
a different retention time and thus generate the corresponding I-t plot.  
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• The mouse can be used to zoom into an area of a plot. Point and drag 
to draw a frame around the area that you want to zoom into.  

• The View and context menus also provide commands for selecting 
data.  

 

 Tip: 
If multiple waveforms were applied during the run, or if additional 
integration intervals were added post-run, non-movable vertical markers (in 
green) designate where each waveform change occurs.  

 

Also, refer to How to …:  Analyzing 3D Amperometry Data. 
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How to …: 

How to …: 
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Creating and Managing Files 
Chromeleon allows you to record a huge number of chromatograms. To 
manage, copy, move, and/or delete the different files that are required for 
this task, Chromeleon provides a central tool for file management, the 
Browser (also, see Data Management  The Browser). In the Browser, 
you can, e.g., create sample lists, save data in a datasource, search for this 
data later, and import data from other programs. For information about 
which actions you can perform in the Browser, refer to: 

 Creating a Sample List (Sequence) 
 Handling Files and Datasources 
 Signing Sequences Electronically 
 Performing a Query 
 Importing PeakNet Method Files (Release 4.5 Through 5.2)  
 Importing Agilent/HP ChemStation Data Files 

 
For information about the actions that administrators can perform in the 
Browser, refer to How to …:  Working with Files, Databases, and 
Networks in the Administrator Help section. 
 

 Caution: 
Browser functions and structure are similar to the Windows Explorer. 
However, do not confuse the Browser with the Windows Explorer! Do not 
use the Windows Explorer for operations within Chromeleon datasources. 

Creating a Sample List (Sequence) 
There are two basic ways how to create a sample list. (see Samples and 
Sequences  The Sample List (Sequence)): 
1.  Manually edit an existing sequence and save it under a different name. 

2.  Automatically create a sequence using the Sequence Wizard. (For 
information about the wizard, refer to Samples and Sequences  The 
Sequence Wizard). 
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Manually creating a sample list 
• In the Browser (see Data Management  The Browser), select the 

sequence whose QNT and PGM Files you want to use for the new 
sequence, probably after having edited them. Select Save as on the 
File menu to save the sequence under a different name. Edit the new 
sequence as necessary. 

• In the lower right Browser section, enter the names and the properties 
of the standard samples and the unknown samples to be analyzed:  

• Click a cell in the table and enter the new value or the name via the 
keyboard. To open a dialog box for assistance, press the F8 key. 

• In the ⇒Name column, enter a name for each sample to be analyzed.  

• In the ⇒Type column, select the sample type from the drop-down list 
(Unknown, Blank, Validate, Standard, Spiked, or Unspiked).  

• In the ⇒Pos. (sample position) and ⇒Inj. Vol. (injection volume) 
columns, type the autosampler position from which to inject and the 
substance volume. 

• In the ⇒Program and ⇒Method columns, determine the 
Chromatographic Methods to be used for the analysis. 

• In the ⇒Status (sample status) column, define how often a sample 
shall be processed. Select Single to process the sample only once. 
Select Multiple to process the sample several times.  

• To analyze two unknown samples (Sample 1 and 2) on the basis of a 
2-point calibration, the input can be as follows: 

 

 
• It is not imperative that you fill the other columns, e.g., ⇒Weight 

(Sample Weight Factor), ⇒Dil. Factor (dilution factor) and ⇒Inj. 
Date/Time. Either they contain special parameters or the system fills 
them automatically after the analysis. 
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• If you are not sure which values or names to enter, select the cell and 
press the F8 key. An edit dialog box appears listing the allowed values 
and/or options. Enter the desired value or select an option. Clicking OK 
automatically updates the cell.  

• Press the F1 key to display more information about the individual 
columns. 

• Press the F9 key to fill all subsequent cells of a column with the same 
input.  

• You can have Chromeleon generate a unique ID for each sample (see 
 Using Globally Unique Sample Identifiers). 

• To enter special values, create User-defined Columns (see 
 Creating User-defined Columns). 

• To take an overview of the most important results in the sample list 
after the samples have been analyzed, add Sequence Report 
Columns (see  Creating a Sequence Report Column). 

• To save the sequence under a new name, select Save As on the File 
menu. To save the sequence under the existing name, select Save. 

• Check the sequence properties by pressing <ALT> + <ENTER>. Or 
else, select the sequence, and then select Properties on the context 
menu. 

 

Automatically creating a sample list 
• Use one of the following methods to open the Sequence Wizard: 

 In the Browser, select New on the File menu. Select Sequence (using 
Wizard) from the list and click OK.  

 In a panel tabset, click the Sequence Control tab. Under Create 
Application, click Create Sequence. 

• Follow the instructions to create a basic sequence structure.  

• Press the F1 key for more help.  

For more information about the appearance of the sample list, refer to 
 Displaying Sequence Columns. For information about the wizard, 

refer to Samples and Sequences  The Sequence Wizard. 
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 Using Globally Unique Sample Identifiers 
Chromeleon supports the generation of unique 128-bit character strings, 
allowing you to clearly identify each sample. For new datasources, 
Chromeleon always generates a globally unique identifier ( GUID). To use 
globally unique sample identifiers for existing datasources, follow the steps 
below: 
• Select the datasource for which you want to enable unique sample 

identification. 

• Select Properties on the context menu.  

• On the General tab page, select the Use Globally Unique Sample 
IDs check box. 

 Note: 
You can select the check box only if you have the CustomizeDS 
CmUser Privilege. 

 

 Tip: 
It is not possible to disable this feature once you have enabled it. 
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• Chromeleon generates a GUID number for each sample in the 
datasource when the analysis is started: 

 

The column is hidden by default. To add the column to the sample list, 
select Display Column on the context menu. The related dialog box is 
opened. Select GUID on the Hidden columns list and click Add (or Add to 
End) to add the column to the Visible columns list.  

 Tips: 
GUIDs are not generated during manual sample acquisition. 

When you rerun a sample later, e.g., a sample with the status Multiple, 
Chromeleon generates a new GUID, overwriting the previous one. 

 
 Creating User-defined Columns 

New columns can be created either in the sample list of the Browser (see 
Data Management  The Browser) or in the peak table of the QNT 
Editor: 
1. a) In the sample list of the Browser: Click the datasource for the 

sequence for which you want to create a new column. Select 
Properties on the context menu, and then click the User-defined 
Columns tab page. 

b) In the peak table of the QNT Editor: On the context menu or Edit 
menu, select Columns, and then select Display User-defined 
Columns. 
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2. Select <New user-defined column> from the Columns list to enable 
the Properties section. 

3. Type a caption for the new column in the Name input field. 

 Note:  
When you enter the name, keep the following restrictions in mind: 

• Use only characters, numbers, and the underscore. The first 
character must be a letter. 

• Do not use the German "Umlaute" or "ß." 

• Names starting with SEQ_ or SMP_ are not permitted. 

• If the desired name is also an SQL keyword, Dionex recommends 
preceding it with an abbreviation of your company name (or some 
other agreed-upon text). For example, if the new caption is 
INTEGER, you might enter it as DX_INTEGER, where DX stands 
for Dionex. This will prevent collisions with SQL keywords and 
help you instantly recognize user-defined columns. 

• Several protected names, such as, Retention, Wavelength, Flow, 
etc., cannot be used as names for user-defined columns unless a 
prefix or suffix is added. Since it would be very time-consuming to 
check long lists of protected names before assigning a name, it is 
recommended in this case, also, that you use a company 
abbreviation as a prefix. For example, instead of "Flow," assign 
the name 'DX_Flow' to a user-defined column. 

• Names of columns that have been deleted in the current ‘dialog 
session’ cannot be entered again. You must close and then re-
open the dialog box before re-entering these names. 

4. Specify the Value Type for the new column by selecting the 
corresponding option from the drop-down list: 

• Integer (whole numbers) 
• Floating point (numbers with a defined number of decimal places) 
• Date  
• Time  
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• Date and Time  
• Enumeration (open the combo box to select an item from the list) 
• String (any sequence of characters. Please note: Spaces at the 

end of the string are deleted.) 

5. Type the Dimension for the values in the new column in the 
corresponding input field. 

6. More specification fields may be displayed, depending on the selected 
value type.  

 Note:  
The operating system restricts date input to the period of 1/2/1970 - 
12/30/2037.  

7. a) When creating a user-defined column in the sample list of the 
Browser, click Append Column to add the new column to the 
Columns list. Click OK to append the new column to the sample list.  
b) When creating a user-defined column in the peak table of the QNT 
Editor, click Append Column to append the new column to the peak 
table.  

Any new column created in the sample list of the Browser applies to the 
entire Datasource; i.e., it becomes part of all Sequences in the 
datasource.  
 

 Tips: 
Be careful when creating user-defined columns in the sample list of the 
Browser. Be sure not to assign the same column name twice in different 
datasources or on different computers that may communicate with each 
other. Otherwise, unless the column definitions are identical, problems may 
occur when you copy sequences or when you  Restore backup files.  

When you have entered or changed user-defined columns in the sample 
list, shut down and restart the Server to use the new and/or changed 
columns in the PGM File.  

There are some restrictions on the deletion of user-defined columns. 
Chromeleon cannot delete user-defined columns unless they are empty. In 
addition, Chromeleon cannot delete user-defined columns in some 
database configurations, e.g., this is not allowed in Oracle, version 8.0, or 
MS SQL Server, version 6.5. In this case, use the Oracle or MS SQL 
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Server database tools to delete the column. For the corresponding 
database columns, refer to the SAMPLES database table. The column 
header corresponds to the name of the user-defined column in Chromeleon 
(without the preceding asterisk). Please note: Deleting a user-defined 
column in Oracle or MS SQL invalidates Electronic Signature for all 
sequences containing this column.  

 Note: 

In a typical HPLC or IC configuration, it is possible to process at least 16 
user-defined sample list columns in the program. 

For two examples of how to use user-defined columns, refer to How to …: 
Creating and Using Report Tables  Calculating the Concentration 
Percentage (in Relation to the Total Concentration). 
New columns are added on the right-hand side of the table. However, you 
can also change the order of the columns afterward. For more information, 
refer to  Displaying Sequence Columns. 
 
If you still cannot display all the values you need, see  Creating a 
Sequence Report Column. 

 
 Creating a Sequence Report Column 

It often makes sense to have some sample results displayed in the sample 
list of a sequence. To do so, add sequence report columns to the sample 
list, in addition to the default columns and the User-defined Columns. 
Thus, the sequence report columns can provide an overview of the most 
important results of the single samples, already in the Browser. 

 Note: 
You need the CustomizeColLayoutSEQ privilege to add sequence report 
columns while the User Mode is enabled. 

To add a sequence report column: 
• Click the sequence, and then select Properties on the context or File 

menu. The Properties dialog box appears. 

• On the Report Columns tab page, the Report Columns list contains 
all existing sequence report columns: 
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• Click New to open the Create Sequence Report Columns dialog box. 

 Tip:  
You can also open this dialog box from the sample list. Select either 
Report Columns on the context menu or Sequence Report Columns on 
the View menu, and then select New Report Column.  
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• First, select a report variable. All report variables of the different 
⇒Report Categories are available for selection. Click the '...' button, 
and select a variable from the Categories and Variables lists. 

• Change the column name (Identifier) and the column header. (It is 
usually not necessary to change the unit (Dimension)). 

• Having selected a peak-specific variable, define the peak to which it 
refers. Select a Peak option. 

• In the same way, if you have selected a channel-specific variable, 
define the channel under Channel. 

• In addition, you can display the statistical values for the corresponding 
column. Select an option: Sum, Average Value, or Relative Standard 
Deviation. 

In this way, you can create different sequence report columns and thus, 
display all required values in the sample list: 
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New columns are added on the right-hand side of the sample list. However, 
you can change the order of the columns afterward or hide any columns 
that are currently not required. For more information, refer to 

 Displaying Sequence Columns.  

Editing Sequence Report Columns 
To edit report columns afterward:  
• Select the column by clicking the column header. 

• Select Report Columns on the context menu or select Sequence 
Report Columns on the View menu. Then, select Modify Report 
Column.  

• The Modify Sequence Report Columns dialog box appears. The 
dialog box corresponds to the Create Sequence Report Columns 
(see above). Make your settings as required.  

 Tip: 
You can also open this dialog box from the sample list by double-clicking 
the column header of the selected column.  

 Note: 
Or else, you can also select the sequence, and then select Properties on 
the context menu. Click Modify on the Report Columns tab page or 
double-click the desired entry on the list to open the Modify Sequence 
Report Columns dialog box.  
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Deleting a Sequence Report Column 
To delete a sequence report column: 
• Select the sequence by clicking the column header. 

• Select Report Columns on the context menu or select Sequence 
Report Columns on the View menu, and then select Delete Report 
Column. 

 Tip: 
You can also select the entire column by clicking the column header and 
then pressing <Del>.  

 Note: 
Or else, you can select the sequence and then select Properties on the 
context menu. On the Report Columns tab, select the column from the 
Report Columns list, and then click Delete. Alternatively, select an entry 
and press <Del>.  

Undoing Changes 
There are different ways to undo changes made for a sequence report 
column: 
• On the sample list: Press <CTRL> + <Z> or select Undo on the Edit 

menu. 

• On the Report Columns tab page of the Properties of Sequence 
dialog box: Click Undo Changes. 

If the sequence report columns are not sufficient to display all the values 
you need, also see  Creating User-defined Columns.  
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 Displaying Sequence Columns 
Chromeleon provides different options for displaying the single columns in 
the sample list. Use these options to create the sample list according to 
your requirements. 

Displaying or Hiding Columns  
Often, it is often not necessary to display all columns in the sample list. 
Therefore, you can hide any columns that are currently not required: 
• In the sample list, select Display Columns on the context or View 

menu. In the Display Columns dialog box, select the columns you 
want to display and determine the order in which they shall appear: 

 

Under Visible Columns, all columns are listed that are visible in the 
sample list. All columns that are currently hidden are listed under Hidden 
Columns. 
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A '#' character in front of the column name, e.g., #Area_Pyrene indicates 
that the column is a report column. If the name of the report column, i.e., its 
identifier, is different from the column header, the column header appears 
in parenthesis and brackets after the column name, e.g., #nPeaks 
("#Peaks"). An asterisk (*) in front of the column name, e.g., *Temperature, 
indicates that this column is a User-defined Column. 

• Under Visible Columns, select the columns you want to hide. 

• Click <<Remove<< to remove these columns from the Visible 
Columns list. 

In the same way, you can later add them again to the sample list. Select 
them in the Hidden Columns list, and then click >>Add>> or >>Add to 
End>>. 

 Note: 
It is also possible to hide columns interactively. Left-click the right column 
separator. While clicking, push the column together completely. To display 
the column again, move the mouse pointer to the right of the column 
separator until the pointer changes it appearance. Left-click and drag the 
column separator to the right.  

Changing the Order 
You can also change the order in which the columns appear in the sample 
list: 
• Select the column(s) to want to move.  

• Move the column(s) to the desired position via the Move Up and Move 
Down buttons.  

 Note: 
It is also possible to change the order interactively. Left-click and draw the 
column to the desired position. 
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Displaying Columns by Default 
If the sample list includes many columns, not all of them can be displayed 
on the screen at the same time. Use the scroll bar to move to the left or 
right. However, you might want to see at least the most important columns 
by default.  

Under Frozen Columns, define the number of leftmost columns to be 
displayed even if the scroll bar is at the utmost right.  

Also, refer to:  
 Creating a Sample List (Sequence)  
 Creating User-Defined Columns 
 Creating a Sequence Report Column 

Handling Files and Datasources 
Handling files and datasources includes managing, copying, moving, and/or 
deleting chromatographic data and files (see  Moving and Copying 
Elements). 

Chromeleon provides several ways to handle, store, and save the data 
collected during operation: 

 Datasources on Removable Media 
 Opening Audit Trails 
 Creating Backup Files 
 Restoring Backup Files 
 Exporting Files  
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 Moving and Copying Elements 
Use Drag & Drop to move or copy various elements in the Browser; for 
example, directories, Sequences, samples, and individual files, such as 

PGM Files, QNT Methods, Audit Trails, etc. 
Drag & Drop via the left mouse button 
To move or copy an element, hold down the left mouse button and move 
the element to the target directory. To define the Drag & Drop behavior, 
select Preferences on the File menu, and then select a When dragging 
item between folders option: 
 
Ask For each Drag & Drop action within a datasource, you are prompted 

to click a button. Click Copy or click Move.   
Copy  For simple Drag & Drop actions, i.e., when you do not hold down any 

other key, the selected element is copied to the new position without 
being deleted at the original position.   

Move 
(As in the Windows 
Explorer) 

There are two different cases:  
Within a datasource: For simple Drag & Drop actions, the selected 
element is moved to the new position and deleted from the original 
position. 
To a different datasource: The selected element is copied to the 
target position, but is not deleted from the original location.  

Independent of the selected setting, you can force the desired behavior for 
each Drag & Drop action by pressing an additional key: 
 
<CTRL> Copies the element.   
<SHIFT> Moves the element.  

 Tips:   

If network failure occurs while a Move action is in progress, the elements 
either in the target directory or in the original directory will be incomplete. 
After rebooting your computer, check whether the elements were moved 
correctly. If they were not, complete the action as required. 

If you cancel a Move action, all data copied so far will be deleted. This may 
take some time.  

Sequences that are locked and signed can only be moved as a whole. 
Locked directories cannot be moved at all. 
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Drag & Drop via the right mouse button 
Hold down the right mouse button and move an element to the target 
directory. When you release the mouse button, the context menu is 
opened: 

 

Select an action (Copy, Move, or Cancel). 

Copy elements via Copy & Paste  
To copy the desired element, you can also select the Copy and Paste 
commands on the Edit or context menu or click the corresponding icons on 
the Standard toolbar. First, copy the element, and then paste it at the 
desired location. Or else, use the corresponding shortcuts: 

<CTRL> <C> = Copy  

<CTRL> <V> = Paste  

Move elements via Cut & Paste  
To move the selected element, you can also select the Cut and Paste 
commands on the Edit or context menu or click the corresponding icons on 
the Standard toolbar. First, cut the element and then paste it at the desired 
location. Or else, use the corresponding shortcuts: 

<CTRL> <X> = Cut  

<CTRL> <V> = Paste  

Behavior if a file already exists in the target directory  
If you move a file to a target directory in which a file with the same name 
already exists, a dialog appears. You are prompted to confirm overwriting 
the existing file. Click either Yes or Yes to all to confirm the action. Click 
No or No to all to cancel the move.  

 Tips:   

If the Move action is later cancelled by the user or terminated due to an 
unforeseeable error, all data overwritten so far will be lost. 
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To overwrite a file, you need the corresponding Delete Privilege. For 
example, to overwrite a sequence, you need the DeleteSEQ privilege. The 
administrator can assign you this privilege in the User Manager (CmUser 
program). A Delete privilege is not required if you move a file (the file is no 
longer available at the original location after the move, i.e., it is "deleted" 
there). 

 Datasources on Removable Media 
Datasources can be installed not only on the hard disk of the local PC or 

a network PC, but also on removable media, such as a disk drive, USB 
stick, or CD-ROM. 

• Select Mount Datasource on the File menu. Chromeleon 
automatically displays the Windows drive letters of all removable media 
that are currently available.  

• Select a drive. Or else, select Browse to navigate to the desired 
datasource. 

• If Chromeleon finds an existing datasource on the selected media, the 
system automatically connects to this datasource, displaying it in the 
Browser in the same way as any other datasource. 

• If Chromeleon does not find a datasource on the selected media, the 
user can install a new one on this drive. The datasource will receive the 
name of the drive. 

 Note: 
You can easily copy datasources in Microsoft Access database format to a 
removable medium. Copy the DATA directory of the local datasource or the 
desired subdirectory of a network datasource to the corresponding 
removable medium. 

 Caution: 
If you connected to a datasource on a removable medium via the Mount 
Datasource command, do not remove the medium until you have closed 
the connection. To do so, select the Dismount Datasource on the context 
menu. If you do not close the connection correctly, data may be lost. 
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 Tip: 
When storing access datasources on CD, DVD, or other read-only media, 
make sure that no Chromeleon server, Chromeleon client, or Online 
Transfer Agent (OTA) is connected to the datasource. In addition, remove 
any existing CM_local.ldb-File from the root directory of the datasource.  

 
 Opening Audit Trails  

In the Browser, you can open two types of event logs (see Data 
Management  The Audit Trail): 

 Daily Audit Trails  

 Sample Audit Trails 

In the Standard Datasource, the daily audit trails are listed in the AUDIT 
directory for the corresponding Timebase. Double-click to open a daily 
audit trail.  

To display a sample audit trail, select the related sample. Select Open on 
the context menu, and then select Audit Trail. You can also display sample 
audit trails in the Report. Double-click to open the related sample and click 
the Audit Trail tab page.  

 Creating Backup Files 
The Chromeleon Backup program allows you to create backup files, 
including all linked objects, for data storage and exchange.  

In the Browser, select the objects to be archived, and then select 
Export/Backup on the File menu.  

You can back up the following objects: 
 
Select a To backup 
Directory All subdirectories, including all files, sequences, etc. 
Sequence All samples and files included in the sequence (QNT File and 

Program File (PGM File)). 
Sample The sequence information (name, directory, title, etc.) and 

selected samples, as well as the PGM File and QNT File for 
these samples. 

Other files The related files.  
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To save samples found in a Query, select one of the following options:  
 
Select a To save 
Sample 
(on the sample list in the 
Browser) 

The sequence information (name, directory, title, etc.) and 
selected samples, as well as the PGM and QNT Files for these 
samples. 

Sequence  
(on the sequence list in 
the Browser) 

All samples of the selected sequence that are contained in the 
query. 

Query 
(in the Browser) 

All samples contained in the query. 

 

 Caution: 
When performing a backup for a query, back up the entire sequence and 
not only the samples found during the query if you want to delete the 
original data after the backup. Before deleting the original data, verify that 
the backup file contains all samples. 
 
The following objects that are linked to the associated files are also copied 
for the backup: 
 
Object Linked Object 
Sequence Preferred Report Definition file (RDF) 
Peak table Calibration list for calibration mode = Fixed (General page of the 

QNT Editor) 
Blank run sample for Blank Run Subtraction = Subtract a fixed 
sample (General page of the QNT Editor) 
and/or  
If selected, spectra library for spectra library screening (Spectra 
Library Screening page of the QNT Editor) 

Query Preferred report definition file (RDF) 
Samples QNT File 

PGM File  
If a linked object is included in the selected objects list, it is treated as a 
normal object. 
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Select Backup to open the Backup dialog box: 

 

For a description of the individual fields, refer to the online Help for the 
Backup dialog box. 

Before starting the backup, Chromeleon determines the amount of storage 
space required. For hard disks and network drivers, Chromeleon checks 
whether sufficient storage capacity is available. If there is not enough 
space, an error message appears and you can cancel the backup 
procedure. 

If you use removable media, Chromeleon displays the expected number of 
media. If you use data compression, the number of actually required media 
may differ from the displayed number. 
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You can monitor the procedure on the screen via a status bar that indicates 
the percentage of stored data already copied to the medium: 

 
If the destination is a removable medium, you will be prompted when to 
change the medium. 

To perform a backup, you must have the Backup privilege (see 
Privileges (User Rights)). The backup is logged in the file history. To stop 

the backup, click Cancel. The backup contains all objects stored up to this 
point. 

You can delete the original objects after the backup has been performed. A 
dialog box appears and prompts you to confirm this action. If History Mode 
is enabled, a dialog box appears in which you can enter a comment for the 
history. 

Backup files have the extension .cmb. For information about how to restore 
backup files, refer to How to …: Creating and Managing Files and Data 

 Restoring Backup Files. 
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 Restoring Backup Files 
To restore backup files created via the Backup command, select 
Import/Restore on the File menu in the Browser, and then select 

Restore (also, refer to How to …: Creating and Managing Files and 
Data  Creating Backup Files). 

 Tip: 
As an alternative, you can select the backup file by double-clicking the file 
name in the Windows Explorer. Backup files are identified by their 
extension (*.cmb). 

After having selected Import/Restore > Restore on the File menu, select 
the backup file you want to restore in the Windows Open dialog box. 
Chromeleon recognizes whether the file is stored on a removable medium, 
a hard disk, or a network drive. 

If the backup file is stored on removable media, you have to insert the first 
medium first because it includes the list of contents. Else, an error message 
appears Chromeleon displays the contents in the following dialog box: 
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For a description of the individual fields, refer to the online Help for the 
Restore dialog box. 

The Channels and Linked Objects that are shared by all samples are 
listed in separate groups. The linked objects appear under the 
corresponding objects. 

Select the channels and links to be restored from these groups. The default 
setting is that all channels are restored, but not the links. 

The selected objects are restored, together with the raw data files of the 
selected channels, the audit trail files, and the history files. A dialog box 
similar to the Backup dialog box appears. If the backup is located on 
several removable media, you will be prompted when to insert the next 
medium. 

If the directory for an object to be restored is missing, Chromeleon creates 
the directory. Links are always restored to the original location. Note that 
the related sequence and datasource must exist. However, missing 
directories will be created if necessary.  

If the destination object already exists, you are prompted whether to 
overwrite it. Select one of the following options: Yes, Yes to all, No, No to 
all, and Cancel. For each restored object, the corresponding entry is 
logged in the history. 

To restore an object, you must have the Restore privilege (see Privileges 
(User Rights) ). To overwrite an existing object, you must have both the 
Restore and Copy privileges for the object. To stop restoration, click 
Cancel. 

 Tip: 
If you have created a backup file that contains a new feature, keep in mind 
that you cannot read this file with a Chromeleon version that does not 
support this feature. For example, this refers to: 

• Sequence Report Columns (available since Chromeleon 6.50) 
• ⇒Std. Add. Group and ⇒Ref. Amount Set sample columns (available 

since Chromeleon 6.60) 
• The Trend Plot (available since Chromeleon 6.50) 
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 Exporting and Transferring Data 
Chromeleon provides various options for exporting data (see Data 
Management  Data Export): 
1. Data can be exported during or after a Batch, using the Export Wizard 
of the Batch Report. 
2. Sequences can be transferred at a specified time, using the Online 
Transfer Agent (OTA). 

For more information, refer to  Exporting Data during or after a Batch 
and  Transferring Sequences Automatically. 

 Exporting Data during or after a Batch 
Select the sample(s) or sequence(s) to be exported: 
• Select Batch Report on the File menu to open the Batch Report 

dialog box. 

• To open the Export Wizard, select the Export check box in the Export 
options section. (If the check box is already selected, click Export 
Settings.) 
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• Click the "..." button in the Location field to specify where data is 
stored. 

• Use the Directory formula field to automatically create additional 
folders under the existing location folders in the Windows Explorer. To 
facilitate finding your files, Dionex recommends using the same 
structure as in the Browser. Use the default {seq.path}\{seq.name}.seq 
formula to create the same structure. 

If you do not know the syntax, click the {...} button to enter the formula. 
For the {seq.path}\{seq.name} formula, select Sequence from the 
Categories list, and then select Directory from the Variables list. Click 
OK to confirm your selection. Enter a backslash and return to the 
previous dialog box by clicking the {...} button again. Select Sequence 
from the Categories list and Name from the Variables list. Confirm 
your input by clicking OK.  

• Use the File name formula field to enter a formula for the file name. 
Individual files are usually created for the corresponding samples. 
Therefore, {smp.name}, i.e., the sample name, is an appropriate entry 
if every sample has a specific name. 

If you do not know the syntax, click the {...} button to enter the formula. 
For the {smp.name} formula, select Sample from the Categories list 
and Sample Name from the Variables list, and then click OK to 
confirm your selection.  

The default entry is {smp.number;04}. The number of the 
corresponding sample is used for the file name. 04 indicates a four-digit 
number; i.e., this entry creates file names such as 0001.txt or 0053.txt. 

• Under Export format(s), select an export format.  

• Click Next to go to the next wizard page. Select the export options. 
Please note: The selected export option determines which wizard 
pages appear. For example, for the ASCII format, if you want to export 
raw data with the report, select the channel(s) first and then select the 
sheets to be exported.  

 Tip: 
Before exporting a Summary page, verify (in the Printer Layout) that a 
peak was selected in the individual columns. If the setting is Selected 
Peak, no data will be exported because you did not select a peak in the 
Browser. Double-click the column to open the Properties Report 
Column dialog box. If necessary, select Fixed Peak(s) and specify the 
peak for which you want to export the data from the column. 
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• Click Finish to complete the Export Wizard, and then click OK to start 
exporting.  

For more information, refer to:  

 Exporting Data from Different Samples to a Single File 
 Transferring Sequences Automatically 

 Exporting Data from Different Samples to a Single File 
Use one page of the Printer Layout containing a peak summary table 
(which is usually the Summary page) to export data for a specified peak 
from different samples of a sequence to just one file. First, define the 
columns of interest: 

• Enable the Layout Mode on the Edit menu. 

• Double-click the header of the column of interest to open the Report 
Column Properties dialog box. Select a peak, and then select Save 
Report Definition… on the Workspace menu to save the Report 
Definition File (RDF). 

 Tip: 
If the setting in the dialog box is Selected Peak, it is not possible to 
export any data. Although data is always exported from the Browser, it 
is not possible to select the peak there. 

• Change to the Browser and follow the description in  Exporting 
Data during or after a Batch. Use the following settings: 

• In the File name formula field, enter {seq.name}, i.e., the formula, 
for the sequence name; this generates a single file for the 
sequence without a superior directory. 

• Select ASCII, Excel, or PDF as the export format. 

• Select Summary or the corresponding page of the peak summary 
table as the report page to be exported. 

• Click Finish to complete the Export Wizard, and then click OK to 
start exporting. 

For more information, refer to  Transferring Sequences Automatically. 
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 Transferring Sequences Automatically  
Sequences found with a Query can be transferred at specified times, 
using the Online Transfer Agent (OTA). 

 Tip:   

When the User Mode is enabled, you need administrator rights to be able 
to transfer sequences automatically. 

In the Browser, select Preferences on the File menu. The Preferences 
dialog box is opened. The Online Transfer Agent tab page shows a Log 
File displaying errors, warnings, and information, as well as a list of the 
tasks to be executed. 
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• Double-click the New Job entry at the bottom of the list to enter a new 
job. The Scheduler Job Type dialog box is opened. 

• Select Transfer sequences selected by a query to open the New 
Scheduler Job dialog box. The dialog box contains two tabs: 

• On the Time Plan tab page, define when, and how often, data will 
be transferred.  

• On the Transfer tab page, select the source and target of the 
transfer job to be executed by the OTA.  

 Tips:  
During batch transfer, sequences in the destination directory may be 
overwritten if they have the same name as the sequences to be transferred. 
However, it is not possible to overwrite locked data, signed data, or 
sequences containing raw data. (Example: If you appended samples to a 
sequence that was already transferred, you have to delete the existing 
sequence in the destination directory manually before you can transfer the 
extended sequence.) 

Sequences not containing raw data are overwritten; a warning does not 
appear before this operation nor are the Privileges (e.g., DeleteSEQ) 
checked.  

For more information, refer to: 

 Exporting Data during or after a Batch 
 Exporting Data from Different Samples to a Single File 

Signing Sequences Electronically 
Electronic signature is an important tool for securing data within the scope 
of quality assurance and GLP. (For general information about electronic 
signature, see Samples and Sequences  Electronic Signature.) In 
order to sign sequences electronically, the User Mode must be enabled 
and the logged-on user must have the corresponding signature 

Privileges; for example, SignResults. For more information, refer to 
Chromeleon User Management  Signature Privileges in the 
Administrator Help section. 
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 Tip: 

Electronic Signature is available only for user databases that were 
created with a User Manager (CmUser) program version 6.10 or higher. If 
an error message notifies you that electronic signature is not possible, 
update your database. 

You can sign a specific sequence only if you are authorized to do so. To 
check and/or edit authorization, open the Properties dialog box of the 
sequence from the context menu, and then click the Signature tab page: 

 

If you have been authorized in the CmUser database to modify the 
signature requirements (ModifySignRequirements privilege), click Edit to 
edit the list of users authorized for each signature level. 
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If these conditions are met, Sequences can be signed in three steps: 
• Submit  

• Review 

• Approve 

The sequence's signature status determines which options are available on 
the context menu: 
• Submit Results (for unsigned sequences) 

• Review Results (for submitted sequences) 

• Approve Results (for reviewed sequences) 

You can also access these options by selecting Electronic Signature on 
the File menu or by clicking the following icon on the standard Toolbar:  

 
The function of the button depends on the signature status.  

For more information, refer to:  

 Individual Steps of Electronic Signature 
 Checking the Signature Status and Undoing the Signature  
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 Individual Steps of Electronic Signature 
The first step of electronic signature is the Submit process. (For general 
information about electronic signature, see Samples and Sequences 

 Electronic Signature.) Click a Sequence that has not yet been 
signed, and then select Submit Results as described in  Signing 
Sequences Electronically. 

 

Select the Report Definition File (RDF) to be used for displaying the 
sequence, select the channel for which you want to show the results, and 
select the report sheets to be signed. 

 Tip: 
The settings saved in the Report Definition File are used as defaults for the 
worksheets to be signed and for the respective conditions. For more 
information, refer to How to …: Preparing the Printout  Specifying the 
Pages to be Printed.  

After you have selected the report definition file, the system writes the 
results to an SOR-File (Signed Off Results). You can monitor the 
procedure on the screen via a status bar that indicates the percentage of 
results already copied to the file.  
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Simultaneously, the pages of the report for the individual samples are 
frozen. Afterward, the Check Signed Results dialog box appears: 

 

This dialog box allows you to check the report to be signed. Use the arrow 
keys to toggle between different sequence samples. For each sample, the 
tab pages for the selected report sheets are displayed. Click OK when you 
have finished checking the report. The Submit Signature dialog box 
appears.  
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To sign the SOR file, enter your User ID and the signature password: 

 

In the Comment field, you can enter additional information, such as any 
critical or doubtful points you noticed while creating the report. 

When a sequence is open, the SOR file is displayed under the other 
sequence files in the top right Browser section. Double-click to open the 
SOR file: 

 

To review sequences that have been signed and submitted, select Review 
Results. You can monitor the process on the screen. The files and 
samples of the sequence that have already been reviewed are listed, as 
well as the result of the review. For the file or sample under review, the 
status bar indicates the percentage of completion:  



 Creating and Managing Files 237 

 

(Reviewing the results is much faster than submitting the signature. Thus, 
the above dialog box may be visible only for a few seconds, especially with 
short sequences.) To approve a sequence, proceed in the same way.  

 Checking the Signature Status and Undoing the 
Signature 
To check the signature status of a Sequence, select the sequence, and 
then select Properties on the context menu. The Properties dialog box is 
opened. Click the Signature tab page for information about the users 
authorized to sign, review, and/or approve the sequence. (For general 
information about electronic signature, refer to Samples and Sequences 

 Electronic Signature.) 



238 Creating and Managing Files 

 

To check the sequence signature, select Electronic Signature > Verify on 
the File menu or click the following icon on the standard Toolbar: 

 

 Tip:  

If you use the sample ⇒Types Spiked and/or Unspiked, please keep in 
mind that 

• An Electronic Signature created with Chromeleon 6.50 or earlier is 
invalid in Chromeleon 6.60 or higher. 

• An electronic signature created with Chromeleon 6.60 or later is invalid 
in Chromeleon 6.50 or earlier. 
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Manipulations attempted on the signed sequence or errors in the signature 
are identified during verification. To check the reports once again in such a 
case, you have to remove the signature first. To remove the signature you 
must have the UndoSignResults  Privilege. If you have this privilege, you 
can select Electronic Signature > Undo Signature on the File menu or 
click the following icon: 

 

The corresponding SOR-File (Signed Off Results) is deleted as well.  

Performing a Query 
The term Query refers to the search for data based on specific search 
criteria. In Chromeleon, you can search for samples and the corresponding 
sequences based on freely selectable parameters. Either you can use very 
detailed criteria to search for one specific sample, or you can use criteria 
that are more general to search for a specific series of samples with the 
same properties. 

 Caution: 
Make sure that you back up the entire sequence and not only the samples 
found during the query if you want to delete the original data after the 
backup. Before deleting the original data, verify that the backup file 
contains all samples. 

How To 
• In the Browser, select Query on the context menu. Or else, select 

New > Query (using the Wizard) on the File menu. Either way, a 
Wizard guides in entering the required conditions. 

• On the first wizard page, determine the Datasource in which the 
query is performed. Also, determine whether the query is performed for 

Sequence properties (Sequences) and/or sample properties 
(Samples), and/or other conditions (Results).  

• Clicking Next> takes you to the next wizard page(s). The pages that 
are opened depend on the properties selected on the first wizard page. 
Determine the desired search criteria. 
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Click Finish to open the New Query Properties dialog box, which provides 
four tab pages: 
• Use the General tab page to select the datasource in which the query 

is performed.  

• Use the Native SQL tab page to edit the SQL statements directly in the 
SQL syntax of the corresponding ODBC driver (contains translated 

Chromeleon statements). 

• Use the SQL tab page to edit the search statement in an entry dialog 
box. 

• Use the Result Restrictions tab page to limit the resulting sample list 
by more result queries.  

For more information, refer to: 

 Entering the Sample Query Using the Wizard 
 Selecting Search Criteria for Samples and/or Sequences 
 Examples (Wizard) 
 Specifying the Sample Query Using the Dialog Box 
 Examples (Dialog Box) 
 Editing a Query in SQL Syntax 
 Saving and Performing a Query 

 Entering the Sample Query Using the Wizard 
On the first wizard page, determine the Datasource in which the Query 
is performed. Select either Selected datasource (the name of the currently 
selected datasource is indicated in brackets) or Fixed datasource, and 
then select a datasource from the drop-down list. 

In addition, determine the Field Type for which the query is performed. 
Select: 
• Sequences and/or 

• Samples and/or 

• Results (variables from the different ⇒Report Categories) 
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On the Samples and/or Sequences wizard page, click the Data Field input 
field and select the variable for which you want to perform the query from 
list. On the Results wizard page, either enter the desired formula manually 
or click the "…" button, and then select a formula from the Edit Result 
Formula dialog box.  

 Tip: 
On the Results wizard page, you cannot access User-defined Columns 
directly by clicking the '...' button. For user-defined columns from the 
sample list of the Browser, select the Samples field type, and then select 
an entry from the Data Field field on the Samples wizard page. For user-
defined columns from the peak table of the QNT Editor, select the Results 
field type, and then enter the formula directly in the Formula field on the 
Results wizard page. The syntax of the formula is as follows: 

peak_tab.user_x 

where x is the name of the user-defined column.  

You can also search for samples with specified Audit Trail properties. In 
this case, enter the formula for the desired Audit Trail variable. For 
example, to search samples that were recorded at a ⇒LampIntensity > 
500.000 counts/s, use the formula below: 

AUDIT.LampIntensity(0.0,"forward")>500000. 
 
Select an operator from the Operator field and enter the desired value in 
the Value field. For information about the operators, refer to  Selecting 
Search Criteria for Samples and/or Sequences.  

To connect one search criterion with another search criterion, select a logic 
connective from the rightmost combo box. The next entry line is enabled 
only after you selected either AND or OR. 

Click Finish to complete the entries. The New Query Properties dialog 
box is opened. Use this dialog box to specify your query further (see 

 Specifying the Sample Query Using the Dialog Box). 

For examples of how to enter the query using the wizard, refer to 
 Examples (Wizard). 
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 Selecting Search Criteria for Samples and/or Sequences 
A Query allows you to search for samples and sequences, using a variety 
of sample or sequence properties. Enter the search criteria (see table) on 
the Query Wizard: Sequences and/or Samples pages. To further restrict 
the query, select the SQL tab page of the New Query Properties dialog 
box. This dialog box is opened automatically after you have clicked Finish. 
(You can also use this dialog box to edit an existing query. To reopen the 
dialog box (then called Properties of Query "xyz"), select the query in the 
Browser, and then select Properties on the context menu.) Click 
Edit/Insert to open the Edit Conditions dialog box. Select the criteria from 
the Field list box.  
 
Name Search Parameter 
Sample Name ⇒Name 
Sample Number ⇒No. 
Sample Type ⇒Type 
Sample Status ⇒Status 
Sample Comment ⇒Comment 
Sample Replicate ID  ⇒Replicate ID 
Sample Inject Volume  ⇒Inj. Vol. 
Sample Inject Time ⇒Inj. Date/Time 
Sample Dilution Factor ⇒Dil. Factor 
Sample Weight ⇒Weight (Sample Weight Factor) 
Sample Amount ⇒ISTD Amount 
Sample Raw Data ID Chromeleon sample ID. 
Sample ID Sample ID assigned by the user 
Sample Program Name ⇒Program used for sample processing  
Sample Quantification Method ⇒Method used for sample evaluation  
Sample Standard Addition Group  Standard Addition group for assigning 

Spiked Samples to unspiked unknown 
samples (see ⇒Std. Add. Group) 

Sample Reference Amount Set  Reference amount ID for assigning 
standards, Validiation Samples and/or 
spiked samples (see ⇒Ref. Amount Set) 

Sample Auto Purification Type  Autopurification type (also, see ⇒Auto 
Purif. Type) 

Sample Auto Purification Reference Autopurification ID assigned by Chromeleon 
(see ⇒Auto Purif. Ref) 
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Sample Auto Purification Fraction Fraction ID assigned by Chromeleon (see 
⇒Auto Purif. Frac) 

Sample Tray   
*Sample x User-defined Column (column name) 
Sequence Name  
Sequence Title Sequence 
Sequence Preferred Channel  
Sequence Preferred Report  
Sequence Directory  
Sequence Timebase Timebase  
Sequence Creation Date  
Sequence Creation Operator  
Sequence Last Update  
Sequence Last Update Operator  
Sequence Sign Status  
Sequence Authorized Submit Users Users authorized to submit the signed 

sequence 
Sequence Submit User User who submitted the signed sequence 
Sequence Submit Date Date when the signed sequence was 

submitted. 
Sequence Authorized Review Users Users authorized to review the signed 

sequence. 
Sequence Review User User who reviewed the signed sequence. 
Sequence Review Date Date when the signed sequence was 

reviewed. 
Sequence Authorized Approved Users Users authorized to approve the signed 

sequence. 
Sequence Approve User User who approved the signed sequence 
Sequence Approve Date Date when the signed sequence was 

approved  
There are four different groups of search criteria: 

1. Text variables, such as, Sample or Sequence Name, Sample ID, etc. 

2. Numerical variables, such as, Sample Number, etc. 

3. Variables with specific values, such as, Sample Type or Sample Status, 
etc. 

4. Time variables, such as, Sample Inject Time, Sequence Creation 
Date, etc. 
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These search parameters must be further specified. Different operators are 
available to link the search criterion with a comparative value. The search 
criterion determines which operators are available: 
 
Operator 
 

Searches all samples... 
 

Available for 
group no. 

= whose property is identical to the specified character 
string. 

1, 2, 3, 4 

< > whose property is not identical to the specified 
character string. 

1, 2, 3, 4  

> whose property is larger than the specified character 
string. 

1, 2, 4  

< whose property is smaller than the specified character 
string. 

1, 2, 4 

>= whose property is larger than or equal to the specified 
character string. 

1, 2, 4 

<= whose property is smaller than or equal to the 
specified character string. 

1, 2, 4  

contains whose property contains the specified character 
string.  

1 

contains not whose property does not contain the specified 
character string.  

1 

starts with whose property starts with the specified character 
string.  

1 

does not start with whose property does not start with the specified 
character string. 

1 

ends with whose property ends with the specified character 
string. 

1 

does not end with whose property does not end with the specified 
character string. 

1 

is like whose property fulfills the specified wildcard 
condition. 

1 

is not like whose property does not fulfill the specified wildcard 
condition. 

1 

is between whose property is between two values. 1, 2, 4 
is not between whose property is not between two values. 1, 2, 4 
during the previous whose property was created during a specified time 

before the query. 
4 

is null in which the variable does not exist. 1, 2, 3, 4 
is not null in which the variable exists. 1, 2, 3, 4  

If the operators >, <, >=, or <= are used for text variables, the alphabetical 
order is considered; for example: A<B. 
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 Note: 
All SQL-time queries containing a relative reference (= during the 
previous operator) are recalculated for each query. 

Wildcards represent character strings. The following wildcards can be used 
for text variables when the operator is either "is like" or "is (not) like": 
 
Wildcard Description 
% Represents any character string with 0 or more characters. 
_(underscore) Represents any single character.  
[ ] Represents a single character in a specified range; for example, [a-f]. 
[^] Represents any character except the specified range.  

When you have completed your entries, click Apply to start the query.  

To restrict the query further, you can enter the desired restrictions on the 
Result Restrictions page of the Query Wizard. Else, you can select the 
Result Restrictions tab page of the New Query Properties (or 
Properties of Query "xyz") dialog box. Click Edit/Insert to open the Edit 
Conditions dialog box. Click the "…" button to open the Edit Result 
Formula dialog box and select a report variable (see ⇒Report Categories). 
The available logical operations depend on the selected sample and 
sequence properties. 

 Note: 
Depending on the number of samples resulting from the SQL query, a 
result-type query may take some time. After approximately 3 seconds, a 
window is opened indicating the status of the result-type query (in percent 
of the samples to be tested). The user can use this window to stop the 
query. In this case, the result of the query includes only those samples of 
the SQL query that have passed the result test until then. 

For examples of how to enter the query using the wizard, refer to 
 Examples (Wizard). 
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 Examples (Wizard) 
Use the following SQL query to search for all samples for which  
• The sample type is Matrix Blank and  

• The sample comment starts with Charge 123456 or 

• The sample inject time is between 6/12/2003 and 7/12/2003: 

. 

Use the following settings to restrict the Query to samples that contain  
• An Anthracene peak or  

• More than 10 calibration points: 

. 

For more examples, refer to  Examples (Dialog Box). 
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 Specifying the Sample Query Using the Dialog Box 
After you specified the Query in the Query Wizard and completed your 
entries by clicking Finish, the New Query Properties dialog box is 
opened. You can use this dialog box to specify the query further. You can 
also use this dialog box to edit an existing query later. In this case, the 
dialog box is named Properties of Query "xyz." To open the dialog box, 
select the query, and then select Properties on the context or File menu. 

The dialog box provides the four tab pages:  
• General tab page: Enter or edit the query title in the Title field. From 

the Datasource drop-down list, select the datasource for which the 
query is performed. If this field remains empty (default), the query is 
performed for the datasource in which the query is saved. The 
Preferred RDF File and Preferred Channel settings are used when a 
sample is opened or a batch report is started. 

• Native SQL tab page: This tab page is read-only by default, providing 
information about the SQL statement sent to the ODBC driver. (Please 
note that the SQL statement is translated into the SQL syntax of the 
corresponding ODBC driver.) To edit the SQL statement manually, 
select the Always use native SQL check box. 

 Caution: 
This edited SQL statement is used whenever the query is performed, 
as long as the Always use native SQL check box remains selected. 

• SQL tab page: Use this tab page to edit the SQL condition(s) that the 
samples must fulfill. To open the Edit Condition dialog box, click Edit 
> Insert. Or else, place the mouse pointer in the list field and double-
click the left mouse button or select Edit Condition on the context 
menu. Use this dialog box to add SQL conditions (select Restrict 
Condition (AND) or Expand Condition (OR)) or to change the 
existing condition (select Change Condition).  

• Result Restrictions tab page: Use this tab page to specify the query 
further. You can change, restrict, or expand the query. Open the Edit 
Condition dialog box by clicking Edit/Insert and select Change 
Condition, Restrict Condition (AND) or Expand Condition (OR). 

Enter a report variable in the Formula field. Click the '...' button to open 
the Edit Result Formula dialog box and select a formula. (For more 
information about the report variables and their categories, refer to 
⇒Report Categories).  
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Enter the desired operator. (For information about which SQL operators 
are supported, refer to How to …: Creating and Managing Files and 
Data  Selecting Search Criteria for Samples and/or Sequences.) 
Finally, type the desired reference value in the Value field.  

 Tip: 
It is not possible to access User-defined Columns by clicking the '...' 
button. Enter the formula for the user-defined column directly in the 
Formula field:  

For user-defined columns from the sample list of the Browser, enter: 

smp.x 

where x is the name of the user-defined column. 

For user-defined columns from the peak table of the QNT Editor, enter:  

peak_tab.user_x 

where x is the name of the user-defined column.  

• After you have made the necessary entries, click Apply to start the 
search. 

For examples of how to enter the query using the dialog box, refer to 
 Examples (Dialog Box). 
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 Examples (Dialog Box) 
To search for all samples of the current day, set up the following SQL 
query in the Edit Condition dialog box of the SQL tab page. (For 
information about how to open this dialog box, refer to  Specifying the 
Sample Query Using the Dialog Box.) 
 

 
 
With these settings, the following SQL statement is displayed on the SQL 
tab page: 

Samples.smp_inject_time >= CURRENT_INTERVAL '0' DAY. 

To restrict the above search to the standard samples of the current day, 
reopen the Edit Condition dialog box and make the following settings: 
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The following SQL statements are listed on the SQL tab page:  

Samples.smp_inject_time >= CURRENT_INTERVAL '0' DAY 

AND Samples.smp_type = 'S' 
 
To search for all samples in a Sequence named S7709, for which the 
Benzene peak or a peak of the PAK (PAH) peak group was identified, use 
the following SQL query: 

Open the Edit Condition dialog box of the SQL tab page and enter the 
condition for the sequence name: 
 

 
 
Change to the Result Restrictions tab page and click Edit/Insert to open 
the Edit Condition dialog box. Enter the condition for the Benzene peak: 
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Return to the Edit Condition dialog box and enter the condition for the 
peak of the PAK (PAH) group: 
 

 
 
With these settings, the following SQL statements are displayed: 

On the SQL tab page:  

Sequences.seq_name = 'S7709' 

On the Result Restrictions tab page: 

peak.name = 'Benzene' 

OR peak.group = 'PAK'. 
 
For examples about how to enter the query using the wizard, refer to 

 Examples (Wizard). 

 
 Editing a Query in SQL Syntax 

On the Native SQL tab page, the query created by Chromeleon is 
displayed in SQL syntax. (For information about how to open these tab 
pages, refer to  Specifying the Sample Query Using the Dialog Box.) 

If you have a good knowledge of SQL, you can use the Native SQL tab 
page to specify your Query further. Select the Always use native SQL 
check box and modify the statement via the keyboard.  
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 Tip: 

If you have edited the SQL statement on the Native SQL tab page, this 
edited SQL statement is used whenever the query is performed, as long as 
the Always use native SQL check box remains selected. When you clear 
the check box, the current entries from the SQL and Result Restrictions 
tab pages are used, overwriting your SQL entries on the Native SQL tab 
page. 

 Saving and Performing a Query 
Queries can be saved as a file in the datasource, similar to Sequence.  

To create a query, select New on the File menu. In the New dialog box, 
select Query (using Wizard) from the list box to open the Query Wizard. 
After you have entered all conditions for the query, click Finish. The New 
Query Properties dialog box is opened. Click Save to save the conditions. 
The Save as dialog box is opened, indicating that the Object of type is 
Query. Enter the name under which the query is saved.  

In the Browser, the Query is indicated by the following symbol: . 

If you select a query with the mouse, Chromeleon behaves in the same 
way as for a sequence: If you select the query in the left Browser pane, 
the query is performed immediately and the results are displayed in the 
right Browser pane. If you select the query in the right Browser pane, click 
Return or double-click the file to perform the query and to display the 
results. 

To edit an existing query, select Properties on the File or context menu 
and edit the query as desired (see  Specifying the Sample Query 
Using the Dialog Box).  
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Answering Frequently Asked Questions on 
the Browser 
Question: What can I do when I can no longer copy data to the network 
datasource? 

Answer: The reason is probably a communication error. Verify that the 
network connection still available. In rare cases, there might be a problem 
with the datasource. In this case, first disconnect the datasource using the 
Disconnect command in Chromeleon, and then reconnect the datasource. 
The Administrator Help section provides more information; refer to How 
to …: Working with Files, Databases, and Networks: 

 Disconnecting a Datasource 
 Connecting a Datasource 

 
Question: I appended a sample to a running sequence. How can I make 
sure that the last sample is processed, too?  

Answer: After appending the sample save the sequence by selecting Save 
on the File menu. Only then, the sample is part of the sequence and can 
be processed. 
 
Question: Can I start a single sample from the Browser or the Control 
Panel? 

Answer: No, you cannot. You have to start a batch. However, the batch 
may contain only one sequence with only one sample.  
 
Question: Can I change the injection volume after the analysis is finished?  

Answer: Yes, you can change the injection volume.  But you must have the 
ModifyFinishedSample Privilege. (The system administrator assigns this 
privilege in the User Manager (CmUser program).)  

 Tip:   

Usually, you should not change the injection volume after the analysis. This 
would falsify the analysis result when an autosampler injected the 
sample(s). You should only change the injection volume after the analysis 
when you entered the wrong volume in case of manual injection of the 
sample. 
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Question: Where are programs (PGM Files), QNT Methods, and Report 
Definition Files (RDF) saved? Are they copied automatically to the 
sequence? 

Answer: These files are not saved at a default location. When creating the 
files you have to determine where they should be saved. Programs and 
QNT Methods must also be saved to the sequence in which you want to 
use them. When saving an old sequence under a new name, using the 
Save as… command on the File menu, all files saved in the old sequence 
are also saved in the new sequence. The Status of the single samples is 
set to Single, i.e., the raw data is not saved in the new sequence. 

 Notes:   
It may make sense to additionally save all programs to a Programs folder. 
Save the QNT Methods and RDF's in the same way.  

When saving a file to more than one location, make sure that the content of 
the file is identical, in both locations.  

Question: What happens with the files saved in a sequence when I copy 
the sequence using the Drag&Drop command? 

Answer: The Drag&Drop operation corresponds to the Save as… 
command on the File menu. All files are copied together with the sequence.  

Question: Is an Audit Trail recoded even if I lock the AUDIT directory? 

Answer: Select the directory, and then select Properties on the context 
menu. On the Access Control tab page, select the Locked check box. In 
this way, the Audit Trail is still saved and a new Audit Trail will be created 
the next day, too. However, it is no longer possible to change the files in 
this directory or to copy files into this directory. 

Question: How can I reduce the number of Workspaces displayed on the 
Workspace menu?  

Answer: This operation is quite complex. Contact your system administrator 
for assistance. (Close the Chromeleon client and edit the information in the 
registry, using the RegEdit program. The path for accessing the information 
is: HKEY_CURRENT_USER\Software\Dionex\Chromeleon\Recent 
Workspaces.) 

For tips to solve similar questions, also refer to How to …:  Creating 
and Managing Files and Data and the related subtopics. 
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Importing PeakNet (Releases 4.3 Through 
5.2) Method Files 

Overview 
In order to use Method files from PeakNet (releases 4.3 through 5.2) with 
Chromeleon, they must first be imported into Chromeleon.  

When imported, the PeakNet 5 Method file is converted into a Chromeleon 
PGM File and/or Quantification Method (QNT Method). Converted PGM 

Files contain timed events and setup parameters for all modules included in 
the original PeakNet 5 Method. Converted QNT Files contain component 
names, retention times, reference peaks, tolerance, calibration options, 
groups, and level amounts for each detector in the PeakNet 5 Method. 

PeakNet 5 Methods from the following modules can be imported: AS50, 
GP40/GP50, IP20/IP25, AD20, AD25, CD20/CD25, ED40/ED50, 
IC20/IC25, DX-120, and UI20. For Methods that were created with AI-450 
software, only the QNT portion of the Method is converted. 

Because of differences in the way that PeakNet 5 and Chromeleon 
function, some features available in a PeakNet 5 Method file are not 
imported into Chromeleon. These include: 
• Replicate calibration information 

• CE Method parameters 

• High/low limit values 

• Outlier rejection 

• Linear weighting options 

In addition, Chromeleon allows only a single component table per injection, 
whereas PeakNet 5 allows one table per detector. When the PeakNet 5 
Method contains multiple detectors, the first detector is converted entirely; 
that is, information about every component and unknown peak is added to 
the peak table. Then, for the other detector(s), only unique components 
and unique unknown groups not present in the first detector's data are 
added to the table. This means that any reference component information 
for detectors other than the first detector may be lost. 
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How To 
1. In the Browser, select a Datasource folder (not a sequence name). 

2. Select Import/Restore on the File menu and then select PeakNet 5 
and Method Files. 

3. In the Import PeakNet 5 Method Files dialog box, navigate to the folder 
that contains the PeakNet 5 Method file(s) to be imported. These files 
are named with the .MET extension.  

4. Select one or more of the Method files and click Add. The files appear 
in the Selected files list.  

5. To convert the PeakNet 5 Method into a PGM File for Chromeleon, 
select the Program box. The PGM File is created in the folder shown 
next to the Program box. The default is the datasource folder currently 
selected in the Browser. To choose a different location, click the 
Browse button and select a location. 

6. To convert the PeakNet 5 Method component table and calibration 
parameters into a Chromeleon QNT Method, select the QNT box. The 
QNT File is created in the folder shown next to the QNT box. The 
default is the datasource folder currently selected in the Browser. To 
choose a different location, click the Browse button and select a 
location. 

7. Select the Inverted Curve Fitting check box to use inverted calibration 
(concentration or amount is plotted against measured values). Clear the 
check box for "normal" curve fitting (measured values are plotted 
against concentration or amount). See How to …: Calibrating 

 Inverting Dependent and Independent Variables for details. 

8. Click Import. The selected PGM and/or QNT Files are created.  

 The new files have the same name as the PeakNet 5 Method file, but 
with PN5 appended and with PGM and QNT extensions. Once a 
Method file is converted, the file name is removed from the Selected 
files list.  

 Tip: 
If the QNT option is selected, but the PeakNet 5 Method does not contain a 
detector module, an empty QNT Method file is created. 

Also, refer to  Importing PeakNet (Releases 4.3 Through 5.2) Data 
Files. 
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Importing PeakNet (Releases 4.3 Through 
5.2) Data Files 

Overview 
In order to use data files from PeakNet (releases 4.3 through 5.2) with 
Chromeleon, the files must first be imported into Chromeleon. 

When the PeakNet 5 data file is imported, a Sequence for Chromeleon is 
created. The sequence includes the raw data from the data file, the 
embedded PeakNet 5 Method (converted to a Chromeleon PGM File and 

Quantification Method (QNT Method), and additional information required 
to complete the sequence. If multiple data files are selected for import, they 
are grouped into one sequence.  

If the PeakNet 5 data file contains multiple detectors, a separate sample 
line in the sequence is created for each detector (up to four). 

How To 
1. In the Browser, select a Datasource folder (not a sequence name). 

2. Select Import/Restore on the File menu and then select PeakNet 5 
and Data Files. 

3. In the Import PeakNet 5 Data Files dialog box, navigate to the folder that 
contains the PeakNet 5 data file(s) to be imported. These files are 
named with a .DXD or .Dxx extension (where xx is 01 - 99). 

4. Select one or more data files and click Add. The files appear in the 
Selected files list.  

5. The selected data files will be imported into the folder shown in the 
PeakNet Folder box. The default is the datasource folder currently 
selected in the Browser. To import the data file(s) into a different 
location, click the Browse button and select a location. 

6. In the Sequence Name box, enter a name for the sequence to be 
created from the imported data files. 

7. Select the Inverted Curve Fitting check box to use inverted calibration 
(concentration or amount is plotted against measured values). Clear the 
check box for "normal" curve fitting (measured values are plotted 
against concentration or amount). See How to …: Calibrating 

 Inverting Dependent and Independent Variables for details. 
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8. Click Import. The selected PeakNet 5 data files are imported into 
Chromeleon.  

The following files are created: 
• One sequence, which contains a sample line for each PeakNet 5 data 

file selected for import. If any of the data files contained data from 
multiple detectors, separate sample lines are created for each 
detector's data.  

• One PGM File and one QNT File for each sample in the sequence. The 
PGM and QNT Files are created from the PeakNet 5 Method 
embedded in the PeakNet 5 data file.  

The PGM and QNT Files are named as follows: the Method file name from 
the PeakNet 5 data file is used, followed by a three-digit identifier that 
corresponds to the detector's position in the sequence, and then a pgm or 
qnt extension.  

Example 
In the Import PeakNet 5 Data Files dialog box, three data files are selected 
for import. 

  

After importing, the following sequence is created. Notice that, because the 
Bioamine.d04 data file contained data from two detectors, two sample lines 
were created in the sequence: 
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The following PGM and QNT Files were also created. These correspond to 
the programs and methods listed in the sequence: 

  

Also, refer to  Importing PeakNet (Releases 4.3 Through 5.2) Method 
Files 

PeakNet (Releases 4.3 Through 5.2) 
Translation Tables 
See the following topics for an explanation of how PeakNet (releases 4.3 
through 5.2) setup and timed event Method parameters are translated to 
Chromeleon PGM File commands. 

 AS50 Autosampler 
 Pump Modules and Eluent Generator 
 AD20 Detector 
 AD25 Detector 
 CD20/CD25 Detectors 
 ED40/ED50 Detectors 
 IC20/IC25 Systems 
 DX-120 System 
 UI20 Module 

See  Detector Component Table Translation for how PeakNet 
(releases 4.3 through 5.2) component table parameters are translated to 
Chromeleon QNT Method parameters. 
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 AS50 Autosampler Setup and Timed Event Parameter 
Translation 
 

PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

TTL 1 (checked/unchecked) Sampler_TTL_1.State (=0v/5v)  Setup & timed 
portions 

TTL 2 (checked/unchecked) Sampler_TTL_2.State (=0v/5v)  Setup & timed 
portions 

Relay 1 (checked/unchecked) Sampler_Relay_1.State 
(=Closed/Open) 

Setup & timed 
portions 

Relay 2 (checked/unchecked) Sampler_Relay_2.State 
(=Closed/Open) 

Setup & timed 
portions 

CSV (A/B) ColumnValve.State(=Col_A/Col_B) Setup & timed 
portions 

Sample NeedleHeight NeedleHeight Setup portion 
ColumnTemperature ColumnTemperature Setup portion 
TrayTemperature TrayTemperature Setup portion 
Cycle Time Cycle Setup portion 
Valve (Load/Inject) Load/Inject 

If Inject, "Wait InjectState" command 
is added 

Setup & timed 
portions 

Pipet function 
(Source/Volume/Destination) 

Pipet (SourceVial/Volume/ 
DestinationVial) 

Setup portion 

Mix function  
(Vial/Volume/Cycles) 

Mix 
(SourceVial/Volume/NumberOfTime
s) 

Setup portion 

Flush function (Volume) FlushSP (Volume) Setup portion 
Delay function (Delay Time) DelaySP (Time) Setup portion 
Needle function (Height) SetNeedleHeight (Height) Setup portion 
Dilute function  
(Concentrate Source/ 
Concentrate Volume/  
Diluent Source/  
Diluent Volume/ 
Destination) 

Dilute  
(SourceVial/ 
ConcentrateVolume 
SourceReservoir/ DiluentVolume/ 
DestinationVial)  

Setup portion 

Dispense function  
(Source/Volume/Destination) 

Dispense (SourceReservoir/Volume/ 
DestinationVial) 

Setup portion 

Wait function Wait (SamplePrep) Setup portion 
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PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Wait for stable temperature 
(checked/unchecked) 

WaitForTemperature (=True/False) Setup portion 

 In any case 2 commands are added: 
1."Flush   Volume=100" 
2."Wait    FlushState" 

Setup portion 

 Syringe Speed always set to default 
value = 3 

Setup portion 

 CutSegmentVolume always set to 
default value = 0 

Setup portion 

Output Labels Not converted  
Comments Comments  
Description Comments   

  
 Pump and Eluent Generator Setup and Timed Event 

Parameter Translation 
Pump Modules Translation Table 

PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Oven Temperature Temperature Setup portion 
High Pressure Limit Pressure.UpperLimit Setup portion 
Low Pressure Limit Pressure.LowerLimit Setup portion 
Eluent Label (A/B/C/D) (%A/%B/%C/%D).Equate Setup portion 
Eluent percentage (B/C/D) %B/%C/%D Timed portion 
Inject  
(checked/unchecked) 

InjectValve.State 
(=InjectPosition/LoadPosition) 

Setup & timed portions 

Column 
(checked/unchecked) 

ColumnValve.State 
(=Col_B/Col_A) 

Setup & timed portions 

TTL 1 (checked/unchecked) Pump_TTL_1.State (=0v/5v)  Setup & timed portions 
TTL 2 (checked/unchecked) Pump_TTL_2.State (=0v/5v)  Setup & timed portions 
Relay 1 
(checked/unchecked) 

Pump_Relay_1.State 
(=Closed/Open) 

Setup & timed portions 

Relay 2 
(checked/unchecked) 

Pump_Relay_2.State 
(=Closed/Open) 

Setup & timed portions 

Flow Flow Setup & timed portions 
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PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Eluent percentage (%A) Not converted Calculated from %B, 
%C, and %D 

Pump (On/Off) Not converted  
Curve Curve  
Comment Comments  
Piston Size Not converted Set in Server 

Configuration instead 
Pressure Units Not converted Set in Server 

Configuration instead 
Description Comments  

 

Eluent Generator Translation Table 
PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Eluent Concentration Concentration Timed portion 
TTL 1 (checked/unchecked) EluentGenerator_TTL_1.State 

(=0v/5v) 
Timed portion 

Offset Volume Not converted Set in Server 
Configuration instead 

Curve Curve  
Eluent Label Not converted  
TTL 1 Output Not converted   

  
 AD20 Setup and Timed Event Parameter Translation 

 
PeakNet (Release 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Rate Data_Collection_Rate Setup portion 
Time UV_VIS_1.AcqOff  

(at time=time of AcqOn + Time) 
Timed portion 

TTL 1 (checked/unchecked) UV_TTL_1.State (=0v/5v) Setup & timed portions 
TTL 2 (checked/unchecked) UV_TTL_2.State (=0v/5v) Setup & timed portions 
Relay 1 
(checked/unchecked) 

UV_Relay_1.State 
(=Closed/Open) 

Setup & timed portions 
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PeakNet (Release 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Relay 2 
(checked/unchecked) 

UV_Relay_2.State 
(=Closed/Open) 

Setup & timed portions 

Offset (checked) Autozero Setup & timed portions 
Mark (checked) UV_Analog_out.Mark Setup & timed portions 
Range UV_Analog_out.Recorder_Range Setup & timed portions 
Wavelength Wavelength Setup & timed portions 
Collection Begin (checked) UV_VIS_1.AcqOn Setup or timed portion 
UV Lamp      (Off/Low/High) UV_Lamp      (=Off/Low/High) 

If =Low/High, command  
"Wait UV_Lamp_Ready" is added 

Setup portion 

Visible Lamp (Off/Low/High) Visible_Lamp (=Off/Low/High) Setup portion 
Plot Scales 
(Minimum/Maximum) 

Not converted  

Detector Units Not converted  
X-Y Data Not converted   

  
 AD25 Setup and Timed Event Parameter Translation 

 
PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Rate Data_Collection_Rate Setup portion 
Time UV_VIS_1.AcqOff  

(at time=time of AcqOn + Time) 
Timed portion 

TTL 1 (checked/unchecked) UV_TTL_1.State (=0v/5v) Setup & timed portions 
TTL 2 (checked/unchecked) UV_TTL_2.State (=0v/5v) Setup & timed portions 
Relay 1 
(checked/unchecked) 

UV_Relay_1.State 
(=Closed/Open) 

Setup & timed portions 

Relay 2 
(checked/unchecked) 

UV_Relay_2.State 
(=Closed/Open) 

Setup & timed portions 

Offset (checked) Autozero Setup & timed portions 
Mark (checked) UV_Analog_out.Mark Setup & timed portions 
Range UV_Analog_out.Recorder_Range Setup & timed portions 
Wavelength Wavelength Setup & timed portions 
Collection Begin (checked) UV_VIS_1.AcqOn Setup or timed portion 
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PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

UV Lamp      (On/Off) UV_Lamp      (=On/Off) 
If =On, command  
"Wait UV_Lamp_Ready" is added 

Setup portion 

Visible Lamp (On/Off) Visible_Lamp (=On/Off) Setup portion 
Offset Level UV_Analog_out.Offset_Level Setup portion 
Calibration 
(Off/Zero/Full Scale) 

Recorder_Calibration 
(AU/Zero/Full_Scale) 

Setup portion 

Polarity (Negative/Positive) UV_Analog_Out.Polarity 
(=Negative/Positive) 

Setup portion 

Rise Time Rise_Time Setup portion 
Comment Comments  
Description Comments  
Labels Not converted  
Plot Scales 
(Minimum/Maximum) 

Not converted  

Detector Units Not converted  
X-Y Data Not converted   

  
 CD20/CD25 Setup and Timed Event Parameter 

Translation 
 

PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Rate  Data_Collection_Rate Setup portion 
Time  AcqOff  

(at time=time of AcqOn + Time) 
Timed portion 

Range (µS) ECD_Analog_Out.Recorder_Rang
e 

Setup & timed portions 

TTL 1 (checked/unchecked) ECD_TTL_1.State (=0v/5v) Setup & timed portions 
TTL 2 (checked/unchecked) ECD_TTL_2.State (=0v/5v) Setup & timed portions 
Relay 1 
(checked/unchecked) 

ECD_Relay_1.State 
(=Closed/Open) 

Setup & timed portions 

Relay 2 
(checked/unchecked) 

ECD_Relay_2.State 
(=Closed/Open) 

Setup & timed portions 
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PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Offset (checked) Autozero Setup & timed portions 
Mark (checked) ECD_Analog_Out.Mark Setup & timed portions 
Temp. Comp. Temperature_Compensation Setup portion 
Cell Temp. DS3_Temperature Setup portion 
SRS Current 
(Off/50/100/300/500 mA) 

SRS_Current 
(=Off/50/100/300/500) 

Setup portion 

Collection Begin (checked) AcqOn Setup or timed portion 
Plot Scales 
(Minimum/Maximum) 

Not converted  

Detector Units Not converted  
X-Y Data Not converted   

  
 ED40/ED50 Setup and Timed Event Parameter 

Translation 
 

PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command of  
 
 

Comment 
 
 

Rate  Data_Collection_Rate Setup portion 
Time  AcqOff  

(at time=time of AcqOn + Time) 
Timed portion 

Range (µS) ECD_Analog_Out.Recorder_Range Setup & timed 
portions 

TTL 1 (checked/unchecked) ECD_TTL_1.State (=0v/5v) Setup & timed 
portions 

TTL 2 (checked/unchecked) ECD_TTL_2.State (=0v/5v) Setup & timed 
portions 

Relay 1 
(checked/unchecked) 

ECD_Relay_1.State (=Closed/Open) Setup & timed 
portions 

Relay 2 
(checked/unchecked) 

ECD_Relay_2.State (=Closed/Open) Setup & timed 
portions 

Offset (checked) Autozero Setup & timed 
portions 

Mark (checked) ECD_Analog_Out.Mark Setup & timed 
portions 
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PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command of  
 
 

Comment 
 
 

Temp. Comp. Temperature_Compensation Setup portion. 
Only for 
ED40/ED50c 
(conductivity) 

Cell Temp. DS3_Temperature Setup portion. 
Only for 
ED40/ED50c 

SRS Current  
(Off/50/100/300/500 mA) 

SRS_Current 
(=Off/50/100/300/500) 

Setup portion. 
Only for 
ED40/ED50c 

Amperometry Cell (On/Off) Cell (=On/Off) Setup portion. 
Only for  
ED40/ED50d (DC 
amperometry) & 
ED40/ED50i 
(integrated 
amperometry) 

Oven Temperature 
(enabled) 

Oven_Temperature Setup portion. 
Only for  
ED40/ED50d & 
ED40/ED50i 

Voltage DC_Voltage Setup portion. 
Only for 
ED40/ED50d 

Collection Begin (checked) AcqOn Setup or timed 
portion 

Plot Scales 
(Minimum/Maximum) 

Not converted  

Detector Units Not converted  
X-Y Data Not converted   
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 IC20/IC25 Setup and Timed Event Parameter Translation 
 

PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Rate Data_Collection_Rate Setup portion 
Time ECD_1.AcqOff  

(at time=time of AcqOn + Time) 
Timed portion 

High Pressure Limit Pressure.UpperLimit Setup portion 
Low Pressure Limit Pressure.LowerLimit Setup portion 
SRS Current 
(Off/50/100/300/500 mA) 

SRS_Current 
(=Off/50/100/300/500) 

Setup portion 

Oven Temp. DS3_Temperature Setup portion 
Temp. Comp. Temperature_Compensation Setup portion 
Inject (checked/unchecked) Pump_InjectValve.State 

(InjectPosition/LoadPosition) 
Setup & timed portions 

TTL 1 (checked/unchecked) Pump_ECD_TTL_1.State (=0v/5v) Setup & timed portions 
TTL 2 (checked/unchecked) Pump_ECD_TTL_2.State (=0v/5v) Setup & timed portions 
Relay 1 
(checked/unchecked) 

Pump_ECD_Relay_1.State 
(=Closed/Open) 

Setup & timed portions 

Relay 2 
(checked/unchecked) 

Pump_ECD_Relay_2.State 
(=Closed/Open) 

Setup & timed portions 

Offset (checked) Autozero  Setup & timed portions 
Mark (checked) Mark Setup & timed portions 
Flow Pump_ECD.Flow Timed portion 
Range Recorder_Range Setup & timed portions 
Eluent (A/B) Pump_ColumnValve.State 

(=Col_A/Col_B) 
Setup & timed portions 

Collection Begin (checked) ECD_1.AcqOn Setup or timed portion 
Pressure Units Not converted Set in Server 

Configuration instead 
Piston Size Not converted Set in Server 

Configuration instead 
Pump (On/Off) Not converted  
Comment Comments  
Description Comments  
Labels Not converted  
Plot Scales 
(Minimum/Maximum) 

Not converted  

Detector Units Not converted  
X-Y Data Not converted   
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 DX-120 Setup and Timed Event Parameter Translation 
 

PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Rate Data_Collection_Rate Setup portion 
Time ECD_1.AcqOff  

(at time=time of AcqOn + Time) 
Timed portion 

Pump (On/Off) Pump (=On/Off) Setup portion 
Column (A/B) Column (=A/B) 

Wait RinseComplete command 
added 

Setup portion 
Only if System Mode is 
Column 

Pressure (psi/MPa) PressureUnit (=psi/MPa) Setup portion 
SRS/Cell (On/Off) SRS (=On/Off) Setup portion 
Eluent Pressure (On/Off) EluentPressure (=On/Off) Setup portion 
Offset (checked) Autozero  

 
Setup & timed portions 

Inject (checked/unchecked) Pump_InjectValve.State 
(InjectPosition/LoadPosition) 

Setup & timed portions 

TTL 1 (checked/unchecked) ECD_TTL_1.State (=0v/5v) Setup & timed portions 
TTL 2 (checked/unchecked) ECD_TTL_2.State (=0v/5v) Setup & timed portions 
Controlled AC 
(checked/unchecked) 

ControlledAC (=On/Off) Setup & timed portions 

Eluent (A/B) Eluent (=A/B) Setup & timed portions 
Only if System Mode is 
Eluent 

Collection Begin (checked) ECD_1.AcqOn Setup or timed portion 
System Mode Not converted  
Comment Comments  
TTL Output Labels Not converted  
Plot Scales 
(Minimum/Maximum) 

Not converted  

Detector Units Not converted  
X-Y Data Not converted   
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 UI20 Setup and Timed Event Parameter Translation 
 

PeakNet (Releases 4.3 
Through 5.2) Method 
Parameter 

Chromeleon PGM Command  
 
 

Comment 
 
 

Rate (A&B) Data_Collection_Rate Setup portion 
Time (A&B) Channel_A.AcqOff for Channel A 

Channel_B.AcqOff for Channel B 
(at time=time of AcqOn + Time) 

Timed portion 

TTL 1 (checked/unchecked) Interface_TTL_1.State (=0v/5v) Setup & timed portions 
TTL 2 (checked/unchecked) Interface_TTL_2.State (=0v/5v) Setup & timed portions 
TTL 3 (checked/unchecked) Interface_TTL_3.State (=0v/5v) Setup & timed portions 
TTL 4 (checked/unchecked) Interface_TTL_4.State (=0v/5v) Setup & timed portions 
Relay 1 
(checked/unchecked) 

Interface_Relay_1.State 
(=Closed/Open) 

Setup & timed portions 

Relay 2 
(checked/unchecked) 

Interface_Relay_2.State 
(=Closed/Open) 

Setup & timed portions 

Full Scale Voltage (mV) 
(10/100/1000/10000) 

Full_Scale_Voltage  
(0.011/ 0.110/ 1.100/ 11.000) 

Setup portion 

Collection Begin (checked) Channel_A.AcqOn for Channel A 
Channel_B.AcqOn for Channel B 

Setup or timed portion 

Comment Comments  
Labels Not converted  
Plot Scales 
(Minimum/Maximum) 

Not converted  

Units Not converted  
X-Y Data Not converted  
TTL Inputs Not converted  
Trigger Not converted   
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 Detector Component Table Parameter Translation 
 

PeakNet Releases 4.3 
Through 5.2  
Component Table 
Parameter 

Chromeleon QNT 
Method Parameter 
 
 

Comment 
 
 
 

Component Name Peak Name  
Retention Time Retention Time If peak Reference Component 

column = None then Retention Time 
options are set to Absolute. 
If peak Reference Component = 
<Component> then Retention Time 
options are set to Time Distance to 
Reference Peak and Reference 
Peak = <Component> is assigned 

Tolerance Window If Tolerance = time then Window 
options are set to Absolute and 
Greatest. 
If Tolerance = % then Window 
options are set to Relative and 
Greatest. 

Reference Component Retention Time Options See Retention Time comments for 
rules.  

Internal Standard 
Component 

Standard If global PN5 calibration options = 
External then all Chromeleon 
Standards = External 
- If Internal Standard Component = 
Internal Standard then "Use this 
peak as Internal Standard" option is 
set. 
- If Internal Standard Component = 
<Component> then Internal Standard 
is set and Associated ISTD Peak is 
assigned.  

Calibration Standards 
Level [1...32] Amounts 

Amount column for each 
level  

An amount column for each level 
labeled Std1, Std2, … Stdn is 
inserted where n = total levels. The 
amounts for each peak in the table 
are filled in. 

Check Standards Level 
[1...32] Amounts 

Amount column for each 
level  

An amount column for each level 
labeled CStd1, CStd2, … CStdn is 
inserted where n = total levels. The 
amounts for each peak in the table 
are filled in. 
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PeakNet Releases 4.3 
Through 5.2  
Component Table 
Parameter 

Chromeleon QNT 
Method Parameter 
 
 

Comment 
 
 
 

Curve Fit Type Calibration Type If Cubic in PN5 then set to quadratic. 
- PN5 Fit Linear/quadratic with Origin 
= Force is Linear/quadratic in 
Chromeleon. 
- PN5 Fit Linear/quadratic with Origin 
= Ignore is Linear/quadratic with 
Offset in Chromeleon. 
- PN5 Fit Linear/quadratic with Origin 
= Include is Linear/quadratic with 
Offset and Include point (0,0) options 
in Chromeleon. 
- All points are set to No Weight in 
Chromeleon. 
- No Average Response Factor in 
Chromeleon, so set to Linear. 

Origin Calibration Type See Curve Fit Type for rules. 
Calibrate By Calibrate By - Area or Height 

- If Relative then set to Relative Area 
for Identified Peaks Only. 

Relative Response 
Component 

Response Factor Relative to Peak is set and correct 
peak is assigned. 

Relative Factor Response Factor Value for factor is assigned. 
Groups Groups - For each peak in a group, the 

Chromeleon group item is set to that 
name. 
- For each time range in a group, the 
range is added to Unidentified Peaks 
list. 

Standardization External/Internal See handling in Quantification 
section above. 

Calibration Standard 
Volume 

Reference Inject 
Volume 

 

Amount Units Dimension of Amounts  
Replace Retention Time Use recently detected 

retention times check 
box is checked 

Last Standard Options = Last Value 

Low Limit Amount Not Available (N.A.)  
High Limit Amount N.A.  
Total Levels for 
Calibration Standards 

N.A.  



272 Creating and Managing Files 

PeakNet Releases 4.3 
Through 5.2  
Component Table 
Parameter 

Chromeleon QNT 
Method Parameter 
 
 

Comment 
 
 
 

Total Levels for Check 
Standards 

N.A.  

Replicates Table N.A. No replicate information will be 
converted from PN5. 

Replicates N.A.  
Rejection of Outlier N.A.  
Linear Weighting N.A.  
Replace/Average 
Response 

N.A.  

Sample Volume Default N.A.  
Sample Weight N.A.  
Dilution Factor N.A.  
Internal Standard 
Amount 

N.A.  

Unknown Response 
Factor 

N.A.  

Response for Unknowns N.A.  
CE Information N.A. If CE information is contained, it will 

not be converted in Chromeleon.   



 Creating and Managing Files 273 

Importing Agilent/HP ChemStation Data 
Files 
In order to use Agilent/HP ChemStation data files with Chromeleon, you 
must first import the files into Chromeleon. However, keep in mind that the 
structure of the two systems is different: 

• Agilent/HP ChemStation contains single files. 

• Chromeleon is a database-aided system. 

Select the type of data you want to import in the wizard that guides you 
through the process (see below): 

Agilent/HP ChemStation Chromeleon  
Batch One Sequence that has already been 

analyzed (not a Batch!) 
Sequence A sequence that has not yet been processed. 
Method Contains elements of the PGM File, the 

QNT Method, and the Report Definition 
File (RDF) 

 Tip: 
Only the transferable QNT part of each file is 
imported.  

Sample Single sample 
Spectra Library Spectra Library 
 
Depending on your selection, the following Agilent/HP ChemStation data 
are imported together with the selected data type: 

Agilent/HP ChemStation Chromeleon  
2D/3D raw data file The corresponding channels; for example, 

UV and 3D channels. 
Instrument data such as  
pressure, flow, temperature, 
and gradient composition 

 

Sample LOG File Audit Trail 
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How To 
• In the Browser, select Import/Restore on the File menu, and then 

select Agilent/HP ChemStation. The Agilent/HP ChemStation Data 
Import Wizard is opened.  

• On the first page, select the data type to be imported. Clicking Next> 
takes you to the next wizard page. 

• Click Add. In the Select Agilent/HP ChemStation … dialog box, 
navigate to the folder in the Windows Explorer that contains the file(s) 
to be imported. (The picture refers to importing a sample.) 

 

• Select the first file to be imported. Click OK to confirm your selection. 
This action automatically returns you to the wizard. (When you import a 
batch, a sequence, or a spectra library, the appearance of the dialog 
box is slightly different. In this case, click Open to confirm your 
selection.) 

• Repeat these steps until all desired files appear in the selected files list. 
Clicking Next> takes you to the next wizard page. 

• Determine the destination directory. (Depending on the data type to be 
imported, you may have to determine the destination sequence and the 
method to be used): 
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• Select Import instrument signals by the check box if you want to 
include the instrument signals into the import. Clicking Next> takes you 
to the next wizard page. 

• All files selected for import and the desired location are listed.  

• Click Finish. The selected files are imported into Chromeleon.  

For more information about how to import ChemStation data files, refer to 
 ChemStation Translation Tables. 
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ChemStation Translation Tables 
For information about how ChemStation data are translated to Chromeleon 
data, refer to: 

 Translating ChemStation Sequences and Batches 
 Translating ChemStation Samples 
 Translating ChemStation Methods 
 Translating ChemStation Spectra Libraries 

  
 Translating ChemStation Sequences and Batches 

ChemStation (CS) sequences and batches correspond to the Sequences 
in Chromeleon. Chromeleon uses all information available in the 
ChemStation sequence or in the ChemStation batch to create a new 
sequence with the same name. A message appears if this sequence 
already exists. You can either overwrite the old sequence or cancel the 
import. 

The table below lists the parameters that are available for a sequence 
and/or batch in ChemStation and their equivalents in Chromeleon: 
 
ChemStation (CS) Chromeleon  
Comment (of a CS sequence) Title 
Instrument Timebase 
Operator Name (of a CS sequence) Created by 
Last modification time (of a CS sequence) Created 
Current CM user (user who imported the data) Last Update by 
Date/time of import Last Update 
- Locked 
- Preferred RDF file 
- Preferred channel 
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Some ChemStation sequence and/or batch settings cannot be mapped 
directly to Chromeleon settings: 

• Cal Level: Used for ChemStation calibration; not used in Chromeleon. 
In Chromeleon, the corresponding information is available in the 
⇒Amount column of the QNT Method. 

• Inj/Location: Indicates the number of replicates. The corresponding 
number of samples will be generated for the Chromeleon sequence. 

• Interval: If the interval value for one of the standards is > 0, the 
ChemStation sequence runs in a special mode: The standard samples 
are injected first; then the unknown samples are injected. After x 
unknown samples have been injected (where x is defined by Interval), 
one or more standards are injected again. After importing, a sequence 
is created in Chromeleon in which standards are injected again after x 
unknown samples. 

Translation table for generating a sample list: 
 
ChemStation Chromeleon  
Sample Name ⇒Name (sample name) 

Sample Type 
Sample 
Calibration 
Control Sample 

⇒Type (sample type) 
Unknown, 
Standard, 
Validation. 

Location ⇒Pos. (sample position) 
Inj Volume ⇒Inj. Vol. (injection 

volume) 
- ⇒Program ( PGM File) 
Method Name ⇒Method  (quantification 

method) 
 ⇒Status (sample status) 
Date/Time of injection (evaluated from CS log file) ⇒Inj. Date/Time (injection 

date and time) 
Product of Sample Amount and Multiplier ⇒Weight (Sample Weight 

Factor) 
Dilution ⇒Dil. Factor (Dilution 

Factor) 
ISTD Amount ⇒ISTD Amount (Amount 

of the Internal Standard) 
Datafile (standards are named automatically - see below) ⇒Sample ID 
- ⇒Replicate ID 
Sample Info ⇒Comment 
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The ChemStation does not name the calibration standards; the names are 
automatically generated with a prefix and counter. Chromeleon needs the 
exact file name for data import and thus, uses the same algorithm.   

 Translating ChemStation Samples 
Chromeleon uses all information available for the ChemStation (CS) 
sample to create a new sample with the same name. If the new sample is 
imported into an existing sequence, the sample is appended to the 
sequence. Existing samples will not be overwritten. 

Unlike Chromeleon, ChemStation does not provide a sequence context for 
the single samples. That is why the sample information is gathered from 
raw data, instrument diagnosis, macros, and the LOG files. 

The table below lists the properties that are available for a ChemStation 
sample and their equivalents in Chromeleon:  
 
ChemStation Chromeleon  
Sample name information from a 2D/3D raw data file ⇒Name (sample name) 
Cannot be evaluated from the CS sample data;  
set to "unknown" 

⇒Type (sample type) 

Vial position information from a 2D/3D raw data file ⇒Pos. (sample position) 
Inj Volume from the Lcdiag.reg file ⇒Inj. Vol. (injection volume) 
Not specified, no entry. ⇒Program ( PGM File) 
Method information from a 2D/3D raw data file ⇒Method  (quantification 

method) 
Set to "Finished" ⇒Status (sample status) 
Date/time of injection (from the LOG file) ⇒Inj. Date/Time (injection date 

and time) 
Cannot be evaluated from the CS sample data, set to 1.0 ⇒Weight (Sample Weight 

Factor) 
Cannot be evaluated from the CS sample data, set to 1.0 ⇒Dil. Factor (dilution factor) 
Cannot be evaluated from the CS sample data, set to 1.0 ⇒ISTD Amount (Amount of the 

Internal Standard) 
Sample name (*.d) ⇒Sample ID 
- ⇒Replicate ID 
Sample information from the "sample.mac" file ⇒Comment  
If you did not specify the ChemStation method to be used, all methods 
used for the imported samples will be imported. If one of these methods 
does not exist, Chromeleon generates a standard QNT Method. 
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 Translating ChemStation Methods 
The ChemStation (CS) method contains parts of the Chromeleon PGM 
File, the QNT Method, and the Report Definition File (RDF). 
Chromeleon uses only the relevant information of a ChemStation method 
(i.e., Peak Table and Integration Events) to create a new QNT Method with 
the same name. A message appears if this method already exists. You can 
either overwrite the old method or cancel the import. 

The table below lists the Integration Events of a ChemStation method and 
the equivalent detection parameters in Chromeleon:  
 
ChemStation Chromeleon  Comment 
Slope Sensitivity Sensitivity Translation factor: 20 
Peak Width Peak Slice Translation factor: 0.8 
Area Reject Minimum Area Translation factor: 1/60 
Height Reject Minimum Height  
Shoulders Peak Shoulder Threshold Off = 0ff, On = 0.1 
Baseline Now Lock Baseline On 
Baseline at Valleys Valley to Valley Off = Off, On = On 
Baseline Hold Lock Baseline On = At Current Level, Off = Off 
Tail Tangent Skim -  
Tangent Skim Mode -  
Area Sum Peak Group Start 

Peak Group End 
On 
Off 

Integration Inhibit Integration Off = On, On = Off 
Negative Peak Detect Negative Peaks Off = Off, On = On 
Split Peak -  
Fixed Peak Width Peak Slice  
Auto Peak Width -  
Detect Shoulders Peak Shoulder Threshold Off = 0ff, On = 0.1 
Shoulder Mode - - 
Solvent Peak -  
Baseline Backwards -  
Baseline Next Valley -  
Unassigned Peaks -   
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Chromeleon provides equivalents in the QNT Method for the following peak 
table parameters of a ChemStation method: 
 
ChemStation Chromeleon  Comment 
Compound Peak Name  
RT Ret. Time  
RT Window Low 
RT Window High 

Window Calculated from the difference: 
RT High - RT Low 

 
 Translating ChemStation Spectra Libraries 

When importing a ChemStation (CS) spectra library into Chromeleon, the 
library name is the same in Chromeleon and in ChemStation. All spectra of 
the ChemStation library are imported into the Chromeleon library. Only the 
unmodified spectra are imported, all specific wavelength entries are 
ignored. 

The table below lists the information available in a ChemStation spectra 
library and the equivalent parameters in Chromeleon: 
 
ChemStation Chromeleon   
File name of the imported library + hint "Imported CS library" Name 
User who imported the spectra library Created by 
Creation date of the imported spectra library  Created 
Current user Last Update by 
Date/time of the import Last Update 
Information on the imported library Title  
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Equilibrating the Chromatography 
System 

Before you can start analyzing your samples, you have to equilibrate the 
chromatography system. For the Summit HPLC System, Chromeleon 
supports SmartStart to automate the equilibration process. SmartStart 
means that the entire system, especially the column, is washed with the 
starting solvent until the system is free of any other liquid compositions. In 
addition, the column thermostat and the thermostatted autosampler if 
installed are warmed or cooled to the starting temperature. Besides, 
Chromeleon checks the lamp for stability to avoid increased Drift or 

Signal Noise. 

The  SmartSmartStart Wizard in Chromeleon assists you in automating 
equilibration for the Dionex Summit HPLC system. To start the wizard, 
select SmartStart on the Batch menu: 

 

Or else, click the following icon on the Online Toolbar:   

The SmartStart Wizard guides you through the following steps: 

 Selecting the Timebase 
 Extracting the Equilibration Conditions 
 Editing the Equilibration Conditions 
 Starting Equilibration 
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 Selecting the Timebase 
In the first step of the SmartStart Wizard, select the Timebase. (Note: If a 
timebase is already selected in the current window, this timebase is used 
and the related wizard step is omitted.) The right-hand pane lists various 
computers, timebases, and networks. It depends on the access right(s) of 
the user which items are displayed.  

 

Select the timebase for which equilibration shall be performed. To do so, 
SmartStart Wizard support must be available for at least one device in the 
timebase. The SmartStart Wizard currently supports the following Dionex 
devices: 
• P680 HPLC pump 

• ASI-100 HPLC autosampler 

• TCC-100 HPLC thermostatted column compartment 

• UVD 170U, UVD 340U, UVD 170S, and UVD 340S HPLC detectors 

Clicking Next> takes you to the next wizard pages. 
 
For an overview of how to equilibrate the HPLC system with Chromeleon, 
refer to How to …:  Equilibrating the Chromatography System. 
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 Extracting the Equilibration Conditions 
Use the Extract Equilibration Conditions page of the SmartStart Wizard 
to determine whether an existing program or the current settings shall be 
the basis for the equilibration program: 

• Select <Choose Program...> to use an existing program. 

• Select <Manual Input> to use the current settings. 

• Any existing equilibration programs are listed and available for 
selection, also. 

After making your selection, click Next> to continue:  

If you selected <Choose Program...>, clicking Next> opens the Browse 
dialog box. Select a program from the list and click Open. This takes you to 
the next wizard page. 

If you selected <Manual Input>, clicking Next> takes you to the next 
wizard page. Use this page to  Edit the Equilibration Conditions.  

If you selected an existing equilibration program, click Next> and edit the 
program on the next wizard page. 
 
For an overview of how to equilibrate the HPLC system with Chromeleon, 
refer to How to …:  Equilibrating the Chromatography System. 
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 Editing the Equilibration Conditions 
The Equilibration Conditions page of the SmartStart Wizard provides an 
overview of the equilibration conditions, including a brief description of the 
parameter settings for the single devices: 

 

If you want to exclude a device from equilibration, clear the Equilibrate 
check box. To edit the parameters for a device, open the related dialog box 
by double-clicking the device in the Devices column.  

As an alternative, select the device and click Edit or press the F8 key. For 
example, double-click PumpLeft to open the following dialog box for the 
left pump of the P680 DGP: 
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Modify the equilibration conditions as required. For example, for the pump, 
change the flow, pressure limits, and the maximum allowed ripple.  

Clicking Next> takes you to the next wizard page. 
 
For an overview of how to equilibrate the HPLC system with Chromeleon, 
refer to How to …:  Equilibrating the Chromatography System. 

 Starting Equilibration 
The Start Equilibration page is the last page of the SmartStart Wizard. 
Click Finish to start equilibration. The single steps that are automatically 
performed by Chromeleon appear in the Equilibration start log section. 
Before performing the first step (Preparing equilibration start), 
Chromeleon wants to know whether you want to save the equilibration 
program for later use.  

To do so, click Yes to open the Save Startup Conditions dialog box: 
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Type a program name in the Save As field. The Saved Startup 
Conditions field lists all existing equilibration programs. 

Click Save to save the equilibration program for later use. Chromeleon 
creates an Equilibration sample (⇒Type = Blank) and saves it to the 
Equilibration sequence in the timebase's directory located in the server's 
standard datasource. The Equilibration sequence also contains the new 
equilibration program (see PGM File). 

When you have saved the equilibration program, Chromeleon closes the 
SmartStart Wizard and opens the appropriate equilibration panel for your 
timebase. 

 Tip:  
The Dionex Templates/Panels/Equilibration folder provides several 
panels from which Chromeleon automatically composes a panel that 
matches your timebase. Therefore, you should not modify the default 
equilibration panels. 

Chromeleon automatically connects the panel to the related timebase. The 
panel contains a stripe for each device in the timebase that is supported by 
the SmartStart Wizard. 

In addition, the Bach Start dialog box is opened, already containing the 
Equilibration sequence with the new sample (first position on the list). 
Click Start to start the Batch and have Chromeleon perform equilibration 
automatically.  
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Equilibration is successful when all devices reached the specified settings 
at the end of the program. If equilibration failed, the batch is aborted after 
the maximum time. When equilibration was successful, Chromeleon 
continues with processing any other sequences in the batch. 
 
For an overview of how to equilibrate the HPLC system with Chromeleon, 
refer to How to …:  Equilibrating the Chromatography System. 
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Controlling Devices from the Control 
Panel 

Chromeleon provides different control panels for device control. Using an 
appropriate control panel, you can connect and control your 
chromatography instruments. In addition, you can modify the control panel 
controls and/or the timebase assignment. (For general information about 
control panels, refer to Control  The Control Panel.) 
For more information, refer to: 

 Opening a Control Panel 
 Connecting a Control Panel to a Chromatography Device 
 Creating and Starting Sample Batches  
 Modifying a Control Panel 
 Displaying Sample and Sequence Information 

As an alternative to recording real data, you may simulate data acquisition, 
also. Refer to  Using and/or Recording Demo Data for more 
information. 

Also, refer to  Answering Frequently Asked Questions. 

Device control also includes System Wellness (see Performing Validation 
and Qualification  Ensuring System Wellness). 

 

 Opening a Control Panel 
To process unknown samples or to control an instrument with Chromeleon, 
open a Control Panel, either manually or automatically. 

Chromeleon is shipped with more than 100 default control panels that 
provide all standard functions required for operation. The default panels are 
usually stored in the Dionex Templates > Panels directory of the local 

Datasource. 
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Open a control panel manually 
• Select Open on the File menu. In the Open dialog box, select Control 

Panel from the Object of type drop-down list and navigate to the folder 
that contains the control panels. All panels available in the selected 
folder are listed. Type the panel name in the Name field. Or else, click 
the name in the list. In this case, the panel name is automatically 
written into the Name field. Click Open to open the panel. 

• Alternatively, you can select the panel directly from the Browser. 
Double-click the panel name to open the panel. 

Each control panel is connected to a Timebase. When you open a control 
panel, Chromeleon automatically connects to the timebase saved last. 
When installing the software, Dionex Service usually specifies the timebase 
to which Chromeleon connects automatically. Of course, you can connect 
the control panel to any other timebase whenever you want (see How 
to …: Controlling Devices  Connecting a Control Panel to a 
Chromatography Device). 

 Tip:  
To change the automatic timebase assignment for a control panel:  

Select Properties on the Edit menu. On the Timebase tab page, delete 
the entry in the Timebase field and click OK. When you open the control 
panel again, no timebase will be assigned. Return to the Timebase tab 
page, and select a timebase. Click OK to save the new assignment. 

Open a control panel automatically 
When started, Chromeleon opens the most recently used Workspace. If 
the workspace contains a control panel, the corresponding control panel is 
opened as well.   

If you cannot open a workspace, for example, because you have not yet 
created such a view, open the control panel manually.  

 Tip:  
Instead of opening a single control panel, you can open a panel tabset, 
which provides (on one window) a group of control panels for controlling 
and monitoring a timebase (see How to …:  Controlling Devices from 
the Panel Tabset). 
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 Connecting a Control Panel to a Chromatography 
Device 
When you open a Control Panel, it is automatically connected to the 
assigned Timebase, i.e., to the chromatography devices in this timebase. 
You can modify the timebase assignment any time: 
• Open a control panel. Select Connect to Timebase on the Control 

menu. 

The Timebase field on the left reports the name of the currently selected 
timebase, the Computer field reports the name of the computer on which 
the corresponding Server is running, and the Protocol field reports the 
used communication protocol. The list box on the right shows an icon for 
the local computer (My Computer). If the computer is connected to a 
network, an icon for the network neighborhood appears, also (see 
Chromatography Components: Hardware and Software  Network 
Installation.) 

• Click the Plus sign (+) beside an icon to display the items underneath. 

• If the server is running, all timebases configured for the local server are 
listed under My Computer. If the server is not active, the entry is The 
server is not running.  

• All PCs available on the network are listed under Network 
Neighborhood. Click the "+" sign beside a computer name to display 
the Chromeleon servers underneath. If there is no active Chromeleon 
server, the entry is Server not found. 

• Select a timebase and click OK to confirm your selection. The name of 
the timebase is automatically written to the Timebase field on the left. 

• If you want to connect to a different timebase whenever you open the 
control panel, delete the entry in the Timebase field. The panel is no 
longer assigned to a specific timebase and the message stating that 
the former timebase is not found does not appear.  

• Click OK to have Chromeleon connect the control panel to the selected 
timebase. If the connection is successful, you can control the 
connected instruments, using the control elements on the control panel. 
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 Tip:  
If you want to connect automatically to the currently timebase when you 
reopen the control panel later, save the panel with the current timebase 
assignment. 

Problems when Connecting to a Timebase 
It depends on the selected network protocol whether a non-local server is 
displayed or can be accessed. The system needs several seconds to check 
whether the selected protocol can be used. If the connection to a specific 
timebase is not successful, this can be due to several reasons.  
• First, check whether the corresponding server is running. 

• If the server is running, try a different network protocol. Chromeleon 
can communicate via various network protocols, such as IPX, TCP/IP, 
or NetBEUI. 

 Tip: 
Communication between two stations is possible only if the same 
network protocol is installed and selected on both stations. It is usually 
sufficient if you have installed the corresponding network protocols, 
e.g., IPX/SPX compatible protocol; NetBEUI Protocol, or Internet 
Protocol (TCP/IP). (Click Settings > Control Panel > Network and 
Dial-up Connections > Local Area Connection, and then select 
Properties on the context menu.) The current network installation 
determines which protocol is actually used. Please contact your 
network administrator. To connect to a Windows 2000 or Windows XP 
computer, use the Named Pipes protocol. Usually, the connection is 
successful when this protocol is used.  

• It may happen that the required timebase exists (Server is running) 
but that it is not displayed. In this case, return to the Connect to 
Timebase dialog box. The timebase is usually displayed then.  
This may also happen when you connect two computers using an ISDN 
connection. Usually, the reason is that the network installation is not 
100 per cent correct. 

• If you use an IPX/SPX compatible protocol, verify that NWLink 
IPS/SPX/NetBIOS Compatible Transport Protocols is installed and 
that the check box is selected. To check this, click Settings > Control 
Panel > Network and Dial-up Connections > Configuration and 
select Properties on the context menu. If necessary, install the 
protocol via the Install button.  
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If the connection is still not successful, contact Dionex Service.  

Problems when Controlling Instruments 
In addition to the control mode, Chromeleon also provides a Monitor Only 
mode. If you connect to a timebase that is only available on a network, you 
can only monitor this timebase. 

The Monitor Only status is also assigned when you attempt to access a 
local timebase that is currently controlled by an external user. 
• Deselect Monitor Only on the Control menu to enable complete 

control over the timebase.  

 Creating and Starting Sample Batches 
Chromatography systems are often operated day and night to ensure the 
best possible rate of utilization. To facilitate processing, Chromeleon allows 
you to group different sequences in a Batch: 
• Select Edit on the Batch menu. The Batch dialog box is opened.   

• On the Batch List tab page, click Add to add the sequences to be 
processed. (In the Browse dialog box, select Sequence as Object of 
type and navigate to the desired sequence(s). Click Open to confirm 
your selection.) If necessary, click Remove to remove any unwanted 
sequences. To delay the start of a sequence, select the sequence and 
click Set Delay. A dialog box is opened. Enter the date and time to 
start the sequence and click OK. 
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• Use the Reporting tab page to determine the print and report options. 
Select the Print/Export Report check box to open the Batch Report 
dialog box. Use this dialog box to specify which pages of the Printer 
Layout you want to print or export and for which samples you want to 
print/export the selected pages. Confirm your settings by clicking OK. 
On the Reporting tab page, also determine whether the selected 
pages shall be printed or exported immediately after the corresponding 
sample has been processed or when the entire batch has been 
finished. (For more information, refer to How to …: Preparing the 
Printout  Printing the Results of a Sequence or a Sample 
Batch.) 

• On the Error Handling tab page, determine the behavior of 
Chromeleon if errors occur during batch processing.   
Under Emergency Program, select the program to be run if an Abort 
error occurs. Select the program from the drop-down list or click 
Browse to navigate to the desired file. (For more information, refer to 
How to …: Creating and Modifying Programs  Creating an 
Emergency Program).   
 
Under Power Failure Handling, determine the program to be run when 
the server restarts after a power failure. Select the program from the 
drop-down list or click Browse to navigate to the desired file. (For more 
information, refer to How to …: Creating and Modifying Programs 

 Creating a Power Failure Program). In addition, determine how 
the system shall proceed after running the power failure program. 
Select an action from the drop-down list. 

• On the Transfer tab page, determine whether the data shall be copied 
when the batch has been processed. Select the Copy data to the 
following location check box, and then click Browse to navigate to 
the desired location. The options provided in the Options section 
depend on whether the Online Transfer Agent (= OTA) is installed on 
your computer. If the Online Transfer Agent is installed, the following 
options are available: 
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If the Online Transfer Agent is not installed on your computer, the 
Chromeleon client transfers the data. If the OTA is installed, data 
transfer is performed by the OTA service. In this case, it is possible to 
start the batch even if the client is not running and to have data 
transferred to network datasources that you are not allowed to access. 

 Tip:  
To use the Online Transfer Agent, make sure that the Multiple 
Network Control license is available on your PC (see  Chromeleon 
Licenses). 

For information about how to install the Online Transfer Agent, refer to How 
to …: Starting and Monitoring the Server, Setting Up the Server for 
Network Access  Setting Up the Online Transfer Agent for Network 
Access in the Administrator Help section. 
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 Modifying a Control Panel 
Open the Control Panel you intend to modify (see How to …: 
Controlling Devices from the Control Panel  Opening a Control 
Panel). 

Saving the Panel under a Different Name 
Dionex recommends that you do not overwrite any panels from the Dionex 
Templates > Panels directory. Also, before modifying an existing panel, 
select Save as on the File menu and save the panel under a different 
name. 

Enabling Layout Mode 
• Enable Layout Mode on the Edit or context menu.  

Adding a Control  
• Move the mouse pointer over the Layout Toolbar: 

 
The quick info box provides a brief description of the Control to 
which you are currently pointing. 

• Left-click to select and append the desired control to the pointer.  

• Point to the desired position. Left-click to position the new control.  

Removing a Control 
• Left-click the control to be removed. A control frame marks the selected 

control.  

• Press the Del key to remove the control. Or, select Delete on the Edit 
menu. 

Modifying the Size and Position of Controls 
• To resize left-click the control and draw its Control Frame to the 

desired size. 

• To move a control left-click and drag the control to the desired position, 
holding down the left mouse button. To select several controls 
simultaneously, press the SHIFT key and left-click the desired controls.  
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• To align several controls, press the SHIFT key and left-click the desired 
controls. Select Align on the Edit menu, and then select an option. 
The control frame of the control selected first is used as the reference 
point and reference size for the other controls.  

Also, refer to: 

 Modifying a Control 
 Linking a Control to a Device 
 Creating a Script Button 
 Linking a Control to a Command 
 Creating a Device Command Button 
 Creating a Timebase Command Button 
 Creating Hidden Windows 

 
 Modifying a Control 

In Online Mode 
• Right-click the Control (= object) to be modified.  

• Select Properties on the context menu to open the Properties dialog 
box for the selected control.  

In Layout Mode 
• Select the control to be modified.  

• Select Properties on the context menu to open the Properties dialog 
box.  
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Properties Dialog Box 
The tab pages provided in the Properties dialog box vary, depending on 
the selected control: 
 
Name Function 
1. General Determine the caption, font, and text position and size for the control.  
2. Link Link to the device for which the property is displayed. 
3. Autosize Determine how the size of the control changes when the entire panel is 

increased or reduced in size. 
4. Color Select the colors for the individual components of the control. 
5. Style Select the shape of the control. 
6. Button Specify whether and which additional Control Panel(s) are opened 

when the corresponding Script button is clicked (also, see How to …: 
Controlling Devices from the Control Panel  Creating Hidden 
Windows). 

7. Command Type the command or program to be executed when the Script button is 
clicked. 

8. Axis/Decoration Determine the scaling of the axes and the representation of the online 
signals and 3D plot. 

9. Signals Determine which signals are displayed and which offset is used. 
10. Chrom. Determine whether and how chromatograms overlap on the signal plot.  
11. Device Select the pump(s) for which gradient profiles are displayed.  
12. Timebase Connect to the selected Timebase. 
13. Default 

Parameters 
Specify the default parameters for a command that is linked to a Device 
Command button. 

14. Events Select the events to be marked on the Trend Plot. 
15. Statistics Select the statistics to be marked on the trend plot and define how they 

are calculated. 
16. Data Labels Specify which data points on the trend plot are labeled, and the text of 

the label. 
17. Data Select the trend variable to be plotted, the datasource from which trend 

data is retrieved, and the time period of the trend data. 
18. Function Select the function to assign to the timebase command button.  
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These tab pages are available for the following controls: 
 
 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 

Form X   X X       X       

Check Box X X X                

Color Box X X X X               

String 
Display 

X X X                

Gauge 
Indicator 

X X X X X              

Script  
Button 

X  X   X X            

Online Signal 
Plot 

X  X X    X X X         

Group Box X  X  X        X      

Gauge/Slider X X X X X         X X X X  

Lamp X X X X X              

Switch X X X  X              

Edit Field X X X X X              

Audit Trail X  X                

Gradient 
Display 

X  X X       X X       

3D Plot X  X X    X           

3D Amp Plot  X  X X    X   X        

Rack Display X X X                

Online Mass 
Spectrum 
Plot 

X  X X               

Device 
Command 
Button  

X X X          X      

Trend Plot  X  X X          X X X X  

Timebase 
Command 
Button  

X  X               X 

Sample List  X  X                
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For information about how to specify the property of a control, refer to How 
to …: Controlling Devices from the Control Panel  Linking a Control 
to a Device. 

 
 Linking a Control to a Device 

To have a control display the status or the parameter of a device, you have 
to link the element to the device: 
• Right-click the corresponding Control and select Properties on the 

context menu.  

• Open the Link tab page. 

• From the Object list box, select the object to which you want to link a 
property or parameter. For example, select an instrument, a function 
(relay), a Channel, or a system. Select a property from the Object 
Property list box. Click OK to link the control to the object and the 
property. 

Example 

To have a color box indicate whether the pump is connected to 
Chromeleon, select Pump from the Object list box and Connected from 
the Object Property list box: 
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 Tip: 
Not every control is an ideal choice for representing a certain function or 
parameter. The functions and properties that appear in the Object 
Property list box depend on the selected control.  

 Note:  
The Link tab page is not available for the signal plot, the gradient profile, 
and the 3D plot. Use the Signals tab page for the signal plot and the 
Device tab page for the gradient profile instead. You cannot change the 
parameters for the 3D plot. 

 
 Creating a Script Button  

Chromeleon lets you assign a command or an entire sequence of 
commands to a Script Button. In this way, you only need to click the 
corresponding button to have Chromeleon execute the command or 
program. To create script buttons, you must have the corresponding 
authorization.  
• Right-click the script button, select Properties on the context menu, 

and then select the Command tab page. 

• Type all commands to be executed successively into the list box. The 
syntax corresponds to the syntax used when creating a Program. 
When you have entered the desired commands, click Check to check 
the syntax. Click Try it now to test the operation before you complete 
programming.  

• You can also use a script to start a previously written program: Copy 
the entire program text and paste it into the list box on the Command 
tab page. Or else, use the ⇒Branch command. Enter the Branch 
command and then enter the path and name for the program to be 
started, e.g.: 

Branch „CM_Seminar\\Programs\\Equilibration" 

This button allows you to start a column equilibration program that is 
stored on the CM_Seminar datasource in the Programs directory. 
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For more information, refer to Control  The Program Syntax. 
 
For practical tips, refer to: 

How to …:  Creating and Modifying Programs and Device Control 
Practical Tips for Device Control (Overview). 

 Linking a Control to a Command 
To have a control execute a specific device command, you have to link the 
control to both the device and the command: 
• Right-click the corresponding Control and select Properties on the 

context menu.  

• Open the Link tab page. 

• From the Object list box, select the object to which you want to link a 
property from the Object list box. For example, select an instrument, a 
function (relay), a Channel, or a system. Select a property from the 
Object Property list box. Click OK to link the control to the object and 
the property. 

  Creating a Device Command Button 
Chromeleon lets you assign a command to a device command button so 
that you can execute the command by clicking the button. To create a 
device command button, you must have the appropriate authorization.  
• Right-click the corresponding button and select Properties on the 

context menu. 

• Open the Link tab page.  

• From the Object list box, select the object to which you want to link the 
command. From the Command list box, select the command to be 
linked to the selected object.  

• Select the Default Parameters tab page.  

• Specify the default setting for the linked command and enter any 
comment text you want to have associated with the command. 
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 Tip: 
Device command buttons provide commands for controlling a specific 
device (for example, performing a detector autozero). Timebase command 
buttons provide commands for controlling a timebase (for example, creating 
a program).  

Also, refer to  Creating a Timebase Command Button. 

 Creating a Timebase Command Button 
Chromeleon lets you assign a command to a button so that you can 
execute the command by clicking the button. To create a timebase 
command button, you must have the appropriate CmUser rights.  

• If you have not already done so, add a timebase command button to 
the control panel (see How to …:  Modifying a Control Panel). 

• Right-click the button and select Properties on the context menu. 

• On the General tab page, enter a caption to identify the function to be 
assigned to the button. To include a variable in the name, click the {..} 
button. 

• On the Timebase Command tab page, select the command to assign 
to the button and click OK. 

 Tip: 
Timebase command buttons provide commands for controlling a timebase 
(for example, creating a program). Device command buttons provide 
commands for controlling a specific device (for example, priming an 
autosampler).  

Also, refer to  Creating a Device Command Button. 
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 Creating Hidden Windows 
In some cases, a Control Panel has to fulfill so many different functions 
that they do not fit in one window. For example, there may be only a small 
space left for the signal plot. In this case, create a Script Button to open 
an additional window for the remaining controls or, for example, a large 
signal plot:  

• First, create an additional window: Enable Layout Mode on the Edit or 
context menu. 

• Select New Window on the Window menu. 

• Click the Online Signal Plot icon on the toolbar. Add the signal plot to 
the window by clicking inside the window, and then determine the size 
of plot. Right-click the signal plot to open the Online Signal Plot 
Properties dialog box. Use this dialog box to determine the properties 
for the signal plot. 

• Right-click the background of the new window, i.e., right-click outside 
beside the signal plot. Select Properties on the context menu to open 
the Form Properties dialog box.  

• On the General tab page, enter a name, e.g., Signal. On the Style tab 
page, clear the Initially Visible check box. 

• Return to the original window by clicking the little cross on the top right 
of the new window.  

• Select the Script Button icon on the toolbar and add a new script 
button to the original window. Right-click the button and select 
Properties on the context menu. The Script Button Properties dialog 
box is opened. 

• The Button tab page indicates the names and captions of all windows 
assigned to this panel. Select the new window and select the Show 
Form check box. 
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After disabling Layout Mode, you can open the signal plot by clicking this 
button.  

 Displaying Sample and Sequence Information 
In addition to the current analysis and status values, information specific to 
sequences and/or samples can be displayed on a Control Panel. Thus, 
you can read from the control panel which sample is processed, to which 

Sequence and Datasource the sample belongs, which status the 
sample has, and so on. 

There are two ways to display this type of information: 

• Display individual properties for a sample or sequence by linking a 
Control (alphanumeric display) to one of the following functions 

(Object Properties): 
 

Comment Datasource Program 
Name Sequence ProgramMoniker 
Number SequencePath Moniker 
Type SequenceMoniker ID 
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• Display information about all sample injections in the current batch by 
adding a Sample List control to the control panel. 

For more information about controls, refer to the topics in How to …: 
 Controlling Devices from the Control Panel. 

 Using and/or Recording Demo Data 

Simulating Data Acquisition  
Demo (or Virtual) Mode lets you simulate data acquisition by loading a 

pre-recorded demo file and displaying the data from the demo file on the 
Control Panel's signal plot. The demo file is "read back" as though the 

data were being acquired in real time. 

1. To select Demo or Virtual Mode for a device, start the Server 
Configuration program and select a device in the corresponding 

Timebase.  

2. Select Properties on the Edit or context menu.  

3. For detectors that use demo mode, select Read under Demo Mode on 
the General tab page, and then select an existing demo file from the 
Demo File Name drop-down list.  

 For other detectors, select Virtual Mode on the General tab page. 
Then, select the Demo Chromatogram tab, select the Read demo 
chromatogram from: check box, and select a demo file from the drop-
down list. 

4. (Optional) Enable the Demo or Virtual Mode for all other devices of the 
timebase on the corresponding General tab pages. 

5. To run the demo file, open the control panel for the device, connect to 
the timebase, and then enable data acquisition. The Data Acquisition 
dialog box appears.  

6. If the demo file contains more than one channel, select the channel(s) 
and click OK. The demo file begins running. It runs continuously 
(repeats) until data acquisition is disabled. 
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Recording Demo Data  
1. To create a demo file for an installed detector, open the Properties 

dialog box in the Server Configuration. 

2. For detectors that use demo mode, select Write under Demo Mode on 
the General tab page.  

 For other detectors, select Live Mode on the General tab page. Then, 
select the Demo Chromatogram tab page and select the Write demo 
chromatogram to: check box. 

3. Enter a name for the demo file. If the device is connected via the Dionex 
DX-LAN, select the Device ID under Communication. 

4. To write the demo file, open the control panel for the device and enable 
data acquisition. The data acquired from the detector is recorded in the 
demo file.  

5. To stop recording data, disable data acquisition. The demo file is then 
complete. Alternatively, instead of starting and stopping data acquisition 
manually, you can run a PGM File that turns acquisition on and off. 

 Answering Frequently Asked Questions 
Question: Why does an error message appear in Chromeleon when I shut 
down a device? 

Answer: The Chromeleon server reports an error because the device is no 
longer connected. Stop the Chromeleon server. Right-click the 

Chromeleon Monitor icon and click Stop Server. 

 Note:   
Keep in mind that you have to restart the Chromeleon server before you 
can record another chromatogram. 
 
Question: How can I learn from a control panel which program is being sent 
to the device and which commands are being executed? 

Answer: The program used for analyzing the sample is displayed in the 
Audit Trail section on the control panel. Under the program, the times at 
which the different commands were executed by the device are listed. 
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Question: What is the function of the Inject command on the Control 
menu? Does it also start data acquisition? 

Answer: Only select this command to perform a manual injection. If you 
select the command while a program is running, the program will be 
interrupted. Data acquisition will not be started. To start data acquisition, 
select Acquisition On on the Control menu. 
 
Question: Several control panels are listed on the Window menu. How can 
I delete an entry? 

Answer: Select the control panel that is not used any longer. Close the 
panel by either clicking the left-most or right-most button on the top of the 
panel or by selecting Close on the File menu. If you have modified the 
panel, a dialog box appears in which you can confirm to save the 
modifications. 
 
For tips to solve similar questions, also refer to How to …:  Controlling 
Devices from the Control Panel. 
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Controlling Devices from the Panel 
Tabset 

A panel tabset provides (on one window) a set of Control Panels for 
controlling and monitoring a timebase. If more than one timebase is 
connected to the chromatography Server, the window provides a panel 
tabset for each timebase. For general information, refer to Control  The 
Panel Tabset. 
Chromeleon provides a default panel tabset, which you can use as is, or 
modify to suit your needs. You can also create new panel tabsets. 

For more information, refer to: 

 Opening a Default or Saved Panel Tabset 
 Modifying a Panel Tabset 
 Creating a New Panel Tabset 
 Expanding, Splitting, or Resizing a Panel Tabset 
 Using the Sequence Control Panel 

 
 Opening a Default or Saved Panel Tabset 

To open a default panel tabset: 

1. Select Default Panel Tabset from the View menu or click the  icon 
on the standard toolbar. The Connect to Chromeleon Server dialog 
box opens. 

2. Select the chromatography Server on which the timebase you want to 
control is configured and click OK. The panel tabset opens.  

 The panel tabset consists of a set of default Control Panels, organized 
on tab pages. The timebase is automatically connected to the panels. If 
there are multiple timebases connected to the selected server, the 
window displays a panel tabset for each timebase.  



310 Controlling Devices from the Panel Tabset 

 Tip: 
The number and type of control panels included in a default panel tabset 
depend on the timebase configuration. After opening the default tabset, you 
can add or delete panels. 

To open a saved panel tabset: 
1. Select Open on the File menu. 

2. In the Open dialog box, select Panel Tabset from the Object of type 
drop-down list. 

3. Navigate to the folder that contains the panel tabset. Click the name in 
the list and click Open. 

 Tip: 
You can also select a panel tabset directly from the Browser. Double-click 
the name (*.PTS) to open the panel tabset. 

For more information, refer to: 

Control:  The Panel Tabset 
 Modifying a Panel Tabset 
 Creating a New Panel Tabset 
 Expanding, Splitting, or Resizing a Panel Tabset 
 Using the Sequence Control Panel 

 
 Modifying a Panel Tabset 

After opening a panel tabset, you can customize it to suit your needs. You 
can: 
• Add panels 

• Delete panels  

• Edit panel tab labels 

After modifying a panel tabset, select Save from the File menu to save it 
under the same name, or Save As to save it under a different name and 
keep the original unchanged. 
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 Tip: 
To change the controls found on individual control panels on a panel 
tabset, open the control panel file (*.PAN) directly from the Browser (see 
How to …:  Modifying a Control Panel).  

To add a panel: 
1. Click the panel tabset. Its border changes to bold, indicating it is active. 

2. Select Add Panel on the Edit or context menu. 

3. In the Browse dialog box, navigate to the folder that contains the control 
panel to be added. 

4. Click the panel name and click Open. Chromeleon automatically 
connects the new panel to the timebase.  

To delete a panel: 
1. Select the tab for the panel to be deleted.  

2. Select Remove Current Panel on the Edit or context menu. 

To edit tab text: 
1. Click the tab to be edited. 

2. Select Edit Panel Tab Text on the Edit or context menu. 

3. Type the new tab label. After 16 characters are displayed on the tab, 
ellipses are used to represent any additional text. 

For more information, refer to: 

Control:  The Panel Tabset 
 Opening a Panel Tabset 
 Creating a New Panel Tabset 
 Expanding, Splitting, or Resizing a Panel Tabset 
 Using the Sequence Control Panel 
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 Creating a New Panel Tabset 
1. In the Browser, select New on the File menu. 

2. Select Panel Tabset and click OK. The Connect to Chromeleon 
Server dialog box opens. 

3. Select the chromatography Server to which the timebase(s) that you 
want to control are connected and click OK. An empty panel tabset 
opens. 

4. The window is divided into panes (one for each timebase). On each 
pane there are two choices for adding Control Panels: 

 Add Panel: Click this option to choose a panel from a Browse dialog 
box. After adding the first panel, you can add additional panels by 
selecting Add Panel from the Edit or context menu. 

 Add Default Panels: Click this option to have Chromeleon add a set of 
default control panels. The control panels added for each timebase 
depend on its configuration. Typically, there is a panel for each 
instrument (pump, detector, autosampler, etc.), a panel for sequence 
control functions (creating programs and sequences, loading 
sequences, starting and stopping a batch, etc.), and a "home" panel that 
provides basic control functions and status for the system.  

5. Select Save from the File menu to save the panel tabset. Panel tabsets 
are saved as PTS (*.pts) files. 

For more information, refer to: 

Control:  The Panel Tabset 
 Opening a Panel Tabset 
 Modifying a Panel Tabset 
 Expanding, Splitting, or Resizing a Panel Tabset 
 Using the Sequence Control Panel 



 Controlling Devices from the Panel Tabset 313 

 Expanding, Splitting, or Resizing a Panel Tabset 
If a panel tabset window contains multiple timebases, you can switch 
between two display options: 

• Click  to expand the selected panel tabset and hide the other panel 
tabsets. 

• Click  to view panel tabsets for each timebase simultaneously (split-
window view).  

In the split-window view, you can also change the width of the panels.  

To do this, point to the vertical bar between two panels and drag left or 
right. Increasing the width of one panel decreases the widths of the other 
panels.  

For example, the panel tabset window below is comprised of two panel 
tabsets. 
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Drag the vertical bar to the left to increase the width of the ICS-3000 panel 
tabset. 

  

To return to the default split-window view, click . 

For more information, refer to: 

Control:  The Panel Tabset 
 Opening a Panel Tabset 
 Modifying a Panel Tabset 
 Creating a New Panel Tabset 
 Using the Sequence Control Panel 
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 Using the Sequence Control Panel 
Each default panel tabset includes a Sequence Control panel that 
provides a central location from which you can develop applications, run 
samples, view sample status, and record system maintenance events. 

Developing an Application 
Two approaches are available: 
• Use the Program and Sequence Wizards. Click Create Program under 

1. Create Application. The Program Wizard opens and guides you 
through creating and saving a program. After creating the program, 
click Create Sequence. The Sequence Wizard opens and guides you 
through creating and saving a sequence.  

• Alternatively, use the Application Wizard. Click Application Wizard 
under 2. Prepare System. The wizard guides you through creating a 
program, quantification method, and sequence. 

Running Samples Manually 
After injecting the sample, click Acq On under 2. Prepare System to start 
data acquisition and Acq Off to stop acquisition. 

Running Samples Automatically 
1. Click Load Sequence under 2. Prepare System. Select the sequence 

to be run and click Open. 
• If the system is idle (not currently running a Batch), the injections 

in the selected sequence are displayed in the Sequence list. If a 
sequence is already loaded you can append the new sequence to 
the list or clear the list first. 

• If the system is running when you load a sequence, the new 
sequence is automatically appended to the existing list. 

2. After loading the sequence, you can edit Sample Variables in the 
Sequence list if desired. 

3. To run the samples, click Start Batch. 

4.  To hold, continue, or abort the batch, click the corresponding button 
under 3. Execute Application. 
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Viewing the Daily Audit Trail 
To view an audit trail for a previous day, click Daily Audit Trail under 
System Maintenance. The View Daily Audit Trail window opens. Select a 
date and click View to see the audit trail for that day.  

 Tip: 
Point to the audit trail pane and right click to open the context menu. The 
menu includes commands for filtering the audit trail, and for selecting, 
copying, and searching entries. Refer to  Audit Trails for additional 
information. 

Recording Consumable and Eluent Changes 
After changing a consumable (for example, a column) or changing eluent, 
click the corresponding button under System Maintenance. The change is 
recorded in the audit trail.  

 Tip: 
In Trend Plots the recorded consumable and eluent changes show up as 
events. This allows a change in a parameter, such as signal background, to 
be correlated directly against a consumable or eluent change. 

For more information, refer to: 

Control:  The Panel Tabset 
 Opening a Default or Saved Panel Tabset 
 Modifying a Panel Tabset 
 Creating a New Panel Tabset 
 Expanding, Splitting, or Resizing a Panel Tabset 
 Using the Sequence Control Panel 
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Creating and Modifying Programs 
A Program is used to define precisely timed start conditions and 
⇒Control Commands. You usually create the program using the 

 Program Wizard and edit the program later in the PGM Editor (see 
Control  The PGM Editor). The minimum entries required for an 
operable program are as follows: 

• Signals to be recorded and their parameters 

• ⇒Flow rate and solvent composition  
(⇒%B, %C, %D - for controlled pumps, only) 

• ⇒Inject command  

• Start of data acquisition (⇒AcqOn) 

• End of data acquisition (AcqOff) 

• End of the program (⇒End) 

Verify that all relevant parameters are defined in the program. For 
parameters that are not explicitly defined, Chromeleon uses the settings of 
the last sequence. 

Dionex recommends creating the program automatically first (see 
 Automatically Creating a Program), and then edit the file either via 

the PGM Editor (see  Editing PGM Files in the Device Views of the 
PGM Editor) or manually (see  Manually Editing a PGM File in the 
Commands View). 

With respect to GLP (Good Laboratory Praxis), Dionex recommends 
adding comments about all chromatographic settings (e.g., for the column, 
detector, pump, and the sample components) as well as explanatory notes 
at the beginning of the program. However, this is possible only in the 
Commands view. 

To see the structure of a simple program, refer to How to …: Creating and 
Modifying Programs   Program Example. 
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 Automatically Creating a Program 
Create the basic structure of a Program using the Program Wizard. (For 
general information about the wizard, refer to Control  The Program 
Wizard.) 
• Select New on the File menu, and then select Program File from the 

list box. The Program Wizard guides you through program creation. 

• Enter the required information in the input fields on the corresponding 
wizard pages. Clicking Next> takes you to the next wizard page. 

• If you need help, press the F1 key.  

When input is complete, click Finish. Based on your entries, Chromeleon 
creates an operable program. You are not required to pay attention to the 
syntax or other programming details.  

The Program Wizard is a basic operating element in Chromeleon. 
Therefore, refer to the Tutorial  Program Wizard for basic information 
about the wizard. For information about special applications, refer to: 

 Defining Tandem Gradients (Summit x2) 

 Setting the Bypass Mode Options (ASI-100) 
 
You can modify and/or extend the basic program later as described in 

 Editing PGM Files in the Device Views of the PGM Editor. 
For a simple program example, refer to How to …: Creating and 
Modifying Programs  Program Example. 

For examples for special programs, refer to How to …: Creating and 
Modifying Programs 

 Creating an Emergency Program  

 Creating a Power Failure Program 
For an overview of the numerous programming capabilities, refer to Device 
Control  Practical Tips for Device Control (Overview). 
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 Defining Tandem Gradients (Summit x2) 
The Summit x2 Dual-Gradient HPLC System features Tandem 
Operation. Running the system with a dual-gradient pump, a second 
column, and a column switching valve allows increasing the sample 
throughput considerably, typically by 50 to 100%. This is achieved by using 
the reequilibration time of the first column after a sample run for analyzing 
the next sample on the second column. 

The Program Wizard (see The Control Program  The Program 
Wizard) supports tandem operation only for the Summit x2 Dual-Gradient 
HPLC System. On the Wizard Options page, select Program for Summit 
x2 Tandem Operation and create the program on the next wizard pages. 

On the Tandem Gradient Options page, determine the (virtual) profile 
assuming that only one pump is installed. The picture graphically 
represents this virtual profile.  

 



320 Creating and Modifying Programs 

Determining the start for off-line reconditioning 
To determine the start for off-line reconditioning, enter a time value in the 
Off-line Reconditioning Start Time input field.  

 Note:   

Starting off-line reconditioning does not mean that the column switching 
valve immediately switches to the other column. Before the valve can 
switch, the solvent lines between the pump and the column switching valve 
have to be purged. This ensures that only solvent of the starting 
composition is transported to the second column. In this way, the second 
column is optimally conditioned when the next sample is injected. 

Set the start of the off-line reconditioning to a retention time at which all 
peaks eluted from the column. Or else, draw the red line in the graphical 
representation to the desired gradient position. In the graphical 
representation, you can draw the line only to certain values, e.g., the basic 
points of the gradient. In the input field, you can enter the time with three 
places after the decimal point. 

The pictures on the Tandem Operation Options page graphically 
represent the gradients actually delivered by the two pumps. 
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 Tip: 
It may happen that the virtual gradient on the Tandem Gradient Options 
page seems to be shorter than the actual gradients on the Tandem 
Operation Options page. The reason is that the times for purging the void 
volume are not considered for the virtual gradient. 

The (virtual) gradient (defined in the table) is delivered by the analytical 
pump until off-line reconditioning starts. Then, the analytical pump washes 
the solvent lines between the pump and the column switching valve. The 
column switching valve can switch to the other column only after solvent 
line washing is finished. Afterward, the reconditioning pump delivers the 
remaining (virtual) gradient that has not yet been delivered by the analytical 
pump. 

For a program example, refer to  Tandem Program (including Bypass 
Mode). 

 Setting the Bypass Mode Options (ASI-100) 
The ASI-100 autosampler features the bypass mode that allows reducing 
the cycle time for short chromatograms. The Program Wizard (see The 
Control Program  The Program Wizard) supports the bypass mode 
only for the Summit x2 Dual-Gradient HPLC System.  

When the bypass mode is enabled, the chromatographic flow bypasses the 
loop of the ASI-100 autosampler. In this way, you can condition the solvent 
line(s) between the injection needle and the motorized switching valve 
(MSV), as well as the sample loop before loading the next sample. 

 Tip:  
Make sure that the system runs under isocratic conditions until switching to 
the bypass mode. 

To avoid carry-over, bypass the sample loop only after the entire sample 
has left the sample loop. To ensure this, purge the loop volume and the 
void volume between the injection needle and the MSV a minimum of 5 
times. 
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The bypass time is calculated as follows: 

Time = FlushFactor * (Max. Inj. Vol. + void vol. between injection needle  
                                   and MSV) / Flow 

The void volume between the injection needle and the MSV is 20 µl. Set all 
other parameters in the Program Wizard. On the Wizard Options page, 
select Program for Summit x2 Tandem Operation and create the 
program on the next wizard pages. To enable the Bypass Mode, select the 
related check box on the Tandem Operation Options page: 

 

Make the following settings: 
 
Max Inj. Vol. Enter the maximum injection volume for the application. 
  
Flow Enter the flow to be delivered by the analytical pump until the bypass time. 

 Tip:  

Dionex recommends using the flow specified for the analysis. (This is the 
default setting.) If you enter a different flow, the pump will deliver this flow until 
reaching the bypass time instead of delivering the flow specified for the 
analysis. 
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Flush Factor Enter a factor for calculating the purge volume. 

 Tip: 

Dionex recommends using a factor of = 5. (Any factor between 1 and 120 is 
allowed.)   

Time Usually, the time is calculated from the above settings: 
Time = FlushFactor * 
            (Max. Inj. Vol. + void volume between needle and MSV) /  Flow 

Enter a time if you want to limit the time until bypass mode is enabled. In this 
case, the flow is recalculated as follows: 
Flow = FlushFactor *  
            (Max Inj. Vol. + void vol. between injection needle and MSV) / Time.  

At the bypass time, the MsvToLoad command is added to the program file. 
The chromatographic flow bypasses the sample loop of the ASI-100. This 
allows conditioning the void volume section between the injection needle 
and the motorized switching valve, as well as the sample loop, before 
loading the next sample.  

 Tip:  

In addition, enter the PrepareNextSample command about 1 minute 
before injection of the next sample to load this sample into the loop and 
inject it immediately after column valve switching. 

For a program example, refer to  Tandem Program (including Bypass 
Mode). 

 Editing PGM Files in the Device Views of the PGM Editor  
The different device views in the PGM Editor offer a user-friendly way to 
edit an existing program at any time according to your requirements. (For 
general information about the PGM Editor, refer to Control  The PGM 
Editor.) 
• Click a device icon on the left pane in the PGM Editor to change the 

parameters and/or to enter new parameters for the associated device. 

• The associated page(s) of the  Program Wizard are opened. 

• Enter the desired parameters or changes. 
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• If you want to change and/or enter parameters for other devices, click 
the respective icon and follow the description above. 

The wizard pages or the PGM Editor provide only the most important 
commands for the devices. The Commands view allows you to enter 
additional commands manually (see  Manually Editing a PGM File in 
the Commands View). 

 Note:  

If your program already contains many comments, it may make sense to 
edit the PGM File in the Commands view and not in the Device Views. If 
you edit such a program in the Device Views, it may happen in some 
configurations that the single commands appear at the "wrong" position. 
Please note that comments that were entered at the end of a line are 
removed. Therefore, please check the program before saving the changes. 

 Manually Editing a PGM File in the Commands View  
If you want to modify and save an existing Program, follow the steps 
below. (For information about how to create a new program, refer to 

 Automatically Creating a Program. Modify the program in the 
corresponding device view as described in  Editing PGM Files in the 
Device Views of the PGM Editor.) 
General Information 
• Select Open… on the File menu, and then select an existing PGM File 

from the Open dialog box.  

• Verify that the server is running. If the server is not yet running, start 
the server in the Server Monitor Program.  

• Select Connect to Timebase on the Control menu, and then select 
the timebase in which you want to use the modified PGM File.  

• To open the Commands view, click the following icon on the icon bar: 

 

• Place the cursor on the position you wish to modify or press the Enter 
key to insert a new program line.  
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Entering commands or properties 
• Press the F8 key to open the Commands dialog box. 

• Select the instrument (below called Device) for which you want to edit 
an instruction. A device can be any instrument of a timebase, an 
installed channel, a relay, a remote input, or the system itself. Devices 
are marked by the following icon . Click the "+" character beside 
the device name to display the items underneath. 

• Each device has its own commands ( ) and/or properties ( , , 
, ).  

• When you select a command or a property, additional input boxes 
appear under the Retention Time input box. A short help text is 
displayed in the Help section. 

• Enter the retention time when the command shall be executed or when 
the status of a property shall be changed.  

• Assign either the required value (e.g., a number) or a new status (e.g., 
On) to the command or property. 

• Click OK to complete the input. Click OK & Prev or click OK & Next to 
change to the previous or to the next program line.  

• Repeat the input procedure until you have changed all commands 
and/or properties of interest. 

Adding command/property values to the audit trail 

• Press the F8 key to open the Commands dialog box. 

• Select the ⇒Log command from the commands list. The devices listed 
in the left window are displayed a second time, in the Property box on 
the right. The structure in which the devices are displayed is the same 
as described above. The Property box provides the commands and 
properties from the left window and in addition several read-only 
variables. 

• Select the command or the property for which you want to write the 
value at the time specified in the Retention Time field to the Audit Trail. 
The Help section provides a short description of the selected command 
or property. 

• Click OK to enter the selected Log command into the program. 
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Adding comments to the audit trail 

• Press the F8 key to open the Commands dialog box. 

• Select the ⇒Protocol command from the commands list. Enter the 
desired comment into the Text input box that appears on the right. 

• Click OK to enter the Protocol command into the program. 

Checks during command input 
• When you enter commands, Chromeleon performs different checks 

(see Check Command): 

Syntax check: Does the entry correspond to the formal rules of the 
program language?  

Semantics check: Does the program make sense with regard to 
chromatography? 

• If an error is detected, the corresponding line is displayed in red color. 
Check and correct the entry. If necessary, repeat this procedure, using 
the F8 box. 

Adding comments 
To enter a comment, place the cursor at desired position. Type the desired 
the text, starting with a semicolon. Or else, press the F8 key to open the 
Commands dialog box and enter the desired comment in Comment field. 
Click OK to add the comment to the program.  

Comments are displayed in green color, indicating that Chromeleon 
considers the text as a comment. Any comment entered in this way does 
not appear in the audit trail. It only serves to comment the program so that 
you can, for example, easily recall and understand the various steps later.  

 Note:  
If you want to edit your program later in the Device views (see Control/The 
PGM Editor  The Device Views), Dionex recommends entering all 
comments right at the beginning of the program. In some cases, 
Chromeleon cannot assign comments to the associated commands when 
re-sorting. Thus, it may happen that some comments appear at the wrong 
position after you have edited the program in the Device views. 

For information about how to perform calculations in a program, refer to 
 Calculating in a Program. 
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Save the result as a new PGM File, using the Save as command.  

 Note:  
Experienced users can enter these commands directly, that is, without 
opening the F8 box. However, this requires profound knowledge of the 
program syntax (see Control  The Program Syntax). 
 

 Tip:  
Try to avoid editing programs for Tandem Operation. If editing is 
necessary, keep in mind that you have the make the corresponding 
changes also for the other pump. Any inconsistencies that might occur are 
displayed on the Consistency Check page. (When Chromeleon detects 
inconsistencies, this page opens automatically when you exit the PGM 
Editor and specify that you want to solve the problem(s). As an alternative, 
you may open this open by clicking the x2 Tandem Operation icon.) 

For a simple program example, refer to  Program Example.  

For special program examples, refer to How to …: Creating and 
Modifying Programs: 

 Creating an Equilibration Program 

 Creating a Shutdown Program 

 Creating an Emergency Program  

 Creating a Power Failure Program 

For program examples for special applications, refer to How to …: 
Creating and Modifying Programs  

 Creating a Tandem Program (including Bypass Mode) 

 Using User-defined Columns in a Program 

For an overview of the numerous programming capabilities, refer to Device 
Control  Practical Tips for Device Control (Overview). 
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 Calculating in a Program 
To use different values and signals in one program, Chromeleon lets you 
use the four fundamental operations of arithmetic and powers. See below 
for some examples:  

Addition or Subtraction: Relative Sample Position 
The two examples below refer to the ASI-100 autosampler. (For general 
information about this autosampler, refer to Hardware Installation  ASI-
100 HPLC Autosampler Series in the Administrator Help section.) 

1. To determine that the vial that is five incremented positions away from 
the current position is always used as the sample preparation vial, use the 
following command line: 
0.000 Sampler.PrepVial Position + 5 

For example, if you are currently processing the sample from position RB3, 
the vial at position RB8 is used for sample preparation. 

2. If the autosampler is currently at a position in the RA ring, the following 
line takes you to the corresponding position in the RB ring: 
0.000 Position Position + RB1 - RA1 

Multiplication: Calculating the Volume 
3. To record the solvent volume, which is transported through the column 
while the current sample is processed, as a virtual channel use the 
following line:  
 VirtualChannel_01.Formula Formula=pump.flow*system.retention 

In addition, you have to define: VirtualChannel_01.FormulaMin and 
VirtualChannel_01.FormulaMax. 

 Tip:  
Always set FormulaMin and FormulaMax after you have defined the 
formula. 

Division: Ratio 
4. To determine the ratio of two channels, record the quotient of the two 
channels as virtual channel: 
 VirtualChannel_01.Formula Formula=UV_VIS_1/UV_VIS_2 
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Powers: Calculating the radioactive decay  
5. Use the following formula to record a channel for a radioactive substance 
as if this substance would not decay: 

VirtualChannel_01.Formula  UV_VIS_1 / 2.718** 
 (-

0.69314718*System.Retention/t½) 
 

 Note:  
For detailed examples of the Virtual Channel Driver, refer to Practical 
Tips for Device Control Special Commands, Relays and Others 

 Program Examples for Virtual Channels.  
 

Relational and logical operators: Trigger Commands 
6. Use the following condition to combine, for example, fraction collection: 

Trigger FRACTION UV_VIS_1 OR UV_VIS_2 > 100 

In the above example, fraction collection could start if a signal with a peak 
area larger than 100 mAU is recorded on either the UV_VIS_1 or the 
UV_VIS_2 channel. 

The following operators are available for trigger commands: 
 
Operator Description 
> Greater than 
< Less than 
= Equals 
AND All parameters must fulfill a condition. 
OR Only one parameter must fulfill a condition. 
NOT Verifies that a parameter has no specified value. 
XOR (=^) Verifies that the values are different. 
 
Dionex recommends using the Fraction Collection device driver to control 
fraction collection. For more information, refer to How to …:  Collecting 
Fractions. 
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 Program Example 
A Program for a 20-minute chromatogram (flow rate: 1 ml/min, 
components: A (60%) and B (40%), signals: UV_VIS_1 (256 nm), 
UV_VIS_2 (300 nm), and 3D field: recorded in the 200 to 360 nm range at 
a step of 0.5 seconds) could have the following appearance: 
 
-10.000 Lamp=On 

 Pressure.LowerLimit =  5 
 Pressure.UpperLimit =  250 
 %A.Equate =  "%A" 
 %B.Equate =  "%B" 
 %C.Equate =  "%C" 
 
 3DFIELD.MaxWavelength =  360.0 
 3DFIELD.MinWavelength =  200.0 
 3DFIELD.BunchWidth =  1.9 
 3DFIELD.Step =  0.5 
 3DFIELD.RefWavelength =  600.0 
 3DFIELD.RefBandwidth =  1.9 
 
 UV_VIS_1.Wavelength =  256 
 UV_VIS_1.Bandwidth =  1 
 UV_VIS_1.Step =  2 
 UV_VIS_1.Average =  On 
 UV_VIS_1.RefWavelength =  600 
 UV_VIS_1.RefBandwidth =  1 
 
 UV_VIS_2.Wavelength =  300 
 UV_VIS_2.Bandwidth =  1 
 UV_VIS_2.Step =  2 
 UV_VIS_2.Average =  On 
 UV_VIS_2.RefWavelength =  600 
 UV_VIS_2.RefBandwidth =  1 
 
 Flow = 1.000 
 %B = 60 
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 0.000 UV.Autozero 
 Inject 
 3DFIELD.AcqOn 
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
  
20.000 3DFIELD.AcqOff 
 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
  
 End 
 

 Notes: 
• A program for processing a sample batch must contain the ⇒Inject, 

⇒AcqOn/Off, and ⇒End commands. 

• It is possible but it is not necessary to include the commands for 
controlling the pump and the detector. Instead of entering the ⇒Flow 
rate, eluent composition (⇒%B, %C, %D), and signal parameters 
directly on the instruments, you can set these values in the program, as 
shown in the example. This is only possible for controllable 
chromatography instruments connected to Chromeleon via an RS-232 
interface. 

• By definition, the injection time is t = 0.000. For all commands that are 
to be executed before the injection time, the time entry is t < =0.000; for 
example, the detector lamp on command, here -10.000 min. 

• You can omit the ⇒Lamp=On command if you allow sufficient time for 
the lamp to reach the operating temperature.  

• Any PDA-100 Photodiode Detector command that triggers an Autozero 
or Auto Offset command must be followed by either a Wait_AZ 
command or a delay of at least 30 seconds until the next command. 
The following commands trigger Autozero or Auto Offset: UV Lamp, 
Visible Lamp, Wavelength, Bandwidth, RefWavelength, RefBandwidth, 
Reference Mode, Rise Time, MinWavelength, and MaxWavelength. 
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• For commands that are not listed but are automatically considered, 
such as, the ⇒Step parameters of the UV_VIS_1 channel, either the 
default values or the values that were last used are used; for example, 
Step = 0.25. The decision which value is considered depends on the 
respective device driver. 

• In your programs, keep in mind that the instruments need a certain time 
to execute the different processes. If you use an HP autosampler, for 
example, the program files must be at least 2 min long to allow the 

Autosampler sufficient time until the next injection. 

For special program examples, refer to How to …: Creating and 
Modifying Programs: 

 Creating an Equilibration Program 

 Creating a Shutdown Program 

 Creating an Emergency Program 

 Creating a Power Failure Program 

 Creating a Tandem Program (including Bypass Mode) 

 Program with Variable Run Time 

 Creating an Equilibration Program 
An equilibration program of a Summit HPLC System (consisting of a 
P680A LPG, ASI-100 with temperature control, TCC-100 with motorized 
switching valve (MSV), and UVD 340U) could look as follows: 
-12.800 %B = 0.0 [%] 
 %C = 0.0 [%] 
 %D = 0.0 [%] 
 Pressure.LowerLimit = 0 [bar] 
 Pressure.UpperLimit = 400 [bar] 
 Pump_Pressure.Ripple.UpperLimit = 3.0 [%] 
 RearSealLeakLimit = 5 
 MsvPosition = A 
 ActiveColumn = Column_A 
 
 MaximumFlowRamp = 10000.00 [ml/min²] 
 Flow = 0.000 [ml/min] 
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Message "Please carefully observe the following 
instructions. Please note that disregarding the 
instructions might cause erroneous results or 
damage parts of your system." 
Message "Open the purge valve screw(s)." 
Message "CHECK!!! Make sure that the purge 
valve screw(s) is(are) open!!!" 
 Flow = 0.000 [ml/min] 

 
-12.700 Flow = 5.000 [ml/min] 
Message "Wait at least 5 minutes while the pump purges 

with a flow of 5.000 ml/min before clicking the 
'OK' button; take care that no air bubbles 
occur in the corresponding channel(s)." 

 
-12.600 Flow = 5.000 [ml/min] 
 
-12.500 Flow = 0.000 [ml/min] 

Message "Close the purge valve screw(s)." 
 
WashSpeed = 10.00 [µl/s] 
DispSpeed = 10.00 [µl/s] 
Message "Verify that you have placed the 4 mL 
vials in the correct positions: Solvent 
position: R99, eluent position: B99. Make sure 
to fill the vials only to half the vial 
height." 
WashVial = R99 
PrimeSyringe 
Wait Sampler.Ready 
WashVial = B99 
PrimeSyringe 
Wait Sampler.Ready 
MsvToInject 
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-12.000 Flow = 0.000 [ml/min] 
 
-11.000 Flow = 1.000 [ml/min] 
 Pressure.LowerLimit = 0 [bar] 
 Pressure.UpperLimit = 400 [bar] 
 
 Lamp =  On 
 
-9.000 Sampler.TempCtrl = On 
 Sampler.Temperature.Nominal = 20[°C] 
 Sampler.Temperature.LowerLimit = 4[°C] 
 Sampler.Temperature.UpperLimit = 45[°C] 
 ColumnOven.TempCtrl = On 
 ColumnOven.Temperature.Nominal = 18.0[°C] 
 ColumnOven.Temperature.LowerLimit = 5.0°C] 
 ColumnOven.Temperature.UpperLimit = 85.0 °C] 
 ReadyTempDelta =  1.0 [°C] 
 
-7.000 %B = 0.0 [%] 
 %C = 0.0 [%] 
 %D = 0.0 [%] 
 
-6.500 %B = 80.0 [%] 
 %C = 0.0 [%] 
 %D = 0.0 [%] 
 
-1.500 %B = 80.0 [%] 
 %C = 0.0 [%] 
 %D = 0.0 [%] 
 
-1.000 %B = 0.0 [%] 
 %C = 0.0 [%] 
 %D = 0.0 [%] 
 
 UV.Disconnect 
 Delay 10.0 
 UV.Connect 
 
 3DFIELD.Step = 0.5 [s] 
 UV_VIS_1.Wavelength = 225 [nm] 
 UV_VIS_1.Bandwidth = 1 [nm] 
 UV_VIS_1.RefWavelength = 600 [nm] 
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 UV_VIS_1.RefBandwidth = 1 [nm] 
 UV_VIS_1.Step = Auto 
 UV_VIS_1.Average = On 
 UV_VIS_1.Noise.UpperLimit = 0.10 [mAU] 
 UV_VIS_1.Drift.UpperLimit = 3.0 [mAU/hours] 
 MinLampIntensity = 250000 [counts/s] 
 
 0.000 UV.Autozero 
 
 Inject 
 
 Pump_Pressure.AcqOn 
 ColumnOven_Temp.AcqOn 
 UV_VIS_1.AcqOn 
 
 Pump_Pressure.StartEquilibration 
 UV_VIS_1.StartEquilibration 
 
Wait Pump_Pressure.Equilibration AND 15 <= 

Sampler.Temperature.Value AND 
Sampler.Temperature.Value <= 25 AND 
ColumnOven.Ready AND UV_VIS_1.Equilibration AND 
LampIntensity >= 250000, Continue, Timeout = 
45.000 

 
 Pump_Pressure.AcqOff 
 ColumnOven_Temp.AcqOff 
 UV_VIS_1.AcqOff 
 
 Message "The system was equilibrated 

successfully." 
 End 
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 Creating a Shutdown Program 
When creating a shutdown program, keep the following aspects in mind: 
• Reduce the flow to make sure that as little solvent as possible is used. 

However, do not reduce the flow to zero because this may result in 
crystallization of salts in ion chromatography, for example. 

• Therefore, set the lower pressure limit (Pressure.LowerLimit) to 1. This 
setting avoids that the pressure falls below the lower pressure limit 
when the flow is reduced and that the pump is shut down. 

• In addition, the detector lamp(s) should be turned off. 

 Tip:  
Dionex does not recommend performing data acquisition in the shutdown 
program, i.e., do not use an AcqOn command.  

An example program could look as follows:  
 

Pressure.LowerLimit = 1 
Pressure.UpperLimit = 350 

 
0.000 Flow = 0.500 
 
0.500 UV_Lamp = Off 

Flow = 0.100 
End 

 

Also, refer to: 

 Creating an Emergency Program 

 Creating a Power Failure Program 
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 Creating an Emergency Program 
If a Batch was automatically aborted due to a severe or serious error, an 

Emergency Program can be started. Determine which Program is 
executed by default. 

Select Error Handling… on the Batch menu to open the Batch - 
<Timebase> dialog box. On the Error Handling tab page, click Browse in 
the Emergency Program section and navigate to the desired emergency 
program. 

 

Example 1: 
Failure of the detector lamp is a severe error because data acquisition is no 
longer possible. However, it is not necessary to stop the flow immediately. 
Instead, the column should be reconditioned after the batch is aborted. You 
may use, for example, the following emergency program: 
 
; Program: Emergency.PGM 

Recondition column after abort. 
0.000 Flow = 1 
 %A.Value = 0 
 %B.Value = 100 
 %C.Value = 0 
10.000 Flow = 1 
10.500 End  
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Example 2: 
Power failure of an Autosampler is a serious error. In this case, the entire 
system should be stopped immediately to prevent more damage. The 
Abort.PGM emergency program stops the pump flow and turns off the 
detector lamp.  
 
; Program: Abort.PGM 

The detector lamp and the pump flow are turned off. 
0.000 Flow = 0 
 Lamp = Off 
0.500 End  
 
For a program example for the 1100 HPLC System, refer to Hardware 
Installation  Agilent 1100 HPLC System: Program Tips in the 
Administrator Help section. 

Also, refer to: 

 Creating a Shutdown Program 

 Creating a Power Failure Program 

 Creating a Power Failure Program 
You can determine how Chromeleon continues operation after a power 
failure (see Power Failure Protection). After booting the server, you may 
run a power failure program first. 

Select Error Handling… on the Batch menu to open the Batch 
<Timebase> dialog box. On the Error Handling tab page, click the 
Browse button in the Power Failure Handling section and navigate to the 
desired power failure program. 

If a power failure program is not yet available, create a program for the 
timebase on which you want to use it. Make sure that all instruments are 
reconnected to Chromeleon first. Very often self-tests have to be performed 
during which the devices are not ready for access. Therefore, issue the 
⇒Connect commands 1-2 minutes before the first ⇒Control Commands 
are sent to the instruments. 
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Example: 
Use the following program example, for example, for a Timebase that 
contains an ASI-100 Autosampler, a UVD 340U Photodiode Array 
Detector, and a P580 pump: 
 
-2.000 UV.Connect 
 Sampler.Connect 
 Pump.Connect 
-1.500 Lamp = On 
 
; After the UVD 340U has been turned on, the detector needs some time 
; for spectra; calibration. That is why you have to issue this  
; command, too, some minutes before data acquisition is started.  
 
 0.000 Flow = 0.300 
 
 1.000 Flow = 1.000 
 
 End 
 
Also, refer to: 

 Creating a Shutdown Program 

 Creating an Emergency Program 

 Program with Variable Run Time 
To be able to create a program with variable run time for method 
development, you need a generic device driver. This driver is not included 
on the Chromeleon software CD. However, you may use the example 
driver described in the Administrator Help section (see Hardware 
Installation: Special Drivers: The Generic Device Driver  Example), 
and then generate the following program for this driver: 
 
(…) 
 Flow = 1.000 
 %B = 60 
 
  0.000 UV.Autozero 
 Inject 
 3DFIELD.AcqOn 
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
 Stop_Device.Time = 15.000 
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 Trigger EndTime System.Retention>Stop_Device.Time 
 3DFIELD.AcqOff 
 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
 End 
 EndTrigger 
 
999.000 3DFIELD.AcqOff 
 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
  
 End 
 

The program ends when the time defined for the stop device (here: 15.000 
minutes) has been reached. You can change this time from the panel 
during the program run. If the Stop-Device.Time is not reached, the above 
program runs 999 minutes. 

To change the run time quickly, create, e.g., an edit field on the control 
panel, following the instructions in How to …: Controlling Devices from 
the Control Panel  Modifying a Control Panel. On the Link tab page, 
link the edit field to the Time object property of the Stop_Device. You can 
then use this edit field to set the run time to the desired value. 

In addition, to identify the edit field, create a Color box above the field: 

 

 Creating a Tandem Program (including Bypass Mode)  
A program for operating a Summit x2 Dual-Gradient HPLC System 
(consisting of a P680-DGP, ASI-100, TCC-100, UVD 340U) in Tandem 
Operation mode with enabled Bypass Mode could look as follows: 
 
 ColumnOven.TempCtrl =  On 

 ColumnOven.Temperature.Nominal =  18.0 [°C] 

 ColumnOven.Temperature.LowerLimit = 5.0 [°C] 

 ColumnOven.Temperature.UpperLimit = 85.0 [°C] 

 EquilibrationTime =  0.5 [min] 

 ReadyTempDelta =  1.0 [°C] 

 HumidityLeakSensor =  Standard 

 GasLeakSensor =  Standard 

 PumpLeft.Pressure.LowerLimit =  0 [bar] 
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 PumpLeft.Pressure.UpperLimit =  400 [bar] 

 PumpRight.Pressure.LowerLimit =  0 [bar] 

 PumpRight.Pressure.UpperLimit =  400 [bar] 

 PumpLeft.%A.Equate =  "%A" 

 PumpRight.%A.Equate =  "%A" 

 PumpLeft.%B.Equate =  "%B" 

 PumpRight.%B.Equate =  "%B" 

 PumpLeft.%C.Equate =  "%C" 

 PumpRight.%C.Equate =  "%C" 

 SyncWithPump =  On 

 PumpDevice =  "PumpLeft" 

; Determines that the left pump (PumpLeft) is the analytical pump and 
; thus that the right pump is the reconditioning pump. 

 DispSpeed =  10.00 [µl/s] 

 DrawSpeed =  10.00 [µl/s] 

 SampleHeight =  0.50 [mm] 

 SyringeDelay =  5 [s] 

 UpSpeed =  10.00 [mm/s] 

 DownSpeed =  10.00 [mm/s] 

 RadialSpeed =  20.00 [mm/s] 

 ColumnOven_Temp.Step =  Auto 

 ColumnOven_Temp.Average = On 
 
 0.000 PumpRight.Flow =  1.000 [ml/min] 

 PumpRight.%B =  20.0 [%] 

 PumpRight.%C =  10.0 [%] 

 PumpLeft.Flow =  1.000 [ml/min] 

 PumpLeft.%B =  10.0 [%] 

 PumpLeft.%C =  0.0 [%] 

 Wait ColumnOven.Ready and Sampler.Ready 

 Inject 

 ColumnOven_Temp.AcqOn 

 PumpRight.Flow =  1.000 [ml/min] 

 PumpRight.%B =  20.0 [%] 

 PumpRight.%C =  10.0 [%] 

 PumpLeft.Flow =  1.000 [ml/min] 

 PumpLeft.%B =  10.0 [%] 

 PumpLeft.%C =  0.0 [%] 
 
 0.050 PumpRight.Flow =  2.500 [ml/min] 

 PumpRight.%B =  60.0 [%] 

 PumpRight.%C =  20.0 [%] 



342 Creating and Modifying Programs 

 0.250 MsvToLoad 

; Sets that the chromatographic flow bypasses the sample loop  
; (= bypass mode). 
 
 1.000 PumpLeft.Flow =  1.000 [ml/min] 

 PumpLeft.%B =  10.0 [%] 

 PumpLeft.%C =  0.0 [%] 
 
 2.500 PumpRight.Flow =  2.500 [ml/min] 

 PumpRight.%B =  60.0 [%] 

 PumpRight.%C =  20.0 [%] 
 
 2.600 PumpRight.Flow =  1.000 [ml/min] 

 PumpRight.%B =  10.0 [%] 

 PumpRight.%C =  0.0 [%] 
 
 3.500 ColumnOven_Temp.AcqOff 

 PumpRight.Flow =  1.000 [ml/min] 

 PumpRight.%B =  10.0 [%] 

 PumpRight.%C =  0.0 [%] 

 PumpLeft.Flow =  1.000 [ml/min] 

 PumpLeft.%B =  20.0 [%] 

 PumpLeft.%C =  10.0 [%] 

 PumpLeft.Flow =  2.500 [ml/min] 

 PumpLeft.%B =  10.0 [%] 

 PumpLeft.%C =  0.0 [%] 
 PrepareNextSample 

; Loads the sample loop with the next sample. 
 
 4.500 PumpRight.Flow =  1.000 [ml/min] 

 PumpRight.%B =  10.0 [%] 

 PumpRight.%C =  0.0 [%] 

 PumpLeft.Flow =  2.500 [ml/min] 

 PumpLeft.%B =  10.0 [%] 

 PumpLeft.%C =  0.0 [%] 

 NextColumn 

; Switches the column switching valve to the next column. 

  

 End 
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 Converting Units 
Chromeleon allows you to convert the registered units. Use the following 
command, observing the correct syntax: 

<Parameter> = <Value> [<Unit>] 

 Tip:  
Chromeleon can only convert registered units, e.g., the pressure units bar, 
psi, and MPa. Conversion is case-sensitive, i.e., Bar is not registered, and 
thus, it would not be converted. 

Example 
If the pressure unit set on a GP50 pump is psi, you can nevertheless enter 
the pressure limits as follows: 
 Pressure.LowerLimit =  15 [bar] 
 Pressure.UpperLimit =  200 [bar] 
 
When the program is started, the pressure limits are converted into psi. 
Chromeleon automatically converts the values and communicates the 
following commands to the pump: 
 Pressure.LowerLimit =  218 [psi] 
 Pressure.UpperLimit =  2901 [psi] 
 
This feature is important for programs that run on different systems. Even if 
the pressure units are different for these systems, you can use the same 
PGM File without adapting the values. 

Chromeleon can convert the following units: 
 
Value Registered Units 
Absorption AU mAU µAU   
Charge C µC nC   
Conductivity S mS µS nS  
Current A mA µA nA pA 
Density kg/m³ g/ml    
Flow rate m³/s ml/min µl/min µl/s  
Flow acceleration m³/s² ml/min²    
Fraction None %    
Frequency Hz kHz MHz   
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Value Registered Units 
Inverse pressure 1/Pa 1/Mbar    
Inverse temperature 1/K %/K    
Length m mm µm nm Å 
Mass kg g amu   
Molar concentration mol/m³ mM    
Pressure Pa bar psi MPa kPa 
Refractive index RIU µRIU nRIU   
Refractive 
index/voltage 

RIU/V µRIU/V    

Refractive index/time RIU/s nRIU/h    
Temperature K °C °F   
Time s h min ms µs 
Velocity m/s mm/s    
Voltage V mV µV   
Volume m³ l ml µl  
 

 Note:  
Concentration units, such as mg/ml and µg/ml, are not available in a PGM 
File.  

 Using User-defined Columns in a Program 
You may include User-defined Columns from the sample list of the 
Browser in a program, e.g., for special applications. However, you can only 
use user-defined columns of the server's Standard Datasource for which 
the Value type is neither Time nor Date and time. 

 Caution: 
Only experienced users should include and program user-defined columns 
in a program. Errors in the control program may abort processing of the 
single program steps, and thus the control program. 

If you use user-defined columns in PGM files, verify that the column does 
not contain empty fields. Otherwise, it may happen that the program is not 
executed. 
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 Tip:  
You cannot use user-defined columns with a date or time format in PGM 
files.  

When user-defined columns are used in a program, the entry of the current 
sample is usually used. The syntax is as follows: 
 <Command> Sample.<UDC Name> 

 Tip:  
You can also use the values of the user-defined column of the next or 
previous sample (NextSample / PrevSample.<UDC-Name>) or of the 
previous standard (PrevStandard<UDC-Name>). The standard may not 
be required for the current sample. 

Example 1: Defining the wavelength 
In a control program, you can use user-defined columns, e.g., to define the 
wavelength of a certain channel separately in the sample list for each 
sample: 
• Create a user-defined column in the Standard Datasource of the 

server (see How to …: Creating and Managing Files and Data 
 Creating User-defined Columns). 

• Name the column, e.g., WL (for wavelength). To avoid confusion, do 
not use a property that is already available in Chromeleon. That is why 
you should not use, e.g., Wavelength. (Instead of WL, any other 
agreed-upon abbreviation is acceptable.) 
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 Tip: 
Do not use a German "Umlaut" or "ß" in the name.  

Restart the server. 
• In the program, enter, e.g., UV_VIS_1 for the channel:  
 
 UV_VIS_1.Wavelength = Sample.WL 
 
This entry means: For each sample, the wavelength used for the UV_VIS_1 
channel is the wavelength defined in the corresponding cell of the user-
defined column called WL. 

Example 2: Starting and stopping fraction collection 
You can use the Program Wizard to create user-defined columns to define 
the fraction collection start and the end. (For information about the wizard, 
refer to Control  The Program Wizard). For more information, refer to 
How to …: Collecting Fractions  PGM Wizard: Fraction Collection - 
General Options. 

Restrictions when using user-defined columns in a program 
You cannot use user-defined columns if the value that the parameter shall 
reach must be known in advance. This applies to all gradient commands, 
for example: 
• ⇒Flow 

• ⇒%B, %C, %D in % gradients 

• GC.Temperature in temperature gradients 

• Concentration 

• Pump.Curve and EluentGenerator.Curve (see Gradient Curves) 

 Note: 
Only if you issue these commands before you enter the retention time, you 
can determine the corresponding values using user-defined columns. 

For some instruments, the entire control program is downloaded before 
sample processing, e.g., for the 1100 HPLC System. In this case, you 
cannot make changes during the analysis. 
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Adding Post-Acquisition Steps 
Use the Post-acquisition steps view of the PGM Editor to define 
extraction and data smoothing steps to be performed after data acquisition. 
(For general information about the PGM Editor, refer to Control  The 
PGM Editor.) In addition, you can copy existing channels or combine them, 
using arithmetic operations. A new data channel is created for each of 
these steps. If a Purification license is installed on your PC, Chromeleon 
also supports automatic creation of samples for fractionation. The single 
data reprocessing steps are performed directly after either data acquisition 
on all channels is finished or the program is completely executed.  

To open the Post-acquisition steps view, click the following icon on the 
shortcut bar:  

 

Click the bottom line to add a new post-acquisition step. In the dialog box, 
select a step: 
• Arithmetic combination of channels (arithmetic combination of 2D 

channels - see  Combining Channels via Arithmetic Operations) 

• Copy Channel (see  Copying a Channel) 

• Create Fraction Analysis Samples (see How to …: Collecting 
Fractions Automatically (Autopurification)  Creating Fraction-
Type Samples) 

• Create Purification Samples (see How to …: Collecting Fractions 
Automatically (Autopurification)  Creating Preparation-Type 
Samples) 

 Tip: 
The Create Fraction Analysis Samples and Create Purification 
Samples options are visible only if a Purification license is installed and 
if a connection to the server exists. A connection exists if a PGM File is 
associated with a timebase, the server on which this timebase resides 
is running, and the client is connected to this server. 
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• Extract ED channel (for extracting an ED channel – only possible if 
3D_Amp data is available) 

• Extract MS channel (for extracting a Mass Trace - only if MS data 
are available; see How to …: Using Mass Spectrometers 

 Extracting Mass Traces Afterward) 

• Extract optimum integration path (for extracting the Optimum 
Integration Path - only possible if a 3D field is available; see How to …: 
Creating and Using Spectra Libraries  Selecting the Optimum 
Integration Path) 

• Extract UV channel (for extracting a UV channel extraction - only 
possible if a 3D field is available; the procedure is similar to selecting 
the optimum integration path) 

• Smooth data (for chromatogram Smoothing - see How to …: 
Working with Chromatograms  Performing Data Smoothing) 

For example, the following steps can be added: 

 

In steps 1 and 6, two UV channels are extracted at 254 nm and 220 nm, 
respectively. The EXT254NM channel does not use compression; only data 
acquired at 254 nm are used. For the EXT220NM, a range of 10 nm was 
selected, i.e., the wavelengths from 215 to 225 nm are used. In addition, 
compression is used during channel extraction. Compression = 3 means 
that only every third data point is saved. 

In steps 3 and 4, two MS channels (MS_1 and MS_2) are extracted. The 
first mass trace covers the mass range 49.0 to 51.0 m/z, while the second 
trace covers masses from 137.0 to 145.0 m/z. For both channels, the 
Gaussian algorithm is used for data smoothing.  
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Seven points are used for data smoothing when the MS_N1 channel is 
extracted; five points are used when the MS_N2 channel is extracted. 

In step 2, the Optimum Integration Path is saved as OPTINT channel. In 
step 5, data smoothing is performed for this new channel, using the 
Savitzky-Golay Filter. The channel is then saved again as 
OPTINT_SG_009_001 channel. Filter size: 9 indicates that 9 input data 
points are used to create one output data point.  

Use the bottom line to add additional steps. Alternatively, select Insert Line 
or Append Line on the context menu. 

The server performs the post-acquisition steps when the program is 
completed and before the System Suitability Test (SST) is started. If there 
is a network failure (see Network Failure Protection), execution of the 
post-acquisition steps is delayed until the network source is available again.  

Manual Injections with Templates 
If no autosampler is found in the server configuration, Chromeleon 
assumes that an AS40 Autosampler is connected to the Pump's Relay 1. If, 
however, sample is being loaded and injected manually instead of via an 
AS40, and the program is being created by either an application template 
or a Virtual Column template selected in the Application Wizard, you 
must modify the PGM File to support this. The PGM File created by the 
application template is saved in the sequence created by the Sequence 
Wizard. The PGM File created by the Virtual Column template can be 
saved to a new sequence or an existing sequence. 

Open the PGM File and locate the AS40 load command. The command 
typically occurs at the beginning of the timed events, at time -2.300. Below 
is an example AS40 load command; note that "Pump_Relay_1.Closed" 
closes the AS40 relay, thereby loading the sample into the loop. 
-2.300 Pump_Relay_1.Closed Duration=130.00 ; For AS40 injection. 
Replace this line with the following for manual injection 

A manual injection line has been added to the PGM File immediately after 
the load command: 
;-0.100  Message "Load the sample into the injection loop, press OK 
to continue" 
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The semicolon at the beginning of the line deactivates (comments out) the 
manual injection ⇒Message. To reactivate it, remove the semicolon at the 
beginning of the manual injection message and add one to the beginning of 
the AS40 load command. Do not change the times preceding the 
commands, even if they differ from the above examples. 
;-2.300  Pump_Relay_1.Closed Duration=130.00 ; For AS40 injection. 
Replace this line with the following for manual injection 

-0.100 Message "Load the sample into the injection loop, press OK 
to continue" 

Save and close the PGM File. 
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Performing Validation and 
Qualification 

To ensure the quality of analytical results,  Validation and Qualification 
have become increasingly important in modern chromatography 
laboratories. 

Chromeleon supports Installation Qualification and Operational 
Qualification for qualification of Chromeleon software. The system 
administrator usually performs both installation and operational 
qualification. The Administrator Help section provides more information; 
refer to: 

 Chromeleon Installation Qualification  
 Chromeleon Operational Qualification (OQ) 

How to …: Working with Files, Databases, and Networks 
 Performing Chromeleon OQ. 

 
Chromeleon also supports instrument qualification, which is usually 
performed by the system administrator, too. For more information, refer to 

 Instrument Installation Qualification in the Administrator Help 
section. Dionex recommends performing Operational Qualification and 

Performance Qualification for devices, as well. For details, refer to 
Operating Instructions for Operational Qualification/Performance 
Qualification for HPLC Instruments, available from Dionex Service. 

In addition, Chromeleon provides several System Wellness features that 
help ensure the functionality of individual devices and, thus, the wellness of 
the entire system. For more information, refer to  Ensuring System 
Wellness. 

To ensure the efficiency of your chromatography method for the current 
analysis, Chromeleon supports System Suitability Tests (SSTs). For more 
information, refer to  Defining System Suitability Tests. 
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Ensuring System Wellness 
System Wellness provides built-in diagnostic and calibration features that 
help prevent unscheduled system shutdowns and assure reliable operation 
of system devices. System Wellness features are available for IC devices 
that have a version of Moduleware installed that supports System 
Wellness. Wellness features are available for devices in the Summit HPLC 
product line, also. 

For an overview of System Wellness features and a list of supported 
devices, refer to:  

 System Wellness for IC Devices (Overview) 

 System Wellness for HPLC Devices (Overview) 
 
System Wellness tasks for IC devices are performed from the control panel. 
For more information, refer to: 

 Opening a Wellness Control Panel  
 Viewing and Restoring Calibration Data 
 Uploading ICS-1500/2000 Calibration Data  
 Performing Device Calibrations 
 Performing Device Diagnostics  
 Entering Device Parameters 

 
Also, refer to How to …: Configuring the Chromeleon Server 

 Enabling and Disabling System Wellness Functions for IC Devices 
in the Administrator Help section. 

 
 Opening a Wellness Control Panel 
Control Panels for performing System Wellness functions are provided for 

various system configurations.  

 Note: 
System Wellness control panels that include "Service." as part of the name 
are reserved for use by Dionex Service Representatives.  
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To open a Wellness panel from the Browser: 
1. In the Browser under the local Datasource, open the Panels folder, 

and then open the Wellness sub-folder.  

2. Double-click the panel name that corresponds to your Timebase 
configuration.  

3. The control panel is opened; then Chromeleon attempts to connect to 
the timebase assigned to the panel.  

4. If an error message appears stating that the timebase was not found, 
close the message, and then select Connect to Timebase on the 
Control menu. Select the timebase to be connected to the panel. 

5. After communication is established with the timebase, the various 
calibration and diagnostic controls on the panel are enabled. 

To open a Wellness panel for a CD or ED from the panel tabset: 
1. In the panel tabset, click the Cond. Detector or EC Detector tab.  

2. On the instrument control panel, click Calibration. 

3. The Wellness panel opens.  

 
 Viewing and Restoring Calibration Data 

Calibration data for IC device is displayed on the Wellness Control Panel 
(see  Opening a Wellness Control Panel). 
Chromeleon stores three sets of calibration data for each System Wellness 
supported IC device. 
• Current is the data most recently sent (uploaded) from the device. It is 

the data currently stored in the device memory. 

• Previous is the data from the previous time calibration data was 
uploaded from the device. 

• Factory is the data obtained (uploaded) from the device when it was 
initially configured in the System Configuration program (see How 
to …: Configuring the Chromeleon Server  Enabling and 
Disabling System Wellness Functions in the Administrator Help 
section). 
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The Wellness control panel displays the current data and the date the 
current calibration function was performed. If the factory value is the current 
data, the date field displays "---."  
• To display previous data or factory data or download calibration data 

from Chromeleon to the device, click Detail. 

A Calibration Detail dialog box appears that displays the three sets of 
calibration data values and their corresponding dates. The dates 
indicate when the values were uploaded from the device to 
Chromeleon. 

• To download calibration data to the device, select Current, Previous, 
or Factory from the list next to the Download button. Then, select 
Download. 

 Uploading ICS-1500/2000 Calibration Data 
After performing a calibration procedure or changing a calibration variable 
from the ICS-1500 or ICS-2000 touch screen, use the procedure below to 
update the System Wellness database with the new calibration data. 

 Note: 
Do not open a System Wellness Control Panel if the name includes 
"Service.pan." These Wellness panels are reserved for use by Dionex 
Service Representatives.  

1. Open the System Wellness Control Panel for the ICS-1500/2000 (see 
 Opening a Wellness Control Panel). 

2. Locate the Update Wellness Database controls. If desired, click 
Instructions for an overview of the procedure.  

3. Click Upload to begin uploading (sending) calibration data to 
Chromeleon. 
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 Performing Device Calibrations 
Wellness Control Panels, which are supplied by Chromeleon, display 
calibration data and provide script buttons for performing IC device 
calibrations. After a calibration is performed, the device uploads the new 
calibration data to Chromeleon.  

 Tip:  
Many calibrations require setup steps before the actual calibration 
command is given. Before selecting a calibration script button on a control 
panel, refer to the topics below for details about the particular calibration 
task you are performing. 
 
Devices Calibration Procedures 
ICS-1000/1500/2000 
systems  Flow Rate 

 Degas Pump 

 Conductivity Cell 
ICS-90 system  Pressure Transducer  

 Conductivity Cell 
Autosamplers, Detectors, 
Pumps  Leak Detector 

AS/AS50 Autosamplers  Inject Port Volume 
Pumps  Flow Rate 

 Pressure Transducer Offset 

 Degas  
Detectors  Wavelength (AD25/PDA-100) 

 Conductivity Cell  
      (CD20/25/25A, ED40/50/50A, IC20/25/25A) 

 pH Reference Electrode  
      (ED40/50/50A Amperometry Mode) 

 ICS-3000 Conductivity Cell 

 ICS-3000 pH Reference Electrode  
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 Calibrating the Leak Detector 
When to Calibrate: After installing a new leak detector 

If the leak detector diagnostic test fails 
Every 6 months 

 
Many System Wellness supported devices are equipped with leak 
detectors. The calibration procedure for all of the sensors of IC devices is 
the same. 

1. Thoroughly dry the sensor. 

2. Open the System Wellness Control Panel for the device (see 
 Opening a Wellness Control Panel.) 

3. Under Calibration, leak detector, click the internal script button to 
calibrate the sensor installed in the device itself. Click the external 
script button to calibrate the sensor on a controlled device. For example, 
for a pump, internal refers to the sensor in the pump and external refers 
to the sensor in a chromatography oven controlled by the pump.  

4. The device calibrates the sensor and uploads the new value to 
Chromeleon. Chromeleon stores this new calibration value as the 
current value. 

 Calibrating the Pump Flow Rate 
When to Calibrate: Every 6 months   
Items Needed: Backpressure tubing to create 14 MPa ± 2 MPa (2000 psi ± 300 psi). 

Use 0.076 mm (0.003 in) ID yellow PEEK tubing (P/N 049715)  
Deionized water 
Tared beaker 

 
1. Verify that there is about 14 MPa (2000 psi) of backpressure.  

2 Pump deionized water at 1.0 ml/min. 

3. Allow the pump to stabilize for at least 5 minutes. 

4. Collect water into a tared beaker for exactly 5 minutes. 

5. Open the System Wellness Control Panel for the pump (see 
 Opening a Wellness Control Panel). 

6. Enter the weight of the water into the weight entry field under flow rate 
and press <Enter>. Chromeleon downloads the value to the pump and 
stores this calibration value as the current value.  
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 Calibrating the ICS-1000/1500/2000 Flow Rate 
When to Calibrate: Every 6 months 

If the OQ/PQ flow rate accuracy and precision test fails   
Items Needed: Backpressure tubing to create 14  ± 1.4 MPa (2000  ± 200 psi); use 

0.076-mm (0.003-in) ID yellow PEEK tubing (P/N 049715) 
Deionized water 
Tared beaker 

 
 Note: 

Do not open a System Wellness Control Panel if the name includes 
"Service.pan." These Wellness panels are reserved for use by Dionex 
Service Representatives.  

1. Open the System Wellness Control Panel for the ICS-1000/1500/2000 
(see  Opening a Wellness Control Panel). 

2. Locate the Pump Flow Rate Calibration controls. If desired, click 
Instructions for an overview of the calibration procedure.  

3. Click Reset Cal to reset the flow rate calibration value. 

4. Click 1.00 ml/min to set the pump flow rate. 

5. Allow the Current Pump Pressure reading to stabilize at 14 ± 1.4 
MPa (2000  ± 200 psi) for 20 minutes. 

6. Click 5.00 min to start the timer and immediately start pumping 
deionized water at 1.00 ml/min. 

7. Collect water into a tared beaker for exactly 5 minutes. 

8. Enter the weight of the deionized water (in grams) in the Enter new 
Flow Rate Cal field. 

9. Click Calibrate to begin the calibration. When the calibration is 
complete, Chromeleon will download the new calibration value to the 
ICS-1000/1500/2000 and will store it as the current calibration value. 

10. Click Log to record the new calibration value in the Audit Trail. 
Chromeleon will automatically update the Current Calibration Date 
and Last Calibration Date fields. 

11. Wait at least 15 minutes, and then recheck the flow rate to verify that 
the calibration was successful. 
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 Calibrating the Pressure Transducer Offset 
When to Calibrate: Every 6 months 

 
 
1. Turn off the pump flow. 

2. Open the waste valve.  
• For GP40/50, IP20/25 pumps: The waste valve is on the pressure 

transducer. To open the valve, turn the knob about two turns 
counterclockwise. 

• For GS50/IS25 pumps: The waste valve is on the secondary pump 
head. To open the valve, turn the knob one-quarter to one-half turn 
counterclockwise. 

3. Open the System Wellness Control Panel for the pump (see 
 Opening a Wellness Control Panel). 

4. Click the offset script button under pressure transducer. The pump 
calibrates the offset and uploads the new value to Chromeleon. 
Chromeleon stores this new offset as the current value. 

5. Close the waste valve. 

 Calibrating the ICS-90 Pressure Transducer 
When to Calibrate: Every 6 months 

 
 
About 10 minutes before starting the calibration, toggle the injection valve 
position a few times by clicking the valve Load and Inject buttons on the 
ICS-90 Control Panel. This removes any air or contaminant buildup in the 
injection valve loop. 

1. Turn off the pump flow. 

2. Open the waste valve on the front of the pump head by turning the knob 
counterclockwise two turns. 

3. Open the ICS-90 System Wellness Control Panel (see   Opening a 
Wellness Control Panel). 

4. Click the Calibrate Offset script button under pressure transducer. 
The pump calibrates the transducer and uploads the new value to 
Chromeleon. The new offset is stored as the current value. 
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5. Close the waste valve. 

6. Connect a pressure gauge between the pump outlet and the pressure 
transducer. Turn on the pump and let the system stabilize. Note the 
average pressure reading on the gauge, and enter this reading in the 
measured field. 

7. Click the Calibrate Slope script button under pressure transducer. 
The pump calibrates the slope and uploads the new value to 
Chromeleon. The new slope is stored as the current value. 

8. Turn off the pump. 

9. Disconnect the pressure gauge. Reconnect the pressure transducer to 
the pump. 

 Degas Calibration 
When to Calibrate: Every 6 months 
 
1. Open the System Wellness Control Panel for the pump (see 

 Opening a Wellness Control Panel). 
2. Select the degas script button. The pump performs the degas 

calibration and uploads the new calibration value to Chromeleon. 
Chromeleon stores this new value as the current degas value.  

 Calibrating the ICS-1000/1500/2000 Degas Pump 
When to Calibrate: Every 6 months 
 

 Note: 
Do not open a System Wellness Control Panel if the name includes 
"Service.pan." These Wellness panels are reserved for use by Dionex 
Service Representatives.  

1. Open the System Wellness Control Panel for the ICS-1000/1500/2000 
(see  Opening a Wellness Control Panel). 

2. Locate the Degas Calibration controls. If desired, click Instructions 
for an overview of the calibration procedure. 
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3. Click Calibrate to begin the calibration. When the calibration is 
complete, the ICS-1000/1500/2000 will upload the new calibration 
value to Chromeleon. Chromeleon will store the new calibration value 
as the current calibration value.  

4. Click Log to record the new calibration value and degas pressure in 
the Audit Trail. Chromeleon will automatically update the Current Cal. 
Date and Last Calibration Date fields. 

 Wavelength Calibration 
Use this manual wavelength calibration procedure for the Dionex AD25 and 
PDA-100 detectors.  

When the AD25 power is turned on, the wavelength is automatically 
calibrated. The PDA-100 wavelength is automatically checked under 
certain conditions, but is not automatically calibrated. 

Manually calibrate the wavelength at the following time: 
 
When to Calibrate: After a failed wavelength calibration check 

After a failed wavelength calibration 
 
1. Verify that there is solvent flowing through the cell, the background 

absorbance is low, and there are no bubbles in the light path. 

2. Open the System Wellness Control Panel for the detector (see 
 Opening a Wellness Control Panel). 

3. Click the wavelength script button under Calibration. The detector 
performs the wavelength calibration routine and uploads the results 
(Pass or Fail) to Chromeleon.  

If wavelength calibration fails, refer to the troubleshooting section of the 
detector operator's manual. 
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 Calibrating the Conductivity Cell (CD20/25/25A, 

ED40/50/50A, IC20/25/25A) 
When to Calibrate: After installing a new cell (use Method A) 

Every 6 months (use Method B)   
Items Needed 
(Method B Only): 

1.0 mM KCl solution: Prepare by dissolving 0.07456 g of reagent grade 
KCl in one liter of 18 megohm deionized water 
Backpressure tubing to provide at least 7 MPa (1000 psi). Use 
0.076 mm (0.003 in) ID yellow PEEK tubing (P/N 049715) 

 

Method A: For Calibrating New or Replacement Cells 
1. Open the System Wellness Control Panel for the detector (see 

 Opening a Wellness Control Panel). 
2. In the conductivity cell calibration entry field, type the cell calibration 

constant (written on a tag on the conductivity cell's cable) and press 
<Enter>. Chromeleon downloads the value to the detector and stores 
the value as the current cell calibration constant. 

Method B: For Calibrating After Every 6 Months of Use 
1. Disconnect the pump output line from the injection valve. 

2. Connect the pump output line directly to the inlet of the DS3 or cell. 

3. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure. 

4. Pump 1.0 mM KCl through the cell at 1.0 ml/min. 

5. If using a DS3, set the DS3 temperature to the intended operating 
point and allow it to reach this temperature. 

6. Allow the conductivity to stabilize for about 5 minutes.  

7. Open the System Wellness control panel for the detector (see 
 Opening a Wellness Control Panel). 

8. Click the calibrate script button under conductivity cell. The detector 
calibrates the cell and uploads a new cell calibration constant to 
Chromeleon. Chromeleon stores this value as the current cell 
calibration constant.  

 After calibration, the conductivity reading should be 147.00 ± 2 µS/cm 
and the cell calibration constant should be between 130 and 190. If 
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this is not the case, refer to the troubleshooting section of your 
detector operator's manual. 

9. Flush the KCl solution from the system by pumping deionized water 
through the cell. When the conductivity drops to less than 1 µS/cm, 
stop the pump. 

10. Reconnect the pump to the injection valve and reconnect the line from 
the suppressor to the cell inlet. 

 
 Calibrating the ICS-90 Conductivity Cell 

When to Calibrate: After installing a new cell 
Every 6 months   

Items Needed: 1.0 mM KCl solution: Prepare by dissolving 0.07456 g of reagent-grade 
KCl in one liter of 18 megohm deionized water 
Backpressure tubing to provide at least 7 MPa (1000 psi). Use 
0.076 mm (0.003 in) ID yellow PEEK tubing (P/N 049715) 

 
1. Open the ICS-90 System Wellness Control Panel (see  Opening 

a Wellness Control Panel). 
2. Use an Allen wrench to remove the two screws securing the DS5 

Detection Stabilizer (which holds the cell) to the ICS-90 component 
mounting panel.  

3. Pull the DS5 straight out from the component mounting panel to 
unplug the cell from its electronics. Let the DS5 hang by the tubing. 

4. Allow the conductivity to stabilize for 5 to 10 minutes. 

5. Click the Calibrate Offset script button under conductivity cell. 
6. Line up the 9-pin connectors on the DS5 and the component mounting 

panel and plug the DS5 back into the electronics. Replace the screws 
and tighten. 

7. Disconnect the pump outlet line from port P (2) on the injection valve; 
connect the line directly to the cell inlet using the yellow PEEK 
backpressure tubing. 

8. Fill an eluent bottle with the 1.0 mM KCl solution and connect it to the 
eluent out line. Prime the pump and then turn on the pump. 

9. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure. 
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10. Allow the conductivity to stabilize for 5 to 10 minutes.  

11. Click the Calibrate Slope script button under conductivity cell. The 
cell is calibrated and a new cell calibration constant is uploaded to 
Chromeleon. The new value is stored as the current cell calibration 
constant.  

12. After calibration, the conductivity reading should be 147.00 ± 2 µS/cm. 
If this is not the case, call Dionex for assistance. 

13. Flush the KCl solution from the system by pumping DI water through 
the cell. When the conductivity drops to less than 1 µS/cm, stop the 
pump flow. 

14. Reconnect the pump to the injection valve and reconnect the line from 
the suppressor to the cell inlet. 

 Calibrating the ICS-1000/1500/2000 Conductivity Cell 
When to Calibrate: (Optional) After installing a new cell (use Method A) 

Every 6 months (use Method B)   
Items Needed 
(Method B Only): 

1.0 mM KCl solution: Prepare by dissolving 0.07456 g of 
reagent-grade KCl in one liter of 18 megohm deionized water. 
Backpressure tubing to provide at least 7 MPa (1000 psi); use 
0.076-mm (0.003-in) ID yellow PEEK tubing (P/N 049715). 

 
 Note: 

Do not open a System Wellness Control Panel if the name includes 
"Service.pan." These Wellness panels are reserved for use by Dionex 
Service Representatives.  

Method A: For Calibrating New or Replacement Cells (Optional) 
1. Open the System Wellness Control Panel for the ICS-1000/1500/2000 

(see   Opening a Wellness Control Panel). 
2. Locate the System Status controls. 

3. Click Details to open the Calibration Details dialog box.  

4. Locate the Conductivity Cell Cal Details controls.  
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5. Enter the cell calibration constant (written on the front of the cell) in the 
Conductivity Cell Constant field and press <Enter>. Chromeleon will 
download the new value to the ICS-1000/1500/2000 and will store it as 
the current cell calibration constant. 

6. Click Close to exit the dialog box. 

Method B: For Calibrating After Every 6 Months of Use 
1. Open the System Wellness Control Panel for the ICS-1000/1500/2000.  

2. Locate the Electric Conductivity Cell Calibration controls. If desired, 
click Instructions for an overview of the calibration procedure. 

3. Click Offset Cal to begin the offset calibration. 

4. When the offset calibration is complete, click Slope Cal to begin the 
slope calibration. When the slope calibration is complete, Chromeleon 
will retrieve the new calibration value from the ICS-1000/1500/2000 
and will store it as the current calibration value. Chromeleon will 
automatically update the Current Calibration Date and Last 
Calibration Date fields. 

5. Disconnect the pump output line from the injection valve. 

6. Connect the pump output line directly to the inlet of the conductivity 
cell.  

7. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure.  

8. Locate the Conductivity Cell Calibration controls. If desired, click 
Instructions for an overview of the calibration procedure. 

9. Click Cell 35 C to select the cell heater temperature. Monitor the cell 
during the warm-up period: 

• If you have an ICS-1000, monitor the cell temperature on a 
standard ICS-1000 control panel. When the temperature reaches 
35 °C, wait an additional 5 minutes and then go on to Step 11.  

• If you have an ICS-1500 or ICS-2000, monitor the cell 
temperature on the HOME page on the instrument front panel. 
When the "=" symbol is displayed next to the Cell Heater control, 
go on to Step 11. 

10. Click 1.00 ml/min to set the pump flow rate. Begin pumping 1.0 mM 
KCl through the cell. 
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11. Wait until the Total Conductivity reading stabilizes (in approximately 
15 minutes), and then click Calibrate. When the calibration procedure 
is complete, Chromeleon will retrieve the new calibration value from 
the ICS-1000/1500/2000 and store it as the current calibration value. 
After calibration, the conductivity reading should be 147.00 ± 2 µS/cm 
and the cell calibration constant should be between 130 and 190. If 
this is not the case, refer to the troubleshooting section of your ICS-
1000/1500/2000 operator's manual.  

12. Click Log to record the new calibration value in the Audit Trail. 
Chromeleon will automatically update the Current Calibration Date 
and Last Calibration Date fields.  

13. Flush the KCl solution from the system by pumping deionized water 
through the cell. When the conductivity drops to less than 1 µS/cm, 
stop the pump flow. 

14. Reconnect the pump to the injection valve and reconnect the line from 
the suppressor to the cell inlet. 

 
 Calibrating the ICS-3000 Conductivity Detector Cell 

When to Calibrate: Every 6 months   
Items Needed 1.00 mM KCl solution: Prepare by dissolving 0.07456 g of 

reagent-grade KCl in 1.000 liter of 18 megohm deionized 
water. 
Backpressure tubing to provide at least 7 MPa (1000 psi); use 
0.076-mm (0.003-in) ID yellow PEEK tubing (P/N 049715). 

 
1. In the panel tabset, click the Cond. Detector tab.  

2. Under Conductivity Detector Settings, click Calibration. 

 The Conductivity Detector Wellness panel opens.  

2. Locate the External Conductivity Cell Calibration controls. If desired, 
click Instructions for an overview of the calibration procedure. 

3. Disconnect the pump output line from the injection valve. 

4. Disconnect the line from the suppressor ELUENT OUT port to the cell 
inlet and connect the pump output line directly to the inlet of the 
conductivity cell.  

5. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure.  
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6. Under External Conductivity Cell Calibration, click Cell 35 C to 
select the cell heater temperature. Allow the cell to reach this 
temperature and then wait an additional 5 minutes to let it stabilize. 

7. Click 1.00 ml/min to set the pump flow rate and begin pumping 1.00 
mM KCl through the cell. 

8. Wait until the Total Conductivity reading stabilizes (in approximately 
15 minutes), and then click Calibrate. After calibration, the 
conductivity reading should be 147.00 ± 2 µS/cm. If this is not the 
case, contact Dionex for help.  

9. Click Log to record the new calibration value in the Audit Trail.   

10. Flush the KCl solution from the system by pumping deionized water 
through the cell. When the conductivity drops to less than 1 µS/cm, 
stop the pump flow. 

11. Reconnect the pump to the injection valve and reconnect the line from 
the suppressor to the cell inlet. 

 Calibrating the ED40/50/50A pH Reference Electrode 
When to Calibrate: After installation of a new reference electrode    
Items Needed: pH 7 buffer  

A second buffer of known pH (usually a calibration buffer that most 
closely matches the pH of the eluent used in your application) 

 
1. Carefully remove the combination pH/Ag-Ag/Cl reference electrode 

from the amperometry cell, making sure to leave the electrode leads 
connected to the cell. 

2. Place the electrode into a pH 7 buffer. 

3. Wait for the pH reading to stabilize (about 1 minute). 

4. Open the System Wellness Control Panel for the detector (see 
 Opening a Wellness Control Panel). 

5. Click the pH 7 script button under pH electrode.  

6. Remove the electrode from the pH buffer, rinse, and then dry it. 

7. Place the electrode in the second buffer.  

8. Wait for the pH reading to stabilize. 
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9. Enter the pH of the second buffer into the edit field above the 2nd 
buffer script button. 

10. Click the 2nd buffer script button. 

 Calibrating the ICS-3000 ED pH Reference Electrode 
When to Calibrate: After installation of a new reference electrode    
Items Needed: pH 7 buffer  

A second buffer of known pH (usually a calibration buffer that most 
closely matches the pH of the eluent used in your application) 

 
1. Carefully remove the combination pH/Ag-Ag/Cl reference electrode 

from the amperometry cell, making sure to leave the electrode leads 
connected to the cell. 

2. Place the electrode into a pH 7 buffer. 

3. Wait for the pH reading to stabilize (about 1 minute). 

4. In the panel tabset, click the EC Detector tab.  

5. Under Electrochemical Detector Settings, click Calibration. 

 The Electrochemical Detector Wellness panel opens.  

6. Under pH Electrode Calibration, click pH Offset Cal.  
7. Remove the electrode from the pH buffer, rinse, and then dry it. 

8. Place the electrode in the second buffer.  

9. Wait for the pH reading to stabilize. 

10. Enter the pH of the second buffer into the pH Slope Buffer Value 
field. 

11. Click pH Slope Cal.  

 Entering the AS/AS50 Inject Port Volume 
The inject port volume is the volume of tubing between the AS or AS50 
inject port and the injection valve. The autosampler uses this information to 
determine how much fluid to push through the line in order to position the 
sample correctly in the loop for precision injections. 
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When to enter a 
new inject port 
volume: 

After recalibrating the inject port volume on a new or existing 
needle seal assembly.  

 
For detailed instructions on replacing a needle seal assembly or calibrating 
the inject port, refer to the AS or AS50 operator's manual. 

1. Open the System Wellness Control Panel for the autosampler (see 
 Opening a Wellness Control Panel). 

2. In the Inject Port Volume field, enter the volume determined during 
recalibration of the inject port volume on a new or existing needle seal 
assembly.  

3. Press <Enter>. Chromeleon downloads the value to the autosampler 
and stores this calibration value as the current value. 

 Performing Device Diagnostics 
Wellness control panels, which are supplied with Chromeleon, display 
diagnostic test results and provide script buttons for performing the tests.  

The following tests are available; see: 

 Leak Detector (for any IC device equipped with a leak detector) 
 Wavelength Verification (for AD25 and PDA-100 detectors) 
 Pressure and Conductivity Diagnostics (for ICS-90 Ion 

Chromatography System) 
 Conductivity Diagnostics (for ICS-1000/1500/2000 Ion 

Chromatography Systems) 

 Testing the Leak Detector 
Many System Wellness supported devices are equipped with leak 
detectors. The test procedure for all of the sensors of IC devices is the 
same. 

1. Thoroughly dry the sensor. 

2. Open the System Wellness Control Panel for the device (see 
 Opening a Wellness Control Panel). 
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3. Under Diagnostic Tests, leak detector, select the internal script 
button to test the sensor installed in the device itself. Select external to 
test the sensor on a controlled device. For example, for a pump, internal 
refers to the sensor in the pump and external refers to the sensor in a 
chromatography oven controlled by the pump.  

4. The device tests the sensor and reports the results to Chromeleon. 
Possible test results are: 
• Passed (Dry)  

• Failed (Wet) 

• Failed (Open circuit): The sensor may be disconnected. Check the 
connection.  

• Failed (Short circuit): The sensor may need replacing. Contact 
Dionex for assistance. 

• Failed (Out-of-calibration): Calibrate the sensor (see  
Calibrating the Leak Detector) and retest. If the test still fails, the 
sensor may need replacing. Contact Dionex for assistance. 

 Wavelength Verification 
Use this procedure for the Dionex AD25 and PDA-100 detectors. The 
Wavelength Verification test verifies the wavelength accuracy of the 
AD25 or PDA-100 detectors. When this test is run, a holmium oxide filter is 
placed in the light path and measured wavelengths are compared to 
theoretical wavelengths for holmium oxide.  

1. Verify that there is solvent flowing through the cell, the background 
absorbance is low, and there are no bubbles in the light path. 

2. Open the System Wellness Control Panel for the detector (see 
 Opening a Wellness Control Panel). 

3. Under Diagnostic Tests, wavelength verification, click the Verify 
script button. The detector runs the test and then reports the results to 
Chromeleon. The overall results (Passed or Failed) are reported and 
the theoretical and measured values for three peaks in the holmium 
oxide spectrum. 

If the test fails, run the wavelength calibration (see  Wavelength 
Calibration) and then rerun the verification test. 



370 Performing Validation and Qualification 

 ICS-90 Pressure and Conductivity Diagnostics 
Use this procedure to test the variance in pressure and conductivity 
readings for the Dionex ICS-90 Ion Chromatography System. 

1. Verify that the ICS-90 pump is on. 

2. Open the ICS-90 System Wellness Control Panel (see  Opening a 
Wellness Control Panel). 

3. Under Diagnostic, click the Start script button. The ICS-90 begins 
collecting pressure and conductivity readings. To stop the test, click the 
Stop script button. The ICS-90 reports the minimum, maximum, and 
variance results for both pressure and conductivity. 

 To test the conductivity variance on the electronics alone, select the 
Dummy Cell check box before running the test. 

 
 Conductivity Verification (ICS-1000/1500/2000) 

Use this procedure to test the conductivity variance on the DS6 conductivity 
cell electronics. 

 Note: 
Do not open a System Wellness Control Panel if the name includes 
"Service.pan." These Wellness panels are reserved for use by Dionex 
Service Representatives.   

1. Open the System Wellness Control Panel for the ICS-1000/1500/2000 
(see  Opening a Wellness Control Panel). 

2. Locate the Dummy Cell Test controls. Click Instructions for an 
overview of the test procedure.  

3. Click On to begin the test. 

4. When the test is complete, click Log to record the new dummy cell 
value in the Audit Trail. The new dummy cell value should be 21 µS; if it 
is not, the CPU card may be defective. Contact Dionex for assistance. 
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 Entering Device Parameters 
For some devices, System Wellness Control Panels include fields that let 
you enter various device parameters.  

Also, see  Applying a Sodium Correction (for ED40/ED50/ED50A 
Amperometry detectors). 

 Applying a Sodium Correction 
If you are using a NaCl reference electrode with an ED40, ED50, or ED50A 
detector in amperometry mode, turn on the sodium correction parameter. 
This adjusts the detector's signal response for the NaCl electrode, instead 
of the default AgCl reference electrode. 

1. Open the System Wellness Control Panel for the detector (see 
 Opening a Wellness Control Panel). 

2. Under Device Parameters, sodium correction, select On.  

Defining System Suitability Tests 
Use the SST page (see System Suitability Test (SST)) of the QNT Editor 
(see Data Representation and Reprocessing  The QNT Editor) to 
check your system's performance for individual samples. The number of 
tests is only limited by the capacity of your computer. Each test is defined in 
a separate line. Use the arrow key ↓ to append additional lines to the table. 
This action automatically opens the SST Wizard, which guides you through 
all further steps. 

 Tip: 
In order to perform a System Suitability Test, enter the QNT File into the 
sample list before you start the analysis. If you start the analysis and the 
QNT File has not yet been entered, the test is not performed during the 
batch run. Thus, the Batch cannot be aborted in case of Fail Action - 
Abort Batch. 
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For more information, refer to: 

 SST Wizard: Overview and Start Conditions 
 SST Wizard: Sample and Test Conditions 
 SST Wizard: Other Wizard Pages 
 Modifying the System Suitability Test  
 SST Example: Is the Amount in the Calibrated Range? 
 SST Example: Amount Deviation on Reinjection 
 Inserting SST Results in the Printer Layout  

 SST Wizard: Overview and Start Conditions 
The SST Wizard supports you in inserting a new System Suitability Test 
(SST). To open the SST Wizard, double-click a cell or press the F8 key. Or 
else, select Lines… Append Line or Insert Line on the context menu or 
press the ↓ key. (Note: To open the SST Wizard via the ↓ key, place the 
cursor on the bottom line.) 

The SST Wizard provides the following pages: 
• Start 

• Sample Condition 

• Test Condition 

• Aggregated (optional) 

• Peak & Channel Condition (optional) 

• N.A. & Fail Action 
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On the first Wizard page, select a test from the Predefined Tests list: 

 

All predefined values on the following pages depend on this selection. 

To copy the previous test, select <Copy Previous Test> from the list. If 
there is no previous test, i.e., if the test is the first on the list, this entry is 
not available. 

If no other conditions are required, you can already complete the Wizard on 
this page by clicking Finish. Clicking Next takes you to the following 
Wizard pages. Use these pages to check and edit the predefined 
conditions as necessary. 

For more information, refer to: 

 SST Wizard: Sample and Test Conditions 
 SST Wizard: Other Wizard Pages 
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 SST Wizard: Sample and Test Conditions 
Use the Sample Condition page to specify for which sample(s) the test is 
performed. Select an option: 

 

Select Apply on all Samples to perform the test for each sample. Select 
Sample Type to perform the test for a certain sample type only. In the 
Sample Number(s) and/or Vial Number(s) input fields, enter the sample 
or vial number(s) for which to perform the test; for example 1,3,7-10. (Note: 
To separate the entries, you can use either a comma or a semicolon.) 
Select Sample Property to perform the test only for samples with the 
specified property. Enter the property in the corresponding input fields. The 
User defined condition option is reserved for advanced users. Select this 
option to enter any kind of formula in the report format. The test is 
performed only for those samples for which this condition is true. 
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Test Condition 
Use Test Condition tab page to enter the basic conditions for the single 
system suitability tests: 

 

First, enter a unique name in the Test Name input field. Specify the Test 
Condition by clicking the "..." (Browse) button. Select a variable from the 
Edit Result Formula dialog box. Select the Operator from the drop-down 
list, and then enter the compare value in the Value input field. The following 
operators are available: 
 
Operator: Description:  

Sample Condition: The SST if performed for all samples for which 
the property ..... 
Test Condition: The SST checks whether the sample property .... 

= equals the entered string of characters. 
< > does not equal the entered string of characters. 
> is larger than the entered string of characters. 
< is smaller than the entered string of characters. 
>= is larger than or equals the entered string of characters. 
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Operator: Description:  
Sample Condition: The SST if performed for all samples for which 
the property ..... 
Test Condition: The SST checks whether the sample property .... 

<= is smaller than or equals the entered string of characters. 
contains: contains the entered string of characters. 
does not contain: does not contain the entered string of characters. 
starts with: starts with the entered string of characters 
does not start with: does not start with the entered string of characters. 
ends with: ends with the entered string of characters 
does not end with: does not end with the entered string of characters.  

 Note:  

If the operators >, <, >=, or <= apply to text variables, the lexicographical 
order is observed; for example, A<B. 

The Value can be either a value or a report variable or formula. Select the 
Use aggregation check box to aggregate the test conditions over several 
samples. Selecting this check box takes you to the Aggregate page.  

For more information, refer to: 

  SST Wizard: Overview and Start Conditions 
 SST Wizard: Other Wizard Pages 

 SST Wizard: Other Wizard Pages 
Aggregate 
Use this page to define the function, sample(s), and condition for sample 
aggregation. (Refer to the online Help for information about the Aggregate 
page.) 

Peak & Channel 
This page is optional and appears only if the test condition requires that 
you enter a peak or channel. (Refer to the online Help for information about 
the Peak & Channel page.) 
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N.A. & Fail Action 
Use this page to determine what the test result is if the test cannot be 
performed (N.A.). Also, determine which action is taken if the test fails (Fail 
Action). 

For more information, refer to: 

  SST Wizard: Overview and Start Conditions 
 SST Wizard: Sample and Test Conditions 

 Modifying the System Suitability Test 
To modify an existing System Suitability Test (SST), double-click a cell or 
press the F8 key. The SST Properties dialog box provides the following 
tab pages:  
• Sample Condition 

• Test Condition 

• Aggregate 

• Peak & Channel Condition 

• N.A. & Fail Action 

These pages correspond to the individual SST Wizard pages. For more 
information, refer to How to …: Integrating Chromatograms and 
Identifying Peaks  SST Wizard: Overview and Start Conditions. 

 SST Example: Is the Amount in the Calibrated Range? 
It is only possible to determine the amount of an unknown sample if it is in 
the calibrated range, i.e., between the smallest and the largest amount of 
the standard samples. You can check this using a System Suitability Test. 
Follow the description below: 

Create a test that checks whether the current Amount is either equal or 
larger than the smallest Amount of all standard samples: 
• If no System Suitability Test has been created yet, double-click the 

empty line on the SST tab page to open the SST Wizard. For an 
existing System Suitability Test, select the bottom line of the existing 
test and press the arrow down key on the keyboard.  
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From the Predefined Tests list, select the Minimum Peak Amount test. 
The Wizard guides you through test creation. Clicking Next> takes you 
to the next Wizard page.  

• On the Sample Condition page, specify for which samples the test is 
performed. The default setting is Apply on all Samples. 

• You can accept the settings on the Test Condition page: 

 

• Use the next Wizard page to determine the peak(s) and the channel for 
which the test is performed. 

• Finally, determine what the test result is if the test cannot be performed 
and which action is taken if the test fails. 

In the same way, create a second test that checks whether the current 
Amount is either equal or smaller than the largest Amount of all standard 
samples. In this case, select the Maximum Peak Amount test from the 
Predefined Tests list. 
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 SST Example: Amount Deviation on Reinjection 
For reinjections from the same vial, the relative standard deviation of the 
determined Amount values should be as small as possible. You can use a 
System Suitability Test to check whether the standard deviation is below a 
specified minimum value. Follow the description below: 
• If no System Suitability Test has been created yet, double-click the 

empty line on the SST tab page to open the SST Wizard. For an 
existing System Suitability Test, select the bottom line of the existing 
test and press the arrow down key on the keyboard. The Wizard guides 
you through test creation. Clicking Next> takes you to the next Wizard 
page.  

• On the Sample Condition page, specify for which samples the test is 
performed. The default setting is Apply on all Samples. 

• On the Test Condition page, enter an appropriate name for the new 
System Suitability Test, e.g., Amount Deviation. 

• Determine the Test Condition, e.g., peak.amount >= 1. (In this case, 
1 is the maximum allowed deviation in percent.) 

• Click the "…" button behind the Test Condition input field. In the 
dialog box, select ⇒Peak Results from the Categories list, and 
then select Amount from the Variables list. 

 

• Click OK to confirm your selection. This returns you to the SST 
Wizard.  

• In the Operator input field, select >=. In the Value input field, enter 
1. 
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• Select the Use aggregation check box. Clicking Next> takes you to 
the Aggregate page. 

• On the Aggregate page, select RSD% from the Aggregate Function 
drop-down list. 

• Enter the Maximum number of samples to aggregate, e.g., 5.  

• For Only aggregate samples with, determine Replicate ID = 
smp.replicate. This searches for a maximum of four previous samples 
for which the replicate ID matches the replicate ID of the current 
sample. The relative standard deviation of the Amount value is 
determined for a maximum of five samples--for the current sample and 
up to four others.  

 

• Use the next Wizard page to determine the peak(s) and the channel for 
which the test is performed. 

• Finally, determine what the test result is if the test cannot be performed 
and which action is taken if the test fails. 
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 Inserting SST Results in the Printer Layout  
If you save the System Suitability Test (SST) parameters in the QNT File, 
you can use the test results for peak labels or as individual variables in the 

Printer Layout (not in tables).  

Use the Report category System Suitability Test to display the SST 
results in the Printer Layout. The following variables are available: 
 
Variable Description 
Number  
Name  
Sample Condition  
Test Condition   
Aggregate  
Operator   
Value   
Channel   
Peak    
N.A. User-defined test result if the test is not 

performed 
Fail Action    
Aggregated Samples   
Sample Condition Results   
Test Results   
Aggregated Sample List   
Aggregated Sample Result List   
Result of Test Condition or Aggregate   
Result of Compare Value    

The Formula field indicates your selection in short; for example, 
sst.test_condition for the test condition.  
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Integrating Chromatograms and 
Identifying Peaks 

Chromeleon supports various ⇒QNT Parameters, such as calibration and 
peak table parameters, as well as ⇒Detection Parameters. Specify in the 

Quantification Method (QNT Method) which parameters are used for 
evaluating chromatographic raw data. For more information, refer to: 

 Creating a Peak Table 
 Defining Detection Parameters  
 Combining Peaks 
 Subtracting a Blank Run Sample  

For information about how to perform calibration and enter the calibration 
parameters in the QNT Editor, refer to  Calibrating.  

Creating a Peak Table 
The peak table contains data for  

• Peak identification  
• Amount calculation 

Specific peaks of a chromatogram are identified by a name. The 
determined peak areas are converted into amount values (= Formula for 
Amount Calculation). The peak table contains the amount values for all 
standard samples. Hence, it is the basis for each calibration. Usually, all the 
information is entered into the peak table before the analysis is started.  

The peak table contains more columns than can be displayed clearly on the 
screen. Thus, the columns are distributed on the following tabs: 
• Peak Table (general peak table) 

• Amount Table (parameters to determine the amount) 

• Peak Tracking (parameters to assign peaks using reference spectra) 

• MS Tracking (parameters to assign peaks using Mass Spectra) 
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To determine which columns are displayed on the tab pages, select 
Display Columns on the View menu or select Columns > Display 
Column on the context menu. In this way, you can adjust the tab pages to 
your individual requirements. 

For more information, refer to: 

 Identifying Peaks 
 Identifying Peaks via Their UV Spectra (Peak Tracking) 
 Identifying Peaks via Their Mass Spectra (MS Tracking) 
 Defining Retention Times and Reference Peaks 
 Defining the Retention Index and the Kovats Index 
 Defining the QNT Method for Several Detectors 
 Entering Reference Spectra 
 Autogenerating the Peak Table  

 
Also, refer to How to …: Calibrating: 

 Selecting the Standard Method (Standard Column) 
 Selecting the Calibration Function (Cal. Type and Int. Type 

Columns) 
 Entering Amount Values (Amount Column) 

and 

How to …: Creating and Managing Files and Data  Creating User-
defined Columns 

 Identifying Peaks 

(Peak Name, Retention Time, and Window columns) 
Most frequently, peaks are identified by their retention time. 
• Enter the names of all peaks to be identified in the ⇒Peak Name 

column, line by line. Assign a nominal retention time to each peak by 
entering a retention time value in the Ret. Time peak table column 
(= manually creating a peak table). Or else: 
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• Select  Autogenerate Peaktable on the Edit menu to generate the 
peak table automatically, based on the current sample. In this case, 
Chromeleon includes all integrated peaks of the current sample into the 
peak table. The assigned peak names consist of the sequence name 
and a consecutive number. Chromeleon uses the maximum values of 
the single peaks to recalculate the values to be entered in the 
⇒Retention Time and ⇒Window columns. All other entries are 
replaced by the default values (= automatically creating a peak table). 

If a peak is detected at the specified time in an unknown sample, the peak 
is automatically assigned a name (fig. a). 

Identification is possible even if the retention times deviate or if neighboring 
peaks are very close. To allow this, use the Window (fig. b) peak table 
parameter to define a tolerance range. If a peak is detected in this range, it 
is identified even if the nominal and the actual retention times do not 
coincide exactly (fig. c). If several peaks are detected in this range, 
Chromeleon identifies the greatest peak, the first peak, or the peak nearest 
to the retention time (fig. d), depending on the selected option.  

Tret (g)

Tret (n)

Tret (f)

Tret

a) b) c) d)

peak name window

set

actual

 
 
To open the Peak Window dialog box, mark the Window column cell of 
the peak of interest, and then either press the F8 key or double-click in the 
cell. Determine the Window Interpretation: Select Absolute to enter the 
window width in minutes. Select Relative to define the window width in 
percent. 

In the Peak Match section, select the criterion for peak identification. If you 
use a Photodiode Array Detector, you can also identify the peaks by the 
spectrum or by the spectrum and the retention time. For more information, 
refer to  Identifying Peaks via Their UV Spectra (Peak Tracking). If 
you use a Mass Spectrometer for data acquisition, you can identify the 
peaks by their mass spectra. (For more information, refer to  Identifying 
Peaks via Their Mass Spectra (MS Tracking).) 
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The Window column in the peak table indicates the window width in 
Decimal Minutes; for example, 0.25, followed by the abbreviation for the 

selected window interpretation and the peak match criterion. To identify the 
greatest peak in a 30 second window, the entry in the column must be as 
follows: 0.25 AG (0.25 min or 15 seconds to the left and right of the 
retention time). If the entry is 0.25 AN, the peak that is nearest to the 
nominal retention time is identified. 

 Notes: 
The retention times and window values stated in the peak table only serve 
to identify a peak. The retention times indicated in a Report are always 
the actual retention times (= retention time in the peak maximum). 

If the retention time of the same peak shifts from sample to sample due to a 
column trend, it may happen that the peak leaves the retention time window 
at some point. In this case, peak identification is no longer possible. 
However, Chromeleon provides a method to reliably identify peaks even 
then: Select the ⇒Use Recently Detected Retention Time check box on the 
General tab page of the QNT Editor. 

In addition to peak identification by the nominal retention time, it is possible 
to identify compounds by their substance spectrum.  

 Identifying Peaks via Their UV Spectra (Peak Tracking) 
Chromeleon allows you to perform peak tracking. Peak tracking means 
identifying peaks by comparing spectra. In addition to the Reference 
Spectrum column, other peak table columns also allow you to influence 
spectra comparison: Match Criterion, Check Derivative, Min. WL, Max. 
WL, Threshold, Rel. Max. Deviation, and Check Extrema. The values 
entered in these columns have the same meaning as described in How 
to …: Displaying and Using UV Spectra  Entering Criteria for the 
Spectra Library Screening. 

 Tip: 
If neither the minimum (Min. WL) nor the maximum wavelength (Max. WL) 
are set, the comparison is performed for the entire wavelength range of the 
reference spectrum. 

Enable peak tracking in the Window column. In the corresponding F8 
dialog box (press the F8 key in any cell in the Window column or double-
click), select Spectrum or Spectrum and time under Peak Match.  
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The algorithm for peak identification by comparing spectra can be 
described as follows: If, in the Window column of the peak table, the Peak 
Match criterion for a peak is Spectrum or Spectrum and time, peak 
tracking uses the reference spectra in the corresponding column. If 
Spectrum and time is selected, the spectra comparison is limited to the 
specified time window. Peak tracking generates a list of spectra sorted by 
the match factor; a peak hit list is not displayed. 

 Tips: 
Peak tracking is performed using the parameters (match criteria, etc.) 
specified for the peak in the peak table. 

The peak hit list includes only peaks with a match factor above the 
threshold specified for this peak. 

An empty peak hit list indicates that no spectrum fulfilling the match criteria 
was found. This could be due to a very high threshold. 

The peak hit list is calculated for all peaks in the peak table, for which peak 
tracking was enabled. After calculation, the peak hit lists are checked for 
multiple hits. If the Check the best hits only option is enabled, only the 
best hits are compared for the individual peaks.  



388 Integrating Chromatograms and Identifying Peaks 

In case of multiple hits, the peak with the best match factor receives the 
name of the reference substance. 

Usually, multiple hits are not found if you select Spectrum and time as 
match criterion. 

All other peaks in the peak table, i.e., peaks for which the peak tracking 
function is disabled, are identified via the window assignment (First, 
Nearest, Greatest) as described in  Identifying Peaks. 

If you acquire data with a Mass Spectrometer, you can identify peaks via 
their mass spectra. (For more information, refer to  Identifying Peaks 
via Their Mass Spectra (MS Tracking)). 

 Identifying Peaks via Their Mass Spectra (MS Tracking) 

(Mass peak x, MS threshold, MS filter conditions, and Check MS ret. 
times columns) 

Mass Spectra present a very reliable method for peak identification. For 
the available parameters, refer to the MS Tracking tab page.  
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Double-click the respective cell or press the F8 key to open the Mass 
spectrometry conditions for dialog box:  

 

If you have entered the mass of at least one mass peak, you can enable 
and disable peak identification via mass spectra by selecting the Check 
mass ratios check box. 

Under Mass Peak 1, enter the mass of the substance (range: 1.0 to 2000.0 
m/z) that is expected at this peak. If you expect fragmentation and can 
estimate the fragments, you can enter two of them, with their expected 
intensities, under Mass Peak 2 and Mass Peak 3.  

Select the MS Threshold option to filter the noise. A mass is detected in 
the mass spectrum only if its relative intensity compared to the Base 
Peak (largest peak) is higher than the threshold value. 

The filter settings limit the mass spectra used for peak identification. This 
option is required if you modify the polarity and/or use a different maximum 
voltage for ionization of the sample.  

Select the Check retention time of mass spectra check box to use the 
retention times of all masses for peak assignment. All retention times must 
be within one scan.  
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The settings selected in the Mass spectrometry conditions for dialog box 
are not active immediately. You can activate them later from the Peak 
Table tab page: Press the F8 key in the Window column or double-click to 
open the Peak Window for dialog box. Select the Check mass ratios 
check box. 

If you acquire data with a Photodiode Array Detector, you can identify 
peaks via their UV spectra. (For more information, refer to  Identifying 
Peaks via Their UV Spectra (Peak Tracking)). 

 Defining Retention Times and Reference Peaks 

(Retention Time column) 
The Retention Time column allows you to select reference peaks for 
relative retention times and to determine how the ⇒Retention Time is to be 
interpreted for the respective peak. Double-click the corresponding peaks 
or press the F8 key in the Ret. Time column, to open the Retention Time 
for dialog box. 

 
In the Interpretation section, determine the display of the retention time 
(relative or absolute time) individually for each peak. Note that relative 
times can be displayed either as difference or as percentage ratio to the 
retention time of a reference peak.  
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Use the Reference peak drop-down list box to define one (or several) of 
the other peaks as reference peak. However, only peaks with absolute 
reference times can be selected as reference peaks. They are indicated 
with a light blue background. It is not possible to delete reference peaks 
from a peak table. 

The retention time is re-calculated automatically when the retention time 
interpretation is changed or when a different reference peak is selected. 

Besides, you can also enter the retention time directly in the input field 
(Peak Table page in the Ret. Time column) in the following manner:  

[<Reference Peak>] <Ret. Time> [<Unit>] 

You are free to choose the order in which the fields are entered.  

If you do not enter a name for the reference peak, the time is interpreted as 
absolute time. 

Select min or % as the unit. min is the default if no entry is made. The unit 
determines whether the time is indicated as the difference (min) or the ratio 
(%) to the time of the reference peak. For absolute times, only min is 
permitted. 

 Defining the Retention Index and the Kovats Index 

(Ret. Index and Kovats Index columns) 
Retention indexes can be used to generate generally comparable retention 
times. Determine one or several marker peaks in the ⇒Ret. Index (= RI) or 
⇒Kovats Index (= KI) column. 

Enter a value between 0 and 99.999. Each peak for which a value is 
entered is used as marker peak. Increment the values that you enter, i.e., 
either leave the field empty or enter any value above the value for the 
predecessor peak. The column is 'empty' by default. 

The retention index and the Kovats index are calculated based on these 
variables. Both indexes are mainly used in GC to correct retention time 
variations. Therefore, the peak table must contain certain marker peaks, 
which usually have the following RI or KI values assigned: 

Retention Index: 100, 200, 300, etc. 

Kovats Index: 100*number of carbon atoms of the alcane. 
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The RI or KI values of all other peaks remain empty; they are calculated by 
means of interpolation. 

Select Columns > Duplicate Column on the Edit or the context menu to 
duplicate the column and thus, allow different values for the individual 
channels. 

 Tip: 
The Kovats index is calculated using the adjusted retention times. 
Therefore, to enable calculation, enter a ⇒Dead Time on the General tab 
page of the QNT Editor. 

 Defining the QNT Method for Several Detectors 
1. If two detectors are connected in series, the retention times are delayed 
against each other. As the flow normally remains unchanged, the shift of 
the retention times is constant. Select the ⇒Delay Time parameter to 
consider this fact.  

On the General tab page of the QNT Editor, click the arrow next to the 2nd 
Detector and/or 3rd Detector input field and select the name of the 
detector from the list. Enter the measured delay time in the next field.  

2. For some applications, it might be necessary to modify the QNT Method 
for a second detector or another channel. For example, you cannot use the 
Delay Time parameter when you are working with Flow Gradients. 
Instead, duplicate the following columns and assign the duplicate to one or 
several channels: 

⇒Calibration Type 

⇒Integration Type 

⇒Kovats Index 

⇒Left/Right Limit 

⇒Peak Type 

⇒Response Factor 

⇒Retention Index 

⇒Retention Time 

⇒Window 
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Select the column to duplicate in the Peak Table (Amount Table, Peak 
Tracking table, respectively) and select Columns on the context or Edit 
menu. Select Duplicate Column to open the Duplicate Column dialog 
box. Click Add Channel to define the channel(s) for the new column.  

If an individual peak is not detected in a channel, the corresponding cell in 
the Retention Time column can be left empty. Thus, this channel will not 
identify this peak. If you do not wish to include a detected peak into the 
report, just leave the corresponding cell in the Retention Time column 
empty.  

In addition, you can define more detection parameters for the respective 
channel(s) in the Channel column on the Detection tab page. Also, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 

 Entering Reference Spectra (Reference Spectrum 
Column) 
You can enter a reference spectrum for each peak in the peak table of the 
QNT Editor: 

Position the cursor in the Reference Spectrum column, press the F8 key 
or left-click twice. In the dialog box, select the reference spectrum of the 
peak. Click Browse to load any samples or spectra libraries for selecting 
the reference spectrum. If samples are loaded, a list of all peaks in the 
corresponding chromatogram is displayed.  

For spectra libraries, the list displays the spectra included in the spectra 
library (see figure). The selected reference spectrum is displayed in the 
right window. If the relevant peak of the peak table is identified in the active 
chromatogram, the spectrum is included as overlay. The corresponding 
match factor is displayed in the upper corner of the plot frame.  
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Click Select to copy the selected reference spectrum to the corresponding 
line of the peak table.  

Clipboard: Spectra can copied to the clipboard from the spectra plot 
window or the spectra library by simultaneously pressing the CTRL+C keys 
or by selecting Copy on the Edit menu. In the QNT Editor, either 
simultaneously press the CTRL+V keys or select Paste on the Edit menu 
to insert the copied spectrum as reference spectrum into the Reference 
Spectra column. 

Copy Peak Spectra as Reference: If one or several lines are selected in 
the Reference Spectrum column, select Copy Peak Spectra as 
Reference on the Edit or context menu to use the spectra of the active 
chromatogram as the reference spectra.  

Overlay of the Reference Spectrum on the Spectra Plot 
To include the current reference spectrum from the peak table as Overlay 
on the Spectra plot, place the cursor in the spectrum and right-click. Select 
Decoration on the context menu. On the Peak Spectra tab page, click 
Reference Spectrum in corresponding peak table. Click OK to receive 
the spectrum from the Reference Spectrum column in addition to the 
current one.  
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 Autogenerating the Peak Table  
To save the user from having to determine the retention time of each peak, 
peak tables can be created automatically by selecting Autogenerate Peak 
Table on the Edit or context menu. 

Chromeleon automatically generates a peak table, entering the retention 
times of all detected peaks of the currently open chromatogram as set 
times. The user need only complete the table by entering component 
names and altering the default window and other values as necessary. 
Peaks, which are not of interest, can be deleted from the table. These will 
consequently be excluded from the report, provided that the Including all 
not detected peaks of the peak table parameter in the Integration 
Report Properties (Table Properties command on the Edit or context 
menus) is turned to OFF. 

During automatic table generation, the variables described below are set as 
follows: 

Autogenerated Peak Table is entered as ⇒Comment. 

The peak names (⇒Name) are constructed from the name of the QNT 
Method; for example, in the Test peak table, detected peaks will be 
assigned the names Test-1, Test-2, Test-3, etc. 

The ⇒Window values are entered as absolute values; they represent one-
third of the distance from the nearest peak. 

No ⇒Group. 

The ⇒Amount values and the ⇒Response Factor are set to 1.0. 

The peak type (⇒Sample Type) is Auto; that is, Chromeleon determines 
the peak type. 

If you select Autogenerate Peak Table on the Edit menu to generate peak 
tables, it is possible to use the results of the spectra library screening (type: 
Use spectra library screening results) instead of enumerating all peaks 
in the chromatogram (type: Enumerate peaks of current chromatogram). 
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In this case, library screening is performed based on the parameters 
entered in the QNT File. The peak table will include all peaks for which at 
least one reference spectrum was found and the name of the best hit. 

The following options can also be used: 
• Apply only to peaks with: With this option, only peaks exceeding a 

selectable absolute or relative area or height will be included in the 
peak table. 

• Apply only to peaks in current time interval: Click this button to 
include only peaks in the currently displayed section of the 
chromatogram; for example, in the zoomed chromatogram section.  

• Copy reference spectrum from: This option simultaneously includes 
the reference spectrum for each peak. Either the current peak 
spectrum from the displayed chromatogram or the library spectrum of 
the best hit from library screening can be used. If you want to use the 
library spectrum of the best hit, make sure that the Use spectra library 
screening results autogeneration option is enabled in the upper 
window section.  
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• Select Enable peak tracking using peak match type to enable peak 
tracking for each included peak. Select Spectrum or Spectrum and 
time as match type (see How to …: Integrating Chromatograms and 
Identifying Peaks  Peak Tracking). 

• Allow multiple best hits or Unique identification: The results of the 
spectra library screening will produce a hit list of library spectra for 
each peak in the chromatogram. If Unique Identification is selected, 
these hit lists are handled as in Peak Tracking; that is, multiple identical 
hits with smaller match factors are eliminated. In the case of Allow 
multiple best hits, each peak in the chromatogram is copied to the 
peak table with the best hit. If the best hits are identical, this can result 
in identical entries in the peak table. In this case, adding a number to 
the name generates a unique peak; for example 2-, -3. 

If you have generated a new peak table via Autogenerate Peak Table, a 
note is automatically included in the Comment column of the peak table: 
• If you have selected Enumerate peaks of current chromatogram, the 

comment is: Autogenerated. 

• If you have selected Use spectra library screening results, the 
comment is: Autogenerated. Spectrum: Name of reference 
spectrum, Match: Match factor. 

 Tip: 
If Use spectra library screening results is enabled, the settings made on 
the Spectra Library Screening tab page are automatically entered in the 
peak table (Peak Tracking tab page). 

Defining Detection Parameters 
The ⇒Detection Parameters define how the chromatograms are integrated, 
in which areas peaks are suppressed, how peak starts and peak ends are 
detected, etc. Thus, the detection parameters allow you to adapt the 
integration to your requirements and to minimize the re-integration effort for 
individual chromatograms. 

You can either enter the detection parameters in the table on the Detection 
tab page of the QNT Editor or define them graphically in a chromatogram. 
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The detection parameters influence the integration of all chromatograms to 
which the selected QNT Method applies. They can assume new values at 
any time. Only the value that was defined last will take effect, however, only 
for the time of the chromatogram. The parameters are reset to their default 
values afterward. If a parameter assumes a new value at a specified time 
(Retention Time column), this is called an Event. You do not have to enter 
these events in chronological order. They will be sorted automatically when 
being saved. The Channel column allows you to define whether this 
applies to an individual channel only or to all channels (default) of a 
sample. 

Each detection parameter has a default value assigned. Using this value, 
the system automatically integrates about 90% of all chromatograms 
correctly. However, for critical applications, such as wavelength 
switching, the user can influence the baseline or the peak type, for 
example, rider peak or main peak, or disable detection for defined periods. 

Parameter tables can include up to 100 lines. For an example of how to 
enter detection parameters in the table of the Detection tab page, refer to 
the following image: 
 

 
 
In many cases, it may be easier to enter the detection parameters 
graphically in the chromatogram (see How to …: Working with 
Chromatograms  Defining Detection Parameters Graphically). 

Usually, the chromatogram and the report table are immediately updated 
when the detection parameters have been changed. However, you may 
disable this function by deselecting Autom. Re-Integerate on the View 
menu of the QNT Editor. If this option is disabled, save the QNT Method or 
select Start Integration on the View menu to start re-integration with the 
new integration parameters. 
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 Tip:  
Save the setting for this option in the corresponding Report Definition File 
(Select Save Report Definition on the Workspace menu.) 

In addition, the QNT Editor provides more detection parameters. The 
following sections describe how to edit the default values together with the 
respective possibilities and advantages. Use the detection parameters for:  

 Reducing the Number of Evaluated Peaks 
 Excluding Certain Peaks 
 Inhibiting Peak Integration 
 Modifying the Baseline 
 Modifying the Peak Recognition Algorithm 
 Defining the Peak Start/End 
 Defining Rider Peaks 
 Defining the Area for PPA  

 Reducing the Number of Evaluated Peaks 
To limit the integration report to a manageable size, only the most important 
peaks (i.e., the largest peaks) should be included in the evaluation. Define 
either the ⇒Minimum Height or the ⇒Minimum Area.  

How To  
The following example refers to the minimum peak height: 
• Open a QNT File (select Open on the File menu) and click the 

Detection tab page. 

• Look at the chromatogram and determine the minimum peak height to 
be evaluated. You may also click the smallest peak to be integrated. 
Then open the corresponding Peak Properties via the context menu. 
The dialog box then indicates the width, height, and area of the peak. 

• Enter the name of the parameter to modify; for example, the 
⇒Minimum Height in the Parameter Name column of the quantification 
method.  



400 Integrating Chromatograms and Identifying Peaks 

• Assign the smallest possible signal value, for example, in mAU, as the 
new parameter value in the Parameter Value column. 

• In the Time column, determine from which time (relative to injection 
time) the parameter becomes valid. 

• Alternatively, you can open an edit dialog box (press the F8 key) to 
enter the parameter name, value, and time.  

All peaks with a height lower than the indicated value will not be displayed. 

As the parameters affect peak recognition and thus the baseline, you must 
consider a tolerance of approximately 5% to ensure that all desired peaks 
are recognized.  

Another way to define, for example, the minimum area, is to graphically 
define the corresponding parameter. For example, follow the steps below: 
• In the chromatogram, find the smallest peak just no longer to be 

displayed. 

• Enlarge this peak to be clearly visible. 

• In the chromatogram, right-click to select an area whose area is a 
slightly smaller than that of the selected peak. 

• Select Set Minimum Area on the context menu. 
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This action enters the selected area as minimum area together with the 
time of its left edge into the QNT Method. Enter the 0.000 as time into the 
Detection tab page or move the parameter in the chromatogram with the 
Detection Parameter Tool so that the minimum area is valid for the entire 
chromatogram. 

 Note: 
You can undo the graphical input of detection parameters. Click one of the 
tables of the QNT Editor and select Undo on the Edit menu. (In the 
chromatogram itself, you can only undo the modifications of the currently 
open chromatogram.) 

 Tip: 
To make the report clearer: 

• Select any cell in the report (integration tab page) and select Table 
Properties on the Table menu. 

• Select the Reject peaks with smaller area than ...% check box and 
specify below which size not to include a peak in the report.  

 Excluding Certain Peaks 

Spikes 
Sometimes, very narrow peaks (so-called spikes) occur in chromatograms 
due to, for example, gas bubbles in the HPLC system. In such a case, the 
problem (= the gas bubbles in the HPLC system) should be solved first, of 
course. However, to use the chromatogram, identification of these narrow 
peaks can be suppressed with the QNT Method. 

Select the ⇒Minimum Width parameter to define the minimum width for the 
peaks to be integrated. Proceed as when entering the minimum height (see 

 Reducing the Number of Evaluated Peaks). 

Peaks above the Detector Maximum 
Sometimes peaks occur whose absorption maximum is above the detector 
maximum so that integration does not make sense. You can then include 
these peaks as unidentified peaks into the peak table by using the 
⇒Maximum Peak Height parameter. 
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Broad Peaks 
If an unusually broad peak occurs in the chromatogram, it may be from a 
previous sample. Select the ⇒Maximum Width parameter to define this 
peak as being unidentified. 

 Inhibiting Peak Integration 

The ⇒Inhibit Integration parameter can be enabled at the time t1 and can 
be disabled at the time t2. The peaks within the time window t1 - t2 are not 
integrated. Whether this applies to all channels or to only one channel is 
specified via the Channel column. 

To prevent the integration of all peaks in the range from 0 to 1.0min 
(especially the injection peak), the following input is necessary in the 
quantification method. 
 

 
 
Peaks detected in this time span will not be integrated and will not be 
included in an integration report. 

 Modifying the Baseline 
It may be necessary to modify the baseline, especially for non-resolved 
peaks. The baseline is usually defined via a mathematical procedure. For 
calculating the individual peak areas, a perpendicular is dropped to the 
baseline from each local minimum (standard).  

If you think that integration starts too early or that the peak end is delayed, 
you can force a better peak start or end by inserting a ⇒Baseline Point.  

If a series of non-resolved peaks is piled on an "absorption mount", for 
example, due to increased solvent absorption, the ⇒Valley to Valley 
detection parameter can be used to force the baseline from minimum to 
minimum via. 
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Move baseline point Valley toValleyDefault  
 
Single peaks that are piled on a recognizable "absorption mount" are 
integrated individually. To integrate the entire area, the baseline can be 
fixed. Setting the ⇒Lock Baseline parameter to At Current Level 
extrapolates the baseline horizontally to the intersection with the signal 
curve. Setting the parameter to At Global Minimum searches for the 
absolute minimum in the direction of the peak end or until the next Lock 
Baseline. Both parameters disable the Valley to Valley parameter. 
 

Lock Baseline -
current level

Default Lock Baseline -
global minimum  

 

 Tip: 
In all these actions, the Peak Type classification criterion of the peak table 
has priority. For a Baseline-Main-Baseline type peak, the peak limits 
always have baseline contact. 

As an alternative, you may modify the baseline manually (refer to Working 
with Chromatograms/Manual Re-Integration  Modifying the Baseline 
Manually.) 

 Modifying the Peak Recognition Algorithm 
Whether signal variations are interpreted as peaks or not, is usually set 
automatically. Manual modification of this "recognition sensitivity" is 
possible via the combination of the ⇒Peak Slice and ⇒Sensitivity detection 
parameters. Changing the parameters is required, for example, in 
chromatograms with unusually wide (many minutes) or very narrow (< 
0.1sec) peaks. 
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Another way to define the peak recognition algorithm is to define both 
parameters graphically.  

How To 
• Enlarge a baseline section so that the noise is clearly visible. 

• In the chromatogram, right-click to select an area from which the 
baseline runs out neither at the top nor at the bottom. 

• Select Set Peak Slice & Sensitivity on the context menu. 

  
The width of the selected area is entered into the QNT Method as peak 
slice and the height is entered as sensitivity at the time of the left edge of 
the area. Enter 0.000 as time onto the Detection tab page or move the 
parameters in the chromatogram with the Detection Parameter Tool so 
that this peak recognition algorithm applies to the entire chromatogram. 

 Note: 
You can undo the graphical input of detection parameters. Click one of the 
tables of the QNT Editor and select Undo on the Edit menu. (In the 
chromatogram itself, you can only undo the modifications of the currently 
open chromatogram.) 

The peak recognition algorithm considers signal variations only beyond the 
adjusted sensitivity values. Peaks below this threshold are interpreted as 
noise. 

Both parameters affect peak recognition only, not integration! The area 
calculation (integration) is not affected.  
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 Defining Peak Start or Peak End 
Depending on the chromatogram type, the peak start or the peak end can 
be detected too early or too late. There are several ways to prevent this: 

If you think that the integration is started too early or that the peak end is 
delayed too much, select the Fronting Sensitivity Factor parameter for 
the peak start and the ⇒Tailing Sensitivity Factor for the peak end. The 
entered value multiplied with the left or right peak width determines the 
peak start or the peak end.  

Depending on the chromatogram type, different values may make sense. 
Test which value is best for your chromatograms. A value of 2 is often an 
appropriate starting point for finding the best Fronting/Tailing Sensitivity 
Factor. 

You can also set a new ⇒Baseline Point to force the peak to start later or 
to end earlier.  

 Caution: 
However, when setting a baseline point keep in mind that this point will be 
valid for all chromatograms, which are evaluated with the respective QNT 
Method. If in one of these chromatograms a peak maximum occurs by 
coincidence at the time of your hard entered baseline point, the peak 
maximum will be defined as base point and the peak will not be detected.  

Correct too late a peak start or too early a peak end (the latter can occur, 
for example, with increased baseline noise as follows: 

1. In recorded chromatograms: Select a higher ⇒Peak Slice (= about 20% 
of the smallest peak width) and, in addition, a higher ⇒Sensitivity, if 
necessary. 

2. For samples that have not been processed yet: Change the data 
acquisition ⇒Step in the program file. Select the step so that only about 20 
data points are recorded for the smallest peak. 
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 Defining Rider Peaks 

The detection parameters ⇒Rider Threshold and ⇒Maximum Rider Ratio 
allow you to define which peaks shall be detected as Rider Peaks and 
which shall be detected as main peaks. The following applies:  

The smaller the rider threshold is, the smaller are the peaks that can be 
detected as rider peaks. (Peaks below the rider threshold are always 
regarded as main peaks. For peaks above the rider threshold, the 
Maximum Rider Ratio defines whether a peak is a rider peak or a main 
peak.) The larger the maximum rider ratio is, the larger the peaks that can 
be defined as rider peaks. 

 Tip: 
When defining rider peaks with these parameters please keep in mind that 
the same peak may be detected in two different chromatograms as main 
peak and as rider peak. This would result in considerable deviations; for 
example, in the calibration. To prevent this, select the peak type Rider (or 
Main) for the respective peak in the peak table. Thus, the peak is a rider 
peak, if possible (or always a main peak). 

In addition, you can define how to skim rider peaks by using the ⇒Rider 
Skimming parameter. With the two options Tangential at lower peak end 
and Tangential at both peak ends the peak is skimmed by a tangent. 
Usually, there is hardly any difference between the results of the two 
options. 

With the Exponential option, the course of the baseline is approximated by 
an exponential function; that is, the peak is skimmed by the exponential 
function. This option clearly distinguishes from the two others. In most of 
the cases, Exponential maps the actual baseline course very accurate. 
With this option, the rider peak will usually receive a more realistic larger 
area. To be able to use this option, make sure that a sufficient number of 
data points is available. 

 Tips: 
You can move the baseline in the chromatogram with the mouse for 
tangentially skimmed riders, but you cannot for exponentially skimmed 
riders. 

Split Peak on the context menu allows splitting one rider peak into two 
peaks.  
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 Defining the Area for PPA  
When using Photodiode Array Detectors and recording 3D Fields, you 
may check the peak purity with the Peak Purity Index (PPI).  

Define the most expressive area of you spectrum by means of the ⇒Peak 
Purity Start/End Wavelength parameters and limit the examination to this 
area only. 

The detection limit becomes especially apparent with very small peaks. The 
influence (that is the noise, drift and limits of the measuring method) on the 
peak spectrum is strongly developed at the peak start and peak end 
because, in these areas, the concentration of the peak substance in the 
flow cell is very low. Set the ⇒Peak Purity Threshold parameter to reduce 
the influence on the PPI and the match factor and, thus, to prevent that 
contaminated substances are indicated falsely. The PP threshold value 
defines the percentage of the peak height starting as of which the spectra 
will be considered for the respective purity examination. 

If you work close to the detection limit, use higher PP threshold values to 
reduce the influence of the detection limit on the purity examinations. If you 
are mainly interested in the purity of large peaks, use lower PP threshold 
values to examine the purity over the largest possible area of the peaks. 

Grouping Peaks  
If you are interested in the sum parameters for two or more peaks, you can  

1. Define these peaks as a peak group (that is treated as one single peak). 

2. Define them as a group of peaks.  

1. If the peaks lie close together and are not baseline separated, for 
example, with overloaded columns, define the peak group start and the 
peak group end via the ⇒Peak Group Start/End parameters on the 
Detection tab page. The baseline will then be drawn from the start of the 
peak group to its end. Such a peak group is treated as one single peak. 

2. To define a peak group in which the peaks do not necessarily succeed 
one another, for example, to determine the amount/concentration of an 
entire class of substances, take the following steps: 
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• Identified peaks: Select Column > Display Column on the context 
menu to insert the ⇒Group column into the peak table if the column is 
not yet displayed. For those peaks that should belong to this group, 
type the desired group name into this column. 

• Unidentified peaks: Click Unidentified peaks… on the General tab 
page to define the period for which this group shall be valid. The 
baseline will be drawn in the same way as for individual peaks. 

• Add the Group Amount column to the Report and the Printer 
Layout. This column shows the desired ⇒Amount value. In the report, 
open the dialog box Insert/Add Report Column via the Insert Column 
or Add Column commands on the context menu. Select the Peak 
Results category and then choose Group Amount as variable. 

 Tip: 
If the selected calibration type is, for example, LOff instead of Lin, the 
value in the Group Amount column will not be identical to the sum of the 
amount values of the individual peaks even if the group includes all peaks 
of the chromatogram. 

Subtracting a Blank Run Sample 
On the General tab page of the QNT Editor, use the Blank Run & Matrix 
Blank section to consider absorption values of a Blank Run Sample, a 

Matrix Blank Sample, or any other sample ( Blank Run Subtraction).  
• Select No Blank Run Subtraction if no correction is to be performed.  

If the absorption values of a specific sample are to be considered for 
sample evaluation, determine which sample is to be used as Blank Run 
Sample.  
• Select Subtract Recent Blank Run Sample in Corresponding 

Sequence if the Blank Run Sample (sample type: Blank) that was 
processed last in the current sequence before the current sample is to 
be used.  

• Select Subtract a Fixed Sample to perform the correction with a 
specific Blank Run Sample. Click Browse to search for the sample. 
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When subtracting a blank run sample, the chromatogram of the blank 
sample is subtracted point by point from the active chromatogram. If 
the current sample is a standard sample, the difference between the 
two chromatograms is used for the calibration. 

• Enable Matrix Blank Subtraction enables the subtraction of matrix 
blank samples. Contrary to the other options, the resulting peak areas 
or peak heights are subtracted for peaks that have been identified for 
the matrix blank sample and for the unknown sample.  

 Tip: 
Although sample types other than "blank" can be subtracted as well, 
this usually does not make sense because often-negative peaks would 
occur in the resulting chromatogram. 

Calibrating 
In calibration, a functional relationship is determined between the peak 
area or peak height and the concentration of a substance (in HPLC/IC; in 
GC, usually the injected amount of a substance). To allow this you have to 
enter certain values or make other settings in Chromeleon. The required 
input is listed below. The order corresponds to the order in which the input 
is usually made. 

Sample List (Browser) 
• Injection volume (⇒Inj. Vol.) 

• Sample weight factor (⇒Weight) 

• Dilution factor (⇒Dil. Factor) 

• Amount of the Internal Standard (⇒ISTD Amount)  

 Tip:  
In many cases, it is sufficient to enter the injection volume in the sample 
list. Usually, you enter the injection volume in the Sequence Wizard (unless 
you copy an existing sequence). 
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QNT Editor: General Tab  
• ⇒Dimension of Amounts 

• ⇒Calibration Mode 

QNT Editor: Peak Table Tab 
• ⇒Standard; also, see  Selecting the Standard Method (Standard 

Column) 

• ⇒Integration Type; also, see  Selecting the Calibration Function 
(Cal Type and Int. Type Columns) and  Weighting and Averaging 
Calibration Points 

• ⇒Calibration Type  

QNT Editor: Amount Table Tab (The amount table is part of the peak 
table.) 
• ⇒Amount; also, see  Entering Amount Values (Amount Column)  

QNT Editor: Calibration Tab 
• See  Disabling the Calibration Sample 
 
For calibration examples, refer to  Calibration Examples. 

For information about how to display calibration curves, refer to 
 Displaying Calibration Curves. 

 Selecting the Standard Method (Standard Column) 
Use the Standard method to determine how calibration is performed. 
Generally, a distinction is made between a calibration based on an internal 
or an external standard.  

External means that the calibration is performed based on one or several 
standard samples. (This is the default.)  

Using an internal standard substance means adding a standard to the 
unknown sample. This can be either before (External/Internal) or after 
(Internal) sample preparation. Either the standard (= Internal Standard) 
can be added to all samples or it can serve as a basis for a relative area 
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calculation. In this case, results are displayed only in relation to the amount 
or area of the internal standard. (For more information, refer to Theory of 
Calibration,  Standard Methods.) 
• In the Standard column, use the Standard Method for <Peak Name> 

dialog box to determine the standard method (External, 
Internal/External, Internal) for each peak to be calibrated. To open 
the dialog box, press the F8 key in the corresponding cell. 

• For the last two options, at least one peak of the peak table must be 
used as the internal standard: In the Standard Method for <Peak 
Name> dialog box for the peak to be used, select Use this peak as 
Internal Standard (ISTD). 

• Press the F8 key to enter the standard method assignment via an edit 
dialog box.  

 Selecting the Calibration Function (Cal.Type and Int. 
Type Columns) 

Use the Int. Type (⇒Integration Type) column to define how the individual 
peaks are evaluated. 

Press the F8 key or double-click a cell in the Int. Type column. The 
following dialog box appears:  

 

In addition to Area, Height, and CE-Area, you can select the relative area 
or the relative height as the reference for the evaluation (Integration Type).  
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If you select Area, all amount calculations refer to the area of one peak. 
This Peak Area Integration is the default setting. The peak height 
integration is only used in exceptional cases. 

The relative height is either calculated relating to all peaks or all identified 
peaks. ISTD peaks can be considered for the calculation of the total area 
(height). 

There are several peak table columns, which define the conversion of the 
determined area values into the calculated amount values. A separate 
calibration and integration type must be assigned to each calibrated peak in 
the peak table.  

Enter a calibration function in the Cal. Type column. Press the F8 key to 
receive a list of available functions and options. Apart from few exceptions, 
the calibration types Linear or Linear with Offset are used.  

 

The ⇒Calibration Type determines which Calibration Function is used for 
deriving a valid amount/area assignment for a larger range from the 
calibration points of the standard samples. For more information about 
linear and non-linear calibration types, refer to Theory of Calibration 

 Calibration Types (Linear), or  Calibration Types (Non-linear). 
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Via the calibration type, you can also define the weighting and averaging of 
calibration values (see How to …: Calibrating  Weighting and 
Averaging Calibration Points.  

Either the calibration curve leads through the origin, for example, with the 
Lin and Quad calibration types, or the origin is not considered, for 
example, with the LOff and QOff calibration types. For calibration types 
with offset, the origin can be treated as a calibration point, using the Add 
zero point (0,0) for curve fitting (0) option. In this case, the calibration 
curve will not be forced through the origin, but the origin will be considered 
nevertheless.  

Usually, all other columns of the peak table can be used with the default 
settings. Press the F1 key to display more information. Press the F8 key to 
open an edit box.  

 Weighting and Averaging Calibration Points 

Weighting 
With the default settings, Chromeleon weights calibration points of higher 
concentrations more strongly than lower concentrations, that is, the course 
of the calibration curve is oriented towards the calibration points of higher 
concentration. This makes sense as smaller concentrations also cause a 
stronger dispersion of the determined area values, which would distort the 
result beyond proportion.  

To undo or even reverse this type of weighting, four additional weighting 
functions have been introduced: 

The weighting 1/Amount (or 1/Response) virtually undoes the "normal" 
weighting described above; i.e., low and high concentrations are weighted 
similarly. The weighting 1/Amount² (or 1/Response²) results in an over-
proportional weighting of smaller amounts.  

By variation of the Number of Replicates, this weighting can be avoided. 
Smaller concentrations are injected more frequently than larger 
concentrations, more calibration points in the low concentration range 
support the calibration curve. Outliers are then less relevant.  

 Tips: 
The stronger weighting of higher concentrations is valid in all Calibration 
Functions, with the exception of Point-to-Point. 
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Outliers can be explicitly "disabled" by excluding a specific standard sample 
from the calculation. Exclude the sample on the Calibration tab page of the 
quantification method. 

When calculating the calibration values Variance, Var.Coeff, Std.Dev, 
Rel.Std.Dev, and Corr.Coeff, averaging is not considered! Weighting only 
influences the course of the calibration curve, the values are a measure for 
the quality of the calibration. 

Averaging 
To determine the calibration curve, all available Calibration Points are 
normally used. As dispersion is stronger for the lower calibration levels, 
many users verify the results by using a large number of calibration points. 
The calibration curve is thus determined by a larger number of points on 
the lower than on the higher level. 

If all points of a Calibration Level are averaged before calculating the 
calibration curve, and the subsequent calibration is performed based on 
these average values only; the calibration curve is based on one point of 
each calibration level only. 

 Entering Amount Values (Amount Column) 
Standard substances are labeled by user input in the Amount column.  
• Search the peak table for the substance name of the standard 

substance(s), or 

• Enter the name and the retention time as described in How to …: 
Integrating Chromatograms and Identifying Peaks  Identifying 
Peaks. 

• Type the amount value of the standard into the first Amount column. 
This can be a concentration value (such as µg/ml) or the absolute value 
(such as µg). If a standard is available in different concentrations, enter 
the concentration of each vial in a separate ⇒Amount column. For 
example, two concentrations result in two Amount column entries: 
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If injection is performed several times from the same sample vial 
(multiple injection), one amount value is sufficient, even if a different 
volume and thus, a different amount, are injected. Chromeleon 
considers this automatically. 

• Repeat the procedure for each substance serving as a standard. 

Inserting new Amount columns 
• Double-click the header of an existing Amount column (or select 

Columns > Edit Amount Columns on the Edit or context menu) to 
open the Edit Amount Columns dialog box. 

• From the Assign Standards on the basis of list, select the sample 
variable (e.g., ⇒Name for the sample name, ⇒No. for the sample (vial) 
number, or ⇒Ref. Amount Set, etc.) that shall be used to identify and 
assign standards to the amount column.  

• Use one of the following methods to create new Amount columns: 

Click New, type a unique column name in the edit field that appears in 
the Amount Column window, and press Enter. Select an Amount 
column (or Unassigned) in the Amount Column window to display the 
associated standards. Drag the selected sample(s) (  = standard 
sample;  = Validation Sample or  = Spiked Sample) from the 
Standards window to the new column. 
-or- 

Click Auto-Generate. Select the preferred option from the drop-down 
list and click Apply. The following options are available: Select 
Generate a separate column for EACH standard to generate a 
separate column for all samples with the same value for the selected 
sample variable. Or else, select Generate a single column to apply 
to ALL standards to generate only one common column for all 
standards. 

 Note: 
The selected option will apply to all sequences that use the current 
QNT File. For example: You select the Vial Number option, and then 
assign vial number 5 to Amount column B. From now on, vial number 
5 (regardless of its contents) will be assigned to Amount column B in 
every sequence that uses this QNT File. 

• Click OK to close the dialog box and return to the peak table. 
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Disabling Calibration Samples 
Use the Calibration tab page to determine which sample shall be used. 

It depends on the ⇒Calibration Mode which sample ⇒Types available (for 
the sample type, refer to the symbol in the Name column): 

Usually standard samples  are used for calibration. 

Only in the Standard Addition mode, i.e., if you use the Standard 
Addition method, you can use the sample types Unspiked  and Spiked  
(see Spiked Sample) for calibration. 

Click the box in the Enabled column to open the Disable (Enable) 
Standard xyz dialog box and define whether the respective sample shall 
be used for calibration purposes. You can exclude the respective 
calibration sample from calibration either for all peaks and all channels 
(default setting) or only for the selected peak and/or channel. For more 
information about how to use this option, refer to the following examples: 

The calibration sample was contaminated 
Exclude the sample from the calibration. Accept the default setting: Disable 
the sample for All Peaks and All Channels. 

By mistake, too much of a substance was added to the calibration 
sample 
Do not exclude the sample completely from calibration, but disable the 
calibration for this substance, instead. Click the peak and select Selected 
Peaks and All Channels in the Disable (Enable) Standard xyz dialog 
box. 

Contamination in the calibration sample that is detected in one 
channel only 
You do not need to exclude the sample completely from calibration. Select 
the channel that detects the contamination and select All Peaks and 
Selected Channel in the Disable (Enable) Standard xyz dialog box. 

For more information about calibration, refer to How to …:  Calibrating. 
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Calibration Examples 
The following topics provide a detailed description of the theory and 
practical use of the available calibration possibilities. The first examples 
describe the different applications: 

 Introduction and Example: 1 Standard and 1 Substance 
 Several Standards with Several Substances Each 
 Multiple-Point Calibration Using One Single Standard 
 Calibrating Using Standards of an Old Sequence 
 Standard Addition  
 Calibrating Unstable Substances 
 No Pure Substance Available - Known Relative Extinction 

Coefficient 
 
For an overview of the different calibration options for which an Internal 
Standard (ISTD) is used, refer to  Calibrating with an Internal 
Standard Substance. 

The ⇒Calibration Mode determines the standard samples that are used for 
calibrating specific unknown samples. For an overview of the different 
calibration modes and the topics that provide more information, refer to 

 Calibration Modes for External Calibration. 

For more information about validation, refer to: 

 Entering the Concentration/Amount of the Validation Sample 
 Validating the Calibration Curve 

 
For a better compatibility with PeakNet 5, Chromeleon also supports 

 Inverting Dependent and Independent Variables. 

 Note: 
To apply an existing calibration to a new sequence consisting of one or 
several Unknown samples, set the ⇒Calibration Mode to Fixed. Always 
perform calibration manually (Calibrate). The Auto-Recalibrate option is 
not available.  
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 Introduction and Example: 1 Standard and 1 Substance 
Most calibrations in HPLC and IC are performed using external standard 
samples. In the simplest case, the corresponding peak area for a known 
amount of a substance is determined for one standard sample only. 
Chromeleon then calculates the slope (c1) of the Calibration Function 
from the ratio of the amount and the peak area. (In this case, you can only 
select the Linear without Offset calibration type). Chromeleon uses this 
slope to calculate the ⇒Amount of this substance in unknown samples. 

Example: 
You want to determine the amount of substance A in two samples, Sample 
1 and Sample 2. A standard sample (Standard) is available. For each 
sample, an injection volume of 20 µl is injected by an autosampler. The 
samples are located at the autosampler positions 1 (standard), 2, and 3 
(unknown samples).  

Sample List 

In the Browser, create the following sequence using the Sequence Wizard:  

 

(For information about the Browser, refer to Data Management  The 
Browser.) 

 Note: 
For more information about how to create a sample list, refer to How 
to …: Creating and Managing Files and Data  Creating a Sample 
List (Sequence). 

QNT Method/General Tab  

The concentration of substance A in the standard sample is 12 mg/l. The 
calibration curve for substance A shall be linear (calibration type: Lin) and 
run through the origin. After processing this sequence, you have to create 
the QNT Method for performing the calibration.  



 Integrating Chromatograms and Identifying Peaks 419 

On the General tab page of the QNT Editor (see Data Representation 
and Reprocessing  The QNT Editor), enter the unit for all other entries 
in the ⇒Dimension of Amounts field. (For this example, enter "mg/l"). In the 
Global Calibration Settings section, keep the setting for the ⇒Calibration 
Mode, i.e., Total. 

QNT Method/Peak Table Tab 

Do not change the defaults in the Standard (External) and ⇒Calibration 
Type (Lin) columns on the Peak Table tab page either. Chromeleon 
automatically creates a "default" amount column. If only one standard 
sample is available (as is in this case), you can keep this standard sample 
as well. Enter the concentration in the Amount column: 

 

 Note: 
If more than one substance is available in the samples, append a new line 
to the table using the Lines > Append Line commands on the context 
menu. Enter the concentration in the corresponding cell of the Amount 
column. 
 
Chromeleon now automatically calculates the amount for the two unknown 
samples. You can display the results afterwards in the report on the 
Integration tab page: 

 

For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 



420 Integrating Chromatograms and Identifying Peaks 

 Several Standards with Several Substances Each 
Calibrations are usually performed using several standards. They often 
contain more than one substance to be calibrated. The simplest case is two 
standard samples that contain two substances each. In this case, you can 
determine the slope and the offset and/or curvature of the calibration curve 
(depending on the number of acquired data points).  

Example: 
You want to determine the amount of substances A and B in two samples, 
Sample I and Sample II. Two standard samples, containing different levels 
of Standard 1 and Standard 2, are available. Both standard samples 
contain substance A and substance B. For each sample, an injection 
volume of 20 µl is injected by an autosampler. The samples are located at 
the autosampler positions 1 (Standard 1), 2 (Standard 2), 3 (Sample I), and 
4 (Sample II).  

Sample List 

The sequence appears as follows (for more information, refer to How to …: 
Creating and Managing Files and Data  Creating a Sample List 
(Sequence)): 

 

QNT Method/Peak Table Tab  

In Standard 1, for example, the concentration of substance A is 10.2 mg/l 
and the concentration of substance B is 20.1 mg/l. Standard 2 contains 
30.5 mg/l of substance A and 49.7 mg/l of substance B. Thus, you have to 
create the following peak table in the QNT Editor (For more information 
about the editor, refer to Data Representation and Reprocessing  The 
QNT Editor.) 
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Remove the default ⇒Amount column and add two new Amount columns 
(one for each standard level): 
• Double-click the header of an existing Amount column (or select 

Columns > Edit Amount Columns on the Edit or context menu) to 
open the Edit Amount Columns dialog box.  

• From the Assign Standards on the basis of list, select the criterion 
(Name, Vial Number, Sample ID, etc.) to use to identify and assign 
standards to the amount columns.  

 Note: 
The selected option will apply to all sequences that use the current QNT 
File. For example: You select the Vial Number option, and then assign vial 
number 5 to Amount column B. From now on, vial number 5 (regardless of 
its contents) will be assigned to Amount column B in every sequence that 
uses this QNT File. 

• Click Auto-Generate. Select Generate a separate column for EACH 
standard from the drop-down list and click Apply. Two new columns 
will appear in the Amount Column window. Double-click the columns 
to rename them, if desired. 

• Click OK to close the dialog box and return to the peak table. 

 Note: 
If one of the substances is not available in the standard sample, the 
corresponding cell in the Amount column should be left empty. 

If you are using several standards for calibration, you may prefer to select a 
⇒Calibration Type other than Lin (Linear without Offset). 

Using these settings, Chromeleon automatically calculates the 
concentrations of substance A and substance B in the two unknown 
samples. 

For an overview of the calibration options provided by Chromeleon, refer to 
How to …:   Calibrating. 
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 Multiple-Point Calibration Using 1 Single Standard 
If you want to perform a multiple-point calibration (see Single-Point and 
Multiple-Point Calibration) using only one standard sample, you can inject 
different injection volumes (= quasi Dilution Series).  

Sample List 

For example, if you inject 10, 20, and 40 µl of just one standard, the sample 
list will appear as follows: 

 

For Chromeleon, each injection is an individual sample. To distinguish 
between different injections made from the same standard sample vial, you 
may append the sample number and the injection number (see example 
above). 

QNT Method/General Tab 

The standard sample contains, for example, 10 ml/l Uracil. As all injections 
of a dilution series are made from the same sample vial with the same 
concentration, you cannot represent the concentration in the calibration 
curve. Instead, enter the actually injected amount in the ⇒Amount column 
and enter a ⇒Dimension of Amounts. For example, enter ng on the 
General tab page of the QNT Editor. (For more information about the 
editor, refer to Data Representation and Reprocessing  The QNT 
Editor). 

QNT Method/Peak Table Tab  

As in the introduction example (see  Introduction and Example), you 
do not need to change the default Amount column setting on the Peak 
Table tab page. 
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If the calibration line does not run through the origin as in the example 
below, select Linear with Offset (= LOff) as ⇒Calibration Type. 

These settings will then result in the following calibration line: 

 

For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 

 Calibrating Using Standards of an Old Sequence 
Calibration standards are often quite expensive. Thus, if the calibration 
curve remains constant for weeks or months, the standards of a sequence 
can be used for calibration for several weeks before the calibration 
constancy needs to be checked again.  

Sample List 

In this case, the new sequence will neither contain standards nor 
Validation Samples but unknown samples only (perhaps plus Blank Run 

Samples and/or Matrix Blank Samples). 
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QNT Method/General Tab 

Select Fixed as ⇒Calibration Mode in the Global Calibration Settings 
section: 

 

In Fixed mode, manual calibration is possible only. That is, you have to add 
standard samples on the Calibration tab page (see below). Then, click 
Calibrate on the General tab page to include the newly entered standards 
in the calibration. 

QNT Method/Calibration Tab  

If the Fixed calibration mode is selected, the Calibration table is empty at 
first. Select Append Standard on the context menu to add the desired 
standard(s). The Browse dialog box is opened. Select a standard sample 
from any sequence: 
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The Calibration tab page then lists the desired standards: 

 

After you have entered all standards, click Calibrate on the General page 
to perform calibration with those standards. After each change, for 
example, if you exclude a standard by disabling the Enabled check box or 
if you correct the injection volume in the sample list, you have to click 
Calibrate again. 

 Note: 
If you later edit the name of the sequence, from which the standards were 
added or if you change the name of the directory that houses the 
sequence, the reference becomes invalid. Then, you have to add the 
standards again on the Calibration page.  
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 

 Standard Addition  
The sample matrix can considerably influence sample analysis. To consider 
this, a known amount of one or more substances is added to the unknown 
sample, particularly in ion and gas chromatography. In this way, the 
concentration of these substances is increased by a value that is exactly 
known. Afterward, the original and the Spiked Sample are analyzed, 
using Standard Addition. 

Sample List 

In this case, the new sequence includes only unspiked, unknown samples 
(⇒Type (Sample Type): Unspiked) and the associated Spiked samples. 
For example, the new sequence could look as follows: 
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Each unknown sample was spiked three times with the same known 
amounts. In this example, several unknown samples are analyzed. 
Therefore, the unknown samples must be assigned to the associated 
spiked samples, via the ⇒Std. Add. Group column. In this column, the 
samples are assigned to a common standard addition group. For example, 
in this way, Sample 1 is calibrated with the spiked samples Spiked 1_1, 
Spiked 1_2, and Spiked 1_3. 

Dionex recommends spiking unknown samples always with the same 
amount of the same substances. In the ⇒Ref. Amount Set column, you can 
then assign the spiked samples to the same amount values in the Amount 
Table of the QNT Editor. Enter the same ID for the associated spiked 
samples into this column (here: Spike1 for samples Spiked 1_1, Spiked 
2_1, and Spiked 3_1). 

QNT Method/General Tab 

Select Standard Addition as ⇒Calibration Mode in the Global 
Calibration Settings section: 

 

Re-calibration is performed automatically; it cannot be disabled. 
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QNT Method/Amount Table Tab 

On the Amount Table tab page, insert standard columns for every spiked 
sample: 

• On the context menu, select Columns, and then select Edit Amount 
Columns.  

• From the Assign Standards on the basis of list, select Ref. Amount 
Set if you have used the associated column in the sample list (see 
above) or, select another option from the list, e.g., Name. 

• Click Auto-Generate and select Generate a separate amount 
column for EACH standard from the list: 

  

• Click Apply to add a column for all identically spiked samples in the 
Amount Table. 

Concentrations 
If your dimension of amount is a concentration, enter the added 
concentrations of the various substances in the spiked samples into the 
associated Amount columns. 
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or 

Amounts 
If your dimension of amount is an amount, enter the added amounts of the 
various substances into the associated Amount columns.  

Chromeleon automatically analyzes the Unspiked sample(s) using the 
Standard Addition method. 
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 

 Calibrating Unstable Substances 
If you want to calibrate unstable substances, the concentration in the 
samples that are analyzed later may be considerably lower than the 
concentration in those samples that are analyzed first although originally 
the concentration was the same. The instability of the substance makes 
calibrating more difficult. Chromeleon provides two possible solutions: 

Sample List 

To consider the instability of substances one or several standard samples 
are added to a series of unknown samples every now and then. The 
sequence will then appear as follows, for example: 
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QNT Method/General Tab  

The bracketed calibration illustrated in the above figure has been achieved 
using the Bracketed ⇒Calibration Mode (set in the Global Calibration 
Settings section). The four less decayed standards 1-4 (from positions 1, 
2, 5, and 6) are used for calibrating the less decayed unknown samples 
(samples 1 and 2 from positions 3 and 4). The more decayed standards 3-6 
(from positions 5, 6, 9, and 10) are used to calibrate the higher decayed 
samples 3 and 4 from positions 7 and 8. The calibration curve shows the 
corresponding Calibration Points, only. 

For more information about the Bracketed mode see  Calibration 
Mode: Bracketed. 

 Tip: 
Knowing the half-life of an unstable substance (this is especially true for 
radioactive substances) is a clever way to calculate the chromatogram, as it 
would be without the decay. Use a virtual channel ( Virtual Channel 
Driver) to record all chromatograms in this special channel as if the 
substance would not decay. For a program example, refer to Practical 
Tips for Device Control  Program Examples for Virtual Channels. 
Having recorded these Virtual Signals, perform the calibration as 
described in the above examples for stable substances. 
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 

 No Pure Substance Available - Known Relative 
Extinction Coefficient  
If you wish to quantify substance A although the pure substance A is not 
available, calibration can be performed nevertheless if the ratio of the 
extinction coefficient to the extinction coefficient of a different substance B 
is known. First, create the corresponding sample list following the 
description in  Several Standards with Several Substances Each.  

Then, create the ⇒Amount columns for your standards. As the pure 
substance A is not available and thus is not contained in the standards, the 
cells for substance A remain empty in the Amount table:  
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The entry made in the ⇒Response Factor column is the decisive entry. 
This column allows you to use the calibration of substance B for substance 
A. Double-click the selected cell (see above) to open the Response Factor 
for Substance A dialog box and enter the factor of the extinction 
coefficient at the measuring wavelength between the two substances:  

B

A

Ext.Coeff
Ext.CoeffResp.Fact. =

 
Set the interpretation to Relative to Peak and select substance B: 

 

The resulting calibration curve is 75% of the Calibration Function of 
substance B. No calibration points are indicated in the calibration curve 
because no points were acquired for substance A: 
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Extinction coefficients depend on the measuring wavelength. Thus, enter 
the corresponding response factor needs for each channel. Create a 
separate Response Factor column for each channel: 

Select Columns on the context menu of the existing Response Factor 
column. Select Duplicate and then select a channel by clicking Add 
Channel. 

 Note: 
The calibration curve of the reference peak is the decisive factor. If 
possible, it should not have an offset. Otherwise, errors may occur when 
calculating the amount using the response factor. This is especially true for 
lower amounts. 

For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …: I  Calibrating. 

 Calibrating with an Internal Standard Substance 
Especially in gas chromatography but also in HPLC or IC, calibration using 
an internal standard substance, i.e., an Internal Standard (= ISTD), is 
used to eliminate possible measuring and sample preparation errors. 
Chromeleon provides different calibration possibilities using one single 
internal standard substance: 
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If several internal standard substances are available, the flow chart 
changes accordingly. For more information about the numbered options in 
the flow chart, refer to: 

1.  Compensating Measurement Errors (Internal Calibration) 
2.  Correcting Sample Preparation Errors (Internal/External 
Calibration) 
3.  Using Different ISTD Amounts (Variable ISTD) 
4.  Calibrating without Standard Samples 
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 Compensating Measurement Errors (Internal 
Calibration) 
It is possible to compensate measuring errors, such as deviations that 
occur during the injection, by calibrating with an internal standard 
substance, i.e., the Internal Standard. In the purely internal standard 
method, calibration is performed relatively to the internal standard 
substance, using area ratios instead of absolute areas.  

Sample List 

In the simplest case, only one standard sample is available. In this case, 
the sample list looks, for example, as follows:  

 
 
QNT Method/Amount Table Tab  

Enter the amounts of the single substances contained in the standard 
sample in the Amount column of the Amount table of the QNT Editor: 

 
 
QNT Method/Peak Table Tab  

The internal standard substance is defined in the peak table. If all three 
samples contain two relevant substances only as in the example, make the 
following entries in the Standard column, using the F8 input box. 
• For substance 1, select Use this peak as Internal Standard and thus 

define this substance as the internal standard. (The light yellow 
background of the line and the ISTD: Internal entry indicate that the 
assignment is correct.) 

• In the F8 input box of substance 2, select the option Internal. From the 
Associated ISTD Peak field, select the standard substance serving as 
internal standard (here: Subst. 1). 
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• If necessary, repeat this operation for every additional substance that 
should be calibrated based on the internal method. 

After completing the input, the substance 2 is labeled Internal Subst. 1 in 
the Standard column. In addition, substance 1 is labeled as the internal 
standard for internal calibration:  
 

 

Amount Calculation 
Chromeleon automatically calculates the amount values for the "unknown" 
substance. The calculation is performed according to the formula for 
amount calculation (rel. to ISTD) (for more information, refer to Formula 
for Amount Calculation (Rel. to ISTD) in the Glossary section). Chromeleon 
calculates the amount for substance 2 adapted by the deviation of 
substance 1. 

For detailed information about how to calculate the amount for unknown 
substances using internal calibration, refer to  Internal Calibration: 
Calculation.  
 
For an overview of the different calibration possibilities with internal 
standard substances provided by Chromeleon, refer to How to …: 
Calibration Examples  Calibrating with an Internal Standard 
Substance. 

 Internal Calibration: Calculation 
In the purely internal standard method, calibration is performed only by 
means of an internal standard substance, i.e., the Internal Standard. 
Calculation is performed using area ratios instead of absolute areas. That is 
why in the Formula for Amount Calculation (Rel. to ISTD) 

n
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p

ISTD

Peak
pp Weight
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Example 
In a clinic lab, prepared urine samples of two patients are examined for the 
catechol level. Adrenaline and dopamine are to be determined. Two 
standard solutions of different concentrations are available (STD 1: 50 ng/µl 
each; STD 2: 100 ng/µl adrenaline/dopamine each). To correct possible 
inaccuracies regarding the precise dosing of the autosampler, catechol is 
added. The internal standard method is selected. 20 µl of each unknown 
sample and each standard sample is mixed with 20 µl of the catechol 
solution. As the concentration of the added catechol solution is 10ng per µl, 
each sample and standard vial (40 µl) contains 10 x 20 = 200 ng catechol. 
This means that exactly 200/4 = 50 ng catechol is injected with each 10 µl 
injection. 

a) User Input 

Sample List 

 
 
In contrast to the examples in the external and internal/external calibration, 
the second calibration point is not determined by means of the modified 
injection volume but by means of a second standard sample with the 
double concentration. As a result, two different autosampler positions are 
used (1 and 2). 

QNT Method/Peak Table Tab  

 
 
As the calibration of adrenaline and dopamine is performed with two 
standard concentrations (STD 1, STD 2; different autosampler position in 
the sample list), two amount values are entered for each peak. Then, the 
internal standard substance is defined. 
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How to define the Internal Standard substance:  
• Select the Standard column in the Catechol line and open the F8 edit 

box.  

• Select the Use this peak as internal Standard option and thus define 
catechol as Internal Standard. 

The yellow coloring of the line and the ISTD: Internal entry indicate the 
correct assignment.  
• Change to the Standard column in the Adrenaline line and open the 

F8 edit box again. 

• Select the option Internal, and then select the standard substance 
serving as Internal Standard (here: catechol) in the Associated ISTD 
Peak field. 

• Perform this operation for each peak that should be calibrated with the 
Internal method (here dopamine). 

After completing the input, the following occurs: In the Standard column, 
alanine, and dopamine are labeled Internal Catechol. In addition, catechol 
is marked as the internal standard substance by a darker shade of yellow. 

 Note: 
In addition to the color changes from light yellow to dark yellow, there are 
two other possible colors. If the retention time is expressed depending on a 
selected reference peak (see ⇒Retention Time), a light blue background 
highlights this reference peak in the peak table. If this reference peak is 
also used as the internal standard peak, the corresponding line is displayed 
in green (blue + yellow = green).  

QNT Method/General Tab  
The Total mode is selected. This ensures that the calibration of all samples 
(Sample I and II) is performed based on all standard samples (STD 1, 
STD 2).  

QNT Method/Calibration Tab  
This page shows all standard samples (of a sequence) that are inserted for 
calibrating the current sample. 

Press the F4 key or the SHIFT+F4 key combination to successively open 
the sample of a sequence. The standard samples forming the basis for 
calibration are shown for each sample. 
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Due to the selected mode, sample I and II appear as follows:  

 

If you notice that an error occurred during the analysis of the standard 
sample, you can "exclude" this standard sample. Remove the standard in 
the Enable column on the Calibration tab page of the QNT Editor. Only 
the standard samples labeled X are considered for the calibration.  

b) Analysis Structure 
Injection is four times. During the first run, the first calibration point of the 
adrenaline and dopamine calibration curve is determined via STD 1, and 
during the second run the second point is determined accordingly via STD 
2. Run three serves to determine the concentration of adrenaline and 
dopamine in sample I. In the fourth run, the concentrations of adrenaline 
and dopamine in sample II are determined. In addition, the area of the 
added catechol is determined in each run. 

Chromeleon determines the following area values: 
 

Name Area Adrenaline Area Dopamine Area Catechol 
STD 1 125 200 250 
STD 2 250 400 250 
Sample I 223 150 245 
Sample II 178 380 255  

The area values determined for catechol reflect the ratio of the injected 
volume or amounts (except for minor inaccuracies). 

c) Calculation of relpAmount ,  and relpx ,  

The ratio of Area (Peak) to Area (ISTD) results in relpx , : 

ISTD

p
prel Area

Area
x =)(
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Substance Area Area (ISTD) x (p, rel) 
Adrenaline (STD 1) 125 250 0.5 
Adrenaline (STD 2) 250 250 1.0 
Dopamine (STD 1) 200 50 0.8 
Dopamine (STD 2) 400  1.6  

The ratio of Amount (Peak) to Amount (ISTD) results in relpAmount , : 

ISTD

Peak
relp Amount

Amount
Amount =),(

 
 

Substance Amount Amount (ISTD) Amount (p, rel) 
Adrenaline (STD 1) 50 50 1.0 
Adrenaline (STD 2) 100 50 2.0 
Dopamine (STD 1) 50 50 1.0 
Dopamine (STD 2) 100 50 2.0  

d) Calculation of the Calibration Coefficients 
A linear calibration curve through the origin (calibration type: Linear) can 
already be described by one calibration coefficient (c1). If the example is 
selected so that the calibration points in each calibration curve are located 
exactly on a straight line, that is, for example, in an exact measurement, c1 
results as the y/x-quotient of each value pair Amount p rel to x p rel: 
 

Substance Amount (p rel) / x (p rel) c1 
Adrenaline 1.0/0.5 2.000
Adrenaline 2.0/1.0 2.000
Dopamine 1.0/0.8 1.250
Dopamine 2.0/1.6 1.250 

If the calibration points are not located exactly on one line, Chromeleon 
calculates an optimized c1 approximate value for each substance.  

If a different calibration type is selected, Chromeleon calculates the 
corresponding calibration coefficients (c0, c1, and c2). 
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e) Amount Calculation 
By means of the Formula for Amount Calculation, the relative amount 
(=relative to the amount of the ISTD) of the sample content adrenaline and 
dopamine can be calculated from the known c1 and from the ratio peak 
area (sample) to peak area (ISTD). If the ⇒Dil. Factor (Dilution Factor) and 
⇒Weight (Sample Weight Factor) correction factors are assumed to be 1, 
the following Amount/Amount ISTD values result: 
 

Sample I Calculation: Amount/Amount ISTD 
Adrenaline 2.000 x (223/245) = 1.820 
Dopamine 1.250 x (150/245) = 0.765  
Sample II Calculation: Amount/Amount ISTD 
Adrenaline 2.000 x (178/255) = 1.396 
Dopamine 1.250 x (380/255) = 1.863  

By multiplication with the amount values of the internal standard substance, 
the actual amount values for adrenaline and dopamine in the analysis 
samples can be calculated.  
 

Sample I Calculation: Amount 
Adrenaline 1.820 x 50 = 91.00 [ng] 
Dopamine 0.765 x 50 = 38.25 [ng]  
Sample II Calculation: Amount 
Adrenaline 1.396 x 50 = 69.80 [ng] 
Dopamine 1.863 x 50 = 93.15 [ng]  

For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 

 Correcting Sample Preparation Errors (Internal/External 
Calibration) 
It is possible to eliminate errors occurring during sample preparation by 
calibrating using the internal/external method. If you use the 
internal/external method, an internal standard substance, i.e., the Internal 
Standard (= ISTD), is used to adapt the external calibration to the 
corresponding sample. Exactly that amount of the internal standard 
substance is added to each standard sample and each unknown sample 
that makes sure that the concentration is identical in all sample vials. The 
following entries are required: 
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Sample List 

In the simplest case, only one standard sample is available. In this case, 
the sample list looks, for example, as follows:  

 

QNT Method/Amount Table Tab  

Enter the amounts of the single substances contained in the standard 
sample in the Amount column of the Amount table of the QNT Editor: 

 

QNT Method/Peak Table Tab  

The internal standard substance is defined in the peak table. If all three 
samples contain two relevant substances only as in the example, make the 
following entries in the Standard column, using the F8 input box. 
• For substance 1, select Use this peak as Internal Standard and thus 

define this substance as the internal standard substance. (The light 
yellow background of the line and the ISTD: Internal entry indicate that 
the assignment is correct.) 

• In the F8 input box of substance 2, select Internal/External. In the 
Associated ISTD Peak field, select the standard substance serving as 
internal/external standard (here: Subst. 1). 

• If necessary, repeat this operation for every additional substance that 
should be calibrated based on the internal/external method. 

After completing the input, the substance 2 is labeled Int/Ext Subst. 1 in 
the Standard column. In addition, substance 1 is labeled as the internal 
standard for internal/external calibration. The description ISTD: Internal is 
changed to ISTD: Int/Ext and the yellow coloring of the Subst. 1 line is 
intensified: 
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Amount Calculation 
Chromeleon automatically calculates the amount values for the substance 
2. The calculation is performed according to the formula for amount 
calculation (for more information, refer to Formula for Amount Calculation 
in the Glossary section). In case of internal/external calibration, the ISTD 
factor is used to correct the external calibration, using the ISTD amount 
determined for the respective sample.  

The ISTD factor considers the ratio of the (nominal) amount entered in the 
peak table to the amount that was determined for the respective sample 
due to the peak area: 

)(

)(

SampleISTD

PeakTableISTD

Amount
Amount

FactorISTD =
 

 
Using this formula, Chromeleon calculates the amount for substance 2 that 
has been adapted by the deviation of substance 1.  

For detailed information about how to calculate the amount of unknown 
substances using internal/external calibration, refer to  Internal/External 
Calibration: Calculation.  

For an overview of the different calibration possibilities with internal 
standard substances provided by Chromeleon, refer to How to …: 
Calibrating  Calibrating with an Internal Standard Substance. 

 Internal/External Calibration: Calculation 
In a calibration with the internal/external method, external calibration is 
adapted to the corresponding sample, by using an internal standard 
substance, i.e., an Internal Standard (= ISTD): 

Each standard sample and each unknown sample is added exactly that 
amount of internal standard substance to make sure the concentration is 
identical in each vial. The internal standard substance and the substance to 
be determined are calibrated using known standard solutions; that is, the 

Calibration Coefficients are determined from the ⇒Amount values of the 
standard sample and the corresponding peak area values by means of the 

Calibration Function. Thus, the amounts of all substances (including the 
ISTD) can be determined. As the concentration of the internal standard 
substance is identical in all samples, the same ISTD amount should result.  

If this is not the case, an error occurred in the chromatography system 
(sample preparation, injection, carry-over, etc). The deviation of the actual 
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ISTD amount from the nominal ISTD quantifies of the error. If the 
substances to be determined and the internal standard substance are 
similar, it can be assumed that the values of the remaining contents of the 
sample deviate in the same way; that is, they are incorrect. A correction by 
the deviation of the nominal and the actual internal standard substance 
supplies the actual values.  

Example: 
You want to determine the concentration of alanine and glycine in two 
samples. One standard sample is available. The internal standard 
substance norvaline is added to all three sample vials, so that the final 
concentration is 10 mmol/l. During the subsequent pre-column 
derivatization, 10 µl sample + 20 µl OPA reagent + 20 µl stop reagent are 
pipetted together. A constant concentration of 2 mmol/l is added from the 
norvaline. The chromatographic separation follows the derivatization of the 
amino acids in OPA derivatives. 10 and 20 µl of the standard solution 
( Dilution Series) and 10 µl of each sample (autosampler position 2 and 3) 
are injected. 

a) User Input: 

Sample List 

 

QNT Method/Peak Table Tab  

 
 
As the calibration of alanine and glycine is performed with only one (STD 1) 
standard concentration (same autosampler position in the sample list), only 
one amount value is be entered for each peak. Then, the internal standard 
substance is defined. 
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How to define the Internal Standard substance 
• In the Norvaline line, select the Standard column and open the F8 edit 

box. 

• Select Use this peak as internal Standard and thus define norvaline 
as the internal standard substance. 

A light yellow background and the ISTD: Internal entry indicate that the 
assignment is correct. 
• In the Alanine line, change to the Standard column and open the F8 

edit box again. 

• Select the option Internal/External. In the Associated ISTD Peak 
field, select the standard substance serving as Internal/External 
Standard (here: norvaline). 

• Repeat this operation for each peak that should be calibrated using the 
Internal/External method (here: glycine). 

After completing the input, the following occurs: In the Standard column, 
alanine and glycine are labeled Int/Ext Norvaline. In addition, norvaline is 
labeled as the internal standard for the Internal/External calibration. The 
ISTD: Internal description is changed to ISTD: Int/Ext and the yellow 
coloring of the norvaline line intensifies. 

 Note: 
In addition to the color changes from light yellow to dark yellow, there are 
two other possible colors. If the retention time is expressed depending on a 
selected reference peak (see ⇒Retention Time), a light blue background 
highlights this reference peak in the peak table. If this reference peak is 
also used as the internal standard peak, the corresponding line is displayed 
in green (blue + yellow = green).  

QNT Method/General Tab  
The Total mode is selected. This ensures that the calibration of all samples 
(Samples I and II) is performed based on all standard samples (STD 1). 

QNT Method/Calibration Tab  
The page shows all standard samples (of a sequence) that are used for 
calibrating the current sample. 
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Press the F4 key or the SHIFT+F4 key combination to successively open 
the samples of a sequence. The standard samples forming the basis for 
calibration are shown for each sample. 

Due to the selected mode, samples I and II appear as follows: 

 

If you notice that an error occurred during the analysis of the standard 
sample, you can "exclude" this standard sample. Remove the standard in 
the Enable column on the Calibration tab page of the QNT Editor. Only 
the standard samples labeled X are considered for the calibration.  

b) Analysis Structure: 
Injection is four times. During the first run, the first calibration point of the 
calibration curve is determined, and during the second run, the second 
point is determined. Run three serves to determine the concentration of 
alanine and glycine in sample I. In the fourth run, the concentrations of 
alanine and glycine in sample II are determined. 

Chromeleon determines the following area values: 
 

Name Area Alanine Area Glycine Area Norvaline 
STD 1 (first run)  55  80  40 
STD 1 (second run)  110  160  80 
Sample I  45  75  39 
Sample II  80  150  41  

The determined area values of the internal standard substance norvaline 
reflect the ratio of the injected volumes (amounts), except for minor 
inaccuracies. 

c) Calibration Points 
From the known amount values and from the determined area values of the 
standard samples, the value pairs of the individual calibration points can be 
established: 
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Substance Area value Amount value [1] Amount value [2] 
Alanine  45  50   
Alanine  90    100 
Glycine  80  50   
Glycine  160    100 
Norvaline  40  20   
Norvaline  80    40  

Chromeleon determines all calibration coefficients, depending on the 
selected calibration function. 

d) Calculation of the Calibration Coefficients  
A linear calibration curve through the origin (calibration type Linear) can 
already be described by one calibration coefficient (c1). If the example is 
selected so that the calibration points in each calibration curve are located 
exactly on a straight line, that is, for example, in an exact measurement, c1 
results as the y/x-quotient of each value pair (= slope of the calibration 
curve). 

Substance y/x-Value pair c1 
Alanine  50/45 1.111 
Alanine  100/90 1.111 
Glycine  50/80 0.625 
Glycine  100/160 0.625 
Norvaline  20/40 0.500 
Norvaline  40/80 0.500  

If the calibration points are not located exactly on one line, Chromeleon 
calculates an optimized c1 approximate value for each substance. If a 
different calibration type were selected, Chromeleon would also calculate 
the remaining calibration coefficients (c0 and c2) according to the 
calibration function. 

e) Amount Calculation: Internal Standard Substance in Unknown 
Samples 
If the area values of the internal standard substances from samples I and II 
are known, the amount of the internal standard substance norvaline can be 
determined in the two samples by means of the calibration coefficient c1 
(here = 0.5) established for the calibration curve of the norvaline. 
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Sample Calculation Amount (ISTD)
I 39 x 0.5 19.50 
II 41 x 0.5 20.50  

The ratio between the (nominal) amount value entered in the peak table 
and the ⇒ISTD Amount (Amount of the Internal Standard) of the internal 
standard in the corresponding sample is referred to as ISTD factor.  

)(

.)(

SampleISTD

TabPeakISTD

Amount
Amount

FactorISTD −=−
 

The following values are resulting: 
 

Sample Calculation ISTD Factor 
I 20 / 19.5 = 1.026 
II 20 / 20.5 = 0.976  

The result states that an error was made by 1.026 (sample 1) or 0.976 
(sample 2). The actual amounts of alanine and glycine deviate in all 
probability by 2.6 or 2.4% from the "real" values. They are corrected by this 
amount. 
 

f) Amount Calculation: Alanine and Glycine 
The amount values of glycine and alanine are calculated by means of the 

Formula for Amount Calculation. In contrast to an external calibration, 
ISTD Factor is not equal to 0; i.e., the results are corrected by the 
calculated ISTD factor. 
 

Sample Calculation (Area x c1 x ISTD Fact. =) Amount 
I 45 x 1.111 x 1.026 = 51.30 (Alanine) 
I 90 x 0.625 x 1.026 = 54.90 (Glycine) 
II 80 x 1.111 x 0.976 = 86.75 (Alanine) 
II 160 x 0.625 x 0.976 = 97.60 (Glycine)  

The alanine or glycine amount values corrected by the norvaline deviation 
are resulting. 
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 
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 Using Different ISTD Amounts (Variable ISTD) 
Due to the method itself or the properties of the internal standard 
substance, i.e., the Internal Standard, it is sometimes impossible to add 
exactly the same amount of ISTD. To solve this problem, Chromeleon 
provides the Use sample amount as reference (Variable Internal 
Standard) option. Use this option to define the ISTD as variable internal 
standard substance. (Access to the option is via the F8 box of the 
Standard column in the peak table). 

In this case, you do not need to enter the amount of the internal standard 
substance in the Amount column of the peak table (this is not possible), 
but in the ⇒ISTD Amount column of the sample list. It is not important 
whether Internal/External or Internal is selected as calibration method. In 
this way, it is possible to enter the amount of an internal standard 
substance separately for each sample. The following entries are required: 

Sample List 
Enter the amount of the internal standard substance directly in the ISTD 
Amount column of the sample list: 

 
 
QNT Method/Peak Table Tab  
Except the substance serving as internal standard, enter all amount values 
as before. Then, select the internal standard substance as follows: 

If all three samples contain two relevant substances only as in the example, 
make the following entries in the Standard column, using the F8 input box. 
• For substance 1, select Use this peak as Internal Standard and thus 

define this substance as the internal standard.  

• In addition, enable the Use sample amount as reference (Variable 
Internal Standard) option to define the ISTD as variable internal 
standard substance. 

The yellow coloring of the line and the ISTD: Var. Internal or ISTD: Var. 
Int/Ext entry indicate that the assignment is correct. The corresponding 
Amount column cells are automatically set to 1.  
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Make all other QNT File entries as before. The peak table appears as 
follows: 

 
 
QNT Method/Amount Table Tab  

Enter the amount values for the unknown substances contained in the 
standard sample in the Amount column of the Amount table of the QNT 
Editor: 

 
 

Evaluation 
Evaluation is similar to the corresponding evaluation with a constant 
amount of the internal standard substance. However, slightly different 
calibration and evaluation formulas are used.  

For a detailed description of the differences between standard methods, 
refer to Calibration  Evaluation with Various Standard Methods. 

For an overview of the different calibration possibilities with internal 
standard substances provided by Chromeleon, refer to How to …:  
Calibrating  Calibrating with an Internal Standard Substance. 

 Calibrating without Standard Sample 
If you calibrate with an internal standard substance, i.e., an Internal 
Standard, you may as well perform the calibration without standard 
samples. The prerequisite is that you know the relative ⇒Response Factor 
of the respective substance for the ISTD. The following entries are 
required: 
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Sample List 

Assign all samples the Unknown sample type. Enter the amount for the 
ISTD in the ISTD Amount column: 

 
 
QNT Method/General Tab  

On the General tab page, select Fixed as ⇒Calibration Mode. 
 
QNT Method/Peak Table Tab  

The internal standard substance is defined in the peak table. If all three 
samples contain two relevant substances only as in the example, make the 
following entries in the Standard column, using the F8 input box. 
• For substance 1, select Use this peak as Internal Standard and 

enable the Use sample amount as reference (Variable Internal 
Standard).  

• In the F8 input box of substance 2, select Internal. In the Associated 
ISTD Peak field, select the standard substance serving as internal 
standard (here: Subst. 1). 

• If necessary, repeat this operation for every additional substance that 
should be calibrated based on the internal method. 

After completing the input, the substance 2 is labeled Var. Internal Subst. 
1 in the Standard column. In addition, substance 1 is labeled ISTD Var. 
Internal to indicate that substance 1 is used as internal standard for the 
internal calibration: 
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QNT Method/Amount Table Tab  

Define the corresponding calibration curve in the Amount table of the QNT 
Editor: 
• Enter =1.000 as C1 value for both the ISTD and the unknown 

substance. 

 Tip:  
Do not recalibrate afterwards by clicking Calibrate on the General tab 
page because this action overwrites the values for the Calibration 
Coefficient. 

• Enter the known response factor. This factor automatically refers to the 
ISTD because the ISTD is used for calibration. It is not necessary to 
define the ISTD as reference. 

 
 

Amount Calculation 
Chromeleon automatically calculates the amount values for the substance 
2. The calculation is performed according to the formula for amount 
calculation (rel. to ISTD) (for more information, refer to Formula for 
Amount Calculation (Rel. to ISTD) in the Glossary section). In case of 
internal calibration, the external calibration of the internal standard 
substance is adapted to the corresponding sample, using the area ratio of 
the peak to the ISTD in the corresponding sample. In addition, in this 
special case, the response factor is used to take the absorption of 
substance 2 in relation to the ISTD (here: Subst. 1) into account. 

Chromeleon calculates the amount for substance 2 adapted by the 
deviation of substance 1. 

For detailed information about how to calculate the amount for unknown 
substance using internal calibration, refer to  Internal Calibration: 
Calculation.  

For an overview of the different calibration possibilities with internal 
standard substances provided by Chromeleon, refer to How to …: 
Calibrating  Calibrating with an Internal Standard Substance. 
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 Calibration Modes for External Calibration 

The ⇒Calibration Mode determines the standard samples that are used for 
calibrating specific unknown samples. The following calibration modes are 
available: 
 
Calibration Mode Description 

Total All standard samples of the current sequence 
Group Grouping calibration 
Additional Additional standard samples for the samples that appear later in the 

sequence. 
Bracketed Unknown samples are "bracketed" by standard samples. 
Fixed Specific standard samples (also from other sequences)  
For a schematic representation of the Group, Additional, and Bracketed 
calibration modes, refer to the example below: 

 
 
For more information about the different calibration modes including 
calibration curve calculation, refer to the topics below: 

 Calibration Mode: Total 
 Calibration Mode: Additional 
 Calibration Mode: Group 
 Calibration Mode: Bracketed 
 Calibration Mode: Fixed 

 

 Note: 
Please note that the procedure is described for the Total mode. All other 
examples describe the differences between the calibration modes only.  
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 Calibration Mode: Total 
If standard samples exist, the ratio between the amount and the peak area 
can be used to calculate the calibration coefficients c0 (offset), c1 (slope), 
and c2 (curvature) by means of the selected Calibration Function. The 
resulting values are entered in the Formula for Amount Calculation, 
together with the area values of the substance of an unknown sample. As 
the result, Chromeleon provides the ⇒Amount of substance A in the 
unknown sample. You can also use the concentration instead of the 
amount. However, in this case, the concentration must be seen in relation 
to the injection volume. 

Example: 
You want to determine the concentration of the substances A and B in two 
samples (Sample 1 and Sample 2). One standard solution (Std 1) is 
available containing substance A in a concentration of 12 mg/l and 
substance B in a concentration of 17 mg/l. The calibration curve for 
substances A and B shall be linear and run through the origin (calibration 
type: linear). The curve shall show two calibration points for each 
substance. As only one standard solution is available, two different volumes 
(10 and 20 µl) must be injected ( Dilution Series). Two Calibration Points 
are resulting. The autosampler injects a volume of 10 µl for the two 
unknown samples. The standard and analysis samples occupy the 
autosampler positions R99, RA1, and RA2.  

a) User Input 

Sample List 

 

For more information, refer to How to …: Creating and Managing Files 
and Data  Creating a Sample List (Sequence). 
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QNT Method/Peak Table Tab  

 

Regarding this example, note the following:  
• Select the External standard method in the Standard column using the 

F8 edit box. 

• Only one standard concentration (Std 1) is available for calibrating the 
substances A and B. That is why one concentration value for each 
substance is entered in the Amount column of the peak table. The 
same applies if several sample list entries are generated by analyzing 
the same standard sample several times (twice, in this case). If the 
injection volume is identical, the calibration is referred to as 1-point 
calibration with several replicates. If the injection volume varies (10 and 
20 µl) as in this case, this is referred to as multiple-point calibration, 
that is, 2-point calibration. This is a special case of the Dilution Series 
("concentration series"). 

However, if two separate standards with different concentrations are 
available (two vials, different autosampler positions), two concentration 
values need to be entered in the Amount column of the peak table. 

All other entries in the peak table are based on the criteria described in 
How to …: Integrating Chromatograms and Identifying Peaks 

 Creating a Peak Table. 
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QNT Method/General Tab  
To calibrate all samples (here: samples 1 and 2) with the two standard 
samples, select the Total ⇒Calibration Mode. 

 

QNT Method/Calibration Tab  
This page shows all standard samples (of a sequence) that are used for 
calibrating the current sample.  

 
 
Press the F4 key or the SHIFT+F4 key combination to successively open 
all samples of a sequence. The standard samples used for calibrating the 
sample are shown for each sample.  

If you notice that an error occurred during the analysis of the standard 
sample, you can "exclude" this standard. Remove the standard in the 
Enable column on the Calibration tab page of the QNT Editor. Only the 
standard samples labeled X are considered for the calibration.  

b) Analysis Structure 
Injection is four times. During the first run, the first calibration point of the 
calibration curves of the substances A and B is determined on the basis of 
the determined area values. In the second run, the second point is 
determined accordingly. Run three serves to determine the area values of 
the substances A and B of sample 1. In the fourth run, the area values of A 
and B of sample 2 are determined. 
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The following area values are resulting: 

Name Area Subst. A Area Subst. B 
STD 1 (first run) 150 200 
STD 2 (second run) 300 400 
Sample I 175 150 
Sample II 95 180  

c) Calculation of the Calibration Coefficients  
From the area values of the standard samples and the corresponding 
concentration values, you can determine the four value pairs. The 
intersection of each value pair represents a calibration point. Based on the 
selected calibration type (in the example:  Calibration Type (Linear)), 
Chromeleon calculates the optimum course of the calibration curve; that is, 
the system tempts to find a course with four calibration points on or near 
the curve. If the course of the curve is established, the corresponding 
calibration coefficients (c0, c1, c2) can be calculated. 

Substance y/x-value pair c1 
A 
A 
B 
B 

12/150 
24/300 
17/200 
34/400 

0.08 
0.08 

0.085 
0.085  

With a linear course through the origin, the calibration curve can be 
described by one single coefficient (c1). C1 expresses the slope of the 
curve. If all calibration points are located exactly on the calibration line, the 
resulting c1 calibration coefficient is the direct y/x-quotient of each value 
pair.  
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If the calibration points are not located exactly on one line, Chromeleon 
calculates an optimized approximate c1 value for each substance from the 

Calibration Function.  

If a different calibration type (Theory of Calibration  Calibration Type 
(Non-Linear)) is used, Chromeleon also calculates the remaining 
calibration coefficients (c0 and c2). 

d) Amount Calculation  
If the calibration coefficients of a substance A are known, each area value 
from an unknown sample for substance A can be converted into an amount 
value by inserting the values in the calibration function. When inserting this 
value into the Formula for Amount Calculation, the actual amount value 
will result.  

When you perform this action for the peak areas of the substances A and B 
in samples I and II (the correction factors of the formula for amount 
calculation are assumed with 1.0), the following amount values are 
calculated:  

Sample Calculation Amount. A Amount B 
I 175 x 0.08 14.00  
I 150 x 0.085  12.75 
II 95 x 0.08 7.60  
II 180 x 0.085  15.30  

For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 

 Calibration Mode: Additional 
The following example illustrates the difference between the Total and 
Additional ⇒Calibration Modes.  

Independently from the standard method, this mode determines which 
standard samples are used for evaluating a specific unknown sample. The 
position of the unknown sample in the sample list is decisive here.  
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Extending the Example: External Calibration/Mode: Total 
Two standard samples are injected after two unknown autosampler have 
been injected. This results in an alternating list of two standard samples: 
two unknown samples, two standard samples, etc. All other settings are 
maintained; that is, two-point calibration is performed. The calibration is 
verified by additional replicates. 

a) User Input: 

Sample List 

 
 
QNT Method/Peak Table Tab  
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QNT Method/General Tab  
If the user selects the Additional mode, each unknown sample is 
evaluated based on the standard samples analyzed so far.  

 

This means: 

As before, samples I and II are evaluated by means of a two-point 
calibration. However, four analyzed standard samples are available for the 
samples III and IV. The result is a two-point calibration with two replicates 
each. Finally, the samples V and VI are evaluated by means of a two-point 
calibration with three replicates each. 

QNT Method/Calibration Tab  
The page shows all standard samples (of one sequence) that can be used 
for calibrating the current sample. 

Press the F4 key or the SHIFT+F4 key combination to successively open 
the samples. The standard samples forming the basis for calibration are 
shown for each sample. 

Thus, two standard samples are displayed for the samples I and II, four 
standard samples are displayed for the samples III and IV, and six standard 
samples are displayed for the samples V and VI (see below).  
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If you notice that an error occurred during the analysis of the standard 
sample, you can "exclude" this standard. Remove the standard in the 
Enable column on the Calibration tab page of the QNT Editor. Only the 
standard samples labeled X are considered for the calibration.  

b) Evaluation: 
Evaluation is similar to the example with external calibration (mode: Total). 
The only difference is: 

The calibration curve is created for the different samples based on a 
different number of replicates.  

This can affect the calculated calibration coefficients and thus the result, 
but does not necessarily do so. Normally this type of calibration is used to 
adapt to changed column conditions. Thus, it may happen that after a 
several samples, a specific substance cannot elute 100 percent from the 
column. As this will also be the case with the standard substance, the result 
is automatically corrected.  
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:  Calibrating. 

 Calibration Mode: Group 

The Group ⇒Calibration Mode completes the Total and Additional 
modes. The Group mode is used when there are time-dependent 
modifications during the analysis, for example, decomposition of the 
analyzed substance. 

The mode is described using the example of the Additional mode (sample 
list of alternating sample pairs (2 standards, 2 samples, 2 standards, etc.).  
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a) User Input: 

Sample List 

 
 
QNT Method/Peak Table Tab  

 
 
QNT Method/General Tab  
If the user selects the Group mode, each sample is evaluated based on the 
standard sample in the sample list that has been analyzed immediately 
before.  

QNT Method/Calibration Tab  
This page indicates all standard samples (of a sequence) that are used for 
calibrating the current sample.  

Press the F4 key or the SHIFT+F4 key combination to successively open 
the sample of a sequence. The standard samples forming the basis for 
calibration are shown for each sample. 

This means in the example that in the Group mode the standard samples 
from the lines 1 and 2 are displayed for the samples I and II. The standard 
samples from lines 5 and 6 are displayed for the samples III and IV, and the 
standard samples from lines 9 and 10 for the samples V and VI. 
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b) Evaluation: 
Evaluation is similar to the examples with the external calibration (modes: 
Total and Additional). The only difference is that the calibration curve is 
constantly updated without considering the previously analyzed standard 
samples.  

For the example, this means: 

Samples I and II are evaluated by means of a two-point calibration of the 
standard samples in the lines no. 1 and 2. 

In contrast to the Additional mode, samples III and IV are also evaluated 
by means of a two-point calibration. However, only the standard samples 
STD 1 from lines no. 5 and 6 are used.  

Correspondingly, the samples V and VI are evaluated by means of the 
standard samples STD 1 in the lines no. 9 and no. 10. 
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 

 Calibration Mode: Bracketed 
In a bracketed calibration, a standard sample is included in a series of 
unknown samples so that modifications, such as column or detector drift, 
can also be considered in the calibration function. Amount calculation of an 
unknown sample is always performed using the calibration coefficients of 
the surrounding standard samples. 

New Example 
You want to determine the concentration of substance A in four samples 
(Samples I-IV). Two standard solutions (STD 1, STD 2) of substance A with 
different concentrations (50 and 100ng/µl) are available for external 
calibration. At the beginning, after the second and after the fourth sample, a 
two-point calibration is to be performed. To receive exacter results, a 
bracketed calibration is performed. The basis for calibrating samples I and 
II is provided by standards STD 1 and STD 2 from lines no. 1, 2, 5, and 6, 
while the samples III and IV are calibrated on the basis of the standards no. 
5, 6, 9, and 10. 
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a) User Input: 

Sample List 

 
 
QNT Method/Peak Table Tab  

The external calibration (Standard = External) is performed via two 
standard samples (autosampler positions 10 and 11) of different 
concentrations. In contrast to the Total, Additional, and Group examples, 
two different ⇒Amount values must be entered in the corresponding 
amount columns [1] and [2] of the peak table. 

 
 
QNT Method/General Tab  

To evaluate each sample based on the neighboring standard samples in 
the sample list, select the Bracketed ⇒Calibration Mode.  

QNT Method/Calibration Tab  

This page shows all standard samples (of a sequence) that are used for 
calibrating the current sample. 

Press the F4 key or the SHIFT+F4 key combination to successively open 
the samples of a sequence. The standard samples forming the basis for 
calibration are shown for each sample. 
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For the samples I and II, the page will look is as follows:  

 
 
For the samples III and IV, the page will look as follows:  

 
 
Note that the standards in line 5 and 6 are determined only once.  

b) Analysis Structure: 
Injection is eight times. The following area values are determined: 

Name Area substance A 
STD 1 (conc.1) 218 
STD 2 (conc.2) 439 
Sample I 167 
Sample II 152 
STD 1 (conc.1) 224 
STD 2 (conc.2) 442 
Sample III 283 
Sample IV 305 
STD 1 (conc.1) 219 
STD 2 (conc.2) 441  

c) Calculation of the Calibration Coefficients  
From the determined area values of the standard samples and the amount 
values from the peak table, the value pairs of the six calibration points can 
be listed. Note that depending on the standard (STD 1 or STD 2) the 
amount value is once taken from the Amount [1] peak table column and 
once from the Amount[2] column. 
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No. Substance y/x-value pair y/x c1 (K1) c1 (K2) 
1 STD 1 (conc.1) 50/218 0.2294 0.2267  
2 STD 2 (conc.2) 100/439 0.2278 0.2267  
5 STD 1 (conc.1) 50/224 0.2232 0.2267 0.2261 
6 STD 2 (conc.2) 100/442 0.2262 0.2267 0.2261 
9 STD 1 (conc.1) 50/219 0.2283  0.2261 

10 STD 2 (conc.2) 100/441 0.2268  0.2261  
If all calibration points are used simultaneously, a two-point calibration with 
three replicates of the same calibration level results.  

As amount determination of samples I and II or III and IV is performed only 
according to the neighboring standard samples, there are two calibrations 
for substance A instead of one. Each calibration is a two-point calibration 
with two replicates each. That is why Chromeleon calculates two different 
sets of calibration coefficients.  

If a linear calibration function without offset is assumed as in the previous 
examples, Chromeleon determines two different c1-values. One value (K1) 
is calculated for the numbers 1, 2, 5, and 6, and another value (K2) is 
calculated for the numbers 5, 6, 9, and 10. 

d) Amount Calculation  
If the calibration coefficients of a substance A are known, the amount of 
substance A contained in each sample can be calculated by inserting the 
peak areas determined from the unknown samples in the calibration 
function. Inserting this value in the Formula for Amount Calculation 
returns the actual amount value. 

If this action is performed for the determined peak areas of substance A in 
the samples I and II (taking K1 into account), the following amount values 
are calculated (the correction factors of the formula for amount calculation 
are assumed to be 1.0):  

Sample Calculation Amount A 
I 167 x 0.2267 37.86 
II 152 x 0.2267 34.46  

For the samples III and IV, the result is as follows (taking K2 into account):  
Sample Calculation Amount A 

III 283 x 0.2261 63.99 
IV 305 x 0.2261 68.96 
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 Tip: 
Calculation of the amount values is continuously; that is, after analyzing an 
unknown sample, the values are calculated based on the standard samples 
calculated so far! 

Calculation of the area values of samples I and II is performed depending 
on the current processing status, first with one, then with two and three, 
and finally with four standard samples. The same applies to the samples III 
and IV that are evaluated based on the standard samples in the lines 5,6,9, 
and 10 of the sample list.  

For example, if a Report is generated after each sample, it will only 
include the results from the samples analyzed so far. The result may differ 
from the final result.  

In the Bracketed ⇒Calibration Mode, processing of all standard samples 
should be completed before printing the results. 
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:  Calibrating. 

 Calibration Mode: Fixed 
To use any desired standard samples of an existing calibration for 
determining current unknown samples, perform calibration based on the 
Fixed ⇒Calibration Mode. 

 Caution: 
Always perform the calibration manually (Calibrate). The Auto-Recalibrate 
option is not available. 

a) User Input: 
Sample List 

Only unknown samples are entered. If the sample list is generated using 
the Sequence Wizard, decide whether to refer to an existing QNT File 
(which is recommended) or whether to leave out this information. When 
closing the Wizard, Chromeleon recognizes that the sequence does not 
contain any standard samples and copies the QNT File with the entire 
information to the sequence directory. The Fixed mode is selected at the 
same time.  
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If no QNT File is defined in the Sequence Wizard, enter the file name in the 
Method column of the sample list after the QNT File has been created. 

QNT Method/Peak Table Tab  

If an existing QNT File is copied, a peak table already exists. Change the 
table according to your requirements. 

However, if a new (empty) QNT File is used, a new peak table must also be 
created. It is not necessary to enter the ⇒Amount because calibration is 
based on an existing calibration. 

QNT Method/General Tab  
If an existing QNT File is copied in which the Fixed calibration mode is 
selected, this mode is automatically selected.  

If a new QNT File was generated, select the Fixed mode. Determine the 
standard samples to be used for calibration on the Calibration tab page. 

QNT Method/Calibration Tab  
If a QNT File was copied, this page lists all standard samples to which the 
QNT-File originally referred. 

With each newly created QNT File, no standard samples are listed. Select 
Insert Standard or Append Standard on the context menu to insert the 
standard samples to be used for calibration and to evaluate the current 
samples according to their results.  

The standard samples listed here always apply to all samples of a 
sequence. Press the F4 key or the SHIFT+F4 key combination to display 
the same maximum number of standard samples. 

b) Analysis and Evaluation 
Performing the analysis and the evaluation of the individual samples is 
similar to the previous examples. 
 
For an overview of the different calibration possibilities provided by 
Chromeleon, refer to How to …:   Calibrating. 
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Entering the Concentration/Amount of the 
Validation Sample 

Validation Samples are used to check the calibration. They correspond to 
standard samples in as much as the amount of analyte is known. They are 
used to validate the calibration, but not to determine the calibration curve.  

Enter the known concentration (or amounts) of the different analytes in the 
validation samples in the QNT Editor. The two sections below explain the 
ways in which the validation and standard samples can interact and the 
most common means to implement them. It is up to each user to decide 
which method is appropriate for a particular application. 

1. The validation sample is equal to the standard sample 
All individual concentrations/amounts correspond to the 
concentrations/amounts of a standard sample that has already been used 
for the calibration curve, especially if the validation sample is injected from 
a vial containing standard sample. 

In this case, an ⇒Amount column for the corresponding standard sample is 
already available in the QNT Editor. The validation sample should have 
already been assigned to the correct vial. To verify this, proceed as follows: 
• On the Amount Table tab page, place the cursor in the header of the 

Amount column of the corresponding standard sample. Double-click 
the column header to open the Edit Amount Columns dialog box. 

• Select an Amount column (or Unassigned) in the Amount Column 
window to display the associated standards. 

• Select one or more validation samples ( ) in the Standards window 
and drag them to the appropriate column in the Amount Column 
window. 

• Click OK to close the dialog box and return to the amount table. 

All values in the Amount column now apply to the validation sample(s), 
also.  
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2. The validation sample is not equal to the standard sample 
When using a validation sample whose composition is different from all 
standard samples (if only in its concentration of amount of one analyte), a 
separate Amount column must be created for the validation sample. Follow 
the steps below: 

• On the Amount Table tab page of the QNT Editor, double-click the 
header of an existing Amount column (or select Columns > Edit 
Amount Columns on the Edit or context menu) to open the Edit 
Amount Columns dialog box. 

• Click New, type a unique column name in the edit field that appears in 
the Amount Column window, and press Enter. 

• Select an Amount column (or Unassigned) in the Amount Column 
window to display the associated standards.  

• Select one or more validation samples ( ) in the Standards window 
and drag them to the new column in the Amount Column window. 

• If the column created for the validation sample is valid for other 
validation samples or for standard samples, assign the additional 
standards as described in The validation sample is equal to the 
standard sample.  

• Click OK to close the dialog box. 

For information about how to use the validation sample to check the 
calibration curve, refer to  Validating the Calibration Curve.  

For an overview of the calibration options provided by Chromeleon, refer to 
How to …:   Calibrating. 
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Displaying Calibration Curves  
Chromeleon displays the Calibration Curve calculated from the 

Calibration Points in the Calibration Curve window. The Calibration tab 
page of the Report allows you to display the calibration data of the peaks 
of the active chromatogram.  

If a single standard was excluded from the calculations (Enabled column) 
on the Calibration tab in the QNT Editor, the corresponding calibration 
point is red. Calibration points of this type will not be used for calculating 
the calibration curve(s) for which they were disabled (see  Disabling the 
Calibration Sample). The display color of the calibration points of the 
current sample is purple.  

In the Calibration Curve, select Disable Standard on the context menu to 
exclude standards, completely or in part, from the calibration. The Disable 
(Enable) Standard xyz dialog box appears for the selected calibration 
point. (This point refers to the selected peak in the active chromatogram. 
Double-click a different calibration point to select a different standard.) 
Define whether the corresponding standard sample shall be used for 
calibration purposes. You can exclude the respective standard from the 
calibration for all peaks and all channels (default) or for the selected peak 
and/or channel only.  
Select Decoration on the context menu to perform the following actions on 
the different tab pages:  
• Select the peak for which to show the calibration curve (Peaks tab 

page). 
• Determine the axis scale (Scale tab page). 
• Define the display and decoration of the axes, frames, and grids 

(Frame & Axes tab). 
• Show validation samples (select Draw validation sample points on 

the Options tab). Validation samples are indicated by the following 
symbol: . 

• Draw lines for the Confidence Interval (Options tab, see  Show 
Confidence Interval) 

• Change the colors of the single elements (Colors tab). 

In addition, you can select Next Peak or Prev. Peak to display the 
calibration curve of the next/previous peak.  

For more information, also refer to  Displaying Values. 
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 Displaying Values 
A purple cross marks the standard sample or the Spiked Sample that is 
currently used: . (The sample has been selected on the Calibration tab 
page of the QNT Editor. For information about the editor, see Data 
Representation and Reprocessing  The QNT Editor.) If you disable a 
specific sample in the Enabled column on the Calibration tab page of the 
QNT Editor, e.g., because an error occurred during determination of the 
area value, this sample is excluded from calibration. A red asterisk marks 
the corresponding calibration point: . This kind of calibration points is 
not considered when the calibration curve is determined. To exclude 
standards, completely or in part, from calibration, select Disable Standard 
on the context menu of the Calibration Curve.  

To display validation samples, Select Decoration on the context menu. 
The Calibration Plot Decoration dialog box is opened. On the Options 
tab page, select the Draw validation sample points check box. Validation 
samples are indicated by the following symbol: . They are not considered 
for calibration. 
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 Indicating the Confidence Interval 
The confidence interval describes the range in which the "true" calibration 
curve will be found with a given probability. The range of the Confidence 
Interval grows linearly with growing standard deviation. The easiest way is 
to indicate the confidence interval graphically.  

How To 
• Open the Calibration Plot Decoration dialog box by selecting 

Decoration on the context menu. 

• Select Draw upper & lower confidence limits on the Options tab 
page. 

• Select the probability with which the values should be within the 
confidence interval. The following options are available: 90%, 95%, 
98%, 99%, 99.8%, 99.9%, and 99.99%. 

The following example shows the confidence interval of a calibration at a 
probability of 99%: 

 

You can indicate the limits of the confidence interval in the Report using the 
Upper and/or Lower Confidence Limit variables of the ⇒Peak Calibration 
peak category. 

For more information, refer to How to …: Creating and Using Report 
Tables  Setting Parameters for Variables (e.g., for the confidence 
interval).  



472 Integrating Chromatograms and Identifying Peaks 

 Validating the Calibration Curve 
To check the calibration using the respective values of the Validation 
Samples (perhaps of the standard sample as well) you have to compare 
the expected concentration or amount values to the measured/calculated 
values either numerically by means of the Amount Deviation report variable 
or visually by means of the calibration function. 

1. Numerically, by means of the Amount Deviation report variable: 
The determined (actual) area values are converted to concentration or 
amount values by means of the Calibration Function and compared to the 
expected (nominal) values of the ⇒Amount table. 
• Add a new column to a report or a Printer Layout page or change the 

assignment of an existing column as described in How to …: Creating 
and Using Report Tables  Defining the Contents of a Report.  

• Select the Amount Deviation variable in the ⇒Peak Results report 
category. Click Parameter to define whether the result of the variance 
comparison shall be expressed as absolute amount value or as 
deviation in percent (Relative in % of the expected Amount).  

2. Visually, by means of the Calibration Curve 
For checking the calibration curve visually, the validation samples can be 
displayed (specially marked) in the curve: 
• Select Decoration on the context menu of the calibration curve 

(respectively, the Calibration Plot Properties command in the Printer 
Layout). 

• Select the Draw validation sample points check box on the Options 
tab page.  

 Note: 
Even if this action is performed in the QNT Editor, these validation 
samples will not be considered for the calibration. Nevertheless, if you 
wish to use a validation sample as standard sample later and consider 
it for calculating the calibration curve, set the ⇒Type (Sample Type) to 
Standard in the sample list of the Browser. 
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3. By Means of the Confidence Interval 
a) In addition, the confidence region interval can be indicated in the 
calibration curve. Select the Draw upper and lower confidence limit 
check box on the Options tab page and define the desired confidence 
region to check whether your validation and standard samples are within 
the corresponding confidence interval (also, refer to How to …: Displaying 
Calibration Curves  Indicating the Confidence Interval).  
b) For single values, you can also indicate the limits for the respective 

Confidence Interval in the Report using the Upper/Lower Confidence 
Limit variables of the ⇒Peak Calibration report category.  

For information about how to enter the concentration/amount, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Entering 
the Concentration/Amount of the Validation Sample. For an overview of 
the different calibration possibilities, refer to How to …:  Calibrating. 

 Inverting Dependent and Independent Variables 

 Tip:  
Chromeleon supports this function to improve compatibility with PeakNet5. 

Normally, calibration curves are fitted using normal regression analysis, in 
which the known amount (or concentration) of the analyte is treated as the 
independent variable (x) and the corresponding response (peak area or 
peak height) is treated as the dependent variable (y): 
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Many legacy data systems use inverted curve fitting, which treats the 
response as if it were the independent variable (x), and amount as if it were 
the dependent variable (y): 

 

You can select the Inverted curve fitting option on the General tab page: 

 

Although inverted curve fitting is not supported by standard statistical 
theory, it was often taken because it makes amounts of analytes in 
unknowns easier to calculate when quadratic and cubic calibration 
functions are used. With linear regression, the differences between normal 
and inverted curve fitting are usually small, but the differences can be 
significant with higher-order polynomials. In a few applications, most 
notably the determination of ammonium by suppressed conductivity 
detection, a better fit to the empirical data may actually be achieved using 
inverted curve fitting. 
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To provide consistency of results for customers migrating from legacy 
systems, and to satisfy users of special applications, Chromeleon supports 
inverted curve fitting via an option in the General tab page of the QNT 
Editor. Methods imported from PeakNet 5 default to using inverted curve 
fitting, the approach used by PeakNet 5. Normal curve fitting remains the 
default setting for new methods created in Chromeleon. 

 Caution: 
It is the user's responsibility to decide whether inverted curve fitting is 
sensible for their application. 

If you select Inverted, the dependent and independent variables are 
inverted. Thus, different values are usually obtained for the following 
variables: 

⇒Peak Results Category 
• ⇒Amount (concentration or amount) 

• Amount Deviation (deviation from the expected concentration or 
amount) 

• Concentration (concentration, if Amount is really an amount) 

• Relative Amount (relative concentration or amount) 

• Group Amount (concentration or amount of a group) 

⇒Peak Calibration Category 
• Offset c0 (intersection with the y-axis) 

• Slope c1  

• Curve c2 (curvature) 

• Cubic Coefficient c3 

• RF Value (1/slope) 

• Variance 

• Variance Coefficient 

• Standard Deviation 
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• Relative Standard Deviation 

• Coefficient of Determination  

• DOF-Adjusted Coefficient of Determination  

• Calibration Point X 

• Calibration Point Y 

• Evaluation of Cal.Function for X () 

• Residual for Calibration Point X 

• Upper Confidence Limit (upper limit for the Confidence Interval) 

• Lower Confidence Limit (lower limit for the confidence interval) 
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Working with Chromatograms 
All operations for processing single chromatograms are performed in the 
Chromatogram window. This window displays the integrated 
chromatogram of the current sample. The peak areas are determined and 
integrated automatically, based on the ⇒Detection Parameters.  

If the representation and/or evaluation of single samples do not correspond 
to the expected result, you can select another chromatogram section to 
specifically change the peak delimiters and the baseline manually. It is also 
possible to display more chromatograms for comparison. In addition, you 
can assign the peaks manually and define a baseline for the entire 
chromatogram (averaged baseline). You can also apply a data filter to 
smooth the chromatogram and to improve the reproducibility of the peak 
baselines.  

For more information, refer to:  

 Using Keyboard Shortcuts in the Chromatogram 
 Manual Re-Integration 
 Manual Peak Assignment 
 Comparing Chromatograms 
 Performing Data Smoothing 

You can also generate additional channels after data acquisition, see: 

 Copying a Channel 
 Combining Channels via Arithmetic Operations 

Due to the increased noise, Dionex recommends performing background 
subtraction for mass spectra. This is also possible for UV channels. In both 
cases, determine background subtraction in the chromatogram (see 

 Subtracting Background Spectra). 

In addition, you can  Display Peak Information in a Separate Area. 

To graphically move the retention window, refer to  Moving a Retention 
Window Graphically. 
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If you want to change the detection parameters, for example, because 
peaks that are too small or unimportant are integrated or because the 
baseline does not meet the requirements, you can perform these changes 
graphically in the chromatogram; see  Defining Detection Parameters 
Graphically. 

You can define the detection parameters according to your requirements. 
All detection parameters are available in the QNT Editor on the Detection 
tab page (see How to …: Integrating Chromatograms and Identifying 
Peaks  Defining Detection Parameters; for information about the 
editor, refer to Data Representation and Reprocessing  The QNT 
Editor). 
 
For more information about how to display a Report or a spectra plot, 
refer to How to …: 

 Displaying  and Using UV Spectra 
 Creating and Using Report Tables 

Using Keyboard Shortcuts in the 
Chromatogram 
Often, it may be necessary to display specified chromatogram areas only. 
In this case, use the mouse to zoom out this area. In addition, keyboard 
keys and key combinations are supported for user-friendly operation. These 
keys refer to the number and navigation area on the keyboard. 

Scrolling 

<←> = <LEFT> scrolls all chromatograms to the right; <→> = <RIGHT> 
scrolls them to the left. If you press the respective key, the chromatogram is 
scrolled by 5% of the window width. 

<↑>= <UP> (<↓> = <DOWN>) scrolls the active chromatogram plot up 
(down). If you press the respective key, the plot is scrolled by 10% of the 
plot height.  
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 Tip:  
Scrolling beyond the chromatogram limits is supported for both cases.  

<HOME> (<END>) brings you to the first (last) datapoint of the active 
chromatogram. The entry is ignored if the chromatogram is already 
displayed in full-size mode. 

Zoom/UnZoom 
Press <x> (MULTIPLY) to zoom in horizontally by 20%. The anchor point is 
the center of the time axis; for example, 0.0 to 10.0 min > 1.0 to 9.0 min. 

Press <÷> (DIVIDE) to unzoom horizontally by 25%. The anchor point is the 
center of the time axis.  

Press <CTRL><x> or <CTRL><÷> to display all chromatograms in full size. 
This action corresponds to an Autoscale of the time axis. 

Press <+> (PLUS SIGN) to zoom in vertically by 20%. The anchor point is 
10% of the signal height because the baseline region at the beginning or 
end of a peak is usually more interesting than the course of the peak at its 
maximum; for example, 0.0 - 100.0 mAU > 2.0 - 82.0 mAU.  

Press the <-> (MINUS SIGN) key to vertically unzoom by 25%. The anchor 
point is near the baseline as described above. 

 Tip:  
If the unzoom operation is performed after the zoom operation, the original 
chromatogram view will be restored. 

Press <CTRL><+> or <CTRL><-> to autoscale the active chromatogram. 

Press <NUM5> to autoscale the time and signal axes in all currently open 
plots. This operation corresponds to the Full Size command on the View 
menu. 

Peak Selection 

Press <CTRL><←> to select the previous peak of the active 
chromatogram. If no peak is selected, the first peak of the chromatogram 
will be selected. 

Press <CTRL><→> to select the next peak of the active chromatogram. If 
no peak is selected, the first peak of the chromatogram will be selected. 
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Press <CTRL><HOME> to select the first peak of the active chromatogram.  

Press <CTRL><END> to select the last peak of the active chromatogram.  

 Tip:  
If the newly selected peak is outside the current view, the peak is 
automatically scrolled into the view. 

Chromatogram Selection 
The following keys are available for chromatogram Overlay: 

Press <PAGE UP ↑> or <CTRL><↑> to activate the next upper 
chromatogram; that is, the chromatogram whose caption is found above the 
active chromatogram. 

Press <PAGE DOWN ↓> or <CTRL><↓> to activate the next lower 
chromatogram; that is, the chromatogram whose caption is found below the 
active chromatogram. 
 
Chromeleon supports many additional " quick access" keys. For a 
summary of the most important keys, refer to the table in Basic Operation 

 Quick Access Keys. 

Manual Re-Integration 
On the Integration Toolbar, Chromeleon provides different icons for 
manual re-integration of a chromatogram via mouse-click. However, please 
note that these actions affect only the active chromatogram:  

 Moving Peak Delimiters 
 Modifying the Baseline Manually 
 Inserting or Deleting Peaks 
 Changing the Peak Type 
 Defining an Averaged Baseline 
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Prerequisite 
Manual re-integration is possible only for integrated chromatograms. They 
have a red baseline below the peaks and blue peak delimiters on the left 
and right ends of the baseline (= integration limit). 

 Tip:  
To display these elements on the chromatogram, select Decoration > 
Peak Decoration on the context menu. 

For manual re-integration, Dionex recommends zooming the area in which 
you want to make the changes. Select Automatic on the context menu. 
The corresponding mouse pointer will then mark all places in the 
chromatogram that can be changed manually. The shape of the mouse 
pointer indicates which action can be performed.  

If you have not yet saved the modifications, you can undo them by 
selecting Delete Manipulations on the Edit menu. 

 Moving Peak Delimiters 
Near the peak delimiters (blue color by default), the mouse pointer changes 
its appearance (if the Automatic Tool or the Delimiter Tool is selected). 
The  pointer indicates the peak start and the  pointer indicates the 
peak end. 

Left-click and move the mouse pointer to the new peak start or peak end.  

It is not possible to cross another peak delimiter. This peak delimiter, too, 
will then be moved in the same direction. After positioning, Chromeleon 
draws a new baseline. The modified peak properties (Area, Width, Amount, 
etc.) are immediately updated and displayed in the integration report.  

 Notes:  

You can also move the peak delimiters of negative peaks.  

For special cases, it is possible to move the peak delimiter beyond the peak 
maximum. However, this is usually not reasonable. 
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 Modifying the Baseline Manually 
The usual way to determine the baseline is to use the detection parameters 
of the QNT Method (see Integrating Chromatograms and Identifying 
Peaks/Defining Detection Parameters  ;Modifying the Baseline). 
However, in some cases it may be necessary to modify the baseline for a 
single chromatogram: 

To individually integrate two peaks that are not completely separated in the 
chromatogram, drop a perpendicular line from the minimum between the 
two peaks to the baseline. The intersection with the baseline is referred to 
as "baseline node" (a).  

a) b) c)

Baseline node

 

To draw the baseline from peak end to peak end, enable the ⇒Valley to 
Valley detection parameter. The baseline node automatically moves 
towards the signal curve until it rests on the curve in the minimum between 
two peaks (b). 

You can move each baseline node along the perpendicular line and 
position it at the desired position ("freely floating baseline node" (c)). If you 
approach state (a) or (b), the mouse pointer automatically clicks into place. 
The shape of the mouse pointer ( , ) indicates which action is currently 
performed. Select the Automatic Tool or the Baseline Tool.  
At the end of a baseline, you can generate freely floating baseline nodes 
(d, e).  

e)d) f)  
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Depending on the direction in which you drag the mouse pointer, the 
system automatically distinguishes between moving a peak delimiter 
horizontally and moving a baseline node vertically.  

Between two baseline nodes, you can move the entire baseline in vertical 
direction (f). The shape of the mouse pointer ( ) indicates whether you 
can perform this action. 

 Note: 

For exponentially skimmed Rider Peaks, you cannot move the baseline 
manually. 

 Inserting or Deleting Peaks 

Inserting a Peak 
You can later insert a new peak, i.e., a baseline and two peak delimiters, at 
any free position on the chromatogram and on the leading and trailing 
edges of a peak. The new peak is also added to the peak table in the QNT 
Editor. 

If a small peak ( ) appears on the right side of the mouse pointer, you can 
insert a new peak at this position. If a warning sign ( ) appears instead, 
you cannot insert a new peak.  
• Select Insert Peak Tool on the context menu to have the mouse 

pointer indicate only those positions where you can or cannot insert a 
peak. If the Insert Peak Tool is active, you cannot perform any other 
actions (edit modes).  

Deleting a Peak 
To delete a peak, point to the peak.  

Select Delete Peak on the context menu to remove the peak's delimiter 
and its baseline. This also removes the peak from the peak table in the 
QNT Editor. 
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 Splitting Peaks 
Sometimes only one peak is recorded when two substances elute 
approximately at the same time. It may happen that one peak is detected 
instead of two. This depends on the concentration ratio of the substances 
and the arrangement of the single peaks. You can then add a second peak 
below the existing one (also, refer to  Inserting or Deleting Peaks). The 
following commands are available:  

Split Peak 
Move the mouse pointer to the position where you want to split the existing 
peak. Select Split Peak on the context menu to split the peak into two main 
peaks. The perpendicular line splits the peak exactly at the pointer position.  

 Note:  
Splitting the peak does not change the baseline.  

Shape Shoulder 
Select Shape Shoulder on the context menu to exponentially skim a 

Peak Shoulder from the existing peak. First, move the pointer to the 
position for the peak start of the peak shoulder and select Shape 
Shoulder. The exponential-skimming algorithm automatically calculates the 
peak end for the peak shoulder. 

 Note:  
The shoulder maximum is calculated relative to the baseline. Thus, it must 
not correspond to the highest signal value. 

Dionex recommends using the ⇒Peak Shoulder Threshold to define 
shoulder shaping for the entire quantification method. 

Use the ⇒Rider Threshold and ⇒Maximum Rider Ratio detection 
parameters to define the peaks that will be detected as rider peaks. For 
more information, refer to How to …: Integrating Chromatograms and 
Identifying Peaks  Defining Rider Peaks. 
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 Changing the Peak Type 
To change the peak type, point to the respective peak.  
• Select Change to Main Peak or Change to Rider on the context 

menu. 

Use this function to change a main peak into a Rider Peak and vice 
versa. Single peaks are always interpreted as main peaks. That is why you 
cannot convert them into rider peaks. The context menu indicates: Can't 
Change Peak Type. 

With automatic classification, the ⇒Rider Threshold and ⇒Maximum Rider 
Ratio parameters determine whether a peak is classified as a main peak or 
a rider. 

 Defining an Averaged Baseline 
By means of two points entered in the chromatogram, you can define a 
baseline for the entire chromatogram (= averaged baseline): 

How To 
• In the chromatogram, right-click to select an area at the beginning of 

the chromatogram. The first ⇒Baseline Point shall be in the middle of 
this area. 

• Select Set Averaged Baseline Start on the context menu. 
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This sets the first baseline point. The x-value is the middle of the selected 
area while the y-value is the averaged value of the signal values weighted 
by the data rate. This first value will not be marked, as it is not sufficient for 
setting the baseline. A second point is required as well. 

 Note: 
If you exit Chromeleon without having entered the second point, the first 
point will be deleted. 

Enter the second point as follows: 
• In the chromatogram, right-click and select an area somewhere at the 

end of the chromatogram. The second baseline point shall be in the 
middle of this area. 

• Select Set Averaged Baseline End on the context menu. 

This action sets the second baseline point. The new baseline is drawn 
through both points, which are marked by a red cross. 

You can modify the averaged baseline later in two ways: 

1. Select a new baseline point, which then replaces one of the former ones. 

2. Use the baseline tool on the Integration Toolbar, see How to …: 
Working with Chromatograms  Modifying the Baseline Manually. 

Manual Peak Assignment  

(Dialog box "Properties of Peak No. x") 
If you have inserted a new peak, or wish to name existing or unidentified 
peaks, or rename incorrectly identified peaks, you can do this in the 
chromatogram either via the QNT Editor (see Data Representation and 
Reprocessing  The QNT Editor) or in a report.  

• Click the respective peak and select Peak Properties on the context 
menu to open the dialog box Properties of Peak No. x or double-click 
the peak. 
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• Enter the corresponding name under Component or select one of the 
names listed in the combo box. Click <Return> or the lowest symbol 
bottom to insert the peak into the peak table of the QNT Method using 
the retention time of the active chromatogram and the settings of the 
previous peak (as far as sensible).  

 
 
• It is also possible to rename an identified peak by manually assigning it 

a different name. Enter the new name or select one of the names listed 
in the combo box and confirm your entry by clicking the first symbol 
button. Via the additional symbol buttons, you can cancel this action or 
delete all manual peak assignments (see quick info for the buttons). 
Manual peak assignments of identified peaks are not transferred to the 
QNT Method but apply to the currently open chromatogram only. 

 
 
You do not have to close the dialog box to continue working in the 
chromatogram. <Return> accepts a new entry in the peak table of the QNT 
Editor (provided that the peak has not yet been assigned there).  
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The dialog box then indicates the values of the next peak to be assigned. 
The dialog box remains open until explicitly closed or until the 
chromatogram is closed. 

 Note: 
The manual peak assignments are saved in the Quantification Method. 
However, manual peak assignments for identified peaks are not included in 
the QNT Method and are valid for the currently open chromatogram only. 

Comparing Chromatograms 
Chromeleon allows you to compare several chromatograms by 
simultaneously displaying different samples or several Channels of the 
same sample. Besides, you can also compare different channels of 
different samples. To compare chromatograms, select the samples or 
channels and relate them to each other.  

For more information, refer to: 

 Selecting the Samples and Channels 
 Displaying Several Chromatograms 
 Mirroring Chromatograms 
 Normalizing Chromatograms 
 Printing Overlaid Chromatograms 

 Selecting the Samples and Channels 
Different alternatives are available to select samples and channels that are 
to be displayed as Overlays: 
• Display the chromatogram for a sample in an integration window, e.g., 

by double-clicking the sample name in the Browser. 

• Afterward, select one or several samples of a Sequence in the 
Browser and drag the sample(s) into an open integration window while 
holding down the left mouse button. The action is indicated by a + sign 
on the mouse pointer. When you release the mouse button, the 
chromatogram of the sample(s) is displayed, showing the same 
channel as for the sample already displayed. 
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Instead of selecting a sample in the Browser and dragging it into an 
open integration window, you may also select the sample in the 
integration view using the Add Overlay command on the File menu. 
The chromatogram of the first sample will then be overlaid by the 
chromatogram of the selected one. 

Or: 
• Select several samples in the Browser and then select Compare on 

the context menu. The Compare submenu lists all recorded channel 
types. After selecting a channel, the chromatograms of all samples with 
raw data for this channel are compared. 

Or: 
• Select a sample in the Browser, and then select Open > All Channels 

on the context menu to compare all channels of a sample in a separate 
window. Press F10 or SHIFT+F10 to display the channels of all 
samples in a sequence successively. 

If several samples are selected, all channels of the first selected 
sample are displayed. Press F4 or SHIFT+F4 to browse through the 
selected samples. 

Or: 
• Hold down the CTRL key and click the Next (or Previous) 

Chromatogram icon (  or ) to insert the chromatogram of the next 
(previous) sample. 

Or: 
• Perform a Query over several sequences or Datasources. Select 

Compare on the context menu. The Compare submenu lists all 
recorded channel types. After selecting a channel, the chromatograms 
of all samples with raw data for this channel are compared. 

Or: 

• Hold down the CTRL key and click the Next Channel icon ( ) to 
insert the next channel of the same sample. 

• Hold down the CTRL key and click the Previous Channel icon ( ) to 
insert the previous channel of the same sample. 

Chromeleon supports several actions for overlaying chromatograms. For an 
overview, refer to  Comparing Chromatograms. 
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 Displaying Several Chromatograms 
After adding an Overlay (= an additional chromatogram), you can define 
the display arrangement for the two chromatograms.  

How To 
• Select Decoration on the context menu of the chromatogram plot.  

• In the Chromatogram Decoration dialog box, select the Comparison 
tab page and define the chromatogram Arrangement: 

Select Overlay to overlay the single chromatograms on one single plot 
(see the left section of the screenshot below). 

Select Stack to display the chromatograms one below the other in 
different plots (see the right section of the screenshot below). 

Select Mixed to combine the Overlay and the Stack option. 
Chromatograms of different detectors are displayed as single plots. 

 

Use the Overlay view to add an additional signal axis (on the right). The 
axis refers to the overlaid chromatogram that was added last using the 
Overlay with right signal axis command. This command, too, is available 
on the Comparison tab page of the Chromatogram Decoration dialog 
box. Thus, you can select a different signal range for the chromatogram 
that was added last. Use the Stack view for individual scaling of the signal 
axis for each single chromatogram.  

To offset the chromatograms in x- and/or y-direction in the Overlay view, 
set the signal or time offset on the Comparison tab page. 
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• Select the Time check box to move the active chromatogram in the x-
direction. 

• Select the Signal check box to move the active chromatogram in the y-
direction. 

The offset is specified in percent of the signal or time axis. A signal offset of 
5% shifts each of the following chromatograms upwards by 5%. 
Accordingly, a time offset causes a percentage alteration in the x-direction. 
This results in a "pseudo-3D" presentation. 

Chromeleon supports several actions for overlaying chromatograms. For an 
overview, refer to  Comparing Chromatograms. 

 Mirroring Chromatograms 
If you have inserted an Overlay (= an additional chromatogram), you can 
mirror the overlay. 
• Select Decoration on the context menu on the chromatogram. 

• In the Chromatogram Decoration dialog box, select the Comparison 
tab page. Verify that Overlay is selected in the Arrangement section. 

• You can mirror the chromatogram that was added first by selecting the 
Mirror chromatogram check box in the Overlay section. 
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If you have also selected the Overlay with right signal axis check box, 
this setting will be ignored. In this case, the overlay is displayed with the 
right signal axis; it is not mirrored. However, if you add another 
chromatogram, it is displayed with the right signal axis and the previous 
chromatogram is mirrored.  

Chromeleon supports several actions for overlaying chromatograms. For an 
overview, refer to  Comparing Chromatograms. 

 Normalizing Chromatograms 
For a sensible comparison of different chromatograms, often a common 
reference point is chosen for the overlaid chromatograms (see Overlay). 
The chromatograms are normalized. As the default, the ⇒Retention Time 
is used for the normalization, that is, all chromatograms are arranged so 
that their start points match (t = 0). 

Alternatively, chromatograms can use a common peak as their reference 
point. 
• Select Decoration on the context menu and open the Comparison tab 

page. 

• Select the reference peak from the At Peak list box. 

• Select Shift if this is to be performed independently from the length of 
the chromatogram. 

• Select Stretch if the chromatograms are to be stretched or 
compressed in x-direction, so that there is a time scaling in all 
chromatograms. The stretch 0 to 1min (or n min) has the same length 
for all chromatograms. 

• Enable the Normalize Signal check box if the height of the desired 
chromatogram peak should match in addition. Depending on how much 
the reference peak must be stretched or compressed, all other peaks in 
the chromatogram are also stretched or compressed. This enables 
amount estimation for the same peaks from different chromatograms. 
This option is not available in the Stack view. 

Chromeleon supports several actions for overlaying chromatograms. For an 
overview, refer to  Comparing Chromatograms. 
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 Printing Overlaid Chromatograms 
On single-colored printouts, it is difficult to distinguish multi-colored 
chromatograms. To enhance legibility, determine that dashed and dotted 
lines are used for the chromatograms in the Printer Layout and printout:  

On the Browser, select Preferences on the File menu to open the 
Preferences dialog box. On the Print tab page, select the Use dashed 
and dotted lines instead of colored lines check box. To define the line 
width, select an option from the Line weight drop-down list. Select hair for 
very thin lines. Or else, select an entry between 1 pt, which is the default 
setting, and 10 pt (for thick lines). 

 

Chromeleon supports several actions for overlaying chromatograms. For an 
overview, refer to  Comparing Chromatograms. 

Performing Data Smoothing 
Data Smoothing can help improve the appearance of chromatograms and 
the reproducibility of peak baselines by reducing noise through digital 
filtering. Smoothing affects both, the display and the integration of the 
chromatogram. When smoothing is completed, the new chromatogram is 
displayed overlaid on the original chromatogram. The original data file is 
not altered and the smoothed data is saved separately. 
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 Tip:  

You can define data smoothing also in the Post-Acquisition Steps view of 
the PGM Editor (see Control  The PGM Editor). 
Please observe the corresponding hints below. 

How To 
1. Display the sample's chromatogram by double-clicking its name in the 

Browser. 

 Tip:  
Open the PGM File in which you want to define data smoothing and 
select the Post-acquisition steps view, instead.  

2. Select Smoothing on the context menu. The Smoothing dialog box 
appears:  

 

 Tip:  
In the PGM Editor, follow the steps below: Select Insert line on the 
context menu to add a new post-acquisition step. The New post-
acquisition step dialog box is opened. Select Smooth data to open the 
Smoothing dialog box. 
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3. Select the Filter Type, Filter Size, and Iterations. For more 
information, refer to  Data Smoothing. 

4. In the Smoothed Channel box, enter the name for the smoothed 
channel. The suggested name is the current channel name, followed by 
the type of filter (MA for Moving Average, OL for Olympic, and SG for 
Savitzky-Golay), the filter size, and the number of iterations. 

5. To smooth all the samples in the sequence or Query, select the Apply 
to all samples in the current sequence or query check box. 

 Tip:  
This option is not provided in the Smoothing dialog box of the PGM 
Editor. 

6. Click OK to start the smoothing. 

For information about how to smooth MS chromatograms during mass 
trace extraction, refer to How to …: Using Mass Spectrometers 

 Extracting Mass Traces Afterward. 

How to delete a smoothed channel 
• Right-click the sequence name to open the context menu.  

• Select Delete to open the Delete Sequence "<Name>" dialog box. 

• Select Only selected raw data. 

• Select the smoothed channel and delete the channel by clicking Yes.  

 Tip:  
This action deletes the channel from all samples in the sequence.  
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Copying a Channel 
Chromeleon allows you to copy a channel to evaluate the same raw data in 
different ways, for example, to determine both, the ingredients and the 
contaminations of a pharmaceutical product in one chromatogram. To do 
so, evaluate the original channel with one QNT Method, and then evaluate 
the copied channel with a different QNT Method. 

 Tip:  
You may also define copying of channels in the Post-Acquisition Steps 
view of the PGM Editor (see Control  The PGM Editor). Please observe 
the corresponding hints below. 

How To 
1. Display the sample's chromatogram by double-clicking its name in the 

Browser. 

 Tip:  
Open the PGM File in which you want to define that a channel is copied 
and select the Post-acquisition steps view, instead.  

2. Select Copy Channel on the context menu. The Copy Channel dialog 
box appears. 

 Tip:  
In the PGM Editor, follow the steps below: Select Insert line on the 
context menu to add a new post-acquisition step. The New post-
acquisition step dialog box is opened. Select Copy Channel to open 
the Copy Channel dialog box. 

3. In the New Channel box, enter the name for the new channel. The 
suggested name is the name of the current channel plus _COPY. 
However, you are free to enter any name of your choice as well. 

4. To copy the channel for all samples in the sequence or Query, select 
the Apply to all samples in the current sequence or query check 
box. 

 Tip:  
This option is not provided in the Copy Channel dialog box of the PGM 
Editor. 

5. Click OK to start the procedure. 
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Combining Channels via Arithmetic 
Operations 
Chromeleon also allows you to combine two channels of different samples, 
using arithmetic operations. Each data point is created by combining the 
associated two data points from the existing channels (i.e., the data points 
at the corresponding time), using the desired operation. Arithmetic 
combinations are not restricted to chromatograms in the strict sense. They 
can be used for all 2D channels, except for temporary channels. 

 Tip:  
You may also define the combination of two channels in the Post-
Acquisition Steps view of the PGM Editor (see Control  The PGM 
Editor). Please observe the corresponding hints below. 

How To 
1. Display the sample's chromatogram by double-clicking its name in the 

Browser. 

 Tip:  
Open the PGM File in which you want to define that two channels are 
combined and select the Post-acquisition steps view, instead.  
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2. Select Arithmetic combination of channels on the context menu. The 
Arithmetic combination of channels dialog box appears. 

 Tip:  
In the PGM Editor, follow the steps below: Select Insert line on the 
context menu to add a new post-acquisition step. The New post-
acquisition step dialog box is opened. Select Arithmetic combination 
of channels to open the Arithmetic combination of channels dialog 
box. 

3. The current channel is Channel A. Select the factor with which the 
channel shall be multiplied. 

 Tip: 
In the PGM Editor, select the channel of the corresponding sample from 
the channels defined in the PGM File. Channels defined in previous 
post-acquisition steps are also available for selection.  

4. Select a channel of the same sample or of any other sample of your 
choice as Channel B. Also, determine the factor with which Channel B 
shall be multiplied.  

5. Select an Operation.  

6. In the Result Channel box, enter the name for the new channel. The 
suggested name is the abbreviation for the operation plus the names of 
the two channels. However, you are free to enter any name of your 
choice as well. 

7. To combine the selected channels for all samples in the sequence or 
Query, select the Apply to all samples in the current sequence or 

query check box. 

 Tip:  
This option is not provided in the Arithmetic combination of channels 
dialog box of the PGM Editor. 

8. Click OK to start the procedure.  
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Subtracting Background Spectra 
Mass Spectra usually have a higher noise level than UV spectra. 

Therefore, you may want to subtract the background spectra. (However, for 
UV channels, it is usually not necessary to change the default background 
subtraction.) There are two ways to subtract background spectra. 

Peak Dependent Background Subtraction 
Enable Background Subtraction on the context menu of the 
chromatogram. Return to the context menu and select Peak Dependent 
Ranges. Chromeleon automatically determines two ranges for calculating 
the background and then subtracts the entire mass or UV spectrum of 
these ranges. On the MS or UV tab page of the QNT Editor (see Data 
Representation and Reprocessing  The QNT Editor), define the 
number of mass spectra or UV spectra to be used for the two ranges. (For 
more information, refer to How to …: Using Mass Spectrometers 

 Processing Mass Spectra and/or How to …: Displaying and Using 
UV Spectra  Processing UV Spectra.) 

Fixed Background Subtraction for the Entire Chromatogram 
At the beginning of the chromatogram, hold down the right mouse button 
and select the baseline range for which the mass spectra (UV spectra) will 
be subtracted. A context menu will appear. Select Set Background 
Subtraction Range 1 on the context menu to use the defined range as the 
first range for which to subtract the mass spectra (UV spectra) from the 
mass spectra (UV spectra) of the single peaks and/or from the retention 
time spectrum. 

 Note: 
Selecting Set Background Subtraction to Range 1 automatically enables 
the Fixed Background Ranges option of the Background Subtraction 
command on the context menu.  

In the same way, select a baseline range at the end of the chromatogram. 
Select Set Background Subtraction Range 2 on the context menu to 
define this range as the second range for which mass spectra (UV spectra) 
will be subtracted from the mass spectra (UV spectra) of the single peaks. 
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 Note: 
It is useful, but not imperative, to define a second range; background 
subtraction can also be performed using only the mass spectra (UV 
spectra) of the first range.  

The two defined ranges are marked by a horizontal line (in the same color 
as the spectrum, or in blue if no spectrum is available) and labeled "SB1" or 
"SB2" (SB = subtracted background). If the background subtraction range 
was used, the number of single mass spectra or UV spectra that were 
averaged is indicated in parentheses: 

 

 Note: 
It is possible to set the two ranges for background subtraction of mass 
spectra in a UV channel. However, Dionex recommends setting the two 
ranges in the corresponding MS channel because the respective peaks are 
visible only there. 

Clear Background Subtraction Ranges removes the previously defined 
ranges.  
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Effects 
The settings selected in the chromatogram are saved in the QNT File of the 
current sample. These settings overwrite the settings on the MS or UV tab 
page of the QNT Editor. It makes no difference whether background 
subtraction is defined on the Integration plot or in the QNT Editor. Thus, 
your input affects all samples that are evaluated using this QNT File. 

 Tip: 
Make sure that no peak of another sample is within the retention time used 
as the Background Subtraction Range in Fixed mode. 

For a mass spectrum (UV spectrum) that was recorded between two 
ranges, the ranges are averaged and the result is subtracted. The mass 
spectra (UV spectra) of the two ranges are weighted based on the time 
distance from where the respective mass spectrum (UV spectrum) was 
recorded; that is, the range that is nearer to the respective mass spectrum 
(UV spectrum) is considered more. 

If a mass spectrum (UV spectrum) is not located between the two ranges, 
only the averaged mass spectrum (UV spectrum) of the range next to the 
spectrum is subtracted. 

Displaying Peak Information in a Separate 
Area 
Chromeleon supports displaying the peak information in a separate area 
above the actual chromatogram: 
• Double-click the chromatogram to open the Chromatogram 

Decoration dialog box. 

• On the Peak Calipers tab page, select Show peak calipers to display 
the peak information. 

In addition, you can also display the following information: 
• The name of the current QNT method: Show QNT info. 

• The lines indicating the width of the retention time ⇒Window of the 
associated substance: Show all caliper drop lines. 



502 Working with Chromatograms 

The chromatogram looks as follows: 

 

In addition, you move the retention time window graphically. For more 
information, refer to  Moving a Retention Window Graphically. 

Moving a Retention Window Graphically 
Chromeleon allows you to change the retention window, i.e., the expected 
⇒Retention Time and the time ⇒Window, for single peaks in the 
chromatogram: 
• Go to the Peak Table tab page of the QNT Editor to check the 

graphical move of the retention window described below: 

• Option: Add the lines that indicate the time limit of the window to the 
chromatogram: In the Chromatogram Decoration dialog box, select 
the Show all caliper drop lines check box on the Peak Calipers tab 
page. (For more information, refer to  Showing the Peak 
Information in a Separate Area.) 
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To graphically move the retention window, perform one of the steps below: 
1. Move the entire window: To move the retention window of a peak, 

point to the center of the associated peak caliper. The pointer changes 
its appearance and looks as follows: . 

Hold down the left mouse button and drag the caliper to the desired 
position, i.e., to the desired time.  

The entry in the Retention Time column of the peak table is updated 
automatically. 

2. Move the start or end time: To change the time of a specific line, 
point the edge of the caliper or on the associated dotted line. The 
pointer changes its appearance and looks as follows . 

Hold down the left mouse button and drag the line to the desired 
position, i.e., to the desired time. 

The entries in the Window and Retention Time columns of the peak table 
are updated automatically. 

3. Move the start or end time symmetrically: Hold down the SHIFT key 
when you point to the edge of a caliper or on a dotted line. The pointer 

changes its appearance and looks as follows .  

Hold down the left mouse button and drag the lines to the desired 
position, i.e., to the desired time. 

The entry in the Window column of the peak table is updated 
automatically. 

 Tip:  
In the same way, you can change the start and end time of an area for 
groups of unidentified peaks. 
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Defining Detection Parameters Graphically 
Chromeleon supports entering detection parameters graphically: This 
considerably facilitates defining the time for the ⇒Detection Parameters. 

How To 
• If no parameter is displayed in the chromatogram, use the Detection 

Parameter Tool. Either select this command on the context menu or 

click the following icon on the integration Toolbar: . 

• In the chromatogram, move to the exact location where you want to 
enter a parameter. 

• Select Detection Parameters on the context menu. 

• You can then select 

Insert Inhibit Integration On or Off to inhibit or allow integration (see 
How to …: Integrating Chromatograms and Identifying Peaks 

 Inhibiting Peak Integration). 

Insert Valley to Valley On or Off to enable or disable integration from 
valley to valley. 

Insert Detect Negative Peaks On or Off to enable or disable 
integration of negative peaks. 

Insert Baseline Point to insert a new baseline point (for more 
information about the last three commands, refer to How to …: 
Integrating Chromatograms and Identifying Peaks  Modifying 
the Baseline). 

Insert to insert a new parameter. 
• The Detection Parameter Tools moves the entered parameters to the 

desired location in the chromatogram. 

The example below corresponds to the table input in How to …: 
Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 
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A dotted line indicates the parameters in the chromatogram. The short form 
for the parameters and their values are displayed along the line. The 
picture shows, for example, the Rider Threshold (in short: RidThd), Rider 
Skimming (RidSki), and Maximum Rider Ratio (RidRat) parameter values at 
1.000 min.  

To enter the detection parameters graphically, you also select a 
chromatogram area while holding the right mouse key. The context menu is 
opened automatically; the menu contains the following commands: 
• Set Averaged Baseline Start and Set Averaged Baseline End to set 

an averaged baseline (see How to …: Working with Chromatograms 
 Defining an Averaged Baseline). 

• Set Minimum Area to define the minimum peak area. 

• Set Minimum Height to define the minimum peak height. 

• Set Minimum Width to define the minimum peak width (for more 
information about the Set Minimum commands, refer to How to …: 
Integrating Chromatograms and Identifying Peaks  Reducing 
the Number of Evaluated Peaks). 
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• Set Peak Slice & Sensitivity to define the peak recognition algorithm 
(see How to …: Integrating Chromatograms and Identifying Peaks 

 Modifying the Peak Recognition Algorithm). 

• Set Inhibit Integration Range to select a range for the peak inhibition. 

• Set Void Volume Treatment Range to determine the range for 
recognition of the negative water peak. This overwrites all previous 
ranges for recognition of the negative water peak. 

 Note: 
You can undo the graphical input of detection parameters. Click one of the 
QNT Editor tables, and then select Undo on the Edit menu. (In the 
chromatogram itself, you can only undo the modifications made for the 
active chromatogram.) 

When new detection parameters are entered graphically, they are 
automatically copied to the Detection tab page of the QNT Editor. (For 
more information about the editor, see Data Representation and 
Reprocessing  The QNT Editor.) They will be used for all samples that 
are evaluated with the QNT File of the current sample. As an alternative, 
you can also enter the detection parameters directly on the Detection 
sheet. (For more information, refer to How to …: Integrating 
Chromatograms and Identifying Peaks  Defining Detection 
Parameters).  
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Displaying and Using UV Spectra 
After recording UV spectra with a Photodiode Array Detector, 
Chromeleon supports all possibilities for using spectra with a modern 
chromatography data system. 

Displaying Spectra 
UV spectra are displayed in the Spectra Plot window. Select Show Spectra 
on the View menu or click  

 

The spectra plot represents UV spectra and allows their identification by 
means of a spectra library.  

For more information, refer to: 

 Displaying Peak Spectra) 
 Displaying and Overlaying Single Spectra 
 Processing UV Spectra 
 Match Factor, Difference Spectra, 1st /2nd Derivatives of Spectra 

 

In addition, you can 

 Create and Use Spectra Libraries 
 Search Reference Spectra 

 
The PPA (Peak Purity Analysis) window allows you to 

 Analyze the Peak Purity 
 Select the Optimum Integration Path  

and  Extract Spectra, Chromatograms, and 3D Fields 
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 Displaying Peak Spectra 
• In the chromatogram, select the peak of which you want to display the 

spectrum. If the associated raw data is available, thumbnail spectra of 
the peak are displayed in the chromatogram. 

• Select Show Spectra on the View menu or click  

 

• Select Decorations on the context menu of the Spectra window. On 
the Peak Spectra tab, determine from which peak height spectra are 
displayed. 

Depending on the settings, up to five spectra of the same peak can be 
displayed in different colors. Normally, the spectra are extracted at 10 and 
50% peak height from the leading and the trailing peak edges and at the 
run time of the peak. The representation of the spectrum is normalized. If 
the spectra largely match, this can be an indication for good peak purity.  

 Displaying and Overlaying Single Spectra 
In addition to peak spectra (= spectrum in the peak maximum or spectrum 
at a defined peak height), Chromeleon is capable of displaying any other 
spectrum of a chromatogram at the time t. 

To extract any spectra of a chromatogram via a mouse click, follow the 
steps below: 
• Enable the Spectra Tool on the context menu or click the 

corresponding icon on the Integration Toolbar 

 
• A spectra symbol that is appended to the mouse pointer indicates that 

the mode was changed. 

• Click anywhere in the chromatogram to display the corresponding 
spectrum.  

• Repeat the action while pressing the SHIFT key to overlay several 
spectra.  
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Displaying Spectra of Different Samples 
To objectively compare spectra of different samples, it is necessary to 
perform a chromatogram comparison. 
• Compare two chromatograms by displaying an additional 

chromatogram in the Integration window (see Integration 
 Chromatogram Comparison). 

• Enable the Spectra Tool and select single spectra by clicking various 
places in the chromatogram while pressing the SHIFT key.  

 Note: 
UV spectra are overlaid in one window.  

 Processing UV Spectra 
For a better comparability of UV spectra, it is useful to subtract the 
background spectrum (of the solvent). Chromeleon performs this 
automatically, using the following algorithm: 

• The background spectra are determined for both peak ends. At both 
peak ends, several UV spectra can be averaged over a specified 
range.  

• The background peak spectrum (usually at the peak maximum) is then 
determined via linear interpolation of these two background spectra 
and is finally subtracted from the single spectrum (usually of the peak 
maximum).  

 Tip:  
In addition, it is possible to combine several spectra to the Apex spectrum, 
and then subtract the background spectrum from this averaged spectrum. 
However, this is usually not necessary for UV spectra as they have a 
relatively low noise level compared to Mass Spectra.  

Use the UV tab of the QNT Editor to determine background subtraction for 
UV spectra. (For more information about the editor, see (see Data 
Representation and Reprocessing  The QNT Editor.)  
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The Enable Background Subtraction check box is enabled indicating that 
spectrum subtraction is active: 
 

 
 
Only for UV spectra with a high noise level, it is necessary to average 
spectra to reduce the noise level. For example, spectra averaging may be 
required for very small peaks that are only slightly above the Limit of 
Detection. In the combo box under Peak Spectrum Bunch, enter the 
number of single spectra that shall be bunched to form the spectrum at the 
peak maximum. A maximum of 99 single spectra can be averaged. For 
symmetry reasons, it is possible to enter odd numbers only. Therefore, by 
default, only one spectrum is selected as Width of the Peak Spectrum 
Bunch. 

Peak Dependent Background Subtraction allows automatic background 
subtraction for each peak. In the edit fields under Left Region Bunch and 
Right Region Bunch, enter the number of spectra to be used for forming 
the two background spectra. You can select up to 99 single spectra. Zero 
and even numbers are permitted as well. These settings apply to peak 
spectra and time spectra below peaks. The default setting is that one 
spectrum each is subtracted on both sides of the peak. 

Select Fixed Background Subtraction Ranges to define two fixed ranges 
for background subtraction for the entire chromatogram. It usually makes 
sense to set one range at the beginning and the other one at the end of the 
chromatogram. These settings apply to peak spectra and to all time 
spectra. 



 Displaying and Using UV Spectra 511 

Click Apply to accept the settings and calculate the resulting UV spectrum. 
When the Show Spectra view is enabled, the newly calculated UV 
spectrum is displayed at once. 

 Note: 
Defining the background subtraction manually in the chromatogram affects 
the settings on the UV tab page. For example, if you select UV 
Background Subtraction on the context menu of the chromatogram, and 
then select Fixed Background Ranges, the corresponding option is 
automatically selected on the UV tab page of the QNT Editor. 

 Match Factor, Difference Spectra, 1st/2nd Derivatives of 
Spectra 
When two or more spectra are represented on the spectra plot, the 
similarity of the UV spectra becomes an issue.  

The match factor can express the similarity, by forming difference spectra 
or by representing the first or second derivative of a UV spectrum.  
• Select Decorations on the View or context menu and select the Show 

match check box on the Label tab page. Chromeleon issues a value 
for each represented spectrum, expressing the match degree relative 
to the main spectrum (0 = no match; 1000 = perfect match).  

• On the Analysis tab, define whether the difference spectrum or the first 
or second derivative of a spectrum shall be displayed in a second 
window in addition to the actual spectra.  

In the case of the match factor and the difference spectrum, the question 
which UV spectrum is considered a main spectrum is especially important, 
as this is the basis of comparison or the basis for all calculations.  

Usually, this is the peak spectrum extracted at the retention time. If there is 
no peak spectrum, distinguish two situations: If you select the spectra tool 
to extract the single UV spectra from the chromatogram, the spectrum that 
is first extracted is the main spectrum. If spectra are extracted automatically 
at different peak heights, the spectrum with the "oldest" retention time is 
considered the main spectrum. When representing difference spectra, the 
Difference to entry indicates the basis of calculation. 
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Creating and Using Spectra Libraries 
The Spectra Library pane allows you to compare Normalized and single 

baseline-corrected spectra with spectra from various libraries. 

For more information, refer to:  

 Creating a New Library 
 Using Spectra Libraries 
 Comparing Spectra 

 Creating a New Library 
First, select New > Spectra Library on the File menu to create a new and 
empty spectra library. Then, include the spectra of interest: 
• From the PPA or Spectra Plot panes: Copy a spectrum to the 

Windows clipboard, using the Copy command or the Extract > Lib-
Spectrum to clipboard commands on the context menu. Insert the 
spectrum in the open library, using the Paste Spectra command. (For 
information about PPA and/or the spectra plot, refer to Data 
Representation and Reprocessing  PPA: Peak Purity Analysis or 
Integration  The Spectra Plot.) 

• Or else, generate a subset of an existing selection based on specific 
Hit Criteria.  

 Note:  
To be able to compare UV spectra, the spectrum and the reference 
spectrum should be recorded under identical conditions. That is why the 
best search results are obtained based on spectra that were recorded and 
saved by the user. Dionex recommends to writing down the conditions 
under which the spectrum is recorded. These notes will be very useful 
when there are several spectra for the same sample. 

Saving the library 
Select Save as to save an open library under a different name to a 
directory of your choice. Libraries have the file extension LIB. 
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 Using Spectra Libraries 

Spectra Table 
The upper section lists all spectra that are contained in the active Spectra 
Library, as well as their data. Double-click a column header to sort the list 
according to the criteria of the selected column, such as the name, ID, or 
number of extremes. Select the first column of the table to select the 
corresponding spectrum.  

 

• When you move the mouse pointer into the left column, the cursor 
becomes a horizontal arrow. Left-click to select a spectrum.  

• To select several spectra, press and hold the CTRL key.  
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Spectra Plot 
The spectra plot is displayed at the bottom left, underneath the table, 
showing the spectra of all substances selected in the spectra table. 
• Double-click the window or select Decoration on the context menu to 

change the spectra representation. For more information, refer to 
Integration  The Spectra Plot. 

Working with the Spectra Library  
The objective of spectra administration is the identification of an unknown 
substance based on its UV spectrum. If you have a spectrum of a 
previously unidentified substance, for example, in the spectra window of the 
PPA method, you can start searching various libraries from there.  

Chromeleon compares the curve form of the two spectra (comparison), 
calculates a similarity value (evaluation), and displays similar spectra (hit 
criterion).  

The distinction made by Chromeleon depends on whether a single 
spectrum is identified or all peaks of a sample. 

Hit List 
The hit list lists all library spectra that have a certain similarity to the 
extracted (and normalized) spectrum. For more information, refer to How 
to …: Displaying and Using UV Spectra  Searching Single 
Reference Spectra. 

Peak Tracking 
Assigning each peak in a chromatogram the spectrum of a library that 
matches the spectrum extracted at the peak maximum best is referred to as 
peak tracking.  

 Comparing Spectra 
To compare two spectra with each other, the curve of the normalized 
spectrum can be compared to the curves of single library spectra. In some 
cases, better results are achieved when the first or second derivations are 
compared instead of the spectra themselves.  

Use the comparison function (see ⇒Check Derivative) to determine the 
curve form to be used for the comparison. 
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In the next step, determine how the single curves are compared with each 
other. Select one of three mathematical methods; they are referred to as 
⇒Match Criterion. 

The combination of comparison function and standard of comparison 
results in a "similarity value" between 0 and 1000 that expresses the match 
degree between the search spectrum and various library spectra. The 
similarity value is known as Match Factor. A perfect match has the value 
1000.  

Depending on the method (hit list or peak tracking), a similarity list is 
displayed or each peak is assigned the most similar spectrum. If you enter 
a minimum similarity value (threshold), only the hits above the threshold 
value are displayed. 

For more information about how to search spectra, refer to How to …: 
Displaying and Using UV Spectra  Searching Single Reference 
Spectra. 
 

Result Presentation in a Hit List 
Using the hit list, a similarity list sorted by the match factor and a 
representation of the original spectrum and the library spectrum with the 
best match are displayed. Entering a minimum similarity value excludes 
dissimilar spectra.  

Due to the frequently insufficient characteristics of UV spectra, it may be 
necessary to further limit the hit lists. Hit Criteria are available as 
additional filters. Only the spectra fulfilling the selected criteria will be 
displayed.  

For information about how to search reference spectra, refer to 
 Searching Reference Spectra. 
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Searching Reference Spectra 
Chromeleon allows you to search for reference spectra as follows: 

1. Searching single spectra: Perform the search from the Spectra windows; 
refer to  Searching Single Reference Spectra. 

2. Searching spectra from any number of samples that use the same 
quantification method: Perform the search from the Spectra Library 
Screening tab in the QNT Editor. 
 
For more information, refer to: 

 Entering Criteria for the Spectra Library Screening 
 Starting Library Screening and Viewing Results 
 Integrating Screening Results in Reports and Peak Labels 

 Searching Single Reference Spectra 
To facilitate substance identification, the peak spectrum, which is displayed 
on the Spectra Plots of the Integration or PPA method, can be compared 
to the UV spectra of a spectra library.  

Based on the available library, Chromeleon creates a spectra list sorted by 
the degree of similarity, the Hit List. The number of possible hits can be 
limited via comprehensive search criteria. 
• If the pointer is in a spectra window, select Library Search on the 

context menu of the UV spectrum to start the spectra search. 

In the edit box, specify the library that should be searched. The following 
are minimum entries required to receive a valid search result:  
• Select a spectra library (LIB file) from the Spectra Library to be 

searched in list. If no LIB file is displayed, click Browse to search for 
the file.  

• In the ⇒Match Criterion field, determine the mathematical method 
based on which the original spectrum and the library spectrum are 
compared with each other. The best search results are generally 
received with Least Squares. 

• Click OK to start a spectra search. 
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 Note: 
To be able to compare UV spectra with each other, the spectrum and the 
reference spectrum should be recorded under identical conditions. For best 
results, compare spectra to your own spectra library.  

Result 
A list of possible candidates will be displayed. The top spectrum has the 
highest match value and the best similarity to the original spectrum.  

Detailed Search 
To accelerate the search and to receive very specific results, there are 
numerous options:  
• Normally, the Spectrum Derivative option is disabled, that is, spectra 

comparison is based on the actual curve shape. If the 1´st Derivative 
option is selected, the comparison of the two spectra is performed 
based on the first derivative. Consequently, the curve characteristics 
are more significant (shoulders become real extremes), which allows a 
more precise comparison. The drawback of this option is the reduction 
of the signal-to-noise ratio, which causes sections with weaker signals 
to loose significance.  

• Select Hit Threshold and enter a value between 0 and 1000, for 
example, 950. Only the spectra with a match above 950 will be 
displayed. Spectra with a lower match value will not be displayed. 
Spectra with a match value below 900 are usually spectra of other 
substances (if derivatives are not used for the comparison). Exceptions 
to this are acceptable only if, for example, the signal-to-noise ratio is 
low.  

Select the following options to ensure precise search results:  
• Enter the number of relative extremes the spectrum should have 

(Number of Relative Extrema). This option is useful to exclude 
spectra that are similar but have an additional side maximum. 

• Select Check Greatest Relative Maximum to use only spectra with 
the greatest relative maximum at the same position. Select Allowed 
Deviation to define a tolerance range. The range should not be more 
than 10 nm to avoid that the criterion weakens. 
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• Via Retention Time Window, define a time window that includes the 
retention time of the peak. Use this option to exclude substances with 
very similar spectra, but which are eluted at very different retention 
times.  

Additional criteria are only required in special cases. However, they are 
useful for searching large libraries containing numerous spectra of the 
same substance, but extracted under different conditions; for example, 
different solvents and detectors, different users, different date, etc. 

 Note: 
When creating your own spectra library, please enter information in all 
fields, even in the fields that may seem unnecessary. In the course of time 
and with a growing library, this may become a major advantage.  

 Entering Criteria for the Spectra Library Screening 
Enter the criteria for a spectra library search on the Spectra Library 
Screening (= SLS) page of the QNT Editor: 

 
 
• Select a spectra library (LIB file) from the Spectra Library to be 

searched in field. If the required LIB file is not included, click the 
Browse button to search for the file. 
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• In the Match Criterion field, select the method (see ⇒Match Criterion) 
used for comparing the original spectrum and the library. The best 
search results are usually received via the setting Least Square. 

• In the Hit Threshold field, enter a Match Factor between 0 and 1000; 
for example, 950. Only spectra with a match value above 950 will be 
shown. Spectra with less similarity will not be included. Unless 
derivatives of spectra are compared with each other, reference spectra 
with a match value below 900 are usually spectra of other substances. 
Exceptions to this rule are only acceptable, if the signal-to-noise ratio is 
low. 

 Note: 
To be able to compare UV spectra, the spectrum and the reference 
spectrum should be recorded under identical conditions. For best 
results, create your own library of spectra you recorded yourself.  

Additional conditions are possible to perform a more exact search: 

Usually, the Use Spectrum Derivative option is disabled; that is, the 
comparison of spectra is based on their actual curve. If the 1st derivative 
option is selected, the comparison of two spectra is based on the first 
derivative. As a result, the curve characteristics increase (shoulders 
become extrema), allowing a more exact comparison of extrema. However, 
the signal-to-noise ratio will considerably decrease; and sections with lower 
signals will be less significant.  

Select Restrict Wavelength Range to limit the spectra comparison to the 
relevant spectral range. 

Select Check Greatest Rel. Max. to use only spectra with the greatest 
relative maximum at the same position. Select Allowed Deviation to 
specify a tolerance range. The range should not exceed 10 nm to avoid 
that the criterion loses significance. 

Click Maximum Retention Time Deviation to determine the maximum 
retention time deviation of the reference spectrum in percent. This prevents 
including substances with very similar spectra that are eluted at different 
retention times. 

If you select Check Number of Relative Extrema, Chromeleon checks the 
number of relative extrema of the reference spectrum. Select this option to 
exclude spectra that are very similar but have an additional maximum.  
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Select Maximum Retention Index Deviation: or Maximum Kovats Index 
Deviation: to include only those spectra in the comparison for which the 
retention index or, respectively, the ⇒Kovats Index is identical with the 
index of the sample substance. The respective tolerances are defined in 
the right field. 

 Tip 
With an increased noise level, noise peaks can be considered extrema. In 
this case, Dionex recommends disabling Check Number of Relative 
Extrema. 
 
On the right side of the window, you can further restrict the resulting library 
spectra. Open the dialog box Restrict Library Search with Add. Via Field 
Name, you can then select type of parameter to be determined from the 
following search criteria: 
 
Solvent Composition Detector Serial Number 
Control Program Timebase 
Substance Name Sequence Name 
Unique ID Sample Name 
Comment Extract Operator 
Detector Name   
These items can be linked (partly) via the following operators (Conditions) 
with a freely selectable value: 
 
Operator Restricts the search to spectra with parameters that 
is equal to: fulfill the specified condition. 
starts with: start with the entered string. 
does not start with: do not start with the entered string. 
ends with: end with the entered string. 
does not end with: do not end with the entered string. 
contains: contain the entered string. 
does not contain: do not contain the entered string.  

 Note: 
If you want to search all libraries in a directory, simply enter the character * 
as the file name. The wildcard characters (known from MSDOS) * and ? 
are valid. Example: LIB::\CMDATA\LIB\D* searches all libraries starting 
with the letter D in the directory LIB of the datasource CMDATA. 
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 Starting Library Screening and Viewing the Results 
Click Apply to use the entered search parameters. This command starts 
the library search for each peak in the active chromatogram.  

The spectra plot is displayed in addition to the chromatogram. The 
reference spectrum (hit) with the corresponding match criterion will be 
shown. The displayed spectrum is the reference spectrum of the selected 
peak. You can display the search results for the other substances by 
clicking the corresponding peaks in the chromatogram. 

If more than one library spectrum fulfills the entered criteria, you can 
display the other hits. Place the cursor on the spectrum, open the context 
menu, and open the Spectra Decoration tab page. Use the Peak Spectra 
tab page to enter the number of reference spectra to overlay: 
 

 
 
In this example, you will receive a list of three reference spectra. The first 
spectrum has the highest match value and thus the greatest similarity to the 
original spectrum.  
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 Inserting Screening Results in Reports and Peak Labels 
If you save the search parameters in the QNT File, the results of the 
Spectra Library Screening can be used for the peak label or in report 
tables or templates ( Printer Layout).  

Inserting Screening Results in Report Definition Files 
To display the screening results in the report, the Peak Purity report 
category supports the following variables:  

Number of SLS Hits calculates the number of library screening hits for a 
peak.  

SLS Hit opens the ⇒Hit Spectrum report category that includes all 
variables of the corresponding library spectrum: 
 
Designation Description 
Substance Name  
Match Factor Match Factor 
Library Name Name of the spectra library 
Library Record Opens the ⇒Spectra Library category 
Number of rel. Extrema  
Solvents  
Comment Comment 
Sequence Name  
Sequence Header Record  
Sample Name  
Sample Record  Branches to the ⇒Sample category 
Acquisition Time Acquisition date and time 
Timebase Timebase 
Program PGM File 
Sample Rate  
Retention Time ⇒Retention Time 
Lambda Min. Minimum wavelength 
Lambda Max. Maximum wavelength 
Lambda Range Wavelength range 
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Designation Description 
Lambda Resolution Spectral wavelength resolution 
Detector Name  
Detector Serial Nr.  
Extract Time Time when the sample was added to the 

library 
Extract Operator User who added the sample to the library 
Retention Index Linear ⇒Retention Index 
Kovats Index ⇒Kovats Index 

The Formula field shows a short version of your selection; for example, 
peak.hitSpec(1).name for the spectra name of the best hit. The digit 
indicates the hit: 1 is the best, 2 is the second best hit, etc. 

Including Screening Results in the Peak Label 
To include the screening results in the chromatogram, follow the steps 
below:  
• Position the cursor in the chromatogram. 

• Select Chromatogram Decoration on the context menu.  

• On the Peak Label tab page of the Chromatogram Decoration dialog 
box, click {...} to open the Insert Variable into Peak Label Formula 
dialog box. Select the Number of SLS Hits and SLS Hit variables (see 
Inserting Screening Results in Report Definition Files above) from 
the Peak Purity category.  

Example 
To label each peak in the chromatogram with the name of the best hit and 
the corresponding match factor, follow the steps below: 
• From the category Peak Purity, select the Substance Name under 

SLS Hit. 

• In the Formula field, enter " - " after the formula, then click Match 
Factor under SLS Hit.  

• Click OK. You will receive the following Formula input on the Peak 
Label tab page of the Chromatogram Decoration dialog box: 
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 Tip: 
If you have saved the search parameters in the QNT File, it is sufficient to 
enable Spectra library screening results; for example, on the spectra 
plot. Just open the context menu and select the option via Spectra 
Decoration and Peak Spectra. In this case, you do not need to open the 
Spectra Library Screening dialog box and click Apply. 
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Analyzing the Peak Purity 
Use the PPA window (see Data Representation and Reprocessing 

 PPA: Peak Purity Analysis) to check the peak purity. The PPA window 
displays the 3D Field of a sample if there is a corresponding raw data file. 
This is the case if the 3DFIELD channel was selected for Data 
Acquisition. 

The 3D field in the lower right-hand window section has cross-wires. With 
the mouse, the axes can be moved separately or together. The spectrum or 
chromatogram extracted along the current y and x-axis will be displayed on 
the left or above the 3D field. 
• Move the y-axis of the cross-wires to successively display all spectra of 

the active chromatogram. 

• Move the x-axis of the cross-wires to display the appearance of a 
chromatogram at different wavelengths. 

• The status bar shows the retention time, wavelength value, and signal 
height of the current cross wire position. 

Peak purity can be evaluated using the following methods: 

 Visual Check of Iso Line Plot 
 PPI and PPI Match Factor 
 Normalized Spectra Overlay 
 Peak Inhibition via Virtual Channels 
 Multiple Ratio  
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 Visual Check of Iso Line Plot 
The visual check of the Iso line plot is a method that allows peak purity 
evaluation. High peak purity is indicated by: 

• All recognizable absorption maxima 
are located vertically below one 
another in direction of the wavelength 
axis. 

• The maxima are separated so that the 
surrounding iso lines do not touch (no 
overlapping). 

• Pure peaks have (local) symmetry or 
an idealized ellipse shape in the 
maximum.  

 PPI and PPI Match Factor 
In the chromatogram window of the PPA method, curves for the PPI 
(Peak Purity Index) and the Peak Purity Match Factor can be displayed: 
• Double-click within the window and select the options Draw PPI and 

Draw Match from the Chromatogram Plot tab page. 

The peak purity index is represented by a purple curve, and the match 
factor is indicated by a green curve. A distinctive rectangular shape is one 
criterion (of many) for peak purity. The exact match value at the current 
mouse pointer position is shown on the status bar. The ideal value is 1000 
and requires approximately 80% of the available window height.  

PPI, match value, and the corresponding standard deviation (RSD) can be 
included in a report. The report variables are available in the Peak Purity 
and Identification category.  

The smaller the standard deviation, the more critical the quality of the 
rectangular curve should be judged; that is, the better the two spectra will 
match in various points of a peak. 
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 Normalized Spectra Overlay 
In a normalized spectra overlay, single spectra of the spectra recorded for 
the peak are extracted and are compared with each other. Usually, 
extraction is at the run time of the peak and at a specific peak height in the 
leading and trailing edges of the peak; for example, at 10% and 50% of the 
peak height. Comparing spectra that are normalized by the same method 
is a means of evaluating the peak purity.  

The more closely the spectra match, the higher the possibility that the peak 
is pure. The following are indications for the impurity of a peak: 
• The number of relative maxima and minima of two spectra does not 

match  

• The relative maxima are clearly offset against each other 

• The height of the relative maxima strongly deviates 

However, please note the following: 
• Especially near peak limits, spectra have an increased noise level due 

to the normalization procedure. This applies in particular to the UV 
range. 

• In the case of very long peaks, baseline correction cannot completely 
compensate for detector drift. 

• The spectra shape depends on the solution; that is, the spectra of a 
peak can only be compared if the mixing ratio was constant during 
detection.  

• It is possible only to compare spectra with the (complete) absorption in 
the dynamic validity range of the Lambert Beer Law. If the peak 
maximum, including the baseline spectrum, is considerably above 1 
AU, caution is called for. 

 Tip: 
The normalized spectra overlay via peak height is currently possible only 
on the spectra plot (also see Integration  The Spectra Plot). Within the 
PPA method, the "animated" extraction of spectra is possible. Pressing the 
CTRL key in the 3D field extracts the current spectrum. If the y-axis of the 
cross-wires is moved simultaneously, all spectra existing for this range are 
displayed in the spectra window. A different color indicates the extraction 
period in the chromatogram.  



528 Displaying and Using UV Spectra 

This process can be repeated; for example, for different retention times 
within the peak width. If you release the CTRL key between the individual 
extractions, the spectra extracted per range are displayed in a separate 
color. 

 Peak Inhibition via Virtual Channels 

If two overlapping peaks have different spectra s1(λ) and s2(λ) the 
following equitation is true when the area below the baseline is ignored: 

A(λ, t) = s1(λ)*c1(t) + s2(λ)*c2(t) (1). 

c1 and c2 stand for the time-dependant concentrations of the 
corresponding components in the flow cell. Then, two wavelengths λ1 and 
λ2 are selected and the following signal is created:  

d(t) = A(λ1, t) - K*A(λ2, t) = c1(t)[s1(λ1) - K*s1(λ2)] + c2(t)[s2(λ1) - K*s2(λ2)]. (2), 

The c2 term disappears provided the appropriate expression was selected 
for K, that is: 

K = s2(λ1) / s2(λ2) (3) 

This is the channel ratio of the second peak. It can be read off the height 
ratio of the two peaks if they do not overlap completely. In order to be able 
to use this approach, the channel ratio of the first peak  

K’ = s1(λ1) / s1(λ2) (4) 

must be different from K. If not, the first term in equation (2) will disappear 
as well. Select the λ1 and λ2 wavelength in such a way that the difference 
between K and K’, that is: 

∆K = ⏐K - K’⏐ (5) 

is the maximum difference. The best way to determine the appropriate 
wavelengths is to do so in the PPA Window. After this, the virtual channel 
d(t) can be defined. Of course, it is possible to inhibit the first peak in the 
same way.  

If you know the wavelengths for which ∆K is the maximum before you 
record the chromatogram, the two channels, for example, UV_VIS_1 and 
UV_VIS_2 can be adjusted to those wavelengths. You can then use the 
following Program: 
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As already mentioned in the comment line of the program, the following 
equation is true for this example:  

K  =  0.3. 

 Multiple Ratio 
Each channel extracted from a 3D field can be used for performing the ratio 
test. Especially suited are chromatograms in the range of spectral minima 
or maxima. If the ratio condition is met, this can indicate, but does not prove 
peak purity. Performing the test with a larger number of channels does not 
change this fact. 
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Selecting the Optimum Integration Path 
Chromeleon is capable of calculating the Optimum Integration Path within 
a 3D field. The calculation is performed automatically. The result can be 
displayed in the 3D field window of the PPA method. 
• Double-click within the window and select the Draw Opt-Int-Path 

option on the Iso/3D Plot tab page. 

 Tip: 
You may also define extraction of the optimum integration path in the 
Post-acquisition steps view of the PGM Editor (see Control  The 
PGM Editor.) Open the PGM File in which you want to define 
extraction of the optimum integration path, and then select the Post-
acquisition steps view. 

A green line in the 3D field indicates the integration path. Similar to 
chromatograms, it can be saved as a separate channel with variable 
wavelength.  
• Select Extract > Opt. Int. Path to file on the View or context menu 

and determine the name under which the path is saved as a separate 
channel or accept the default name (OPTINT).  

 Tip:  
In the PGM Editor, follow the steps below: Select Insert line on the 
context menu to add a new post-acquisition step. The New post-
acquisition step dialog box is opened. Select Extract optimum 
integration path to open the Extract optimum integration path 
dialog box. 

• Select Extract from all samples of current sequence or query 
option, if the path should be extracted for all samples of the underlying 
sequence or query. The shape of the path is identical for all samples!  

 Tip:  
This option is not provided in the dialog box of the PGM Editor.  
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 Notes:  

Chromeleon does not consider rider peaks (Type (⇒Peak Type): Rider) 
when calculating the optimum integration path. 

The channel extracted in this way may have baseline jumps. For distinctly 
absorbing solvents, they may be due to changes in the wavelength.  

If the path should serve as a basis for a Wavelength Switch in future 
samples, the switch times and the selected wavelength values must be 
entered in a program with exact time specifications. This can also be 
performed by automatically inserting the data. 
• Select Extract > Opt.Int.Path to clipboard on the View or context 

menu to copy the data to the clipboard. 

• Select the Name of the channel, for which the wavelength is 
automatically switched in the future. 

• Enter a value for the Bandwidth if several chromatograms should be 
averaged to one. The bandwidth determines the range of the path. All 
sections of a chromatogram within this range are averaged to one 
chromatogram.  

• Open a PGM File and insert the data at the beginning of the program 
(Commands view) via the Paste command.  

The resulting PGM File could have the following appearance: 
 

0.000 UV_VIS_1.Bandwidth = 0 
 UV_VIS_1.Wavelength = 210 
3.320 UV_VIS_1.Wavelength = 210 
4.830 UV_VIS_1.Wavelength = 206 
6.100 UV_VIS_1.Wavelength = 272 
8.100 UV_VIS_1.Wavelength = 262 
9.660 UV_VIS_1.Wavelength = 278 
10.480 UV_VIS_1.Wavelength = 250 

 
• Enter more commands in the program to complete it. Sort it according 

to ascending retention times.  
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Extracting and Exporting Spectra, 
Chromatograms, and 3D Fields 

Spectra 
You can copy each spectrum extracted from a 3D field in the PPA method 
or on the spectra plot (see Integration  The Spectra Plot) to the 
Windows clipboard (Copy command). From the clipboard, you can then 
paste the spectrum in a spectra library (Paste command). (For information 
about spectra libraries, refer to Data Representation and Reprocessing 

 Spectra Libraries). Follow the steps below: 
• Select Extract > Spectrum to clipboard on the View or context menu 

to copy the current spectrum from the 3D field of the method PPA to 
the Windows clipboard. 

• Open an existing Spectra Library. Select the command by opening the 
corresponding LIB file from the Browser, or 

• Create a new library via the File> New > Spectra Library commands. 

• Select Paste Spectra to save the spectrum and the data in the library.  

Chromatograms 
From an open 3D field in the method PPA, you can extract a chromatogram 
of any wavelength: 
• Select Extract > Chromatogram to file on the View or context menu 

to save the active chromatogram as a separate channel. 

• Select the wavelength and the bandwidth at which to extract the 
chromatogram.  

Chromeleon will suggest a name for the extracted chromatogram, 
considering the wavelength. However, you may also enter any other name 
of your choice. The chromatogram is saved in addition to the raw data of 
the existing 3D field. Simultaneously, the extracted chromatogram is 
opened via the Integration method to give the user an overview of the 
saved data.  

In addition, the Extract > Chromatogram to file command provides a 
special option. Instead of saving one single chromatogram, another 
chromatogram of the same wavelength can be extracted and saved from all 
samples of the underlying sequence or query. Enable Extract from all 
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samples of current sequence or query. Especially in this case, 
automatically naming the extracted chromatogram (see above) is very 
useful. 

3D Field Data 
Select Export > 3DFIELD to include and display the current 3D field raw 
data in other applications, such as Microsoft Excel. Data is converted into a 
general ASCII format.  
• After you have executed the Export 3DFIELD command, change to the 

other application and insert the data, using the Paste command. In 
addition to the pure raw data, additional sample and sequence 
information is transferred to the application.  

Answering Frequently Asked Questions 
 
Question: How do I perform spectra scanning? 

Answer: In the Program Wizard, select the 3DField check box on the UV 
Options page to record the 3D channel for the corresponding samples. 
 
Question: How do I change the ⇒Detection Parameters, such as 
⇒Minimum Area or ⇒Inhibit Integration? 

Answer: Enter the parameters on the Detection tab page of the QNT Editor 
(see Data Representation and Reprocessing  The QNT Editor). 
 
Question: How do I save the modifications to the layout of the on-screen 
report? 

Answer: Modifications to the layout of the on-screen report are saved in the 
workspace. To save any modifications, select Save Workspace on the 
Workspace menu. The workspace contains the arrangement of the 
individual windows. Which information is displayed in the single windows is 
defined by the information saved in the corresponding file. For example, for 
the Printer Layout window, the information is saved in the Report Definition 
File (RDF).  
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Creating and Using Report Tables 
Chromeleon provides numerous options to work with Reports. You can 
add report tables to the screen report and in the Printer Layout. The 
related settings are stored in the Report Definition File (RDF).  

You can use existing report definition files or create special files to meet 
your individual requirements.  

For more information about how to use report tables in the screen report, 
refer to  Using Report Tables in the Screen Report. For information 
about how to use report tables in the Printer Layout, refer to  Creating 
Report Tables for the Printout. 

 Using Report Tables in the Screen Report 
Before you can use a report table in the screen report, you have to display 
the report table (see  Displaying a Report.) For more information about 
how to use report tables in the screen report, refer to: 

 Defining the Contents of a Report  
 Defining the Appearance of a Report 
 Optimizing the Line Height 
 Saving a New Report Definition File 
 Linking Report Variables 
 Calculating the Peak Variable "Amount" 
 Adding and/or Renaming a Worksheet  
 Displaying the Peak Summary 
 Displaying an Audit Trail 
 Creating a History Report 
 Displaying MS Reports 
 Selecting Other Special Reports 
 Setting Parameters for Variables (e.g., for the confidence interval) 
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 Displaying a Report 
A numerical Report can be included in the Integration, QNT Editor, and 
PPA method windows. 
• Select Show Report on the View menu. 

If you have not generated a report before, the default report (called 
Default) will be opened. The default report contains the following 
worksheets: Integration, Calibration, Peak Analysis, Summary, and 
Audit. If you are working with a Photodiode Array Detector, select the 
default report, DEFLTDAD. This report contains two additional worksheets: 
Peak Purity and Lib Search. 
• To select a worksheet, click the corresponding tab.  

Each worksheet includes several default variables that are specific to the 
selected report type. For example, in an integration report, there are 
columns for Ret.Time, Area, and ⇒Amount. A calibration report contains 
columns for Offset (c0), Slope (c1), and Curve (c2), etc.  

These predefined report sheets can be used for various purposes; no 
additional input is necessary. 

 Defining the Contents of a Report 
To change the contents of a Report Definition File (RDF), select a 
command on the Table or context menu: 
• Select Insert Column to insert a column in the report table on the left 

of the current cursor position.  

• Select Add Column to add a column to the report table on the utmost 
right.  

 Note: 
A new column that has been created using the Add Column command 
has no format yet.  

• Select Fix Column to move the selected columns to the far left. 
Columns of this type are permanently visible, even when scrolling. 

• Select Delete Column to delete one or several columns. 
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• Select Column Properties (or double-click the column header) to 
modify the column properties. You can then replace the current column 
contents, for example, number of theoretical plates, with a different 
variable. 

• To change the formula of a cell, enable the Layout Mode on the Table 
menu. (The Layout Mode command is not available on the context 
menu.) An edit line appears above the table. In the table, click the cell 
for which you want to edit the formula. To the left of the edit line, the 
number of the cell is displayed. Edit the formula as desired. You can 
also use the Additional Functions of the Report Publisher module, if 
your Chromeleon license supports this.  

 Tip: 
When Layout Mode is enabled, do not change the format. 

 

 Tip: 
Each column usually shows one report variable. However, it is possible to 
link several report variables (see How to …: Creating and Using Report 
Tables  Linking Report Variables). Mathematical and statistical 
functions such as SUM, AVERAGE, etc. are only available in the Report 
and the Printer Layout together with the Report Publisher. 

• Select Table Properties to modify the properties of the entire report. 
Use this command to sort the table in groups or remove peaks below a 
certain area value. 

 Defining the Appearance of a Report 
To modify the appearance of a report, select the Table menu. Then, select 
Format >...  
• Alignment to position the text horizontally and vertically in a cell or a 

column.  

• Font to determine the font, font style, and size. 

• Border to determine the location, the color, and the shape of the 
frame.  

• Pattern to determine the color and the pattern of the cell background. 



538 Creating and Using Report Tables 

• Number Format to determine the format of the represented values.  

• Autoformat to design the entire report by selecting a ready-made 
default template. The Preview window shows the appearance of the 
report in the currently selected format. 

 Tip: 

When Layout Mode is enabled, do not change the format. 

 Optimizing the Line Height 
Chromeleon allows you to optimize the line height. Do this especially for 
sample variables, for which the single values are displayed in several lines 
in one cell: 
• Enable Layout Mode on the Table menu. 

• In the left column, double-click the separation line under the line for 
which you want to adjust the height automatically. (In the picture below, 
for example, double-click the blue line that separates lines 6 and 7. 
(Note: The blue color is used in the picture only for illustration purposes; 
it does not appear in Chromeleon.) This optimizes the height of line 6 so 
that the entry in the List of Aggr. Smp. column is completely 
displayed.) 
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(In the example in the picture, the heights of lines 3 to 5 were already 
adjusted automatically, i.e., optimized. Thus, the list of aggregated samples 
is completely displayed in each line. The height of lines 6 to 9 was defined 
by a fixed value so that the lists were not displayed completely.) 

 Saving a New Report Definition File 
You can save all modifications made in a report to a Report Definition File 
(RDF): 
• Select Save Report Definition and then enter the file name under 

which to save the RDF.  

• If you change a default Report Definition File from the Dionex 
Templates > Report directory, you usually cannot save the new file to 
this Report folder because the Dionex Templates directory is locked. 
Save the modified file to a different directory; for example, create a new 
'Report' directory under your local datasource.  

 Tip:  
If you do not save the RDF before you exit the screen report, any changes 
made to the report's layout are lost. There will be no hints as to the loss of 
these changes because a warning would then have to appear for every 
other change, as well, e.g., when resizing single windows. 

 Linking Report Variables 
To generate user-defined report variables, use the four basic arithmetic 
operations or powers to link two or more report variables. Link the single 
variables, using the formulas of the ⇒Report Categories. 

How to 
• Select a report column, and then select Add Column on the Table 

menu.  

• In the Formula field of the edit box (Add Report Column), enter the 
formulas you wish to link by mathematical operators. 

• Note that the variable names are not identical with their "formulas"; for 
example, peak height and peak.height). For the correct syntax, refer 
to ⇒Report Categories. You can copy the syntax by selecting the 
required formula and pressing the CTRL+C. Change to the edit box 
again and insert the formula by pressing CTRL+V.  
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Example: To put the peak height in relation to the corresponding 
⇒Amount, use the following expression:  

peak.height / peak.amount 
• You can also use the following operators to link expressions:  +, -, x, 

and ^ (for powers) 

• Enter the desired column header in the Header field.  

• Click OK to complete your input. 

 Tip: 
Mathematical and statistical functions such as SUM, AVERAGE, etc. are 
only available in the Report and in the Printer Layout together with the 

Report Publisher!  

 Calculating the Peak Variable "Amount" 

If you wish to check the indicated ⇒Amount values, have a look at the 
respective coefficients of the calibration function first. Then, add the 
columns offset (c0), slope (c1), and curve (c2), which are all part of the 
Peak Calibration category.  

For the amount calculation of an unknown sample, the inverse function f(y) 
of the calibration function F(x) must be calculated. Calibration functions are 
calculated as follows:  

Linear:  
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Exponential:  
f y
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 Note: 
For ambiguous inverse functions (two possible values for quadratic with or 
without offset) always use the value which comes "closest" to the X values 
of the respective calibration. If it is not possible to calculate the expression 
(c1=0 for linear with or without offset, the radiant < 0 for quadratic with or 
without offset, or c0=0, or c2=0 for exponential), "n.a." is returned as 
amount.  

If the response factor, dilution factor, weight, and a factor for the Internal 
Standard are available, that is, if they do not equal 1, they have to be 
considered for the calculation as well (see Formula for Amount 
Calculation). 

 Adding and/or Renaming a Worksheet 
You can add new worksheets to the Report Definition File (RDF) and 
define their contents and appearance.  
• Select Insert Report on the Table menu and determine the type of 

report to be created.  
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The following reports are available (the order is the same as in dialog 
box): 

Result Tables    
Peak Results    

Calibration 
Report 

Displays all variables required for creating a calibration report on the 
right.   

Integration 
Report 

Displays all variables required for creating an integration report.  

  
Sample Results    

Calibration 
History 

Displays all variables documenting the course of the calibration on 
the right.   

Peak Summary Displays all variables required for creating a peak summary.   
SST Summary 
Report 

Displays all variables required for documenting the results of the 
System Suitability Test for the entire sequence.   

Audit Trails    
Audit Trail 
(Commands, 
SST, ...) 

Displays the Audit Trail of the current sample (see Data 
Management  Audit Trails). 

  
MS Instrument 
Info Report 

Displays information about the Mass Spectrometer. 

  
MS Status Log 
Report 

Displays the mass spectrometer settings. 

  
MS Tune Data 
Report 

Displays the tune data of the Xcalibur raw data file. 

  
MS Instr. Method 
Report (XRaw) 

Displays the MS method. 

  
Spectra Results    

MS Raw Report Displays the raw data of the current Mass Spectrum.   
Fraction Collection Results    

Fraction Report Displays all variables required to create a fraction report.    
Tube Report Displays the different variables describing the single fraction 

collection tubes. This also includes the fraction report variables. 
However, please note that these variables are not selected by 
default. 



 Creating and Using Report Tables 543 

QNT Tables    
Detection 
Parameter  

Displays all ⇒Detection Parameters of the current sample. 

  
Peak Table Displays all variables that are required for displaying the peak table 

of the QNT Editor.   
SST Table Displays all variables that are required for the representation of the 

System Suitability Test.   
PGM Tables    

Commands Displays the Program for the current sample.   
Post Acq. 
Processing 

Displays the Post-Acquisition Steps for the current sample.  

  
MS Method Displays information about the current method of the Mass 

Spectrometer.   
Miscellaneous Tables    

Database Query Inserts any kind of database queries into the report.   
History Report Displays all variables required for creating a History report.  

• From the variables that are available on the right-hand side, click those 
you wish to include in the new report. Click OK to create the desired 
worksheet. 

• In the report, double-click the newly added tab and edit the name.  

Saving 
To save the content and appearance of a report, select Save Report 
Definition. 

 Tip: 
Please note that the appearance and the contents of the on-screen report 
needs not to be identical with the actually printed report, the Report 
Templates. The printout is defined in the Printer Layout. Thus, it allows 
you to initiate printing independently of what is displayed on screen.  
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 Displaying the Peak Summary 

Use the Summary worksheet in the Report (see Report Tables  The 
Peak Summary Report) to show certain results from all samples. 

The required steps are described in How to …: Creating and Using 
Report Tables: 

 Displaying a Report and  

 Adding and/or Renaming a Worksheet. 
The Summary worksheet represents, e.g., data of a specific peak from all 
samples (generally from a Sequence) while the Integration and 
Calibration worksheets of the Report Definition File (RDF) list the data of 
the peaks from one sample. 

To display, for example, the amount of different peaks of all samples of a 
sequence in one table, select Column Properties on the context menu. 
Select Peak Results from the Categories list, and then select Amount 
from the Variables list and have Chromeleon display the value for certain 
peaks (Fixed Peak(s)). The default setting shows the values for the 
currently Selected Peak. Determine the peak for which the data are 
displayed by clicking the peak in the above chromatogram. 

The default Summary report contains several columns. In addition to the 
sample name and the retention time, it also includes the Area, Height, 
⇒Amount, Types, and Plates columns. When you select a peak in the 
chromatogram, the values of this peak are included in the Summary report. 
If the selected peak is not contained in a sample, this line remains empty 
(n.a. = not available). 

Below the sample list, there are the lines Average and Relative Standard 
Deviation. The average value of a column is calculated and displayed. The 
relative standard deviation from this value is indicated in percent.  

The user can modify the default Summary report at any time. However, it is 
recommended to keep this report page. If another report is required, create 
an additional Peak Summary report page with new column assignments.  
 

 Note: 
Instead of a single sequence, the Summary report can also be started 
based on a Query. Then, the Summary may include different samples 
from different sequences. 
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 Displaying an Audit Trail  

You can include the sample audit trail (see Data Management  The 
Sample Audit Trail) as a worksheet in a Report Definition File (RDF). 
The worksheet always shows the audit trail for the currently selected 
sample. 
• The Day Time column indicates the time of a command or message.  

• The Ret.Time column indicates the corresponding retention time.  

• The Command/Message column command shows the command itself, 
the text of a message, or an event. 

To make further settings, select the Table Properties command on the 
context menu. The Audit Trail Report Properties dialog box is opened; 
define which the data shall be displayed.  

In addition, you can select one of the following Display options: 
• Run only to display only the entries for the sample run (default option) 

• Preconditions only to display only the conditions before a sample run 

• Preconditions and Run to display all entries 

The display filter (Filter Level) defines the type and extent of the Audit Trail 
entries for a sample run. 

Normal: Only the most important commands and properties are 
displayed. 

Advanced: Normal and Advanced level commands and properties 
are displayed. 

Expert: Normal, Advanced, and Expert level commands and 
properties are displayed (for experts only). 

Errors and Warnings: Only error messages and warnings but no 
commands are displayed. 

You can add the contents of the worksheet to other documents, using the 
Cut and Paste commands. It is also possible to print the entire audit trail in 
the Printer Layout. 



546 Creating and Using Report Tables 

Using Audit Trail Variables in Other Worksheets 

Certain events (such as performing a ⇒Trigger or changing the wavelength 
at a specific time) can be included in any Report worksheet. 
• Open the corresponding worksheet and select Column Properties on 

the context menu. 

• Select Audit Trail from the Categories list. 

• In the Variables field, select one of the audit trail variables. The 
variables that are available for selection depend on the events listed in 
the sample audit trail. 

• Use the Formula field to display events that are not listed (for example, 
the system pressure that is recorded using a Log command). In this 
case, the event variable is appended to the name AUDIT; separated by 
a period (AUDIT.pressure). 

• Click OK to confirm your input. 

Your report now includes an additional column for an audit trail variable. 
Normally, the value for the corresponding peak at the retention time is 
entered in each line. If there is no value at this time, the value that was 
recorded last is entered. When forming a gradient, Chromeleon calculates 
the corresponding values (%A, %B, %C . . .). 

If you want to display a specific audit trail event for all peaks in a report at a 
specific time: 
• Select Column Properties and then select an Audit Trail variable. 

• Click Parameter. 

A dialog box is opened allowing you to enter a retention time. Click OK to 
confirm the entry. A report column with a fixed retention time is generated. 
For example, the Wavelength audit trail variable displays the wavelength 
at time t. 

However, you can also search for the next associated entry in the Audit 
Trail. Starting point of the search is the entered retention time. Select 
backward as Search Direction to find the previous entry before the 
retention time. Select forward to find the next entry after the entered 
retention time. 
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 Creating a History Report 
The History report is not part of a default report. Therefore, select Insert 
Report to add a history worksheet to a Report Definition File (RDF) (see 
How to …: Creating and Using Report Tables  Adding and/or 
Renaming a Worksheet). 
By default, the worksheet shows the history of the current sample. Select 
Table Properties on the context menu to open the History Report 
Properties dialog box where you can change the settings: 
• On the History Objects tab page, select the object for which to display 

history entries. 

• On the Time Restrictions tab page, specify the time when the history 
entries to be displayed must have been made. 

• On the Operations tab page, determine the changes to be displayed. 

• On the Users tab page, determine the user(s) whose changes shall be 
displayed. 

• On the Sorting tab page, define the sorting order for the history 
entries. 

• A special layout mode is provided for the history report. Select the 
Layout Mode on Layout tab page. However, this is only possible if 
detail columns are available. If detail columns exist, select the Design 
template mode to display a shortened history report, thus, simplifying 
layout definition.  

 Displaying MS Reports  
Similar to the History report, the different MS reports are not part of the 
default Report Definition File (RDF). Select Insert > Chromeleon Report 
Table to add them as separate worksheets to a report definition file (see 
How to …: Creating and Using Report Tables  Adding and/or 
Renaming a Worksheet): 
 
• Select the MS Instrument Info Report to display information about the 

Mass Spectrometer. If there is no MS data, the following message 
appears in the report: "No MS Instrument Info found". 

• The MS Instrument Method Report indicates the MS method. If there 
is no MS data, the following message appears in the report: "No MS 
Instrument Method found." 
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 Note: 
The MS Method (under PGM tables) indicates the current method. It is 
possible that both MS methods are identical.  

• The MS Raw Report shows the raw data (mass, intensity, and relative 
intensity) of the Mass Spectrum of the current sample. If no MS data 
is available, the report just says: "No MS Raw Data found." 

• The MS Status Log Report shows the mass spectrometer settings. If 
there is no MS data, the report just says: "No MS Status Log found." 

• Select the MS Tune Data Report to display the tune data of the 
Xcalibur raw data file. If there is no MS data, the report just says: "No 

Tune Data found". 

 Notes: 
If the MS Control option is disabled on your PC, the MS reports will not be 
displayed in the Insert Report Table dialog.  

All MS reports comprise only the default columns. It is not possible to add 
more columns. 

 Selecting Other Special Reports  
Similar to the History report, the following reports are not part of the 
default Report Definition File (RDF) either. Select Insert Report to add 
them as separate worksheets to a report definition file (see How to …: 
Creating and Using Report Tables  Adding and/or Renaming a 
Worksheet): 

Result Tables 
• The Calibration History documents the calibration run. 

• The SST Summary Report shows the results of the System 
Suitability Test for the entire sequence. The default columns are part of 
the ⇒Sample and ⇒System Suitability Test categories. It is also 
possible to edit the columns or to use different columns for the report. 
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QNT Tables 
• The Detection Parameter Report shows the ⇒Detection Parameters 

used for the current sample.  

• The Peak Table report shows certain entries of the peak table of the 
QNT Editor (such as the expected Retention Time or the retention 
⇒Window).  

• The SST Report shows the parameters used and the results of the 
System Suitability Test. The default columns are part of the System 
Suitability Test category.  

PGM Tables 
• The Commands report shows the Program of the current sample.  

• The Post-Acquisition Processing report shows the Post-Acquisition 
Steps of the current sample.  

• The MS Method shows the current method of the Mass 
Spectrometer.  

 Note: 
The MS Instrument Method Report (under Result Tables) indicates 
the method that is used for data acquisition. It is possible that both MS 
method reports are identical. 

Miscellaneous Tables 
• Select the Database Query report to integrate any kind of database 

query in the report. Select Table Properties on the context menu to 
open the table properties and specify the datasource in which the query 
shall be performed. Use SQL statements to define the properties for 
which the query shall be performed. 

 Note: 
The Detection Parameter Report and the Commands, Post-Acquisition 
Processing, MS Method, and Database Query reports comprise only the 
default columns. It is not possible to add more columns. 
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 Setting Parameters for Variables (e.g., for the 
confidence interval) 
You can set special parameters for many of the report variables. For an 
example, refer to the description below for the limits of the Confidence 
Interval. 

The Parameter button is enabled for those variables for which special 
parameters can be set. 
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Click Parameter to open the Parameter Input … dialog box. Use this 
dialog box to make the settings for the displayed report variable: 

 

The Parameter Input for Upper Confidence Limit dialog box allows you, 
for example, to define the probability and the calibration level at which the 
upper limit of the confidence interval will be computed: 
 
Confidence 
probability 

Select the probability with which the indicated values shall apply via 
the arrow key. The following probability values are available: 
90%, 95%, 98%, 99%, 99.7%, 99.8%, 99.9%, and 99.99%. 

Compute confidence 
limit at 

Define the level for which to compute the respective limit of the 
confidence interval. Select one of the following options: 
• Lowest calibration level 

• Highest calibration level 

• Average of all calibration levels 

• Reference amount (standard and validation samples only) for 
reference values. The corresponding values are given for 
standard and validation samples only if an entry for the respective 
peak is available in the Amount column. If a peak has no entry or 
if the Amount column is not available for a standard or validation 
sample, n.a. is returned. 

• Computed amount (for the computed amount of the respective 
peak in the single samples). 

• Any fixed value. Define the Amount value in the right-hand field.  
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The graphical representation of the confidence interval in the calibration 
curve is possible as well. For more information, refer to How 
to …: Displaying Calibration Curves  Indicating the Confidence 
Interval. 
The limits of the confidence interval, which are defined using the 
corresponding Report variables, are determined as follows: For a given 
amount, the system determines the intersections with the limiting curves of 
the confidence interval In the height of the value that is defined via the 
calibration curve. 

 

The image shows the calibration curve together with the corresponding 
confidence interval at a probability of 99%. In the above example, the upper 
and lower limits belonging to a concentration of 6.3 µg/ml are derived. Their 
values are 6.0 and 6.6 µg/ml, respectively. (The distance between the 
limiting values and the given Amount value must not necessarily be 
symmetrical.) 
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 Creating Report Tables for the Printout 
Similar to the screen report, you can use report tables in the Printer Layout, 
also. For information, refer to: 

 Inserting and Editing a Table in the Printer Layout 
 Inserting a Column into an Existing Table  

 
Users who have the Report Publisher add-on product can use the 
additional features described in  Entering User-defined Formulas. 

Thus, they have numerous possibilities, e.g., for 

 Calculating the Amount Percentage (for Identified Peaks) 

 Calculating the Concentration Percentage (in Relation to the Total 
Concentration) 

 Calculating the Retention Time Difference of Two Channels 

 Creating Dynamic Columns That Contain Flexible Formulas 

 Creating Dynamic Links to Lines Other than the Current Line 

 Inserting and Editing a Table in the Printer Layout 
• Enable Layout Mode on the Edit menu.  
• Select Insert > Chromeleon Report Table on the Edit or context 

menu. The Insert Report Table dialog box appears. 
• In the Report Tables field, mark the report table you want to insert. If 

necessary, click the + character beside the report table groups to 
display the tables underneath. The columns available for the selected 
table are displayed in the Columns field. 

• Some columns are already marked by default. Select the columns that 
should be included in the table and deselect all others. Press and hold 
the Ctrl key to select or deselect several columns simultaneously. 

• Clicking OK inserts the table into the worksheet. 
• To indicate that the table is a Chromeleon object all four corners of the 

table are marked by red triangles. The last row(s) are not marked by 
red triangles because they are no Chromeleon objects. 
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 Caution: 
If the worksheet already contains a report table, insert the new table 
above or below the existing one. It is not possible to insert several 
report tables next to each other.  

 
 Tip: 

You cannot move or copy an entire table. When moving or copying a 
table, only the current content (= the values) is copied to the clipboard 
but not the underlying variables! (The red triangles are missing 
indicating that this table is no longer a Chromeleon object.) Besides, it 
is not possible to move single columns. Instead, insert a new column at 
the corresponding position and delete the 'old' column. 

• Select a column header and then select Report Column Properties 
on the context menu. Determine the header, the dimension, and the 
format of the column or of the column values. 

• To modify the appearance of a single cell, a table area, or the entire 
table (font size and style, frame, color, etc.), select the cell, the area or 
the entire table and then select the corresponding command on the 
Format menu. 

• Select the column or the row you want to delete, and then select 
Delete Column(s) or Delete Row(s) on the Edit menu. To insert 
additional rows or columns in front of the selected area, select Insert 
Row(s) or Insert Column(s) on the Edit menu. 

Inserting a "Total" Row 
The new table does not comprise a Total row. Insert the Total row as 
follows: 
• Copy any cell from another Total row; for example, from another 

Printer Layout table or from an integration report. 

• Select the cells of the new table, which should indicate the sum of all 
cell values of the corresponding column. 

• Select Paste.  

 Tip:  
Proceed in the same way to update any existing entries in the rows 
Average and/or Rel.Std.Dev rows. These rows are not marked by red 
triangles, because they are no Chromeleon objects. 
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Creating the correct cell reference 
The values in the Total row must receive the correct cell reference. This is 
especially important when the new table is longer than the table from which 
the cell was copied. 
• Enable Layout Mode on the Edit menu. The edit line is displayed.  

• Select the first value in the Total row. In the edit line, the corresponding 
formula appears; for example, =SUM(C10:C22). 

• Select the cell range indicated in parentheses in the edit line with the 
mouse; for example, C10:C22. 

• Then, select the actual cell range in the table with the mouse or type 
the cell range in the edit line via the keyboard.  

• Press <Enter> to confirm your input. 

The sum cell value is recalculated based on the new cell range. Then 
perform the individual steps for the remaining sum cell values. 

For more information, see  Inserting a Column into an Existing Table. 

 Inserting a Column into an Existing Table 
To insert a new column into an existing table: 
• Enable Layout Mode on the Edit menu.  

• Select the entire column, including its header and it’s the cell Total, to 
the left of which you want insert the new column: 

 
• Select Insert Column(s) on the context menu. A new table column is 

inserted that also contains a Total cell.  
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• Double-click the header of the new column to open the Report Column 
Properties dialog box. Select a variable from the Variables list (Please 
note: The picture only shows part of the dialog box): 

 
• Click OK to assign the selected variable to the new column. 

• Fill the cell Total. Click a different cell in this line, which already contains 
a value. Copy the cell reference by pressing the Ctrl + C keys and then 
paste it into the new cell by the pressing Ctrl + V keys. (The format of 
the copied cell is automatically transferred, too. Adapt the format to the 
new column if necessary.)  

For more information, refer to  Inserting and Editing Tables. 

 Entering User-defined Formulas 

 Tip: 
In order to use the options described below, the Report Publisher add-on 
product must be installed on your computer. 

Creating user-defined formulas is analogous to the Microsoft Excel 
spreadsheet. The following description is intended for users who are not 
familiar with entering formulas: 

Example 1: 
Let's assume that a table containing two columns (A and B) and three lines 
(1 to 3) is extended by one column (C), for which there is no Chromeleon 
report variable. Thus, for example, the quotient of the cell contents of 
columns A and B can be included in column C. 
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To enter a formula in a cell, select the corresponding cell first. In this 
example, select the cell C1. Enter the equal sign. The entire input is 
displayed in the edit line (here indicated in blue print). 
 

C1 = 
 A B C 
1 12 5  
2 17 10  
3 13 20  
4     

Select the cell A1, enter a division sign (slash), select the cell B1, and 
complete your input by pressing <Enter>. The formula (C1=A1/B1) is 
displayed in the edit line; the cell C1 displays the result of the operation 
(2.4). The cursor moves to cell C2. 
 

C1 =A1/B1 
 A B C 
1 12 5 2.4 
2 17 10  
3 13 20  
4     

Follow the description to output the corresponding results in the cells C2 
and C3. To facilitate the procedure, click the cell C1 again, grab the 
selection frame on the lower right corner, and drag it to the required cells 
(C2, C3). For calculating the cell values, Chromeleon uses the previously 
entered formula and automatically creates the correct reference, line by 
line.  
 

C1 =A1/B1 
 A B C 
1 12 5 2.4 
2 17 10 1.7 
3 13 20 0.65 
4    

Example 1 (continued) 
How to sum the cells of column C in the field C4:  

Select the cell C4 and enter an equal sign. Enter the SUM command 
required for adding cell values, and then enter an opening bracket. 
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C4 =SUM( 
 A B C 
1 12 5 2.4 
2 17 10 1.7 
3 13 20 0.65 
4     

Select all cells (C1, C2, C3) that you want to sum up. Close the bracket 
after the last cell. Press <Enter> to complete your input. 
 

C4 =SUM(C1:C3) 
 A B C 
1 12 5 2.4 
2 17 10 1.7 
3 13 20 0.65 
4   4.75  

In addition to the SUM command, many other functions are entered in the 
same way. Thus, you can form the average (see AVERAGE), express 
conditions (see IF, True, FALSE), create logical operations (see AND, 
OR), or enter time values (see TIME, DATE, DAY, YEAR).  

 Tip: 
For an alphabetical list of the available formulas, refer to Additional 
Functions. 

Example 1 (continued) 
Besides, it is also possible to use "fixed references". Contrary to the 
variable value pairs described above (A1/B1, A2/B2, A3/B3), form the 
quotient of a variable and a fixed value (A1/C4, A2/C4, A3/C4). In this 
example, the result is displayed in column D. 

Follow the description for Example 1 above to create the first cell reference 
(D1). 
 

D1 =A1/C4  
 A B C D 
1 12 5 2.4 2.5263 
2 17 10 1.7  
3 13 20 0.65  
4   4.75   
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Extend the formula by adding two $ signs. They convert a variable 
reference into a fixed cell reference.  
 

D1 =A1/$C$4  
 A B C D 
1 12 5 2.4 2.5263 
2 17 10 1.7  
3 13 20 0.65  
4   4.75   

When the formula is copied, the reference to cell C4 will be retained. The 
fields to be calculated (D2 and D3) can then be calculated by 
simultaneously selecting the cells D1, D2, and D3. 
 

D1 =A1/$C$4  
 A B C D 
1 12 5 2.4 2.5263 
2 17 10 1.7 3.5790 
3 13 20 0.65 2.3768 
4   4.75   

For practical examples, refer to: 

 Calculating the Percentage Value for the Amount (for Identified 
Peaks) 

 Calculating the Percentage Value for the Concentration (in Relation 
to the Total Concentration) 

 Creating Dynamic Columns That Contain Flexible Formulas 

 Creating Dynamic Links to Lines Other than the Current Line 



560 Creating and Using Report Tables 

 Calculating the Amount Percentage (for Identified 
Peaks) 
If you use samples with Internal Standard but wish to calculate the 
percentage values of the different substances that have been identified in 
the sample (without internal standard): 

1. First, disable the display of unidentified peaks in the report table. Select 
Report Table Properties on the context menu. On the General tab page 
of the Integration Report Properties dialog box, clear the Including 
unidentified peaks check box. 

2. Select a column that you do not need (in the example below: column D). 
Select Add Column or Insert Column on the context menu. From the 
Categories list, select Peak Table, and then select Standard Method from 
the Variables list.  

3. a) Select a different column (here: column G) that you do not need. 
Double-click the column header to open the related dialog box. Delete the 
entry in the Formula field. Afterward, delete the entries in the column 
(except the last line, i.e., the line named Total). 
b) In the field G29, enter the formula  

=IF(OR(D29="ISTD Internal ";D29="ISTD Int/Ext ");"ISTD";F29) 
(Observe the space following Internal!) Copy the formula to the following 
lines. 

 Tip:  
Do not omit the space in the formula behind Internal and Int/Ext, 
respectively. 
 
4. a) Select another column which you do not need either (here: column H). 
Press F8 to open the dialog box. Delete the entry in the Formula field. 
Afterward, delete the entries in the column (except the last line). 

b) Enter the formula =100*G29/G$36 in the field H29 and copy it to the 
following lines 
 



 Creating and Using Report Tables 561 

 
 
Also, refer to  

How to …: Creating and Using Report Tables  Calculating the 
Concentration Percentage (in Relation to the Total Concentration) 

 Calculating the Concentration Percentage (in Relation to 
the Total Concentration) 

Entering and Calculating the Total Concentration 
To calculate the percentage concentration in relation to the total 
concentration, calculate the total concentration using your exact sample 
weight (without any added Internal Standards) and the liquid volume.  

Enter the concentration, for example, in the Weight column of the sample 
list. However, it may be better to create a User-defined Column, name the 
column concentration, and assign Floating Point as the Value Type.  
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(For more information, refer to How to …: Creating and Managing Files 
and Data  Creating User-defined Columns.) Enter the corresponding 
total concentrations of the single samples in this column.  
 

Creating the Report Table 
1. Double-click a variable in the page header that is not necessarily 
required (here: H6). For this variable, define the concentration column 
created before: 
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2. Follow the description in the previous topic (see How to …: Creating 
and Using Report Tables  Calculating the Percentage Amount (for 
Identified peaks)). Instead of the formula described there in 4b, enter the 
following formula (here: in the field H13): 
=IF(G13="ISTD";"ISTD";100*F13/$H$6).  

 Tip:  
Unless otherwise defined, enter no spaces before and after ISTD. 

The value in the Total line of the %-Amount column indicates the 
percentage of the substances defined by you in relation of the total 
concentration: 
 

 

 Calculating the Retention Time Difference of Two 
Channels 
If data acquisition is performed with two different detectors (for example, in 
an APS), the retention times may be different. In this case, the retention 
time deviation should be documented in a separate column. 

A special formula allows you to determine for a peak how the retention time 
of one channel deviates from the retention time of the current channel. 
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 Note:  
You can create the related column in both the Printer Layout and screen 
report. In this case, the Report Publisher add-on module is not required.  

Follow the steps below to subtract the retention time of a channel from the 
retention time of the current channel: 
• Double-click in the header of an unused or newly inserted column to 

open the Properties Report Column dialog box. 

• In the Formula field, enter the following formula (also, refer to the 
explanation below): 
(retention_time - smp.chm("TIC").peak("By Retention Time", 
peak.retention_time, 0.100, "AN").retention_time)*60. 

• In the Header field, enter the column header, e.g., "Ret.Diff. (UV-
MS)".  

• In the Dimension field, enter "s" (for seconds). 

• Usually, two positions after the decimal point (i.e., "0.00") will be 
sufficient. 

 

Explanation and possibly required modifications  
To efficiently use the formula, you do not need to understand the formula in 
detail. It will be sufficient to know the parts you may wish to modify: 
• Channel: The formula calculates the retention time difference between 

the TIC channel and the current channel for a peak. In the formula, 
replace TIC with a different channel if you want to subtract the retention 
time of this channel from the retention time of the current channel. 

• Dimension: Usually, the retention times are in minutes. However, the 
retention time difference is relatively small for one peak. That is why 
the value is multiplied by a factor of 60 to convert it into seconds. You 
may delete this factor. In this case, set the entry in the Dimension field 
to "min".  

• Peak detection: The main part of the formula refers to peak detection 
in another channel: peak("By Retention Time", peak.retention_time, 
0.100, "AN"). The expression in brackets finds the peak that is nearest 
to the expected retention time ( = N) in a windows of ± 0.100 min 
(absolute = A) around the expected retention time (determined in the 
peak table of the QNT Editor). This is required to find the peak in a 
different channel. 
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 Creating Dynamic Columns that Contain Flexible 
Formulas 
Follow the description below to create a table column that contains flexible 
formulas and dynamically adapts to the number of existing peaks. (This 
procedure is only important if the table contains columns with report 
variables and if these columns are next to the newly added column.) 

See the following example for information about how to create a column 
that allows you to check automatically whether the signal noise is below 
0.005 mAU: 

• Add a new column to the table. In the Printer Layout, new columns are 
always inserted to the left of the selected column. Select the first field 
below the header in the column that shall appear to the right of the new 
column: 

 

• On the context menu, select Insert and then select Insert Chromeleon 
Report Column. 

• The Insert Report Column dialog box opens. Select a variable. 

• Delete any existing entry in the Formula field. 
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• Click OK to exit the dialog. This action automatically selects the first 
field in the new column. 

• Enter the desired formula in the layout line without changing the 
selection in the report table. Press <Enter> to confirm your entry. 

 
• Do not change the selection, i.e., the first field below the header is 

selected in the new column. Place the cursor on the black rectangle on 
the bottom right corner of the selection frame. The cursor becomes a 
solid black cross. Left-click and draw the formula into all lines of the 
selected report table column. 

• Double-click in any field in the new column to open the Report Column 
Properties dialog box for the new report column. Edit the Header and 
Dimension fields as appropriate: 
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 Creating Dynamic Links to Lines Other than the Current 
Line 
To reference lines in a report table other than the current line, use indirect 
references instead of direct references such as G6. For indirect references, 
use the following Report Publisher variables: 
 INDIRECT and ADDRESS  

The following formula references the cell G6 from the cell E2: 
 =INDIRECT(ADDRESS(ROW()+4;COLUMN()+2)) 
 

 Note:  

Use the ROW() and COLUMN() formulas to return the current line and 
column numbers. 



568 Creating and Using Report Tables 

 



 Preparing the Printout 569 

Preparing the Printout 
Use the Printer Layout to prepare your data for the printout. It is saved in 
the Report Definition File (RDF). To assist you in preparing the first 
printout and in creating your own report definition files (also called report 
templates below), Chromeleon provides some default RDF templates. 
During the Chromeleon installation, the default RDFs are written to the 
Dionex Templates > Reports directory of your local datasource. 

To printout more data that is not included in the default report definition 
files, Chromeleon provides the possibility to create individual worksheets 
via the Printer Layout window. These worksheets can be combined and 
saved as a report template. The results of sample processing can thus be 
printed in a number of layouts. 

For more information, refer to:  

 Opening and Editing the Printer Layout 
 Saving/Loading a Report Definition File 
 Specifying the Pages to be Printed 
 Specifying the Printout 
 Printing the Results of a Single Sample 
 Printing the Results of a Sequence or a Sample Batch 
 Setting Print Area and/or Print Title(s) 
 Automatically Repeating the Output for the Selected Objects 
 Saving the Contents of a Printer Layout Page  

 
In addition, you can use the Printer Layout to create charts (see 

 Creating Charts). 
 
For assistance to change the page format and to create headers and 
footers refer to: 

 Changing the Page Format 
 Notes on the Page Setup 
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 Opening and Editing the Printer Layout 
To access the Printer Layout, first open the desired sample and then 
change to the Printer Layout: 
• Select and double-click the desired sample in the Browser. The 

(screen) report for the sample appears. 

• Click the Printer Layout icon  on the Method toolbar to change to 
the Printer Layout. The Printer Layout of the corresponding report 
definition file (RDF) is opened, i.e., the Preferred RDF File of the 
sequence to which the sample belongs.  

 Note:  
If you open the report definition file in the Browser, e.g. by double-clicking, 
the Printer Layout is opened with the data that were saved last. In this 
case, it is not possible to load the desired sample data. 

The Printer Layout consists of several (work)sheets. To change to a 
different sheet, click the desired tab on the bottom edge. The 'default' report 
definition contains, for example, an Integration tab, a Calibration (Curr. 
Peak) tab, and a Calibration (Batch) tab. The area of the single sheets is 
virtually unlimited in horizontal and vertical direction. However, depending 
on the amount of information, it may comprise different print pages. The 
different sheets comprise chromatograms, tables, diagrams, calibration 
curves, or other elements indicating the corresponding values of the current 
sample. 

If you need more variables, chromatograms, tables, etc. than those 
available in the open Report Definition File, you can insert them into the 
existing worksheets.  

Or else, create a new worksheet: 
• Enable Layout Mode on the Edit menu. 

• Select Insert Sheet on the Edit menu. An additional worksheet is 
inserted before the open sheet. 

For information about how to edit existing worksheets, refer to: 

 Inserting a Chromatogram 
 Inserting a Trend, 3D Amperometry, or CV Plot 
 Inserting and Deleting Individual Variables 
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 Inserting Text 
 
In addition, you can insert tables in the Printer Layout. For more 
information, refer to Creating and Using Report Tables  Creating 
Report Tables for the Printout. 

 Inserting a Chromatogram 
• Enable Layout Mode on the Edit menu.  

• Select Insert > Chromatogram on the Edit menu or context menu. 
The mouse pointer becomes a + sign. 

• Draw a rectangular frame of any size. The frame reserves this area for 
the chromatogram of the current sample. 

• To indicate that the chromatogram is a Chromeleon object all four 
corners of the chromatogram inserted in this way are marked by a red 
triangle. 

• Click the chromatogram to select it completely. You can then move it, 
or reduce or enlarge it in size.  

• Select Chromatogram Properties on the Edit menu or context menu. 
Format the chromatogram as desired on the corresponding tab pages 
of the Chromatogram Decoration dialog box (caption, axes, font size, 
etc.). 

• Press the F4 or the SHIFT+F4 to display the chromatogram of the next 
or previous sample and to check whether the selected settings are 
appropriate for all chromatograms. 

 Inserting a Trend, 3D Amperometry, or CV Plot 

Inserting a Plot 

1. Open the Printer Layout (see  Opening and Editing the Printer 
Layout).  

2. Select Layout Mode on the Edit menu. 

3. Select the worksheet on which you want to insert the plot, or add a new 
worksheet (select Insert Sheet on the Edit menu). 
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4. On the Edit or context menu, select Insert > Trend Plot, Insert > 3D 
Amperometry Plot, or Insert > CV Plot. The mouse pointer becomes a 
+ sign. 

5. Drag the mouse to draw a rectangular frame of the approximate size 
that you want the plot to be. When you release the mouse, the rectangle 
will display the selected plot type. 

 To indicate that the plot is a Chromeleon object, all four corners of the 
plot are marked by a red triangle. 

Modifying a Plot 
1. To select the complete area, click inside the frame. 

2. You can now move, reduce, or enlarge the frame. 

3. To define the data and format of the plot, select Trend Plot Properties, 
3D Amperometry Plot Properties, or CV Plot Properties on the Edit 
or context menu.  

4. Select the desired options on the corresponding tab pages of the 
Decoration dialog box. 

 Inserting and Deleting Individual Variables 
Usually, general sample data, such as the sequence name, the 
corresponding Datasource, the user name, etc. appear at the beginning 
of a printout or in addition to a table or a chromatogram. To insert more 
variables: 
• Enable Layout Mode on the Edit menu. 

• Select a single cell and then select Insert > Chromeleon Report 
Variable on the Edit menu. 

• In the Select Report Variable dialog box, select the variable category 
from the Categories list and then select a variable from the Variables 
list. 

• Clicking OK includes the variable into the selected cell. 

• To indicate that the variable is a Chromeleon object, a red triangle 
appears in the upper right corner of the cell.  

• To modify the appearance of the variable, select the respective cell and 
then select the corresponding command on the Format menu. 
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Deleting a Variable 
To delete a variable, it is not sufficient to delete the value indicated in the 
edit line. Proceed as follows: 

• Select the cell for which you want to delete the contents.  

• Select Clear on the context menu or press the Del key on the keyboard. 
The Clear dialog box appears.  

• Select the Values option to delete only the values. Select All to delete 
the formats as well, e.g., the frames assigned to the cell. Click OK to 
clear the cell. 

• Check whether the clear action was successful. Click a different cell and 
then click the cell again, for which you wanted to delete the contents. 
The edit line is updated for this cell. If the clear action was successful, 
the edit line does not contain any information. 

 Notes: 
Cells containing an underlying variable can be recognized by the formula 
name that is displayed in the status line whenever the cell is selected, for 
example, peak.height. If the selected cell contains only text, the status line 
is empty. 

You cannot insert new variables by entering the corresponding formula, for 
example, smp.name for the sample name. Chromeleon interprets formulas 
that are entered in this way as pure text. Thus, only the text 'smp.name' 
appears in the edit line and not the value of the formula, i.e., the name of 
the corresponding sample. 

 Inserting Text 
You can insert text in any empty text cell of the worksheet. However, the 
size of the cell limits the length of the text that is displayed in the cell. Note 
the following: 
• When you type longer texts into a cell than permitted by the cell size, 

the entire text is displayed using the neighboring cells to the right as 
long as these cells are not used. If the neighboring cells are used, the 
visible text is 'cut' to the cell size; the entire text is displayed only in the 
edit line.  
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• Text cells are not marked by a red triangle because they are no 
Chromeleon objects. 

• To insert a line break, select the Wrap Text check box in the Format 
Cells dialog box. (To open this dialog box, select Alignment on the 
Format menu.)  

• If graphics, such as chromatograms, are inserted, they will always hide 
the text.  

 Saving or Loading a Report Definition File 
The Printer Layout of a report template ( Report Definition File (RDF)) 
can contain one or several worksheets. If you save or load a Report 
Definition File, all worksheets included in the Printer Layout are saved or 
loaded.  

• Select Save Report Definition on the context menu to save the Report 
Definition File and its worksheets under either an existing or a new 
name. 

• Select Load Report Definition on the context menu to open an 
existing Report Definition File. 

 Tip: 
In addition, a Report Definition File contains various settings of the on-
screen report, such as the window size, the type, and number of the 
columns in a report, axis captions, etc. When you save the Printer Layout, 
any modifications made to the on-screen report are saved as well. 

 Specifying the Pages to be printed 
To specify which pages of the Printer Layout shall be printed, enable 
Layout Mode on the Edit menu. Select Batch Report Setup on the File 
menu to open the Batch Report Setup dialog box: 



 Preparing the Printout 575 

 

Click Conditions to specify the print conditions for the corresponding 
worksheet. For example, it would be sensible to print the Summary page 
only for the last sample of a sequence: 
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However, you could print the Calibration (Batch) sheet for the Last 
Sample in a List of Standards.  

 Tip: 
These settings are saved in the report definition file (RDF). They are used 
as default for Batch Report printing. The same defaults are used for 
electronically signing sequences (see Electronic Signature). 

 Specifying the Printout 
Before you can print your data, define the printer to be used. In addition, 
define the headers and footers, margins, etc. on the Print dialog box and 
the Page Setup dialog box. Select Print Setup and Page Setup on the 
File menu. 

The Print Setup and Page Setup settings are stored separately for each 
worksheet in a Report Definition file (Integration, Calibration, Peak 
Analysis, Summary, etc.). Therefore, select the settings for each 
worksheet separately. 
• Select Print Setup on the File menu to determine the printer, the paper 

size, and the format (portrait or landscape). Having made these 
settings, a message box appears. Determine whether these settings 
shall be used only for the current worksheet or for all worksheets of the 
Printer Layout of the current Report Definition File (RDF). 

 Tip: 
The Print Setup settings selected here only apply to the report 
definition file of the current sequence. They do not affect the default 
settings for Windows. On the other hand, changing the default printer, 
paper size, and format in Windows will not affect the settings specified 
here. 

• Select Page Setup on the File menu to determine the appearance of 
the headers and footers, the margins, the alignment, etc. You can also 
set grid lines, determine whether column and/or row headers are 
displayed, and whether the printout should be in black and white or in 
color. For more information, refer to How to …: Preparing the 
Printout  Notes on the Page Setup. 
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 Tip: 
For technical reasons, direct help information for the Print Setup dialog 
box is not available. 

Also, refer to How to …: Preparing the Printout  Saving/Loading a 
Report Definition File and  Saving the Contents of a Printer Layout 
Page. 

 Printing the Results of a Single Sample 
You can print the results of single samples from either the Printer Layout or 
the on-screen report (integration plot). For each printout, the Printer 
Layout pages saved in the Report Definition File (RDF) are used as a 
template. The results of a single sample or of a sequence are output in the 
defined way (see  Printing the Results of a Sequence or a Sample 
Batch). Please note that the Report Definition File and the worksheets 
define only the appearance of the printout, but not the contents. Unless you 
have already specified the worksheets to be printed, specify them now: 

In the Printer Layout 
Select Batch Report Setup on the File menu to specify which worksheets 
shall be printed. The Batch Report Setup dialog box is opened:  
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Select the corresponding settings on the Print Sheets tab page. The 
available worksheets are listed in the Sheets field. Define which pages 
shall be printed and under which conditions. Click Conditions… to define 
the print conditions. For example, you can specify for which sample type a 
page shall be printed. For instance, it would be sensible to print a summary 
report only for the last sample of a sequence. 

In the Report (Screen Report) 
Select Print on the File menu to print the results of the currently open 
sample from the on-screen report:  

 

On the Print dialog box, select the worksheet to be printed from the Using 
Sheet drop-down list. The worksheet is always printed with the on-screen 
results if they are part of the defined view. For example, the current Mass 
Spectrum is only printed if a mass spectrum is part of the selected 
worksheet. 

 Tip: 
In the Printer Layout, you can only select peak spectra but no retention time 
spectra. If you want to print a retention time spectrum, open the Report, 
select a spectrum on-screen, and then print a worksheet that includes the 
spectrum. 
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 Printing the Results of a Sequence or a Sample Batch 
You may also print the results of an entire sequence, a Query or a 

Batch. Unless you have already specified which of the worksheets 
created in the Printer Layout should be printed, specify the worksheets 
now.  

In the Browser 
Click a Sequence or a sample, and then select Batch Report on the File 
menu. The Batch Report dialog box appears. Select a report definition file 
from the Use Report Definition drop-down list. Or else, click the "…" 
button and navigate to the desired file. 

 

The worksheets defined in the Printer Layout of the Report Definition File 
are listed in the Select sheets to be printed field. Specify which pages 
shall be printed. To print the pages under certain conditions only, select the 
Print under certain conditions only option and then click Conditions. 
Define the print conditions in the Print Conditions dialog box. Click OK to 
print the entire sequence or the selected samples of a query. To print the 
entire query, select all samples of a query by clicking the No. field at the top 
left of the sample list. 



580 Preparing the Printout 

On the Control Panel: Printing the Results Directly after Data 
Acquisition 
To print the results directly after data acquisition, select Reporting on the 
Batch menu. The Reporting tab page of the Batch dialog box appears: 

 

Select the Print/Export Report check box to reopen the Batch Report 
dialog box (see the picture in the Browser section above). Follow the 
description in the Browser section. The tab dialog box indicates the printer, 
the report definition file (RDF), and the channel selected for the printout. 
Click OK to return to the Reporting tab page. Specify whether each sample 
shall be printed separately and immediately after data acquisition or 
whether all samples shall be printed when the batch is finished. 

 Tip: 
The settings made in the Browser or on the control panel are saved in the 
report definition file of the current sequence. They apply to all sequences 
that use this report definition file. The same defaults are used for 
electronically signing the worksheets of these sequences (see Electronic 
Signature). 

For more information, refer to  Printing the Results of a Single 
Sample. 
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 Setting Print Area and Print Title(s) 
To print a defined area of a Printer Layout page: 
• Press the left mouse button and drag the mouse to select an area.  

• Select Printing > Set Print Area on the Format menu.  

• Select Printing > Release Print Area on the Format menu to deselect 
the defined print area. The defined print area is indicated in 
parentheses behind the command. 

When printing a table that exceeds one page, you can print the title on 
every page:  
• Select the entire line(s) for the print title with the left mouse button. 

• Select Printing > Set Print Titles on the Format menu.  

• Select Printing > Release Print Titles to deselect the set print titles. 
The set print title area is indicated in parentheses after the command.  

 Automatically Repeating the Output for the Selected 
Objects  
It is often useful to repeat the output of reports for other channels, samples, 
and/or peaks. In Chromeleon, you can automatically repeat the output of 
reports for: 
• Each sample of a sequence or selection 

• Each peak in a peak table or the current chromatogram 

• Each channel of a sample 

Follow the steps below: 
• Select the lines completely, i.e., in the grey column at the utmost left 

that indicates the line numbers.  

 Tip:  
Verify for graphic objects that you have selected all lines covered by 
the object. 

• To select more than one area, hold the CTRL key down, and then 
select the next area by the lines as described above.  
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• Select Printing > Set Autorepeat Area on the Format menu to specify 
the selected area as the area for which the output is automatically 
repeated. 

• The Autorepeat Area Properties dialog box is opened. Use this dialog 
box to define for which channels, samples, and/or peaks the selected 
area shall be output. 

For an example, refer to  Automatically Repeating the Output for the 
Selected Objects: Example. 

It depends on the objects in the selected area whether it makes sense to 
repeat the output for other samples and/or peaks. Therefore, please note: 
• The Repeat Samples tab page is disabled if at least one Peak 

Summary table and/or one SST Summary table is selected.  

• The Print and Repeat Peaks tab page is disabled if at least one 
Integration table is selected. 

You can repeat the output for other channels, samples, and/or peaks when 
you 
• Print a batch  

• Sign sequences 

• Print interactively from the Printer Layout 

 Note:  
When you repeat the output for channels and peaks, only those objects are 
replaced for which no fixed channel/peak is specified. A warning appears if 
the Fixed Channel or Fixed Peak option is selected for objects that shall 
be output for different channels or peaks. 

For example, this applies to chromatograms for which the Fixed Channel 
option is selected on the Channel tab page. (To access the Channel tab 
page, select Chromatogram Properties on the chromatogram's context 
menu).  
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 Automatically Repeating the Output for the Selected 
Objects: Example 
To repeat the output for the header and the table below the chromatogram, 
select the following lines: 
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If your sequence contains only two standards of interest, you can specify 
that the repetition include all standards; refer to the image below.  
In addition, select the Page break after each sample check box to output 
the second sample on a separate page: 

 

With these settings, the following two pages are output via the Print 
command (File menu): 
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For general information, refer to  Automatically Repeating the Output 
for the Selected Objects. 

 Saving the Contents of a Report Definition File  
Chromeleon provides various formats for saving the report data of the 
current sample: 
• To save the active page of the Printer Layout, select Save as on the 

File menu. The Save As dialog box is opened. Under Save as type: 

• Select Excel ... (*.xls) to convert your data into the Excel format. Enter 
the file name and click Save to save your data as a separate file. In 
addition to the values of the table, any graphics and diagrams included 
in the table are also saved to the new file. If the Printer Layout of the 

Report Definition File (RDF) contains several worksheets, the Excel 
file has the same structure. Please note that different Excel file types 
are available, depending on the Excel version (Excel V4 or Excel V5 or 
V7).  

• Select HTML (*.htm) to save your data as an HTML page. Graphics 
and diagrams cannot be converted and saved in HTML format. 

• Select Tabbed Text (*.txt) to save your data as pure text. The content 
of the individual report columns is separated by a tab stop. Graphics 
and diagrams cannot be converted and saved in Tabbed Text format. 
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 Creating Charts 

 Tip: 
In order to perform the operations described below, verify that the Report 
Publisher add-on product is licensed.  
 
The Chart Wizard assists you in creating charts: 
• Enable Layout Mode on the Edit menu.  

• Select the columns and rows that shall be represented in a chart.  

• Select Insert > Charts on the context menu. The shape of the mouse 
pointer changes to a + character. 

• Hold down the left mouse button down and draw a rectangle in the size 
required for the chart. 

• The Wizard guides you through the chart creation process. Select the 
chart type and style and then enter the desired layout settings and axis 
titles.  

• Click Finish to exit the Wizard and insert the chart.  

The new chart is displayed in the previously drawn frame. If required, you 
can edit the chart later. For example, you can change the width, color, and 
pattern of lines, areas, or captions, smooth curves, or select a different 
chart type.  
• Select a single chart element by (double-) clicking and then double-

click the selected element to change it. The Chart Designer is opened. 
After you have made the desired changes and click OK to apply the 
changes to the chart.  

You can also change the size and position of the entire chart: 
• Click inside the chart. Hold down the left mouse button and move the 

chart to the desired position. Resize the chart by dragging the 
corresponding size markers. 
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 Changing the Page Format 
In the Printer Layout, the page format can be changed as follows: 

Define the printer settings 
• Select Print Setup on the File menu. The Print Setup dialog box 

appears. 

• In the Paper section, specify the paper size. Click the arrow then select 
a size from the list. In the Orientation section, select Portrait or 
Landscape. The size and orientation is used for all pages of the 
respective printout but is not accepted as default. 

 Tip: 
The settings are only valid for the report definition file of the current 
sequence. They do not overwrite the default Windows settings. In addition, 
any change of the default printer, paper size, or format that is made under 
Windows does not affect the settings made here. 

Directly printing in the desired format:  
• Select Print on the File menu.  

• Click Properties to open the Properties dialog box.  

• Select a paper size and orientation. 

 Notes on the Page Setup 
Headers and footers are printed at the upper and lower page margins. 
Select Page Setup on the File menu. Make the desired settings in the 
Page Setup dialog box. 

Headers and footers can contain text and specific format codes. The syntax 
is compatible with Microsoft Excel. Observe the order of the single entries. 
First, define the alignment of the single header and/or footer, using one of 
the following commands: 
 
&L Left-aligns the characters that follow 
&C Centers the characters that follow (default) 
&R Right-aligns the characters that follow  
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The default font is Arial 10. You can only define a different font after you 
have defined the header and/or footer alignment. Define the new font as 
follows: 
 
&B Bold 
&I Italic 
&U Underline 
&S Strikeout 
&"fontname" Uses the specified font 
&nn Uses the specified font size  

 Tip:  
If you do not enter these font definitions after the header and/or footer 
alignment, they will be ignored. You can change the font after each 
alignment code (&l/&C/&R).  

Finally, enter the expression to be printed: 
 
&A Prints the current sheet name 
&D Prints the current date 
&T Prints the current time 
&F Prints the Report Definition File (RDF) 
&P Prints the page number 
&P+Number Prints the following page number: current page + entered number. 

For example: &P+4 prints page 16 if the current page is page  12 
and you entered 4. 

&& Prints an ampersand 
&N Prints the total number of pages in the document  
When entering headers and footers longer than one line, note that the 
alignment codes (&L,&C,&R) must be column-oriented. Enter all left-aligned 
rows first, then enter all centered rows, and finally enter all right-aligned 
rows. To separate rows, press <Ctrl> <Enter>. 

In addition to the pre-defined variables above, you can enter variables 
pertaining to Chromeleon. Enclose these variables in braces. 

Example: 
&LOperator: {gen.operator} , Timebase: {seq.timebase} , 
Sequence:{seq.name} &RPage &P of &N 
&D  
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This example produces the following header or footer  
 
Operator: cmadmin, Timebase: HPLC, Sequence: Calibration  Page 1 of 12 
 4/6/2002  
You can include any Chromeleon variable in the header. However, 
including sample and sequence variables makes the most sense. The 
Chromeleon formula variables are identical with the ones generated in the 
dialog box for entering report variables. Enter the decimal places for 
numerical variables after the formula. Separate them by ";" (default: 0). 
Example: {smp.inject_volume;2}. Time entries cannot be formatted. 
 

 Note: 
All worksheets of the Printer Layout that are selected for printing are 
considered one single print job; that is, page numbering is consecutive for 
all worksheets. 

 Answering Frequently Asked Questions 
Question: How can I have the results printed out automatically after the 
analysis? 

Answer: Mark the sequence of interest in the Browser. Select Reporting on 
the Batch menu and select Print/Export Report by the box. Afterward 
select an option: Print each sample immediately or Print when the 
entire batch is finished. 
 
Question: The view in the Printer Layout window and the printed report 
have a different layout. Why? 

Answer: This may happen. There are different ways how to print a sample 
report. Usually, you will print the report via the Batch Report dialog 
window. When you print the report in this way, the report definition defined 
in this dialog is used. When you have the results printed automatically via 
Reporting as described above, it may happen that the report definition 
used to display the data in the Printer Layout is different from the report 
definition used for the printout. 

 Notes:   
When you either select Print on the File menu in the Printer Layout or click 
the Print icon on the standard toolbar, it is always the current view that is 
printed. 
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Question: Where is the used Report Definition File (RDF) saved? 

Answer: Some predefined Report Definition Files (RDFs) are available in 
the Dionex Templates > Reports folder. However, it is not imperative that 
the used RDF is stored in this folder. To find out where the used RDF is 
stored, proceed as follows: Mark the sequence of interest in the Browser. 
Right-click and select Properties on the context menu. In the Preferred 
Report & Channel section, the entry in the Preferred RDF File field 
indicates the path of the current report definition file. To determine a 
different report definition file as preferred RDF, click the Browse button 
("…") and navigate to the desired report definition. 

The settings of this RDF are then always used when you open a sample of 
this sequence afterward. However, you can select a different RDF in the 
on-screen report or in the Printer Layout, using the Load Report Definition 
command on the Workspace menu. 

 Notes:   
If you select the RDF via Load Report Definition, this does only apply to the 
current view. The Preferred RDF File of the sequence is not changed. 
 
Question: What do the terms Printer Layout, Report Template, and Report 
Definition File refer to? 

Answer: The Printer Layout is an editor window that allows you to define 
the content and the layout of the pages to be printed. This information is 
saved to the Report Definition File (RDF) together with the layout of the on-
screen report. Sometimes, the Report Definition File is also referred to as 
report template.  
 
Question: How can I save the scaling? 

Answer: The scaling, too, is saved to the Report Definition File. Select 
Save Report Definition on the Workspace menu. Afterward, select the 
previously saved RDF as Preferred RDF File in the properties of the 
sequence (see above). (Unlike the peak parameters, the scaling is not 
saved to the QNT File.) 
 
Question: How can I save comments in the report? Where can I enter 
information about the column I am using? 
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Answer: Chromeleon provides different possibilities for doing this. For 
example, you can use the Title field to enter information about the column: 
Mark the sequence in the Browser and select Properties on the context 
menu. Afterward, add the Title variable of the ⇒Sequence category to the 
Printer Layout. 

 Tip:   

Keep in mind to update the Title field entry whenever you change the 
column. 
 
For tips to solve similar questions, refer to How to …:  Preparing the 
Printout and the corresponding subtopics. 



 Analyzing 3D Amperometry Data 593 

Analyzing 3D Amperometry Data 
The ICS-3000 Electrochemical Detector (ED) can collect 3D amperometry 
data when it is running in integrated amperometry mode. To turn on 
collection of 3D amperometry data, enable the 3D_Amp channel check 
box in the Program Wizard or Program Editor. This adds a 
3D_Amp.AcqOn command to the control program.  

After collecting the 3D data, you can view and analyze it in the 3D 
amperometry window of any Chromeleon PC that has Release 6.7 or 
higher installed.  

 Note:   
The 3D Data Acquisition license is required to acquire 3D amperometry 
data. See  Chromeleon (Overview) Chromeleon Licenses. 

For more information, refer to: 

 Displaying a Sample's 3D Amperometry Data 
 Selecting the Integrated or Raw 3D Amperometry View 
 Changing the 3D Amperometry Plot Scale 
 Viewing Chromatograms in the 3D Amperometry Window 
 Viewing I-t Plots in the 3D Amperometry Window 
 Editing Integration Intervals 
 Extracting a Chromatogram from 3D Amperometry Data 
 Exporting a Chromatogram, an I-t Plot, or 3D Amperometry Data  

 
See also, Baseline Correction of I-t Plots  

For an overview of 3D amperometry window features, refer to  The 3D 
Amperometry Window. 
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 Displaying a Sample's 3D Amperometry Data 
Use one of the following methods to display a sample's 3D amperometry 
data: 

• Select the sample in the Browser and then select Open>3D_Amp from 
the context menu. 

• If the sample is already open in another window (for example, the 
integration window), select 3D Amperometry on the View menu or 
click the following icon on the Method toolbar . 

 Tips:   

3D amperometry data collection is available only with the ED 
electrochemical detector running in integrated amperometry mode and on a 
Chromeleon PC that has the 3D Data Acquisition license. To turn on 
collection of 3D amperometry data, enable the 3D_Amp channel on the 
ED Options tab page of the Program Wizard or PGM Editor. 

The 3D amperometry data can also be viewed on a control panel during 
data acquisition.  

Also, refer to: 

 Analyzing 3D Amperometry Data 

 The 3D Amperometry Window 

 The Program Wizard 

 The PGM Editor: Device Views 

 Selecting the Integrated or Raw 3D Amperometry View 
The 3D Amperometry Window has two options for viewing chromatographic 

3D_Amp data: 

• Integrated data view 
• Raw data view 
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To distinguish between the two views: 
• In integrated data view, parallel integration interval line cursors appear 

on the 3D data and I-t plots. The Y-axis units on the chromatogram 
displayed above the 3D data plot are nC (nanoCoulombs). 

• In Raw data view, a single horizontal line cursor for selecting waveform 
time is displayed instead of the integration cursors. The Y-axis units on 
the chromatogram displayed above the 3D data plot are nA 
(nanoAmps).  

To select the view option: 
1. Double-click the 3D or I-t plot or select Decoration on the context 

menu. 

2. On the Chromatogram Plot tab page, select either the Show Raw 
Data option or the Show Integrated Data option. 

 

Also, refer to: 

 Analyzing 3D Amperometry Data 

 The 3D Amperometry Window 
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 Changing the 3D Amperometry Plot Scale 
When you initially open a sample's 3D amperometry data, the window 
displays the data in full-scale view (i.e., the axes on each plot include the 
full range of data values from the analysis). There are several methods for 
adjusting the scale of a plot to zoom in or out to show the data of interest: 

 Tip:   
Changing the scale on one of the plots (chromatogram, raw 3D data, or I-t) 
also changes the scale of the other plots. 

• Point to an area on a plot and then drag to define the area to zoom 
into. 

• Select commands from the View or context menu (right-click to open 
the context menu): 

Full Size Adjusts the scale of all plot axes to include the entire 3D data set. 
  
Autoscale Adjusts the signal axis optimally for the selected data. 
  
Zoom to 
Integration 
Interval 

Adjusts the waveform period axis (ms) on the 3D and I-t plots to 
display only the integrated portion of the data. The response axis 
(nC) on the chromatogram and 3D plots is adjusted to the range of 
responses in the integrated data. 

  
Unzoom Reverses the previous zoom steps one by one. 

• Adjust scaling parameters manually using the Decoration dialog box:  

1. Double-click the plot or select Decoration on the context menu to 
open the dialog box.  

2. Then, go to the General and/or Chromatogram Plot tab pages to 
adjust scaling parameters: 
• On the General tab page, clear the Autoscale check boxes and 

then enter the desired values for the Time, Waveform, and 
Signal axes. 

 Tip:   
When the Autoscale check boxes are enabled, the plot axes 
are adjusted to include the full range of data values from the 
analysis. Clearing the check boxes lets you enter specific 
values for each axis.   

• On the Chromatogram Plot tab page, enter the desired Scale 
values for the response axis. 



 Analyzing 3D Amperometry Data 597 

In the following examples, the first window shows 3D data in the initial full 
size scale. 

 

After selecting Zoom to Integration Interval, the window looks like this: 
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The Scale parameters on the General tab page of the Decoration dialog 
box can be used to adjust the scale further: 

 

Time: Adjusted to include only the peaks of interest (no peaks of interest 
occurred after about 30 minutes). 

Waveform: Adjusted to the length of the integration interval (done by the 
Zoom to Integration Interval command).  

Signal: Adjusted to the highest response within the integration interval 
(done by the Zoom to Integration Interval command). 
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These settings result in the following plot display: 

 

Also, refer to: 

 Analyzing 3D Amperometry Data 

 The 3D Amperometry Window 

 Viewing Chromatograms in the 3D Amperometry 
Window 
The upper right pane of the 3D amperometry window displays a 
chromatogram of the selected 3D data. In integration view, the 
chromatogram is generated by adding responses measured throughout the 
integration interval to produce one integrated data point per waveform 
cycle.  

In raw data view, the chromatogram is generated by extracting one data 
point per waveform from the selected waveform period time slice. 
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 Tip:   

If the chromatogram pane is not displayed, enable the Show 
Chromatogram option on the context menu or click the following icon on 
the Method toolbar . 

To select a different chromatogram: 
The following methods can be used to select data and generate a different 
chromatogram: 
• In integration view, drag the upper integration interval line cursor on the 

3D or I-t plot to move the integration interval. Drag the lower integration 
interval line cursor to increase or decrease the interval. 

 Tip:   

If multiple integration intervals are defined, you must first drag the 
vertical retention time line cursor into the interval that you want to 
adjust and then move the integration interval line cursor. 

• In raw data view, drag the single horizontal waveform time line cursor 
to select a different waveform period time from which to generate the 
chromatogram. 

• In integration view, add or delete integration intervals. 

• Enable or disable the Autozero. 

Also, refer to: 

 Analyzing 3D Amperometry Data 

 Editing Integration Intervals  

 Extracting a Chromatogram 

 The 3D Amperometry Window 
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 Viewing I-t Plots in the 3D Amperometry Window 
The lower left pane of the 3D amperometry window displays a plot of 
current (I) vs. waveform time (t). To better visualize this plot, imagine that a 
vertical slice of the 3D data is taken at retention time (T) and the slice is 
then laid flat. The left axis is the waveform period (ms) and the bottom axis 
is the current (nA). When the Waveform is displayed, the top axis on the 
plot indicates the applied voltage (mV). 

 

 Tips:   

If the I-t plot pane is not displayed, enable the Show I-t Plot option on the 
context menu or click the following icon on the Method toolbar . 

To display a different I-t plot: 
On the 3D or chromatogram plot, drag the vertical retention time line cursor 
to a new position.  

To show or hide the waveform display: 
1. Double-click the 3D or I-t plot or select Decoration on the context 

menu. 

2. Select the I-t and Waveform Plots tab. 

3. Select the Show waveform check box to display the waveform or clear 
the check box to hide the waveform display.  
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Also, refer to: 

 Analyzing 3D Amperometry Data 

 The 3D Amperometry Window 

 Editing Integration Intervals 
In addition to editing integration intervals by moving the line cursors in the 
3D amperometry window (see  Viewing Chromatograms in the 3D 
Amperometry Window), you can also edit integration intervals on the 
Chromatogram Plot tab of the Decoration dialog box.  

Use the Chromatogram Plot tab page to add or delete intervals and edit 
existing intervals.  

1. Double-click the 3D or I-t plot or select Decoration on the context 
menu. 

2. Select the Chromatogram Plot tab. 

3. To add an integration interval, click Insert and then enter the Retention 
Time (min), the Begin Integration, and the End Integration 
parameters. See the guidelines below for details.  
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 When you add an integration interval at a particular retention time, the 
new interval is in effect from that time forward until the next integration 
interval is specified. 

4. To delete an integration interval, select the interval and click Delete.  

 Note:   
Integration intervals that were defined in the control Program cannot be 
deleted. The Retention Time (min) cell for these intervals is disabled 
(gray). 

Guidelines for Defining New Integration Intervals 
• The retention time of the last integration interval in the table must be 

before the end of the run. 

• The Begin Integration must be at least 10 ms after the start of the 
waveform period. 

• The End Integration must be at least 10 ms before the end of the 
waveform period. 

• Up to 15 intervals can be defined. 

Also, refer to: 

 Analyzing 3D Amperometry Data 

 The 3D Amperometry Window 

 Extracting a Chromatogram from 3D Amperometry Data 
You can extract a chromatogram from 3D_Amp data displayed in the 3D 
amperometry window. 

1. In the 3D amperometry window, select Extract>Chromatogram to file 
from the View or context menu (right-click to open the context menu). 

 A dialog box opens with settings for the chromatogram currently 
displayed in the 3D amperometry window.  

2. Enter a Channel name in which to save the chromatogram, or retain the 
default name if you wish to overwrite the existing channel data. 
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3. Click OK to accept these settings and extract the current chromatogram 
to a separate channel. The chromatogram opens in the integration 
window. 

You can also change the following settings before extracting the 
chromatogram: 
• Autozero: When Autozero is enabled, the extracted 3D channel data is 

adjusted by the signal offset. When disabled, the total 3D channel 
signal is extracted. 

• Extract Raw Data: The chromatogram is generated by extracting one 
data point per waveform from the selected Waveform Period time 
slice. Enter the time at which to extract the data. 

• Extract Integrated Data: The chromatogram is generated by 
calculating one data point per waveform from the selected integration 
interval(s). Edit the beginning and ending integration times for existing 
integration intervals, add integration intervals, or delete intervals. See 

 Editing Integration Intervals for additional information.  

• Extract from all samples of current sequence or query: A 
chromatogram is extracted for all of the samples in the sequence or in 
a list of samples created with a query. Each chromatogram is named 
with the channel name entered in the Channel name field. After you 
click OK, Chromeleon extracts all of the chromatograms and then 
opens the chromatogram of the selected sample. To view an extracted 
chromatogram for a different sample, right-click the sample in the 
Browser, select Open from the context menu and select the channel 
name from the list. 

Also, refer to: 

 Analyzing 3D Amperometry Data 

 The 3D Amperometry Window 
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 Exporting a Chromatogram, an I-t Plot, or 3D 
Amperometry Data 
You can export a chromatogram, an I-t plot, or raw 3D_Amp data from 
the 3D amperometry window. 

1. Select Export>Chromatogram from the View or context menu. 

2. Select whether to copy the chromatogram to the Windows clipboard or 
to a file. A text file containing the data values corresponding to the 
chromatogram currently displayed in the 3D amperometry window is 
copied. 

Follow the same procedure to export an I-t plot or raw 3D amperometry 
data. 

Also, refer to: 

 Analyzing 3D Amperometry Data 

 The 3D Amperometry Window 
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Working with Cyclic Voltammetry Data 
You can use the ICS-3000 Electrochemical Detector to perform Cyclic 
Voltammetry (CV) by issuing commands from a control panel (see 
Detector Control  Performing Cyclic Voltammetry). The recorded 
data can be viewed in a CV view window. CV data is acquired as a 
3D_Amp channel at 1 kHz and then compressed to 20 Hz before it is 
stored. The data from all the cycles in a run is stored in the manual 
sequence as a single sample, with a default name of Manual Acquisition. 

 Note:   
The 3D Data Acquisition license is required to acquire and process cyclic 
voltammetry data. 

Also, refer to: 

 Opening a Cyclic Voltammetry Data Plot 
 Viewing Cyclic Voltammetry Data 
 Copying Cyclic Voltammetry Plots 

  
 Opening a Cyclic Voltammetry Data Plot 

1. To view cyclic voltammetry data plot, right-click the Manual Acquisition 
sample in the manual sequence in which the data was saved. 

2. Select Open on the context menu and then select 3D_Amp from the list 
of channels.  
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The data opens in a CV view window. 

  

Also, refer to: 

 Viewing Cyclic Voltammetry Data 
 Copying Cyclic Voltammetry Plots 
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 Viewing Cyclic Voltammetry Data 

Cyclic Voltammetry data is displayed in a CV view window (see  
Opening a Cyclic Voltammetry Data Plot).  
The right pane of the window displays the cyclic Voltammogram. The x-
axis is the applied voltage and the y-axis is the detected current. To change 
the appearance of the plot (for example, to display a grid, change the plot 
or background colors, change the scale, or change the font) right-click 
anywhere on the plot and select Decoration on the context menu. 

The left pane of the CV view window displays basic information about when 
and how the data was collected.  
  
Name The Name assigned to the sample. 
  
Date The ⇒Injection Date/Time. 
  
Comment Additional sample description (if any). 
  
CV Steps The steps (the three voltages and the number of seconds they were 

applied) that define one CV cycle. See Detector Control:  
Performing Cyclic Voltammetry. 

  
The left pane also provides options for changing the display mode: 
  
Single CV at 
cycle # n 

Displays one cyclic voltammogram at a time. For example, if the CV 
run consisted of 6 cycles, you can view voltammograms 1 through 6 
individually. 

  
Average of All 
CV Cycles 

Averages the voltammograms from each cycle in the run and 
displays the resulting voltammogram. 

  
Overlay of All 
CV Cycles 

This mode displays all of the voltammograms recorded in the run. 
Each one is plotted in a different color. To see (or change) the color 
assigned to each plot, select Decoration from the View or context 
menu. 

  
Reversed 
(Polarographic) 

Selecting this check box inverts the plot axes. The voltage will be 
plotted from positive to negative (left to right) and the current from 
positive to negative (bottom to top). 

  
Also, refer to: 

 Opening a Cyclic Voltammetry Data Plot 
 Copying Cyclic Voltammetry Plots 
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 Copying Cyclic Voltammetry Plots 
You can copy a cyclic voltammetry plot to the Windows Clipboard and then 
paste it into another application (for example, a Word document).  

1. Display the desired plot in the CV view window (see  Viewing Cyclic 
Voltammetry Data).  

2. Click the right pane of the CV view window to select the plot. 

3. Select Copy on the Edit menu.   

Also, refer to: 

 Opening a Cyclic Voltammetry Data Plot 
 Viewing Cyclic Voltammetry Data 
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Using Mass Spectrometers 
When used together with the Thermo Finnigan aQa or MSQ Mass 
Spectrometer, Chromeleon supports MS data acquisition. However, before 
you can record and process mass spectra, several conditions must be 
fulfilled. For more information, refer to: 

 Creating an MS Program and Sequence 
 Creating a PGM File for the MSQ 
 Creating MSQ Channels with the MSQ PGM File 
 Creating a PGM File for the aQa MS 
 Creating aQa MS Channels with the aQa PGM File 
 Acquiring MS Data in MCA Mode 
 Extracting Mass Traces Online 
 Extracting Mass Traces Afterward 
 Extracting a Temporary Mass Trace 
 Showing Mass Spectra 
 Minimizing the Noise of Mass Spectra 
 Processing Mass Spectra 
 Defining Further QNT Settings for MS 

 Creating an MS Program and Sequence 
Manual data acquisition is not supported for Mass Spectrometers. 
Therefore, you must prepare a sequence before you can start data 
acquisition. This requires a control file ( PGM File). 

Program Wizard (PGM Editor: Commands) 
Create a new PGM File, using the Program Wizard (see The Control 
Program  The Program Wizard). If a mass spectrometer is installed in 
the current timebase, select data acquisition with the MS channel on the 
Acquisition Options tab page. This action opens the page for MS-specific 
parameters. 
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 Tip:  
Log on to the PC as a main user or as administrator if you wish to create a 
program for the MSQ mass spectrometer. If you do not log on this way, a 
No MS device configured error message appears. 

Set the parameters required for Mass Trace processing (= MS 
chromatogram). The Range parameter is the scaling factor for the online 
display of mass traces on the control panel; for example, Range = 5 allows 
a maximum value of 100.000 = (1 E+5) counts in the online display. 
However, the stored data are not affected. The Smoothing parameter 
determines which type of smoothing filter is used for smoothing MS 
chromatograms.  

In the Points field, define the number of data points to be used for 
smoothing. Select the number of data points such that the width of the 
smoothing filter approximately equals the peak's half width. For example, 
the following program will be created: 
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The PGM File that was generated using the PGM Wizard does not include 
⇒AcqOn/Off (Data Acquisition On/Off) commands for the MS channels. 
The channels that are needed for mass trace acquisition depend on the 
contents of the MS method. 

The Program Wizard automatically generates the wait MS.ready command 
before the inject command. This synchronization is required between the 
mass spectrometer and Chromeleon. If you want to create your own PGM 
Files manually, always add the wait MS.ready command before the inject 
command. 

If you want to use Blank Run Samples, verify that the inject mode is set to 
Inject. The aQa mass spectrometer will not start data acquisition unless an 
injection signal is received. 
 
Example: 
 Wait MS.Ready 
 Inject Blank=Inject 

On the last wizard page, select the Review the program in a new window 
option. This action automatically opens the PGM Editor as soon as the new 
PGM File is saved. Use the PGM Editor to define the mass spectrometer 
settings for the PGM File. Select the Mass Spectrometer view by clicking 
the corresponding icon in the left editor section. For information about mass 
spectrometer methods, refer to  Creating a PGM File for the aQa MS or 

 Creating a PGM File for the MSQ. 
 
Sequence 
Then, create a sequence for your HPLC or IC system.   

a) Using the Sequence Wizard:  

Enter the created PGM File in step 4. 

b) From a previous sequence:  

Copy the PGM File to a new sequence and enter the PGM File in the 
sample list. 

 Tip: 
Verify that the Operation property of the aQa mass spectrometer is in the 
On state. Otherwise, the gas flow and the probe heating are turned off and 
data acquisition cannot be started. 
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Then, start data acquisition as usual (see Practical Tips for Device 
Control  Starting Data Acquisition). The current mass spectrum can 
be displayed on the Control Panel. 

 Creating a PGM File for the MSQ 

Use the Surveyor MSQ view of the PGM Editor (see Control  The PGM 
Editor) to create a new instrument method for the MSQ Mass 
Spectrometer as part of a PGM File. Open this view by clicking this icon on 
the shortcut bar in the left PGM Editor section: 

 
 Tip: 

If the PGM File was not created for a timebase that includes a mass 
spectrometer, neither an MS method nor the MSQ symbol will be available. 
To use such a PGM File for a timebase that includes a mass spectrometer, 
select Add MS Instrument Method on the Edit or context menu. This adds 
the Surveyor MSQ view. From the standard MS methods (Surveyor MSQ 
Templates) in the dialog box, select an MS method. The appropriate MS 
method depends on the ionization mode, the MS mode ( Full Scan or 

SIM), and the polarity of the recorded ions. In addition, enter the following 
command in the Program (Commands view) at the time t = 0.000 min: 

 0.000 Wait MS.Ready 
 
The Surveyor MSQ view is part of the Xcalibur software and allows you 
to specify the method used by the MSQ mass spectrometer. 

The upper left section shows a runtime preview of the single channels to 
record. In the Preview section, select: 
• All Scans to display all channels. 

• Full Scans to display the Full Scan channels (orange) only.  

• SIM to display the SIM channels (green) only.  

For an overview of the defined channels, including their measurement 
parameters, select the Parameter option. 
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If a chromatogram was recorded with one MS channel only, you can also 
have the chromatogram displayed in the preview. Select Show Method 
Options to open the method options, and then select a sample by clicking 
the "..." button under Display.  

On the top right, in the Per Method Parameters section, select ESI 
(Electrospray Ionization) or APCI (Atmospheric Pressure Chemical 
Ionization) as the ionization mode, depending on your MSQ installation. In 
addition, enter the nominal temperature on the ion source (range: 0 to 
655°C). 

In the Full/SIM Scan Events section, enter the MSQ-specific signal 
parameters for Mass Spectra acquisition: 

 

In the Mass Range field, define the desired mass range ( Full Scan). In 
the Mass field, define the mass. Define the corresponding bandwidth 
( SIM) in the Span field. In addition, define the duration of the data 
acquisition (Time Range), the data acquisition rate (Dwell Time (SIM) or 
Scan Time (Full Scan)), the Polarity, and the ionization voltage (Cone 
[V]).  

 Note: 
For a list of SIM masses for anions, cations, and amines in water, refer to 
How to …: Using Mass Spectrometers  SIM Mass Lists for IC-MS. 
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In the Scans section, select the Add Full option to add a new full-scan 
channel or Add SIM to add a new SIM channel. The settings from the 
preceding channel are adopted. Use the Create Group option to group all 
SIM channels that are recorded in the same retention time window. (To do 
so, hold down the CTRL key and click to select the SIM channels.) Select 
Ungroup to undo this action. To delete a channel, select the channel, and 
then click Delete. 

 Tip: 
This view of the PGM Editor is part of the Xcalibur software. The Xcalibur 
Help system provides detailed information about mass spectra acquisition. 
First, click the question mark (at the top right) and then click the option of 
interest to open the corresponding Help topic. 

 Tip:  
When saving the PGM File, only use ASCII characters to name the entire 
path, i.e., including the datasource and the directories. If you use other 
characters, too, it may be impossible to start data acquisition. 

For more information, refer to  Creating MSQ Channels with the MSQ 
PGM File. 

 Creating MSQ Channels with the MSQ PGM File 
Chromeleon creates a channel for each scan event of the MSQ instrument 
method. In the case of SIM groups, this also applies to each sub scan 
event. The examples below describe which channels Chromeleon creates 
automatically for the different types of data acquisition with the MSQ.  

 Note: 
For a list of SIM masses for anions, cations, and amines in water, refer to 
How to …: Using Mass Spectrometers  SIM Mass Lists for IC-MS. 
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The first example creates four SIM channels plus the TIC channel: 

 

The SIM1 channel records the chromatogram at a mass of 80.00 m/z, while 
the other channels record the same chromatogram at a mass of 85.00 m/z 
(SIM2), 90.00 m/z (SIM3), and 100.00 m/z (SIM 4). 

Data acquisition is performed for all four channels at the same time (0 to 1 
min). That is why you can group all four channels. In this case, only SIM 
channels and the TIC channel would be created.  

 
 
The next example creates 11 SIM channels (SIM 01 to SIM 11) and the TIC 
channel: 
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The channel assignment is as follows:  
Xcalibur (CM program: MSQ) Chromeleon 
Name Mass [m/z] Span [m/z] Name Mass Range [m/z] 
GROUP 1: Retention time 0.00 to 2.00 min    
SIM 1 100 1 SIM_01 99.5 - 100.5 
SIM 2 200 1 SIM_02 199.5 - 200.5 
SIM 3 300 1 SIM_03 299.5 - 300.5 
SIM 4 400 1 SIM_04 399.5 - 400.5 
GROUP 2: Retention time 2.00 to 3.00 min   
SIM 1 100 1 SIM_05 99.5 - 100.5 
SIM 2 100 3 SIM_06 98.5 - 101.5 
SIM 3 100 5 SIM_07 97.5 - 102.5 
SIM 4 150 1 SIM_08 149.5 - 150.5 
SIM 5 200  SIM_09 199.5 - 200.5 
Single channels:    
SIM 1 99 1 SIM_10 98.5 - 99.5 
SIM 2 110 1 SIM_11 109.5 - 110.5  
The next examples creates 3 TICF channels and the TIC channel:  

 

The channel assignment is as follows: 

TICF_1:  
FS 1, Mass range 30.00 to 500.00 m/z; retention time 0.00 to 1.00 min, 

TICF_2:  
FS 2, Mass range 60.00 to 400.00 m/z; retention time 2.00 to 4.00 min, 

TICF_3:  
FS 3, Mass range 600.00 to 800.00 m/z; retention time 0.00 to 2.00 min. 
 

 Tip:  
When saving the PGM File, always use ASCII characters to name the 
entire path, i.e., including the datasource and the directories. If you use 
other characters, too, it may be impossible to start data acquisition. 
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If you notice after data acquisition that a channel is missing, you can extract 
separate Mass Traces (or mass ranges) from the Mass Spectrum and 
save them as new channels. (For more information, refer to How 
to …: Using Mass Spectrometers  Extracting Mass Traces 
Afterward.) 

 Creating a PGM File for the aQa MS 

Use the Mass Spectrometer view of the PGM Editor (see Control  The 
PGM Editor) to create a new instrument method for the aQa Mass 
Spectrometer as part of the PGM File. Open this view by clicking this icon 
on the shortcut bar in the left PGM Editor section: 

 
 Tip: 

If the PGM File was not created for a timebase that includes a mass 
spectrometer, neither the MS method nor the Thermo Finnigan aQa symbol 
will be available. To use such a PGM File for a timebase that includes a 
mass spectrometer, select the Add MS Instrument Method command to 
the Edit or context menu. This creates a standard MS method and adds the 
Mass Spectrometer view. In addition, enter the following command in the 

Program (Commands view) at the time t = 0.000 min: 

 0.000 Wait MS.Ready 
 
The Mass Spectrometer view is part of the Xcalibur software and allows 
you to specify the method used by the aQa mass spectrometer. 

On the Ionization Mode tab page, select Electrospray (Electrospray 
Ionization) or APCI (Atmospheric Pressure Chemical Ionization) as the 
ionization mode.  

On the Analysis tab page, set the sensitivity of the mass spectrometer via 
the detector voltage. Via Advanced (from tune file), load a tune file that 
has been previously defined. To fine-tune the mass spectrometer directly, 
click Tune. 
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 Caution: 
When you use the Xcalibur method editor of Chromeleon, the Other 
detectors section is irrelevant. Do not use this section for data acquisition 
with other detectors, such as UV detectors! In this case, perform data 
acquisition as usual. 

On the Acquisition tab page, enter the aQa-specific signal parameters for 
Mass Spectra acquisition: 

 

Select the data acquisition mode first: Select Full-Scan to acquire the 
entire mass spectrum for each analyte or SIM to obtain MS 
chromatogram at a defined mass.  
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 Note: 
For a list of SIM masses for anions, cations, and amines in water, refer to 
How to …: Using Mass Spectrometers  SIM Mass Lists for IC-MS. 

In Full-Scan mode, use the Simultaneous acquisitions tab page to set the 
polarity and maximum voltage on the aQa MS for four single channels 
( TICF channels). In the Acquisition rate field, specify the rate for data 
acquisition; in the Mass spectrum field, specify the mass range for which 
to perform data acquisition. 

 Tips: 
This view of the PGM Editor is part of the Xcalibur software. Thus, you can 
open the Xcalibur help either via the Help menu or by clicking Help. The 
Xcalibur help provides detailed information about mass spectra acquisition. 

When saving the PGM File, only use ASCII characters to name the entire 
path, i.e., including the datasource and the directories. If you use other 
characters, too, it may be impossible to start data acquisition. 

For more information, refer to  Creating aQa MS Channels with the 
aQa PGM File. 

 Creating aQa MS Channels with the aQa PGM File 
The examples below describe which channels Chromeleon creates for the 
different types of data acquisition with the aQa MS.  

 Note: 
For a list of SIM masses for anions, cations, and amines in water, refer to 
How to …: Using Mass Spectrometers  SIM Mass Lists for IC-MS. 
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The first example creates two SIM channels plus the TIC channel: 

 

The SIM_01 channel records the chromatogram at a mass of 100 amu, 
while the SIM_02 channel records the corresponding chromatograms at a 
mass of 200 amu. 
 



 Using Mass Spectrometers 623 

The second example creates six SIM channels and the TIC channel: 

 

The channel assignment is as follows: 

SIM_01: Mass 100 amu, positive voltage, 100V, 

SIM_02: Mass 100 amu, negative voltage, -80V, 

SIM_03: Mass 200 amu, positive voltage, 100V, 

SIM_04: Mass 200 amu, negative voltage, -100V, 

SIM_05: Mass 300 amu, positive voltage, 100V, 

SIM_06: Mass 300 amu, positive voltage, 80V. 
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The third example creates three TICF channels and the TIC channel: 

 

The channel assignment is as follows: 

TICF1: positive voltage, 100V 

TICF2: positive voltage, 200V 

TICF3: negative voltage, -100V. 

 Tip:  
When saving the PGM File, only use ASCII characters to name the entire 
path, i.e., including the datasource and the directories. If you use other 
characters, too, it may be impossible to start data acquisition. 
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If you notice after data acquisition that a channel is missing, you can extract 
separate Mass Traces (or mass ranges) from the Mass Spectrum and 
save them as new channels. (For more information, refer to How 
to …: Using Mass Spectrometers  Extracting Mass Traces 
Afterward.) 

 SIM Mass Lists for IC-MS 
SIM (Selected Ion Monitoring) is the Mass Spectrometer method used 

for recording an MS chromatogram at a specific mass-to-charge ratio.  

The tables below list the SIM masses for anions, cations, and amines in 
water. Refer to the appropriate table when entering SIM masses in aQa or 
MSQ PGM Files, or to identify found masses. 
 

Anion SIM Mass List for IC-MS (in water) 
m/z 
 
 

Anion 
 
 

Detected As 
 
 

Isotopes 
(decreasing 
frequency) 

19 Fluoride −F  
 

35 Chloride −Cl  
 

45 Formate −HCOO  
 

46 Nitrite −
2NO

 
 

58 Thiocyanate −SCN  
 

59 Acetate −COOCH3  
 

61 Bicarbonate −
3HCO  

 

62 Nitrate −
3NO  

 

67 Chlorite −
2ClO  

67/69 

73 Glyoxylate −CHOCOO  
 

73 Propionate −COOCHCH 23  
 

75 Glycolate −COOHOCH2  
 

79 Bromide −Br  
79/81 

83 Chlorate −
3ClO  

83/85 
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m/z 
 
 

Anion 
 
 

Detected As 
 
 

Isotopes 
(decreasing 
frequency) 

87 Butyrate −COOCHCHCH 223  
 

87 Pyruvate −COCOOCH3  
 

89 Lactate −COO)OH(CHCH3  
 

89 Oxalate −COOHCOO  
 

93 Chloroacetate −COOCICH2  
93/95 

95 Methanesulfonate −
33SOCH  

95/97 

96 Sulfamate −
32SONH  

96/98 

97 Sulfate −
4HSO  

97/99 

97 Phosphate −
42POH  

 

99 Perchlorate −
4ClO  

99/101 

101 Valerate −COOCHCHCHCH 2223  
 

103 Hydroxybutyrate −COOCHOHCHCH 23  
 

103 Malonate −COOCOOHCH2  
 

113 Thiosulfate −
32OHS  

113/115 

113 Trifluoroacetate −CCOOF3  
 

115 Maleate −OCOOHCHCHCO  
 

115 Fumarate −OCOOHCHCHCO  
 

117 Succinate −COOCHCOOHCH 22  
 

127 Bromate −
3BrO  

127/129 

127 Dichloroacetate −CHCOOCl2  
127/129 

127 Iodide −I  
 

128 Selenite −
3SeO  

128/126 

131 Glutarate −COO)CH(COOH 32  
 

133 Malate −CHOHCOOCOOHCH2  
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m/z 
 
 

Anion 
 
 

Detected As 
 
 

Isotopes 
(decreasing 
frequency) 

133 Tartrate −COO)CHOH(COOH 2  
 

137 Bromoacetate −COOBrCH2  
137/139 

144 Selenate −
4SeO  

144/142 

145 Adipate −COO)CH(COOH 42  
 

173 Bromochloroacetate −BrClCHCOO  
173/171/175 

183 Styrenesulfonate −
3462 SOHCHCCH  

 

191 Citrate −COOCH)COOH(COHHOOCCH 22  
 

191 Quinate −COO)OH(HC 476  
 

191 Isocitrate −COOCH)COOH(HOOCCHOHCH 2  
 

207 Dichlorobromoacetate −BrCCOOCl2  
207/205/209/211 

217 Dibromoacetate −CHCOOBr2  
297/295/293/299 

251 Dibromochloroacetate −ClCCOOBr2  
251/253/249/255 

297 Tribromoacetate −CCOOBr3  
297/295/293/299  

 
 

Cation and Amine SIM Mass List for IC-MS (in water) 
m/z Cation Detected As 
18 Ammonium +

4NH  
19 Hydronium +OH3  
20 Calcium +

2Ca2/1  
23 Sodium +Na  
39 Potassium +K  
46 Ethylamine +

323 NHCHCH  
46 Dimethylamine +

223 NH)CH(  
60 Trimethylamine +NH)CH( 33  
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Cation and Amine SIM Mass List for IC-MS (in water) 
m/z Cation Detected As 
60 Guanidine +

222 CNH)NH(  
61 Ethanediamine +

3222 NHCHCHNH  
62 Monoethanolamine +

322 NHCHOHCH  
69 Imidazole +HNHC 243  
74 Diethylamine +

2223 NH)CHCH(  
74 Dimethylethylamine +NH)HC()CH( 5223  
74 Butylamine +

394 NHHC  
75 Propanediamine +

32222 NHCHCHCHNH  
76 Methylethanolamine +

332 NH)CH(CHHOCH  
76 Dimethylmethanolamine +

323 NH)CH(HOC  
76 Propanolamine +

363 OHNHHC  
80 Pyridine +NHHC 55  
85 Lysidine +HNHC 284  
88 Morpholine +

284 ONHHC  
88 Methyldiethylamine +NH)HC(CH 2523  
89 Butanediamine (Putrescine) +

3842 NHHNCH  
90 Dimethylethanolamine +NHHC 135  
90 Methylpropanolamine +

384 NH)OH(HC  
100 Cyclohexylamine +

3116 NHHC  
102 Triethylamine +NH)CHCH( 323  
103 Pentanediamine (Cadaverine) +

31052 NHHNCH  
104 Dimethylamino-2-propanol +NH)CH)(OHHC( 2363  
106 Diethanolamine +

2222 NH)CHOHCH(  
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Cation and Amine SIM Mass List for IC-MS (in water) 
m/z Cation Detected As 
118 Diethylethanolamine +ONHHC 156  
120 Methyldiethanolamine +NHOHC 2135  
132 Diethylaminopropanol +ONHHC 177  
146 Spermidine +

342322 NH)CH(NH)CH(NH  
150 Triethanolamine +NH)CHOHCH( 322  
203 Spermine +HNHC 42610   

 Acquiring MS Data in MCA Mode 
Use the MCA (= Multi-Channel Analysis) mode to calibrate the aQa Mass 
Spectrometer and analyze pure, low-concentration solutions of substances. 
Usually, the solution in question is provided to the mass spectrometer via 
infusion. 

 Tip:  
The MCA mode is not available for the MSQ.  

The MCA mode summarizes all Mass Spectra of the single scans. Only 
the resulting averaged mass spectrum from each of the scan filters (up to 
four) is saved when the analysis is finished. 

 Caution: 
The MCA mode does not allow recording and showing mass spectra at a 
defined time of the chromatogram. Therefore, the MCA mode is not 
suitable for chromatographic analyses! 

Data acquisition in MCA mode is as follows: 
• Create a PGM File, using the Program Wizard (see The Control 

Program  The Program Wizard). 

• Verify that the PGM File includes an Inject command even if you do 
not use an autosampler. Otherwise, data acquisition cannot be started. 
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• In the PGM Editor (see Control  The PGM Editor), open the 
Acquisition tab page of the Finnigan aQa window. In the Mass 
spectrum field, select MCA as Peak format.  

• Save the PGM File and close the PGM Editor. 

• Enter the PGM File in your sequence and start the sequence in a 
batch. 

 Tip: 
MCA data acquisition is not possible in demo mode!  

The Xcalibur window below opens automatically when data acquisition is 
started: 

 

The status bar indicates the time that passed since the data acquisition was 
started. The results of the last two scans appear at the top left and right. 
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As soon as the data acquisition is finished, you can display the results in 
the Chromeleon report. To display the results click the line at the highest 
retention time on the chromatogram plot using the Spectra Tool. This action 
opens the following view: 

 

The chromatogram in the left pane contains one data point only that is at 
the highest retention time. To illustrate the summing up of the entire 
acquisition period, it shows one line in the height of the entire counts of all 
summed up mass spectra. In addition, only one single (entire) mass 
spectrum is displayed in the right window section. 

 Tip: 
As MCA mass spectra are not spectra from chromatographic peaks, but are 
formally retention time spectra, they cannot be inserted in the Printer 
Layout. Therefore, select Print on the File menu to print mass spectra. A 
dialog box appears. Select the Printer Layout page that contains the mass 
spectrum. 
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 Extracting Mass Traces Online 
It is possible to extract Mass Traces (MS chromatograms) and save them 
as additional channels. This can be done either during data acquisition 
(online) or later (see  Extracting Mass Traces Afterward). 

In the Server Configuration Program, define the required number of 
Online Mass Extract Channels on the Installed Channels tab page. (Up to 
32 channels can be defined.) These channels are automatically named 
MS_01 to MS_32. 

Create a PGM File for data acquisition in Full Scan mode, using the 
Program Wizard (see The Control Program  The Program Wizard). 
Each single MS channel needs its own ⇒AcqOn/Off command. Define the 
following parameters for each single MS channel: 
 
Parameter Min. Max. Default Usage 
FilterIndex 0: NoFilter 

 
n: TICF_0n (MSQ) or 
TICF_n (aQa) 
(n = number of the 
TICF channel 
configured in the Server 
Configuration) 

0 Selects the filter for extraction. 
The filter indexes correspond to 
the nine MSQ filters or the four 
aQa filters that can be defined 
in the MS method. 
0 = NoFilter means that the 

TIC channel is used. 
MinMass 0.00 m/z 

(MSQ) 
2.0 m/z 
(aQa) 

2000.00 m/z (MSQ) 
1636.0 m/z (aQa) 

 Minimum mass of interval that 
will be extracted. 

MaxMass 0.00 m/z 
(MSQ) 
2.0 m/z 
(aQa) 

2000.00 m/z (MSQ) 
1636.0 m/z (aQa) 

 Maximum mass of interval that 
will be extracted. 

 
These parameters cannot be set using the Program Wizard. Therefore, 
follow the steps below: 
• Open the PGM File. 

• Select Command on the Control menu to open the Commands dialog 
box.  

• Select your Mass Spectrometer (listed by the name defined in the 
Server Configuration).  

• Open the mass channel to be extracted; for example, MS_01.  
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• Specify the individual parameters: 

 

Use the Upper/Lower Limit parameters to specify the signal limits. 

You can also extract the trace of the Base Peak. In this case, verify that 
the BasePeakMode property is set to Yes. 

 Tip: 
Do not change the mass trace settings during a run. This might result in 
confusion. Therefore, Dionex recommends not entering a retention time. 

The corresponding section in the Program could look as follows: 
 MS_01.MinMass = 149.5  
 MS_01.MaxMass = 150.5  
 MS_01.FilterIndex = 1  
 

 Tip:  
To start data acquisition, manually enter the following command for the 
MS_01 channel:  MS_01.AcqOn 
 
To stop data acquisition for the MS_01 channel, enter:  MS_01.AcqOff 

You can display these channels on the Control Panel during data 
acquisition. 
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 Extracting Mass Traces Afterward 
If you did not extract a Mass Trace online, during data acquisition (see 

 Extracting Mass Traces Online), you can do this afterward: 

 Tip:  

To view a mass trace before extracting it, extract a temporary mass trace 
first (see  Extracting a Temporary Mass Trace). 

1. To extract a mass trace, open the Mass Spectrum from the 
Integration plot or the QNT Editor. (For more information about the 
editor, see Data Representation and Reprocessing  The QNT 
Editor.) 

 Tip:  
You may also define mass trace extraction in the Post-acquisition 
steps view of the PGM Editor (see Control  The PGM Editor). Open 
the PGM File in which you want to define mass trace extraction, and 
then select the Post-acquisition steps view. 

2. Select Extract Mass Trace… on the context menu to open the Extract 
Mass Trace dialog box: 
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 Tip:  
In the PGM Editor, follow the steps below: Select Insert line on the 
context menu to add a new post-acquisition step. The New post-
acquisition step dialog box is opened. Select Extract MS channel to 
open the Extract Mass Trace dialog box. 

3. Select a filter and mass range, as well as the Smoothing type for the 
MS chromatograms, the number of data points to be used, and the type 
of the mass trace to be extracted.  

4. In the Channel Name box, enter the name for the new channel or 
accept the default name. Chromeleon creates the suggested name from 
the Filter Index, the Mass, if indicated, the Smoothing information, and 
the Trace Type for the mass trace to be extracted.  

 Note: 
If the Trace Type is TIC, Chromeleon does not consider the mass (or 
the mass range if < 1.00 m/z) for the channel name. 

5. To extract the mass trace for all samples in the sequence or Query, 
select the Apply to all samples in the current sequence or query 
check box. 

 Tip:  
This option is not available in the Extract Mass Trace dialog box of the 
PGM Editor. 

6. Click Extract to make the new channel available for chromatographic 
representation. 

If you know prior to data acquisition which channels you will need, you can 
omit this step and record the required channels right from the beginning 
(see How to …: Installing and Configuring Mass Spectrometers 

 Defining the Number of MS Channels in the Administrator Help 
section) or extract them as described above. 

 Note: 
If you need help identifying found masses, refer to How to …: Using Mass 
Spectrometers  SIM Mass Lists for IC-MS.  
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 Extracting a Temporary Mass Trace 

Before you extract a Mass Trace (see  Extracting Mass Traces 
Afterward), you can create it temporarily by just clicking the mouse. The 
following options are available: 

Using the mouse pointer 
 
Cursor Activated by What it does 

 

Placing the pointer near a 
mass data point or a mass 
needle. 

A temporary MS channel is extracted for the 
current mass. An existing temporary MS 
channel will be overwritten. 

 

Placing the pointer near a 
mass data point or a mass 
needle and simultaneously 
pressing the SHIFT key. 

A temporary MS channel is extracted for the 
current mass. The new channel will overlay 
existing temporary MS channels. 

 

Placing the pointer between 
two mass range delimiters. 

This action moves the mass range as desired.  

 

Placing the pointer on or near 
a mass range delimiter. 

This action moves the left or right delimiter in 
the desired direction.  

 

On the context menu 
To extract a mass trace, click the corresponding mass or right-click the 
mass range. On the context menu, select Extract Temporary Mass Trace 
and define the corresponding parameters in the dialog box: 
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 Showing Mass Spectra  
The Mass Spectra view can be added to almost all Chromeleon plots 
(Integration, QNT Editor (see Data Representation and Reprocessing 

 The QNT Editor), Printer Layout) if Xcalibur is installed. To enable the 
mass spectra view click the following icon:  

Or else, select Show Mass Spectra on the View menu: 

 

To add a mass spectrum to the Printer Layout, enable Layout Mode on 
the Edit menu. Select Insert on the View or context menu, and then select 
Mass Spectra Plot. 
The appearance of the displayed mass spectra may be quite different, 
depending on which the MS instrument method was used. For more 
information, refer to How to …: Using Mass Spectrometers  Creating 
a PGM File for the aQa MS or  Creating a PGM File for the MSQ. For 
information about which the parameters should be used in this method to 
receive a certain mass spectrum, refer to the Xcalibur help. 

 Note:  
MS spectra are displayed one below the other to enhance the clearness of 
representation. For a large enough representation, enlarge the upper 
section of the entire window, if necessary. 
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In the captions of the single mass spectra plots, the peak name (if the mass 
spectrum of a peak is given) plus the retention time of the mass spectrum is 
given on the left. On the right, the acquisition mode is given: Full ms 
indicates Full-Scan mode; SIM ms indicates SIM mode. 

In the caption of full-scan mass spectra, the entire mass range is given in 
parentheses on the right. The fragmentation voltage that is given in front of 
the mode is important, as well. 

With mass spectra that were acquired in SIM mode, no entire mass spectra 
are available. These SIM mass spectra are extracted from single mass 
traces, so the resulting SIM mass spectrum usually shows gaps between 
the single traces. In the caption, the single mass ranges are given together 
with the corresponding fragmentation voltage behind the respective mass 
range (following a @ sign) on the right.  

How to set the MS specific parameters of the view 
Place the pointer on the mass spectrum and right-click to open the context 
menu. Select Decoration, go to the MS Filter tab page, and then make the 
desired settings: 
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 Minimizing the Noise of Mass Spectra 
Mass Spectra usually include more details than UV spectra. However, 

they often have an increase noise level. Especially with low signal intensity, 
they are considerably affected by the background spectrum. To use the 
information of mass spectra in the best possible way, Dionex recommends 
that you reprocess them as described below. There a two ways:  

Spectra Bunching 
To reduce mass spectra noise, you can bunch several single mass spectra 
to one entire mass spectrum. Spectra bunching can be performed for both 
peak spectra and retention time spectra. 

Use the MS tab page of the QNT Editor to bunch several single spectra to 
the left and the right of the chromatogram peak together with the peak 
maximum spectrum to one entire peak spectrum. (For more information 
about the editor, see Data Representation and Reprocessing  The QNT 
Editor.) 
In the chromatogram, define the range for which to display the entire 
retention time spectrum. Use the Spectra Tool to select a range while 
left clicking. You can perform this in a UV channel as well. 

Subtracting Background Mass Spectra 
Background subtraction of mass spectra eliminates the influence of the 
background on the mass spectra. The background mass spectrum to be 
subtracted can be defined either for the entire chromatogram or 
automatically by Chromeleon for each single peak.  

The corresponding setting is made on the MS tab page of the QNT Editor 
or in the chromatogram. The settings made in the chromatogram are saved 
to the QNT File of the current sample as well. Thus, your input affects all 
samples that are evaluated using this QNT File. 

For more information, refer to:  

 Processing Mass Spectra  

How to …: Working with Chromatograms  Subtracting Background 
Spectra 
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Tracking the Effects of Background Subtraction 
You can track the effects of spectra subtraction directly on the mass 
spectra plot: 
• Select Decoration on the context menu to open the mass spectrum 

decoration and then the select the Peak Spectra tab page. 

• In the Background Subtraction Overlay section, select the 
Background Spectrum to display the subtracted background mass 
spectrum in addition to the peak and retention time spectra.  

• In addition, select the Original Spectra to display the respective mass 
spectrum without subtraction. 

 Processing Mass Spectra 
Mass Traces have a relatively high noise level. Therefore, they must be 

processed before being used further. Chromeleon uses the following 
algorithm: 
• First, the spectrum of the peak maximum is determined by averaging 

several spectra in the peak maximum on both ends. 

• Then, the background spectra of both peak ends are determined, also 
by averaging several spectra.  

• The background peak spectrum (usually at the peak maximum) is then 
determined via linear interpolation of these two background spectra 
and is finally subtracted from the single spectrum (usually of the peak 
maximum).  

 Tip:  
Only mass spectra recorded with the same filter settings are averaged and 
subtracted. The filter settings of the Apex mass spectrum of the current 
peak are used for this. For time spectra, the filter settings of the mass 
spectrum nearest to the selected retention time are used. 

In the QNT Editor, use the MS tab page to specify how mass spectra are 
formed from individual spectra. (For more information about the editor, see 
Data Representation and Reprocessing  The QNT Editor.) Select the 
Enable Background Subtraction check box to enable spectrum 
subtraction: 
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In the combo box under Peak Spectrum Bunch, enter the number of 
single spectra that shall be bunched to form the spectrum at the peak 
maximum. A maximum of 99 single spectra can be averaged. For 
symmetry reasons, it is possible to enter odd numbers only. 

Select Peak Dependent Background Subtraction to allow automatic 
background subtraction for each peak. 

In the edit fields under Left Region Bunch and Right Region Bunch, 
enter the number of spectra to be used to form the two background spectra. 
You can select up to 99 single spectra. Zero and even numbers are 
permitted as well. These settings apply to peak spectra and time spectra 
below peaks. 

Select Fixed Background Subtraction Ranges to define two fixed ranges 
for background subtraction for the entire chromatogram. It usually makes 
sense to set one range at the beginning and the other one at the end of the 
chromatogram. These settings apply to peak spectra and to all time 
spectra. 

Click Apply to accept the settings and calculate the resulting mass 
spectrum. When the Show Spectra view is enabled, the newly calculated 
mass spectrum is displayed at once. 
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 Note: 
Defining the background subtraction manually in the chromatogram affects 
the settings on the MS tab page. For example, if you select MS 
Background Subtraction on the context menu of the chromatogram, and 
then select Fixed Background Ranges, the corresponding option is 
automatically selected on the MS tab page of the QNT Editor. 

 Defining Further QNT Settings for MS 

Handling the Retention Time Delay as against a second detector 
Use the Delay Time option on the General tab page to take the retention 
time difference into account that is due to the time needed by the 
substances to travel from the first detector, for example, to the MSQ 

Mass Spectrometer.  

For more information, refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Defining the QNT Method for Several 
Detectors in the Creating a Peak Table section. 

Defining Peaks via Mass Spectra  
For peak identification via mass spectra, use the six MS columns: 
• Mass Peak 1 (as well as Mass Peak 2 and Mass Peak 3)  

• MS threshold 

• MS filter conditions 

• Check MS retention times 

For more information, refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Identifying Peaks via Their Mass Spectra 
(MS Tracking) Detectors. 
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Collecting Fractions 
Fraction Collectors are often used for fraction collection after the detector. 

The online interpretation of the signal can be used to automate 
fractionation.  

Fractions can be collected for preparative use, if desired. However, in many 
cases, the objective is further analysis of each fraction. In either case, you 
can collect the fractions based on the signal. Signal-based fraction 
collection is quite complex, but the Fraction Collection driver provided by 
Chromeleon facilitates the process. In the Server Configuration program, 
install the Fraction Collection driver in addition to the device driver for your 
fraction collector. 

 Tips: 
In order to perform fraction collection, a Fraction or Purification license 
must be installed. 

The Fraction Collection driver also allows you to collect fractions 
independently of the signal, with a fixed volume at predefined retention 
times. 

For more information about fraction collection, refer to: 

 Setting up Fraction Collection 

 Enabling Fraction Collection (General Options) 

 Setting the Fraction Collection Options 

 Selecting the Channel for Fraction Collection  
     (Channel Selection Options) 

 Detecting the Peak Start, Peak Maximum, and Peak End (Peak 
Detection Options) 

 Entering More Peak Detection Parameters  
    (Peak Detection Options) 

 Determining the Delay Time (Delay and Detector Offsets) 

 Editing Signal-Dependent Fraction Collection Parameters 

 Editing Signal-Independent Fraction Collection Parameters  
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 Defining the Reactions to Certain Events 

 Program Example (One Detection Channel) 

 Program Example (Two Detection Channels) 

 Fraction Collection Control via an MS 

 Fraction Collection Control via an MS for Different Samples 

 Checking the Fraction Collection Status on the Control Panel 

 Tracking Fraction Collection in the Chromatogram 

 Tracking Fraction Collection in the Report 
 
If you select the appropriate Post-Acquisition Steps, Chromeleon can 
create new samples and perform fractionation automatically. This process 
is also known as Autopurification. Before beginning, verify that a 
Purification license is installed. For more information, refer to  Collecting 
Fractions Automatically (Autopurification) and to the autopurification 
manual. 

 Note: 
The Fraction Collection Automation driver from earlier Chromeleon 
versions is obsolete. It is included on the Chromeleon software CD only for 
compatibility reasons (Server Configuration program > Add device to 
timebase > Manufacturers > Obsolete). Dionex recommends that you 
install the new Fraction Collection driver, instead (Server Configuration 
program > Add device to timebase > Manufacturers > General).  

 Setting up Fraction Collection 
Before you can collect fractions, you have to set up fraction collection as 
follows: 

Server Configuration 
Install the Fraction Collection driver in the desired timebase. (Select Add 
Device on the context menu, select Generic from the left list box, and then 
select Fraction Collection from the right list box.) In addition, install the 

Device Driver for the respective fraction collector. 
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Determine how the fractions are collected, either in the Program Wizard 
(see The Control Program  The Program Wizard) or on a Control 
Panel. On a control panel, select Command on the Control menu and then 
select the required settings under Fraction Collection. 

 

Program Wizard 
The Program Wizard assists you in creating a Program for fraction 
collection control: 
• On the Fraction Collection - General Options page, determine the 

fraction collection period (see  PGM Wizard: Fraction Collection - 
General Options). 

• On the Fraction Collection Options page, define the fraction 
collection control parameters (see  Setting the Fraction Collection 
Options). 

• On the Fraction Collection - Channel Selection Options page, 
determine the channel(s) for peak recognition during fraction collection 
(see  Selecting the Channel for Fraction Collection (Channel 
Selection Options)). 

• On the Peak Detection Options page, specify the peak detection 
algorithm for fraction collection (see  Detecting the Peak Start, 
Peak Maximum, and Peak End (Peak Detection Options)).  
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Standard Program Example 

If you have not yet saved a FractionCollectionTemplate.pgm, the PGM 
Wizard creates the following standard program. (The program includes the 
default fraction collection commands for a single detection channel plus the 
standard commands.)  
 
 ;************************************************************** 
 ;* Definition of triggers for fraction collection starts here. 
 ;************************************************************** 
 ; Definitions copied from template <Timebase> 

\FractionCollectionTemplate! 
 Trigger FracStart FracStartDetected 
 EndTrigger 
 Trigger TubeChange FracTubeChange 
 EndTrigger 
 Trigger FracEnd FracEndDetected 
 EndTrigger 
 ;************************************************************** 
 ;* Definition of triggers for fraction collection ends here. 
 ;************************************************************** 
 PumpDevice =  "Pump" 
 TubeMaxVolume =  Unlimited 
 FractionCollection.TotalNumberInstalled =  Unlimited 
 MaxTubesPerFraction =  Unlimited 
 TubeWrapping =  No 
 TubeChangeDuration 2.0 
 DelayTime =  0.0 
 OffsetTime =  0.0 
 DetectionChannel1.Name =  "UV_VIS_1" 
 PeakStartSlope =  0.500 
 PeakStartTrueTime =  1.00 
 PeakStartThreshold =  10.00 
 PeakStartCurve Off 
 PeakMaxSlope =  0.000 
 PeakMaxTrueTime 1.00 
 PeakEndSlope =  -1.000 
 PeakEndThreshold =  10.00 
 PeakEndCurve Off 
 PeakEndTrueTime 1.000 
 ThresholdNoPeakEnd =  2000.000 
 BaselineOffset =  0.000 
 BaselineDrift =  0.000 
 Flow = 1.00 
 %B = 0.0 
 %C = 0.0 
 %D = 0.0 
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 0.000 Autozero 
 Wait Frac.Ready and Sampler.Ready 
 Inject 
 3DFIELD.AcqOn 
 UV_VIS_1.AcqOn 
 CollectFractions = By_Peak 
 CollectOutsidePeaks = No 
 
10.000 3DFIELD.AcqOff 
 UV_VIS_1.AcqOff 
 
10.100 End  
 

 Note: 
To make sure that the fractions are collected exactly, you have to enter 
and/or consider the actual delay time or the actual delay volume. 

For more complex program examples, refer to:  

 Program Example (One Detection Channel)  

 Program Example (Two Detection Channels) 

 Fraction Collection Control via an MS.  

For an overview of the fraction collection topics, refer to How to …: 
 Collecting Fractions. 
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 Enabling Fraction Collection (General Options) 
On the General Options page of the Program Wizard or PGM Editor, 
determine whether peaks are to be collected depending on peak detection 
or set the time range for fraction collection. (The Control Program section 
provides more information about the  Program Wizard and  PGM 
Editor.) 

 

When you click Next>, more fraction collection wizard pages are displayed. 
The settings selected on this page determine which pages are displayed 
and which program commands are generated:  
 

Off (do not collect at all) 
Select this option to disable fraction collection. When this option is selected, 
no other fraction collection wizard pages are displayed. The program 
includes the following command: 
 

CollectFractions = No 
 

Collect by peak 
Select this option to collect fractions depending on peak detector. The 
program includes the following fraction collection triggers: 
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;******************************************************************* 
;* Definition of triggers for fraction collection starts here. 
;******************************************************************* 
; Definitions copied from <Timebase>\FractionCollectionTemplate! 
Trigger FracStart FracStartDetected 
EndTrigger 
Trigger TubeChange FracTubeChange 
EndTrigger 
Trigger FracEnd FracEndDetected 
EndTrigger 
;******************************************************************* 
;* Definition of triggers for fraction collection ends here. 
;******************************************************************* 

(…) 
CollectFractions = By Peak 
CollectOutsidePeaks = No ;(or Yes - see Note below) 

 

 Note: 
It is also possible to collect fractions outside peaks (CollectOutsidePeaks = 
Yes). To do so, select the Collect outside peaks check box.  
 

Collect by time 
Select this option to collect fractions independent of peak detection. The program includes the 
following command:  

CollectFractions = By_Time 
 
With this option, use the Collection Period input field to specify the time in 
[s] after which a new tube shall be used. The default setting is 30[s]. The 
program includes the following command: 
 

CollectPeriod =  30 [s] 
 

Collect all the time 
Select this option to collect fractions during the entire chromatogram. 
 

Collect only from ... to ... 
Select this option to collect fractions only during a specified period. For 
example, if the time ranges from 2.000 to 8.000 min and if peak-dependent 
fraction collection is selected, the program includes the following 
commands: 
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;******************************************************************* 
;* Definition of triggers for fraction collection starts here. 
;******************************************************************* 
; Definitions copied from <Timebase>\FractionCollectionTemplate! 
Trigger FracStart FracStartDetected 
EndTrigger 
Trigger TubeChange FracTubeChange 
EndTrigger 
Trigger FracEnd FracEndDetected 
EndTrigger 
;******************************************************************** 
;* Definition of triggers for fraction collection ends here. 
;******************************************************************* 

 

2.000 CollectFractions =  By_Peak 
 CollectOutsidePeaks =  Yes ;(oder No - see Note) 
 
8.000 CollectFractions =  No 
 

 Note: 
It is also possible to collect fractions outside peaks (CollectOutsidePeaks = 
Yes). To do so, select the Collect outside peaks check box.  

Restricted time range & user-defined columns 
You can use User-defined Columns in the sample list to define when 
fraction collection starts and stops: 
• Create two user-defined columns (see How to …: Creating and 

Managing Files and Data  Creating User-defined Columns) in the 
Standard Datasource of the server.  

• Name the two columns, e.g., FractionStart and FractionEnd: 
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• Restart the server. 

• On the General Options page, select Collect only from ... to. In the 
from field, select the user-defined column FractionStart; in the to field, 
select FractionEnd. The following triggers are generated (if peak-
dependent fraction collection is enabled):  

 Trigger FractCollectionOn System.Retention >  
Sample.FractionStart,True=0.0,Hysteresis=0.0 

 CollectFraction = By Peak 
 CollectOutsidePeaks = Yes 
 EndTrigger 
 
 Trigger FractCollectionOff System.Retention >  

Sample.FractionEnd,True=0.0,Hysteresis=0.0 
 CollectFraction = No 
 EndTrigger 
 
This program starts fraction collection at the retention time entered in the 
*FractionStart column for the corresponding sample. Fraction collection is 
stopped at the retention time from the *FractionEnd column. 

For an overview of the fraction collection topics, refer to How to …: 
 Collecting Fractions. 
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 Setting the Fraction Collection Options (Collection 
Device Options) 
On the Collection Device Options page of the Program Wizard or PGM 
Editor, determine the most important parameters for fraction collection. 
(The Control Program section provides more information about the 

 Program Wizard and  PGM Editor.)  

 

Pump device: Select the name under which the pump is identified in the installation 
environment (see Server Configuration program). It is usually not 
necessary to change the default. 

  Note: This entry defines the pump and thus, the pump flow for 
which the time required to fill the tubes is calculated. 

  
Max. tube volume: Enter the maximum tube volume. The allowed range is 0.000000 to 

1000.000000 ml or unlimited. 
  
Max number of 
tubes per fraction: 

Enter the maximum number of tubes per fraction. The allowed range is 
0 to 99 or unlimited. 

  
Total number of 
tubes: 

Enter the total number of fractions. The allowed range is 0 to 9999. 
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Minimum time for 
tube change: 

Enter the time that the tube change must take at least. The allowed 
range is 1.0 to 100.0 s. 

  
After last tube, 
return to first 

Select this check box to return to the first tube after the last tube is 
filled. If this check box is cleared, the Batch will be aborted when the 
last tube is reached. 

 Tip: If this box is checked, be sure to replace the filled tubes 
with empty ones before the last tube is reached. This is to 
prevent the next fractions from being collected in tubes 
already used. 

  
  
Delay Under Delay, enter the ⇒Delay Time or the Delay Volume between the 

detector and the Fraction Collector. The delay time is the time that a 
substance needs to travel from the detector cell of the first detector to 
the switching valve or to the tube, depending on the device type. The 
delay volume is the volume between the output of the detector cell of 
the first detector and the switching valve or to the tube, depending on 
the device type. (If you have any questions, please contact the device 
manufacturer.) 

 Tip: The prerequisite for entering the Delay Time is that the 
flow is constant. If the flow rate changes, the actual delay 
time between the detector and the fraction collector would 
change during the run, which is not supported by the 
system. If you find it easier to determine the Delay Volume 
rather than the Delay Time, enter the Delay Volume 
instead and let the system use the (constant) Flow to 
calculate the appropriate Delay Time. 

 Note: If you use several detectors, this delay time entry always 
refers to the first detector after the column. 

 
For an overview of the fraction collection topics, refer to How to …: 

 Collecting Fractions. 
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 Selecting the Channel for Fraction Collection (Channel 
Selection Options) 
On the Channel Selection Options page of the Program Wizard or PGM 
Editor, select the channel(s) for fraction collection. (The Control Program 
section provides more information about the  Program Wizard and 

 PGM Editor.) 

 

Select one or more channels to evaluate for fraction collection. Also, select 
one of the following options: 
 
Option Description 
All selected 
channels 

(Default) The system starts fraction collection when a peak start is 
detected in all detection channels.  
The system stops fraction collection when the end of the first peak is 
detected. 

 Note: The program includes the following command: 

ChannelEvaluation = All. 
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At least one of 
the selected 
channels 

The system starts fraction collection when a peak start is detected in at 
least one detection channel.  
The system stops fraction collection when the end of the last peak is 
detected. 

 Note: 

The program includes the following command: 
ChannelEvaluation = Any. 

 
For an overview of the fraction collection topics, refer to How to …: 

 Collecting Fractions. 

 Detecting the Peak Start, Peak Maximum, and Peak End 
(Peak Detection Options) 
To ensure that the Fraction Collector fills the desired tube, the peak start, 
peak maximum, and peak end all must be correctly detected. Select the 
necessary settings on the Peak Detection Options page of the Program 
Wizard or PGM Editor, select the channel(s) for fraction collection. (The 
Control Program section provides more information about the 

 Program Wizard and  PGM Editor.) 
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Peak Start 
The prerequisites for detecting the peak start (and hence, the beginning of 
a fraction) are as follows: 
• No peak start has been detected so far.  

• Fraction collection and peak detection are enabled via the 
CollectFractions = ByPeak. 

• The signal of the detection channel is greater than the signal defined by 
PeakStartThreshold. 

• The signal slope is greater than the slope defined by PeakStartSlope. 

• Data acquisition on the selected channel is not yet completed.  

• The run itself is not completed yet  

• The conditions are fulfilled for the PeakStartTrueTime. (The default 
setting is 1.00 s. The allowed range is 0.00 to 4.00 s.) 

The PeakStartThreshold and PeakStartSlope variables influence the 
peak detection sensitivity.  

The PeakStartSlope variable can be changed within broad limits. The 
higher the value is, the later the peak start is detected. If the detector signal 
exceeds the PeakStartThreshold, the peak is detected only if the slope 
threshold value is also exceeded. 

Chromeleon remembers a peak start so that a peak maximum can be 
detected next. Thus, a peak maximum can be detected only if a peak start 
has been detected before. 

Peak Maximum 
The peak maximum is detected only if 
• A peak start has been detected before. 

• No peak maximum has been detected yet. 

• The signal slope is smaller than the signal slope defined by 
PeakMaxSlope. 

• The conditions are fulfilled for the time specified by 
PeakMaxTrueTime. (The default setting is 1.00 s. The allowed range 
is 0.00 to 4.00 s.) 
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A peak maximum can be detected only if a peak start has been detected 
before. Thus, if no peak start has been detected, no maximum will be 
detected either. The PeakMaxSlope variable is defined as negative slope 
value as it applies to the tailing side of the peak. The closer the value is to 
zero, the closer to the peak maximum the PeakMaxRecognition ⇒Trigger 
will be executed. 

Chromeleon remembers a peak maximum so that a peak end can be 
detected next. Thus, a peak end can be detected only if a peak maximum 
has been detected before (unless one of the end-run conditions apply). 

Peak End  
A peak end (and hence the end of a fraction) is detected if: 
• The signal slope is less than the signal slope defined by 

PeakEndSlope and  

• The signal of the detection channel is less than the signal defined by 
TresholdNoPeakEnd and  

• A peak maximum has been detected before. 

OR: 
• The signal of the detection channel is less than the signal defined by 

PeakEndThreshold and  

• A peak maximum has been detected before. 

OR: 
• A peak start has been detected before and  

• Data acquisition on the signal channel has been finished 

AND: 
• The conditions are fulfilled for the PeakEndTrueTime. (The default 

setting is 1.00 s. The allowed range is 0.00 to 4.00 s.) 

The first group of conditions checks whether the signal is below a limit, 
which is defined by the ThresholdNoPeakEnd variable. With heavily 
overloaded detector signals, there is a lot of signal noise, so a peak end 
and/or start would be detected several times near the top of the peak. The 
top of the peak could also be formed like a plateau. To inhibit this, set the 
ThresholdNoPeakEnd variable to a value below this level. If the value is 
set to Off, this part of the condition will always be true and this check will be 
disabled. PeakEndSlope delays the peak end. 
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The second group of conditions uses the signal height criterion. If the signal 
value falls below PeakEndThreshold, the peak is completed. 

The third group of conditions completes the current peak in case the data 
acquisition is disabled. 

For more information, refer to:  

 Entering More Peak Detection Parameters (Peak Detection 
Options) 

 Defining the Reactions to Certain Events 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 

 Entering More Peak Detection Parameters (Peak 
Detection Options) 

Use the PGM Wizard (see The Control Program  The Program 
Wizard) to enter the basic peak detection parameters as described in 

 Detecting the Peak Start, Peak Maximum, and Peak End (Peak 
Detection Options). In addition, you can enter special parameters on the 
Peak Detection Options page. 

Derivative Step 
Use this parameter to determine for which period the signal values are 
evaluated to determine the slope and curve of the signal. The slope and 
curve are determined at the associated retention time t for the range (t - 
DerivStep/2) to (t + DerivStep/2). You can have Chromeleon display the 
retention time on the control panel via the RetentionTime variable (see 

 Checking the Fraction Collection Status on the Control Panel). 
(Dimension: s; range: 0.02 to 60.00) 

 Note: 
The higher the DerivStep value is, the lower the noise for the Slope and 
the Curve. 
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PeakStartTrueTime, PeakMaxTrueTime, and PeakEndTrueTime  
Use these parameters to set the time in seconds for which the different 
conditions must be fulfilled. If the conditions are not fulfilled within this time 
period, the peak start, peak maximum, and peak end cannot be detected. 

(Dimension: s; range: 0.0 to 4.0) 

 Notes:  
If you perform smoothing when using a mass spectrometer, calculating a 
signal value for a channel may take up to 5 seconds. If you do not allow for 
this time before the peaks reach the fraction collector, peaks cannot be 
collected. Therefore, set the respective parameter to at least 5 seconds. 

In addition, a peak can be detected only after the DerivStep and 
PeakStartTrueTime (or PeakEndTrueTime) have expired. To make sure 
that a peak is completely collected as a fraction on an MS detection 
channel, the following must apply: 

5 + PeakStartTrueTime (or PeakEndTrueTime) + DerivStep < DelayTime. 

(The ⇒Delay Time is the time between the detector (here: an MS) and the 
Fraction Collector. If necessary, install a longer loop before the fraction 

collector.) 
 

Shoulder detection 
Use the PeakStartCurve and PeakEndCurve parameters to determine the 
curve in [Signal]/s^2 that must be exceeded so that a shoulder is detected 
after the peak start (PeakStartCurve). If the value is below this value, a 
shoulder can be detected after the peak maximum (PeakEndCurve). 

(Dimension: [Signal]/s^2; range: 0 to 10^10; default setting: Off) 

 Tip: 
Chromeleon supports these parameters only for the Purification license. 
 

Threshold for PeakEndSlope enabling and disabling 
Use the ThresholdDoNotResolve parameter to disable peak end 
detection via the PeakEndSlope parameter. Determine the threshold 
above which PeakEndSlope is disabled. 

(Dimension: [Signal]/s; range: -10^10 to 10^10; default setting: Off) 



660 Collecting Fractions 

If the minimum between these peaks is above the threshold value, a peak 
end is not detected before. Instead, a new peak is detected and a tube 
change is triggered when the signal slope is 0.0. The advantage is that the 
fraction for the first peak is collected until the minimum; the fraction for the 
second peak is then collected from the minimum. 

 

In the picture, the red horizontal line indicates the threshold value. The solid 
lines indicate the fractions for which the minimum between the peaks is 
above the threshold value. 

If the minimum is below the threshold value, a peak end is detected before 
the minimum (via the PeakEndSlope parameter; red descending line). 
Thus, the first fraction is collected only until the first dotted line. Then, a 
peak start is detected (red ascending line), so that the second peak is 
collected only from the second dotted line. 

The area between these two lines contains a compound of the two 
substances. This area is collected as a separate fraction only if the program 
contains the following line: 

CollectOutsidePeaks =  Yes 

Peak starts and peak ends that occur underneath the 
ThresholdDoNotResolveLine are detected as usual (indicated in the picture 
by the green diagonal lines). 
 

Drift compensation 
In the Baseline Drift field, enter the baseline drift that is used to correct the 
signal value. Enter the related baseline offset in [Signal] in the Baseline 
Offset field. The related thresholds (Peak Start Threshold, Peak End 
Threshold, and Threshold No Peak End) are compared to the signal value: 

Signal value - (BaselineOffset + ∆t*BaselineDrift) 

Whenever Baseline Drift changes, ∆t is set to 0. In addition, Baseline Offset 
is set to the current value of the correction term. Thus, the BaselineDrift 
value always matches the actual drift.  
 
For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 
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 Determining the Delay Time (Delay and Detector 
Offsets) 
On the Delay and Detector Offsets page of the Program Wizard or PGM 
Editor, enter the delay time or delay volume between the detector and the 
fraction collector. (The Control Program section provides more information 
about the  Program Wizard and  PGM Editor.) 

 

Delay Enter the ⇒Delay Time or the Delay Volume between the detector and 
the Fraction Collector. The delay time is the time that a substance 
needs to travel from the detector cell of the first detector to the 
switching valve or tube. The delay volume is the volume between the 
detector cell and the switching valve or tube, respective. (The delay 
time and/or volume depend on the device type. Contact the device 
manufacturer for more information.) 

 Tip: The prerequisite for entering the Delay Time is that the 
flow is constant. If the flow rate changes, the actual delay 
time between the detector and the fraction collector would 
change during the run, which is not supported by the 
system. If you find it easier to determine the Delay Volume 
rather than the Delay Time, enter the Delay Volume 
instead and let the system use the (constant) Flow to 
calculate the appropriate Delay Time. 

 Note: If you use several detectors, this entry always refers to the 
first detector after the column. 
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If the system includes several detectors (in the example above, MS and 
UV), the Detector Delay Offsets section appears. Enter the delay time 
between the first detector after the column and any other detector(s) in the 
Delay Time Offset column. Keep the following in mind: 

 Tips: 
If no channel has been selected for a certain detector in the channel 
selection field on the Channel Selection Options page, you cannot enter a 
delay time for this detector. 

It is not possible to enter a delay time exceeding the time between the first 
detector and the Fraction Collector (also, see  Setting the Fraction 
Collection Options). 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 

 Editing Signal-Dependent Fraction Collection 
Parameters 
After you have created a basic program with the PGM Wizard, you can later 
edit this program in the PGM Editor as described in  Creating and 
Modifying PGM Files. 

Independently of the installed Fraction Collector, the Fraction Collection 
driver supports several PGM Wizard parameters. These parameters, which 
are described in the tables below, allow you to start fraction collection in the 

PGM File (or on the Control Panel).  

Press the F8 key to open the Commands dialog box, and then enter the 
desired parameters in the PGM Editor. You can also establish controls with 
the desired functionality on the control panel. (For more information, refer to 
How to …: Controlling Devices from the Control Panel  Modifying a 
Control Panel.) 
The tables below list the parameters in the Commands dialog box for the 
associated DetectionChannel. (For information about the read-only 
parameters, refer to  Checking the Fraction Collection Status on the 
Control Panel.) 
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Signal-Based Parameters (Min., Max., and Default depend on the 
detector; here, they are shown for a UV detector) 
 
Parameter Min. Max. Description 
BaselineDrift ² -1e10 1e10 Baseline drift in [Signal]/s used to correct 

the signal value. The specified thresholds 
(PeakStartThreshold, PeakEndThreshold, 
and ThresholdNoPeakEnd) are compared 
to: 
signal value - (BaselineOffset + 
∆t*BaselineDrift) 
∆t is set to 0 whenever BaselineDrift 
changes.  
Baseline Offset is then set to the current 
value of the correction term. Thus, the 
BaselineDrift value always matches the 
actual drift.  

BaselineOffset ² -1e10 1e10 Baseline offset in [Signal] used to correct 
the signal value. 

DerivStep 0.02 s 60.00 s Time for which the signal values are 
evaluated to determine the signal slope 
and the curve.  

Name N/a n/a Name of the signal channel used for peak 
detection (this may be a Virtual Signal, 
also). 

OffsetTime 0.0 s 9999.9 s Retention time offsets between the first 
detector and other detectors. 

 Tip: 

Make sure the retention time setting for 
this command is later than the DelayTime 
(see below). 

OffsetVolume 0.0 µl 5000.0 µl Offset volume between the first detector 
and other detectors. (Based on the flow, 
the offset volume is converted into the 
corresponding OffsetTime.) 

PeakEndCurve * 0 10^10 Curve in [Signal]/s^2 that must be 
exceeded for a shoulder to be recognized 
after the peak maximum. 

PeakEndSlope * ² -1e10 0.000 The slope value in [Signal]/s must exceed 
the PeakEndSlope value for the peak end 
to be recognized. 

PeakEndThreshold * ² -1e10 1e10 The actual signal value in [Signal] must 
be below the PeakEndThreshold value for 
the peak end to be recognized. 
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Parameter Min. Max. Description 
PeakEndTrueTime * 0.0 s 4.0 s The time must be fulfilled for the different 

conditions for a peak end to be 
recognized. 

PeakMaxSlope * ² -1e10 0 The actual slope value in [Singal]/s must 
be below the PeakMaxSlope value for the 
peak maximum to be recognized. 

PeakMaxTrueTime * 0.0 s 4.0 s The time must be fulfilled for the different 
conditions for a peak maximum to be 
recognized. 

PeakStartCurve * 0 10^10 Curve in [Signal]/s^2 that must be 
exceeded for a shoulder to be recognized 
after the peak start.  

PeakStartSlope * ² 0.000 1e10 The actual slope value in [Signal]/s must 
exceed the PeakStartSlope value for the 
peak start to be recognized. 

PeakStartThreshold * ² -1e10 1e10 The actual signal value in [Signal]/s must 
exceed the PeakStartThreshold value for 
the peak start to be recognized. 

PeakStartTrueTime * 0.0 s 4.0 s The time must be fulfilled for the different 
conditions for a peak start to be 
recognized. 

ThresholdDoNot 
Resolve * 

-10^10 10^10 Threshold value for the slope in [Signal]/s 
above which peak detection via the 
PeakEndSlope parameter is disabled. 
Instead, a new peak is detected and a 
tube change is triggered when the signal 
slope is 0.0.  

ThresholdNoPeak 
End * ² 

-1e10 1e10 The actual signal threshold value in 
[Signal] must be below the 
ThresholdNoPeakEnd value for the peak 
end to be recognized. (This parameter 
supports the PeakEndSlope parameter 
for peak detection.)  

 Tips: 
* To ignore the parameter for peak detection, set the parameter to Off. 
² Set these parameters on the Peak Detection Options page in the PGM 
Wizard. 
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Commands 
In addition, you can enter the following commands manually for a specified 
retention time: 
 
Command Description 
ManualPeakEnd Stops the current peak at the specified retention time, independently 

of the peak detection parameters. 
ManualPeakStart Starts the next peak at the specified retention time, independently of 

the peak detection parameters. 
ManualTubeChange Changes to the next tube at the specified retention time, 

independently of the peak detection parameters.  
For the signal-independent parameters, refer to  Editing Signal-
Independent Fraction Collection Parameters. 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 

 Editing Signal-Independent Fraction Collection 
Parameters 
After you have created a basic program with the PGM Wizard, you can later 
edit this program in the PGM Editor as described in  Creating and 
Modifying PGM Files. 

The following signal-independent parameters are listed in the Commands 
dialog box under Fraction Collection. (To open the Commands dialog box, 
press the F8 key in the PGM Editor.) 
 
Parameter Min. Max. Description 
ChannelEvaluation All Any Determines how the results of the 

single detection channels are used for 
peak detection. 

CollectFractions No By_Peak Performs fraction collection based on 
peak detection. 
Note: Detected fractions will trigger 
related events after the delay time, 
even if CollectFractions is No at that 
time. 

  By_Time Performs fraction collection 
independent of peak detection. 

CollectOutsidePeaks No Yes Determines whether fractions are 
collected outside peaks, also. 
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Parameter Min. Max. Description 
DelayTime 0.0 s 9999.9 s Delay time between the first detector 

and the Fraction Collector. 
DelayVolume 0.0 µl 5000.0 µl Delay volume between the first detector 

and the fraction collector. (Based on the 
flow, the delay volume is converted into 
the corresponding DelayTime.) 

MaxTubesPerFraction 0 999 Maximum number of tubes per fraction. 
If the specified number is reached, no 
additional tubes are used to collect the 
current peak. Set this parameter to 
Unlimited to collect all peaks 
completely. 

PumpDevice   Pump whose flow is used to convert 
between time and volume. 

TotalNumberInstalled 0 9999 Number of tubes installed in the rack. If 
this number is exceeded, the 
TubePosition parameter is reset to 1 if 
the TubeWrapping option has been 
selected. Otherwise, the batch is 
terminated. 

 Tip: 
A warning appears in the Audit Trail 
when the TubePosition parameter is 
reset to 1. 

TubeChangeDuration 1.0 100.0 Time in seconds until the next fraction 
can be collected. 

 Tip: 
This property is especially useful if 
several channels are used for peak 
detection. If one peak is detected in one 
channel a little later than in another 
channel, a new fraction is usually 
started. Set the TubeChangeDuration 
parameter to prevent this. 

TubeMaxVolume 0.000000 1000.000000 Maximum filling volume of the tube in 
[ml]. If the specified volume is reached, 
the next tube is filled. 

 Tip: 
Set the TubeMaxVolume parameter to 
Unlimited to prevent the next tube from 
being filled automatically. 

TubePosition 1 9999 Position of the tube in the current 
fraction. 
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Parameter Min. Max. Description 
TubeWrapping No Yes If this option is selected, the 

TubePosition parameter is reset to 1 
when TotalNumberInstalled is reached.   

 Tips: 
You can set the following properties in the PGM Wizard, also: 

Set CollectFractions and CollectOutsidePeaks on the General Options 
page. 

Set DelayTime to TubeWrapping on the Peak Detection Options page, 

Set ChannelEvaluation on the Channel Selection page. 

These properties cannot be changed during a peak. Any attempted change 
will produce the following warning: "Parameters cannot be changed until 
the current peak has ended. New value will be assigned at peak end." The 
change will become effective as soon as the current peak ends.  

 Tip: 
When performing Autopurification, you can correct the parameters set in 
the PGM File for all other samples in the sequence on the control panel. 
Use the corresponding parameters of the 
Dionex_Purification_Parameters device driver (see Collecting Fractions 
Automatically (Autopurification)  Setting Correction Parameters). 

For the signal-dependent parameters, refer to  Editing Signal-
dependent Fraction Collection Parameters. 

In addition to these parameters, various read-only variables are available. 
These variables are only displayed if you open the Commands dialog box 
on a control panel. They allow you to check the peak detection status (see 

 Checking the Fraction Collection Status on the Control Panel). 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 
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 Defining the Reactions to Certain Events 
A peak start, peak maximum, and peak end are recognized if certain 
conditions are fulfilled (see  Recognizing Peak Start, Peak Maximum, 
and Peak End).  

If one of these events occurs, Chromeleon issues certain commands to the 
Fraction Collector. These commands can be defined in the Program. In 

the respective ⇒Trigger block, you can define device-specific actions for 
your Sample and Fraction Manager or fraction collector. 
 
Event Condition Action 
FracStartDetected A peak start, which means 

the start of a new fraction, 
"arrives" at the switching 
valve/ tube.  

 Note: 

If, during a peak, a peak start 
is detected on another 
channel, a new fraction is 
also started for 
ChannelEvaluation = Any. 

Switch to next fraction.* 
Switch to collect.  

FracTubeChange The tube is filled to the limit. Switch to next tube. 
FracEndDetected A peak end, which means the 

end of a fraction, "arrives" at 
the switching valve/ tube. 

Switch to waste. 
Switch to next fraction.* 

 
* Switching to the next fraction is needed only once. It depends on the 

type of hardware whether this is better to switch to the first tube of the 
next fraction at the peak start or at the peak end. 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 
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 Program Example (One Detection Channel) 
A Program for a timebase including a Fraction Collector and one 
detection channel might look as follows:  
 
-0.300 Flow = 20.000 
 %B = 10 
 UV_VIS_1.Step = 0.50 
 UV_VIS_1.Average =  On 
 UV_VIS_1.MaxAutoStep = 1.0 
 Pressure.LowerLimit = 10.00 
 Pressure.UpperLimit = 200.00 
 
 
;******************************************************************** 
;*Definition of triggers for fraction collection starts here 
;******************************************************************** 
; Definition copied from template 
<Timebase>\FractionCollectionTemplate! 
;FracStart: Start of fractionation collection 
 Trigger FracStart  FracStartDetected 
 Collect 
 Log SFM_A.Tray 
 EndTrigger 
 
;TubeChange: The fraction is collected to another tube when the 
current tube is full 
 Trigger TubeChange FracTubeChange 
 Drain 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 Collect 
 EndTrigger 
 
;FracEnd: End of fraction collection 
 Trigger FracEnd FracEndDetected 
 MovementMode = InterruptAndEject 
 Drain 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 EndTrigger 
;******************************************************************** 
;*Definition of triggers for fraction collection ends here 
;******************************************************************** 
 
; Maximum filling volume of a tube in ml: 
 PumpDevice = "Pump" 
 TubeMaxVolume = 10 
 
; Maximum number of installed fraction tubes: 
 FractionCollection.TotalNumberInstalled = 1092 
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; Basic fraction collection parameters: 
 MaxTubesPerFraction =  Unlimited 
 TubeWrapping = No 
 
; Delay time between detector output and switching valve or tube: 
 DelayTime = 0.4 
 OffsetTime = 0.0 
 TubeChangeDuration =  2.0 [s] 
 ChannelEvaluation =  All 
 
; Conditions for online peak recognition at program start: 
 Name = "UV_VIS_1" 
 ;Slope at peak start: 
 PeakStartSlope = 2.000 
 ;Minimum signal height at peak start: 
 PeakStartThreshold = 10.00 
 ;Slope after the peak maximum: 
 PeakMaxSlope = -4.000 
 ;Slope at peak end: 
 PeakEndSlope = -4.000 
 ;Maximum signal height at peak end: 
 PeakEndThreshold = 5.00 
 ;Signal must be less than this threshold value 
 ;before a new peak start can be recognized:  
 ThresholdNoPeakEnd = 200 
 ;Baseline drift correction: 
 BaselineOffset = 0.000 
 BaselineDrift = 0.000 
 
; Separation start with injection:  
-0.100 UV.Autozero 
0.000 Wait Sampler.Ready 
 Flow = 20.000 
 %B = 10 
 Sampler.Inject 
 UV_VIS_1.AcqOn 
 
; Basic fraction collection parameters: 
 CollectFractions =  By_Peak 
 
; Gradient program: 
 Flow = 20.000 
 %B = 10.0 
10.000 %B = 90 
13.000 %B = 90 
 
13.000 UV_VIS_1.AcqOff 
 CollectFractions =  No 
 
; Regeneration and equilibration phase of the gradient program: 
15.000 Flow = 20.000 
 %B = 90 
 
16.000 %B = 10 
 End 
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 Note: 
The trigger block used in this program example refers to a preparative 
application with a Dionex Sample and Fraction Manager (SMF). Besides, 
the trigger block is intended for a preparative pump. 
 
For more program examples, refer to: 

 Program Example (Two Detection Channels)  

 Fraction Collection Control via an MS 

 Fraction Collection Control via an MS for Different Samples 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 

 Program Example (Two Detection Channels) 

 Tip: 
If the Fraction license is installed, Chromeleon supports two detection 
channels. You need the Purification license if you want to use more than 
two detection channels. 

A Program for a timebase including a Fraction Collector and two 
detection channels might look as follows:  
 
-0.300 Flow = 20.000 
 %B = 10 
 UV_VIS_1.Step = 0.50 
 UV_VIS_1.Average =  On 
 UV_VIS_1.MaxAutoStep = 1.0 
 Pressure.LowerLimit = 10.00 
 Pressure.UpperLimit = 200.00 
 
 
;******************************************************************** 
;*Definition of triggers for fraction collection starts here 
;******************************************************************** 
;Definition copied from template 
<Timebase>\FractionCollectionTemplate! 
;FracStart: Start of fraction collection 
 Trigger FracStart  FracStartDetected 
 Collect 
 Log SFM_A.Tray 
 EndTrigger 
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;TubeChange: The fraction is collected to another tube when the 
current tube is full 
 Trigger TubeChange FracTubeChange 
 Drain 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 Collect 
 EndTrigger 
 
;FracEnd: End of fraction collection 
 Trigger FracEnd FracEndDetected 
 MovementMode = InterruptAndEject 
 Drain 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 EndTrigger 
;******************************************************************** 
;*Definition of triggers for fraction collection ends here 
;******************************************************************** 
 
; Maximum filling volume of a tube in ml: 
 PumpDevice = "Pump" 
 TubeMaxVolume = 10 
 
; Maximum number of installed tubes: 
 FractionCollection.TotalNumberInstalled = 1092 
 
; Basic fraction collection parameters: 
 MaxTubesPerFraction =  Unlimited 
 TubeWrapping = No 
 TubeChangeDuration =  2.0 [s] 
 ChannelEvaluation =  All 
 
; Delay time between detector output and switching valve or tube: 
 DelayTime = 0.8 
 DetectionChannel2.OffsetTime = 0.0 
 DetectionChannel3.OffsetTime = 0.0 
 
; Conditions for online peak recognition at program start: 
 DetectionChannel2.Name = "UV_VIS_1" 
 ;Slope at peak start: 
 DetectionChannel2.PeakStartSlope = 2.000 
 ;Minimum signal height at peak start: 
 DetectionChannel2.PeakStartThreshold = 10.00 
 ;Slope after peak maximum: 
 DetectionChannel2.PeakMaxSlope = -4.000 
 ;Slope at peak end: 
 DetectionChannel2.PeakEndSlope = -4.000 
 ;Maximum signal height at peak end: 
 DetectionChannel2.PeakEndThreshold = 5.00 
 ;Signal must be less than this threshold value 
 ;before a new peak start can be recognized 
 DetectionChannel2.ThresholdNoPeakEnd = 200 
 ;Baseline drift correction: 
 DetectionChannel2.BaselineOffset = 0.000 
 DetectionChannel2.BaselineDrift = 0.000 
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; Conditions for online peak recognition for the 2. detection 
channel: 
 DetectionChannel3.Name = "UV_VIS_2" 
 DetectionChannel3.PeakStartSlope = 2.000 
 DetectionChannel3.PeakStartThreshold = 10.00 
 DetectionChannel3.PeakMaxSlope = -5.000 
 DetectionChannel3.PeakEndSlope = -4.000 
 DetectionChannel3.PeakEndThreshold = 5.00 
 DetectionChannel3.ThresholdNoPeakEnd = 200 
 DetectionChannel3.BaselineOffset = 0.000 
 DetectionChannel3.BaselineDrift = 0.000 
 
; Separation start with injection: 
-0.100 UV.Autozero 
0.000 Wait Ready 
 Flow = 20.000 
 %B = 10 
 Sampler.Inject 
 UV_VIS_1.AcqOn 
 
; Basic fraction collection parameters: 
 CollectFractions =  By_Peak 
 
; Gradient Program: 
 Flow = 20.000 
 %B = 10.0 
10.000 %B = 90 
13.000 %B = 90 
 
13.000 UV_VIS_1.AcqOff 
 CollectFractions =  No 
 
; Regeneration and equilibration phase of the gradient program: 
15.000 Flow = 20.000 
 %B = 90 
 
16.000 %B = 10 
 End 

 

 Notes: 
The trigger block used in this program example refers to a preparative 
application with a Dionex Sample and Fraction Manager (SFM). Besides, 
the trigger block is intended for a preparative pump. 

In the example, DetectionChannel1 has not been used as the first detection 
channel because '1' and 'I' look almost identical when Courier is the 
selected font.  
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For more program examples, refer to: 

 Program Example (One Detection Channel)  

 Fraction Collection Control via an MS 

 Fraction Collection Control via an MS for Different Samples 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 

 Fraction Collection Control via an MS 
Mass Traces can be used to selectively collect certain substances in 

fractions. This selective collection is possible since the occurrence of peaks 
with data acquisition via Mass Spectrometers depends much more 
selectively on the corresponding masses than it depends on the 
wavelength with UV Detectors. 

It is possible to use certain mass traces at specific times to trigger the 
fraction collection. For this purpose, online extraction of mass traces is 
required (see How to …: Using Mass Spectrometers  Extracting 
Mass Traces Online). The following program requires five channels for 
online extraction of mass traces: 
 
; Definition of the minimum/maximum mass and of the filter index for 
the channels MS_01 to MS_05: 
 MS_01.MinMass = 243.5 
 MS_01.MaxMass = 244.5 
 MS_01.FilterIndex = 2 
 
 MS_02.MinMass = 145.5 
 MS_02.MaxMass = 146.5 
 MS_02.FilterIndex = 2 
 
 MS_03.MinMass = 164.5 
 MS_03.MaxMass = 165.5 
 MS_03.FilterIndex = 2 
 
 MS_04.MinMass = 178.5 
 MS_04.MaxMass = 179.5 
 MS_04.FilterIndex = 2 
 
 MS_05.MinMass = 192.5 
 MS_05.MaxMass = 193.5 
 MS_05.FilterIndex = 2 
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;******************************************************************** 
;*Definition of triggers for fraction collection starts here 
;******************************************************************** 
;Definition copied from template 
<Timebase>\FractionCollectionTemplate! 
;FracStart: Start of fraction collection 
 Trigger FracStart  FracStartDetected 
 Collect 
 Log SFM_A.Tray 
 EndTrigger 
 
;TubeChange: The fraction is collected to another tube when the 
current tube is full 
 Trigger TubeChange FracTubeChange 
 Drain 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 Collect 
 EndTrigger 
 
;FracEnd: End of fraction collection 
 Trigger FracEnd FracEndDetected 
 MovementMode = InterruptAndEject 
 Drain 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 EndTrigger 
;******************************************************************** 
;*Definition of triggers for fraction collection ends here 
;******************************************************************** 
 
; Maximum filling volume of a tube in ml: 
 PumpDevice = "Pump" 
 TubeMaxVolume = 10 
 
; Maximum number of installed fraction tubes: 
 FractionCollection.TotalNumberInstalled = 240 
 
; Basic fraction collection parameters: 
 MaxTubesPerFraction =  Unlimited 
 TubeWrapping = No 
 TubeChangeDuration =  2.0 [s] 
 ChannelEvaluation =  All 
 
; Delay time between detector output and switching valve or tube: 
 DelayTime = 0.8 
 DetectionChannel2.OffsetTime = 0.0 
 DetectionChannel3.OffsetTime = 0.4 
 
; Conditions for online peak recognition at program start: 
 CollectFractions =  Yes 
 DetectionChannel2.Name = "UV_VIS_01" 
 ;Slope at peak start [mAU/s]: 
 DetectionChannel2.PeakStartSlope = 2.000 
 ;Minimum signal height at peak start [mAU] 
 DetectionChannel2.PeakStartThreshold = 5000.00 
 ;Slope after peak maximum [mAU/s] 
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 DetectionChannel2.PeakMaxSlope = -5.000 
 ;Slope at peak end [mAU/s] 
 DetectionChannel2.PeakEndSlope = -4.000 
 ;Maximum signal height at peak end [mAU] 
 DetectionChannel2.PeakEndThreshold = 5000.00 
 ;Signal mst be less than this threshold value 
 ;before a new peak start can be recognized [mAU] 
 DetectionChannel2.ThresholdNoPeakEnd = 10000 
 ;Baseline drift correction: 
 DetectionChannel2.BaselineOffset = 0.000 
 DetectionChannel2.BaselineDrift = 0.000 
 
; Conditions for online peak recognition for the MS detection 
channel: 
 DetectionChannel3.Name = "MS_01" 
 DetectionChannel3.PeakStartSlope = 2.000 
 DetectionChannel3.PeakStartThreshold = 10.00 
 DetectionChannel3.PeakMaxSlope = -5.000 
 DetectionChannel3.PeakEndSlope = -4.000 
 DetectionChannel3.PeakEndThreshold = 5.00 
 DetectionChannel3.ThresholdNoPeakEnd = 200 
 DetectionChannel3.BaselineOffset = 0.000 
 DetectionChannel3.BaselineDrift = 0.000 
 
; Separation start with injection and acquisition start 
0.000 UV.Autozero 
 Wait Sampler.Ready and MS.Ready 
 Inject 
 3DFIELD.AcqOn 
 UV_VIS_1.AcqOn 
 MS_01.AcqOn 
 MS_02.AcqOn 
 MS_03.AcqOn 
 MS_04.AcqOn 
 MS_05.AcqOn 
 
; Basic fraction collection parameters: 
 CollectFractions =  By_Peak 
 
; Change of the detection channel according to the expected 
substances 
3.20 DetectionChannel3 =  "MS_02" 
  
3.7 DetectionChannel3 =  "MS_03" 
  
4.3 DetectionChannel3 =  "MS_04" 
  
5.5 DetectionChannel3 =  "MS_05" 
 
; End of data acquisition 
10.000 3DFIELD.AcqOff 
 UV_VIS_1.AcqOff 
 MS_01.AcqOff 
 MS_02.AcqOff 
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 MS_03.AcqOff 
 MS_04.AcqOff 
 MS_05.AcqOff 
 CollectFractions =  No 
 
 End 

 Notes: 
The trigger block used in this program example refers to the Dionex 
Sample and Fraction Manager (SFM). 

In the example, DetectionChannel1 has not been used as the first detection 
channel because '1' and 'I' look identical when Courier is the selected font.  
 
If the above Program is used, fractions would be collected at the following 
retention times, provided that a peak occurs within the following mass 
traces: 
 

Retention time-interval [min] 
 

Channel
 

Mass 
[m/z] 

Positions of the  
collection vials 

0.000 -  3.200 MS_01 244 1  
3.200 -  3.700 MS_02 146 2 
3.700 -  4.200 MS_03 165 3 
4.200 -  5.500 MS_04 179 4 
 5.500 - 10.000 MS_05 193 5  

(Usually, the desired mass peak occurs only once within the corresponding 
time interval - this is assumed in the above table. Otherwise, the positions 
of the collection vials will change accordingly.) 

This program example for mass-controlled fraction collection presumes that 
the same substances will be collected in all samples. If there are different 
substances in the samples, fraction collection via a mass channel needs to 
be adapted accordingly. For more information, refer to  Fraction 
Collection Control via an MS for Different Samples. 

For more program examples, refer to: 

 Program Example (One Detection Channel)  

 Program Example (Two Detection Channels) 
 
For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 
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 Fraction Collection Control via an MS for Different 
Samples 
If there are samples with different substances, the procedure described in 

 Fraction Collection Control via an MS has to be changed accordingly.  

In this case, Mass Traces have to be extracted online, as well (see How 
to …: Using Mass Spectrometers  Extracting Mass Traces Online). 
 

1. Define User-defined Columns 
Define the User-defined Columns Mass1 to Mass5 and FilterIndex to 
FilterIndex5 as Integer columns (see How to …: Creating and Managing 
Files and Data  Creating User-defined Columns). The program part 
below checks the content of the corresponding user-defined columns 
during data acquisition and thus allows you to control fraction collection 

Triggering. 
 

2. Modify the Program 
In the example described in Fraction Collection via an MS (see above), 
replace the corresponding paragraph in the Program with the following 
program part: 
 
; Definition of the minimum/maximum mass and of the filter index for 
the channels MS_01 to MS_05: 
 MS_01.MinMass = sample.mass1-0.5 
 MS_01.MaxMass = sample.mass1+0.5 
 MS_01.FilterIndex = sample.filterindex 
 
 MS_02.MinMass = sample.mass2-0.5 
 MS_02.MaxMass = sample.mass2+0.5 
 MS_02.FilterIndex = sample.filterindex2 
 
 MS_03.MinMass = sample.mass3-0.5 
 MS_03.MaxMass = sample.mass3+0.5 
 MS_03.FilterIndex = sample.filterindex3 
 
 MS_04.MinMass = sample.mass4-0.5 
 MS_04.MaxMass = sample.mass4+0.5 
 MS_04.FilterIndex = sample.filterindex4 
 
 MS_05.MinMass = sample.mass5-0.5 
 MS_05.MaxMass = sample.mass5+0.5 
 MS_05.FilterIndex = sample.filterindex5 
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3. Enter the Values in Sample List 
Finally, enter the corresponding values of the single samples into each 
column of the sample table: 

 
 
In this example, the following mass traces are relevant for controlling the 

Fraction Collector at the corresponding samples: 
 

Retention time 
interval [min] 

Channel
 

Standards 
Mass [m/z] 

Sample 1 /2 
Mass [m/z] 

Sample3/4 
Mass [m/z] 

0.000 -  3.200 MS_01 149 ± 0,5 176 ± 0,5 163 ± 0,5 
3.200 -  3.700 MS_02 197 ± 0,5 153 ± 0,5 215 ± 0,5 
3.700 -  4.200 MS_03 275 ± 0,5 235 ± 0,5 179 ± 0,5  

 Note: 

The retention times refer to the program example described in  Fraction 
Collection Control via an MS (see above). 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 

 Checking the Fraction Collection Status on the Control 
Panel 
The Fraction Collection driver supports various properties that allow you 
to check the fraction collection status on a Control Panel. These 
properties are read-only. They are available independently of the installed 

Fraction Collector. 

On the control panel, create display elements indicating the status of the 
desired parameter. You can use a Color Box, String Display, Gauge 
Indicator, or Lamp. (For more information, refer to How to …: Controlling 
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Devices from the Control Panel  Modifying a Control Panel and the 
following topics.)  

The tables below list the properties in the order in which they appear in the 
dialog box. (For information about the parameters for active fraction 
collection control, refer to  Editing Signal-Dependent Fraction 
Collection Parameters and  Editing Signal-Independent Fraction 
Collection Parameters.) 
 

Properties for the single channels 
These properties are available on the Link tab page of the Properties 
(context menu) for the corresponding control if the associated 
DetectionChannelN is selected as Object. 
 
Property Description 
Curve Indicates the last signal curve in [Signal]/s^2 evaluated by the Fraction 

Collection driver for peak detection. 
PeakDetectCode Use this property to have Chromeleon display the peak detection 

status: 
 Unknown (= 0) The status is not defined.  
 Ready for  

Start (= 1) 
The driver waits for the peak start, i.e., waits until 
the peak start conditions are fulfilled. 

 Start is  
Detected (= 2) 

A peak start was detected.  

 Ready for 
Shoulder Up 
(= 3) 

A Peak Shoulder may have been detected at 
the fronting edge of the peak. However, this is not 
yet clearly detected. 

 Tip: Chromeleon supports this parameter 
only for the Purification license. 

 Max is  
Detected (= 4) 

A peak maximum was detected. 

 Ready for 
Shoulder  
Down (= 5) 

A peak shoulder may have been detected at the 
tailing edge of the peak. However, this is not yet 
clearly detected. 

 Tip: Chromeleon supports this parameter 
only for the Purification license. 

 Waiting for 
Manual Peak 
End (= 6) 

The Manual Peak Start command was 
performed. Thus, automatic peak detection is 
disabled. The driver waits for the Manual Peak 
End command. 
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Property Description 
PeakEndTime 
PeakMaxTime 
PeakStartTime 

Indicates the last retention times evaluated by the Fraction Collection 
driver for detecting a peak start, peak maximum, or peak end. 

RetentionTime Indicates the retention time in minutes evaluated by the Fraction 
Collection driver for peak detection. 

Signal Indicates the last signal value evaluated by the Fraction Collection 
driver for peak detection. 

Slope Indicates the last slope in [Signal]/s evaluated by the Fraction 
Collection driver for peak detection.  

Properties for the Fraction Collection Driver 

 Tip: 
These properties are available if the selected Object is 
FractionCollection. 
 
Property Description 
FracEndDetected Set to Yes when a fraction start is detected. When the fraction end 

is detected, the property is reset to No.  
(Delayed) 

FracStartDetected 
 

Set to Yes when a fraction start is detected. When the fraction end 
is detected, the property is reset to No.  
(Delayed) 

FractionOn Set to Yes during fraction collection.  
(Corresponds to PeakOn, but delayed) 

FractionTubeCount Number of filled tubes in the current fraction.  
(Delayed) 

FracTubeChange Set to Yes when a filled tube is detected. When a filled tube is not 
detected, the property is automatically reset to No. 
(Delayed) 

TubeFilling Volume collected in the current tube. 
(Delayed)  

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 
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 Tracking Fraction Collection in the Chromatogram 
After you have collected fractions during the analysis, it is important that 
you can later track which substances have been collected in which tube. 
This is possible in Chromeleon: 
• In the chromatogram  

• In the report (see  Tracking Fraction Collection in the Report.) 

In the chromatogram, you can display which fractions have been collected 
at which time: 

 

You can adapt the appearance of the display according to your 
requirements. Select Decoration on the context menu. The 
Chromatogram Decoration dialog box appears. On the Fractions tab 
page, select the options and thus, determine how the fractions are 
displayed in the chromatogram: 
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 Note:  
The settings in the picture correspond to the settings used for the above 
chromatogram. 

In the Fraction Visualization section, determine how the fractions shall be 
displayed. Usually, it makes sense to select the Vertical stripes and Fill 
stripes options. In this way, you can display the exact time assignment of 
the single peaks to the corresponding fractions. 

In the lower section, determine how the fractions shall be labeled. In order 
to label fractions, select the Label Fractions check box first, and then 
determine the label in the Formula input field. The following formula has 
proved a good choice: 

F{frac.number} ({frac.tube(1).position}-{frac.tube(frac.nTubes).position}) 

The corresponding label could then read, e.g., "F2 (37-38)". This means 
that the second fraction was collected in the tubes 37 and 38. (Note: To 
mark the single tubes in the chromatogram by dotted lines, select the Mark 
tubes inside fraction or Mark tubes outside fraction check box.) The 'F' 
in the above formula serves to distinguish fraction labels from peak labels. 
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 Tip: 
It is also possible to track fraction collection in the chromatogram during 
data acquisition. However, in this case, several complex settings are 
required that must be tailored to the individual installation. A description of 
these settings goes beyond the scope of this online Help. Therefore, if you 
need more information, please contact your local Dionex representative.  

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 

 Tracking Fraction Collection in the Report 
You can display fraction collection information in the report at any time. The 
easiest way is to insert one of the two predefined report tables: 
• Double-click to open the desired sequence, and then display the report. 

• On the Table menu, select Insert Report. 

• The Insert Report Table dialog box appears. Click the '+' characters in 
front of Result Tables and Fraction Collection Results to display the 
reports underneath. 

• Select one of the two reports: 

 

• Select the Fraction Report to display an overview of the fractions. 
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• Select Tube Report to add an overview of the single tubes to the 
report: 

 

The picture shows a standard tube report that was created with the default 
settings. To insert additional columns: 
• Select the column in front of which you want to insert the new column. 

• Select Insert Column on the context menu. The Insert Report 
Column dialog box appears. 

• Select one of the variables provided in the Fraction and Fraction 
Tube report categories. These categories provide the variables shown 
in the first picture plus some more. 

• To access the variables of the Fraction Detection Parameter 
category, select the Channel Parameter variable of the Fraction 
category. 

For a list of all available variables, refer to the following topics in the 
Reference Information section: 

⇒'Fraction' Category 

⇒'Fraction Tube' Category 

⇒'Fraction Detection Parameter' Category 

For an overview of the fraction collection topics, refer to  Collecting 
Fractions. 
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Collecting Fractions Automatically 
(Autopurification) 

Chromeleon supports automatic fraction collection. This is also referred to 
as Autopurification. Autopurification includes three steps: 

• Pre-analysis of the preparative samples 

• Preparative purification of the remaining samples, based on the pre-
analysis results 

• Post-analysis of the collected fractions for purity and yield evaluation 

In order to perform autopurification, make sure that  

1. A Purification license is installed. 

2. A Dionex Sample and Fraction Manager is installed. (For installation 
details, refer to Installing Dionex Devices  HPLC Sample and 
Fraction Manager (SFM) in the Administrator Help section.) 

For general information about fraction collection, refer to  Collecting 
Fractions.  

For more information about autopurification, refer to: 

 Setting up Autopurification 
 Creating PGM Files for Autopurification Samples 
 Using Triggers in Autopurification Programs 
 Performing Autopurification 
 Autopurification Samples in the Sample List 
 Autopurification Samples in the Chromatogram 
 Autopurification Samples in the Tray Views 
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 Setting up Autopurification 
Before you can collect fractions automatically, you need to take the 
necessary preparative steps in Chromeleon, using the corresponding files 
from the Additional_Software_Autopurification CD. First, select the 
appropriate directory for your installation, e.g., APS_2222_UV_MS. 

Windows Explorer 
Copy the Dionex_Purification_Parameters.GEN file from the Drivers 
subdirectory to the Chromel/bin directory. 

 Tip: 
Usually, a Dionex Service Representative or an authorized Dionex 
distributor copies the file. (Make sure that you do not move any 
chromatographic files in the Windows Explorer. The reason is that, except 
for the visible results, processes are performed below the surface.) 

Server Configuration 
Install the devices in the Server Configuration program. Usually, you have 
to install the single devices manually. However, for autopurification, 
Chromeleon provides several predefined device configurations on the CD 
that is shipped with the product. For example: 

APS_2222_UV_MS.CFG (in the cfg file directory) 

Select Import on the File menu and import the desired configuration. 
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PGM Files 
In the PGM File, define how the single fractions are to be collected. The 
Programs directory provides different programs as backup files. Select 

Restore on the File menu and specify the location to which you want to 
restore the program(s). 

Or else, you may create a program in the Program Wizard (see The 
Control Program  The Program Wizard). For more information, refer to 

 Collecting Fractions. 

Control Panels  
Install the predefined control panels from the Panels directory on the CD to 
an appropriate location, e.g., the Dionex Templates>Panels directory in 
the local datasource of the Chromeleon Browser. For example, create an 
Autopurification folder in this directory. 

Reports  
In the same way, you may copy the report templates from the Reports 
directory on the CD to an appropriate location, e.g., the Dionex 
Templates>Reports directory in the local datasource of the Chromeleon 
Browser. For example, create an Autopurification folder in this directory. 

Demo Data  
In addition, demo data backup files are provided in the Demo_data 
directory. Copy the data to an appropriate location, if required. 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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 Creating PGM Files for Autopurification Samples 
The purification process includes three steps. Therefore, three different 
PGM Files are required for 

1. Pre-analysis of the preparative samples 

2. Fraction collection 

3. Post-analysis of the collected fractions 

No special PGM Files are required for steps 1 and 3. For step 2, use the 
PGM Wizard to create a program for fraction collection. Follow the steps in 
How to …: Collecting Fractions  Setting up Fraction Collection. 

The Dionex_Purificiation_Parameters device driver supports additional 
parameters. For more information, refer to: 

 Setting the General Parameters for the 
Dionex_Purification_Parameters Driver 

 Setting the Safety Parameters 
 Setting the Correction Parameters (Settings Panel) 

 
For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 

 Setting the General Parameters for the 
Dionex_Purification_Parameters Driver 
The Dionex_Purification_Parameters driver supports the following general 
parameters. 
 
Property Description 
AnalOn When the variable is set to On, the control panel shows that the 

analytical pump flow is directed through the analytical column.  
AutoCh* Enables or disables the ARC logic, e.g., on the Operation panel. 

(ARC logic must be off for isomers.) 
Col1On (Tandem operation only) When the variable is set to On, the control 

panel shows that the preparative pump flow is directed through the 
preparative column 1. 

Col2On (Tandem operation only) When the variable is set to On, the control 
panel shows that the preparative pump flow is directed through the 
preparative column 2.  
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Property Description 
FirstRack Indicates the rack that contains the first fraction tube of a sample (report 

variable). 
FirstTube Indicates the first fraction tube of a sample. 
LastRack Indicates the rack that contains the last fraction tube of a sample. 
LastTube Indicates the last fraction tube of a sample. 
MSTgtPkEnd* The variable is set to Yes when the system has detected a target 

compound (required for the ARC logic). 
MSThrFact Multiplication factor for absolute threshold values for peak start and 

peak end in the MS. 
NextImpuls Controls the impulse transmitter for software function monitoring of the 

Security and Solvent Monitoring System (SSM). 
PkPrevRunEnd Indicates whether fractions were collected during the last two runs. If no 

fractions were collected, you have to reset the variable manually on the 
Operation panel to allow a new sample to be injected.  

TenPortState Controls valve switching for two preparative columns in tandem 
operation. 

ThrMSTgtPkDet* Absolute threshold value for detecting a target mass in the MS (required 
for the ARC logic). 

ThrUVTgtPkDet* Absolute threshold value for detecting a target mass in the UV (required 
for the ARC logic). 

TrigBusy Inhibits that several triggers are performed in parallel. 
UVThrFact Multiplication factor for absolute threshold values for peak start and 

peak end in the UV.  

 Tip: 
On the control panel, you can correct the parameters marked with an 
asterisk (*) for all other samples of the current sequence, using the 
corresponding parameters that are supported by the 
Dionex_Purification_Parameters device driver (see Collecting Fractions 
Automatically (Autopurification)  Setting Correction Parameters). 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 



692 Collecting Fractions Automatically (Autopurification) 

 Setting the Safety Parameters 
The Dionex_Purification_Parameters driver supports several parameters 
that can be used to improve system safety. 
 
Parameter Description 
Disc* Enables or disables the Disconnect function. If the parameter is set to 

Yes, all modules are disconnected when the Emergency Program is 
running. 

LeakOn Enables or disables leak detection. If the parameter is enabled (Yes), a 
Message appears when the emergency program is running explaining 

why the system has stopped when a leak is detected, i.e., when the 
value is below the PMinAlarm. 

MaxPress Highest pressure measured in the system (used for early pressure 
alarm). 

PMaxAlarm* Upper pressure limit. If the pressure exceeds this value, a warning 
appears and no sample will be injected. 

PMinAlarm* Lower pressure limit. When the pressure is below this value, a warning 
appears and the system is stopped immediately.  

PressAlarm Enables or disables the pressure alarm. If parameter is set to On, no 
sample will be injected. 

PressMem At a specified time during the program run (usually, at the highest 
pressure), the parameter is assigned the current system pressure. 

RunDone If the parameter is set to Yes, fractionation is stopped at the end of the 
sample.   

 Tip: 
On the control panel, you can correct the parameters marked with an 
asterisk (*) for all other samples of the current sequence, using the 
corresponding parameters that are supported by the 
Dionex_Purification_Parameters device driver (see Collecting Fractions 
Automatically (Autopurification)  Setting Correction Parameters). 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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 Setting the Correction Parameters (Settings Panel) 
The Dionex_Purification_Parameters driver supports several parameters 
that allow you to later change the settings for single fraction collection 
parameters defined in the PGM File, e.g., if you come across an 
unfavorable setting for a special parameter when processing a long 
sequence. 

 Tip: 
Unlike all other properties, the values for these parameters are not reset to 
the values in the PGM File when a new sample is started. Thus, these 
values are valid for all other samples. 

To change a setting, click Settings on the Administration.pan panel. The 
Settings sub panel appears.  

 Tips: 
To use the default values for the parameters listed in the panel sections 
below, click the associated SET DEFAULT VALUES button. 

For many parameters, a NOW button is provided. Click this button to apply 
the new value immediately. In all other cases, the new value is used after 
the current sample has been processed completely. 

The appearance of the panels may vary, depending on the installed 
version. Therefore, the parameter names listed below may be slightly 
different from the names on your panel version. 

Pressure Monitoring 
Enable use of the following pressure monitoring parameters by selecting 
the Use global parameters for pressure monitoring check box or via the 
GlobParPressMem parameter in the Commands dialog box: 
Option Parameter Description 
Upper pressure alarm level PMaxAlarm2 Upper limit for the system pressure. If the 

pressure exceeds this value, a warning 
appears and no sample will be injected. 

Lower pressure alarm level PMinAlarm2 Indicates the lower limit for the system 
pressure during a run. A pressure below 
this value indicates a leak. A warning 
appears and the system is stopped 
immediately.  
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Safety 
To enable the disconnect function, select the Disconnect System in Case 
of Emergency check box or use the Disc command in the Commands 
dialog box. When this function is active, Chromeleon interrupts software 
control for all modules while the Emergency Program is running. 
 

Threshold Values for Fraction Collection 
Enable use of the related peak detection parameters by selecting the Use 
parameters below for peak detection check box or via the 
GlobParUVDet or GlobParMSDet parameter in the Commands dialog 
box: 
 
Option Parameter Description 
Peak Start Threshold (UV) UVStartThr The signal threshold must exceed this 

value for a peak start to be detected 
(PeakStartThreshold of Detection 
Channel1). 

Peak End Threshold (UV) UVEndThr The signal value must be below this 
value for a peak end to be detected 
(PeakEndThreshold of Detection 
Channel1). 

Threshold Do Not Resolve 
(UV) 

UVThrRes Above this threshold value, a new 
fraction tube is used in the minimum 
between two peaks if these peaks are 
not baseline separated 
(ThresholdDoNotResolve of Detection 
Channel1). 

Threshold No Peak End (UV) UVThrNoPkEnd The signal value must be below this 
value for a peak end to be detected 
(PeakEndThreshold of Detection 
Channel1) 

Peak Start Slope (UV) UVStartSlp The slope must exceed this value for a 
peak start to be detected 
(PeakStartSlope of DetectionChannel1). 

Peak End Slope (UV) UVEndSlp The signal slope must be below this 
value for a peak end to be detected 
(PeakEndSlope of DetectionChannel1) 

Peak Start Curve (UV) UVStCurv The curvature in [Signal]/s^2 must 
exceed this value for a peak start to be 
detected (PeakStartCurve of 
DetectionChannel2). 

Peak End Curve (UV) UVEndCurv The curvature in [Signal]/s^2 must be 
below this value for a peak end to be 
detected (PeakEndCurve of 
DetectionChannel2). 
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Option Parameter Description 
Peak Start True Time (UV) UVStTrTi Time in seconds for which the PeakStart 

conditions must be fulfilled. Only then, a 
peak start will be detected 
(PeakStartTrueTime of Detection 
Channel1). 

Peak End True Time (UV) UVEndTrTi Time in seconds for which the PeakEnd 
conditions must be fulfilled. Only then, a 
peak end will be detected 
(PeakEndTrueTime of Detection 
Channel1). 

Peak Start Threshold (MS) MSStartThr The signal threshold must exceed this 
value for a peak start to be detected 
(PeakStartThreshold of Detection 
Channel2). 

Peak End Threshold (MS) MSEndThr The signal threshold must be below this 
value for a peak end to be detected 
(PeakEndThreshold of Detection 
Channel2). 

Threshold No Peak End (MS) MSThrNoPkEnd The signal value must be below this 
value for a peak end to be detected 
(ThresholdNoPeakEnd of Detection 
Channel2). 

Peak Start Slope (MS) MSStartSlp The slope must exceed this value for a 
peak start to be detected 
(PeakStartSlope of DetectionChannel2). 

Peak End Slope (MS) MSEndSlp The signal slope must be below this 
value for a peak end to be detected 
(PeakEndSlope of DetectionChannel2) 

Peak Start True Time (MS) MSStTrTi Time in seconds for which the PeakStart 
conditions must be fulfilled. Only then, a 
peak start will be detected 
(PeakStartTrueTime of 
DetectionChannel2). 

Peak End True Time (MS) MSEndTrTi Time in seconds for which the PeakEnd 
conditions must be fulfilled. Only then, a 
peak end will be detected 
(PeakEndTrueTime of Detection 
Channel2).  

 Tip: 
The parameter names determined for DetectionChannel1 and 
DetectionChannel2 imply that DetectionChannel1 is a UV channel and 
DetectionChannel2 is an MS channel. 
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Fraction collection 
 
Option Parameter Description 
Channel Evaluation "ALL" ChanEval Determine how the results of the 

detection channels are to be used for 
peak detection: 
Selecting this check box, activates All, 
i.e., the condition must be true for all 
channels. 
Clearing this check box, activates Any, 
i.e., the condition must be true for only 
one channel.   

Enable use of the following fraction collection parameters by selecting the 
use parameters below for fraction collection check box or via the 
GlobParFr parameter in the Commands dialog box: 
 
Option Parameter Description 
# of Tubes Installed MaxTubes Maximum number of tubes available for 

fraction collection in the system. 
Tube Max Volume TbMaxVol Maximum volume per tube. 
max # Tubes/Fraction MaxTbPerFr Maximum number of tubes per fraction.  

High throughput 
Enable or disable the procedure for increasing the sample throughput: 
Option Parameter Description 
ARC Logic ARCLogic Enables or disables ARC logic. (ARC 

logic must be off for isomers.) 
Injection Mode InjectMode Enables or disables overlapping sample 

preparation.  

Threshold values ARC Logic 
Enable the following fraction collection parameters by selecting the use 
parameters below for ARC logic check box or via the GlobParEarlTerm 
parameter in the Commands dialog box: 
Option Parameter Description 
UV ThrUVTgtPkDet2 UV threshold value for a target peak 
MS ThrMSTgtPkDet2 MS threshold value for a target mass  
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Continuos Fraction Collection 
To enable fraction collection outside of peaks by selecting the Collect 
outside peaks check box or via the ColOuts parameter in the Commands 
dialog box. 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 

 Using Triggers in Autopurification Programs 

Using ⇒Triggers allows performing one or more actions as soon as certain 
conditions are true. Usually, three triggers are required for fraction 
collection: 
• To start fraction collection 

• To change the tube 

• To finish fraction collection 

For an example, refer to Commands for Controlling Dionex Devices 
 Sample and Fraction Manager: PGM File for Fraction Collection. 

Miscellaneous and freely definable conditions allow linking triggers to 
certain action, thus making them a flexible and versatile tool for controlling 
and monitoring various functions of the APS-2000 Series systems. For 
example, you can use a trigger to control and monitor the 
• System pressure,  

• Correct communication between the system and the software, 

• ARC logic,  

• And to transfer various variables from the panel to the program. 

For information about special autopurification triggers, refer to the operating 
instructions for the APS-2000 Series systems. 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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 Performing Autopurification 
First, create a sequence that contains the samples for fractionation.  

Then, have Chromeleon analyze the samples chromatographically to check 
whether fractionation is appropriate. From the original analytical samples 
(⇒Auto Purif. Type = Analytic), Chromeleon can automatically create the 
necessary preparative samples (Auto Purif. Type = Preparation). 
Determine the conditions in the Create Purification Samples Post-
Acquisition Step.  

 Notes: 
The Create Purification Samples post-acquisition step is available only if 
the timebase is connected to the related server, if this server is running, 
and if a Purification license is installed. 

The preparative samples are injected from the same vials/tubes as the 
original analytical samples. 

For more information, refer to: 

 Creating Preparation-Type Samples 

 Using Optimized MS Threshold Values 
Afterward, fractionation is performed. This step, too, can be monitored 
chromatographically. Use the Create Fraction Analysis Samples post-
acquisition step to create the necessary fractionated samples (Auto Purif. 
Type = Fraction). Only then will it be possible to chromatographically 
reanalyze the individual fractions later.  

 Note: 
The Create Fraction Analysis Samples post-acquisition step is available 
only if the timebase is connected to the related server, if this server is 
running, and if a Purification license is installed. 

For more information, refer to  Creating Fraction-Type Samples. 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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 Creating Preparation-Type Samples 
Preparative samples are required to allow fractionation of the content of a 
tube or vial. Create preparative samples in the Create Purification 
Samples Post-Acquisition Steps. A wizard guides you through the 
creation process. 

 Note: 
The Create Purification Samples post-acquisition step is available only if 
the timebase is connected to the related server, if this server is running, 
and if a Purification license is installed. 

The flow chart on the first wizard page illustrates how preparative samples 
are created. In addition, determine for how many target compounds is 
searched: 
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On the second wizard page, define the channel and the target compound: 

 

Select the search criterion for the target compound from the Select Peak… 
drop-down list: 
by Name:  
by Retention Time:  
by Greatest Height& Threshold: (= Highest peak)  
by Greatest Area& Threshold: (= Peak with the largest area)  
In the Mass Spectrometry Settings section, enter the Target Mass in the 
related input field. In addition, enter the mass range in the Isotope bunch 
field. If necessary, enter the mass of one or two adducts of the target 
compound, e.g., with a solvent, in the Adduct Mass 1 and/or Adduct Mass 
2 input fields. 

On the third wizard page, define the tests to be performed: 
Ion present: Checks whether the target compound is present. 
Mass spectrum purity: Checks whether the target compound is pure enough. 
Amount check: Checks whether the amount of the target compound is sufficient. 
<New customized>: Allows you to define your own test.  
For more information about this wizard page, refer to Create Purification 
Samples: Target Compound X. 
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Use the next wizard page to enable special options: 

Use Conditional Program Select this check box if you want to define an additional gradient 
program. 

Optimize MS Threshold for 
Target Compound X 

(X is a number between 1 and 10) Select this check box if you 
want to further analyze tailing and fronting of the target 
compound for a specified channel.  

Selecting one of these options and clicking Next> takes you to the 
corresponding wizard page. If you did not select one of these option, 
clicking Next> takes you to the three last wizard pages. Use these pages to 
determine the properties for the purification sequence and its samples 
(⇒Auto Purif. Type: Preparation). For more information, refer to the online 
Help for Create Fraction Analysis Samples: Sequence Properties, 
Create Fraction Analysis Samples: Sample Properties, and Create 
Fraction Analysis Samples: Extended Sample Properties. Click Finish 
to complete creation of the post-acquisition step.  

For more information, refer to: 

 Performing Autopurification 
 Creating Fraction-Type Samples 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 

 Using Optimized MS Threshold Values 
The Purification Sample Wizard supports the input of automatically 
optimizing threshold values for peak detection. For example, this may be 
useful in the following situation: 

When the ion source of the Mass Spectrometer is overloaded, it may 
appear in the MS channel as if a target compound is still eluting from the 
column. To avoid collecting fractions that do not contain the target 
compound, you can enter two automatically optimizing MS threshold values 
for the peak start and peak end on the Optimized MS Threshold TCx 
page. Follow the steps below: 

From the Channel for peak height list, select the channel to be used to 
determine the retention time at the peak height specified in the Peak Front 
Evaluation and Peak End Evaluation sections. From the Signal 
evaluation channel list, select the channel whose signal height at this 
retention time will be used.  
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The target channel is the default setting, but you may select a different 
channel, instead. In addition, you may enter a Multiplication Factor. The 
signal value of this channel is multiplied with this factor. 

 

In the example, the ion source is overloaded, resulting in tailing of the peak 
on the MS channel (contrary to the peak in the UV channel). To check 
whether the peak exists on the UV channel, Chromeleon first determines 
the retention time that is exactly between the peak start and peak end on 
the MS channel. This retention time is also between the peak start and 
peak end on the UV channel (dashed lines), thus proving that the peak 
exists on the UV channel, too. 

Afterward, Chromeleon determines the retention time at which the signal on 
the UV channel has reached (in this example) 10% of the maximum on the 
ascending peak edge (dotted line). Finally, Chromeleon determines the 
height of the signal on the Signal evaluation channel at this retention 
time. In the example, the signal evaluation channel is the target channel. 

In the pre-analysis (i.e., during the analysis of the sample for which the 
⇒Auto Purif. Type is Analytic), the signal value is written to the specified 

User-defined Column and evaluated during fraction collection (i.e., during 
the analysis of the sample for which the Auto Purif. Type is Preparation). 
When the signal value is exceeded during the analysis of the preparation-
type sample, a peak is detected and a fraction is collected. 
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To determine the peak end and thus stop fraction collection, you can enter 
the height for Peak Tail Evaluation in the same way. 

 Tip:   

Samples consisting of several substances with clearly different degrees of 
ionization are another example. When a fixed threshold value is used, it is 
possible that only a small portion (or no portion) of weakly ionizing 
substances might be collected. However, with an optimized MS threshold, 
the same portion of substances would be collected even if the ionization 
degrees were different. 

 Creating Fraction-Type Samples 
When fractionating preparative samples, the samples are 
chromatographically analyzed. If you want to reanalyze these fractions later 
again, you need one Chromeleon sample for each fraction. Chromeleon 
can create the samples automatically during fraction collection via the 
Create Fraction Analysis Samples Post-Acquisition Step. A wizard 
guides you in creating this step. 

 Note: 
The Create Fraction Analysis Samples post-acquisition step is available 
only if the timebase is connected to the related server, if this server is 
running, and if a Purification license is installed. 

On the first wizard page, determine which fractions are to be 
chromatographically reanalyzed: 
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Select: 

Reanalyze all tubes To reanalyze all tubes containing fractionated samples.    
Reanalyze all tubes that 
contain the target 
compound 

To reanalyze only those tubes that contain the target 
compound.  

  
Reanalyze only the tube 
with the target compound 
apex 

To reanalyze only the tubes into which the fractions 
containing the peak maximum of the target compounds were 
collected.  

The Target Compound table lists all defined target compounds. Click 
<New> to add a new target compound. The Select Target Compound 
Context dialog box is opened: 

 

Select the search criterion for the target compound from the Select Peak… 
drop-down list. For information about the criteria, refer to  Creating 
Preparation-Type Samples.  

Clicking Next> takes you to the next wizard page. Determine the properties 
for the fractionation sequence and its samples (⇒Auto Purif. Type: 
Fraction). For more information, refer to the online Help for Create 
Fraction Analysis Samples: Sequence Properties, Create Fraction 
Analysis Samples: Sample Properties, and Create Fraction Analysis 
Samples: Extended Sample Properties. Click Finish to complete 
creation of the post-acquisition step.  

For more information, refer to: 

 Performing Autopurification 
 Creating Preparation-Type Samples 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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 Autopurification Samples in the Sample List 
Click Display Columns on the context menu to include the following 
columns in the sample list: 

⇒Auto Purif. Frac (Autopurification Fraction) 

⇒Auto Purif. Ref. (Autopurification Sample Reference)  

⇒Auto Purif. Type (Autopurification Type) 

 Note:  
The columns display the values assigned by Chromeleon. These values 
are read-only. 

The Auto Purif. Type sample variable indicates the Autopurification 
stage for the associated sample: 

1. Analytic = original analytical sample 

2. Preparation = preparative sample  

3. Fraction = fractionated sample 

An identical entry in the Auto Purif. Ref. column of the sample list indicates 
that the samples of these three sample types belong together. 

The fraction ID assigned by Chromeleon appears in the Auto Purif. Frac. 
column. Chromeleon numbers the fractionated samples so that the order of 
the samples remains unchanged even if they are moved to a different 
sequence or folder. 

The picture shows an example in which the analytical samples are stored in 
the sequence 1_Analytic, the preparative samples in the sequence 
2_Preparation, and the fractionated samples in the 3_Fractions sequence: 

 

For an overview of how to perform autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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 Autopurification Samples in the Chromatogram 
After Autopurification has been performed, you can have Chromeleon 
display the results of the different samples in the associated 
chromatograms. The default setting is that all samples of the Analytic, 
Preparation, and Fraction ⇒Auto Purification Types that belong together 
are displayed: 

 

The topmost chromatogram shows the original analytical sample. If this 
sample fulfills the conditions determined in the Create Purification 
Samples Post-Acquisition Steps, a preparation-type sample is created 
and fractionated. The chromatogram for the preparation-type sample is 
displayed next. The vertical stripes indicate the chromatogram ranges for 
which fractions were collected. 

The individual fractions are chromatographically reanalyzed, based on the 
conditions determined in the Create Fraction Analysis Samples post-
acquisition step. The chromatogram for the associated fractions is 
displayed last. 

The bottommost chromatogram shows the fraction for the selected peak of 
the preparative sample. This is either the fraction under the peak maximum 
or, if no fraction was collected at the peak maximum, the fraction 
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overlapping most with the peak. If no peak was selected in the preparative 
chromatogram or if no fraction was collected for the selected peak, the 
chromatogram for the first peak is displayed. 

 Note:   

To display the next or previous sample or channel of the current 

chromatogram, click the associated icon: Click  for the next 

chromatogram,  for the previous chromatogram,  for the next 

channels or  for the previous channel. If another chromatogram is 
displayed, the associated chromatograms are updated simultaneously. For 
example, if Chromeleon displays the next analytical chromatogram, the 
associated preparative chromatogram and the associated chromatogram of 
the first fraction are displayed as well. 

To change the representation of the single chromatograms, double-click the 
chromatogram or select Decoration on the context menu. The 
Chromatogram Decoration dialog box is opened. On the 
Autopurification tab page, determine which autopurification samples are 
displayed. On the Fractions tab page, determine how fraction collection is 
displayed in the chromatogram. 

Also, refer to  Autopurification Samples in the Tray Views. 

For an overview of how to perform autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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 Autopurification Samples in the Tray Views 
Chromeleon supports two tray views for displaying the different samples 
and/or fractions. Analytical and preparation-type samples are displayed in 
the Inject Trays view. To open the Inject Trays view, click the following 
icon on the Method toolbar: . Tubes with fraction-type samples are 
displayed in the Fraction Racks view. To open the Fraction Racks view, 
click the following icon: . 

 

The default setting is that an overview of the single racks is displayed 
below the title line, also showing the racks that do not contain samples 
and/or fractions. The racks and their samples are then displayed below this 
general overview. The samples and/or fractions are color-coded, based on 
their ⇒Type (Sample Type) and ⇒Status. 

To change the representation of the samples and/or fractions, double-click 
the respective tray view or select Properties… on the context menu. The 
Inject Tray Properties or Fraction Tray Properties dialog box is opened. 
On the Format, tab page, determine the formats in which the trays are 
displayed. On the Tube Format tab page, define the formats for the vials 
and/or tubes. Use the Overview tab page to display, hide, and/or format 
the trays.  

Also, refer to  Autopurification Samples in the Chromatogram. 

For an overview of how to perform Autopurification, refer to  Collecting 
Fractions Automatically (Autopurification). 
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Simulating Chromatograms 
To use Virtual Column to simulate retention data and chromatograms, 
you first select the analysis parameters (analytes of interest, methodology, 
column, etc.). Virtual Column then calculates retention data for the selected 
parameters, and displays the resulting Resolution Response Surface and 
Virtual Chromatogram.* 

 Note: 
Results obtained with Virtual Column are intended to represent typical 
results for a particular column type. Because no two columns or systems 
are identical, the results you obtain in an actual analysis may differ 
somewhat from the Virtual Column predictions. 

Starting Virtual Column 
In the Chromeleon Browser, select Virtual Column on the Tools menu.  

 
 

 Tip: You can open more than one Virtual Column window.  

Using Virtual Column (Overview) 

1. Select an analyte category. 
2. Select two or more analytes. 
3. Select a column. 
4. View the Resolution 

Response Surface (a plot of 
the lowest resolution values 
found at each eluent 
condition). 

5. View the Virtual 
Chromatogram. 

 Tip: 

Right-click on the Resolution 
Response Surface to select a 
different resolution criterion. 
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For details about how to use Virtual Column, refer to: 

 Selecting the Analysis Parameters  

 Viewing the Results Table 

 Viewing the Resolution Response Surface 

 Viewing the Virtual Chromatogram 

 Selecting a Resolution Criterion 

 Finding the Fastest Chromatogram 

 Finding the Global Optimum 

 Selecting the Column Quality Assurance Conditions 

 Manually Selecting an Eluent Condition 

 Saving and Reloading Virtual Column Settings 

 Viewing the Eluent Composition 

 Modeling Gradient Separations 

 Note: 
Parts of the Virtual Column software were developed jointly by Dionex 
Corporation and the Australian Centre for Research on Separation Science 
(ACROSS) at the University of Tasmania, Australia 
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 Selecting the Analysis Parameters 
The left side of the Virtual Column window provides controls for selecting 
the desired analysis parameters.  

 Tip: 
To clear selections and return the Virtual Column window to the initial blank 
state, click Reset All.  

1.  Select an Analyte Category. 
To begin a Virtual Column 
simulation, first select the Analyte 
Category. The table on the Select 
Analytes tab lists all analytes in the 
selected category for which 
embedded data are available. The 
example shows the list when 
Anions is the selected category. 

 

2.  Select the analytes. 
Select the check box for each 
analyte to be included in the Virtual 
Chromatogram. 

 Tip: 

If you want Virtual Column to 
calculate retention data for the void 
dip, or if you want to change its 
Peak Area, Asymmetry, or 
Efficiency values, select the Void 
Dip check box. If the check box is 
not selected, the void dip is 
displayed on the Virtual 
Chromatogram, but retention and 
resolution data are not calculated 
for it.  
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3.  (Optional) Select methodologies.  
After you select two or more 
analytes, the methodologies and 
columns available for the selection 
are displayed. If more than one 
methodology is shown, you can 
restrict the column choices by 
clearing the check boxes from 
methodologies you do not want to 
consider.  

  

4.  (Optional) Select a column diameter. 
To restrict the column choices to a 
particular diameter category, clear 
the check box for the diameter of 
column (Standard Bore or Micro 
Bore) you do not want to consider. 

 

5.  Select a column.  
Select a column from the list. Virtual 
Column calculates retention and 
resolution data for the selected 
parameters and displays the 
resulting Resolution Response 
Surface and Virtual Chromatogram. 
The display defaults to the best 
Minimum Resolution case (see 

How to …:  Selecting a 
Resolution Criterion). 

 Note: 

Gradient cases are listed only if a 
Virtual Column Linear Gradient 
license is present and a gradient 
Methodology option is selected. 
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 The following example shows the plot and chromatogram for Fluoride, 
Chloride, Nitrite, Sulfate, Bromide, and Nitrate when the AS18 column is 
selected using isocratic conditions. 

  

6.  (Optional) Change the Set Response By option. 
 The default response factor is Peak Area. You can change this to 

Concentration (mg/l) or Concentration (mM). 
7. (Optional) Change the Inj. Volume.  
 After you select the Concentration option for Set Response By, a 

default injection volume is displayed. You can enter a different value in 
the edit box.  
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8.  (Optional) Change the Peak Area, Concentration, Asymmetry, and 
Efficiency Values. 

 After you select the analytes and choose a column, the Select Analytes 
table displays the default Peak Area or Concentration, Asymmetry, 
and Efficiency values for each selected analyte. The values displayed 
were obtained from the experimental data embedded in Virtual Column. 
If you have data specific for your system, you can enter those values in 
the table. Virtual Column uses the new values in retention and 
resolution calculations.  

 After entering the values, you can save them to a file for later use (see 
How to …:  Saving and Reloading Virtual Column Settings). 

9.  (Optional) Change the Temperature.  
 For some columns, you can select a different temperature to view the 

effect of a temperature change on the Virtual Chromatogram.  

10. (Optional) Change the Gradient Start. 
 After you select a column for a gradient simulation, a default value for 

the eluent concentration at the beginning of the gradient is displayed. 
You can select a different value from the drop-down list. 

 Note: 

See How to …:  Modeling Gradient Separations for more 
information about gradient analyses. 

11. (Optional) Change the Flow Rate, Void Volume, and Void Time. 
 After you select the analytes and choose a column, Virtual Column 

displays a default flow rate, void volume (also called Dead Volume), 
and void time (also called Dead Time) for the selected column. You 
can change the flow rate and/or void volume values to more accurately 
model your specific system. Changing either value affects the void time 
(void time = void volume/flow rate). 

 Note: 
If you change the flow rate in Virtual Column, the peak shapes on the 
virtual chromatogram are not affected. However, under actual operating 
conditions, peak shapes are affected by changes in the flow rate. 
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12. (Optional) View the retention data. 
 To view the calculated retention data, click the Display Results tab. 

See How to …:  Viewing the Results Table for details. 

  

 Viewing the Results Table 
After you select the analytes and choose a column, click the Display 
Results tab to view the calculated retention data. The results table lists the 
calculated results (Retention Time, Retention Factor, and Resolution) 
for each selected analyte. The analytes are listed in order of ascending 
retention time. Results are calculated based on the analyte data (peak area 
or concentration, asymmetry, and efficiency) and on the selected column, 
temperature, void time, and eluent conditions.  
• Retention Time is the time (in minutes) since injection. 

• Retention Factor (also called Capacity Factor) is the ratio of the net 
retention time to the void time (also called Dead Time). 

• Resolution is the degree of separation between the current peak and 
the next peak in the chromatogram. 

 Viewing the Resolution Response Surface 
The Resolution Response Surface is a plot of the lowest resolution values 
found for the Virtual Chromatogram at each possible eluent condition. 
Specific features of the plot vary, depending on which resolution criterion is 
selected (see How to …:  Selecting a Resolution Criterion) and on 
whether the eluent is a single- or dual-species type.  
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Single-Species Eluents 
When a single-species eluent is used, the Resolution Response Surface is 
represented by a line plot. In this example, the Minimum Resolution 
criterion is selected.  
 

  

Dual-Species Eluents 
When a dual-species eluent is used, the Resolution Response Surface is 
represented by a contour plot. In this example, the Minimum Resolution 
criterion is selected.  
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 Viewing the Virtual Chromatogram 
The Virtual Chromatogram simulates an actual analysis, using the currently 
selected analytes, column, void time, temperature, resolution criterion, and 
eluent condition. The Virtual Chromatogram is updated whenever the 
selected analytes or other parameters are changed. The figure below 
describes the features of the Virtual Chromatogram. In this example, the 
Minimum Resolution criterion is selected. 

  

Zooming/Unzooming 
To zoom into an area of the chromatogram, press the left mouse button 
and drag to form a box around the area.  
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To return to the previous view, right-click and select Unzoom. To display 
the full chromatogram in the pane, right-click and select Full Size.  

  

Gradient Profile 
To superimpose the gradient profile (in blue) over the Virtual 
Chromatogram (in red), right-click and select Gradient Profile. This option 
is available only when a gradient simulation is selected. 

  

 Selecting a Resolution Criterion 
Virtual Column provides three options for determining the optimal eluent 

condition for peak resolution:  
• Minimum Resolution  
• Normalized Resolution Product  
• Resolution Optimized for Analyte  
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To select a resolution criterion, right-click on the Resolution Response 
Surface and select a criterion on the menu, or select an option on the 
Criterion menu on the Chromeleon menu bar. 

The sections below describe each resolution criterion. Examples illustrate 
how each criterion affects the same Virtual Chromatogram. For the 
examples, the AS18 column was selected and the following list of anions 
was used: Bromide, Carbonate, Chloride, Fluoride, Nitrate, Nitrite, and 
Sulfate. Note: Carbonate was added to the list to better illustrate the 
differences among the criteria. 

Minimum Resolution 
When Minimum Resolution is selected, Virtual Column finds the least 
resolved peak pair for the selected eluent condition. The resolution of the 
entire chromatogram for that eluent condition is defined as the resolution of 
the least resolved peak pair. All other peak pairs of higher resolution are 
ignored. Minimum Resolution is the default criterion. This option is useful 
for difficult separations because it optimizes the resolution of any peak 
pairs that are hard to separate.  

In general, a resolution value of at least 1.5 (peak areas overlap less than 
0.2%) is regarded as good baseline separation. For many applications, a 
value of 1.2 (peak areas overlap less than 2%) is considered to be an 
acceptable separation. A value of 0 indicates that at least two peaks are 
eluting at the same retention time. 
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Normalized Resolution Product 
When Normalized Resolution Product is selected, Virtual Column finds 
the eluent condition that provides the most evenly spaced peaks across the 
entire chromatogram. A normalized resolution product value of 1 indicates 
that all peaks are evenly resolved across the chromatogram. A value of 0 
indicates that at least one peak pair is co-eluting. Normalized Resolution 
Product is useful for easy separations, as it optimizes the resolution of all 
peak pairs. However, for more difficult separations, Normalized Resolution 
Product may find a chromatogram with evenly spaced peaks, but the peaks 
may not all be resolved. 

The normalized resolution product (r) is defined by the following equation: 
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where n is the number of peaks and 1, +iisR
 is the resolution of peaks i and 

i+1. 
Notice that with this example, when the Normalized Resolution Product 
option is selected, the Carbonate/Nitrite peak pair is no longer resolved. 
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Resolution Optimized for Analyte 
When Resolution Optimized for Analyte is selected, Virtual Column finds 
the eluent condition that optimizes the resolution of a selected peak. Virtual 
Column finds the best resolution for the selected analyte. The resolution of 
the other peaks is not taken into account. Resolution Optimized for 
Analyte is useful if resolving a particular analyte's peak is more critical than 
resolving all other peak pairs. 

In this example, Chloride is the selected analyte (indicated by the asterisk 
next to the Resolution value in the Display Results table and the blue 
markers on the peak). Notice that, with this option, the Carbonate/Bromide 
and Nitrate/Sulfate peaks are not resolved. 
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 Tip: 
When Resolution Optimized for Analyte is selected, you can select a 
different analyte to be optimized by double-clicking the analyte peak on the 
Virtual Chromatogram. 

 Finding the Fastest Chromatogram 
Virtual Column provides an option that lets you optimize a separation for 

speed rather than for peak resolution. To select this option, right-click on 
the Resolution Response Surface and select Find Fastest Chromatogram 
on the menu, or select the option on the Criterion menu on the 
Chromeleon menu bar. Enter the minimum acceptable resolution and click 
OK. Virtual Column finds the eluent condition that gives the fastest 
chromatogram that satisfies the currently selected resolution criterion.   

The example below shows the results of a Find Fastest Chromatogram 
command. The minimum acceptable resolution entered was 1.5. Notice that 
the eluent concentration selection bar was moved from 24.912 to 29.459 
mM and the chromatogram time was reduced from 11.8 to 10.5 minutes. 
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 Finding the Global Optimum 
The Virtual Column Find Global Optimum option finds the eluent 
composition that gives the maximum value for the selected resolution 
criterion (see How to …:  Selecting a Resolution Criterion). To select 
this option, right-click on the Resolution Response Surface and select Find 
Global Optimum on the menu, or select the option on the Criterion menu 
on the Chromeleon menu bar. This option is the default when you select a 
column or resolution criterion. 
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 Selecting the Column Quality Assurance Conditions 
The Virtual Column Column Quality Assurance Conditions option sets 
the eluent composition to that specified in the production control test 
performed on every Dionex column before it is shipped. For details about 
the production test, refer to the column manual.  

To select this option, right-click on the Resolution Response Surface and 
select Column Quality Assurance Conditions on the menu, or select the 
option on the Criterion menu on the Chromeleon menu bar. This option is 
available only when an isocratic modeling case is selected.  

 Note: 
The Column Quality Assurance Conditions option changes the eluent 
composition, but does not affect the analyte selections. If the production 
test includes more analytes than those selected for display in Virtual 
Column, the missing analytes are not automatically added to the Virtual 
Chromatogram. 

 Manually Selecting an Eluent Condition 
To determine the optimum eluent condition, you can select an option (Find 
Fastest Chromatogram, Global Optimum, or Column Quality 
Assurance Conditions) on the Virtual Column Criterion menu or you 
can manually select the eluent condition on the Resolution Response 
Surface.   

To manually select the eluent condition if you are working with a single-
species eluent, drag the single vertical bar to the desired eluent 
concentration (see the example below), or click on the plot where you want 
to move the bar. The virtual chromatogram is updated to reflect the new 
concentration. 
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 Note: 
If a gradient Methodology option is selected, moving the vertical bar 
adjusts the gradient slope rather than the eluent concentration.  

If you are working with a dual-species eluent, two eluent selection bars are 
provided: one for total eluent concentration and one for ratio of the species. 
You can move both bars together or drag each individually. To move both 
bars, click on the Resolution Response Surface at the desired eluent 
composition, or point to the intersection of the two bars, wait for the pointer 
to change to a four-directional arrow and then drag the bars. See the 
following example. 

  

To move only one of the bars, point to the bar, wait for the pointer to 
change to a two-directional arrow, and drag the bar to the desired location. 
Drag the horizontal bar to change the ratio of the species (see the example 
below) or drag the vertical bar to change the total eluent concentration. 
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 Saving and Reloading Virtual Column Settings 
After you have selected analytes and a column, you can save the selected 
settings to a file to be available for later use. The following information is 
saved and can be reloaded from the saved file: 
• Each analyte's name, peak area or concentration, asymmetry, 

efficiency, and retention time information 

• Resolution criterion 

• Injection volume 

• Methodologies 

• Column name and size 

• Temperature 

• Eluent concentration at the gradient start 

• Flow rate 

• System void time and void volume 

When you reload the saved file, the settings are restored and the 
corresponding Resolution Response Surface and Virtual Chromatogram 
are displayed. 

To save settings: 
Select Save on the File menu. The .vcol extension is assigned to the saved 
file.  

 Tip: 
Virtual Column settings files are saved in the ..\My Documents\Virtual 
Column Custom Files folder.  

To reload a saved file: 
1. Select Open on the File menu. 

2. Select a .vcol file and click OK. 

 The Load Selected File dialog box opens. This dialog box displays the 
analyte data saved in the selected .vcol file and gives you the 
opportunity to choose the data from the saved file that you want loaded 
into the Virtual Column analyte table.  
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3. Clear the check box above any column (Peak Area, mg/l, mM, 
Asymmetry, or Efficiency) that you do not want loaded.  

4. Clear the Void Time check box if you do not want the void time loaded.  

5. Clear the Inj. Volume check box if you do not want the injection volume 
loaded. 

 Note: 
If you clear a check box in the Load Selected File dialog box, Virtual 
Column loads the current user interface setting for the item instead of the 
data from the saved file. If no setting for the item exists (or if the setting is 
invalid), Virtual Column loads data for the item from the embedded Virtual 
Column database. 

6. Click OK. 

 Viewing the Eluent Composition 
Virtual Column can provide detailed instructions for preparing the eluents 

corresponding to the currently selected conditions. This option is available 
only when an isocratic simulation is selected.  

1. Select Eluent Composition on the View menu on the Chromeleon 
menu bar. 

The Eluent Composition dialog box opens. 

2. Click the Eluent Species option button to display information for the 
eluent of interest. 

3. Click Print to print the contents of the dialog box. 

4. Click Close to exit. 

 Modeling Gradient Separations 
Virtual Column’s gradient predictions are based on gradient data acquired 

under conditions that equate to zero delay time. This means that the start of 
the concentration ramp reaches the column at exactly the same moment as 
the sample, thus eliminating any effects of isocratic elution of the sample 
before the ramp begins. 
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If you try to reproduce results obtained in Virtual Column, take into 
consideration that your results may include a delay time, while those 
obtained with Virtual Column do not. This should have little effect on the 
results unless high starting concentrations are used in conjunction with low 
slopes; in that case, monovalent species with short run times may 
experience a shift in retention time compared to other species. 

 Note: 
The Chromeleon Virtual Column Linear Gradient license is required to use 
Virtual Column to simulate gradient separations. 
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Device Control 

Device Control 
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Device Control (Overview) 

Device Control  
(Overview) 

Chromeleon allows you to control several HPLC, IC, and GC devices from 
various manufacturers. To support the different device functions, you can 
use the corresponding commands in Chromeleon.  

For more information, refer to: 

 General Commands for Device Control 

 Commands for Controlling Dionex Devices 

 Commands and Tips for Third-Party Devices 

Also, refer to  Practical Tips for Device Control. 
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General Commands for Device Control 

General Commands for  
Device Control 

Certain commands are used independent of the installed devices, for 
example: 

 System Commands 
 General Commands 
 General Device Commands 

 
For information about special commands for the respective devices, refer 
to: 

 Commands for Controlling Dionex Devices 

 Commands and Tips for Third-Party Devices 

 System Commands 
System control comprises all commands that concern the entire 
chromatographic process or the entire system. The commands are 
available via both Command on the Control menu and the F8 key in the 
Commands view of the PGM Editor. Some commands are available on the 
toolbar, also.   
 
Command Description 

⇒AbortSample Stop data acquisition and sample; continue the Batch with the next 
sample. 

⇒AbortBatch Stop data acquisition and batch processing. 
ConsumableChanged Log in the Audit Trail that a consumable has been changed.  
⇒Continue Continue all operations that are in Hold mode. 
EluentChanged Log in the Audit Trail that the solvent has been changed.  
⇒Hold Freeze a running gradient program, stop data acquisition, and stop 

batch processing. 
HoldMode If Hold mode is enabled, the timebase waits for an event, e.g., a 

Continue command. In Hold mode, the retention time and the pump 
gradient are stopped. The pump continues to deliver the solvent; the 
flow rate and the solvent composition remain unchanged. 
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Command Description 

⇒Sound Generate a sound of selectable frequency and duration that is heard 
on the PC loudspeaker.  

⇒StopFlow Stop pump flow, interrupt data acquisition, and stop batch processing. 
StopMode If Stop mode is enabled, the timebase waits for an event, e.g., a 

Continue command. In Stop mode, the retention time and the pump 
flow are stopped. 

 General Commands 
Independent from the installed instruments, Chromeleon supports the 
following general commands (under the device commands): 
 
Command Description 

⇒Branch Completes the active Program and starts another one  
⇒Delay Especially with trigger commands, execution of the next program 

command is delayed for the specified time. 
⇒EndTrigger Continues all processes in hold mode. 
⇒End Starts or stops data acquisition. 
⇒Log Logs device variable values in the Audit Trail (see Data Management 

 Audit Trails). 
⇒Message Displays a message to the user and interrupts the program until the 

message is clicked. 
⇒Protocol Logs any message in the Audit Trail 
⇒Trigger Freezes a running gradient program, stops data acquisition, stops 

sample processing. 
⇒Wait: Interrupts the program until a certain condition is fulfilled.  

 General Device Commands 
Most device commands are specific for a certain type of device or even for 
a certain device. For example, the ⇒Flow command is available for pumps 
and the ⇒Inject command is available for autosamplers. However, some 
commands are available independent of the device type: 
 
Command Description 

⇒Connect Connects the device to Chromeleon  
(also, see Connected, Disconnect). 

Connected Indicates whether the pump is connected to Chromeleon, that 
is, under computer control (also, see Connect, Disconnect) 

Disconnect Disconnects the pump from Chromeleon 
(also, see Connect, Connected).  
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The following commands and properties appear very often. However, they 
are not available for every device: 

Command Description 
FirmwareVersion Indicates the firmware version of the device (read-only). 
ModelNo Indicates the device type (read-only). 
Ready Indicates that the device is ready for operation, i.e., no 

Autozero is started, the temperature has been reached, no 
error has occurred (read-only). 

⇒Reset Resets the device to its initial conditions, as attained after 
power-up. 

SerialNo Indicates the serial number of the device (read-only).  
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Commands for Controlling Dionex Devices 
Commands for Controlling  

Dionex Devices 
Chromeleon supports all functions and commands of the Dionex devices. 
This section provides the special commands that Chromeleon supports for 
the corresponding devices. 

For information about the general commands supported for the respective 
device types and often for third-party devices, too, refer to:  

 Dionex Pumps  
 Dionex Sample and Fraction Manager 
 Dionex Autosamplers 
 Dionex Flow Manager and Thermostatted Column Compartments 
 Dionex Detectors 
 Dionex Ion Chromatography Systems 
 Additional Dionex Components 

 
Optimum support for all functions is ensured for Dionex devices. For a list 
of the third-party devices that are currently supported, refer to Hardware 
Installation  Installing and Controlling Third-Party Devices in the 
Administrator Help section. 

For information about the commands for third-party devices, refer to 
 Commands and Tips for Third-Party Devices. 
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Dionex Pumps 

In addition to the  General Device Commands, Chromeleon supports 
the following commands for controlling HPLC and IC pumps:  
 
Command Description 

⇒Flow Enter the desired flow rate. 
⇒Pressure.Lower/UpperLimit Sets the pressure limits. 
⇒WasteLevel Enter the actual waste level before starting a sequence. 

 
The following additional commands are available for controlling gradient 
pumps (P680, DP/SP, GP40/GP50, GS50, LPG-3x00, and P580): 
 
Command Description 

⇒%B, %C, %D Changes the solvent composition, determines the gradient 
course. 

⇒%A, %B, %C, %D_Level Enter the amount of solvent that is available when you start 
the sequence.  

Commands can be selected directly (via the toolbar, menu bar, or a control) 
or as part of a Program (programmable button). 

They enable delivery of a specific liquid volume of defined composition, as 
well as starting and holding the pump. The pump is automatically placed on 
hold as soon as the upper or lower pressure limit is exceeded. Changing 
the flow rate creates a Flow Gradient, changing the solvent composition 
creates a % Gradient. Flow and % gradients can be realized 
simultaneously. 

 Tip: 
Dionex GP40/GP50, GS50, IC20/IC25, IP20/IP25, and IS25 pumps do not 
deliver flow gradient ramps. Instead, changing the flow rate creates a step 
change; that is, flow rate changes are made immediately, not gradually 
over time. Refer to Practical Tips for Device Control  Pump 
Commands for additional information.  

Dionex P680, DP/SP, LPG-3x00, and P580 Pumps 
The Dionex P680, DP/SP, LPG-3x00, and P580 pumps support automatic 
pre-compression control. The pumps are capable of adjusting to the 
compressibility of commonly used solvents. In addition, Learn and Freeze 
commands are available for the P580 pump to extend pre-compression 
control to unknown solvent types. Pre-compression control is fully 
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automatic for the P680, DP/SP, and LPG-3x00 pumps. Therefore, the 
Learn and Freeze commands are not required. 

Command input is identical for the Low-Pressure Gradient System and 
High-Pressure Gradient System.  

 Caution: 
Chromatography pumps are high-precision instruments! Dry operation or 
crystallization of buffer solutions within the fluidic system must be avoided. 
The most common cause of such problems is stopping pump flow without 
turning off the lamp of an optical detector. The flow cell heats up, and the 
solvent evaporates. Deposits of substances can result, for example, from 
the presence of salt in a buffer solution.  

For information about special commands for the pumps, refer to  

 Dionex P680 HPLC Pump 

 Dionex DP/SP IC Pumps 

 Dionex LPG-3x00 Micro Pump 
 

Dionex GP40/GP50, GS50, IC20/IC25, IP20/IP25, and IS25 Pumps 
In addition to the general pump commands, the following commands are 
available for controlling the isocratic or gradient pumps listed above: 
 
Command Description 
On Turns the pump motor on 
Off Turns the pump motor off 
Prime Primes the pump  

For pump operating specifications, refer to the individual pump operator's 
manuals.  

Also, see: 

 Dionex/LC Packings UltiMate Capillary/Nano HPLC Pump 

 PP-150 Preparative HPLC Pump 

 Controlling Pumps Without a Separate Device Driver 
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 Dionex P680 HPLC Pump 

In addition to the standard pump commands (see  Dionex Pumps), the 
P680 pumps support the following commands and properties (please note 
that the display Filter level determines which commands and properties 
are displayed): 
 
Command/Property Description 
AnalogOut Determine whether the pressure of the left or right pump is 

monitored via the Analog Out port on the pump (available for 
pumps with firmware 2.50.05 or higher).  

CamRevolutionsRight 
CamRevolutionsLeft 

Indicates the number of revolutions of the camshaft of the right 
of left pump block. The CamRevolutionsLeft command is 
available for HPG pumps only. 

Curve Determines the curvature for flow gradients (see Gradient 
Curves) 

Degasser Turns the degasser of a P680A LPG-4, SOR-100, or SRD-3x00 
solvent rack on or off. The integrated degasser should always 
be on.  

DegasserVacuum Reports the status of the solvent rack degasser (P680A LPG-4, 
SOR-100, or SRD-3x00 only): OK or NotOK (read-only; 
available for pumps with firmware 2.03 or higher). 

HeadType Indicates the head type of the pump: Analytical or Semi-Prep 
(read-only). 

Leak Indicates the status of the central leak sensor: Ok or Leak 
(read-only).  

LeakAlarm On indicates that there is a leak alarm (read only; available for 
pumps with firmware 2.50.05 or higher). 

LeakAlarmOff Turns off the acoustic beep for the current alarm (available for 
pumps with firmware 2.50.05 or higher). 

LeakDelay Sets the time for how long a leak may occur before the pump 
shuts down (available for pumps with FW 2.50.05 or higher). 

LeakSensorMode Specifies how leak detection is performed: 
Enabled−enables leak detection; an acoustic beep sounds 
when the leak sensor is activated.  
Silent−enables leak detection, but no beep sounds when the 
leak sensor is activated. 
Disabled−disables leak detection. 

MaximumFlowRamp Upper limit for the flow rate acceleration  
(0.1 - 10,000.00 ml/min²)  

ModelVariant Indicates the variant: Isocratic, LPG, or HPG (read-only) 
Motor Indicates whether the pump is delivering: On or Off (read-only) 
Pump_Pressure Commands and properties for the pressure signal (see below) 
⇒Purge Set to On to enable purging (available for pumps with FW 

2.50.06 or higher). 
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Command/Property Description 
PurgeFlow Enter the flow [in mL/min] to be delivered by the pump during 

purging (range: 0,000 to 10.000 mL/min or 20.000 mL/min for 
HPG pumps with enabled Double Flow option; available for 
pumps with FW 2.50.05 or higher). 

PurgeTime Specify how long purging shall be performed (0 - 1000 s) 
(available for pumps with FW 2.50.05 or higher). 

RearSealLeakCounter Indicates the number of drops that passed the piston seal in the 
past hour. 

RearSealLeakLimit Specifies the leak detection threshold for the rear seal wash 
system. If the limit is met, a message is displayed in the Audit 
Trail and on the pump. 

RearSealWashPump Indicates whether the peristaltic pump of the rear seal wash 
system is running (Active) or not (Idle) (read-only). 

RearSealWashSystem Turns the rear seal wash system on (Interval or Automatic) or 
Off.  
Interval activates rear-seal washing once per hour for five 
minutes. However, the drop sensor on the liquid reservoir is not 
active, i.e., monitoring the piston seals for tightness is disabled. 
Automatic periodically activates rear-seal washing once per 
hour until the drop sensor has counted 50 drops. The drop 
sensor is active, i.e., the piston seals are monitored for 
tightness is enabled. Off turns the rear-seal wash system off. 

SolventRackLeak Reports whether the leak sensor in the solvent rack detected a 
leak: Leak or NoLeak (read-only; available for pumps with FW 
2.03 or higher). 

WorkLoadLeft Indicates the workload of the left pump block in [MJ] (read-only). 
The WorkLoadLeft command is available for HPG pumps only. 

WorkLoadRight Indicates the workload of the right pump block in [MJ] (read-
only). 

Pump_Pressure 

If you have selected the Pressure Signal(s) check box on the Devices 
page in the Server Configuration program, Chromeleon records the pump 
pressure as a separate channel (Pump_Pressure). The following 
commands and properties are available: 
 
⇒AcqOn/AcqOff AcqOn starts data acquisition. AcqOff terminates data acquisition. 
⇒Average Averages all measured values. 
⇒Delta Reports the signal's slope, i.e., the difference between the value 

and the value one second ago (read-only). This is useful for 
⇒Triggers.  

⇒MaxAutoStep  Sets the maximum step rate for Step = Auto. 
⇒Step Set the step for data acquisition. 
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Equilibration Commands and Properties 
 

 Tip:  
You should use the equilibration commands and properties only for the 

SmartStart feature. 
 
Equilibration Reports the equilibration status. 
Ripple Reports the ripple of the pump pressure. 
 UpperLimit Determine the upper limit for the ripple of the 

pressure signal in [%]. The upper limit can be any 
value between 1.0% and 5.0%. The default setting 
is 3.0%. 

 Value (Read-only) Reports the actual value (usually, this 
value is averaged over the last 5 minutes.): At the 
beginning (i.e., after installation of the pump), the 
value field is empty, indicating that no measurement 
has been performed yet. Chromeleon calculates the 
value as soon as a 1-minute segment has been 
measured and updates the value with each new 
segment. The value of the property does not 
change after the measurement and is displayed 
under Preconditions. 

RippleStatus Reports the ripple equilibration status of the pump pressure (read-
only) 

 N/A Equilibration was not yet performed. 
 Measuring Equilibration is running but the amount of data is 

not yet sufficient to report a result. 
 Good Equilibration is running or terminated. The values 

are within the specified limits. 
 NotReady Equilibration is running. The current data is outside 

the specified limits. 
 Failed Equilibration is completed. The result is outside the 

specified limits. 
 NotTested The limit was set to 0, thus disabling ripple 

checking. 
StartEquilibration Starts equilibration. For more information, refer to How to ...: 

 Equilibrating the Chromatography System.  
For information about how to install the pump, refer to Hardware 
Installation  P680 HPLC Pump: Overview in the Administrator Help 
section. 
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 Dionex DP/SP Pumps 

In addition to the standard pump commands (see  Dionex Pumps), the 
DP/SP pumps support the following commands and properties (please note 
that the display Filter level determines which commands and properties 
are displayed): 
 
Command/Property Description 
CamRevolutionsLeft 
CamRevolutionsRight 

Indicates the number of revolutions of the camshaft of the left or 
right pump block. 

Degasser Turns the integrated vacuum degassing module on or off. The 
degassing module normally remains on at all times. 

HeadType Indicates the head type of the pump: Analytical or Semi-Prep 
(read-only). 

Leak Indicates the status of the main leak sensor: Ok or Leak (read-
only).  

MaximumFlowRamp Upper limit for the flow rate acceleration:  
(0.1 to 10,000.00 ml/min²). 

ModelVariant Indicates the variant: Isocratic or Gradient (read-only). 
Motor Indicates whether the pump is delivering: On or Off (read-only). 
RearSealLeakCounter Indicates the number of drops that passed the piston seal in the 

past hour. 
RearSealLeakLimit Specifies the leak detection threshold for the rear seal wash 

system. If the limit is reached, a message is displayed in the 
Audit Trail. 

RearSealWashPump Indicates whether the peristaltic pump of the rear seal wash 
system is running (Active) or not running (Idle) (read-only). 

RearSealWashSystem Turns the rear seal wash system on (Interval or Automatic) or 
Off.  
Interval activates rear-seal washing for 5 minutes every hour. 
During this time, the drop sensor on the liquid reservoir is not 
active, i.e., the pistons seals are not monitored for tightness. 
Automatic periodically activates rear-seal washing once per 
hour until the drop sensor has counted 50 drops. During this 
time, the drop sensor is active, i.e., the piston seals are 
monitored for tightness. 
Off turns off the rear-seal wash system. 

WorkLoadLeft Indicates the workload of the left pump block in MJ (read-only). 
WorkLoadRight Indicates the workload of the right pump block in MJ (read-

only). 
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 Dionex LPG-3x00 Micro Pump 

In addition to the standard pump commands (see  Dionex Pumps) and 
the P680 pump commands (see  Dionex P680 HPLC Pump), the LPG-
3x00 micro pumps supports the following commands and properties 
(please note that the display Filter level determines which commands and 
properties are displayed): 

Flow and Pressure commands and properties 
Chromeleon supports the following commands and properties only if the 
pump is connected to a flow splitter. (In the standard configuration of an 
LPG-3600, Dionex recommends assigning the flow splitter to the right 
pump (MicroPump).) 
 
Command/Property Range Description 
Flow 0.000 - 2500.000 Sets the flow rate [µl/min]. This is the total 

flow through the column. (The valid range 
depends on the split ratio.) 

MasterFlow 0.000 - 2500.000 Reports the flow through the master pump, 
i.e., the flow before the flow splitter, in 
[µl/min]. 

MasterPressure 0 - 500 bar Reports the pressure of the master pump, 
i.e., the pressure before the flow splitter. (This 
property is read-only. The channel is 
recorded as MicroPump_MasterPressure.) 

*.LowerLimit 
*.UpperLimit 

 Set the lower and upper pressure limits at the 
master pump. If the pressure exceeds the 
upper limit for 0.15 seconds or if it is below 
the lower limit for more than 60 seconds, the 
system aborts the running batch and starts 
error handling (see 
⇒Pressure.Lower/UpperLimit). 

Pressure 0 - 350 bar Reports the current column pressure. (This 
property is read-only. The channel is 
recorded as ColumnPressure.)  

*.LowerLimit 
*.UpperLimit 

 Set the lower and upper pressure limits at the 
column. If the pressure exceeds the upper 
limit or if it is below the lower limit for more 
than 5 minutes, the system aborts the running 
batch and starts error handling.  

If the pump has no flow splitter assigned, Flow and Pressure refer directly 
to the pump outlet. In the standard configuration of an LPG-3600, this is the 
LoadingPump, which is the left pump. 
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Command/Property Range Description 
Flow 0.000 - 2500.000 Sets the flow rate [µl/min]. This is the total 

flow through the pump.  
Pressure 0 - 500 bar Reports the pressure. (This property is read-

only. The channel is recorded as 
LoadingPump_Pressure.)  

*.LowerLimit 
*.UpperLimit 

 Set the lower and upper pressure limits at the 
loading pump. If the pressure exceeds the 
upper limit for 0.15 seconds or if it is below 
the lower limit for more than 60 seconds, the 
system aborts the running batch and starts 
error handling (see ⇒Pressure.Lower/ 
UpperLimit).  

Display commands and properties 
Command/Property Range/Values Description 
Brightness 0 - 100 %  Adapts the brightness of the pump's front 

panel display to your requirements. 
Contrast 0 - 100 %  Adapts the contrast of the pump's front panel 

display to your requirements. 
DisplayMode Left_Master (0) 

Left_Column (1) 
Right_Master (2)
Right_Column (3)
Both (4) 

Specifies which information appears on the 
pump's front panel display. 

 

Additional commands and properties 
Command/Property Range/Value Description 
Relay2Enabled Yes (0),  

No (1) 
Determines whether relay 2 can be used in 
Chromeleon (Yes) or whether it is controlled 
by the pump for the Left Cam Sync Out signal 
(No). 

Relay3Enabled Yes (0),  
No (1) 

Determines whether relay 3 can be used in 
Chromeleon (Yes) or whether it is controlled 
by the pump for the Operable Out signal (No).  

Relay4Enabled Yes (0),  
No (1) 

Determines whether relay 4 can be used in 
Chromeleon (Yes) or whether it is controlled 
by the pump for the Right Cam Sync Out 
signal (No). 

⇒ParkPercentage 0.00 - 100.00 % Enables peak parking. The flow is reduced to 
the specified percentage of the current flow. 

PeakParked No (0), 
Yes (1) 

Reports the status of peak parking (read-
only). Reports Yes while the pump delivers 
the reduced flow set by ParkPercentage. 
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Command/Property Range/Value Description 
SelfTest Passed or  

NotPassed 
Performs a self-test. 

 Note:  
You cannot start a batch when the pump did 
not pass the self-test. 

Standby NoStandby (0), 
Standby (1) 

Sets the pump into the Standby mode or 
cancels this mode (NoStandby). The pump 
remains connected to Chromeleon. 

 Note:  
You cannot start a batch when the pump is in 
standby mode. 

 
For information about how to install the pumps, refer to Hardware 
Installation  LPG-3x00 Micro Pump: Overview in the Administrator 
Help section. 

 Dionex/LC Packings UltiMate Capillary/Nano HPLC 
Pump 

In addition to the standard pump commands (see  Dionex Pumps), the 
pumps of the UltiMate system support the following commands and 
properties (please note that the display Filter level determines which 
commands and properties are displayed): 
 
Command/Property Description 
CycleTime Indicates the time in [s] for a switching cycle of the LPG 

pump proportioning valves; values between 1 and 5s are 
possible. 

CalibratorType Indicates the calibrator type, for example, NAN-75 (read-
only). 

Description Optional device description (read-only). 
⇒Flow Indicates the system flow, i.e., flow through the separation 

column: 
0.000 to 200.000 µl/min 

HeadType Indicates the pump head (read-only): 
None 
Steel_10ml 
Ceramic_10ml 

InstallationDate Indicates the installation date (read-only). 
LastHeadRevolutionCounter Indicates the total number of cycles performed by the 

corresponding pump head (read-only). 
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Command/Property Description 
LastService Date Indicates the date when the last service procedure was 

performed (read-only). 
LastServiceCode Indicates the code number of the last service (read-only). 
Motor Turns the pump on or off. 
⇒ParkPercentage Enables or disables peak parking and sets the new flow to 

the entered percentage of the previous flow  
(values: 0 - 100% or Disabled). 

PeakParked State of peak parking (read-only). 
PowerIndex Pressure index in [MPah] (read-only) - a measure of pump 

wear: 

∫ Pressure dt 
Pressure.LowerLimit 
Pressure.UpperLimit 

If these limits are exceeded/not met for more than 60 
seconds, the system aborts the running batch and starts 
emergency handling (see ⇒Pressure.Lower/UpperLimit) 

TotalPumpCycles Indicates the total number of pump cycles (read-only). 
TotalVolume Indicates the total volume in [ml] (read-only). 
TotalWorkingTime Indicates the total number of power-on hours (read-only).  
The UltiMate system splits the flow before the column. Usually, only a part 
of the flow delivered by the pump is directed through the column. This 
"system flow" is determined via the Flow command. The flow that must be 
delivered by the pump to achieve the desired system flow is calculated via 
the CRP value. The maximum system flow is 200.000 µl/min; the maximum 
permissible pressure is 400 bar. 

The micropump in the UltiMate system is the "master pump." The master 
pump is responsible for generating the system flow. The four standard 
parameters for the master pump (before the flow splitter) are Flow, 
PressureLowerLimit, PressureUpperLimit, and PressureValue. These 
parameters can be checked separately, if desired, by entering the term 
"Master" before the command (for example, MasterPressureUpperLimit). 
The pressure limits for the master pump can be issued separately. The 
range for the pressure limits corresponds to the range for the pressure 
limits of the entire system. However, the flow of the master pump can be no 
more than 0.5 ml/min. With a Bypass Calibrator installed, up to 5 ml/min is 
possible. 

Commands without the Master prefix refer to the values behind the flow 
splitter, i.e., to the column flow and the column pressure. In this connection, 
ColumnPressure refers to the column and TrapColumnPressure refers to 
the precolumn on the Switchos Switching Device. 
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The following commands and properties are supported for the flow sensor: 
 
Command/Property Description 
CalibrateCRP 
[When={BeforeFirstSample| 
BeforeEachSample}] 

Performs flow measurement and recalculates CRP. (The 
property is visible only on the Expert level.) 

Ready Indicates the state of the flow sensor: Ready or NotReady. 
(The property is visible only on the Advanced level and is 
read-only.) (NotReady is indicated during the flow 
recalibration procedure.)  

Type Indicates the type of the flow sensor type. (The property is 
visible only on the Expert level and is read-only.)  

For information about how to install the UltiMate pump, refer to Hardware 
Installation  UltiMate Capillary/Nano HPLC System: Overview in the 
Administrator Help section. 

 Dionex/LC Packings UltiMate Pump: Columns 

In addition to the pump commands (see  Dionex/LC Packings UltiMate 
Pump), the following commands and properties are available for controlling 
columns in the UltiMate system (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Command/Property Minimum Maximum Description 
BatchNo 64 characters Column batch number. 
CRP 0.0 2000.0 Factor for calculating the master flow ². 
Diameter Other, 50µm, 75µm, 

100µm, 180µm, 300µm, 
500µm, 800µm, 1000µm 

Internal diameter of the column 
(required for calculating the CRP 
value). 

Length Other, 50mm, 100mm, 
150mm, 200mm, 250mm 

Column length (required for calculating 
the CRP value). 

Manufacturer 64 characters Column manufacturer. 
Material 64 characters Column material³.  
MeasuredFlowRate 0.000 

µl/min 
10.000 
µl/min 

Measured flow rate. If set, the CRP 
value is calculated automatically via the 
measured flow rate (also, refer to ²). 

ParticleSize 0.0 µm 2000.0 µm Particle size³ of the column material. 
PoreWidth 0.0 Å 2000.0 Å Pore width³ of the column material. 
SerialNo 64 characters Column serial number. 
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Command/Property Minimum Maximum Description 
StationaryPhase Other, C18_3µm_100A, 

C18_5µm_100A, 
C18_3µm_300A, 
C18_5µm_300A 

Stationary phase of the column 
(required for calculating the CRP 
value). 

² Master flow [ml/min] = CRP*system flow [µl/min]  
If possible, this value is automatically calculated from the lookup table 
(using the settings for Length, Diameter, and Stationary Phase) whenever 
one of these parameters is changed. Override the value if your column is 
not mentioned in the table. For more information, refer to Practical Tips for 
Device Control  Determining the CRP Value. 

³ This value is automatically set whenever the StationaryPhase parameter 
changes. The user can override the value. 

The different parameters describing the column material (BatchNo, 
Manufacturer, Material, ParticleSize, PoreWidth, and SerialNo) are only 
available from the Advanced level on. All other parameters are available on 
the Normal Filter level. 

 PP-150 Preparative HPLC Pump 
In addition to the standard pump commands (see Commands for 
Controlling Dionex Devices  Dionex Pumps), the commands and 
properties from the table below are available (please note that the display 

Filter level determines which commands and properties are displayed). 
 
Property Values Description 

⇒%B, %C, %D 0.0 - 100.0 % Use %B, %C, and/or %D to determine the 
solvent composition. 

⇒Flow 0.000 - 9.999 ml/min Sets the flow rate. 
Motor On/Off (Only available for the first pump) Turns 

the (all) pump(s) on or off 
ModelVariant Unknown 

Isocratic 
LPG 
HPG 

Indicates the pump's operating mode 
(read-only). Set the operating mode on 
the Pumps tab page in the Server 
Configuration program. 

Pressure 0 - 432 bar  Indicates the pressure (read-only). 
Pressure.LowerLimit 0 - 392 bar Sets the lower pressure limit. 
Pressure.UpperLimit 10 - 432 bar Sets the upper pressure limit. 
Solvent 
(Pump: PASV, PBSV, 
PCSV) 

A, B, C, D (For pumps with connected FCV Solvent 
Selector) Selects the solvent. 
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 Tip: 
To use the Motor On/Off, CycleMode, and Solvent properties, you have 
to enter them manually in the PGM Editor. 

Observe the following when creating a program: 
• When the pressure unit is psi, always add the entry in brackets, e.g. 

PrepPump.Pressure.LowerLimit = 400 [psi] 

• Try to avoid ⇒Delay. Instead, use the retention time whenever 
possible. 

• In triggers, use ⇒AbortSample instead of ⇒End.  

• Use ⇒Protocol instead of ⇒Message. 

For information about how to install the pump, refer to Hardware 
Installation  PP-150 Preparative HPLC-Pump: Overview in the 
Administrator Help section. 

 Controlling Pumps without a Separate Device Driver 

In addition to the device drivers for  Dionex Pumps, Chromeleon 
provides many drivers for controlling third-party pumps. For an overview of 
the different manufacturers whose devices can be controlled by 
Chromeleon, refer to Hardware Installation  Installing and Controlling 
Third-Party Devices in the Administrator Help section. 

Besides, pumps can be controlled for which separate device drivers or 
serial interfaces are not available (for example, the former Gynkotek M300 
pump). Depending on the type of pump to be controlled, the following plug-
in boards are available: 

1. "Dionex Pump DA Converter (12 Bit)" (for voltage-controlled pumps) or 

2. "Dionex Pump Control Card" (for frequency-controlled pumps). 

The Administrator Help section provides more information; refer to 
Hardware Installation: 

 Installing the Dionex 12-Bit DAC Card  

 Installing the Pump Control Card 
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In addition, install the respective device driver, for example, DAC Pumps 
(for voltage-controlled pumps) or Pump Control Board Pump(s) (for 
frequency-controlled pumps). (For more information, refer to How 
to …: Configuring the Chromeleon Server  Adding, Configuring, or 
Deleting Components in the Administrator Help section.) 
 
Chromeleon supports the following commands for voltage-controlled pumps 
(DAC pumps): 
 
Command Description 

⇒Flow: Change the flow rate 
⇒%B, %C, %D: Change the solvent composition, determines the course of the 

gradient  
In addition, a reset can be performed for frequency-controlled pumps, 
which are installed via the Pump Control Board Pump(s) device driver. 
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Dionex Sample and Fraction Manager 

For information about the different commands, refer to  Sample and 
Fraction Manager Commands and/or  Commands for Fraction 
Collection.  

For additional tips and program examples for the different injection modes, 
refer to: 

 Tips for Injection 

 Overlapping Areas 

 PGM File for Fraction Collection 

For information about how to solve possible problems, refer to  Sample 
and Fraction Manager: Troubleshooting 

 Sample and Fraction Manager Commands 

Apart from  General Device Commands, the Sample and Fraction 
Manager supports the following commands and properties (please note that 
display Filter level determines which commands and properties are 
displayed): 

Status properties 
 
Property Value Range Filter Description 
Busy Busy/Idle Expert Indicates whether the device 

driver has not yet sent all 
commands or whether execution 
of a command is yet complete  
(read-only). 

CPUSerialNo - Expert Indicates the CPU serial number 
of the connected sampler  
(read-only). 

DeviceState Ready/Busy/ 
Init(Error)/Unknown 

Normal Indicates the current device 
status (read-only). 

StatusDescription - Normal Indicates the current action of the 
sampler. If no action is 
performed, Idle is displayed  
(read-only). 

Syringe - Normal Indicates the installed syringe 
type (read-only).  
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Inject properties 
 
Command Value Range Description 
AirVolume Depends on the volume of the 

installed syringe; indicated in 
µl.  
Special value: Default* 

Specifies the air volume that is drawn 
for the Inject and/or 
WashWithSample commands (in 
LC_Inject and LC_Overlap mode). 

FillSpeed Depends on the minimum and 
maximum speed of the 
installed syringe; indicated in 
µl/s. 
Special value: Default* 

Fill speed for the preparing fill strokes 
for the Inject and/or 
WashWithSample commands. 

FillStrokes 0-99 or Default* Number of preparing fill strokes for the 
Inject and/or WashWithSample 
commands (in LC_Inject and 
LC_Overlap mode). 

FillVolume Depends on the syringe 
volume; indicated in µl.  
Special value: Default* 

Fill volume for the single piston strokes 
(for the WashWithSample command). 

InjectMode LC_Inject  
LC_Overlap 

Injection mode. In sample programs, 
this value must be set prior to the 
Inject command. 

Injector List of injection objects for the 
respective arm of the installed 
Sample and Fraction Manager 

Injector to be used for the Inject and/or 
WashWithSample commands (in 
LC_Inject and LC_Overlap mode). 
The setting is ignored in Custom 
injection mode. 

InjectSpeed Depends on the minimum and 
maximum speed of the 
installed syringe;  
Special value: Default* 

Syringe speed in µl/s for injections to 
the sample loop 
(in LC_Inject and LC_Overlap mode).  

NoOfPlungerStr
okes 

 Indicates the number of strokes since 
the last reset (Value) and maximum 
allowed number (Max.) as reported by 
the device. (The property is read-only.) 

NoOfInjects  Indicates the number of injections 
since the last reset (Value) and 
maximum allowed number (Max.) as 
reported by the device. (The property 
is read-only.) 

Penetration 0 - maximum value of all 
installed tray types 

Defines how deep the needle 
descends into the vial (parameter for 
Inject, PrepareThisSample, 
PrepareNextSample, 
WashWithSolvent). 
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Command Value Range Description 
Position 1 to maximum number of 

tubes allowed for the trays 
used in the current 
configuration. 

Defines the absolute position via an 
index entry, which can be defined as 
<TrayName> <Tube>. 
Note: When you select a different 
position, the Tube, Tray, and 
TrayName properties are updated 
automatically. 

PostInjectDelay 0 - 99000 ms or Default* Time between the injection and the 
removing of the needle from the 
injector (in LC_Inject and LC_Overlap 
mode). 

PreInjectDelay 0 - 99000 ms or Default* Time between inserting the needle in 
the injector and injecting the liquid into 
the sample loop (in LC_Inject mode). 

PullupDelay 0 - 10000 ms or Default* Indicates the delay time between 
drawing the liquid into the syringe and 
dispensing the volume that is not 
required (for the WashWithSample 
command). 

Tray  Trayused (read-only - determined via 
the Position property). 
 

TrayName String Indicates the name of the current tray  
Note: If you select a different tray, the 
Tray property is updated automatically. 

Tube  Number of the current tube in the tray 
(read-only - determined via the 
Position property) 

*  Note:  
For the Default parameter, the default value set on the respective device is 
used. 

Command for the analytical SFM 
 
Command Description 
CloseStack Closes all stacks that might be open. This might be useful when fraction 

collection is finished.   
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Commands for the LC_Overlap mode 
 
Command Description 
PrepareNextSample The autosampler fills the sample loop with the next sample, observing 

the parameters defined in the PGM file for that sample (Volume, 
Position, Tray, AirVolume, FillSpeed, FillStrokes, and PullupDelay). 
The syringe then returns to the Park position. 
This command is ignored for InjectModes other than LC_Overlap. 
This command is available only after the Inject command in the PGM 
File. 

PrepareThisSample The autosampler fills the sample loop with the current sample, 
observing the parameters defined in the PGM File for the current 
sample (also, see PrepareNextSample). This command is available 
only before the Inject command in the PGM File.  

For more information, refer to: 

 Commands for Fraction Collection 

 Tips for Injection 

 Overlapping Areas 

 PGM File for Fraction Collection 

 Sample and Fraction Manager: Commands for Fraction 
Collection 
Chromeleon supports the following commands and properties for fraction 
collection with the Sample and Fraction Manager (SFM) (please note that 
the display Filter level determines which commands and properties are 
displayed): 

Commands 
 
Command Description 
Collect Moves the syringe to the Collect position.  
Drain Moves the syringe to the Drain position without ejecting the contents of 

syringe.  
Eject Ejects the remaining contents of the syringe before the syringe is moved to 

the Drain position.   
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Properties 
 
Property Value Range Description 
CollectMode Vertical, 

SawVertical, 
Horizontal, 
SawHorizontal 

Indicates the collect mode set on the Options tab 
page in the Server Configuration program. (The 
property is read-only.) 

FracTrayName Available trays Indicates the name of the tray specified via the 
TubePosition property. (The property is read-only.) 

FracTrayTube 1 to maximum 
number of 
tubes per tray 

Indicates the tube index in the tray, referring to the 
absolute TubePosition. (The property is read-only.) 

MovementMode StopAndEject, 
Stop, Collect 

Specifies the behavior of the SFM if the 
TubePosition is changed during collection: 
StopAndEject: The remaining sample is ejected into 
the original tube, the SFM moves to the next tube 
position and continues collecting. 
Stop: Before moving to the next tube, the syringe 
moves to the Drain position without ejecting the 
remaining contents of the syringe.  
Collect: The syringe moves to the next tube position 
and continues collecting. 

TotalNumberInstalled - Indicates the total number of tubes. This property can 
be used to set the respective property of the Fraction 
Collection driver. (The property is read-only.) 

TubePosition 1 to number of 
tubes 

Enter the absolute position of the tube to which the 
sample arm shall be moved. If this property is set 
while the SFM is collecting, the behavior depends on 
the MovementMode setting.  

For more information, refer to: 

 Sample and Fraction Manager Commands 

 Tips for Injection 

 Overlapping Areas 

 PGM File for Fraction Collection 
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 Sample and Fraction Manager: Tips for Injection 
Chromeleon supports the different parameters for sample loading and 
injecting.  

Parameters supported for sample loading: 

Position, Volume, AirVolume, FillSpeed, FillStrokes, and PullupDelay 
Parameters supported for injection: 

PreInjDelay, PostInjDelay, InjSpeed, and Injector. 
 
When performing an inject command, the Sample and Fraction Manager 
performs the following steps: 

1. The sample needle is moved to the specified tube.  

2. The specified sample volume is drawn into the syringe. 

3. Optional: If the AirVolume parameter is set to a value > 0, air is drawn 
from outside the tube.  

 Note: 
Steps 1 through 3 omitted if they were already performed via the 
PrepareThisSample or PrepareNextSample commands. 

4. The sample needle is moved to the specified injector. 

5. The Sample and Fraction Manager (SFM) waits for the Inject Sync 
signal. (The Inject Sync signal is an SFM synchronization signal.) Set 
this signal to immediately if no waiting time is required. Alternatively, 
you can set the signal to an input port of the SFM if the instrument is to 
wait for a signal from the pump. (For information about the settings, 
refer to Installing Dionex Devices  HPLC Sample and Fraction 
Manager: Installation in the Administrator Help section.) 

6. The needle is moved into the injector. 

7. The sampler pauses for the time specified by PreInjDelay. 

8. The injection valve is moved into the Load position. 

9. The content of the syringe is dispensed into the sample loop. 

10. The sampler pauses for the time specified by PostInjDelay. 
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11. The injection valve is moved into the Inject position. 

12. The needle is moved out of the injector. 

13. The needle returns to the Home position. 

For more information, refer to: 

 Sample and Fraction Manager Commands 

 Commands for Fraction Collection 

 Overlapping Areas 

 PGM File for Fraction Collection 

 Sample and Fraction Manager: Overlapping Areas 
The Sample and Fraction Manager has two independent arms for which the 
working areas partly overlap. To prevent collision of the arms in the 
overlapping area, only one arm is allowed in the area at a time:  

For example, if arm 2 is in the overlapping area and arm 1 is to perform an 
operation in the overlapping area, arm 1 has to wait until arm 2 has 
completed its operation. Arm 2 is then moved to the Park position and arm 
1 can enter and perform its operation in the overlapping area. 

This is performed after each operation. To have one arm perform 
subsequent operations in the overlapping area without being interrupted by 
the other arm, Chromeleon supports the following commands: 
 
Command Description 
AcquireOverlapArea Provides exclusive access to the overlapping area; i.e., the other arm 

cannot enter the overlapping area. 

 Note:  
If the second arm already has exclusive access to the overlapping area, 
the first arm will wait until the second arm no longer has exclusive 
access. 

ReleaseOverlapArea Releases the exclusive access right for the overlapping area. The other 
arm can now enter and perform operations in this area. 

 Note:  
At the beginning of a sample program, an implicit UnblockOverlap 
command is performed. 
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Example: 
2.000 SFM_A.AcquireOverlapArea  
; Empty syringe of the SFM_A if necessary: 
 SFM_A.Waste   
; Wash syringe of the SFM_A:  
 SFM_A.Wash   
; Wash the SFM_A injector:  
 SFM_A.WashInjector 
 SFM_A.ReleaseOverlapArea 
 SFM_P.PrepareNextSample 
 
This program ensures that the arm of the SFM_A is not returned to the 
Park position between emptying the syringe and washing the injector. 
Before starting sample preparation, the arm of the SFM_P waits until the 
SFM_A has completed its operations and left the overlapping area. 

Dionex recommends minimizing the blocking time of the overlapping area 
because the arm for which the area is blocked cannot perform any other 
operation until the area is no longer blocked. 
 

 Note:  
If an arm is not connected, Chromeleon does not know its position and 
thus, assumes that it might be in the overlapping area. That is why the 
other arm cannot enter the overlapping area. Therefore, always connect 
both arms even if you want to use only one arm. 

For more information, refer to: 

 Sample and Fraction Manager Commands 

 Commands for Fraction Collection 

 Tips for Injection 

 PGM File for Fraction Collection 
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 Sample and Fraction Manager: PGM File for Fraction 
Collection 
You can use the left arm of the Sample and Fraction Manager (SFM) for 
fraction collection. Chromeleon supports the following high-level commands 
for fractionation: Collect, Drain, Eject, and TubePosition. 

A typical program for a timebase with SFM (device name: SFM_A and 
SFM_P), Fraction Collection driver (device name: Fraction Collection), 
pump (here: Dionex P680P HPG-4), and detector (here: Dionex UVD340U 
PDA) if only the UV_VIS_1 channel is used for peak detection could look as 
follows: 
 
; Preparing the devices for the next sample 
-1.000 PumpDevice =  "Pump" 
 Flow = 50.000 
 %B = 0.0 
 %C = 0.0 
 %D = 0.0 
 Pressure.LowerLimit =  0 
 Pressure.UpperLimit =  150 
 %A.Equate =  "%A" 
 %B.Equate =  "%B" 
 %C.Equate =  "%C" 
 %D.Equate =  "%D" 
 
 CollectFractions =  Yes 
 CollectOutsidePeaks =  No 
 
; Preparing the SFM_A for fraction collection 
 SFM_A.MovementMode =  Interrupt 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 
 SFM_P.InjectMode = LC_Overlap 
 
;********************************************************************
* 
;* Definition of triggers for fraction collection starts here. 
;********************************************************************
* 
; Note: The Fraction Collection driver increments its TubePosition 
property before the TubeChange and FracEnd triggers are executed. 
Thus, the SFM driver only has to synchronize its TubePosition with 
the fraction collection property. 
 Trigger FracStart FracStartDetected 
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; When a new fraction collection starts, the sample needle should be 
positioned already over the correct tube to start collecting 
immediately. 
 Collect 
 EndTrigger 
 
 Trigger TubeChange FracTubeChange 
 ; Tube change necessary: synchronize SFM_A with fraction 
collection position 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 EndTrigger 
 
 Trigger FracEnd FracEndDetected 
; Fraction collection ends, the remaining content of the syringe is 
ejected, the plunger is moved to Drain position, and the arm is moved 
to next tube to be prepared for next collection 
 Eject 
 SFM_A.TubePosition = FractionCollection.TubePosition 
 EndTrigger 
 
;********************************************************************
* 
;* Definition of triggers for fraction collection ends here. 
;********************************************************************
* 
 
 TubeMaxVolume =  2.000000 
 FractionCollection.TotalNumberInstalled = 

FM_A.TotalNumberInstalled 
 MaxTubesPerFraction =  Unlimited 
 TubeWrapping =  No 
 DelayTime =  1.0 

 DetectionChannel2.OffsetTime =  0.5 

 DetectionChannel2.Name =  "UV_VIS_1" 

 DetectionChannel2.PeakStartSlope =  0.500 

 DetectionChannel2.PeakStartThreshold =  10.00 

 DetectionChannel2.PeakMaxSlope =  0.000 

 DetectionChannel2.PeakEndSlope =  -1.000 

 DetectionChannel2.PeakEndThreshold =  10.00 

 DetectionChannel2.ThresholdNoPeakEnd =  2000.00 

 DetectionChannel2.BaselineOffset =  0.000 

 DetectionChannel2.BaselineDrift =  0.000 

 UV_VIS_1.Wavelength =  225 
 UV_VIS_1.Bandwidth =  1 
 UV_VIS_1.RefWavelength =  600 
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 UV_VIS_1.RefBandwidth =  1 
 UV_VIS_1.Step =  Auto 
 UV_VIS_1.Average =  On 
 UV_VIS_2.Wavelength =  250 
 UV_VIS_2.Bandwidth =  1 
 UV_VIS_2.RefWavelength =  600 
 UV_VIS_2.RefBandwidth =  1 
 UV_VIS_2.Step =  Auto 
 UV_VIS_2.Average =  On 
 UV_VIS_3.Wavelength =  275 
 UV_VIS_3.Bandwidth =  1 
 UV_VIS_3.RefWavelength =  600 
 UV_VIS_3.RefBandwidth =  1 
 UV_VIS_3.Step =  Auto 
 UV_VIS_3.Average =  On 
 UV_VIS_4.Wavelength =  300 
 UV_VIS_4.Bandwidth =  1 
 UV_VIS_4.RefWavelength =  600 
 UV_VIS_4.RefBandwidth =  1 
 UV_VIS_4.Step =  Auto 
 UV_VIS_4.Average =  On 
 3DFIELD.RefWavelength =  600.0 
 3DFIELD.RefBandwidth =  1.9 
 3DFIELD.Step =  0.5 
 3DFIELD.MinWavelength =  200.0 
 3DFIELD.MaxWavelength =  595.2 
 3DFIELD.BunchWidth =  1.9 
 
0.000 Flow = 50.000 
 %B = 0.0 
 %C = 0.0 
 %D = 0.0 
 Autozero 
 Wait SFM_P.Ready 
 SFM_P.Inject 
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
 UV_VIS_3.AcqOn 
 UV_VIS_4.AcqOn 
 3DFIELD.AcqOn 
 
; If the SFM_A does not operate in the overlapping area during 
fractionation, the SFM_P can be cleaned (not shown here) and the next 
sample can be prepared if necessary, e.g.: 
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8.000 SFM_P.PrepareNextSample 
 
CollectFractions = No 
SFM_A.Wash WashStation=Wash1, Cycles=2 
 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
 UV_VIS_3.AcqOff 
 UV_VIS_4.AcqOff 
 3DFIELD.AcqOff 
 
10.20 End 
 

 Note:   

In the example, DetectionChannel1 has not been used as the first detection 
channel because '1' and 'I' look almost identical when Courier is the 
selected font.  

For more information, refer to: 

 Sample and Fraction Manager Commands 

 Commands for Fraction Collection 

 Tips for Injection 

 Overlapping Areas 
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 Sample and Fraction Manager: Troubleshooting 
The following problems may occur during operation of the Sample and 
Fraction Manager: 

Missing vial: 
If no vial is present at the position from which the Sample and Fraction 
Manager performs injection, the batch is aborted. The Sample and Fraction 
Manager may then remain in an inconsistent state.  

Therefore, Dionex recommends performing a Home command. If the tray in 
which the error occurred is part of a tray stack, you have to close the stack 
drawer manually. 

Z collision error: 
If the syringe holder collides with another component of the Sample and 
Fraction Manager while moving in z direction (e.g., because of an incorrect 
configuration), the instrument reports a z collision error.  

First, find and eliminate the cause of the z collision error. Then, perform a 
Home command to re-calibrate the motor in the x, y, and z directions. The 
driver cannot perform movement commands until the motor has been 
recalibrated.  

 Tip:   

The Sample and Fraction Manager is not equipped with collision sensors 
for the x and y directions. Therefore, stop the batch immediately if you 
observe a collision in the x or y direction. Afterward, perform the same 
steps as described for a z collision error. 
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Dionex Autosamplers  

Automatic sample injection with a modern Autosampler has several 
advantages: 
• Efficient processing of large sample batches  

• Reproducible and verifiable dosing precision  

• Loss-free and bubble-free injection of the sample  

In spite of the vast scope of performance, only the "standard" commands 
(Inject, Position, and Volume) are usually required for automatic control of 
the Dionex autosamplers: 

Standard Commands  

In addition to the  General Device Commands, Chromeleon supports 
the following standard autosampler commands: 
 
Command Description 
⇒Dispense Dispenses the previously drawn amount of liquid. 
⇒Draw Draws the specified amount of liquid. 
⇒Inject Injects the sample. 

The Inject command is not used when the AS or AS50 (USB) is in 
Concentrate or Sequential Concentrate mode. 

Mix Mixes the contents of a vial. (The mixing procedure depends on the 
autosampler.) 

⇒Position Indicates the vial position. 
⇒Volume Sets the volume to be injected.  
⇒Wash Performs a wash cycle. 

 
For information about the individual autosamplers and their specifications, 
refer to: 

 Dionex ASI-100 Autosampler Series 
 Dionex AS/AS50 Autosamplers  
 Dionex WPS-3000 Well-Plate Micro Autosampler 
 Dionex/LC Packings FAMOS Capillary/Nano HPLC Autosampler  
 Dionex GINA 50 Autosampler  
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 Dionex ASI-100 Autosampler Series 

In addition to the standard autosampler commands (see  Dionex 
Autosamplers), the autosamplers of the Dionex ASI-100 series provide 
many additional commands for controlling autosampler functions, such as 
the speed with which a sample is drawn (= DrawSpeed), the repeat count 
for mixing operations (= MixRepeat), or how deep the needle dips into the 
vial for the washing operations (= WashHeight). You can specify the 
standard commands further, for example, via the vial whose contents you 
wish to prepare (= PrepSubject) or via the volume to be used for the Draw, 
Dispense, and Mix (= PrepVolume) commands. For a list of the supported 
commands and properties, refer to the table below. (Please note that the 
display Filter level determines which commands and properties are 
displayed.) 

Special Commands and Properties  
 
Command/Property Description 
BlueSegment Select the segment type that is used in the blue segment. The 

following types are available: Analytical - Semiprep - Mini - 
Eppendorf. 

CoolingPower  
(only ASI-100T/ASI-100PT) 

Indicates the cooling power (for diagnosis purposes only). 

DispSpeed Specify the speed with which the contents of the syringe shall be 
dispensed. 

DownSpeed Specify the speed with which the needle moves down. 
DrawSpeed Specify the speed for filling the syringe. 
ExternalMSV State of the external valve. The property is available only if the 

External MSV installed check box has been selected on the 
Segments & MSV tab page in the Server Configuration 
program.  

GreenSegment Select the segment type that is used in the green segment. 
Available types are: Analytical - Semiprep - Mini - Eppendorf. 

HeatSinkTemperature 
(only ASI-100T/ASI-100PT) 

Indicates the heat sink temperature (read-only). 

InjectionCounter Number of injections. 
InjectMode Inject Mode. If set to Normal, the autosampler draws the 

specified volume from the specified position and injects. If set to 
Mix, the autosampler injects whatever volume is left in the 
syringe after preceding draw/dispense operations. 

InjectWaitTime Period between the issuing of the command by Chromeleon and 
the acknowledgement of the autosampler. 

InternalMSV State of the internal motorized switching valve. 
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Command/Property Description 
Mix From the position that is determined via the PrepSubject 

parameter, the syringe draws and dispenses the volume that is 
determined via the PrepVolume parameter. If PrepVial is 
selected as PrepSubject, the PrepVial parameter must be 
specified as well. The MixRepeat parameter indicates the 
number of replicates during mixing. 

MixRepeat Repeat count for draw, dispense, and mix operations for mixing. 
Msv2ToInject Switch the external valve to Inject. 
Msv2ToLoad Switch the external valve to Load. 
MsvToInject Switch the injection valve to Inject. 
MsvToLoad Switch the injection valve to Load.  
NeedleSealCounter Needle seal wear. 
PrepareNextSample Starts the injection procedure for the next sample, if available. 

However, the injection valve is only switched at the next Inject 
command (Display Filter level: Advanced). 

PrepareThisSample Starts the injection procedure for the current sample. However, 
the injection valve is switched only at the next Inject command 
(Display Filter level: Advanced). 

PrepHeight Needle height for draw, dispense and mix operations, specify 
how deep the needle will dip into the vial for mixing. 

PrepSpeed Syringe speed for draw and dispense operations for mixing. 
PrepSubject Specify the subject to be used for draw, dispense, and mix 

operations. The following subjects are available: PrepVial, 
SampleVial, WashVial, Air, ReagentAVial, ReagentBVial, 
ReagentCVial, ReagentDVial. If Air is specified as mix subject, 
air is drawn in. During Dispense, the needle moves into the 
needle port and is dispensed there. 

PrepVial Specify the vial position if PrepVial is selected as PrepSubject 
(see PrepSubject). 

PrepVolume Volume to be used for the Draw, Dispense, and Mix. 
PrimeSyringe Primes the syringe by flushing it several times. 

PumpDevice Enter the name of the pump for which you want to synchronize 
the strokes with the autosampler. (This property is available only 
if you have selected an entry other than <None> from the Sync 
Inject with pump drop-down list on the Syringe & Stroke Sync 
tab page in the Server Configuration program.)  

RadialSpeed The speed of the radial needle movement. 
ReagentACapacity Specify how often the volume can be drawn from the vial with 

reagent A (reagent B, C, and D, respectively). 
ReagentAVial Position of the reagent A (reagent B, C, and D, respectively) vial 

- is used only if ReagentAVial has been selected as 
PrepSubject (see PrepSubject). 

RedSegment Select the segment type that is used in the red segment. 
Available types are: Analytical - Semiprep - Mini - Eppendorf. 
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Command/Property Description 
Relay1, 2, 3 or 4 The following commands are available: State (indicates or sets 

the state of the relay), Duration (when set, the relay's state 
toggles after the specified time), On (turns the relay on), and Off 
(turns the relay off). 

Relay3Enabled Relay3 mode. If set to Yes, the relay can be controlled by 
Chromeleon. If set to No, the autosampler controls the relay and 
the relay indicates, whether the autosampler is operable. 

Relay4Enabled Relay 4 mode. If set to Yes, the relay can be controlled by 
Chromeleon. If set to No, the relay is controlled by the 
autosampler and indicates injection. 

SampleHeight Indicates the height at which the sample is drawn, measured 
from the vial bottom to the needle tip. 

State Indicates that the autosampler has injected. 
SyncWithPump Synchronizes the injection with the cycle of a P680A LPG or 

P680A DGP-6 pump. (This property is available only if you have 
selected an entry other than <None> from the Sync Inject with 
pump drop-down list on the Syringe & Stroke Sync tab page in 
the Server Configuration program.)  

Syringe Indicates the volume of the syringe that is installed in the 
autosampler. 

SyringeCounter Indicates the number of syringe movements. 
SyringeDelay Specify the time the needle shall remain in the vial after loading. 
⇒Temperature 
(only ASI-100T/ASI-100PT) 

Define the set temperature of the autosampler's tray and hence 
of the sample. Click the + character to open the command tree; 
the following commands are available: Value (= actual 
temperature, read-only), Nominal (= set temperature), 
UpperLimit,and Lower Limit. With UpperLimit and 
LowerLimit, the system aborts the batch and starts emergency 
handling if the nominal temperature is outside these limits. 

TempCtrl 
(only ASI-100T/ASI-100PT) 

The following settings are available: On (= cooling/heating 
enabled) and Off (= cooling/heating disabled) (comp. Nominal, 
Value, HeatSinkTemperature, CoolingPower). 

Test Moves the needle to the specified vial. If no vial is specified, 
MixSubject is used (comp. PrepSubject). 

TrayDetection Turn tray detection (including manual interference monitoring) on 
or off. When tray detection is enabled, a home run is executed 
when the tray is installed. 
If the tray was removed while tray detection was disabled, a self-
test must be performed when the tray is installed again. This is 
to make sure that the sample is injected from the correct 
position. 

UpSpeed The speed used to move the needle up. 
⇒Wash The internal MSV is switched to the Load position, if necessary. 

The volume specified under WashVolume is drawn from the 
position specified under WashVial and dispensed into the 
needle port/waste. The WashSpeed and WashHeight 
parameters are also considered. 
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Command/Property Description 
WaitInput1, 2, 3, or 4 State of the digital input 1, 2, 3, or 4. 
WashHeight Wash height  = distance between the bottom of the wash vial 

and the needle tip (= the depth with which the needle will dip into 
the vial). 

WashSpeed The speed with which the syringe draws the wash volume. 
WashVial Position of the wash vial. 
WashVialVolume Total volume of the wash vial. 
WashVolume Specify the volume to be drawn from the wash vial.  

 Note: 
All autosampler inputs are also available as CM input ports so that other 
device drivers can use them as well (for example, Remote Inject). 
 
For a basic description of Dionex autosamplers, including the standard 
commands, refer to  Dionex Autosamplers.  

For information about how to use the commands in practical operation, 
refer to Practical Tips for Device Control  Autosampler Commands 
(ASI-100 Series). 
For information about how to install the autosamplers of the ASI-100 series, 
refer to Hardware Installation  ASI-100 HPLC Autosampler Series: 
Overview in the Administrator Help section. 
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 Dionex AS/AS50 Autosamplers 

In addition to the standard autosampler commands (see  Dionex 
Autosamplers), the Dionex AS and AS50 Autosamplers support many 
additional commands for controlling autosampler functions. The following 
commands are available (please note that the display Filter level 
determines which commands and properties are displayed): 

Special Commands 
 
Command Description 
DoorSafetyTime Displays the amount of time the autosampler door can 

remain open without aborting the sequence. 
Flush Flushes the inject port. During the flush cycle, the needle 

moves to the waste port and expels any fluid. The 
needle then moves to the inject port and delivers a 
volume of fluid (see FlushVolume below) for flushing the 
inject port. The needle then moves to the flush port and 
delivers a factory-set volume of flush fluid, which washes 
the outside of the needle. 

FlushVolume Sets the volume of liquid used for flushing the inject port. 
If the volume is greater than the sample syringe volume, 
the AS or AS50 performs multiple syringe strokes until 
the volume is reached. 

Home Moves the needle arm to home position. 
InjectionType  Displays the type of injection (full-loop, partial-loop, or 

partial-loop limited sample) the AS or AS50 is 
performing. 

LoopSize Displays the size (volume) of loop installed. 
Prime Primes the liquid lines. 
PrimeReservoir Sets the reservoir to be used as a source for priming. 

The Flush_Reservoir is the default. If the sample 
preparation option is installed, Reservoir_A through D 
can be specified. 

PrimeSyringe Sets the syringe to be used for priming. The Sample 
syringe is the default. If the sample preparation option is 
installed, the Prep syringe can be specified.  

PrimeVolume Sets the volume of liquid used for priming the liquid 
lines. 

SecondLoopSize (For AS or AS50 (USB) Simultaneous mode only) 
Displays the size (volume) of loop installed on the 
second injection valve. 

SerialNumber Displays the autosampler serial number. 
Status Displays the current action being performed by the 

autosampler. 
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Command Description 
Stop Stops the current process. 
TrayType Reports the type of sample tray (rack) installed (read-

only).  
Special Commands for Sampler Setup 
The following commands set options that remain constant throughout the 
sample preparation steps and the time-dependent commands of a program. 
Command Description 
ColumnTemperature  (Only for autosamplers equipped with the thermal 

compartment)  
Sets the temperature of the thermal compartment. 

CutSegmentVolume Sets the volume of sample discarded from each end of 
the aspirated sample. The middle portion of the sample 
is positioned in the loop and injected. The 
CutSegmentVolume is used only for partial-loop 
injections. To perform a partial-loop injection from a 
limited amount of sample, specify a CutSegmentVolume 
of 0. For full-loop injections, the CutSegmentVolume is 
ignored. 

CycleTime  Sets the time between injections. To set a uniform time 
between injections, specify a cycle time in minutes (1 to 
240). When a cycle time is specified, the autosampler 
delays sample injection until the specified time has 
elapsed since the previous injection. If the cycle time is 
set to 0, the time between injections is determined by the 
commands in the Program specified for each sample 
injection in a Sequence. 

SetNeedleHeight Sets the distance between the needle tip and the vial 
bottom. Note: This position is used for all functions, 
except for sample preparation functions that use a 
separately-specified NeedleHeight(see below).  

SyringeSpeed Sets the syringe speed. 1 is the slowest speed and 5 is 
the fastest. Select a slower speed for more viscous 
samples. 

TrayTemperature (Only for autosamplers equipped with the sample 
temperature control option)  
Sets the temperature of the sample tray. 

WaitForTemperature (Only for autosamplers equipped with a thermal 
compartment or a sample temperature control option)  
Instructs the autosampler to wait for the column or tray 
temperature to stabilize before proceeding to the next 
command.  
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Special Commands for Sample Preparation 
The AS and AS50 provide several commands for preparing the sample 
before injection. The standard AS or AS50 supports eight sample 
preparation commands. If the autosampler is equipped with the sample 
preparation option, two additional commands are available. 
 
Command Description 
DelaySP Pauses sample preparation. 
FlushSP Flushes the inject port during sample preparation. 
Mix Mixes the vial contents. 
NeedleHeight Positions the needle above the vial bottom (used for 

sample preparation functions only). 
Pipet Moves sample between vials. 
Concentrate Loads and injects sample onto the concentrator column. 
ReagentPrime Primes the injector lines with reagent in preparation for a 

ReagentFlush. 
ReagentFlush Flushes reagent onto the concentrator column.  

The following commands are available only if the AS or AS50 is equipped 
with the sample preparation option: 
Command Description 
Dilute Dilutes the sample with reagent. 
Dispense Dispenses reagent to a vial.  

 Note: 
The Concentrate, ReagentPrime, and ReagentFlush commands require 
AS or AS50 (USB) Moduleware version 2.0.0 (or later). These commands 
are not available for the DX-LAN model of the AS50, regardless of which 
Moduleware version is installed in the autosampler. 

Special Commands for Exclusive Access 
The exclusive access feature allows one AS or AS50 to be shared by two 
timebases. 
 
Command Description 
AcquireExclusiveAccess A timebase requests exclusive access to the 

autosampler as soon as the other timebase relinquishes 
exclusive access. 

ReleaseExclusiveAccess A timebase relinquishes exclusive access to the 
autosampler.  
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 Note: 
The DX-LAN model of the AS50 does not support the exclusive access 
feature. If a program created for this autosampler includes 
AcquireExclusiveAccess and ReleaseExclusiveAccess, the commands 
are ignored. However, both the AS and AS50 (USB) autosamplers can run 
any program created for the DX-LAN autosampler that includes these 
commands.  

Sample overlap is not allowed when the autosampler is shared by two 
timebases. 

Calibration Commands 
 
Command Description 
DownloadCalibration Downloads the selected set of calibration values to the 

autosampler. 
DownloadCalibrationParameter Selects the set of calibration values (Current, Previous, 

or Factory) to be downloaded. 
ExtLeakDet Performs the leak detector calibration on the 

chromatography or thermal compartment. 
InjPortVolCurVal Specifies the current volume of the inject port. This value 

is determined when the inject port is manually calibrated. 
Calibration is not performed with Chromeleon. See the 
AS or AS50 operator's manual for details. 

TrayLeakDet Performs the autosampler tray leak detector calibration.  
Diagnostic Commands 
 
Command Description 
ExtLeakDetTest Performs a test of the chromatography or thermal 

compartment leak detector. 
ExtLeakDetTestDate Reports the date of the leak detector test. 
ExtLeakDetTestResult Reports the result (pass or fail) of the leak detector test. 
TrayLeakDetTest Performs a test of the autosampler tray leak detector. 
TrayLeakDetTestDate Reports the date of the leak detector test. 
TrayLeakDetTestResult Reports the result (pass or fail) of the leak detector test.  

For information about how to use the commands in practical operation, 
refer to Practical Tips for Device Control  Autosampler Commands 
(AS/AS50). For a basic description of Dionex autosamplers, including the 
standard commands, refer to  Dionex Autosamplers.  
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 Dionex WPS-3000 Well-Plate Micro Autosampler 

In addition to the standard autosampler commands (see  Dionex 
Autosamplers), the Dionex WPS-3000 Autosampler provides additional 
commands for controlling autosampler functions. The following general 
commands are available (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Command/Property Description 
BlueTray Reports which sample containers are installed in the blue 

segment (corresponds to the settings on the Segments tab 
page in the autosampler's properties). 

BootLoaderVersion Indicates the bootloader version (read-only). 
Brightness Adapts the brightness of the autosampler's front panel display 

to your requirements. 
BufferTubingVolume Reports the volume of the installed buffer tubing (read-only). 
Contrast Adapts the contrast of the autosampler's front panel display to 

your requirements. 
DispenseDelay Sets the time that the needle shall remain in the sample 

container after dispensing. 
DispSpeed Sets the speed at which the sample is expelled for standard 

injections  
DrawDelay Sets the speed at which the sample is drawn for standard 

injections. 
DrawSpeed Sets the speed at which the sample is drawn for standard 

injections. 
FirstTransportVial Sets the position for the first transport vial. Transport vials are 

required only for microliter pick-up injections. (Also, see 
LastTransportVial.)  

FlushVolume Sets the flush volume that shall be used for the first Full-Loop, 
Partial-Loop, or microliter pick-up injection. 

FlushVolume2 Sets the flush volume that shall be used for additional 
injections from the same vial for Full-Loop and Partial-Loop 
injections when RinseBetweenInjections=No. 

GreenTray Reports which sample containers are installed in the blue 
segment (corresponds to the settings on the Segments tab 
page in the autosampler's properties). 

InitiateChangeSyringe Initiates the procedure for exchanging the syringe. (Also, see 
TerminateChangeSyringe.) 

InitiateChangeVial Rotates the sample containers specified in the Tray field to the 
front, allowing you to change the vials or plates easily. Select 
BlueTray, GreenTray, or RedTray to move the corresponding 
plate or tray to the front). Or else, selet BlueVials, 
GreenVials, or RedVials to move the corresponding segment 
with the transport vials to the front. 
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Command/Property Description 

⇒Inject Injects the sample. If you have created a user-defined WPS-

3000 program, e.g., in the  Program Wizard, use the 
Inject command to start the program. In this case, injection is 
performed after the UdpInjectMarker command of the user-
defined program. 

 Note:  

Injection can be performed only if the autosampler is in Not 
running state. This is usually ensured by the 
WaitSampler.Ready command that is generated by the PGM 
Wizard. If the system detects a different state, the following 
message appears in the Audit Trail: Abort] hh:mm:ss 
{Sampler} Sampler status must be "Not running" before inject." 

InjectionValveCounter Counts the number of injection valve movements. 
InjectionValvePosition Reports the current position of the injection valve: Inject, 

Load, SwitchToInject, SwitchToLoad, or Unknown. 
InjectMode Injection mode (for more information, refer to the operating 

instructions for the instrument):  
UserProg The autosampler executes the program or sample 

preparation steps defined by the user. 
Partial The syringe volume is injected in part only 

(recommended: at most 50% of the sample loop 
volume). 

FullLoop The syringe volume is injected completely. 
µlPickUp The syringe volume is injected completely. 

However, it contains partly sample volume only. 
Transport liquid is drawn first, then sample, and 
then transport liquid again, i.e. the syringe, the 
sample needle, and both ends of the sample loop 
are filled with transport liquid. That is why the 
TransportVial should contain solvent. The sample 
volume is in the middle of the sample loop. 

InjectValveToInject Switches the injection valve into the Inject position. 
InjectValveToLoad Switches the injection valve into the Load position. 
InjectWaitTime Reports the time that has passed between the issuing of the 

injection command by Chromeleon and the response from the 
autosampler. 

LastTransportVial Sets the position for the last transport vial. Transport vials are 
required only for microliter pick-up injections. (Also, see 
FirstTransportVial.) 

Leak Reports whether the leak sensor detected a leak NoLeak or 
Leak. 

LeakAlarmOff Turns off the beep for the current alarm. A new beep sounds 
when the leak sensor detects another leak. 



776 Commands for Controlling Dionex Devices 

Command/Property Description 
LeakSensorMode The following options are available:  

Enabled - Enables leak detection. If the sensor is activated, a 
message appears in the Chromeleon Audit Trail and an 
acoustic beep sounds.  
Silent - Enables leak detection. If the sensor is activated, a 
message appears in the Chromeleon Audit Trail, but no beep 
sounds. 
Disabled - Disables leak detection. 

LoopOverfill (Used only for full-loop injections) 
The volume of the sample loop and the LoopOverfill factor 
determine the volume that is drawn in and/or transported 
through the sample loop before the sample is injected. 
Example:  
Loop volume: 5 µl, LoopOverfill: 2 = 
Volume to be drawn: 10 µl 

LoopVolume Reports the volume of the installed sample loop (read-only). 
LoopWashFactor Factor for the loop wash volume. The contents of the buffer 

loop and the LoopWashFactor determine the loop wash 
volume. The default factor is 1. 

LowDispersionFactor Determines the volume for Low Dispersion Injections. The 
volume is calculated by multiplying the factor with the original 
sample volume. 
 

LowDispersionFlow Sets the flow rate with which the sample is flushed out of the 
sample loop in Low Dispersion Mode. 
 

LowDispersionMode Enables low dispersion mode. 
MotorControllerVersion Indicates the version of the motor controller (read-only). 
MoveNeedleDown Moves the needle to the position specified by NeedleHeight. 
MoveNeedleHome Moves the needle to the topmost position (Home position). 
MoveTo Moves the needle over the position specified in the Position 

input field. 
NeedleCounter Counts the number of needle drive movements. 
NeedleHeight Determines to which position the needle moves with the 

MoveNeedleDown command. 
NeedleVolume Reports the volume of the installed needle (read-only). 
Operable Reports whether the autosampler is ready to operate. 
Position Sets the sample position on the carousel.  
PrepareThisSample Starts the injection procedure for the current sample. However, 

the injection valve will be switched only at the next injection 
command. 
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Command/Property Description 
PrepVial Sets the position for the sample container used for sample 

preparation. This position is used for UdpDraw and 
UdpDispense operations if PrepVial has been selected in the 
From and/or To fields of the UdpDraw and/or UdpDispense 
commands.  

PrimeSyringe Primes the syringe by filling and emptying it. Use 
PrimeSyringeNumber to determine how often the syringe is 
primed.  

PrimeSyringeNumber Specifies how often the syringe is filled and emptied during the 
PrimeSyringe operation. 

PumpDevice This property is available only if you have specified on the 
Segments tab in the autosampler's properties that the 
injection command be synchronized with the strokes of an 
LPG-3x00 pump. Usually, the setting from the Segments tab 
page is displayed by default, e.g., MicroPump or Loading 
Pump. 
If you want to change the synchronization assignment for a 
specific application, enter the pump in the input field. This does 
not overwrite the default setting on the Segments tab page.  

PuncturerDepth Sets how deep the puncturer descends into the sample 
container, measured from the top of the sample container. 

PuncturerDownNeedleDown Moves the puncturer and needle down. 
PuncturerDownNeedleUp Moves the puncturer down and the needle up. 
PuncturerUpNeedleDown Moves the puncturer up and the needle down. 
PuncturerUpNeedleUp Moves the puncturer and needle up. 
ReadyTempDelta 
(WPS-3000T with enabled 
cooling option only") 

When the current temperature deviates from the target 
temperature by more than the ReadyTempDelta, the 
autosampler is not ready to operate (TemperatureReady = 
NotReady). 

ReagentXVial 
(where X = A to D) 

Sets the position of the sample container with the associated 
reagent. This position is used for UdpDraw and UdpDispense 
operations if the associated ReagentxVial has been selected 
in the From and/or To fields of the Draw and/or Dispense 
commands.  

RedTray Reports, which sample containers are installed in the blue 
segment (corresponds to the settings on the Segments tab 
page in the autosampler's properties). 

Relay4Enabled Sets whether relay 4 controls the inject response. If you 
specify the duration, relay 4 will be active for this time upon 
each inject. Select Yes for user-defined control, i.e., if you 
want to control the relay via the Relay_4.On and 
"Relay_4.Off commands. 

Reset Sets the autosampler to the initial conditions when the 
instrument was turned on. 
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Command/Property Description 
RinsebetweenReinjections Sets whether a wash cycle is performed after each injection. If 

set to Yes, the system is washed after each injection. If set to 
No, the wash cycle is skipped when the next injection is 
performed from the same vial.  

 Notes:  
This command allows you to make several injections from the 
same vial one after the other without loosing sample between 
the injections by rinsing. 

A wash cycle is always performed after the last sample in a 
sequence. 

SampleHeight Sets the distance (in mm) between the bottom of the sample 
container (well-plate, deep-well plate, or vial), as measured 
from the exterior, and the tip of the needle for a standard 
injection, defining how deep the needle descends into the 
container for sampling. 

SelfTest Performs a self-test. 

 Note: 
You cannot start a batch when the sampler did not pass the 
self-test. 

Standby Sets the autosampler into the Standby mode or cancels this 
mode (NoStandby). 

 Note: 
You cannot start a batch when the sampler is in standby 
mode. 

State Reports whether the autosampler has injected: On (= injection 
has been performed) or Off (= injection has not yet been 
performed). (Read-only) 

Status Indicates which operation the autosampler is currently 
performing (read-only). 

SyncWithPump This property is available only if you have specified on the 
Segments tab in the autosampler's properties that the 
injection command be synchronized with the strokes of an 
LPG-3x00 pump. In this case, the setting is On. If you want to 
disable synchronization for a specific application, set the 
property to Off. (Also, see PumpDevice.) 

 Note:  
SyncWithPump is automatically set to On when you change 
the PumpDevice setting.  
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Command/Property Description 
Syringe Reports the volume of the installed syringe (read-only). 
SyringeCounter Counts the number of syringe plunger movements (read-only). 
SyringeValveCounter Counts the valve movements. 
SyringeValvePosition Reports the current position of the syringe valve: Needle, 

Wash, Waste, or Unknown.  
SyringeWashFactor Factor for the syringe wash volume. The syringe volume and 

the SyringeWashFactor determine the syringe wash volume. 
The default factor is 1.  

TempCtrl 
(WPS-3000T with installed 
cooling option only) 

Temperature control of the sample rack. The following settings 
are available: On (enables temperature control) or Off 
(disables temperature control). 

Temperature 
(WPS-3000T with installed 
Cooling Option only) 

Sets the target temperature for the carousel and thus, for the 
sample. The temperature can be between 4°C to 50°C (39.2°F 
to 122°F). Click the "+" character beside the name to display 
the items underneath: Value (reports the actual temperature), 
Nominal (sets the target temperature), UpperLimit (sets the 
upper temperature limit), and LowerLimit (sets the lower 
temperature limit). The system aborts the sample batch and/or 
starts error handling if the nominal temperature is outside the 
specified limits. 

TemperatureReady 
(WPS-3000T with installed 
Cooling Option only) 

Reports whether the autosampler is ready to operate. When 
Chromeleon reports NotReady, the current temperature 
deviates from the target temperature by more than the 
ReadyTempDelta. 

TerminateChangeSyringe Terminates the procedure for exchanging the syringe (Also, 
see InitiateChangeSyringe.) 

TransLiquidHeight Sets how deep the needle descends into the container for 
sampling (= distance in mm between the bottom of the 
transport vial, as measured from the exterior, and the tip of the 
needle.  

TransportVialCapacity Sets how often transport liquid can be drawn from one 
transport vial.  

 Tip:  
Keep in mind that two draw operations are required for 
microliter pick-up.  

TransportVialUsecount Reports how often transport liquid was drawn from the 
transport vials.  

 Tip:  
Reset the counter to zero after you have refilled the transport 
vials. If the maximum permissible number of draw operations, 
as defined with TransportVialCapacity, has been reached, a 
message ("out of transport liquid") is logged in the Chromeleon 
Audit Trail. 
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Command/Property Description 
TransVialPunctureDepth Sets how deep the puncturer descends into the transport vial, 

measured from the top of the transport vial.  
Volume Sets the injection volume for standard injections. 
⇒Wash Performs a wash operation. 
WashVolume Sets the volume that is drawn for the needle wash cycle after 

an injection. 
WasteSpeed Sets the syringe speed for expelling liquid to the waste.  

For a basic description of Dionex autosamplers, including the standard 
commands, refer to  Dionex Autosamplers.  

For more information about the sample preparation commands for the 
WPS-3000 autosampler, refer to  Dionex WPS-3000 Well-Plate Micro 
Autosampler: Commands for User-Defined Programs 

For information about how to use the commands in practical operation, 
refer to Practical Tips for Device Control  Examples for User-Defined 
Programs for the WPS-3000 Well-Plate Micro Autosampler. 

For installation instructions for the autosampler, refer to Hardware 
Installation  WPS-3000 Well-Plate Micro Autosampler: Overview in 
the Administrator Help section. 
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 Dionex WPS-3000 Well-Plate Micro Autosampler: 
Commands for User-Defined Programs 
The Dionex WPS-3000 Autosampler provides many sample preparation 
commands that are used to further define the individual sample preparation 
steps. The sample preparation commands are accessible from the 
Advanced level only. Use the  Program Wizard to create a user-
defined sample preparation program. This program is started by the 
⇒Inject command.  

Chromeleon supports the following sample preparation commands (please 
note that the display Filter level determines which commands and 
properties are displayed): 
 
Command/Property Description 
UdpAirPump Sets whether outside air shall be used to dry the needle.  

Select On or Off. 
Udp⇒Dispense Dispenses a specified volume of liquid. Make the following 

settings:  
To: Enter the position to which the specified volume is delivered. 
Volume: Enter the volume to be dispensed (0.0 to 25.0 µl). 
SyringeSpeed: Specify the speed with which the volume is 
expelled (10 to 8333 nl/s; option: GlobalSpeed here  = 
DispSpeed).  
SampleHeight: Determine how deep the needle descends into 
the sample container (0 to 40 mm; option: GlobalHeight = 
SampleHeight). 

Udp⇒Draw Draws a specified volume of liquid. Make the following settings:  
From: Enter the position from which the specified volume is 
drawn. 
Volume: Enter the volume to be drawn (0.0 to 25.0 µl). 
SyringeSpeed: Specify the speed with which the volume is 
drawn (10 to 8333 nl/s; option: GlobalSpeed here  = 
DrawSpeed).  
SampleHeight: Determine how deep the needle descends into 
the sample container (0 to 40 mm; option: GlobalHeight = 
SampleHeight). 

UdpInjectMarker Generates an inject marker pulse. This is required in user-
specific programs, i.e., when InjectMode = UserProg. The 
injection can be performed only after this pulse. 

UdpInjectValve Switches the injection valve to the specified position:  
Inject or Load. 

UdpMixNeedleWash Sets the volume that is used for washing the needle during 
sample preparation. 



782 Commands for Controlling Dionex Devices 

Command/Property Description 
UdpMixWait Sets the time that the system waits between the single sample  

preparation steps.  
UdpMoveSyringe Moves the syringe. Enter the volume to be drawn in the Load 

field; or else, enter the volume to be dispensed in the Unload 
field. Only set one of these parameters. Enter the speed for the 
syringe movement in the SyringeSpeed field. 

 Tip:  
Make sure that both parameters appear in the same line of the 
PGM File. If they appear in different lines, the PGM File does not 
pass the Ready Check. 

UdpMoveSyringeHome Moves the syringe it to its Home position and empties it. 
UdpOutput Sets the specified output into the defined state. Select the output  

(Out1 ... Out4) and the state  (On or Off) from the associated  
drop-down lists. 

UdpSyringeValve Switches the syringe valve to the specified position:  
Needle, Wash, or Waste. 

UdpWaitInput Waits until the specified input is in the selected state. Select the 
input  
(Inp1 ... Inp4) and the state (Low or High) from the associated  
drop-down lists. 

UdpWaitStrokeSync Waits with the execution of a program for InjectMode = 
UserProg until the pump has sent the synchronization signal. 
(Also, see PumpDevice, SyncWithPump.)  

For a basic description of Dionex autosamplers, including the standard 
commands, refer to  Dionex Autosamplers.  

For information about the general commands for the WPS-3000 
autosampler, refer to  Dionex WPS-3000 Well-Plate Micro 
Autosampler. 

For information about how to use the commands in practical operation, 
refer to Practical Tips for Device Control  Examples for User-Defined 
Programs for the WPS-3000 Well-Plate Micro Autosampler. 
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 Dionex/LC Packings FAMOS Capillary/Nano HPLC 
Autosamplers 

In addition to the standard autosampler commands (see  Dionex 
Autosamplers), the Dionex/LC Packings FAMOS Autosampler provides 
additional commands for controlling autosampler functions.  

The following general commands are available (please note that the display 
Filter level determines which commands and properties are displayed): 

 
Command/Property Description 
AlarmBuzzer When set to On, the buzzer will signal error conditions.  

 Tip:   

If the buzzer signals an error condition (AlarmBuzzer=On), you 
have to turn the autosampler off and on again to reset the 
instrument and continue operation. Therefore, avoid using this 
command when controlling the autosampler under Chromeleon. 

CoolingOnTime Indicates cooling time (in total) of the autosampler (read-only). 
⇒Dispense Dispenses a specified volume. The following options are 

available:  
To: Sample position to which to dispense the volume. 
Volume: Volume to dispense (0.0 to 25.0 µl). 
SyringeSpeed: Speed used to dispense the volume (1 to 9 - 
optional setting: if the SyringeSpeed is not set, the PrepSpeed 
will be used instead (see below)). 
SampleHeight: Height at which the sample is dispensed (0 to 40 
mm - see below). 

⇒Draw Draws a specified volume. The following options are available:  
From: Sample position from which to draw the volume.  
Volume: Volume to dispense (0.0 to 25.0 µl). 
SyringeSpeed: Speed used to draw the volume (1 to 9 - 
optional setting: if the SyringeSpeed is not set, the PrepSpeed 
will be used instead (see below).) 
SampleHeight: Height at which the sample is drawn (0 to 40 
mm - see below). 

FirstTransportVial Defines the vials to be used for µlPickUp injections. Used 
together with LastTransportVial.  

FlushVolume Flush volume used for FullLoop and PartialLoop injections  
(0.1 to 25.0 µl). 
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Command/Property Description 

⇒Inject Injects the sample. If you have created a user-defined FAMOS 

program, e.g., in the  Program Wizard, use the Inject 
command to start the program. In this case, injection is 
performed after the InjectMarker command of the user-defined 
program. 

 Note:   

Injection can be performed only if the autosampler is in Not 
running state. This is usually ensured by the 
WaitSampler.Ready command that is generated by the PGM 
Wizard. If the system detects a different state, the following 
message appears in the Audit Trail: Abort] hh:mm:ss {Sampler} 
Sampler status must be "Not running" before inject." 

InjectionCounter Total number of injections (read-only). 
InjectMode Injection mode (for more information, refer to the operating 

instructions for the instrument):  
UserProg The autosampler executes the program or sample 

preparation steps defined by the user. 
Partial The syringe volume is injected in part only (at most 

50% of the sample loop volume). 
FullLoop The syringe volume is injected completely. 
µlPickUp The syringe volume is injected completely. 

However, it contains partly sample volume only. 
Transport liquid is drawn first, then sample, and 
then transport liquid again, i.e. the syringe, the 
sample needle, and both ends of the sample loop 
are filled with transport liquid. That is why the 
TransportVial should contain solvent. The sample 
volume is in the middle of the sample loop. 

InjectValve Injection valve can be in the following positions:  
Inject or Load. 

ISS_A / ISS_B_Immediate Switches the associated valve immediately. 
LastTransportVial Defines the vials to be used for µlPickUp injections. Used 

together with FirstTransportVial.  
LoopVolume Volume of the installed loop (read-only). 
LowDispersionFactor (In Micro mode only) For more information, refer to the FAMOS 

User's Manual. 
LowDispersionFlow (In Micro mode only) For more information, refer to the FAMOS 

User's Manual. 
LowDispersionMode Enable low dispersion mode (in Micro mode only). 
OperationalMode Operational mode (Micro or Conventional - also, refer to 

Hardware Installation  UltiMate Capillay/Nano HPLC 
System: Overview in the Administrator Help section). Affects 
some limits, changing resets many operational parameters 
(read-only). 



 Commands for Controlling Dionex Devices 785 

Command/Property Description 
Output Sets the corresponding output to the specified state. 
PowerOnTime Indicates the time (in total) the autosampler was turned on (read-

only). 
PrepSpeed Speed used as the default syringe speed. 
PrepVial Sample preparation vial for the Draw and Dispense actions. 
ReagentXVial 
(where X = A to D) 

Position of the vial that contains the reagent X or the 
transportation fluid when UserProg is selected as Inject Mode.  

RinsebetweenReinjections If this parameter is set to No, the rinse step is omitted. 

 Note:  

This command allows you to make several injections from the 
same vial one after the other without loosing sample between 
the injections by rinsing. 

RunScreen If the command is set to On, the action currently performed by 
the autosampler is displayed on the instrument. 

SampleHeight The height at which the sample is drawn or dispensed. 
Status Status (read-only). 
Syringe Volume of the installed syringe (read-only). 
SyringeCounter Total number of syringe movements (read-only). 
SyringeSpeed Syringe speed used for draw and dispense operations (Low, 

Normal, or High). The flow depends on the volume of the 
installed syringe. (For more information, refer to the FAMOS 
User's Manual.) 

 Note:  

The flow into or from the syringe is the product of the speed 
defined by SyringeSpeed and the SyringeSpeedFactor. 
Example: SyringeSpeed=Low corresponds to 31.3µl/min for the 
25µl syringe), SyringeSpeedFactor=0.5. The resulting flow is 
15.65µl/min.  

SyringeSpeedFactor Factor used for scaling the syringe speed (see SyringeSpeed). 
SyringeValve Can be in the following positions: 

Needle, Wash, or Waste  
SyringeValveCounter Counts the valve movements. 
TempCtrl 
(with installed Cooling 
Option only) 

Temperature control of the sample rack. The following settings 
are available: On (cooling/heating enabled) or Off 
(cooling/heating disabled). 

Temperature 
(with installed Cooling 
Option only) 

You can indicate the nominal temperature for the tray and thus 
for the sample. The temperature can be between 4°C to 40°C 
(39.2°F to 104°F). If you open the command tree, the following 
commands are available: Value (= current tray temperature, 
read-only), Nominal (= nominal tray temperature), UpperLimit, 
and LowerLimit. If the current temperature exceeds the limits, 
the system aborts the batch and starts emergency handling. 
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Command/Property Description 
TubingVolume Volume of the installed needle capillary (read-only). 
UseAirSegment When set to On, an additional air segment is added when 

loading the sample loop. This reduces sample contamination. 
(For more information, refer to the FAMOS User's Manual.) 

UseHeadSpace When set to On, additional pressure is applied to the vial while 
the sample is transported to the loop. This increases the 
reproducibility but requires airtight vials and/or well septa. (For 
more information, refer to the FAMOS User's Manual.) 

⇒Wash Starts the wash cycle. 
WashVolume Volume used for the wash cycle.  

For a basic description of Dionex autosamplers, including the standard 
commands, refer to  Dionex Autosamplers.  

For more information about the sample preparation commands for the 
FAMOS autosampler, refer to  Dionex/LC Packings FAMOS 
Autosampler: Sample Preparation. 

For information about how to use the commands in practical operation, 
refer to Practical Tips for Device Control  Examples for User-Defined 
Programs for the FAMOS Autosampler (Dionex/LC Packings). 

For installation instructions for the FAMOS autosampler, refer to Hardware 
Installation  FAMOS Capillary/Nano Autosampler: Overview in the 
Administrator Help section. 
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 Dionex/LC Packings FAMOS Autosampler: Sample 
Preparation 
The Dionex/LC Packings FAMOS Autosampler provides many sample 
preparation commands that are used to further define the individual sample 
preparation steps. The sample preparation commands are accessible from 
the Advanced level only. Use the  Program Wizard to create a user-
defined sample preparation program. This program is started by the 
⇒Inject command.  

Chromeleon supports the following sample preparation commands (please 
note that the display Filter level determines which commands and 
properties are displayed): 
 
Command/Property Description 
CodeOutput Communicates a code number (between 0 and 15) to the P2 

output (VialNo&Marker ( TTL)). For more information, refer to the 
FAMOS User's Manual. 

Compressor Serves to build up pressure (On) or relieve pressure (Off)  
⇒Dispense Dispenses a specified volume. The following options are available:  

To: Sample position to which to dispense the volume. 
Volume: Volume to dispense (0.0 to 25.0 µl). 
SyringeSpeed: Speed used to dispense the volume (Either select 
an option (Low, Normal, or High) from the drop-down list or enter 
the any number between 1 and 9). 
SampleHeight: Height at which the sample is dispensed (0 to 
40 mm). 

⇒Draw Draws a specified volume. The following options are available:  
From: Sample position from which to draw the volume.  
Volume: Volume to dispense (0.0 to 25.0 µl). 
SyringeSpeed: Speed used to draw the volume (Either select an 
option (Low, Normal, or High) from the drop-down list or enter the 
any number between 1 and 9). 
SampleHeight: Height at which the sample is drawn (0 to 40 mm). 

InjectMarker Required to start injection. 
InjectValve Injection valve. The valve can be either in Inject or in Load position. 
LabeledVialMarker Creates another marker pulse for different vials, e.g., standard 

samples. 
MixWait Specify the time the system waits between steps  

(0s (0:00:00h) to 35.999s (9:59:59h))  
MixNeedleWash Volume used for washing the needle (10 to 9.999µl). 
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Command/Property Description 
MoveSyringe Determines the volume and the speed for loading and dispensing 

the syringe. For this command, the Load and Unload parameters 
are available. 

 Tip:  

Do not use both parameters in the same line of the PGM File 
because in this case, the PGM File does not pass the Ready 
Check. 

MoveSyringeHome Returns the syringe to its home position. 
Output Sets the corresponding output to the selected state. 
SSV Solvent Selection Valve. Specify the Position. The following 

options are available: Solvent A-D. 
SyringeValve Specify the Position. The following options are available: Needle, 

Wash, or Waste. 
Valve_A Specify the Position. The following options are available: 

1_2 (concentrating the sample) or  
10_1 (eluting the sample concentrated on the pre-column to the 
analytical column). 

Valve_B Specify the Position. The following options are available: 
10_1 (concentrating the sample) or  
1_2 (eluting the sample concentrated on the pre-column to the 
analytical column). 

VialMarker Generates a marker pulse for sample vials, e.g., unknown 
samples. 

WaitInput Defines the incoming signal for which to wait. 
⇒Wash Starts a wash cycle. 

 
For a basic description of Dionex autosamplers, including the standard 
commands, refer to  Dionex Autosamplers.  

For information about the general commands for the FAMOS autosampler, 
refer to  Dionex/LC Packings FAMOS Autosampler. (The general 
FAMOS autosampler commands partly overlap the sample preparation 
commands listed above.) 

For information about how to use the commands in practical operation, 
refer to Practical Tips for Device Control  Examples for User-Defined 
Programs for the FAMOS Autosampler (Dionex/LC Packings). 
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 Dionex GINA 50 Autosamplers  

In addition to the standard commands (see  Dionex Autosamplers), the 
Dionex GINA 50 autosampler provides additional commands for controlling 
autosampler functions such as multiple draw operations (Suck) from one 
sample, washing the sample loop (Wash), moving the sample needle 
(NeedleUp), or cooling the sample vials. The following commands are 
available (note that it depends on the display Filter level which commands 
are displayed):  

Special Commands  
Command Description 

⇒Dispense: Dispenses a specified volume; Please note: If position = 101, the 
autosampler dispenses the volume into the needle port. 

Load Switches the internal switching valve without moving the needle 
(also, refer to NeedleUp) 

⇒NeedleUp Moves the needle up. 
⇒Suck: Draws a specified volume. Please note: If position = 100, the 

autosampler draws an air segment from an imaginary air vial. 
TempCtrl Enables temperature control of the Dionex GINA 50T autosampler. 

The Gina 50T autosampler is capable of controlling the rack 
temperature and, thus, the sample temperature within a 15°C 
range. At room temperature (20°C), maximum sample cooling is to 
5°C above zero.  

For a general description of the Dionex autosamplers, including the 
standard commands, refer to  Dionex Autosamplers.  

For information about how to use the commands in practical operation, 
refer to Practical Tips for Device Control  Autosampler Commands 
(GINA 50). 
For installation instructions for the GINA 50 autosampler, refer to Hardware 
Installation  GINA50 HPLC Autosampler: Overview in the 
Administrator Help section. 
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Dionex Flow Manager and Thermostatted Column 
Compartments 

In addition to the  General Device Commands, the Temperature 
property is available for controlling the operating functions of the Dionex 
Thermostatted Column Compartments: 
 

Property Description 
Temperature For the TCC-100, the range is 5.0…80°C (41° - 186°F). For the 

FLM-3x00, the range is 5.0…70°C (41° - 158°F). Click the "+" 
character beside the name to display the items underneath: 
Value-reports the current temperature. 
Nominal-sets the nominal temperature.  
UpperLimit-sets the upper temperature limit 
LowerLimit-sets the lower temperature limit.  
If the nominal temperature is not in the limits, the command is not 
executed.   

For information about the special commands and properties available for 
the TCC-100 and FLM-3x00 thermostatted column compartments, refer to: 

 Dionex TCC-100 Thermostatted Column Compartment  

 Dionex TCC-100 Thermostatted Column Compartment: Column ID 
Properties 

 Dionex FLM-3x00 Flow Manager and Thermostatted Column 
Compartment 

 Dionex FLM-3x00: Column ID Properties 

 Dionex FLM-3x00: Splitter Commands 

For an example program, refer to Practical Tips for Device Control 
 Controlling the Column Temperature. 
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 Dionex TCC-100 Thermostatted Column Compartment  
In addition to the commands supported for the different column 
compartments, such as Connect, Disconnect, and Temperature (see 

 Dionex Flow Manager and Thermostatted Column Compartments), 
Chromeleon supports the following commands and properties (please note 
that the display Filter level determines which commands and properties 
are displayed): 
Command/Property Description 
ActiveColumn Determine for which column the column identification 

information shall be updated (A or B ). The names correspond 
to the names entered on the Configuration tab page in the 
Server Configuration program. 

Column_A 
Column_B 

The column names correspond to the names entered on the 
Configuration tab page in the Server Configuration program. 
The various column commands and properties allow you to 
enter and check information about the column. For more 

information, refer to  Dionex TCC-100 Thermostatted 
Column Compartment: Column ID Properties. 

ColumnOven_Temp This channel is available only if you have selected the 
TemperatureSignal check box in the TCC-100's properties (on 
the Configuration tab page in the Server Configuration 
program.) If the check box is selected, Chromeleon records the 
temperature as a separate channel. The channels's name is the 
name entered on the Configuration tab page in the Server 
Configuration program. 
Click the "+ "character beside the name to display the items 
underneath: 
Delta−reports the signal's slope, i.e., the difference between the 
current value and the value one second ago. This is useful for 
triggers.  
Signal−has the following commands: Value (current signal 
value, read-only), UpperLimit and LowerLimit. If the current 
signal value is outside these limits, a warning appears in the 
Audit Trail.  
AcqOff−terminates data acquisition.  
AcqOn−starts data acquisition.  
Retention−reports the retention time of the signal (read-only).  
MaxAutoStep = Maximum step rate for Auto Step Mode;  
range: 0.1 - 5.1 s; default: 5.1 s 
Step−sets the step for data acquisition; range: 0.01 - 4.80 s; 
Auto selects the best step dynamically 
Average−averages all measured values over the step interval. 
Default: On. Off records only the last point of each interval.  
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Command/Property Description 
Door Reports whether the compartment door is open or closed 

(Open or Closed; read-only). 
EquilibrationTime Range: 0.0…30.0 min. Only if the deviation between the current 

temperature and the set point specified under 
ReadyTempDelta does not exceed the EquilibrationTime, the 
column compartment enters the Ready state (also, see 
ReadyTempDelta and Ready). 

GasLeak Reports whether the gas sensor has detected a leak  
(Ok or Leak; read-only). 

GasLeakSensor Sets the sensitivity with which the sensor responds to gas in the 
column chamber. Click the arrow in the GasLeakSensor 
combo box and select an option from the list: Low, Standard, 
or High. To turn the sensor off, select Off. 

HardwareVersion Indicates the compartment's hardware version. 
HumidityLeak Indicates whether the humidity sensor has detected a leak  

(Ok or Leak; read-only). 
HumidityLeakSensor Sets the sensitivity with which the sensor responds to humidity. 

Click the arrow in the HumidityLeakSensor combo box and 
select an option from the list: Low, Standard, or High.  
To turn the sensor off, select Off. 

Leak Indicates whether at least one leak sensor has detected 
leakage (Ok or Leak; read-only; also see HumidityLeak and 
GasLeak). 

LeakSensorState Reports whether the sensors are ready for leak detection 
(Ready, NotReady, or Error; read-only). 

MaxPosition If a column switching valve is installed and if the Internal MSV 
check box is selected on the Configuration tab page in the 
Server Configuration program, the maximum number of 
position of the installed valve is indicated (read-only). 

MsvPosition If a column switching valve is installed and if the Internal MSV 
check box is selected on the Configuration tab page in the 
Server Configuration program, the column switching valve is 
switched to the desired position (A (1) or B (2)). 

NextColumn Switches the column switching valve to the next position, 
directing the flow through the other column. 

Ready Reports whether the compartment is ready to operate (Ready 
or NotReady; read-only; also see ReadyTempDelta and 
EquilibrationTime). 

ReadyTemperatureDelta Range: 0.0...5.0°C. If the current temperature deviates from the 
temperature set point by more than the ReadyTempDelta, the 
column compartment enters the NotReady state. If the 
ReadyTempDelta is set to 0, Chromeleon does not check 
whether the temperature set point deviates from the actual 
temperature (also see Ready and EquilibrationTime). 

SerialNo Serial number of the column compartment (read-only). 
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Command/Property Description 
TCC_INPUT_1 and/or 
TCC_INPUT_2 

Reports the state of the related digital input (On or Off). 

TCC_RELAY_1 and/or 
TCC_RELAY_2 

Relay 1 and/or relay 2. Click the "+"character beside the relay 
name to display the items underneath: 
State−reports the state of the relay. 
Duration−when set, the relay toggles after the specified time. 
On−turns the relay on. 
Off−turns the relay off 

TempCtrl Turns temperature control on or off. 
Vendor Indicates the device manufacturer (read-only). 
WorkingHours Counts the operating hours of the column thermostat.  

For information about column identification, refer to  Dionex TCC-100 
Thermostatted HPLC Column Compartment: Column ID Properties. 

For an example program for the TCC-100, refer to Practical Tips for 
Device Control  Controlling the Column Temperature. 

For information about how to install the TCC-100, refer to Hardware 
Installation  TCC-100 Thermostatted HPLC Column Compartment: 
Overview in the Administrator Help section. 
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 Dionex TCC-100 Thermostatted Column Compartment: 
Column ID Properties 
The Dionex TCC-100 Column Thermostat supports the following column ID 
properties. The column properties appear underneath the column name 
specified in the Server Configuration program. (Note that the display Filter 
level determines which properties are displayed.) 

Primary column properties 
These properties are used for column identification. They are entered once 
by either the column manufacturer or the user and cannot be changed. 
 
Property Description 
BatchNumber Batch or lot number of the column. 
CustomId You can enter any number you want, for example, the column's 

inventory number. (Note: The number cannot be changed once it is 
entered.)  

DateOfManufacture Manufacturing date of the column. 
ProductId Product number of the column. 
SerialNo Serial number of the column. 

Secondary column properties 
The user can enter and later change the following properties if necessary: 
 
Property Description 
CardState Reports whether the memory card is present: 
 NoChip  The card is missing. 
 DoorOpened  The door is open. (The card is not writeable 

while the door is open.)  
 UnknownFormat The card format is unknown. 
 BusBlocked  One of the cards is not inserted correctly. 

Thus, it may happen that another card is not 
readable although it is correctly. 

DateOfExpiration Expiration date of the column. If a date has been entered, the 
current date is compared with the expiration date during injection or 
at the beginning of batch processing. If the current date exceeds 
the expiration date or if batch processing starts less than 24 h 
before the expiration date, a warning appears once per Batch. 

Description Column description. 
Diameter Column diameter in [mm]. 
FormatChipCard Select this command to format a chip card that contains invalid or 

corrupt data. 
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Property Description 
Injections_Limit Maximum number of injections allowed for the column.  
Length Column length in [mm]. 
Manufacturer Column manufacturer. 
PackingMaterial Packing material of the column. 
ParticleSize Particle size in [µm] 
pH_LowerLimit 
pH_UpperLimit 

Upper and lower pH limits. If both limits are set to the same value, 
this means that no limit exists. 

 Note:  
These values are for information purposes only. The device driver 
cannot check the pH value. 

Pressure_UpperLimit If the column pressure exceeds the upper pressure limit, a warning 
appears. 

 Note:  
Accept the default (0.0) if you do not want to have the system check 
the pressure. 

Temp_LowerLimit 
Temp_UpperLimit 

If the column temperature is above the upper temperature limit or 
below the lower temperature limit, a warning appears. If both limits 
are set to the same value (default: 25°C each), this means that no 
limit exists. (These values also apply to the inactive column.) 

VoidVolume The column's void volume in [µl]  

System properties 
System properties are read-only and cannot be changed by the user. 
Chromeleon determines and updates the following properties during each 
injection: 
 
Property Description 
DateOfFirstUse Date of the first injection  
DateOfLastUse Date of the last injection 
Injections_Counter Number of injections 
Pressure_Max Maximum pressure measured while the column was in use  
Temp_Min Minimum temperature measured while the column was in the column 

compartment 
Temp_Max Maximum temperature measured while the column was in the column 

compartment  
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User properties 
The user can change the following properties at any time: 
 
Property Description 
Application Enter any text to describe the application. 
Comment Enter any comment text.  
SystemPressure Name of the device to be used for system pressure measurement.  

For information about the special commands supported by the Dionex 
TCC-100 Thermostatted Column Compartment, refer to  Dionex TCC-
100 Thermostatted Column Compartment. 
For information about the standard commands supported for the different 
column compartments, refer to  Dionex Flow Manager and 
Thermostatted Column Compartments. 
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 Dionex FLM-3x00 Flow Manager and Thermostatted 
Column Compartment 
For the flow manager, several subentries appear in the Commands dialog 
box. They provide the following commands and properties: 
 
Command/Property Description 
Column_1 
Column_2 
(possibly Colum_3) 

The column names correspond to the names entered on the 
Components tab page in the Server Configuration program. 
The various commands and properties allow you to enter and 
check information about the column. For more information, refer 

to  Dionex FLM-3x00 Flow Manager and Thermostatted 
Column Compartment: Column ID Properties. 

ColumnOven_Temp This channel is available only if you have selected the 
TemperatureSignal check box in the FLM's properties (on the 
Configuration tab page in the Server Configuration program.) If 
the check box is selected, Chromeleon records the temperature 
as a separate channel. The channel's name is the name 
entered on the Configuration tab page in the Server 
Configuration program. 
Click the "+ "character beside the name to display the items 
underneath: 
Delta−reports the signal's slope, i.e., the difference between the 
current value and the value one second ago. This is useful for 
triggers.  
Signal−has the following commands: Value (current signal 
value, read-only), UpperLimit and LowerLimit. If the current 
signal value is outside these limits, a warning appears in the 
Audit Trail.  
AcqOff−terminates data acquisition.  
AcqOn−starts data acquisition.  
Retention−reports the retention time of the signal (read-only).  
MaxAutoStep = Maximum step rate for Auto Step Mode;  
range: 0.1...5.1 s; default: 5.1 s 
Step−sets the step for data acquisition; range: 0.01...4.80 s; 
Auto selects the best step dynamically 
Average−averages all measured values over the step interval. 
Default: On. Off records only the last point of each interval.  

FLM-3x00_INPUT_1 and/or 
FLM-3x00_INPUT_2 

Reports the state of the related digital input (On or Off). The 
property is read-only. 

FLM-3x00_RELAY_1 
and/or 
FLM-3x00_RELAY_2 

Relay 1 and/or relay 2. Click the "+"character beside the relay 
name to display the items underneath: 
State−reports the state of the relay. 
Duration−when set, the relay toggles after the specified time. 
On−turns the relay on. 
Off−turns the relay off 
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Command/Property Description 
FlowSplitter_1 The splitter name corresponds to the name entered on the 

Configuration tab page in the Server Configuration program. 
For information about the commands and properties that are 

available, refer to  Dionex FLM-3x00 Flow Manager and 
Thermostatted Column Compartment: Flow Splitter 
Properties.  

In addition to the standard column compartment commands, such as 
Connect, Disconnect, and Temperature, (see  Dionex Flow Manager 
and Thermostatted Column Compartments), the FLM-3x00 supports the 
following commands and properties (please note that the display Filter 
level determines which commands and properties are displayed): 
 
Command/Property Description 
Brightness Adapts the brightness of the pump's front panel display to your 

requirements (0 - 100 %). 
Contrast Adapts the contrast of the pump's front panel display to your 

requirements (0 - 100 %). 
Door Reports whether the front panel door is open or closed (Open 

or Closed; read-only). 

 Note: 
You cannot start a batch when the front panel door is open. 

FlowController1Error Reports whether the flow splitter 1 is working properly (OK or 
Error) (read-only).  

FluidLeak Reports whether the fluid leak sensor has detected a leak (Ok 
or Leak; read-only). 

FluidLeakSensor Settings of the fluid leak sensor: 
 Enabled Enables leak detection via the fluid leak sensor. If a 

leak is detected, a message appears in the 
Chromeleon Audit Trail and an acoustic beep 
sounds. 

 Silent Enables leak detection. If a leak is detected, a 
message appears but no beep sounds. 

 Off Disables the leak detection. 
GasLeak Reports whether the gas sensor has detected a leak  

(Ok or Leak; read-only). 
GasLeakSensor Sets the sensitivity with which the sensor responds to gas in the 

column chamber. Click the arrow in the GasLeakSensor 
combo box and select an option from the list: Low, Standard, 
or High (if the sensor is activated, a message appears in the 
Chromeleon Audit Trail and an acoustic beep sounds) or 
Low_Silent, Standard_Silent, or High_Silent, respectively (a 
message appears but no beep sounds). To turn the sensor off, 
select Off. 
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Command/Property Description 
HardwareVersion Indicates the flow manager's hardware version. 
HumidityLeak Indicates whether the humidity sensor has detected a leak  

(Ok or Leak; read-only). 
HumidityLeakSensor Sets the sensitivity with which the sensor responds to humidity. 

Click the arrow in the HumidityLeakSensor combo box and 
select an option from the list: Low, Standard, or High (if the 
sensor is activated, a message appears in the Chromeleon 
Audit Trail and an acoustic beep sounds) or Low_Silent, 
Standard_Silent, or High_Silent, respectively (a message 
appears but no beep sounds). To turn the sensor off, select Off. 

Leak Indicates whether at least one leak sensor has detected a 
leakage (Ok or Leak; read-only; also see FluidLeak, GasLeak, 
and HumidityLeak). 

LeakAlarmOff Turns off the beep for the current alarm. A new beep sounds 
when one of the leak sensors detects another leak. 

LeakSensorState Reports whether the sensors are ready for leak detection 
(Ready, NotReady, or Error; read-only). 

MSVPosition (FLM-3300 only) Reports and/or sets the current valve position: 
 Moving The valve is switching. 
 10_1 Indicates the fluid connections in the valve: 

ports 10 and 1 are connected. 
 1_2 Indicates the fluid connections in the valve: 

ports 1 and 2 are connected. 
 NotConnected The control electronics is not connected; 

contact Dionex Service. 
 Error An error occurred. Contact Dionex Service. 
MSVPosition_Counter Counts how often the left and/or right valve was switched since 

being installed (read-only). 
Ready Reports whether the instrument is ready to operate (Ready or 

NotReady; read-only; also see ReadyTempDelta and 
EquilibrationTime). 

 Note: 
You cannot start a batch when the flow manager is not ready. 

ReadyTemperatureDelta Range: 0.0 - 5.0°C. If the current temperature deviates from the 
temperature set point by more than the ReadyTempDelta, the 
flow manager enters the NotReady state. If the 
ReadyTempDelta is set to 0,Chromeleon does not check 
whether the temperature set point deviates from the actual 
temperature (also see Ready and EquilibrationTime). 

SerialNo Serial number of the manager (read-only). 
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Command/Property Description 
Standby Sets the flow manager to Standby mode or cancels this mode 

(NoStandby) to resume operation (values: NoStandby (0), 
Standby (1)). 

 Note: 
You cannot start a batch when the flow manager is in standby 
mode. 

TempCtrl Turns temperature control on or off. 
TempReady Reports whether the temperature is within the defined limits 

(Ready or NotReady). (Read-only, also see Temperature.) 

 Note: 
You cannot start a batch when the temperature is not within the 
defined limits. 

ValveLeft 
ValveRight 

(FLM-3100 and FLM-3200 only) Reports and/or sets the current 
valve position: 

 Moving The valve is switching. 
 10_1 (or 6-1) Indicates the fluid connections in the valve: 

ports 10 (6) and 1 are connected. 
 1_2 Indicates the fluid connections in the valve: 

ports 1 and 2 are connected. 
 NotConnected The control electronics is not connected; 

contact Dionex Service. 
 Error An error occurred. Contact Dionex Service. 
ValveLeftCounter 
ValveRightCounter 

(FLM-3100 and FLM-3200 only) Counts how often the left 
and/or right valve was switched since being installed (read-
only). 

Vendor Indicates the device manufacturer (read-only). 
WorkingHours Counts the operating hours of the column thermostat.  

For information about column identification, refer to  Dionex FLM-3x00: 
Column ID Properties. 

For information about the flow splitter commands and properties, refer to 
 Dionex FLM-3x00: Flow Splitter Commands.  

For information about how to install the flow manager, refer to Hardware 
Installation  FLM-3x00 Flow Manager and Thermostatted Column 
Compartment: Overview in the Administrator Help section. 
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 Dionex FLM-3x00: Column ID Properties 
The Dionex FLM-3x00 Flow Manager and Thermostatted Column 
Compartment supports the following column ID properties. The column 
properties appear underneath the column name specified in the Server 
Configuration program. (Note that the display Filter level determines 
which properties are displayed.) 

Primary column properties 
These properties are used for column identification. They are entered once 
by either the column manufacturer or the user and cannot be changed. 
 
Property Description 
BatchNumber Batch or lot number of the column. 
CustomId You can enter any number you want, for example, the column's 

inventory number. (Note: The number cannot be changed once it is 
entered.)  

DateOfManufacture Manufacturing date of the column. 
ProductId Product number of the column. 
SerialNo Serial number of the column.  

Secondary column properties 
The user can enter and later change the following properties if necessary: 
 
Property Description 
ActiveColumn Set to Yes to have Chromeleon update the information for the 

associated column. The name corresponds to the name entered on 
the Configuration tab page in the Server Configuration program. 

CardState Reports whether the memory card is present: 
 NoChip The card is missing. 
 DoorOpened The door is open. (The card is not writeable 

while the door is open.)  
 UnknownFormat The card format is unknown. 
 BusBlocked One of the cards is not inserted correctly. 

Thus, it may happen that another card is not 
readable although it is correctly. 

DateOfExpiration Expiration date of the column. If a date has been entered, the 
current date is compared with the expiration date during injection or 
at the beginning of batch processing. If the current date exceeds 
the expiration date or if batch processing starts less than 24 h 
before the expiration date, a warning appears once per Batch. 

Description Column description. 
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Property Description 
Diameter Column diameter in [mm]. 
FormatChipCard Select this command to format a chip card that contains invalid or 

corrupt data. 
Injections_Limit Maximum number of injections allowed for the column.  
Length Column length in [mm]. 
Manufacturer Column manufacturer. 
PackingMaterial Packing material of the column. 
ParticleSize Particle size in [µm] 
pH_LowerLimit 
pH_UpperLimit 

Upper and lower pH limits. If both limits are set to the same value, 
this means that no limit exists. 

 Note:  
These values are for information purposes only. The device driver 
cannot check the pH value. 

Pressure_UpperLimit If the column pressure exceeds the upper pressure limit, a warning 
appears. 

 Note:  
Accept the default (0.0) if you do not want to have the system check 
the pressure. 

Temp_LowerLimit 
Temp_UpperLimit 

If the column temperature is above the upper temperature limit or 
below the lower temperature limit, a warning appears. If both limits 
are set to the same value (default: 25°C each), this means that no 
limit exists. (These values also apply to the inactive column.) 

VoidVolume The column's void volume in [µl] 

System properties 
System properties are read-only and cannot be changed by the user. 
Chromeleon determines and updates the following properties during each 
injection: 
 
Property Description 
DateOfFirstUse Date of the first injection  
DateOfLastUse Date of the last injection 
Injections_Counter Number of injections 
Pressure_Max Maximum pressure measured while the column was in use  
Temp_Min Minimum temperature measured while the column was in the column 

compartment 
Temp_Max Maximum temperature measured while the column was in the column 

compartment  
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User properties 
The user can change the following properties at any time: 
 
Property Description 
Application Enter any text to describe the application. 
Comment Enter any comment text.  
SystemPressure Name of the device to be used for system pressure measurement.  

For information about the special commands supported by the FLM-3x00, 
refer to  Dionex FLM-3x00 Flow Manager and Thermostatted Column 
Compartment. 
For information about the flow splitter commands and properties, refer to 

 Dionex FLM-3x00: Flow Splitter Commands.  

For information about the standard commands supported for the different 
column compartments, refer to  Dionex Flow Manager and 
Thermostatted Column Compartments. 

For information about how to install the flow manager, refer to Hardware 
Installation  FLM-3x00 Flow Manager and Thermostatted Column 
Compartment: Overview in the Administrator Help section. 

 Dionex FLM-3x00: Flow Splitter Commands 
The FLM-3x00 supports the following commands and properties for flow 
splitter control (please note that the display Filter level determines which 
commands and properties are displayed): 

 Note:  
The name specified on the Components page in the Server Configuration 
program determines the name under which the flow splitter commands and 
properties appear in the Commands dialog box. 
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Command/Property Description 
ActualSplitRatio Indicates the actual split ratio of the flow splitter. A value of 

1000 means that a master flow of 100 µL/min will result in a 
nano flow of 100 nL/min. 

CardState Reports whether the flow splitter chip card is present  
 NoChip The card is missing. 
 DoorOpened The front panel door is open. (The 

card is not writeable while the door is 
open.) 

 UnknownFormat The card format is unknown. 
 BusBlocked One of the cards is not inserted 

correctly. Thus, it may happen that 
another card is not readable although 
it is correctly installed. 

Comment Enter any user-specific comment text. 
Description Describes the flow splitter. 
FSColPressDesired Sets the desired pressure when FSControlMode is set to 

Pressure. For test purposes only. 
FSControlMode Sets the flow control operation mode. The standard operation 

mode is Auto. All other modes are for test purposes only. 
FSFlowControllerStatus Reports the flow control status (read-only). This includes the 

status of the flow sensor (see FSFlowSensorStatus) and the 
status of the flow splitter valve (see FSValveStatus). 

 OK  The flow splitter is working 
correctly. 

 PressureLow The necessary pressure is not built 
up. This can be due to: 
a) The flow delivered by the pump 
is too low. 
--Or-- 
b) Pressure buildup is insufficient 
due to, e.g., leakage in the system. 
Inspect the system for signs of 
leakage. Verify that the 
configuration settings match the 
actual system structure. 

 PressureHigh There is too much backpressure, 
for example, because a capillary or 
the column is blocked. 
Perform a self-test for the valve. 
Perform a cleaning cycle for the 
valve if necessary. Exchange the 
capillaries and/or column if 
necessary. 
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Command/Property Description 
 ValveFail The flow control valve is 

malfunctioning. Check the valve 
and perform a cleaning cycle if 
necessary. 

 ValvePositionLimit The flow control valve does not 
build up enough pressure. For 
remedial actions, refer to 
PressureLow and ValveFail. 

 FlowSensorFail The flow sensor is malfunctioning. 
Turn the flow manager off and on. 

 RegulationErrorr The control accuracy is insufficient. 
In most cases, this is due to 
excessive pump pressure pulsation. 
Make sure that the pump works 
bubble-free. Check the valves if 
necessary. . 

FSFlowSensorStatus Reports the status of the flow sensor (read-only): 
 OK The flow splitter is working 

correctly. 
 SensorNotFound 

TimeoutError 
DataTransferError 
DataIntervalError 
InvalidData 
DataFrameErrorr 

The flow sensor is malfunctioning. 
(The exact wording is important 
only for Dionex Service.) Turn the 
flow manager off and on. 

FSValveInit Resets the flow control actuator; can be used to recover from 
malfunction (for service purposes only). 

FSValveStatus Reports the status of the flow splitter valve (read-only): 
 Init The valve is initializing. 
 OK The valve is working correctly. 
 OutOfRange The flow splitter valve is 

malfunctioning. This error can 
correspond to the errors described 
in FSFlowControllerStatus. Refer 
to the section above for information 
about remedial actions. 

 PressureLimit This error is also reported as 
PressureLow and/or 
PressureHigh for the 
FSFlowControllerStatus property. 
Refer to the sections above for 
information about remedial actions. 

 PositionLimit This error is also reported as 
ValvePositionLimit for the 
FSFlowControllerStatus property. 
Refer to the sections above for 
information about remedial actions. 
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Command/Property Description 
InitFlowControlSelfTest Starting from zero, the flow control actuator runs a linear ramp 

with the specified step (StepRate; range 10-100 ms). The 
resulting course of the column pressure allows you to draw 
conclusions when an error or fault occurs. 

ProductId Indicates the product number of the flow splitter. 
SerialNo Indicates the serial number of the flow splitter.  

For information about the special commands supported by the FLM-3x00, 
refer to  Dionex FLM-3x00 Flow Manager and Thermostatted Column 
Compartment. 

For information about the column ID properties, refer to  Dionex FLM-
3x00: Column ID Properties.  

For information about how to install the flow manager, refer to Hardware 
Installation  FLM-3x00 Flow Manager and Thermostatted Column 
Compartment: Overview in the Administrator Help section. 
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Dionex Detectors 

In addition to the  General Device Commands, Chromeleon supports 
the following standard commands for representing the recorded data. The 
commands are available for all detectors, even if they supply analog 
signals, for example, via the UCI Universal Chromatography Interface. 

Standard Commands  
 
Command Description 

⇒AcqOn/Off Start/stop data acquisition. 
⇒Autozero Automatic autozero. 

AutoAutoscale Axis/scaling adjustment. 
⇒Average Average all measured values over the Step interval.  
⇒Delta Indicates the signal's slope, that is, the difference between the 

current value and the value one second ago; this is useful for 
⇒Triggers. 

⇒Lamp Turns the lamp on or off. 
⇒MaxAutoStep  Sets the maximum step if Step = Auto. 
⇒Step Step width adjustment 
⇒Wavelength Sets the wavelength.  

 
For information about special commands and properties available for 
individual detectors, refer to: 

 Dionex UVD 170/340 UV/PDA Detectors  
 Dionex PDA-100 Photodiode Array Detector  
 Dionex AD20/AD25 Absorbance Detectors  
 Dionex UVD-3000 UV Detector 
 Dionex/LC Packings UltiMate Capillary/Nano HPLC UV Detector 
 Dionex RF2000 Fluorescence Detector  
 Dionex CD20/CD25/CD25A, ED40/ED50/ED50A, and 

IC20/IC25/IC25A Electrochemical Detectors  
 Dionex CD Conductivity Detector 
 Dionex ED Electrochemical Detector 
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Please note: The Shodex RI-101 Refractive Index Detector is available 
from Dionex as part of the Summit HPLC System; refer to Commands and 
Tips for Third-Party Devices  Shodex RI-101 Refractive Index 
Detector. 

 Dionex UVD 170/340 UV/PDA Detectors  
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), the UVD 170 and UVD 340 detectors support 
additional control commands (please note that the display Filter level 
determines which commands are displayed): 

Special Commands  
 
Command Description 

⇒Bandwidth Sets the bandwidth of a UV-VIS channel.  
⇒BunchWidth For UVD 340U only: Averages photodiode signals for 3D field 

acquisition.  
CheckWavelength Checks wavelength calibration, using a Holmium-Oxide Filter.  
⇒LampIntensity States the lamp intensity at 254 nm in counts/seconds. The value 

can be used as a comparison value to determine how much the 
lamp intensity decreased. This requires that the value be first 
measured when the lamp is new. 

⇒RefWavelength Sets the reference wavelength.  
⇒RefBandwidth Sets the reference bandwidth. 

 
The Dionex UVD 170 and UVD 340 detectors can be completely controlled 
by Chromeleon, using the above commands. In addition, the following 
special commands are supported: 

Equilibration command and properties 
 

 Tip:  
You should use the equilibration commands and properties only for the 

SmartStart feature. 
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Command/Property Description 
Drift Reports the signal Drift. 
 UpperLimit Determine the upper limit for the drift in [mAU/h]. 

The upper limit can be any value between 0.8 and 
20.0. The default setting is 3.0. 

 Value (Read-only) Reports the actual value (usually, this 
value is averaged over the last 5 minutes.): At the 
beginning (i.e., after installation of the pump), the 
value field is empty, indicating that no measurement 
has been performed yet. Chromeleon calculates the 
value as soon as a 1-minute segment has been 
measured and updates the value with each new 
segment. The value of the property does not 
change after the measurement and displayed under 

Preconditions. 
DriftEquilibration (Read-only) Reports drift whether equilibration was successful: Ok 

or NotOK. 
DriftStatus Reports the status of drift equilibration (read-only). 
 N/A Equilibration was not yet performed. 
 Measuring Equilibration is running but the amount of data is 

not yet sufficient to report a result. 
 Good Equilibration is running or terminated. The values 

are within the specified limits. 
 NotReady Equilibration is running. The current data is outside 

the specified limits. 
 Failed Equilibration is completed. The result is outside the 

specified limits. 
 NotTested The limit was set to 0, thus disabling ripple 

checking. 
Equilibration (Read-only) Reports the overall status of equilibration. 
Noise Reports the Signal Noise. 
 UpperLimit Determine the upper limit for the signal noise in 

[mAU]. The upper limit can be any value between 
0.03 and 0.50. The default setting is 0.10. 

 Value (Read-only) Reports the actual signal noise 
(usually, this value is averaged over 5 minutes. For 
more information, refer to Drift.Value above.. 

NoiseEquilibration (Read only) Reports whether noise equilibration was successful: Ok 
or NotOk 

NoiseStatus (Read only) Reports the status of noise equilibration. For more 
information, refer to DriftStatus above. 
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Special Commands for the Dionex UVD 170U/340U Detectors 
 
Command Description 
LampAge Indicates the lamp age (in hours). 
LampIgnitions Indicates the number of lamp ignitions. 
MinLampIntensity Enter the value for the minimum lamp intensity. If the lamp 

intensity is below this value, a warning is written to the Audit 
Trail.  

SnapshotGetSpectrum For UVD 340U only: Stores the current spectrum in a text file. 
SnapshotResolution For UVD 340U only: Defines the wavelength resolution for a UV 

spectrum that is recorded using the SnapshotGetSpectrum 
command  
(Range: 0.1 to 20.0 nm). 

SnapshotDirPath For UVD 340U only: Defines the destination directory for a UV 
spectrum that is recorded using the SnapshotGetSpectrum 
command. 

SnapshotGetBLSpectrum For UVD 340U only: Saves the current spectrum as baseline 
spectrum. The baseline spectrum is always subtracted from the 
spectrum recorded with the SnapshotGetSpectrum command. 

SnapshotClearBLSpectrum For UVD 340U only: Clears the buffer for baseline spectrum 
that was recorded using the SnapshotGetBLSpectrum 
command.  

 Note:  
Using a registry key, you can define a voltage offset (in millivolt) on the 16-
bit DAC card for the analog output of the Dionex UVD 170/340 detector 
signal. The offset values for all 16-bit DAC channels of the CM server are 
identical. 

Enter the respective offset in millivolt into the registry key: 

Example for 100 millivolt (hexadecimal entry):  
[HKEY_LOCAL_MACHINE\Software\Dionex\Chromeleon\drivers\UVD340]
   
"DAC Offset"=dword:00000064 

The Administrator Help section provides information about how to install 
the UVD 170 or UVD 340 detector; refer to Hardware Installation  

 UVD 170S and UVD 340S HPLC Detectors: Overview  

 UVD 170U and UVD 340U HPLC Detectors: Overview 
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 Dionex PDA-100 Photodiode Array Detectors  
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), the PDA-100 detector provides the additional 
control commands (please note that the display Filter level determines 
which commands are displayed):  

UV_VIS Channel Commands 
 
Command Description 

⇒Bandwidth Sets the bandwidth (the wavelength range at which the 
chromatogram is measured).  

Offset_Level Sets the offset for the analog output signal. 
Recorder_Range Sets the range of a full-scale recorder response (analog output). 

⇒RefBandwidth Sets the bandwidth of the reference wavelength (if one is 
selected). If RefWavelength is Off, the RefBandwidth setting has 
no effect. 

⇒RefWavelength Sets the reference wavelength.  
 

3DFIELD Channel Commands 
Command Description 

⇒BunchWidth Determines how many nanometers are averaged when collecting 
3D data. Bunching (averaging) the signals of adjacent 
wavelengths reduces the size of the 3D data stored. 

MaxWavelength Sets the maximum wavelength of the 3D field. 
MinWavelength Sets the minimum wavelength of the 3D field. 
RefBandwidth Sets the bandwidth of the reference wavelength (if one is 

selected). If RefWavelength is Off, the RefBandwidth setting has 
no effect. 

RefWavelength Sets the reference bandwidth. 

Other Special Detector Commands 
Command Description 
AmbientTemp Reports the temperature outside the optical assembly. 
AZ_Done Reports the status of an autozero command (Busy or Done). 

Data_Collection_Rate Sets the rate at which Chromeleon collects digital data points 
from the detector. 

⇒LampIntensity Reports the deuterium lamp's intensity at 254 nm in 
counts/second. 

ModuleAge Reports (or resets) the number of hours the module has been 
on. 
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Command Description 
NegativeAbsorptionLevel  Sets the amount of increased light transmission from autozero 

(negative absorption) to which the detector responds. This 
permits peaks to be seen even when the eluent decreases 
absorbance. 

OpticalBenchTemp Reports the temperature of the optical bench. 
Rise_Time Sets how quickly the detector responds to a change in signal. 
TTL_Input_Mode  Sets the TTL input signal mode. 
UV_Lamp Turns the deuterium lamp on and off. 

UVLampAge Reports (or resets) the number of hours the deuterium lamp has 
been on. 

UVLampPowerOnSetting Selects whether the deuterium lamp is turned on when the 
device power is turned on. The default setting is On. 

Visible_Lamp Turns the tungsten lamp on and off.  
VisLampAge Reports (or resets) the number of hours the tungsten lamp has 

been on. 
VisLampIntensity Reports the tungsten lamp's intensity at 520 nm. Reported in 

counts per second. 
VisLampPowerOnSetting Selects whether the tungsten lamp is turned on when the 

device power is turned on. The default setting is On. 

UV Calibration Commands 
Command Description 
DownloadCalibration Downloads the selected set of calibration values to the detector. 
DownloadCalibration 
Parameter 

Selects the set of calibration values (Current, Previous, or 
Factory) to be downloaded. 

FilterWheel Calibrates the filter wheel (not applicable to the USB model of the 
PDA-100). 

Intensity Calibrates the intensity of the deuterium lamp. 
LeakDet Performs the leak detector calibration (not applicable to the USB 

model of the PDA-100). 
WavelengthCal Performs a wavelength calibration. 
WavelenthCalDate Reports the date of the wavelength calibration. 
WavelenthCalResult Reports the result (pass or fail) of the wavelength calibration. 

UV Diagnostic Commands 
Command Description 
LeakDetTest Performs a test of the leak detector (not applicable to the USB 

model of the PDA-100). 
LeakDetTestDate Reports the date of the leak detector test. 
LeakDetTestResult Reports the result (pass or fail) of the leak detector test. 
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Command Description 
WavelengthVerTest Performs wavelength verification via the Holmium Oxide Filter. 
WavelengthVerTestDate Reports the date of the wavelength verification. 
WavelengthVerTestResult Reports the result (pass or fail) of the wavelength verification.  

For information about how to install the detector, refer to Hardware 
Installation  PDA-100 (DX-LAN) Detector: Overview or  PDA-100 
(USB) Detector: Overview in the Administrator Help section. 

 Dionex AD20/AD25 Absorbance Detectors  
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), Dionex absorbance detectors provide the following 
commands (please note that the display Filter level determines which 
commands and properties are displayed):  

Special Commands 
 
Command Description 

Data_Collection_Rate Sets the rate at which Chromeleon collects digital data points 
from the detector. 

⇒Rise_Time  Sets how quickly the detector responds to a change in signal. 
UV_Cutover For AD20 only: Sets the wavelength above which the second 

order filter is inserted in the light path. Typically, the UV cutover 
wavelength is 380nm. 

UV_Lamp Turns the deuterium lamp to Off, Low, or High (AD20 detector), 
or Off or On (AD25 detector).  

Visible_Lamp Turns the tungsten lamp to Off, Low, or High (AD20 detector), or 
Off or On (AD25 detector).  

⇒Wavelength Sets the wavelength.  

Analog Output Commands 
 
Command Description 

Full_Scale For AD20 only: Sets the full-scale analog out voltage. 
Mark  Sends a positive pulse to the detector’s analog output as an 

event marker. 
Offset_Level  Sets the offset for the analog output signal. 
Polarity  Switches the analog output polarity (+/-). 
Recorder_Calibration  For AD25 only: Allows calibration of the recorder’s response to 

three detector analog output settings (AU, Zero, Full_Scale) 
Recorder_Range  Sets the range of a full-scale recorder response. 
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UV Calibration Commands (For AD25 Only) 
 
Command Description 
DownloadCalibration Downloads the selected set of calibration values to the 

detector. 
DownloadCalibration 
Parameter 

Selects the set of calibration values (Current, Previous, or 
Factory) to be downloaded. 

LeakDet Performs the leak detector calibration. 
WavelengthCal Performs a wavelength calibration. 
WavelengthCalDate Reports the date of the wavelength calibration. 
WavelengthCalResult Reports the result (pass or fail) of the wavelength calibration.  

UV Diagnostic Commands (For AD25 Only) 
 
Command Description 
LeakDetTest Performs a test of the leak detector. 
LeakDetTestDate Reports the date of the leak detector test. 
LeakDetTestResult Reports the result (pass or fail) of the leak detector test. 
WavelengthVerTest Performs a wavelength verification via the Holmium Oxide 

Filter. 
WavelengthVerTestDate Reports the date of the wavelength verification. 
WavelengthVerTest 
Result 

Reports the result (pass or fail) of the wavelength verification. 
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 Dionex UVD-3000 UV Detector 
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), the UVD-3000 detector provides the following 
control commands (please note that the display Filter level determines 
which commands and properties are displayed):  
 
Command/Property Description 
Adjust_Calibration Performs wavelength calibration by using an internal test. 

 Tip:   
The command stops the data acquisition. 

AnalogOffset1 Sets the offset voltage for analog output 1. 
AnalogOffset2 Sets the offset voltage for analog output 2. 
AnalogScale Sets the sensitivity of the analog outputs. 
⇒Autozero Performs automatic null balancing. 

 Tip:   
Use this command only before you start data acquisition. For null 
balancing whenever the wavelength is changed in the program, use 
AutozeroOnWlChange = On. Use AutozeroOnWlChange = Off to 
cancel null balancing. Use: 
    AutozeroOnWlChange = On 
    UV_VIS_1 = 300 

(not:     AutozeroOnWlChange = Off 
            UV_VIS_1 = 300 
          Autozero) 

AutozeroOnWlChange When set to On, automatic null balancing is performed whenever the 
wavelength is changed. 

Data_Collection_Rate Enter the rate at which Chromeleon collects digital data from the 
detector. 

DemoFileName Name of the file that is read in the Demo Mode. 
GetDiodeReading Determines the values for SignalDiode and ReferenceDiode. 
LampType Indicates the lamp type (read-only). 
ReferenceDiode Indicates the brightness of the reference signal. 
Response Time constant. This is the time the detector requires for rising from 

10% to 90% in response to a signal step. The constant is used for 
noise suppression (values: 0.1; 0.2; 0.5; 1; 2; 5, or 10s) 

 Tip:   
Most noise is suppressed if the Response is 10s. However, for the 
acquisition of narrow peaks a lower time response will be more 
appropriate. 

SignalDiode Indicates the brightness of the measured signal.  
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 Tip:  

If you perform the Data Collection Rate command, the default ⇒Step 
value is set to the reciprocal value. That is why you have to perform the 
Step command after the Data Collection Rate command if you need a 
different step.  

The UV_Diagnostic section provides information about detector operation 
and service. The entries are read-only: 
 
Command/Property Description 
LampAge Reports the total operating hours of the lamp. 
LampIgnitions Reports the number of lamp starts. 
LampNumber Indicates the lamp number. (The value is incremented when a new 

lamp is installed.) 
LampOnTime Reports how many hours the lamp has been burning since it was 

turned on. 
LastServiceDate Reports when the detector was last serviced. (The Dionex Service 

Engineer enters the date.) 
LastServiceCode Reports the service code, providing information about the service. 

(The Dionex Service Engineer sets the code.) 
ManufacturingDate Reports the detector manufacturing date. 
MotorWorkTime Reports the total operating hours of the motor.  

For information about how to install the detector, refer to Hardware 
Installation  UVD-3000 UV Detector: Overview in the Administrator 
Help section. 
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 Dionex/LC Packings UltiMate Capillary/Nano HPLC UV 
Detectors 
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), the UltiMate detector provides the following control 
commands (please note that the display Filter level determines which 
commands and properties are displayed):  
 
Command/Property Description 
Adjust_Calibration Performs wavelength calibration by using an internal test. 

 Tip:   
The command stops the data acquisition. 

Data_Collection_Rate Enter the rate at which Chromeleon collects digital data from the 
detector. 

DemoFileName Name of the file that is read in the Demo Mode. 
LampType Indicates the lamp type: Deuterium or Tungsten (read-only). 
TimeConstant Time constant. This is the time the detector requires for rising from 

10% to 90% in response to a signal step. The constant is used for 
noise suppression (values: 0.1; 0.2; 0.5; 1; 2; 5, or 10s) 

 Tip:   
Most noise is suppressed if the Response is 10s. However, for the 
acquisition of narrow peaks a lower response will be more 
appropriate. 

 

 Tip:  

If you perform the Data Collection Rate command, the default ⇒Step 
value is set to the reciprocal value. That is why you have to perform the 
Step command after the Data Collection Rate command if you need a 
different step.  

The UV_Diagnostic section provides information about the detector 
operation and service. The entries are read-only: 
 
Command/Property Description 
LampAge Reports the total operating hours of the lamp. 
LampIgnitions Reports the number of lamp starts. 
LampNumber Indicates the lamp number. (The value is incremented when a new 

lamp is installed.) 
LampOnTime Reports how many hours the lamp has been burning since it was 

turned on. 
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Command/Property Description 
LastServiceDate Reports when the detector was last serviced. (The Dionex Service 

Engineer enters the date.) 
LastServiceCode Reports the service code, providing information about the service. 

(The Dionex Service Engineer sets the code.) 
ManufacturingDate Reports the detector manufacturing date. 
MotorWorkTime Reports the total operating hours of the motor.  

For information about how to install the UltiMate UV detector, refer to 
Hardware Installation  UltiMate Capillary/Nano HPLC System: 
Overview in the Administrator Help section. 

 Dionex RF2000 Fluorescence Detector  
In addition to the commands available for various detector types, such as 
Step, Average, Autozero (see  Dionex Detectors), controllable 
fluorescence detectors allow you to modify the Emission and Excitation 
wavelengths. 
 
Command Description 

Emission Modifies the measuring wavelength. 
Excitation Modifies the excitation wavelength.  

In addition, the RF2000 detector supports the Scan mode for recording 
emission and excitation spectra. For a PGM File example, refer to 
Practical Tips for Device Control  Determining the Optimum 
Emission Wavelength (RF2000). 
For information about the following RF2000 commands, refer to Dionex 
RF2000 Fluorescence Detector: 

 Excitation Wavelength 

 Emission Wavelength 

 Gain 

 Response 

 Sensitivity 

 Scanning 
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 (Scan)Start and (Scan)End Wavelengths 

 ScanSpeed 

 ScanWithAnalogOutput 
 
For information about how to install the Dionex RF2000 Fluorescence 
Detector, refer to Hardware Installation  RF2000 Fluorescence 
Detector: Overview in the Administrator Help section. 
The Administrator Help section provides information about the pin 
assignment of the RF2000 cable; refer to  RF2000 RS Cable in the 
Appendix of the Hardware Installation section. 

 Dionex RF2000 Fluorescence Detector: Excitation 
Wavelength 
Use the Excitation parameter to determine the excitation wavelength of 
the fluorescence detector. This is the wavelength required to induce a 
specific substance to fluoresce. 

To be able to measure the light emitted by the substance, set the 
fluorescence detector exactly to this wavelength, using the Emission 
parameter. 

 Dionex RF2000 Fluorescence Detector: Emission 
Wavelength 
To be able to measure the light emitted by the substance, set the 
fluorescence detector exactly to the corresponding wavelength, using the 

Emission parameter. 

To set the wavelength required for excitation, use the Excitation 
parameter. 
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 Dionex RF2000 Fluorescence Detector: Gain 
Use the Gain signal parameter to determine the factor by which the analog 
output signal of the RF2000 fluorescence spectrometer is increased or 
decreased. Thus, the Gain parameter corresponds to the Range 
parameter that is supported for other detector types. 

 Note: 
The UCI Universal Chromatography Interface ranges from -10V to +10V 
and thus covers virtually all detector output signals. It is possible to record 
signals directly, without considering the Gain parameter. If size adjustment 
is necessary anyway, adjust the size, using the Factor parameter of the 
signal configuration. (Select the Signals tab page of the fluorescence 
detector properties in the Server Configuration program). 

 Dionex RF2000 Fluorescence Detector: Response 
Response refers to the time the detector requires to reach 98% of the full-
scale deflection.  

The larger the chosen time interval is, the better is the Signal-to-Noise 
Ratio, but the lower is the resolution. 

 Dionex RF2000 Fluorescence Detector: Sensitivity 
Use the Sensitivity parameter to determine the detector sensitivity. The 
detector sensitivity increases with a higher Sensitivity value. However, 
increasing the Sensitivity value also increases the noise; that is, the 

Signal-to-Noise Ratio decreases.  

The RF2000 fluorescence detector supports the following values: LOW, 
MED, and HIGH. 

The actual sensitivity results from the product of the Sensitivity (LOW = 1, 
MED = 32, HIGH = 1024) and the Gain (1/4/16). 
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 Dionex RF2000 Fluorescence Detector: Scanning 
Scanning indicates that the detector is currently in the Scan Mode. The 
Scan Mode functionality determines optimum values for the Excitation 
and the Emission wavelengths. However, determination is not 
simultaneously. The procedure is described below for the emission 
wavelength as an example. For a corresponding Program, refer to 
Practical Tips for Device Control  Determining the Optimum 
Emission Wavelength (RF2000). 

Scanning 
• Stop the pump flow via the Flow = 0 command.  

• Execute the ScanEmission command.  

The duration of the Scan procedure depends on the wavelength range to 
be scanned (Start and End Wavelengths) and on the scan speed (see 

 Dionex RF2000 Fluorescence Detector: ScanSpeed). You can add 
an LED or a color box to the Control Panel to optically indicate whether 
the detector is scanning. 

After completing the actual scan process, the resulting spectrum is saved in 
the instrument and overwritten with each new recording. To retain the data, 
Chromeleon saves each scan spectrum automatically to the local 
datasource. A Spectra Library named RF2000 is created in the sequence 
directory of the associated Timebase. 

Depending on when the pump flow is stopped and when the scan 
procedure was started, either a background spectrum or the spectrum of a 
peak is saved. 
• Determine an optimum excitation wavelength (excitation value) in the 

same way.  

 Tip: 
While the RF2000 Fluorescence Detector is performing a scan operation, it 
cannot receive any other commands. It is not possible to interrupt the 
scanning process. 
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How to form a difference spectrum  
To receive a difference spectrum (= current spectrum minus background 
spectrum):  
• Record a background spectrum as described above.  

• Use the Save Background Spectrum command to save this spectrum 
also as a separate spectrum in the detector. 

• Reset the pump flow to the original value, using the Flow= ... 
command. Continue until the maximum of the peak to be detected is 
reached. 

• Stop the pump flow and record a new spectrum. 

The two spectra now exist both in the RF2000 spectra library and as 
individual spectra that are stored in two different locations in the detector. 
• Execute the GetSpectraDifference command to receive a difference 

spectrum.  

The detector behaves in the same way as if a Scan procedure has been 
started. The result of the difference formation is also saved to the RF2000 
spectra library. This spectrum indicates the optimum emission or excitation 
value.  
 

 Tip: 
The basic requirement for forming difference spectra is that the wavelength 
range defined by the start wavelength and the end wavelength corresponds 
to the spectra type (Excitation or Emission). 

 Dionex RF2000 Fluorescence Detector: (Scan)Start and 
End Wavelengths 
Use the (Scan)Start parameter to determine the lower limit of the 
wavelength range to be scanned. Use the (Scan)End parameter to 
determine the upper limit of range. To set the speed with which the range is 
scanned, use the ScanSpeed parameter (see  Dionex RF2000 
Fluorescence Detector: ScanSpeed). 

For more information about the Scan procedure, refer to  Dionex 
RF2000 Fluorescence Detector: Scanning. 
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 Dionex RF2000 Fluorescence Detector: ScanSpeed 
Use the ScanSpeed parameter to determine the speed with which the 
determined wavelength range is scanned. The range is defined by the start 
and end wavelengths (see  Dionex RF2000 Fluorescence Detector: 
(Scan)Start and End Wavelengths).  

The following settings are available: 
 
Setting Scan Speed Required time from 200 to 900 nm 
Slow (24 nm/min) 1900 sec. 
Medium (120 nm/min) 370 sec. 
Fast (default) (600 nm/min) 85 sec. 
Super (3000 nm/min) 25 sec.  

 Tip: 
While the RF2000 Fluorescence Detector is performing a scan operation, it 
cannot receive any other commands. It is not possible to interrupt the 
scanning process. 
 
For more information about the scanning process, refer to  Dionex 
RF2000 Fluorescence Detector: Scanning. 

 Dionex RF2000 Fluorescence Detector: Scan With 
Analog Output 
Enable Scan With Analog Output to display the scanned spectrum at the 
integrator or recorder output. On the instrument's rear panel, these outputs 
are labeled as follows: INTEG.1V and REC. 10mV or REC. 1mV. 
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 Dionex CD20/CD25/CD25A, ED40/ED50/ED50A, and 
IC20/IC25/IC25A Electrochemical Detectors  
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), Dionex electrochemical detectors provide special 
commands (see the table below; please note that the display Filter level 
determines which commands are displayed).  

The Data_Collection_Rate command and the analog output commands 
are available for all Dionex electrochemical detectors in any operating 
mode.  

The Mode command is available only for the ED40/ED50/ED50A detectors. 
Other special commands depend on the selected operating mode. 
 
Command Description 

Data_Collection_Rate Sets the rate at which Chromeleon collects digital data 
points from the detector. 

Mode (Available only for the ED40/ED50/ED50A) Select the 
operating mode: conductivity, integrated amperometry, or 
DC amperometry.  

Analog Output Commands (All Modes) 
 
Command Description 

Full_Scale Sets the full-scale analog out voltage. 
Mark  Sends a positive pulse to the detector’s analog output as an 

event marker. 
Offset_Level Sets the offset for the analog output signal. 
Polarity Switches the analog output polarity (+/-). 
Recorder_Range Sets the range of a full-scale recorder response. 
Rise_Time Sets how quickly the detector responds to a change in 

signal.  
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Special Commands (Conductivity Mode) 
The following commands are available for conductivity detectors 
(CD20/CD25/CD25A, ED40/ED50/ED50A, or IC20/IC25/IC25A): 
 
Command Description 
DS3_Temperature Sets the DS3 temperature. 
SRS_Current  For CD20/CD25, ED40/ED50, IC20/IC25 only: Sets the 

current supplied to the SRS. 
Suppressor_Current For CD25A, ED50A, and IC25A only: Sets the current 

supplied to the suppressor. 
Suppressor_Type For CD25A, ED50A, and IC25A only: Sets the installed 

Suppressor. 
Temperature_Compensation  Sets the temperature compensation factor, which is used 

to stabilize conductivity readings.  

Special Commands (DC Amperometry Mode) 
The following commands are available for the ED40/ED50/ED50A 
detectors in DC amperometry mode: 
 
Command Description 
Cell Turns the cell on and off. 

DC_Voltage Sets the voltage applied to the cell. 
Electrode Select the type of electrode installed.  

Special Commands (Integrated Amperometry Mode) 
The following commands are available for the ED40/ED50/ED50A 
detectors in integrated amperometry mode: 
 
Command Description 
Cell Turns the cell on and off. 
Electrode Select the reference electrode type. 

Waveform  Define a waveform (a plot of potential vs. time).  
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Calibration Commands (For CD25A, ED50A, and IC25A Only) 
 
Command Description 
LeakDet Performs the leak detector calibration. 
CondCell Performs the conductivity cell calibration 
DownloadCalibration Downloads the selected set of calibration values to the detector. 
DownloadCalibration 
Parameter 

Selects the set of calibration values (Current, Previous, or Factory) 
to be downloaded.  

Diagnostic Commands (For CD25A, ED50A, and IC25A Only) 
 
Command Description 
LeakDetTest Performs a test of the leak detector. 
LeakDetTestDate Reports the date of the leak detector test. 
LeakDetTestResult Reports the result (pass or fail) of the leak detector test. 
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 Dionex CD Conductivity Detector  
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), the CD provides special commands (see the table 
below; please note that the display Filter level determines which 
commands are displayed).  
 
Command Description 

DataCollectionRate Sets the rate at which Chromeleon collects digital data 
points from the detector. 

FlowStatus Reports the status of the flow sensor (flow detected or flow 
not detected). 

PressureStatus Reports the status of the pressure sensor (over pressure or 
not over pressure). 

Rise_Time Sets how quickly the detector responds to a change in 
signal. 

Suppressor_Current Reports the actual suppressor current. 
Suppressor_CurrentSet Sets the current supplied to the suppressor and turns on the 

suppressor (Suppressor_Mode=On) 
Suppresor_Mode Turns the suppressor on and off. 
Suppressor_Type Sets the installed Suppressor type. 
Suppressor_Voltage Reports the suppressor voltage. 

Temperature_Compensation  Sets the temperature compensation factor, which is used to 
stabilize conductivity readings. 

Cell Heater Commands 
 
Command Description 
Mode Selects whether the cell heater is on or off.  
Status  Reports whether the cell heater is under the set temperature, 

at the set temperature, or over the set temperature. 
TemperatureActual Reports the actual temperature. 
TemperatureSet Sets the temperature of the cell heater. 
TemperatureState Reports the state of the cell heater (Ready or NotReady) 

Analog Output Commands (Available only if I/O option is installed) 
 
Command Description 

Full_Scale Sets the full-scale analog out voltage. 
Mark  Sends a positive pulse to the detector’s analog output as an 

event marker. 
Offset_Level Sets the offset for the analog output signal. 
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Command Description 
Polarity Switches the analog output polarity (+/-). 

Recorder_Calibration Calibrates a recording device.  
Zero sets the output signal to zero volts. 
Full Scale sets the output signal to the selected full-scale 
voltage (10, 100, or 1000 mV).  
Normal (the default) outputs a signal corresponding to the 
detector output. 

Recorder_Range Sets the range of a full-scale recorder response. 

 

 Dionex ED Electrochemical Detector  
In addition to the standard commands available for all detectors (see 

 Dionex Detectors), the ED provides special commands (see the table 
below; please note that the display Filter level determines which 
commands are displayed).  
 
Command/Property Description 
CellControl Turns the cell on and off, or turns the dummy cell on and off. 
CellStatus Reports whether the cell is connected or disconnected. 

DataCollectionRate Sets the rate at which Chromeleon collects digital data points 
from the detector. 

DC_Voltage Sets the voltage applied to the cell. 
Electrode Select the reference electrode type (AgCl or pH). 
ElectrodeStatus Reports whether the electrode is connected or disconnected. 
pH Reports the current pH 
pHAtTime0 Reports the pH at the start of acquisition. 
pH.LowerLimit Sets the lower limit for pH. An error is reported in the Audit Trail 

if the pH is lower than this value at the start of acquisition. 
pH.UpperLimit Sets the upper limit for pH. An error is reported in the Audit Trail 

if the pH is higher than this value at the start of acquisition. 
Mode Select the operating mode: IntAmp (integrated amperometry), 

DCAmp (DC amperometry), or Cyclic (cyclic voltammetry). 
Rise_Time Sets how quickly the detector responds to a change in signal. 
Waveform  Define a waveform (a plot of potential vs. time). 
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Commands for Cyclic Voltammetry (for the 3D_Amp Channel) 
 
Command/Property Description 
CV_CycleTime Sets the time in seconds for one CV cycle, which is the time 

it takes to go from the CV Low Voltage to the CV High 
Voltage and then back to the CV Low Voltage. This 
creates a triangle Waveform. 

CV_LoVoltage Sets the lowest voltage to be applied during the CV cycle. 
This voltage begins and ends the cycle. 

CV_HiVoltage Sets the highest voltage to be applied during the CV cycle. 
This is the peak of the triangle waveform. 

CV_Cycles Sets the number of times to repeat the CV cycle. 
StartCV Starts the CV run.  
  

Analog Output Commands (Available only if I/O option is installed) 
 
Command/Property Description 

Full_Scale Sets the full-scale analog out voltage. 
Mark  Sends a positive pulse to the detector’s analog output as an 

event marker. 
Offset_Level Sets the offset for the analog output signal. 
Polarity Switches the analog output polarity (+/-). 

Recorder_Calibration Calibrates a recording device.  
Zero sets the output signal to zero volts. 
Full Scale sets the output signal to the selected full-scale 
voltage (10, 100, or 1000 mV).  
Normal (the default) outputs a signal corresponding to the 
detector output. 

Recorder_Range Sets the range of a full-scale recorder response. 
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Dionex Ion Chromatography Systems 

Refer to the following topics for information about control commands for the 
current Dionex ion chromatography systems: 

 Dionex DX-120 Ion Chromatograph 
 Dionex ICS-90 Ion Chromatography System 
 Dionex ICS-1000/1500/2000 Ion Chromatography System 

 Dionex DX-120 Ion Chromatograph 
The following commands are available for control of DX-120 operating 
functions (please note that the display Filter level determines which 
commands are displayed): 
 
Command Description 
Column If the DX-120 is in Column Mode, the Column command sets 

the flow path to column A or column B. 
Controlled AC Turns the AC power outlet on the DX-120 rear panel on and off. 

This provides on off control of an external accessory connected to 
the outlet. Refer to the DX-120 operator’s manual for cabling 
instructions. 

Data_Collection_Rate Sets the rate at which Chromeleon collects digital data points 
from the detector. 

Eluent If the DX-120 is in Eluent Mode, the Eluent command selects 
the eluent reservoir (A or B). 

Eluent Pressure Turns the pressure to the eluent reservoir(s) on and off. 
Pressure Unit Select the units of pressure to use (psi or MPa). 
Pump Turns the pump on and off. 
SRS Turns the current supplied to the Self-Regenerating Suppressor 

(SRS) on and off.  



 Commands for Controlling Dionex Devices 831 

 Dionex ICS-90 Ion Chromatography System 

In addition to the  General Device Commands, the following commands 
are available for control of ICS-90 operating functions (please note that the 
display Filter level determines which commands are displayed): 

Detector Commands  
 
Command Description 

⇒AcqOn/Off Starts/stops data acquisition. 
⇒Autozero Automatic autozero. 

 

Pump Commands  
 
Command Description 
Pump (on/off) Turns the pump on or off. 
⇒Pressure.Lower/ 
UpperLimit 

Sets pressure limits. 

 

Injection and TTL Commands 
 
Command Description 
InjectPosition Sets the injection valve to the inject position. 
LoadPosition Sets the injection valve to the load position. 
TTL 1 The following commands are available: State (indicates or sets 

the state of the TTL), Ov (turns the TTL on), 5v (turns the TTL 
off), and Duration (toggles the TTL’s state after the specified 
time).  

In addition to the commands listed above, calibration and diagnostic 
commands are also available (see How to …: Performing Validation and 
Qualification  Ensuring System Wellness for details). 
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 Dionex ICS-1000/1500/2000 Ion Chromatography System 

In addition to the  General Device Commands, the following commands 
are available for control of ICS-1000/1500/2000 operating functions (please 
note that the display Filter level determines which commands are 
displayed). 

Pump Commands  

In addition to the standard pump commands (see  Dionex Pumps), the 
following commands are available for controlling the ICS-1000/1500/2000 
pump. 
 
Command Description 
EluentBottleLevel Indicates the volume of liquid (in liters) in the eluent reservoir. To 

ensure the accuracy of this value, enter the volume of liquid in the 
reservoir each time you fill the reservoir. 

EluentValve Indicates the eluent valve position (Open or Closed). 
On, Off, Prime Turns the pump on or off, or starts the pump priming function. 
Pump_InjectValve. 
InjectPosition 

(If no AS50 is installed) Injects the sample 

 Tip:  
For the ICS ion chromatography system, injection is performed with 
the Pump_InjectValve.InjectPosition command (if no AS50 is 
installed). With the Pump_InjectValve.InjectPosition command, 
an injection is always performed, also for a Blank Run Sample. 
This is contrary to the autosampler ⇒Inject command.  

PumpMode Indicates whether the pump is on, off, or priming.  

Detector Commands  

In addition to the standard detector commands (see  Dionex Detectors), 
the following commands are available for controlling the ICS-
1000/1500/2000 detector. 
 
Command Description 
Acquisition_Ready Indicates when the detector is ready to start data acquisition. 
CellTemperature Sets the temperature of the DS6 conductivity cell. 

Data_Collection_Rate Set the rate at which Chromeleon collects digital data points 
from the detector 

DataPolarity Sets the signal polarity to Normal or Inverted. 
MaxAutoStep Sets the maximum step rate if ⇒Step is set to Auto. 
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Command Description 
Offset_Level (Analog Out) Sets the offset (0 to 100%) applied to the 

recorder output. 
Polarity (Analog Out) Sets the recorder output polarity. 
Recorder_Calibration  (Analog Out) Calibrates the recorder output (Normal, Zero or 

Full-Scale). 
Recorder_Range  (Analog Out) Sets the full-scale output range of the recorder. 

Rise_Time Sets how quickly the detector responds to a change in signal. 
TotalConductivity Reports the measured conductivity with no offset applied.  

Column Temperature and Suppressor Commands 
Command Description 
ColumnTemperature Sets the column heater temperature. 
Suppressor_Current Sets the suppressor current (in mA). 
Suppressor_Mode Turns the suppressor on or off. 
Suppressor_Type Selects the type of Suppressor installed.  

Eluent Generator Commands (ICS-2000 only) 

In addition to the standard eluent generator commands (see  Dionex 
Eluent Generators), the following commands are available for controlling 
the ICS-2000 eluent generator. 
Command Description 
CR_TC Turns the CR-TC on or off. 
EgcCurrent Indicates the EGC current value. 
EgcVoltage Indicates the EGC voltage value. 
Mode Turns the eluent generator on or off.  

State Commands 
Command Description 
InjectPosition Sets the injection valve to the inject position. 
LoadPosition Sets the injection valve to the load position. 
Relay_1, Relay_2 The following commands are available: State (indicates or sets 

the state of the relay), Closed (closes the relay), Open (opens 
the relay), and Duration (toggles the relay's state after the 
specified time). The relay-contact closures are normally open. 
When the relay is closed, current flows to the connected device 
(turns on the action). 
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Command Description 
TTL_1, TTL_2 The following commands are available: State (indicates or sets 

the state of the TTL), Ov (sets the TTL to zero volts), 5v (sets 
the TTL to 5 volts), and Duration (toggles the TTL’s state after 
the specified time). The TTL outputs are normally at 5 volts. 
Setting a TTL output to 0 volts turns on the action in the 
connected device.  

In addition to the commands listed above, calibration and diagnostic 
commands for the ICS-1000/1500/2000 are also available (see How to …: 
Performing Validation and Qualification  Ensuring System Wellness 
for details). 
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Additional Dionex Components 

In addition, Chromeleon supports the Additional components. For a 
description of the commands and properties supported for these 
components, refer to: 

 Dionex Eluent Generators 
 Dionex External MSVs 
 Dionex Detector/Chromatography Module 
 Dionex Active Flow Splitter (MRA) 

 

 Dionex Eluent Generators  

In addition to the  General Device Commands, the following commands 
are available for controlling the operating functions of Dionex eluent 
generators (please note that the display Filter level determines which 
commands are displayed). 
 
Command Description 
CartridgeExpirationDate Reports the expiration date of the cartridge (read-only). 
CartridgeNumber Reports the serial number of the cartridge.  
CartridgeRemainingLife
Time 

Reports the percentage of the original ion count remaining in the 
cartridge (read-only). 

CartridgeType Reports the cartridge type currently installed (read-only). 
Concentration Sets the eluent concentration to be generated. 
CR-TC (ICS-2000 and 
ICS-3000 EG only) 

Turns the CR-TC (Continuously Regenerated Trap Column) on 
or off. The CR-TC removes anionic or cationic contaminants in 
the eluent or deionized water. 

Curve Sets the curve number for gradients. Refer to Gradient Curves 
for an explanation of curve numbers. 

EgcCurrent (ICS-2000 
and ICS-3000 EG only) 

Indicates the current value of the cartridge (read-only). 

EgcVoltage (ICS-2000 
and ICS-3000 EG only) 

Indicates the voltage value of the cartridge (ready-only). 

Mode (ICS-2000 and 
ICS-3000 EG only) 

Turns the eluent generator on or off. 

SerialNumber Reports the serial number of the eluent generator (read-only).  



836 Commands for Controlling Dionex Devices 

For additional information, refer to Practical Tips for Device Control: 

 Controlling the Eluent Generator Concentration 

 Monitoring the Eluent Generator Cartridge Lifetime 
 

Calibration Commands 
Command Description 
DownloadCalibration Downloads the selected set of calibration values to the detector. 
DownloadCalibration 
Parameter 

Selects the set of calibration values (Current, Previous, or 
Factory) to be downloaded. 

LeakDet Performs the leak detector calibration. This command is not 
available for the ICS-3000 EG.  

Diagnostic Commands 
The following diagnostic commands are not available for the ICS-3000 EG: 
Command Description 
LeakDetTest Performs a test of the leak detector. 
LeakDetTestDate Reports the date of the leak detector test. 
LeakDetTestResult Reports the result (pass or fail) of the leak detector test. 
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 External MSVs 

In addition to the  General Device Commands, the following commands 
are available for controlling the operating functions of the switching valves 
(please note that the display Filter level determines which commands are 
displayed):  
 
Command Min. Max. Default Description 
Direction 0 Shortest 

1 Counterclockwise 
2 Clockwise 

0 Defines the direction in which 
the valve moves to the 
specified position.  

Home  Moves the valve to position 1. 
(Note: The command ignores 
the Direction property.) 

Position 1 Depends on 
the type. 

Read out from 
the device on 
connect.  

The current position of the 
valve. (The valve moves to 
the specified position, 
obeying the Direction 
property.) 

Test  Tests the valve. (Moves the 
valve to position 1, steps to 
all positions, and returns the 
valve to position 1) 
Level: Expert.  

 Dionex Detector/Chromatography Module  

In addition to the  General Device Commands, the following commands 
are available for control of DC operating functions (please note that the 
display Filter level determines which commands are displayed). 
 
Property Description 
LowerDoor Reports whether the compartment lower door is open or closed. 
UpperDoor Reports whether the compartment upper door is open or closed. 
LowerLeakCondition Reports whether the lower leak sensor is wet or dry. 
UpperLeakCondition Reports whether the upper leak sensor is wet or dry.  
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Temperature Control Commands 
The following commands are used for controlling the various DC 
temperature control zones (conductivity cell, compartment, column, and 
reaction coil heater). 
 
Command/Property Description 
AcquireExclusiveAccess Gives exclusive access of the temperature zone to the current 

timebase. Exclusive access commands allow two timebases to 
share the same DC temperature zones. 

ReleaseExclusiveAccess Takes exclusive access of the temperature zone away from the 
current timebase, to allow another timebase to acquire 
exclusive access. 

Mode Selects whether the temperature zone is on or off.  
Status  Reports whether the temperature of the zone is under the set 

temperature, at the set temperature, or over the set 
temperature. 

TemperatureActual Reports the actual temperature. 
TemperatureSet Sets the temperature of the temperature zone. 
TemperatureState Reports the state of the temperature zone (Ready or 

NotReady) 

Injection Valve Control Commands 
The following commands are used for controlling the high-pressure 
injection valves installed in the DC. 
 
Command/Property Description 
State Indicates and can set the valve position (Load or Inject).  
LoadPosition Switches the valve to position Load. 
InjectPosition Switches the valve to position Inject. 

High-Pressure Valve Control Commands 
The following commands are used for controlling the high-pressure valves 
installed in the Automation Manager. 
 
Command/Property Description 
State Indicates and can set the valve position (A or B).  
A Switches the valve to position A. 
B Switches the valve to position B.  
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Low-Pressure Valve Control Commands 
The following commands are used for controlling the various low-pressure 
valves installed in the DC. 
 
Command/Property Description 
State Indicates and can set the valve position (Open or Closed).  
Open Switches the valve to the open position. 
Closed Switches the valve to the closed position.  

Relay Control Commands 
The following commands are used for controlling the relay outputs installed 
in the DC. 
 
Command/Property Description 
State Indicates and can set the relay position (Open or Closed).  
Open Switches the relay to the open position. 
Closed Switches the relay to the closed position.  

 Active Flow Splitter (MRA) 

In addition to the  General Device Commands, the following commands 
are available for controlling the operating functions of the flow splitter 
(please note that the display Filter level determines which commands are 
displayed): 
 
Command Min. Max. Default Description 
Flow 1.0 100.0 10.0 Sets the flow in mL/min that 

shall be split. 
GrooveVolume 0 300 - Indicates the groove volume in 

nL (ready only). (The property 
is available from the Expert 
level on.) 

Home  Moves the splitter to position 1.  
ModuleType Text (64 characters), 

describing the flow 
splitter type 

Read from 
the splitter 
upon 
connect. 

Indicates the module type 
(should be MRA100-000; read-
only). (The property is available 
form the Expert level on.) 
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Command Min. Max. Default Description 
RunState On/Off Off Sets the status of the MRA: On 

splits the flow based on the 
related parameters. 

SplitFactor 1 59 47 Reports the split factor set on 
the device (read-only). (The 
property is available from the 
Expert level on.) 

SplitRatio.Nominal 100 100000 20000 Sets the nominal split ratio.  
SplitRatio.Value 100 100000 - Indicates the actual split ratio 

(read-only). The ratio is 
calculated from the HPLC flow 
and SplitRatio.Nominal. 

SwitchCounter    Counts how often the flow 
splitter switched since the 
counter was last reset.  

UpperLimit 0 NoLimit; 
10000001 

NoLimit If the total number of switches 
exceeds the upper limit, a 
warning appears. To disable 
the function, set the upper limit 
to NoLimit. 

Value Reset; 
0 

10000000 1 Reports the total number of 
splitter switches. Select Reset 
to reset the counter to 0.  

SwitchFrequency 0.00 100.00 - Reports the switching 
frequency in Hz (read-only). 
(The property is available from 
the Expert level on.) 

Test  Tests the flow splitter. (Moves 
the splitter to position 1, steps 
to all positions, and returns the 
splitter to position 1). 
(The property is available from 
the Expert level on.)  
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Commands and Tips for  
Third-Party Devices 

Chromeleon allows you to control both Dionex devices and numerous third-
party devices. For an overview of manufacturers whose instruments can be 
controlled by Chromeleon, refer to Hardware Installation  Installing 
and Controlling Third-Party Devices in the Administrator Help section. 

For many third-party devices, Chromeleon provides the same commands 
as for the Dionex devices. For more information about the standard 
commands, refer to Device Control  Practical Tips for Device Control 
(Overview) and  Commands for Controlling Dionex Devices. 

In addition to the standard commands, several third-party devices support 
special commands. For information about these commands and other 
useful tips for the respective instruments, refer to: 

 Agilent 
 CTC Analytics PAL Samplers 

Finnigan (see  ThermoFinnigan/TQ/TSP) 
 Fisons AS800 Autosampler 
 Gilson  

Hewlett Packard (see  Agilent) 
Hitachi (see  Merck Hitachi) 

 Kontron 
 Merck Hitachi 
 Perkin Elmer  
 Rheodyne Valves 
 Shodex Refractive Index Detectors (RI-101, RI-102, RI-104) 
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 Shimadzu HPLC Systems 
 ThermoFinnigan/TQ/TSP 
 Valco (= VICI) Valves 
 Varian 
 Waters 

Agilent (formerly HP): Commands and Tips  

For information about the special commands that Chromeleon supports for 
the different Agilent devices and for tips for practical operation, refer to: 

 1100 HPLC System  
 Agilent 1050 HPLC System: UV Detector 
 6890/6850 GCs 
 Agilent HP5890 GC: Application 

 Agilent 1100 HPLC System: Commands and Tips 
Refer to the following pages for information about the special commands 
supported for the Agilent 1100 HPLC System and for tips for practical 
operation: 

 General 

 Pump 

 Autosampler (G1329) 

 Wellplate-Sampler (G1367) 

 Column Compartment 

 UV Detectors 

 Fluorescence Detectors 

 Program Tips 
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 Example for a Derivatization Program 

 Scan Modes for the Fluorescence Detector 

 Tips for Lamp Commands 

 Checking the Solvent Liquid Level 

 Diagnostic Functions 

 Troubleshooting 

 Agilent 1100 HPLC System: General 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min Max Default Description 
Firmware n/a n/a n/a Firmware version of the module 

(read-only) 
ModelNo n/a n/a n/a Module number (read-only) 
NotReadyCauses n/a n/a n/a String to explain why the module is 

not yet ready for the next analysis 
(read-only) 

SerialNo n/a n/a n/a Serial number of the module (read-
only) 

 
Command Description 

⇒Connect Connect the device. 
Disconnect Disconnect the device. 
Identify Identify the module. The module LED will flash. 
⇒Reset Reset the device. 

 
Name Possible States Description 
AnalysisState NoAnalysis, 

Analysis 
Pending 

Retention time state 

AnalysisTime 0 outside of analysis, analysis time in 
minutes since analysis start. 

Retention Time 

ErrorState NoError 
Error 

Error state 
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Name Possible States Description 
ReadyState NotReady 

Ready 
Ready state 

RuntimeState Prerun 
Run 
Postrun 
Leak 
Shutdown 

Run time state 

RunTime 0 outside of run, runtime in minutes 
since run start. 

Run time 

TestState NoTest 
Test 

Test state 

 
The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation: 

 Agilent 1100 HPLC System: Overview 

 Agilent 1100 HPLC System: Installation 

 Agilent 1100 HPLC System: Pump 
In addition to the standard pump commands (see Commands for 
Controlling Dionex Devices  Dionex Pumps), the following commands 
and properties are available (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Property Min Max Default. Description 

⇒%B, %C, %D 0.0 % 100.0 % 100.0 %A  
Compressibility autom., no 

compensation, 
50..150 

- 100 Compressibility 
[1e-6/bar] 
(Available only 
for the isocratic 
and quaternary 
pumps.) 

Compressibility 
LeftPump 

autom., no 
compensation, 
50..150 

- 50 Compressibility 
of the left pump 
[1e-6/bar] 
(Only for the 
binary pump) 
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Property Min Max Default. Description 
Compressibility 
RightPump 

autom., no 
compensation, 
50..150 

- 115 Compressibility 
of the right pump 
[1e-6/bar] 
(Available only 
for the binary 
pump.) 

EmptySolventError Off On Off * 
⇒Flow 0.000 ml/min 10.000 ml/min 

(quaternary) 
5.000 ml/min 
(binary) 

0.000 ml/min  

Pressure 0.0 bar 400.0 bar  
(5800 psi) 
(Flow < 5 ml/min) 
200.0 bar  
(2900 psi) (else) 

Min.: 0 
Max. 400.0  

 

PrimaryChannel  autom.,  
A, B,  
C, D 

- autom. (Quaternary 
LPG pump only) 
Select the 
channel from 
which the pump 
shall draw liquid 
first. The pump 
starts with 
drawing half the 
volume required 
for the 
composition, 
then draws the 
required volume 
from the other 
channels, and 
then draws the 
second half of 
the volume 
required for the 
first channel. 
Automatic 
selects the 
channel with the 
maximum 
percentage.  

SolventFillingX 0.00 l 1000.00 l n/a * (Where X = 
A1, A2, B1 or B2 
for the binary 
pump and X = A 
to D for the 
quaternary 
pump.) 
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Property Min Max Default. Description 
SolventLeftPump A1, A2 - A1 Eluent of the left 

pump. (Available 
only for the 
binary pump.) 

SolventNotReady 
Limit 

0.00 l 1000.00 l 0.00 l * 

SolventRightPump B1, B2 - B1 Eluent of the 
right pump. 
(Available only 
for the binary 
pump.) 

Stroke autom., 
20..100 µl 

- autom. Pump stroke 
(Available only 
for the isocratic 
and quaternary 
pumps.) 

StrokeLeftPump autom., 20..100 
µl 

- autom. Stroke of the left 
pump. (Available 
only for the 
binary pump.) 

StrokeRightPump autom., 20..100 
µl 

- autom. Stroke of the 
right pump. 
(Available only 
for the binary 
pump.) 

 

* For more information about these commands, refer to  Agilent 1100 
HPLC System: Checking the Solvent Liquid Level. 
 

Diagnostic Commands 
 
Command Description 
CountDown Keeps the specified flow rate for the CountDown time. (The default 

setting is 0.00 min. The allowed range is 0.00 to 99,999.00 min.) 
LeakTestInit Prepares the pump for the leak test by moving pistons A1 and B1 for 

the quaternary pump and/or piston 2 for the binary pump to the top of 
its stroke.  

LeakTestRun Performs a leak test. 

 Tip:  
Dionex recommends performing the command from the related 

diagnostic panel (see  Agilent 1100 HPLC System Diagnostics: 
Leak Test).  
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Command Description 
PressureTest Performs a pressure test. 

 Tip:   
Dionex recommends performing the command from the related 

diagnostic panel (see  Agilent 1100 HPLC System 1100 
Diagnostics: Pump Pressure).  

The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation: 

 Agilent 1100 HPLC System: Overview 

 Agilent 1100 HPLC System: Installation 

 Agilent 1100 HPLC System: Autosampler (G1329) 
In addition to the standard autosampler commands (see Commands for 
Controlling Dionex Devices  Dionex Autosamplers), the following 
commands and properties are available (please note that the display 

Filter level determines which commands and properties are displayed): 
 
Property Min Max Default Description 
DispSpeed 10 µl/min or 

90 µl/min 
1000 µl/min 200 µl/min Speed for dispensing 

the sample 
DrawSpeed 10 µl/min or  

90 µl/min 
1000 µl/min 200 µl/min Speed for drawing the 

sample 
Position 0 (Tray 

dependent) 
n/a Sample vial number 

SampleHeight -2.5 mm 35 mm 0.0 mm Needle draw/eject 
position offset  

Syringe 100 µl 900 µl as configured Syringe volume [µl] 
⇒Volume 0.0 µl 8000.0 µl 5.0 µl Injection volume 
WashVial 0 Greatest sample 

position (tray 
dependent) 

0 Wash vial number  
0: no wash 
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Command Description 

⇒Dispense Injects the sample into the loop. 
⇒Draw Draws sample from a vial into the syringe.  
InitiateChangeGripper Initiates the gripper change by moving the gripper to the front. 
InitiateChangeNeedle Initiates the needle change by removing the safety covering and 

moving the needle carrier to an easily accessible mounting 
position. In addition, the needle is lifted to the uppermost 
position. 

InitiateChangePiston Initiates the piston change by releasing the spring on the 
proportioning unit. 

⇒Inject Performs an injection (see note below). 
Mix Mixes the sample using the syringe.  
Repeat/EndRepeat Repeats the enclosed sample preparation steps.  
TerminateChangeGripper Terminates the gripper change by returning the gripper to the 

Home position. 
TerminateChangeNeedle Terminates the needle changes by returning the needle to the 

Home position. 
TerminateChangePiston Terminates the piston change by tensing the spring on the 

proportioning unit. 
Valve Switches the injection valve.  
Wait Waits a given time during the injection program.   

Parameters of the commands 
Command Values Description 
Dispense, 
parameter: Vial 

SampleVial (current sample vial) 
SampleVialPlus (current sample vial + n) 
Vial (sample vial No. n) 
Seat (needle seat) 
Air 

Position of the vial for 
dispense 

Dispense, Mix 
parameter: Speed 

10 (or 90 µl) to 1000 µl/min 
Maximum 
Default (uses DispSpeed) 

Speed for dispense or 
mix  

Draw, 
parameter: Source 

SampleVial (current sample vial) 
SampleVialPlus (current sample vial + n) 
Vial (sample vial No. n) 
Seat (needle seat) 
Air  

Position of the vial for 
draw  

Draw, 
parameter: Speed 

10 (or 90) to 1000 µl/min  
Maximum 
Default (uses DrawSpeed) 

Speed for draw  

Draw/Dispense, 
parameter: Offset 

-2.5 to 35.0 mm 
SampleHeight 

Needle draw/eject 
position offset for draw or 
dispense 



 Commands and Tips for Third-Party Devices 851 

Command Values Description 
Draw, Dispense, Mix 
parameter: Volume 

0.0 to 100.0 µl (or 900.0 µl) 
Maximum 
InjectVolume 

Volume for draw, 
dispense, or mix  

Needle, 
parameter: Vial 

SampleVial (current sample vial) 
SampleVialPlus (current sample vial + n) 
Vial (sample vial No. n) 

Position to which the 
needle is moved 

 

 Tips: 
The Inject command sends a start impulse to all modules. Then the 
analysis will start with the following steps: 

• The detector performs an ⇒Autozero if the program file contains the 
corresponding command at the time t=0.000 min.  

• An injection/sample preparation program is executed if the program 
contains the corresponding commands at the t=0.000 min.  

• The injection will take place and the run will start.  
 
Three different injection programs are available: 
Standard (injection volume from the 
respective position) 

WashVial=None and no sample preparation commands 

Standard (with needle wash) WashVial=None and no sample preparation commands 
User-defined injection program If sample preparation commands are given 

 

Autosampler/Thermostat 
Property Min Max Default Description 
AutoActivateSetpoint Off On On If set to On, temperature control 

is automatically enabled right 
after power-up.  

TempCtrl Off On Off Turns temperature control on or 
off. 

Temperature.Nominal 4°C 40°C 20°C Temperature set point for the air 
stream.  

Temperature.Value 4°C 40°C n/a Current temperature of the air 
stream.  

Also, see  Agilent HPLC System 1100: Wellplate Sampler (G1367). 
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Diagnostic Commands 
 
Command Description 
GripperHome Moves the gripper to home position. 
GripperPick Picks the vial at the current position.  
GripperPut Positions the vial at the current position. 
GripperToPosition Moves the gripper to the specified position. 
NeedleIntoSeat 
NeedleIntoVial 
NeedleToPosition 

(For the G1329 autosampler, the commands have no functionality.) 

NeedleUp Moves the needle to its topmost position. 
PlungerDraw Draws the plunger to load sample into the sample loop. 
PlungerHome Moves the plunger back to its home position. 
VialToSeat Positions the vial in the seat. 
VialToTray Positions the vial in the tray. 
ValveToBypass Switches the sample loop into the bypass position. 
ValveToMainpass Switches the sample loop into the inject position.   

For more information about the diagnostic functions for the autosampler, 
refer to: 

 Agilent 1100 HPLC System Diagnostics: Injector Steps 
 Agilent 1100 HPLC System Diagnostics: Gripper Verification 

 
The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation: 

 Agilent 1100 HPLC System: Overview 

 Agilent 1100 HPLC System: Installation 
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 Agilent 1100 HPLC System: Wellplate Sampler (G1367) 
In addition to the commands supported by the autosampler of the 1100 
HPLC System (see  Agilent 1100 HPLC System: Autosampler 
(1329)), the wellplate sampler supports the some special commands 
(please note that the display Filter level determines which commands and 
properties are displayed). Please note: For some of the HP 1100 
autosampler commands, the ranges and parameters may be different for 
the wellplate sampler (refer to the table below).  

Special Wellplate Sampler Parameters and Values 
Command Values Description 
Dispense, 
parameter: Vial 

SampleVial (current sample vial) 
Location (sample position No. n) 
Seat (needle seat) 

Position of the vial for 
dispense 

Dispense, Mix 
parameter: Speed 

10-1000 µl/min 
Maximum 
Default (uses DispSpeed) 

Speed for dispense or mix  

DispSpeed 10-1000 µl/min Speed for ejecting the sample 
Draw, 
parameter: Source 

SampleVial (current sample vial) 
Location (sample position No. n) 
Seat (needle seat) 
Air 

Position of the vial for draw  

Draw, 
parameter: Speed 

10-1000 µl/min 
Maximum 
Default (uses DrawSpeed) 

Speed for draw  

Draw/Dispense, 
parameter: Offset 

-10.0 to 60.0 mm 
SampleHeight 

Needle draw/eject position 
offset for draw or dispense 

Draw/Dispense, Mix 
parameter: Volume 

0.00-100.00 µl 
Maximum 
InjectVolume 

Volume for draw, dispense, or 
mix  

DrawSpeed 10-1000 µl/min Speed for drawing the sample 
Needle, 
parameter: Vial 

SampleVial (current sample vial) 
Location (sample position No. n) 

Position to which the needle 
is moved 

SampleHeight -10.0 to 60.0 mm Needle draw/eject position 
offset 

Volume 0.0-100.0 µl Injection volume  
WashVial Sample position No. 

no wash 
flush (see WashTime) 

Wash vial number. If the 
setting is no wash, no wash 
cycle will be performed.  
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Special Wellplate Sampler Commands 
Property Min. Max. Default Description 
DelayVolumeReduction² Off On Off  

(read from device 
on connect) 

Enables or disables 
automatic delay volume 
reduction. 

EquilibrationTime³ 0.0 s 100.0 s 0.0 s  
(sent to device on 
connect 

Time until equilibration is 
complete. 

FlushFactor 1.0 10.0 5.0 
(read from device 
on connect) 

Indicates how often the flush 
port is filled for flushing the 
needle (exterior). 

PrimePump 1 1000 5 Primes needle for the time 
specified (in [s]). 

WashRepeat 1 5 1 
(read from device 
on connect) 

Number of washes when 
WashVial is set to a vial 
location 

WashTime 0.0 s 100.0 s 1.0 s  
(read from device 
on connect) 

Time to wash when 
WashVial is set to Flush. 

 Tip:  

² Switches the injection valve back to BYPASS after the sample is eluted 
beyond the injection valve. 

³ On connect of the wellplate sampler EquilibrationTime = 0.0 s is sent to 
the device. If necessary, enter another value explicitly. 

 
Command Options 
Wash In  Time  Repeat  Offset  
(For user-
defined inject 
programs) 

In =  
AsMethod, 
Flush, 
SampleVial or 
osition of sample 

Time = 
0.0 to 100.0 s
 

Repeat = 
1 to 5 
 

Offset = 
-10.0 to 60.0 mm 
 

Function Defines the location 
of the wash solution 

See 
WashTime  
required if 
In = Flush 

See 
WashRepeat  
required if  
In > 0 or 
SampleVial 

Height of the needle 
above the bottom of 
the vial 
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For example, the following parameters are possible for the Wash 
command: 

1. Wash In=Flush Time=3 
(Washes for 3 seconds, using the eluent from the flush port.) 

2. Wash  In=SampleVial Repeat=2 
(Washes twice, using the solution from the current sample position.) 

3. Wash  In=15 Repeat=5 
(Washes five times, using the solution from sample position 15.) 

4. Wash  In=AsMethod 
(With this option, the parameters entered via the WashVial, WashTime, and 
WashRepeat commands are used.) 

Also, see  Agilent 1100 HPLC System: Autosampler (G1329). 

Diagnostic Commands 
 
Command Description 
GripperHome 
GripperPick 
GripperPut 
GripperToPosition 

(For the G1367 autosampler, the commands have no functionality.) 

NeedleIntoSeat Moves the needle into the needle seat. 
NeedleIntoVial Descends the needle into the vial. 
NeedleToPosition Moves the needle to the specified position. 
NeedleUp Moves the needle to its topmost position. 
PlungerDraw Draws the plunger to load sample into the sample loop. 
PlungerHome Moves the plunger back to its home position. 
VialToSeat 
VialToTray 

(For the G1367 autosampler, the commands have no functionality.) 

ValveToBypass Switches the sample loop into the bypass position. 
ValveToMainpass Switches the sample loop into the inject position.   
For more information about the diagnostic functions for the autosampler, 
refer to  Agilent 1100 HPLC System Diagnostics: Injector Steps. 

The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation  Agilent 1100 HPLC System: Overview and  Agilent 
1100 HPLC System: Installation. 
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 Agilent 1100 HPLC System: Column Compartment 
In addition to the standard oven commands (see Commands for 
Controlling Dionex Devices  Dionex Flow Manager and 
Thermostatted Column Compartments), the following commands and 
properties are available (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Property Min Max Default Description 
AutoActivateSetpoint 0 (Off) 1 (On) 0 (Off) If set to On, 

temperature control 
is automatically 
enabled right after 
power-up.  

LeftTemperature.Delta 
or 
RightTemperature.Delta 

0°C 100°C 0.8°C Temperature 
deviation permitted 
for the temperature 
set point in the left or 
right column 
compartment. 

LeftTemperature.Nominal 
or 
RightTemperature.Nominal 

-5°C 80°C 40°C Temperature set 
point for the left or 
right column 
compartment. 

LeftTemperature.Value 
or 
RightTemperature.Value 

-5°C 80°C 40°C Current temperature 
of the left column or 
right compartment. 

Mode 0  
(Combined)

1 
(Separate) 

0  
(Combined) 

Enables independent 
control of the right 
column compartment. 
If set to Combined, 
the settings for the 
left column 
compartment apply to 
both compartments.  

TempCtrl 0 (Off) 1 (On) Off Turns temperature 
control on or off. 

Valve 0 (Right 
Column) 

1 (Left 
Column) 

1 (Left 
Column) 

Switches the column 
selector valve 
(option).  

The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation: 

 Agilent 1100 HPLC System: Overview 

 Agilent 1100 HPLC System: Installation 
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 Agilent 1100 HPLC System: UV Detectors 
In addition to the standard detector commands (see Commands for 
Controlling Dionex Devices  Dionex Detectors), the following 
commands and properties are available (please note that the display 

Filter level determines which commands and properties are displayed): 
 
Property Min Max Default Description 
AutoActivateUV_Lamp Off On Off If set to On, the deuterium lamp 

is automatically turned on upon 
power-up.  

UV_Lamp Off On Off, (On in 
Demo Mode) 

Reports the state of the 
deuterium lamp. 

 
Property Min Max Default Description 
FilterMovements 0 UINT_MAX 0 in demo mode, 

else read from 
module on 
connect. 

Counter for the 
movements of the 
holmium oxide 
filter.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test. (PDA only) 

ReferenceDiodeExposure 0 UINT_MAX 0 in demo mode, 
else read from 
module on 
connect. 

Counter of the 
reference diode 
exposure.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test. (VWD only) 

SampleDiodeExposure 0 UINT_MAX 0 in demo mode, 
else read from 
module on 
connect. 

Counter of the 
sample diode 
exposure.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test. (VWD only) 
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Property Min Max Default Description 
SlitMovements 0 UINT_MAX 0 in demo mode, 

else read from 
module on 
connect. 

Slit movement 
counter.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test. (PDA only) 

UvLampIgnitions 0 UINT_MAX 0 in demo mode, 
else read from 
module on 
connect. 

UV lamp ignition 
counter.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test.  

UvLampLifetime 0.0h UINT_MAX/3600 0 in demo mode, 
else read from 
module on 
connect. 

Total burn time of 
the UV lamp [h] 
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test.  

UvLampOntime 0.0h UINT_MAX/3600 0 in demo mode, 
else read from 
module on 
connect. 

Burn time of the 
UV lamp since 
the last time it 
was turned on.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test.  

VisLampIgnitions 0 UINT_MAX 0 in demo mode, 
else read from 
module on 
connect. 

VIS lamp ignition 
counter.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test. (DAD only) 

VisLampLifetime 0.0h UINT_MAX/3600 0 in demo mode, 
else read from 
module on 
connect. 

Total burn time of 
the VIS lamp [h]] 
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test. (DAD only) 
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Property Min Max Default Description 
VisLampOntime 0.0h UINT_MAX/3600 0 in demo mode, 

else read from 
module on 
connect. 

Burn time of the 
VIS lamp since 
the last time it 
was turned on.  
Set the 
UpperLimit to 0 to 
disable the 
associated limit 
test. (DAD only) 

 
Command Description 
Autozero Performs ⇒Autozero. The command will be performed immediately when issued 

manually or at a Program time <0.000 min. With a program time of 0.000, the 
command is executed before the injection program; with a program >0.000, the 
command is executed at this program time. 

 
Name Possible States Description 
DeviceState Idle 

Prepare 
Reset 
Startup 
Whol 
TestWcal 
Scan 

Detector state. 

LampState Off 
On 
LampWarmup 
Ignition 
Retry 

Lamp state. 

 

Diode Array Detector 
Property Min Max Default Description 
AutoactivateVisible_ 
Lamp 

Off On Off If set to On, the Tungsten 
lamp is automatically 
turned on right after 
power-up of the detector.  

⇒Bandwidth 2nm 400nm Channel 
dependent 

Signal bandwidth 

⇒BunchWidth 0.01nm 100nm 2nm Bandwidth of the 3D 
wavelength 
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Property Min Max Default Description 
DemoFileName n/a n/a As  

configured 
File name of the demo file. 
(May contain %d that will 
be replaced by the sample 
number) 

⇒MaxAutoStep 0.1s 5.1s 0.1x Maximum signal and 
spectra data rate if Step = 
Auto. 

MaxWavelength 190nm 950nm 400 Maximum 3D wavelength 
MinWavelength 190nm 950nm 190 Minimum 3D wavelength 
PeakWidth 0 7 4 Expected minimum peak 

width (The setting affects 
the Step: see below). 

⇒RefBandwidth 0;2nm 400nm Channel 
dependent 

Reference bandwidth (set 
to 0 if RefWavelength = 0) 

⇒RefWavelength 0;190nm 950nm Channel 
dependent 

Reference wavelength (0 
means: not used) 

SlitWidth 1nm 16nm 4nm Width of the micro slit 
(also MWD). A small slit 
allows using the fine 
structures of the UV 
spectrum. A wide slit 
provides higher sensitivity. 

⇒Step 0.05s 3.2s 0.4s Signal and spectra data 
rate (The setting affects 
the peak width: see 
below). 

UV_LampRequired Off On Off If set to On: The detector 
is not ready for operation if 
the deuterium lamp is off.  

Visible_Lamp Off On Off, (On in 
demo mode) 

Tungsten lamp state 

Visible_LampRequired Off On Off If set to On: The detector 
is not ready for operation if 
the Tungsten lamp is off.  

⇒Wavelength 190nm 950nm Channel 
dependent 

Signal wavelength 

 
For the PDA/MWD, the relation between the expected peak width and the 
corresponding step is as follows: 
Expected peak width [min] 0.00 0.01 0.02 0.05 0.10 0.20 0.40 0.85 
Corresponding step [s] 0.05 0.05 0.10 0.20 0.40 0.80 1.60 3.20  
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For the VWD, the relation is as follows: 
Expected peak width [min] 0.000 0.005 0.010 0.025 0.050 0.100 0.200 0.400 
Corresponding step [s] 0.073 0.073 0.073 0.073 0.146 0.291 0.582 1.165 
 
Name Possible States Description 
DeviceState Idle 

Prepare 
Reset 
Startup 

Detector state 

UVLampState Off 
On 
Ignition 

UV lamp state 

VISLampState Off 
On 

VIS lamp state 
(DAD only) 

 
Property Min. Max. Default Description 
AnalogAttenuation -10 

(≡ 2^-10 AU)
1 
(≡ 2 AU) 

0 
(≡ 1 AU) 

Attenuation of the analog 
output (signal value that 
corresponds to the 
maximum output voltage) 
Note: logarithmic scale 

AnalogOffset 1% 99% 5 Zero offset of the analog 
output in % of the full output 
range. 

AnalogRange 0.1V 1.0V 1.0V Voltage range of the analog 
output (may be set to 0.1 or 
1.0V only).  

 
Property Min Max Default Description 
Adjust_Calibration n/a n/a n/a Adjusts the wavelength 

calibration using the 
absolute deviations 
determined by the test.  

D2_Alpha_Deviation_ 
Absolute 
or 
D2_Beta_Deviation_ 
Absolute 

-2.000nm 2.000nm 0 in demo 
mode, else 
read from 
module on 
connect. 

Current deviation of D2 
alpha or D2 beta line, 
ignoring current calibration 
settings. 
Valid only after the 
Test_Calibration 
command has been 
executed. 
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Property Min Max Default Description 
D2_Alpha_Deviation_ 
Correction 
or 
D2_Beta_Deviation_ 
Correction 

-2.000nm 2.000nm 0 in demo 
mode, else 
read from 
module on 
connect. 

Current calibration setting 
for the D2 alpha or D2 beta 
line. 

D2_Alpha_Deviation_ 
Current 
or 
D2_Beta_Deviation_ 
Current 

-2.000nm 2.000nm 0 in demo 
mode, else 
read from 
module on 
connect. 

Current deviation of the D2 
alpha or D2 beta line, 
considering current 
calibration. 
Valid only after the 
Test_Calibration 
command has been 
executed. 

Test_Calibration n/a n/a n/a Performs a wavelength 
calibration test using the 
D2-alpha and D2-beta 
lines. 
You need to remove the 
flow cell before executing 
this command. In addition, 
the UV lamp must be on. 

Diagnostic Commands and Properties 
 
Command Description 
CellTest Performs a cell test.  
CellTestEvaluation Evaluates the cell test by averaging the spectra of all test data. 
CellTestInfo Indicates whether the cell test in the next step is performed with 

or without cell. 
DarkCurrentTest Performs a dark current test.  
DarkCurrentTestEvaluation Evaluates the cark current test by averaging the minimum and 

maximum values of all selected spectra ranges. 
FilterTest Performs a holmium filter test.  
IntensityTest Performs an intensity test.  
IntensityTestEvaluation Evaluates the intensity test by calculating the minimum and 

maximum values of the 1024 diodes for all test data.  
For more information about the diagnostic functions for the DAD detector, 
refer to Agilent 1100 HPLC System Diagnostics:  Dark Current Test, 

 CellT est,  Filter Test, and  Intensity Test. 
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The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation: 

 Agilent 1100 HPLC System: Overview 

 Agilent 1100 HPLC System: Installation 

 Agilent 1100 HPLC System: Fluorescence Detectors 
The following command and properties are available (please that it 
depends on the display Filter level which commands and properties are 
displayed): 

Device Properties 
 
Property Min. Max. Description 
AutoActivateLamp Off On If set to On, the lamp is automatically 

turned on right after power-up.  
BaselineBehavior Append, Free, Zero Determines how the baseline behaves after 

the wavelength or photomultiplier gain has 
changed: 
Append: Resets the baseline to the 
previous position. 
Free: No adjustment, shifts may occur in 
the baseline position. 
Zero: Sets the baseline to 0 LU 
(luminescence units). 

Dark_Pmt 0 999999 Last value (in counts) for the dark current of 
the photomultiplier (read-only). The value 
should not exceed 10000 counts. 

 Tip:  
This property is used only if an internal 
calibration was successfully performed via 
the Test_Calibration command. 

Dark_Reference 0 999999 Last value (in counts) of the dark current for 
the reference diode (read-only). The value 
should not exceed 5000 counts. 

 Tip:  
This property is used only if an internal 
calibration was successfully performed via 
the Test_Calibration command. 
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Property Min. Max. Description 
DetectionMode Fluorescence, 

Phosphorescence
Specifies the operating mode. 

 Tips: 
The property may be set only once and only 
at retention times <0.000 min. 

The property can be set to 
Phosporescence only for detectors with a 
firmware version A.03.6x and higher. In 
addition, ScanMode must be set to Off. 

Emission_Deviation_ 
Absolute 

-12.000 -12.000 Correction value for the emission 
wavelength as established during 
Test_Calibration as the optimum value 
(read-only). 

 Tip:  
This property is used only if an internal 
calibration was successfully performed via 
the Test_Calibration command. 

Emission_Deviation_ 
Correction 

-12.000 -12.000 Currently used correction value for the 
emission wavelength (read-only). 

 Tip:  

This property is used only if an internal 
calibration was successfully performed via 
the Test_Calibration command. 

EmScanDuration 0 99999 Indicates the time in seconds needed to 
scan an emission spectrum (read-only). 
(This property can be used only if 
ScanMode=Emission.) 

 Tip:  
To perform meaningful scans, make sure 
that this time is less than the width of the 
smallest peak. A warning appears if the 
time exceeds one of the peak widths 
defined in the QNT Method. 

EmScanStepSize 1 20 Specifies the wavelength increments at 
which the detector scans the emission 
spectrum. (You can set this property only if 
ScanMode = Emission.) 

EmScanWhen None, Apex, 
AllInPeak, All, 
AllWithoutSignals 

Determines when the scans of an emission 
spectrum are taken. (You can set this 
property only if ScanMode = Emission.) 

For more information, refer to  Scan 
Modes for the Fluorescence Detector. 
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Property Min. Max. Description 
Excitation_Deviation_ 
Ab solute 

-12.000 -12.000 Correction value for the excitation 
wavelength as established during 
Test_Calibration as the optimum value 
(read-only). 

 Tip:  
This property is used only if an internal 
calibration was successfully performed via 
the Test_Calibration command. 

Excitation_Deviation_Cor 
rection 

-12.000 -12.000 Currently used correction value for the 
excitation wavelength (read-only). 

 Tip:  
This property is used only if an internal 
calibration was successfully performed via 
the Test_Calibration command. 

ExScanDuration 0 99999 Indicates the time in seconds needed to 
scan an excitation spectrum (read-only). 
(This property can be used only if 
ScanMode=Excitation.) 

 Tip:  
To perform meaningful scans, make sure 
that this time is less than the width of the 
smallest peak. A warning appears if the 
time exceeds one of the peak widths 
defined in the QNT Method. 

ExScanStepSize 1 20 Specifies the wavelength increments at 
which the detector scans the excitation 
spectrum. (You can set this property only if 
ScanMode = Excitation.). 

ExScanWhen None, Apex, 
AllInPeak, All, 
AllWithoutSignals 

Determines when the scans of an emission 
spectrum are taken. (You can set this 
property only if ScanMode = Excitation.) 

For more information, refer to  Scan 
Modes for the Fluorescence Detector. 
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Property Min. Max. Description 
FitSpectralRange No Yes When set to Yes, the spectral ranges have 

to be set in such a way that there is always 
a difference of at least 25 nm between the 
shortest emission wavelength and the 
longest excitation wavelength. This avoids 
that emission is disturbed by stray light. 

 Tips:  
The property may be set only once and only 
at retention times <0.000 min. 
A warning appears if, in a program, the 
distance between the longest excitation 
wavelength and the shortest emission 
wavelength is less than 25 nm. 

HighPowerFlashes 0 99999 Number of lamp flashes at high power (in 
thousands). HighPowerFlashes.Value 
indicates the current value. Set the 
HighPowerFlashes.UpperLimit to 0 to 
disable the associated limit test. 

LampEnergyReference Off On Set to On to compensate for variations in 
light intensity of the lamp, using a reference 
diode. This may improve the signal-to-noise 
ratio. 

LampFlashRate Standard, Economy Specifies the rate at which the lamp pulses: 
Economy: 74 Hz - prolongs the lamp life. 
Standard: 296 Hz - increases the detector 
sensitivity. 

LampOnOnlyDuringRun No Yes Specifies the lamp state when no analysis 
is running: 
Yes: Turns the lamp off after each analysis. 
No: The lamp keeps burning after each 
analysis. 

LampRequired No Yes Specifies whether the lamp is required for 
the next analysis: 
Yes: If the lamp is turned off, the detector is 
in NotReady state. 
No: The configuration includes several 
detectors; the fluorescence detector is not 
required for the next analysis. 

LowPowerFlashes 0 99999 Number of lamp flashes at low power (in 
thousands). LowPowerFlashes.Value 
indicates the current value. Set the 
LowPowerFlashes.UpperLimit to 0 to 
disable the associated limit test. 
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Property Min. Max. Description 
PeakWidth <0.005, >0.005, 

>0.010, >0.025, 
>0.050, >0.100, 
>0.200, >0.400  

Specifies the detector's response time (in 
minutes). 

 Tip:  
The property may be set only once and only 
at retention times <0.000 min. 

PeakWidthPD <0.005, >0.005, 
>0.010, >0.025, 
>0.050, >0.100, 
>0.200, >0.400  

Select from which signal width the peak 
shall be recognized. This setting plus the 
Threshold (see below) determine the 
internal peak recognition of the device 
firmware. For EmScanWhen or 
ExScanWhen = Apex or AllnPeak, 
scanning is performed only if a peak is 
recognized in the first channel. 
Specifies the expected peak width (in 
minutes) for the internal peak detector. 

 Tip:  
The property may be set only once and only 
at retention times <0.000 min. 

PhosphorescenceDelay 0.00 5000.00 Specifies the time (in µs) for which the lamp 
must be on before the detector starts 
recording data. 

 Tips: 
This property can be set only if 
DetectionMode = Phosphorescence. 
The property may be set only once and only 
at retention times <0.000 min. 

PhosphorescenceGate 20.00 5000.00 Specifies the time (in µs) during which data 
is recorded after the lamp was on. 

 Tips: 
This property can be set only if 
DetectionMode = Phosphorescence. 
The property may be set only once and only 
at retention times <0.000 min. 

PMTGain 0 18 Specifies the photomultiplier gain. (A typical 
setting is between 10 and 15.) Each step 
approximately doubles the gain. Use lower 
values for very high concentrations. Higher 
values may improve the signal-to-noise 
ratio. 

 Tip:  
The property may be set only once and only 
at retention times <0.000 min. 
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Property Min. Max. Description 
Polarity Positive, Negative Specifies the signal polarity. Set the polarity 

to the expected signal polarity. 

 Tip:  
The property may be set only once and only 
at retention times <0.000 min. 

RemainingLifetime 0 100 Remaining lifetime of the lamp (in percent). 
RemainingLifetime.Value indicates the 
current percentage. Set the 
RemainingLifetime.UpperLimit to 0 to 
disable the associated limit test. 

ScanEndEmWavelength 281 900 Specifies the emission wavelength at which 
the scan should end. (This property is used 
only if ScanMode  = Emission.) In addition, 
the following must be true: 
ScanEndEmWavelength 
>ScanStartEmWavelength and 
>ExWavelength 

ScanEndExWavelength 201 700 Specifies the excitation wavelength at 
which the scan should end. (This property 
is used only if ScanMode = Excitation.) In 
addition, the following must be true: 
ScanEndExWavelength 
>ScanStartExWavelength and 
<EmWavelength 

ScanMode Off, Emission 
Excitation 

Specifies the scan mode. For more 

information, refer to  Scan Modes for 
the Fluorescence Detector. 

 Tips: 
The property may be set only once and only 
at retention times <0.000 min. 
Changing the mode takes about 5-10 
seconds. During this time, the detector is in 
NotReady state. 

ScanStartEmWavelength 280 899 Specifies the emission wavelength at which 
the scan should start. (This property is used 
only if ScanMode  = Emission.) In addition, 
the following must be true: 
ScanStartEmWavelength 
<ScanEndEmWavelength and 
>ExWavelength 
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Property Min. Max. Description 
ScanStartExWavelength 200 699 Specifies the excitation wavelength at 

which the scan should start. (This property 
is used only if ScanMode  = Excitation.) In 
addition, the following must be true: 
ScanStartExWavelength 
<ScanEndExWavelength and 
<EmWavelength 

Threshold 0.0001 1^5 Select from which signal height in LU 
(Luminescence Units) the peak shall be 
recognized. This setting plus PeakWidthPD 
(see above) determine the internal peak 
recognition of the device firmware. For 
EmScanWhen or ExScanWhen = Apex or 
AllnPeak, scanning is performed only if a 
peak is recognized in the first channel. 
Specifies the height of the smallest 
expected peak in LU (Luminescence Units). 
The detector ignores all peaks below this 
threshold value.  

 Tip:  

The default setting is that the current values are read from the detector. 

Device Commands  
 
Command Description 
Abort_Calibration Aborts the detector's internal calibration procedure. 

 Tip:  
This command can be performed only when the instrument is performing 
a calibration. 

Adjust_Calibration After the internal calibration of the detector, you can use this command to 
update the internal calibration settings, based on the test. That means 
that the measured Excitation_Deviation_Absolute value is assigned to 
Excitation_Deviation_Correction and the measured 
Emission_Deviation_Absolute value to 
Emission_Deviation_Correction. 

 Tip: 
This command can be used only if an internal calibration was successfully 
performed via the Test_Calibration command. 
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Command Description 
DarkCurrentTest Performs a dark current test. The results of the last dark current test are 

saved as properties (Dark_Reference and Dark_Pmt, see above). 

 Tip: 
This command can be performed only if the detector is idle. In addition, 
the lamp must be on. 

PmtTest Calculates an appropriate photomultiplier gain, based on the settings. 

 Tip:  
This command can be performed only if the detector is idle. 

Scan Saves the spectrum scan.  

 Tip:  
This command can be performed only during data acquisition. In addition, 
verify that ScanMode is not set to Off and that ScanWhen is set to All. 

Test_Calibration Starts the detector's internal calibration procedure and updates the 
associated properties with the results. 

 Tip: 
This command can be performed only if the detector is idle. In addition, 
the lamp must be on. 

 

Channel Properties 
 
Property Min. Max. Description 
EmWavelength 200 to 700 nm,  

Off, 
ZeroOrder 

Emission wavelength in nm 
Off: No data is recorded on this channel. This 
improves the signal-to-noise ratio on the other 
channels because more single values are 
averaged. 

ZeroOrder: The monochromator grating serves 
as mirror. The entire emission spectrum is 
recorded on the channel. 

 Tips: 

The EmWavelength must be longer than all 
used excitation wavelengths. In addition, it must 
be identical for all channels in programs with 
ScanMode = Excitation. 
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Property Min. Max. Description 
ExWavelength 200 to 700 nm,  

Off, 
ZeroOrder 

Excitation wavelength in nm 
Off: No data is recorded on this channel. This 
improves the signal-to-noise ratio on the other 
channels because more single values are 
averaged. 

ZeroOrder: The monochromator grating serves 
as mirror. The entire lamp spectrum is used for 
excitation. Overlaps with the emission 
wavelength result in increased stray light and 
thus, in increased background noise. 

 Tip:  

The ExWavelength must be shorter than all 
used emission wavelengths. In addition, it must 
be identical for all channels in programs with 
ScanMode = Emission. 

 

 Tip:  

The default setting is that the current values are read from the detector. 

For more information, refer to:  

 Agilent 1100 HPLC System: Scan Modes for the Fluorescence 
Detector 

 Agilent 1100 HPLC System: Example Programs for the 
Fluorescence Detector 

 Agilent 1100 HPLC System: Tips for Lamp Commands 
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 Agilent 1100 HPLC System: Program Tips 
• Flow ramps (⇒Flow and ⇒%B, %C, %D commands) cannot be 

executed at negative program times (t < 0) or in Programs without 
an Inject command. (The pumps of the 1100 HPLC System do not 
support this.) 

• The ⇒Inject command and all sample preparation commands are 
only accepted at the time t = 0. The Autosampler of the 1100 HPLC 
System executes these commands as a block during the transition from 
Prerun to Run following a possibly specified UV.Autozero command. 

• Interpretation of the Inject command with explicit sample 
preparation: If sample preparation commands are specified the 
position of the required inject command among these commands is 
irrelevant. The actual injection occurs either explicitly via the Valve 
ValvePosition=MainpassOnStart command or automatically at the 
end of the sample preparation if the command is not given. (See the 
example below.) 

• Changes to the 3D field parameter may result in an automatic 
⇒Autozero for the PDA. During the execution of the autozero (see 
UV.NotReadyCauses(Prepare) property), no further command must be 
given that would result in another autozero. If necessary, this can be 
achieved via the Wait UV.Ready command. During the execution of 
the autozero, no Run must be started. Therefore, the Program Wizard 
adds a Wait UV.Ready command before the Inject command. 

Hints for manual program creation 
Programs for the 1100 HPLC System that were developed manually should 
include a ⇒Wait command before the Inject command for each module: 
 
0.000 UV.Autozero 

 Wait UV.Ready and ColumnComp.Ready and 
Sampler.Ready and Pump.Ready 

 Inject 

 3DFIELD.AcqOn 

 UV_VIS_1.AcqOn 

 UV_VIS_2.AcqOn 
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 UV_VIS_3.AcqOn 

 UV_VIS_4.AcqOn 

 UV_VIS_5.AcqOn 
 
(These commands are automatically inserted if the Program Wizard is 
used.)  

 Note:  
Generally, a time should be given at the beginning of a program (pump and 
detector settings, such as at the time "-1.000") thus defining a time for each 
command. 
 

Example for a user-defined wash and injection program  
0.000 Valve ValvePosition=Bypass 

; Washes from vial 91 to vial 92 
Draw Volume=Maximum, Source=Vial, Vial=91  
Dispense Volume=Maximum, Source=Vial, Vial=92 
; Draws the sample 
Draw Volume=InjectVolume, Source=SampleVial  
Needle Function=Seat 
Valve ValvePosition=MainpassOnStart  
; Injection performed  
; Option: further steps after the injection, e.g., for 
washing: 
; Valve ValvePosition=Bypass 
; Washes from vial 91 to vial 92 
; Draw Volume=Maximum, Source=Vial, Vial=91  
; Dispense Volume=Maximum, Source=Vial, Vial=92 
; Valve ValvePosition=Mainpass 
UV.Autozero 
Wait UV.Ready and ColumnComp.Ready and Sampler.Ready and 
Pump.Ready 
Inject 

 

Also, see  Agilent 1100 HPLC System: Program Example for 
Derivatization. 
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Data acquisition  
The detectors of the 1100 HPLC System do not always record data until the 
program end. Thus, it may happen that data acquisition ends approximately 
0.3 min before the AcqOff command so that raw data are not available in 
Chromeleon until the end of the program. (Note: This corresponds to the 
ChemStation behavior.) To avoid this, perform the End command 0.5 (or 
more) minutes after the AcqOff command: 
 
0.000 InjectWait UV.Ready and ColumnComp.Ready and Sampler.Ready and 

Pump.Ready 

 UV_VIS_1.AcqOn(...)7.500 UV_VIS_1.AcqOff8.000 EndExample for 
a shutdown program 
To shut down the 1100 HPLC System, use a shutdown program. For 
example: 
 
0.000 Flow = 0 

Wait UV.Ready and ColumnComp.Ready and Sampler.Ready and 
Pump.Ready 

%B = 100 
UV_Lamp = Off 

      
UV.Disconnect 

      
End  

At the end of each Chromeleon sample, the program must make sure (for 
technical reasons) that all connected modules of the 1100 HPLC System 
are ready. If you turn off the detector lamp, the unit is no longer ready for 
operation. Therefore, the UV_Lamp.Off command can be performed only 
after the readiness for operation has been ensured. However, if you add a 
UV.Disconnect command to the program, the sample will be finished as 
expected. 

 Note:   

Select Blank as sample type to process the PGM File without an Inject 
command. 
 
The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation  Agilent 1100 HPLC System: Overview and  Agilent 
1100 HPLC System: Installation. 
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 Agilent 1100 HPLC System: Example for a Derivatization 
Program 
The Agilent 1100 HPLC System independently processes sample 
preparation programs. Thus, time control by Chromeleon is not supported. 
To wait during sample preparation, you can only use the Sampler.Wait 
Time command. 
 
0.000 UV.Autozero 
 Flow = 0.450 
 %B = 0.0 
 Wait UV.Ready and ColumnComp.Ready and Sampler.Ready and 

Pump.Ready 
  
 ;Derivatization program: 
 Sampler.Valve ValvePosition=Bypass 
 Draw Volume=5.0, SyringeSpeed=200, Source=Vial, Vial=11 
 Draw Volume=1.0, SyringeSpeed=200, Source=Vial, Vial=12 
 Draw Volume=0.0, SyringeSpeed=200, Source=Vial, Vial=14 
 ;Draws the sample: 
 Draw Volume=1.0, SyringeSpeed=200, Source=SampleVial 
 ;Mixes 6 times: 

Mix Volume=8.0, SyringeSpeed=Maximum, Repeat=6, Source=Seat 
 Draw Volume=1.0, SyringeSpeed=200, Source=Vial, Vial=13 
 Draw Volume=0.0, SyringeSpeed=200, Source=Vial, Vial=15 
 ;Mixes 3 times: 

Mix Volume=9.0, SyringeSpeed=Maximum, Repeat=3, Source=Seat 
 Sampler.Wait Time=0.5 ; falls notwendig 
 Sampler.Valve ValvePosition=MainpassOnStart ;(*) 
 
 ;Wash program: 

;you can enter additional steps, e.g., to wash the needle. 
These steps are performed only after the injection, i.e., 
while the sample is running.  

 
 Inject  

;Executes the commands of the wash and sample preparation 
programs. Injection to the column is performed only after the 
line (*) has been reached.  

 
 Flow = 0.450 
 %B = 0  
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
 
In a user-defined wash and/or sample preparation program, verify that you 
have entered all desired steps. After the ⇒Inject has been issued, 
Chromeleon starts processing the single steps to prepare injection. 
However, the actual injection is performed only when the Valve 
ValvePosition=MainpassOnStart command has been reached.  
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 Tip:   

Keep in mind that you have to enter the Valve 
ValvePosition=MainpassOnStart command as the last step of the sample 
preparation program. 

Also, refer to  Agilent 1100 HPLC System: Program Tips. 

 Agilent 1100 HPLC System: Scan Modes for the 
Fluorescence Detector 
The Fluorescence detector supports the following operating modes: 

ScanMode = Off: The monochromators are set to a fixed wavelength. In 
this mode, the detector can acquire the emission signal only for this 
wavelength. It is possible to change the wavelength setting during a sample 
run. However, it is not possible to acquire scans. Compared to the other 
operating modes, data acquisition is performed with the best signal-to-noise 
ratio. 

ScanMode = Excitation/Emission: One monochromator is set to a fixed 
wavelength; the other monochromator rotates at 4000 rpm. In this way, it is 
possible to perform measurements at different wavelengths quasi-parallel. 
You can record data from up to four emission channels. In addition, you 
can determine whether and when you want to perform spectra scans: 
• ScanWhen = None: No spectra scans are recorded. Use this mode if 

you want to record data from several channels and no spectra. 

• ScanWhen = AllInPeak or Apex supports data acquisition from 
several channels and automatically saves the scans, based on peak 
detection from the fluorescence detector. The PeakWidthPD and 
Threshold parameters determine the peak width and the peak height 
for this. Scanning is performed only if the device firmware recognizes a 
peak via these parameters. 

• ScanWhen = All: Spectra are not saved automatically. Nevertheless, a 
Scan command is provided. You can use this command at any time to 
save the spectrum (either by using it in a program or by executing a 
trigger). 
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 Note:  
If no spectrum is recorded (ScanWhen = None), the signal-to-noise ratio is 
only slightly lower as for ScanMode = Off. If spectra are recorded 
(ScanWhen = AllInPeak, Apex, All), the signal-to-noise ratio is 
approximately half the ratio as for ScanMode = Off. 

Also, refer to  Agilent 1100 HPLC: Program Examples for the 
Fluorescence Detector. 
For information about the commands for fluorescence detector control, 
refer to  Agilent 1100 HPLC System: Fluorescence Detectors. 

The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation: 

 Agilent 1100 HPLC System: Overview 

 Agilent 1100 HPLC System: Installation 

 Agilent 1100 HPLC System: Program Examples for the 
Fluorescence Detector 

1. One channel, no spectra acquisition  
Set the operating mode to ScanMode = Off. 
 

Fluorescence.PeakWidth = 0.200 
 ScanMode = Off 
 Emission_1.ExWavelength =  335 
 Emission_1.EmWavelength =  390 
 Emission_1.Step =  Auto 
 Emission_1.Average =  On 
 
0.000 Wait Sampler.Ready and Fluorescence.Ready 
 Inject 
 Emission_1.AcqOn 
 
2.000 Emission_1.AcqOff 
 End 
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2. Several channels, no spectra acquisition 
Set the operating mode to ScanMode = Emission or Excitation. In 
addition, set EmScanWhen (and/or ExScanWhen) to None. 

 Note:   

Set ExWavelength (or EmWavelength, respectively) to Off for all 
channels for which data acquisition will not be performed. The other 
wavelength must be identical for all channels. 
 

Fluorescence.PeakWidth = 0.200 
 ScanMode = Emission 
 EmScanWhen = None 
 PeakWidthPD = 0.200 
 Threshold = 1.000 
 Emission_1.ExWavelength =  335 
 Emission_1.EmWavelength =  390 
 Emission_1.Step =  Auto 
 Emission_1.Average =  On 
 Emission_2.ExWavelength =  335 
 Emission_2.EmWavelength =  450 
 Emission_3.ExWavelength =  Off 
 Emission_3.EmWavelength =  390 
 Emission_4.ExWavelength =  Off 
 Emission_4.EmWavelength =  390 
 
0.000 Wait Sampler.Ready and Fluorescence.Ready 
 Inject 
 Emission_1.AcqOn 
 Emission_2.AcqOn 
 
2.000  Emission_1.AcqOff 
 Emission_2.AcqOff 
 End 
 

3. Peak-dependent spectra acquisition 
Set the operating mode to ScanMode = Emission (or Excitation). In 
addition, set EmScanWhen (or ExScanWhen, respectively) to Apex (only 
at the peak maximum) or to AllInPeak (= all spectra during the peaks). 
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 Tip:   

Verify that the settings for PeakWidthPD and Threshold match the peaks 
recorded on the first channel (Emission_1). 
 
 Fluorescence.PeakWidth = 0.200 
 ScanMode = Emission 
 EmScanWhen = Apex 
 PeakWidthPD = 0.200 
 Threshold = 1.000 
 Emission_1.ExWavelength =  335 
 Emission_1.EmWavelength =  390 
 Emission_1.Step =  Auto 
 Emission_1.Average =  On 
 Emission_2.ExWavelength =  Off 
 Emission_2.EmWavelength =  390 
 Emission_3.ExWavelength =  Off 
 Emission_3.EmWavelength =  390 
 Emission_4.ExWavelength =  Off 
 Emission_4.EmWavelength =  390 
 
0.000 Wait Sampler.Ready and Fluorescence.Ready 
 Inject 
 Emission_1.AcqOn 
 
2.000  Emission_1.AcqOff 
 End 

4. User-defined spectra acquisition 
Set the operating mode to ScanMode = Emission (or Excitation). In 
addition, set EmScanWhen (or ExScanWhen, respectively) to All: 
 
Trigger DoScan Emission_1.Signal > 10.000 
 Scan 
EndTrigger 
 
 Fluorescence.PeakWidth = 0.200 
 ScanMode = Emission 
 EmScanWhen = All 
 Emission_1.ExWavelength =  335 
 Emission_1.EmWavelength =  390 
 Emission_1.Step =  Auto 
 Emission_1.Average =  On 
 Emission_2.ExWavelength =  340 
 Emission_2.EmWavelength =  390 
 Emission_2.Step =  Auto 
 Emission_2.Average =  On 
 Emission_3.ExWavelength =  Off 
 Emission_3.EmWavelength =  390 
 Emission_4.ExWavelength =  Off 
 Emission_4.EmWavelength =  390 
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0.000 Wait Sampler.Ready and Fluorescence.Ready 
 Inject 
 Emission_1.AcqOn 
 Emission_2.AcqOn 
 
1.000  Scan 
 
2.000  Emission_1.AcqOff 
 Emission_2.AcqOff 
 End 
 
The DoScan ⇒Trigger determines that a fluorescence spectrum is 
recorded when the signal of the Emission_1 channel exceeds 10. 

Also, refer to  Agilent 1100 HPLC System: Scan Modes for the 
Fluorescence Detector. 
For information about the commands for fluorescence detector control, 
refer to  Agilent 1100 HPLC System: Fluorescence Detectors. 

 Agilent 1100 HPLC System Fluorescence Detector: Tips 
for Lamp Commands 
Chromeleon supports several commands for defining the state of the 
Xenon lamp of the fluorescence detector that is installed in the 1100 HPLC 
System. Depending on the situation, use one of the first three settings in 
your PGM Files: 

1. No data acquisition 
The fluorescence detector is available but data acquisition is not performed 
for fluorescence data (e.g., only UV data are recorded): 
 
LampRequired = No 
Lamp = Off 
LampOnOnlyDuringRun = No 
 

 Tip:   

If the PGM File contains an Emission_n.AcqOn command, the PGM File or 
the batch does not pass the Ready Check. 
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2. The lamp is turned on only if required 
The fluorescence detector is used for data acquisition. However, the lamp 
is turned on only if required. 
LampRequired = Yes 
Lamp = On 
LampOnOnlyDuringRun = Yes 

The lamp is turned off after each sample. However, the instrument remains 
ready for operation after the analysis. The lamp is automatically turned on 
when the next sample is started. 

 Tip:   

It may be necessary to turn on the lamp (i.e., to issue a Lamp=On 
command) manually before starting the analysis of the first sample; e.g., if 
the detector is in NotReady state. 

3. The lamp is burning permanently 
The fluorescence detector is used for data acquisition. The lamp is burning 
permanently. 
LampRequired = Yes 
Lamp = On 
LampOnOnlyDuringRun = No 
 

 Tip:   

This reduces the lamp's life cycle. However, analysis is performed more 
quickly because the lamp is warmed up only once (at the very beginning); it 
does not need to warm up before each sample (see 2. above).  

4. Not allowed 
You should not combine the following commands: 
LampRequired = Yes 
Lamp = Off 
LampOnOnlyDuringRun = No 
 
With this sequence of commands, the Ready Check would fail. The 
detector remains in NotReady state. 



882 Commands and Tips for Third-Party Devices 

For more information, refer to:  

 Agilent 1100 HPLC System: Scan Modes for the Fluorescence 
Detector 

 Agilent 1100 HPLC System: Example Programs for the 
Fluorescence Detector 

 Agilent 1100 HPLC System: Tips for Lamp Commands 

 Agilent 1100 HPLC System: Checking the Solvent Liquid 
Level 
For the 1100 HPLC System, you can have Chromeleon check the liquid 
level for the single solvents and determine the system's reaction if a 
specified minimum volume is not met. The following commands are 
available (it depends on the display Filter level which commands are 
displayed): 
 
Command Min. Max. Default Description 
EmptySolventError Off On Off Determine how the system reacts 

when the SolventNotReadyLimit 
is not met: 
On = The pump is turned off 
immediately. (The red LED 
lights.) 
Off = The system waits until 
processing of the running sample 
is finished and then turns off the 
pump. The pump is in NotReady 
state; the yellow LED lights. 

SolventFillingXX 0.00 l 1000.00 l n/a Enter the volume in [l] with which 
the bottle is originally filled (XX = 
A1, A2, B1 or B2).  

SolventNotReadyLimit 0.00 l 1000.00 l 0.00 l Determine the minimum filling 
volume. If the actual solvent 
volume is below this value a 
warning appears.  

A meaningful setting for SolventNotReadyLimit would be to enter a 
volume that is large enough so that the last sample can be completely 
processed in any case. If the EmtpySolvent Error is set to Off, even the 
last sample can be processed when the SolventNotReadyLimit has been 
reached. The pump is stopped when sample processing is complete. 
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 Tip:  
Older pump versions, e.g., with firmware version A.01.06, do not yet 
support checking the solvent liquid level. For these pumps, select the 
Disable Solvent Limits Features option on the Options tab page in the 
Server Configuration program. (For more information about the program, 
refer to Software Installation and Communication  The Server 
Configuration Program in the Administrator Help section.) 
 
The Administrator Help section provides general information and 
installation instructions for the 1100 HPLC system; refer to Hardware 
Installation: 

 Agilent 1100 HPLC System: Overview 

 Agilent 1100 HPLC System: Installation 
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 Agilent 1100 HPLC System: Diagnostic Functions 
In Chromeleon, the HP1100.pan control panel supports the different 
diagnostic functions for the Agilent 1100 HPLC system. Click Diagnostic 
Functions to open the diagnostic panel. To perform a test, click the related 
button: 
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Chromeleon supports the following tests: 

Pump: 

 Pressure Test 

 Leak Test 
Autosampler: 

 Injector Steps 

 Gripper Verification 

Photodiode Array Detector (DAD): 

 Dark Current Test 

 Cell Test 

 Filter Test 

 Intensity Test 
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 Agilent 1100 HPLC System Diagnostics: Pressure Test 
The pressure test allows you to test the pressure resistance of the system 
up to 400 bar. Chromeleon supports this test for the following pumps: 
G1312 (binary pump) and G1311 (quaternary) pump. To perform the test, 
click the button for the pump on the main diagnostic panel. 

A subpanel is opened, guiding you through the test similar to a wizard: 

  
Follow the instructions on the right. (The description below refers to a 
G1312 pump with solvent selector valve). Clicking Next> takes you to the 
next step. 

1. Isopropanol Connect a isopropanol solvent reservoir to channel A(2). 

2. Block Seal the column compartment outlet with a blank nut.  

3. Open valve Open the purge valve. 

4. Flush Flush the system, using isopropanol from channel A(2). 
(Pumps without degasser: Flush 2 minutes. Pumps with 
degasser: Flush 12 minutes.) 
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5. Close valve Close the purge valve. 

6. Run This step starts the pressure test. The pump delivers at a 
flow rate of 0.51 ml/min until the pressure reaches 
390 bar. The test results appear in the audit trail on the 
right. 

7. Open valve Open the purge valve and remove the blank nut. 
 

 Tips:   

To close the subpanel, click Cancel or Finish. This ensures that the pump is 
in a consistent state afterward.  

For more information, refer to the instrument manual for the pump. 

 Agilent 1100 HPLC System Diagnostics: Leak Test 
The leak test allows you to test system leakage. Chromeleon supports this 
test for the following pumps: G1312 (binary pump) and G1311 (quaternary) 
pump. To perform the test, click the button for the pump on the main 
diagnostic panel. A subpanel is opened, guiding you through the test 
similar to a wizard: 
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Follow the instructions on the right. (The description below refers to a 
G1312 pump with solvent selector valve). Clicking Next> takes you to the 
next step. 

1. Isopropanol Connect a isopropanol solvent reservoir to channels 
A(2) and B(2). 

2. Open valve Open the purge valve. 

3. Flush Flush the system with isopropanol from channels A(2) 
(51%) and B(2) (49%). (Pumps without degasser: 
Flush 2x2 minutes. Pumps with degasser: Flush 2x12 
minutes.) 

4. Close valve Close the purge valve. 

5. Install cap. Install the restriction capillary G1313-87305. 

6. Flush Click the button to flush the system with isopropanol 
from channels A(2) (50%) and B(2) (50%). 

7. Replace cap. Replace the restriction capillary with a blank nut.  

8. Open valve Open the purge valve. 

9. Init pump Initialize the pump. 

10. Close valve Close the purge valve. 

11. Run This step starts the leak test. The LeakTestRun 
command is slightly different for the binary pump 
(G1312) and then quaternary pump (G1311). The 
results appear in the audit trail on the right. 

12. Open valve Open the purge valve and remove the blank nut.  
 
The leak test includes several ramps and plateaus that are slightly different 
for the binary pump (G1312) and the quaternary pump (G1311). (For a 
detailed description, refer to the instrument manual for the pump.)  

For the G1311 pump, the leak test is successful: 

a) If the pressure reaches a certain value for the plateaus, e.g., 100 bar for 
the first plateau,  

b) If there is no increase in pressure on the first two plateaus, and  

c) If the pressure increase on the third plateau does not exceed 2 bar. 
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 Tips:   

To close the subpanel, click Cancel or Finish. This ensures that the pump is 
in a consistent state afterward.  

For more information, refer to the instrument manual for the pump. 

 Agilent 1100 HPLC System Diagnostics: Injector Steps 
The injector steps test allows you to check the different injector functions. 
Chromeleon supports this test for the following autosamplers: G1329 and 
G1367 (wellplate sampler). To perform the test, click the button for the 
autosampler on the main diagnostic panel. 

A subpanel is opened providing buttons for the different steps. First, enter 
the sample position in and the injection volume in the related input fields: 

  



890 Commands and Tips for Third-Party Devices 

Click a button to perform the following operations: 

Sampler G1329 
 
Valve to bypass Switches the injection valve into the bypass position. 

Plunger home Moves the plunger into the home position.  

Needle up Moves the needle arm to its topmost position. 
Vial to seat Positions the specified vial in the seat. 
Needle into sample Descends the needle into the vial. 
Draw Draws the specified injection volume. 
Needle up Moves the needle arm to its topmost position. 
Vial to tray Returns the vial to the tray. 
Needle into seat Descends the needle into the needle seat. 

Valve to mainpass Switches the valve into the inject position.  
 

 Tip:   

For the G1367 Wellplate-Sampler, the needle is moved to the specified 
sample position. Therefore, the Move to location button is available 
instead of the Vial to seat and Needle into sample buttons. 

Move to location Moves the needle to the specified position. 
 

 Tip:   

For more information, refer to the instrument manual for the autosampler. 
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 Agilent 1100 HPLC System Diagnostics: Gripper 
Verification 
The gripper verification test allows you to check the different functions of 
the gripper of the G1329 autosampler. To perform the test, click the button 
for the autosampler on the main diagnostic panel. 

A subpanel is opened providing buttons for the different tests. First, enter 
the sample positon in the Position field: 

  
Click a button to perform the following operation: 
 
Move to position Moves the gripper to the specified position. 
Pick vial at position Picks the vial at the specified position. 
Put vial at position Returns the vial to the specified position. 
Home Moves the gripper to its home position. 

 

 Tip:   

For more information, refer to the instrument manual for the autosampler. 
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 Agilent 1100 HPLC System Diagnostics: Dark Current 
Test 
The dark current test allows you to check the dark current of the diode 
array detector. To perform the test, click Dark Current Test on the main 
diagnostic panel. A subpanel is opened. Click Start Test to start the 
measurement and compare the result to the limits: 

  
The test is successful when the measured dark current is within the limits. 
Click Eval Test to recheck the measurement. 
 

 Tip:   

For more information, refer to the instrument manual for the diode array 
detector. 
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 Agilent 1100 HPLC System Diagnostics: Cell Test 
The cell test allows you to check the detector flow cell by measuring the 
light intensity of the deuterium and tungsten lamps over the entire 
wavelength range (190 - 905 nm). To perform the test, click Cell Test on 
the main diagnostic panel. A subpanel is opened, listing the test steps. 
Perform the steps in the listed order: 

1. If the flow cell is not yet installed, install the cell. Fill the cell with water. 

2. Click Start test with cell to measure the cell's light intensity. 

3. Remove the cell from the light path. 

4. Click Start test without cell to measure the light intensity without the 
cell. 

The results appear in the audit trail section of the panel: 
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The final result is the ratio of the intensity with and without cell (here: 
25,000/38,000 = 0.66). 
 

 Tip:   

For more information, refer to the instrument manual for the diode array 
detector. 

 Agilent 1100 HPLC System Diagnostics: Filter Test 
The filter test checks the holminium oxide filter of the diode array detector. 
During the measurement, the holmium oxide filter is first installed in the 
light path and then removed. To perform the test, click Filter Test on the 
main diagnostic panel. 

On the subpanel, click Start to start the test. 
 

 Tip:   

For more information, refer to the instrument manual for the diode array 
detector. 
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 Agilent 1100 HPLC System Diagnostics: Intensity Test 
The intensity test allows you check the intensity of the diode array detector. 
To perform the test, click Intensity Test on the main diagnostic panel. 

A subpanel is opened. Click Start to start the measurement and compare 
the results to the limits: 

  
The test is successful if the measured intensities are within the limits. Click 
Eval to recheck the measurement. 
 

 Tip:   

For more information, refer to the instrument manual for the diode array 
detector. 
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 Agilent 1100 HPLC System: Troubleshooting 
• An error occurs if one of the single devices of the HP 1100 HPLC 

system is turned off while it is still connected; for example: 

[Abort] 08:12:04 {UV} Fatal device notification (configuration 
change) 
In this case, re-start the Chromeleon server. 

• If the pump stops delivering and the red LED lights, although no leak or 
any other obvious hardware problem could be detected, this may be due 
to the settings made for checking the solvent liquid level. This also 
applies if the pump does not return to the Ready state after Motor = On 
and the yellow LED continues to light. For more information about these 
commands, refer to Commands and Tips for Third-Party Devices 

 Agilent 1100 HPLC System: Checking the Solvent Liquid Level. 

• If the Communication error: LICOP command not acknowledged. 
(RE0503 command unknown (outdated firmware?)) error message 
appears after the installation of the pump, select the Disable Sovent 
Limit Features check box on the Options tab page. 

• The following message may appear for detectors: 

• [Warning] 15:10:47 1.257 {UV} Raw data delivered by detector has 
ended prematurely. Finishing acquisition on all channels. 

The reason is that the detectors of the 1100 HPLC System do not 
always record data until the end of the program. Thus, it may happen 
that data acquisition ends approximately 0.3 min before the AcqOff 
command so that raw data are not available in Chromeleon until the 
end of the program. (Note: This corresponds to the ChemStation 
behavior.) To avoid this, perform the End command 0.5 (or more) 
minutes after the AcqOff command: 
0.000 InjectWait UV.Ready and ColumnComp.Ready and Sampler.Ready 
and Pump.Ready 
 UV_VIS_1.AcqOn (...)7.500 UV_VIS_1.AcqOff8.000 End  

• When connecting, the 1100 HPLC system sends different device 
notifications to the Audit Trail. Usually, these notifications are for 
information purposes only. They may facilitate troubleshooting in case of 
system failure. 
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• It may happen that the fluorescence detector remains in Not Ready 
state after the detector and the lamp have been turned on. In this case, 
the yellow LED on the detector is on and Chromeleon displays the 
following message: Initializing excitation monochromator, initializing 
emission monochromator. Execute the Fluorescence.Reset 
command to remedy the situation. 

• If you system does not reach the Ready state, check the 
NotReadyCauses property and take appropriate remedial action. 

• Dionex recommends performing blank runs with injection. Specify vial 
that contain solvent as position, and then specify the injection command 
as follows: 

• Inject Blank=Inject 

The sampler of the 1100 HPLC system is running as well thus, 
improving synchronization of the entire system. 
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 Agilent 1050 HPLC System: UV Detector 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 

Device properties and commands 
 
Property Min. Max. Default Description 
Lamp Off On Read from the 

device on connect 
(On in Demo 
Mode). 

Lamp state. 

ModelNo "HP1050VWD" Type description (read-only)  
PeakWidth 1.600 min 

1.060 min 
0.530 min 
0.270 min 
0.130 min 
0.053 min 
0.026 min 
0.013 min 

Read from the 
device on connect, 
(0.530 min in Demo 
mode). 

Expected minimum peak 
width (This setting influences 
the Response property, see 
below.) 

Response 0.25 s 
1.00 s 
4.00 s 

Set to the 
corresponding 
value on connect, 
based on the 
PeakWidth setting 
(4.0 s in Demo 
mode). 

Time constant; indicates the 
time required by the detector 
to reach 98% of the full 
deflection. 

 
Channel properties and commands 
Command/Property Min. Max. Default Description 

⇒Delta  -2*10^4 2*10^4 Not available.  Signal slope [mAU/s]. 
⇒MaxAutoStep 0.1 5.1 0.1 Maximum data rate [s] of 

signals and spectra when 
Step = Auto 

Retention  0.000  10^7 Not available. Retention time [min]. 
Signal  -10^4 10^4 Read from the 

device during 
data acquisition. 

Signal value [mAU]. 

⇒Step 0.05 3.2 0.4 Data rate [s] for signal 
and spectra.  

⇒Wavelength 190 600 Read from the 
device on 
connect (254 in 
Demo mode).  

Signal wavelength [nm]. 
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The Administrator Help section provides general information and 
installation instructions for the 1050 HPLC system; refer to Hardware 
Installation: 

 Agilent HP 1050 HPLC System: Overview 

 Agilent HP 1050 HPLC System: Installation 

 Agilent 6890/6850 GCs: Commands and Tips 
For information about the special commands supported for the Agilent 
6890/6850 GCs and for tips for practical operation, refer to: 

 General 

 Injector 

 Inlet (General) 

 Inlet (Purged Packed EPC, Cool On-Column EPC, ACI, PCM, 
Volatiles) 

 Inlet (Split/Splitless EPC, Gerstel PTV, PTV, CIS3, CSI4) 

 Column 

 Detectors 

 ECD 

 FID and FPD 

 NPD (Nitrogen Phosphorous Detector) 

 TCD (Thermal Conductivity Detector) 

 µ-ECD 

 Auxiliary Devices 

 Application 

 PGM File - Entering Pressure or Flow? 
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 Agilent 6890/6850 GCs: General 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
Ambient 0°C 450°C in  

increments 
of 1. 

² (Demo  
mode: 24°C) 

Temperature in the 
laboratory. (The property 
is available only if Cryo is 
selected on the Options 
configuration tab page.) 

Cryo Off On ² (Demo  
mode: Off) 

If set to On, the cryogenic 
valve operates 
automatically. If set to 
Off, the valve is disabled. 
(The property is available 
only if Cryo is selected on 
the Options configuration 
tab page.) 

CryoFault Off On Off  The oven shuts down if it 
does not reach the set 
point temperature after 
the time specified for cryo 
operation. (The property 
is available only if Cryo is 
selected on the Options 
configuration tab page.) 

CryoTimeout 0 min 999.99 min 
in 0.01 
increments  

² (Demo  
mode:  
0.00 min) 

Indicates the time that the 
GC waits before turning 
off the cooling if no 
sample has been 
injected.  

CryoTimeoutOn Off On ² (Demo  
mode: On) 

Turns on CryoTimeout on 
or off. (The property is 
available only if Cryo is 
selected on the Options 
configuration tab page.) 

DualOperation FrontOnly, BackOnly 
Shared 

 Shared enables the dual-
inject mode (see 
Practical Tips for 
Device Control/GC and 
Temperature 

 Injecting Two GC 
Samples 
Simultaneously (6890)). 
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Property Min. Max. Default Description 
EquilibrationTime 0 min 999.99 min 

in 0.01 
increments 

² (Demo  
mode: 0.5) 

After reaching the desired 
temperature, the GC 
waits for the equilibration 
time. When the 
equilibration time has 
passed, the GC is ready. 

FirmwareVersion n/a n/a n/a Firmware version (20 
characters; read-only). 

ModelNo n/a n/a n/a Device number, i.e., 6850 
or 6890 (20 characters; 
read-only). 

Oven Type Fast Regular Fast  Regular or fast oven type.  
PrepRun - - - Sets the instrument into 

the PreRun state. 
QuickCool Off On ² (Demo  

mode: Off) 
If set to "On", the oven is 
cooled faster before the 
next sample is injected. 
(The property is available 
only if Cryo is selected on 
the Options configuration 
tab page.) 

Ready Not 
Ready 

Ready Depends on the 
Ready state of 
the instrument. 
Demo mode: 
Ready  

Indicates whether the GC 
is ready for injection 
(read-only).  

ReportReady - - - Status of the instrument; 
reports whether the 
instrument is not ready 
for operation and why.  

RunLog - - - Writes the sample 
protocol to the Audit Trail.  

RunState Idle, PreRun, Run, 
PostRun 

²  
(In Demo  
mode: Idle) 

GC state: Idle, PreRun, 
Run, or PostRun (read-
only). 

SerialNo n/a n/a n/a Serial number (20 
characters; read-only). 

Temperature - - - Properties related to the 
column compartment 
temperature. 

 Temperature. 
Value 

Depends on the system 
and installed cryo type; 
refer to the column 
compartment 
temperature section.  

- Current column 
compartment temperature 
(read-only).  
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Property Min. Max. Default Description 
 Temperature. 

Nominal 
Depends on the system 
and installed cryo type; 
refer to the column 
compartment 
temperature section. In 
increments of 1. 

² (Demo  
mode: 80°C) 

Determines the nominal 
temperature of the 
column compartment. 

 Temperature. 
UpperLimit 

Depends on the system 
and installed cryo type; 
refer to the column 
compartment 
temperature section. In 
increments of 1. 

² (Demo  
mode: highest 
temperature 

The system aborts the 
sample batch and starts 
emergency handling 
when the value is outside 
the limits. 

TempCtrl Off On ² (Demo  
mode: On) 

 

 

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to Hardware 
Installation: 

 Agilent 6890 GC: Overview 

 Agilent 6890 GC: Installation 

 Agilent 6850 GC: Overview 

 Agilent 6850 GC: Installation 
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 Agilent 6890/6850 GCs: Injector 
The following properties are available (please note that the display Filter 
level determines which properties are displayed): 
 
Property Min. Max. Default Description 
6890 GC     
Mode Normal on_column ² (Demo  

mode: 
on_column). 

Injection mode. Must be 
set to on_column for 
cooling on the column 
inlet. Otherwise, set to 
Normal. 
Usually, the correct 
setting is automatically 
selected in the Server 
Configuration program. It 
is not necessary to 
change this setting. 

6850 and 6890 GCs 
Depth 0.0 mm 1.0 mm  

in increments 
of 1 

0.0 mm Position of the needle in 
the vial. The default 
position is about 3.6 mm 
from the bottom of the 
vial. The default position 
is the reference of all 
other positions. 

Fan Off On ² (Demo  
mode: Off) 

Turns the injector fan on 
and off.  

FirmwareVersion - - - Firmware version (6 
characters, read-only)  

InjectWaitTime 0.0 s 1 E7 s 0.0 s Time between the inject 
command and the inject 
response.  

ModelNo - - - Model number (8 
characters, read-only)  

Position 1 
 

22 
or 
27 in 
increments of 
1 

1 Current sample position 
on the tablet.  

Post-a 0 15 0 Indicates how often the 
syringe is rinsed with 
solvent from the solvent 
reservoir A after the 
injection. 



904 Commands and Tips for Third-Party Devices 

Property Min. Max. Default Description 
Post-b 0 15 0 Indicates how often the 

syringe is rinsed with 
solvent from the solvent 
reservoir B after the 
injection. 

PostDwell 0.00 min 1.00 min  
in 0.01 
increments 

 Time that the needle 
remains in the inlet after 
the injection before it is 
withdrawn. 

Pre-a 0 15 0 Indicates how often the 
syringe is rinsed with 
solvent from the solvent 
reservoir A prior to the 
injection. 

Pre-b 0 15 0  Indicates how often the 
syringe is rinsed with 
solvent from the solvent 
reservoir B prior to the 
injection. 

PreDwell 0.00 min 1.00 min  
in 0.01 
increments 

0.00 min Time that the needle 
remains in the inlet 
before the piston moves 
to inject the sample. 

Prewash 0 15 0 Indicates how often the 
syringe is rinsed with the 
sample prior to the 
injection.  

Pumps 0 15 0 Indicates the how often 
the pressure plunger of 
the syringe is moved up 
and down while the 
needle is in the sample. 
This is to expel gas 
bubbles and to enhance 
the reproducibility. 

Speed Fast Slow 0 Average piston speed³ 
State Off On Off Indicates whether the 

autosampler has injected 
(read-only).  

Syringe 5 µl, 10 µl, 25 µl, 
50 µl, 100 µl.  

0 Indicates the syringe 
type as specified in the 
Server Configuration 
program (read-only).  
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Property Min. Max. Default Description 
Viscosity 0 s 7 s  

in increments 
of 1 

0 s Number of seconds the 
pressure plunger of the 
syringe pauses after the 
pump and injection 
strokes. This pause 
allows viscous samples 
to flow into the vacuum 
created in the syringe. 

Volume Fixed volume which 
corresponds to 2%, 10%, 
20%, 30%, 40%, or 50%  
of the syringe volume. 

2% of the 
volume 

Specifies the amount of 
sample to be injected (in 
µl).  

Waste A-only, B-only, A-and-B ² (Demo  
mode: Off) 

Specifies which waste 
bottles shall be used 
(alternating).   

 Notes: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 

³ For information about which plunger speed can be achieved with the 
Speed command for the different syringes, refer to the table below: 
 

Syringe (µl) Plunger Speed (µl/min) 
 Fast Slow 

5 3000 150 
10 6000 300 
25 15000 750 
50 30000 1500 

100 60000 3000  
In addition, the following commands are available, depending on the filter 
level:  
 
Command Description 
EraseErrorLog Deletes the sample error log. 
StopInject Stops the running injection.  
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to the related 
topics in the Hardware Installation section. 
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 Agilent 6890/6850 GCs: Inlet (General) 
The following commands and properties are available for all inlets: 
 
Property Min. Max. Default Description 
TempCtrl Off On ² (Demo  

mode: Off) 
Specifies the state of the 
heated zone control: If 
set to Off, temperature 
control is disabled. The 
property is automatically 
set to On if an 
assignment is made in 
the Temperature field. 

Temperature - - - Properties related to the 
temperature of the 
heated zone.  

 Temperature. 
Nominal 

°C in increments of 1. 
Depends on the inlet type 
(see Inlets temperature 
limits).  

² (Demo  
mode: 250°C) 

Specifies the target 
operating temperature for 
the heated zone. 

 Temperature. 
Value 

Depends on the inlet type 
(see Inlets temperature 
limits) 

- Current temperature of 
the heated zone (read-
only).  

Type - - - Type of the installed 
inlet: 
6890: 
Purged Packed EPC, 
Cool On-Column EPC, 
Split/Splitless EPC, 
<Other PTV>, Purged 
Packed, Cool on-
Column, Split/Splitless, 
Unknown/Other, None, 
ACI, Gerstel PTV, 
<manual ACI>, PTV, 
PCM, Gerstel CSI3, 
<JIB>, Volatiles 
6850:  
Purged Packed EPC, 
Split/Splitless EPC, 
Purged Packed, 
Split/Splitless, None. 
(33 characters, read-
only) 

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
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Additional commands and properties are available, depending on the inlet 
type: 

 Inlet (Purged Packed EPC, Cool On-Column EPC, ACI, PCM, 
Volatiles) 

 Inlet (Split/Splitless EPC, Gerstel PTV, PTV, CIS3, CSI4) 
Also, refer to: 

 Agilent 6890/6850 GCs: PGM File - Entering Pressure or Flow? 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to Hardware 
Installation: 

 Agilent 6890 GC: Overview 

 Agilent 6890 GC: Installation 

 Agilent 6850 GC: Overview 

 Agilent 6850 GC: Installation 
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 Agilent 6890/6850 GCs: Inlet (Purged Packed EPC, Cool 
On-Column EPC, ACI, PCM, Volatiles) 

In addition to the general commands described in  Inlet (General), the 
following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
Flow - - - Properties related to the 

gas flow.  
 Flow.Nominal 0.0 ml/min 1000.0 ml/min

in 0.1 
increments 

² (Demo  
mode:  
80 ml/min) 

Specifies the target gas 
flow.  

 Flow.Value 0.0 ml/min 1000.0 ml/min - Measured gas flow 
(read-only).  

FlowEquilibration 
Time 

0.00 min 999.99 min 
in 0.01 
increments 

0.00 min  After reaching the 
desired gas flow, the GC 
waits the time specified 
under 
FlowEquilibrationTime 
before signaling Ready. 

GasType Nitrogen, Hydrogen, 
Helium, Argon Methane, 
Unknown 

² (Demo  
mode: Nitrogen) 

Gas type.  

Pressure - - - Properties related to the 
gas pressure 

 Pressure. 
Nominal 

0.00 bar 10.00 bar 
in 0.01 
increments 

² (Demo  
mode:  
1.30 bar) 

Specifies the target gas 
pressure. 

 Pressure.Value 0.00 bar 10.00 bar - Measured gas pressure 
(read-only).  

Pressure 
EquilibrationTime 

0.00 min 999.99 min 
in 0.01 
increments 

² (Demo  
mode:  
0.00 min) 

After reaching the 
desired gas pressure, the 
GC waits the time 
specified under 
PressureEquilibration 
Time before signaling 
Ready.  

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
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Also, refer to  Agilent 6890/6850 GCs: PGM File - Entering Pressure 
or Flow? 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to Hardware 
Installation: 

 Agilent 6890 GC: Overview 

 Agilent 6890 GC: Installation 

 Agilent 6850 GC: Overview 

 Agilent 6850 GC: Installation 

 Agilent 6890/6850 GCs: Inlet (Split/Splitless EPC, 
Gerstel PTV, PTV, CIS3, CIS4) 

In addition to the general commands described in  Inlet (General), the 
following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
ColumnDefined Off On ² (Demo 

mode: Off) 
Indicates whether the 
column is defined 
(ready-only).  

Flow - - - Properties related to 
the gas flow.  

 Flow.Nominal 0.0 ml/min 1000.0 
ml/min 
in 0.1 
increments 

² (Demo 
mode:  
80.0 ml/min) 

Target gas flow.  

 Flow.Value 0.0 ml/min 1000.0 
ml/min 

- Measured gas flow 
(read-only).  

FlowEquilibration 
Time 

0.00 min 999.99 min  
in 0.01 
increments 

² (Demo 
mode:  
0.00 min) 

After reaching the 
desired gas flow, the 
GC waits the time 
specified under 
FlowEquilibrationTime 
before signaling Ready 

GasSaver Off On Off Turns the gas saver on 
and off.  
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Property Min. Max. Default Description 
GasSaverFlow 0.0 ml/min in 

0.1 
increments 

1000.0ml/min
in 0.1 
increments 

² (Demo 
mode:  
70.0 ml/min) 

Reduced flow from the 
split vent when the gas 
saver is active. The 
value must be at least 
15 ml/min higher than 
the value for the 
column flow.  

GasSaverTime 0.00 min 999.99 min 
in 0.01 
increments 

² (Demo 
mode: 2.00 
min) 

Retention time when 
the gas saver shall 
become active. The 
time setting must be 
after the injection and 
purge times. 

GasType Nitrogen, Hydrogen, Helium, 
Argon Methane, Unknown 

² (Demo 
mode: Off) 

Gas type.  

Mode Split, Splitless) 
PulsedSplitless, PulsedSplit, 
SolventVent/Vent 

² (Demo 
mode: Split) 

Operating mode (split 
or splitless, with or 
without pulse). 

Pressure - - - Properties related to 
the gas pressure.  

 Pressure. 
Nominal 

0.00 bar 10.00 bar  
in 0.01 
increments 

² (Demo 
mode:  
1.30 ml/min) 

Target gas pressure.  

 Pressure.Value 0.00 bar 10.00 bar - Measure gas pressure 
(read-only).  

Pressure- 
EquilibrationTime 

0.00 min 999.99 min 
in 0.01 
increments 

² (Demo 
mode:  
0.00 min) 

After reaching the 
desired gas pressure, 
the GC waits the time 
specified under 
PressureEquilibration 
Time before signaling 
Ready. 

PulsePressure 0.00 bar 10.00 bar  
in 0.01 
increments 

² (Demo 
mode:  
2.00 bar) 

(Only in Pulsed mode) 
Inlet pressure during 
injection: The pressure 
rises to this value at 
the start of the sample 
(PrepRun) and remains 
at this value until the 
PulseTime is reached. 

PulseTime 0.00 min 999.99  
in 0.01 
increments 

² (Demo 
mode:  
1.00 min) 

(Only in Pulsed mode) 
Duration of the 
pressure pulse.  

PurgeFlow 0.0 ml/min 1000.0 
ml/min in 
increments of 
1 

² (Demo 
mode:  
60 ml/min) 

Properties related to 
the flow from the purge 
vent. 
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Property Min. Max. Default Description 
PurgeTime 0.00 min 999.99 min  

in increments 
of 1 

² (Demo 
mode:  
0.75 min). 

(Only in Splitless 
mode) Time when the 
purge valve shall be 
opened.  

SplitRatio 0.1 7500.0 in 0.1 
increments 

² (Demo 
mode: 50.0) 

Ratio of the split flow to 
the column flow. (The 
column flow is set as a 
column property.) This 
property is valid in split 
mode only if the 
column is defined.  

VentEndTime 0.00 min 999.99 min  
in 0.01 
increments. 

² (Demo 
mode:  
0.00 min) 

(Only valid in 
SolventVent mode) 
Time at which solvent 
venting ends. The time 
should be greater than 
the time needed for all 
injections. 

VentFlow 0.0 ml/min 1000.0ml/min
in 0.1 
increments 

² (Demo 
mode:  
0.0 ml/min) 

(Only valid in 
SolventVent mode) 
Properties related to 
the flow from the split 
vent during the vent 
period (before the 
VentEndTime). . 

VentPressure 0.00 bar 10,00 bar in 
0,01er 
Schritten 

² (Demo 
mode:  
0.00 bar) 

Inlet pressure during 
the vent period. Set the 
property to 0 for the 
lowest possible 
pressure.   

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 

Also, refer to  Agilent 6890/6850 GCs: PGM File - Entering Pressure 
or Flow? 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to the related 
topics in the Hardware Installation section. 
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 Agilent 6890/6850 GCs: Column 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
Detector 6890:  

Front, Back, MSD, AED, 
Unknown 
6850:  
Front, MSD, AED, Unknown 

6890:  
Front for the 
front detector 
6850: Front  

Detector to which the 
column is connected.  

Diameter 0.0 
(Unknown) 
µm 

1000.00 µm
in 0.01 
increments 

250.00  Specifies the inner 
diameter of the column.  

FilmThickness 0.0 
(Unknown) 
µm 

1000.00 µm
in 0.01 
increments 

10.00 µm  Specifies the film 
thickness of the column. 

Flow - - - Properties related to the 

flow; see  PGM File - 
Entering Pressure or 
Flow.  

 Flow.Nominal 0.0 ml/min 1000.0 
ml/min in 
increments 
of 1 

Emulation of the 
ramp 

Specifies the target flow 
value. 

 Flow.Value 0.0 ml/min 1000.0 
ml/min 

- Current flow value (read-
only). 

FlowMode Pressure-
Ctrl 

FlowCtrl PressureCtrl  Defines the pneumatics 
mode for the pressure or 
flow profile for the 
column.  

Inlet 6890:  
Front, Back, Aux3, Aux 4, 
Aux 5, Unknown 
6850:  
Front, Aux3, Aux 4, Aux 5, 
Unknown 

6890:  
Front for the 
front detector,  
Back for the 
back detector 
6850: Front 

Inlet to which the 
detector is connected.  

Length 0.0 
(Unknown) 
mm 

1000,00 mm
in 0.01 
increments 

30.00 mm  Specifies the column 
length. 
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Property Min. Max. Default Description 
OutletPressure 0.0 bar 10.0 bar  

in increments  
of 1 

² (Demo  
mode: 1.0 bar) 

Specifies the pressure at 
the column end if the 
column is neither in the 
vacuum nor under 
atmospheric pressure, 
e.g., if the column is 
directly connected to an 
ECD. 

OutletPressure 
Correction 

Off On ² (Demo  
mode: Off) 

Set to On if the column 
end is neither in the 
vacuum nor under 
atmospheric pressure. 
Specify the pressure at 
the column end as 
OutletPressure.  

Pressure - - - Properties related to the 
pressure. 

 Pressure. 
Nominal 

0.0 bar 10.0 bar in 
increments 
of 1 

Emulation of the 
ramp. 

Specifies the target 
pressure value. 

 Pressure.Value 0.0 bar 10.0 bar - Measured pressure value 
(read-only). 

VacuumCorrection Off On ² (Demo  
mode: Off) 

Set to On if the column is 
connected to the 
vacuum, i.e., if the 
column is directly 
connected to a mass 
spectrometer. 

Velocity - - - Properties related to the 
average linear gas 
velocity.  

 Velocity. 
Nominal 

0 cm/s 1000 cm/s in 
increments 
of 1 

- Specifies the desired 
average target gas 
velocity. . 

 Velocity.Value 0 cm/s 1000 cm/s - Average linear gas 
velocity (read-only).  

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to the related 
topics in the Hardware Installation section. 
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 Agilent 6890/6850 GCs: Detectors 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 

⇒Autozero - - - Sets the current detector 
signal to 0.  

CombinedFlow 
(Detectors without 
EPC option) 

0.0 
ml/min 

1000.0 
ml/min 

- Combined gas flow (makeup 
+ inlet). In this form, the 
property is available for 
detectors without EPC 
option (see Detector 
configuration tab page). 

CombinedFlow 
(Detectors with EPC 
option) 

Off On ² (Demo  
mode: Off) 

Properties related to the 
combined gas flow (makeup 
+ inlet). In this form, the 
property is available for 
detectors with EPC option 
(see Detector configuration 
tab page). 

 Combined 
Flow.Nominal 

0.0 
ml/min 

1000.0 
ml/min 

- Specifies the target 
combined flow. 

 Combined 
Flow.Value 

0.0 
ml/min 

1000.0 
ml/min 

- Indicates the current 
combined flow (read-only) 

Data_Collection_ 
Rate 

0.1, 0.2, 0.5, 1.0, 2.0, 5.0, 
10.0, 20.0, 50.0, 100.0 Hz

² (Demo 
 mode: 1.0 Hz) 

The property is available 
only for instruments with 
digital data acquisition 
mode. 

FastPeaks Off On ² (Demo  
mode: Off) 

If set to On, the peak width 
is 0.004 min (8 Hz 
bandwidth). Otherwise, the 
peak width is 0.001 min (1.6 
Hz bandwidth). 

MakeupFlow  0.0 
ml/min 

100.0 ml/min
in increments
of 1 

² (Demo mode: 
10.0 ml/min) 

Properties related to the 
makeup gas flow (see 
Front/Back Detector tab 
page in the Server 
Configuration program). 

 MakeupFlow. 
Nominal 

0.0 
ml/min 

100.0 ml/min ² (Demo mode: 
10.0 ml/min) 

Specifies the target makeup 
gas flow.  

 MakeupFlow. 
Value 

0.0 
ml/min 

100.0 ml/min - Current makeup gas flow 
(read-only). 



 Commands and Tips for Third-Party Devices 915 

Property Min. Max. Default Description 
MakeupFlowCtrl 
(Detectors with EPC 
option) 

Off On) ² (Demo  
mode: Off) 

Turns the pneumatics on 
and off. In this form, the 
property is available for 
detectors with EPC option 
(see Front/Back Detector 
tab page in the Server 
Configuration program). 

MakeupMode Make 
-up 

Combined) ² (Demo  
mode: Makeup) 

Determine which flow shall 
be kept constant: Make-p or 
Combined. 
(The property is available 
only for FID; TCD, ECD, µ-
ECD, NPD, and FPDs 
detectors.) 

Range 0 13  
in increments 
of 1 

² (Demo  
mode: 0) 

(Only for detectors with 
analog data acquisition 
mode) Data acquisition 
range: The smaller the 
signal is, the smoother is the 
signal. However, high peaks 
may be cut off if the range is 
small. 

TempCtrl Off On ² (Demo  
mode: Off) 

Specifies the state of the 
temperature control. If set to 
Off, temperature control is 
disabled. The property is 
automatically set to On 
when a temperature value is 
entered in the Temperature 
field. 

Temperature - - - Properties related to the 
temperature of the heated 
zone. (The property is 
available only if Zone is 
installed on the Detector 
configuration tab page.)  

 Temperature. 
Nominal 

0 450°C  
in increments 
of 1 

² (Demo  
mode: 300°C) 

Specifies the target 
temperature for the heated 
zone.  

 Temperature. 
Value 

0.0°C 450.0°C  - Actual temperature of the 
heated zone (read-only).  
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Property Min. Max. Default Description 
Type - - - Installed detector type: 

6890:  
None, FID (flame ionization), 
TCD (thermal conductivity), 
ECD (electron capture), 
NPD (nitrogen 
phosphorous), FPD (flame 
photometric), Other, µ-ECD 
6850:  
None, FID, TCD  
(33 characters, read-only)  

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to Hardware 
Installation: 

 Agilent 6890 GC: Overview 

 Agilent 6890 GC: Installation 

 Agilent 6850 GC: Overview 

 Agilent 6850 GC: Installation 
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 Agilent 6890/6850 GCs: ECD 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
AdjustOffset Off, On, or Abort ² (Demo  

mode: On) 
Adjusts the reference 
current until the desired 
output is reached as 
defined by the 
TargetOutput property. 

AnodeFlow 
(Detectors without 
EPC option) 

0.0 ml/min 12.0 ml/min ² (Demo  
mode: 0.0 
ml/min) 

Anode gas flow. (In this 
form, the property is 
available only for 
detectors without EPC 
option, see the Detector 
configuration tab page. 
The property is read-
only.) 

AnodeFlow 
(Detectors with EPC 
option) 

- - - Properties related to the 
anode gas flow (The 
property is available for 
detectors with EPC 
option, see the Detector 
configuration tab page.) 

 AnodeFlow. 
Nominal 

0.0 ml/min 12.0 ml/min 0.0 ml/min  Specifies the target 
anode gas flow. 

 AnodeFlow. 
Value  

0.0 ml/min 12.0 ml/min - Current anode gas flow 
(read-only).  

Anode FlowCtrl 
(Detectors with EPC 
option) 

Off On ² (Demo  
mode: On). 

Turns the pneumatics on 
and off. In this form, the 
property is available for 
detectors with EPC 
option, see the 
Front/Back Detector tab 
page in the Server 
Configuration program.) 

MakeupGasType 
(Detectors with EPC 
option) 

Nitrogen, Argon Methane, 
Unknown 

² (Demo  
mode: Nitrogen) 

Makeup gas type. (The 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.) 

Pulser Off On ² (Demo  
mode: Off) 

Turns the detector 
electronics on and off.  
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Property Min. Max. Default Description 
RefCurrent 0.5 nA 5.0 nA 

in 
increments 
of 1 

² (Demo  
mode: 1.5) 

 

TargetOutput 20 200 in  
increments 
of 1 

² (Demo  
mode: 60) 

Specifies the desired 
detector output for the 
AdjustOffset procedure.  

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to Hardware 
Installation: 

 Agilent 6890 GC: Overview 

 Agilent 6890 GC: Installation 

 Agilent 6850 GC: Overview 

 Agilent 6850 GC: Installation 
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 Agilent 6890/6850 GCs: FID and FPD 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
AirFlow  
(Detectors without 
EPC option) 

0.0 ml/min 800.0 ml/min ² (Demo  
mode:  
400.0 ml/min) 

Air gas flow. In this form, 
the property is available 
only for detectors without 
EPC option, see the 
Detector configuration tab 
page. The property is read-
only.) 

AirFlow  
(Detectors with 
EPC option) 

- - - Properties related to the air 
gas flow. In this form, the 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.  

 AirFlow.Value 0.0 ml/min 800.0 ml/min - Current air gas flow (read-
only).  

 AirFlow. 
Nominal 

0.0 ml/min 800.0 ml/min 0.0 ml/min  Specifies the target air gas 
flow.  

AirFlowCtrl 
(Detectors with 
EPC option) 

Off On ² (Demo  
mode: Off) 

Turns the pneumatics on 
and off. In this form, the 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.  

Electrometer Off On ² (Demo  
mode: Off) 

Turns the detector 
electronics on and off. 

Flame Off On ² (Demo  
mode: Off) 

Turns the flame on and off. 

H2Flow  
(Detectors without 
EPC option) 

0.0 ml/min 100.0 ml/min ² (Demo  
mode:  
30 ml/min) 

H2 gas flow. In this form, 
the property is available 
only for detectors without 
EPC option, see the 
Detector configuration tab 
page. The property is read-
only.  

H2Flow  
(Detectors with 
EPC option) 

- - - Properties related to the H2 
gas flow. In this form, the 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.  
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Property Min. Max. Default Description 
 H2Flow. 

Nominal 
0,0 ml/min 100,0 ml/min 

in 1er 
Schritten 

² (Demo  
mode: 30 
ml/min) 

Specifies the target H2 gas 
flow. 

 H2Flow.Value 0.0 ml/min 100.0 ml/min  Current H2 gas flow.  
H2FlowCtrl Off On ² (Demo  

mode: Off) 
Turns the pneumatics on 
and off. In this form, the 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.) 

LitOffset 0.00 pA 99.9 pA 
in increments
of 1 

² (Demo  
mode: 0.0 pA) 

If the detector output is 
below this level, the GC 
assumes that the flame is 
no longer burning and tries 
to reignite the flame. 

MakeupGasType Nitrogen, Hydrogen, 
Helium, Argon Methane, 
Unknown 

² (Demo  
mode: 
Nitrogen) 

Makeup gas type. The 
property is available only 
for FID detectors with EPC 
option, see the Detector 
configuration tab page.  

OxidizerGasType Oxygen) Air,  
Unknown 

 The property is available 
only for FPD detectors with 
EPC option, see the 
Detector configuration tab 
page.   

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to Hardware 
Installation: 

 Agilent 6890 GC: Overview 

 Agilent 6890 GC: Installation 

 Agilent 6850 GC: Overview 

 Agilent 6850 GC: Installation 
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 Agilent 6890/6850 GCs: NPD (Nitrogen Phosphorous 
Detector) 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
AdjustOffset Off) On) Abort) ² (Demo  

mode: Off) 
Adjusts the reference 
current until the desired 
output is reached as 
defined by the 
TargetOutput property. 

AirFlow  
(Detectors without 
EPC option) 

0.0 
ml/min 

200.0 ml/min ² (Demo mode: 
60.0 ml/min) 

Air gas flow. In this form, 
the property is available 
only for detectors without 
EPC option, see the 
Detector configuration 
tab page.) 

AirFlow 
(Detectors with EPC 
option) 

- - - Properties related to the 
air gas flow. In this form, 
the property is available 
only for detectors with 
EPC option, see the 
Detector configuration 
tab page.) 

 AirFlow. 
Nominal 

0.0 
ml/min 

200.0 ml/min 
in increments 
of 1 

² (Demo  
mode: 60) 

Specifies the target air 
gas flow.  

 AirFlow.Value 0.0 
ml/min 

200.0 ml/min 
in increments 
of 1 

- Current air gas flow 
(read-only).  

AirFlowCtrl 
(Detectors with EPC 
option) 

Off On ² (Demo  
mode: On) 

Turns the pneumatics on 
and off. In this form, the 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page. 

BeadPower Off On ² (Demo  
mode: On) 

Turns the bead power on 
and off. 

BeadVoltage 0.000 pA 4.095 pA 
in 0.001 
increments 

² (Demo  
mode: 2.500 pA) 

The bead voltage can be 
set either via 
AdjustOffset or directly.  
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Property Min. Max. Default Description 
H2Flow 
(Detectors without 
EPC option) 

0.0 
ml/min 

30.0 ml/min ² (Demo  
mode:  
3.0 ml/min) 

H2 gas flow. In this form, 
the property is available 
only for detectors without 
EPC option, see the 
Detector configuration 
tab page. The property is 
read-only. 

H2Flow  
(Detectors with EPC 
option) 

- - . Properties related to the 
H2 gas flow. In this form, 
the property is available 
only for detectors with 
EPC option, see the 
Detector configuration 
tab page.) 

 H2Flow. 
Nominal 

0.0 
ml/min 

30.0 ml/min  
in increments 
of 1 

² (Demo  
mode:  
3.0 ml/min) 

Specifies the target H2 
gas flow.  

 H2Flow.Value 0.0 
ml/min 

30.0 ml/min - Current H2 gas flow 
(read-only). 

H2FlowCtrl 
(Detectors with EPC 
option) 

Off On ² (Demo  
mode: On) 

Turns the pneumatics on 
and off. In this form, the 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page. 

MakeupGasType 
(Detectors with EPC 
option) 

Nitrogen) Hydrogen, 
Helium, Argon Methane, 
Unknown 

² (Demo  
mode: Nitrogen) 

Makeup gas type. The 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.) 

OffsetEquilibration 
Time 

0.00 min 999.99 min 
in 0.01 
increments 

² (Demo  
mode: 5.00 min) 

Specifies how long the 
detector output must be 
stable before the 
AdjustOffset procedure is 
finished. 

PolVoltage Off On ² (Demo  
mode: On) 

Turns the detector 
electronics on and off. 

RefCurrent 0.5 nA 50 nA 
in 0.1 
increments 

² (Demo  
mode: 1.5 nA) 

Specifies the target 
detector output for the 
AdjustOffset procedure.  

TargetOutput 20 200  
in increments 
of 1 

² (Demo  
mode: 50) 

Specifies the target 
detector output for the 
AdjustOffset procedure.   

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
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The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to the related 
topics in the Hardware Installation section. 

 Agilent 6890/6850 GCs: TCD (Thermal Conductivity 
Detector) 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
Filament Off On 1  Turns the filament on 

and off. 
MakeupGasType 
(FID Detectors with 
EPC option)  

Nitrogen, Hydrogen, 
Helium, Argon Methane, 
Unknown) 

² (Demo  
mode: Nitrogen)

Makeup gas type. In this 
form, the property is 
available only for FID 
detectors with EPC 
option, see the Detector 
configuration tab page.  

Polarity Positive Negative ² (Demo  
mode: Positive) 

Set to Negative to invert 
negative peaks. Set to 
Positive for normal 
peaks.  

RefFlow 
(Detectors without 
EPC option)  

0.0 ml/min 100.0 
ml/min  

² (Demo  
mode:  
0.0 ml/min) 

Reference gas flow. In 
this form, the property is 
available only for 
detectors without EPC 
option, see the Detector 
configuration tab page.  

RefFlow 
(Detectors with EPC 
option) 

- - - Properties related to the 
reference gas flow.  

 Ref.Flow. 
Nominal 

0.0 ml/min 100.0 
ml/min in 
increments of 
1 

0.0 ml/min Specifies the target 
reference gas flow.  

 RefFlow.Value 0.0 ml/min 100.0 
ml/min  

- Current reference gas 
flow (read-only). 

RefFlowCtrl 
(Detectors with EPC 
option)  

Off On ² (Demo  
mode: On) 

Turns the pneumatics on 
and off. In this form, the 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.  
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 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to the related 
topics in the Hardware Installation section. 

 Agilent 6890/6850 GCs: µ-ECD 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
AdjustOffset Off, On, Abort ² (Demo  

mode: Off) 
Adjusts the reference 
current to the desired 
output as defined by the 
TargetOutput property.  

MakeupGasType 
(Detectors with EPC 
option)  

Nitrogen, ArgonMethane, 
Unknown 

² (Demo  
mode: Nitrogen) 

Makeup gas type. The 
property is available only 
for detectors with EPC 
option, see the Detector 
configuration tab page.  

Pulser Off On ² (Demo  
mode: On) 

Turns the detector 
electronics on and off. 

RefCurrent 0.5 nA 5.0 nA in 0.1 
increments 

² (Demo  
mode: 1.5 nA) 

Reference current. 

TargetOutput 20 200 
in increments  
of 1 

² (Demo  
mode: 60) 

Specifies the target 
detector output for the 
AdjustOffset procedure.   

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to related topics in 
the Hardware Installation section. 
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 Agilent 6890/6850 GCs: Auxiliary Devices 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min. Max. Default Description 
PresCtrl Off On ² (Demo  

mode: Off) 
Specifies the state 
of the pressure 
control. The 
property is 
automatically set to 
On if an assignment 
is made in the 
Pressure field. 

Pressure - - - Properties related to 
the gas pressure. 

 Pressure.Nominal 0.00 bar 10.00 bar  Downloaded 
from the 
instrument. 

Specifies the target 
gas pressure.  

 Pressure.Value 0.00 bar 10.00 bar  - Measured gas 
pressure (read-
only).  

Temperature    Properties related to 
the temperature of 
the heated zone.  

 Temperature. 
Nominal 

0.0°C 500.0°C Downloaded 
from the 
instrument. 

Target operating 
temperature for the 
heated zone.  

 Temperature. 
Value 

0.0°C 500.0°C  - Current temperature 
of the heated zone.  

TempCtrl Off On ² (Demo  
mode: Off) 

Specifies the state 
of the heated zone 
control. If set to Off, 
temperature control 
is disabled. The 
property is 
automatically set to 
On if an assignment 
is made in the 
Temperature field.   

 Note: 
² When connecting, Chromeleon reads the value from the instrument and 
accepts it as default. 
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 Agilent 6890/6850 GCs: Application 

Notes on the Device Driver: 

General 
Experienced 6890/6850 GC users should be able to control the instrument 
without any problems. In Chromeleon, short descriptions of the GC 
commands are available in the corresponding Command dialog box or the 
Properties/Link box. 

In Chromeleon, pressure is always stated in bar. Selecting a different 
pressure unit is not supported. For more information, please contact Dionex 
Service. 

Inlet 
The inlet is usually controlled by the use of Inlet.* commands. However, 
the inlet can be connected to the column via the PGM File or via a direct 
command, e.g., using  

Column.Inlet = Front 

After this command, the column commands also control the inlet. In this 
case, the command given last applies.  

With the following command order 
Inlet.Flow.Nominal = 20.0 
Column.Pressure.Nominal = 5.00 

the inlet flow is adjusted according to a column pressure of 5.00 bar instead 
of being set to 20.0 ml per minute. 

Also, refer to  Agilent 6890/6850 GCs: PGM File - Entering Pressure 
or Flow? 

Column 
It is possible to enter column dimensions and connections. However, 
entering the calibration is currently not possible. If column dimensions and 
connections are not defined, certain commands, such as Velocity, 
MakeupMode = Combined, etc., cannot be executed  

It is not recommended to enter the column dimensions and connections in 
a sample program. However, you should include the parameters in the 

Audit Trail using the ⇒Log command. 
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Valves 
Special valve types (Multiposition, Gas Sampling) are currently not 
supported. For more information, please contact Dionex Service. 

Aux 
For the 6850 GC, an auxiliary device can be installed. For the 6890 GC, a 
maximum of two auxiliary devices for temperature control are supported. 

For both GC types, a maximum of three auxiliary devices for pressure 
control are supported. 

Sampler 
For the 6890 GC, the extended capabilities of the 7683 autosampler, such 
as solvent prewashes, are supported. The model 7673 did not support 
them.  

When Chromeleon connects the 6890 GC or 6850 ALS for the first time 
(see ⇒Connect), some (or many) error messages may appear starting with 
Error log at. These are previous errors recorded by the autosampler. You 
can simply ignore them. Future versions will show new errors only.  

Barcode Reader (only for the 6890 GC): If UseBCR = On, the barcode of 
the sample is read during the Inject command and is logged in the Audit 
Trail. 

Application 
Entering a Temperature Gradient 
You can enter a temperature gradient directly, using the Flow command on 
the Control menu (GC tab page) or by a PGM File. 

For the 6890 GC, a temperature profile can be entered with a maximum of 
six ascents or descents. (The 6890 GC cannot store more steps!) The 
maximum temperature change (ascent) is up to 120°C per minute, 
depending on the oven type.  

Gradients are entered in the Program Wizard or online in the typical format 
for GC applications. (The starting and end temperatures are entered as well 
as the modification rate.) In the program, however, the so-called "base 
point philosophy" is used (similar to entering a flow or percent gradient in 
HPLC). Each temperature command is a base point of the gradient 
program. The wizard automatically converts the entered rates into the base 
point representation. 
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However, no gradient is executed before the Inject command. Temperature 
gradients can only begin after the Inject command. If the program does not 
contain an Inject command, this does not apply.  
 
Temperature Setting Commands 
You can enable or disable temperature control of the oven, the inlet (two 
inlets for the 6890 GC), and the detector (two detectors for the 6890 GC), 
using the following commands:  
 
0.000 FrontInlet.TempCtrl=On Or = Off 
0.000 BackInlet.TempCtrl=On Or = Off 
0.000 GC.TempCtrl=On Or = Off 
0.000 FrontDetector.TempCtrl=On Or = Off 
0.000 BackDetector.TempCtrl=On Or = Off 

 
To set the temperature of the single modules, e.g., to 80°C, you have to 
use the following commands: 
 
0.000 FrontInlet.Temperature = 80  
0.000 BackInlet.Temperature = 80  
0.000 GC.Temperature = 80  
0.000 FrontDetector.Temperature = 80  
0.000 BackDetector.Temperature = 80  

 
Reaching the nominal temperature on the instrument can take some time. 
Please note that the oven heats faster than the injector and the detector 
system. As soon as the nominal temperature is reached, the GC sends a 
Ready signal. An injection via the autosampler is possible only after this 
signal. 

Example: 
The following program waits until the nominal temperature 150°C is 
reached, before the Inject command is executed:  
 
  0.000 GC.Temperature = 150 
   Wait GC.Ready 
   Inject 
  ...... .............. 
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 Tip:  
After the instrument has received the nominal temperature value from 
Chromeleon, it implements the desired value as fast as possible. When the 
value is "almost" reached, the Equilibration Time passes until the 
instrument sends the confirmation message to Chromeleon. You can 
specify the duration of this time interval using the Equilibration Time 
parameter in Chromeleon. 
 
The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to the related 
topics in the Hardware Installation section. 

 Agilent 6890/6850 GCs: PGM File - Entering Pressure or 
Flow? 
Depending on the inlet (or auxiliary device), you have to define pressure or 
flow in the PGM file. In addition, this depends on the column dimensions. 
The GC can calculate the flow from the pressure (or vice versa) only if the 
column diameter, the column length, and the film thickness are known. In 
all other cases, you have to enter the values required by the inlet or 
auxiliary device.  

Whether the pressure or the flow must be entered also depends on the 
control mode to be used by the GC for the separation. The following control 
modes are available: 
• Constant flow 

• Constant pressure 

• Flow ramp 

• Pressure ramp 

Known column dimensions 
Inlet/AUX Con. Pressure Con. Flow Press. Ramp Flow Ramp 
Purge Packed Pressure Flow Pressure Flow 
Cool On - Column Pressure Flow Pressure Flow 
Split/Splitless Pressure Flow Pressure Flow 
PTV Pressure Flow Pressure Flow 
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Inlet/AUX Con. Pressure Con. Flow Press. Ramp Flow Ramp 
ACI Pressure Flow Pressure Flow 
Gerstel PTV     -     -     -     - 
CIS3 Pressure Flow Pressure Flow 
JIB Pressure Flow Pressure Flow 
Volatiles Pressure Flow Pressure Flow 
     
AUX Pressure Flow Pressure Flow  

Unknown column dimensions 
Inlet/AUX Con. Pressure Con. Flow Press. Ramp Flow Ramp 
Purge Packed (with EPC)     - Flow     - Flow 
Cool On Column (with EPC) Pressure Pressure Pressure     - 
Split/Splitless (with EPC) Pressure Pressure Pressure     - 
PTV Pressure Pressure Pressure     - 
ACI     - Flow     - Flow 
Gerstel PTV     -     -     -     - 
CIS3 Pressure Pressure Pressure     - 
JIB     - Flow     -     - 
Volatiles Pressure Pressure Pressure     - 
     
AUX Pressure Pressure Pressure     -  

 Tips:   

If you want to work with a constant flow but if you do not know the column 
dimensions, you have to enter pressure instead of the flow nevertheless, 
e.g., for Cool-On-Column-Inlet. In this case, you have to determine the 
pressure by trial and error to achieve the desired flow. 

Agilent does not support the applications for which the fields in the above 
table are empty. Agilent does not support the Purge Packed, Cool on 
Column and Split/Splitless inlets without ECP when the column dimensions 
are not known. 

You can only operate the PTV inlet in the constant pressure/flow and 
pressure ramp modes if no column dimensions are defined. 

You can only operate the Gerstel PTV without control mode. 

The Administrator Help section provides general information and 
installation instructions for the 6890 and 6850 GCs; refer to the related 
topics in the Hardware Installation section. 
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 Agilent HP 5890 GC: Application 
Entering a Temperature Gradient 
You can enter a temperature gradient either directly, using the Flow 
command on the Control menu (GC tab page) or by a PGM File. 

Under Chromeleon, a temperature profile is possible with a maximum of 
three ascents or descents. (The HP 5890 GC cannot store more steps.) 
The maximum temperature change (ascent) is 70°C per minute.  

When entering a temperature gradient in the Program, the so-called 
"base point philosophy" is used (similar to entering a flow or percent 
gradient in HPLC). Each Temperature command is a base point for the 
gradient program. Understandably, no gradient is executed before the 
Inject command. Temperature gradients can only begin after the Inject 
command. If the program does not contain an Inject command, this does 
not apply. 
 
Temperature Settings 
Use the following commands to enable or disable temperature control of 
the injector, oven, and detector: 
 
0.00 InjectorA.TempCtrl = On or = Off 
0.00 InjectorB.TempCtrl = On or = Off 
0.00 GC.TempCtrl = On or = Off 
0.00 DetectorA.TempCtrl = On or = Off 
0.00 DetectorB.TempCtrl = On or = Off 

 
To set the temperature of the single modules, for example, to 80°C, you 
have to use the following commands:  
 
0.00 InjectorA.Temperature = 80  
0.00 InjectorB.Temperature = 80  
0.00 GC.Temperature = 80  
0.00 DetectorA.Temperature = 80  
0.00 DetectorB.Temperature = 80  

 
The temperature of the injector system and the detector should always be 
approximately 15 - 20°C (59 - 68°F) above the current oven temperature. 
Reaching the nominal temperature on the instrument can take some time. 
Please note that the oven heats faster than the injector and the detector 
system. As soon as the temperature is reached, the GC sends a Ready 
signal. An injection via the autosampler is possible only after this signal.  
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Example: 
The following program waits until the nominal temperature of 150°C is 
reached, before the ⇒Inject command is executed:  
 
  0.000 GC.Temperature = 150 
   Wait GC.Ready 
   Inject 
  ...... .............. 
 

 Tip:  
After Chromeleon has communicated the nominal temperature value to the 
instrument, the instrument implements the desired value as fast as 
possible. If the value is "almost" reached, the Equilibration Time passes 
until the instrument sends the confirmation message to Chromeleon. You 
can specify the duration of this time interval using the Equilibration Time 
parameter in Chromeleon. 
 
The Administrator Help section provides general information and 
installation instructions for the 5890 GC; refer to Hardware Installation: 

 Agilent HP5890 GC: Overview 

 Agilent HP5890 GC: Installation 
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CTC Analytics: Commands and Tips 

The first topic in this section provides information about the different 
 CTC PAL Sampler Commands. For information about the different 

injection modes, refer to: 

 Tips for Injection 

 PGM File for LC_Inject Mode 

 PGM File for Custom Inject Mode 

 Tips for Headspace Operation  

 PGM File for HS_Progr Inject Mode 

For information about how to solve possible problems, refer to  CTC 
Analytics PAL: Troubleshooting 

 CTC Analytics PAL Sampler Commands 

In addition to  General Device Commands, the CTC PAL Samplers 
support the following commands and properties (please note that the 
display Filter level determines which commands and properties are 
displayed): 

Status properties 
 
Property Value Range Filter Description 
Busy Busy/Idle Expert Indicates whether the device 

driver has sent all commands or 
whether execution of a command 
is complete  
(read-only). 

CPUSerialNo - Expert Indicates the CPU serial number 
of the connected sampler  
(read-only). 

DeviceState Ready/Busy/ 
Init(Error)/Unknown 

Normal Indicates the current device 
status (read-only). 

StatusDescription - Normal Indicates the current action of the 
sampler. If no action is being 
performed, Idle is displayed  
(read-only). 

Syringe - Normal Indicates the installed syringe 
type (read-only). 
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Inject properties 
 
Command Value Range Filter Description 
AgitationOffTime 0-99 s or Default* Normal Specifies the period during 

which the agitator is idle. 
AgitationOnTime 0-99 s or Default* Normal Specifies the period during 

which the agitator is active. 
AgitationSpeed Depends on the agitator; 

indicated in rpm. 
Special values: Off and 
Default* 

Normal Sets the agitation speed in 
revolutions per minute and 
starts the agitator (Off 
deactivates the agitator).  

AirVolume Depends on the volume of the 
installed syringe; indicated in µl. 
Special value: Default* 

Normal Specifies the air volume to 
be drawn for the Inject 
and/or WashWithSample 
commands (in LC_Inject 
and GC_Inject modes). 

FillSpeed Depends on the minimum and 
maximum speed of the installed 
syringe; indicated in µl/s. 
Special value: Default* 

Normal Fill speed for the preparing 
fill strokes for the Inject 
and/or WashWithSample 
commands. 

FillStrokes 0-99 or Default* Normal Number of preparing fill 
strokes for the Inject 
and/or WashWithSample 
commands (in all injection 
modes except Custom). 

FillVolume Depends on the syringe volume; 
indicated in µl.  
Special value: Default* 

Normal Fill volume for the single 
piston strokes (for the 
Inject command in 
GC_Inject mode and for 
the WashWithSample 
command). 

GCCycleTime 0 - 1440 min Normal Specifies the run time for 
the GC between two 
injections. In sample 
programs, this value must 
be set prior to the Inject 
command  

IncubationTime 0 - 1440 min Normal Specifies the incubation 
time for the sample.  
In sample programs, this 
value must be set prior to 
the Inject command (only 
in HS_Single injection 
mode). 

IncubTimeOffset 0 - 1440 min Normal Additional incubation time 
with respect to the previous 
sample in a sequence. This 
value can be set only once 
per sequence (only in 
HS_Progr injection mode). 
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Command Value Range Filter Description 
IncubTimeStart 0 - 1440 min Normal Incubation time for the first 

sample in a sequence. This 
value can only be set once 
per sequence (only in 
HS_Progr injection mode). 

InjectMode LC_Inject Custom (for LC),  
GC_Inject/HS_Single/HS_Progr/
Custom (for GC) 

Advanced Injection mode. In sample 
programs, this value must 
be set prior to the Inject 
command. 

Injector List of all injection objects for 
the installed PAL 

Normal Injector to be used for the 
Inject and/or 
WashWithSample 
commands (for all injection 
modes except Custom). 
The setting is ignored in 
Custom injection mode. 

InjectSpeed Depends on the min. and max. 
speed of the installed syringe;  
Special value: Default* 

Normal Syringe speed in µl/s for 
injections to the sample 
loop/GC inlet  
(in LC_Inject, GC_Inject, 
and HS_Single modes).  

PostInjectDelay 0 - 99000 ms or Default* Normal Time between the injection 
and the removal of the 
needle from the injector (in 
LC_Inject, GC_Inject, 
HS_Single, and HS_Progr 
modes). 

PreInjectDelay 0 - 99000 ms or Default* Normal Time between insertion of 
the needle into the injector 
and injection of liquid into 
the sample loop (GC inlet) 
(in LC_Inject, GC_Inject, 
HS_Single, and HS_Progr 
modes). 

PreparationTime 0 - 1440 min Normal Preparation time. This 
value is set in HS_Single 
mode at the start time of a 
new sample (read-only). 
Corresponds to the 
remaining incubation time 
of the running sample 
(marked green), i.e., the 
time until the sample is 
injected.  
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Command Value Range Filter Description 
PullupDelay 0 - 10000 ms or Default* Normal Indicates the delay time 

between drawing the liquid 
into the syringe and 
dispensing the volume that 
is not required (in 
GC_Inject mode and for 
the WashWithSample 
command). 

Tray List of all tray objects of the 
installed PAL  

Normal Tray to be used for Inject 
(for all injection modes 
except Custom). 
Note: If you select a 
different tray, the 
TrayName property is 
updated automatically. 

TrayName String Normal Indicates the name of the 
current tray  
Note: If you select a 
different tray, the Tray 
property is updated 
automatically. 

*  Note:  
For the Default parameter, the default value set by CTC on the respective 
device is used. 
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 CTC Analytics PAL Samplers: Tips for Injection 
CTC PAL samplers support the following injection modes: 

PAL Sampler for LC: 

Standard HPLC injections -- LC_Inject injection mode (see  PGM File 
for LC_Inject Mode) 

User-defined HPLC injections -- Custom injection mode (see  PGM File 
for Custom Inject Mode) 

PAL Sampler for GC:  

Standard GC injections -- GC_Inject injection mode 
Headspace injections -- HS_Single and HS_Progr injection modes (see 

 PGM File for HS_Progr Inject Mode) 

The table below indicates which parameters must be defined for each 
injection mode.  
 
Step 
 
 

Parameters for 
LC_Inject 
 

Parameters for 
GC_Inject 
 

Parameters for HS_Single 
and HS_Progr headspace 
Modes 

1. Preparation   IncubationTime or 
IncubStartTime/IncubOffset, 
GCCycleTime 

2. Load  AirVolume 
FillSpeed 
FillStrokes 
PullupDelay 

AirVolume 
FillVolume 
FillSpeed 
PullupDelay 
FillStrokes 

AirVolume = 0 
FillSpeed 
PullupDelay 
FillStrokes 

3. Injection  PreInjDelay 
PostInjDelay 
InjSpeed 
Injector 

PreInjDelay 
PostInjDelay 
InjSpeed 
Injector 

PreInjDelay 
PostInjDelay 
InjSpeed 
Injector  
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When performing an inject command, the LC PAL sampler performs the 
following steps: 

1. The sample needle is moved to the specified vial (in the tray or agitator).  

2. The specified sample volume is drawn into the syringe. 

3. Optional: If the AirVolume parameter is set to a value > 0, air is drawn 
from outside the vial.  

4. The sample needle is moved to the specified injector. 

5. The sampler waits for the Inject Sync signal. (The Inject Sync signal is a 
PAL synchronization signal.) Set this signal to immediately if no waiting 
time is required. Alternatively, you can set the signal to the input port of 
the PAL if the sampler is to wait for a signal from the pump. (For 
information about the settings, refer to Installing and Controlling 
Third-Party Devices  CTC Analytics PAL LC/GC Samplers: 
Installation in the Administrator Help section.) 

6. The needle is moved into the injector. 

7. The sampler pauses for the time specified by PreInjDelay. 

8. The injection valve is moved into the Load position (LC_Inject mode 
only). 

9. The content of the syringe is dispensed into the sample loop or the GC 
inlet. 

10. The sampler pauses for the time specified by PostInjDelay. 

11. The injection valve is moved into the Inject position (LC_Inject mode 
only). 

12. The needle is moved out of the injector. 

13. The needle returns to the Home position. 
 

 Tip:  
Steps 4 and 5 are omitted in the GC injection mode. Additional steps are 
required for headspace injections (refer to  Tips for Headspace 
Operation). 
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 CTC Analytics PAL Samplers: PGM File for LC_Inject 
Mode 
Use the LC_Inject mode for HPLC standard injections. A typical program 
might look as follows: 
 
; Pump/detector commands 
 ... 
; PAL commands  
 TrayName = Sample.PALTray 
; (Prerequisite: User-defined column named PALTray) 
 InjectMode = LC_Inject 
 Injector = LC_Inj1 
 InjectSpeed = 50.00 
 FillSpeed = 100.00 
 FillStrokes =  2 
; Preparation steps of the PAL Sampler 
 Wash WashStation=Wash1, WashCycles=1 
 WashWithSample  WashCycles=2 
; Injection procedure  
0.000 Wait Ready 
 Inject 
 UV.AcqOn 
; Cleansing steps of the PAL Sampler 
 Wash WashStation=Wash1, WashCycles=1 
 WashInjector WashStation=Wash2, Injector=GC_Inj1, 
 WashCycles=1 
10.00 UV.AcqOff 
 
 End 
 

 Tip:   

You can use the TrayName command only if the corresponding User-
Defined Column (here: PALTray) has been defined. 

For more information, refer to: 

 CTC Analytics PAL Sampler Commands 

 Tips for Injection 

 PGM File for Custom Inject Mode 

For information about how to solve possible problems, refer to  CTC 
Analytics PAL Samplers: Troubleshooting. 
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 CTC Analytics PAL Sampler: PGM File for Custom Inject 
Mode 
The Custom injection mode supports special injections, e.g., from different 
trays with irregularly distributed sample positions and varying injection 
volumes. The ⇒Inject command only defines the injection. You have to 
define all sample preparation steps and the injection procedure in the PGM 
File. The Inject command is the last command in the injection procedure.  

A typical program for the Custom injection mode might look as follows: 
 
; Pump/detector commands 
 ... 
; PAL commands  
 InjectMode = Custom 
; Preparation steps of the PAL Sampler 
 Wash WashStation=Wash1, WashCycles=1 
  WashWithSample; WashCycles=2 
; Injection procedure 
0.000 Wait Sampler.Ready 
 GET_SAMPLE Source=Tray01, Index=Sample.Position,  
  Sample_Volume = Sample.Volume 
 SWITCH_INJ_Position = Standby 
 SWITCH_INJ Injector=LCInj 
 PUT_SAMPLE Destination=LCInj, Index=1 
 SWITCH_INJ_Position = Active 
 SWITCH_INJ Injector=LCInj 
 Inject  
; (The Inject command completes the injection procedure) 
 UV.AcqOn 
 . . . 
; Cleansing steps of the PAL Sampler 
 Wash WashStation=Wash1, WashCycles=1 
 WashInjector WashStation=Wash2, Injector=GC_Inj1, 
 WashCycles=1 
10.00 UV.AcqOff 
 
 End 
 
For more information, refer to  CTC Analytics PAL Sampler 
Commands,  Tips for Injection, and  PGM File for LC_Inject Mode. 
For information about how to solve possible problems, refer to  CTC 
Analytics PAL Samplers: Troubleshooting. 
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 CTC Analytics PAL Samplers: Tips for Headspace 
Operation 
Chromeleon supports two headspace injection modes: 

HS_Single:  Standard headspace injection 

HS_Progr:  Progressive headspace injection 

In HS_Single mode, the sampler performs a standard headspace injection, 
including sample preparation. You must specify an incubation time 
(IncubationTime parameter) for every sample in the sequence.  

In HS_Progr mode, you do not have to explicitly set the incubation time for 
samples. Instead, you can increase the incubation time of the previous 
sample by a certain value (IncubOffset). The IncubTimeStart parameter 
determines the start of the incubation time of the first sample in a 
sequence. Thus, the incubation time for the sample number n is calculated 
as follows: 

IncubTimeStart  + (n-1) * IncubOffset . 

 Tip:   

You are not allowed to change the IncubOffset or IncubTimeStart 
parameters in a sequence, i.e., they can be set before the start of the 
sequence or they must have the same value in each sample program that 
is used in the sequence. 

In both modes, Chromeleon needs information about the minimum time 
difference between two sample injections. Use the GCCycleTime 
parameter to specify the time required by the GC after injection until the 
instrument is ready for the next injection.  

 Tip:   

Make sure the cycle time is long enough for completion of all actions by the 
GC (injection procedure, chromatographic separation, cleaning, warming 
up of the inlet, etc.) and the sampler (cleaning before and after injection, 
preparation of new samples, etc.). 

The PAL sampler automatically places the vials in the agitator for sample 
preparation. After the injection procedure, the vials are moved back to their 
original positions in the tray. 
• If you start a new sequence, make sure that no samples were left in the 

agitator. If necessary, remove all vials from the agitator manually 
before starting a new sequence. 
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 Caution:   
Always run an emergency program to cool down the agitator (or other 
temperature-controlled components) before removing the samples 
manually from the agitator. 

• If you interrupt a current sequence (immediately or after current 
sample) or if an abort error occurs, Chromeleon attempts to remove all 
remaining samples from the agitator. This attempt may fail in case of a 
general device error. In this case, remove the vials manually. 

 Caution:   
Always run an emergency program to cool down the agitator (or other 
temperature-controlled components) before removing the samples 
manually from the agitator. 

• Chromeleon checks whether the specified GC cycle time of a sample 
exceeds the program end time minus the start time of the next sample. 
Nevertheless, Dionex recommends allowing for some extra time.  

 Tip:   

The GC may require more time, e.g., to heat up the inlet, column, 
and/or detector until it has reached the new temperature. In this case, 
certain commands, such as Wait and Inject, delay the execution of the 
program, possibly even beyond the sample incubation time. Therefore, 
Dionex recommends setting the real time of the GC cycle to 
GCCycleTime and adding 30 to 60 seconds for safety reasons. (You 
might have to add more time, depending on the GC running conditions; 
for more information, refer to the GC instruction manual.)  

• Do not use the TRANSP_VIAL command to transport vials to or from 
the agitator while the sequence is being processed in HS_Inject mode. 
The mechanism for sample preparation is not connected with this 
command. If you use this command while a sample is being processed, 
Chromeleon may attempt to place a vial in a position that is already 
occupied or to fetch a vial from a position where no vial is present.  

• In headspace injection mode, you can assign the tray to be used either 
manually or explicitly in the PGM File via the tray name (e.g., 
TrayName = Tray1 or Tray = Tray1). If you use the Tray and 
TrayName parameters, it is not possible to make assignments via 
user-defined columns or formulae. 
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• Actions for the current sample have priority over preparation steps for 
the next sample. Therefore, sample preparation steps are only 
performed when the sampler is idle. The injection is performed when 
the PAL sampler has completed sample preparation. Chromeleon does 
not place a new sample in the agitator if the remaining preparation time 
for the running sample (marked green) is less than 30 seconds. 

• If you use the headspace mode for injection, all samples must use the 
same injection mode. It is not possible to change the headspace mode 
during a sequence or use non-headspace and headspace modes in 
one sequence. 

• The following applies to blank samples (the Blank sample type, for 
which the inject command contains the Skipped parameter) and 
samples without an inject command: Sample preparation is simulated, 
i.e., the system waits for the desired incubation time but the sample is 
not placed in the agitator and no injection is performed. 

 Note:   

The audit trail messages for sample preparation are displayed both in the 
currently running sample and in the sample that is prepared. 

For more information, refer to  PGM File for HS_Progr Inject Mode. 
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 CTC Analytics PAL Samplers: PGM File for HS_Progr 
Inject Mode 
GC injections are similar to LC injections. If you want to perform headspace 
injections, you have to define the appropriate sample preparation steps via 
the HS_Progr injection mode. A typical program for headspace injections 
might look as follows: 
 Agitator_Temperature.Nominal = 100.0 
 Agitator_Temperature.Accuracy = 1.0 
 TrayName = "Tray1" 
 Injector = GC_Inj1 
 InjectMode = HS_Progr 
 FillStrokes = 3 
; Delay times in [ms]: 
 PreInjectDelay = 3000 
 PostInjectDelay = 5000 
; Incubation time for the first sample of a sequence in [min] 
 IncubTimeStart = 2.0 
; Additional incubation time of the last sample 
 IncubTimeOffset = 1.0 
; Minimum run time between two injections(buffer: 10min + 1.5min) 
 GCCycleTime = 700 
; Agitation times in [s] 
 AgitationOnTime = 20 
 AgitationOffTime = 10 
 AgitationSpeed = 250 
 
0.000 Wait Sampler.Ready   
 Inject 
 UV.AcqOn  
; Cleansing steps sampler 
 Wash WashStation=Wash1, WashCycles=1 
 WashInjector WashStation=Wash2, Injector=GC_Inj1, 
 WashCycles=1 
10.000 UV.AcqOff 
  
 End 
 
Also, refer to  Tips for Headspace Operation. 
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 CTC Analytics PAL Sampler: Troubleshooting 
The following problems may occur during operation of the PAL sampler: 

Missing vial: 
If no vial is present at the position from which the sampler performs 
injections, the batch is aborted. Due to a firmware limitation, the sampler 
may then remain in an inconsistent state.  

Therefore, Dionex recommends performing a Home command. If the tray in 
which the error occurred is part of a tray stack, close the stack drawer 
manually. 

Z collision error: 
If the syringe holder collides with another component of the sampler while 
moving in the z direction (e.g., because of an incorrect configuration), the 
sampler reports a z collision error.  

First, find and eliminate the cause of the z collision error. Then, perform a 
Home command to recalibrate the motor in the x, y, and z directions. The 
driver cannot perform movement commands until the motor has been 
recalibrated.  

 Tip:   

The sampler is not equipped with collision sensors for the x and y 
directions. Therefore, stop the batch immediately if you observe a collision 
in the x or y direction. Afterward, perform the same steps described for a z 
collision error. 

Aborting a sequence or abort error in headspace mode:  
Unless a z collision error caused the abort error, the driver attempts to 
remove all samples that are still in the agitator. However, samples may 
remain in the (heated) agitator. For security reasons, Dionex recommends 
generating an emergency program for cooling the agitator (or other 
temperature-controlled components) down to ambient temperature.  

 Caution:   

Always run the emergency program before manually removing the samples 
from the agitator. 
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Fisons AS800/ThermoQuest AS2000 Autosamplers: 
Commands and Tips 

Chromeleon supports the following special commands and parameters for 
these autosamplers, which are identical in construction (please note that 
the display Filter level determines which commands and properties are 
displayed). Also, refer to the information in the manual shipped with the 
instrument. 
 
Command Description 
Clean Cleans the syringe using the previously defined parameters (see below). 
Inject Injects the sample using the previously defined parameters (see below). 
StopInject Aborts a running injection.  

 Tip:   

Use with Care! Might cause incorrect behavior! 
 
Use the following parameters to specify the Inject command in detail. 
Define all injection parameters before initiating the Inject command. 
Otherwise, they will not take effect. 
 
Parameter Description 
AirVolume Select this parameter to specify the volume of air (0.0 -

 500.0 µl) drawn after pulling the syringe needle out of the vial. 
This reduces evaporation from the syringe needle. The total of 
AirVolume plus FillingVolume must not exceed the syringe 
volume. 

CleanCycles Select this parameter to determine the number of cleaning 
cycles before injection (0...15). Specify the volume with the 
FillingVolume parameter. 

Cleaning Cycles before 
Injection (Pre Inj Clean 
Cyc) [Solvent A/B/C/D] 

Select this parameter to set the number of pre-injection 
cleaning cycles with solvent A/B/C/D. Please note: Only the 
solvent that has been specified last is used. 

Cleaning Cycles after 
Injection (Post Inj Clean 
Cyc) [Solvent A/B/C/D] 

Select this parameter to set the number of post-injection 
cleaning cycles with solvent A/B/C/D. Please note: Only the 
solvent that has been specified last is used. 

Delay (PullUpDelayTime) Select this parameter to determine the delay following the up 
and down movements of the syringe plunger (0.0 - 15.0 s). 

Delay after (Post Inj Delay 
Time) 

Select this parameter to determine for how long the syringe 
remains in the injector after the injection (0 - 63 s). 

Delay before (Pre Inj Delay 
Time) 

Select this parameter to determine the delay the syringe 
remains in the injector before the injection (0 - 63 s). 
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Parameter Description 
FillingVolume Select this parameter to set the sample volume to be used for 

cleaning and eliminating gas bubbles (see CleanCycles and 
PullupCount). If the FillingVolume (0.0 - 500.0 µl) is less than 
the sample volume (Volume), the sample volume will be used 
instead. 

InjectionSpeed Select this parameter to determine how fast the sample is 
injected (1 - 100 µl/s). 

Post Inj Clean Cyc A/B/C/D Select this parameter to set post-injection cleaning cycles with 
solvent A/B/C/D. Please note: Only the solvent that has been 
specified last is used 

PullupSpeed  
(AspirationSpeed) 

Select this parameter to determine how fast the sample is 
drawn (1 - 100 µl/s). 

Pumps (PullupCount) Select this parameter to determine how often the syringe 
plunger is moved up and down before the sample is actually 
drawn up (0...15). This eliminates bubbles and thus, enhances 
reproducibility. 

Volume (Pre Inj Clean Vol) Select this parameter to set the pre-injection cleaning volume 
(0,0 - 500,0 µl). 

With Sample (Position) Select this parameter to specify the sample that shall be used 
for cleaning (positions 0...15).  

For more information, refer to: 

 Program Example 

 Troubleshooting 

The Administrator Help section provides installation details; refer to 
Hardware Installation: 

 Fisons AS800 GC Autosampler  
 Thermo Finnigan/TQ/TSP AS2000 GC Autosamplers 
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 Fisons AS800/ThermoQuest AS2000: Program Example 

After the ⇒Connect command, the parameter values are initially unknown 
to Chromeleon (blank fields in the AS800 control panel). You should enter 
meaningful values before injection. Use one of the Method A/B/C/D 
buttons on the control panel or specify them in the sample program. (For 
more information, refer to How to …: Creating and Modifying Programs 

 Creating a Program.) This might be a good starting point: 
 ; Standard 10 µl syringe. 
 ; Injection Volume: 1.0 µL. 
 PreInjCleanVol = 10.0  
 PreInjCleanCycA = 3  
 CleanCycles = 1  
 PostInjCleanCycC = 0  
 ; PostInjCleanVol = 10.0  
 PullUpCount = 6  
 PullUpDelayTime = 2.0  
 AirVolume = 3.0  
 FillingVolume = 5.0  
 AspirationSpeed = 100  
 InjectionSpeed = 100  
 PreInjDelayTime = 1  
 PostInjDelayTime = 2 
 
For the commands supported for these instruments and for additional tips, 
refer to: 

 Fisons AS800/ThermoQuest AS2000 Autosamplers 

 Troubleshooting 

The Administrator Help section provides installation details; refer to 
Hardware Installation: 

 Fisons AS800 GC Autosampler  

 Thermo Finnigan/TQ/TSP AS2000 GC Autosampler 
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 Fisons AS800/ThermoQuest AS2000: Troubleshooting 

 Note:  
If an error occurs during operation, for example, excessive sample volume, 
the error is displayed on the instrument only. To continue the analysis, 
confirm the error message directly on the autosampler by pressing the 
<Enter>. This is possible after the autosampler keycard has been unlocked 
in Chromeleon. Use either the Disconnect command or the 
KeycardUnlocked command. Better yet: Disconnect the autosampler, 
turn it off and on again, wait until the autosampler is ready, and then 
reconnect the unit (see ⇒Connect). 
 
Error Description  Remedial Action 

Missing vial The following messages 
appears on the instrument's 
display: 
End Sample 
Total Injections 0 

In addition, Chromeleon waits 
forever for an inject response. 

Abort the batch. 

Bad vial After some retries, a message 
like this appears on the 
instrument's display: 
PLG NDL INJ TUR CNTR 
--- BSY --- ---   * 

This happens quite easily if 
the vials are not perfectly 
crimped.  

Disconnect the autosampler and 
press the EXIT key (on the 
autosampler's keycard). When 
prompted whether to pause, 
continue, or abort the sample, 
select Abort. Abort the batch and 
reconnect. 

Illegal parameter (e.g., 
Volume/ 
Position > Max or Air + 
Sample Volume > Max) 

An error message appears on 
the autosampler's display. 

Disconnect the autosampler. 
Press the autosampler key, as 
necessary. 

Continuous beep and 
display cleared 

Severe damage may occur 
(destroyed syringe, vials etc.)! 

Turn off the autosampler 
immediately! 

Strange behavior of any 
other kind 

 Disconnect the autosampler, turn 
it off and on again, wait until it is 
ready, and reconnect.  

For the commands supported for these instruments and for additional tips, 
refer to: 

 Fisons AS800/ThermoQuest AS2000 Autosamplers 

 Program Example 
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Gilson: Commands and Tips 

For information about the special commands that Chromeleon supports for 
the different Gilson devices and for tips for practical operation, refer to: 

 Gilson 321 and 322 Pumps 

 Gilson 333 and 334 Pumps 

 Gilson 202 Fraction Collector (Ext.)/204 Fraction Collector 

 Gilson: Injection Modes 

 Gilson 156 UV/VIS Detector 

 Gilson 321 and 322 Pumps 
In addition to the standard pump commands (see Commands for 
Controlling Dionex Devices  Dionex Pumps), the following commands 
and properties are available (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Property 
 

(Min/Max) 
Values 

Description 
 

ModelNo N/A Indicates the model number of the pump 
(read-only) 

Firmware Version x.xx Indicates the pump's firmware version 
(read-only) 

ChartOut (321 only) Possible values: 
Pressure, Flow, 
Percentage %A, 
%B 

Determines the property to be monitored 
via the digital output (pin no. 9). 

   
Pump Properties    

%A_RefillTime, %B_RefillTime  125 –1000 ms  Determines how long the piston takes to 
return to its initial state. Enter a higher 
value in case of cavitation. 

%A_LiquidCompr 
%B_LiquidCompr  

0 – 2000 1/Mbar Determines the solvent compressibility. 
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Prime Commands    
StartPriming PumpHead 

parameter 
(possible values: 
RightHead, 
LeftHead) 

Starts a priming sequence for the 
specified pump head. 
Note: After performing the StartPriming 
command, no other command or property 
is allowed until the StopPriming 
command was performed. 

StopPriming - Finishes a running priming sequence.    
Maintenance Counters    

Right_PistonSeal, 
Left_PistonSeal  

0 - 65534 h Maintenance counter for the right or left 
piston seal (read-only) 

Right_Piston, Left_Piston 0 - 65534 h Maintenance counter for the right or left 
piston (read-only) 

Right_OutletValve, 
Left_OutletValve 

0 - 65534 h Maintenance counter for the right or left 
outlet valve (read-only) 

Right_InletValve, 
Left_InletValve 

0 - 65534 h Maintenance counter for the right or left 
inlet valve (read-only) 

Right_Actuator, Left_Actuator 0 - 65534 h Maintenance counter for the right or left 
actuator (read-only) 

Further Information 

 Tip:   

For more information, for example, about the empirical compressibility 
correction values for the Gilson 321 and 322 pumps, refer to the pump's 
User's Guide. 

For information about how to install these pumps, refer to Hardware 
Installation  Gilson 321 and 322 Pumps: Installation in the 
Administrator Help section. 
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 Gilson 333 and 334 Pumps 
In addition to the standard pump commands (see Commands for 
Controlling Dionex Devices  Dionex Pumps), the following commands 
and properties are available (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Property 
 

(Min/Max) 
Values 

Description 
 

ModelNo N/A Indicates the model number and firmware 
version of the master pump (read-only) 

ChartOut Possible values: 
Pressure, Flow, 
Percentage %A, 
%B, %C 

Determines the property to be monitored 
via the digital output (pin no. 9). 

   
Selection of Predefined Solvents    

%A_UseSolvent 
(%B_UseSolvent, 
%C_UseSolvent; only 
available if a second/third 
pump is installed)  
The property is visible only if 
the SVB is enabled for the 
pump. 

Possible values: 
Solvent1-
Solvent4 

Determines which solvent is used when 
the Solvent Valve Block (SVB) is installed 
for the pump. 

%A_Type, %B_Type, 
%C_Type  
(%B_… and %C_…; only 
available if a second/third 
pump is installed) 
If the SVB is enabled for a 
pump, e.g., A, four properties 
are available for this pump: 
%A1_Type … %A4_Type  

Possible values: 
Custom or one of 
the predefined 
solvents of the 
Gilson 333 pump.

Indicates the type of the used solvent. If 
you change this property, the ..._K0 and 
..._X0 properties (see below) are also 
changed unless the setting is Custom. 

%A_K0, %B_K0, %C_K0 
(%B_… and %C_ …; only 
available if a second/third 
pump is installed) 
If the SVB is enabled for a 
pump, e.g., A, four properties 
are available for this pump: 
%A1_K0 … %A4_K0 

0 … 2000 1/Mbar Specifies the empirical compressibility 
correction K0 for the selected solvent (for 
the Gilson 333 and 334 pumps, refer to 
the Reference Information section of the 
pump's User's Guide). This value can 
only be changed if the corresponding 
Type property is set to Custom. The 
value is adapted again if the Type 
property is reset to a value other than 
Custom.  
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Property 
 

(Min/Max) 
Values 

Description 
 

%A_X0, %B_X0, %C_X0 
(%B_… and %C_…; only 
available if a second/third 
pump is installed) 
If the SVB is enabled for a 
pump, e.g., A, four properties 
are available for this pump: 
%A1_X0 … %A4_X0 

0 … 2000 1/Mbar Specifies the liquid compressibility X0. 
This value can only be changed if the 
corresponding Type property is set to 
Custom. The value is adapted again if 
the Type property is reset to a value other 
than Custom.  

‘Type’ sub-property of the %A 
(%B, %C) property 

Possible values: 
Custom or one of 
the predefined 
solvents of the 
Gilson 333 pump 

This type refers to the currently selected 
solvent of a pump. If you change this 
property, e.g., for pump %A, the type of 
the selected solvent is changed as well. 
For example, if %A_UseSolvent=Solvent2 
the %A2_Type is also changed (plus the 
compressibility, unless the Type setting is 
Custom.    

Maintenance Counters    
%A<x>Count_PistonSeal, 
<x>=’R’, ‘L’ 

0 - 65535 h Maintenance counter for the right (R) or 
left (L) piston seal (read-only) 

%A<x>Limit_PistonSeal, 
<x>=’R’, ‘L’ 

0 - 65535 h Counter limit for the right (R) or left (L) 
piston seal (read-only) 

%A<x>Count_Piston,  
<x>=’R’, ‘L’ 

0 - 65535 h Maintenance counter for the right (R) or 
left (L) piston (read-only) 

%A<x>Limit_Piston,  
<x>=’R’, ‘L’ 

0 - 65535 h Counter limit for the right (R) or left (L) 
piston seal (read-only) 

%A<x>Count_OutChkValve, 
<x>=’R’, ‘L’ 

0 - 65535 h Maintenance counter for the right (R) or 
left (L) outlet valve (read-only) 

%A<x>Limit_OutChkValve,  
<x>=’R’, ‘L’ 

0 - 65535 h Counter limit for the right (R) or left (L) 
outlet valve (read-only) 

%A<x>Count_InlChkValve, 
<x>=’R’, ‘L’ 

0 - 65535 h Maintenance counter for the right (R) or 
left (L) inlet valve (read-only) 

%A<x>Limit_InlChkValve, 
<x>=’R’, ‘L’ 

0 - 65535 h Counter limit for the right (R) or left (L) 
outlet valve (read-only) 

 Tip:   
For more information, for example, about the empirical K0 compressibility 
correction values for the Gilson 333 and 334 pumps, refer to the pump's 
User's Guide. 

For information about how to install these pumps, refer to Hardware 
Installation  Gilson 333 and 334 Pumps: Installation in the 
Administrator Help section. 
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 Gilson 202 Fraction Collector (Ext.)/204 Fraction 
Collector 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property (Min/Max) Values Purpose/Remarks 
ModelNo N/A Indicates the model number (for the Gilson 202 

including the firmware version; (read-only).  
FirmwareVersion N/A Indicates the firmware version  
ValvePosition Possible values:  

Drain and Collect 
Switches the fractionation valve to the Drain or 
Collect position (The property is available only if 
a fractionation valve is installed.) 

RackType Possible values: All 
Gilson 202 rack types  
+ Custom (user-defined 
setting) 

Indicates the used rack type, specified in the 
Server Configuration program (read-only). 

TubePosition Range: 1 … n.  
n depends on the rack 
type and the number of 
used racks (see Server 
Configuration program): 
n = number of racks * 
number of tubes per 
line * number of lines 

Moves the collect head to the specified position.  

MovementMode Possible values:  
normal and secure. 
Default: secure 

In Secure mode, the fractionation valve 
switches to the Drain position before the collect 
head starts moving and switches back to the 
Collect position when the tube position has 
been reached. If the fractionation valve is 
already in the Drain position, the instrument 
does not automatically switch to the Collect 
position. (The property is available only if a 
fractionation valve is installed.) 

 
Command Purpose/Remark 
Home Moves the collect head to the Home position (drain outlet) 
Next Moves the collect head to the next tube. If the collect head is positioned at 

the last tube, it moves to the first one. 
Drain If the rack type is code 10, the collect head is positioned over the central 

rack hole. For all other rack types, the fractionation valve is switched to 
the Drain position. (The property is available only if a fractionation valve is 
installed or if Code 10 is selected as the rack type.)  
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Further Information 

For information about how to install the Gilson 202 fraction collector with 
the Gilson 202 Fraction Collector (ext.) device driver and the Gilson 204 
fraction collector with the Gilson 204 Fraction Collector device driver, refer 
to nstallation Instructions  Gilson 202 Fraction Collector (Ext.)/204 
Fraction Collector: Installation in the Administrator Help section. 

 Gilson: Injection Modes 
Chromeleon supports the following injection modes: 
 
Mode Description 
Auto: Default setting. Depending on the injection volume, either the entire loop 

(Total Loop) or a section of it (Partial Loop) is filled with the sample. 
Total Loop: The entire injection loop is filled with the sample liquid; the injection 

volume therefore corresponds to the injection loop. 
If the syringe volume is larger than the loop volume, it is possible to use a 
higher volume than the loop volume (IntoLoopFactor > 1). The volume 
exceeding the loop volume is used to pre-wash the injection loop with the 
sample liquid. 
To prevent dilution effects, the volume extracted from the sample 
reservoir can be larger than the volume injected into the loop (Sample 
Factor>1). The sample liquid remaining in the syringe after the injection 
(= excessive volume) is then dispensed during the final wash cycle. 

V F V F VS I S S S≤ ≤* *  
VS : Sample volume 

FI : IntoLoopFactor 

FS : Sample Factor 
Partial Loop: Only a part of the injection loop is filled with the sample liquid. The 

injection volume is therefore smaller than the volume of the injection loop. 
To compensate for the dead volume between the injection port and the 
injection loop, it is possible to inject a small quantity of solvent after the 
sample. The volume of this injection can be specified under Push 
Volume. Please note: 

V V V VS S P I≤ + ≤  
VS : Sample volume 

VP : Push volume 

VI : Injection volume 
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Mode Description 
Centered Loop: 
(only for the 235 
Autosampler) 

Only a part of the injection loop is filled with the sample liquid. Solvent is 
drawn into the injection loop before and after the sample. Contrary to the 
Partial Loop injection mode, the entire content of the injection loop is 
injected. 

Custom: With the setting Custom, only the injection valve is switched to Inject. 
The user must perform any other steps.  

 Gilson 156 UV/VIS Detector 
In addition to the standard detector commands (see Commands for 
Controlling Dionex Devices  Dionex Detectors), the following 
commands and properties are available (please note that the display 

Filter level determines which commands and properties are displayed): 
 
Property Min/Max Description 
 
ModelNo N/A Indicates the model number (read-only).  
FirmwareVersion N/A Indicates the firmware version (read-only).  
VisLampAge  Age of the VIS lamp 

VisLampAge.Value 0 .. 9999 [h] Current value  
The allowed input is to reset the value to 0. 

VisLampAge.UpperLimit 0 .. 9999 [h] Upper limit 
If the burning hours exceed the upper limit, an 
error message appears. Enter 0 to disable this 
check.  

UVLampAge  Age of the UV lamp 
UVLampAge.Value 0 .. 9999 [h] Current value  

The allowed input is to reset the value to 0. 
UVLampAge.UpperLimit 0 .. 9999 [h] Upper limit 

If the burning hours exceed the upper limit, an 
error message appears. Enter 0 to disable this 
check.  

LampSaver On / Off Set to On to have Chromeleon automatically 
turn off a lamp that is not used. This may 
increase the lamp's lifetime.  

Reference -9999999 .. 
9999999  

Indicates the current of the reference 
absorption in µFS (µ full scale; read-only). This 
value is for control only and not for data 
acquisition.   
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Property Min/Max Description 
LampIntensity -9999999 .. 

9999999  
Indicates the measured absorption current in 
µFS (µ full scale; read-only). This value is for 
control only and not for data acquisition.   

Mode single / dual Toggle between single-channel and dual-
channel mode.  

Channel Characteristics 
Property Min/Max Description 
 
Wavelength 190 .. 700 [nm] Wavelength at which the channel records the 

signal.  
Response 0.0 / 4.0.. 99.0 

(single mode) 
4.0 .. 99.0   
(dual mode) 

Time in seconds required by the detector until 
the signal reaches 98% of full scale. (Note: In 
single mode, the minimum value can be 0.0 s.) 

 
Range 0.001 .. 2.000 Measuring range in [AU]  
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Kontron (Bio-Tek): Commands and Tips 

For information about the special commands that Chromeleon supports for 
the different Kontron devices, refer to: 

 Kontron 465 Autosampler 

 Kontron SFM 25 Fluorescence Detector 

 Kontron 465 Autosampler 

In addition to the standard autosampler commands (see  Dionex 
Autosamplers), Chromeleon supports the following Kontron 465 
commands for pre-column derivatization (please note that the display 

Filter level determines which commands and properties are displayed). 
Also, refer to the information in the manual shipped with the instrument. 
 
Command Description 
StartPosition Returns to the start position. 
GetReagent The reagent is withdrawn from a pre-defined position. 
Mix Mixes the reagents. 
AddReagentAndMix The reagent is added and mixed with the sample. 
AirSegment Draws an air segment.   
Parameter Description 
ReagentPosition Position of the reagent. 
ReagentVolume Reagent volume to be used.  
AirVolume Air volume to be drawn up after pulling the syringe needle out of the 

vial. 
MixingVolume Mixing volume.  

 Tip: 
The prerequisite for controlling this instrument is that the Extended Device 
Control feature must licensed on your system. 

For more information, refer to Hardware Installation  Kontron 
Autosamplers in the Administrator Help section. 
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 Kontron SFM25 Fluorescence Detector 
Chromeleon supports the following special commands and parameters for 
the Kontron SFM25 Fluorescence Detector (please note that the display 

Filter level determines which commands and properties are displayed). 
Also, refer to the information in the manual shipped with the instrument. 
 
Command Description 
Autoblank Sets the zero value of the amplifying factor. 
Calibrate Sets the maximum value of the amplifying factor.   
Parameter Description 
HighVoltage Enter the maximum output voltage (100...999V). Pressing Calibrate 

command automatically sets the value of the voltage.  
Factor Enter the multiplying factor (0.01...10.00). Pressing Autoblank 

automatically calculates and stores the value. 
 

For more information, refer to Hardware Installation  Kontron SFM25 
Fluorescence Detector in the Administrator Help section. 
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Merck Hitachi: Commands and Tips 

For information about the special commands that Chromeleon supports for 
the different Merck Hitachi devices and for tips for practical operation, refer 
to: 

 LaChrom HPLC System: Tips 

 Merck Hitachi Pumps: Program Example 

 Merck Hitachi Autosamplers 

 Merck Hitachi AS4000: Program Example 

 Merck Hitachi LaChrom HPLC System: Tips  

Chromatogram (Detector) 
The detector allows negative signals to pass up to 250 mV only. Thus, 
Chromeleon displays negative signals only up to 250 mV, although the 
detector displays values up to 500 mV. 

Rack Display (Autosampler) 
If the rack you selected in the Server Configuration is not the one used in 
the current sequence, the Browser displays the wrong rack. 

 Merck Hitachi Pumps: Program Example 
To avoid overloading the Merck pumps with too fast a sequence of 
commands, allow for at least 0.1 min between the individual commands. 
For a program example for the L6200 pump, see below: 
 
-0.100 Pressure.LowerLimit =  0 
 Pressure.UpperLimit =  400 
 %A.Equate =  "%A" 
 %B.Equate =  "%B" 
 %C.Equate =  "%C" 
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;******* Detector commands: ****************  
 UV_VIS_1.Mode = UV 
 UV_VIS_1.Range = 0.200 
 UV_VIS_1.Response = 1.0 
 UV_VIS_1.Step =  Auto 
 UV_VIS_1.Average =  On 
 UV_VIS_1.Wavelength = 260 
 
 0.000 UV_VIS_1.Autozero 
 Flow = 1.000 
 %B = 10 
 %C = 0 
 Inject 
 UV_VIS_1.AcqOn 
 Flow = 1.000 
 %B = 10 
 %C = 0 
 
;The gradient starts after 0.1 minutes to avoid overload the pump 
with too fast a sequence of commands: 
0.100 %B = 10 
 
10.000 %B = 90 
 
15.000 %B = 90 
 
16.000 %B = 10 
 
30.000 UV_VIS_1.AcqOff 
 Flow = 1.000 
 %B = 10 
 %C = 0 
 
 End 
 

For an overview of the Merck Hitachi pumps (L6200/L6210 and L6250), 
refer to Hardware Installation  Merck Hitachi L6200/L6210 and L6250 
Pumps: Overview in the Administrator Help section. 
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 Merck Hitachi Autosamplers 

Supported Autosamplers 
For Autosampler…  …controlled via… …use device driver 
AS2000 RS-232 Merck Hitachi AS2000 Autosampler 
AS4000 RS-232 Merck Hitachi AS4000 Autosampler 
L7250 RS-232 Merck Hitachi L7250 Autosampler 
L7250 D-Line Merck Hitachi L7200/L7250 AS (D-Line) 
L7200 D-Line Merck Hitachi L7200/L7250 AS (D-Line)  

Supported Device Properties  

In addition to the standard autosampler commands (see  Dionex 
Autosamplers), the Merck Hitachi autosampler support the following 
commands and properties (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Property AS2000 AS4000 L7250 L7200 
InjectPortWashs 0-20 0-20 0-20 0-20³ 
InjectPortWashSpee
d 

1 (Low) ... 
5 (High) 

1 (Low) ... 
5 (High) 

1 (Low) ... 
5 (High) 

1 (Low) ... 
5 (High)3 

NeedleWashs 1-20 1-20 1-20 1-20³ 
NeedleWashSpeed 1 (Low) ... 

5 (High) 
1 (Low) ... 
5 (High) 

1 (Low) ... 
5 (High) 

1 (Low) ... 
5 (High)³ 

WasteVolume Not supported Not supported 0-4000.0 µl 0-4000.0 µl² 
WashVolume 10.0-100.0 µl 10.0-1000.0 µl 10.0-1000.0 µl  
LeadVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl 0-500.0 µl² 
RearVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl 0-500.0 µl² 
FeedVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl 0-500.0 µl² 
DeadVolume 0-100.0 µl 0-1000.0 µl 0-1000.0 µl  
Syringe 0-100.0 µl 0-1000.0 µl 0-1000.0 µl  
InjectionMethod 0 (Compatibility) 

1 (Cut)  
2 (All) 

0 (Compatibil.)
1 (Cut)  
2 (All) 

0 (Compatibil.)
1 (Cut)  
3 (FullLoop) 

1 (Cut) ...  
3 (FullLoop)² 

SyringeSpeed 1 (Low) ... 
5 (High) 

1 (Low) ... 
5 (High) 

1 (Low) ... 
5 (High) 

 

NeedleDownSpeed 1 (Slow) ...  
2 (Fast) 

1 (Slow) ...  
2 (Fast) 

1 (Slow) ...  
2 (Fast) 

1 (Slow) ... 
2 (Fast) 

VolSyringe 1 (100µl) -  
2 (500 µl) 

1 (100 µl) -
5 (5000 µl) 

1 (100 µl) -
5 (5000 µl) 

Not supported 
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Property AS2000 AS4000 L7250 L7200 
PumpPlungerWash Not supported Not supported 0 (No) or 

1 (Yes) 
0 (No) or 
1 (Yes)³ 

VolOptionalSyringe Not supported 1 (100 µl) - 
5 (5000 µl) 

Not supported Not supported 

NumberOfDilutors Not supported 1 or 2 Not supported Not supported 
Dilutor Not supported 1 or 2 Not supported Not supported 
RackCode 1 - 16 1 - 16 1 - 16 Not supported 
⇒Volume 1 - 500.0 µl 1 - 5000.0 µl 1 - 5000.0 µl 1 - 500.0 µl 
⇒Position 1 - 100 1 - 200 1 - 200 1 - 200 
 
²  If one of these properties is set, all other settings that are marked with ² 

are set, too. Check the parameters sent to the autosampler with extra 
care.  

³ If one of these properties is set, all other settings that are marked with ³ 
are set, too. Check the parameters sent to the autosampler with extra 
care. 

 

Supported Device Commands 
 AS2000 AS4000 L7250 L7200 

⇒Connect (/Disc.) Supported Supported Supported Supported 
Disconnect Supported Supported Supported Not supported 
Aspirate (see 
⇒Draw) 

0 - 500.0 µl, 
Speed 

Dilutor, 0 - 
5000.0 µl, Speed 

0 - 5000.0 µl, 
Speed 

Not supported 

⇒Dispense 0 - 500.0 µl, 
Speed 

Dilutor, 0-
5000.0 µl, Speed 

0-5000.0 µl, 
Speed 

Not supported 

GotoTube 1 - 100, 
RackCode 

1 - 200, 
RackCode 

1 - 200, 
RackCode 

Not supported 

GotoWashPort Supported Supported Supported Not supported 
GotoInjectPort Supported Supported Supported Not supported 
MoveNeedle X:0-163.0 mm 

Y:0-68.0 mm 
Z:0-38.0 mm 

X:0-244.0 mm 
Y:0-163.0 mm 
Z:0-57.0 mm 

X:0-156.0 mm 
Y:0-156.0 mm 
Z:0-57.0 mm 

Not supported 

Height Z:0-38.0 mm Z:0-57.0 mm Z:0-57.0 mm Not supported 
GotoSyringePos 0 - 500.0 µl, 

Speed 
Dilutor, 0-
5000.0 µl, Speed 

0 - 5000.0 µl, 
Speed 

Not supported 

GotoSValvePos 0 (Bottle) or  
1 (Needle) 

Dilutor, 0 (Bottle) 
or 1 (Needle) 

0 (Bottle) or  
1 (Needle) 

Not supported 

GotoValvePos 0 (Inject) or  
1 (Load) 

0 (Inject) or  
1 (Load) 

0 (Inject) or  
1 (Load) 

Not supported 
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 AS2000 AS4000 L7250 L7200 
Home Supported Supported Supported Not supported 
Reset Supported Supported Supported Supported 
Wash Supported Supported Supported Not supported 
WashPumpPlunger Not supported Not supported Supported* Not supported 
Inject Supported - 

see below 
Supported - 
see below 

Supported - 
see below 

Supported 

Wash_X Supported - 
see below 

Not supported Supported - 
see below 

Not supported 

WashDil_X Not supported Supported - 
see below 

Not supported Not supported 

GotoOpValvePos Not supported Not supported 0 (Inject) or  
1 (Load)* 

Not supported 

 

Inject Programs 
AS2000 
AS4000 
L7250 

Depending on the current value of the Syringe device property, three different 
programs are internally executed during processing an ⇒Inject command. For 
AS2000 and L7250 the dilutor property always equals 1.  

 Syringe>0 GotoSyringePos SyringePos=0 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoSValvePos SValvePos=Bottle 
 Dilutor=<current value of property Dilutor> 
GotoSyringePos SyringePos=<current value of property  
 Syringe> 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoTube TubeNumber=<current value of property  
 Position> 
 RackCode=<current value of property 
 RackCode> 
Aspirate AspirateVol=<current value of property Volume> 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoInjectPort 
GotoValvePos ValvePos=Load 
GotoSyringePos SyringePos=0 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoValvePos ValvePos=Inject 
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 Syringe=0 GotoTube TubeNumber=<current value of property
 Position> 
 RackCode=<current value of property 
 RackCode> 
Aspirate AspirateVol=<current value of property 
 Volume> 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoInjectPort 
GotoValvePos ValvePos=Load 
GotoSyringePos SyringePos=0 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoValvePos ValvePos=Inject 

 Syringe<0 GotoValvePos ValvePos=Inject 
L7200 Based on the current parameter settings, the autosampler performs an injection. 

The Inject command transmits the vial number and the sample volume only.  

Wash Programs 
AS2000 
AS4000 
L7250 

This is the program that is run when the extended wash command (Wash_X 
resp. WashDil_X) is executed. For AS2000 and L7250 the dilutor property 
always equals 1.  
GotoWashPort 
GotoSValvePos SValvePos=Bottle 
 Dilutor=<current value of property Dilutor> 
GotoSyringePos SyringePos=<current value of property Syringe> 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoSValvePos SValvePos=Needle 
 Dilutor=<current value of property Dilutor> 
GotoSyringePos SyringePos=0 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
GotoInjectPort 
GotoSValvePos SvalvePos=Bottle 
 Dilutor=<current value of property Dilutor> 
GotoSyringePos SyringePos=<current value of property Syringe> 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 
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 GotoSValvePos SValvePos=Needle 
 Dilutor=<current value of property Dilutor> 
GotoSyringePos SyringePos=0 
 Speed=<current value of property Speed> 
 Dilutor=<current value of property Dilutor> 

L7200 not supported  
The Administrator Help section provides more information about the 
different autosampler types; refer to Hardware Installation:  

 Merck Hitachi AS2000 and AS4000 Autosamplers: Overview  

 Merck Hitachi L7250 Autosampler: Overview  

 Merck Hitachi L7200 Autosampler: Overview  

 Merck Hitachi AS4000: Program Example  
To avoid stressing the Merck Autosamplers with a fast succession of 
commands, allow at least 0.1 min between the individual commands. A 
program example for the AS4000 could look as follows: 
 
;******* Pump Commands: ****************  

Pressure.LowerLimit =  2 
 Pressure.UpperLimit =  200 
 %A.Equate =  "Water" 
 %A.Type =  Automatic 

 
;******* Detector Commands: ****************  
 UV_VIS_1.Wavelength =  254 
 UV_VIS_1.Bandwidth =  1 
 UV_VIS_1.Step =  0.20 
 UV_VIS_1.Average =  On 
 UV_VIS_1.RefWavelength =  600 
 UV_VIS_1.RefBandwidth =  1 
 
 Flow = 0.300 
 



 Commands and Tips for Third-Party Devices 967 

;******* Autosampler Commands: ****************  
;(Allow for at least 0.1 min between the individual commands to avoid 
stressing the autosampler with a rapid succession of commands) 
-2.100 Home  
 Wash 

 
-1.600 LeadVolume = 30.0 
-1.550 RearVolume = 30.0 
 
-1.500 Height Z = 0.0, NeedleSpeed = Fast 

Aspirate DilutorNumber = 1, SyringePos = 5.0, PlungerSpeed = 
VeryFast  

;Aspirate 5 µl air 
 
 GotoTube RackCode = 1, TubeNumber = Position  
;Go to the sample vial 

Aspirate DilutorNumber = 1, SyringePos = LeadVolume + Volume 
+ RearVolume, PlungerSpeed = VeryFast 

;Aspirate sample from sample vial 
 
 Height Z = 0.0, NeedleSpeed = Fast 
 Aspirate DilutorNumber = 1, SyringePos = 5.0, PlungerSpeed = 

VeryFast  
;Aspirate 5 µl air 
 
-1.000 GotoWashPort  
;Wash outside of needle 
 
-0.500 GotoInjectPort 

Dispense DilutorNumber = 1, SyringePos = 5.0 + LeadVolume + 
14.9, PlungerSpeed = VeryFast 

;Dispense air + leadVolume + dead volume 
 GotoValvePos ValvePos = Load 
 Dispense DilutorNumber = 1, SyringePos = Volume, 

PlungerSpeed = VeryFast  
;Dispense injection volume 
 
 Syringe = -1  

 
0.000 UV.Autozero 
 Inject 
 UV_VIS_1.AcqOn 
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;do not execute another program, Inject switches the valve only 
 GotoWashPort 
 Home 
 
8.000 UV_VIS_1.AcqOff 
  
 End 

 

The Administrator Help section provides more information about the 
different autosampler types; refer to Hardware Installation:  

 Merck Hitachi AS2000 and AS4000 Autosamplers: Overview  

 Merck Hitachi L7250 Autosampler: Overview  

 Merck Hitachi L7200 Autosampler: Overview  
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Perkin Elmer: Commands and Tips 

For information about the special commands that Chromeleon supports for 
the different Perkin Elmer devices and for tips for practical operation, refer 
to: 

 Autosystem (XL) and Clarus 500 GCs 

 TurboMatrix Headspace Sampler 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
Commands and Tips 
Chromeleon supports special commands for the Perkin Elmer Autosystem 
(XL) and Clarus 500 gas chromatographs. For more information, refer to: 

 General 

 Sampler 

 Inlet 

 Column 

 Detectors 

For application examples, refer to:  

 Changing the Syringe Type 
 PSplit Valve Control for PSS and CAP Inlets 
 Pressure and Flow Ramps 

If problems occur, refer to  Troubleshooting. 
 
For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 
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 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
General 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Values Description 
Data_Collection_Rate 1.625Hz, 3.125Hz, 

6.25Hz, 12.5Hz, 25Hz 
Sets the data collection rate. (Level: 
Advanced or higher)  

  Note: 
The property cannot be changed during 
data acquisition. 

EquilibrationTime 0 min 99.0 min in 
0.01 
increments 

After reaching the desired start values 
(temperature and/or flow), the GC waits 
for the equilibration time. When the 
equilibration time has passed, the GC is 
ready. 

FirmwareVersion n/a n/a Indicates the firmware version. (Level: 
Expert or higher). 

OvenReady Not 
Ready 

Ready Indicates whether the oven has reached 
the target temperature (read-only). 

RampState Initial,  
Time1, Ramp1, Time2, 
…, Ramp3, Time4, 
Unknown 

Indicates the current phase of the oven's 
temperature range (read-only; level: 
Advanced or higher). 

Ready Not 
Ready 

Ready Indicates whether the GC is ready for 
injection (read-only). 

RunState PowerUp,  
OvenOff,  
NotReady, Equilibration, 
PreRun,  
Ready,  
Running,  
Hold, Unknown 

Indicates the GC state (read-only; level: 
Advanced or higher). 

TempCtrl Off On Enables or disables temperature control 
for the oven. 

Temperature - - Properties related to the column oven. 

  Notes: 
A PGM File can include a maximum of 3 
temperature ramps. The temperature can 
be changed between 0 and 45°C. 
If a temperature is set, TempCtrl is 
automatically set to On. 
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Property Range/Values Description 
Temperature. 
Value 

-99°C - 450°C  Current temperature (read-only). 

Temperature. 
Nominal 

-99°C - UpperLimit Sets the nominal temperature. 

Temperature. 
UpperLimit 

50 - 450°C Sets the upper limit for the oven 
temperature.   

In addition, Chromeleon supports the following commands and/or 
properties if the Autosystem GC includes a PPC: 
 
Property Values Description 
PPCAlarm On or Off Enables or disables the PPC alarm. (Level: 

Advanced or higher) 
PPCVersion  Indicates the firmware part number and 

version of the PPC. (Level: Expert or higher) 
PressUnit kpa, psig, or bar Indicates the pressure unit used for the PPC 

settings. (Level: Advanced or higher; read-
only). Select the unit on the Components 
tab page in the Server Configuration 
program.  

For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 
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 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
Sampler 
The following commands and properties are available for autosampler 
control (please note that the display Filter level determines which 
commands and properties are displayed): 
 
Property Range/Values Description 
FillStrokes 0-15 Specifies how often the syringe is filled with 

sample before the syringe content is drawn 
for injection. (Level: Advanced or higher) 

InletPosition Injector1-Injector2  
(if available) 

Specifies the inlet used for the injection. 

PostWash 0-15 Specifies how often the syringe is filled with 
solvent and dispensed to the waste after the 
injection. (Level: Advanced or higher) 

PreWash 0-2 Specifies how often the syringe is filled with 
solvent and dispensed to the waste before 
the injection. (Level: Advanced or higher) 

Ready Ready/NotReady Set to Ready when the internal autosampler 
is ready for injection, i.e., when it has 
finished its prewash cycle. (Level: Advanced 
or higher) 

SampleWash 0-15 Specifies how often the syringe is filled with 
sample and emptied to the waste before the 
injection is performed. (Level: Advanced or 
higher) 

Status Unknown,  
Ready,  
Priority,  
Running,  
Sampling,  
Pause,  
Clean 

Indicates the current status of the 
autosampler (read-only; level: Advanced or 
higher). 

Syringe 0.1 -  50µl Indicates the syringe type (read-only). 
Chromeleon reads the type from the GC. 

SyringeSpeed Normal, 
Fast, 
OnColumn 

Sets the syringe speed for the injection: 
Normal: 1 s, Fast: 0.3 s, OnColumn: 7.5 s 

Visc_Delay 0-15 s Specifies the time in seconds that  the 
autosampler waits after the piston has 
moved back (can be set according to the 
sample's viscosity).  
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For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Inlet 
The following commands and properties are available for inlet control 
(please note that the display Filter level determines which commands and 
properties are displayed): 
 
Property Range/Values Description 
FollowOven On or Off (Only for PPS and POC injectors) If the 

property is set to On, the inlet temperature 
follows the oven temperature (+5°C).  

InletType PKD, CAP, GSV, 
PSSO, PSSI, POCI, 
POCO 

Indicates the inlet type (read-only): 
PKD: Packed column 
CAP: Capillary 
GSV: Gas Sampling Valve 
PSSO: Split/Splitless follow oven 
PSSI: Split/Splitless  
POCI: On Column  
POCO: On Column follow oven  

Ready Ready/NotReady Set to Ready when the inlet heating 
component is ready (level: Advanced or 
higher). (If a PPC is installed, the SplitStatus 
setting must also be Ready.) 

Status None 
Ready 
NotReady 
FilamentOver 
Unknown 

Indicates the current status of the associated 
heating component (read-only; level: 
Advanced or higher).  

TempCtrl On or Off Enables or disables temperature control for 
the inlet. 

Temperature Without PTR: 
100 - 450°C or  
50 - 450°C CAP/PKD 
(50 - 350°C for GSV) 

With PTR: -99 - 500°C 

Properties related to the column oven. 

  Note: 
If a temperature is set, TempCtrl is 
automatically set to On. 



974 Commands and Tips for Third-Party Devices 

Property Range/Values Description 
Temperature. 
Nominal 

 Sets the nominal temperature. For the PSSI 
and POCI, this command sets a temperature 
ramp, instead. A maximum of two inlet 
temperature ramps are allowed. 

Temperature. 
Value 

 Indicates the current temperature (read-only)  

 
In addition, Chromeleon supports the following commands and/or 
properties if the Autosystem GC includes a PPC: 
 
Property Values Description 
PurgeCtrlMode Auto, Fixed Sets the purge flow compensation mode 

(level: Advanced or higher). (For more 
information, refer to the manual for the 
instrument.) 

PurgeFlow 0.0 -100.0 ml/min Sets the split flow offset value to 
compensate the reduction of the split flow 
due to septum purge flow (level: Advanced 
or higher). (The property can be set only if 
PurgeCtrlMode = Fixed.) 

SplitCtrlMode Flow, Ratio Sets the split control mode. Specifies 
whether the flow or the flow ratio is 
controlled. 

SplitFlow 0 - 500 ml/min Sets the target value for the total split flow. 
(The property can be set only if 
SplitCtrlMode = Flow.)  

SplitRatio 1-6000 Sets the target value for the split ratio. (The 
property can be set only if 
SplitCtrlMode = Ratio.)  

SplitStatus NotUsed, Ready, 
NotReady, Alarm, 
Unknown 

Indicates the current split status (read-only; 
level: Advanced or higher). 

TotalSplitFlow 0 – 500 ml/min Indicates the current total flow (split flow + 
purge flow; read-only).  

For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 
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 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
Column 
The following commands and properties are available for column control 
(please note that the display Filter level determines which commands and 
properties are displayed): 
 
Property Range/Values Description 
Flow 0 - 99.99 ml/min (For SetPointUnit = flow) 

Flow. 
Nominal 

Observe the 
restrictions for 
ramps. 

Sets the target value for the gas flow. This does not 
include control: If the actual flow deviates too much 
from nominal flow, the column enters NotReady state. 

Flow 
Value 

 Indicates the current gas flow (read-only). 

GasType He, N2, H2, 
AR/CH4, Air 

Indicates the type of the used gas (as set in the 
Server Configuration program; read-only). 

PressureCtrl On or Off Turns gas pressure control on or off. 

Pressure 0-6.89 bar; 0-100 
psig; 0-689 kPa 
(The unit depends 
on the PPC 
pressure unit set in 
the Server 
Configuration 
program.) 

(For SetPointUnit = flow) Properties related to the gas 
pressure. 

Pressure. 
Nominal 

 Sets the nominal pressure. This does not include 
control: If the actual gas pressure deviates too much 
from the nominal pressure, the column enters 
NotReady state. 

Pressure. 
Value 

 Indicates the current pressure (read-only). 

Ready Ready or NotReady Indicates whether the carrier unit is ready. The carrier 
unit is ready when the set pressure (or flow or speed; 
set in the Server Configuration program) has been 
reached. (The property is read-only.) 

SetPointUnit None, psig, kPa, 
flow 

Indicates the value of interest and the unit used for 
observing the gas flow (read-only). The property can 
be set on only on the device.. 
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In addition, Chromeleon supports the following commands and/or 
properties if the Autosystem GC includes a PPC: 
 
Property Values Description 
CapCtrlMode On/Off (Only for PSS and CAP inlets) Enables or 

disables capillary column control (level: 
Advanced or higher). 

  Note: 
If CapCtrlMode is set to Off, FlowCtrlMode is 
set to Flow and SplitCtrlMode is set to Split 

(also, refer to  Inlet). 
Diameter 50 - 1000 µm Specifies the diameter of the capillary column 

(level: Advanced or higher). 
Flow 0 - 99.99 ml/min 

Observe the restrictions 
for ramps (see below ²) 

Properties related to the carrier flow. 

Flow.Nominal  (Only if CapCtrlMode is set to On and if 
FlowMode is set to Flow) Sets the nominal 
flow. 

Flow.Value  Indicates the current flow (read-only).  
FlowCtrl On/Off Enables or disables carrier flow. 
FlowMode for CAP, PSS :  

Off, PressOvenTrack, 
Flow, Velocity, Pressure 
For POC, PKD:  
Off, Pressure, Flow 

Sets the flow control mode (level: Advanced 
or higher). 

Length 1.00-200.0 m Specifies the length of the capillary column 
(level: Advanced or higher). 

Pressure 0-6.89 bar; 0-100 psig; 
0-689 kPa (The unit 
depends PPC pressure 
unit set in the Server 
Configuration program) 
Observe the restrictions 
for ramps (see below ²) 

 

Pressure.Nominal  (Only if CapCtrlMode is set to On and if 
FlowMode is set to Pressure) Sets the 
nominal gas pressure.  

Pressure.Value  Indicates the current gas pressure (read-
only): 

Ready Ready/NotReady Indicates Ready if the PPC is ready or if the 
specified carrier gas is not used (read-only). 
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Property Values Description 
Status NotUsed, Ready, 

NotReady, Alarm 
Indicates the current status of the PPC for the 
specified carrier gas. 

VacuumCorrection On/Off (Only for PPS and CAP inlets) Turns vacuum 
compensation on or off (level: Advanced or 
higher).  

  Note: 
This property can be set only if CapCtrlMode 
is set to On. 

Velocity 0 - 200.0 cm/s 
Observe the restrictions 
for ramps (see below ²) 

Properties related to the carrier flow. 

Velocity.Nominal  (Only if CapCtrlMode is set to On and if 
FlowMode is set to Velocity) Sets the nominal 
flow. 

Velocity.Value  Indicates the current speed (read-only)  
² Observe the following restrictions when you run ramps: 
• The single steps must be between 0 and 999. 

• A PGM File can include a maximum of 4 ramp commands, depending 
on the FlowMode settings: Flow, Pressure, or Velocity). 

• Maximum ramp steepness: 

o Pressure ramps: 0-6.89 bar/min or 0-99.9psig/min 

o Flow ramps: 0-99.99 ml/min² 

o Speed rams: 0-200.0 cm/(s·min) 
 
For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 
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 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
Detectors 
The following commands and properties are available for detector control 
(please note that the display Filter level determines which commands and 
properties are displayed): 
 
Property Range/Values Description 
Attenuation 1, 2, 4, 8, 16, 32, 64, 

(and 128, 256, … 
65536 if Output is set 
to Recorder in the 
Server Configuration 
program)) 

Sets the detector attenuation.²  

AZCompensation On or Off Enables or disables the Autozero-option.²  
DetectorType Output, FID, ECD, TCD Indicates the detector type (read-only). Select 

the detector type in the Server Configuration 
program: 
FID: Flame Ionization Detector 
ECD: Electron Capture Detector 
TCD: Thermal Conductivity Detector 

FlameThreshold 0.00-9.99 mV Flame threshold for evaluating whether the 
detector flame is lit. If the signal exceeds this 
value, the GC assumes that the flame is lit. 
Otherwise, the flame is ignited automatically. 
(Level: Advanced or higher) 

Range 1, 20  
(FID) 
1 (ECD) 
-4 - 4 (TCD) 

Sets the detector output range.²  

Ready Ready or NotReady Indicates whether the detector is ready (read-
only; level: Advanced or higher). If a PPC is 
installed, the status of the gas flows is taken 
into account, also. 

Retention 0 - 10^8 min Indicates the retention time. 
Signal -10000  - 10000mV  Indicates the current signal value (read-only). 
Status None, Ready, 

NotReady, 
FilamentOver, Unknown

Indicate the detector status (read-only; level: 
Advanced or higher). 

TempCtrl On/Off Turns the heating component of the detector 
on or off. 
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Property Range/Values Description 
Temperature 100-450°C  

(FID, ECD 
100-350°C (TCD) 

Properties related to the detector 
temperature. 

  Note: 
If a temperature is set, TempCtrl is 
automatically set to On.  

Temperature. 
Nominal 

 Sets the nominal temperature. 

Temperature. 
Value 

 Indicates the current temperature (read-only) 

TimeConstant 50 ms (not for the 
ECD), 200ms, 800ms 

Specifies the time constant for the noise filter 
of the related detector.  

² If the value is entered manually or at time t=0, the value used at the 
beginning of the run is adapted. 

 Tip:  
If a value is entered at another time, this value remains valid until the next 
setting or the beginning of the next GC run. 

In addition, Chromeleon supports the following commands and/or 
properties if the Autosystem GC includes a PPC: 
 
Property Values Description 
<Gasname> 0–500 ml/min <Gasname> is the gas specified on the 

Detectors tab page in the Server 
Configuration program, e.g., He, N2, H2, 
Ar/CH4, or Air. 

 Note: 
You can enter the gas name on the 
Detectors tab page in the Server 
Configuration program. 

<Gasname>. 
Nominal 

 Sets the nominal flow for the associated gas 
(level: Advanced or higher).  

<Gasname>. 
Value 

 Indicates the current flow for the associated 
gas (read-only; level: Advanced or higher). 

<GasName>_Ctrl On/Off  
<GasName>_GasTy
pe 

He, N2, H2, Ar/CH4, Air Indicates the gas type in the PPC module 
(read-only; level: Advanced or higher). Note: 
The gas type is set in the Server 
Configuration program. 
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Property Values Description 
<GasName>_Status NotUsed, Ready, 

NotReady, Alarm 
Indicates the current status in the PPC 
module (read-only; level: Advanced or 
higher).  

For an overview of the Autosystem GC series and Clarus 500, refer to 
nstallation Instructions: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
Changing the Syringe Type 
You may change the syringe type for the internal autosampler without the 
need to reconfigure the device driver in the Server Configuration program: 

1. Disconnect the GC in Chromeleon (Disconnect command). 

2. Exchange the syringe, as described in the instrument's manual. 

3. Set the new syringe type on the GC's display, as described in the 
instrument's manual. 

4. Reconnect the GC in Chromeleon (Connect command). Verify that the 
Syringe property of the internal autosampler indicates the correct type. 

 
For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 
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 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Split 
Valve Control for PSS and CAP Inlets 
If you have a Perkin Elmer capillary split inlet installed, the GC cannot 
control the split valve automatically, neither with split programs nor with 
splitless programs. To control the split valve manually, enter the initial value 
and operate the valve during analysis. Please note: CAP = not 
programmable, PSS = programmable.   

In split mode, the split valve remains open during the entire analyzing 
process (the usual setting in Chromeleon is Split1 or Split2, for inlets 1 or 
2). Therefore, it is sufficient to set the valve to On at the retention time 
0.000 min.  
 . . .  
0.000 Split1.On  

Inject 
GC_1.AcqOn 
. . .  

In Splitless mode, the split valve remains closed during injection and is 
opened afterward; e.g.: 
-0.500 Split1.Off  ;(optional) 
0.000 Split1.Off  ;(necessary) 
 Inject 
 GC_1.AcqOn 
 . . .  
1.000 Split1.On ;(enables the split flow to purge the inlet) 
 . . . 
2.000 GC_1.AcqOff 
 
For more information about how to control the various split modes, refer to 
the Perkin Elmer operating manuals for the instruments. 

For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 
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 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
Pressure and Flow Ramps 
Programming pressure ramps is very similar to programming temperature 
ramps. Different modes available for controlling the pressure of the carrier 
gas and the inlet but not all possible combinations are allowed. Therefore, 
Dionex recommends specifying the various properties in each PGM file. 
Ready Check then verifies whether the various PGM settings represent a 
valid combination. 

The examples below show common combinations for a PPC column and a 
capillary inlet with a pressure controlled split flow. For more information, 
refer to PPC Fundamentals in the Perkin Elmer operating manual for the 
instrument. 
 
Constant Pressure/pressure ramps for PPC columns: 
 
 GC_1.TempCtrl =  On 
 GC_1.Temperature.Nominal =  100 
  
 ; setting of the pressure modes 
 Column_1.CapCtrlMode = On 
 Column_1.FlowMode = Pressure 
 Column_1.VacuumCorrection = Off 
 . . .  
 
 0.000 Column_1.Pressure = 10.0 
 Wait GC.Ready 
 Inject 
 GC_1.AcqOn 
 Column_1.Pressure = 10.0 
 
 0.500 Column_1.Pressure = 10.0 ; pressure ramp 
 
 1.500 Column_1.Pressure = 15.0 ; pressure ramp 
 
 2.000 Column_1.Pressure = 15.0 ; pressure ramp 
 GC_1.AcqOff 

End 
 
In PressOvenTrack mode, you can define pressure modes that follow the 
oven temperature to hold the column flow constant. In this mode, you may 
enter only an initial pressure value: 
 
 . . .  
 ; setting of the pressure modes: 
 Column_1.CapCtrlMode = On 
 Column_1.FlowMode = PressOvenTrack 
 Column_1.VacuumCorrection = Off 
 . . .  
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 0.000 Column_1.Pressure = 10.0 ; initial pressure value 
 Wait GC.Ready 
 Inject 
 GC_1.AcqOn 
 . . .  
2.000 GC_1.AcqOff 
 End 
 
Use the following modes to realize flow and velocity ramps:  
Column_1.FlowMode = Flow 

and 
Column_1.FlowMode = Velocity. 
 
Split flow control allows you to run step gradients, to specify the absolute 
flow, or to define the split ratio. For a split injection in a flow-controlled 
program (flow mode), refer to the example below. In the example, the split 
flow is increased after 0.5 minutes. (For more information on split and 
splitless injection techniques, refer to the Perkin Elmer operating manual for 
the instrument.) 

. . .  
; setting of the pressure modes 
 Column_1.CapCtrlMode = On 
 Column_1.FlowMode = Pressure 
 Column_1.VacuumCorrection = Off 
 Injector_1.SplitCtrlMode = Flow   

; uses absolute split flow 
 Injector_1.PurgeMode = Fixed  

; uses a fixed purge flow 
 Injector_1.PurgeFlow = 6.0 

; sets the purge flow to 6.0 ml/min 
 . . .  
; Program 
 0.000 Column_1.Pressure = 10.0 
 Valve1.On       

; split valve is open 
 Injector_1.SplitFlow =  50.0  

; sets the initial split flow 
 Wait GC.Ready 
 Inject 
 GC_1.AcqOn 
 Column_1.Pressure = 10.0 
 0.500 Column_1.Pressure = 10.0; pressure ramp 
 Injector_1.SplitFlow = 200.0 ; increases the split flow 
 1.500 Column_1.Pressure = 15.0; pressure ramp 
 2.000 Column_1.Pressure = 15.0; pressure ramp 
 GC_1.AcqOff 

End 
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For an overview of the Autosystem GC series and Clarus 500, refer to 
Hardware Installation: Installing and Controlling Third-Party Devices 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 
For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 

 Perkin Elmer Autosystem (XL) and Clarus 500 GCs: 
Troubleshooting  
Problem: Missing Connection 
It is not possible to connect the GC with Chromeleon, e.g., with a panel. 

Explanation: 
Each time you connect the GC, the driver compares the actual 
configuration with the configuration entered in the Server Configuration 
program. If those configurations do not match, the connection cannot be 
established.  

Solution: 
Change the settings in the Server Configuration program according to the 
installed hardware. 
 
Problem: Missing vials 
It depends on the instrument whether you the cause for the error is 
eliminated automatically (Clarus 500) or whether it must be eliminated 
manually (Autosystem (XL)): 

Autosystem (XL):  
Chromeleon cannot remedy the situation automatically. The GC stops 
sample processing but remains in Ready state. Chromeleon remains in 
Waiting for inject response state. 

Solution: 
Abort and restart the batch. 
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Clarus 500:  
Chromeleon automatically remedies the situation for the Clarus 500. An 
error message is logged in the Audit Trail. Chromeleon skips the sample 
and continues processing with the next sample. The status for the missing 
sample is Interrupted. 

 Note:  
If a wash vial or a waste vial is missing, Chromeleon automatically aborts 
the batch because the remaining samples are affected as well. Correct 
execution of the analysis cannot be guaranteed. Place the missing wash or 
waste vial on the rack and restart the batch. 

For an overview of the Autosystem GC and Clarus 500, refer to Hardware 
Installation: Installing and Controlling Third-Party Devices  Perkin 
Elmer Autosystem (XL) and Clarus 500 GCs: Overview in the 
Administrator Help section. 

For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Perkin Elmer Autosystem (XL) and 
Clarus 500 GCs: Installation in the Administrator Help section. 
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 Perkin Elmer TurboMatrix Headspace Sampler: 
Commands and Tips 
Chromeleon supports special commands for the Perkin Elmer TurboMatrix 
Headspace sampler; refer to  

 State 

 Options 

 Temperatures 

 Time Programs 

 Oven 

 Pressure 
 
For more information, practical examples, and tips, refer to: 

 Single and Progressive Injection Modes 
 Program Example 
 MHE Mode 
 Tips 

 
For an overview of the Elmer TurboMatrix Headspace Sampler, refer to 
Installing and Controlling Third-Party Devices  Perkin Elmer 
TurboMatrix Headspace Sampler: Overview in the Administrator Help 
section. 
For installation details, refer to Installing and Controlling Third-Party 
Devices  Perkin Elmer TurboMatrix Headspace Sampler: Installation 
in the Administrator Help section. 
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 Perkin Elmer TurboMatrix Headspace Sampler: State 

In addition to the  General Commands described in the General 
Commands for Device Control section, the following commands and 
properties are available (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Property Range/Values Description 
Busy Busy or Idle Busy indicates that the device driver still has to 

send commands to the sampler or that the 
commands are not yet performed completely (read-
only).  

DeviceState Indicates the state in which the sampler is (read-only): 

 Initializing 
Standby 
Preparation 
Equilibration 
GCNotReady 
Thermostating 
Pressurizing 
ExtThermostat 
Injecting 
WaitingForWithdraw 
 
Venting 
Analyzing 
RunBackflush 
Finishing 
BackflushCal 
GasLeakTest 
Error 
EconomyMode 
CryoFocus 
ValveLeakTest1 
ValveLeak_Test2 
Unknown 

The sampler is initializing (start/reset). 
The sampler is idle. 
The sampler prepares for a new run. 
The sampler performs equilibration. 
The GC is not ready for operation. 
The sampler is thermostating. 
Pressure is build up. 
Thermostating is exceeded. 
The sampler is performing an injection. 
Time between the end of the injection and the 
withdrawal of the needle. 
The sample is being vented. 
A sample analysis is in progress. 
Backflushing is performed. 
The sample run is finished. 
Backflush calibration is performed. 
A gas leak test is performed. 
A fault or error has occured. 
The sampler is in the economy mode. 
A cryo focus test is performed. 
The first valve leak test is performed. 
The second valve leak test is performed. 
Unknown. 

 Chromeleon does not yet support the following states 

 PressurizeVial 
DecayPressToTrap 
TrapDesorb 
TrapHold 
TrapDryPurge 
TrayGCAnalysis 
InsertNeedle 
RemoveNeedle 
TrapLeakTest 

The vial is being pressurized (cryo trap). 
The pressure buildup in the cryo trap is decayed. 
Desorption of the trap. 
The cryo trap process is hold. 
The cryo trap is being purged. 
A GC analysis of the tray is performed. 
The needle is inserted. 
The needle is removed. 
A trap leak test is performed. 
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 Tip:   

Please refer to the instrument manual for more information about the State 
properties. 
 
For more commands and properties that Chromeleon supports for the 
TurboMatrix Headspace sampler, refer to: 

 Options 

 Temperatures 

 Time Programs 

 Oven 

 Pressure 

 Perkin Elmer TurboMatrix Headspace Sampler: Options 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Value Description 
CryoFocus Off, On Enables or disables cryo cooling. (This property is 

available only if cryo cooling is installed on the device 
and configured in Chromeleon.) 

FlowRate 0.01 - 50 ml/min Determines the expected flow rate. The sampler uses 
this setting to calculate the time required for injecting 
the specified volume. 

InjectMode Single, 
Progressive, 
MHE 

Determines the injection mode. For more information, 
refer to: 

 Single and Progressive Injection Modes 

 Program Example 

 MHE Mode 
InjectionsPerVial 1 - 9 Specifies the number of injections to be performed from 

the same vial. 

InjectWaitTime  Indicates the time between the Inject command in 
Chromeleon and the response to Chromeleon from the 
autosampler (read-only). 
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Property Range/Value Description 
Position  

 
1 - 16 
1 - 40 
1 - 110 

Indicates the sample position (read-only). The position 
is set in the sequence; it depends on the type: 
TM16 
TM40 
TM110 

Shaker Off, On Enables or disables the shaker. (This property is 
available only if the shaker is installed on the device 
and configured in Chromeleon.) 

VentingTime 1 - 60s Specifies how long the vial is vented.  

VialVenting Off, On Specifies whether the vial is vented.  

Volume 0 - 9.99 ml Indicates the injection volume (read-only). The injection 
volume is set in the sequence.  

WaterTrap Off, On Enables or disables the water trap. (This property is 
available only if cryo cooling is installed on the device 
and configured in Chromeleon.) 

 

 Tip:   

Please refer to the instrument manual for more information about the 
Options properties. 

For more commands and properties that Chromeleon supports for the 
TurboMatrix Headspace sampler, refer to: 

 State 

 Temperatures 

 Time Programs 

 Oven 

 Pressure 
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 Perkin Elmer TurboMatrix Headspace Sampler: 
Temperatures 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Values Description 
CryoTemperature  Properties for the cryo cooling temperature. (The 

properties are available only if Cyro-Focus is 
installed on the device and configured in 
Chromeleon.) 

CryoTemperature. 
Nominal 

-180 to -10°C Sets the nominal temperature for cryo cooling. 

CryoTemperature. 
Value 

-180 to -10°C Reports the current temperature of the cryo 
cooling (read-only).  

FollowOven On or Off (Name on the sampler: Track Oven) 
If the property is set to Off, you can set 
NeedleTemperature, OvenTemperature, and 
TransferTemperature separately. 
Setting the property to On defines the 
OvenTemperature. Any settings for the  
NeedleTemperature and TransferTemperature 
are ignored. The target temperature for the 
needle heating and the transfer temperature is 
automatically set to a value that is 5°C higher 
than the OvenTemperature. 

NeedleTempCtrl On or Off Enables or disables needle heating. 
NeedleTemperature  Properties related to the temperature for the 

needle heater (when FollowOven is set to Off). 

  Note: 
NeedleTempCtrl is automatically set to On when 
the corresponding temperature command is 
performed. 

NeedleTemperature. 
Nominal 

35 to 210°C Sets the target temperature for needle heating. 

NeedleTemperature. 
Value 

35 to 210°C Indicates the actual needle temperature (read-
only). 

OvenTempCtrl On or Off Turn the incubation oven on or off. 
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Property Range/Values Description 
OvenTemperature  Properties related to the temperature of the 

incubation oven. 

  Note: 
OvenTempCtrl is automatically set to On when 
the corresponding temperature command is 
performed. 

OvenTemperature. 
Nominal 

35 to 210°C Sets the target temperature for the incubation 
oven. 

OvenTemperature. 
Value 

35 to 210°C Indicates the current temperature of the 
incubation oven (read-only). 

TransferTempCtrl On or Off Enables or disables transfer line heating. 
TransferTemperature  Properties related to transfer line heating (when 

FollowOven is set to Off). 

  Note: 
TransferTempCtrl is automatically set to On 
when the corresponding temperature command is 
performed. 

TransferTemperature. 
Nominal 

35 to 210°C Sets the target temperature for transfer line 
heating. 

TransferTemperature. 
Value 

35 to 210°C Indicates the actual transfer line temperature 
(read-only). 

 
For more commands and properties that Chromeleon supports for the 
TurboMatrix Headspace sampler, refer to: 

 State 

 Options 

 Time Programs 

 Oven 

 Pressure 
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 Perkin Elmer TurboMatrix Headspace Sampler: Time 
Programs 
The following commands and properties are available (range: 0.1 to 999.9 
min; please note that the display Filter level determines which commands 
and properties are displayed): 
 
Property Description 
GCCycleTime Sets the GC cycle time (on the device: cycle time). The range 0.1 to 

999.99 min. The GC cycle time is the minimum time between the start of 
a GC run and the time when the GC is ready for the next injection. 

  Note: 
A error message appears when the GC cycle time is shorter than the time 
between two injections (PGM end time for the current sample and PGM 
start time for the next sample). 

IncubationTime Sets the incubation time (on the device: Thermostatting Time and 
Thermo). The range is 0.1 to 999.99 min. 

InjectTime Indicates the injection time (read-only). The injection volume and the 
column flow allow you to determine the injection time. 

PostCryoTime If Cryo-Focus is installed on the device and configured in Chromeleon 
(CryoFocus = On), the parameter sets the time between the injection and 
the end of cooling (range: 0.1 to 99.99 min).  

PreCryoTime If Cryo-Focus is installed on the device and configured in Chromeleon 
(CryoFocus = On), the parameter sets the time between the start of 
cooling and the injection (range: 0.1 to 99.99 min).  

PreparationTime Indicates the estimated preparation time, i.e., the time until the next 
injection (read-only).  

PressTime Sets the time for sample pressurizing (on the device: Pressurization time 
and Pressurize). The range is 0.1 to 999.99 min. 

WithdrawTime Sets the time between the end of the injection cycle and the withdrawal of 
the needle from the sample (= venting). The range is 0.1 to 99.99 min.  

For more commands and properties that Chromeleon supports for the 
TurboMatrix Headspace sampler, refer to: 

 State,  Options,  Temperatures,  Oven, and  Pressure. 
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 Perkin Elmer TurboMatrix Headspace Sampler: Oven 
The oven supports 15 different positions for sample conditioning. A new 
sample is always placed at position 0. Injection is performed from position 
2. The following properties are available on the Expert Filter level: 
 
Property Range/Values Description 
_IncTime<i> -1000 to 1000 min If the oven position is occupied, the variable reports the 

remaining incubation time (read-only). 

_Occupied<i> Off, On Set to On if the oven position is occupied. If the position 
is free, the setting is Off. (This property is read-only.) 

_Vial<i> 0 to 14. 0=’Empty’ If the oven position is occupied, the variable reports the 
number of the related sample (read-only). 

 
Where:   <i> = 0 to 14 

For more commands and properties that Chromeleon supports for the 
TurboMatrix Headspace sampler, refer to: 

 State,  Options,  Temperatures,  Oven, and  Pressure. 

 Perkin Elmer TurboMatrix Headspace Sampler: Pressure 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Values Description 
ColumnPressure  Properties related to the column pressure. 

Column Pressure. 
Nominal² 

0.00 - 4.00 bar, 
0 - 400 kPa or 
0 - 60.0 psig 

Sets the target pressure in the column. 

Column Pressure. 
Value² 

0.00 - 4.00 bar  
0 - 400 kPa or 
0 - 60.0 psig 

Indicates the current column pressure (read-
only). 

HighPressInject On or Off Enables or disables high-pressure injection 
mode (on the device: Hi Psi Inject). 

  Note: 
This property is available only if you have 
selected the Programmable Pneumatic (PPC) 
check box on the Options tab page in the 
Server Configuration program. 
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Property Range/Values Description 
InjectPressure² 0.00 - 4.00 bar 

0 - 400 kPa or 
0 - 60.0 psig 

Sets the pressure for high-pressure injections 
(HighPressInject = On) for the time between the 
start of the pressure period and sample venting 
(withdrawing the needle). 

  Notes: 
This property is available only if you have 
selected the Programmable Pneumatic (PPC) 
check box on the Options tab page in the 
Server Configuration program. 
When HighPressInject is set to Off, the device 
does not use this value. 

 

  Notes²: 
The sampler accepts Chromeleon pressure commands only in psi. That is 
why Chromeleon must convert bar or kPa to psig before sending these 
commands to the sampler. This conversion may result in minor rounding 
differences, e.g., 120 kPa in Chromeleon is transferred to the sampler as 
119.9 kPa. 

The range of 0 - 60 psi (or 0 - 413.7 kPa) corresponds to the range that can 
be set on the device.  
 
For more commands and properties that Chromeleon supports for the 
TurboMatrix Headspace sampler, refer to: 

 State,  Options,  Temperatures,  Oven, and  Pressure. 
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 Perkin Elmer TurboMatrix Headspace Sampler: Single 
and Progressive Injection Modes  
The Perkin Elmer TurboMatrix Headspace Sampler supports different 
injection modes: 
• Single mode (in routine operation: all samples are thermostated the 

same time) 

• Progressive mode (for method generation: increasing thermostatting 
time) 

• MHE mode (for multiple injections from the same vial; refer to  MHE 
Mode) 

In Single and Progressive modes, the sampler assumes that the injection 
volume and the parameters are identical for all samples and that the vial 
positions are incremented. To achieve optimum sample overlapping, 
Dionex recommends taking this into account when creating a sequence in 
Chromeleon.  

 

However, in Chromeleon, the parameters can vary for each sample. This 
allows you, e.g., to process the samples with different PGM Files or to vary 
the injection volumes. Chromeleon regards this as independent sampler 
runs. Sample overlapping is possible only in the single sampler runs. 

This is especially important in Progressive mode. In this mode, the sample 
uses the IncubationTime parameter as the thermostatting time for the first 
sample in the sampler sequence. The thermostatting time for the other 
samples in the sampler run is prolonged, based on the sample number: 
Sample n is thermostatted n times as long as sample 1. 
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Example: 

 

Setting the IncubationTime to 10 min results in the following 
thermostatting times for the single samples: 
 
No. 1 2 3 4 5 6 7 8 
Time [min] 10 20 30 40 10 20 30 40 
 
The injection volume changes after the 4th sample. Thus, a new sampler 
run starts with the 5th sample. In this run, the Chromeleon sample no. 5 is 
the first sample. 

For a program example for the single or progressive injection mode, refer to 
 Perkin Elmer TurboMatrix Headspace Sampler: Program Example. 

For tips for practical operation, refer to  Perkin Elmer TurboMatrix 
Headspace Sampler: Tips. 
 
For an overview of the Elmer TurboMatrix Headspace Sampler, refer to 
Installing and Controlling Third-Party Devices  Perkin Elmer 
TurboMatrix Headspace Sampler: Overview in the Administrator Help 
section. 
For installation details, refer to Installing and Controlling Third-Party 
Devices  Perkin Elmer TurboMatrix Headspace Sampler: Installation 
in the Administrator Help section. 
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 Perkin Elmer TurboMatrix Headspace Sampler: Program 
Example 

Below please find a typical PGM File for the  Single and Progressive 
Injection Modes 
 
; Specify the injection mode 

InjectMode = Single ; or ‘Progressive’ 
InjectionsPerVial = 1 

 
; Sample thermostatting 

IncubationTime =  6.5 [min] 
OvenTemperature = 59 [°C] 

 
; GC cycle time: The time should be sufficiently longer than the PGM 
; run time so that the GC has enough time to reset the temperature 
and 
; the flow to the initial values and to get ready for the next 
; injection 

GCCycleTime = 13.5 [min] 
 
; Remaining time program 

PressTime = 0.2 [min] 
WithdrawTime = 0.3 [min] 
VialVenting = On 
VentingTime = 5 [s] 

 
; Temperatur program: e.g., set all temperature separately 

FollowOven = Off 
NeedleTemperature = 60 [°C] 
TransferTemperature = 62 [°C] 

 
; Pressure, e.g., high-pressure injection 

HighPressInject = On 
CarrierPressure = 100.0 [kPa] 
InjectPressure = 110.0 [kPa] 

 
; You can then enter the GC settings 
; ... 
 
; The injection procedure starts: 
0.000 Wait Sampler.Ready AND GC.Ready 

Inject 
 

; the following commands refer to GC analysis 
; ... 

 
12.000 End 
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After making some modification, you can use this program for the MHE 
mode, also. For information about the modifications, refer to  MHE 
Mode. 
 
For tips for practical operation, refer to  Perkin Elmer TurboMatrix 
Headspace Sampler: Tips. 

For an overview of the Elmer TurboMatrix Headspace Sampler, refer to 
Installing and Controlling Third-Party Devices  Perkin Elmer 
TurboMatrix Headspace Sampler: Overview in the Administrator Help 
section. 
For installation details, refer to Installing and Controlling Third-Party 
Devices  Perkin Elmer TurboMatrix Headspace Sampler: Installation 
in the Administrator Help section. 

 Perkin Elmer TurboMatrix Headspace Sampler: MHE 
Mode 
In MHE mode (= Multiple headspace extraction), multiple injections are 
performed from the same vial. Use the Sequence Wizard to create such a 
sequence (3 injections per vial), e.g.: 

 

The PGM file for the MHE mode is similar to the PGM File for the other 
injection modes (see  Program Example). The only difference is that 
you have to specify in the program file how often the injection shall be 
performed from the same vial, in addition to the sequence. The entry must 
match the setting in the sequence. Otherwise, the Ready Check fails. 
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; Specify the injection mode 
 InjectMode = MHE 
 InjectionsPerVial = 3 
; Sample thermostatting 
 IncubationTime = 6.5 
 OvenTemperature = 59 [°C] 
 

 Tip:  
In MHE mode, avoid explicitly setting a cycle time (GCCycleTime). The 
sampler uses the IncubationTime as cycle time. Thus, you only need to 
set the cycle time. Even if you set the GCCycleTime explicitly, the sampler 
uses the IncubationTime, instead. (Note: The selected GCCycleTime would 
be saved in the device and thus, it would then be used as preset cycle time 
in programs for Single and/or Progressive mode.) 

For information about the other two injection modes, refer to  Perkin 
Elmer TurboMatrix Headspace Sampler: Single and Progressive 
Injection Modes. 

For tips for practical operation, refer to  Perkin Elmer TurboMatrix 
Headspace Sampler: Tips. 

For an overview of the Elmer TurboMatrix Headspace Sampler, refer to 
Installing and Controlling Third-Party Devices  Perkin Elmer 
TurboMatrix Headspace Sampler: Overview in the Administrator Help 
section. 
For installation details, refer to Installing and Controlling Third-Party 
Devices  Perkin Elmer TurboMatrix Headspace Sampler: Installation 
in the Administrator Help section. 



1000 Commands and Tips for Third-Party Devices 

 Perkin Elmer TurboMatrix Headspace Sampler: Tips  

Injection time 
You can set an injection time on the sampler. In Chromeleon, it is not 
possible to explicitly set the injection time. However, the relationship 
between the injection time and the injection volume is as follows: 

Injection time (min)  =  volume (ml) / column flow (ml/min) 

Therefore, to determine the injection time, specify the Volume and the 
ColumnFlow. 

 Note:   

Besides, the injection time is indicated in Chromeleon via the InjectTime 
property. 

Missing vials 
When the sampler detects a missing sample vial, it does not interrupt the 
run. The sampler waits for the time specified for that sample and continues 
with the next sample afterward. 

Chromeleon, too, notices that a vial is missing and 
• Logs the missing sample in the Audit Trail. 

• Sets the sample status to Interrupted.  

• Does not start the GC run. 

• Continues the run with the next sample as soon as the sampler is in 
Ready state. 

Blank Run Samples 
The TurboMatrix Headspace sampler does not know blank run samples. 
The sampler injects every specified sample. If a Chromeleon sequence 
includes a blank run sample, Chromeleon splits the sequence into several 
subsequences and the sampler then processes them one after the other. 
When the blank run sample is processed, the sampler is in Standby mode. 
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In the example (injection mode: Single), the sequence would be split into 
three subsequences: 

1. Samples 1 2 

2. Samples 4 through 6 

3. Sample 8 

When sample 3 and 7 are processed, the sample is in Standby mode. 

 Tips:  
In Progressive mode, only the first sample of a Chromeleon sequence can 
be a blank run sample. 

It is not possible in MHE mode to enter single samples as blank run 
sample. All samples that are injected from the same vial must be defined as 
blank run samples, instead. 
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Interrupting a batch 
1. When a batch was started, Chromeleon combines as many samples as 
possible in a sampler method and sends the associated data to the sampler 
so that the sampler can start a run with overlapping sample preparation 
(thermostatting). For all samples sent to the sampler that have not yet been 
injected, the sample status is Preparing. 

When a batch is interrupted, the status for samples having the status 
Prepapring changes to Interrupted. It is irrelevant whether the samples 
are already in the oven. 

2. When a batch is interrupted with the Abort after current sample option, 
Chromeleon waits until the sampler has finished the current injection cycle, 
i.e., until the sampler is in GCAnalysis or Finishing state. 

It may happen that another sample vial is moved into the oven for 
preparation even if no injection can be performed. You cannot prevent this 
because the sampler does not allow you to stop the preparation without 
interrupting the entire run. 

Actual incubation time 
The actual incubation time may be different from the specified time. This 
may happen, e.g., when, after the previous run was finished, the GC does 
not enter the Ready state in time before the next injection. Chromeleon 
records the status of the oven and the devices to determine how long the 
single sample vials were actually incubated. When a sample was injected, 
i.e., after it was pressurized, Chromeleon logs the actual incubation time in 
the Audit Trail: 
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 Tips:  
In almost all cases, the actual incubation time will be slightly different from 
the specified time because Chromeleon receives data from the sampler 
only every second. Thus, a measuring error of at least 1 second (= 0.017 
min) can be expected. In addition, data processing in the sampler must be 
considered so that the measuring error may be some hundredth minutes. 

To include the actual incubation time in the report, use the Real Incubation 
Time (Sampler) variable that is available in the Audit Trail category. 

Inject synchronization 
The injection process starts by pressurizing the sample (device state: 
Pressurize). (The sampler sends the GC start run signal when the device 
status changes from Pressurize to Injecting. Chromeleon sets the sampler 
to Ready when the pressure phase starts and sends an Inject Response 
signal when starting the injection.) 
 
For information about the different injection modes, refer to Perkin Elmer 
TurboMatrix Headspace Sampler:  

 Single and Progressive Injection Modes  

 Program Example 

 MHE Mode 

For an overview of the Elmer TurboMatrix Headspace Sampler, refer to 
Installing and Controlling Third-Party Devices  Perkin Elmer 
TurboMatrix Headspace Sampler: Overview in the Administrator Help 
section. 
For installation details, refer to Installing and Controlling Third-Party 
Devices  Perkin Elmer TurboMatrix Headspace Sampler: Installation 
in the Administrator Help section. 
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Rheodyne Valves: Commands and Tips 

The Rheodyne External MSV driver supports the following commands 
(please note that the display Filter level determines which commands are 
displayed):  
 
Command Min. Max. Default Description 
Position 1 Depends on 

the type. 
Read out from 
the device on 
connect.  

The current position of the 
valve. (The valve moves to 
the specified position, 
obeying the Direction 
property.) 

Direction 0 Shortest 
1 Counterclockwise 
2 Clockwise 

0 Defines the direction in which 
the valve moves to the 
specified position.  

Home  Moves the valve to position 1. 
(Note: The command ignores 
the Direction property.) 

Test  Tests the valve. (Moves the 
valve to position 1, steps to 
all positions, and returns the 
valve to position 1) 
Level: Expert. 

ModelNo Text string (64 
characters) describing 
the valve type.  

Read out from 
the device on 
connect. 

Read-only - Expert level. 

SerialNo Text string (64 
characters) indicating 
the serial number 

Read out from 
the device on 
connect. 

Read-only - Expert level. 

FirmwareVersion Text string (64 
characters) indicating 
the firmware number 

Read out from 
the device on 
connect. 

Read-only - Expert level. 

 
It is not possible to check the serial number for the Rheodyne LabPro 
driver. Also, note that the following properties are available instead of the 
Direction property: 
 
Property Description 
StepCounterClockwise Moves the valve counterclockwise to the next position (Level: 

Advanced). 
StepClockwise Moves the valve clockwise to the next position (Level: Advanced).  
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Shimadzu HPLC Systems: Commands and Tips  

For information about the special commands that Chromeleon supports for 
the Shimadzu LC-10A and LC-2010 HPLC systems and for tips for practical 
operation, refer to: 
 

 System Settings 

 Pump 

 Autosampler 

 Inject Synchronization  
    (relates only to the Shimadzu LC-10A HPLC System) 

 SIL-10ADvp Sample Preparation  
     (relates only to the Shimadzu LC-10A HPLC System) 

 Column Oven 

 UV/VIS Detector 

 General Tips 

 Troubleshooting 
For program examples for sample preparation with the SIL-10ADvp 
autosampler, which is part of the LC-10A HPLC system, refer to: 

 Program Example for the Standard Injection Mode 

 Program Example for the Reagent Injection Mode 

 Program Example for the Dilution Injection Mode 

 Tip:  
You can only set the injection mode if you have selected the Prep Loop 
option on the Sampler tab page in the Server Configuration program. 
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 Shimadzu LC-10A and LC-2010 HPLC Systems: System 
Settings 
The table below lists the commands and properties that are available for 
the Shimadzu LC-10A and LC-2010 HPLC Systems (please note that the 
display Filter level determines which commands and properties are 
displayed). 

 Note:  
The names of the Shimadzu commands and properties may be slightly 
different, depending on version of your system. 
 
Shimadzu Chromeleon Values Description 
 Activated No, Yes Activates or deactivates 

the instrument or system. 
Reactivate the system if it 
was deactivated, e.g., 
because the pressure was 
below the pressure limit. 

 Note:  
Activating the system 
automatically enables 
temperature control and 
turns the pump(s) on 
(Motor = On).  

EXT_S ExternalStart None, AllRuns, InjOnly Determines which program 
starts are signalled by the 
START otuput (relay 1 on 
the system controller). 

INJ_IN WaitForRemoteStart Run, Sync Run: The autoinjector 
injects the samples 
immediately after drawing 
them. 
Sync: The injector waits 
for the manual injection 
signal before injecting the 
sample (read-only). 
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Shimadzu Chromeleon Values Description 
STATUS Status  

 
 
 
PURGE 
PAUSE 
HOLD 
RUN 
ERROR 
WAIT_OVEN 
 
OVEN_NOT_READY 
 
TRANSMIT 
WAIT_DP 
PRETREAT 
 
STOP 
RINSE 
READY 

Indicates the overall 
instrument or system 
status. The instrument or 
system is: 
purging. 
in Pause mode. 
in Hold mode. 
running. 
An error has occurred. 
waiting for the column 
oven. 
The oven is not yet ready 
for operation. 
transmitting data. 
waiting for INJ_IN. 
busy with sample 
prepration 
stopped. 
rinsing. 
ready for operation.  

For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 



1008 Commands and Tips for Third-Party Devices 

 Shimadzu LC-10A and LC-2010 HPLC Systems: Pump 
In addition to the standard pump commands (see Commands for 
Controlling Dionex Devices  Dionex Pumps), the commands and 
properties from the table below are available (please note that the display 

Filter level determines which commands and properties are displayed). 

 Note:  
The names of the Shimadzu commands and properties may be slightly 
different, depending on version of your pump. 
 
Property Values Description 

⇒%B, %C, %D 0.0 - 100.0 % Use %B, %C, and/or %D to determine the 
solvent composition. 

CycleMode 
(Shimadzu: LPGE.M) 

Auto 
OneCycle 
FourCycles 

(Only available for LC-2010 and only for 
Pump_A in quaternary LPG pumps) Sets 
the cycle mode. 

Degasser 
(Shimadzu: DEGAS) 

On / Off (Only for LC-2010) Turns the degasser on 
or off. 

⇒Flow 0.000 - 9.999 ml/min Sets the flow rate. 
Motor On/Off (Only available for the first pump) Turns 

the (all) pump(s) on or off 
ModelVariant Unknown 

Isocratic 
LPG 
HPG 

Indicates the pump's operating mode 
(read-only). Set the operating mode on 
the Pumps tab page in the Server 
Configuration program. 

Pressure 0 - 432 bar  Indicates the pressure (read-only). 
Pressure.LowerLimit LC-10A: 0 - 392 bar  

LC-2010: 0 - 343 bar  
Sets the lower pressure limit. 

Pressure.UpperLimit LC-10A: 10 - 432 bar 
LC-2010: 10 - 378 bar 

Sets the upper pressure limit. 

Solvent 
(Shimadzu: PASV, 
PBSV, PCSV) 

A, B, C, D (For pumps with connected FCV Solvent 
Selector) Selects the solvent. 

 

  Tips: 
To use the Motor On/Off, CycleMode, and Solvent properties, you have 
to enter them manually in the PGM Editor. 
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The CycleMode, Degasser, and Solvent properties supported by 
Chromeleon correspond to the Shimadzu LPGE.M, DEGAS, and PASV, 
PBSV, and PCSV properties (see the table above). 

For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 

 Shimadzu LC-10A and LC-2010 HPLC Systems: 
Autosampler 
In addition to the standard autosampler commands (see Commands for 
Controlling Dionex Devices  Dionex Autosamplers), the commands 
and properties from the table below are available (please note that the 
display Filter level determines which commands and properties are 
displayed). 

 Note:  
The names of the Shimadzu commands and properties may be slightly 
different, depending on version of your autosampler. 
 
Command Description 

Purge Purges the autosampler. 
Wash Washes the needle.  
The table below lists the Shimadzu autosampler properties that are 
supported by Chromeleon. 

 Tip:  
In Chromeleon, you can set the tray in the server configuration program, 
based on the Shimadzu MTPTRAY property. Sample processing in 
Chromeleon (Shimadzu MTP S.ORD property) is performed column by 
column. 
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Shimadzu Chromeleon Values Description 
- Volume Standard syringe: 

0.1-100.0 µl  
2ml syringe: 
0.1-2000 µl  

Injection volume 

CLTEMP Temperature 1-35 µl/s (Only for the SIL-HTC) Sets 
the temperature for the 
cooling unit.  

DIPTIME WashDuration 0-60 s (Only for the SIL-
HTA/HTC/10ADvp:) Sets the 
duration for the needle 
wash.  

INJCNT Injections_ 
Count 

- Counts the injections (read-
only). 

NDLSTK NeedleStroke 17-54 mm Sets the distance that the 
needle moves down when 
drawing sample. 

P.MAXT PurgeTime SIL-HTA/HTC: 
0.1 - 25.0 s  
SIL-10ADvp: 
0.1 - 10.0 s  

(Only for the LC-10A) Sets 
the time for which the 
autosampler is purged. 

RINSE.MODE WashMode NoWash 
WashBeforeSample 
WashAfterSample 
Both 

Determines when the needle 
is washed. 

RNSSPD WashSpeed 1-35 µl/s Sets the speed with which 
the syringe draws the 
volume for washing the 
needle. 

RNSVOL WashVolume 1-2000 µl Sets the volume with which 
the needle is washed. 

SILNRNS Wash_Counter - (Only for the LC-2010) 
Counts the needle wash 
operations (read-only). 

SILNVLR HighPressure 
ValveRotations 

- (Only for the LC-2010) 
Counts the rotations of the 
high-pressure valve (read-
only). 

SILNLVR LowPressure 
ValveRotations 

- (Only for the LC-2010) 
Counts the rotations of the 
low-pressure valve (read-
only)  

SMPSD SyringeSpeed 0.1-15.0 µl/s Sets the speed with which 
the syringe draws the 
sample.  
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 Tips:  
To use the Purge and Wash commands or the NeedleStroke, 
WashVolume, WashSpeed, SyringeSpeed, PurgeTime, WashMode, 
and WashDuration properties, you have to enter them manually in the 
PGM Editor. 

The NeedleStroke, WashVolume, WashSpeed, SyringeSpeed, 
Temperature, PurgeTime, WashMode, and WashDuration properties are 
allowed only once in the program. Besides, they are allowed only at the 
time t = 0.000 min. Otherwise, an error message appears during the 

Ready Check. 

Washing is always performed between two injections. Chromeleon waits for 
this either at the end of sampling or before the next injection. 

For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 
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 Shimadzu LC-10A HPLC System: Inject Synchronization 
 
Mode Injection Standard Sample Blank Run Sample 
Shimadzu 
sampler 
installed in 
Chromeleon 

Shimadzu 
Sampler 
(i.e., the program 
includes the 
Sampler.Inject 
command) 

WaitForRemoteStart is not 
allowed. 
Chromeleon starts a 1-
sample batch (i.e., a batch 
that contains one sample) 
on the system controller 
(SCL). The autosampler 
draws and injects the 
sample. 
Via the driver's internal inject 
port, Chromeleon generates 
an inject response upon the 
SCL start. 

WaitForRemoteStart is not 
allowed. 
Chromeleon starts a 0-
sample batch (i.e., a batch 
that does not contain a 
sample) on the system 
controller (SCL). 
 
 
Via the driver's internal inject 
port, Chromeleon generates 
an inject response upon the 
SCL start. 

No Shimadzu 
sampler 
installed in 
Chromeleon 

Manual injection 
via the SCL's 
contact input 
(i.e., an inject 
port is assigned) 

WaitForRemoteStart must 
be set. 
Chromeleon starts a 1-
sample batch on the SCL 
from the position "-1". The 
SCL waits until the contact is 
closed. 
 
Chromeleon changes the 
inject port state upon SCL 
start. 
The manual injection device 
detects this change and 
generates an inject 
response. 

WaitForRemoteStart must 
be set. 
Chromeleon starts a 0-
sample batch on the SCL. 
The SCL does not wait until 
the contact is closed.  
 
 
Chromeleon changes the 
inject port state upon SCL 
start. 
The manual injection device 
does not wait for a change 
of the inject port state. An 
inject response is generated 
immediately, instead. 

 Inject response 
from another 
sampler (i.e., no 
inject port is 
assigned) 

WaitForRemoteStart is not 
allowed. 
When the Sample2.Inject 
command is performed, the 
other sampler injects as 
usual. 
Upon receipt of the inject 
response, Chromeleon 
starts a 0-sample batch (i.e., 
a batch that does not 
contain a sample) on the 
SCL. 

WaitForRemoteStart is not 
allowed. 
When the Sample2.Inject 
command is performed, the 
other sampler injects as 
usual. 
Upon receipt of the inject 
response, Chromeleon 
starts a 0-sample batch (i.e., 
a batch that does not 
contain a sample) on the 
SCL.  

 Tip:  
The two cases described for No sampler installed in Chromeleon are 
true for Sampler installed in Chromeleon, also. 
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 Shimadzu LC-10A HPLC System: SIL-10ADvp Sample 
Preparation 
To perform sample preparation when the SIL10ADvp autosampler is part of 
the LC-10A HPLC System, you have to select the injection mode first. 

 Note:  
The names of the Shimadzu commands and properties may be slightly 
different, depending on version of your autosampler. 

 
Shimadzu Property Values Description 
PR.MODE InjectMode Standard 

Advanced 
Dilution 
Reagent 

Sets the mode for sample preparation. 

 Note:  
The Dilution and Reagent modes are not 
available for titer plates. 

 

Dilution and Reagent modes 
Chromeleon supports the following properties (please note that the display 

Filter level determines which properties are displayed): 
 
Shimadzu Chromeleon Values Description 
BUBBLING Bubbling On/Off On: Turns bubbling on, directing air through 

the sample. 
MIXCNT MixRepeat 1-10 Counts the mix operations after the diluent 

was added. 
MIXVOL PrepVolume 1-1000 µl Sets the volume that is drawn and 

dispensed for a mix operation. 
REACTM PrepTime 0.1 - 120.0 min Sets the time that the system waits after the 

mix operation has been completed. 
S.VIAL SourceVial Depends on the 

rack type. 
Specifies the sample container from which 
the injection is performed. (It is also 
possible to mix several substances in that 
container.) 
UpperHalf: Specifies the corresponding 
position in the upper half of the rack.  
R101, R102, R103: Additional reagent vials 
(if available on the rack)  



1014 Commands and Tips for Third-Party Devices 

Only Dilution mode: 
In addition to the parameters listed in Dilution and Reagent modes above, 
Chromeleon supports the following properties (please note that the display 

Filter level determines which properties are displayed): 
 
Shimadzu Chromeleon Values Description 
D.VIAL DiluentVial Depends on the 

rack type. 
Vial for the diluent 
Bottle: Large bottle 
R101, R102, R103: Additional reagent vials 
(if available on the rack) 

D.FACT DilutFactor 2-50 Ratio between the diluent and the original 
sample in the injected sample. 

T.VOL TotalVolume 200-1000 µl Sets the volume that is to be present in the 
vial after dilution. (This volume should 
exceed the injection volume.)  

Only Reagent mode 
In addition to the parameters listed in Dilution and Reagent modes above, 
Chromeleon supports the following properties: 
 
Shimadzu Chromeleon Values Description 
S.VOL SourceVolume 1-1000 µl Specifies the volume drawn from the vial.  
VIAL1 
VIAL2 
VIAL3 

ReagentAVial 
ReagentBVial 
ReagentCVial 

Depends on 
the rack type. 

Reagent vials 
UpperHalf: Specifies the corresponding 
position in the upper half of the rack.  
R101, R102, R103: Additional reagent vials 
(if available on the rack) 

VOL1 
VOL2 
VOL3 

ReagentAVolume
ReagentBVolume
ReagentCVolume

1-1000 µl Specifies the volume drawn from the 
reagent vial. 

 
For program examples, refer to: 

 Program Example for the Standard Injection Mode 

 Program Example for the Reagent Injection Mode 

 Program Example for the Dilution Injection Mode 
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 Tip:  
You can set the injection mode only if you have selected the Prep Loop 
option on the Samplertab page in the Server Configuration program. 
 
For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 

 Shimadzu LC-10A and LC-2010 HPLC Systems: Column 
Oven 
In addition to the standard oven commands (see Commands for 
Controlling Dionex Devices  Dionex Flow Manager and 
Thermostatted Column Compartments), the commands and properties 
from the table below are available (please note that the display Filter level 
determines which commands and properties are displayed): 

 Note:  
The names of the Shimadzu commands and properties may be slightly 
different, depending on version of your column oven. 
 
Shimadzu Chromeleon Values Description 
OVEN 
OVEN.T 

TempCtrl On/Off Enables or disables 
temperature control. 

OVEN.T Temperature.Nominal CTO-10A: 4-80°C 
LC-2010: 4-60°C 

Temperature setpoint for the 
column oven 

ROOM AmbientTemperature 5-85°C (Only for the vp module) 
Indicates the ambient 
temperature (read-only). 

TEMPm Temperature.Value CTO-10A: 4-85°C 
LC-2010: 4-65°C 

Current temperature of the 
column oven 

T.MAX Temperature.Upper  
Limit 

CTO-10A: 5-85°C 
LC-2010: 5-65°C 

Sets the upper temperature 
limit. Chromeleon aborts the 
sample batch and starts 
emergency handling if the 
current value exceeds the 
temperature limit.  
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 Tips: 
You cannot set Temperature.Nominal and TempCtrl for retention times 
<0.000 min. 

Each program may include only one Temperature.UpperLimit setting. In 
addition, the setting must be entered at the time t = 0.000 min. Otherwise, 
an error message appears during the Ready Check. 

Setting Temperature.Nominal automatically sets TempCtrl to On. If 
TempCtrl was set to Off before, Log.TempCtrl=On appears in the Audit 
Trail. 

For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 

 Shimadzu LC-10A and LC-2010 HPLC Systems: UV/VIS 
Detector 
In addition to the standard detector commands (see Commands for 
Controlling Dionex Devices  Dionex Detectors), the commands and 
properties from the table below are available (please note that the display 

Filter level determines which commands and properties are displayed): 

 Note:  
The names of the Shimadzu commands and properties may be slightly 
different, depending on version of your detector. 
 
Shimadzu Chromeleon Range Description 

ACELL.T CellTemp.Value  (Only for the LC2010) Indicates 
the current cell temperature 
(read-only). 

ACELL.T CellTemp.Nominal Off,  
Low (40°C),  
High (50°C) 

(Only for the LC2010) Sets the 
nominal cell temperature. 

AD2TIME UVLampOnTime  Counts the operating hours of the 
UV (D2) lamp (read-only). 

ADUAL UV.Mode² Single 
Dual 

See below 
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Shimadzu Chromeleon Range Description 

ALAMP UV.UV_Lamp  
UV.Visible_Lamp 

Off/On Specifies which lamp isto be 
turned on. Only one lamp at a 
time can be burning. 

 Tip:  
Changing from the UV lamp to 
the VIS lamp takes some time. 
Therefore, make sure that this 
does not interfere with sample 
processing. 

AREFENG ReferenceEnergy  Indicates the light energy in [mV] 
in the reference beam (read-
only). 

ARESP UV.Response² 0.05; 0.1; 0.5; 
1.0; 1.5; 2.0; 3.0; 
6.0; 8.0; 10.0 

Sets the time in [s] required by 
the detector until it reaches full 
scale (98%).  

ASMPENG SampleEnergy  Indicates the light energy in [mV] 
in the sample beam (read-only). 

AWAVE 
AWAVE2 

UV_VIS_1.Wavelength²
UV_VIS_2.Wavelength²

SPD-10Avp and 
LC2010: 
190-600 nm 
SPD-10AVvp : 
D2: 190-370 nm 
W: 371-900 nm 

Specifies the wavelength for the 
channel. 

AWTIME VisLampOnTime  Counts the operating hours of the 
VIS (tungsten) lamp (read-only). 

AZERO UV.Autozero  Performs autozero.  

 Tips:  
To use the UV_Lamp, Visible_Lamp, Mode, and Response commands, 
you have to enter them manually in the Commands view of the PGM Editor. 
This also applies to any additional Autozero commands. 

You cannot set UV_VIS_X.Wavelength, UV.Lamp, UV.Response, and 
UV.Autozero for retention times <0.000 min. 

Data acquisition can be started only at the retention time t = 0.000 min. 

The system automatically performs an Autozero command at t = 0.1 min. 
Therefore, leaps may occur in the absorption at the beginning of the 
chromatogram. 

The wavelengths must be appropriate for the lamp that is currently burning: 
When the UV (D2) lamp is burning, both wavelengths must be between 190 
and 370 nm. For the SPD-10AVvp with tungsten lamp, both wavelengths 
must be between 371 and 700 nm or between 701 and 900 nm. For the 
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LC-2010 and the SPD-10Avp with tungsten lamp, both wavelengths must 
be between 371 and 600 nm. If the one or both wavelengths are not in 
these ranges, an Abort message appears during the Ready Check and 
the program does not start.  

Manual data acquisition is limited to 100 min. Chromeleon automatically 
aborts manual data acquisition on all channels after that time. 

² Single Wavelength Mode and Dual Wavelength Mode 
To perform data acquisition on two channels (dual wavelength mode: 
Mode = Dual), two channels must be enabled on the UV/VIS tab page in 
the Server Configuration program. If only one channel is enabled, the 
UV.Mode property is not available. Thus, the detector runs always in single 
wavelength mode (Mode = Single). 

If two channels were enabled, the mode depends on the number and type 
of the channels to be recorded. If two channels are requested for data 
acquisition, the detector runs in dual wavelength mode. If only the first 
channel is requested (UV_VIS_1), the detector runs in single wavelength 
mode. However, if only the second channel is requested for data 
acquisition (UV_VIS_2), dual wavelength mode is required to make the 
second channel available. If the detector is configured only for channel 2, a 
warning appears during the Ready Check. It is still possible to start the 
program. 

When the detector runs in dual wavelength mode, the sampling step is 
1.2 s per channel. Therefore, this mode is appropriate only if the width of 
the smallest peak is at least 7.2 s at 50% of the peak height. 

Response settings  <= 1.0s are allowed only in single wavelength mode. In 
all other cases, an error message appears during the Ready Check and the 
program cannot start. 

When the mode is changed, Chromeleon automatically disconnects and 
reconnects the HPLC system. Thus, changing the mode is possible only if 
no other program is running. When the mode is changed, instrument 
settings may be reset to the default settings. Therefore, a warning appears 
for each program that changes the mode. However, the program can be 
started, nevertheless. 
 
For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 
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 Shimadzu LC-10A and LC-2010 HPLC Systems: General 
Tips 

LC-10A and LC-2010 
• When the system is operated in stand-alone mode, the system 

conditions, such as the oven temperature, are reset to the initial values 
at the end of the sample program (called Time Program by Shimadzu). 
If Chromeleon controls the HPLC System, the system conditions 
entered last are retained. 

• Chromeleon also disconnects and automatically reconnects to the 
HPLC System when you change the Mode parameter (single or dual 
wavelength) for the UV detector. This may take some time. After 
reconnect, an audible beep sounds. Make sure that this process does 
not interfere with sample processing.  

LC-10A 
• Parameter settings changed on the instrument in stand-alone operation 

are lost when Chromeleon connects to the instrument. Chromeleon 
always restores the preset values when connecting to the instrument. 

• Changes made in Chromeleon do not appear immediately on the 
ANALYSIS FILE and TIME PROGRAM menus on the System 
Controller. To see the changes, exit and reenter the corresponding 
display. The MONITOR menu is updated immediately. However, the 
nominal values are not displayed. 

• Depending on the desired operation (with either the Shimadzu sampler 
or a manual injection valve), Chromeleon sets the 
WaitForRemoteStart property automatically to the appropriate value 
for the selected option. 

• Chromeleon disconnects and automatically reconnects to the HPLC 
System when you change the setting for ExternalStart or when 
Chromeleon changes the setting for the WaitForRemoteStart property 
(see above). Make sure that this process does not interfere with 
sample processing. 

• To change from the UV lamp to the VIS lamp takes considerable time. 
Make sure that this process does not interfere with sample processing. 
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LC-2010 
• If the HPLC System detects an error or if data acquisition is active, you 

cannot connect to Chromeleon. 

• Parameter settings changed on the instrument in stand-alone operation 
are lost when Chromeleon connects to the instrument. Chromeleon 
always restores the preset values when connecting to the instrument: 

WashDuration: 0 
WashMode: NoWash 
PurgeTime: 25.0 
WashSpeed: 35 
WashVolume: 200 
SyringeSpeed: 15.0 
NeedleStroke: 52 

SourceVial: UpperHalf 
DiluentVial: Bottle 
TotalVolume: 400 
Sampler.DilutionFactor: 2 
MixRepeat: 3 
PrepVolume: 200 
Bubbling: On 
PrepTime: 1.0 

SourceVolume: 100 
ReagentAVolume: 100 
ReagentBVolume: 100 
ReagentCVolume: 100 
ReagentAVial: None 
ReagentBVial: None 
ReagentCVial: None 

• Changes made in Chromeleon do not appear immediately on the 
METHOD menu. To see the changes, exit and reenter the 
corresponding display. The MONITOR menu is updated immediately. 
However, the nominal values are not displayed. 

 
For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 
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 Shimadzu LC-10A HPLC System: Program Example for 
the Standard Injection Mode 

 Tip:  
The Shimadzu devices support only programs that start at the time 
t = 0.000 min. It is not possible to perform commands at negative retention 
times. If the program includes a command at a negative retention time, an 
abort error occurs during the Ready Check. 

The following program is an example for sample preparation with the 
Shimadzu SIL-10ADvp autosampler in Standard injection mode:  
 
; Pump settings: 
 Pressure.LowerLimit = 2 
 Pressure.UpperLimit = 150 
 %A.Equate = "Water" 
 %B.Equate = "Methanol" 
 Flow = 1.000 
 %B = 80.0 
 
; Detector settings: 
 Mode = Dual 
 Response = 2.00 
 UV_VIS_1.Wavelength =  272 
 UV_VIS_1.Step =  0.20 
 UV_VIS_1.Average =  On 
 UV_VIS_2.Wavelength =  254 
 UV_VIS_2.Step =  0.20 
 UV_VIS_2.Average =  On 
  
; The following autosampler settings are valid for each InjectMode: 
 WashMode = WashAfterSample 
; Determines when the needle is washed (Options: NoWash, 
WashBeforeSample (before injection), WashAfterSample (after 
injection), Both (before and after injection) 
 
 WashSpeed = 35 
; Syringe speed when washing the needle 
 
 WashVolume = 1 
; Volume used for washing the sample loop 
 
 SyringeSpeed = 15.0 
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; Speed with which the syringe draws the sample 
 
 NeedleStroke = 52 
; Indicates how deep the needle moves into the vial when drawing the 
sample 
 
 Position = 0 
 Volume = 5 
; You can specify the vial position in the PGM File or in the sample 
list of the sequence.  
 
 InjectMode = Standard 
 
; Injection and data acquisition: 
 0.000 UV.Autozero 
 Inject 
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
  
10.000 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
 End 
 
For other example programs, refer to: 

 Shimadzu LC-10A HPLC System: Program Example for the 
Reagent Injection Mode 

 Shimadzu LC-10A HPLC System: Program Example for the Dilution 
Injection Mode 
For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 
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 Shimadzu LC-10A HPLC System: Program Example for 
the Reagent Injection Mode 

 Tip:  
The Shimadzu devices support only programs that start at the time 
t = 0.000 min. If the program includes a command at a negative retention 
time, an abort error occurs during the Ready Check. 

You can only set the injection mode if you have selected the Prep Loop 
option on the Sampler tab page in the Server Configuration program. 

The following program is an example for sample preparation with the 
Shimadzu SIL-10ADvp autosampler in Reagent injection mode:  
 
; Pump settings: 
 Pressure.LowerLimit = 2 
 Pressure.UpperLimit = 150 
 %A.Equate = "Water" 
 %B.Equate = "Methanol" 
 Flow = 1.000 
 %B = 80.0  
 
; Detector settings: 
 Mode = Dual 
 Response = 2.00 
 UV_VIS_1.Wavelength =  272 
 UV_VIS_1.Step =  0.20 
 UV_VIS_1.Average =  On 
 UV_VIS_2.Wavelength =  254 
 UV_VIS_2.Step =  0.20 
 UV_VIS_2.Average =  On 
  
; Settings for the Reagent InjectMode: 
 InjectMode = Reagent 
 SourceVial = 51  
 SourceVolume = 20 
; 20 µl of air is automatically drawn first, and then the source 
volume, e.g., 20 µl, is drawn from position 51. Finally, 30 µl (= 
source volume + 10 µl) are delivered to the injection vial (defined 
position). 



1024 Commands and Tips for Third-Party Devices 

; Afterward, a Wash command is executed for the sample loop and the 
needle, using the settings for WashVolume and WashSpeed. 
 
 ReagentAVial = 30 
 ReagentAVolume = 5 
 
 ReagentBVial = 31 
 ReagentBVolume = 10 
 
 ReagentCVial = 32 
 ReagentCVolume = 15 
 
; For each reagent, 20 µl of air is automatically drawn first, and 
then the reagent volume, e.g. AVolume = 5 µl, is drawn from the 
indicated position. The reagent volume + 10 µl (here = 15 µl) are 
then delivered to the injection vial (defined position). 
; Each time after a reagent has been delivered to the injection vial, 
a Wash command is performed for the sample loop and the needle, using 
the settings for WashVolume and WashSpeed. After the last reagent has 
been delivered to the injection vial, the contents of the vials is 
mixed; no additional wash cycle is performed. For information about 

the general commands, refer to the previous topic:  Program Example 
for the Standard Injection Mode. 
 
 Position = 0 
 Volume = 5 
 
; The position of the injection vial is the position at which the 
sample and the reagent are mixed and from which injection is 
performed. You can specify the position in the PGM File or in the 
sample list of the sequence. 
 
; Settings for the mixing cycle 
 MixRepeat = 3 
 PrepVolume = 25 
; Number of mixing cylces that are performed after the SourceVolume 
and the Reagent have been delivered to the injection vial. The 
PrepVolume is drawn and expelled for each mixing cycle. 
 
 Bubbling = Off 
; If Bubbling is set to On, the PrepVolume is used as volume. 
; After all mixing cycles have been performed, a Wash command is 
executed for the sample loop and the needle, using the settings for 
WashVolume and WashSpeed. 
 
 PrepTime = 1.0 
; Indicates the time the system waits after the mixing cycles have 
been completed (here: 1.0 min). 
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; Injection and data acquisition: 
 0.000 UV.Autozero 
 Inject 
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
 
10.000 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
 End 
 
For another example program, refer to  Shimadzu LC-10A HPLC 
System: Program Example for the Dilution Injection Mode. 

For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 

 Shimadzu LC-10A HPLC System: Program Example for 
the Dilution Injection Mode 

 Tip:  
The Shimadzu devices support only programs that start at the time 
t = 0.000 min. If the program includes a command at a negative retention 
time, an abort error occurs during the Ready Check. 

You can only set the injection mode if you have selected the Prep Loop 
option on the Sampler tab page in the Server Configuration program. 

The following program is an example for sample preparation with the 
Shimadzu SIL-10ADvp autosampler in Dilution injection mode:  
 
; Pump settings: 
 Pressure.LowerLimit = 2 
 Pressure.UpperLimit = 150 
 %A.Equate = "Water" 
 Flow = 1.000 
 %B = 0.0 
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; Detector settings: 
 Mode = Dual 
 Response = 2.00 
 UV_VIS_1.Wavelength =  272 
 UV_VIS_1.Step =  0.20 
 UV_VIS_1.Average =  On 
 UV_VIS_2.Wavelength =  254 
 UV_VIS_2.Step =  0.20 
 UV_VIS_2.Average =  On 
 
; Settings for the Dilution InjectMode 
; The commands below are necessary to allow the autosampler execute 
the desired actions: 
 InjectMode = Dilution 
 SourceVial = 30 
; 20 µl of air is automatically drawn first, and then the calculate 
source volume, e.g., 200 µl, is drawn from position 30. Finally, 210 
µl (= source volume + 10 µl) are delivered to the injection vial 
(defined position). 
; Afterward, a Wash command is executed for the sample loop and the 
needle, using the settings for WashVolume and WashSpeed. For 
information about the general commands, refer to the previous topic: 

 Program Example for the Standard Injection Mode. 
 
 DiluentVial = 51 
; 20 µl of air is automatically drawn first, and then the calculated 
DilutVolume, e.g. 200 µl, is drawn from the position 51. Afterward, 
410 µl (= DilutVolume + 10 µl) are then delivered to the injection 
vial (defined position). 
 
 TotalVolume = 600 
; Volume that shall be delivered to the injection vial after dilution 
(should exceed the injection volume). 
 
 DilutFactor = 3 
; Ratio between the diluent/sample ratio in the resulting mixture. If 
the total volume is 600 µl and if the dilution factor is 3, 200 µl 
are drawn from the SourceVial and 400 µl are drawn from the diluent 
vial and delivered to the injection vial.  
 
 Position = 0 
 
 Volume = 5 
 
; The position of the injection vial is the position at which the 
sample and the reagent are mixed and from which injection is 
performed. You can specify the position in the PGM File or in the 
sample list of the sequence. 
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 MixRepeat = 3 
 PrepVolume = 300 
 Bubbling = Off 
 PrepTime = 1.0 
 
; Injection and data acquition: 
 0.000 UV.Autozero 
 Inject 
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
 
 3.000 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
 End 
 
For another example program, refer to  Shimadzu LC-10A HPLC 
System: Program Example for the Reagent Injection Mode. 

For information about how to install the Shimadzu HPLC Systems, refer to 
Hardware Installation  Shimadzu LC-2010 HPLC System: Installation 
and  Shimadzu LC-10A HPLC System: Installation in the 
Administrator Help section. 

 Shimadzu LC-10A and LC-2010 HPLC Systems: 
Troubleshooting 

LC-10A and LC2010 
• If communication to the Chromeleon cannot be re-established after a 

fatal communication error, the Chromeleon sever might not run 
stable afterward (due to the Shimadzu software). Restart the server to 
solve the problem. 

• When communication to Chromeleon is interrupted, the instrument 
may be in KEYLOCK state afterward. In this case, it is not possible to 
control the instrument by Chromeleon. Cancel KEYLOCK state by 
pressing the F5 key from the System Controller's Main menu and enter 
the system password. 

• Chromeleon uses the ANALYSIS FILE #0 file and the associated TIME 
PROGRAM. Thus, changes made while the instrument is operated in 
stand-alone mode are lost when you reconnect to Chromeleon later.  
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LC-10A 
• Error: "[Abort] {HPLC_System} Fatal Instrument Error (NOT LINKED, 

0)." 

• Cause: This error occurs if the server configuration includes an 
instrument that is not connected to the LC-10A system 

• Remedial action: Adapt the server configuration to the actually installed 
instruments. 

• Error: "[Error] 09:00:58 {HPLC_System} Error in task Remote: 
Configuration settings mismatch with the actual connection." 

• Cause: This error may occur if the operating mode set in the server 
configuration on the Pumps tab page does not match the setting on the 
instrument. 

• Remedial action: Check and change the operating mode on the device 
if necessary: 

1.  Press the key 1 to open the ANALYSIS FILE menu. 

2.  Press the F3 key (T.PROG) to open the TIME PROGRAM menu. 

3.  Pres F1 (P.CTRL), and then use the F1 - F4 key to select the 
operating mode (ISO, B.GE, T.GE, LPGE). 

LC-2010 
• When configuring the LC_2010 HPLC System for the first time in the 

Chromeleon Server Configuration program, the following error may 
occur:  

• "[Error] 10:50:51 {HPLC_System} Error in task PollCfg:  
Configuration settings mismatch with the actual HPLC system."This 
error may indicate that you have installed an LC-10A HPLC System in 
Server Configuration program. Uninstall the LC-10A HPLC System and 
install the LC-2010 HPLC System instead. 

• "[Error] 10:51:27 {HPLC_System} Error in task PollCfg: Invalid 
Parameter."This error may indicate that self-test of the LC-2010 HPLC 
system failed. Check the system and press CE or restart the system if 
necessary. 
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• "[Error] 17:51:25 {HPLC_System} Error in task Remote: Invalid 
function."This error may indicate that the LC-2010 HPLC System was 
not in Ready state when the Connect command was issued. Check the 
system; stop data acquisition, or perform a SIL rinse operation if 
necessary. 

• In very rare cases, it may happen that the LC-2010 displays 
"Calculating…" and seems to be frozen. You may have to wait some 
time until the system responds again. If you do not want to wait, you 
may turn the system off and on again and perform the following steps: 

 Tip:  
If you perform these steps, ALL settings, including the communication, 
start, and shutdown settings, are reset to the factory defaults. This 
means that you have to reenter all settings on the system (for example, 
the settings described in the Device Settings section in the 
Administrator Help section: Hardware Installation  Shimadzu LC-
2010 HPLC System: Installation). 

1. Press the [VP] key. 

2. Press the [F4](CALIB) key. 

3. Enter the login ID "00000" on the system. 

4. Press the [F2](OK) key. 

5. Select "7: Initialize Parameters." 

6. Press the [Enter] key. 

7. Press the [F2](OK) key. 

8. Restart the system. 

• Problem: Only 100 µl are injected although the injection volume is 
larger than 100 µl and the 2000 µl syringe was configured in the Server 
Configuration program. 

Reason: The 100 µl injection was set on the device. Set the 2000 µl 
syringe on the device, following the steps in the Device Settings 
section in the Shimadzu LC-2010 HPLC System: Installation topic in 
the Administrator Help section. 



1030 Commands and Tips for Third-Party Devices 

For a list of error messages that might appear in Chromeleon refer to the 
Error Levels tab page in the Server Configuration program. 
 
For information about how to install the Shimadzu LC-10A HPLC System, 
refer to Hardware Installation  Shimadzu LC-10A HPLC System: 
Installation in the Administrator Help section. 
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Shodex Refractive Index Detectors (RI-101, RI-102, 
RI-104): Commands and Tips  

 Tips:  
The Shodex RI-101 Refractive Index Detector is available from Dionex as 
part of the Summit HPLC System whereas the RI-102 and RI-104 detectors 
are not. However, the commands listed below are also supported for the 
Shodex RI-102 and RI-104 detectors. 

In addition to the commands available for various detector types, such as 
Step, Average, and Autozero (see  Dionex Detectors), the Shodex RI-
101 Refractive Index Detector supports the following commands and 
properties (please note that the display Filter level determines which 
commands and properties are displayed): 
 
Property Minimum Maximum Description 
Baseline_Shift 0 mV 500 mV Baseline offset (10 mV increments 

only). (Display level: Advanced) 
DemoFileName   Name of the standard demo file 

(Display level: Expert. The property 
is read-only.) 

Drift 0 nRIU/h 9990 nRIU/h Drift value (Display level: 
Advanced. The property is read-
only.) 

FirmwareVersion "1.06" (Note: This is the version 
number displayed on the 
startup screen. Other 
information is not retrievable.)  

Standard firmware version. 

Integrator_Range 125 µRIU/V or 500 µRIU/V Voltage scale for analog integrator 
output (display level: Advanced) 

LampAge 0 h 99999 h Lamp age (The value should not 
exceed 2000h. Display level: 
Advanced. The property is read-
only.) 

LampVoltage 0.0V 9.9V Lamp voltage (The value should not 
exceed 4.5V. Display level: 
Advanced. The property is read-
only.) 

Noise 0 nRIU 9990 nRIU Noise value (Display level: 
Advanced. The property is read-
only.) 

NotReadyCauses Text string (128 characters) Explanation of why the device is not 
ready (read-only).  
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Property Minimum Maximum Description 
Polarity Plus Minus Output polarity (Display level: 

Advanced) 
Purge Off On Controls the purge valve. 
Recorder_Range 0.25 µRIU 512.00 µRIU Voltage scale for full-scale analog 

recorder output. Only powers of 2 
are allowed. (Display level: 
Advanced) 

Rise_Time 0.10, 0.25, 0.50,1.00, 1.50, 
2.00, 3.00, 6.00 s 

Rise time constant. 

Span 0 µRIU 999 µRIU Validation span (The value should 
be between 487 and 537 µRIU. 
Display level: Advanced. The 
property is read-only.) 

TemperatureDelta -99°C 99°C Temperature delta (also see: 
Temperature.Nominal and 
Temperature.Value. Display level: 
Advanced. The property is read-
only.) 

Temperature.Nominal 30°C 
Off 

50°C Temperature set point. 

Temperature.Value 0°C 99°C Measured temperature.  

For information about how to install the Shodex RI-detectors, refer to 
Hardware Installation  Shodex HPLC Refractive Index Detectors 
(RI-101, RI-102, RI-104): Overview in the Administrator Help section. 
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Thermo Finnigan/TQ/TSP: Commands and Tips 

For information about the special commands that Chromeleon supports for 
the different Thermo Finnigan/TQ/TSP devices and for tips for practical 
operation, refer to: 

 Surveyor MSQ Mass Spectrometer 

 aQa Mass Spectrometer 

 Trace and Focus GCs 

 AS3000 and AI3000 GC Autosamplers 

 AS3500/AS3000 Autosamplers: Sample Preparation 

 UV1000 Detector 

 UV2000 Detector 

 UV3000 Detector 

 UV6000 PDA Detector 

 FL2000 and FL3000 Fluorescence Detectors 

For the commands supported for the ThermoQuest AS2000 Autosampler, 
which corresponds to the Fisons AS800 autosampler, refer to  Fisons 
AS800/ThermoQuest AS2000 Autosamplers. 
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 Thermo Finnigan/TQ/TSP Surveyor MSQ Mass 
Spectrometer 

TIC, SIM, and MS Channel Properties and Commands  
These channels are standard data channels with the following properties 
(please note that the display Filter level determines which properties are 
displayed):  
Property Min Max  Description 

⇒AcqOn/Off - - MS_n only Starts and stops data 
acquisition. 

MinMass 0.00 m/z 2000.00 Read-only Minimum mass recorded in 
this trace. (SIM channels 
only) 

MaxMass 0.00 m/z 2000.00 Read-only Maximum mass recorded in 
this trace. (SIM channels 
only) 

Polarity Negative Positive Read-only Polarity 
SourceVoltage 0 V 200 V Read-only Maximum voltage.  
FilterIndex 0: NoFilter n (dep. on 

installation): 
9 (TIC/MS) 
41 (SIM) 

Read-only 
(for TICF 
and SIM 
channels) 

Extraction filter. The filter 
corresponds to the filters 
defined in the MS method. 
For 0 = NoFilter, the TIC 
channel is used. 

Filter n/a n/a Read-only Filter string as used in 
Thermo Finnigan MSQ 
method. 

BasePeakMode No Yes MS only Extracts Base Peak 
chromatograms during data 
acquisition 

⇒Delta - - Read-only Signal change (difference 
between the current value 
and the value one second 
before).  

 Tip:  
Support for data acquisition is not available. Thus, the Step, 
MaxAutoStop, and Average commands cannot be set. Manual data 
acquisition is not possible, either. In addition, acquisition is started at the 
time 0.000 and stopped at the end of the program for all channels that 
deliver data according to an MSQ method file. These channels do not 
appear in the Program Wizard or on the control panel.  
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Device Properties and Commands 
 
Property Min Max Default Description 
Ready Ready, Busy  Read-only Indicates whether the 

spectrometer is busy or 
idle. 

Operation On, Off, 
Standby 

 Off Indicates whether the 
spectrometer is busy or 
idle. 

Status n/a  Read-only Indicates the 
spectrometer's 
operational status. 

Range 1  
(for exp(1) 
Counts) 

10  
(for exp(10) 
Counts) 

 Scaling range used for 
online signal plot during 
data acquisition. (Can be 
set only before data 
acquisition starts.) 

Smoothing  None, 
Gaussian, 
Boxcar 

None  Smoothing algorithm. 
Note: This parameter is 
used by Xcalibur raw data 
extraction during online 
and post-run channel 
extraction. 

SmoothingPoints 3, 5, 7, 9,  
11, 13, 15 

3  Number of data points 
used for smoothing.  
Note: This parameter is 
used by Xcalibur raw data 
extraction during online 
and post-run channel 
extraction. 

HardwareVersion n/a  Read-only The mass spectrometer's 
hardware version.  
Note: This value is 
available only after the 
first raw data acquisition. 

FirmwareVersion n/a  Read-only The spectrometer's 
firmware version.  
Note: This value is 
available only after the 
first raw data acquisition. 
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Command Description 

⇒Connect Connects the device 
Disconnect Disconnects the device 
⇒Reset Resets the device to the defaults 

For troubleshooting information, refer to  

 Thermo Finnigan/TQ/TSP Surveyor MSQ: Troubleshooting. 

 Thermo Finnigan/TQ/TSP Surveyor MSQ: 
Troubleshooting 

Problem: Interruption of the Xcalibur server 
Grounding of the USB cable and connector on the MSQ is intermittent and 
can interrupt the Xcalibur server. Interruption of the Xcalibur server 
results in the following symptoms: 
• The Xcalibur Manual Tune software spinning "tune note" stops 

spinning. This indicates that communication is interrupted between the 
MSQ and the PC; the MSQ can neither be controlled nor transmit 
values to the Chromeleon. 

 Tip:   

The MSQ communicates with the PC via the USB port. 
Communications function is monitored with the Xcalibur Manual Tune 
software with a spinning "tune note" in the upper right corner of the 
screen. Spinning of the "tune note" is the primary indication that the 
Xcalibur server is operational. 

• The Xcalibur Manual Tune spectra section "freezes". This, too, 
indicates that communication between the MSQ and the PC is 
interrupted. 

Solution:  
1. Restart the Xcalibur server, following the steps below: 
• Exit Xcalibur Manual Tune.  

• Reset the MSQ by depressing the hardware reset button on the MSQ's 
rear panel. 
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• Restart Xcalibur Manual Tune and observe the active Xcalibur server: 
The MSQ makes an audible beep, the spinning "tune note" in the upper 
right corner of Manual Tune will be spinning, and the MSQ can be 
controlled and transmits values to Chromeleon. 

2. Ensure that the length of the USB cable between the MSQ and PC is of 
minimum length (preferably 2 meters or less). 

3. Ensure that the MSQ USB connector is grounded. Temporarily insert a 
conductive material, such as a paper clip or similar, between the MSQ USB 
connector and the sheet metal panel from which it protrudes. If the Xcalibur 
server interrupt problem does not re-occur, a more permanent solution 
would be to utilize a powered USB hub. (A suitable product is available, for 
example, from Belkin.) Install the hub between the MSQ and PC, using 
USB cables of minimum length. 
 

Problem: Leakage on the return-valve 
If the LC pump continues running after shutting down the MSQ, the non-
return valve can leak inside the instrument. This is problem especially for 
high flow applications. 

The Turbo pump controller is located directly below the non-return valve. 
When the non-return valve leaks, it does so onto the controller and pools 
on the main chassis bottom. In extreme cases, such a leak can cause the 
Turbo pump controller to fail. In minor cases, the leak causes the inside of 
the MSQ to be unsightly. 

Solution:  
A non-return valve removal kit and instruction sheet is available from 
Dionex. Contact the Callcenter at Callcenter@Dionex.com or 1-800-346-
6390. Removal of the valve takes 30 to 60 minutes and can be performed 
during any other scheduled service.  

 Note:   

The removal kit includes an apparatus to provide a continuous nitrogen 
leak into the MSQ source, when the instrument is not in operation. This 
configuration consumes more nitrogen and customers may need to take 
measures to conserve nitrogen when supply is limited. In these cases, 
Dionex recommends turning off nitrogen at the source when the instrument 
is not in use.  
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Closely monitor the level of the waste in the source waste bottle and/or 
leave the source door open slightly when the MSQ is not in use. This will 
prevent waste from being drawn back into the source when the instrument 
is turned off. 

Problem: No data acquisition for Blank Run Samples 
The Inject command of the PGM File is not performed for Blank Run 
samples (sample type: Blank) because it is not required. However, the 
MSQ needs this signal from the sample to start data acquisition. 

Solution:  
There are two possible solutions: 

1. For Blank Run Samples (sample type: Blank), inject the solvent that is in 
the sample loop. Specify the Inject command as follows: 

Inject Blank=Inject 

2. To analyze blank run samples without an injection, connect a relay, e.g., 
from the pump or detector, to the IN1 digital input on the Surveyor MSQ 
User Interface, using the black and the red wire of the three-core cable 
from the MSQ's accessory kit. In addition, add the following line to the PGM 
File directly after the Inject command, e.g.: 

Pump_Relay_1.Open Duration=1.00 
 

 Note:   

This example refers to Relay_1 on the pump. 
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 Thermo Finnigan/TQ/TSP aQa Mass Spectrometer 

TIC and SIM Channel Properties and Commands  
These channels are standard data channels with the following properties 
(please note that the display Filter level determines which commands and 
properties are displayed):  
Property Min Max  Description 
MinMass 2.00 1636.00 Read-only Minimum mass recorded in this 

trace. (SIM channels only) 
MaxMass 2.00 1636.00 Read-only Maximum mass recorded in this 

trace. (SIM channels only) 
Polarity Negative Positive Read-only Polarity 
SourceVoltage 0 V 200 V Read-only aQa max voltage. (SIM 

channels only) 
SourceVoltage 0 V 200 V Read-only aQa max voltage range. 

(TIC/TICF channels only) 
BasePeakMode No Yes MS only Extracts Base Peak 

chromatograms during data 
acquisition 

Filter n/a n/a Read-only Filter string as used in Thermo 
Finnigan aQa method.  

 Tip:  
Support for data compression is not available. Thus, the Step, 
MaxAutoStop, and Average commands cannot be set. Manual data 
acquisition is not possible, either. In addition, acquisition is started at the 
time 0.000 and stopped at the end of the program for all channels that 
deliver data according to an aQa method file. These channels do not 
appear in the Program Wizard or on the control panel.  
 
Device Properties and Commands 
Property Min Max Default Description 
Ready Ready, Busy  Read-only Indicates whether the 

spectrometer is busy or 
idle. 

Operation On, Off, 
Standby 

 Off Indicates whether the 
spectrometer is busy or 
idle. 

Status n/a  Read-only Indicates the 
spectrometer's 
operational status. 
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Property Min Max Default Description 
Range 1  

(for exp(1) 
Counts) 

10  
(for exp(10) 
Counts) 

 Scaling range used for 
online signal plot during 
data acquisition. (Can be 
set only before data 
acquisition starts.) 

Smoothing None, 
Gaussian, 
Boxcar 

None  Smoothing algorithm. 
Note: This parameter is 
used by Xcalibur raw data 
extraction during online 
and post-run channel 
extraction. 

SmoothingPoints 3, 5, 7, 9,  
11, 13, 15 

3  Number of data points 
used for smoothing.  
Note: This parameter is 
used by Xcalibur raw data 
extraction during online 
and post-run channel 
extraction. 

HardwareVersion n/a  Read-only The mass spectrometer's 
hardware version.  
Note: This value is 
available only after the 
first raw data acquisition. 

FirmwareVersion n/a  Read-only The spectrometer's 
firmware version.  
Note: This value is 
available only after the 
first raw data acquisition.  

Command Description 

⇒Connect Connects the device 
Disconnect Disconnects the device 
⇒Reset Resets the device to the defaults 
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 Thermo Finnigan/TQ/TSP Trace and Focus GC 
Commands 
Lots of commands are available for the individual options of the Trace and 
Focus GCs. Only the most important of them are described below (please 
note that the display Filter level determines which commands and 
properties are displayed). They are common to the respective device types 
(for example, the different detectors). For a short description of all GC 
commands, refer to the corresponding Command dialog box (press the F8 
key in the program) or the Properties/Link box. 

GC 
Command Min Max Default Description 
Cryo 
(Trace GC only) 

Off On Off ON: The cryo valve will 
operate when needed. 
OFF: The cryo valve is 
disabled. (The property is 
visible only if the cryo 
option is enabled.) 

TempCtrl OFF ON ON Turns the oven's 
temperature control on or 
off. 

Temperature    The allowed maximum 
temperature change is 
120°C/min (1200°C/min 
for the Trace UltraFast). 
A maximum of 6 ramps 
per program are possible. 

.Nominal 30 
Note 1 

Note 2 50 Nominal oven 
temperature in [°C]. 

.Value 30 
Note 1 

Note 2 N/A Actual oven temperature 
in [°C] (read-only). 

.UpperLimit 70 Note 2 350 (Focus) 
450 (Trace) 

Upper limit for the oven 
temperature in [°C]. 

.LowerLimit 30 
Note 1 

50°C 30 Lower limit for the oven 
temperature in [°C].  

Note 1: Trace GC: Depending on the cryo settings, the minimum 
temperature can be 30°C, -55°C, or -99°C. 

Note 2: Trace GC: Depending on the cryo settings, the maximum 
temperature can be 450°C or 500°C. 
Focus GC: Depending on the cryo settings, the maximum 
temperature can be 350°C. 
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Inlet 
Command Min Max Default Description 
TempCtrl OFF ON ON Turns temperature control 

on or off. 
Temperature     
.Nominal 30 (Trace) 

50 (Focus) 
450(Trace) 
375 (Focus) 

50 (Trace) 
150 (Focus) 

Nominal inlet temperature 
in [°C] 

.Value 30 (Trace) 
50 (Focus) 

450(Trace) 
375 (Focus) 

N/A Actual inlet temperature 
in [°C] (read-only). 

Mode N/A N/A Split Inlet mode: Split or 
Splitless  

Detector(s) 
Command Min Max Default Description 

⇒Autozero    Sets the signal output to 
0. 

TempCtrl OFF ON ON Turns temperature control 
on or off.  

Temp     
.Nominal 30 (Trace) 

100 (Focus) 
450 (Trace) 
375 (Focus) 

150 Nominal detector 
temperature in [°C] 

.Value 30 (Trace) 
100 (Focus) 

450 (Trace) 
375 (Focus) 

N/A Actual detector 
temperature in [°C] (read-
only).  

Column(s) 
Command Min Max Default Description 
PressureCtrl OFF ON ON Turns the control of the 

column gas pressure on 
or off. 

Pressure     
.Nominal 0.03 10.00 N/A Nominal pressure in the 

column [bar]. 
.Value 0.03r 10.00 N/A Actual pressure in the 

column [bar] (read-only). 
FlowCtrl OFF ON ON Turns the column flow 

control on or off.  
Flow     
.Nominal 0.0 50.0 (Trace) 

100.0 (Focus)
N/A Nominal flow in the 

column [ml/min]. 
.Value 0.0 50.0 (Trace) 

100.0 (Focus)
N/A Actual flow in the column 

[ml/min].  
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The Administrator Help section provides more information about the Trace 
and Focus GCs. Refer to Hardware Installation: 

 Thermo Finnigan/TQ/TSP Trace GC: Overview and  Thermo 
Finnigan/TQ/TSP Trace GC: Installation. 

 Thermo Finnigan/TQ/TSP Focus GC: Overview and  Thermo 
Finnigan/TQ/TSP Focus GC: Installation. 

 Thermo Finnigan/TQ/TSP Trace GC: Application 

General 
The Thermo Finnigan Trace GC uses a packet-oriented, binary data format 
to communicate with the PC via the RS-232 interface. When the GC is 
connected in Chromeleon, Chromeleon enables remote mode for the GC 
and locks the GC keypad. When Chromeleon terminates the connection to 
the GC, the GC switches back to local mode after 30 seconds.  

The GC will not start communication by itself; it will only respond to 
commands and requests sent by Chromeleon. 

Sampler 
Using the AS2000 autosampler with the GC: If a sample vial is missing at 
the position specified in the sequence, the autosampler treats this as a 

Blank Run Sample (refer to the AS2000 manual, page 118). However, the 
sequence will not be stopped. 

If the GC is waiting for an inject response from the autosampler and 
suddenly becomes Not Ready due to gas supply or flow problems, an error 
message appears and the sequence is stopped.  
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 Thermo Finnigan/TQ/TSP Trace GC: Setting the 
Temperature 
Entering a Temperature Gradient 
To enter a temperature gradient, use a Program. 

For the Thermo Finnigan Trace GC, a temperature profile can be entered 
with a maximum of six ascents or descents. The maximum temperature 
change (ascent) is up to 120°C per minute (1200°C/min for the Trace 
UltraFast), depending on the oven type.  

Gradients are entered in the Program Wizard in the typical format for GC 
applications. (The starting and end temperatures are entered, as well as 
the modification rate.) In the program, however, the so-called "base point 
philosophy" is used (similar to entering a flow or percent gradient in HPLC). 
Each temperature command is the base point of the gradient program. 
The wizard automatically converts the entered rates into the base point 
representation. 

An Inject command is indispensable. No gradient is executed before the 
Inject command. Thus, temperature gradients can only begin after the 
Inject command  

Temperature Setting  
Reaching the nominal temperature on the instrument can take some time. 
Please note that the oven heats faster than the injector and the detector 
system. As soon as all temperatures and the specified pressure and flow 
parameter are reached, the GC sends a Ready signal. An injection from 
the autosampler is possible only after this signal.  

Example: 
The following program waits until the nominal temperature (150°C) is 
reached before the Inject command is executed:  
 
  0.000 GC.Temperature = 150 
   Wait GC.Ready 
   Inject 
  ...... .............. 
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 Tip:  

After the instrument has received the method parameters from 
Chromeleon, it implements the desired value as quickly as possible. When 
the value is "almost" reached, the Equilibration Time passes until the 
instrument sends the confirmation message to Chromeleon. You can 
specify the duration of this time interval, using the Equilibration Time 
parameter in Chromeleon. 

 Thermo Finnigan/TQ/TSP: AS3000 and AI3000 
Autosampler Commands 
Chromeleon supports the following special commands and parameters for 
these autosamplers (please note that the display Filter level determines 
which commands and properties are displayed). Also, refer to the 
information in the manual supplied with the instrument. 
 
Command Description 
Clean Cleans the syringe using the previously defined parameters (see below). 
Inject Injects the sample using the previously defined parameters (see below). 
Recalibrate Performs the start procedure again, allowing the autosampler to recalibrate 

the internal positions, such as injector, wash vials, tray. This command is 
required when a new tray was installed. 

StopInject Aborts a running injection.   
Use the following parameters to specify the Inject command in detail. 
Define all injection parameters before initiating the Inject command. 
Otherwise, they will not take effect! 
 
Parameter Description 
AirVolume Select this parameter to specify the volume of air (0.0 - 3.0 µl) 

drawn after pulling the syringe needle out of the vial. This 
reduces evaporation from the syringe needle. The total of 
AirVolume plus Volume must not exceed the syringe volume. 

DrawSpeed Select this parameter to determine how fast the sample is 
drawn (slow or fast). 

FillStrokes Select this parameter to determine how often the syringe 
plunger is moved up and down before the sample is actually 
drawn up (0...15). This eliminates bubbles and thus, enhances 
reproducibility. 

InjectWaitTime Set the time between the injection command and the response 
from the autosampler (0 - 10.000.000 s) 
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Parameter Description 
PostInjDelayTime Select this parameter to determine for how long the syringe 

remains in the injector after the injection (0 - 63 s). 
PostWash Select this parameter to set the number of post-injection 

cleaning cycles (0 - 15). 
PostWashVial Specify which vial(s) is(are) used for washing the syringe after 

the injection with the solvent(s): A, B, C, D, A+B, C+D. 
PreInjDelayTime Select this parameter to determine the delay the syringe 

remains in the injector before the injection (0 - 63 s). 
PreWash Select this parameter to set the number of pre-injection 

cleaning cycles (0 - 15) 
PreWashVial Specify which vial(s) is(are) used for washing the syringe before 

the injection with the solvents: A, B, C, D, A+B, C+D. 
SampleDepth Specify how deep the needle descends into the vial when 

drawing the sample for injection (bottom or half). 
SampleWash Select this parameter to determine the number of cleaning 

cycles with sample before injection (0...15).  
State Indicates the status of the autosampler (read-only): 

On = the injection has been performed 
Off = the injection has not yet been performed  

For more information, refer to Hardware Installation  Thermo 
Finnigan/TQ/TSP AS3000 and AI3000 GC Autosamplers in the 
Administrator Help section. 

 Thermo Finnigan/TQ/TSP AS3500/AS3000 
Autosamplers: Sample Preparation 
Follow these guidelines to ensure successful sample preparation with an 
AS3500 or AS3000 Autosampler: 
• Place extra vials in the three positions after the sample vial position 

(FirstVial+1, FirstVial+2, and FirstVial+3). 

• When you create the Program, make sure the sample prep steps are 
in the correct order and that all required steps are present. The 
AS3500/AS3000 Basic Template example program (see below) lists 
the sample prep steps in the order they should be run and identifies the 
required steps. 

• Make sure that each dilution cycle includes all of the required steps. 
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• Specify the desired final volume in the Add step. 

• To skip any step (except the Add step), set its volume to 0. 

• To perform an operation on the target vial (but not make a delivery to 
it), set the Add step’s volume to 0. This is useful, for example, when 
you want to mix or heat the contents of a vial. 

• Make sure the volume specified in the Add step in a given dilution cycle 
is less than or equal to the sum of the PickUpLg and the Load volumes. 

• Remember that the autosampler only injects from the FirstVial, which is 
specified in the Pos. column of the sequence. 

 

Example AS3500/AS3000 Sample Preparation Programs 

1. AS3500/AS3000 Basic Template 
; Basic Template for sample preparation 
; Injection will be made from FirstVial 

; Optionally specify Reagent positions 
ReagentA = A35 
ReagentB = B35 
ReagentC = C35 
 
; Required to tell autosampler prep is starting.  Must be 
first command! 
PrepStart ; required 
 
; Prep steps defined.  Up to 4 sets.  Must be done in this 
exact order! 
PrepLoad Volume=0.0, Reservoir=Solvent_1;optional 
PrepPickUp1 Volume=0.0, Reservoir=FirstVial+1;optional 
PrepPickUp2 Volume=0.0, Reservoir=FirstVial+2;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial+3;optional 
PrepAdd  Volume=0.0, Reservoir=FirstVial;required 
PrepMix  PreHeatMix=0.00, Heat=0.00, PostHeatMix=0.00 
;optional 
PrepWait Time = 0.00 ;optional 
PrepRemove Volume=0.0, SampleHeight=2.0;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
;Repeat previous commands for additional 3 cycles 
;... 
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; required end of prep steps.  Must be last commands! 
PrepFlushP Volume=0.0, Solvent=Solvent_1 ;optional 
PrepEnd ; required 
 

0.000 Inject ; Required for sample prep to execute. 
 
End 

 

2. AS3500/AS3000 Dilution Template 
; Template is a dilution program that you can use to perform a 1:5 
dilution 
; Injection will be made from FirstVial 

 
; Required to tell sampler prep is starting  Must be first 
command! 
PrepStart ; required 
 
; Prep steps defined.  Up to 4 sets.  Must be done in this 
exact order! 
PrepLoad Volume=500.0, Reservoir=Solvent_1;optional 
PrepPickUp1 Volume=100.0, Reservoir=FirstVial+1 ;optional 
PrepPickUp2 Volume=0.0, Reservoir=FirstVial+1;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial+1;optional 
PrepAdd  Volume=500, Reservoir=FirstVial;required 
PrepMix  PreHeatMix=0.50, Heat=0.00, PostHeatMix=0.00 
   ;optional 
PrepWait Time = 0.00 ;optional 
PrepRemove Volume=0.0, SampleHeight=0.0;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
 
; required end of prep steps.  Must be last commands! 
PrepFlushP Volume=0.0, Solvent=Solvent_1 ;optional 
PrepEnd ; required 

 
0.000 Inject ; Required for sample prep to execute. 

 
End 
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3. AS3500/AS3000 DABS-CL Template 
; Template heats your samples to a given temperature 
; Injection will be made from FirstVial 
 

; Turn on heater and set to desired temperature for mix/heat 
step 
Heater =  On 
HeaterTemperature = 65 
 
; Optionally specify Reagent positions 
ReagentA = A35 
ReagentB = B35 
ReagentC = C35 
 
; Required to tell autosampler prep is starting.  Must be 
first command! 
PrepStart ; required 
 
; Prep steps defined.  Up to 4 sets. Must be done in this 
exact order! 
; Cycle 1 
PrepLoad Volume=200.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=100.0, Reservoir=ReagentA ;optional 
PrepPickUp2 Volume=40.0, Reservoir=ReagentB ;optional 
PrepPickUpLg Volume=0.0, Reservoir=ReagentC ;optional 
PrepAdd  Volume=140, Reservoir=FirstVial ;required 
PrepMix PreHeatMix=0.30, Heat=4.50, PostHeatMix=0.30  
;optional 
PrepWait Time = 0.00 ;optional 
PrepRemove Volume=0.0, SampleHeight=0.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
; Cycle 2 
PrepLoad Volume=1000.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=0.0, Reservoir=ReagentA ;optional 
PrepPickUp2 Volume=0.0, Reservoir=ReagentB ;optional 
PrepPickUpLg Volume=0.0, Reservoir=ReagentC ;optional 
PrepAdd  Volume=860, Reservoir=FirstVial+1 ;required 
PrepMix PreHeatMix=0.30, Heat=0.00, PostHeatMix=0.00 
;optional 
PrepWait Time = 0.00 ;optional 
PrepRemove Volume=0.0, SampleHeight=0.0 ;optional 
PrepRetvial ; required 
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PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
 
; required end of prep steps.  Must be last commands! 
PrepFlushP Volume=0.0, Solvent=Solvent_1 ;optional 
PrepEnd ; required 
 

0.000 Inject ; Required for sample prep to execute. 
 
End 

 

4. AS3500/AS3000 Rainbow Template 
; Prepares four samples 
; Injection will be made from FirstVial 

; Setup Reagent positions 
ReagentA = A35 
ReagentB = B35 
 
; Required to tell autosampler prep is starting.  Must be 
first prep command! 
PrepStart ; required 
 
; Prep steps defined.  Up to 4 sets. Must be done in this 
exact order! 
; Cycle 1 
PrepLoad Volume=1000.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=30.0, Reservoir=Reagent_B;optional 
PrepPickUp2 Volume=0.0, Reservoir=Reagent_A;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial;optional 
PrepAdd  Volume=1000.0, Reservoir=FirstVial ;required 
PrepMix  PreHeatMix=0.50, Heat=0.00, PostHeatMix=0.00 
   ;optional 
PrepWait 0 ;optional 
PrepRemove Volume=0.0, SampleHeight=2.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
; Cycle 2 
PrepLoad Volume=1000.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=20.0, Reservoir=Reagent_B;optional 
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PrepPickUp2 Volume=10.0, Reservoir=Reagent_A;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial;optional 
PrepAdd  Volume=1000.0, Reservoir=FirstVial+1
 ;required 
PrepMix  PreHeatMix=0.50, Heat=0.00, PostHeatMix=0.00 
   ;optional 
PrepWait 0 ;optional 
PrepRemove Volume=0.0, SampleHeight=2.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
; Cycle 3 
PrepLoad Volume=1000.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=10.0, Reservoir=Reagent_B;optional 
PrepPickUp2 Volume=20.0, Reservoir=Reagent_A;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial;optional 
PrepAdd  Volume=1000.0, Reservoir=FirstVial+2
 ;required 
PrepMix  PreHeatMix=0.50, Heat=0.00, PostHeatMix=0.00 
   ;optional 
PrepWait 0 ;optional 
PrepRemove Volume=0.0, SampleHeight=2.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
; Cycle 4 
PrepLoad Volume=1000.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=0.0, Reservoir=Reagent_B;optional 
PrepPickUp2 Volume=30.0, Reservoir=Reagent_A;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial;optional 
PrepAdd  Volume=1000.0, Reservoir=FirstVial+3
 ;required 
PrepMix  PreHeatMix=0.50, Heat=0.00, PostHeatMix=0.00 
   ;optional 
PrepWait 0 ;optional 
PrepRemove Volume=0.0, SampleHeight=2.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
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; required end of prep steps.  Must be last of the prep 
commands! 
PrepFlushP Volume=0.0, Solvent=Solvent_1 ;optional 
PrepEnd ; required 
 

0.000 Inject ; Required for sample prep to execute. 
 
End 

 

5. AS3500/AS3000 Linear Template 
; Template allows you to do linear dilutions 
; Injection will be made from FirstVial 
 

; Required to tell autosampler prep is starting.  Must be 
first prep command! 
PrepStart ; required 
 
; Prep steps defined.  Up to 4 sets. Must be done in this 
exact order! 
; Cycle 1 
PrepLoad Volume=1000.0, Reservoir=Solvent_1;optional 
PrepPickUp1 Volume=100.0, Reservoir=FirstVial+3 ;optional 
PrepPickUp2 Volume=0.0, Reservoir=FirstVial ;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial ;optional 
PrepAdd  Volume=1000.0, Reservoir=FirstVial+2 ;required 
PrepMix  PreHeatMix=0.30, Heat=0.00, PostHeatMix=0.00 
   ;optional 
PrepWait 0 ;optional 
PrepRemove Volume=0.0, SampleHeight=2.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
; Cycle 2 
PrepLoad Volume=1000.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=50.0, Reservoir=FirstVial+3;optional 
PrepPickUp2 Volume=0.0, Reservoir=FirstVial;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial;optional 
PrepAdd  Volume=1000.0, Reservoir=FirstVial+1
 ;required 
PrepMix PreHeatMix=0.30, Heat=0.00, PostHeatMix=0.00 
;optional 
PrepWait 0 ;optional 
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PrepRemove Volume=0.0, SampleHeight=2.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
; Cycle 3 
PrepLoad Volume=1000.0, Reservoir=Solvent_1 ;optional 
PrepPickUp1 Volume=5.0, Reservoir=FirstVial+3;optional 
PrepPickUp2 Volume=0.0, Reservoir=FirstVial;optional 
PrepPickUpLg Volume=0.0, Reservoir=FirstVial;optional 
PrepAdd  Volume=1000.0, Reservoir=FirstVial ;required 
PrepMix PreHeatMix=0.30, Heat=0.00, PostHeatMix=0.00 
;optional 
PrepWait 0 ;optional 
PrepRemove Volume=0.0, SampleHeight=2.0 ;optional 
PrepRetvial ; required 
PrepMovearm ; required 
PrepFlush ; required 
PrepFlushBtl ; required 
 
; required end of prep steps.  Must be last of the prep 
commands! 
PrepFlushP Volume=0.0, Solvent=Solvent_1 ;optional 
PrepEnd ; required 
 

0.000 Inject ; Required for sample prep to execute. 
 
End 

 



1054 Commands and Tips for Third-Party Devices 

 Thermo Finnigan/TQ/TSP UV1000 Detector 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min Max Default Description 
AvailableLamps None UV & VIS 

lamp 
UV-lamp 
only 

Indicates which lamps are available 
(read-only). 

Range 0.0005, 0.001, 
0.002, 0.005, 0.01, 
0.02, 0.05, 0.1, 0.2, 
0.5, 1.0, 2.0, 3.0  

1.0000 Amplifying factor in [AUFS] for the 
output signal. 

Response 0.0 5.0 1.0 Time constant. Indicates the time 
needed by the detector to reach 98% of 
full-scale. 

Wavelength 190 nm 800 nm 254 nm Wavelength at which the detector 
measures the signal: 
UV lamp: 190 - 380 nm 
VIS lamp: 366 - 800 nm  
Both lamps: 190 - 800 nm 

ZeroOnLambda 
Change 

Off On Off Determines whether the detector 
⇒Autozeroes  every time the 
wavelength is changed.  

Command Description 
UV_LampOn Turns the deuterium lamp on. 
UV_LampOff Turns the deuterium lamp off. 
Visible_LampOn Turns the tungsten lamp on. 
Visible_LampOff Turns the tungsten lamp off.  

 Tip:  

After a ⇒Reset command, it takes 90 seconds until the detector is ready to 
execute further commands. 
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 Thermo Finnigan/TQ/TSP UV2000 Detector 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min Max Default Description 
DetectionMode - - - Sets the wavelength mode: 

Single Mode: 190 - 800 nm  
(only one detector channel is used) 
Dual1 Mode: 190 ... 450 nm 
Dual2 Mode: 366 ... 800 nm 

Response 0.0 5.0 1.0 Time constant. Indicates the time needed 
by the detector to reach 98% of full-scale. 

 
Property Description 
UV_LampOn Turns the deuterium lamp on. 
UV_LampOff Turns the deuterium lamp off. 
Visible_LampOn Turns the tungsten lamp on. 
Visible_LampOff Turns the tungsten lamp off.  

Channel-Specific Commands and Properties 
Common to both channels 
 
Property Min Max Default Description 
Range 0.0005 AUFS 3.0000 AUFS 1.0000 AUFS Amplifier gain for the output 

signal 
Wavelength 190 nm 800 nm 254 nm Wavelength at which the 

detector measures the signal. 
Legal range: see 
DetectionMode.   
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 Thermo Finnigan/TQ/TSP UV3000 Detector 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min Max Default Description 
AcquisitionMode Single 

Wavelength 
Multi 
Wavelength 

N/A Changes the data acquisition 
mode. 

Connected Discon- 
nected  

Connec- 
ted 

N/A Indicates whether the 
detector is connected. 

UV_Lamp Off On N/A Turns the deuterium lamp on 
or off (λ = 190 - 365 nm) 

UV_Lamp_ 
Intensity 

Intensity_ 
low 

Intensity_ 
OK 

N/A Indicates whether the 
deuterium lamp intensity is 
too low or OK (read-only) 

Visible_Lamp Off On N/A Turns the tungsten lamp on 
or off (λ = 366 - 800 nm)  

Visible_Lamp_ 
Intensity 

Intensity_ 
low 

Intensity_ 
OK 

N/A Indicates whether the 
tungsten lamp intensity is too 
low or OK (read-only)  

Channel-specific Commands and Properties 
 
Property Min Max Default Description 
Response 0.0 9.9 1.0 Time constant. Indicates the 

time needed by the detector 
to reach 98% of full-scale. 

⇒Wavelengt
h 

190 nm 800 nm 254 nm Wavelength at which the 
detector measures the signal. 

 

All other channel properties and commands correspond to the standard 
detector commands (refer to Practical Tips for Device Control 

 Detector Commands). 

 Notes:  
The Range property provided by the TSP UV3000 (analog data acquisition) 
driver is not required for digital data acquisition; thus, it is not available with 
the TSP UV3000 (digital data acquisition) driver. 
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Due to extensive communication during the ⇒Connect procedure, it may 
take up to 1 min until the instrument is finally connected. The corresponding 
message is logged in the Audit Trail. 

 Tip:   

The device driver does not support the Scan mode of the detector. 
Therefore, it is not possible to acquire single spectra.  

 Thermo Finnigan/TQ/TSP: Troubleshooting 
 
Why can't you start the data acquisition? 
Is an AS3500 or an AS3000 autosampler installed for which Inj Hold 
Active has been set to HI? Set this option to LO; otherwise, data 
acquisition cannot start. 
 
Why does the batch abort? 
a) The batch aborts due to a communication timeout.  

b) A TSP device is not ready for communication. 

In both cases, the reason may be that TSP devices communicate via the 
Start and/or Stop input. Make sure that no cables are connected to these 
inputs or remove them if necessary.  
 
AS350 and AS300:  
Why can it take some time until the program is started? 
Chromeleon needs to Wait for the Equilibration Time or Wait for 
Temperature that is set on the instrument until the autosampler can inject. 
Reduce the Equilibration Time if your system needs less time to equilibrate 
or disable the Wait for Temperature option. For more information, refer to 
the device manual. 
 
Only UV3000:  
Why doesn't the UV detector respond? 
Due to the extensive communication during connecting the device 
(following the Connect command), it may take up to 1 min until the device 
finally responds. The respective message is logged in the Audit Trail. 
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UV2000, UV1000, P2000, P4000, AS3500, and AS3000: 
How to cure a communication error? 
The Communication error while sending may occur periodically in the 
Audit Trail. In this case, reduce the input buffer of the COM port to Low: 
Under Windows 2000 (or correspondingly under another Windows system), 
open the Device Manager via Settings>Control Panel>System>Hardware. 
Double-click the respective COM port and open the Advanced Settings 
dialog box by clicking Advanced on the Settings tab page. Reduce the 
input buffer as far as possible and confirm the input by clicking OK. 
Disconnect and reconnect the device in Chromeleon. 
Only UV1000:  
Why is a command not executed? 
Have 90 s passed since the last reset? Otherwise, the command cannot be 
executed because the detector is not yet ready. 
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 Thermo Finnigan/TQ/TSP UV6000 PDA Detector 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min Max Default Description 
Data_Collection_Rate 
(For more information, 
refer to Data 
Collection Rate in the 
Glossary section.) 

0.5 Hz 20.0 Hz 1.0 Hz 
Read from 
the device 
on connect 

Indicates the data collection 
rate for the channels. 

FirmwareVersion Text string (max.32 characters) 
Read from the device on connect - 
typically: ROM 0.2 RAM 1.4 

Indicates the module's firmware 
version 
(read-only) 

Rise_Time 0.0 s 10.0 s 2.0 s 
Read from 
the device 
on connect 

Indicates the response time 
after a signal has been 
changed. 

XY_Lamp Off On N/A Turns the tungsten/deuterium 
lamp on and off. 

XY_LampAge 0 h 9999 h Periodically 
read from 
the device. 

Indicates the time the 
tungsten/deuterium lamp has 
been on since its installation. 

XY_LampReplacedAt Date string (periodically read from 
the device) 

Indicates the time when the 
tungsten/deuterium lamp has 
been installed. 

In the tables above and below, XY can be either UV (deuterium lamp λ = 
190 - 340 nm) or Visible (tungsten lamp: (λ = 340 - 800 nm). 

 Tip:  

When the Data Collection Rate command is executed, the default ⇒Step 
value is set to the reciprocal value. Thus, you must issue the Step 
command after the Data Collection Rate command, if you need a different 
step.  

Command Description 

⇒Autozero Sets the detector signal to 0. 
⇒Connect Connects the PDA detector to Chromeleon. 
Disconnect Disconnects the PDA detector from Chromeleon. 
⇒Reset Resets the PDA detector to the defaults. 
XY_LampReset Resets the XY_LampReplacedAt counter to now  



1060 Commands and Tips for Third-Party Devices 

Commands and Properties of UV Channels 
 
Property Min Max Default Description 

⇒Average Off On Off Allows signal averaging. 
⇒Bandwidth 1 nm 121 nm 1 nm 

Read from the 
device on 
connect. 

(Odd values only) 

⇒MaxAutoSte
p 

0.01 s 5.10 s 5.10 s Indicates the maximum step for 
Step = Auto 

⇒Step Auto, 0.01 s 5.10 s Auto Indicates the time interval 
between data points. 

⇒Wavelength 190 nm 800 nm 254 nm Indicates the wavelength at 
which the detector measures the 
signal.  

 Tip:   

After a Reset command, it takes 90 s until the detector is ready to execute 
another command. 

Commands and Properties of the 3D Field 
 
Property Min Max Default Description 

⇒Bandwidth 1 nm 121 nm 1 nm 
(Read from the 
device on 
connect.) 

Indicates the bandwidth for 
all wavelengths in the 
spectrum² (odd values only) 

⇒BunchWidth 1 nm 
2 nm 
4 nm 
5 nm 

10 nm 

1 nm 
(Read from the 
device on 
connect.) 

Indicates the distance 
between the wavelengths in 
the spectrum². 

MaxWavelength 190 nm 800 nm 800 nm Indicates the upper limit of 
the measuring range.  

MinWavelength 190 nm 800 nm 190 nm Indicates the lower limit of 
the measuring range.  

⇒Step 0.05 s 
0.10 s 
0.20 s 
0.25 s 
0.50 s 
1.00 s 
2.00 s 

1.00 s 
(Read from the 
device on 
connect.) 

Indicates the time interval 
between recorded spectra. 
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 Tip:  

² For example, to scan the wavelengths between 400 nm and 500 nm with 
a BunchWidth of 10 mm, you can select the following bandwidths, e.g., 
11 nm or 5 nm. 

a) 11 nm  

Select a bandwidth of 11 nm to scan the following wavelength ranges: 

395-405, 405-415, 415-425, 425-435, 435-445, 445-455, 455-465,  
465-475, 475-485, 485-495, and 495-505 nm. 

b) 5 nm  

Select a bandwidth of 5 nm to scan the following wavelength ranges: 

398-402, 408-412, 418-422, 428-432, 438-442, 448-452, 458-462,  
468-472, 478-482, 488-492, and 498-502 nm.   

In this case, the wavelength ranges 403-407, 413-417, 423-427 nm etc. are 
not scanned. 

 Thermo Finnigan/TQ/TSP UV6000 Detector: 
Troubleshooting 
How can you turn on the lamps? 
The PDA detector does not automatically turn on the lamps at power-up. To 
turn on the lamps, connect the PDA detector to Chromeleon, and issue the 
corresponding commands. 

Why can't you reconnect the PDA detector? 
It is not always possible to reconnect the PDA detector after a breakdown 
in communication. In this case, turn the detector off and on before 
reconnecting. 

Why can't you start the data acquisition? 
Is an AS3500 or an AS3000 autosampler installed for which Inj Hold 
Active has been set to HI? Set this option to LO; otherwise, data 
acquisition cannot start. 
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Why does the batch abort? 
a) The batch aborts due to a communication timeout.  

b) A TSP device is not ready for communication. 

In both cases, the reason may be that TSP devices communicate via the 
Start and/or Stop input. Make sure that no cables are connected to these 
inputs or remove them if necessary.  

 Thermo Finnigan/TQ/TSP: FL2000 and FL3000 
Fluorescence Detectors 
The following commands and properties are available (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min Max Description 
AnOut_1_Offset, 
AnOut_1_Offset 

-50; -20; -10; -5; -2; -
1; 0; 1; 2; 5; 10; 20; 
50 %FS 

Offset on the analog output. (This value is added 
to the associated measured value.) 

AnOut_1_Range, 
AnOut_2_Range 

500; 200; 100; 50; 
20; 10; 5; 2; 1; 0,5; 
0,2; 0,1; 0,05; 0,02; 
0,01 FUFS 

Output range for the analog output 

DetectionMode Fluorescence, 
Phosphorescence 

Operating mode of the detector. 

Lamp Off On Turns the lamp or or off. (Note: It is not possible 
to turn the lamp off during data acquisition. Also, 
it is not possible to start data acquisition if the 
lamp is off.) 

LampFlashRate 20 Hz 100 Hz Pulse rate of the xenon lamp (20 Hz prolongs the 
lamp's life cycle; 100 Hz increases the sensitivity 
for the measurements) 

NumberOfScans* 2 - 32 (in 2 nm 
increments) 

This property is available only for the FL3000.  
It specifies how often the monochromator shall 
repeat each scan for averaging. 

PmtVoltage 0, 500, 600, 700, 
800, 900, 1000 V 

Specifies the voltage applied to the 
photomultiplier tube (PMT). (The PMT's sensitivity 
increases proportional to the applied voltage. 
However, higher voltages shorten the PMT's life 
cycle.) 
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Property Min Max Description 
ScanEndEm 
Wavelength* 

200 - 650 nm  
(or 800 nm;  
in 2 nm increments) 

This property is available only for the FL3000.  
Emission wavelenth at the end of the scan. 
(ignored for für ScanMode = Excitation) 
The difference between 
ScanStartEmWavelength and 
ScanEndEmWavelenght must be a multiple of 
10. 

ScanEndEx 
Wavelength* 

200 - 650 nm  
(in 2 nm increments)
 

This property is available only for the FL3000.  
Excitation wavelength at the end of the scan 
(ignored for ScanMode = Emission) 
The difference between 
ScanStartEmWavelength and 
ScanEndEmWavelenght must be a multiple of 
10. 
If ScanMode=Delta, the differences between the 
emission and the excitation scan ranges must be 
identical:  
(ScanEndEmWavelength - 
ScanStartEmWavelength) equals 
(ScanEndExWavelength -
ScanStartExWavelength).  

ScanMode Excit. Emission This property is available only for the FL3000. 
Scan mode: 
• Excitation: The emission wavelength is 

constant; the excitation monochromator 
scans the wavelengths.  

• Emission: The excitation wavelength is 
constant; the emission monochromator 
scans the wavelengths.  

• Delta: Both monochromators perform the 
scans simultaneously; the difference 
between the wavelengths is constant.  

ScanStartEm 
Wavelength* 

200 - 650 nm  
(or 800 nm;  
in 2 nm increments) 

This property is available only for the FL3000.  
Emission wavelength at the beginning of the scan 
(ignored for ScanMode = Excitation)  

ScanStartEx 
Wavelength* 

200 - 650 nm  
(in 2 nm increments) 

This property is available only for the FL3000.  
Excitation wavelength at the beginning of the 
scan (ignored for ScanMode = Emission)  

ScanStepSize 2, 4, 8, 16 nm This property is available only for the FL3000.  
Specifies the step for the wavelength scan.   
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*  Tip:  

If the value for NumberOfScans and/or for the area to be scanned, 
specified by either ScanStartEmWavelength and ScanEndEmWavelength 
or ScanStartExWavelength and ScanEndExWavelength, is too large, it may 
happen that the sample is interrupted and the batch is stopped. (The 
reason is that the firmware does not respond.) In this case, turn the 
instrument off and on again. 
 
Command Description 
Scan This property, which is available only for the FL3000, starts the scan for the 

emission and/or excitation wavelength. 
Scanning is possible only during the run of a PGM File. 
During the run of a PGM File, manual scanning is possible only if the detector 
provides enough storage capacity.  
A scan can start only after the previous baseline scan is finished (see 
ScanAutozero). 

 Tip:  
The chromatogram is disturbed during the scan. 

ScanAutozero This property, which is available only for the FL3000, starts the baseline scan 
for the emission and/or excitation wavelength. 
A baseline scan can start only after the previous baseline scan is finished.  

Data acquisition channel 
Property Min Max Description 
AutozeroOnWlChange Off, On If the setting is On, autozeroing is 

performed each time the wavelength (see 
EmWavelength and ExWavelength) is 
entered. 

 Tip:   
Autoszeroing is performed each time the 
wavelength is changed, even if the new 
value is the same as the previous one. 

EmWavelength 200 - 650 nm  
(or 800 nm;  
in 2 nm increments) 

Emission wavelength 

ExWavelength 200 - 650 nm  
(in 2 nm increments) 

Excitation wavelength 

Response 0.0, 0.1, 0.2, 0.5, 1.0, 
2.0, 5.0, 10.0 s 

Specifies the response time for the detector 
(see Response). 
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Property Min Max Description 
Signal.UpperLimit 
Signal.LowerLimit  

-1000 1000 FU Upper and lower signal limit.  

 Tip:  
If the actual value is above the upper limit 
or if it is below the lower limit, Chromeleon 
aborts the batch and starts emergency 
handling. 

Signal.Value -1000 1000 FU Indicates the current signal value.  

 Tip:   

After a Reset command, it takes 90 s until the detector is ready to execute 
another command. 
 
Also, refer to  Thermo Finnigan/TQ/TSP: FL2000 and FL3000 
Fluorescence Detectors: Different Names in Firmware and 
Chromeleon 
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 Thermo Finnigan/TQ/TSP: FL2000 and FL3000 
Fluorescence Detectors: Different Names in Firmware and 
Chromeleon 
For consistency reasons, the names of some Chromeleon properties and 
commands are different from the names used in the instrument's firmware: 
 
Instrument Chromeleon Description 
Lamp Status: 
On, Off, Run, 
Off@End 

Lamp: 
On, Off 

The instrument provides two additional lamp 
modes: 
Run (The lamp is turned on at the beginning of 
the sample run; it is turned off at the end of the 
run.) 
Off@End (The lamp is turned off at the end of 
the sequence.) 
The device driver does not support these 
modes because you can control the lamp by 
the corresponding commands in the PGM File.) 

Scan Scan This command corresponds to 'Scan' entry on 
the instrument's COMMANDS menu (manual 
scanning). 

Scan Zero ScanAutozero The Chromeleon command corresponds to the 
'Scan Zero' command on the instrument's 
COMMANDS menu (manual baseline 
scanning). 
The first ScanAutozero command that is 
included in the PGM File at a non-negative time 
is not executed immediately. The time is 
downloaded to the instrument as Autozero 
Time parameter. The instrument performs the 
Autozero command at this time. 

Autozero Time Supported via the 
ScanAutozero 
command (see above) 

 

Auto Spectra: 
On, Off 

 Chromeleon sets this parameter always to Off 
because Chromeleon can perform automatic 
scanning more reliably by using Trigger 
Commands. 

Zero on λ 
Change 

AutozeroOnWlChange  

Detection Type: 
Fluor 
Phos 
 

DetectionMode: 
Fluorescence 
Phosphorescence 

In addition, it is possible to measure the 
Chemiluminescence. Use one of the two 

modes and turn off the lamp.  
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 Tip:   

After a Reset command, it takes 90 s until the detector is ready to execute 
another command. 

Also, refer to  Thermo Finnigan/TQ/TSP: FL2000 and FL3000 
Fluorescence Detectors 

 Thermo Finnigan/TQ/TSP: FL2000 and FL3000 
Detectors: Troubleshooting 

Why does the batch and the sample abort and the detector does not 
respond? 
If the value for NumberOfScans and/or for the area to be scanned, 
specified by either ScanStartEmWavelength and ScanEndEmWavelength 
or ScanStartExWavelength and ScanEndExWavelength, is too large, it may 
happen that the sample is interrupted and the batch is stopped. (The 
reason is that the firmware does not respond.) Turn the instrument off and 
on again. 
 
Why does the batch abort? 
a) The batch aborts due to a communication timeout.  

b) A TSP device is not ready for communication. 

In both cases, the reason may be that TSP devices communicate via the 
Start and/or Stop input. Make sure that no cables are connected to these 
inputs or remove them if necessary.  
 
Why doesn't the fluorescence detector respond? 
Due to the extensive communication during connecting the device 
(following the Connect command), it may take up to 1 min until the device 
finally responds. The respective message is logged in the Audit Trail. 
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Valco Valves: Commands and Tips 

The Two-Position Valve has two valve positions (A and B). The Multi-
Position Valve has up to 16 valve positions (1, 2, 3, ...16). The valve is 
switched to position A (Two-Position Valve) or position 1 (Multi-Position 
Valve) when connecting to Chromeleon. 

Valve Commands and Properties 
In addition to the standard commands, the following commands and 
properties are available (please note that the display Filter level 
determines which commands and properties are displayed): 
 
Property Value Description 
Direction  
(Available only for the 
Multi-Position Valve.) 

Clockwise or 
Counterclockwise 

Direction in which the valve is switched. 

FirmwareDate  Firmware date (read-only).  
FirmwareVersion  Firmware version (read-only). 
FlipDelay 
(Available only for the 
Two-Position Valve.) 

0 to 65.000 ms Delay time for the Flip command.  

MaxPosition 
(Available only for the 
Multi-Position Valve.) 

4, 6, 8, 10, 12, 16 Maximum number of positions (read-only). 
The property is set on the General tab 
page in the Server Configuration program.  

Position A or B  
1 through 
MaxPosition, 
respectively. 

Current valve position.  

 
Command Description 
Flip 
(Available only for the 
Two-Position Valve.) 

Switches the valve to the opposite position, waits for the time 
specified by the FilpDelay property, and then returns to the 
original position.  

Home Switches the Two-Position Valve to position A. 
Switches the Multi-Position Valve to position 1.  

Reset Performs a Disconnect command, and then a ⇒Connect 
command. 

Toggle 
(Available only for the 
Two-Position Valve.) 

Switches the valve to the other position. 

 
For an overview of the Valco valves, refer to Hardware Installation 

 Valco Valves in the Administrator Help section. 
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Varian: Commands and Tips 

For information about the special commands that Chromeleon supports for 
the different Varian devices and for tips for practical operation, refer to: 

Varian 3800 GC: 

 General 

 Sampler 

 Injector 

 Column 

 Detectors 

 Troubleshooting 

Varian 3400 and 3600 GCs: 

 Varian 3400 and Varian 3600 GCs  

 Different Names in Firmware and Chromeleon 

 Detectors  

 Different Names in Firmware and Chromeleon 

 Tips for Operation 

 Troubleshooting 
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 Varian 3800 GC: General 

In addition to the  General Device Commands, the Varian 3800 GC 
supports the following commands and properties (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Value Description 
AtmosphericPressure 0.000 - 2.067 bar Indicates the atmospheric pressure 
Cryo On/Off (If cryo cooling is installed) Enables or 

disables cyro cooling. 
CryoHasTimeout Yes, No (If cryo cooling is installed) = Yes if the 

temperature zone did not reach the target 
temperature, despite Cryo*. 

CryoTimeout 0.01 - 999.99 min (If cryo cooling is installed) Time that the 
GC waits before turning off the cooling if no 
sample has been injected.  

CryoThreshold 30-450°C (If cryo cooling is installed) Temperature 
above which the GC shall use cryo for 
cooling.  

EndRunTime 0.01 - 999.99 min Actual run time of the current program*. 
Fault Fault, OK Indicates whether a fault occurred in the 

GC*. 
OvenFault Fault, OK Indicates whether a fault occurred in the 

column oven*. 
OvenPower On, Off Indicates whether the column oven is on*. 
OvenReady Ready, NotReady Indicates whether the column oven has 

reached the target temperature and is 
ready*. 

ProtocolVersion n/a n/a Protocol version of the instrument* (must be 
'7'). 

RunState NotReady, 
Equilibrating, 
Stabilizing, Monitoring, 
Ready, Running 

Indicates the status of the GC*. 

RunTime 0.01 - 999.99 min Indicates the actual retention time during 
sample processing. 

StabilizationTime 0.00 - 10.00 min Time that the GC waits after reaching the 
target temperature*. 

Temperature   Properties related to the column oven 
temperature. 

Temperature. 
Value 

-99°C - 450°C  Current temperature*. 
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Property Range/Value Description 
Temperature. 
Nominal 

-99°C - UpperLimit Sets the nominal temperature. 

Temperature. 
UpperLimit 

50 - 450°C The system aborts the sample batch and 
starts emergency handling if the 
temperature exceeds the upper limit.  

* Note:  These properties are read-only. 
 
For an overview of the Varian 3800 GC, refer to Hardware Installation: 
Installing and Controlling Third-Party Devices  Varian 3800 GC: 
Overview in the Administrator Help section. 

For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Varian 3800 GC: Installation in the 
Administrator Help section. 

 Varian 3800 GC: Sampler 

In addition to the  General Device Commands and the standard 
autosampler commands (see  Dionex Autosamplers), the Varian 3800 
GC supports the following commands and properties (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property/Command Range/Values Description 
AbortWashVial I, II, III (Only 8400) Wash vial that is used when 

the injection was aborted. 
AdvanceTray Yes, No Sets whether both injections are 

performed from the same tray (No) or 
whether the second injection is performed 
from the next tray (Yes).² 

AirPlugAfterSample 0.0 - 5.0 µl  
(5µl syringe) 
0.0 - 10.0 µl  
(10µl syringe) 
0.0 - 100 µl  
(100µl syringe) 

Volume of the air gap after the sample.³ 

Buzzer On, Off (Only 8400) Turns the buzzer on or off at 
the beginning of the injection cycle. 

CleanBetweenInjections Yes, No Sets whether a wash cycle is performed 
between injections (Yes). 
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Property/Command Range/Values Description 
Depth_1 (or Depth_2) 0 - 100 % (Only 8400 if the injection port 1 (or 2) is 

enabled in the configuration) Sets how 
deep the syringe needle descends into 
the injector. 

FillStrokes 0 - 99 Number of piston strokes for filling the 
syringe. 

FillVolume 0.0 - 5.0 µl  
(5µl syringe) 
0.0 - 10.0 µl  
(10µl syringe) 
0.0 - 100 µl  
(100µl syringe) 

Volume with which the syringe is to be 
filled. 

FirstInjectorUsed Position_1,  
Position_2 

Sets which injector is used first for the 
injection. (If only one injector is installed, 
the property is read-only.) 

Home (Only 8400) Recalibrates the sampler's Home position. 

 Tip:   
Select this command when a mechanical error occurred after 
the sampler accessed a position. 

InjectionDelay 0.0 - 10.0 min Determines how long the sampler waits 
between injections. 

InjectionMode Split_Splitless,  
On_ Column,  
Neat,  
Viscous,  
Volatile,  
User_Defined,  

Only if the injection mode is set to User 
Defined, all sample parameter can be 
controlled in Chromeleon.  

InjectorPosition Position_1,  
Position_2,  
Both 

Sets which injector is used first for the 
injection. (If only one injector is installed, 
the property is read-only.) 

InjectWaitTime 0.0 - 10000000.0 Indicates the time between the Inject 
command in Chromeleon and the 
response to Chromeleon from the 
autosampler. 

IntStd_AirGap On, Off (Only 8400 for the Viscous, Volatile, and 
User_Defined injection modes) Enables 
usage of an air gap for the internal 
standards. 

IntStd_Delay 0.0 - 9.9 s (Only 8400 for the Viscous, Volatile, and 
User_Defined injection modes) Delay 
time for the internal standards. 

IntStd_Enable On, Off (Only 8400 for the Viscous, Volatile, and 
User_Defined injection modes) Enables 
usage of an internal standard. 
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Property/Command Range/Values Description 
IntStd_Position I, II, III Position of the internal standard. 
IntStd_Speed 0.1 - 25.0 µl/s  

(5µl syringe) 
0.1 - 50.0 µl/s  
(10µl syringe) 
1 - 100 µl/s  
(100µl syringe) 

(Only 8400 for the Viscous, Volatile, and 
User_Defined injection modes) Speed 
with which an internal standard is drawn. 

IntStd_Volume 0.0 - 4.9 µl  
(5µl syringe) 
0.0 - 9.9 µl  
(10µl syringe) 
0.0 - 99 µl  
(100µl syringe) 

(Only 8400 for the Viscous, Volatile, and 
User_Defined injection modes) Volume 
of the internal standards. 

PlungerStrokes.Upperlimit 1 - 10000 (Only 8400) Sets the upper limit for the 
number of plunger strokes. 

PlungerStrokes.Value 0 - 10000 (Only 8400) Indicates the number of 
plunger strokes. The property can be 
reset to 0 after a piston has been 
exchanged. 

PostWash 0 - 99 (Only 8400) Sets how often the syringe is 
washed with solvent after the injection. 

PreWash 0 - 99 (Only 8400) Sets how often the syringe is 
washed with solvent before the injection. 

SampleAirGap On, Off Enables usage of an air gap for samples. 
SampleDepth 0 - 100 % (Only 8400) Sets how deep the syringe 

needle descends into the sample vial. 
SampleWash 0 - 99 (Only 8400) Sets how often the syringe is 

filled with sample before the injection. 
SecondInjectionVolume 0.1 - 5.0 µl  

(5µl syringe) 
0.1 - 10.0 µl  
(10µl syringe) 
0.1 - 100 µl  
(100µl syringe) 

(Only 8400 if both injection ports are 
enabled in the configuration) Sets the 
volume for the second injection. 

SolventDepth 0 - 100 % (Only 8400) Sets how deep the syringe 
needle descends into the solvent vial. 

SolventPlug_AirGap On, Off Enables usage of an air gap for solvent 
plugs³. 

SolventPlug_Delay 0.0 - 9.9 s Delay time for solvent plugs³. 
SolventPlug_Position I, II, III Position of the solvent plug³. 



1074 Commands and Tips for Third-Party Devices 

Property/Command Range/Values Description 
SolventPlug_Speed 0.1 - 25.0 µl/s  

(5µl syringe) 
0.1 - 50.0 µl/s  
(10µl syringe) 
1 - 100 µl/s  
(100µl syringe) 

Speed with which the solvent plugs are 
drawn³. 

SolventPlug_Volume 0.0 - 5 µl  
(5µl syringe) 
0.0 - 10 µl  
(10µl syringe) 
0.0 - 100 µl  
(100µl syringe) 

Solvent plug volume³. 

Speed_1 (or Speed_2) 1 - 30 % (Only 8400 if the injection port 1 (or 2) is 
enabled in the configuration) Sets how 
fast the syringe needle descends into the 
injector. 

State On, Off (Only 8400) Indicates whether the 
sampler has injected. 

Status Ready,  
Running,  
Suspended,  
Resetting 

(Only 8400) Indicates the autosampler 
status*. 

SyringeVolume 5µl, 10µl, 100µl Indicates the syringe volume*.  
VialDetect On, Off (Only 8400) If VialDetect = On (default 

setting), the sample checks whether a 
sample vial is available at the next 
position. If the vial is missing, the injection 
is aborted. If VialDetect = Off, no error 
message is logged if the vial is missing. 

Visc_Delay 0.0 - 9.9 s Delivery time for viscous samples³. 
Visc_DispenseSpeed 0.1 - 25.0 µl/s  

(5µl syringe) 
0.1 - 50.0 µl/s  
(10µl syringe) 
1 - 100 µl/s  
(100µl syringe) 

Speed with which viscous samples are 
dispensed³.  

Visc_DrawSpeed 0.1 - 25.0 µl/s  
(5µl syringe) 
0.1 - 50.0 µl/s  
(10µl syringe) 
1 - 100 µl/s  
(100µl syringe) 

Speed with which viscous samples are 
drawn³. 

Visc_PostInjectionDelay 0.0 - 99.9 s Time that the needle remains in the 
injector after a viscous sample was 
injected³. 
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Property/Command Range/Values Description 
Visc_PreInjectionDelay 0.0 - 99.9 s Time that the needle remains in the 

injector before a viscous sample is 
injected³. 

⇒Volume 0.1 - 5.0 µl  
(5µl syringe) 
0.1 - 10.0 µl  
(10µl syringe) 
0.1 - 100 µl  
(100µl syringe) 
For the 8100/8200:
Max. ¾ of the 
syringe volume 

Injection volume. 
An error message appears if the total 
injection volume (Volume + 
IntStd_Volume + SolventPlug_Volume + 
AirPlugAfterSample) exceeds the syringe 
volume. 

WashCycles 0 - 10 (Only 8400) Sets how often the syringe is 
washed after an abort. 

WashSpeed 0.1 - 25.0 µl/s  
(5µl syringe) 
0.1 - 50.0 µl/s  
(10µl syringe) 
1 - 100 µl/s  
(100µl syringe) 

(Only 8400) Sets the speed with which 
the wash volume is drawn. 

WashVials I, II, III, I_II, I_III, 
I_II_III 

(Only 8400) Sets from which wash vial(s) 
the wash solvent is drawn. 

WashVolume 0.1 - 5.0 µl  
(5µl syringe) 
0.1 - 10.0 µl  
(10µl syringe) 
0.1 - 100 µl  
(100µl syringe) 
For 8100/8200: 
maximum ¾ of the 
syringe volume 

Wash volume. 

 

 Notes:   

* These properties are read-only. 

² Chromeleon supports these properties only if the injection port setting on 
the Sampler tab page in the Server Configuration is Injection ports = 
Position 1 and 2. 
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³ Chromeleon supports these properties only for the 8400 in the 
User_Defined injection mode. An error message is displayed if these 
properties are set in an injection mode other than User_Defined: 
 
For an overview of the Varian 3800 GC, refer to Hardware Installation: 
Installing and Controlling Third-Party Devices  Varian 3800 GC: 
Overview in the Administrator Help section. 

For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Varian 3800 GC: Installation in the 
Administrator Help section. 

 Varian 3800 GC: Injector 

In addition to the  General Device Commands, the Varian 3800 GC 
supports the following injector commands and properties (please note that 
the display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Values Description 
ConstantFlow 0.0 - 50.0 ml/min (Only if a type 1 electronic flow control (EFC) 

is installed) Nominal value for a constant flow 
rate. 

ConstantFlowMode On, Off (Only if an EFC type 1 is installed) Enables or 
disables ConstantFlow. 
If ConstantFlowMode is disabled and 
Pressure.Nominal is not in the allowed range, 
the nominal pressure is set to the minimum 
pressure of 0.007 bar. 

Cryo On, Off (Only if a cooling element is installed) Turns 
the cooling element on or off. 

CryoTimeout Off, 0.01 - 999.99 min (Only if a cooling element is installed) Time 
that the GC waits before turning off the 
cooling if no sample was injected. 

CryoThreshold 30 - 450°C (Only if a cooling element is installed) 
Temperature above which the GC shall use 
cryo for cooling. 

Description On-Column Injector, 
Universal Capillary 
Injector, 
Split/Splitless Capillary 
Injector,  
EFC only 

Indicates the inlet type*. 
EFC_only means that only EFC is installed 
(without injector). 
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Property Range/Values Description 
EFCFault Fault, OK (Only if electronic flow control (EFC) is 

installed) Indicates an error in the injector 
EFC.  

EFCReady Ready, NotReady (Only if EFC is installed) Indicates whether 
the injector EFC has reached the target 
temperature and/or flow and is ready, 

EFCType None, 1, 3, 4, Generic 
(Reserved) 

Indicates the type of injector electronic flow 
control (EFC) 

Flow  Properties related to the total flow 
Flow. Value 1.0 - 1000.0 ml/min (Only if EFC type 1 and 3 is installed) 

Indicates the current flow*. 
Flow.Nominal 0.1 - 100.0 ml/min (Only if EFC type 3 is installed) Sets the 

target flow. 
The pressure range can be programmed; the 
allowed range is 0.007 to 27.576 bar/min in 8 
increments (including the first value). 

GasSaverFlow 1 - 100 ml/min (Only if EFC type 1 is installed) Sets the 
minimum gas flow to which the flow is 
reduced. 

GasSaverTimeout 0.00 .. 999.99 min (Only if EFC type 1 is installed) Time after 
which the gas flow is reduced to the minimum 
gas flow (see GasSaverFlow). 

Mode Split, Splitless (Only for 1079 and 1177 with EFC) Indicates 
split or splitless mode.  

OvenFault² Fault, OK Fault indicates a fault in the injector oven. 
OvenReady² Ready, NotReady Ready indicates whether the injector oven 

reached the target temperature and is ready. 
Pressure  Properties related to the column pressure. 

Pressure.Value 0.007 - 6.894 bar (Only if EFC type 1 and 3 is installed) 
Indicates the current pressure in the column 
head*. 

Pressure.Nominal 0.007 - 6.894 bar (Only if EFC type 1 is installed) Sets the 
injector target pressure. 
The pressure range can be programmed; the 
allowed range is 0.007 to 27.576 bar/min in 8 
increments (including the first value). 

PulseEnable On, Off (Only if EFC type 1 is installed) Enables or 
disables the pressure pulse. 

PulsePressure 0.007 - 6.894 bar (Only if EFC type 1 is installed) Sets the 
target value for the pressure pulse. 

PulseTime 0.01 - 5.00 min (Only if EFC type 1 is installed) Sets the 
duration of the pressure pulse. 
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Property Range/Values Description 
SplitRatio 1 - 10000 (Only for the 1079 and 1177 with EFC). Sets 

the split ratio. 
The ratio can be programmed; a maximum of 
six increments (including the first value) is 
allowed. An error message appears if the 
SplitRatio is set for SplitMode = Splitless. 

SplitlessVentFlow 0 - 500 ml/min (Only if EFC type 1 is installed) System flow 
when the split valve is closed. 

Temperature²  Properties related to the injector temperature  
Temperature. 
Value² 

-99°C - 450°C  Indicates the current temperature*. 

Temperature. 
Nominal² 

-99°C - UpperLimit Sets the target temperature.  

Temperature. 
UpperLimit² 

50 - 450°C If the temperature exceeds this value, 
Chromeleon aborts the batch and starts 
emergency handling. 

Type 1041, 1079,  1177,   
EFC only 

Indicates the inlet type*. 
EFC_only means that only EFC is installed 
(without injector).  

 Notes:   
* These properties are read-only. 

² These properties are available only if a heating zone was specified for the 
associated injector in the Server Configuration program. 
 
For an overview of the Varian 3800 GC, refer to Hardware Installation: 
Installing and Controlling Third-Party Devices  Varian 3800 GC: 
Overview in the Administrator Help section. 

For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Varian 3800 GC: Installation in the 
Administrator Help section. 
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 Varian 3800 GC: Column 

In addition to the  General Device Commands, the Varian 3800 GC 
supports the following column commands and properties (please note that 
the display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Values Description 
Diameter 0 - 999 µm Inner column diameter (read-only; for packed 

columns, the entry is 0 µm). 
Flow 0.0 - 999.99 min Indicates the flow rate in the column (read-

only).  
GasType He, H2, N2 Type of the carrier gas (read-only). 
Length 0.00 - 250 m Column length (read-only; for packed columns, 

the entry is 0.00 m) 
Mode Standard, 

Rapid_MS 
Column mode. 

SeptumPurgePressure 0.007 .. 6.894 bar Pressure at the column's purge head septum 
(read-only). 

SeptumPurgeFlow 0.1 ..100.0 ml/min Flow rate at the column's purge head septum 
(read-only). 

Velocity 0.0 - 999.99 cm/s Linear velocity in the column (read-only).   

For an overview of the Varian 3800 GC, refer to Hardware Installation: 
Installing and Controlling Third-Party Devices  Varian 3800 GC: 
Overview in the Administrator Help section. 

For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Varian 3800 GC: Installation in the 
Administrator Help section. 
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 Varian 3800 GC: Detectors 

In addition to the  General Device Commands and the standard 
detector commands (see  Dionex Detectors), the Varian 3800 GC 
supports the following detector commands and properties (please note that 
the display Filter level determines which commands and properties are 
displayed): 
 
Property Range/Values Description 
AirFlow  Properties related to the air flow. 

AirFlow. Value 0 - 500 ml/min (Only for type 11 or type 12 electronic flow 
control (EFC)) Current air flow (read-only). 

AirFlow.Nominal 0 - 500 ml/min (Only for type 11 or type 12 EFC) Sets the 
target air flow. 

BalancePercentage -100 - 100 % Balance percentage for the bridge (read-
only). The property is set during Autozero in 
such a way that the signal value is 0. 

Baseline -10^8 - 10^8 mV Current baseline value (read-only). 
BeadCurrent 2.4 .. 3.8 A (Only TSD) Sets the current at the bead. 
BeadPower On, Off (Only TSD) Turns the bead power on or off 

(read-only). 
CellContactPotential -800 - 800V (Only ECD) Cell contact voltage. 
CellCurrentSelection N2_High, N2_Standard, 

CAP, AR_CH4, ZERO 
(Only ECD) Selection of the cell current, 
based on the gas type. 

Channel1_GasType Helium Makeup, 
Nitrogen Makeup, 
Argon Makeup 

(Only for type 11, 12, or 14 EFC) Type of the 
carrier gas in channel 1 (read-only) 

Channel2_GasType 
(Type 11 or 12 EFC) 

Hydrogen (Only for type 11 or type 12 EFC) Type of the 
carrier gas in channel 2 (read-only) 

Channel2_GasType 
(Type 14 EFC) 

Helium Makeup, 
Nitrogen Makeup, 
Argon Makeup, 
Helium Reference, 
Nitrogen Reference, 
Argon Reference 

(Only for type 14 EFC) Type of the carrier gas 
in channel 2 (read-only) 

Channel3_GasType Air (Only for type 11 or type 12 EFC) Type of the 
carrier gas in channel 3 (read-only)  

CheckFlameOut On, Off (Only FID) Enables the check whether the 
flame is burning. 
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Property Range/Values Description 
Description Flame Ionization 

Detector, 
Thermal Conductivity 
Detector, 
Thermionic Specific 
Detector, 
Electron Capture 
Detector 

Detector type (read-only) 

DetFault Fault, OK Fault indicates a detector error. 
DetReady Ready/NotReady Indicates whether the detector has reached 

the initial condition and is ready.  
EFCFault Fault, OK (Only if EFC is installed) Indicates an error in 

the detector EFC (read-only). 
EFCReady Ready, NotReady (Only if EFC is installed) Indicates whether 

the detector EFC has reached the target flow 
and is ready (read-only). 

EFCType None, 11, 12, 15, 16 Indicates the type of detector electronic flow 
control (read-only; electronic flow control = 
EFC) 

Electronics On, Off (FID, TCD, and ECD) Turns the electronic 
elements of the detector on or off. 

  Note: 
If the electronic elements are off, the GC can 
be Ready even if, e.g., the flame of the FID is 
not burning. 

FilamentCurrent 0 .. 500 mA (Only TCD) Indicates the current of the 
filament (read-only). 

FilamentTemerature. 
Nominal 

0 - 490°C (Only TCD) Sets the target temperature for 
the filament. 

FilamentTemerature. 
UpperLimit 

390°C or 490°C (Only TCD) Upper limit for the filament 
temperature (read-only) 

FilamentTemerature. 
Value 

0 - 490°C (Only TCD) Current temperature of the 
filament (read-only). 

GasType He, N2_Ar Type of the carrier gas. 
HydrogenFlow  Properties related to the hydrogen flow  

HydrogenFlow. 
Value 

0 - 500 ml/min (Only for type 11 or type 12 EFC) Current 
flow (read-only) 

HydrogenFlow. 
Nominal 

0 - 500 ml/min (Only for type 11 or type 12 EFC) Sets the 
target hydrogen flow. 

MakeupFlow  Properties related to the carrier gas flow. 
MakeupFlow. 
Value 

0 - 50 ml/min 
(Type 11, 12, or 14 
EFC) 

(Only for type 11, 12, or 14 EFC) Current 
carrier gas flow (read-only)  
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Property Range/Values Description 
MakeupFlow. 
Nominal 

0 - 50 ml/min 
(Type 11, 12, or 14 
EFC) 

(Only for type 11, 12, or 14 EFC) Sets the 
carrier gas target flow. 

OvenFault Fault, OK Fault indicates a detector oven error.  
OvenReady Ready/NotReady Indicates whether the detector oven has 

reached the target tempeature and is ready.  
Polarity Negative, Positive Sets the detector polarity. The polarity can be 

programmed in up to 7 increments (including 
Range and Autozero). 

Range 9, 10, 11, 12  
(FID, TSD)  
0.05, 0.5, 5.0 (TCD) 
1, 10 (ECD) 

Sets the output range of the detector. The 
range can be programmed in up to 7 
increments (including Polarity and Autozero). 

  Note: 
This range also refers to digital signals. 

ReferenceFlow  Properties related to the reference gas flow 
ReferenceFlow. 
Value 

0 - 100 ml/min (Only for type 14 EFC) Current reference gas 
flow (read-only)  

ReferenceFlow. 
Nominal 

0 - 100 ml/min (Only for type 14 EFC) Sets the reference gas 
target flow. 

Signal Signal.LowerLimit - 
Signal.UpperLimit 

Current detector signal (read-only) 

Signal.LowerLimit -10^8 mV bis 10^8 mV Lower limit for the detector signal (read-only) 

Signal.UpperLimit -10^8 mV bis 10^8 mV Upper limit for the detector signal (read-only) 

TempCtrl On / Off Turns the detector oven on or off. 
Temperature. 
Nominal 

-99 - Upperlimit Sets the target temperature for the detector. 

Temperature. 
Upperlimit 

50 - 450°C  Upper limit for the detector temperature 
(read-only) 

Temperature. 
Value 

-99 - 450°C  Current detector temperature (read-only) 

TimeConstant Slow, Fast Sets the time constant for the noise filter of 
the detector.  

Type FID, ECD, TCD, TSD Indicates the detector type (read-only).   
For an overview of the Varian 3800 GC, refer to Hardware Installation: 
Installing and Controlling Third-Party Devices  Varian 3800 GC: 
Overview in the Administrator Help section. 

For installation details, refer to Hardware Installation: Installing and 
Controlling Third-Party Devices  Varian 3800 GC: Installation in the 
Administrator Help section. 
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 Varian 3800 GC: Troubleshooting 

Problem:  
The gas chromatograph does not start after reconfiguration has been 
performed in the Ethernet setup. This may be due to errors in the Ethernet 
configuration.  

Solution:  
Follow the steps below:  

1. Uninstall the network card. Please note that the network card is located 
behind the EPROM card. Therefore, uninstall the EPROM card first.  

2. Reinstall the EPROM card.  

3. Start the gas chromatograph. 

4. Reconfigure the gas chromatograph as follows: 
• Set BOOTP to No. 

• Enter the associated network address in the Network Address field. 
Verify that no other PC or device is already using this address. 

• In addition, make sure that the subnet mask is identical to the subnet 
mask of the PC and that the gateway addresses and the IP 
addresses of the gas chromatograph and the PC are identical as 
well. 

5. Restart the instrument via Save+Exit (without the network card) to check 
whether the instrument accepted the changes. 

6. Turn the instrument off. 

7. Reinstall the network card. 

8. Reconnect and restart the instrument. 
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Problem:  
It looks as if changes to different parameters, such as ConstFlowMode, 
ConstFlow, and Pulse are not transmitted to the instrument. 

Solution:  
The method that is displayed on the instrument is not the method that is 
actually used. Set Active Method on the instrument to display the currently 
used method. 

 Tip:  
In addition, set Edit Method to Method 8. This ensures that Method 8, 
which is used by Chromeleon, is displayed in any case. 

 Varian 3400 and Varian 3600 GCs 
The Varian 3400 GC and Varian 3600 GC device drivers support the 
following commands and properties (please note that the display Filter 
level determines which commands and properties are displayed): 

Columns and Main Device 
 
Property Min Max Default Description 
CausesForNotReady N/a N/a N/a Indicates why the driver is not in 

Ready state (read-only). 
Connected Off On Off Indicates whether the GC is 

connected to Chromeleon. 
CryoHasTimeout Off On Off Indicates whether a cryogenic 

coolant time out occurs (read-
only). 

CryoTimeout 2.00 650.00 650.00 If no run starts after the specified 
time (in [min]), cooling is stopped 
to save coolant. To disable 
CryoTimeout, set the property to 
Infinite. 

CryoToColumn Off On Off Turns cryogenic cooling for the 
column thermostat on and off.  

CryoToInjector Off On Off Turns cryogenic cooling for the 
injector on and off. (For the Varian 
3400 GC, this is an Injector 
property.) 
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Property Min Max Default Description 
ModelNo N/a N/a N/a Indicates the model number (read-

only). This property is available 
only for the Varian 3600 GC. 

Ready N/a N/a N/a Indicates whether the GC is ready 
for injection (read-only). 

StabilizationTime 0.00 650.00 2.00 After reaching the desired 
temperature, the GC waits for the 
specified time (in [min]) before 
indicating Ready. 

StabilizationTimeRemainder N/a N/a N/a Indicates how much time of the 
StabilizationTime is left (read-
only). This property is available 
only for the Varian 3600 GC. 

SystemState N/a N/a N/a Indicates the current GC status: 
Run, Equilibrate, Stabilize, Wait, 
Sample, Test, RunEnd, or ERROR 
(read-only). 

TempCtrl Off On On Turns the oven on or off.  
Temperature.UpperLimit ² ² ² Sets the maximum temperature for 

the oven.  
Temperature.Nominal ² ² ² Sets the nominal temperature for 

the oven 
Temperature.Value -99°C 420°C 50°C Indicates the actual temperature of 

the oven (read-only). 

² The values depend on the device settings. 
 
Command Description 

⇒Connect Connects the GC to Chromeleon. 
Disconnect Disconnects the GC from Chromeleon. 
⇒Reset Resets the GC. 
 

Auxiliary Heater 
 
Property Min Max Default Description 
TempCtrl Off On ² Turns the auxiliary heater on and off. 
Temperature.Nominal ² ² ² Sets the nominal temperature of the 

auxiliary heater. 
Temperature.UpperLimit ² ² ² Sets the maximum temperature of 

the auxiliary heater. 
Temperature.Value -99°C 420°C 50°C Indicates the actual temperature of 

the auxiliary heater (read-only) 

² The values depend on the device settings. 
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Autosampler 
 
Property Min Max Default Description 
AirDry Off On On Enables or disables air drying after the 

injection.  
Depth  0% 100% 90% Sets how deep the needle moves into the 

vial: 0%: septum height; 100%: to the 
bottom of the vial. 

InjectWaitTime 0.0 10000000.0 N/a Indicates the time delay [sec] between the 
injection command and the inject 
response.  

LowerAirGap Off On On Sets whether an air gap is used below the 
sample.  

Position 101 412 101 Indicates the position of the vial used for 
injection. Range: 
101 ... 112; 201 ... 212; 
301 ... 312; 401 ... 412 

PostDwell 0.00 10.00 0.10 Sets the time [min] that the needle remains 
in the injection port after the injection. 

PreDwell 0.00 1.00 0.00 Sets how long ([min]) the needle stays in 
the injection port before the injection. 

Purge N/a N/a A_only Sets which solvent bottles are used for the 
washing process: A_only, B_only, 
A_then_B, or No_wash 
(For the Varian 3400 GC, this is an Injector 
property.) 

SamplerStatus N/a N/a N/a Indicates the current state of the 
autosampler: ERROR, Searching, 
Washing, Sampling, Injecting, Waiting, 
Stop_Pin_Found, No_Vial, or 
Not_in_method (read-only). 

SolventPlug 0.0 µl 3.0 µl 0 µl Sets the solvent volume for the injection. 
Speed 0.2 10.0  5.0  Sets the average injection speed [µl/sec]  
State Off On N/a Indicates whether the autosampler has 

injected the sample. 
UpperAirGap Off On On Sets whether an air gap is used above the 

sample. 
Volume ² ² ² Sets the injections volume.²   

² The values depend on the syringe volume. The Varian 3600 GC supports 
a variable syringe volume. 
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Command Description 

⇒Inject Performs an injection. 
 

Injector 
 
Property Min Max Default Description 
Flow.Nominal³ 0  100  40  Sets the nominal carrier gas flow 

[ml/min] 
Flow.Value³ 0  100  N/a Indicates the actual carrier gas flow 

[ml/min] (read-only). 
Pressure.Nominal³ 0  60  15  Sets the nominal carrier gas 

pressure [psi]. 
Pressure.Value³ 0  60  N/a Indicates the actual carrier gas 

pressure [psi] (read-only). 
TempCtrl Off On On Turns the injector heater on or off.  
Temperature.Nominal ² ² ² Indicates the nominal temperature of 

the injector heater.  
Temperature.UpperLimit ² ² ² Sets the maximum temperature of 

the injector heater. 
Temperature.Value -99°C 420°C 50°C Indicates the actual temperature of 

the injector heater (read-only). 

² The values depend on the device settings. 

³ These properties are available only if you have selected the Injector Flow 
Control or Injector Pressure Control option on the Components tab 
page in the Server Configuration program.  
 

Valve (available only for the Varian 3600 GC) 
 
Property Min Max Default Description 
Duration 0.00  59999.90 N/a When set, the relay switches after the 

indicated time [sec]. 
State Off On Off Indicates and sets the valve's state.  
Command Description 
Off Turns the valve off. 
On Turns the valve on.  
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Also, refer to  Varian 3400 3600 GCs: Different Names in Firmware 
and Chromeleon. 

For an overview of the Varian 3400 GC, refer to Hardware Installation 
 Varian 3400 GC  in the Administrator Help section. 

For an overview of the Varian 3600 GC, refer to Hardware Installation 
 Varian 3600 GC in the Administrator Help section. 

 Varian 3400 and 600 GCs: Different Names in Firmware 
and Chromeleon  

 Tip:   

Dionex recommends avoiding manual input on the device. Chromeleon 
cannot read all settings from the device. Therefore, manual settings on the 
device may lead to errors in the program. 

For consistency reasons, the names of some Chromeleon properties and 
commands are different from the names used in the instrument's firmware: 

Columns and Main Device  
Instrument Chromeleon 
Coolant To Injector CryoToInjector 
Coolant To Column CryoToColumn 
Fault 39 CryoHasTimeout 
Coolant Time Out² CryoTimeout 
div. fault codes CausesForNotReady 
Thermal Stabilize Time² StabilizationTime 
Column Oven On/Off TempCtrl 
Column Temp Limit³ Temperature.UpperLimit 
Initial Column Temp Temperature.Nominal  

 Tip:   

² Chromeleon cannot read Coolant Time Out and Thermal Stabilize Time 
from the instrument. Therefore, these setting are overwritten when 
Chromeleon connects to the instrument and when the sample is started. 
Please do not set these parameters on the instrument. 
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Auxiliary oven 
Instrument Chromeleon 
Auxiliary Oven On TempCtrl 
Auxiliary Temp Limit Temperature.UpperLimit 
Initial Aux Temp Temperature.Nominal 

Autosampler 
Instrument Chromeleon 
A/S Solvent Plug Size SolventPlug 
A/S Lower Air Gap LowerAirGap 
A/S Upper Air Gap UpperAirGap 
A/S Air Dry After Wash AirDry 
A/S Solvent Select Purge 
Vial Needle Depth Depth  
A/S Residence Time PostDwell 
A/S Hot Needle Time PreDwell 
A/S Uptake Speed Speed 

Injector 
Instrument Chromeleon 
Pressure Pressure.Nominal 
Flow Flow.Nominal 
Injector Oven On/Off TempCtrl 
Injector Temp Limit Temperature.UpperLimit 
(Initial) Injector Temp Temperature.Nominal 

Valve (available only for the Varian 3600 GC) 
Instrument Chromeleon 
Initial Relays State  

 Tip:   

³ Chromeleon cannot read the temperature limits from the instrument. 
Therefore, these setting are overwritten when Chromeleon connects to the 
instrument and when the sample is started. Please do not change the 
temperature limits on the instrument. 
 
For detailed information about the different commands and the allowed 
minimum and maximum values, refer to  Varian 3400 and 3600 GCs. 
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 Varian 3400 and Varian 3600 GCs: Detectors 
The Varian 3400 and 3600 GC device drivers support the following 
commands and properties for the different detectors (please note that the 
display Filter level determines which commands and properties are 
displayed): 

General Detector Properties 
 
Property Min Max Default Description 
Attenuation 1 8 1 Sets the attenuation of the 

detector signal  
Baseline -1315.80 1315.80 N/a Indicates the actual baseline 

value.  
TempCtrl Off On On Turns the detector heater on or 

off. 
Temperature.Nominal ² ² ² Sets the nominal temperature for 

the detector heater.  
Temperature.UpperLimit ² ² ² Sets the maximum temperature 

for the detector heater. 
Temperature.Value -99°C 420°C 50°C Indicates the actual temperature 

of the detector heater (read-
only). 

Type TCD, FID, TSD, or 
ECD 

N/a Indicates which type of detector 
is installed. 

² The values depend on the device settings. 
 
Command Description 

⇒Autozero Sets the current detector signal to 0. 
 

Thermal Conductivity Detector (TCD) 
 
Property Min Max Default Description 
FilamentTemp 50°C 390°C 50°C Sets the temperature of the TCD 

filament.  
Polarity Negative Positive Positive Sets the polarity of the detector 

signal. 
Range 5 500 500 Range for the output signal: 5, 50, 

500.  
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Flame Ionization Detector (FID) 
 
Property Min Max Default Description 
Range 10^8 10^12 10^8 Range for the output signal.   

Thermionic Specific Detector (TSD) 
 
Property Min Max Default Description 
BeadCurrent 2400  3800  2400  Indicates the current bead power 

[mA]. 
BeadPower 
(TSD_BeadPower 
for the Varian 3400 GC) 

Off On On Turns the TSD bead power on or off. 

Range 10^8 10^12 10^8 Range for the output signal.   

Electron Capture Detector (ECD) 
 
Property Min Max Default Description 
Range 1 10 1 Range for the output signal (allowed 

values: 1 and 10).   
Also, refer to  Varian 3400 3600 GC Detectors: Different Names in 
Firmware and Chromeleon. 

For an overview of the Varian 3400 GC, refer to Hardware Installation 
 Varian 3400 GC in the Administrator Help section. 

For an overview of the Varian 3600 GC, refer to Hardware Installation 
 Varian 3600 GC in the Administrator Help section. 
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 Varian 3400 and 3600 GC Detectors: Different Names in 
Firmware and Chromeleon 
For consistency reasons, the names of some Chromeleon properties and 
commands are different from the names used in the instrument's firmware: 

General Detector Properties 
Instrument Chromeleon 
Detector A/B Oven On TempCtrl 
Detector Temp Limit² Temperature.UpperLimit 
Detector Temp Temperature.Nominal 
Initial Atten Attenuation  

 Tip:   

² Chromeleon cannot read the temperature limits from the instrument. 
Therefore, these setting are overwritten when Chromeleon connects to the 
instrument and when the sample is started. Please do not change the 
temperature limits on the instrument. 

Thermal Conductivity Detector (TCD) 
Instrument Chromeleon 
TCD Filament Temp Off FilamentTemp 
Initial Range Range 
Polarity Positive Polarity  

Flame Ionization Detector (FID) and Electron Capture Detector (ECD) 
Instrument Chromeleon 
Initial Range Range  

Thermionic Specific Detector (TSD) 
Instrument Chromeleon 
Bead Power On BeadPower 
Bead Current In Amps BeadCurrent 
Initial Range Range  
For detailed information about the different commands and the allowed 
minimum and maximum values, refer to  Varian 3400 and 3600 GCs: 
Detectors. 
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 Varian 3400 and 3600 GCs: Tips for Operation 

Method 
For the 3600 GC:   
The driver always uses Method 1. The method is automatically activated 
and overwritten with the settings in Chromeleon. 

For the 3400 GC:   
The driver for the Varian 3400 GC cannot identify whether a reset was 
performed on the instrument or a different method was selected. Therefore, 
Dionex recommends that you always activate Method 1 before Chromeleon 
connects to the instrument and that you do not change this setting while 
Chromeleon controls the instrument. 

Setting Properties 
You can set properties only if the GC is not in Sample, Run, or RunEnd 
mode. If you set a property for the 3400 GC although the GC is in one of 
the above modes, execution is postponed until the GC is no longer in this 
mode. A message is written to the Audit Trail. If you set a property for the 
3600 GC although the GC is in one of the above modes, a message is 
written to the Audit Trail but the command will not be executed. 

The only commands and properties that can be used after an Inject 
command are: temperature gradients for the column oven, Acquisition 
On/Off, Delta, Average, and Step. Therefore, define all properties that are 
required for the method before the Inject command. A Reset command 
can always be sent. 

If you want to include the temperature for an isocratic column oven in a 
program, define the desired temperature before and after the Inject 
command, and at the final program time. Otherwise, runtime calculation will 
not be correct. 

Example: 
 
0.000 GC.Temperature = 100 
  Wait GC.Ready 
  Inject  
 GC.Temperature = 100 
30.000 GC.Temperature = 100 
 End   
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Entering a Temperature Gradient 
Temperature gradients can be defined only for the column heater. 

Enter the temperature gradient either directly, by selecting the Flow 
command on the Control menu, or via a Program. 

Chromeleon supports a temperature profile with up to four ascents. The 
maximum change in temperature is 50°C per minute. Descending 
temperature profiles are not supported. The GC returns to the initial 
temperature when the gradient is completed.  
 

3600 GC: Flow / Pressure 
The gas chromatograph maintains a constant pressure or flow for column A 
or column B, depending on the value that was entered last. This is how the 
column is selected. 

Example: 

If the following command was entered last: 
 Injector_B.Flow = 1  

the flow for column B is kept constant at 1 ml/min. 
 
For an overview of the Varian 3400 GC, refer to Hardware Installation 

 Varian 3400 GC in the Administrator Help section. 

For an overview of the Varian 3600 GC, refer to Hardware Installation 
 Varian 3600 GC in the Administrator Help section. 
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 Varian 3400 and 3600 GCs: Troubleshooting 

Problem: The GC does not reach the Ready state 
In addition, the following message appears in Chromeleon: 
GC.CausesForNotReady=Remote_In. 

Solution:  
Disable the Remote input on the device. Select Set Checks on the 
Configuration menu and set Wait for ext. device ready? to No. 
 

Error messages in Chromeleon: 
(GC) Communication Error:  Bad Response to "0" command 0 
Problem: The instrument uses a method from the GC's method table. 

The error message is repeated until Chromeleon disconnects 
from the instrument. 

Solution: On the instrument, delete all references to Method 1: 

Select Method 1. 

Press Delete/Section Table and select Section or Table, and then 
select Method 1. Select the section you want to delete (here: 
Column). The following message should appear on the 
instrument: Section Cleared. 

Repeat these steps for the Injection Port, Autosampler, and 
Detector sections of the instrument. 

If you want to use a Varian GC method (instrument) in 
Chromeleon, you have to add an autosampler. Select 
Build/Modify, and then select Method 1. Enable the autosampler 
in the method by selecting the autosampler and adding it to 
Method 1. 
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(GC) Communication Error:  Bad Response to XB?22@DS Command: 
XB?22@DS COMMAND (or … to XC?22@DX Command: XC?22@DS 
COMMAND) 
Problem: No autosampler has been defined in the Varian GC method (on 

the instrument). 

Solution: Add the autosampler to the Varian GC method in Single mode. 
Select the autosampler on the instrument's panel via 
Build/Modify > Method 1 > Autosampler > Add Autosampler 
Section > Yes. 

 

(GC) Communication Error:  Bad Response to "Read Flag Not Ready" 
Command: ;B?22@DS COMMAND (or C?22@DS COMMAND) 
Problem: Communication error due to incompatible EPROM or Varian GC 

CPU board. 

Solution: Replace the four outdated EPROMs with EPROMs version 03-
910617-00 Rev. 1 or higher. 

 

Autosampler not present: 
Problem: Communication error with the autosampler, mainly due to a bad 

connection.  

Solution: Disconnect the autosampler from the power source and connect 
the brown autosampler cable to the CPU board. 
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Waters: Commands and Tips 

For information about the special commands that Chromeleon supports for 
the different Waters devices and for tips for practical operation, refer to: 

 Alliance 2690/2695 HPLC Modules 

 Alliance 2790/2795 HPLC Modules 

 717plus Autosampler 

 996 and 2996 PDA Detectors 

 2487 UV Detector 

For troubleshooting information, refer to: 

 Waters Instruments: Troubleshooting 

 GPIB-Connected Devices: Troubleshooting 
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 Waters Alliance 2690/2695 HPLC Modules: Commands 
and Tips 
In addition to the standard commands (refer to Practical Tips for Device 
Control  Pump and Flow Control), the Waters 2690/2695 Separation 
Module device driver supports the following commands and properties 
(please note that the display Filter level determines which commands and 
properties are displayed):  

Pump Commands and Properties 
Property Min Max Description 
BubbleDetection², Off On Checks the System for gas bubbles in the 

flow path, can return an error message 
and perform a bubble reduction 
procedure. 
The following settings are required on the 
instrument: In the Default method, set the 
Alarms/Bubble detect field to Alert 
User, Stop Funct, or StopFlow as 
described in the instrument's manual on 
page 1 (Mobile Phase). 

Curve convex concave Gradient Curve (Default: linear) 

 Note: 

If the gradient defined by Curve is steeper 
than the one defined by the 
MaxAcceleration parameter, the actually 
performed gradient can be different from 
the gradient defined here. In this case, a 
warning appears. This is always the case 
for step gradients. 

MaxAcceleration² 0.01 min 30.00 min Sets the time needed by the pump to 
reach the maximum flow rate of 
10 ml/min. The property serves to protect 
the column from major pressure changes. 
It is connected with the 
MaximumFlowRamp property: 
MaxAcceleration =  
10 / MaximumFlowRamp 
(Default: 0.01 min. The property is visible 
only on the Advanced level.) 
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Property Min Max Description 
MaximumFlowRamp 0.34 1000.00 Sets the maximum flow rate increase in 

[ml/min²]. The property serves to protect 
the column from major pressure changes. 
It is connected with the MaxAcceleration 
property: 
MaximumFlowRamp =  
10 / MaxAcceleration 
(Default: 1000.00 ml/min². The property is 
visible only on the Advanced level.) 

⇒Pressure.LowerLimit 
Pressure.UpperLimit² 

0.0 bar 344.70 bar
(= 5000 psi)

Upper and lower pressure limits. 
For the pressure limits to take effect, the 
following setting is required on the 
instrument: In the Default method, set the 
Alarms/Min. and Alarms/Max fields to 
Alert User, Stop Funct, or StopFlow as 
described in the instrument's manual on 
page 1 (Mobile Phase). The limits entered 
last in Chromeleon are valid (not the 
values set on the instrument). 

 Note: 

The instrument checks the lower pressure 
limit only during injection. 

PrimaryPressure -3.45 bar 380 bar Sets the pressure after the first piston 
chamber. (The property is read-only and 
visible only on the Expert level.) 

StrokeVolume² Auto; 25 µL;  
50 µL; 100 µL  

Sets the volume delivered with each 
piston stroke. (Default: Auto. The property 
is visible only on the Advanced level. ) 

⇒StopFlow, 
⇒Continue 

  When using these commands for the 
pump of the Alliance system, please note: 
When the Stop command is executed 
while a gradient program is running, the 
Continue command does not restart the 
gradient. Instead, the pump is started with 
constant solvent composition and 
constant flow rate.  

 Tip:  
² It is not possible to change the property during an injection, during 
gradient runs, or at negative retention times. 
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 Note:  

As described in the instrument's manual, negative pressure readings are 
possible for the pressure behind the first piston chamber 
(PrimaryPressure property).  
 

Degasser Commands and Properties 
The standard degasser of the Waters Alliance 2690/2695 HPLC module is 
a Helium degasser. Select the following property to specify which solvent 
reservoirs shall be helium sparged and set the sparge rate for each 
reservoir:  
 
Property Min Max Default Description 
HeliumSparge_A 
to 
HeliumSparge_D² 

0 100 0 If the sparge rate is set to 100% for a 
specific reservoir, the solvent in this 
reservoir is helium sparged all the time. If 
the sparge rate is less than 100%, the 
corresponding valve turns on and off 
according to the desired percentage.  

The standard degasser of the Waters Alliance 2690/2695 XE HPLC 
modules is a vacuum degasser (In-Line Degasser). Specify the degassing 
mode: 
 
Property Value Default Description 
Degasser 
Mode² 

Normal 
Continuous 
Off 

Off Normal: The degasser turns on and off, 
depending on the pressure.  
Continuous: The degasser is always on.  
Off: The degasser is always off.  

 Tip:  
² It is not possible to change the setting during an injection, during gradient 
runs, or at negative retention times. 
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The Pressure property indicates the current pressure:   
 
Property Min Max Description 
Degasser 
Pressure 

-1.0 1.0 Indicates the pressure (in bar) measured by 
the degasser. (The property is read-only.)  

Injector Commands and Properties 
For information about the standard autosampler commands, refer to 
Control  Dionex Autosampler. 
In addition, the Waters 2690/2695 Separation Module device driver 
supports the following commands and properties (please note that the 
display Filter level determines which commands and properties are 
displayed):  
 
Property Min Max Description 
InjectWaitTime 0 1E+7 Indicates the time in seconds between the 

inject command from Chromeleon and the 
inject response from the autosampler to 
Chromeleon (read-only) 

LoopPressure -3.45 380 Indicates the pressure (in bar) in the 
sample loop (The property is read-only and 
visible only on the Expert level.) 

⇒Ready NotReady Ready Indicates the state of the autosampler. (It 
depends on the state of the sample 
temperature control if WaitForTemperature 
= Yes). 

SampleHeight² 0.0 mm 20.0 mm Indicates the distance of the needle tip from 
the bottom of the sample vial (default: 
0.0 mm). 

SyringeSpeed², Fast (5.0 ml/min) 
Normal (2.5 ml/min) 
Slow (1.0 ml/min) 

Defines the drawing speed of the syringe. 
The speed depends on the installed syringe 
type. The values correspond to a standard 
250 µL syringe. 

WaitForTemperature² No Yes Specifies whether the autosampler waits for 
the sample temperature control.  

 Tip:  
² It is not possible to change the setting during an injection, during gradient 
runs, or at negative retention times. 
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 Note: 
As described in the instrument's manual, negative pressure readings are 
possible for the sample loop pressure (LoopPressure property).  

Column Heater and Sample Temperature Control Commands and 
Properties 
For information about the standard commands for temperature control, 
refer to Practical Tips for Device Control  Temperature Control 
(On/Off) and  Controlling the Temperature. 

In addition, the following properties allow you to determine, e.g., the 
maximum allowed deviation of the actual temperature from the expected 
temperature: 
 
Property Min Max Default Description 
MaxTempDeviation² 0°C 10°C 5°C If the actual column temperature 

deviates from the expected 
temperature by more than the set 
value, an error message appears. 
The following setting is required 
on the instrument: Follow the 
description in the instrument's 
manual to set the Column 
Temperature/On error field to 
Alert User, Stop Funct, or 
StopFlow. For the column oven, 
this setting is made on page 4 
(Column); for sample 
temperature control, it is made on 
page 2 (Sample). 

⇒Ready² NotReady Ready Ready Indicates the state of the column 
heater. The heater is Ready: 
• when temperature control 

(TempCtrl) is Off   or 
• when the difference between 

the actual temperature and 
the target temperature is 
equal or less than 2°C for at 
least 30 minutes. 

TempCtrl² Off On Off Sets the state of the temperature 
control. (Temperature control is 
active only if TempCtrl = On.) 
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Property Min Max Default Description 
Temperature.Nominal² 20°C 

(4°C) 
60°C 
(40°C) 

20°C Sets the target operating 
temperature (sample temperature 
control). The temperature must 
be at least 5°C above ambient. 

Temperature.Value² 0°C 80°C  Indicates the actual temperature. 
(The property is ready-only.) 

 Note:  
For better understanding, [°C] is used as unit, even though [K] would be 
correct to indicate temperature differences. 

 Tip:  
² The temperature control commands of the column oven can be used only 
if an injection is made. In all other cases, e.g. for Blank Run Samples, an 
error message appears.  

It is not possible to change the MaxTempDeviation setting during an 
injection, during gradient runs, or at negative retention times. 

The standard relay commands are available to control the relays of the 
Waters Alliance 2690 and 2695 HPLC modules (refer to Practical Tips for 
Device Control  Relay, TTL, and Remote Input Commands). 

For information about how to install the Waters Alliance 2690 and 2695 
HPLC modules, refer to Hardware Installation  Waters Alliance 
2690/2695 HPLC Modules: Installation in the Administrator Help 
section. 

For an overview of the Waters Alliance 2690 and 2695 HPLC modules, 
refer to Hardware Installation  Waters Alliance 2690/2695 HPLC 
Modules: Overview in the Administrator Help section. 
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 Waters Alliance 2790/2795 HPLC Modules: Commands 
and Tips 
The Alliance 2790/2795 Separation Module device driver supports several 
modules. For information about the corresponding commands and 
properties, refer to:  

 HPLC System 

 Pump and Degasser 

 Injector 

 Column Heater and Sample Temperature Control  

 Overlapping Sample Preparation  

 Waters Alliance 2790/2795: HPLC System 
In addition to the standard commands (refer to Practical Tips for Device 
Control  General Device Commands), the Waters 2790/2795 
Separation Module device driver supports the following commands and 
properties for the HPLC System (please note that the display Filter level 
determines which commands and properties are displayed):  
 
Property Values Description 
ChartOut² ³ GradA, GradB, GradC, 

GradD, FlowRate, 
SampleLoopPressure, 
SystemPressure, 
PrimaryHeadPressure, 
VacuumLevel, 
SampleTemperature, 
ColumnTemperature 

Sets the type of the analog signal that 
is transmitted from the Chart Out 
output. 
The available options depend on the 
system configuration. The following 
options are available only if the 
corresponding module is installed: 

  Option Module 
  VacuumLevel Degasser 
  SampleTemperature Sample Heater 
  ColumnTemperature Column Heater 
LogStatus² On, Off If the property is set to On, each 

change of the instrument's status is 
logged in the Audit Trail. (The default 
setting is Off. The property is visible 
only on the Advanced level.) 
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Property Values Description 
PrecolumnVolume² 0.0 to 10,000.0 Specifies the solvent volume in [µl] that 

is pumped through the column before 
injection is started. (The default setting 
is 0.0 µl. The property is visible only on 
the Advanced level.) 

Status (80 characters) Indicates the status of the HPLC 
system.  

Vendor  Indicates the manufacturer (here: 
Waters). 

 Tips:  
² It is not possible to change the property during injection or during a 
gradient run. 

³ The signal condition depends on the selected ChartOut option: 

Signal Parameter at 0 mV (min) Parameter at 2000 mV (max) 
ColumnTemperature 20°C 60°C 
FlowRate  0.000 ml/min 10.000 ml/min 
GradA - GradD 0.0% 100.0% 
PrimaryHeadPressure -3.45 bar (-50 psi) 380 bar (5500 psi) 
SampleLoopPressure -3.45 bar (-50 psi) 380 bar (5500 psi) 
SampleTemperature 4°C 40°C 
SystemPressure -3.45 bar (-50 psi) 380 bar (5500 psi) 
VacuumLevel -0.0 bar  0.34 bar (4.91 psi)  

Commands 
 
Command Description 
StopOperation Stops a previously started operation (e.g., by the SysPrep or 

WetPrime commands (see below) or by the PrimeSyringe 

command, see  Waters Alliance 2790/2795 HPLC Modules: 
Injector). (The command is visible only on the Advanced level.) 

SysPrep Performs system preparation including priming the fluid components 
of the systems, rinsing the syringe, and washing the needle. (The 
command is visible only on the Advanced level.) 

WetPrime Primes the fluid components of the system with the currently selected 
flow rate and for 100.0 minutes. Use the StopOperation command to 
stop priming. (The command is visible only on the Advanced level.)  
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For information about how to install the Waters Alliance 2790 and 2795 
HPLC modules, refer to Hardware Installation  Waters Alliance 
2790/2795 HPLC Modules: Installation in the Administrator Help 
section. 

For an overview of the Waters Alliance 2790 and 2795 HPLC modules, 
refer to Hardware Installation  Waters Alliance 2790/2795 HPLC 
Modules: Overview in the Administrator Help section. 

 Waters Alliance 2790/2795: Pump and Degasser 
In addition to the standard commands (refer to Practical Tips for Device 
Control  Pump and Flow Control), the Waters 2790/2795 Separation 
Module device driver supports the following pump commands and 
properties (please note that the display Filter level determines which 
commands and properties are displayed):  

Pump Commands and Properties 
Property Min Max Description 
BubbleDetection², Off On  Checks the system for gas bubbles in the 

flow path, can return an error message 
and perform a bubble reduction 
procedure. 
The following settings are required on the 
instrument: In the Default method, set the 
Alarms/Bubble detect field to Alert 
User, Stop Funct, or StopFlow as 
described in the instrument's manual on 
page 1 (Mobile Phase). 

Continue   see StopFlow  
Curve convex concave Gradient Curve (Default: linear) 

 Note: 

If the gradient defined by Curve is steeper 
than the one defined by the 
MaxAcceleration parameter, the actually 
performed gradient can be different from 
the gradient defined here. In this case, a 
warning appears. This is always the case 
for step gradients. 
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Property Min Max Description 
MaxAcceleration² 0.01 min 30.00 min Sets the time needed by the pump to 

reach the maximum flow rate of 
10 ml/min. The property serves to protect 
the column from major pressure changes. 
It is connected with the 
MaximumFlowRamp property: 
MaxAcceleration =  
10 / MaximumFlowRamp 
(Default: 0.01 min. The property is visible 
only on the Advanced level.) 

MaximumFlowRamp 0.34 1000.00 Maximum flow rate increase in [ml/min²]. 
This property serves to protect the 
column from major pressure changes. 
This property is connected with the 
MaxAcceleration property as follows: 
MaximumFlowRamp =  
10 / MaxAcceleration 
(Default: 1000.00 ml/min². The property is 
visible only on the Advanced level.) 

⇒Pressure.LowerLimit 
Pressure.UpperLimit² 

0.0 bar 344.70 bar
(= 5000 psi)

Upper and lower pressure limits. 
For the pressure limits to take effect, the 
following setting is required on the 
instrument: In the Default method, set the 
Alarms/Min. and Alarms/Max fields to 
Alert User, Stop Funct, or StopFlow as 
described in the instrument's manual on 
page 1 (Mobile Phase). The limits entered 
last in Chromeleon are valid (not the 
values set on the instrument). 

 Note: 

The instrument checks the lower pressure 
limit only during injection. 

Pressure.Value 0.0 bar 380 bar 
(= 5500 psi)

Indicates the current pump pressure. 

PrimaryPressure -3.45 bar 380 bar Pressure after the first piston chamber 
(The property is read-only and visible only 
on the Expert level.) 

StrokeVolume² Auto; 25 µL;  
50 µL; 100 µL  

Volume delivered with each piston stroke 
(Default: Auto. The property is visible only 
on the Advanced level. ) 
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Property Min Max Description 

⇒StopFlow, 
⇒Continue 

  When using these commands for the 
pump of the Alliance system, please note: 
When the Stop command is executed 
while a gradient program is running, the 
Continue command does not restart the 
gradient. Instead, the pump is started with 
constant solvent composition and 
constant flow rate.  

 Tip:  
² It is not possible to change the property during an injection, during 
gradient runs, or at negative retention times. 

 Note:  

As described in the instrument's manual, negative pressure readings are 
possible for the pressure behind the first piston chamber 
(PrimaryPressure property).  
 

Degasser Commands and Properties 
The standard degasser of the Waters Alliance 2790/2795 HPLC modules is 
a Helium degasser. Select the following property to specify which solvent 
reservoirs shall be helium sparged and set the sparge rate for each 
reservoir:  
 
Property Min Max Default Description 
HeliumSparge_A 
to 
HeliumSparge_D² 

0 100 0 If the sparge rate is set to 100% for a 
specific reservoir, the solvent in this 
reservoir is helium sparged all the time. If 
the sparge rate is less than 100%, the 
corresponding valve turns on and off 
according to the desired percentage.  

The standard degasser of the Waters Alliance 2790/2795 XE HPLC 
modules is a vacuum degasser (In-Line Degasser). Specify the degassing 
mode: 
 
Property Value Default Description 
Degasser 
Mode² 

Normal 
Continuous 
Off 

Off Normal: The degasser turns on and off, 
depending on the pressure.  
Continuous: The degasser is always on.  
Off: The degasser is always off.  
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 Tip:  
² It is not possible to change the setting during an injection, during gradient 
runs, or at negative retention times. 
 
The Pressure property indicates the current pressure:   
 
Property Min Max Description 
Degasser 
Pressure 

-1.0 1.0 Indicates the pressure (in bar) measured by 
the degasser. (The property is read-only.)  

For information about how to install the Waters Alliance 2790 and 2795 
HPLC modules, refer to Hardware Installation  Waters Alliance 
2790/2795 HPLC Modules: Installation in the Administrator Help 
section. 

For an overview of the Waters Alliance 2790 and 2795 HPLC modules, 
refer to Hardware Installation  Waters Alliance 2790/2795 HPLC 
Modules: Overview in the Administrator Help section. 
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 Waters Alliance 2790/2795: Injector 
For information about the standard autosampler commands, refer to 
Control  Dionex Autosampler. 
In addition, the Waters 2790/2795 Separation Module device driver 
supports the following commands and properties (please note that the 
display Filter level determines which commands and properties are 
displayed):  
 
Property Min Max Description 
CheckPlateHeight² Off On When set to On, the needle position sensor 

determines the plate height before the first 
injection is performed from this plate. The 
value is checked against the range of 
values allowed for this plate type. (The 
default setting is Off. The property is visible 
only on the Advanced level.) 

FullLoopOverfill² 1.0% 99.9% Only in InjectMode = FullLoop (see below). 
Specifies the excess volume drawn to rinse 
the loop when the loop is filled with the 
sample. (The default setting is 4 %. The 
property is visible only on the Advanced 
level.) 

InjectWaitTime 0 1E+7 Indicates the time in seconds between the 
inject command from Chromeleon and the 
inject response from the autosampler to 
Chromeleon. (The property is read-only.) 

InjPortWashTime² 0, 1, 2, ... 9999 Specifies the time in seconds for inject port 
washing. (The default setting is 6. The 
property is visible only on the Advanced 
level.) 

InjectMode² PartialLoop; FullLoop Determines the injection mode. (The default 
setting is FullLoop.) 

  FullLoop The entire loop volume is 
delivered to the column. 

  PartialLoop Only part of the loop 
volume is delivered to the 
column.  

LoopPressure -3.45 380 Indicates the pressure (in bar) in the 
sample loop (The property is read-only and 
visible only on the Expert level.) 

NeedleWashTime² 0, 1, 2, ... 9999 Specifies in seconds how long the exterior 
of the needle is washed. (The default 
setting is 15. The property is visible only on 
the Advanced level.) 
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Property Min Max Description 
PrepDelay³ 0.0 Loop 

volume 
Determines in seconds how long it may 
take until the loop is completely filled. (The 
default setting is 0.0. The property is visible 
only on the Advanced level.) 

PrepSubject³ Vial positions 
Sample_Vial, Air, 
Sample_Vial ± number 
(relative addressing) 

Determines which vial is used for Draw, 
Dispense, and Mix operations. If set to Air, 
the needle first draws air, and then 
dispenses the air into the needle port. (The 
default setting is 15. The property is visible 
only on the Advanced level.) 

PrepVolume³ 0, 1, 2, ... 9999 Determines the volume [µl] to be used for 
the Draw, Dispense, and Mix commands. 
(The default setting is 10.0. The property is 
visible only on the Advanced level.) 

PrimeSyringe  Primes the syringe by flushing it. 

 Tip:   

After priming the syringe, always perform a 
Wait Sampler.Ready command. 

PurgeVolume³ 0, 1, 2, ... 9999 Determines the volume [µl] to be used for 
purging. (The default setting is 100. The 
property is visible only on the Advanced 
level.) 

⇒Ready NotReady Ready State of the autosampler (depends on the 
state of the sample temperature control if 
WaitForTemperature = Yes). 

SampleHeight² 0.0 mm 20.0 mm Indicates the distance of the needle tip from 
the bottom of the sample vial (default: 
0.0 mm). 

SampleOverlapped² Off On When set to On, the current sample will be 
prepared while the previous sample is still 
analysed. (The default setting is Off. The 
property is visible only on the Advanced 
level.) 

SeekWellBottom² Off On Can be enabled only if SampleHeight = 0.0 
(see above). 
When set to On, the needle detects the well 
bottom for a specified plate before the first 
injection is performed. This value is stored 
for the subsequent injections from this 
plate. When a different plate is used, the 
measurement is performed again. (The 
default setting is Off. The property is visible 
only on the Advanced level.) 

State Off On Indicates On when the autosampler has 
injected a sample. (The property is read-
only.) 
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Property Min Max Description 
SyringeSpeed², Fast (5.0 ml/min) 

Normal (2.5 ml/min) 
Slow (1.0 ml/min) 

Defines the drawing speed of the syringe. 
The speed depends on the installed syringe 
type. The values correspond to a standard 
250 µL syringe. 

WaitForTemperature² No Yes Specifies whether the autosampler waits for 
the sample temperature control.  

⇒Wash  Flushes the autosampler. 

 Tip:   

After priming the syringe, always perform a 
Wait Sampler.Ready command. 

WashCycle² 0, 1, 2, ... 9 Sets the number of wash cycles to be 
performed. (The default setting is 1. The 
property is visible only on the Advanced 
level.) 

WashFrequency² Never, EveryInject, 
EveryWell 

Determines when a wash cycle shall be 
performed. The following options are 
available: Never, EveryInject, EveryWell. 
(The default setting is EveryInject. The 
property is visible only on the Advanced 
level.) 

WashSequence² PurgeWash, 
PurgeWashPump 

Determines the wash sequence for the 
needle. (The default setting is PurgeWash. 
The property is visible only on the 
Advanced level.) 

 Tips:  
² It is not possible to change the setting during an injection, during gradient 
runs, or at negative retention times. 

³ It is not possible to change the setting during sample analysis.  
 

 Note: 
As described in the instrument's manual, negative pressure readings are 
possible for the sample loop pressure (LoopPressure property).  
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Injector Commands 
 
Command Description 
Draw³ Draws the PrepVolume from the PrepSubject (see above). (The command 

is available only on Advanced level.) 

 Tips: 
Up to 16 Draw commands are allowed per injection. 
Always use a Mix command after a sequence of Draw commands. 

LoopOffline³ Switches the sample injection valve after the injection. Thus, the loop is no 
longer part of the flow path. Preparation of the next sample can be started. 
(The property is visible only on the Advanced level.) 

 Tip:  
Make sure to issue the command only after the previous sample has 
completely left the loop.  

Mix³ Starts sample preparation. (The property is visible only on the Advanced 
level.) 

 Tips: 
No further Draw commands are allowed after a Mix command. 
Always use a Mix command after a sequence of Draw commands. 

PrimeSyringe Fills the syringe with the purge solvent. (The property is visible only on the 
Advanced level.) 

 Tip:  
The command uses the values set for PurgeVolume and WashCycle.  

 

 Tip:  
³ It is not possible to change the setting during sample analysis.  
 
For information about how to install the Waters Alliance 2790 and 2795 
HPLC modules, refer to Hardware Installation  Waters Alliance 
2790/2795 HPLC Modules: Installation in the Administrator Help 
section. 

For an overview of the Waters Alliance 2790 and 2795 HPLC modules, 
refer to Hardware Installation  Waters Alliance 2790/2795 HPLC 
Modules: Overview in the Administrator Help section. 
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 Waters Alliance 2790/2795: Column Heater and Sample 
Temperature Control 
For information about the standard commands for temperature control, 
refer to Practical Tips for Device Control  Temperature Control 
(On/Off) and  Controlling the Temperature. 

In addition, the following properties allow you to determine, e.g., the 
maximum allowed deviation of the actual temperature from the expected 
temperature: 
 
Property Min Max Default Description 
MaxTempDeviation² 0°C 10°C 5°C If the actual column temperature 

deviates from the expected 
temperature by more than the set 
value, an error message appears. 
The following setting is required 
on the instrument: Follow the 
description in the instrument's 
manual to set the Column 
Temperature/On error field to 
Alert User, Stop Funct, or 
StopFlow. For the column oven, 
this setting is made on page 4 
(Column); for sample 
temperature control, it is made on 
page 2 (Sample). 

⇒Ready² NotReady Ready Ready Indicates the state of the column 
heater. The column heater is 
Ready 
• when temperature control 

(TempCtrl) is Off   or 
• when the difference between 

the actual temperature and 
the target temperature is 
equal or less than 2°C for at 
least 30 minutes. 

Temperature.Nominal² 20°C 
(4°C) 

60°C 
(40°C) 

20°C Sets the target operating 
temperature (sample temperature 
control). The temperature must 
be at least 5°C above ambient. 

Temperature.Value² 0°C 80°C  Indicates the actual temperature. 
(The property is ready-only.) 

TempCtrl² Off On Off Sets the state of the temperature 
control. (Temperature control is 
active only if TempCtrl = On.)  
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 Note: 
For better understanding, [°C] is used as unit, even though [K] would be 
correct to indicate temperature differences. 

 Tip:  
² The temperature control commands of the column oven can be used only 
if an injection is made. In all other cases, e.g. for Blank Run Samples, an 
error message appears.  

It is not possible to change the MaxTempDeviation setting during an 
injection, during gradient runs, or at negative retention times. 

The standard relay commands are available to control the relays of the 
Waters Alliance 2790 and 2795 HPLC modules (refer to Practical Tips for 
Device Control  Relay, TTL, and Remote Input Commands). 

For information about how to install the Waters Alliance 2790 and 2795 
HPLC modules, refer to Hardware Installation  Waters Alliance 
2790/2795 HPLC Modules: Installation in the Administrator Help 
section. 

For an overview of the Waters Alliance 2790 and 2795 HPLC modules, 
refer to Hardware Installation  Waters Alliance 2790/2795 HPLC 
Modules: Overview in the Administrator Help section. 
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 Waters Alliance 2790/2795: Overlapping Sample 
Preparation 
The following program is an example for overlapping sample preparation 
with the Alliance 2790/2795 HPLC Modules and a Waters 996 or 2996 PDA 
Detector: 
 SampleHeater.TempCtrl =  Off 
 ColumnOven.TempCtrl =  Off 
 Pressure.LowerLimit =  1.0 
 Pressure.UpperLimit =  345.0 
 %A.Equate =  "%A" 
 %B.Equate =  "%B" 
 %C.Equate =  "%C" 
 %D.Equate =  "%D" 
 3DFIELD.MaxWavelength =  799.6 
 3DFIELD.MinWavelength =  190.0 
 3DFIELD.BunchWidth =  1.2 
 3DFIELD.Step =  1.0 
 UV_VIS_1.Wavelength =  272 
 UV_VIS_1.Bandwidth =  1.2 
 UV_VIS_1.Step =  0.50 
 UV_VIS_1.Average =  Off 
 ExposureTime =  Auto 
 Interpolate656nm =  On 
 Flow = 1 
 %B = 0.0 
 %C = 0.0 
 %D = 0.0 
 Curve = 5 
 
; Optional for overlapping sample prepration:  
;  SampleOverlapped = On 
 
 InjectMode = PartialLoop 
 
; The following commands are used to fill the syringe as follows: 
10.0 µl air, 5.0 µl sample, 10 µl reagent, and again 10.0 µl air: 
 PrepSubject = Air 
 PrepVolume = 10.0 
 Draw 
 
 PrepSubject = Sample_Vial 
 PrepVolume = 5.0 
 Draw 
 PrepSubject = 2_F8 
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; For this example: The reagent is in vial 2_F8 of a 48-vial rack 
 PrepVolume = 10.0 
 Draw 
 
 PrepSubject = Air 
 PrepVolume = 10.0 
 Draw 
 
 Mix 
; The Mix command is required to complete the sample preparation 
commands: 
 
0.000 Autozero 
 Wait UV.Ready and Sampler.Ready and ColumnOven.Ready  and 
HPLC_System.Ready 
 Inject 
 3DFIELD.AcqOn 
 UV_VIS_1.AcqOn 
 
5.000 3DFIELD.AcqOff 
 UV_VIS_1.AcqOff 
 
 End 

 

 Tips: 
The SampleOverlapped = Off command is required to disable overlapping 
sample preparation. 

It is not possible to prepare the first sample after a blank sample or after a 
run without injection while the previous sample is being analyzed. 

The PrepSubject = Air command can be specified only as the first and/or 
the last PrepSubject command. 

For more information, also refer to Practical Tips for Device Control 
 Overlapping Samples. 
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 Waters 717plus Autosampler 
For information about the standard autosampler commands, refer to 
Device Control  Dionex Autosamplers.  

In addition, Chromeleon supports the following properties: 
 
Property Min Max Description 
SyringeVol 25, 250, 2500 Indicates the syringe volume (read-only). 
InjectWaitTime 0 1E+7 Sets the time between the inject command 

and the inject response in seconds. The 
default setting is 0 s. 

LoopPressure -3,45 380 Indicates the pressure (in bar) in the 
sample loop (read-only). This property is 
available only on Expert level.  

 Note: 
As described in the instrument's manual, negative pressure readings are 
possible for the sample loop pressure (LoopPressure property).  

For an overview of the Waters autosampler, refer to Hardware Installation 
 Waters 717plus Autosampler: Overview in the Administrator Help 

section. 
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 Waters 996 and 2996 PDA Detectors  

 Tip:  
Before data acquisition can start, the detector needs some time to load the 
parameter settings. That is why a Wait command is required before data 
acquisition is started. 

In addition to the standard commands, the Waters 996 PDA detector 
supports the following commands and properties (please note that the 
display Filter level determines which commands and properties are 
displayed): 
 
Property Min Max Description 
ExposureTime Auto; 

11 ms 
500 ms Time during which a single diode is exposed 

to light. (The value cannot exceed the Step 
value - see below.) 

 Tip:  

Do not change the default ('Auto') unless 
absolutely required.  

Interpolate656nm Off On On: To protect the lamp the signal at 
656.1 nm (Balmer line for deuterium) is 
ignored (visible only on the Expert level). 

Lamp Off On Turns the lamp on or off.  

UV Channel Commands 
 
Property Min Max Default Description 

⇒Average Off On On Allows signal averaging. 
⇒Bandwidth 1.2 nm 30 nm 1.2 nm  
⇒Step Auto, 0.01 s 4.80 s Auto Indicates the interval between 

two data points. (The value must 
exceed the ExposureTime 
value.) 

⇒Wavelengt
h 

190 nm 800 nm 240.0 nm Indicates the wavelength at 
which the detector measures the 
signal.  

 Tip:   

After a Reset command, it takes 90 s until the detector is ready to execute 
further commands. 
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Commands and Properties of the 3D Field 
 
Property Min Max Default Description 

⇒BunchWidth 1.2 nm 60 nm 1.2 nm Describes the 
bandwidth of a bunch 
of diodes. 

MaxWavelength MinWavelength 799.6 nm 799.6 nm Indicates the upper 
limit of the measuring 
range. (The setting 
cannot be changed 
during data 
acquisition.) 

MinWavelength 190.0 nm MaxWavelength 190.0 nm Indicates the lower 
limit of the measuring 
range. (The setting 
cannot be changed 
during data 
acquisition.) 

⇒Step 0.1 s 
0.2 s 
0.5 s 
1.0 s 
2.0 s 
3.0 s 
4.0 s 

0.1 s Indicates the interval 
between two data 
points. (The value 
must exceed the 
ExposureTime value.) 

 

 Note:   

Due to the minimum Bunch Width of 1.2 nm, the minimum and/or maximum 
wavelength can only have the following value: 190.0 nm + n*1.2 nm (where 
n = integer). If you enter a different value, the next lower value is used for 
the minimum wavelength and the next higher value is used for the 
maximum wavelength. This is logged in the Audit Trail. 

The standard relay commands are available to control the relays of the 
Waters 996 and 2996 PDA detectors (refer to Practical Tips for Device 
Control  Relay, TTL, and Remote Input Commands). 
 
For an overview of the Waters 996 and 2996 PDA detectors, refer to 
Hardware Installation  Waters 996 and 2996 PDA Detectors: 
Overview in the Administrator Help section. 

For information about how to install the Waters 996 and 2996 PDA 
detectors, refer to Hardware Installation  Waters 996 and 2996 PDA 
Detectors: Installation in the Administrator Help section. 
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 Waters 2487 UV Detector 

 Tip:  
Before data acquisition can start, the detector needs some time to load the 
parameter settings. That is why a Wait command is required before data 
acquisition is started. 

In addition to the standard commands, the Waters 2487 UV Detector 
provides the following commands (please note that the display Filter level 
determines which commands are displayed): 
 
Command Min Max Default Description 
Data_Collection_Rate  
(For more information, 
refer to Data 
Collection Rate in the 
Glossary.) 

1 Hz 10 Hz 1 Hz Indicates the data collection rate for 
the channels. 

Lamp Off On  Turns the lamp on or off.  

Commands and Properties of UV Channels 
 
Property Min Max Default Description 
AutozeroOn 
EventIn² 

On  Off  Off  If the property is enabled, 
autozeroing is performed 
whenever this is required by an 
event. 

AutozeroOn 
WlChange² 

On Off On If the property is enabled, 
autozeroing is performed 
whenever the wavelength 
changes. 

⇒Average Off On On Allows signal averaging. 
FilterTime 
Constant³ 

0.0 s 99.0 s 1.0 s Time constant for the selected 
noise filter. 

FilterType None RC Hamming Filter type used to reduce analog 
and digital signal noise. 

Signal. 
Upper/ 
LowerLimit 

-10^10 mAU 10^10 mAU 
 

0 Indicates the upper and lower 
limit for the signal. 

⇒Step Auto, 0.01 s 4.80 s Auto Interval between two data 
points.  

⇒Wavelengt
h 

190 nm 700 nm UV_VIS_1: 
254.0 nm 
UV_VIS_2: 
225.0 nm 

Wavelength at which the 
detector measures the signal 
(see the Troubleshooting 
section).  
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 Tips:  
² It is only possible to change the Filtertype, AutozeroOnEventIn, and 
AutozeroOnWlChange properties once in the PGM File during negative 
retention times. 

³ It is not possible to change the time constant for the selected filter during 
data acquisition.  
 
For an overview of the Waters 2487 UV detector, refer to Hardware 
Installation  Waters 2487 UV Detector: Overview in the Administrator 
Help section. 

For information about how to install the Waters 2487 UV detector, refer to 
Hardware Installation  Waters 2487 UV Detector: Installation in the 
Administrator Help section. 

 Waters Instruments: Troubleshooting 

Waters 2690/2695 or 2790/2795 Separation Modules: 
a) A Separation Module (Alliance 2690/2695 or 2790/2795 modules) and 
the Chromeleon audit trail report a communication error with another 
Waters instrument, e.g., The instrument stops due to error circumstances 
or user interaction: Absorbance detector fault.  

Cause: The reason is that both Chromeleon and the Separation Module 
attempt to control this instrument. 

Remedial action: Disconnect the other Waters instrument from the 
Separation Module, and then perform the following steps on the Separation 
Module (the example refers to a detector):  

1. In the main window, press the Develop Method key to open the 
Method window.  

2. Use the arrow key to select the <Default> method. Confirm your 
selection by pressing <Enter>.  
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3. Press the Next key until the Detectors window is opened: 

 

4. Use the arrow keys to select the first detector and press <Enter>.  

5. Use the arrow keys to select the <Not used> option and press <Enter>.  

6. If necessary, repeat steps 4 and 4 for all other detectors.  

7. Press the Exit key to open the Save Method dialog box.  

8. Select Yes to save the method.  

9. In the main window, select Default Method.  

10. Make sure that the other parameters in the method, e.g., extreme flow 
rates, selected solvents, etc., do not cause any damage. 

11. Start the method. 

12. Immediately stop the method. 
 
b) No injection is performed although the Inject command was executed. 
Conditioning Column and a countdown are displayed on the instrument's 
display. The injection is not performed either after the countdown time has 
expired. 

Remedial action: On the Condition Column menu on the instrument, set 
the conditioning time to 0: 

1. Press Menu/Status to open the Status dialog. 

2. From the Method field, select the column conditioning method.  
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3. Press the Direct Function key.  

4. Select Condition Column and confirm by pressing OK. The Condition 
Column dialog box is opened. 

5. (Option) Specify the column that is currently conditioned if applicable. 

6. Set the time to 0 and confirm with OK. 
 

Waters 2487 UV Detector: 
When you enter a wavelength, the following warning can appear: 
"Wavelengths will span 370 nm during acquisition. The order filter will not 
be used. Do you really want to execute this command?"  

Reason: The detector automatically uses a filter for wavelengths above 
370 nm. In this way, unwanted UV light is filtered out. For measurements at 
or below 370 nm, the filter is automatically removed. The warning appears 
when the measuring wavelength of one channel is above 370 nm while the 
measuring wavelength of the other channel is below or equal to 370 nm. 

Remedial Action: Click Yes to confirm the warning. Data acquisition is 
performed at the selected wavelengths without a filter. However, in this 
case, it may happen that errors occur in the data recorded at the higher 
wavelength, due to unwanted UV light. Or else, click No to use two 
wavelengths that are both either above or equal to 370 nm or below 
370 nm.  
 
Also, refer to  GPIB-Connected Devices: Troubleshooting. 

For an overview of the different Waters instruments for which device drivers 
are available in Chromeleon, refer to Hardware Installation  Waters in 
the Administrator Help section. 
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 GPIB-Connected Devices: Troubleshooting 

Communication Error 
A communication error may occur when you install a driver in the Server 
Configuration program. Possible reasons are: 
• The instrument is either turned off or disconnected from the mains. 

• An invalid address has been assigned to the instrument. 

• Only for the Waters Separation Modules (2690/2695 or 2790/2795): 
The Controlled by Millennium 32 option has not been enabled on the 
module. (The Administrator Help section provides more information; 
refer to Hardware Installation  Waters Alliance 2690/2965 HPLC 
Modules: Installation, Device Settings section.) 

• The instrument is not yet completely initialized. 

• There are problems with the cable. 

• The instruments are not connected in series. One or more instruments 
are connected in a star structure. 

• One or more of the instruments are turned off. 

• There are more than 20 devices connected. 

• The cable length between two instruments exceeds 4 meters. 

• The average cable length between the separate instruments connected 
to a bus exceeds 2 meters. 

Remedy the situation, and then reinstall the driver in the Chromeleon 
Server Configuration. 

Problems with Cables 
If problems occur with a cable, follow the steps below: 

1. Turn the instruments off. 

2. Perform the following steps in succession for the individual instruments:  
• Connect only one instrument to the PC. 

• Make sure that the GPIB address for the connected instrument is 
correct.  
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• Wait until the instrument has completely initialized. 

• Try to connect the instrument from a Chromeleon panel. 

3. If you cannot connect to the instrument from Chromeleon, the reason is 
mainly that the cable is defective. Turn off the instrument and replace 
the cable. 

 
Also, refer to  Waters Instruments: Troubleshooting. 
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Practical Tips for Device Control 
In addition to the standard commands of the Program, which are easily 
created with the Program Wizard (see The Control Program  The 
Program Wizard), Chromeleon supports various additional ⇒Control 
Commands. For more information about these commands and the 
command syntax, refer to:  

 Pump and Flow Control 
 Autosampler Control 
 Detector Control 
 IC Control 
 GC and Temperature Control 
 Component Controller Control 
 Special Commands, Relay Control, and Miscellaneous 

 

• Transfer the structure and syntax of the commands that you want to 
use to your program file. 

• Use Cut & Paste to install the command directly from online Help at 
the appropriate position in the standard program.  

• Specify the time when to execute each command.  

• Save the result of your input as a PGM File. 
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Pump and Flow Control 

The following commands are available for pump and/or flow control. For the 
"simple" commands, refer to  Pump Commands. 
For more information, refer to:  

 Setting the Flow Rate 

 Determining the Solvent Composition 

 Determining a Gradient 

 Determining Pressure and Pressure Limits 

 Starting/Stopping the Pump Flow  

 Holding the Pump Flow 
 
In addition, refer to the following information about 

 Recording the Pump Pressure 

 Setting Automatic Pre-Compression Control (P580) 

 Viewing Leak Sensor and Workload Status.  

 Parking Peaks  
 
You can use an Active Flow Splitter (MRA) to split the flow. For a typical 
program example, refer to  Splitting the Flow (Program Example). 
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 Pump Commands 
The following commands are supported for pump and/or flow control: 

Hold/Continue Gradient 
 
0.000 HoldMode = On / Off 
 
Alternatively, the following short command is valid:  
  
0.000 ⇒Hold or 

0.000 ⇒Continue  
 

Stop Pump Flow/Gradient 
 
0.000 StopMode = On  or 
0.000 ⇒StopFlow  
 

Determining Pressure Limits (see ⇒Pressure.Lower/UpperLimit) 
 
0.000 Pressure.LowerLimit = Value[bar, MPa, psi]
0.000 Pressure.UpperLimit = Value[bar, MPa, psi]
 

 Note: 
The pressure unit (bar, MPa, or psi) depends on the pump type. 

Generating a Flow or % Gradient  
The flow or solvent value determined for the time t is continually adjusted to 
the following flow or solvent command. If the two values coincide, the flow 
or solvent value is kept at a specific level (see ramp profile 0 to 1), if they 
differ from each other, the value is modified. The difference between the 
two time values corresponds to the length of the ramp (see ramp profile 1 
to 2min).  
 
0.000 
1.000 
2.000 
3.000 

%B.Value 
%B.Value 
%B.Value 
%B.Value 

= 20 
= 20 
= 50 
= 50 

Ramp Profile 
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 Tip: 
Dionex GP40/GP50, IP20/IP25, IC20/IC25/IC25A, GS50, and IS25 pumps 
do not deliver flow gradient ramps. Instead, changing the flow rate between 
one time value and the next results in an immediate change in the flow rate 
(step change).  

To determine a sharp increase, two different values must be defined at the 
same time. The start and end values must be entered at the exact times 
(see rectangle profile at the time t=1min).  
 
0.000 
1.000 
1.000 
2.000 
2.000 
3.000 

%B.Value 
%B.Value 
%B.Value 
%B.Value 
%B.Value 
%B.Value 

= 20 
= 20 
= 40 
= 40 
= 20 
= 20 

Rectangle Profile 

  
By combining the just mentioned possibilities, any multi-step gradient 
profile can be realized. For example: 
  
0.000 
0.500 
1.500 
2.000 
2.000 
2.500 
2.500 

%B.Value 
%B.Value 
%B.Value 
%B.Value 
%B.Value 
%B.Value 
%B.Value 

= 20 
= 20 
= 40 
= 40 
= 30 
= 30 
= 20 

Multi-Step Profile 

 

 
Instead of the arbitrarily selected quantity %B used in these examples, any 
other solvent (see ⇒%B, %C, %D) or the flow rate can be changed. 

Creating a Non-Linear Gradient Ramp (Dionex GP40/GP50/GS50 
pumps only) 
A Curve command (also, refer to Gradient Curves) instructs the pump to 
apply the selected curve number when adjusting the solvent composition 
between two retention times. In the example below, the Curve = 8 
command at 2 min creates a concave ramp between 1 and 2 min. 
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Consecutive commands with identical solvent compositions generate an 
isocratic segment, regardless of the curve number selected (see 0 to 1 min 
and 2 to 3 min below). 
 
0.000 
1.000 
2.000 
 
3.000 

%B.Value 
%B.Value 
%B.Value 
Curve 

%B.Value 

= 20 
= 20 
= 50 
= 8 
= 50 

Non-Linear Ramp Profile

2 310
t

20
50

%B

 

 Setting the Flow Rate 

The ⇒Flow rate is set via the corresponding controls on the control panel 
(slider, edit field, or button). For more information about the control panel, 
see Control  The Control Panel.  
• To set a higher or lower flow rate, use the mouse to move the gauge 

slider in the desired direction.  

• Enter the desired flow rate value in the edit field via the keyboard. 
Confirm your input by pressing <Enter> (Return).  

• Click a button to execute the assigned function.  

• Alternatively, select Flow on the Control menu.  

It is also possible to include the Flow command in the Program (see How 
to: Creating and Modifying Programs  Creating a Program). 
Example: 
 

0.000 Pump.Flow = Value[ml/min%] ;HPLC/IC pump 
0.000 InjectorB.flow = Value[ml/min%] ;GC HP5890 

 
Several Flow commands result in a Flow Gradient. For a description on 
how to enter gradients, refer to  Determining a Gradient. 
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 Determining the Solvent Composition 

Manually 

For non-controlled pumps, solvent composition (see ⇒%B, %C, %D) is set 
directly on the instrument (also, refer to the Operating Instructions of the 
instrument). 

For controlled pumps, Chromeleon features the appropriate controls 
(sliders, edit fields, switches, etc.). Depending on the control panel layout, 
you can set the values for %B, %C, and %D via either a slider or an edit 
field.  
• Use the mouse to move the slider of a gauge in the desired direction.  

• Type a value in an edit field and press <Enter>. 

• To determine a gradient, select ⇒Flow on the Control menu (also, see 
 Determining a Gradient). 

Programmed 
To change the solvent composition via the program, enter the following 
commands in the Program: 
 

t=.... %B.Value = Value[%] 
t=.... %C.Value = Value[%] 
t=.... %D.Value = Value[%] 

 
If you enter the command several times for at least one component, this 
input results in a % Gradient.  

For more information, refer to How to: Creating and Modifying Programs 
 Creating a Program. 
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 Determining a Gradient 
There are two ways how to determine a gradient. You can do this either 
manually on a control panel or automatically via a program:  

Manual Input 
Different dialog boxes are provided for each device for which a gradient can 
be determined. Use these dialog boxes to enter the device-specific 
settings. You can determine: 
• ⇒Flow and % gradients for HPLC and IC pumps. 

• Temperature, pressure, and flow gradients for gas chromatographs.  

A gradient can be run either as a ramp or as a Step Gradients (in IC, also 
as a Gradient Curve).  
• Select Flow on the Control menu or press <CTRL> + <F>. Make the 

necessary settings in the dialog box. 

• For HPLC/IC, determine the desired gradient on the Gradient tab 
page. For gas chromatographs, select a gradient on the GC and 
Column1 and Column2 tab pages.  

Programmed Input 
The easiest way to create a new program is to use the Program Wizard 
(see The Control Program  The Program Wizard). To open the wizard, 
select New on the File menu, and then select Program File. 
 
HPLC/IC On the Pump Options page, select Multi-Step Gradient. The Flow Gradient 

Options dialog box appears. This dialog box corresponds to the Gradient page 
during manual input. 

GC On the GC Options page (or the Front/Back Inlet Options tabs), click the 
arrow next to the Type field, and then select Ramped Temperature from the 
list. This setting allows you to program a temperature gradient. In the same 
way, you can program flow and pressure gradients. Select Ramped Flow or 
Ramped Pressure on the Column1 Options and Column2 Options pages.  
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Entering "Basic points" 

HPLC/IC 
• In the Retention column, enter the time (relative to the injection time) 

of the desired modification.  

• In the Flow column, enter the new value for the flow rate. 

• In the %B, %C, and/or %D columns, enter the new value for the 
delivered solvent composition. %A is the difference between the total of 
the entered values and 100%. 

• For Dionex GP40, GP50, and GS50 pumps only: Enter a value in the 
Curve column to determine whether the pump delivers a linear or 

Curved Gradient. Curve 5 (the default) is linear; curves 1 - 4 are 
convex upward and curves 6 - 9 are concave upward. 

• Click Insert Line to append another line to the table. After appending 
the first new line, further lines are appended automatically, as 
necessary. Enable or disable this option by selecting or deselecting 
Autom. Append New Lines on the context menu. 

• Click Delete Line to remove unnecessary lines from the table.  

• If an entry is invalid, the input in the corresponding cell is displayed in 
red color. Invalid entries must be corrected immediately.  

• Click Clean Up to delete superfluous information from a previously 
selected area. 

• To calculate missing values between two or more time values can, click 
Interpolate. The values are automatically added to the table.  

• Select Fill Column on the context menu to fill the cells in the column 
with the currently selected value. Only the cells below the selected 
value are filled.  

In a graphical representation, each flow and solvent value of the value table 
is represented as a point. By interpolation between the basic points of a 
column, an area gradient profile is created. The solvent areas are 
represented in the color of the corresponding caption; the flow rate is 
displayed as a thin line.  
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Direct Input into a Program  
If you know the Program syntax, you can directly determine the gradient 
in the program. Entering the ⇒%B, %C, %D, ⇒Flow, and Temp. 
commands in the program allows you to change the solvent composition, 
flow rate, and temperature at a precise time. The gradient profile results 
from the change in value of a certain quantity at the time t. 

 Tip: 
The Dionex GP40/GP50, IP20/IP25, IC20/IC25/IC25A, GS50, and IS25 
pumps do not deliver flow gradient ramps. Instead, changing the flow rate 
between one time value and the next, results in an immediate change in 
the flow rate (step change).  

Example:  The three different profiles are realized via the commands 
listed below the profiles.  

 
Rectangle Profile Ramp Profile Multi-Step Profile 

   
0.000 %B.Value = 20 0.000 %B.Value = 20 0.000 %B.Value = 20 
1.000 %B.Value = 20 1.000 %B.Value = 20 0.500 %B.Value = 20 
1.000 %B.Value = 40 2.000 %B.Value = 50 1.500 %B.Value = 40 
2.000 %B.Value = 40  2.000 %B.Value = 40 
2.000 %B.Value = 20  2.000 %B.Value = 30 
  2.500 %B.Value = 30 
  2.500 %B.Value = 20  

For a rectangle profile, indicate exactly how long the specific solvent 
composition is valid. If the composition is changed at the same time as 
another percent command is defined, the change in solvent composition is 
executed immediately. The solvent percentage achieved is then maintained 
until replaced by another command. 

To realize an increase over a longer period, the start value and end value 
must be specified with the precise time. The difference between the two 
time values corresponds to the duration of the increase (see ramp profile). 

You can realize any multi-step gradient profile by combining the above-
mentioned possibilities. 

For more information about how to enter basic points in GC, refer to 
 Determining a Gradient (GC). 
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 Determining Pressure and Pressure Limits 
Pressure 
The operating pressure can only be determined for gas chromatographs. It 
depends on the layout of the control panel which type of control is used to 
set the pressure. 
• Determine the pressure via the corresponding slider or type the value 

in the input field. 

For other devices, such as Dionex IC and HPLC pumps, the current 
operating pressure can be displayed on a control panel.  

Pressure Limits 
Some device drivers provide the possibility to determine the upper and 
lower pressure limits.  
• Type the corresponding value in the input field.  

Or 
• Position the slider for the upper and lower pressure limits with the 

mouse pointer. Assign different colors to the controlling sliders so that 
they indicate whether a pressure limit is exceeded or whether it is 
within the selected limits (see How to: Controlling Devices from the 
Control Panel  Modifying a Control).  

If defined ⇒Pressure Limits, for example, of an HPLC pump, are exceeded, 
Chromeleon automatically turns off the flow, issues an error message, and 
stops the sample batch, as necessary. In addition, all operations are logged 
in the Audit Trail. 
 
It is also possible to determine the pressure limits by entering the following 
commands in the Program: 
 
0.000 X.Pressure.LowerLimit =Value[bar, MPa, psi] 
0.000 X.Pressure.UpperLimit =Value[bar, MPa, psi] 
 
where X refers to the name of the instrument defined in the Server 
Configuration. The pressure unit depends on the pump type. 
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 Starting and Stopping the Pump Flow 
• Select ⇒StopFlow to stop the pump flow and the Gradient formation. 

During a running Batch, batch processing is stopped. 

• Select ⇒Continue to resume the pump flow, a running gradient 
program, or batch processing. 

 Tip: 

The ⇒Hold command interrupts gradient formation and automatic batch 
processing, but not the pump flow. 

 Holding the Pump Flow 
• Select ⇒Hold to interrupt Gradient formation or a running batch. 

During a running Batch, sample processing is stopped. 

In Hold mode, the pump delivers a constant flow rate and solvent 
composition until a stop or a ⇒Continue command is entered. 

 Recording the Pump Pressure 
To determine whether signal variations are related to pressure variations, 
that is, whether the pump causes those variations, Dionex recommends 
that you record the pump pressure as an additional signal. 

Hardware Configuration 
To display the pump pressure, an analog pressure output must be available 
on your pump. In addition, a UCI-100 Universal Chromatography 
Interface is required. Connect the pressure output of your pump to one of 
the free channels of the UCI-100. 

 Tip:  
If you do not have a UCI-100 installed, a virtual channel can be used to 
record the pump pressure. If you use a virtual channel, note the greater 
distance between the measured values (⇒Step). For an example, refer to 

 Program Examples for Virtual Channels. 
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Server Configuration 
P680: 
On the General tab page, select the Pressure Signal check box to record 
the pump pressure. Chromeleon generates the Pump_Pressure channel for 
data acquisition.  

Other Pumps: 
Add an Integrator Driver to the devices of the corresponding timebase. 
Name the unassigned signal, for example, Pump_Pressure, and click 
Change. 

 

Select the channel to which the pressure output of your pump is connected 
as AD Port. Enter under Factor how many bar correspond to an output 
voltage of 1 mV. For example, enter 0.5 bar/mV (0.5 bar = 50 kPa = 7.25 
psi) for the Dionex P580 pump or 5 bar/mV (5 bar = 500 kPa = 72.5 psi) for 
the Dionex M480 pump. 
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You can now record data for the Pump_Pressure channel. Data 
acquisition can also be defined in the PGM File or by selecting ⇒AcqOn 
on the Control menu on the Control Panel.  

Panel 
• When you are on the signal plot of your panel, select Signals on the 

context menu. 

• Select a signal in the Available Signals field (that is, for the above 
example, select Pressure). 

• When starting the data acquisition, select the Pump_Pressure channel 
and define the ⇒Step (see  Starting Data Acquisition). 

 Setting Automatic Pre-Compression Control (P580) 
The better the pump is set to the varying compressibility of the different 
components of the solvents, the lower the pump's pulsation. Automatic pre-
compression control of the Dionex P580 pump considers the varying 
compressibility of different solvents. Automatic pre-compression control can 
also be used for unknown solvents. 

With low-pressure gradients and isocratic pumps, pre-compression control 
is fully automatic. On the Control Panel, select Commands on the 
Control menu. Select the pump and the solvent components one after the 
other and assign the component type Automatic. 

The high-pressure gradient pumps must "learn" the automatic pre-
compression control. Select Commands on the Control menu. Select the 
pump and the solvent component. Assign the solvent type Custom. Deliver 
100% of this solvent at 1 ml/min and a backpressure of approximately 
100 bar (= 10 MPa = 1450 psi). Select Commands on the Control menu 
and issue the ⇒Learn command. Observe the pressure signal for at least 
10 minutes. Issue the corresponding pump ⇒Freeze command to save the 
optimum pre-compression setting when the pressure fluctuations from the 
pump are minimal.  

 Tip:  
During the Learn phase, the backpressure should correspond to the 
maximum pressure in normal operation. If the backpressure is less than 
25°bar (= 2.5 MPa = 362.5 psi) during this phase, pre-compression control 
cannot be set correctly! Increase the backpressure, for example, by 
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installing a second column or a longer capillary before the detector. Again, 
wait for approximately 10 minutes before saving the pre-compression value 
using the Freeze command. 

Change the flow to 100% of the next solvent and set the pre-compression 
control as described above. 

For a detailed description, refer to the P580 Operating Instructions. 

 Viewing Leak Sensor and Workload Status 
The Dionex P580 pump allows you to display of the status of the leak 
sensor. In addition, you can display the Cumulated Workload. 

To create the corresponding controls, follow the description in How to: 
Controlling Devices from the Control Panel: 

 Modifying a Control Panel 
 Modifying a Control 
 Linking a Control to a Device 

Select Commands on the Control menu. Under Pump, select Leak to 
display the status of the leak sensor. Click Cumulated WorkLoad to 
display the total workload [in mega joule, MJ] of the pump.  

 Peak Parking 
The UltiMate system pump allows peak parking, for example, to increase 
the Mass Spectrometer acquisition time while the peak elutes. The 
⇒ParkPercentage enables peak parking. Select the PeakParked property 
to display the peak parking state. 

Peak parking is similar to the behavior of the ⇒StopFlow command: 
• The Gradient program is interrupted.  

• Usually, the pump flow is reduced (but not turned off).  

However, unlike the behavior of the StopFlow command: 
• Data Acquisition (see Acquisition On/Off) is not interrupted. 

• A running Batch is not stopped.  
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Select ParkPercentage to enable and disable peak parking. The following 
value disables peak parking: 
0.000 ParkPercentage = Disabled 

ParkPercentage  > 0.00 sets the flow to the following relative value during 
PeakParked state: 

current flow * ParkPercentage.  

The PeakParked state is entered whenever the signal at the pump’s 
START IN input changes from Open to Closed (edge trigger) and continues 
until the signal changes from Open to Closed again: 

 

At each sample start, the PeakParked state is reset. 
 

 Tip:  
Peak parking freezes the gradient with its current composition and reduced 
flow while data acquisition continues. Make sure that data acquisition is 
long enough (that is, the expected running time of the chromatogram + 
expected time for peak parking). Therefore, with peak parking the retention 
times do not correspond to the expected times. In addition, Audit Trail 
entries and gradient plots are no longer synchronized. 
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 Splitting the Flow (Program Example) 
The Dionex Active Flow Splitter (MRA), which is usually part of an APS 
system for Autopurification, splits the HPLC flow and directs the smaller 
portion to a Mass Spectrometer. The following program is a typical 
example for how to set up flow splitting in a PGM File: 
 
 . . . 
 3DFIELD.Step =  0.5 [s] 
 Pump.Flow = 50.000 [ml/min] 
 
; MRA settings: Communicate the used flow rate and the target 
; value for the split ratio 
 
; Caution: You might find it useful to add an implicit 
; assignment, such as MRA.Flow = Pump.Flow. However, this is 
; not possible as most pumps do not deliver the target value 
; immediately. The Flow property always sets the actual flow. 
; Therefore, you have to set the MRA flow explicitly: 
 
 MRA.Flow = 50.000 [ml/min] 
 MRA.SplitRatio = 20000 
 
 0.000 Autozero 
 Wait Ready 
 Inject 
 UV_VIS_1.AcqOn 
 
; To minimize wear, start the MRA after the injection if possible: 
 
 MRA.RunState = On 
 . . .  
 
; You can change the split ratio during a run. 
 
 1.300 MRA.SplitRatio = 100000 
  . . .  
 2.600 MRA.SplitRatio = 20000 
 . . .  
 10.000 UV_VIS_1.AcqOff 
 
; To minimize wear, stop the MRA after a run if possible 
 
 MRA.RunState = Off 
 
 End 
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Autosampler Control 

Depending on the Autosampler type, different commands are available. 
For an overview of the individual commands that are available for the 
different Dionex autosamplers, refer to: 

 Autosampler Commands (GINA 50) 

 Autosampler Commands (ASI-100 Series)  

 Autosampler Commands (AS/AS50) 

 Examples for User-Defined Programs for the WPS-3000 Well-Plate 
Micro Autosampler  

 Examples for User-Defined Programs for the FAMOS Autosampler 
(LC Packings) 
 
The following pages provide detailed information about: 

 Injecting a Sample 

 Setting Up Remote Injection 

 Priming the Syringe (ASI-100 Series) 

 Defining Sample Preparation Steps (AS/AS50) 

 Overlapping Samples 

 Injecting Two Samples Simultaneously 

 Opening the AS/AS50 Door during Operation 

 Monitoring the Status of the AS/AS50 
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 Autosampler Commands (GINA 50) 

Suck (see ⇒Draw)/⇒Dispense Sample  
 
0.000 Suck Position = Value, Volume = Value [µl],  

Duration = Value [s] 
0.000 Dispense Position = Value, Volume = Value [µl],  

Duration = Value [s] 

 Note: 
In the case of the Dionex Autosampler GINA 50, the corresponding 
operations can be synchronized with Chromeleon via a remote input and 
the Suck and Dispense commands. The device automatically reports the 
completion of each operation to Chromeleon. In the Program, the wait 
command Sucked must be inserted. All following commands are executed 
only after the autosampler confirmed the execution of the Suck command, 
that is, after the sample has been drawn. The program performs this 
independently of the time required by the autosampler for the suck and 
dispenses processes. This is shown in the following example: 
   
0.000 Suck Position = 20, Volume = 30, Duration = 0 
0.000 Wait Sucked 
0.000 Suck Position = 21, Volume = 30, Duration = 0 
0.000 Wait Sucked 
0.000 Dispense Position = , Volume = 60, Duration = 0 
0.000 Wait Sucked 
0.000 ⇒Inject  
 
Description of the program part: First, the Autosampler GINA 50 draws 
30 µl solution from ⇒Position 20 and afterward draws 30 µl solution from 
position 21. The entire drawn volume is dispensed in the current vial 
(current = last position if no other position is specified). Then, the injection 
volume, which has been specified in the sample list, is drawn and injected 
from there.  

Short command syntax: 
 
0.000 Suck 20, 30, 0 
0.000 Wait Sucked 
0.000 Suck 21, 30, 0 
0.000 Wait Sucked 
0.000 Dispense Position = , Volume = 60, Duration = 0 
0.000 Wait Sucked 
0.000 Inject  
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Relative Sample Location 
The Dionex Autosampler GINA 50 is capable of executing the suck and the 
dispense commands relative to a certain sample position. The 
Position+Location is entered in the field Position of the Suck or 
Dispense commands. In the program this is expressed as follows: 
 
0.000 Suck Position = 20, Volume = 30, Duration = 0 
0.000 Wait Sucked 
0.000 Suck Position = Position+10, Volume = 30, Duration = 0 
0.000 Wait Sucked 
0.000 Dispense Position = Position+20, Volume = 60, Duration = 0 
0.000 Wait Sucked 
 
Description of the program part: The autosampler takes 30 µl of solution 
from position 20, moves 10 positions from the current position in the 
sample list, and takes 30 µl of solution from there. Then, the 60-µl solution 
is dispensed into a vial that is located 20 positions from the current sample 
vial.  

Air Segment 
For the Dionex GINA 50 Autosampler, the input position = 100 is an 
imaginary Air Vial from which a certain air volume can be drawn as a 
separating segment; for example: 
 
0.000 Suck Position = 20, Volume = 30, Duration = 0 
0.000 Wait Sucked 
0.000 Suck Position = 100, Volume = 30, Duration = 0 
0.000 Wait Sucked 
0.000 Suck Position = 21, Volume = 30, Duration = 0 
0.000 Wait Sucked 
 
Description of the program part: After 30 µl of solution is sucked from 
position 20, 30 µl of air is sucked before another 30 µl of solution is sucked 
from position 21. Thus, the two solutions do not encounter each other.  

 Note: 
Only use the Segment command in combination with the Dispense 
command, as otherwise the sucked air volume is also injected.  
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Dispense in Needle Seat 
Entering position 101 in a Dispense command enables dispensing the 
volume contained in the needle into the needle seat of the Autosampler 
and thus into the waste container.  
 
0.000 Dispense Position = 101, Volume = 60, Duration = 0 
 

Wash Injection Loop  

Select the ⇒Wash command to rinse the injection loop of the Gina 50 
autosampler with solvent. This corresponds to the normal solvent flow 
during the Inject command.  
 
0.000 DEVICENAME.Wash  Or 
0.000 Wash  
 

Lift/Lower Sample Needle 

Select the ⇒NeedleUp command to lift the sample needle. When lifting the 
needle, an active Wash process is automatically interrupted, i.e., solvent 
flow is not through the injection loop any longer but directly from the pump 
to the column.  
 
0.000 NeedleUp  
 
Execute the Wash command to lower the needle again and direct the 
solvent flow through the sample loop again (for more information see 

Autosampler).  
 
0.000 Wash  
 
The combination of the two commands prevents crystallization of 
substances in the sample loop.  

For an overview of the individual commands for the GINA 50, refer to 
Commands for Controlling Dionex Devices  Dionex GINA 50 
Autosamplers. 

Also, refer to  Autosampler Commands (ASI-100 Series). 
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 Autosampler Commands (ASI-100 Series) 
Many commands of the Dionex ASI-100 Autosamplers (ASI-100 T and 
ASI-100 PT= with temperature control) are similar to those of the GINA 50 
(see  Autosampler Commands (GINA 50)). However, there are some 
important differences, which are described below: 

Sample Positions 
The sample vials are situated in three different segments, which are 
distinguished by color. Within the segments, the vials are situated in 
different rows. Thus, the sample ⇒Positions are indicated as follows:  

Letters according to their color describe the individual segments: R, G, or B 
(indicating the red, green, and blue segment, respectively). The different 
rows are described from the outer to the inner row: A, B, C, or D. The 
individual positions within the respective rows are numbered 
counterclockwise. For example, the RA1 position is located in the outer row 
of the red segment (also, refer to the Operating Instructions for the ASI-100 
Series). 

Autosampler Configuration 
Specify the device configuration before starting the actual program. It is 
important to define the sample positions for the reagents and the wash 
liquid. These positions are valid throughout the entire running time of the 
program: 
 
0.000 Sampler.ReagentAVial BB1 
0.000 Sampler.ReagentBVial BC1 
0.000 Sampler.ReagentCVial BA1 
0.000 Sampler.WashVial G99 
0.000 Sampler.PrepVial R99 
 
The following commands define the number of draw and dispense actions 
(for the Mix command): 
 
0.000 Sampler.MixRepeat 3 
 

⇒Draw, ⇒Dispense Sample, ⇒Mix  
Before issuing the Draw, Dispense, or Mix command, specify the vial 
(depending on the selected option - see below) from which to draw and/or 
dispense and the volume to draw and/or dispense (the latter for the Mix 
command):  
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0.000 PrepSubject Option (see below) 
0.000 PrepVolume Value [µl] 
0.000 Draw  
 
0.000 PrepSubject Option (see below) 
0.000 PrepVolume Value [µl] 
0.000 Dispense  
 
The following options are available for the PrepSubject command: 
Option Description 
PrepVial Actual mixing vial position (current PrepVial value) 
Sample_Vial Vial for the actual sample in the sample list (current 

Sampler.Position value) 
WashVial Vial containing the wash liquid (current Sampler.WashVial value) 
Air Air (with the Draw command) and needle port (with the Dispense 

command), respectively 
ReagentA (B, C or D) Reagents A (B, C, or D) (actual Sampler.ReagentAVial value)  
Some commands need to be synchronized with Chromeleon, that is, the 
autosampler automatically reports completion of the respective operation to 
Chromeleon. In addition, the Sampler.Ready wait condition must be part of 
the Program. The following commands are executed only after the 
autosampler has confirmed that the command has been executed. This 
applies to the Draw, Dispense, Mix, Test, and ⇒Wash commands and is 
illustrated below: 
 
0.000 PrepSubject Sample_Vial 
0.000 PrepVolume 30  
0.000 Draw  
0.000 Wait Sampler.Ready 
0.000 PrepSubject ReagentA 
0.000 PrepVolume 30  
0.000 Draw  
0.000 Wait Sampler.Ready 
0.000 PrepSubject MixVial 
0.000 PrepVolume 60  
0.000 Dispense  
0.000 Wait Sampler.Ready 
0.000 ⇒Inject Position = PrepVial 
 
Description of the program part: First, the autosampler draws 30 µl of 
solution from the current sample vial, and, upon completion, 30 µl of 
solution from the reagent A vial. The entire volume drawn is dispensed into 
the MixVial. The injection volume, which has been specified in the sample 
list, is then drawn and injected from this position. 
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Air Segment 
To draw an air segment, specify that the PrepSubject be Air. For example, 
use the following program part to draw two samples separated by an air 
segment. The air segment prevents early mixing in the needle and makes 
sure that an exactly defined reaction time is met. 
 
0.000 PrepSubject ReagentA 
0.000 PrepVolume 100  
0.000 Draw  
0.000 Wait Sampler.Ready 
0.000 PrepSubject Air 
0.000 PrepVolume 5 
0.000 Draw  
0.000 Wait Sampler.Ready 
0.000 PrepSubject Sample_Vial 
0.000 PrepVolume 100  
0.000 Draw  
0.000 Wait Sampler.Ready 
0.000 PrepSubject MixVial 
0.000 PrepVolume 205  
0.000 Dispense  
0.000 Wait Sampler.Ready 
 
Description of the program part: Having drawn 100 µl of reagent A, 5 µl of 
air is drawn first before another 100 µl of sample is drawn from the vial. 
Thus, the two solutions encounter each other in the mixing vial only. 

Relative Sample Location 
1. Different rings: The autosampler can execute commands relative to a 
given sample position. Type the description "Position + relative entry" in the 
Position field of the Draw or Dispense commands. In the program, this is 
expressed as follows (if the current position is in the RA ring): 
 
0.000 PrepSubject Sample_Vial 
0.000 PrepVolume 30  
0.000 Draw  
0.000 Wait Sampler.Ready 
0.000 Position Position + RB1 - RA1 
0.000 PrepSubject Sample_Vial 
0.000 PrepVolume 30  
0.000 Draw  
0.000 Wait Sampler.Ready 
0.000 Position Position + RC1 - RB1 
0.000 PrepSubject Sample_Vial 
0.000 PrepVolume 60  
0.000 Dispense  
0.000 Wait Sampler.Ready 
0.000 Inject Volume=30 
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Description of the program part: The autosampler draws 30 µl of solution 
from the actual sample vial, moves to the respective position in the RB ring, 
and draws 30 µl of solution from this position as well. Then, the 60 µl 
solution is dispensed into the vial at the respective position in the RC ring. 
For example, if the current sample is situated at position RA3, another 30 µl 
will be drawn from position RB3, and the entire volume of 60 µl will be 
dispensed at position RC3. After that, 30 µl are injected from position RC3. 

 Note: 
To complete the program, the PrepSubject command is repeated with the 
Sample_Vial argument. However, this command is not required, as 
Chromeleon keeps the latest setting. The second command 
(= PrepVolume) could also be omitted, as it only repeats the argument 
"30." 

2. Different segments: You can also place the samples to derivate into the 
red segment, for example, and execute the mixing process with a reagent 
in the corresponding sample vial in the green segment using the following 
commands: 
 
0.000 Sampler.PrepVial Position + GA1 - RA1 
0.000 PrepSubject PrepVial 
0.000 Mix  
 
The first line specifies that the corresponding vial in the green segment be 
used as the mixing vial for the sample in the red segment. For example, if 
you wish to process the sample at position RB5, mixing takes place at 
position GB5. 

3. Incrementing the positions: Another way is to increment the positions. 
Use the following example to define a position 5 after the current position 
for MixSubject: 
 
0.000 Sampler.PrepVial Position + 5 
0.000 PrepSubject PrepVial 
0.000 Mix  
 
For example, if you wish to process the sample from position RB3, the vial 
at position RB8 is the mixing vial. 
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Wash Needle  
Use the Wash command to rinse the autosampler's needle with the wash 
liquid. The wash volume is drawn and dispensed into the needle seat. 
  
0.000 WashVolume Value [µl] 
0.000 Wash  
 
For an overview of the individual commands for the ASI-100 Autosamplers, 
refer to Commands for Controlling Dionex Devices  Dionex ASI-100 
Autosampler Series.  

 Autosampler Commands (AS/AS50) 

Sample Loading and Injection 
With the AS and AS50 autosamplers, sample loading and injection are two 
distinct events. The Load command switches the injection valve to the load 
position and moves the sample from the AS or AS50 inject port into the 
sample loop. The Inject command switches the injection valve to the inject 
position, which directs the pump flow through the loop. The sample is then 
transported from the loop to the column.  

 Tip: 
Clicking the Inject button on the control panel sends both the Load and the 
Inject commands to the autosampler. 

 Note: 
If the AS or AS50 is in Simultaneous mode, separate Valve.LoadPosition 
and Valve.InjectPosition commands are required (in addition to the Load 
and Inject commands). See the description of Simultaneous mode below 
for details. 

Flush the Inject Port 
The Flush and Wait commands must be in the order shown. We 
recommend that these commands occur either before any other 

Autosampler commands or after all other autosampler commands.  
 
 Flush  Volume = Value [µl] 
 Wait FlushState 
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Autosampler Options 
All AS and AS50 autosampler option commands must be grouped together 
in the Program. Place them at the beginning of the program, before 
t = 0.000. You do not need to specify event times for the option commands. 
 
 Devicename.NeedleHeight = Value [mm] 
 Devicename.CutSegmentVolume = Value [µl] 
 Devicename.SyringeSpeed = Value 
 Devicename.ColumnTemperature = Off / Value [°C] 
 Devicename.TrayTemperature = Off / Value [°C] 
 Devicename.Cycle = Value 
 

Sample Preparation 
All AS and AS50 sample prep commands (Pipet, Mix, FlushSP, DelaySP, 
SetNeedleHeight, Dilute, Dispense, Concentrate, ReagentPrime, and 
ReagentFlush) must be grouped together in the program. Place them at 
the beginning of the program, after the AS and AS50 option commands and 
before t=0.000. You do not need to specify event times for the sample prep 
commands. Include a Wait SampleReady command after the sample prep 
commands to allow them to be completed before injection.  

 Note: 
The Dilute and Dispense commands are available only if the AS or AS50 
is equipped with the sample preparation option. The Concentrate, 
ReagentPrime, and ReagentFlush commands require AS or AS50 (USB) 
Moduleware version 2.0.0 (or later). These commands are not available for 
the DX-LAN model of the AS50, regardless of which Moduleware version is 
installed in the autosampler. 

In the example below, 20 µl are pipetted from vial 1 and delivered to vial 
10. 200 µl are dispensed from reservoir A into vial 10. The contents of vial 
10 is mixed by drawing in and expelling 100 µl of the vial contents. The 
mixing cycle is repeated 5 times. 
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 Note: 
Due to limitations here, commands are shown on two lines. In an actual 
program, one command must be entered on one line. 
 
 Sampler.Pipet Volume = 20.0, SourceVial = 1, 

DestinationVial = 10 
 Sampler.Dispense Volume = 200.0, SourceReservoir = 

Reservoir_A, DestinationVial = 10 
 Sampler.Mix SourceVial = 10, NumberOfTimes = 5, 

Volume = 100.0 
 Wait  SampleReady 
 
Also refer to  Defining Sample Preparation Steps. 

ReagentFlush Applications 
The AS or AS50 (USB) runs in Concentrate or Sequential Concentrate 
mode when the mode is selected on the autosampler front panel and a 
concentrator column is installed. The default ReagentFlush program for 
these modes contains the following parameters: 
• The Concentrate command is automatically listed on the first line of 

the Sample Prep Options page. You may add sample prep steps 
before or after this line. 

• The program does not include the Load, Inject, or Wait InjectState 
commands. 

• The Sampler_InjectValve.InjectPosition command is located after 
the Wait CycleTimeState command at time 0.00.  

• The BeginOverlap command is inserted at 5.00 minutes. Sample 
overlap normally begins after the Wait InjectState command; however, 
since ReagentFlush programs do not include the Inject and Wait 
InjectState commands, sample overlap will start at the time specified 
for BeginOverlap. 

You may add sample prep commands before or after the Concentrate 
command. You may add or delete the Concentrate, ReagentPrime, 
ReagentFlush, and BeginOverlap commands as needed.  

A program may include multiple Concentrate, ReagentPrime, and 
ReagentFlush commands. However, if the program includes multiple 
BeginOverlap commands, all but the first BeginOverlap command is 
ignored.  
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Make sure the multiple Concentrate or ReagentFlush commands do not 
exceed the volume of sample or reagent in the vial specified in the 
sequence. 

In the following example program for the Concentrate mode, commands for 
the ReagentFlush function are in bold. If the Sequential Concentrate mode 
is selected, the program must also include exclusive access commands 
that allow the autosampler to be shared by two timebases. 

Also, refer to  Sharing an Autosampler. 

 Note: 
Due to limitations here, commands are shown on two lines. In an actual 
program, one command must be entered on one line. 
 
 Flush Volume = 100 
 Wait FlushState 
 NeedleHeight = 2 
 CutSegmentVolume = 0 
 SyringeSpeed = 3 
 ColumnTemperature = 15 
 CycleTime = 0 
 Pipet  Volume = 20.0, SourceVial = 

CurrentVial, DestinationVial = CurrentVial 
 

 Mix  SourceVial = CurrentVial, 
NumberOfTimes = 5, Volume = 250.0 

 

 FlushSP  Volume = 250.0  
 DelaySP  Time = 0.0  
 Dispense  Volume = 1000.0, SourceReservoir 

= Reservoir_A, DestinationVial = 
CurrentVial 

 

 WaitForTemperature False 
 Concentrate ValvePosition = LoadPosition  
 ReagentPrime Volume = 10000.0, SourceVial = 

CurrentVial, ValvePosition = NoChange 
 

 ReagentFlush Volume = 5000.0, SourceVial = 
CurrentVial, ValvePosition = NoChange 

 

 Wait SampleReady 
0.000 Wait CycleTimeState 
 Sampler_InjectValve.InjectPosition  
0.100 Home  
5.000 BeginOverlap  
30.000 End  
 



 Practical Tips for Device Control 1155 

Relative Vial Location 
In the sample preparation commands, a vial location can be specified either 
as an absolute position or as a relative position. In relative positioning, the 
CurrentVial is the current sample vial position, specified in the sample list in 
the Sequence. In the example below, 20 µl of liquid are pipetted from the 
current sample vial and then expelled into the vial, 1 position past the 
current vial. 
 
 Sampler.Pipet Volume = 20.0, SourceVial = CurrentVial, 

DestinationVial = CurrentVial+1 
 

Sample Overlap 
If the AS or AS50 Sample Overlap option is enabled in the Server 
Configuration, the autosampler performs the following commands for the 
next sample in a sequence, while data acquisition is occurring for the 
currently running sample in the sequence:  
• Flush  

• Autosampler Option Commands (ColumnTemperature, 
TrayTemperature, WaitForTemperature, SyringeSpeed, CycleTime, 
SetNeedleHeight, CutSegmentVolume) 

• Sample Prep Commands (Pipet, Mix, DelaySP, FlushSP, 
NeedleHeight, Dilute, Dispense, Concentrate, ReagentPrime, 
ReagentFlush)  

When the autosampler is preparing a sample, the Status field in the 
sequence displays Preparing and the sample line is highlighted in yellow. 
A message is also logged in the Audit Trail. 

Sample overlap is not allowed when the autosampler is running in the 
Sequential or Sequential Concentrate mode. 

Also, refer to  Overlapping Samples. 

Cycle Time 
Cycle time controls the time between injections. When a cycle time is 
specified, the autosampler delays sample injection until the specified time 
has elapsed since the previous injection. This is accomplished with the 
Wait CycleTimeState command. When running a batch, the Wait 
CycleTimeState command in the first PGM File in the batch is ignored.  
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The following example sets a cycle time of 30 minutes. 
 
 Cycle =30 
0.000 Sampler.Load  
 Wait CycleTimeState 
 Sampler.Inject  
 

Priming the Liquid Lines 
The Prime command is used to prime the flush reservoir line to the 
sampling valve and the sample transfer line. In addition, if the sample prep 
option is installed, the Prime command is used to prime the lines from each 
installed reagent reservoir. The following example uses the prep syringe to 
prime the line to reservoir A with 2000 µl.  
 
0.000 Sampler.Prime Volume=2000, PrimeReservoir=Reservoir_A, 

PrimeSyringe=Prep 
 

Simultaneous Mode 
If the Simultaneous mode is selected on the AS or AS50 front panel, the 
program includes additional commands for controlling two injection valves. 
The additional commands are used to switch the position of each valve 
during sample injection.  

In the following example, an AS50 is connected to two ICS-2000 systems. 
Each ICS-2000 is equipped with an injection valve; no injection valves are 
installed in the AS50. 
 
0.000 Pump_InjectValve.LoadPosition  
 Pump_InjectValve_2.LoadPosition  
 Load  
 Wait   CycleTimeState  
 Pump_InjectValve.InjectPosition  
 Pump_InjectValve_2.InjectPosition  
 Pump_ECD.Autozero  
 Pump_ECD_2.Autozero  
 Inject  
 Wait   InjectState  
 

 Note: 
For an overview of the individual commands for the autosamplers, refer to 

 Dionex AS/AS50 Autosamplers. 
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 Examples for User-Defined Programs for the WPS-3000 
Autosampler 
The user-defined program is loaded and executed at the autosampler's 
start time (Sampler.Inject command) even if the program steps appear 
prior to that command in the program file. Make sure that the user-defined 
program includes an UdpInjectMarker command at the appropriate 
position so that the system recognizes that an injection has been made: 

The following programs are typical application examples for the WPS-3000 
Autosampler: 

0. User-defined standard program 
 ;User defined program (UDP) template for WPS-3000 sampler 
 ;******    PLEASE DO NOT EDIT  ****** 
0.000 InjectMode = UserProg 
 Sampler.ReagentAVial= R1 
 Sampler.ReagentBVial= R2 
 Sampler.ReagentCVial= R3 
 Sampler.ReagentDVial= R4 
 Sampler.PrepVial= RA1 
 Sampler.UdpDraw From=SampleVial, Volume=5, 

SyringeSpeed=50, SampleHeight=2 
 Sampler.UdpDispense To=PrepVial, Volume=5, 

SyringeSpeed=100, SampleHeight=2 
 Sampler.UdpDraw From=ReagentAVial, Volume=10, 

SyringeSpeed=50, SampleHeight=2 
 Sampler.UdpDispense To=PrepVial, Volume=10, 

SyringeSpeed=2000,  SampleHeight=2 
 Sampler.UdpMixWait Duration=10 
 Sampler.UdpDraw From=PrepVial, Volume=5, 

SyringeSpeed=50, SampleHeight=2 
 Sampler.UdpInjectValve Position=Inject 
 Sampler.UdpInjectMarker 
 

Inject  
;starts the above program and waits for the inject response. 

 
 Acquisition On 

... 
4.000 Acquisition Off 
 End 
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1. Drawing a sample volume of 1 µl 
 ;User defined program (UDP) template for WPS-3000 sampler 
 ;******    PLEASE DO NOT EDIT  ****** 
0.000 InjectMode = UserProg 
 UdpInjectValve Position=Load 
 UdpSyringeValve Position=Needle 
 UdpDraw From=SampleVial, Volume=1.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpDraw From=SampleVial, Volume=0.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpDraw From=ReagentAVial, Volume=25, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpInjectValve Position=Inject 
 UdpInjectMarker  

;generates an Inject Response during the program run 
 
 UdpMixWait Duration=5 
 UdpDraw From=ReagentAVial, Volume=0.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpSyringeValve Position=Waste 
 UdpMoveSyringeHome SyringeSpeed=2000 
 UdpSyringeValve Position=Needle 
 UdpMixNeedleWash Volume=50 
 

Inject  
;starts the above program and waits for the inject response. 

 
 Acquisition On 

... 
4.000 Acquisition Off 
 End 

 

2. Sample preparation with 2 reagents 
 ;User defined program (UDP) template for WPS-3000 sampler 
 ;******    PLEASE DO NOT EDIT  ****** 
0.000 InjectMode = UserProg 
 UdpDraw From=ReagentAVial, Volume=20.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpDraw From=ReagentAVial, Volume=0.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpDispense To=SampleVial, Volume=20.0, 

SyringeSpeed=2000, SampleHeight=2 
 UdpMixWait Duration=10 
 UdpDraw From=ReagentBVial, Volume=10.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
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 UdpDraw From=ReagentBVial, Volume=0.0, 
SyringeSpeed=50, SampleHeight=2 

 UdpMixWait Duration=5 
 UdpDispense To=SampleVial, Volume=10.0, 

SyringeSpeed=2000, SampleHeight=2 
 UdpMixWait Duration=10 
 
 UdpInjectValve Position=Inject 
 UdpSyringeValve Position=Needle 
 UdpDraw From=SampleVial, Volume=3.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpInjectValve Position=Load 
 UdpDraw From=SampleVial, Volume=5.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpInjectValve Position=Inject 
 UdpInjectMarker  

;generates am inject response during the program run 
 
 UdpMixWait Duration=5 
 UdpDraw From=SampleVial, Volume=0.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpSyringeValve Position=Waste 
 UdpMoveSyringeHome SyringeSpeed=2000 
 UdpSyringeValve Position=Needle 
 UdpMixNeedleWash Volume=50 
 

Inject  
;starts the above program and waits for the inject response. 

 
 Acquisition On 

... 
4.000 Acquisition Off 
 End 

 

3. Gel extraction 
 ;User defined program (UDP) template for WPS-3000 sampler 
 ;******    PLEASE DO NOT EDIT  ****** 
0.000 InjectMode = UserProg 
 UdpDraw From=SampleVial, Volume=5.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpDispense To=PrepVial, Volume=5.0, 

SyringeSpeed=2000, SampleHeight=2 
 UdpDraw From=ReagentAVial, Volume=5.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpDispense To=SampleVial, Volume=5.0, 

SyringeSpeed=2000, SampleHeight=2 
 UdpMixWait Duration=10 
 
 UdpDraw From=SampleVial, Volume=5.0, 

SyringeSpeed=50, SampleHeight=2 



1160 Practical Tips for Device Control 

 UdpDispense To=PrepVial, Volume=5.0, 
SyringeSpeed=2000, SampleHeight=2 

 UdpDraw From=ReagentBVial, Volume=5.0, 
SyringeSpeed=50, SampleHeight=2 

 UdpDispense To=PrepVial, Volume=5.0, 
SyringeSpeed=2000, SampleHeight=2 

 UdpMixWait Duration=10 
 
 UdpDraw From=SampleVial, Volume=5.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpDispense To=PrepVial, Volume=5.0, 

SyringeSpeed=2000, SampleHeight=2 
 UdpMixWait Duration=5 
 
 UdpInjectValve Position=Inject 
 UdpSyringeValve Position=Needle 
 UdpDraw From=SampleVial, Volume=1.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpInjectValve Position=Load 
 UdpDraw From=PrepVial, Volume=5.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpMixWait Duration=5 
 UdpInjectValve Position=Inject 
 UdpInjectMarker  
 
 ;generates an inject response during the program run 
 
 UdpMixWait Duration=5 
 UdpDraw From=SampleVial, Volume=0.0, 

SyringeSpeed=50, SampleHeight=2 
 UdpSyringeValve Position=Waste 
 UdpMoveSyringeHome SyringeSpeed=2000 
 UdpSyringeValve Position=Needle 
 UdpMixNeedleWash Volume=50 
 

Inject  
;starts the above program and waits for the inject response 

 
 Acquisition On 

... 
4.000 Acquisition Off 
 
 End 

 

 Notes: 
Use the PGM Wizard to create a user-defined program. You can either 
create a new user-defined program or use an existing program as a 
template for the new one. 

Each user-defined program must include an UdpInjectMarker command. If 
this command is not included, a message appears in the PGM Wizard. 
 



 Practical Tips for Device Control 1161 

For an overview of the individual commands that are available for the 
WPS-3000 autosampler, refer to Commands for Controlling Dionex 
Devices  Dionex WPS-3000 Well-Plate Micro Autosampler. 
For information about the sample preparation commands supported by the 
autosampler, refer to Commands for Controlling Dionex Devices 

 Dionex WPS-3000 Well-Plate Micro Autosampler: Commands for 
User-Defined Programs. 

 Examples for User-Defined Programs for the FAMOS 
Autosampler (LC Packings) 
The user-defined program is loaded and executed at the autosampler's 
start time (Sampler.Inject command) even if the program steps appear 
prior to that command in the program file. Make sure that the user-defined 
program includes an InjectMarker command at the appropriate position so 
that the system recognizes that an injection has been made: 

The following programs are typical application examples for the FAMOS 
HPLC Autosampler: 

0. User-Defined Standard Program 
 ;User-defined program (UDP) template for FAMOS autosampler 
 ;******    PLEASE DO NOT EDIT  ****** 
 Sampler.ReagentAVial= 1 
 Sampler.ReagentBVial= 2 
 Sampler.ReagentCVial= 3 
 Sampler.ReagentDVial= 4 
 Sampler.PrepVial= A1 
 Sampler.Draw From=SampleVial, Volume=5, 

SyringeSpeed=Low,  SampleHeight=0 
 Sampler.Dispense To=PrepVial, Volume=5, SyringeSpeed=Low, 

 SampleHeight=0 
 Sampler.Draw From=ReagentAVial, Volume=10,   

 SyringeSpeed=Low, SampleHeight=0 
 Sampler.Dispense To=PrepVial, Volume=10, SyringeSpeed=Low, 

 SampleHeight=0 
 Sampler.MixWait Duration=10 
 Sampler.Draw From=PrepVial, Volume=5, SyringeSpeed=Low, 

 SampleHeight=0 
 Sampler.InjectValve Position=Inject 
 InjectMarker 
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1. Drawing a Sample Volume of 1 µl 
 ;User-defined program (UDP) template for FAMOS autosampler 
 ;******    PLEASE DO NOT EDIT  ****** 
0.000 InjectMode = UserProg 
 InjectValve Position=Load 
 SyringeValve Position=Needle 
 Draw From=SampleVial, Volume=1.0 
 MixWait Duration=5 
 Draw From=SampleVial, Volume=0.0 
 Draw From=ReagentAVial, Volume=25 
 MixWait Duration=5 
 InjectValve Position=Inject 
 InjectMarker  

; generates an inject response during the program run 
 MixWait Duration=5 
 Draw From=ReagentAVial, Volume=0.0 
 SyringeValve Position=Waste 
 MoveSyringeHome 
 SyringeValve Position=Needle 
 MixNeedleWash Volume=50 
 

Inject  
; starts the above program and waits for the inject response 

 
 Acquisition On 

... 
4.000 Acquisition Off 
 End 

 

2. Sample Preparation with 2 Reagents 
 ;User-defined program (UDP) template for FAMOS autosampler 
 ;******    PLEASE DO NOT EDIT  ****** 
0.000 InjectMode = UserProg 
 Draw From=ReagentAVial, Volume=20.0 
 MixWait Duration=5 
 Draw From=ReagentAVial, Volume=0.0 
 MixWait Duration=5 
 Dispense To=SampleVial, Volume=20.0 
 MixWait Duration=10 
 Draw From=ReagentBVial, Volume=10.0 
 MixWait Duration=5 
 Draw From=ReagentBVial, Volume=0.0 
 MixWait Duration=5 
 Dispense To=SampleVial, Volume=10.0 
 MixWait Duration=10 
 
 InjectValve Position=Inject 
 SyringeValve Position=Needle 
 Draw From=SampleVial, Volume=3.0 
 MixWait Duration=5 
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 InjectValve Position=Load 
 Draw From=SampleVial, Volume=5.0 
 MixWait Duration=5 
 InjectValve Position=Inject 
 InjectMarker  

; generates an inject response during the program run 
 
 MixWait Duration=5 
 Draw From=SampleVial, Volume=0.0 
 SyringeValve Position=Waste 
 MoveSyringeHome 
 SyringeValve Position=Needle 
 MixNeedleWash Volume=50 
 

Inject  
; starts the above program and waits for the inject response 

 
 Acquisition On 

... 
4.000 Acquisition Off 
 End 

 

3. Gel Extraction 
 ;User-defined program (UDP) template for FAMOS autosampler 
 ;******    PLEASE DO NOT EDIT  ****** 
0.000 InjectMode = UserProg 
 Draw From=SampleVial, Volume=5.0 
 Dispense To=PrepVial, Volume=5.0 
 Draw From=ReagentAVial, Volume=5.0 
 Dispense To=SampleVial, Volume=5.0 
 MixWait Duration=10 
 
 Draw From=SampleVial, Volume=5.0 
 Dispense To=PrepVial, Volume=5.0 
 Draw From=ReagentBVial, Volume=5.0 
 Dispense To=PrepVial, Volume=5.0 
 MixWait Duration=10 
 
 Draw From=SampleVial, Volume=5.0 
 Dispense To=PrepVial, Volume=5.0 
 MixWait Duration=5 
 InjectValve Position=Inject 
 SyringeValve Position=Needle 
 Draw From=SampleVial, Volume=1.0 
 MixWait Duration=5 
 InjectValve Position=Load 
 Draw From=PrepVial, Volume=5.0 
 MixWait Duration=5 
 InjectValve Position=Inject 
 InjectMarker  

; generates an inject response during the program run 
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 MixWait Duration=5 
 
 Draw From=SampleVial, Volume=0.0 
 SyringeValve Position=Waste 
 MoveSyringeHome 
 SyringeValve Position=Needle 
 MixNeedleWash Volume=50 
 

Inject  
; starts the above program and waits for the inject response 

 
 Acquisition On 

... 
4.000 Acquisition Off 
 
 End 

 

 Tips: 
If the previous action was Draw or Dispense, the needle slowly returns to 
its start position while the MixWait command is executed. For the needle to 
remain at its current position, enter another Draw or Dispense command 
with "Volume=0.0" as shown in the above program examples. 

 Notes: 
Use the PGM Wizard to create a user-defined program. You can either 
create a new user-defined program or use an existing program as a 
template for the new one. 

Each user-defined program must include an InjectMarker command. If this 
command is not included, a message appears in the PGM Wizard. 
 
For an overview of the individual commands that are available for the 
FAMOS autosampler, refer to Commands for Controlling Dionex 
Devices  Dionex/LC Packings FAMOS Autosampler. 
For information about the sample preparation commands supported by the 
FAMOS autosampler, refer to Commands for Controlling Dionex 
Devices  Dionex/LC Packings FAMOS Autosampler: Sample 
Preparation. 
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 Injecting a Sample 
Injections can be performed: 
• Manually  

• Via an Autosampler 

• Automatically (the injection is programmed) 

Click the corresponding control on the control panel or select Inject… on 
the Control menu to open the Inject dialog box. Determine how much of a 
substance is injected (⇒Volume) and from which Autosampler ⇒Position. 

Then, issue the ⇒Inject command.  

Reporting the end of the injection process to Chromeleon completes 
successful injection. If a hand-operated valve is used, this is via a contact 
closure relay. Modern autosamplers automatically send the message via 
the serial interface or a DX-LAN. When Chromeleon has received this 
message, the retention time is started.  

Hand-operated valve (manual injection): 
A µl-syringe is used to inject the sample into the needle seat of the hand-
operated valve. In this way, it reaches the sample loop (Load). By 
switching the valve (Inject), the solvent flow is directed to the sample loop, 
and the sample enters the high-pressure circuit of the system. If correctly 
connected (via a Remote Input), switching the hand-operated valve 
triggers the Inject signal and thus the timer. Very exact operation is 
possible if the injected volume corresponds to the sample loop size. In this 
case, the sample loop is completely filled. When switching the valve, the 
exact volume of the sample loop is injected without any loss. 

Autosampler (manual injection): 
The autosampler can be operated via the input panel on the instrument or 
via the PC. Controlling the autosampler via the PC is a very convenient 
method. However, this is only possible if the autosampler is connected with 
Chromeleon via an RS-232 interface, the DX-LAN, or USB (Universal Serial 
Bus).  
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• Select ⇒Inject on the Control menu and determine the ⇒Volume and 
the Autosampler position for the injection. 

• If your control panel provides the corresponding controls, enter the 
Volume and Position parameters directly in the corresponding edit 
box and click the Load/Inject button. 

The time required by the autosampler to inject the sample can be indicated 
optically. Link a color area or a lamp with the Inject Wait property (for more 
information, refer to How to: Controlling Devices from the Control Panel 

 Linking a Control to a Device). In a controlled system, the pump is set 
to ⇒Hold during injection. 

Automatic injection: 
• Enter the Inject command at the time t = 0.000 in the Program.  

If the command is executed by an autosampler that is controlled by 
Chromeleon, the autosampler returns a signal to Chromeleon when 
injection is completed. Then, the timer is started.  

 Tip: 
With the AS and AS50 autosamplers, sample loading and injection are two 
distinct events. Therefore, include a Load command in the program at 
t = 0.000 and then the Inject command. See  Autosampler Commands 
(AS/AS50) for details. 

When injecting via a hand-operated valve or an autosampler that is not 
controlled by Chromeleon, the data system also waits for a signal before it 
starts the timer. For example, with a hand-operated valve, the signal is 
returned after the valve has switched from Load to Inject, that is, program 
execution is delayed until the injection is actually performed. This type of 
automatic injection requires connection of a remote input or remote start 
device via remote inputs (TTL or relay) and configuration of a remote inject 
device. See  Setting Up Remote Injection. 
 

 Tip:  
As an Inject signal is not specified, there can only be one injection unit per 
timebase, that is, install either a hand-operated valve or an autosampler.  
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 Setting Up Remote Injection 
If Chromeleon does not directly control the injection valve, a Remote 
Inputs (remote start) device can be set up that communicates to 
Chromeleon that injection was performed. The setup procedure is as 
follows: Connect the remote input device via TTL or relay, install and 
configure a remote inject device in the Timebase, and add an ⇒Inject 
command to the Program.  

 Tip: 
For the UI20, remote injection can be triggered by the remote input or by 
pressing the Run button on the UI20 front panel. For the DX-120, remote 
injection can only be triggered by the remote input. The Load/Inject button 
on the DX-120 front panel is disabled during remote control. 
 

Connect the Remote Input Device (TTL or Relay Connections) 
The remote input of the remote input (remote start) device must be 
connected via TTL or a relay to the injection valve or to another device, 
e.g., an Autosampler. Only then, the device can communicate to 
Chromeleon that injection was performed. When injection is performed, the 
injection valve or autosampler sends a signal to the remote input device 
and the remote input device then communicates to Chromeleon that 
injection was performed. 

Example Connections: AS40 and DX-120 
 

 Tip: 
For detailed TTL and relay connection instructions, refer to the operator's 
manual for each device. 
 
The following connections allow completely automated control of the AS40 
and DX-120. 

1. Connect the Relay Control Ready Out pin on the AS40 rear panel to 
the Inject TTL Input pin on the DX-120 rear panel.  

2. Connect the Ready Out Ground pin on the AS40 to the TTL Inputs 
Ground pin on the DX-120. 
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3. Connect the Load pin on the AS40 to the TTL 1 Out pin on the DX-120.  

4. Connect the Load Ground pin on the AS40 to the TTL Outputs 
Ground pin on the DX-120. 

  
 

Configure a Remote Inject Device 
1. Open the Server Configuration. 

2. Select the timebase in which the remote input device is configured. 

3. Select Add Device on the Edit or context menu. The Add device to 
timebase dialog box appears.  

4. Select General from the Manufacturers list box, and then select 
Remote Inject from the Devices list and click OK. 

 The Properties dialog box for the Remote Inject device appears.  

5. The default device name is InjectValve. You can accept the default 
name or enter a different one.  

6. From the Inject Port drop-down list, select the remote input device that 
was connected through TTL or relay. Click OK. 

Add an Inject Command to the Program 
Add the following command to the PGM File. (If you use the Program 
Wizard (see Control  The Program Wizard), the command is added 
automatically). 
 
0.000 Inject  
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When Chromeleon executes the program, it runs the commands that occur 
before the Inject command and then waits for the signal from the remote 
input device. A message in the audit trail is displayed: "Wait for inject 
response on remote start." When the inject signal occurs, program 
execution resumes. 

Example PGM File: AS40 and DX-120 
 
 Data_Collection_Rate 5.00  
 Pump =  On  
 SRS =  On  
 EluentPressure =  On  
 Column =  A  
 ECD_TTL_1.State =  5v Note 1 
 Wait RinseComplete Note 2 
-0.100 ECD_TTL_1.State = 0v Note 3 
    
0.000 ECD.Autozero  Note 4 
 Inject  Note 5 
 ECD_1.AcqOn   
    
10.000 ECD_1.AcqOff   
    
 End   

Notes: 

1. TTL Out 1 turned off. 

2. The TTL_1 5v and TTL_1 0 v commands must be separated by one or 
more commands or they must occur at different times in the program. 

3. TTL Out 1 turned on. AS40 Load Cycle starts. 

4. Program execution waits until inject signal is received. 

5. AS40 Ready Out signals the DX-120 Inject TTL Input. Injection occurs. 
Program execution resumes. 
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 Priming the Syringe (ASI-100 Series) 
The PrimeSyringe command allows removing air from the syringe without 
dismantling the syringe from the instrument. The steps of the PrimeSyringe 
procedure (see below) are automatically performed 5 times with the wash 
liquid. Then, repeat the procedure with the eluent. 

Before performing the PrimeSyringe command: 
• Make sure that the pump flow is off. Else, the pump would deliver 

eluent to the wash vial when the injection valve switches into the Inject 
position (see step 3). 

• Set the WashSpeed and the DispSpeed to values that correspond to 
the installed syringe. (Note: When a wash vial is used, the WashSpeed 
command is required instead of the DrawSpeed command.) 

The recommended settings and the required time are listed in the table 
below: 
 
Syringe 100 µL 250 µL 1000 µL* 2500 µL* 
WashSpeed [µL/s] 5 10 25 25 
DispSpeed [µL/s] 5 10 50 50 
SyringeDelay [s] 5 5 5 5 
Duration of the prime 
syringe cycle [min] 

Approx. 5 Approx. 6 Approx. 7  
(5 x 1000µl) 

Approx. 9 
(5 x 2500µl)  

* Usually no PrimeSyringe command is required to remove gas bubbles 
from syringes with a volume of 1000 or 2500 µL. It is usually sufficient to 
inject the entire syringe volume of eluent. 

• Fill the wash vial with the wash liquid. Enter the vial position in 
Chromeleon (WashVial). 

Dionex recommends using isopropanol (2-propanol) for the PrimeSyringe 
cycle and repeating the cycle with the starting eluent of the next sample. 
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The ASI-100 automatically performs the following steps: 

1. The injection valve is switched into the Load position. The eluent flow is 
from the pump through the valve directly to the column; the eluent does 
not get into contact with the needle or the syringe. In addition, the 
needle descends into the wash vial: 

 

2. The syringe is completely filled: 
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3. The injection valve is switched into the Inject position; the needle 
remains in the wash vial and the contents of the syringe is dispensed 
into the waste:  

 

4. The injection valve is switched into the Load position 

The above steps are performed five times. The wash liquid reaches the 
syringe, removes existing gas bubbles, and exchanges the syringe content: 

 

 Tip:  
The PrimeSyringe command exchanges the liquid in the autosampler 
completely. Therefore, you may also use the PrimeSyringe procedure when 
switching between incompatible applications, such as between reversed-
phase and normal-phase applications. 
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Afterward, the needle returns to the needle port and the injection valve is 
switched into the Inject position. Although most of the wash liquid is 
exchanged with the current eluent and the needle and the needle port are 
filled again with eluent, the segment between the syringe and the waste 
remains filled with the wash liquid: 

  

Therefore, repeat the procedure using the eluent to precondition the valve 
and syringe with the eluent, too. (Note: Use the starting eluent without 
buffer additives to avoid deposits.)  
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 Defining Sample Preparation Steps (AS/AS50) 
Sample preparation steps for the AS and AS50 Autosamplers are part of 
a PGM File and can be defined using the Program Wizard (see Control 

 The Program Wizard). 

Perform the following functions from the Sampler Options dialog box in the 
Program Wizard. 

Defining a New Sample Preparation Step 
1. Select a Function from the list and then select the parameter values for 

the function (see the table below). 

2. Click Insert to add the step to the list. 

The new step is added above the currently selected step (if any). 

Changing an Existing Step 
1. Select the step in the list. 

2. Make the required changes, for example, select a new function and 
enter the function’s parameters, or change the parameters for the 
current function. 

3. Click Enter. 

 Tip: 
To delete a step, select it, and click Delete. 
 
Sample Prep 
Functions 

 
Description 

 
Parameters 

Pipet Move sample between vials Source: the vial from which to pick up the 
sample volume 
Volume: the amount (µl) of sample to be 
pipetted Destination: the vial in which to 
add the sample volume 

Mix Mix the contents of a vial by 
repeatedly drawing and 
expelling a volume of the 
vial contents  

Vial: the vial to be mixed 
Volume: the amount (µl) of the vial 
contents to draw and expel  
Cycles: the number of times to draw and 
expel the specified volume 

Flush Flush inject port during 
sample preparation 

Volume: the amount (µl) to flush through 
the inject port  

Delay Pause sample preparation Delay Time: the number of minutes to 
pause 
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Sample Prep 
Functions 

 
Description 

 
Parameters 

Needle Position needle above vial 
bottom 

Height: the distance (mm) from the vial 
bottom 

Dilute (Available only with the AS 
or AS50 sample preparation 
option) Dilute sample with 
reagent 

Concentrate Source: the vial that contains 
the concentrated sample 
Concentrate Volume: the amount of 
concentrated sample to be diluted 
Diluent Source: the reservoir that contains 
the diluent 
Diluent Volume: the amount of diluent to 
be used 
Destination: the vial into which the 
concentrated sample and diluent are added 

Dispense (Available only with the AS 
or AS50 sample preparation 
option) Dispense reagent to 
a vial 

Source: the reservoir from which to 
dispense reagent 
Volume: the amount of reagent to 
dispense 
Destination: the vial into which reagent is 
dispensed 

Concentrate (Available only when the AS 
or AS50 is in Concentrate 
mode) Load and inject 
sample onto the 
concentrator column 

Valve Position: the position of the injection 
valve 

ReagentPrime (Available only when the AS 
or AS50 is in Concentrate 
mode) Prime the injection 
valve lines with reagent 

Source: the reservoir from which to pick up 
reagent 
Volume: the amount of reagent used for 
priming 
Valve Position: the position of the injection 
valve 

ReagentFlush (Available only when the AS 
or AS50 is in Concentrate 
mode) Flush reagent onto 
the concentrator column 

Source: the reservoir from which to pick up 
reagent 
Volume: the amount of reagent to flush 
through the concentrator 
Valve Position: the position of the injection 
valve 

 Note: 
The Concentrate, ReagentPrime, and ReagentFlush commands require 
AS or AS50 (USB) Moduleware version 2.0.0 (or later). These commands 
are not available for the DX-LAN model of the AS50, regardless of which 
Moduleware version is installed in the autosampler. 

Also, refer to  Entering Sample Preparation Vial Positions and 
 Overlapping Samples. 
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 Entering Sample Preparation Vial Positions 
In sample preparation operations for the AS and AS50 autosamplers, a vial 
position can be specified either as an absolute position or as a relative 
position. 

To specify an absolute position, enter the number of the vial’s position in 
the tray. Valid numbers depend on the tray type in use: 1 to 100 for the 2 ml 
tray; 1 to 49 for the 10 ml plastic tray. 

To specify a relative position, select CurrentVial for the current sample 
vial, CurrentVial+1 for one vial past the current vial, CurrentVial+2 for two 
vials past the current vial, and so on, up to CurrentVial+9.  

Some operations let you specify FlushPort instead of a vial. 

 Overlapping Samples 
To reduce the time between injections, some devices (for example, the 
AS50 and the CC80 Component Controller) support overlapping sample 
preparation. This means that the sample preparation steps are performed 
for the next sample while the current sample is still being analyzed. 

When the device finishes the overlapped functions, the program pauses, if 
necessary, to finish the currently running sample. Then, the remaining 
commands in the overlapped sample’s program are executed. 

The sequence (displayed in the Browser) indicates that sample overlap is 
being performed. The sample currently being analyzed has a green 
background and the ⇒Status Running. The sample being simultaneously 
prepared has a yellow background and the status Preparing. This sample 
has not yet been injected. Therefore, the ⇒Inj. Date/Time column is empty: 

 

In this example, the first unknown sample ('Sample 1') is being analyzed 
while the next sample ('Sample 2') is being prepared. 
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 Note: 
Sample overlap is disabled if the AS or AS50 is shared by two timebases or 
if the autosampler is running in Sequential or Sequential Concentrate 
mode. 

Details about how sample overlapping is performed and which commands 
are required depend on the device. For more information, refer to: 

 Autosampler Commands (AS/AS50) 
 Defining Sample Preparation Steps (AS/AS50) 
 Component Controller Control 

 
Also, refer to Commands and Tips for Third-Party Devices  Waters 
Alliance 2790/2795: Overlapping Sample Preparation. 

 Injecting Two Samples Simultaneously 
Some autosamplers (for example, an AS or AS50 (USB) in the 
Simultaneous mode) can deliver sample to two independent ion 
chromatography (IC) systems. The two IC systems and the autosampler 
are configured into a single timebase and each system is assigned a 
unique device name and channel. This lets you monitor and control both 
systems from one Control Panel and run all samples in one sequence.  

For plumbing connections, refer to the autosampler operator's manual or 
the simultaneous injection kit instructions. 

To set up simultaneous injections in Chromeleon, follow these basic steps: 

1. In the Server Configuration program, create a timebase that includes 
both systems and the AS or AS50 (if used). 

2. Assign a unique name to each device in the timebase. For example, if 
the timebase includes two ICS-2000 systems, name the second system, 
Pump_ECD_2. In addition to renaming the device, also rename any 
signals and other devices associated with system #2 (for example, the 
detector signals, TTLs, relays, and eluent generator). 

 Tip:  
Although you can assign any unique device and signal names to system 
#2, adding _2 to the default names will allow the timebase to be connected 
to the template control panels (described below) without errors.  
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3. In the Browser, open a simultaneous injection control panel and then 
connect the timebase to the panel. For example, to open a simultaneous 
injection control panel for a timebase with two ICS-2000 systems and an 
AS50 autosampler, go to the Dionex 
Templates\Panels\Dionex_IC\ICS-2000 System Panels folder and 
double-click the ICS-2000_System_Simultaneous_AS50.pan file. 

4. Create sequences, PGM Files, and QNT Files for simultaneous 
injections. Follow these guidelines: 
• Create one sequence that includes calibration standards for both 

systems and the unknown samples.  

• Create a PGM File for the unknown samples that includes 
commands for controlling both systems.  

• Calibrate each system separately by creating separate calibration 
PGM Files. 

• Create a single QNT File that includes the components from both 
systems. Use the Duplicate Column command on the Peak Table, 
Amount Table, and Peak Tracking pages of the method to create 
two extra Ret. Time columns; associate each column with a 
different channel. 

Also, refer to: 

Autosampler Control  Autosampler Commands (AS/AS50) 
How To: Integrating Chromatograms and Identifying Peaks 

 Defining the QNT Method for Several Detectors 
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 Sharing an Autosampler 
Two timebases can share a single AS or AS50 (USB) when: 
• The Sequential or Sequential Concentrate mode is selected on the 

autosampler front panel. 

• The diverter valve is installed in the autosampler. 

• The autosampler is configured as a shared device in the Server 
Configuration program. 

• The program includes commands that specify when each timebase has 
exclusive access to the autosampler. 

 Note: 
The DX-LAN model of the AS50 does not support the exclusive access 
feature. If a program created for this autosampler includes 
AcquireExclusiveAccess or ReleaseExclusiveAccess, the command is 
ignored. However, both the AS and AS50 (USB) autosamplers can run any 
program created for the DX-LAN autosampler that includes these 
commands.  

To ensure that the autosampler commands for a timebase are exercised 
before it yields access to the next timebase, insert the 
AcquireExclusiveAccess command immediately before the first 
autosampler command (Flush or Prime) and the 
ReleaseExclusiveAccess command immediately after the last 
autosampler command or property (e.g., TTL or Relay). Thus, a timebase 
does not have to finish data acquisition before the next timebase can 
acquire access to the autosampler. If you want one timebase to control the 
autosampler for an entire sequence, you may omit the 
ReleaseExclusiveAccess command from all but the last program in the 
sequence. 

When the autosampler is in Sequential or Sequential Concentrate mode, a 
DiverterValve.Position command is automatically added immediately after 
the AcquireExclusiveAccess command. 
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In the following example program, commands required for exclusive access 
are in bold. 
 
 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 5000 
 %A.Equate = "%A" 
 %B.Equate = "%B" 
 %C.Equate = "%C" 
 %D.Equate = "%D" 
 AcquireExclusiveAccess  
 DiverterValve.Position_1  
 Flush Volume = 100 
 Wait FlushState 
 NeedleHeight = 2 
 CutSegmentVolume = 0 
 SyringeSpeed = 3 
 TrayTemperature = 10 
 CycleTime = 0 
 WaitForTemperature = False 
 Data_Collection_Rate = 5.0 
 Temperature_Compensation = 1.7 
 DS3_Temperature = 35 
 SRS_Current = 100 
 Wait SampleReady 
 Flow =  1.00 
 %B = 0.0 
 %C = 0.0 
 %D = 0.0 
 Curve = 5 
0.000 Load  
 Wait CycleTimeState 
 Autozero  
 Inject  
 Wait InjectState 
 ECD_1.AcqOn  
1.000 Sampler_TTL_1.0v  
 ReleaseExclusiveAccess  
30.000 ECD_1.AcqOff  
 End  
 
For an overview of the individual commands for the autosamplers, refer to 

 Dionex AS/AS50 Autosamplers. 
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 Opening the AS/AS50 Door during Operation 
Normally, the Autosampler door must remain closed while the AS or 
AS50 is running a batch. If the door is opened inadvertently, the sampling 
arm stops immediately and the batch is aborted. There are certain times 
during operation, however, when the autosampler is not busy, and it is safe 
to open the door. Chromeleon monitors operation and informs you when 
you can open the door without aborting the batch. 
First, press the Door button on the AS or AS50 front panel. If the 
autosampler is busy, a message in the Audit Trail window informs you 
that it is currently not safe to open the door. 

When the autosampler is no longer busy, a message informs you that it is 
now safe to open the door. A timer then begins counting down the time 
remaining in which it is safe to have the door open. It continues counting 
down after the door is opened. The door must be closed again before the 
timer reaches zero, or the batch will be aborted. 

If, after pressing the Door button, you decide you do not want to open the 
door, you can either allow the timer to expire or press any button on the 
autosampler’s front panel to reset the timer to zero. 

 Note: 
To display the timer on the control panel, place a string display, gauge 
slider, or gauge indicator Control on the control panel (see Layout 
Toolbar). Then, link the control to the object property, DoorSafetyTime. 
For more information, refer to How to: Controlling Devices from the 
Control Panel  Linking a Control to a Device. 
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 Monitoring the Status of the AS/AS50 
The Autosampler Status control on a Control Panel displays the action 
currently being performed by the AS or AS50 autosampler: Idle, Preparing 
to run, Injecting, and so on.  

To add the autosampler status to a control panel, place a string display 
Control on the panel (see Layout Toolbar). Then, link the control via the 

Link tab page to the Sampler object property, Status.  
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Detector Control 

The detector type determines which commands are available. For an 
overview of the individual commands available for Dionex UV and PDA 
detectors, refer to  Detector Commands. For more information, refer to:   

 Starting Data Acquisition 
 Defining Signals, Signal Parameters, Axis Decoration, etc. 
 Modifying Signal Parameters (Overview) 
 Determining Wavelength Switching 
 Determining the Optimum Emission Wavelength (RF2000) 
 Recording Fluorescence Spectra (RF2000) 
 Defining a Waveform (Overview)  
 Controlling a Suppressor 
 Performing Cyclic Voltammetry 

In addition, you can  View or Reset the Lamp Age. 

 Detector Commands 

Modifying Signal Parameters 
 
0.000 Channelname.⇒Average =On / Off 

0.000 Channelname.⇒Bandwidth =Value 

0.000 Channelname.⇒Wavelength =Value 

0.000 Channelname.⇒Step =Value [s] / Auto 
 

 Tip:  
Select the Step in such a way that 20 to 50 data points are placed on the 
narrowest relevant peak in your chromatogram. If you acquire more data 
points than necessary, this will consume more storage space and slow 
down data processing and the integration might become incorrect, 
especially when baseline noise is high. This may also happen when using 
the Step =Auto option. 
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 Note: 
To implement Wavelength Switching, define a new wavelength for a 
channel at the switch time.  

Switching Detector ⇒Lamp 
 
0.000 Devicename.Lamp =On / Off 
 

Switching Detector Lamps On/Off  
AD20 Detector 
0.000 Devicename.UV_Lamp =Low / High / Off 
0.000 Devicename.Visible_Lamp =Low / High / Off 
 
AD25 and PDA-100 Detector 
0.000 Devicename.UV_Lamp =On / Off 
0.000 Devicename.Visible_Lamp =On / Off 
 

Selecting the Detection Mode 
ED40, ED50, and ED50A, Detectors 
0.000 Devicename.Mode =Conductivity / IntAmp / DCAmp 
 
ICS-3000 ED Detectors 
0.000 Devicename.Mode = IntAmp / DCAmp / Cyclic 
 

Turning the Amperometry Cell On/Off  
ED40, ED50, ED50A Detector in Amperometry Mode 
0.000 Devicename.Cell =On / Off 
 
ICS-3000 ED Detector 
0.000 Devicename.CellControl =On / Off 
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Selecting the Reference Electrode (ED and ED40/ED50/ED50A 
Detector in Amperometry Mode) 
 
0.000 Devicename.Electrode =pH / AgCL 
 

 Starting Data Acquisition 
• Click the ⇒AcqOn/Off button on the toolbar and determine the 

channels to record via the automatically displayed dialog box.  

• Click the button again to stop data acquisition.  

Alternatively, the command can be performed via the Control menu or the 
corresponding button on the Desktop. Each signal (channel) selected 
during the start of data acquisition is stored in a separate raw data file.  
• Open the context menu from the signal plot to influence the 

representation of the signals (Autoscale, Replot from Beginning, 
Chromatogram Overlay) or the type of the recorded data (signal 
parameters) via the context menu. 

  Defining Signals, Signal Parameters, Axis Decoration, 
etc. 
Right-click a signal plot to open the context menu. Select: 
• Signals to determine the signals to be displayed. 

• Axis/Decoration to display axis decoration, units, timebase names, 
signal parameters, a grid, the signal value, or the retention time. 

• Chrom. Overlay to display a comparable chromatogram. 

Press the F1 key for context-sensitive help. 
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  Modifying Signal Parameters (Overview) 

Manually or directly: 
• Move the mouse pointer to the signal plot on a control panel. 

• Right-click a signal plot and select Signal Parameters.  

• Select the tab page of the signal or channel for which you want to 
change the parameters. Signals of different types have different 

Signal Parameters. 

• MS parameters are not available in this dialog box. Define them in a 
separate METH file. 

Programmed or indirectly: 
In controlled systems, the parameters can be enabled/disabled during 
chromatogram run time at exact times.  
• Select Command on the Control menu, select the signal to modify, 

and then define its signal parameters - or else 

• Enter the corresponding command in a Program that is executed in 
automatic Batch processing. 

For more information, also refer to: 

 Modifying the Signal Parameters of a UV Channel 

 Modifying the Signal Parameters of a 3D Field 

 Displaying the Signal Parameters of a Mass Channel 

For an example for modifying signal parameters, refer to  Determining 
Wavelength Switching. 
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 Modifying the Signal Parameters of a UV Channel 
Modify one or several signal parameters to improve the signals provided by 
the UV Detector: 
 
Signal 
Parameter 

Description 
 

Comment 
 

⇒Average Averaging. Use this parameter to improve the signal-
to-noise ratio. 

⇒Bandwidth Changes the bandwidth with 
which the signal is recorded. 

If necessary, increase the bandwidth to 
improve the Signal to Noise Ratio. 

Delta Indicates the difference 
between the current signal 
value and the signal value 
one second before. 

The value cannot be changed. 

MaxAutoStep Sets the maximum step width 
for the auto setting. 

The highest possible value is the default: 
5.1 s. 

Polarity Changes the polarity of the 
output signal. 

For some detectors, you can use this 
parameter to change the polarity of the 
output signal. 

Retention Indicates the current retention 
time 

The value cannot be changed. 

Signal Value indicates the current 
value of a Signal 
Use UpperLimit and 
LowerLimit to set the signal 
acquisition limits. 

If signal acquisition limits are not met, the 
running batch is stopped and the 

Emergency Program is started. 

⇒Step Changes the step. Select the step such that the narrowest 
peak contains approximately 20 
datapoints  

⇒RefBandwidth 
(Reference 
Bandwidth) 

Changes the reference 
bandwidth. 

If necessary, increase the bandwidth to 
improve the signal-to-noise ratio. 

⇒Wavelength Changes the recorded 
wavelength. 

Note the possibilities for wavelength 

switching (see  Determining 
Wavelength Switching). 
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 Modifying the Signal Parameters of a 3D Field 
Modify one or several signal parameters of a Photodiode Array Detector 
to improve the size and the quality of a 3D Field: 
 
Signal Parameter Description Comment 

⇒BunchWidth Shows the current value of 
the bunch width. 

Increasing the value improves the signal-
to-noise ratio. However, the resolution 
decreases. 

MaxWavelength 
MinWavelength 

Determines the upper/lower 
limit of the 3D field. 

Use these parameters to limit the size of 
the 3D field to the essential section. 

⇒RefWavelength 
(Reference 
Wavelength) 

Changes the reference 
wavelength. 

If necessary, increase the bandwidth to 
improve the Signal-to-Noise Ratio. 

⇒RefBandwidth 
(Reference 
Bandwidth) 

Changes the reference 
bandwidth. 

If necessary, increase the bandwidth to 
improve the signal-to-noise ratio. 

Retention Indicates the current retention 
time.  

The value cannot be modified. 

⇒Step Changes the step. Select the step such that the narrowest 
peak contains approximately 20 
datapoints  

 Determining Wavelength Switching 
Wavelength Switching is realized by time-precise modification of the 

⇒Wavelength (UV detector) or Emission, and Excitation (fluorescence 
detector) signal parameters. 
• For each wavelength switch, enter the time, the channel, and the new 

parameter value in the Program, for example, for the channel of a 
fluorescence detector: 

 
10.000 UV_VIS1.Wavelength = 280 nm 
10.000 UV_VIS2.Wavelength = 320 nm 

or 
 

10.000 Emission.ExWavelength = 240 nm 
10.000 Emission.EmWavelength = 295 nm 

 
In addition to changing the wavelength once, you may as well record 
spectra, for example, using the RF2000 fluorescence detector. For an 
example PGM File for the scan procedure with the RF2000 detector, refer 
to  Determining the Optimum Emission Wavelength (RF2000). 
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 Determining the Optimum Emission Wavelength 
(RF2000) 
Fluorescence detectors not only allow you to automatically change the 
wavelength from time to time (see  Determining Wavelength 
Switching), but also to scan the entire range of the spectrum. Thus, 
spectra acquisition is possible for determining the optimum emission and 
excitation wavelengths. For more information, refer to  Recording 
Fluorescence Spectra (RF2000). 
The PGM File below assists you in finding the optimum values for the 
emission wavelength (that is, the Emission parameter). Start the 
chromatographic analysis using the same conditions as before. Decrease 
the pump flow to 0.000 ml/min as soon as you reach the peak for which to 
optimize the emission wavelength (in the example below: 5.370 min) and 
then start scanning. 
 
-0.1 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 400 
 %A.Equate = "%A" 
 %A.Type = Automatic 
 %B.Equate = "%B" 
 %B.Type = Automatic 
 %C.Equate = "H2O/MeOH 80/20" 
 %C.Type = Automatic 
 %D.Equate = "%D" 
 %D.Type = Automatic 
 Flow = 1.000 
 %B = 0.0 
 %C = 100.0 
 %D = 0.0 
   
 Emission.ExWavelength = 275 
 Emission.EmWavelength = 350 
 Emission.Gain = 1.0 
 Emission.Response = 0.5 
 Emission.Sensitivity = Low 
 Emission.Step = Auto 
 Emission.Average = On 
   
 0.000 Emission.Autozero  
 Inject  
 Emission.AcqOn  
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 5.370 ; stop flow  
 Flow = 1.000 
 Flow = 0.000 
 ; start scanning  
 Emission.ScanEmission  
 ; wait for start of scan  
 Wait Emission.Scanning 
 ; wait for end of scan  
 Wait Not emission.Scanning 
 ; continue flow  
 Flow = 0.000 
 Flow = 1.000 
   
10.000 Emission.AcqOff  
 End  
 
You receive the usual chromatogram until 5.370 min. From 5.370 min on, 
the emission spectrum of the substance currently being in the flow cell is 
recorded. The excitation wavelength of 275 nm is kept. 

Stop the pump flow at the corresponding retention time to optimize the 
emission wavelength for all other peaks as well. Determine the optimum 

Excitation wavelength in the same way. 

 Recording Fluorescence Spectra (RF2000) 
It is not possible to record spectra simultaneously with the Emission 
signal. Single spectra scans are performed, instead. To guarantee a stable 
status in the flow cell stop the pump flow while the scans are performed. 

The duration of the scans depends on the scan speed and the scan range. 
A scan from 200 to 900 nm with the scan speed Fast takes approximately 
85 seconds. The result of a scan is either an emission spectrum or an 
excitation spectrum. These spectra are automatically saved in a Spectra 
Library. A library called RF2000.LIB is created in the timebase directory of 
the local datasource. If a scan is performed during sample processing, a 
library with the same name is saved in the associated sequence.  
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Emission Spectrum 
To scan an emission spectrum: 
• Stop the pump flow via the Flow=0 command. 

• Execute the ScanEmission command. Depending on when the pump 
flow was stopped and when the scan procedure was started, either a 
background spectrum or a peak spectrum is saved. 

• Perform the analog procedure to determine an optimum Excitation 
value. 

Difference Spectrum  
To record a difference spectrum: 
• Record a background spectrum as described above.  

• Select Save Background Spectrum to save this spectrum separately 
in the detector. 

• Reset the pump flow to the original value via the Flow= ... command. 
Continue until the maximum of the peak to detect is reached. 

• Stop the pump flow and record a new spectrum.  

The two spectra now exist in the RF2000 spectra library and as individual 
spectra in two different storage locations within the detector.  
• Execute the GetSpectraDifference command to receive a difference 

spectrum. 

The detector behaves as if a Scan procedure was started. The result of the 
difference formation is also saved to the RF2000 spectra library. This 
spectrum indicates the optimum emission or excitation value. 

 Tip:   

The basic requirement for forming difference spectra is the correspondence 
between the wavelength range defined by the start wavelength and the end 
wavelength, as well as the spectra type (Excitation or Emission). 

For an example program, refer to  Determining the Optimum Emission 
Wavelength (RF2000). 
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 Displaying the Signal Parameters of a Mass Channel 
Different channel types are available for Mass Spectrometers: 

TICF channels (TICF 01 to TICF 09 for the MSQ or TICF_1 to TICF_4 for 
the aQa: data acquisition in Full-Scan mode) 

SIM channels (SIM_01 to SIM_32: data acquisition in SIM mode) 

TIC channel (total of all TICF or SIM channels) 

MS_01 to MS_32 channels (data acquisition in full-scan mode) 

Almost no parameters for mass spectrometer channels can be changed 
from the Control Panel. Select Axis/Decoration on the context menu of 
the signal plot to display the following parameters for the channels of a 
mass spectrometer:  
 
Parameter Description Comment 
Filter Filter of the MS method 

(METH file). 
No input possible, not even in the F8 
dialog box. 

FilterIndex Number of the Filter of the 
MS method. 

Only for the MS_01 to MS_32 channels 
(press F8): Select the number of the 
desired filter (1-9 for the MSQ or 1-4 for 
the aQa): 

 
Min/MaxMass Limits of the mass range that 

is acquired in this channel. 
Only for MS channels MS_01 to MS_32 
(press the F8 key): Enter the lower and/or 
upper mass range limit. 

Polarity Ionization polarity of the mass 
spectrometer.  

No input possible, not even in the F8 
dialog box. 

Source Voltage Voltage of the ion source of 
the mass spectrometer. 

No input possible, not even in the F8 
dialog box.  
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Press the F8 key or select Commands on the Control menu to display the 
following parameters: 
 
Parameter Description Comment 
Delta Difference between the 

current signal value and the 
signal value one second 
before. 

The value cannot be changed. 

Retention Indicates the current retention 
time. 

The value cannot be changed. 

Signal Value indicates the current 
value of a Signal. 
UpperLimit and LowerLimit 
define the signal acquisition 
limits. 

If signal acquisition limits are not met, the 
running batch is stopped and the 
emergency program is started. 

 

  Defining a Waveform (Overview) 
A Waveform must be defined when a Dionex electrochemical detector is 
used in Integrated Amperometry Mode. Waveform definitions are part of a 

Program and can be defined using the Program Wizard. Waveforms can 
also be entered manually into the program. The steps for defining a 
waveform using the Program Wizard vary, depending on the model of 
electrochemical detector being used.  

For details, see: 

 Defining a Waveform for an ED40, ED50, or ED50A Electrochemical 
Detector 

 Defining a Waveform for an ICS-3000 Electrochemical Detector 
(ED) 
Also, refer to: 

The Control Program  The Program Wizard 

How to: Creating and Modifying Programs  Manually Editing a PGM 
File in the Commands View 
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  Defining a Waveform for an ED40, ED50, or ED50A 
Electrochemical Detector 
You can select a preprogrammed Waveform from the Program Wizard, or 
define a custom waveform.  

1. In the Select Waveform Options dialog box of the Program Wizard, 
select Custom to create a new waveform, or select a preprogrammed 
waveform from the list.  

 Note: 
The selected waveform must match the electrode. For guidelines, see 

 Selecting a Default Waveform for Integrated Amperometry.  

2. Click Next>. 

The Waveform Options dialog box appears. If you selected a 
preprogrammed waveform, the selected waveform’s time, potential, and 
integration settings are displayed in the waveform table. If necessary, 
the settings can be modified now (see below). The waveform can also 
be modified in the resulting program after completing the Program 
Wizard.  

3. For each step in the waveform, enter or edit the parameters listed 
below, and then click Enter. 
Time (Sec) The time at which to apply the selected potential.  

 Tip: 
The maximum waveform period (the length of time from the first step in 
the waveform to the last) is 2 seconds. However, because only 1 data 
point can be collected per waveform period, the actual maximum length of 
a waveform period depends on the Data Collection Rate. The 
relationship is as follows: 
data collection rate x waveform period ≤ 1 
For example, if the data collection rate is 5 Hz (5 points per second), the 
longest waveform period allowed is 0.2 seconds. To create a longer 
waveform, reduce the data collection rate. 

Potential (V) The potential to apply between the reference and working electrode. 
Integration The Integration Interval option: 

No-Change keeps the setting selected in the previous step  
Begin starts integration at this point 
End stops integration 

 Tip: 
Each waveform must have one integration interval. Integration cannot 
begin at the first step or end at the last step in the waveform. 
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4. Select the Reference Electrode Mode. 

5. Enter the pH Lower Limit and pH Upper Limit. 
The pH is read at the start of each injection. 

 Note: 
For guidelines when setting the reference electrode mode and pH limits, 
see  Selecting the Reference Electrode Mode with Alkaline 
Eluents. 

 

 Tips: 
To delete a step, select it in the waveform table and click Delete. 

To edit an existing step, select it in the waveform table; change the time, 
potential, and/or integration settings; and press <Enter>. 

Also, refer to: 

The Control Program  The Program Wizard 

How to: Creating and Modifying Programs  Manually Editing a PGM 
File in the Commands View 

  Defining a Waveform for an ICS-3000 Electrochemical 
Detector (ED) 
You can select a preprogrammed Waveform from the Program Wizard or 
PGM Editor, or define a custom waveform.  

1. Go to the ED Options dialog box of the Program Wizard or PGM Editor. 

2. In the Waveform Selector table, select the waveform to be edited or 
select <New Waveform>. 

 Tip: 
In the PGM Editor, an asterisk (*) before a waveform name indicates 
that Chromeleon is reading the waveform definition directly from the 
program (i.e., there is no associated waveform file for this waveform). 
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3. Click Edit. 
 The Waveform Editor appears. If you selected an existing waveform, a 

plot of the waveform is displayed, with the waveform’s times, potentials, 
and other settings displayed in the table below. If you did not select a 
waveform, you can select one now from the Waveform list or you can 
begin creating a new waveform.  

4. Follow the guidelines below to edit an existing waveform or create a 
new one: 
• To add a new line to the end of the list, click Append. 

• To add a new line above an existing line, select the existing line and 
click Insert. 

• To delete a line, select the line and click Delete. 

• To edit parameters for each line, select the parameter and type or 
select the new value. Then, press <Enter> or <Tab>. 

• To update the plot with the new value(s), click Apply. 

5. For each step in the waveform, enter the following parameters: 
 

Time (ms) The time at which to apply the selected voltage.  

 Tip: 
The absolute maximum waveform period is 2 sec. However, for 2D data, 
because only 1 data point is generated per waveform period, the effective 
maximum length of a waveform period depends on the Data Collection 
Rate. The relationship is as follows: 
data collection rate x waveform period ≤ 1 
For example, if the data collection rate is 5 Hz (5 points per second), the 
longest waveform period allowed is 0.2 s (200 ms). To create a longer 
waveform, reduce the data collection rate. 

Voltage (mV) The voltage to apply between the reference and working electrode. 
  
Gain Region Select whether to turn the Gain Region on or off.  
  
Ramp Select either a Ramp or a Step 

change:  
Ramp is a gradual change in 
potential from this step in the 
waveform to the next step. 
Step is an immediate change in 
potential at this step. 
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 For example, enter the following information to define the waveform steps 
shown in the above example: 

 Time Voltage Ramp/Step 
 0.00 -0.10 Step 
 0.20 -0.10 Ramp 
 0.25  0.35 Step 
 0.40  0.60 Step 

 
Integration The Integration Interval option: 

On starts or continues integration 
Off stops integration or keeps integration off (if it was turned off in a 
previous step) 

 Tip: 
Each waveform must have one integration interval. Integration cannot 
begin at the first step or end at the last step in the waveform. 

 
6. After all of the steps have been entered, save the waveform. If you are 

creating a new waveform or editing one of the default waveforms, enter 
a new name before saving. The default waveforms provided with 
Chromeleon are read-only.  

Also, refer to: 

The Control Program  The Program Wizard 

Control  The PGM Editor 

How to: Creating and Modifying Programs  Manually Editing a PGM 
File in the Commands View 

 Selecting a Default Waveform for Integrated Amperometry 
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 Using the Reference Electrode with Alkaline Eluents 
The reference electrode inside the ED and ED40/ED50/ED50A cell is a 
combination pH/Ag/AgCl electrode. Selection of the Reference Electrode 
Mode is one of the steps in  Defining a Waveform. If you select the Ag 
mode, only the Ag/AgCl part of the electrode is used. If you select the pH 
mode, the entire pH/Ag/AgCl electrode is used. 

There are several important considerations: 
• The same pH/Ag/AgCl combination electrode is used in both reference 

modes (Ag and pH). 

• The Ag/AgCl half-cell is more commonly used as the cell reference 
electrode. However, if the pH changes during a separation, then use 
the pH reference mode instead of the Ag mode.  

• When selecting the pH mode, always correct the waveform for pH 
dependence (0.059 V/pH unit). See  Correcting a Waveform for pH 
Dependence for details. 

• The pH readout matters, even if the reference mode is Ag. 

When used with alkaline eluents, the reference potential undergoes a 
gradual change. As the silver chloride layer on the silver wire is converted 
to a mixture of silver oxide and hydroxide, the value of the reference 
potential gradually increases. This gradual change is indicated by the 
changes in pH readout when pumping a known composition of mobile 
phase.  

For example, the pH readout for 60 mM sodium hydroxide should be 
approximately 12.8. It thus follows, from the Nernst equation, that a change 
in pH from 12.8 to 13.3 corresponds to approximately 30 mV of change in 
the reference potential. By calibrating the pH reference electrode only once, 
during initial installation, and by monitoring the pH readout, you can 
determine the status of the reference electrode. On the other hand, 
repeating the calibration will cause an electronic adjustment of the constant 
and slope of the Nernst equation in the detector electronics. Hence, the pH 
readout will be corrected with each recalibration, but the reference potential 
drift will not be apparent.  

Also refer to How to: Performing Validation and Qualification 
 Calibrating the pH Reference Electrode. 
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 Note: 
The reference electrode is a consumable item and should be replaced 
whenever the potential has changed by more than 30 mV (typically, after 3 
months of use). Continued use of a defective reference electrode will cause 
a passivation (loss of detection response) of the working electrode, and 
may result in delays and unnecessary service calls.  

Chromeleon compares the pH value at the beginning of each 
chromatographic run with the upper and lower pH limits you selected when 
defining the waveform. If the pH reading falls outside this range, a warning 
message appears in the Audit Trail. You may want to set the pH limits to 
define a narrow range and rely on the "out of range" warning to detect any 
unacceptable shift in the reference potential. To avoid receiving this 
warning, set the pH limits to a very broad range; for example, 7 to 14.  

Recommendations for Specific Operating Conditions 
 
Operating Conditions Comments 
The mobile phase composition is 
identical at the beginning of each run 
and pH <12.8 

Calibrate the reference electrode only after installation 
of a new electrode. 

 Set the pH upper and lower limits to values 0.5 higher 
and lower, respectively, than the known and constant 
initial pH. Replace the reference electrode when the "out 
of range" warning appears in the Audit Trail. 

 This mode of operation can be used for all CarboPac 
PA10 and AminoPac PA10 applications; it can also be 
used with the CarboPac PA1 when running isocratic 
monosaccharide separations. 

The initial mobile phase composition 
changes from run to run and/or the 
initial pH >12.8 

Calibrate the reference electrode only after installation 
of a new electrode. 

 Test the reference electrode at least twice a week, as 
follows: 
1. Replace the column with a length of narrow diameter 
PEEK tubing. The tubing must generate at least 500 psi 
at the flow rate for your application.  

 Note: 
Testing the pH with PEEK tubing (instead of a column) 
eliminates re-equilibration periods between the high pH 
of actual eluents and lower pH during the reference 
electrode testing. 
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 2. Set the pH limits to 11.5 and 12.5.  
3. Pump an eluent composition having pH 12.0 (for 
example, 90% water and 10% of 100 mM NaOH).  
4. When testing is completed, do the following: 

- Reset the eluent composition. 
- Specify a pH range that is wide enough, for 

example, 7 to 14, to avoid receiving warning 
messages.  

- Reconnect the column. 
 This electrode test with PEEK tubing can be used for all 

CarboPac MA1 applications; it can also be used for 
some separations, such as, sialic acids, with the 
CarboPac PA1.  

Also, refer to  Selecting a Default Waveform for Integrated 
Amperometry. 

 Selecting a Default Waveform for Integrated 
Amperometry 
The following waveforms are provided with Chromeleon. You can use these 
waveforms as is, or modify them for your own applications. If you modify 
one of the default waveforms, you must save it with a different name. The 
default waveforms are read-only. 
 

Waveform 
 

Working 
Electrode* 

Reference 
Mode** 

Comments 
 

Carbohydrates 
(std. quad. 
potential) 

Au disposable 
(P/N 060139; 
pkg. of 6) 
Au (P/N 044112) 

Ag/AgCl Can be used with disposable gold 
electrodes. 

Alcohols, 
Formic Acid, 
Glycols 

Pt (P/N 044113) Ag/AgCl Use with platinum electrodes only. 

Amino Acids 
(pH reference) 

Au disposable 
(P/N 060082; 
pkg. of 6) 

pH/Ag/AgCl For research tasks (e.g., 
waveform development, 
separation optimization), use non-
disposable gold electrode Au (P/N 
055832) 

Amino Acids 
(Ag reference) 

Au disposable 
(P/N 060082; 
package of 6) 

Ag/AgCl For research tasks (e.g., 
waveform development, 
separation optimization), use non-
disposable gold electrode Au (P/N 
055832). 
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Waveform 
 

Working 
Electrode* 

Reference 
Mode** 

Comments 
 

Carbohydrates 
(triple potential) 

Au (P/N 044112) Ag/AgCl Discontinued waveform. DO NOT 
use with disposable gold 
electrodes; dissolves gold and can 
cause reproducibility problems. 

* Working electrode only (does not include complete electrode cell). 
** The same combination electrode (P/N 044198) is used for the pH/Ag/AgCl and 
Ag/AgCl reference modes. 

 Correcting a Waveform for pH Dependence 
At a mobile phase pH of 7, the reference potential of the entire electrode is 
the same as that of the Ag/AgCl half-cell. As the mobile phase pH is 
increased, the pH half-cell potential decreases approximately 0.059 V per 
pH unit. For example, at a mobile phase pH of 12, the reference potential of 
the pH half-cell would be -0.295 V relative to the Ag/AgCl half-cell. 
Therefore, at pH 12, the potentials applied to the working electrode must be 
raised approximately 0.3 V when switching from the "Ag" reference to the 
"pH" reference. 
For example, two default waveforms for amino acids are provided with 
Chromeleon: one for use with the Ag reference electrode mode and one for 
the pH mode. The waveforms are identical except that in the pH mode 
waveform, the potentials are raised by 0.33 V, to compensate for an eluent 
with a pH of 12.7.  
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Also, refer to: 

 Defining a Waveform 

 Selecting a Default Waveform for Integrated Amperometry 

 Performing Cyclic Voltammetry 
The ICS-3000 ED can be used for Cyclic Voltammetry (CV) detection. 
This mode is available only by issuing commands from a Control Panel. 
Cyclic voltammetry commands cannot be programmed into a PGM File.  

 Note:   
A 3D data license is required to acquire and process cyclic voltammetry 
data. 

Before you begin: 
Data from a CV run is stored in the manual sequence in the timebase. In 
order to ensure all data is saved and data from one cyclic voltammetry run 
does not overwrite the data from a previous run, make sure the datasource 
does not have multiple sample status enabled.  
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To do this: 

1. On the Browser, right-click the datasource name and select Properties 
from the context menu.  

2. On the General tab page, clear the Enable Sample Status Multiple 
check box, if it is selected. 

3. In the manual sequence, select Single for the Sample Status of the 
manual sample. Press Enter.  

4. Select Save on the File menu to save the sequence change. 

Setting up and starting the CV run: 
1. On the panel tabset, click the EC Detector tab, or on the Browser, open 

the ED control panel and connect to the Timebase in which the ED is 
configured; see How to: Controlling Devices from the Control Panel 

 Opening a Control Panel.  
2. Enter the following CV parameters:  

CV Cycle Time Enter the time in seconds for one 
CV cycle, which is the time it 
takes to go from the CV Low 
Voltage to the CV High Voltage 
and then back to the CV Low 
Voltage. This creates a triangle 

Waveform.   
CV Low Voltage Enter the lowest voltage to be 

applied during the CV cycle. This 
voltage begins and ends the 
cycle. 

 

CV High Voltage Enter the highest voltage to be 
applied during the CV cycle. This 
is the peak of the triangle 
waveform. 

 

CV Cycles Enter the number of times (2 or 
more) to repeat the CV cycle 

 

3. To start the CV run, click Start CV. The Mode automatically switches to 
CV. 

4. The run continues until all of the specified CV Cycles are completed. At 
the end of the run, the mode, waveform, and voltage settings that were 
in effect before the start of the CV run are restored. 

5. After the run is complete, view the data in the CV view window (see 
 Viewing Cyclic Voltammetry Data). 
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  Defining Step and Average 
The time interval between two recorded data points is referred to as 
⇒Step.  

The smaller the selected step, the more data points will be recorded, thus 
(generally) ensuring a more precise result. As this increases required 
storage capacity, Dionex recommends a good compromise between the 
required information and the capacity. 

For intelligent minimization of the required storage capacity, the individual 
instruments, for example, Dionex detectors, support the setting 
Step = Auto. However, Dionex recommends that you select a fixed step 
because an automatic step may result in a faulty integration. 

In combination with the ⇒Average parameter, the step can optimize the 
signal-to-noise ratio. See the following example: 
 
Example:  A detector delivers 100 values per channel (A and B) and 

per second. For channel A, the setting Step = 0.1; 
Average = ON is selected, and for channel B 
Step = Auto; Average = ON. 

 

Channel A: 
A step of 0.1 corresponds to a sampling rate of 10 values/s. This means 
that out of the 100 values that are available, only every tenth value is 
stored. If the Average signal parameter is ON, the values recorded per 
step are averaged. From 10 values, one average value is formed and is 
stored. For channel A, one signal value per second is stored.  

Channel B: 
Step = Auto means that the Chromeleon decides depending on events, 
how many values should be recorded per second. As a different number of 
values is recorded at different times, a varying number of values is 
averaged in the final value.  

 Tip: 
Use Step = Auto for fast sample chromatograms for which you do not know 
the peak width to be expected. For a precise and reproducible analysis, a 
fixed step should be used. 
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 Viewing or Resetting the Lamp Age 
The PDA-100 detector allows you to display the number of hours the UV 
and visible lamps have been on. In addition, the lamp age can be reset to 
0, if new lamps are installed. 

The lamp age commands are available from the Command dialog box. 
Select Command on the Control menu. Under UV, select UVLampAge or 
VisibleLampAge. The total number of hours the lamp has been on is 
displayed. The number of hours can also be changed from this dialog box. 

The UV and Visible lamp ages can also be displayed on the Control 
Panel. To do this, place a string display Control on the control panel (see 

Layout Toolbar). Then, on the Link tab page, link the control to the UV 
object property: UVLampAge for the UV lamp or VisibleLampAge for the 
visible lamp. 

For more information, refer to: 

 Modifying a Control Panel 
 Modifying a Control 
 Linking a Control to a Device 

 Controlling a Suppressor 
The commands used for controlling a Suppressor differ, depending on the 
model of conductivity detector used and the type of suppressor installed: 
 
Detector Model Supported Suppressor(s) 
CD20, CD25, ED40, 
ED50, IC20, and IC25 

SRS 

 
 Command 
 SRS_Current  =Off, 50, 100, 300, 500 (mA) 

 
Detector Model Supported Suppressor(s) 
CD25A, ED50A, IC25A, 
ICS-1000/1500/2000 

AES, SRS 

 
 Commands 
 Suppressor_Type =AAES, CAES, ASRS_4mm, ASRS_2mm, ASRS MS, 

CSRS_4mm, CSRS_2mm, SRS-MPIC 
 Suppressor_Current =mA 
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 Example  
 Suppressor_Type =AAES 
 Suppressor_Current =20 [mA] 

 
Detector Model Supported Suppressor(s) 
ICS-3000 CD AES, SRS  
 Commands 
 Suppressor_Type =AAES, CAES, ASRS_4mm, ASRS_2mm, 

ASRS MS, CSRS_4mm, CSRS_2mm, SRS-
MPIC 

 Suppressor_CurrentSet =mA 
 
 Example  
 Suppressor_Type =AAES 
 Suppressor_CurrentSet =20 [mA] 
 
The following table lists the operating current range for the suppressors. 
 Suppressor Type Current Range 
 AAES =0.0...150 (mA) 
 CAES =0.0...150 (mA) 
 ASRS_4mm =0.0...500 (mA) 
 ASRS_2mm =0.0...150 (mA) 
 ASRS MS =0.0...150 (mA) 
 CSRS_4mm =0.0...300 (mA) 
 CSRS_2mm =0.0...110 (mA) 
 

 Note: 
The Program Wizard guides you in setting the recommended current for the 
suppressors. The Wizard supplies a recommended current based on the 
eluent concentration and flow rate settings. Chromeleon automatically 
enters the recommended current into the Program and applies that 
current to the suppressor. To ensure the optimal performance of the 
suppressor, always accept the recommended current setting. 

For more information, refer to: 

 Setting Atlas Suppressor Currents 

 Setting SRS Suppressor Currents  

 Setting SRS-MPIC Suppressor Currents 
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 Setting Atlas Suppressor Currents 
For optimal suppressor performance, it is important to use the 
recommended suppressor currents for the target applications. The 
Chromeleon Program Wizard (see The Control Program  The Program 
Wizard) guides you in setting the recommended current for the Atlas 
Electrolytic Suppressor. The wizard supplies a recommended current 
based on the eluent concentration and flow rate settings (see the table 
below). Chromeleon automatically enters the recommended current into the 

Program and applies that current to the Atlas Electrolytic Suppressor.  

 Caution: 
It is possible to override the recommended current settings in the wizard by 
entering an alternate current value in the program file. However, to ensure 
the optimal performance of the suppressor, avoid applying excess current 
to it. Excess operating current leads to excess heat generation, which can 
reduce the suppressor lifetime and cause higher chromatographic baseline 
noise. 

Atlas Electrolytic Suppressors have a maximum suppression capacity of 
25 mN eluent at 1.0 ml/min, which is equivalent to 12.5 mM sodium 
carbonate for anion separations or 25 mM methanesulfonic acid (MSA) for 
cation separations at 1.0 ml/min. 

 Tip: 
For gradient separations, use the highest eluent concentration in the 
gradient when you enter the eluent concentration in the wizard. 

Examples of Recommended Operating Currents for Atlas Electrolytic 
Suppressors: 
Column 
 

Eluent 
 

Flow Rate 
(ml/min) 

Current 
(mA) 

4-mm AS4A-SC 1.8 mM Na2CO3/1.7 mM NaHCO3 2.00 36 
2-mm AS4A-SC 1.8 mM Na2CO3/1.7 mM NaHCO3 0.50 9 
4-mm AS9-HC 9.0 mM Na2CO3 1.00 60 
2-mm AS9-HC 9.0 mM Na2CO3 0.25 15 
4-mm AS14 3.5 mM Na2CO3/1.0 mM NaHCO3 1.20 32 
2-mm AS14 3.5 mM Na2CO3/1.0 mM NaHCO3 0.30 8 
3-mm AS14A 8.0 mM Na2CO3/1.0 mM NaHCO3 0.5 28 
4-mm CS12A 22 mM MSA 1.00 72 
3-mm CS12A-5 µm 20 mM MSA 0.50 32 
2-mm CS12A 22 mM MSA 0.25 18  
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For other column and eluent conditions, the recommended current for the 
Atlas electrolytic suppressors can be calculated using the following 
equation: 

min)/()]([)*min*(67.12)( mlrateflowmNeluentmlmNmAmACurrent ×××=  
For anion separations: 

)]([)]([)]([2)]([ 3
2

3 mMOHmMHCOmMCOmNeluent −−− ++×=  
For cation separations:   

)]([)]([2)]([ 42 mMMSAmMSOHmNeluent +×=  
(Where: [ ] enclosing an ion or eluent indicates concentration.)  

The following table lists the maximum operating currents for the Atlas 
Electrolytic Suppressors under various column diameter and flow rate 
conditions. 

Maximum Operating Currents for the Atlas Electrolytic Suppressors: 
Separation Column Flow Rate (ml/min) Maximum Current (mA) 
2-mm column 0.25 to 0.50   30 
3-mm column 0.50 to 1.00   50 
4-mm column 1.00 to 2.00 100  
Once the recommended suppressor current is determined, turn on the 
pump flow and apply the current to the suppressor.  

 Setting SRS Suppressor Currents 
For optimal suppressor performance, it is important to use the 
recommended suppressor currents for the target applications. The 
Chromeleon Program Wizard (see The Control Program  The Program 
Wizard) guides you in setting the recommended current for the Self-
Regenerating Suppressors (SRS). The wizard supplies a recommended 
current based on the eluent concentration and flow rate settings (see the 
table below). Chromeleon automatically enters the recommended current 
into the Program and applies that current to the SRS.  
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 Caution: 
It is possible to override the recommended current settings in the wizard by 
entering an alternate current value in the program file. However, to ensure 
the optimal performance of the suppressor, avoid applying excess current 
to it. Excess operating current leads to excess heat generation, which can 
reduce the suppressor lifetime and cause higher chromatographic baseline 
noise. 

The maximum suppression capacity of the Self-Regenerating Suppressors 
varies, depending on the suppressor type and the flow rate. The table 
below indicates the absolute maximum suppression capacity for each SRS, 
regardless of flow rate. The required capacity for an application is 
calculated as [mN eluent][ml/min flow rate] and cannot exceed the absolute 
maximum dynamic capacity of the specific suppressor. For example, the 4-
mm ASRS cannot suppress 200 mM at 2.0 ml/min. 
 
Suppressor Absolute Maximum Suppression Capacity  
4-mm ASRS 200 µeqv/min at 1.0 ml/min 
2-mm ASRS 50 µeqv/min at 0.25 ml/min 
4-mm CSRS 110 µeqv/min at 1.0 ml/min 
2-mm CSRS 37.5 µeqv/min at 0.25 ml/min  

 Tip: 
For gradient applications, select the highest eluent concentration in the 
gradient when you enter the eluent concentration in the wizard. 

Examples of Recommended Operating Currents for Self-Regenerating 
Suppressors: 
Column 
 

Eluent 
 

Flow Rate 
(ml/min) 

Current 
(mA) 

4-mm AS4A-SC 1.8 mM Na2CO3/1.7 mM NaHCO3 2.00 26 
2-mm AS4A-SC 1.8 mM Na2CO3/1.7 mM NaHCO3 0.50 7 
4-mm AS9-HC 9.0 mM Na2CO3 1.00 44 
2-mm AS9-HC 9.0 mM Na2CO3 0.25 11 
4-mm AS14 3.5 mM Na2CO3/1.0 mM NaHCO3 1.20 24 
2-mm AS14 3.5 mM Na2CO3/1.0 mM NaHCO3 0.30 6 
3-mm AS14A 8.0 mM Na2CO3/1.0 mM NaHCO3 0.5 21 
4-mm CS12A 22 mM MSA 1.00 65 
3-mm CS12A-5 µm 20 mM MSA 0.50 59 
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Column 
 

Eluent 
 

Flow Rate 
(ml/min) 

Current 
(mA) 

2-mm CS12A 22 mM MSA 0.25 16 
4-mm AS11 12 mM NaOH or KOH 1.00 30 
2-mm AS11 12 mM NaOH or KOH 0.25 7 
4-mm AS11-HC 30 mM NaOH or KOH 1.50 111 
2-mm AS11-HC 30 mM NaOH or KOH 0.38 28 
4-mm AS15 38 mM NaOH or KOH 1.20 113 
3-mm AS15 40 mM NaOH or KOH 0.50 49 
2-mm AS15 38 mM NaOH or KOH 0.30 28 
4-mm AS16 35 mM NaOH or KOH 1.00 86 
2-mm AS16 35 mM NaOH or KOH 0.25 22 
4-mm AS17 15 mM NaOH or KOH 1.00 37 
2-mm AS17 15 mM NaOH or KOH 0.25 9 
4-mm CS14 10 mM MSA 1.00 29 
2-mm CS14 10 mM MSA 0.25 7 
4-mm CS15 10 mM H2SO4/9% Acetonitrile 1.25 74 
2-mm CS15 10 mM H2SO4/9% Acetonitrile 0.30 18 
4-mm CS16 30 mM MSA 1.00 88  
For other conditions, the recommended current for the Self-Regenerating 
Suppressors can be calculated using the following equations. 

For anion separations: 

min)/()]([)*min*(47.2 )( mlrateflowmNeluentmlmNmAmACurrent ××=  

)]([)](3[)](2
3[2)]([ mMOHmMHCOmMCOmNeluent −+

−
+

−
×=

 
For cation separations:  

min)/()]([)*min*(94.2 )( mlrateflowmNeluentmlmNmAmACurrent ××=  

)]([)](
42

[2)]([ mMMSAmMSOHmNeluent +×=
 

(Where: [ ] enclosing an ion or eluent indicates concentration.) 
 
The following table lists the maximum operating currents for the 
suppressors under various column diameter and flow rate conditions. 
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Maximum Operating Currents for the Self-Regenerating Suppressors: 
Suppressor Maximum Current (mA) 
4-mm ASRS 500 
2-mm ASRS 150 
4-mm CSRS 300 
2-mm CSRS 110  
Once the recommended suppressor current is determined, turn on the 
pump flow and apply the current to the suppressor.  

 Setting SRS-MPIC Suppressor Currents 

The Chromeleon Program Wizard (see The Control Program  The 
Program Wizard) displays the valid current settings for Self-Regenerating 

Suppressors (SRS) operating in the MPIC (mobile phase ion 
chromatography) Suppression Mode. For optimal suppressor performance, 
it is important to use the recommended suppressor currents for the target 
applications. The sections below indicate the recommended current for 
anion and cation applications, based on the eluent concentration and flow 
rate. 

 Caution: 
It is possible to override the recommended current settings in the wizard by 
entering an alternate current value in the program file. However, to ensure 
the optimal performance of the suppressor, avoid applying excess current 
to it. Excess operating current leads to excess heat generation, which can 
reduce the suppressor lifetime and cause higher chromatographic baseline 
noise. 

ASRS-MPIC Suppressor 
The ASRS-ULTRA can be used for suppression of MPIC (ion-pairing) 
eluents when operating in the MPIC Suppression Mode. The MPIC 
Suppression Mode is a combination of the AutoSuppression External Water 
Mode augmented with a chemical regenerant, such as, sulfuric acid.  

During operation in the MPIC Suppression Mode, the ASRS-ULTRA uses 
an applied current and a constant source of dilute sulfuric acid solution from 
a pressurized bottle delivery system. The table below lists the 
concentrations and flow rates of standard eluents for anion MPIC 
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separations and the current levels and regenerant flow rates required to 
suppress them.  
 

4-mm ASRS-ULTRA in the MPIC Suppression Mode: 
Matching the Current Setting and Regenerant Flow Rate 

Eluent Eluent 
Flow Rate 
(ml/min) 

Current 
(mA) 

Regenerant 
Flow Rate 
(ml/min)* 

Sulfuric Acid 
Regenerant 
Concentration 
(mN) 

0.1-2.0 mM Tetrabutylammonium 
Hydroxide  

0.5-2.0 50/100 3-5 5-10 

2.0-5.0 mM Tetrabutylammonium 
Hydroxide 

0.5-1.0 100/300 5-8 10 

 1.1-1.5 300/500 5-8 10 
* The flow rate is measured volumetrically with a graduated cylinder (with the power on).  

 Tip:  

For the lower eluent concentration in a given range, choose a 
correspondingly lower current setting; for a higher eluent concentration, 
choose a higher current setting. Higher current settings require the 
application of higher pressure to the pressurized regenerant delivery bottle 
to maintain adequate regenerant flow. 

For complete operating instructions, refer to the manual for the 4-mm 
ASRS-ULTRA. 

CSRS-MPIC Suppressor  

The CSRS-ULTRA can be used for suppression of MPIC (ion-pairing) 
eluents when operating in either the AutoSuppression External Water Mode 
or the MPIC Suppression Mode; the appropriate mode depends on the 
specific MPIC application. The MPIC Suppression Mode is a combination of 
the AutoSuppression External Water Mode augmented with a chemical 
regenerant, if necessary (for example, boric acid). During operation in the 
MPIC Suppression Mode, the CSRS-ULTRA uses an applied current and a 
constant source of regenerant from a pressurized bottle delivery system. 

The separation of alkanolamines by ion-pairing using the CSRS-ULTRA 
requires the addition of 10 mM boric acid to the regenerant. This increases 
the degree of ionization of the alkanolamines, thereby increasing their 
conductivity. Do not use boric acid regenerant for the separations of the 
fully-ionized alkali and alkaline earth metal salts; the borate ion will displace 
the hydroxide counter ion and lower the conductivity response.  
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The table below lists the concentrations and flow rates of standard eluents 
for cation MPIC separations and the current levels and regenerant flow 
rates required to suppress them. 
 

4-mm CSRS-ULTRA in the MPIC Suppression Mode: 
Matching the Current Setting and Regenerant Flow Rate 

Eluent Eluent Flow 
Rate (ml/min) 

Current 
(mA)* 

Regenerant** Flow 
Rate (ml/min)*** 

0.1-2.0 mM Hexanesulfonic 
Acid 

0.5-1.0 50/100 3-5 

2.0-5.0 mM Hexanesulfonic 
Acid 

0.5-1.0 100/300 5-8 

1.1-2.0 mM Octanesulfonic 
Acid 

0.5-1.0 50/100 3-5 

2.0-5.0 mM Octanesulfonic 
Acid 

0.5-1.0 100/300 3-5 

0.1-2.0 mM 
Nonafluoropentanoic Acid 

0.5-1.0 50/100 3-5 

2.0-5.0 mM 
Nonafluoropentanoic Acid 

0.5-1.0 100/300 3-5 

* For optimal results, choose a current setting of 300 mA or less. Operating the 4-mm CSRS-
ULTRA at current settings over 300 mA can shorten the life of the suppressor. 
** The regenerant is deionized water or boric acid. 
*** The flow rate is measured volumetrically with a graduated cylinder (with the power on).  

 Tip:  

For the lower eluent concentration in a given range, choose a 
correspondingly lower current setting; for a higher eluent concentration, 
choose a higher current setting. Higher current settings require the 
application of higher pressure to the pressurized regenerant delivery bottle 
to maintain adequate regenerant flow. 

For complete operating instructions, refer to the manual for the 4-mm 
CSRS-ULTRA. 

 Controlling an MMS Suppressor 
Refer to the MicroMembrane Suppressor manual for operating conditions 
for the MMS, including the Displacement Chemical Regeneration mode. 
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IC Control 

For the control commands for the DX-120, ICS-90, or ICS-1000/1500/2000, 
refer to:  

 Controlling a DX-120 Ion Chromatograph 
 Controlling an ICS-1000/1500/2000 Ion Chromatography System 
 Controlling an ICS-90 Ion Chromatography System 

The following pages provide details on:  

 Controlling the Eluent Generator Concentration 
 Monitoring the Eluent Generator Cartridge Lifetime 
 Monitoring the DX-120 Operating Status 

 Controlling a DX-120 Ion Chromatograph 
The following commands are available for controlling DX-120 operating 
functions: 
 
Controlled AC Turn the AC power outlet on the DX-120 rear panel on and off. This 

provides on off control of an external accessory connected to the outlet. 
See the DX-120 operator’s manual for cabling instructions. 

Column/Eluent If the DX-120 is in Column Mode, the Column command sets the flow 
path to column A or column B. If the DX-120 is in Eluent Mode, the 
Eluent command selects the eluent reservoir (A or B).  

 Note: 

These commands are active only if the DX-120 is equipped with the 
dual-column option. 

Data Collection 
Rate 

Sets the Data Collection Rate of the detector. 

Eluent Pressure Turns the pressure to the eluent reservoir(s) on and off. 
Pressure Unit Selects the units of pressure to use (psi or MPa). 
Pump Turns the pump on and off. 
SRS Turns the current supplied to the Self-Regenerating Suppressor (SRS) 

on and off.  
These commands can be included in a Program, executed directly from 
the Commands dialog box (to do so, select Command… on the Control 
menu), or linked to a Control on the control panel.  
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To link a command to a control, place an edit box or switch control on the 
control panel (see Layout Toolbar). Then, link the control to the desired 
object property. For example, to turn the DX-120 pump on and off from the 
control panel, link the Pump object property to a switch control. For more 
information, refer to How to: Controlling Devices from the Control Panel 

 Linking a Control to a Device. 

The corresponding commands in the program are as follows: 
 
0.000 ControlledAC =On/Off 
0.000 Column =A/B 
; Only for a DX-120 equipped with the dual-column option. 
0.000 Data_Collection_Rate =Value [Hz] 
0.000 Eluent =A/B 
; Only for a DX-120 equipped with the dual-column option. 
0.000 EluentPressure =On/Off 
0.000 PressureUnit =psi/MPa 
0.000 Pump =On/Off 
0.000 SRS =On/Off 

 Controlling an ICS-1000/1500/2000 Ion Chromatography 
System 
Commands for controlling the ICS-1000, ICS-1500, or ICS-2000 can be 
included in a Program (see the examples below), or executed directly 
from either the Control  Panel or the Commands dialog box (select 
Command… on the Control menu). For a list and description of the 
commands used most often, refer to Commands for Controlling Dionex 
Devices  ICS-1000/1500/2000 Ion Chromatography System. Also see 
the Commands dialog box for a complete list of commands. 

The following programs are created with the Program Wizard (see The 
Control Program  The Program Wizard).  

Program for an ICS-1000: 
 
 Pump_ECD.Pressure.LowerLimit =  200 
 Pump_ECD.Pressure.UpperLimit = 3000 
 Pump_ECD.%A.Equate =  "%A" 
 Pump_InjectValve.LoadPosition  
 Pump_ECD.Data_Collection_Rate = 5.0 
 Pump_ECD.CellTemperature =  35.0 
 Pump_ECD.ColumnTemperature = 30.0 
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 Suppressor_Type = AAES 
 ; Carbonate =  3.5 
 ; Bicarbonate = 1.0 
 ; Hydroxide =  0.0 
 ; Recommended Current = 33 
 Suppressor_Current =  33 
 Pump_ECD.Flow = 1.20 
-2.300 Pump_ECD_Relay_1.Closed Duration=138.00 
 ; For AS40 injection. Replace this line 

with the following for manual injection 
 

 ;-0.100 Message "Load the sample into 
the injection loop, press OK to 
continue" 

 

0.000 Pump_ECD.Autozero  
 ECD_1.AcqOn  
 Pump_InjectValve.InjectPosition Duration=30.00 
15.000 ECD_1.AcqOff  
 End  

 

 Note: 
The program above assumes that the ICS-1000’s TTL output is connected 
to the AS40’s Load Relay. Refer to the ICS-1000 and AS40 operator’s 
manuals for connection details. 

Program for an ICS-2000: 
 
 Pump_ECD.Pressure.LowerLimit =  200 
 Pump_ECD.Pressure.UpperLimit = 3000 
 Pump_ECD.%A.Equate =  "%A" 
 Pump_InjectValve.LoadPosition  
 Pump_ECD.Data_Collection_Rate = 5.0 
 Pump_ECD.CellTemperature =  35.0 
 Pump_ECD.ColumnTemperature = 30.0 
 Suppressor_Type = ASRS_4mm 
 ; Carbonate =  0.0 
 ; Bicarbonate = 0.0 
 ; Hydroxide =  12.0 
 ; Tetraborate =  0.0 
 ; Other eluent =  0.0 
 ; Recommended Current = 30 
 Suppressor_Current =  30 
 EluentGenerator.Concentration =  12.0 
 Pump_ECD.Flow = 1.00 
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-2.300 Pump_ECD_Relay_1.Closed Duration=138.00 
 ; For AS40 injection. Replace this line 

with the following for manual injection 
 

 ;-0.100 Message "Load the sample into 
the injection loop, press OK to 
continue" 

 

0.000 Pump_ECD.Autozero  
 ECD_1.AcqOn  
 Pump_InjectValve.InjectPosition Duration=60.00 
15.000 ECD_1.AcqOff  
 End  

 

 Note: 
The program above assumes that the ICS-2000’s TTL output is connected 
to the AS40’s Load Relay. Refer to the ICS-2000 and AS40 operator’s 
manuals for connection details. 

 Controlling an ICS-90 Ion Chromatography System 
Commands for controlling the ICS-90 can be included in a Program (see 
the examples below), or executed directly from either the Control Panel or 
the Commands dialog box (select Command… on the Control menu). For 
a list and description of the commands used most often, refer to 
Commands for Controlling Dionex Devices  ICS-90 
Chromatography System. Also see the Commands dialog box for a 
complete list of commands. 

The following programs are created with the Program Wizard (see The 
Control Program  The Program Wizard). They are identical, except for 
the method used to load the sample loop. 

Program for an ICS-90 connected to an AS40 autosampler: 
 
 Pump =  On  
 MeasuredFlowRate  = 1 
 ;Record the flow rate set from the hardware 
 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 3000 
-2.000 Pump_ECD_TTL_1. 0v Duration= 

120.00 
 ;Turn on TTL 1 for 120 seconds,  

;AS40 load cycle started 
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0.000 Pump_ECD.Autozero  
 InjectPosition Duration= 

60.00 
 ;Set the injection valve to the inject position 

;for 60 seconds 
 ECD_1.AcqOn  
30.000 ECD_1.AcqOff  
 End  

 

 Note: 
The program above assumes that the ICS-90’s TTL output is connected to 
the AS40’s Load Relay. Refer to the ICS-90 and AS40 operator’s manuals 
for connection details. 

Program for manual injections: 
 
 Pump =  On   
 MeasuredFlowRate  = 1  
 Pressure.LowerLimit = 0  
 Pressure.UpperLimit = 3000  
0.000 Pump_ECD.Autozero   
 Message "Manually inject the 

sample and click OK to continue. 
If you are using an autosampler 
remove this command from the 
Program file." 

;Pause the program and 
display the message 

 InjectPosition Duration= 
60.00 

 

 ECD_1.AcqOn   
30.000 ECD_1.AcqOff   
 End   
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 Controlling the Eluent Generator Concentration 
The eluent concentration generated by the Eluent Generator can be set 
manually or controlled via a Program. The allowable eluent concentration 
depends on several factors. Refer to the appropriate section below for 
details.  

To determine the maximum eluent concentration for your application, refer 
to the column manual. Dionex column manuals are included on the Dionex 
Reference Library CD-ROM. 

EG40, EG50, or ICS-2000 Eluent Generator 
These products can generate eluent concentrations from 0.1 to 100 mM. 
The maximum concentration (X) depends on the pump flow rate and is 
calculated as:  

0.1 to 100 mM at 0.1 to 1.0 ml/min 

0.1 to X mM at 1.0 to 3.0 ml/min 

where X mM = 100/Flow Rate in ml/min  

Apart from the flow rate, the suppressor and the EluGen cartridge type 
determine the maximum eluent concentration possible for a particular 
application.  

ICS-3000 EG: Single-Cartridge Configuration or Independent Dual-
Cartridge Configuration 
In the single-cartridge configuration, the EG contains one EluGen cartridge. 
In the independent dual-cartridge configuration, the EG contains two 
EluGen cartridges that are being operated independently on separate 
systems (each cartridge is linked to a different pump). The following table 
indicates the allowable concentration range for each cartridge in this 
configuration. 
 
EluGen Cartridge Eluent Concentration Range 

K2CO3 0.1 to 15 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 15/Flow 

KOH 0.1 to 100 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 100/Flow 
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EluGen Cartridge Eluent Concentration Range 

LiOH 0.1 to 80 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 80/Flow 

MSA 0.1 to 100 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 100/Flow 

NaOH 0.1 to 100 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 100/Flow 

Electrolytic pH Modifier Not applicable; the Electrolytic pH Modifier is 
available for selection only for the linked dual-
cartridge configuration.  

ICS-3000 EG: Linked Dual-Cartridge Configuration 
In the linked dual-cartridge configuration, the EG contains two EluGen 
cartridges, linked to a single pump, that work together. The allowable 
concentration for each linked cartridge is less than when the cartridge is 
defined as independent. The following table indicates the allowable total 
concentration for each cartridge in this configuration. 
 
EluGen Cartridges Eluent Concentration Range Comment 
K2CO3/Electrolytic pH 
Modifier 

0.1 to 15 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 15/Flow 

The Electrolytic pH 
Modifier’s eluent 
concentration must be 
less than or equal to the 
K2CO3 cartridge’s eluent 
concentration, but must 
not exceed 10 mM. 

KOH/KOH 
KOH/MSA 
KOH/NaOH 
MSA/MSA 
MSA/NaOH 
NaOH/NaOH 

0.1 to 50 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 50/Flow  

The eluent concentration 
range for each cartridge 
is cut by 50%. 

LiOH/LiOH 0.1 to 40 mM, 0.1 < Flow ≤ 1.0 ml/min 
0.1 to X mM, 1.0 < Flow ≤ 3.0 ml/min 
X = 40/Flow 

The eluent concentration 
range for each cartridge 
is cut by 50%. 
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Manually Setting the Eluent Generator Concentration 
1. Open the control panel for the Timebase; see How to: Controlling 

Devices from the Control Panel  Opening a Control Panel. 
2. Move the Concentration slider to select a value or enter the value into 

the edit field. 

-or- 

Enter the concentration from the Commands dialog box. To do this, select 
Command on the Control menu. Under EluentGenerator, select the 
Concentration command. 

Programming the Eluent Generator Concentration 
Commands for setting the eluent concentration can be added to a program 
(see Control  The Control Program).  

You can use the  Program Wizard to enter the concentration 
command(s). With the wizard, you can enter a single concentration value 
for the entire analysis or program a ramp or multi-step gradient in which the 
generated concentration of eluent changes over time. When completing the 
wizard, click the Help button on the EluentGenerator Options tab page to 
display details about the eluent generator and gradient options.  

 Note: 
The ICS-2000 Gradient Generator license is required in order to create 
eluent gradients with the ICS-2000. 

 Monitoring the Eluent Generator Cartridge Lifetime 
Chromeleon monitors the lifetime status of the EluGen cartridge currently 
being used by the eluent generator and displays the information on the 

Control Panel and in the Chromeleon Server Configuration program.  

The Remaining Lifetime (Ion Count) or Remaining Life (%) represents 
the percentage of the original ion capacity remaining in the cartridge. The 
ion percentage is counted down in 1% increments. At 10%, Chromeleon 
logs a warning each time the cartridge is used. At 0%, Chromeleon displays 
a message that the ion count is depleted; the cartridge must then be 
replaced before operation can be continued. 
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The Expiration Date is 2 years from the date of manufacture. One month 
before expiration, Chromeleon logs a warning each time the cartridge is 
used. Although you can continue to operate with the cartridge after the 
expiration date, performance may be impaired until a new cartridge is 
installed. 

To view the cartridge lifetime status information from the Server 
Configuration program: 

1. In the Server Configuration program, select the EG40 or EG50 Eluent 
Generator, the ICS-2000 that contains the eluent generator, or the ICS-
3000 EG. 

2. Select Properties on the Edit menu. 

3. For an EG40 or EG50, select the Pump Link & Cartridge tab.  

4. For an ICS-2000, select the Eluent Generator tab.  

5. For an ICS-3000 EG, select the Cartridges tab. 

 Monitoring the DX-120 Operating Status 
You can monitor the status of many DX-120 operating functions on the 
control panel. For example, the control panel can include Controls 
displaying the current DS4 temperature set point and status, the current 
flow rate, and the SRS status. 

To add the corresponding controls to the control panel and link the desired 
status functions, follow the description in How to: Controlling Devices 
from the Control Panel: 

 Modifying a Control Panel 
 Modifying a Control 
 Linking a Control to a Device 

 
The following DX-120 functions can be monitored on the control panel. 
 
DX-120 Function Description 

Column 
Configuration 

Indicates whether the DX-120 is configured with a single- or dual-column 
set. 

DS4 Status Indicates whether the current DS4 temperature is under, at (ready), or 
over the temperature set point. 

DS4 Temperature Displays the current DS4 temperature set point. 
Flow Rate Displays the pump flow rate. 
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DX-120 Function Description 

Full Scale Indicates the microSiemens output (100 or 1000) of a full-scale detector 
response. 

Pressure Displays the current pump pressure transducer reading.  
SRS Status Indicates the status of the SRS, not installed, off, or the selected 

operating current (if on). 
System Mode Indicates whether the DX-120 is in Column Mode or Eluent Mode.  

 Tips: 
The Chromeleon reports the status of the above DX-120 functions only. 
Except for the system mode, values for these functions are selected with 
DIP-switches on the DX-120. Refer to the DX-120 operator’s manual for 
more information. The system mode is selected in the DX-120 Properties 
dialog box (Mode tab page) in the Server Configuration. 

For functions that can be controlled by Chromeleon, refer to 
 Controlling a DX-120 Ion Chromatograph. 

 Monitoring the ICS-1000/1500/2000 Operating Status 
You can monitor the status of many ICS-1000/1500/2000 operating 
functions on the control panel. For example, the control panel can include 

Controls displaying the current pump flow rate, DS6 conductivity cell 
temperature, eluent generator status, and amount of eluent in the reservoir. 

To add the corresponding controls to the control panel and link the desired 
status functions, follow the description in How to: Controlling Devices 
from the Control Panel: 

 Modifying a Control Panel 
 Modifying a Control 
 Linking a Control to a Device 
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The following ICS-1000/1500/2000 functions can be monitored on the 
control panel. 
 
Function Description 

%A_Value Indicates the partial flow of a component, expressed as a percentage 
of the total flow. 

Acquisition_Ready Indicates whether the ICS-1000/1500/2000 is ready to begin data 
acquisition. 

CellTemperature Indicates the DS6 conductivity cell temperature. 
ColumnTemperature Indicates the column temperature; available only if the column heater 

option is installed. 
DegasCycleOff, 
DegasCycleOn 

Indicates whether the degas cycle is off or on; available only if the 
vacuum degas option is installed. 

DegasMode Indicates the degas mode setting (Always Off, Always On, Cycle, or 
Monitor); available only if the vacuum degas option is installed. 

DegasPressure Indicates the degas pressure (in psi); available only if the vacuum 
degas option is installed. 

EGC1_Connected, 
EGC2_Connected 

Indicates whether the corresponding eluent generator cartridge is 
connected or disconnected (ICS-2000 only). 

EgcCurrent Indicates the operating current of the eluent generator cartridge (in 
mA) (ICS-2000 only). 

EgcVoltage Indicates the eluent generator cartridge voltage (ICS-2000 only). 
EluentBottleLevel Indicates the volume of liquid (in liters) in the eluent reservoir.  
EluentValve Indicates whether the eluent valve is open or closed. 
Pressure Indicates the current pump pressure transducer reading.  
Rise_Time Indicates the filter rise time to apply to the recorder output. 
SuppressorStatus Indicates whether the suppressor is on, off, or not installed. If the 

suppressor is on, the selected operating current is displayed. 
SuppressorVoltage Indicates the suppressor voltage. 
TotalConductivity Indicates the measured conductivity (with no offset applied). 
  
TTL_Input_Function_1, 
TTL_Input_Function_2, 
TTL_Input_Function_3, 
TTL_Input_Function_4 

Indicates the function assigned to the corresponding TTL input. 

TTL_Input_Mode Indicates the TTL input mode setting.  

 Note: 
Chromeleon reports the status of the above ICS-1000/1500/2000 functions. 
For a list of functions that can be controlled by Chromeleon, refer to 

 Controlling an ICS-1000/1500/2000 Ion Chromatography System. 
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GC and Temperature Control 

Flow and pressure control is an important aspect of gas chromatographs. 
For more information, refer to 

 Flow/Pressure Control for Gas Chromatographs 

 Determining a Gradient (GC). 
The Agilent 6890 GC and the 7673 and 7683 GC autosamplers support 
simultaneous injection of two samples. For more information, refer to:  

 Commands and Properties for Dual Operation (6890)  

 Injecting Two GC Samples Simultaneously (6890)  

 Injecting Two GC Samples Simultaneously (7673 and 7683 
Autosamplers).  
Some instruments support temperature control. For general information, 
refer to: 

 Temperature Control (On/Off)  

 Controlling the Temperature 
For information about how to control a column thermostat, refer to 

 Controlling the Column Temperature 

 Flow/Pressure Control for Gas Chromatographs 
Gas chromatographs can operate at a constant gas flow or at a constant 
pressure. It is possible to switch from one mode to the other.  

Two mutual switches are assigned the property FlowMode. Setting the flow 
and the pressure is in the corresponding mode via a separate control 
(gauge or edit field). 
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 Determining a Gradient (GC) 
For basic information about how to determine a gradient, refer to 

 Determining a Gradient. 
How to enter basic points for GC: 
• Select the initial temperature in the Init line. 

• In the Iso Time column, enter for how long this temperature shall be 
maintained. 

• In the next line, select the ramp (Rate in °C/min) to be used to change 
the temperature. In the Temperature column, select the temperature 
that the GC should reach with this first ramp. In the ISO Time column, 
reenter for how long this temperature shall be maintained. 

You can program up to six temperature ramps. 

In the same way, you can use the FrontInlet and BackInlet pages to 
determine a temperature gradient for an inlet. A temperature gradient can 
be determined for PTV and Cool on Column inlets. 

For example, for the HP 6890, you can use the Column1 and Column2 
pages to define flow and pressure gradients. Select Type: Ramped Flow 
to program a low gradient. Or else, select Type: Ramped Pressure to 
program a pressure gradient. The gradient will then be displayed in the 
color indicated at the top right. 

 Tip:  

After the program run, each sample is automatically reset to the original 
state, i.e., for example, the initial temperature is restored. Restoring the 
initial temperature in this way is usually the quicker way, compared to 
setting the corresponding cool-down command in the program.   
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 Commands and Properties for Dual Operation (6890) 
In dual operation mode, the 6890 GC allows you to simultaneously inject 
two samples from different positions, and thus doubling the sample 
throughput. To work in dual operation mode, you have to install and 
configure the 6890 GC as described in Installation Instruction  Agilent 
6890 GC: Dual Operation in the Administrator Help section. 

After you have installed the GC as described, the following commands and 
devices will be available in the PGM Editor, depending on the timebase: 

    

The commands and properties for the GC and the sampler are listed under 
both timebases. For the sampler, this is above all UseTray. For the GC, 
these are temperature commands and properties. (Note: The single 
commands and properties have been removed from the above picture; they 
are usually listed in the Commands dialog box between the 
EraseErrorLog and Connect commands.) The commands that are 
available for both timebases must be identical for simultaneously running 
samples, i.e., they must be identical in the related PGM Files. 

In addition, only commands and properties are listed for the devices that 
are actually installed in the timebase. For example, the commands and 
properties for the following devices appear under the first timebase (here: 
6890_A): 



1228 Practical Tips for Device Control 

• Front injector (default name: FrontInjector) 

• Front inlet (FrontInlet) 

• First column (Column1) 

• Front detector (GC_1) 

Under the second timebase (here: 6890_B), the commands and properties 
appear for the following devices: 
• Back injector (BackInjector) 

• Back inlet (BackInlet) 

• Second column (Column2) 

• Back detector (GC_2). 

For information about how to perform dual injection, refer to  Injecting 
Two GC Samples Simultaneously (6890). 

 Injecting Two GC Samples Simultaneously (6890) 
To double the sample throughput, the 6890 GC supports dual operation 
mode, allowing you to simultaneously inject two samples from different 
positions. The following conditions must be met: 
• The GC must be fitted with the required hardware components. 

• The GC must be installed in two timebases (refer to Hardware 
Installation: Third-Party Devices  Agilent 6890 GC: Dual 
Operation in the Administrator Help section). 

• The PGM Files for the two timebases must match. 

• A batch must be available for each timebase. 

After the installation, follow the steps below to set up dual injection: 
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Creating two PGM Files 
Create a PGM File for each timebase, observing the following: 

Enable dual operation with the following command (this is also possible 
from the control panel):  

 DualOperation = Shared 
 

 Tip:  
 When a batch is running, it is not possible to perform manual commands in 
Shared mode (exceptions: RunLog, ReportReady und PrepRun). To 
control the GC via manual commands while a batch is running, assign the 
GC to only one timebase: 

 DualOperation = FrontOnly or BackOnly 
 
• Make sure that all commands and properties shared between the 

timebases (see  Commands and Properties for Dual Operation 
(6890)) have the same values at the same retention times. This is 
especially important for the temperature. 

• Commands and properties that are assigned to only one timebase can 
be set independently of the setting in the PGM File for the other 
timebase. 

• The Inject command is an exception: It must be available in both 
programs at the same time. (In special cases, it may be missing in 
both programs; it must not be missing in only one program.) 

Creating a sequence and a batch for each timebase 
Keep in mind it is not possible to simultaneously inject two samples from 
the same vial (except if UseTray = No). 

It is not necessary that the batches include the same number of samples. If 
all samples of one batch are processed, sample processing will continue for 
the remaining samples of the other batch. 

 Tip:  
It is also possible to add new samples or sequences to the finished batch 
and restart the batch. Sample processing is resumed when the next sample 
of the running batch is started. 
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Starting batches 
When DualOperation is set to Shared, a batch must be started on both 
timebases simultaneously: 
• Start the batch on one timebase. 

• A message may appear in the Audit Trail telling you to start a batch on 
the other timebase, too. 

• Start the batch on the other timebase.  

• Both batches run synchronized. The ReadyCheck checks that the 
shared properties, temperature gradient, and run time for the sample 
pairs match and that the injections are performed from different 
positions. 

 Note:  

• Observe the following restrictions: 

• The Ready Check is possible for both timebases only if the batch 
on the other timebase is already running. 

• The Ready Check can check only the active sequences. 

• The Ready Check can see changes to the running sequence on the 
other timebase only when you stop and restart the batch on the 
other timebase. (If the Ready Check reports an error on the other 
timebase, follow the steps below:  

- In the timebase for which the error was reported. 

- Stop the batch. 

- Eliminate the error. 

- For the first sample, set the status from Interrupted to Single. 

- Restart the batch. 

- Return to the original timebase. 

- Run the Ready Check once again. 

For information about how to install the 6890, refer to Hardware 
Installation  Agilent 6890 GC: Overview in the Administrator Help 
section. 
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 Injecting Two GC Samples Simultaneously (7673 and 
7683 Autosamplers) 
To double the sample throughput, the Agilent 7673 and 7683 GC 
autosamplers support dual injection, allowing you to simultaneously inject 
two samples from different sample positions. 

 Note: 
The Dionex AS and AS50 autosamplers also support simultaneous 
injection of samples. Refer to Practical Tips for Device Control: 
Autosampler Control  Autosampler Commands (AS/AS50). 

Use the following command to enable or disable the dual injection: 
 DualInject = On/Off 

 
If DualInject is set to On, both injectors inject simultaneously. The master 
injector is always the injector mentioned in the Inject command. For 
example, the front injector is the master injector if the command is:  

0.000 Front.Inject  
 
The master injector injects from the sample position defined in the 
sequence. The sample position for the other injector (the so-called slave 
injector) needs to be defined separately, via either the Fixed Offset or the 
UDC method. 

Fixed Offset Method 
The Fixed Offset method defines the sample position from which to inject, 
relative to the position from which the Master Injector injects: 

 DualInject = On 
 Rear.Position = FrontPosition + 25 
0.000 Front.Inject  

 
Dionex recommends reserving the first and third quadrant for the Front 
Injector and the second and fourth quadrant for the Rear Injector. 

To run a chromatogram with one sample only, use a different PGM File 
including "DualInject = Off" for the corresponding sample. 
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UDC Method 
For the UDC method, a User-Defined Column is required for the 
datasource named; for example, RearPosition, Value type "Integer", 
Minimum "1", Maximum "100." The "empty values are possible" option 
should be enabled. In this column, enter the sample position from which the 
slave injector (in this case, the Rear Injector) will inject. 

The corresponding program lines read as follows: 
 DualInject = On/Off 
 Rear.Position = Sample.RearPosition 
0.000 Front.Inject  

 
Use the UDC method to define a separate sample position for each 
injection. If the Rear Injector will not be performing an injection, leave the 
corresponding cell empty. (This is only possible if the "empty values are 
possible" option is enabled for the column.) 

For information about how to install the Dual Inject option of the 7673 and 
7683 autosamplers, refer to Installation Instruction  Agilent 7673 and 
7683 Autosamplers: Dual Inject in the Administrator Help section. 

For information about how to install the autosampler, refer to  Agilent 
GC Autosamplers: Flow Chart in the Administrator Help section. 

 Temperature Control (On/Off) 
Assign TempCtrl property to a Control on a control panel, e.g., to a 
switch, to turn temperature control for the corresponding instrument on and 
off (see How to: Controlling Devices from the Control Panel  Linking 
a Control to a Device). The actual temperature is set by an additional 
control (see Practical Tips for Device Control: GC and Temperature 
Control  Controlling the Temperature). 

Instruments providing temperature control include column ovens, 
autosamplers (Dionex ASI-100 T and ASI-100 PT), specific detectors, and 
gas chromatographs (HP 5890). 
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You can also enable the temperature control via a Program. The 
corresponding command syntax is: 
 
0.000 X.TempCtrl=On or 
0.000 X.TempCtrl=Off  
 
Where X is the name under which the corresponding instrument is listed in 
the Server Configuration program; for example: 
 
0.000 GC.TempCtrl=On or 
0.000 Sampler.TempCtrl=On  
 

 Controlling the Temperature 
Instruments providing temperature control, such as column ovens, 
autosamplers (Dionex ASI-100T and ASI-100 PT), or gas chromatographs 
(HP 5890), can be operated directly by Chromeleon if the corresponding 
device driver supports this function. The prerequisite is that temperature 
control of the instrument has been enabled (see Practical Tips for Device 
Control: GC and Temperature Control  Temperature Control 
(On/Off)). 
You can then control the temperature of the instrument by using the 
corresponding Control (gauge or edit field) on the Control  Panel.  
 

 Note: 
To do so, assign the Temperature property to the control. For more 
information, refer to How to: Controlling Devices from the Control Panel 

 Linking a Control to a Device 

Manual Cooling 
• Move the slider with the mouse to the desired temperature value.   

• Enter the nominal temperature in an edit field. 

• A slider can have an additional gauge for the upper and lower 
temperature limits. Chromeleon monitors the set temperature range. 

• Point to the gauge to display the exact value of the set temperature.  
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If an instrument reports that the set temperature value was actually reached 
(Ready), this can be made visible via an LED on the control panel (see 
Practical Tips for Device Control: Special Commands, Relay Control, 
and Miscellaneous  The Ready Signal). 

Programmed Cooling 
In the Program, the temperature of an instrument can be adjusted as 
follows:  
  

0.000 TempCtrl = On/Off 
; This command enables and disables 

the temperature control. 
 

0.000 X.Temperature = Value[°C] 
; 
; 
; 

This command sets the nominal temperature.  
X corresponds to name of the instrument as defined  
in the "Server Configuration" program. 

0.000 X.Temperature.UpperLimit = Value[°C] 
0.000 X.Temperature.LowerLimit = Value[°C] 
; 
; 

These commands define the upper and lower limit.  
The limits are monitored by Chromeleon. 

0.000 Wait SampleTempOK (or 
similar) 

; 
; 
; 

The Wait command delays all further operations on  
the instrument until the system receives the feedback 
that the nominal temperature has been reached. 
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 Controlling the Column Temperature 
The following Dionex instruments provide temperature control of the 
column: 
 
Instrument Temperature Control Range 
  

 TCC-100 Thermostatted Column 
Compartment (see the Administrator 
Help section for details) 

5°C to 80°C 

  

 STH585 Column Oven (see the 
Administrator Help section for details) 

5°C to 85°C 

  
ICS-1000/1500/2000 Ion 
Chromatography Systems 

30°C to 60°C. (The column heater is an option for 
the ICS-1000.) 

  
AS50 Thermal Compartment 10°C to 40°C for PEEK systems 

10°C to 80°C for stainless steel systems 
  
ICS-3000 Detector/Chromatography Units without separate column temperature 

control: 10°C to 40°C  
Units with separate column temperature control: 
10°C to 40°C (upper compartment) 
10°C to 70°C (column compartment) 

  

 FLM-3100 Flow Manager and 
Thermostatted Column Compartment  
(see the Administrator Help section for 
details) 

5°C to 70°C 

 
Depending on the type of Control (see Layout Toolbar), you can have 
the current temperature displayed (alphanumeric display), set a new 
temperature value (edit field), or determine the upper and/or lower 
temperature limit (gauge slider). For more information about changing 
controls, refer to How to:  Controlling Devices from the Control 
Panel. 
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It is also possible to integrate column temperature control into a Program. 
See the following descriptions. 

TCC-100 and FLM-3100program commands: 
0.000 ColumnOven.Temperature            = Value[°C] 
; This command determines the nominal temperature. 
0.000 ColumnOven.Temperature.UpperLimit = Value[°C] 
0.000 ColumnOven.Temperature.LowerLimit = Value[°C] 
; 
; 

These commands determine the upper and lower limits.  
The limits are monitored by Chromeleon. 

 

ICS-1000/1500/2000 and AS50 thermal compartment program 
commands: 
0.000 Column.Temperature              = Value[°C] 
; This command determines the nominal temperature. 
0.000 Column.Temperature.UpperLimit   = Value[°C] 
0.000 Column.Temperature.LowerLimit   = Value[°C] 
; 
; 

These commands are available for the ICS-1000/1500/2000 
only and determine the upper and lower limits.  
The limits are monitored by Chromeleon. 

 

DC program commands: 
Include the following commands before data acquisition begins: 
 Column_TC.AcquireExclusiveAccess 
; This command gives exclusive control of column temperature 

to the current timebase. 
 Column_TC.Mode                   = On/Off 
 Column_TC.TemperatureSet         = Value[°C] 
; 
; 

These commands turn on or off column temperature control 
and determine the temperature setpoint. Column temperature 
control is an option in the DC. 

 Compartment_TC.AcquireExclusiveAccess 
; This command gives exclusive control of compartment 

temperature to the current timebase. 
 Compartment_TC.Mode              = On/Off 
 Compartment_TC.TemperatureSet    = Value[°C] 
; 
; 

These commands turn on or off compartment temperature 
control and determine the temperature setpoint. 
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Include the following commands after data acquisition ends: 
 Column_TC.RelaseExclusiveAccess 
 Compartment_TC.ReleaseExclusiveAccess 
; 
; 

These commands release control of the column and 
compartment temperatures to allow another timebase to 
acquire exclusive access. 

 

For the commands that Chromeleon supports for the column compartments 
and for the FLM-3100 Flow Manager and Thermostatted Column 
Compartment, refer to Device Control: Commands for Controlling 
Dionex Devices  Dionex Flow Manager and Thermostatted Column 
Compartments. 
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Component Controller Control 

As with other Chromeleon controlled devices, to control a CC80 
Component Controller using programmed control, commands are included 
in a PGM File. However, the CC80 differs from other controlled devices in 
that Sequences are not created in Chromeleon. Instead, sequences are 
created in the Analyzer program, which then oversees control of the CC80 
and the other analyzer devices. Refer to the Analyzer program Help for how 
to create and run analyzer sequences. 

The simplest way to create a program for the CC80 is to use the Program 
Wizard (see Control  The Program Wizard). Using the wizard ensures 
that commands and parameters are entered with the correct syntax and in 
the correct order. This is especially helpful for entering the SP80 valve 
commands for sample preparation.  

 Note: 
Direct control of a CC80 using a Control Panel is used only when the 
CC80 is offline (not controlled via the Analyzer program). When the CC80 
is online, the control panel is set to Monitor Only.   

Sample Preparation 
CC80 sample preparation commands that will be used to prepare the 
sample or standard for analysis are grouped together in the program and 
executed before the timed commands. The beginning of the group is 
defined with the BeginSamplePrep command, and the end of the group is 
defined with the EndSamplePrep command. Because these grouped 
commands are not assigned retention times, the Delay SP command is 
used to specify a time to wait before continuing to the next command. 

Sample Preparation Overlap 
To reduce the time between injections, the CC80 can perform the sample 
preparation functions for the next sample while the current sample is still 
running. The overlapped functions are run while data acquisition or other 
program commands that do not require the CC80 are being executed. 
When the CC80 finishes the overlapped functions, the program pauses, if 
necessary, to allow the currently running sample to finish. Then, the 
remaining commands in the overlapped sample’s program are executed.  
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To ensure sample overlap works correctly, if you are editing a PGM 
manually, be sure that the following three commands are present in the 
given order: 
 
 BeginSamplePrep  
 [list of CC80 sample prep commands] 
 EndSamplePrep  
 Wait SamplePrepComplete  
 

The BeginSamplePrep and the EndSamplePrep commands enclose the 
commands that are to be overlapped. The Wait SamplePrepComplete 
command determines whether the CC80 can begin running the overlapped 
commands for the next sample. Chromeleon automatically sets the 
SamplePrepComplete status to true or false at the appropriate times when 
running the program. 

CC80 sample prep commands can also be assigned retention times. When 
a sample prep command is assigned a time, it is not included in the 
overlapped commands. To ensure that timed CC80 commands do not 
interfere with overlapped sample preparation, commands that require a 
length of time to complete cannot be assigned retention times. These 
commands are: DelaySP, Dilution Pump, and Loading Pump.  

 Note: 
The Sample Preparation Overlap option can be disabled in the CC80 
server configuration properties on the Options tab page.  

Also, refer to Overlapping Samples. 

Program Examples 
Chromeleon-PA provides example program files, which you can use as 
starting points for your programs. Because every program is created for a 
specific system and application, the examples will not work "as is" with your 
analyzer, but the principles behind the types of commands included and the 
order in which they are listed can be applied to many systems. Refer to 
Setting Up Chromeleon-PA (Document No. 031970) for detailed 
descriptions of the example programs. 
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The example programs are included in the CM-PA Example datasource on 
the Chromeleon-PA installation CD. To connect to the datasource and view 
the examples, insert the CD in the drive, go to the Chromeleon Browser, 
and select File>Mount Datasource>Browse.  

Also, refer to How to: 

 Valve Control for CC81: Concentration 

 Valve Control for CC82: Dilution 

 Valve Control for CC83: Dilution with Reagent 

 Valve Control for CC84: Concentration with Reagent 
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 Valve Control for CC81: Concentration 

   
  
Sample (SM) waste (0)—directs output from the Chk Std (CS) valve to waste 

SS valve (1)—directs output from the CS valve to the SS valve 
Diluent (DI) closed (0)—stops flow of diluent (typically DI water) to the 

dilution pump 
open (1)—allows flow of diluent to the dilution pump 

Dil Vessel (DV) purge (0)—directs output from the dilution vessel to waste 
SS valve (1)—directs output from the dilution vessel to the SS 
valve 

Samp/Std (SS) sample (0)—directs output from the CS valve (sample or check 
standard) to the Load/Inject valve 
standard (1)—directs output from the DV valve (the diluted 
standard) to the Load/Inject valve 

Gas (GAS) vent (0)—no gas pressure on the dilution vessel 
pressurize (1)—pressurizes the dilution vessel  

Metering (ME) standard (0)—allows the stock standard to flush and fill the loop 
diluent (1)—directs the diluent through the loop for delivery to 
the dilution vessel 

Chk Std (CS) sample (0)—directs the sample to the SM valve 
ChkStd (1)—directs the check standard to the SM valve  
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 Valve Control for CC82: Dilution 

  
 
  
Sample (SM) SS valve (0)—directs output from the SM valve (sample or check 

standard) to the SS valve 
ST valve (1)—directs output from the SM valve to the ST valve 

Diluent (DI) closed (0)—stops flow of diluent (typically DI water) to the 
dilution pump 
open (1)—allows flow of diluent to the dilution pump 

Dil Vessel (DV) purge (0)—directs output from the dilution vessel to waste 
SS valve (1)—directs output from the dilution vessel to the SS 
valve 

Samp/Std (SS) sample (0)—directs the (undiluted) sample or check standard to 
the Load/Inject valve 
standard (1)—directs output from the dilution vessel to the 
Load/Inject valve 

Gas (GAS) vent (0)—no gas pressure on the dilution vessel 
pressurize (1)—pressurizes the dilution vessel  

Metering (ME) ST valve (0)—allows the output from the ST valve (stock 
standard, sample, or check standard) to flush and fill the loop 
diluent (1)—directs the diluent through the loop for delivery to 
the dilution vessel 
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Chk Std (CS) sample (0)—directs the sample to the SM valve 
ChkStd (1)—directs the check standard to the SM valve 

Standard (ST) standard (0)—directs stock standard to the ME valve 
sample (1)—directs output from the SM valve (sample or check 
standard) to the ME valve  

 Valve Control for CC83: Dilution with Reagent 

 
  
Sample (SM) ST valve (0)—directs sample to the ST valve 

SS valve (1)—directs sample to the SS valve  
Diluent (DI) closed (0)—stops flow from the DS valve to the dilution pump 

open (1)—allows flow from the DS valve to the dilution pump 
Dil Vessel (DV) purge (0)—directs output from the dilution vessel to waste 

SS valve (1)—directs output from the dilution vessel to the SS 
valve 

Samp/Std (SS) sample (0)—directs the (undiluted) sample to the Load/Inject 
valve 
diluent (1)—directs output from the dilution vessel to the 
Load/Inject valve 
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Gas (GAS) vent (0)—no gas pressure on the dilution vessel 
pressurize (1)—pressurizes the dilution vessel  

Metering (ME) ST valve (0)—allows the output from the ST valve (sample or 
standard) to flush and fill the loop 
diluent (1)—allows output from the DS valve (diluent or reagent) 
to flow through the loop and into the dilution vessel 

Dil Select (DS) diluent (0)—directs diluent to the ME valve (through the dilution 
pump) 
reagent (1)—directs reagent to the ME valve (through the 
dilution pump) 

Standard (ST) sample (0)—directs sample to the ME valve 
standard (1)—directs stock standard to the ME valve  

 Valve Control for CC84: Concentration with Reagent 

  
 
  
Sample (SM) sample (0)—directs sample to the DS valve 

ChkStd (1)—directs check standard to the DS valve 
Diluent (DI) closed (0)— stops flow of diluent (typically DI water) to the 

dilution pump 
open (1)— allows flow of diluent to the dilution pump 
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Dil Vessel (DV) purge (0)—directs output from the dilution vessel to waste 
SS valve (1)—directs output from the dilution vessel to the SS 
valve 

Samp/Std (SS) closed (0)—does not allow flow through the valve 
DV valve (1)—directs output from the DV valve to the loading 
pump 

Gas (GAS) vent (0)—no gas pressure on the dilution vessel 
pressurize (1)—pressurizes the dilution vessel  

Metering (ME) ST valve (0)—allows output from the ST valve (stock standard or 
reagent) to flush and fill the loop 
DS valve (1)—allows output from the DS valve to flow through 
the loop and into the dilution vessel 

Dil Select (DS) diluent (0)—directs diluent to the ME valve 
SM valve (1)—directs output from the SM valve to the ME valve 

Standard (ST) standard (0)—directs standard to the ME valve 
reagent (1)—directs reagent to the ME valve  
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Special Commands, Relay Control, and Miscellaneous 

Chromeleon also supports various special commands:  

 Virtual Channel Commands  

 Program Examples for Virtual Channels 

 Trigger Commands 
 Mixed Commands 

 
For information about relays, refer to:  

 Relay, TTL, and Remote Input Commands 

 Switching a Relay 
 
For general information about instrument control, refer to: 

 Device Successfully Connected  

 The Ready Signal  

 Virtual Channel Commands 

Changing the Channel Type 
To optimize signal recording, assign each virtual channel a type. Three 
types are currently defined (see Hardware Installation  Channel Types 
of the Virtual Channel Driver in the Administrator Help section: 
 
0.000 VirtualChannel_01.Type = Analog, Digital or Fixed 
 
Analog Suitable for expressions that  

a) change quickly and/or 
b) are composed of other analog signals. 

Examples: formula = 
a) pressure.value 
b) UV_VIS_1/UV_VIS_2 

Digital Suitable for digital expressions. P580Relay_1.State AND 
P580Relay_2.State 

Fixed Suitable for expressions that change slowly. Pump.%A 
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 Tip:  
If step gradients occur for virtual signals consisting of other signals even if 
the channel type is set to Analog, the resolution in y direction is insufficient. 
In this case, set FormulaMin/FomulaMax accordingl 

The selected type affects the ⇒Step, ⇒MaxAutoStep, and ⇒Average 
settings of the corresponding signal and the selection of appropriate raw 
data compression. For the standard compressor, these three parameters 
have the same significance as with normal signal channels. For the step 
compressor, the values have no significance because this compressor 
always uses a fixed step of 0.01s. The default values are as follows: 
 
 Step MaxAutoStep Average Compression 
Analog Auto 5.1s On Standard compressor 
Digital Fixed, 0.01s   Special compressor for step 

signals 
Fixed Fixed, 0.01s 5.1s Off Standard compressor  
For analog or fixed channels, you can change Step, MaxAutoStep, and 
Average values after you have selected the type. If these properties are set 
for digital channels, a warning appears.  

 Tip:  
Step = Auto and Average = On is not considered for fixed channels. 

Defining the signal to record 

Select Formula to specify the expression to be recorded. You can use the 
same expressions as for ⇒Trigger conditions, i.e., arithmetic and logical 
links. The expression must be numeric. During program execution, the 
FormulaCur property indicates the value calculated. FormulaMin and 
FormulaMax define the minimum and maximum signal values. If the 
measured signal exceeds the FormulaMax value, only the FormulaMax 
value is used for the data point. (This also applies to FormulaMin.)  

 Note:  
The more the measuring range is limited by FormulaMin and FormulaMax, 
the better is the signal resolution. 
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As for other signal channels, you can use the Value property to display the 
current (or interpolated) signal value (changes every 0.01s). 

The Equate property allows you to enter a user-defined name for the virtual 
channel during the analysis. Use the Log command to include the name in 
the Audit Trail. 

It is not possible to change the Step, MaxAutoStep, Average, Formula, 
and Type properties during data acquisition. The FormulaCur property 
indicates the status. 

For program examples for virtual channels, refer to  Program Examples 
for Virtual Channels. 

 Program Examples for Virtual Channels 

Recording the Pump Pressure 
You can use the Virtual Channel Driver to record the pump pressure. This 
steady signal is likely to change frequently. That is why Dionex 
recommends setting the type of the virtual channel to Analog. You can use 
the default settings for recording this channel: 
 
0.000 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 400 
 Inject 
 VirtualChannel_01.Formula  pump.pressure 
 VirtualChannel_01.Type = Analog 
 VirtualChannel_01.AcqOn 
2.000 VirtualChannel_01.AcqOff 
 
The signals are recorded with the ⇒Step determined by the corresponding 
pump. This step might be too large to return the pump pressure precisely. 
In this case, use the Integrator Driver to receive the precise pump 
pressure signal. In this case, you will need an A/D converter such as the 

UCI-100 Universal Chromatography Interface (also, refer to 
 Recording the Pump Pressure). 

Sum of two channels 
Much as the pump pressure, you can record the sum of two UV channels 
as a virtual channel. This steady signal is also likely to change frequently. 
That is why Dionex recommends setting the type of the virtual channel to 
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Analog. Using the default settings, this channel is recorded as precisely as 
the two UV channels: 
 
0.000 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 400 
 Inject  
 VirtualChannel_01.Formula  UV_VIS_1+UV_VIS_2 
 VirtualChannel_01.Type = Analog 
 UV_VIS_1.AcqOn 
 UV_VIS_2.AcqOn 
 VirtualChannel_01.AcqOn 
2.000 UV_VIS_1.AcqOff 
 UV_VIS_2.AcqOff 
 VirtualChannel_01.AcqOff 
 

 Tip:  
If step gradients occur for virtual signals consisting of other signals even if 
the channel type is set to Analog, the resolution in y direction is insufficient. 
In this case, set FormulaMin/FomulaMax accordingly. 

Relay Status 
The status of a relay should be recorded as a virtual channel. For this 
rectangle signal, Dionex recommends setting the type of virtual channel to 
Digital: 
0.000 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 400 
 Inject  
 VirtualChannel_01.Formula  P580_Relay1.State 
 VirtualChannel_01.Type = Digital 
 VirtualChannel_01.AcqOn  
0.000 P580_Relay1.On 
0.100 P580_Relay1.Off 
0.200 P580_Relay1.On 
0.300 P580_Relay1.Off 
0.400 P580_Relay1.On 
0.500 P580_Relay1.Off 
0.600 P580_Relay1.On 
0.700 P580_Relay1.Off 
0.800 P580_Relay1.On 
0.900 P580_Relay1.Off 
1.000 P580_Relay1.Off 
1.000 VirtualChannel_01.AcqOff 
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Recording a Gradient  
The currently set gradient should be recorded as a virtual channel. This 
steady signal is unlikely to change frequently. That is why Dionex 
recommends setting the type of the virtual channel to Fixed. It is sufficient 
to record the current value once per second: 
 
0.000 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 400 
 Inject  
 Flow = 10  
 %B = 100  
 VirtualChannel_01.Formula  Pump.%B 
 VirtualChannel_01.Type = Fixed 
 VirtualChannel_01.Step = 1 
 VirtualChannel_01.AcqOn  
0.500 %B = 100 
1.000 %B = 50 
1.500 %B = 50 
2.000 %B = 0 
2.000 VirtualChannel_01.AcqOff 
 
Correcting a signal from a radioactive substance: 
To determine the concentration of a radioactive substance, you must take 
the decay of the substance into account and correct the signal accordingly. 
Use the virtual channel driver to accomplish this task.  

In the example below  
• The half-life is t½ min  

• The run time of the chromatogram is tl min  

• The uncorrected signal (UV_VIS_1) is between - 10.000 and 10.000 
mAU, 

 
0.000 Pressure.LowerLimit = 0 
 Pressure.UpperLimit = 400 
 Inject 
 

VirtualChannel_01.Formula  UV_VIS_1 / 2.718** 
(-0.69314718* System.Retention /t½) 
VirtualChannel_01.FormulaMin = -10000 / 2.718** 
  (-0.69314718* tl /t½) 
 VirtualChannel_01.FormulaMax = 10000 / 2.718** 
  (-0.69314718* tl /t½) 
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 VirtualChannel_01.Type = Analog 
 
 UV_VIS_1.AcqOn 
 VirtualChannel_01.AcqOn 
 
tl UV_VIS_1.AcqOff 
 VirtualChannel_01.AcqOff 
 

In the program, replace the t½ entry with the actual half-life. In addition, 
enter the actual run time of your program with three decimal places for tl. 
When the program is modified accordingly, the virtual channel records the 
signal that would be measured by the detector if the radioactive decay were 
stopped with the injection into the chromatography system. The decay that 
occurred before the injection will not be corrected. 

 Note: 
If you know the signal range to be expected for your chromatogram (in the 
example for the channel UV_VIS_1) you may enter this value instead of -
10,000 and 10,000 for calculating FormulaMin/Max to map your 
chromatogram more precisely. 

 Trigger Commands 

 Note: 
The trigger name must be unique; that is, no triggers by the same name 
can be used, nor device, relay, or signal names that were already assigned. 
The same trigger can initiate any number of reactions. The reactions of the 
trigger list are not supplied with time information. The trigger must always 
be completed by an EndTrigger command; for example: 
  
0.000 Trigger <NAME> Condition= [Value](Operator)[Value] 

,OperatorValue,True=Value[s] 
,Delay=Value[s],Limit=Number 

 Reaction 1 =Value/Status  
 ...  ... 
 Reaction n =Value/Status  
 EndTrigger   
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If a trigger condition consists of several values, operators can combine 
them. Available operators are +, -, *, /, AND, OR, NOT. The Trigger 
condition is fulfilled if the corresponding value is reached, not reached, or 
exceeded. This is indicated by the operators <, >, <=, >=, = and <>. Any 
dependence on various values can be realized via parentheses.  

If the value is preceded by the name ⇒Delta, the slope (i.e., the first 
derivation) is processed as the trigger condition. Remote input signals or 
relay states can also be processed.  
 

 Note: 
Due to lack of space, line breaks are inserted here. Normally, one 
command must be entered in one line. For a detailed description of the 
Trigger command, refer to ⇒Trigger in the Reference Information 
section. 

Example 1: Peak Recognition via Absolute Value 
 
0.000 Trigger EXAMPLE1 UV_VIS_1>100,True=1,Delay=5,Limit=4 
 Sound File="TEST.WAV" 
 ... ... 
 RELAYNAME =On 
 EndTrigger  
 
Description: The trigger with the Trigger Name EXAMPLE1 monitors the 
channel UV_VIS_1. If the signal exceeds the value 100 for more than 1 
second ((Trigger-) True), the Audio file TEST.WAV is played after a 
(Trigger-) Delay of 5 seconds. (If no sound card is installed in the PC, there 
is a short Beep instead.) At the same time, the RELAYNAME relay is 
enabled.  

The entire process, i.e., exceeding the signal value 100 of channel 
UV_VIS_1 with a subsequent reaction, is limited to 4 times (Limit=4). If the 
condition (Trigger-) Limit is not entered, the process is always repeated if.... 

Example 2: Peak Recognition via Signal Slope 
 
0.000 Trigger EXAMPLE2 UV_VIS_1.DELTA>1 
 Sound File="TEST.WAV"  
 EndTrigger  
 



 Practical Tips for Device Control 1253 

Description: The trigger EXAMPLE2 monitors the channel UV_VIS_1. At a 
slope value (DELTA) above 1, the Audio file TEST.WAV is played. If no 
sound card is installed in the PC, there is a short beep instead. 

Example 3: AND, OR, NOT 
 
0.000 Trigger EXAMPLE3 ((UV_VIS_1>100) AND (UV_VIS_2>100) OR  

(UV_VIS_3>200)) AND NOT REMOTE1 
 Sound File="TEST.WAV"  
 EndTrigger  
 
Description: The EXAMPLE3 trigger monitors the UV_VIS_1, UV_VIS_2, 
and UV_VIS_3 channels as well as the REMOTE1 remote input. If the 
channels 1 and 2 simultaneously (AND) exceed the value 100, or (OR) if 
the channel UV_VIS_3 exceeds the value 200 and if the remote input 
REMOTE1 delivers no signal (AND NOT) at the same time, the TEST.WAV 
Audio file is played (without a sound card, there is a short beep instead).  

Example 4: Further parameters that can be triggered  
 
0.000 Trigger EXAMPLE4 Pressure.LowerLimit<20 OR  

Pressure.UpperLimit>300 OR  
Temperature>60 

 AbortBatch  
 EndTrigger  
 
Description: The trigger EXAMPLE4 monitors the pump pressure and the 
temperature of the column oven. If the pressure falls below 20 bar (= 2 
MPa = 290 psi) or exceeds 300 bar (= 30 MPa = 4350 psi), or if 
temperature exceeds 60°C, the running sample batch is aborted (Abort 
Batch). 

Example 5: Fraction Collector Foxy Jr. 
 
 FoxiJr.Valve = Off  
 ; switches the Fraction Collector valve to the "Waste" position 
0.000 Trigger STARTofPEAK FoxiJr.Valve = 0 AND  

UV_VIS_1.Delta >1, True = 2 
 FoxiJr.Valve = On  
 ; switches the valve to the "Collect" position 
 EndTrigger  
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 Trigger TUBEFULL FoxiJr.Valve = 1,True = 60 
 Protocol "Tube full"  
 FoxiJr.Valve = Off  
 EndTrigger  
   
 Trigger ENDofPEAK FoxiJr.Valve = 1 AND  

UV_VIS_1.Delta > -1, 

True = 2, Delay = 5 
 FoxiJr.Valve = Off  
 ; switches the valve to the "waste" position 
 FoxiJr.Tube = FoxiJr.Tube +1  
 EndTrigger  
 
Description: The PEAKSTART trigger causes the valve to switch to the 
Collect position if the valve is previously in the Waste position and if the 
slope of the UV_VIS_1 channel exceeds the value 1 for more than 2 
seconds (True). After 60 seconds, the TUBEFULL trigger ensures that the 
collection container does not overflow. The valve is switched again (back to 
the Waste position). For larger collection containers, the time can be 
adjusted as needed. If the signal is below the slope value -1 for more than 
2 seconds, and if the valve is still in the Collect position, this is interpreted 
as the end of the peak. After a delay of 5 seconds, the valve is switched to 
the Waste position. Simultaneously, the x/y-arm of the fraction collector is 
moved by one position (FoxiJr.Tube = FoxiJr.Tube +1).  

Also, refer to How to: Collecting Fractions: 

 Setting Up Fraction Collection 

 Program Example (One Detection Channel) 

 Program Example (Two Detection Channels) 

 Fraction Collection Control via an MS 
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 Mixed Commands 

Produce Sound 
 
0.000 Sound File="TEST.WAV" 
 
For more information, refer to ⇒Sound command. 

Temperature Regulation for Column Oven 
 
0.000 Temperature.Nominal =Value [°C] (nominal value) 
 
In combination with a ⇒Trigger condition, the actual value can also be 
inquired:  
 
0.000 Trigger OVENTEST Condition=Temperature>50[°C] 
 Sound File="TEST.WAV" 
 EndTrigger  
 
Description: The OVENTEST trigger monitors the current oven 
temperature. Each time the temperature exceeds 50°C, the TEST.WAV 
Audio file is played. If the PC has no sound card, there is a short beep. 

Comments, Protocol and Message Texts 
  
; Comment Text...  
0.000 Protocol "Text ..." 
0.000 Message "Text ..." 
 

 Note: 
Comments can be added to any program instruction via " ; ". They can 
easily be recognized by their green color. Protocol and message texts must 
be indicated by quotation marks ("Text...")! Both are included in the Audit 
Trail. While the ⇒Protocol command is for documentation purposes only, 
the ⇒Message text appears on the screen. Continuation of the program is 
only possible after confirming with the Enter key. 
 



1256 Practical Tips for Device Control 

Example 6: Delayed Execution of the Inject Command ("Wait") 
  
0.000 Acquisition =On 
0.000 Wait UV_VIS_1 < 10 
0.000 Inject  
 
Description: Program execution is delayed until the absorption on channel 
UV_VIS_1 is below 10 mAU. As soon as this is the case, injection is 
started.  

The Wait command is also required for Suck and Dispense operations of 
the Dionex GINA 50 and GINA 160 autosamplers (see  Autosampler 
Control). 

 Relay, TTL, and Remote Input Commands 

Enable/Disable Relays  
 
0.000 RELAYNAME.State =On / Off 
 
Alternatively, the following short command is valid:  
  
0.000 RELAYNAME.On  
0.000 RELAYNAME.Off  

Enable/Disable Relay for a specific duration 
 
0.000 RELAYNAME.On =Value[s] 
0.000 RELAYNAME.Duration =Value[s] 
 
Alternatively, use the following short command:  
  
0.000 RELAYNAME.On Duration= Value[s]  or 
0.000 RELAYNAME.Off Duration= Value[s] 
 

Enable/Disable TTLs  
 
0.000 TTL_NAME.State =0v / 5v 
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Alternatively, use the following short command:  
  
0.000 TTL_NAME.0v  
0.000 TTL_NAME.5v  

Enable/Disable TTLs for a specific duration 
 
0.000 TTL_NAME.0v Duration=Value[s] 
0.000 TTL_NAME.5v Duration=Value[s] 

 Switching a Relay 
Every Relay can be integrated as a simple switch on the control panel 
interface. The two switch settings correspond to the relay states On and 
Off. In addition, Controls on the Control Panel are linked to State. Each 
relay can be executed with a time relay, using the Duration parameter. 

If a 3-way valve is integrated in the fluidics on the detector output, two 
switch states can be controlled via an internal device relay; for example, the 
Dionex M480 pump. 
• In the Server Configuration, double-click the instrument to open its 

Property dialog box, and select Relays. 

• Enable a currently free device relay and click OK. 

• Save the new Server Configuration. 

 Note: 
All settings you select on the Relays tab page will be automatically copied 
to the State Devices page of the Program Wizard (see Control  The 
Program Wizard). 

• On the control panel, any switch can be linked to the new relay function 
(Object=Relayname, Object Property=State). See How to: 
Controlling Devices from the Control Panel  Linking a Control to 
a Device. 

• If necessary, create an additional control, for example, an edit field (see 
Layout Toolbar), to set the on/off duration of the valve. 



1258 Practical Tips for Device Control 

In the Program, the switch procedure of a relay can be realized via the 
following commands: 
 

0.000 RELAYNAME.State =On/Off 
0.000 RELAYNAME.Duration =Value[s] 

 Device Successfully Connected 
Many devices automatically communicate their status to Chromeleon; that 
is, they communicate whether they were successfully integrated into a 
system or not.  

This signal can be displayed on the Control Panel, for example, via an 
LED or color area integrated into the control panel (see Layout Toolbar).  
• Link the corresponding Control on the Link tab page to the 

Connected object property. (For more information, refer to How 
to: Controlling Devices from the Control Panel  Linking a 
Control to a Device.)  

If the LED or the color area is active, the device was successfully integrated 
into the system. In this state, Chromeleon can control the device.  

 The Ready Signal 

If an instrument supplies a feedback (Ready signal) when reaching a 
nominal (set) value, this can be indicated via the corresponding Control 
on the control panel (LED or color box).  

Column ovens, autosamplers with temperature control, electrochemical 
detectors (Antec Decade), or gas chromatographs (HP 5890; Fisons 8000) 
are sending Ready signals. 

The Dionex GINA 50T autosampler with temperature control sends the 
SampleTempOK signal instead of the Ready signal. 
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 Determining the CRP Value 
With the UltiMate capillary/nano HPLC system, the pump flow is split before 
the column. Enter the system flow, that is, the flow through the column, in 
Chromeleon. Chromeleon uses the following formula to determine the flow 
to be delivered by the pump (= master flow): 

Master Flow [ml/min] = CRP*System Flow [µl/min]. 

The CRP value is a conversion factor that depends on the properties of the 
installed column and the used calibrator. Chromeleon determines the 
appropriate CRP value based on the following lookup table that indicates 
the column length, internal diameter of the column, and the stationary 
phase: 

 
Internal Diameter of 
the Column [µm] 

Column Length [cm] 
 

 5 10 15 20 25 
50 A: 1100 

B: 1000 
C: 1100 
D: 800 

A: 1150 
B: 1100 
C: 1150 
D: 850 

A: 1250 
B: 1170 
C: 1250 
D: 890 

A: 1275 
B: 1235 
C: 1275 
D: 950 

A: 1300 
B: 1300 
C: 1300 
D: 1000 

75 A: 1100 
B: 1000 
C: 1100 
D: 800 

A: 1150 
B: 1100 
C: 1150 
D: 850 

A: 1250 
B: 1170 
C: 1250 
D: 890 

A: 1275 
B: 1235 
C: 1275 
D: 950 

A: 1300 
B: 1300 
C: 1300 
D: 1000 

100 A: 440 
B: 440 
C: 440 
D: 440 

A: 460 
B: 460 
C: 460 
D: 460 

A: 500 
B: 500 
C: 500 
D: 500 

A: 510 
B: 510 
C: 510 
D: 510 

A: 520 
B: 520 
C: 520 
D: 520 

180 A: 90.5 
B: 69.2 
C: 90.5 
D: 68.5 

A: 105.5 
B: 79.9 
C: 105.5 
D: 74.9 

A: 124.9 
B: 91.0 
C: 124.9 
D: 81.3 

A: 143.1 
B: 95.5 
C: 143.1 
D: 89.5 

A: 161.2 
B: 100.0 
C: 161.2 
D: 97.5 

300 A: 36 
B: 28 
C: 36 
D: 33 

A: 43 
B: 32 
C: 43 
D: 30 

A: 50 
B: 47 
C: 50 
D: 33 

A: 58 
B: 39 
C: 58 
D: 36 

A: 65 
B: 40 
C: 65 
D: 40 

500 20 20 20 20 20 
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Internal Diameter of 
the Column [µm] 

Column Length [cm] 
 

 5 10 15 20 25 
800 A: 6.67 

B: 5.16 
C: 6.67 
D: 4.93 

A: 8.07 
B: 5.66 
C: 8.07 
D: 5.43 

A: 9.46 
B: 6.17 
C: 9.46 
D: 5.94 

A: 10.44 
B: 6.84 
C: 10.44 
D: 6.58 

A: 11.39 
B: 7.49 
C: 11.39 
D: 7.19 

1000 A: 4 
B: 3 
C: 4 
D: 3 

A: 5 
B: 3 
C: 5 
D: 3 

A: 6 
B: 4 
C: 6 
D: 4 

A: 6 
B: 4 
C: 6 
D: 4 

A: 7 
B: 5 
C: 7 
D: 4  

The capital letters A-D in the table describe the column material. The 
meaning is as follows: 
 
Column Chemical Structure  Particle Size [µm] Pore Width [Å] 

A C18 3 100 
B C18 5 100 
C C18 3 300 
D C18 5 300  

This table is part of the UltiMate.lup text file in the ../Chromel/bin 
directory. You can extend the file, i.e., the comments in the file, according 
to you rrequirements. 
 

 Caution:   
If the appropriate CRP value is missing, Chromeleon cannot determine the 
pump's flow rate. Thus, the pump cannot deliver the correct flow. 
Therefore, make sure to enter the length, internal diameter, and stationary 
phase of the installed column! 

If your column does not correspond to an entry in the table, Chromeleon 
cannot determine the CRP value. In this case, enter the appropriate CRP 
value manually. 
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Determine the CRP value as follows: 
• Enter a CRP value that is close to your column (according to the table 

above). 

• Enter a high nominal flow rate. Based on the entered CRP value, 
Chromeleon calculates the master flow. Usually, the actual system flow 
deviates from the nominal flow rate as it may happen that the entered 
CRP value is correct only by chance. 

• Determine the current system flow by measuring the volume 
transported through the column within a specified time. 

• Enter the measured system flow as MeasuredFlowRate. The CRP 
value will then be determined automatically according to the formula. 

measured

enteredentered

SystemFlow
FlowNomCRPCRP .*

=
 

CRP and MasterFlow will then be corrected appropriately so that the 
resulting system flow will match the specified system flow. 

 



1262 Practical Tips for Device Control 

 



 Reference Information 1263 

Reference Information 

Reference Information 
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Sample Variables 

Sample Variables (Overview) 
The variables in the sample list (see Samples and Sequences  The 
Sample List (Sequence)) default columns are referred to as sample 
variables. They characterize a sample and are stored in a database as part 
of the Sample Data. For an explanation of the columns, refer to: 

⇒Auto Purif. Frac. (Autopurification Fraction)  
⇒Auto Purif. Ref. (Autopurification Sample Reference) 
⇒Auto Purif. Type (Autopurification Sample Type) 
⇒Comment (Sample Comment) 
⇒Dil. Factor (Dilution Factor) 
⇒GUID (Globally Unique Identifier) 
⇒Inj. Date/Time 
⇒Inj. Vol. (Injection Volume) 
⇒ISTD Amount (Amount of the Internal Standard) 
⇒Method (QNT Method) 
⇒Name (Sample Name) 
⇒No. (Sample Number) 
⇒Pos. (Sample Position) 
⇒Program (also, refer to PGM File) 
⇒Ref. Amount Set (Reference Amount ID) 
⇒Replicate ID 
⇒Sample ID  
⇒Std. Add. Group (Standard Addition Group) 
⇒Status (Sample Status) 
⇒Type (Sample Type) 
⇒Weight (Sample Weight Factor) 
 
In addition to these default columns, Chromeleon supports User-defined 
Columns and Sequence Report Columns. 
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Auto Purif. Frac. (Autopurification Fraction) 
 
Type: Text  
Dimension: --- 
Value Range: Digits 

Default: --- 
Related Parameters: ⇒Auto Purif. Ref 

⇒Auto Purif. Type 

⇒Replicate ID 

⇒Sample ID 

⇒Name 

⇒No. 

Description: The Auto Purif. Frac. column indicates the ID for 
the associated fraction. Chromeleon determines 
the ID; it is read-only.  

Function: Chromeleon uses this column to number the 
fractionated samples. This allows Chromeleon to 
keep the order of the samples if they are moved 
to a different sequence or to a different folder. 
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Auto Purif. Ref.  
(Autopurification Sample Reference) 
 
Type: Text  
Dimension: --- 
Value Range: All printable characters 

Default: --- 
Related Parameters: ⇒Auto Purif. Frac 

⇒Auto Purif. Type 

⇒Replicate ID 

⇒Sample ID 

⇒Name 

⇒No. 

Description: The Auto Purif. Ref. column indicates the 
autopurification ID. Chromeleon determines the 
ID; it is read-only. 

Function: Chromeleon uses this column to associate 
samples of the different autopurification sample 
types to each other. Preparative samples (sample 
type: Preparation) and fractionated samples 
(sample type: Fraction) have the same 
autopurification reference ID as the analytical 
sample from which they originate. 
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Auto Purif. Type (Autopurification Sample Type) 
 
Type: Text 
Dimension: --- 
Value Range: Analytic, Preparation, Fraction 

Related Parameters: ⇒Type 

⇒Auto Purif. Frac. 

⇒Auto Purif. Ref 

Default: --- 
Description: The Auto Purif. Type column and/or ⇒Sample 

Variable reports the type of the autopurification 
sample: 
• Analytic for the original analytical sample. 

• Preparation for a preparative sample. 

• Fraction for injections from fraction or tubes 
generated from a preparative sample. 

 Note:   

These values are automatically set during sample 
creation in the related post-acquisition step. They 
are read-only and cannot be changed. 

Function:  

 Analytic Analytic indicates an analytical sample. The 
sample is to be analyzed and its content of one or 
several substances is to be determined. Based on 
the analysis and on Post-Acquisition Steps, 
Chromeleon automatically determines whether 
the sample shall be processed further. 
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 Preparation Preparative samples are used for fraction 
collection.  

 Fraction Fractionated samples are used to check the 
pureness of the fractions. 

 Tip:   

To analyze the fractioned samples, Dionex 
recommends using chromatographic conditions 
other than those used for fraction collection. 
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Comment (Sample Comment) 
 
Type: Text  
Dimension: --- 
Value Range: All printable characters  
Default: --- 
Related Parameter: ⇒Name (sample name) 

Description: In addition to the sample name, further comments 
can be entered. Press the F8 key to open an 
enlarged edit field. 
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Dil. Factor (Dilution Factor) 
 
Type: Floating point value 

Dimension: --- 
Value Range: 0.0001 ... 999999.9999 

Default: 1.0000 

Related Parameters: ⇒Inj. Vol. (injection volume) 
 ⇒Weight (Sample Weight Factor) 

Description: The ⇒Sample Variable Dilution Factor is a 
correction factor for amount calculation formulas. 
As is the injection volume, it can also be used for 
multi-point calibrations to define the dilution of 
subsequent calibration samples. For integration 
samples, it serves to account for any dilution that 
was made before the injection. 

Function: The calculated values for all peaks of a sample 
are corrected by the appropriate dilution factor. 

 Note:  The effect is reciprocal to the injection volume; 
that is, a larger dilution factor indicates that less 
of the component is present. 
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GUID (Globally Unique Identifier) 
 
Type: 128-bit character string 

Dimension: --- 
Value Range: (Consists of hexadecimal characters.) 

Default: --- 
Related Parameters: ⇒Name 

⇒No. 

⇒Replicate ID 

⇒Sample ID 

Description: Chromeleon creates a globally unique 128-bit 
GUID in the GUID column when the analysis is 

started. 

Function: The GUID allows unique identification of each 
sample. 

 
Also, refer to Creating and Managing Files/Creating a Sample List 
(Sequence)  Using Globally Unique Sample Identifiers. 
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Inj. Date/Time (Time of Injection) 
 
Type: Character String  
Dimension: Month/Day/Year Hours:Minutes:Seconds 

Value Range: --- 
Default: --- 
Related Parameter: Time 

Description: This column is read-only. Chromeleon enters the 
injection time and date of the sample in the 
corresponding column of the sample list. For 
samples with the ⇒Status (Sample Status) M 
(multiple), the time of the last injection is entered. 

Chromeleon stores the time stamps as universal 
time (Greenwich time). However, the date 
notation is displayed according to regional 
settings made in the operating system. 

Function: The kind of entry (empty or time value) indicates 
if the sample was processed and when the 
sample was processed. 

 Note: The time difference between successive samples 
is generally the analysis time plus the time 
required for injecting the following sample 
because the report is generated in parallel to the 
online batch. As the injection time is generally 
minimal, the time value provides a reliable 
indication as to whether the sample batch was 
processed smoothly, i.e., without an incident, 
such as power failure or third-party interference.  
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Inj. Vol. (Injection Volume) 
 
Type: Floating point value 

Dimension: µl 
Value Range: system-dependent 
Default: 20.0 

Related Parameters: ⇒Dil. Factor (dilution factor) 
⇒Weight (Sample Weight Factor) 

Description: The ⇒Sample Variable Injection Volume 
defines the injection volume in micro liters (µl). 
In automatic operation, the installed Driver 
converts this value into a volume readable by 
the autosampler, then the value is sent to the 

Autosampler. You can enter different injection 
volumes to create a Dilution Series for 
multiple-point calibration ( Single-Point and 
Multiple-Point Calibration).  

Function: In multiple-point calibration with differing 
injection volumes, the concentration of the 
second calibration sample is calculated from the 
injection volumes of the first and the second 
sample. The same principle (doubling injection 
volume equals doubling the amounts of each 
component) is applied to all subsequent 
calibration samples. 

In a multi-point calibration with a "concentration 
series" (varying injection volume) which was 
created with an automatic autosampler it is 
therefore only necessary to enter the component 
amounts for the first standard sample into the 
peak table. Chromeleon calculates all additional 
calibration values, that is, the corresponding 
amounts of the subsequent standard samples 
(Type: Standard). 

 Note: In order to minimize carry-over effects in such a 
multiple-point calibration, standard order should 
always be from lowest to highest concentration. 
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ISTD Amount (Amount of the internal standard) 
 
Type: Floating point value 
Dimension: --- 
Value Range: 0.0001 ... 999999.9999 

Default: 1.0000 

Related Parameters: ⇒Dil. Factor (dilution factor) 

⇒Weight (Sample Weight Factor) 

⇒Inj. Vol. (injection volume) 

Description: The ⇒Sample Variable ISTD Amount is only 
required for a calibration based on a variable 

Internal Standard (internal or internal/external).  

In this case, the column serves in the sample list 
for entering the amount values of the internal 
standards used for the different samples. Input is 
directly in the sample list (via the keyboard or the 
F8 edit dialog box). Editing the column in the 
QNT Editor is not possible. Entering the amount 
values in the peak table is omitted. 

Function: The ISTD Amount parameter is implemented as 
a multiplication factor in the Amount Calculation 
Formula and is dimensionless. 
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Method (QNT Method) 
 
Type: File name 

Dimension: --- 
Value Range: --- 

Default: Name of QNT File 

Related Parameters: ⇒Program (PGM File) 

Description: The Method column (in the Browser) contains the 
name of the quantification method (see The QNT 
Editor  The Quantification Method (QNT 
Editor)). 
The quantification method includes all parameters 
that are used for evaluating a peak or the entire 
chromatogram. 

Function: The QNT Method serves as the basis for 
calculation for sample evaluation. It includes:  
⇒QNT Parameters 
All parameters required for (qualitative) peak 
identification and for converting the determined 
peak areas into amount or concentration values 
(quantitatively) 

⇒Detection Parameters 
All parameters regarding, for example, peak 
recognition and peak area evaluation  

Calibration Variables 
All parameters regarding the type and 
performance of a calibration  

Blank Run Subtraction 
Information about baseline subtraction 

Peak Tracking 
Parameters for comparing spectra to library or 
sequence spectra 
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Function: 
(Cont'd) 

Spectra Library Screening 
Parameters for spectra library screening 

System Suitability Test (SST) 
Parameters for performing the System Suitability 
Test 

MS 
Parameters for Mass Spectra evaluation 

 Tip:  Normally it is not necessary to include the QNT 
Method in the sample list before the analysis 
starts. However, if you want to perform a System 
Suitability Test, make sure to enter the QNT File 
into the sample list before starting the analysis. 
Otherwise, the batch cannot be aborted in case of 
Fail Action - Abort Batch because the SST will 
not yet be performed during the batch run! 
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Name (Sample Name) 
 
Type: Character String 

Dimension: --- 
Value Range: All printable characters  
Default: [Sample] [No.] 
Related Parameters: ⇒No. (sample number) 

⇒GUID 

⇒Sample ID  

⇒Replicate ID 

Description: The ⇒Sample Variable Name serves to identify a 
sample and to label graphics and reports. 

 Note:  

If the sequence contains Sequence Report 
Columns, statistical values can be displayed in 
the last three lines of the sample list. In this case, 
the names of the statistical values appear in the 
Name column: Sum, Average Value, and/or Rel. 
Std. Dev. (relative standard deviation). 

Function: The Fill Column function (F9) allows automatic 
sample name generation. For this purpose, the 
currently selected name can be copied or a 
character string with wild cards as template can 
be entered. These are names that might include, 
for example, the sample number (#n, refer to 
⇒No.), the position (#p, refer to ⇒Pos.), the 
replicate number (#r), and the injection volume 
(#i, s. ⇒Inj. Vol.). Thus, telling names can be 
easily generated using these wild cards! The 
replicate number is calculated from the repetition 
of a sample number. Example: If two injections 
are made from the first two vials the template 
„Analysis-#p_Repl.#r" yields the following names: 
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 Analysis-1_Repl.1 Function: 
(Cont'd)  Analysis-1_Repl.2 
  Analysis-2_Repl.1 

  Analysis-2_Repl.2 

When creating a sample list using the Sequence 
Wizard (see Samples and Sequences  The 
Sequence Wizard), automatic sample name 
generation is possible as well. 

 Note:  Each line represents an individual analysis. As 
multiple injections of the same sample also 
represent multiple analyses, a sample line must 
be reserved for each injection. 

  



1280 Sample Variables 

 No. (Sample Number) 
 
Type: Nonnegative integer 
Dimension: --- 
Value Range: 1 ... infinite 

Default: Ascending number 
Related Parameters: ⇒Pos. (sample position) 

⇒Name (sample name) 

⇒GUID 

⇒Sample ID  

⇒Replicate ID 

Description: You cannot edit the sample number. Each new 
line in the sample list, that is, each analysis, is 
assigned its own number. 

For a sample that is currently being processed 
(⇒Status = Running), the sample number is 
replaced with a green arrow:  

 

 Note:  

If the sequence contains Sequence Report 
Columns, statistical values can be displayed in 
the last three lines of the sample list. In this case, 
the symbols for the statistical values appear in 
the No. column. 

 Tip:  Each injection (or replicate) occupies its own line 
in the sample list and is, therefore, an individual 
analysis for which an individual raw data file is 
created. 
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Pos. (Sample Position - Sample List) 
 
Type: Nonnegative integer and/or letters 

Dimension: --- 
Value Range: Depending on the autosampler 
Default:  

Related Parameter: ⇒No. 

Description: The ⇒Sample Variable Pos. determines the 
position of the sample in the Autosampler. 

For externally controlled autosamplers, this value 
is automatically transmitted to the autosampler for 
sample processing. The autosampler approaches 
the corresponding sample for injection. For non-
controllable autosamplers, this value is for 
documentation purposes only. If the sample 
position parameter is not entered, the previous 
(current) value is used. 

Function: Depending on the installed segment type, the 
ASI-100 Autosampler supports 63 position for 
semiprep vials, 66 positions for Eppendorf vials, 
117 positions for analytical vials, or 192 positions 
for mini vials. 

Letters according to their color describe the 
individual segments: R, G, or B (indicating the 
red, green, and blue segment, respectively). The 
different rows are described from the outer to the 
inner row: A, B, C, or D. The individual positions 
within the respective rows are number 
counterclockwise. The position RA1, for example, 
is in the outer row of the red segment (also, refer 
to the Operating Instructions for the ASI-100 
Series).  

Some autosamplers and fraction collectors, e.g., 
the Dionex SFM (Sample and Fraction Manager) 
have several trays installed. In this case, you 
have to enter the Sample tray and Vial to make 
sure that the position is defined unambiguously. 
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Program (PGM File) 
 
Type: File name 

Dimension: --- 
Value Range: --- 

Default: Name of PGM File 

Related Parameter: ⇒Method (QNT Method) 

Description: The column serves to name the control program. 
(For information about control program, see 
Control  The Control Program.)  

The file contains all information for 
chromatographic sample processing. These are 
commands for chromatography devices (flow, 
%B, etc.), analysis time, acquisition time, etc.  

For more information, refer to PGM File. 

Input for a sequence is by directly editing the 
column in the Browser. All program files that are 
part of the sequence are listed. 

Function: The sample is processed according to the 
conditions contained in the PGM File.  



 Sample Variables 1283 

Ref. Amount Set (Reference Amount ID) 
 
Type: Text  
Dimension: --- 
Value Range: All printable characters 

Default: --- 
Related Parameter: ⇒Std. Add. Group 

Description: The Ref. Amount Set ⇒Sample Variable allows 
you to assign standards, Validation Samples, 
and/or Spiked Samples to the ⇒Amount 
columns of the QNT Editor. Enter the same name 
for standard and validation samples for which the 
concentration (amount) is identical. Proceed in 
the same way for spiked samples. 

 Tip:   
If you analyze several samples using the 

Standard Addition method, Dionex recommends 
adding identical amounts of the same substances 
to the same sample volume. 

Function: To assign the samples to the desired Amount 
columns, select Columns > Edit Amount 
Columns on the context or Edit menu in the QNT 
Editor.  
In the Edit Amount Columns dialog box, select 
Ref. Amount Set from the Assign Standards on 
the basis of: drop-down list. The entries of the 
Ref. Amount Set sample column are then used 
to assign amount columns.  
To assign one Amount column to each level of 
standard, validation, and/or spiked samples, click 
Auto-Generate, and then select Generate a 
separate amount column for EACH standard 
from the list. 
For an application example, refer to How to …: 
Calibrating  Standard Addition. 
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Replicate ID  
 
Type: Text  
Dimension: --- 
Value Range: All printable characters  
Default: --- 
Related Parameters: ⇒Name (sample name) 

⇒No. 

⇒GUID 
⇒Sample ID  

Description: The Replicate ID column serves to mark samples 
as Replicates. 

Function: This column is a mere text column and not used 
for evaluation purposes. If a sequence is 
generated using the Sequence Wizard (see 
Samples and Sequences  The Sequence 
Wizard), the sample position is entered 
automatically as replicate ID. 

To group samples with identical replicate IDs in 
the Summary report, select the Table Properties 
command on the context menu to open the Peak 
Summary Property dialog box. Select Sort the 
report table according to the evaluation of this 
formula 'smp.replicate'. It is also possible to 
access the replicate ID for a query (see How 
to …: Creating and Managing Files and Data 

 Performing a Query). 
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Sample ID 
 
Type: Text  
Dimension: --- 
Value Range: All printable characters  
Default: --- 
Related Parameters: ⇒Name (sample name) 

⇒No. 

⇒GUID 
⇒Replicate ID 

Description: The user or a help program enters a sample ID in 
the Sample ID column. 

Function: This column is a mere text column and not used 
for evaluation purposes. The sample ID is 
intended for LIMS connections that usually know 
sample IDs. 

To group samples with identical sample IDs in the 
Summary report, select the Table Properties 
command on the context menu to open the Peak 
Summary Property dialog box. Select Sort the 
report table according to the evaluation of this 
formula 'smp.ident'. It is also possible to access 
the replicate ID for a query (see How to …: 
Creating and Managing Files and Data 

 Performing a Query). 
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Std. Add. Group (Standard Addition Group) 
 
Type: Text  
Dimension: --- 
Value Range: All printable characters 

Default: --- 
Related Parameter: ⇒Ref. Amount Set 

Description: The Std. Add. Group ⇒Sample Variable allows 
you to assign Spiked Samples to unspiked 
unknown samples. 

Enter the desired group name into this column. 
Make sure that the group name is identical for the 
unspiked unknown samples and the associated 
spiked samples. 

Function: The Std. Amount Group variable is required to 
analyze several unspiked samples using the 

Standard Addition method. For more 
information, refer to How to …: Calibrating 

 Standard Addition. 
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Status (Sample Status) 
 
Type: Text  
Dimension: --- 
Value Range: Single/Multiple/Finished/Interrupted/Running/

Preparing 

Default: Single 

Related Parameter: ⇒Inj. Date/Time (Time of Injection) 

Description: The ⇒Sample Variable Status determines the 
current sample processing status. A sample is 
unprocessed (Single), due for multiple processing 
(Multiple), processed (Finished), or currently 
being processed (Running).  

Chromeleon also maintains a log of the sample 
status, that is, a Single sample is automatically 
assigned the status Finished as soon as 
processing is complete. A sample may also be 
excluded from processing by assigning the status 
Finished manually. 

The sample status has a special significance for 
the built-in Power Failure Protection. Upon 
recovery from a power failure or starting the 
sample batch after a manual interruption, 
Chromeleon continues processing the sample 
batch according to the selected power failure 
handling option.  

Functions:   

Single The sample is processed only once, after which it 
receives the status Finished. When loading a 
sample list for processing (online), only samples 
with the status Single and Multiple are processed. 

If a Single sample contains an entry in the time 
column, this indicates that the sample was 
injected but was interrupted before completion. 
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Multiple 
(Not available 
for XPress) 

The sample can be repeatedly acquired. The 
system just enters the ⇒Inj. Date/Time (Time of 
Injection) in the Time column. Existing Raw 
Data are overwritten with each new data 
acquisition. New samples can have the status 
Multiple assigned only if the Enable Sample 
Status Multiple option of the corresponding 
datasource is enabled. The option is available in 
the (datasource) Properties (via the Properties 
command on the context menu) on the General 
tab page. Samples that have the status Multiple 
already assigned keep their status even with 
disabled Enable Sample Status Multiple option. 

Finished All original Single samples are automatically 
assigned the status Finished after successful 
processing. A sample with the status Finished will 
be omitted in the renewed processing (also 
following a Power Failure). In GLP 

Datasources, it is not possible to reset the 
sample type Finished to Single. 

Interrupted If the user stops a running batch via Immediate 
while a sample is being processed of if an error 
occurs during the sample run resulting in an 
abort, the corresponding sample is labeled 
Interrupted.  

After a power failure or a server breakdown the 
sample is started again if you selected the 
Continue with interrupted sample option on 
the Error Handling tab page. (Access the Error 
Handling tab page by selecting the Error 
Handling command on the Batch menu.) 

Running A running sample is marked green. When the 
sample has been processed, it gets the status 
Finished or Multiple assigned (without 
background color).  

 Tip:  
You can also open samples during the analysis, 
while their status is Running (see Integration 

 Opening a Sample). 
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Preparing The autosampler prepares the next sample while 
the current sample is Running. The sample being 
prepared is marked yellow. 

 Note:  

This status occurs, for example, when an AS50 
autosampler that has the Sample Overlap option 
enabled is preparing a sample. The Sample 
Overlap option is enabled in the AS50 Server 
Configuration Properties on the Options tab page. 

Also, refer to Practical Tips for Device Control 
 Overlapping Samples 

 Tip:  

 

Multiple status samples will be acquired each 
time. The raw data, therefore, are not protected 
from accidental overwriting. The Time column 
indicates, however, whether and when the 
sample was last injected. If this column is empty, 
the sample has not yet been acquired at all. 
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Type (Sample Type) 
 
Type: Text 
Dimension: --- 
Value Range: Blank, Unknown, Standard, Validate, Matrix, 

Spiked, Unspiked 

Related Parameters: Amount, Baseline Subtraction 

Default: Unknown 

Description: The Type ⇒Sample Variable indicates the 
sample type: 

• Select Unknown for an unknown analysis 
sample: . 

• Select Standard for a standard sample with 
known concentration: . 

• Select Validate for a Validation Sample: . 

• Select Blank for a Blank Run Sample: . If a 
sample is corrected by Raw Data of a blank 
run sample, this is referred to as Blank Run 
Subtraction.  

• Select Matrix for a Matrix Blank Sample:  
• Select Spiked for a Spiked Sample: . 

• Select Unspiked for an unspiked unknown 
sample to be analyzed with Standard Addition 
method: . 

Functions:  

Blank The sample injected with the ⇒Inject command is 
no "real" sample; it is a Blank Run. In this case, 
the baseline is stored for subsequent subtraction 
from a later sample. Thus, if baseline subtraction 
is enabled for a following sample, the baseline 
chromatogram may be subtracted before 
integration.  
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Blank 
(Cont'd) 

 Tip:  

For the ICS ion chromatography system, injection 
is performed with the 
Pump_InjectValve.InjectPosition command (if 
no AS50 is installed). With the 
Pump_InjectValve.InjectPosition command, an 
injection is always performed, also for a Blank 
Run Sample. This is contrary to the autosampler 
⇒Inject command.  

Unknown The (unknown) sample shall be analyzed. It shall 
be determined whether the sample contains one 
or more substances. 

Standard The sample is a calibration standard. The 
corresponding ⇒Amount values of the single 
peaks are listed in the corresponding Amount 
Table column. 

Validate Validation samples are treated as ordinary 
analyses. However, the type is written to the 
result file. The validation sample references to the 
Amount column in the subordinated peak table. 
The Amount column referenced by such a 
validation sample contains the required amount 
or concentration for each peak of the sample. In 
the report, this amount or concentration can be 
compared with the calculated actual amount or 
concentration. The Amnt. Diff. (amount 
difference) and Rel. Amnt. Diff. (relative amount 
difference) peak variables are available for this. 

Matrix Contrary to Blank Run samples, Matrix Blank 
Samples are "real" samples that are injected 
indeed. Chromeleon automatically subtracts the 
peak areas or peak heights of the matrix blind 
sample from the corresponding peak areas or 
peak heights of all samples in the sequence. The 
resulting areas (heights) are then used for all 
other calculations, such as calibration. However, 
the respective peaks must have been identified 
for both the unknown sample (or standard 
sample) and the Matrix Blank Sample. 
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Matrix 
(Cont'd)  Note:  

Thus, matrix blank samples are treated differently 
from "normal" Blank Run Samples. For normal 
blank run samples, the chromatogram is 
subtracted point by point from the chromatogram 
of the current sample.  

 Tip:  

Matrix blank samples are subtracted only if they 
are evaluated in the same QNT Method. 
Otherwise, they will not be considered. 

Spiked A known amount is added to an unspiked sample 
(see Unspiked). The spiked sample is used to 
analyze the original unspiked sample, using the 

Standard Addition method. 

Unspiked Known amounts of the analytes to be determined 
are added to unspiked unknown samples. 
Afterward, the original (Unspiked) and the 
Spiked samples are analyzed. The quantitative 
analysis of the results is performed, using the 
Standard Addition ⇒Calibration Mode, i.e., the 

Standard Addition method. 
 

 Tip:   

If you use the sample ⇒Types Spiked and/or Unspiked, please keep in 
mind that: 

• An Electronic Signature created with Chromeleon 6.50 or earlier is 
invalid in Chromeleon 6.60 or higher. 

• An electronic signature created with Chromeleon 6.60 or later is invalid 
in Chromeleon 6.50 or earlier. 
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Weight (Sample Weight Factor) 
 
Type: Floating point value  

Dimension: None 

Value Range: 0.0001 ... 999999.9999 

Default: 1.0000 

Related Parameters: ⇒Dil. Factor (dilution factor) 
⇒Inj. Vol. (injection volume) 

Description: The ⇒Sample Variable Weight has two 
functions. It serves to enter the sample weight but 
it can also be used as a weight correction factor. 
1. Sample Weight: Enter the sample weight to 
calculate the content - normalized to the basic 
unit - of a substance in a sample  
For example, if the calculated concentrations 
should always be valid for 1 mg of a sample, 
enter the actual weight; for example, 124.08. 
Chromeleon then divides all calculated 
concentrations by 124.08. 

2. Weight Correction Factor (for Standard and 
Validation samples): If you wish to relate the 
concentrations to be calculated to a specific 
concentration, enter the corresponding correction 
factor as Weight.  
If, for example, 4.16 mg were weighed instead of 
4.0 mg, you must enter 1.04 (not 4.16!) here. This 
procedure is called approximate exact 
weighting.  

Function: The Weight parameter is implemented as a 
dimensionless multiplication factor or divisor: 
1. It is used as factor for calculating the 
calibration curve (for the formulas, see Theory of 
Calibration  Evaluation with Various 
Standard Methods). 
2. It is used as divisor for amount calculation (see 

Formula for Amount Calculation).  
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Control Commands 

Control Commands (Overview) 
On the following pages, the most important control commands are 
described, together with their corresponding parameters. The commands 
and parameters that are actually available depend on the individual 
installation. For example, if a simple UV detector is installed, it is not 
possible to record a 3D field.  

 Tip:  
An extensive explanation of all existing commands for all devices that can 
be controlled is far beyond the scope of this reference manual. About 100 
commands are available only for the 6890 GC! 

For examples on the commands for various devices, refer to: 

⇒General Commands 

⇒System Commands 

⇒Pump Commands 

⇒Autosampler Commands 

⇒Detector Commands 

General Commands 
The following general commands are available regardless of the installed 
devices: 
⇒Branch 
⇒Delay 
⇒End 
⇒EndTrigger 
⇒Log 
⇒Message 
⇒Protocol 
⇒Trigger 
⇒Wait 
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System Commands 
System control comprises all commands that concern the entire 
chromatographic process or the entire system. Some system commands 
are available on the Online toolbar and on the context menu. The most 
important system commands are: 
⇒Abort Batch 
⇒AbortSample 
⇒Acquisition On/Off 
⇒Continue 
⇒Hold 
⇒Sound 
⇒StopFlow  
Also, refer to Control  System Commands. 

Pump Commands 
For more information about the most important pump commands, refer to: 

⇒%B, %C, %D 
⇒%A, %B, %C, %D_Level 
⇒%A-, %B-, %C-, %D_RemainTime 
⇒%A, %B, %C, %D_WarningLimit 
⇒Connect/Disconnect 
⇒Delta 
⇒Flow 
⇒Freeze 
⇒Learn 
⇒ParkPercentage 
⇒Pressure.Lower/UpperLimit 
⇒Purge 
⇒WasteLevel 
⇒WasteRemainTime 
⇒WasteWarningLimit  
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Autosampler Commands 
For more information about the most important autosampler commands, 
refer to: 

⇒Connect/Disconnect 
⇒Dispense 
⇒Draw 
⇒Inject 
⇒Mix 
⇒NeedleUp 
⇒Position 
⇒Ready 
⇒Reset 
⇒Relay On/Off  
⇒Temperature 
⇒Volume 
⇒Wash 

Detector Commands 
For more information about the most important detector commands,  
refer to: 

⇒AcqOn/Off 
⇒Autozero 
⇒Average 
⇒Bandwidth 
⇒Bunch Width 
⇒Connect/Disconnect 
⇒Delta 
⇒Lamp  
⇒LampAge 
⇒LampIgnitions 
⇒LampIntensity 
⇒MaxAutoStep 
⇒MinLampIntensity 
⇒RefBandwidth 
⇒RefWavelength 
⇒Step 
⇒Wavelength  
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%B, %C, %D (Solvent Components) 
 
Instrument Type: Pump(s) 
Related Commands: ⇒Flow 

⇒%A, %B, %C, %D_Level 
Description: The solvent and thus the flow usually consist of 

different individual components. The respective 
amounts of the partial flow are indicated in 
percent of the flow. The total sum of all partial 
flows (solvent components) is 100% 
(%A+%B+%C+%D=100%), where %A is 
calculated from the remaining partial flows 
(%A=100%-(%B+%C+%D)). It is therefore 
sufficient to determine the values for %B, %C, 
and %D. Changing the solvent composition 
during the analysis is referred to as gradient (or 
more exactly as %-Gradient). 

%A, %B, %C, and %D define the partial flow 
rates of the individual pumps in a high pressure 
mixing system (as %-values of flow), or the partial 
flow rates on the suction side of a low pressure 
mixing system. The latter generally refers to a 
single pump or a separate mixing vessel with 
controlled proportioning valves. The formation of 
%-gradients is by the same principle as for Flow. 

 For each Timebase, one or more fluidic 
systems can be installed. They can be controlled 
independently, either manually or via a 

Program. 

 In case a second fluidic system is installed, the 
corresponding device name has to be specified in 
the program. Use the F8 key or the Program 
Wizard to insert the device name automatically. 

 Tip:  The ⇒Hold, ⇒Continue, and ⇒StopFlow 
commands are always effective for all fluidic 
systems. 
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Function: With Ramps, the partial flow rates of A, B, C, 
and D change linearly with time between two %A, 
%B, %C, or %D commands. By entering two 
percent commands at the same time, you can 
program Step Gradients. When sorting, the 
editor does not change the order of commands 
having the same program time! If the partial flow 
rates are to remain constant during analysis, that 
is, isocratic, the appropriate %A, %B, %C, and/or 
%D commands need only be entered at the 
beginning of the file. 

 -2.000 Flow = 1.000 
          %B =  20.0 
 ...  ... 
  0.000 Inject 
  0.500 %B =  20.0 
        %B =  40.0 
 ...  ... 
  8.500 %B.Value =  80.0 
  8.500 End 

 In this example, the total flow rate remains 
constant at 1.0 ml/min. %B also remains 
constant, at 20% from -2.0 to 0.5 min, then 
increasing abruptly to 40%, then linearly to 80% 
with a gradient of 5%/min. 

Parameters:  

Value Partial flow of the solvent component [%] 

Equate Name of the solvent component 

Type  
(P580 only) 

Solvent type of the respective component 

 Tip:  

Dionex recommends the following setting: 
Isocratic and LPG pumps:  Automatic 
HPG pumps:  Custom  

With HPG pumps, set the pre-compression 
control via the ⇒Learn and ⇒Freeze commands.  
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 Tips: 

 

Chromeleon is able to run flow and %-gradients 
simultaneously. However, in high pressure mixing 
systems, this results in non-linear partial flow rate 
changes for each individual pump.  

 Note that due to compressibility and dead volume 
considerations, high pressure and low-pressure 
applications are not always interchangeable! 

 The %-values remain constant from the last %-
command to the end of the program. Thus, for 
isocratic operation, a single %-entry at the 
beginning of the file is sufficient. 
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%A, %B, %C, %D_Level (Solvent Volume) 
 
Instrument Type: Pump(s) 
Related Commands: ⇒%A, %B, %C, %D_WarningLimit 

⇒%B, %C, %D 

⇒Flow 

⇒WasteLevel 

Description: This command monitors solvent consumption.  

Function: Before starting a sequence, enter the existing 
volume for each solvent component. Based on the 
flow rate and the solvent composition, Chromeleon 
checks whether the available amount of solvent is 
sufficient for the sequence. 

Parameters:  

 Value Actually available volume for the corresponding 
component in [l]. 

 LowerLimit Lower limit for the corresponding component in [l]. 
If this value is reached, the batch is aborted and 
the following message appears: 

[Abort] xx:xx:xx {Pump} The %A level is below the 
limit (x l)! Please refill %A.  

 Tip:  

In the emergency program, reduce the flow rate to 
0 ml/min. This ensures that neither the pump nor 
the detector cell runs dry. 

 Tip:  

 

Chromeleon checks the calculated demand for 
solvent during the Ready Check. The 
corresponding warning appears if necessary. 

 Note:  
This command is not available for all ion chromatography pumps. 



1302 Control Commands 

%A, %B, %C, %D_RemainTime 
 
Instrument Type: Pump(s) 
Related Commands: ⇒WasteRemainTime 

⇒%A, %B, %C, %D_Level 

⇒%A, %B, %C,%D_WarningLimit 

Description: Reports the approximate time until the associated 
solvent reservoir will be empty to the lower limit  
(%X_Level.LowerLimit). 

Function: Chromeleon calculates the remain time based on 
the current flow and the specified filling height of 
the solvent reservoir. 

 Tip:  
When you change the flow rate later, Chromeleon 
recalculates the remain time. Therefore, check this 
value whenever you have changed the flow rate. 

 

 Note:  
This command is available for all pumps except for ion chromatography 
pumps. 
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%A, %B, %C, %D_WarningLimit 
 
Instrument Type: Pump(s) 
Related Commands:  ⇒%A,%B,%C,%D_Level 

⇒WasteWarningLimit 

Description: This command allows you to enter a warning limit 
for monitoring the filling height in the associated 
solvent reservoir. Input is in percent and refers to 
the lower filling limit (%X_Level.LowerLimit). 

Function: If the filling height in the solvent reservoir is below 
the lower limit plus the warning limit 
(%X_Level.LowerLimit + %X_WarningLimit), 
the following warning appears: 

[Warning] xx:xx:xx {Pump} The %A level (x l) will 
reach the lower limit in about x.x hours! Please 
refill %A.  

 Tip:  
If the filling level reaches the 
%X_Level.LowerLimit, the batch is aborted. In the 
emergency program, reduce the flow to 0 ml/min. 
This ensures that neither the pump nor the flow 
cell runs dry. 

 

 Note:  
This command is not available for all ion chromatography pumps. 
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AbortBatch  
 
Instrument Type: System Command 
Related Commands: ⇒AbortSample 

Description: The Abort Batch command aborts a running 
sample batch. In combination with the ⇒Trigger 
command, this command allows you to react, for 
instance, to external errors. Example: 

 0.000 Trigger  Cond=RemErr 
   Abort Batch 
   EndTrigger 

Function: Abort batch terminates data acquisition, deletes 
all triggers, and aborts the current sample batch. 

AbortSample  
 
Instrument Type: System Command 
Related Commands: ⇒AbortBatch 

Description: The Abort Sample command interrupts data 
acquisition and aborts a running sample.  

Function: The batch continues with the next sample. 

Use this command, for example, if, by mistake, 
no injection was made for a sample.  
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AcqOn/Off (Data Acquisition On/Off) 
 
Instrument Type: System Command, all detectors 
Related Commands: ⇒Inject 

Description: The AcqOn/Off command enables or disables 
data recording ( Raw Data) for the selected 

Signal (= channel) of a timebase. Each signal 
(or channel) is stored in a separate file. Signal 
parameters define the type of data from each 
signal.  

Function: To reduce raw data storage requirements, issue 
the AcqOn command some time after the Inject 
command. However, be sure to issue the 
command at least 30 seconds before the elution 
of the first peak. The reason is that Chromeleon 
requires a baseline segment of several seconds 
in order to perform a noise analysis for the auto-
optimized step control functions (⇒Step, 

Sampling Rate, or Data Collection Rate). 

You can issue the command either manually 
using the AcqOn/Off command or automatically 
via the Program. 

 ⇒Trigger commands whose conditions depend 
on signal values or their slope are effective during 
data acquisition only. 

 Tip:  You can change the parameters that are defined 
in the program, such as Step and ⇒Average at 
any time. For clarity, however, Dionex 
recommends observing the following command 
sequence:  

 -2.000 Flow = 1.000  

  ...  ... 

  0.000 Inject 

  0.500 UV_VIS_1.AcqOn 

  ...  ... 
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  3.270 UV_VIS_1.Wavelength = 275 

  ...  ... 

 12.000 UV_VIS_1.AcqOff 

 13.500 End 

 Do not change the 3DFIELD signal parameters 
between AcqOn and AcqOff. 
Use the ⇒Hold and ⇒StopFlow commands to 
interrupt data acquisition. Use the ⇒Continue 
command to resume acquisition. To complete raw 
data acquisition, select the AcqOff command. 
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Autozero 
 
Instrument Type: All detectors 
Related Commands: --- 
Description: The Autozero command resets physical or 

Virtual Signals to zero.  

Function: All data recorded after an autozero is interpreted 
and displayed in relation to the new zero point. A 
sharp increase of the absorption value indicates 
this in the chromatogram. 

The Autozero command applies to all signals 
delivered by a single detector. Thus, autozeroing 
a diode array detector, such as the Dionex UVD 
340 detector, causes the entire 3DFIELD to be 
zeroed. Autozero applies to one detector only! If 
several detectors are present in one system, for 
example, connected in series, they must be 
autozeroed individually.  

 Tip:  Usually, a jump is observed in the baseline after 
an autozero. That is why Dionex recommends 
performing autozero before data acquisition, 
unless this is specifically required during the 
analysis; for example, after wavelength switching.  

 If a wavelength switch is triggered, a ⇒triggered 
autozero command should follow! Example: 

 0.000 Inject 

 0.100 Trigger SwitchWave UV_VIS_1 > 
20 

  UV_VIS_1.Wavelength = 280 

  Autozero 

  EndTrigger 

 0.500 UV_VIS_1.AcqOn 
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Average 
 
Instrument Type: Detector 
Default: ON 

Related Commands: ⇒Step 

Description: The Average parameter allows averaging 
signals. Signal averaging is possible for both, 
digital signals sent to the server PC from the 
detector, such as the Dionex UVD 170U and 
UVD 340U detectors, and analog signals 
recorded via the A/D converter.  

The Dionex A/D converter records each analog 
signal with a frequency of 100 Hz. This 
corresponds to a ⇒Step of 0.01 seconds or a 

Sampling Rate of 100 data points per second. 
When increasing the step or decreasing the 
sampling rate, less data points are stored than 
theoretically possible. 

Function: When activating the Average signal parameter, 
the data points between the stored values are 
considered as well. Chromeleon averages all 
measured values that are within a step interval. 
The calculated average is stored in the Raw 
Data file. This generally improves the Signal-to-
Noise Ratio. (Select the Average parameter to 
smooth chromatograms with an increased noise 
level.) This parameter does not influence the 
precision of integration. 

 Tip:  Averaging is always performed in a 3D field. 
For almost all detectors, concentration is 
proportional to peak-area; that is, it is integral of 
the signal over time. That is why local (time) 
signal averaging does not influence quantitative 
determination. 
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Bandwidth 
 
Instrument Type: Detector 
Type: Integer 
Value Range: Detector-dependent 
Default: 0 [nm] 
Related Commands: ⇒Wavelength 

⇒RefBandwidth (Reference Bandwidth) 

⇒BunchWidth 

Description: The Bandwidth command specifies the optical 
bandwidth [in nm] with which a chromatogram 
(UV VIS channel) is recorded. In general, this 
corresponds to the Optical Resolution of a 
detector.  

Function: You can increase the bandwidth by averaging 
several single photodiode signals. This process is 
known as Photodiode Bunching. Averaging is 
performed symmetrically to the selected 
wavelength. Thus, at a bandwidth of 30 nm and a 
wavelength of 255 nm, the signals of all 
photodiodes between 240 and 270 nm are 
averaged. 

 Tip:  
Changing the bandwidth can often increase the 
sensitivity. Quadrupling the bandwidth almost 
halves the noise. However, in this case, linearity 
usually decreases.  
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Branch  
 
Instrument Type: Processed in PC 
Related Commands: --- 

Description: The Branch command allows you to start a 
different program either from the active 

Program or on a Control Panel. In order to 
start the program on a control panel, the Branch 
command needs to be assigned to a Script 
Button. For example, you can combine the 
Branch command with the ⇒Trigger Commands 
to define dynamic program runs. 

Function: If a Branch command is issued while a program 
is running, the execution of the active control file 
is stopped. The newly selected control file is used 
instead. The times in the new control file are 
automatically corrected by the program time that 
already passed.  

Example1 (within a program): 

 0.000 Trigger       Pressure > 300 

       Branch       "Overpressure" 

       EndTrigger 

 If the pressure exceeds 300 bar (30 MPa = 4350 
psi), the Overpressure program is started. You 
can use the Overpressure program, for example, 
to slow down the flow, turn off the lamp, and 
deliver the ⇒Message that the pressure within 
the system was too high and thus, the flow has 
been slowed down. 

 Tip:  
In example 1, make sure that the program to be 
started via the Branch command is stored in the 
sequence to be processed. If the program is not 
stored in the sequence, specify the location in the 
program. As with the Script Button, use slashes 
to separate the different levels. 
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Function: 
(Cont'd) 

Example 2 (as script button on a control panel): 

Add a Script Button to the Control Panel (see 
How to …: Controlling Devices from the 
Control Panel  Creating a Script Button). 
Branch to the desired program by assigning the 
Branch command to the button. 

 Branch 
"CM_Seminar/Programs/Equilibration" 

 Click the button to start the column equilibration 
program that is stored in the CM_Seminar 

Datasource in the Programs directory. 

Parameter:  

 Program Name of the program file used for further 
processing 

 Tip:  When making a backup of a sequence, all PGM 
Files that are included in the sequence are also 
saved automatically. Therefore, to ensure that 
PGM Files branched to via a Branch command 
are automatically added to your sequence 
backups, verify that they are saved in the 
corresponding sequence.  
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BunchWidth (Distance between Wavelengths) 
 
Instrument Type: Detector 
Type: Fixed point value 
Value Range: 1.9 ... 197.6 [nm] 
Default: 1.9 [nm] 
Related Commands: ⇒Bandwidth 

Description: The distance between the wavelengths of a 3D 
field is referred to as BunchWidth. To enhance 
the Signal-to-Noise Ratio of a Photodiode 
Array Detector, the signals of several 
photodiodes can be averaged (or bunched).  

Function: The BunchWidth is closely linked to the 
Bandwidth. For Dionex detectors, the 
Bandwidth is calculated automatically from the 
BunchWidth. Thus, you do not need to 
determine the Bandwidth for the 3D field of 
Dionex detectors. 

If a detector, for example, has 80 photodiodes 
distributed on a wavelength range of 160nm, the 
(theoretical) optical resolution (= Bandwidth) is 
2 nm. If the BunchWidth is set to 8 nm, 8 : 2 = 4 
photodiodes are averaged to one signal.  

 Tips:  Averaging the signals improves the signal-to-
noise ratio. However, at the same time, Optical 
Resolution decreases.  
For certain instrument, the settings cannot be 
changed during the sample run. Thus, it may 
happen that commands included in the branched 
program are not performed. 
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Connect/Disconnect 
 
Instrument Type: All 
Related Commands: --- 
Description: Perform the Connect Device command to 

connect a device with the server to enable remote 
control. 

Execute the Disconnect command to separate a 
user PC (client) from a timebase or to operate an 
instrument locally.  

Functions:  

 Connect The command checks whether the specified 
device is actually connected, and then turns the 
instrument on. For all installed instruments, the 
Connect command is executed automatically 
when the Chromeleon server is started. Thus, if 
working in remote operating mode only, you do 
not need to explicitly issue this command. 

When the Connect command is enabled, the 
corresponding instrument may now be remotely 
operated from the PC. On most instruments, 
including all Dionex devices, the instrument 
keyboard is now locked for safety (and GLP) 
reasons. The instrument can be operated 
remotely, only. This is to ensure that the selected 
settings are retained. Input on the instrument 
itself is possible again after the Disconnect 
command. 

 Disconnect The corresponding instrument reverts to local 
operating mode and the keyboard is unlocked 
again. The instrument is no longer monitored by 
Chromeleon, nor can it be operated via the data 
system.  

 Tip:  Connect and Disconnect should only be used in 
interactive (online) mode and not within a 

Program. Otherwise, the Ready Check may 
not be valid.  
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Continue 
 
Instrument Type: System Command 
Related Commands: ⇒StopFlow 

⇒Hold 

Description: The Continue command cancels the Hold and 
StopFlow commands. 

Function: An interrupted sample Batch is continued in the 
same way as is an interrupted pump flow. 

Delay 
 
Instrument Type: System Command 
Related Commands: ⇒Trigger 

Description: Delays the execution of the following commands 
for the given time. 

 Tip:  Delay is usually used for Trigger commands, 
only. Example: 
Trigger PEAK UV_VIS_1 > 20 
Delay 5.0 
Sound Frequency = 440, Duration = 1 
EndTrigger 

With this program, an acoustic beep sounds 5 
seconds after the signal has exceeded 20 mAU. 
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Delta 
 
Instrument Type: All  
Related Command: ⇒Trigger 
Description: Chromeleon is capable of recording and 

evaluating signals or output variables supplied by 
a detector, for example, UV/VIS channel, 
Temperature, Pressure, %A, Flow rate, etc.  

Instead of the actual value (in mAU, Volt, °C, ml, 
etc.), the changes of a variable in a specific period 
can be calculated, that is, the first derivative of a 
signal. To do so, use the Delta signal property to 
calculate the difference between the current value 
and the value one second ago. 

The Delta option is especially useful when 
creating complex trigger conditions. A peak 
cannot only be recognized by the height of its 
absorption signal within a chromatogram, but also, 
for example, by a sharp increase of the signal.  

 Note:  
The first derivative is calculated once per second 
independent of the Sampling Rate or the ⇒Step 
used for data acquisition. 

Function: Delta is used especially for trigger conditions. The 
syntax is as follows: 
<Signal.Delta><comparison 
operator><value> 

Example: 
Trigger PEAK UV_VIS_1.Delta > 0.1 
Sound Frequency=440, Duration=1 
EndTrigger 

With this program, an acoustic beep is given after 
a peak has been detected (exactly: if the 
UV_VIS_1 signal ascends by more than 0.1 mAU 
in one second). 
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Function: 
(Cont'd)  Note:  

Select the reference value individually depending 
on the peak height and the baseline noise. 

 Tip:  

 

For another example of a trigger condition, refer to 
How to …: Practical Tips for Device Control 

 Trigger Commands. 
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Dispense 
 
Instrument Type: Autosampler  
Related Commands: ⇒Inject 

⇒Draw 

Description: The Dispense command causes the autosampler 
to dispense a specific quantity (volume) from the 
sample loop into a certain sample vial 
(⇒Position). The amount of time the autosampler 
may take for this operation is determined via the 

Duration parameter. When the operation is 
completed, the autosampler communicates the 
Sampler.Ready signal (for the ASI-100 
Autosampler; Sucked for the 
GINA 50/GINA 160 Autosamplers) to 
Chromeleon. The time interval between the 
Dispense command and the Sampler.Ready 
response signal can vary, depending on the 
instrument (ASI-100/GINA 50).  

Parameters (GINA50 only): 

 Position Sample position 

 Volume Sample volume 

 Duration This parameter indicates the minimum time 
required by the autosampler for the respective 
operation. 

 Tips:  For highly viscous liquids, more time must be 
allowed for the autosampler to dispense the exact 
volume. 
In manual operation, the commands are selected 
via the control pull-down of the unit window. 
When entering the commands to a Program, 
the three parameters need not be specified. 
During execution of a PGM File, the missing 
parameters are replaced by the current sample 
position, the current inject volume, and by the 
value 0 (if there is no duration), respectively. 
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Draw 
 
Instrument Type: Autosampler 
Related Commands: ⇒Inject 

⇒Dispense 

Description: The Draw command (Draw for the ASI-100, 
Suck for the GINA 50/GINA 160) induces the 
autosampler to draw a specific ⇒Inj. Vol. 
(injection volume) from a certain sample vial 
(⇒Pos. (Sample position)). The amount of time 
this operation is allowed to take is determined for 
the GINA50 autosampler via the Duration 
parameter. 

Function: When the operation is completed, the 
autosampler communicates the Sampler.Ready 
signal (for the ASI-100; Sucked for the 
GINA 50/GINA 160) back to Chromeleon. The 
time interval between the Draw (or Suck) 
command and the Sampler.Ready (or Sucked) 
response signal can vary, depending on the 
instrument type. 

Examples: 

 ASI-100 Autosamplers: The following command 
sequence delivers 10 µl of the current sample to 
the RA1 vial. The Dispense command is not 
executed until the Draw process has been 
completed. 

 -1.000 PrepSubject Sample_Vial 

  PrepVolume 10  

  Draw  

  Wait Sampler.Ready 
  
 -1.000 PrepVial RA1 

  PrepSubject PrepVial 

  PrepVolume 10  

  Dispense  
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Function: 
(Cont'd) 

GINA 50 autosampler: The following command 
sequence is required to deliver 10 µl of the 
current sample to the vial 1. Again, the Dispense 
command will not be executed until the Draw 
process is completed. 

 -1.000 Draw  Volume=10 
  Wait  Sampler.Ready  
  Dispense Pos=1, Volume=10 

Parameters (GINA 50 only): 

 Position Sample position 

 Volume Sample volume 

 Duration This parameter indicates the minimum time 
required by the autosampler for the respective 
operation. 

 Tips:  For highly viscous or low-boiling liquids, more 
time must be allowed for the autosampler to draw 
the exact volume without bubbles. 
In manual operation, the commands are selected 
via the control pull-down of the unit window. 
When entering the commands to a Program, 
the three parameters need not to be specified. 
During execution of a program, the missing 
parameters are replaced by the current sample 
position, the current inject volume, and by the 
value 0 (if there is no Duration), respectively. 

For more information, refer to Practical Tips for Device Control: 

 Autosampler Commands (GINA 50) 

 Autosampler Commands (ASI-100 Series) 
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End 
 
Instrument Type: System Command 
Related Command: ⇒EndTrigger 

Description: Marks the end of a program. 

EndTrigger 
 
Instrument Type: System Command 
Related Command: ⇒Trigger 

Description: The EndTrigger command marks the end of a 
block of triggered commands. 

Function: All commands between Trigger and EndTrigger 
are executed when the trigger condition becomes 
true. 

 Tip:  Define the Trigger identified by its name with the 
new condition „0" and mark the end of this trigger 
block with the EndTrigger command to finish an 
active Trigger. 
Time Trigger Name 0 

 EndTrigger 

This is necessary for each trigger separately. It is 
not possible to finish all triggers together.  
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Equate  
 
Instrument Type: Processed in PC 
Related Command: ⇒%B, %C, %D 

Description: The Equate command is used to assign different 
designations to the three partial flows of the 
fluidics, %A, %B, %C, and %D. Example: 

  0.000 %A.Equate =  "Water" 

  0.000 %B.Equate =  "MeOH" 

  0.000 %C.Equate =  "ACN" 

Function: In the unit windows, you can assign the partial 
flows the actual eluent names. The equate 
commands are logged in the audit trail. This to 
keep track of the chromatographic conditions at 
any time. Consider that a PGM File which 
contains equate commands may itself serve as a 
protocol! 

 Tip:  It is up to the user to check the consistency of 
%A, %B, %C, and %D with the eluents actually 
used! 
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Flow (Flow Rate) 
 
Instrument Type: Pump 
Related Commands: ⇒%B, %C, %D  

⇒%A, %B, %C, %D_Level 

⇒Purge 

⇒WasteLevel 
Description: The Flow command defines the total flow rate (in 

[ml/min]) through the column, i.e., the sum of all 
⇒Partial Flows (%A+%B+%C+%D=100%). The 
value entered represents the current value. For 
isocratic systems, this value remains constant 
during the program. In flow-gradient systems, 
this value represents an interpolation point of a 
polygonal line to which the previous and following 
flow values are adjoined by straight lines.  

Function: With flow Ramps, the total flow rate alters 
linearly with time, between two flow commands. 
By entering two flow commands at the same time, 
you can program Step Gradients. When sorting, 
the editor does not change the order of 
commands having the same program time! If the 
flow is to remain constant for the entire analysis, 
a single entry at the beginning of the Program is 
sufficient.  

 -2.000 Flow= 0.500  
  ... ... 
  0.000 Inject 
  0.500 Flow= 0.500  
  0.500 Flow= 1.000 
  ...  ... 
  8.500 Flow= 5.000 
  8.500 End 

 In this example, the flow rate remains constant at 
0.5 ml/min between -2.0 and 0.5 min. Then it 
increases abruptly to 1.0 ml/min and then linearly 
to 5 ml/min with a gradient of 0.5 ml/min. 
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Function: 
(Cont'd) 

If a second fluidic system is installed in the same 
Timebase, the corresponding device name has 

to be specified in the program. By using the F8 
key for generating command lines, the device 
name is inserted automatically. 

 Tip:  

The ⇒Hold, ⇒Continue, and ⇒StopFlow 
commands are always effective for both fluidic 
systems! 

 Tips: Chromeleon is able to run flow and %-gradients 
simultaneously. However, in high pressure mixing 
systems this results in non-linear partial flow rate 
changes for each individual pump.  
As there are pressures up to 400 bars in the 
chromatography column and as solvent mixtures 
such as methanol/water are subject to volume 
compression, the volume delivered in High-
Pressure Gradient Systems does not correspond 
to the volume transported via the column. 
However, the number of delivered and 
transported solvent particles is not changed by 
this fact. 

 The flow rate remains constant from the last flow 
command to the end of the program. Thus, for 
isocratic operation, a single flow entry at the 
beginning of the file is sufficient. 

 The first flow command must be at the beginning 
of the PGM File! 

Normal flow rates are in the range 0.5 to 
10 ml/min. Flow rates deviating from this range 
are achieved by using special micro pumps (0.1 - 
0.5 ml/min) or preparative pumps (as from 
10 ml/min). 
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 Tips: 
(Cont'd) 

Stopping the flow or decreasing the flow to 0.00 
ml may result in deposits in the detector flow cell. 
To avoid this, turn off the lamp in UV and 
fluorescence detectors when the flow is stopped 
(⇒Lamp = Off). 

For Dionex detectors, a warning appears if the 
lamp is not turned off. However, make sure that 
you have selected the installed pump from Link 
to Pump list on the General tab page for the 
detector in the Server Configuration program. 
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Freeze  
 
Instrument Type: Pump (P580 only) 
Related Commands: ⇒Learn 

Description: Compressibility always varies with different 
solvents. The better the pump is set to the 
compressibility of the respective solvent the lower 
is the pump's pulsation. Chromeleon allows you to 
determine optimum pre-compression control for 
the Dionex P580 pumps, using the Learn and 
Freeze commands. 

The Freeze command completes the learn mode 
for determining the compressibility of the 
respective solvent component. (For more 
information, refer to Practical Tips for Device 
Control  Setting Automatic Pre-
Compression Control.) 

Function: If the Freeze command is issued, the measured 
compressibility is saved and used for pre-
compression, according to the portion of the 
respective component in the total flow. 



1326 Control Commands 

Hold 
 
Instrument Type: System  
Related Command: ⇒StopFlow  

⇒Continue 

Description: The Hold command  
• Stops Data Acquisition 

• Interrupts a running Gradient program 

• Stops automatic processing of the Batch 

Function: In Hold mode, no data is acquired, the pump 
continues delivery with the current solvent 
composition, and evaluation of the batch samples 
is stopped. 

 Tip:  To abort all processes, select the StopFlow 
command. To continue the processes, select 
Continue. 
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Inject  
 
Instrument Type: Autosampler 
Related Commands: ⇒AcqOn 

⇒Draw 

⇒Dispense 

Description: The Inject command defines the beginning of a 
chromatogram, that is, it determines the time at 
which the sample enters the high-pressure 
system. Thus, the time of the first inject command 
is 0 by definition. The advantage is that the 
⇒Retention Time, as appearing in 
chromatograms and reports, coincides with 
program execution times. All commands before 
inject, are assigned negative execution times.  

Between the Inject command and the actual 
injection process (Inject response by the 
autosampler or the hand-operated valve), a 
system-dependent interval is required for 
reaching the rack and to draw the sample. During 
this time, the pump remains in ⇒Hold state; that 
is, a gradient that might be running is stopped. 
The Inject Wait state is canceled only by an 
Inject Response signal. The response signal is 
delivered either automatically (via an interface) or 
via a remote input signal. Only from this point, 
time keeping is started.  

Function: The function depends on the individual 
installation. For manual injection, Chromeleon 
simply holds the analysis time and waits for inject 
response. For a controlled autosampler, the inject 
command (at least) is relayed to this. For 
autosamplers with variable injection volumes 
and random sample access, such as the ASI-
100 autosampler, the inject volume and vial 
position are relayed as well. Such autosamplers 
are ideal for automated multipoint calibration.  
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Function: 
(Cont'd) 

For interactive operation (online) of the inject 
command, the Sample Position and Inject 
Volume parameters must be entered as well. 
During automated batch operation, these 
values are read from the sequence. Thus, 
parameters do not have to be set individually in 
the Program. 

Parameters: (When a hand-operated valve is used for 
injection, this information can be used for 
documentation purposes.) 

Position Vial ⇒Position in the autosampler 

Inject Volume Injection ⇒Volume in µl 

Blank Specifies whether Blank Run Samples are 
actually injected: 
Skip: no injection 
Inject: Injection is performed. 
When you use the Famos autosampler, make 
sure to allow a short time before blank run 
samples are injected. (For more information on 
the autosampler, refer to Hardware Installation 

 FAMOS Capillary/Nano HPLC Autosampler 
in the Administrator Help section.) 
-0.100 ; 6 seconds to process program 

0.000 Inject 

 Tips: Data acquisition (⇒AcqOn/Off) should be started 
after the Inject signal, at least 30 seconds before 
the first peak. Also, there should be Isocratic 
conditions during the injection process. 

 A program should only contain one inject 
command.  

 For the ICS ion chromatography system, injection 
is performed with the Pump_InjectValve. 
InjectPosition command (if no AS50 is installed). 
With this command, an injection is always 
performed, also for a Blank Run Sample. This is 
contrary to the autosampler ⇒Inject command.  
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Lamp 
 
Instrument Type: All optical detectors 
Related Commands: --- 
Description: The Lamp On/Off command turns the lamp of an 

optical detector on and off. UV/VIS detectors 
often have a separate lamp (deuterium/tungsten) 
for each wavelength range. In this case, the 
commands are as follows:  
UV_Lamp = On/off  
Visible_Lamp = On/Off. 

Function: The lamp is turned on or off. 

 Tips:  

 

Almost all optical detectors require a considerable 
warm-up period for high sensitivity, drift-free 
operation. The inject command should, therefore, 
be placed several minutes (minimum) after this 
command. Note also that lamp(s) should never 
be turned off during a sample batch. Many 
laboratories operate detectors 24 hours a day 
with the lamp turned on. 
Detector lamps are subject to aging. Check the 
⇒LampIntensity property, using the ⇒Log 
command; for example, to receive the value of 
the current lamp intensity at 254 nm. 

 Stopping the flow or decreasing the flow to 0.00 
ml may result in deposits in the detector flow cell. 
To avoid this, turn off the lamp in UV and 
fluorescence detectors when the flow is stopped 
(⇒Lamp = Off). 

For Dionex detectors, a warning appears if the 
lamp is not turned off. However, make sure that 
you have selected the installed pump from Link 
to Pump list on the General tab page for the 
detector in the Server Configuration program. 
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LampAge 
 
Instrument Type: All optical detectors 
Related Commands: ⇒LampIgnitions 

⇒LampIntensity  
Description: Detector lamps are subject to aging. After 

installing a new lamp, select the LampAge 
command to reset the lamp age to 0. 

The LampAge command allows you to check the 
lamp age via the ⇒Log command. The value 
indicates the quality of the lamp.  

 Tip: 
The maximum number of operating hours for a 
UV lamp is usually approximately 2000 hours. 

Function: The Log LampAge command logs the age of the 
optical detector lamp in the Audit Trail, 
indicating the values in operating hours. The lamp 
age is checked at the retention time at which the 
command was performed. 
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LampIgnitions  
 
Instrument Type: All optical detectors 
Related Commands: ⇒LampAge 

⇒LampIntensity  

Description: Detector lamps are subject to aging. After 
installing a new lamp, select the LampIgnitions 
command to reset the number of ignitions to 0. 

The LampIgnitions command allows you to 
check the number of ignitions via the ⇒Log 
command. The value indicates the quality of the 
lamp.  

Function: The Log LampIngitions command logs the 
number of ignitions performed by the optical 
detector lamp. The number of lamp ignitions is 
checked at the retention time at which the 
command was performed. 
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LampIntensity  
 
Instrument Type: All optical detectors 
Related Commands: ⇒LampAge 

⇒LampIgnitions 

⇒MinLampIntensity  
Description: Detector lamps are subject to aging. The 

LampIntensity command allows you to check the 
intensity of the lamp via the ⇒Log command. The 
value indicates the quality of the lamp. After you 
have installed a new lamp, periodically check the 
lamp intensity via the Log command, and then 
compare the two values. 

Function: The Log LampIntensity command logs the lamp 
intensity for an optical detector in the Audit 
Trail, indicating the value in counts/second. The 
intensity of the lamp is checked at 254 nm at the 
retention time when the command is performed. 

 Tip: 

Determine the lamp intensity at a time when it is 
not affected by substances in the flow cell. 
Therefore, it makes sense to check the value at 
the beginning of data acquisition. 

 Tips:  

 

The lamp intensity can be included in the report. 
Select the LampIntensity variable from the Audit 
Trail category. 
If you check the lamp intensity while recording the 
chromatogram, you have to a) search for the 
retention time at which the intensity was read 
(done automatically) or b) indicate it manually.  

a) Type the end retention time of the 
chromatogram in the Formula field. For example, 
for an overall run time of 15 minutes, type 

AUDIT.LampIntensity(15.0) 
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 Tips:  
(Cont'd) 

Chromeleon will automatically search for the 
retention time (backwards from the end retention 
time on) at which the lamp intensity was checked, 
and then indicate the lamp intensity that was 
measured at that time.  

Or, you may search for the retention time at 
which the lamp intensity was 
checked from the data 
acquisition start: 

AUDIT.LampIntensity(0.0,"forward"). 
b) If you know the retention time at which the 
intensity was checked, enter the exact time. For 
example, if the lamp intensity was read at 0.5 
min, type  

AUDIT.LampIntensity(0.5) 
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Learn  
 
Instrument Type: Pump (P580 only) 
Related Command: ⇒Freeze 

Description: Compressibility always varies with different 
solvents. The better the pump is set to the 
compressibility of the respective solvent the lower 
is the pump's pulsation. Chromeleon allows you to 
determine the optimum pre-compression control 
for the Dionex P580 pumps, using the Learn and 
Freeze commands.  

The Learn command starts the learn mode for 
determining the compressibility of the respective 
solvent component. However, verify that the 
solvent type has been set to Custom. (For more 
information, refer to Practical Tips for Device 
Control  Setting Automatic Pre-
Compression Control.) 

Function: After you have issued the Learn command, the 
pump automatically adapts to the compressibility 
of the respective solvent. 
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Log 
 
Instrument Type: Processed in PC 
Related Commands: ⇒Message 

⇒Protocol 

Description: The Log command allows you to document the 
values of variables in the Audit Trail at any time.  

Function: All device settings are listed as Preconditions in 
the Audit Trails. (For more information about the 
Audit Trails, refer to Data Management  Audit 
Trail.). In addition, you can log them at a 
specified time, using the Log command. 

If, for example, the pressure at the time t = 5.000 
min during sample processing should be logged, 
include the following line in the control program 
(see Control  The Control Program): 
 
5.000 Log Pressure.Value 

In the example mentioned above, the current 
pressure will be logged. In exceptions, the Log 
command is sent directly by the device driver; for 
example, for Fraction Collectors. For another 
example, refer to ⇒LampIntensity. 

Using the Log command, the different values 
from the sample table of the Browser may be 
written to the audit trail. This is possible for: 

PrevStandard: the most recent standard sample 

 Note: 
This standard may not be required for the current 
sample. 

PrevSample: the most recent sample 
Sample: the currently running sample 
NextSample: the next sample of the current 

sequence 
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Function: 
(Cont'd) 

 

It is possible for various standard columns and for 
User-defined Columns to output the 

corresponding values. 
  

MaxAutoStep  
 
Instrument Type Detector 
Type: Fixed point value 

Value Range: 0.1 ... 5.1 [s] (not with 3D fields) 
Default: 5.1 s  

Related Parameters: ⇒Step 

Sampling Rate 
Data Collection Rate 

Description: The MaxAutostep variable determines the 
maximum step if Step = Auto. 
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Message 
 
Instrument Type: Processed in PC 
Related Commands: ⇒Wait 

⇒Protocol 
⇒Log 

Description: When a program is executed, an on-screen 
message pops up. Click OK to confirm the 
message. Only then, the program will be 
continued.  

 The Message command allows the user to enter 
reminders for things to do or to consider while 
executing a Program.  

Function: When executing the program, a window 
containing the respective message text is 
displayed. The program is interrupted until the 
user confirms the message. Besides, the 
command and the message are written to the 
Audit Trail. 
For example, it a user should be reminded to 
check and, if necessary, refill eluents prior to the 
analysis, add the following command to the 
program: 
-1.000 Message "Check eluent containers!" 

When executing the program, the text in 
quotation marks is displayed on screen at the 
specified time (in the above example one minute 
prior to injection). Simultaneously, the command 
and the message are logged in the Audit Trail. 
The server is then in Hold mode. During this 
time, the monitor icon indicates this status by its 
yellow/red coloring. 
If Chromeleon is operated on a network, the 
message appears on the client having control 
privileges.  
The program continues operating as soon as the 
message has been confirmed. 
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Parameter:  

Text The message to be displayed. 

 Tip:  As long as the message dialog box is displayed 
on the screen, the time is interrupted and the flow 
conditions are in Hold mode. 

  

MinLampIntensity 
 
Instrument Type: All optical detectors 
Related Commands: ⇒LampIntensity  

Description: Select the MinLampIntensity command to set 
the lower limit for the lamp intensity. 

Function: When the measured lamp intensity is below the 
MinLampIntensity, a warning appears when 
data acquisition is started. 
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Mix  
 
Instrument Type: Autosampler 

Related Commands: ⇒Inject 

⇒Dispense 

Description: The Mix command causes the autosampler to 
mix defined injection volumes (see ⇒Volume) 
from several sample vials (see ⇒Position) in a 
different sample vial.  

Function: When the action is completed, the autosampler 
returns the Sampler.Ready signal. 

Example (ASI-100 Series): 

 0.000 PrepVial BA1 

0.000 PrepVolume 10 

0.000 Sampler.PrepVial Position + GA1 - RA1 

0.000 PrepSubject PrepVial 

0.000 Mix  
 

 The above command sequence mixes 10 µl from 
a vial in the green segment with 10 µl of a vial in 
the red segment in the corresponding vial of the 
blue segment. 

Example (AS/AS50): 

 Sampler.Pipet Volume = 20.0, SourceVial = 1, 
DestinationVial = 10 

Sampler.Mix SourceVial = 10, NumberOfTimes = 
5, Volume = 30.0 

 In the above command sequence, 20 µl is 
pipetted from vial 1 and delivered to vial 10. The 
contents of vial 10 is mixed by drawing in and 
expelling 30 µl of the vial contents. The mixing 
cycle is repeated 5 times. 

You can also use the PrepSpeed (ASI-100) or 
SyringeSpeed (AS/AS50) command to determine 
the draw speed of the syringe. 
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 Tip:  

 

When using highly viscous liquids or liquids with a 
low boiling temperature, allow the autosampler 
more time to draw the volume exactly and free of 
bubbles. 

 

For more information, refer to Practical Tips for Device Control: 

 Autosampler Commands (ASI-100 Series) 

 Autosampler Commands (AS/AS50) 
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NeedleUp 
Instrument Type: Autosampler 

Related Commands: ⇒Wash 

Value Range: Depends on device and installed syringe 

Description: The NeedleUp command enables lifting the 
sample needle. 

Function: Then the internal sample valve is switched (see 
the example for a load/inject process in the 
Autosampler). 

When lifting the needle, a running ⇒Wash 
process is automatically interrupted, i.e., the 
solvent flow is not through the sample loop but 
directly from the pump onto the column. Use the 
Load command to perform the same operation 
without moving the needle up. 

 Tip:  Use the Wash and NeedleUp commands to 
prevent crystallization of substances, such as 
buffers, by washing the sample loop. 
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ParkPercentage 
 
Instrument Type: UltiMate and LPG-3x00 pumps only 
Related Commands: ⇒Hold  

⇒Continue 
⇒StopFlow  

Description: The ParkPercentage command enables the peak 
parking functionality. A peak can be parked only 
from the system if the ParkPercentage is > 0.00. 
For the UltiMate pump, an external signal must be 
sent to the pump's START IN input.  

For the LPG-3x00, the ParkPercentage can be 
controlled via the corresponding commands, e.g., 
via script buttons on a panel. For example, one 
button sets ParkPercentage = 5 and the other 
ParkPercentage = 100. 

If peak parking is signaled, e.g., via a digital 
impuls from a Mass Spectrometer, you can use 
triggers for one of the pump's inputs: 
 
Trigger ParkPeakStart LPG3x00_Input1.State = 1 
 MicroPump.ParkPercentage = 5 
EndTrigger 
 
Trigger ParkPeakEnd LPG3x00_Input1.State = 0 
 MicroPump.ParkPercentage = 100 
EndTrigger 

Function: Peak parking is similar to the behavior of the 
⇒StopFlow command: 
• The Gradient program is interrupted.  

• Usually, the flow is reduced (but not turned off). 

However, unlike the behavior of the StopFlow 
command: 
• Data Acquisition (see Acquisition On/Off) is 

not interrupted. 

• A running Batch is not stopped.  
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Function: 
(Cont'd) 

The PeakParked variable displays the peak 
parking state. Chromeleon cannot control the 
state. 

By parking a peak, the peak is slowly pumped 
through the detector. Thus, you can operate, for 
example, a Mass Spectrometer in a more 
sensitive range. 

  Tips:  
Peak parking freezes the gradient with its current 
composition and reduced flow while data 
acquisition continues. Please keep the following in 
mind: 

• The retention times do not correspond to the 
expected times.  

• Audit Trail entries and gradient plots are no 
longer synchronized. 

• Triggers may no longer work as 
programmed.   

• Detection parameters need to be corrected.  

• The ⇒Delay Time between two detectors is 
incorrect.  

The changed flow is not displayed on the pump 
display or in Chromeleon.  
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Position 
 
Instrument Type: Autosampler 

Related Commands: ⇒Inject 

⇒Volume 

Value Range: Depends on device and installed carrier 
segment 

Description: Specifies the position of the vial from which a 
sample shall be injected.  

Function: If you use a controllable autosampler, the entered 
position is transmitted automatically to the 
autosampler. The autosampler approaches the 
corresponding sample for injection.  

If you use either a non-controlled autosampler or 
a hand-operated valve, this column is for 
documentation purposes only. If the sample 
position parameter is not entered, the previous 
(current) value is used. 
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Pressure.Lower/UpperLimit 
 
Instrument Type: Pump 
Related Commands: ⇒Flow 

Description: Define the pressure limits within which the 
pump(s) is permitted to operate. 

Function: If one of the limits is exceeded, Chromeleon 
turns off the flow, displays an error message, 
and terminates the current sample batch.  

If the upper pressure limit is exceeded, the flow is 
immediately set to 0 ml/min. The pressure 
reading must remain below the lower pressure 
limit for some time (typically approximately 60 s - 
the time depends on the pump type), before 
Chromeleon turns off the flow.  

Parameters: (The values that can be entered and the pressure 
unit depend on the pump type.) 

Pressure.LowerLimit Lower pressure limit in Bar, MPa, or psi. 
Pressure.UpperLimit Upper pressure limit in Bar, MPa, or psi. 

 Tip:  Pressure limits apply to all pumps that are 
connected on the high-pressure side.  
Exceeding the upper pressure limit can be due to 
a blocked column or capillary or to a defective 
injection valve. 

If the pressure is below the lower limit, this is 
usually due to a leak in the fluidic system. 
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Protocol  
 
Instrument Type: Processed in PC 
Related Commands: ⇒Message 

⇒Log 

Description: Writes a comment to the audit trail (without 
screen message). Thus, program steps can be 
additionally commented or chromatographic 
conditions can be written to the audit trail. (PGM 
comments are not written to the audit trail.) 

 -2.000 Protocol "Separation 
according to DFG-method, residue 
analysis" 

 -2.000 Protocol "0.05 M 
Natriumdihydrogenephosphate buffer" 

 -2.000 Protocol "Column: LiChrospher 
RP-18" 

Function: Unlike simple green comments starting with a 
semicolon, which are only part of the program, 
the Protocol text is included in the Audit Trail and 
thus, it is directly linked with the corresponding 
sample. Therefore, the Protocol text can be used 
for commenting individual samples. The Protocol 
command does not affect the program run. 

Parameter:  

Text The text that is logged in the Audit Trail. 

 Tip:  Event-controlled execution of the command is 
also possible. Example: 
0.000 Trigger Protocol UV_VIS_1 > 1000 

  Protocol "Valid absorption 
  range exceeded" 

  EndTrigger 
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Purge 
 

Type: Pump 
Related Commands: ⇒Flow  

Description Usually, the Purge command is used to rinse the 
system for a short time at a considerably higher 
flow rate. 

Function: The command sets the flow rate to the rate 
specified by PurgeFlow. The PurgeFlow is valid for 
the time specified by PurgeTime. Afterward, the 
flow rate is reset to the value specified by Flow. 

Ready 
 
Type: Autosampler  

Related Commands: ⇒Inject 

Value Range: NotReady ... Ready 
Description: The Ready property indicates the state of the 

autosampler. 

Function: The autosampler can only execute a command, for 
instance, the Inject command, when it is in Ready 
state. 
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RefBandwidth (Reference Bandwidth) 
 
Type: Integer 
Value Range: Detector-dependent 
Default: 0 [nm] 
Related Commands: ⇒RefWavlength (Reference Wavelength) 

⇒Bandwidth 

Description: The reference bandwidth can be selected 
separately for each channel. The 3D field of a 

Photodiode Array Detector also has its own 
reference bandwidth. 

Analogous to the conventional bandwidth of a 
channel, the reference bandwidth serves to 
average several photodiode signals of the 
Reference Wavelength. 

Function: For example, if the reference wavelength is 
350 nm and the reference bandwidth is 5 nm, 
wavelengths in the range of 348 - 352 nm are 
averaged and used as the reference. 

 Tips: 

 

For the UVD 170/340 detectors, change the 
reference bandwidth only if the reference 
wavelength cannot be set to 600 nm; that is, for 
substances clearly absorbing at 600 nm, 
especially blue substances. This is the only case 
where using a higher bandwidth can improve the 
signal to noise ratio. 
For PDA-100 detectors and other two-lamp PDA 
detectors, select a reference bandwidth that 
includes a majority of light from the same lamp as 
the sample wavelength. For the PDA-100, the 
deuterium lamp provides wavelengths of 190 nm 
to 380 nm and the tungsten lamp provides 
wavelengths of 380 nm to 800 nm. Select a 
reference bandwidth that is narrow enough not to 
interfere with nearby compounds and select an 
area of the spectrum where the sample does not 
absorb. 
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RefWavelength (Reference Wavelength) 
 
Instrument Type Detector 
Type: Integer 
Value Range: Detector-dependent 
Default: Off 
Related Commands: ⇒RefBandwidth (Reference Bandwidth) 

⇒Wavelength 

Description: With Dionex Photodiode Array Detectors, the 
reference wavelength is used to correct the 
absorption values of the wavelength that has 
been selected for the analysis.  

Function: If the absorption of the reference wavelength 
changes during the analysis, absorption values of 
the analysis wavelengths are adjusted up or 
down accordingly. The selected reference 
wavelength should be in a quiet area of the 
spectrum where little absorption occurs. Each 
change in the absorption then indicates 
substantially changed conditions; for example, a 
reduction of the lamp energy (lamp drift). Each 
change can be used to correct the absorption in 
the remaining wavelength range even during the 
analysis (the recorded signal is reduced or 
amplified accordingly, as necessary). 

Reference wavelengths are especially useful for 
gradient analyses because, as the light intensity 
changes over time (due to the gradient), 
absorption values are adjusted. This minimizes 
baseline drift. 

Peaks are not detected in the reference 
wavelength range where the system is "blind" per 
definition. Should peaks be detected, 
nevertheless, select a different reference 
wavelength. You can deliberately use this as well 
to inhibit peaks. 
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Function: 
(Cont'd) 

If the reference wavelength is chosen in a light-
deficient range, it is recommended to average the 
signals of several photodiodes by increasing the 
Reference Bandwidth and thus improve the signal 
to noise ratio. 

For the Dionex Photodiode Array, you may 
change the reference wavelength after data 
acquisition. To do so, the PPA window has two 
options:  

1. Extracting a channel at a wavelength other 
than used for data acquisition: On the context 
menu, select Extract and then 
Chromatogram to file. Then, select a 
reference condition for the new channel. 

2. Displaying the 3D field at a different reference 
wavelength: Select the Decoration option on the 
context menu to open the Peak Purity 
Decoration. Then, select the reference 
conditions on the General tab page. 

 Tip:  Do not confuse the reference wavelength with the 
Reference Channel used for Baseline 

Correction of Spectra. 

Settings: Details about reference wavelengths vary, 
depending on the type of detector: 

Dionex UVD 170/340 Detectors  

For the Dionex UVD 170/340 UV/PDA detectors, 
select a reference wavelength of 600 nm because 
relatively small absorption values are observed at 
this wavelength. In addition, the Dionex detectors 
have a special noise optimum at this value. 
However, when the reference wavelength is 
changed, the special noise optimum no longer 
applies. 
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  Tip:  
Use a Holmium Oxide Filter (spectra calibration) 
to reference the measured wavelength range, 
that is, to verify whether the actual nanometer 
value corresponds to the nominal value.  
 
Dionex PDA-100 Detector 
By default, the reference wavelength is disabled 
for the PDA-100. With UV channels (≠ 3D Field), 
the absorption at the first scan after the autozero 
is used as a reference. This results in lower noise 
but less drift compensation. The 
Reference_Wavelength=Off command in a 
program or on the control panel turns off the 
reference wavelength.  

During collection of 3D Field data, the 
absorption after autozero is always used as a 
reference (as described above). After data 
collection, a reference wavelength can be applied 
to the data. The reference wavelength in this 
case defaults to the highest wavelength in the 
analysis range. For example, if the analysis 
wavelength range is 190 - 350 nm, the default 
reference wavelength is 350 nm. If you select a 
different reference wavelength, the selected 
reference must be within in the stored wavelength 
range. 
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Relay On/Off 
 
Instrument Type: All relays  
Related Commands: --- 

Description: Relay-Name.On (Off) closes (opens) a relay 
output (closure contact) for a specific instructed 
time. Switching valves are treated as relays also.  

Function: The specified relay is opened or closed for a 
specified time in seconds. Relay-Name.On 
opens the relay upon completing a certain period 
( Duration), Relay-Name.Off closes the relay 
after completing the duration. If no duration is 
specified for Relay-Name.On (Off), the relay 
remains closed (open) until the next relay 
command is given. 

Parameter:  

Duration Closure or opening time in seconds [s] (optional). 

 Tip:  Relay On/Off duration for the same relay may not 
overlap. 
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Reset  
 
Instrument Type: All 
Related Commands: ⇒Autozero 

Description: Resets an instrument to its initial conditions, as 
attained after power-up; i.e., to standby mode. 

Function: Enables (in general) a warm start, that is, the 
instrument regains its initial state as immediately 
after power-up. The reset command is particularly 
useful when an instrument has been operated 
locally, or if it has an undefined status (to 
Chromeleon); for example, after an instrument 
fault. 

 Tip:  Activating the reset of an autosampler may 
require a considerable time to completion, as 
generally this involves a mechanical recalibration 
and a complete wash cycle. 
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Sound 
 
Instrument Type: Processed in PC 
Related Commands: --- 
Description: The Sound command generates an acoustic 

beep of selectable frequency and duration that is 
heard on the internal loudspeaker of the PC. You 
can use a beep to acoustically monitor the 
progress of a program, by setting Sound 
commands at key positions in the file. Combining 
the Sound command with a ⇒Trigger command 
allows you, e.g., to "hear" a peak elute. Select 
different frequencies for leading and trailing peak 
edges to distinguish them acoustically.  

 Example: 

 -2.000 Flow = 1.000 

 -2.000 %B = 50 

  0.000 Inject 

  0.000 Trigger Up    UV-VIS-1 > 20 

        Sound Frequency=440, Duration=1 

        EndTrigger        

        Trigger Down  UV-VIS-1 < 40 

        Sound Frequency=880, Duration=1 

        EndTrigger        

  0.500 Acquisition On 

  ...  ... 

  8.000 Acquisition Off 

  9.000 Program End 
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Function: If the PC is not equipped with a sound card, the 
loudspeaker may not be able to process the beep 
generated by the Sound command. In this case, a 
default beep is generated, instead. 

Also, refer to Practical Tips for Device Control 
 Trigger Commands. 

Parameters:  

File Sound File (normally WAV file) 

Frequency In Hertz [Hz] (concert pitch a = 440 Hz 

Duration In seconds [s]. 
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Step 
 
Instrument Type: Detector 
Type: Fixed point value 
Value Range: Depends on the channel; for example, for a 

UV channel: 0.01 ... 4.8 [s] or Auto 

Default: Depends on the detector and the channel; for 
example: 

0.5 s (3D field of the 340U PDA) 

Auto (UV-VIS channel of the 340U PDA) 

0.05 s (GC) 

 Note:  
For non-controlled GCs: 0.25 s. 

Related Commands: ⇒MaxAutoStep 

Sampling Rate 
Data Collection Rate 

Description: The Step determines the time interval between 
two consecutive data points within the signal's 
raw data file (see Data Management  Raw 
Data). The step is variable; you can specify a 
fixed step or have it selected automatically. A 
fixed sampling rate is especially useful if you want 
to export the recorded raw data to external 
software applications and if the destination 
program can only process equidistant data 
points. 

Function: Fixed Step [0.01 .... 4.8 s] 
Every step seconds, a data point is stored in the 
Raw Data file. For example, selecting step = 0.5 
means acquiring and storing 2 data points per 
second. The smaller the step, the more data 
points will be recorded per time unit (regardless 
of whether there is a baseline segment or a 
peak). 
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Function: 
(Cont'd) 

For the 3D field, step (here, 0.1 - 4.0 s) defines 
the data rate at which the connected 

Photodiode Array Detector collects spectra. 

The distance between individual data is as 
follows: 
• for the Dionex UV Detector = 0.01 s 

• for the UCI Universal Chromatography 
Interface = 0.01 s 

• for the 3D Field = 0.1 s 

 Automatic Step [auto] 
At a variable sampling rate, the last 10 seconds 
of a chromatogram are temporarily stored in the 
system memory with the highest sampling rate. 
For each new data point (every 0.01 s), the oldest 
data point can be removed.  

A complex algorithm allows determining and 
storing only those data points in the raw data file 
that are actually required. All "unnecessary" data 
points are filtered out and the chromatogram is 
stored almost without a loss in representation. 

Depending on whether the peaks are narrow or 
wide or a baseline segment, 0.2 to 100 data 
points are stored per second as the result. Thus, 
the step automatically varies between 0.01 and 5 
seconds. 

Saving raw data with automatic step reduces the 
storage requirement up to 75% and thus 
increases data processing. 

Select the Decoration command on the context 
menu and then the Raw Data Point option on the 
Peak Decoration tab page to display the chosen 
raw data points in the Report. 

Select the ⇒MaxAutoStep command to 
determine the maximum step for Step = Auto. 
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 Tips:  Select the step in such a way that 20 data points 
are placed on the narrowest relevant peak of your 
chromatogram. If you acquire more data points, 
this will use unnecessary disk capacity and the 
integration might become incorrect, especially 
with increased baseline noise. 
Use the Auto step for fast peak chromatograms 
for which you do not know the width of the 
expected peak. For a precise and reproducible 
analysis, always use a fixed step (see above). 
Especially with increased baseline noise, using 
Auto may result in incorrect integration. 

If you issue the Data Collection Rate command, 
the default Step value is set to the reciprocal 
value. That is why you have to issue the Step 
command after the Data Collection Rate 
command if you need a different step. 

For an overview of data acquisition, refer to Data 
Management  Data Acquisition. 



 Control Commands 1359 

StopFlow 
 
Instrument Type: System Command 
Related Commands: ⇒Hold 

⇒Flow 

⇒Continue 
Function: The Stop Flow command turns off the pump flow; 

data acquisition is interrupted. A running Batch 
is stopped, as in the hold mode.  

Select the Continue command to undo this 
command. 
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Temperature 
 
Instrument Type: Column Oven/Autosampler/GC 
Related Commands: --- 
Description: The Temperature command adjusts the required 

temperature for a column thermostat, 
autosampler, or GC. 

Function: If the program file contains more than one 
Temperature command, you will get a step profile 
instead of linear interpolation between two 
commands, which is happening with all 
temperature commands. In other words: Every 
new temperature command drives the thermostat 
to the new temperature as fast as possible 
(device-dependent). With GCs, the temperature is 
changed according to the desired temperature 
program. 

Parameters:  

Value Actual column oven temperature 

Nominal Required temperature for the column oven. 

Upper/LowerLimit Upper/lower limit for the temperature of the 
column oven. 

 Note:  As with all device parameters, Chromeleon tries 
to display the status on the screen! Whether this 
is possible depends on the column oven 
connected.  
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Trigger  
 
Instrument Type: System Command 

Related Commands: ⇒EndTrigger 

Description: Executes any commands that are immediately 
following if previously defined conditions are met; 
for example, if a defined signal voltage threshold 
and/or your time gradients exceeds a specified 
threshold. Define the condition, using the 
Condition parameter.  

In the program, the entire Trigger block is 
indicated in blue color. 

Examples • A typical use for this function is the control of 
a Fraction Collector. If the absorption signal 
of a given channel exceeds a threshold value, 
a relay is enabled, switching to the next 
collection vial. Further important applications 
are: 

 • Signal-dependent Wavelength Switchings; 
for example, immediately after completion of 
a peak. Thus, retention time variations can be 
neglected. 

 • Programs can be ⇒Branched off according to 
external conditions, such as a remote input or 
the value of an analog signal. Thus, you are 
flexible in determining the chromatographic 
reaction to external conditions (pressure, 
conductivity, etc.). 

 • Acoustic signals can be generated when 
certain conditions become true (⇒Sound). 
Thus, your peaks can be made audible. 

Function: The trigger condition is active from the time of the 
trigger command and has to be specifically 
disabled. However, signal values are received 
only after the ⇒AcqOn command of the program. 
The following command is executed every time 
the specified conditions are med (edge 
triggering), i.e., from each transition from false to 
true.  



1362 Control Commands 

Function: 
(Cont'd) 

Thus, in the previous example, the trigger 
condition must be entered only once in the 
program; the fraction collector will then be 
switched for each new peak. 
Trigger commands can only be activated from 
programs or programmable buttons but not in the 
online control. The following syntax is valid: 

 Time Trigger NAME Condition, True, 
                  Delay, Limit, Hysteresis 

  Triggered command 1 

  Triggered command 2 

  Triggered command 3 

  ... 

  EndTrigger        

 As a response to a Trigger condition becoming 
true, virtually any instruction can be performed. 
Examples:  
• AbortBatch 
• Acquisition.on/off 
• BranchTo  
• ⇒Message 
• ⇒Protocol 
• Relayname.on/off 
• Signalname.Parameter 
• Sound 
Triggering the flow rate and the solvent 
composition is also possible. However, a gradient 
will be interrupted, and the analysis will be 
continued under isocratic conditions. Yet, you can 
use the Branch command to start a new gradient 
program. 
The inject command cannot be triggered, as it is 
linked to t = 0.000 and can be given dependently 
from the time.  
Note that trigger commands can be triggered, 
also. 
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Parameters:  

Name The name of the trigger command is obligatory. It 
serves for its identification. That is why the name 
must be unique, that is, the trigger cannot have 
the same name as a device or another command. 
Then, several triggers with different names can 
be activated simultaneously. 

 Note:  
To be able to find the trigger in an Audit Trail or a 
Report, it is recommended to include the trigger 
name in capital letters in the program. 

Condition Defines the trigger condition and can have two 
forms: 

 <Parameter><Comparison Operator><Value> or 
<Signal.Delta><Comparison Operator><Value> 

 or 

 <Remote-Input-Name> 

 <Parameter> 
All installed channels, but also parameters such 
as Temperature (column temperature), Pressure 
(system pressure), Flow (flow rate), and %A, 
%B, %C, and %D can be used. 
<Signal.Delta> 
For signals, the first derivative of the parameter 
can be evaluated. This is achieved by adding the 
signal property DELTA. 
<Comparison Operator> 
<, >, =, <=, >= and <> 
<Value> 
Fixed-point number. The dimension of the 
<Value> corresponds to the signal dimension. 
Parameters that are combined with DELTA have 
the dimension [signal dimension / s]. 
<Remote-Input-Name> 
is reported from the instrument to Chromeleon, 
for example, Sample.Ready or Leak. 
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Condition 
(Cont'd) 

If several parameters are to be linked, this can be 
realized via mathematical (+, -, *, / , **) or logical 
(AND, OR, NOT, XOR) operators. Parentheses 
show combinations and hierarchy, as for 
instance: 

 • (UV_VIS_1>100) AND (UV_VIS_2>100) 

 • (UV_VIS_1+UV_VIS_2)>200 

 Logical links of entire conditions are also 
possible.  

 • (UV_VIS_1>100) AND NOT (UV_VIS_2>200) 

True Validity in seconds. The trigger condition must 
be true for this time, to activate the trigger. 
Example: 

 Trigger DIGIN1 Remote1, True=2.0 
 The input signal must be active for at least 2 

seconds to trigger DIGIN1.  

The True parameter is also used as a criterion for 
the truth of signals; for example, to differentiate 
between true signals and spikes. 

Delay Indicates the delay time (in seconds) between 
fulfillment of the conditions and execution of the 
command; for example: 

 1.220 Trigger SIGNAL  UV_VIS_1>20, Delay=5.0 

 1.220 Relay On FracCol 

 The FraCol relay is switched 5 seconds after 
trigger activation only. 

The Delay parameter is usually used for 
switching a fraction collector with a time delay. 
Thus, the dead volume between the detector and 
the fraction collector is taken into account.  

If the Delay parameter is used in combination 
with the True parameter, the command is 
executed only <TRUE> + <DELAY> seconds 
after the condition is true. 
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Limit The upper limit for executing the trigger 
command. Without the limit parameter, a trigger 
command is carried out any number of times until 
the trigger off command is executed. The limit 
parameter automatically deletes the trigger after a 
corresponding number of activations. Example: 

 1.220 Trigger BRANCH RemoteIn, Limit=1 

       Branch NEWPGM 

 The trigger command is only carried out once, 
and then the trigger is deleted. 

Hysteresis To prevent multiple trigger execution with very 
noisy signals, each trigger receives the 
Hysteresis parameter in addition to the True 
parameter. 

In contrast to the True parameter, Hysteresis is 
not time but signal-dependent. The parameter 
can vary between 0 and 100%. The default value 
is 5%. 

A 5 % hysteresis causes, for example, the 
condition 
Cond = UV_VIS_1 > 20,0  

To change from FALSE to TRUE when reaching 
the value 20.0, but only changing from TRUE to 
FALSE at 19.0. Thus, a difference is made 
between signal increases and decreases. This 
corresponds to the different paths of a hysteresis 
loop. 

If the operator < is used instead of >, the 
calculation is reversed! For the above example 
this means that the condition  
Cond = UV_VIS_1 < 20,0 

Becomes TRUE immediately when the value falls 
below 20, but is reset from TRUE to FALSE only 
at 20 + 5% = 21. 
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 Tips:  While acquisition is disabled or interrupted, signal 
values cannot be evaluated. 

 If the True and Delay parameters are used, the 
command is switched only <TRUE> + <DELAY> 
seconds after the condition becomes true. 

 End program automatically disables all trigger 
conditions. 

 Triggering the Flow, %B, %C, and %D 
commands is restricted to isocratic separations. 

 For certain instrument, the settings cannot be 
changed during the sample run. Thus, it may 
happen that trigger commands are not performed. 

 Example: 

 When the trigger condition becomes true, the 
following program switches the flow to 0.1 ml/min 
and sets %B to 0. 

 -1.000 Trigger ELUENT UV_VIS_1 > 20 

  Flow = 0.100 

  %B.Value = 0.0 

  EndTrigger 

  0.000 Inject 

  0.000 UV_VIS_1.AcqOn 

  .... ........ 

 15.000 UV_VIS_1.AcqOff 

 15.000 End  
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Volume 
 
Instrument Type: Autosampler 

Related Commands: ⇒Inject 

⇒Position 

Value Range: Depends on device and installed syringe 

Description: Specifies the injection volume in micro liters (µl).  

Function: In automatic operation, the installed Driver 
converts this value into a volume readable by the 
autosampler, then the value is sent to the 
autosampler. 

You can enter different injection volumes to 
create a Dilution Series for multiple-point 
calibration ( Single-Point and Multiple-Point 
Calibration). 

 Tip:  In order to minimize carry-over effects in multiple-
point calibrations, you should always start with 
the sample with the highest dilution or the 
smallest injection volume. 
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Wait 
 
Instrument Type: Remote Input 

Related 
Commands: 

⇒Message 

⇒Inject 

⇒AcqOn/Off 

Description: The Wait command interrupts program execution 
until the specified remote input signal arrives.  

Function: Wait stops the program time and the acquisition; the 
pump(s) are in Hold mode. For examples for how to 
use the Wait command, refer to Practical Tips for 
Device Control: 

 Autosampler Control 
Special Commands, Relay Control, and 
Miscellaneous  Mixed Commands 

Parameter:  

Condition Condition for the realization of which the system waits 
(see ⇒Trigger) 
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Wash 
Instrument Type: Autosampler 

Related Commands: ⇒Inject 

⇒NeedleUp 

Value Range: Depends on device and installed syringe 

Description: The Wash command serves for rinsing the 
autosampler. 

Function: It causes the autosampler to lower the needle into 
the needle seat and to rinse the sample loop and 
needle with solvent in Inject state. This 
corresponds to the normal solvent flow following 
an Inject command. 

 Tip:  Select the Wash and NeedleUp commands to 
wash the sample loop and thus prevent 
crystallization of substances in the sample loop. 
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WasteLevel  
 
Instrument Type: Pump(s) 
Related Commands: ⇒WasteWarningLimit 

⇒%A, %B, %C, %D_Level 

⇒%B, %C, %D 

⇒Flow 

Description: This commands indicates the level for the 
solvent waste. 

Function: Before starting a sequence, enter the actual 
filling height in the waste container. Chromeleon 
checks whether the waste container has 
sufficient capacity. 

Parameters:  

 Value Actual waste level in [l]. 

 UpperLimit Upper limit for the waste level in [l]. If the level in 
the waste container reaches this value, the batch 
is aborted and following message appears: 

[Abort] xx:xx:xx {Pump} The waste level is above 
the limit (x.xxx l)! Please empty the waste 
container. 

 Tip:  
In the emergency program, reduce the flow rate 
to 0 ml/min. This avoids that the waste container 
runs over. 

 Tip:  

 

Chromeleon checks the calculated level of 
solvent waste during the Ready Check. The 
corresponding warning appears if necessary. 

 

 Note:  
This command is available for all pumps except for ion chromatography 
pumps. 
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WasteRemainTime 
 
Instrument Type: Pump(s) 
Related Commands: ⇒%A-, %B-, %C-, %D_RemainTime  

⇒WasteLevel  

⇒WasteWarningLimit 

Description: Reports the approximate time until the 
associated waste container will be full to the 
upper limit (WasteLevel.UpperLimit). 

Function: Chromeleon calculates the waste remain time 
based on the current flow and the current filling 
height of the waste container. 

 Tip:  
When you change the flow rate later, 
Chromeleon recalculates the remain time. 
Therefore, check this value whenever you have 
changed the flow rate. 

 

 Note:  
This command is available for all pumps except for ion chromatography 
pumps. 
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WasteWarningLimit  
 
Instrument Type: Pump(s) 
Related Commands: ⇒WasteLevel 

⇒%A-, %B-, %C-, %D_WarningLimit 

Description: This command allows you to enter a warning 
limit for monitoring the filling height in the waste 
container. Input is in percent and refers to the 
upper limit (WasteLevel.UpperLimit). 

Function: If the filling height in the waste container 
exceeds the upper limit x the warning limit/100 
(WasteLevel.UpperLimit x 
WasteWarningLimit/100), the following warning 
appears: 

[Warning] xx:xx:xx {Pump} The waste level 
(actual level in [l]) will reach the upper limit 
(upper limit in [l]) in about 0.1 hours! Please 
empty the waste container. 

 Tip:  
When the filling height reaches the upper limit, 
the batch is aborted. In the emergency program, 
reduce the flow rate to 0 ml/min. This avoids that 
the waste container runs over. 

 

 Note:  
This command is available for all pumps except for ion chromatography 
pumps. 
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Wavelength 
 
Instrument Type: Detector 
Type: Integer 
Value Range: Detector-dependent 
Default: 0 [nm] 
Related Commands: ⇒Bandwidth 

⇒RefWavelength (Reference Wavelength) 

Description: The Wavelength command specifies the 
wavelength at which the chromatogram is 
recorded.  

Function: For controlled detectors, such as the Dionex 
detectors, this value is automatically transferred 
to the detector (requires control option). The 
wavelength can also be entered manually during 
the analysis or in the program.  

In Chromeleon configurations without control 
option, the selected wavelength remains fixed 
during the analysis. In controlled versions, the 
wavelength can be altered during analysis. 
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QNT Parameters 

QNT Parameters (Overview) 
The QNT Editor allows you to define general, peak table, and detection 
parameters. For information about the general parameters and peak table 
parameters, refer to: 

⇒Amount 
⇒Calibration Mode  
⇒Calibration Type 
⇒Check Derivative 
⇒Check Extrema 
⇒Comment (Peak) 
⇒Dead Time 
⇒Delay Time  
⇒Dimension of Amounts 
⇒Group (Peak Group) 
⇒Integration Type 
⇒Kovats Index 
⇒Left/Right Limit  
⇒Match Criterion 
⇒Maximum/Minimum Wavelength 
⇒Name (Peak Name) 
⇒Reference Spectrum 
⇒Relative Maximum Deviation 
⇒Response Factor 
⇒Retention Index 
⇒Retention Time 
⇒Standard 
⇒Threshold 
⇒Type (Peak Type) 
⇒Use Recently Detected Retention Time 
⇒Window 
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Amount  
 
Location: Peak Table tab page 

Report Variable (Peak Table/Peak Results) 
Type: Floating point number 
Dimension: Determined by the Dimension of Amounts 

parameter on the General tab page 

Value Range: 0.000001 ... 9999999.999999 

Default: 1.000000 

Related Parameter: ⇒Dimension of Amounts 

Description: The Amount parameter determines the content 
(amount, concentration) of a standard sample or 
a Validation Sample of a particular mixture 
component. For multi-point calibration with 
various standards (i.e., the injection volume does 
not vary), several values must be entered for 
each peak. Thus, a matrix of standard contents is 
created, whose lines correlate to the peaks and 
the columns to the various standards.  

Function: Enter the amount as concentration value (e.g., 
µg/µl) or as absolute amount (e.g., µg). In the 
report, the result is displayed accordingly, either 
as concentration value or as an absolute amount. 
The respective inverse function is used for 
calculation (see How to …: Creating and Using 
Report Tables  Calculating the Peak 
Variable "Amount"). The Formula for 
Calculating the Amount allows you to consider 
the response factor, dilution factor, weight, and a 
factor for the Internal Standard. 

In absolute amounts, the result always relates to 
the injected volume; for example, 17.6 µg per 
20 µl injection volume. Select the Concentration 
peak result variable to normalize the value to 1 µl 
by dividing the absolute value by the injection 
volume; for example, 17.6 / 20 = 0.88 µg/µl.  
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  Tip:  
If a concentration unit has been chosen as 
Dimension of Amount, the Concentration peak 
variable has lost its sense.  

In a single-point calibration, only one standard is 
used. This means that there is only one value per 
component (peak).  

In a "real" multiple-point calibration ( Single-
Point and Multiple-Point Calibration - no variation 
of the injection volume), the number of amount 
values for each component must correspond 
exactly to the number of standards.  

 Tips:  In a multiple-point calibration, the values of the 
Amount columns are corrected by the ratio of the 
injection volumes (for which the reference volume 
defined on the General tab page of the QNT 
Editor is used) and the dilution factors in 
comparison to the first standard. You can thus 
combine the amount values with the Dilution 
Series! 

 Even for multi-point calibration, normally only one 
peak table is required! 
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Calibration Mode 
 
Location: General tab page 

Report Variable (Peak Calibration) 
Type: Character 
Dimension: No dimension 

Value Range: Fixed/Total/Group/Additional/Bracketed/Stand
ard Addition 

Default: Total 
Related Parameter: ⇒Calibration Type 

Description: The Calibration Mode parameter determines the 
standards that are used for calibrating a specific 
sample of a sequence. Chromeleon provides six 
different calibration modes. 

Select the mode on the General tab page in the 
QNT Editor (see The QNT Editor  The 
General Tab Page). 

Function:   

Fixed This setting enables the calibration using various 
standards (also from other sequences).  

The desired standards are entered via the Insert 
Standard or Append Standard commands on 
the Calibration tab page of the QNT Editor. The 
sequence the standards are taken from is 
included in the Sequence column.  

If desired, you can enter individual calibration 
coefficients via the c0, c1, c2, and c3 columns in 
the amount table. 

  Tip:  
Always perform the calibration manually 
(Calibrate). The Auto-Recalibrate option is not 
available. 
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Total Calibration is performed using all valid standard 
samples of a sequence. The standard samples 
disabled in the Enabled column of the 
Calibration tab page (QNT Editor) are not 
included. 

Group  The calibration of a sample series from the 
sample list (for example, samples 3 to 50) is 
performed based on the standard samples listed 
directly before this series; for example, no. 1 and 
2. If this sample list includes additional standards 
(for instance, no. 51 and 52), the samples that 
follow (for instance, 53 to 100), will be evaluated 
based on these. The standard samples in lines 1 
and 2 will no longer be considered. (For an 
example, see the picture below.) 

Additional For calibrating a sample, all standard samples 
that are listed before this sample in the sample 
list are used. The further down the sample is 
listed in the table, the more standard samples will 
be considered. For an example, see the picture 
below. 

Bracketed  Samples are evaluated based on all standard 
samples immediately surrounding. In case of a 
list containing two samples, two standards, two 
samples, two standards, and so on, samples 1 
and 2, located at positions 3 and 4, are evaluated 
with standards 1, 2, 3, and 4, located at positions 
1, 2, 5, and 6. Samples 3 and 4 are evaluated 
using standards 3, 4, 5, and 6, located at 
positions 5, 6, 9, and 10. For an example, see the 
picture below. 
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Standard 
Addition 

Use this mode to analyze unspiked samples using 
the Standard Addition method. In this case, only 
the sample types Unspiked and Spiked are 
considered for the analysis. (For more information 
about these sample types, refer to Spiked 
Sample). 

If several unspiked samples (sample type: 
Unspiked) are available, only the associated 
spiked samples are analyzed. Make sure that they 
are assigned to the same ⇒Std. Add Group 
(Standard Addition Group), i.e., verify that the 
names indicated in the Standard Addition Group 
column in the sample list are identical. 
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Calibration Type 
 
Location: Peak Table tab page 

Report Variable (Peak Calibration) 
Type: Code 

Dimension: --- 
Value Range: Linear (Lin and/or LOff) 

Quadratic (Quad and/or QOff) 
Cubic (Cubic and/or COff) 
Exponential (Exp) 
Point-to-Point (P-P) 

Combine with: No Weights, 1/Amount (X), 1/Amount² (XX), 
1/Response (Y), 1/Response² (YY) (with 
Average all response values... additionally 
1/Rel.Std.Dev., 1/Rel.Std.Dev.²) 

Default: Linear 
Related Parameters: ⇒Standard 

⇒Calibration Mode  

Description: The Calibration Type parameter determines the 
Calibration Function and the Weights. In 

calibration, up to three calibration constants per 
peak are entered into the calibration file, defining 
the peak area/amount ratio. The minimum 
number of required samples depends on the type 
of calibration curve chosen. A maximum of 20 
samples from different sample files may be 
marked and used as calibration samples. The 
calibration points can also be weighted with 
1/Amount, 1/Amount^2, 1/Response, and 
1/Response^2. The type of the weight function is 
entered together with the curve type. Dionex 
recommends using the F8 box for selecting the 
desired specifications; for example, the field value 
XXQOff stands for quadratic with offset and 
weight function 1/Amount^2. 
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Function: A series of methods, differing with respect to their 
model function and the number of coefficients, is 
available. The number of calibration samples 
needs to be at least equal to the number of 
coefficients to be determined.  

Calibration functions:  
Linear  
(Lin) 

Minimum number of standards or Spiked 
Samples: 1 
The model function is a straight line leading 
through the origin. (In Standard Addition 
calibration mode, the line leads through the 
average of all unspiked samples.) For more than 
one standard, the regression line is calculated. 
The calibration curve is based on the following 
equation: 

 Model function:  AxcAf 1)( =  
 Where A is the peak area and f(A) the calculated 

amount. 
 c1 (linear coefficient, slope) is calculated and 

stored. 
Linear with offset 
(LOff) 

Minimum number of standards or spiked 
samples: 2 
The calibration curve is a straight line, crossing 
the ordinate at a finite value. 

 Model function: AxccAf 10)( +=  
 c0 and c1 are calculated and stored. 

Quadratic 
(Quad) 

Minimum number of standards or spiked 
samples: 2 
The calibration curve is a parabola leading 
through the origin. (In Standard Addition 
calibration mode, the curve leads through the 
average of all unspiked samples.) For more than 
two calibration samples, the regression parabola 
is calculated. 

 Model function: 221)( AxcAxcAf +=  
 c1 and c2 are calculated and stored. 
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Quadratic with 
offset (QOff) 

Minimum number of standards or spiked 
samples: 3 

The calibration curve is a parabola crossing the 
ordinate at a finite value. For more than three 
calibration samples, the regression parabola is 
calculated. 

 Model function: 2210)( AxcAxccAf ++=  
 c0, c1, and c2 are calculated and stored. 

Cubic  Minimum number of standards or spiked 
samples: 3 

The calibration curve leads through the origin. (In 
Standard Addition calibration mode, the curve 
leads through the average of all unspiked 
samples.) For more than three calibration 
samples, the regression curve is calculated. 

 Model  
function: 

32 321)( xAcAxcAxcAf ++=  

 c1, c2, and c3 are calculated and stored. 

Cubic with offset 
(COff) 

Minimum number of standards or spiked 
samples: 4 

The calibration curve is a curve crossing the 
ordinate at a finite value. For more than four 
calibration samples, the regression curve is 
calculated. 

 Model  
function: 

32 3210)( xAcAxcAxccAf +++=  

 c0, c1, c2, and c3 are calculated and stored. 

Exponential 
(Exp) 

Minimum number of standards or spiked 
samples: 2 

The calibration curve presents an exponential 
function.  

 Model function: 10)( cAxcAf =  
 c0 and c1 are calculated and stored. 



1384 QNT Parameters 

Exponential 
(Exp) (Cont'd) 

The following applies to the Standard Addition 
calibration mode: 

 Model function: 10~)( cAxccAf +=  
 With:  

c~  = Expected offset value of all calibration 
points with positive amount values. 

Point-to-Point Minimum number of standards or spiked 
samples: 1 

 The calibration curve is polygon, that is, a linear 
interpolation between two calibration points. If 
there are several replicates of a calibration level, 
they are averaged before interpolation. 

Weighting:  
No Weights Default: higher weighting of higher amounts or 

signal values. 
1/Amount (X) Nearly cancels out the weighting of higher 

amounts. 
1/Amount^2 (XX) Causes over-proportional weighting of smaller 

amounts. 
1/Response (Y) Nearly cancels out the weighting of higher signal 

values. In this case, the Y-values (dependent 
signal values) of the calibration points are used 
as weight factors instead of the X-values 
(nominal amounts). 

1/Response^2 (YY) Causes over-proportional weighting of smaller 
signal values. In this case, the Y-values 
(dependent signal values) of the calibration 
points are used as weight factors instead of the 
X-values (nominal amounts). 

1/Rel.Std.Dev. (S) Weights signal values with small relative 
standard deviations more than those with large 
relative standard deviations.  

1/Rel.Std.Dev. ² (SS) Weights signal values with small relative 
standard deviations clearly more than those with 
large relative standard deviation. 
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Options: Average all response values of each 
calibration level before curve fitting averages 
the calibration level points before calculating the 
calibration curve from the average values. 
Include point (0,0) for curve fitting includes 
the origin into the calibration curve calculation for 
calibration functions with offset without forcing 
the calibration curve through the origin. 

 Tip:  All procedures are possible both, with the area 
method and the height method. Note that 
integration and calibration should fit together, 
that is, either area method in both cases, or 
height method. Only the area method can be 
substantiated by physics. 

For more information about the available calibration types, refer to Theory 
of Calibration: 

 Calibration Types (Linear) 
 Calibration Types (Non-Linear) 
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Check Derivative 
 
Location: Peak Tracking and Spectra Library Screening 

tab pages/Report Variable (Peak Table) 
Type: Selection  
Dimension: - 
Value Range: Off; 1st derivative; 2nd derivative 

Default: Off 
Related Parameters: Additional parameters for comparing spectra: 

⇒Check Extrema 
⇒Match Criterion 
⇒Maximum/Minimum Wavelength 
⇒Relative Maximum Deviation 
⇒Threshold 

Description: Comparison of two or more spectra with each 
other can be performed in three different ways 
(comparison functions): 
 
• Based on the curve shape of the spectrum 

itself  
• Based on the curve shape of the first 

derivative of the spectrum  
• Based on the curve shape of the second 

derivative of the spectrum  

Function: Comparing the curve shape of the first or second 
derivative of the spectrum is more characteristic 
(shoulders become extremes). However, the 

Signal-to-Noise Ratio decreases considerably. 
Depending on the comparison function different 
⇒Threshold values are useful. 

 Note:  Differentiating once or twice can lead to well 
matching hits, although the absorption heights of 
the original spectra differ significantly. 
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Check Extrema 
 
Location: Peak Tracking and Spectra Library Screening 

tab pages/Report Variable (Peak Table) 
Type: Selection  
Dimension: - 
Value Range: Off; On 

Default: Off 
Related Parameters: Additional parameters for comparing spectra: 

⇒Check Derivative  
⇒Match Criterion 
⇒Maximum/Minimum Wavelength 
⇒Relative Maximum Deviation 
⇒Threshold 

Description: The parameter indicates whether the spectra 
search compares the number of extrema in the 
reference spectra with the ones in the peak 
spectrum. 

 Note: If there is a high noise level (see Signal-to-
Noise Ratio), it is possible that noise peaks are 
considered extrema. In this case, Dionex 
recommends disabling the Check Extrema 
option. 
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Comment (Peak) 
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: Text  
Dimension: --- 
Value Range: All printable characters  
Default: --- 
Related Parameters: ⇒Name (Peak Name) 

Description: In addition to the peak name, further comments 
can be entered. Double-click or press the F8 key 
to open an enlarged entry field. 

 Note:  If you have generated the peak table in the QNT 
Editor via Autogenerate Peak Table, this will be 
automatically indicated in the peak table's 
Comment column: 
• If Enumerate peaks of current 

chromatogram is enabled, the comment is 
Autogenerated. 

• If Use spectra library screening results is 
enabled, the comment is Autogenerated, 
Spectrum: Name of Reference Spectrum, 
Match: Match Factor number. 
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Dead Time 
 
Location: General tab page 

Report Variable (Quantification Method) 
Type: Floating point value 

Dimension: Minutes 

Value Range: 0.000 ... 9999.999 

Default: Not chosen 

Related Parameters: ⇒Retention Time  
⇒Delay Time 
⇒Window 

Description: The dead time is defined as the time required for 
the peak maximum of an unretained substance to 
reach the detector from the point of injection. 
Thus, the dead time corresponds to the residual 
time (of all substances) in the mobile phase. 

Enter the dead time on the General tab page in 
the QNT Editor. 

Function: The adjusted retention time of a substance is 
defined as the time this substance remains in the 
stationary phase. The sum of the residual times in 
the mobile and stationary phases is the 

Retention Time: 

0' ttt SS +=  
Where: 

 St  = Retention time of a substance 

 St '  = Adjusted retention time of a substance 

 0t  = Dead time 

 The dead time is required to calculate the 
Capacity Factors and the ⇒Kovats Indexes.  



1390 QNT Parameters 

Delay Time  
 

Location: General tab page 
Report Variable (Quantification Method) 

Type: Floating point value 

Dimension: Minutes 

Value Range: -9999.999 ... 9999.999 

Default: Not selected 

Related Parameters: ⇒Dead Time 

⇒Retention Time 

Description: The time required for a substance to travel from 
the detector cell of one detector to the detector 
cell of a second detector is referred to as Delay 
Time.  

Function: Usually, a constant ⇒Flow is used. With 
constant flow, the delay time between two 
detectors is constant as well. In this case, it can 
be measured and entered on the General tab 
page in the QNT Editor (see The QNT Editor 

 The General Tab Page). Verify that a 
second detector (or channel) is specified in the 
Detector name field. Otherwise, you cannot 
enter a delay time. 

The entered delay times can be positive or 
negative, depending on whether the detector 
directly following the column or any other 
detector is defined as 2nd detector. 

 Note: Entering a delay time for Flow Gradients does 
not make sense because the delay is not 
constant in this case. Follow the description in 
How to …: Integrating Chromatograms and 
Identifying Peaks  Defining the QNT 
Method for Several Detectors. 



 QNT Parameters 1391 

Dimension of Amounts 
 
Location: General tab page 

Report Variable (Peak Table) 
Type: String 

Dimension: --- 
Value Range: All printable characters 

Default: --- 
Related Parameters: ⇒Amount 

Description: The Dimension of Amounts parameter defines 
the physical dimension of the amount values. 
This is usually an amount dimension, but you 
may select a concentration dimension, instead. 

Function: The chosen dimension is entered in the column 
header of the amount column of the report table. 
It is only relevant to the documentation of results 
and has no influence on the calculation 
algorithms. 

 Tips:  Consistency of dimensions is entirely up to the 
user. If weight was read as g, do not enter mg 
here. There will be no automatic conversion!  
For the calculation of the concentration in the 
report or the printer layout, Chromeleon 
presumes that a dimension of amount was 
chosen. If a dimension of concentration was 
entered as Dimension of Amounts, this 
calculation does not make sense. 
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Group (Peak Group) 
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: String 

Dimension: --- 
Value Range: All printable characters 

Default: --- 
Related Parameters: ⇒Peak Group Start/End 

⇒Integration Type  
⇒Calibration Type 

Description: Peaks may be grouped and then be calibrated 
and integrated together. You may assign the 
group any name, whilst it is recommended to use 
the name of the group's most "important" 
member. The members must not necessarily 
succeed one another. 

(If you wish to group peaks that lie close together, 
use the Peak Group Start and Peak Group End 
detection parameters (on the Detection tab page 
of the QNT Editor). 

Function: During calibration (not during peak detection), the 
peak group is treated as one non-resolved peak: 
The calibration constants of the amount value 
and the area sum of all peaks being part of the 
group are calculated. The calibration curve, 
therefore, is identical for all peaks. 

 During integration, the amount/concentration 
values for each peak are calculated individually 
for each peak from its area and calibration 
constants. 

 Tip:  The Integration and Calibration types must be 
identical for all peaks within a peak group. 

 
Also, refer to How to …: Integrating Chromatograms and Identifying 
Peaks  Grouping Peaks. 



 QNT Parameters 1393 

Integration Type 
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: Selection 

Dimension: No dimension 

Value Range: Area/Height/Relative Area/Relative Height/ 
CE Area 

Can be combined with: All peaks, identified Peaks only/Exclude ISTD 
peaks (only with Relative Area/Relative Height) 

Default: Area 

Related Parameters: ⇒Calibration Type 
⇒Group 

Description: Indicates the peak property to be used for the 
calculation of quantitative results. Different Area 
and height methods are the alternatives. 

Functions:  

Area Peak area integration.  
 All amount calculations refer to the peak area 

which itself is calculated numerically according to 
the trapezoidal method. Area delimiters in this 
case, consist of chromatogram, baseline and, if 
necessary, perpendiculars in order to exclude 
adjacent non-resolved peaks. In case of Riders, 
an appropriate skimming tangent substitutes the 
baseline. 

Height Peak height integration. 
 All amounts refer to the peak height; that is, to the 

height of the peak maximum as related to the 
baseline. 
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Relative Area Relative peak area integration. The area can be 
chosen relative to the area of  
• All peaks or 

• Identified peaks only 

In both cases, the internal standard(s) may be 
excluded (Exclude ISTD peaks). 

Relative Height Relative peak height integration. Reference 
corresponding to the relative peak area 
integration is possible.  

CE Area Integration type for capillary electrophoresis 

CE-Area = Area / Ret. Time in [mAU]) 

 Tips:  Integration and calibration always require the 
same method! 

 All peaks of a Group require the same method. 

 Only the area methods can be substantiated by 
physics. 



 QNT Parameters 1395 

Kovats Index  
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: Integer 
Dimension: No dimension 

Value Range: 0 ... 999.999  
Default: - 
Related Parameters: ⇒Retention Time 

⇒Dead Time 

Description: Data exchange between laboratories for 
substance identification based on relative 
retention times is not exact. Therefore, especially 
in gas chromatography, retention indexes are 
used. They use a series of chemically similar 
standard substances to achieve uniform scaling 
of the Retention Time. 

Advantage is taken of the fact that within a 
homologous series of compounds the logarithms 
of the adjusted retention times are proportional to 
the number of carbon atoms (adiabatic and 
isothermal conditions presumed). The most 
frequently used Kovats Index is defined as 
follows: 

]'log'[log
]'log'[log
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Where: 

 KI = Kovats index 
 St '  = Adjusted retention time with 0' ttt SS +=  
 St  = Retention time 

 0t  = Dead time 
 n = Number of carbon atoms  

   (normally of n-alcane) 
 S = Substance of interest 
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 The following must be true: 

1+<< nSn ttt  
Function: As the Kovats indexes for the markers are freely 

selectable the following formula is used for the 
calculation: 
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With KI = Kovats index (usually KI  = 100 * n is 
entered) and 

z = number of the marker peak. 

If no marker peaks or no dead time is determined, 
the Kovats index is not defined (n.a.). In addition, 
the Kovats index is not defined for any peaks that 
occur before the first and behind the last marker 
peaks. For more information about how to enter 
marker peaks and dead time, refer to How to …: 
Integrating Chromatograms and Identifying 
Peaks  Defining the Retention Index and the 
Kovats Index. 

 Note:  In Chromeleon, the substances of interest must 
be between two marker peaks. 
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Left/Right Limit 
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: Fixed point number 
Dimension: Minutes 

Value Range: 0 ... 999.999 [min] 
Default: 0 (no function) 
Related Parameters: ⇒Retention Time 

Description: Normally, peak integration is performed 
automatically. It is possible to limit or extend 
integration on the left, right, or on both sides with 
the appropriate peak table parameters. This may 
be done in the peak table via a left and/or a right 
limit. 

Function: The peak is integrated between left and right limit, 
that is, between:  

 t - LL   ...  t + RL 
 Where: 
 t = Retention Time 
 LL = Left Limit 
 RL = Right Limit. 
 The value 0 disables the limitation. 

Example 1:  
For the right and left integration limits, the value 
0.5 min is entered. The peak maximum is at the 
retention time of 8 min. The peak is integrated 
from 7 min 30 s to 8 min 30 s. 
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 Note:  The LL and RL limits can also be 
enabled/disabled independently. 
Example 2:  
For the left integration limit, the value 0.5 min is 
entered. For the right integration limit, the value 0 
is entered. As before, the peak maximum is at the 
retention time of 8 min. The peak is integrated 
from 7 min 30 s. The end of integration is 
automatically determined then.  
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Match Criterion 
 
Location: Peak Table and Spectra Library Screening tab 

pages/ Report Variable (Peak Table) 
Type: Selection  
Dimension: No dimension 

Value Range: Least Square, Weighted Least Square, or 
Correlation 

Default: Least Square 

Related Parameters: Additional parameters for comparing spectra: 
⇒Check Derivative  
⇒Check Extrema 
⇒Maximum/Minimum Wavelength 
⇒Relative Maximum Deviation 
⇒Threshold 

Description: The match criterion defines the mathematical 
method with which two standardized spectra are 
compared with each other.  

Function: The signal deviation, that is, the difference 
between the UV spectrum and a reference 
spectrum at defined wavelength, is checked (λ1, 
λ 2, ...). Since the square of the deviations is 
calculated as well, the direction of the subtraction 
does not matter. 
 

200 350 [nm]
0

100 [%]
UV spectrum

comparison spectrum

∆1
∆2

∆...
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Function: 
(Cont'd) 

The method provides a value of similarity (match) 
between completely different (= 0) and identical 
(= 1000).  

The following mathematical methods are 
available in Chromeleon: 

Least Square: Forms the sum of the squared signal deviations 
at each wavelength and determines the average 
square deviation between two spectra (standard 
method) 

Weighted Least  
Square: 

Analogue to Least Square; the squared 
deviations are weighted by the signal height (for 
spectra extracted close to the detection limit). 

Correlation: Usual match criterion in statistics if a linear 
correlation between two curves is presumed 
(similar to Least Square; usually provides the 
same result). 
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Maximum/Minimum Wavelength 
 
Location: Peak Tracking and Spectra Library Screening 

tab pages/Report Variable (Peak Table) 
Type: Floating point number 
Dimension: nm 

Value Range: Auto;  190.0 - 900.0 nm 

Default: Auto 

Related Parameters: Additional parameters for comparing spectra: 
⇒Check Derivative  
⇒Check Extrema 
⇒Match Criterion 
⇒Relative Maximum Deviation 
⇒Threshold 

Description: The Maximum Wavelength (Max. WL) and 
Minimum Wavelength (Min. WL) columns allow 
you to enter the upper and lower wavelength 
limits for spectra screening. In case of Auto, the 
respective limits will not be considered. 

 Note:  The value entered here has no significance for 
any currently displayed peak spectrum. 



1402 QNT Parameters 

Name (Peak Name) 
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: String 

Dimension: no dimension 

Value Range: All printable characters 

Default: With automatic table generation: <Name of the 
QNT Method>x, where x is the current peak 
number. 
When appending a new cell: Peak-x 

Description: In this column, you may enter the chemical name 
of the substance that created the peak at the time 
t. (The default is used with auto-generated peaks, 
only.) 

Function: The substance name is taken for the report and 
the Printer Layout. 

 Note:  Only use letters, numbers, and punctuation 
marks, since the complete MS-DOS character set 
is not available on all printers. 
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Reference Spectrum 
 
Location: Peak Tracking tab page 

Report Variable (Peak Table) 
Type: Selection 

Dimension: No dimension 

Value Range: --- 
Default: Empty 

Related Parameters: ⇒Window 

Description: Reference spectra are used for substance 
identification. A reference spectrum can be 
chosen for each peak. Such spectra are acquired 
with the Chromeleon DAD license.  

Identifying peaks by means of peak tracking can 
be enabled via input in the Window column. In 
the corresponding F8 dialog box (press the F8 
key or double-click the Window column), select 
the Spectrum or Spectrum and time option of 
the Peak Match group. 

Function: Peak tracking is performed (limited to the 
specified time window in the case of Spectrum 
and time) using the reference spectra in the 
corresponding column. (For more information, 
refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Peak Tracking.) 

 Tip:  Spectra acquisition is possible with the DAD 
license only. 
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Relative Maximum Deviation 
 
Location: Peak Tracking and Spectra Library Screening 

tab pages/Report Variable (Peak Table) 
Type: Floating point number 
Dimension: nm 

Value Range: Off; 0.0-100.0 nm 

Default: Off 
Related Parameters: Additional parameters for comparing spectra: 

⇒Check Derivative 
⇒Check Extrema 
⇒Match Criterion 
⇒Maximum/Minimum Wavelength 
⇒Threshold 

Description: The Relative Maximum Deviation column allows 
you to enter the maximum permissible deviation 
of the wavelength maxima of the reference 
spectra from the maximum of the current peak 
spectrum. 

Function: If the setting is Off, deviation is not checked.  
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Response Factor 
 
Location: Peak Table tag page 

Report Variable (Peak Table) 
Type: Floating point number 
Dimension: --- 
Value Range: 0.000000 ... 9999999.999999 

Default: 1.000000 

Related Parameters: ⇒Weight (Sample Weight Factor) 
⇒Dil. Factor (dilution factor) 

Description: The response factor is a peak-specific 
dimensionless, multiplicative factor, used to 
compensate for absorption differences in the 
case of differing wavelengths.  

Function:  

Absolute Select Absolute to correct the amount value 
received from the peak area via the Formula for 
Amount Calculation by the entered factor. In this 
way, for example, absorption differences at 
different wavelengths can be compensated. 
Besides, losses of readily volatile samples can 
thus be considered in the calculation (especially 
common in gas chromatography). 

Relative To Peak Select Relative To Peak for calculating the peak 
in relation to a reference peak. As reference 
peak, all identified peaks with absolute response 
factor can be used. The basis of the evaluation is 
the calibration curve of the selected reference 
peak. The amount value calculated in this way is 
multiplied by the reciprocal value of the relative 
response factor and thus corrected. 
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Relative To Peak 
(Cont'd) 

Example: Relative to Peak 
Under certain conditions, an active agent in a 
tablet decomposes into various products. As 
standards for these products are difficult to 
produce or very expensive, the active agent and 
the decomposition products are calibrated; for 
example, once a year.  

If the active agent and the decomposition 
products are calibrated via the linear without 
offset function, there is a direct correlation 
between the slope of the active agent calibration 
curve and the calibration curves of the individual 
decomposition products. This proportionality 
between the calibration coefficient c1 of the active 
agent and that of the decomposition product is 
expressed as the Response Factor and must be 
determined by the user. 

Should the active agent and/or the decomposition 
product be determined in an analysis, the existing 
calibration and the Response Factor determined 
for each decomposition product is used. The 
factors are entered as relative values (Response 
Factor column) in the peak table; that is, the 
active agent in the tablet is used as the reference 
peak. 

Calculating the amount values of all 
decomposition products is according to the 
calibration coefficients of the active agent, 
corrected by the Response Factor. 

 Note: The response factor is peak-specific.  
In contrast to this, the Sample Weight and the 
Dilution Factor of the sequence are sample 
specific; that is, they apply to all peaks. 
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Retention Index  
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: Integer 
Dimension: No dimension 

Value Range: 0 - 999.999  
Default: - 
Related Parameters: ⇒Retention Time 

⇒Dead Time  
⇒Kovats Index 

Description: Retention indexes are used to facilitate positive 
assignment of substances in inter-laboratory data 
exchange. For programmed GC as well as for 
HPLC linear retention indexes are defined.  

Function: Chromeleon calculates the following linear 
retention index: 
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Wherein:  

RI: Retention index  
     (usually RI = 100, 200, 300 is entered) 

S: Substance 

Z: number of the marker 

The following is true: 

1+<< ZSZ ttt  
If the peak occurs before the first maker peak, the 
following formula is used: 

RI (x)   =   RI(1)  *  [t(x)  /  t(1)] 
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Function: 
(Cont'd) 

If the peak occurs behind the last marker peak, 
the following formula is used: 

RI (x)   =   RI(last)  *  [t(x)  /  t(last)] 

For information how to determine marker peaks, 
refer to How to …: Integrating Chromatograms 
and Identifying Peaks  Defining the 
Retention Index and the Kovats Index. 
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Retention Time 
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: Floating point value 

Dimension: Minutes 

Value Range: 0.000 ... 9999.999 

Default: 0.000 
With Autogenerate Peak Table, the retention 
time of the active chromatogram is used. 

Can be combined with: Absolute time; Time distance/ratio to 
reference peak; Reference peak 

Related Parameters: ⇒Window 
⇒Use Recently Detected Retention Times 
⇒Dead Time 

Description: The retention time is used for peak identification. 
The Retention Time variable refers to the time 
(in minutes) that passed since the injection 
(also, refer to ⇒Dead Time).  

By definition, the injection time always equals 
zero. Therefore, control commands issued 
before this time will have negative times. The 
advantage is that the times stated in the PGM 
File (file type .PGM) are compatible with the 
retention times, rather than being delayed by the 
injection time. 

Peak retention times are generally interpreted as 
time between injection and peak maximum. 
However, indication of the distance to a 
reference peak is possible as well. As the 
reference peak does not need to be at the 
beginning of the chromatogram, such difference 
retention times can also have negative values. 
Relative retention times are time quotients in 
percent as to a reference peak.  
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Function: On the page Peak Table in the QNT Editor, the 
retention time can be entered either manually by 
the user or automatically by the system. The 
latter is possible via the Autogenerate Peak 
Table command on the Edit or context menus. 

The user enters the expected retention time, 
while the system enters the actually detected 
retention time of the actually analyzed sample.  

Interpretation Input in the Retention Time for Peak X dialog 
box (to be opened via F8 or by double-clicking in 
the Ret. Time column) 

Absolute time Select Absolute time [min] to display the 
retention times as usual (time period between 
injection and peak maximum). 

Time distance to 
reference peak 
[min] 

Select Time distance to reference peak [min] 
to express the time difference to the reference 
peak in minutes. All peak lines apart from the 
reference peak line display time differences in 
the time column. 

Time ratio to 
reference peak [%] 

Select Time ratio to reference peak [%] to 
express the retention time relatively to the 
reference peak in % values. The retention times 
are indicated as time ratio (percent) to the 
reference peak. All peak lines apart from the 
reference peak line display the time ratios to the 
reference peak in percent. 

Reference peak Select a peak from the peaks listed in the 
selection box. The reference peak line in the 
peak table is highlighted in light blue. It always 
displays the absolute retention time! 

 Note:  If the Use Recently Detected Retention Time 
option (retention time correction) is enabled in 
the peak table, the retention times entered 
manually on the page Peak Table are no longer 
used as nominal retention times for all identified 
peaks. Instead, the values detected for the 
previously analyzed sample (its nominal times) 
are used. Distinguish between: 
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 Note: 
(Cont'd) 

• The originally expected retention time that 
was entered on the Peak Table tab page. 

• The nominal retention time which, in this 
case, corresponds to the actual retention 
time of the previously analyzed sample. 

• The actual retention time of the actually 
analyzed sample. 

⇒Retention Windows are also interpreted as 
percentage value of the absolute retention time 
for both, difference, and relative retention times! 
Only the retention times of identified peaks are 
corrected! 

In the Peak Table, you can toggle the three 
options. The retention time column is 
automatically re-calculated. 
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Standard 
 

Location: Peak Table tab page 
Report Variable (Peak Table) 

Type: String 

Dimension: --- 
Value Range: External; Internal; Internal/External; Use this 

peak as internal Standard 

Default: External 
Can be combined with: Use sample amount as reference (only with Use 

this peak as internal Standard) 
Related Parameter: ⇒Amount 

Description: The Standard parameter indicates the standard 
method to be used for calibration. For a detailed 
description including numerical examples, refer to 
How to …:  Calibrating. 

Function:  

External  The calibration curve determines the area/amount 
ratio. During calibration, the calibration coefficients 
are calculated from mixtures of known 
components (see Calibration Function and 
Theory of Calibration  Standard Methods). 

Internal  Calibration corresponds to the External Standard 
method. In addition, an Internal Standard is 
added. The internal standard itself is calibrated as 
all other peaks. When performing the integration, 
the calculated amounts of the remaining peaks 
are corrected by the nominal/actual ratio of the 
internal standard. 

Chromeleon recognizes any number of internal 
standards. Theoretically, each peak may have its 
own internal standard! Furthermore, the standard 
method may be selected for each peak 
individually.  
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Internal  
(Cont'd) 

During calibration, the amount ratio (instead of 
amount against area) is given in the diagram with 
regard to the respective peak. From these data 
points, the calibration function is calculated. 

 During integration also, the area ratio is inserted 
into the stored calibration function and the amount 
ratio is calculated. 

 Tip:  
Before you can use this option, at least one 
internal standard must be defined (see Use this 
peak as internal Standard). Select an ISTD peak 
in the Associated ISTD Peak check box. 

 Entering Several Internal Standards 

It is also possible to define several internal 
standards. Via the F8 box, define the respective 
peaks of the peak table in the Standard column of 
the peak table as ISTD peaks. A yellow 
background will highlight the corresponding line of 
the peak table. For the remaining peaks, enter the 
standard method to be used (external, 
internal/external, internal). If this should be 
performed in relation to an ISTD peak, it is 
possible to choose between the previously defined 
ISTD peaks. 

Internal/External When calibrating with an internal standard, 
calculation is with area and amount ratios instead 
of absolute areas and amounts. During 
integration, the area ratio is inserted into the 
saved calibration function to calculate the amount 
ratio. The result is the amount in relation to its 
reference peak. Each peak can have its own 
internal standard. 

Calibration does not vary from the external 
standard method, except for a defined peak (that 
is, internal standard) being added to the analyses. 
The internal standard is calibrated as all other 
peaks. During integration, the calculated amounts 
of the other peaks are corrected according to the 
relation of the internal standard to the actual peak. 
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Internal/External 
(Cont'd) 

 Tip:  

Before you can use this option, at least one 
internal standard must be defined as well (see 
Use this peak as internal Standard). Select an 
ISTD peak in the Associated ISTD Peak check 
box. 

Use this peak as 
Internal Standard 

Select this option to define the current peak as 
ISTD peak. Select the Use sample amount as 
reference check box to use the amount of the 
internal standard from the ISTD amount column of 
the sample list instead of the Amount columns of 
the QNT peak table. In this way, you can enter a 
different amount of internal standard for each 
sample. 

 Tips: 

 

For internal standard as well as internal/external 
standard methods, a substance whose 
concentration is known, must be added to the 
standards and to the analyses. This can be 
conveniently carried out by means of an 
appropriate Autosampler. Quantitative accuracy 
reached with this method, exceeds that of the 
external standard method by one dimension. 
For these two options, the name of the internal 
standard must be indicated. 

 Internal standard methods compensate even 
small injections deviations, since possible loss or 
excess apply to the internal standard as well. 
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Threshold  
 
Location: Peak Tracking and Spectra Library Screening 

tab pages/Report Variable (Peak Table) 
Type: Integer 
Dimension: No dimension 

Value Range: 0 - 1000 

Default: 950 

Related Parameters: Additional parameters for comparing spectra: 
⇒Check Derivative 
⇒Check Extrema 
⇒Match Criterion 
⇒Maximum/Minimum Wavelength 
⇒Relative Maximum Deviation 
⇒Threshold 

Description: This parameter defines the threshold of the 
Match Factor above which two spectra may be 

accepted as matching. 

Function: Depending on the comparison function the 
following settings can usually be recommended: 

Spectrum (Off):  950 

1st derivative:  900 

2nd derivative:  800 
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Type (Peak Type) 
 
Location: Peak Table tab page 

(Peak Table) Report Variable  
Type: Alternatives 

Dimension: No dimension 

Value Range: Autodetect (Auto)/Rider (R)/Main (M)/Baseline-
Main (B-M)/Main-Baseline (M-B)/Baseline-
Main-Baseline (B-M-B) 

Default: Autodetect 
Related Parameters: ⇒Rider Threshold 

⇒Maximum Rider Ratio 
⇒Valley to Valley  
⇒Lock Baseline 

Description: The Type parameter determines the type of 
baseline contact and the separation of other, non-
resolved peaks. An integration program algorithm 
usually defines the peak type. You can also 
change the peak type as desired, using the 
detection parameters (see How to …: 
Integrating Chromatograms and Identifying 
Peaks  Modifying Detection Parameters). To 
determine the peak type regardless of other 
factors, this should be done in the peak table. 
Type specifications of the peak table have 
priority. 

Functions:  

Autodetect (Auto) The peak type is determined via an algorithm, or 
via detection parameters. 

Determine at 
Calibration 

Not yet implemented  
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Rider (R)/Main (M) The peak is integrated as rider or main peak 
without baseline contact. This, of course, applies 
to non-resolved peaks, only. 
In the case of rider peaks, an additional 
distinction is made between peaks on the leading 
edge (u = up) and peaks on the trailing edge (d = 
down). Of course, this does not affect the type of 
baseline contact of the reference peak. 

 Note:  
Chromeleon does not consider rider peaks when 
calculating the Optimum Integration Path. 

Baseline-Main(B-M)/ 
Main-Baseline(M-B)/ 
Baseline-Main-
Baseline  
(M-B-M) 

The peak is integrated as main peak with left, 
right, or bilateral baseline contact. A further 
distinction between b and B is made in the report: 
If a main peak has direct baseline contact on the 
left and/or right side, this is, indicated by a capital 
B. If the baseline below non-resolved peaks is 
drawn from minimum to minimum (⇒Valley to 
Valley), that is, from peak end to peak end, this 
type of baseline contact is characterized by a 
small b. 

BMB BMBBMBM bMb

MB
RdRu

bMBBMbBM

 

 Note:  The peak type determined here can only be 
realized with non-resolved peaks. For resolved 
peaks, peak type is always Baseline-Main-
Baseline. 
The distinction between b and B is made only in 
the report output. The baseline is checked 
automatically. Then, the baseline contact is 
determined. In the peak table, the classification is 
always B. 
The peak type that is defined in the peak table 
has priority over the type assignments of the 
Rider Threshold and Maximum Rider Ratio 
detection parameters.  
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Use Recently Detected Retention Time 
 
Location: General tab page 

Use Prev. Retention Time (Peak Table) Report 
Variable  

Type: Check-box 

Dimension: --- 
Value Ranges: Marked/not marked 

Use recently detected ret. times of last 
sample/standard 
Set reference time to Last value/Average of 
last n values/Global average 

Defaults: Not marked 
Last sample 
Last value 

Related Parameters: ⇒Retention Time 
⇒Window 

Description: This QNT File parameter (General tab page) 
defines whether the retention time stored in the 
peak table (nominal time) is used by default to 
identify a peak or whether the actual retention 
time of a peak in the last sample is used. Thus, 
many types of drift phenomena can be 
compensated; for example, evaporation of volatile 
components in pre-mixed solvents or column age.  

If the peak is not found in this sample, the 
chronologically previous sample in the sequence 
is searched, etc. (The chronological order is 
important and not the order in the sample list.) 

If you have chosen this option, you may select 
whether you want to use the retention times of the 
last unknown sample (Sample) or of the last 
Standard. 
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Description: 
(Cont'd) 

Click Options to define whether you want to use 
the last retention time (Last value), the average 
of the last x retention times (Average of last x 
values), or the average of all retention times 
(Global average). 

Function: If the Use Recently Detected Ret.Time check 
box is selected, Chromeleon always stores the 
last actual retention time of the peak and positions 
the Window specified in the peak table around 
this actual value, not around the nominal value 
stated in the peak table.  

This allows positive identification of peaks even if 
the retention time changes due to column trends, 
and thus, if the peak leaves the defined retention 
time window.  

Example: The first sample of a sequence containing 10 
samples is processed in an automatic batch. 
Based on the retention times stated in the peak 
table and the selected window values; for 
example, 0.2G, four peaks are identified in the 
first sample (A, B, C, and D). Each one of these 
peaks may have an actual retention time that 
deviates from the nominal retention time. 
Chromeleon stores these actual values and uses 
them as the basis for positioning the time window 
in the second sample. If single peaks are then 
identified in the second sample, the "stored" 
actual values are replaced by the current actual 
values. The time window is repositioned 
accordingly. If, for example, the retention time of 
peak A from the first sample (1 min) is delayed by 
10 s in each sample, the peak will be appear at 
1 min + 9 x 10 s = 150 s or 2.5 min in the tenth 
sample. As the time window is also moved by 10 s 
with each sample, peak A can be clearly identified 
in the tenth sample, although the peak is no 
longer within the originally specified time window 
(48 s to 1 min 12 s). 

 Note:  Only retention times of identified peaks are 
corrected! 
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Window (Retention Window) 
 
Location: Peak Table tab page 

Report Variable (Peak Table) 
Type: Positive floating point number or string  
Dimension: Minutes or % 

Value Range: 0.000 ... 999.999 or 0 - 100% 
 Absolute/Relative and  

First/Greatest/Nearest/Spectrum/Spectrum 
and time 

Default: Autogenerate Peak Table: A third of the 
distance to the preceding or the succeeding peak 
depending on which distance is smaller 
Else: 0.100 min or % 

 Absolute Greatest 
Can be combined with: Check the best hits only (with the peak match 

options Spectrum and Spectrum and Time only) 
Related Parameters: ⇒Retention Time 

Description: The Window parameter defines a tolerance 
interval within which the peak is expected. The 
start and end times of the retention window result 
from adding the window value to and subtracting 
it from the retention time (retention time +/- 
window value); that is, the window width is always 
twice as wide as your input. A peak outside this 
window is not identified. The window value 
defined here is either interpreted as absolute 
(minutes) or relative (percentage) value by the 
integration programs. For each peak, the 
interpretation can be individually specified, by 
adding a suffix to the window time.  
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Function: The dimension W of the time windows is 
calculated according to the following formula: 

 Absolute time window: W = TW 
 Relative time window: W = T x TW / 100 
 Where T is the retention time of the table and TW 

the entered window value. All peaks whose 
maximum falls into the time interval T+W belong 
to the time window. 

Function of the suffixes: 
• Select Absolute or add a capital A to the window value to indicate the 

window width in minutes. 

• Select Relative or add a capital R to the window value to indicate the 
window width relative to the retention time. 

If a peak is registered within this window, it is assigned the peak name 
entered in the peak table. If several peaks are located in the same window, 
the window parameter can be extended to determine which peak is 
identified: 
• Select First to identify the first peak within the window (F). 

• Select Greatest to identify the largest peak within the window (G). 

• Select Nearest to identify the peak nearest to the specified retention 
time (N). 

• Select Spectrum to identify a peak by a spectrum. The reference 
spectrum is specified in the Spectrum column of the peak table (S).  

• Select Spectrum and time to identify a peak within a specific window 
width by a spectrum. The reference spectrum is specified in the 
Reference Spectrum column of the peak table (ST). 

Via the Check the best hits only option, Spectrum and Spectrum and 
time allow you to check the hits with the largest Match Factors for the 
respective peaks only (= check box selected, default). The abbreviation for 
this is B (SB or STB). 

If you have MS options installed, you can also enable the Check mass 
ratios option to check whether the masses indicated on the Mass 
Tracking tab page are found in the defined ratio range.  



1422 QNT Parameters 

Examples: Window Values: 0.2 AF / 0.2 AG / = 0.2 AN 
If the expected retention time of the peak is 
Ret.Time = 5.0min and the window value is 0.2 A, 
the time window is 5.0min +/-
 0.2min = 4min 48sec to 5min 12sec. By adding 
the suffix F, the first peak in the time window, by 
adding the suffix G, the greatest peak in the 
window, and by adding the suffix N, the peak 
nearest to the expected retention time is 
assigned. 

Window Values: 10 RF / 10 RG 
If the expected retention time of the peak is 
Ret.Time = 5.0min and the window value is 10 R, 
the time window has the range 5.0 min ± 10% = 
5 min ± 0.5 min = 4 min 30 s to 5min 30 s. By 
adding the suffix F, the first peak in the time 
window, by adding the suffix G, the largest peak 
in the window is assigned. 

 Note:  The absolute time interval of the window is twice 
as wide as the window value entered, since the 
interval reaches from T-W to T+W! 
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Detection Parameters 

Detection Parameters (Overview) 
Chromeleon supports the following detection parameters: 

⇒Baseline Point 
⇒Detect Negative Peaks 
⇒Front Riders to Main Peaks 
⇒Inhibit Integration 
⇒Lock Baseline 
⇒Maximum Area Reject 
⇒Maximum Height Reject 
⇒Maximum Peak Height 
⇒Maximum Rider Ratio 
⇒Maximum Width 
⇒Minimum Area 
⇒Minimum Height 
⇒Minimum Width 
⇒Peak Group Start/End 
⇒Peak Purity Start/End Wavelength  (PWlStart/PPWIEnd) 
⇒Peak Purity Threshold (PPTrshold) 
⇒Peak Shoulder Threshold 
⇒Peak Slice 
⇒Rider Skimming 
⇒Rider Threshold 
⇒Sensitivity 
⇒Tailing/Fronting Sensitivity Factor 
⇒Valley to Valley 
⇒Void Volume Treatment  
 
For more information about how to define detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Baseline Point 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Command 

Dimension: --- 
Value Range: --- 
Default: --- 
Related Parameters: ⇒Lock Baseline 

⇒Valley to Valley 
⇒Inhibit Integration 
⇒Type (Peak Type) 

Description: The Baseline Point detection parameter defines 
a baseline point at the indicated time. 

 Tips:  When setting a baseline point, keep in mind that 
this point will be valid for all chromatograms that 
are evaluated with the respective QNT Method. If 
in one of these chromatograms a peak maximum 
occurs by coincidence at the time of your hard 
entered baseline point, the peak maximum will be 
defined as base point and the peak will not be 
detected. 
This command has priority over ⇒Lock Baseline 
and ⇒Valley to Valley, but not over ⇒Type (Peak 
Type) from the peak table. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Detect Negative Peaks 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Switch 

Dimension: --- 
Value Range: On; Off 
Default: Off; that is, negative peaks are not detected. 

Description: The Detect Negative Peaks parameter enables 
and disables detection of negative peaks. When 
the parameter is enabled, negative as well as 
positive peaks are detected. 

Function: Enabling detection of negative peaks 
automatically enables the ⇒Lock Baseline  
parameter. Disabling negative peak detection 
locks the baseline to the default again. In the 
result report, the area of negative peaks is 
indicated as a positive value.  

To correct the baseline without labeling the peaks 
or including peaks in the peak list, select the 
Don't label option. 

 Tip:  In order to be effective, this switch must be 
activated before the peak start. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Front Riders to Main Peaks 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Selection 

Dimension: - 
Value Range: Off, On 

Default: Off 
Related Parameters: ⇒Rider Threshold 

⇒Maximum Rider Ratio 
⇒Type (Peak Type) 

Description: Select the Front Riders to Main Peaks detection 
parameter to change rider peaks on the leading 
edge of a peak into main peaks. 

Function: Set the parameter value to On to change upward 
riders to main peaks even if riders are enforced; 
for example, ⇒Rider Threshold = 0.00%, 
⇒Maximum Rider Ratio = 100.0%). 

 Tip:  This parameter has priority over the Rider peak 
type in the peak table (see Rider). 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Inhibit Integration 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Switch 

Dimension: --- 
Value Range: On; Off 
Default: Off 
Description: The Inhibit Integration detection parameter 

serves to fade out certain chromatogram areas. 
When set, peak detection is disabled. 

Function: If the value is set to On before the first peak to 
inhibit, peak detection will not take place until the 
parameter is disabled (Off); that is, no peaks are 
recognized in this area. The chromatogram is 
displayed on screen, but it is not integrated.  

Inhibit Integration can be used to inhibit the 
injection peak by activating the criterion at the 
start time of the chromatogram and by 
deactivating it after the dead time.  

 Tip:  To have any effect, set this parameter before the 
first peak to be inhibited starts. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Lock Baseline 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Alternatives 

Dimension: --- 
Value Range: Off; On; At current level / 
 At global minimum 

Default: No 

Related Parameters: ⇒Valley to Valley 
⇒Inhibit Integration 
⇒Baseline Point 
⇒Type (Peak Type) 

Description: If the Lock Baseline parameter is set to Off, the 
detection program calculates the baseline below 
non-resolved peaks according to a complex 
pattern recognition process. The other values are 
used to lock the baseline on different levels. 

Function:  

Off Under non-resolved peaks, the baseline is 
determined automatically. The Valley-to-Valley 
parameter is effective in this mode, only. With all 
other lock-values, lock baseline has priority, while 
valley-to-valley is ignored. 

On In case of non-resolved peaks, the baseline is 
not pulled up to the relative minima (valleys). The 
baseline connects the start of the first with the 
end of the last non-resolved peak. 

If one of the valleys in between is located below 
the baseline, the baseline is connected with this 
minimum to avoid cutting off a peak foot. The 
Valley-to-Valley parameter is not effective. 

At current level The baseline is fixed at the current signal level 
and is extrapolated horizontally to the right. The 
Valley-to-Valley parameter will not take effect. 
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At global minimum Chromeleon searches to the right for the next 
absolute minimum. The search is performed 
either to the end of the chromatogram or to the 
next Lock Baseline. Within this interval, the 
baseline is locked on the found minimum and is 
horizontal. The Valley-to-Valley parameter is not 
effective.  

 Tips:  The end of the last non-resolved peak in a series 
of peaks is always a baseline point, since the 
chromatogram itself forms the baseline outside 
the peak! 

 Lock baseline needs to be disabled, before 
switching from At global minimum to another 
lock baseline value.  

 The classification criterion ⇒Type (Peak Type) in 
the peak table has priority. The criterion specified 
here is effective only for Peak Type = AUTO! 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Maximum Area Reject 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Signal dimension ∗ Minute 

Value Range: 0.000 ... 1,000,000.000 

Default: The default setting is Off; i.e., all peaks are 
integrated. 

Related Parameters: ⇒Minimum Area 
⇒Maximum Height Reject  

Description: Select the Maximum Area Reject parameter to 
limit the number of integrated peaks. This 
parameter is very similar to ⇒Minimum Area. 

Function: The parameter defines the maximum peak area 
up to which a peak is rejected. No peaks with a 
peak area below the defined value are integrated. 

 Tip:  Contrary to the Minimum Area the Maximum 
Area Reject parameter does not affect the 
baseline course. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Maximum Height Reject 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Signal dimension, such as mAU 

Value Range: 0.000 ... 1,000,000.000 

Default: The default setting is Off; i.e., all peaks are 
integrated. 

Related Parameters: ⇒Minimum Height 

⇒Maximum Peak Height 

⇒Maximum Area Reject 

Description: Select the Maximum Height Reject parameter to 
limit the number of integrated peaks. This 
parameter is very similar to ⇒Minimum Height. 

Function: The parameter defines the maximum peak height 
up to which a peak is rejected. Not all peaks with 
a peak height below the defined value are 
integrated. (Determination of the height is always 
relatively to the baseline.) 

 Tip:  Contrary to Minimum Height, the Maximum 
Height Reject parameter does not affect the 
baseline course. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Maximum Peak Height (MaxHght) 
  
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Signal dimension, such as mAU 

Value Range: Off; 0.000 ... 1,000,000.000 

Default: The default setting is Off; that is, all peaks are 
integrated. 

Related Parameters: ⇒Minimum Height 
⇒Maximum Area Reject 

Description: Positive peak identification is performed using the 
⇒Minimum Height parameter. All peaks above 
this height value are identified. The Max. Peak 
Height detection parameter is used as a 
maximum criterion determining the height 
threshold above which peaks are not identified.  

Function: All peaks above the specified peak height are 
classified as Unknown; that is, despite positive 
identification, they are not assigned a name from 
the peak table. (The height is always determined 
relative to the baseline.) This option is very useful 
when working with two detectors switched in 
series. Peaks that are clearly identified in the 
channel of the first detector, such as a UV 
detector, can cause problems in the second 
detector, for example, a fluorescence detector, 
due to an excessive concentration. These peaks 
are outside the linear range. Due to the positive 
identification, they would be considered in the 
calibration and they would falsify the result. If they 
are classified as Unknown, they are not 
considered.  

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Maximum Rider Ratio 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Percent [%] 
Value Range: 0 ... 99.99 

Default: 20 

Related Parameters: ⇒Rider Threshold 
⇒Type 

Description: If one or several peaks (h1 to h4) are above the 
Rider Threshold in a series of non-resolved 
peaks, Chromeleon determines via the Maximum 
Rider Ratio detection parameter, whether a peak 
is classified as main peak or Rider.  

Function: For this, the height of the peak to classify is put in 
relation to the height of the greatest peak in the 
series (reference peak). 
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As can be seen in the figure, not the "real" peak 
height of the peak to be classified is evaluated 
but the distance between the peak maximum and 
the skimming tangent. 

If the ratio h/b multiplied by 100 percent produces 
a value larger than the one defined as maximum 
rider ratio, the peak is a main peak.  

If the ratio h/b multiplied by 100 percent produces 
a value smaller than the one defined as maximum 
rider ratio, the peak is a rider peak.  
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Function: 
(Cont'd) 

Starting with the largest peak in the series 
(reference peak), all adjacent peaks are then 
classified. As soon as another main peak is 
recognized, this peak automatically becomes the 
new reference peak (b´). The maximum rider ratio 
is recalculated considering b´. The remaining 
peaks are classified again. The process is 
continued until all peaks of the series are 
classified. 

Riders can be recognized as such by the 
skimming tangent drawn on the chromatogram 
plot and by a Ru (Rider up) or Rd (Rider down) 
entry in the Type column of the report 
(Integration tab page). 

 Tips:  

 

In order to be effective, the criterion must be 
enabled before the peak start! 

 The ⇒Type (Peak Type) criterion in the peak 
table has priority! The criterion specified here, is 
effective only in combination with PEAK TYPE = 
AUTO! 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Maximum Width 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: min  
Value Range: 0.01 ... 999.99 

Default: The presetting is 999.99 min so that all peaks 
are considered.  

Related Parameters: ⇒Minimum Width 
⇒Maximum Peak Height 

Description: The Maximum Width detection parameter 
defines the maximum width above which peaks 
are ignored during peak detection. The peak 
width is measured on the baseline. For peaks that 
do not reach the baseline, the width is 
extrapolated. 

 Tip:  The criterion must be enabled before the peak 
end. The maximum width influences peak 
recognition and thus the baseline! In order to 
avoid this and to inhibit small peaks in the report 
only, select Properties on the Table menu, and 
then select Reject peaks with smaller relative 
area than ...%  check box. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Minimum Area 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Signal dimension ∗ Minute 

Value Range: 0.000 ... 1,000,000.000 

Default: The default setting is 0.001; that is, all peaks with 
an area > 0.001 [Sig.dimension x minutes] are 
integrated. 

Related Parameters: ⇒Maximum Area Reject 
⇒Minimum Width 
⇒Minimum Height 

Description: The Minimum Area detection parameter is used 
as a minimum criterion determining the area 
threshold below which peaks are ignored during 
peak detection or integration. 

Function: Should only this inhibition criterion be applied, 
peak numbers in the integration report table may 
not be consecutive, because two detection 
phases are carried out for a chromatogram; that 
is, for peak detection and area calculation. The 
minimum area parameter might be effective in the 
second run only; that is, a peak may be sorted 
out only then, the result being a gap. The No. 
column of the result file thus indicates which 
criterion was responsible for inhibiting a peak. 

 Tip:  This parameter must be enabled at a retention 
time before the start of a peak. It influences peak 
recognition and, therefore, also the baseline! In 
order to avoid this and to inhibit small peaks in 
the report only, select Properties on the Table 
menu, and then select the Reject peaks with 
smaller relative area than ...% check box. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Minimum Height 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Signal dimension  
Value Range: 0.000 ... 1,000,000.000 

Default: The default setting is zero; that is, all peaks with 
the height > 0 [Sig.dimension] are integrated. 

Related Parameters: ⇒Maximum Height Reject 
⇒Minimum Area 
⇒Minimum Width 
⇒Maximum Peak Height 

Description: The Minimum Height detection parameter is 
used as a minimum criterion determining the 
height threshold below which peaks are ignored. 

Function: The peak height is measured relative to the 
baseline (a). For Rider Peaks, the height 
measurement is relative to the profile of the 
carrier peak (b). The baseline can strongly 
influence these criteria (c,d). 

a) b) c) d)  

 Tip:  Enable this parameter if the retention time is 
before the start of the peak. The parameter 
influences peak recognition and, therefore, also 
the baseline! In order to avoid this and to inhibit 
small peaks in the report only, select Properties 
on the Table menu, and then select the Reject 
peaks with smaller relative area than ...% 
check box. 
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Minimum Width 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Minute  
Value Range: 0.000 ... 1,000,000.000 

Default: The default setting is zero; that is, all peaks with 
the width > 0 [minutes] are integrated. 

Related Parameters: ⇒Minimum Area 
⇒Minimum Height 

Description: The Minimum Width detection parameter is used 
as a minimum criterion defining the minimum 
width below which peaks are ignored during peak 
detection.  

Function: The peak width is measured on the baseline. In 
the case of peaks not reaching the baseline, the 
width is extrapolated. 

 Tip:  Enable this parameter if the retention time is 
before the start of the peak. The parameter 
influences peak recognition and, therefore, also 
the baseline! In order to avoid this and to inhibit 
small peaks in the report only, select Properties 
on the Table menu, and then select the Reject 
peaks with smaller relative area than ...% 
check box. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Peak Group Start/Peak Group End 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Selection 

Dimension: --- 
Value range: Auto, Fixed 

Default: Auto 

Related Parameters: ⇒Baseline Point 
⇒Lock Baseline 
⇒Inhibit Integration 

Description: Select the Peak Group Start and Peak Group 
End detection parameters to identify several 
successive peaks as one peak group. A peak 
group that has been defined in such a way is 
treated as one single peak.  

The peak maximum of the largest peak becomes 
the peak maximum of the entire group.  

For the group, only one name and number is 
entered in the chromatogram. Parameters such 
as area value, peak height, etc. are determined 
and displayed only once.  

Function: The Peak Group Start parameter (Peak Group 
End parameter, respectively) defines the start 
(end) of such a group. On the Detection tab 
page of the QNT Editor, set the start of the peak 
group automatically (Auto). If you select the 
Fixed mode, the baseline will start and end 
exactly at the mentioned retention times. The 
setting made for the Peak Group Start 
parameter is also adopted for Peak Group End. 
The system toggles between Peak Group Start 
and Peak Group End when appending a line.  
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Function: 
(Cont'd) 

Within one group, the entire peak detection 
algorithm is disabled; i.e., the Rider Threshold 
and Maximum Rider Ratio detection parameters 
are not considered. The area defined by Peak 
Group Start and Peak Group End only indicates 
the limits in which the algorithm is not active. 
Peak start and end as well as the baseline are 
determined as usual. 

 Note:  The time interval defined by peak group start and 
peak group end defines only the limits within 
which the algorithm is disabled. Peak start, peak 
end, and baseline course are determined as 
usual! 
Instead of setting the peak group start and peak 
group end, you can group individual peaks that 
are not necessarily consecutive. To do so, use 
the ⇒Group column of the peak table in the QNT 
Editor. Contrary to a peak group that has been 
defined via peak group start and peak group end 
the individual peaks of this group are still 
indicated. 

 
Also, refer to How to …: Integrating Chromatograms and Identifying 
Peaks  Grouping Peaks. 

For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Peak Purity Start/End Wavelength 
(PPWlStart/PPWIEnd) 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Floating point number 
Dimension: nm 

Value range: 190.0 - 900.0 

Default: Start: 190.0 nm; End: 900.0 nm 

Related Parameters: ⇒Peak Purity Threshold 

Description: The Peak Purity Start Wavelength and Peak 
Purity End Wavelength detection parameters 
limit the wavelength range for peak purity 
calculations. 

Function: For calculating the Peak Purity Index (PPI) and 
the Peak Purity Match Factor, only the 
wavelength range within the values limited by 
start and end is used.  

 Note:  The values 190 nm (Start) and 900 nm (End) are 
used as defaults. The actually recorded 
wavelength range is used for the calculation if the 
recorded range of the 3D field is smaller. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Peak Purity Threshold (PPTrshold) 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Command 
Dimension: --- 
Value range: 0.00 ... 100.00 

Default: 10.00 

Related Parameters: ⇒Peak Purity Start/End Wavelength 

Description: The Peak Purity Threshold detection parameter 
determines the threshold for the signal height 
above which spectra comparison is performed for 
the UV and Mass Spectra. The parameter is 
important for the Peak Purity Analysis (PPA) and 
the Peak Ratio. 
Peak Purity Analysis (PPA) 
When determining the Peak Purity Index (PPI) 
or the Peak Purity Match Factor, the parameter 
defines the signal height above the baseline, 
from which the spectra are extracted for 
calculation. 
Peak Ratio 
For the Peak Ratio, the PPTrshold parameter 
defines the signal height above which the ratio is 
formed. 

Function: Peak Purity Analysis (PPA) 
The value is stated in percent of the peak height, 
that is at the value 20%, only the spectra are 
used to determine the match factor for which the 
signal height of the peak is at least 20%. The 
smaller the selected value, the wider the match 
factor curves. The calculation may include 
spectra that no longer have an optimum Signal-
to-Noise Ratio. The match factor curve then has 
"fringes" at the margins (peak start and peak 
end). This can be avoided by a smaller threshold 
value.  
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Function: 
(Cont'd) 

Limiting the wavelength range that is used for 
calculating the center wavelength of the PPI is 
possible via the ⇒Peak Purity Start/End 
Wavelength detection parameters. A 
corresponding limitation to a specified mass 
range is not possible for the MS Peak Purity 
Match. 

Peak Ratio 
A value of 10% means that the signal ratio 
between two channels is only formed where the 
signal intensity exceeds 10% in two channels. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Peak Shoulder Threshold 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: - 
Value Range: Off; 0.01 ... 1000.00 

Default: Off; that is, shoulders without relative maximum 
are not recognized as peaks. Only if value ≠ Off, 
shoulders are detected. 

Related Parameters: ⇒Rider Threshold 
⇒Type (Peak Type) 

Description: The Peak Shoulder Threshold parameter 
defines a threshold value for peak shoulder 
recognition. 

Function: First, the average baseline curvature is 
determined for the entire chromatogram. The 
curvature threshold value is the product of the 
average baseline curvature and the threshold 
value. 

Detected peak shoulders with a maximum 
curvature above this threshold value are not 
considered. Select the ⇒Sensitivity detection 
parameter to influence the determination of the 
average baseline curvature. Higher sensitivity 
results in a smaller average baseline curvature 
and thus effects peak shoulder recognition.  

 Note:  Peak shoulders are treated like "normal" peaks. 
All other detection parameters (such as rider 
criteria, minimum criteria as well as peak 
recognition via peak table) except the peak group 
parameters (⇒Peak Group Start/Peak Group 
End) and the ⇒Valley to Valley parameter are 
used for peak shoulders as well. 
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Peak Slice  
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Floating point number 
Dimension: Seconds [s] 
Value Range: 0.01 ... 100,000.00 

Default: 0.05 

Related Parameters: This parameter should always be considered in 
combination with the ⇒Sensitivity! 

Description: The Peak Slice detection parameter determines 
the width (= time span) from which several 
successive data points are interpreted as peak or 
as noise. The presetting is 5/100 seconds.  

Function: General Rule 
If a specific peak should "just" be interpreted as a 
peak and if this was not reached via the Auto 
setting, a manual peak slice value can be 
specified by selecting the peak width. 

 Note:  This parameter only refers directly to peak 
detection and indirectly to integration. For area 
calculation, the original signal is used. (The 
parameter influences peak start and peak end. In 
this way, the peak area is influenced, also.) 
To change the variables, Sensitivity and Peak 
Slice, is only necessary in case of 
chromatograms comprising very wide (many 
minutes) or very narrow (< 0.1 s) peaks. Under 
normal conditions, the default values should not 
be changed. 
Graphical definition is recommended above all for 
Sensitivity and Peak Slice. For more information 
see. How to …: Integrating Chromatograms 
and Identifying Peaks  Modifying the Peak 
Recognition Algorithm. 
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Rider Skimming 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Selection 

Dimension: - 
Value Range: Tangential at lower peak end, Tangential at 

both peak ends or Exponential 
Default: Tangential at lower peak end 

Related Parameters: ⇒Rider Threshold 
⇒Maximum Rider Ratio 
⇒Type (Peak Type) 

Description: This parameter indicates how Rider Peaks are 
skimmed. 

Function: There are three options: 
• Tangential at lower peak end (default and 

the common skimming method): For 
ascending rider peaks, the peak start, and for 
descending rider peaks, the peak end is 
defined in such a way that rider skimming is 
tangential to the chromatogram. 

• Tangential at both peak ends: Peak start 
and peak end are determined so that rider 
skimming is tangential at both chromatogram 
ends. 

• Exponential: The chromatogram is 
approximated by an exponential function, so 
that the slope of the chromatogram and the 
exponential function correspond at the peak 
start and the peak end of the rider peak. This 
option clearly distinguishes from the two 
others. In most cases, Exponential maps the 
actual course of the curve very accurate. With 
this option, the rider peak will usually receive 
a more realistic larger area. You can use this 
option only if a sufficient number of data 
points is available. 
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 Tip:  You can move the baseline in the chromatogram 
with the mouse for tangentially skimmed riders, 
but you cannot for exponentially skimmed riders. 

 Note:  When reprocessing a chromatogram, the 
skimming function can be set manually for each 
rider peak. The required commands are available 
on the context menu of the selected peak. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Rider Threshold 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Fixed point number 
Dimension: Percent [%] 
Value Range: 0.00 ... 100.00 

Default: 10.00 

Related Parameters: ⇒Maximum Rider Ratio 
⇒Type (Peak Type) 
⇒Peak Shoulder Threshold 

Description: The Rider Threshold and Maximum Rider 
Ratio variables determine whether a single peak 
in a series of non-resolved peaks is classified as 
a Rider Peak (skimming peak) or as main peak. 

Function: The ratio between the Peak Height of the single 
peaks (here: h1 to h5) and the height of the 
largest peak (here: b) determines whether a peak 
is classified as rider peak or main peak. 
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If the height ratio h/b multiplied by 100 percent 
produces a value below the defined rider 
threshold, the corresponding peak is a main peak 
by definition. In this example, this is only the case 
for the h5 peak. 

If the height ratio h/b multiplied by 100 percent 
produces a value above the defined rider 
threshold, the Rider Threshold criterion is not 
sufficient for a clear classification.  
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Function: 
(Cont'd) 

In this case, the ⇒Maximum Rider Ratio is 
established. The resulting value allows you to 
classify the remaining peaks as rider peaks or 
main peaks. 

Riders can be recognized as such by the 
skimming tangent drawn on the chromatogram 
plot and by a Ru (Rider up) or Rd (Rider down) 
entry in the Type column of the report 
(Integration tab page). 

 Notes:  In order to be effective, the criterion must be 
enabled before the peak start! 

 The ⇒Type (Peak Type) classification criterion in 
the peak table has priority! The criterion specified 
here, is effective only together with PEAK TYPE = 
AUTO! 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Sensitivity  
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Floating point number 
Dimension: Signal dimension 

Value Range: 0.0001 ... 10,000,000.0 

Default: Dynamical (= Noise value of the related 
chromatogram) 

Related Parameters: Always consider this parameter in combination 
with the ⇒Peak Slice 

Description: Together with the Peak Slice parameter, the 
Sensitivity parameter determines the 
granularity of the peak detection algorithm; i.e., 
when using small values, even the smallest 
signals are interpreted as peaks; for example, 
pump pulsation, whereas such signals are 
ignored when using higher values. 

Function: Peak recognition is performed using a rectangle 
formed by the granularity of the y-axis 
(Sensitivity) and the granularity of the x-axis 
(Peak Slice) (see figure a): 

y-axis

x-axis

Sensitivity

Peak Slice

a)  
As shown in the picture, this rectangle is placed 
with its lower left corner on the first data point, 
and is duplicated by mirroring in the direction of 
negative y-values. As long as none of the 
subsequent data points is above or below the 
mirrored rectangle, the last data point will be used 
for positioning further rectangles (b). The 
measured signal is interpreted as noise.  
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Function: 
(Cont'd) 

b) c)  
If three successive data points are located above 
or below the rectangle (simplified!), the peak 
recognition algorithm will recognize a peak. When 
the signal difference of one data point to the next 
one becomes so small that they are within the 
bandwidth again, the peak end is indicated (c). 
 
Manually Setting the Parameters Sensitivity 
and Peak Slice 
You can manually modify the granularity of the 
peak recognition; that is, you can determine the 
size of the rectangle or the bandwidth. The larger 
the area, the lower the sensitivity of the system. 
Smaller peaks are likely to be interpreted as 
noise.  

General Rule 
If a specific peak shall "just" be interpreted as a 
peak and if this was not achieved via the Auto 
setting, specify a manual Sensitivity value of a 
third of the signal height of the peak.  

 Notes:  This parameter refers directly to peak detection 
only and indirectly to integration. For area 
calculation, the original signal is used. (The 
parameter influences peak start and peak end. In 
this way, the peak area is influenced, also.) 
Using the Sensitivity and Peak Slice variables is 
only necessary in case of chromatograms 
comprising very wide (many minutes) or very 
narrow (< 0.1 s) peaks. Under normal conditions, 
the default values should not be changed.  
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 Notes:  
(Cont'd) 

Sensitivity is always interpreted in the dimension 
installed; for example, mAU. 

Graphical definition is recommended above all for 
Sensitivity and Peak Slice. For more 
information, refer to How to …: Integrating 
Chromatograms and Identifying Peaks 

 Modifying the Peak Recognition Algorithm. 
 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Tailing/Fronting Sensitivity Factor 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Floating point number 
Dimension: --- 
Value range: Off; 1.0 ... 100.0 

Default: Off 
Related 
Parameters: 

Baseline Point, Lock baseline, Inhibit Integration 

Description: This detection parameter is an implicit threshold for 
setting the peak end. In the case of the Fronting 
sensitivity factor, the options refer to the peak 
start. 

Function: The following paragraphs describe the Tailing 
sensitivity factor options. The Fronting sensitivity 
factor behaves in the same way. 

Off (=0): The peak end is moved on the time axis until the 
slopes of the chromatogram and of the baseline 
correspond in the peak end. 

Factor 1 - 100: First, determine the time for the peak end as 
described above for Off (=0) and then determine the 
right baseline width, using the Baseline Level 
parameter of the Right Width peak variable or 
peak.right_width(0)). Multiply the value, which is 
the upper limit for the distance between the peak 
retention time and the peak end, by the Tailing 
sensitivity factor. If this limit is exceeded, the peak 
end is corrected and reset accordingly. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Valley to Valley 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Switch 

Dimension: --- 
Value Range: On; Off 
Default: Off 
Description: Usually, an algorithm determines the baseline 

automatically. The Valley to Valley parameter 
enables baseline treatment from valley-to-valley, 
that is, from peak minimum to peak minimum, in a 
series of non-resolved peaks. 

Function: When the parameter is enabled, the baseline 
below non-resolved peaks leads from peak end to 
peak end.  

Default Valley to Valley  

 Notes:  The end of the last non-resolved peak in a series 
of peaks is always a baseline point since the 
chromatogram itself forms the baseline outside 
the peak. 

 The Valley to Valley parameter is invalidated by 
⇒Lock Baseline. 

 The ⇒Type (Peak Type) criterion of the peak 
table has absolute priority. 

 
For information about how to use individual detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Void Volume Treatment 
 
Location: Detection tab page 

Report Variable (Detection Parameters) 
Type: Switch 

Dimension: --- 
Value Range On; Off  
Default: Off 
Related 
Parameters: 

⇒Inhibit Integration 

Description: Use this parameter to hide a negative peak at the 
chromatogram start. This is especially useful for the 
negative water peak in ion chromatography. If Void 
Volume Treatment is set to On, peak detection is 
disabled for the range of the negative water peak.  

Function: The system searches for the negative water peak in 
the retention time range between Void Volume 
Treatment = On and Void Volume Treatment = Off. 
The negative water peak is the peak with the lowest 
signal at the retention time. Peak suppression is 
enabled for the time between Void Volume Treatment 
= On and the end of the negative water peak. The 
chromatogram is recorded, but it is not integrated. 
(This corresponds to Inhibit Integration = On.) Peak 
detection is enabled again only after the peak end of 
the negative water peak has been detected. (This 
corresponds to Inhibit Integration = Off.) 

 Tip:  The Void Volume Treatment parameter becomes 
active only when its time is set before the start of the 
negative water peak. 

 Note:  

 

For each chromatogram, there can only be one range 
in which the negative water peak is detected. If you 
have defined several Void Volume Treatment = On 
and Void Volume Treatment = Off commands, the 
negative water peak is searched in the first defined 
range.  
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 Note:  
(Cont'd) 

If you have selected a range in the chromatogram 
using the right mouse button and if you have set Void 
Volume Treatment to On via the Set Void Volume 
Treatment command on the context menu, this 
overwrites all previously defined ranges.  

If Void Volume Treatment is not set to Off, 
Chromeleon uses the end of the chromatogram as 
the end of the range. 

 
For information about how to use individual detection parameters, refer to 
How to …: Working with Chromatograms  Defining Detection 
Parameters Graphically. 
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Report Categories 
The report variables are grouped in the following categories: 
 

Category Formula Variables 

⇒General gen.* General variables (in the Printer Layout 
only) 

⇒Sequence seq.* Sequence variables  
⇒Sample smp.* Sample variables 
⇒Audit Trail AUDIT.* Audit trail variables (protocol variables) (see 

Data Management  Audit Trails) 
⇒Preconditions precond.* Variables at the conditions before a sample 

run. 
⇒Chromatogram chm.* Chromatogram variables  
⇒Detection Parameters det.* ⇒Detection Parameters variables 
⇒Peak Results peak.* Peak result variables 
⇒Peak Calibration peak.* Calibration variables 
⇒Peak Table peakTab.* Peak table variables 
⇒Mass Spectrometry ms.* Mass spectrometry variables 
⇒Peak Purity and 
Identification 

peak.* Peak purity and identification variables 

⇒Quantification Method qnt.* Quantification method variables (in the 
Printer Layout only) 

⇒System Suitability Test sst. System Suitability Test (SST) variables (in 
the Printer Layout only) 

⇒History history.* History variables (in the history report 
only) 

⇒Integration/Summary Table table.group* Variables for statistics concerning sample 
groups and/or replicates (named Summary 
Table from the Summary tab page - or 
else: Integration Table) 

⇒Program pgm.* Program variables 
⇒Report Definition File (RDF) pgm.* Report Definition File (RDF) variables 
⇒Device Wellness  wns.* Device Wellness variables 
⇒Fraction frac.* Fraction collection variables 
⇒Fraction Tube tube.* Tube variable for fraction collection 
⇒Fraction Detection 
Parameter 

frac.channel.* Peak detection variables for fraction 
collection 



1458 Report Categories 

Category Formula Variables 

⇒Spectra Library Screening sls.* Variables for the settings in the QNT File 
regarding spectra library screening 

⇒Mass Spectrum msspec.* Mass Spectra variables (accessible via 
the Select Spectrum variable of the Mass 
Spectrometry category) 

⇒Spectrum Data peak.spectrum.* Peak spectra variables (accessible via the 
Reference Spectrum variable of the Peak 
Table category) 

⇒Hit Spectrum hitSpec.* Variables concerning spectra of spectra 
libraries (accessible via the SLS Hit 
variable of the Peak Purity category) 

⇒Spectra Library specLib.* Spectra library variables (accessible via the 
Library Record variable of the Hit 
Spectrum category) 

⇒User Information ~.* Variables concerning the corresponding 
user (accessible via all Operator variables 
of the different categories. ~: Formula 
depends on the way you opened the 
category.)  

The following pages provide a brief description of the respective variables 
of the corresponding categories. 

 Tip:  
Follow the description in How to …: Creating and Using Report Tables 

 Linking Report Variables to link report variables listed on the following 
pages via the four basic arithmetic operations, and thus create user-defined 
report variables. 
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"General" Category 
The General category is only available in the Printer Layout. It includes 
the following variables: 
 

Variable Formula Description 
Version Number  gen.version  
Serial Number gen.serialNo  
Key Code gen.keyCode Key Code 
Computer Name gen.computerName  
Operator Name gen.operator User name - opens the 

⇒User Information category 
Report Batch ID gen.batchID Number of the Report 

Definition File (RDF) 
Report Batch Status gen.batchStatus Status of the batch printout at 

the end of the batch  
Total Number of Sheets gen.nSheets Total number of worksheets 

to be printed 
Current Sheet Number gen.SheetNr Number of the current 

worksheet 
Current Time gen.Time Current date and time  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Sequence" Category  
The Sequence category includes the following variables: 
  

Variable Formula Description  
Name seq.name Sequence name 
Directory seq.path Directory in which the 

sequence is stored 
Datasource seq.dsn Name of the corresponding 

Datasource 
Timebase seq.timebase Timebase of last run 
Title seq.title Sequence header  
Number of Samples seq.nSamples  
Creation Date & Time seq.creation_time (See Time) 
Creation Operator seq.creation_operator Opens the ⇒User Information 

category 
Last Update Date & Time seq.update_time  
Last Update Operator seq.update_operator Opens the User Information 

category 
Preferred RDF File seq.prefRdf Preferred Report Definition 

File (RDF) 
Preferred Channel seq.prefChl Preferred Channel 
Sign Status  seq.signStatus Status of the  Electronic 

Signature 
Submit Date & Time  seq.submitTime Date and time when 

submitting the electronic 
signature  

Submit Operator  seq.submitOperator… User who submitted the 
electronic signature - opens 
the User Information 
category 

Submit Comment  seq.submitComment Comment when submitting 
the electronic signature 

Review Date & Time  seq.reviewTime Date and time when 
checking the electronic 
signature  

Review Operator  seq.reviewOperator… User who checked the 
electronic signature - opens 
the User Information 
category 

Review Comment  seq.reviewComment Comment when checking 
the electronic signature  

Approve Date & Time  seq.approveTime Date and time when the 
approving the electronic 
signature  



 Report Categories 1461 

Variable Formula Description  
Approve Operator  seq.approveOperator… User who approved the 

electronic signature - opens 
the User Information 
category 

Approve Comment  seq.approveTime Comment when approving 
the electronic signature 

 
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Sample" Category  
The ⇒Sample category includes the following variables: 
  

Variable Formula Description  
Sample Number smp.number ⇒No. 
Sample Name smp.name ⇒Name 
Raw Data ID smp.id  
Sample ID smp.ident ⇒Sample ID 
Comment smp.comment ⇒Comment 
Sample Type smp.type ⇒Type (sample type) 
Vial Number smp.position See ⇒Pos. (Sample position) 
Replicate ID smp.replicate ⇒Replicate ID 
Status smp.status ⇒Status (sample status): 

Single/Multiple/ 
Finished/Interrupted/Running 

Date & Time Sample Run smp.time See ⇒Inj. Date/Time  
Inject Volume smp.inject_volume ⇒Inj. Vol. (injection volume) 
Dilution Factor smp.dilution_factor See ⇒Dil. Factor 
Sample Weight smp.weight ⇒Weight (Sample Weight 

Factor) 
ISTD Amount smp.amount See ⇒ISTD Amount  (amount 

of the Internal Standard 
(ISTD)) 

Program smp.program PGM File  
Quantification Method smp.method Quantification Method  

(QNT Method) 
Standard Addition Group smp.spike_group Standard Addition group 
Reference Amount Set smp.refamount_set ID for ⇒Amount column in 

the QNT Editor 
Auto Purification Type smp.autopurification_sample 

_type 
Type of the associated 
autopurification sample 

Auto Purification Sample 
Reference 

smp.autopurification_reference ID for the associated 
autopurification sample 

Auto Purification Fraction smp.autopurification_fraction Fraction of the associated 
autopurification sample 
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Variable Formula Description  
Select Chromatogram smp.chm.x Selects the chromatogram for 

the associated sample - 
opens the ⇒Chromatogram 
category. 

*x smp.x User-defined Column  
(x = column name)  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 



1464 Report Categories 

"Audit Trail" Category  
Depending on the connected instrumentation, hundreds of variables are 
available in the Audit Trail. (For more information about the Audit Trails, 
refer to Data Management  Audit Trails.)   

The list below contains some of the variables that are typically available 
during data acquisition with a P680 pump or a UVD 340 detector. 

P680 
 

Variable Formula Description  
%B, %C, %D AUDIT.%B (C or D) Percentage of the respective 

component in the eluent (partial flow) 
(see ⇒%B, %C, %D 

Average 
(Pump_Pressure) 

AUDIT.Pump_Pressure. 
Average 

Status of averaging (also, see 
⇒Average) 

Equate (%A) AUDIT.%A.Equate Name of eluent component A 
(components B, C and D accordingly) 

Flow AUDIT.Flow ⇒Flow rate 
Lower Limit (Pressure) AUDIT.Pressure.Lower 

Limit 
Lower pressure limit (see 
⇒Pressure.Lower/UpperLimit) 

Step (Pump_Pressure) AUDIT.Pump_Pressure. 
Step 

Step for each channel (also, see 
⇒Step) 

Upper Limit (Pressure) AUDIT.Pressure.Upper 
Limit 

Upper pressure limit (see 
⇒Pressure.Lower/UpperLimit) 

 

UVD340 
 

Variable Formula Description  
Average AUDIT.Average Status of averaging: enabled or 

disabled (see⇒ Average) 
Bandwidth AUDIT.BandWidth ⇒Bandwidth (for each UV channel) 
Bunch Width AUDIT.3DFIELD.Bunch 

Width 
⇒Bunch Width of the diode bundle 
(3D-field only) 

LampIntensity AUDIT.LampIntensity ⇒LampIntensity [counts/s] 
MaxAutoStep AUDIT.MaxAutoStep Maximum value for Step = Auto (see 

⇒MaxAutoStep) 
Max. Wavelength 
(3DFIELD) 

AUDIT.3DFIELD.Max 
Wavelength 

Maximum wavelength of the  
3D Field 

Min. Wavelength 
(3DFIELD) 

AUDIT.3DFIELD.Min 
Wavelength 

Min. wavelength of the 3D field 
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Variable Formula Description  
Ref Wavelength AUDIT.RefWavelength ⇒RefWavelength (Reference 

Wavelength) (for each UV channel) 
Ref Bandwidth AUDIT.RefBandwidth ⇒RefBandwidth (Reference 

Bandwidth)  (for each UV channel) 
Step AUDIT.Step ⇒Step  
Wavelength AUDIT.Wavelength ⇒Wavelength (for each UV channel)  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Preconditions" Category  
Depending on the connected instrumentation, thousands of Preconditions 
variables exist. They allow you to display the device settings before a 
sample run in the Audit Trails. (For more information about the Audit Trails, 
refer to Data Management  Audit Trails.) The Preconditions are 
displayed if you have selected Preconditions only or Preconditions and 
Run on the View or context menu. 

The list below contains some of the variables that are typically available 
during data acquisition with a P680 pump or a UVD 340 detector. 

P680 
 

Variable Formula Description  
Average 
(Pump_Pressure) 

precond.Pump_Pressure. 
Average 

Status of averaging (also, see 
⇒Average) 

Equate (%A) precond.Pump.%A.Equate Name of eluent component A 
(components B, C and D 
accordingly) 

Flow precond.Pump.Flow ⇒Flow rate 
Lower Limit (Pressure) precond.Pump.Pressure. 

LowerLimit 
Lower pressure limit (see 
⇒Pressure.Lower/UpperLimit) 

Step (Pump_Pressure) precond.Pump_Pressure. 
Step 

Step for each channel (also, see 
⇒Step) 

Upper Limit (Pressure) precond.Pump.Pressure. 
UpperLimit 

Upper pressure limit (see 
⇒Pressure.Lower/UpperLimit) 

Value (Pump.%A)  precond.Pump.%A.Value  Percentage of the component in 
the solvent (partial flow): ⇒%B, 
%C, %D (in the same way for 
components B, C, and D) 

Value (Pump.%A_Level) precond.Pump.%A_Level Value for the ⇒%A, %B, %C, 
%D_Levels (in the same way for 
the components B, C, and D) 

Value (PumpWasteLevel) precond.Pump.WasteLevel Value for the ⇒WasteLevel (in the 
same way for the components B, 
C, and D) 
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UVD340 
 

Variable Formula Description  
Average precond.Average Status of averaging: enabled or 

disabled (see⇒ Average) 
Bandwidth precond.BandWidth ⇒Bandwidth (for each UV channel) 
Bunch Width precond.3DFIELD.Bunch

Width 
⇒Bunch Width of the diode bundle 
(3D-field only) 

LampIntensity precond.LampIntensity ⇒LampIntensity [counts/s] 
MaxAutoStep AUDIT.MaxAutoStep Maximum value for Step = Auto (see 

⇒MaxAutoStep) 
Max. Wavelength 
(3DFIELD) 

precond.3DFIELD.Max 
Wavelength 

Maximum wavelength of the 3D Field 

Min. Wavelength 
(3DFIELD) 

precond.3DFIELD.Min 
Wavelength 

Min. wavelength of the 3D field 

Ref Wavelength precond.RefWavelength ⇒RefWavelength (Reference 
Wavelength) (for each UV channel) 

Ref Bandwidth precond.RefBandwidth ⇒RefBandwidth (Reference 
Bandwidth)  (for each UV channel) 

Step precond.Step ⇒Step  
Wavelength precond.Wavelength ⇒Wavelength (for each UV channel)  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Chromatogram" Category  
It depends on the detector(s) that is(are) connected which chromatogram 
variables are available during data acquisition. The table below lists the 
variables that are available when either a UVD 340 detector or an aQa 

Mass Spectrometer is connected. 
 

Variable Formula Description 
Channel Name chm.channel  
Raw Data File Path Name chm.rawpath See Raw Data 
Number of Peaks chm.nPeak  
Select Peak chm.peak(OPT) ⇒Select Peak selects a peak in 

the chromatogram according to 
input; opens the ⇒Peak 
Results category 

Count Peaks if ... chm.countIF Counts the peaks which ... 
Sum Peak Results if ... chm.sumIF Adds up the characteristics of 

peaks that .... 
Start Time (relative to Inject 
Time) 

chm.start_time Chromatogram start time [min] 

End Time (relative to Inject 
Time) 

chm.end_time Chromatogram end time [min] 

Signal Value chm.sig_value Signal value [for example, in 
mAU] 

Signal Dimension chm.sig_dim  
Signal Noise chm.noise Signal noise [for example, in 

mAU] 
Sample Rate chm.sig_step  
Modified? chm.manipulated (Yes/no) 
Modification Time chm.manip_time Corresponding date/time 
Modification Operator chm.manip_operator Corresponding operator - 

opens the ⇒User Information 
category 

XXXXX Start Value chm.XXXXX Start value of the signal 
parameter XXXXX when 
acquiring data. 

Delay Time Value  chm.delayTimeValue ⇒Delay Time between two 
detectors 

Delay Time Detector chm.delayTimeDetector Name of the second detector 
Average chm.Average ⇒Average (for UV channels 

only) 
Step chm.Step ⇒Step (for UV channels only) 
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Variable Formula Description 
Wavelength chm.Wavelength ⇒Wavelength (for UV channels 

only) 
Bandwidth chm.Bandwidth  ⇒Bandwidth (for UV channels 

only) 
RefWavelength chm.RefWavelength See ⇒RefWavelength 

(Reference Wavelength)) (for 
UV channels only) 

RefBandwidth  chm.RefBandwidth  See ⇒RefBandwidth 
(Reference Bandwidth)) (for UV 
channels only) 

MassRange chm.MassRange Mass range of the Mass 
Spectrometer channel (for MS 
channels only) 

Polarity chm.Polarity Polarity (for MS channels only) 
Source Voltage  chm.Voltage  Voltage (for MS channels only) 
FilterIndex chm.FilterIndex Number of the Filter (MS 

channels only).  
Smoothing chm.Smoothing Smoothing algorithm (in 

parenthesis: number of 
smoothing points) (for MS 
channels only or if explicitly 
performed)  

For an overview of the different report variable categories, including links to 
the lists for these categories, refer to ⇒Report Categories. 
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"Detection Parameters" Category  
The Detection Parameters category includes the following variables: 
 

Variable Formula Description  
Minimum Area det.minArea ⇒Minimum Peak Area 
Maximum Area Reject det.maxAreaRj ⇒Maximum Area Reject 
Minimum Height det.minHeight ⇒Minimum Height 
Maximum Height Reject det.maxHeightRj ⇒Maximum Height Reject 
Maximum Peak Height det.maxHeight ⇒Maximum Peak Height 
Minimum Width det.minWidth ⇒Minimum Width 
Maximum Width det.maxWidth ⇒Maximum Width 
Rider Threshold det.riderMin ⇒Rider Threshold 
Maximum Rider Ratio det.riderRatio ⇒Maximum Rider Ratio 
Rider Skimming det.riderSkim Rider⇒ Skimming  
Peak Shoulder Threshold det.shoulderThrshld ⇒Peak Shoulder Threshold 
Front Riders to Main Peaks  det.frontRiderToMain ⇒Front Riders to Main Peaks 
Detect Negative Peaks det.negDetect ⇒Detect Negative Peaks 
Lock Baseline det.lockBl ⇒Lock Baseline 
Valley to Valley det.valval Baseline from ⇒Valley to 

Valley 
Inhibit Integration det.noInteg ⇒Inhibit Integration 
Sensitivity det.noise ⇒Sensitivity 
Peak Slice det.filter ⇒Peak Slice 
Fronting Sensitivity Factor det.frontFac ⇒Fronting Sensitivity Factor 
Tailing Sensitivity Factor det.tailFac ⇒Tailing Sensitivity Factor 
Part of a Peak Group? det.isInGroup See ⇒Group 
Peak Purity Threshold det.ppThrshld ⇒Peak Purity Threshold 
Peak Purity Start Wavelength det.ppStartWl ⇒Peak Purity Start 

Wavelength 
Peak Purity End Wavelength det.ppEndWl ⇒Peak Purity End 

Wavelength  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Peak Results" Category  
The Peak Results category includes the following variables: 
 

Variable Formula Description  
Number peak.number  
Name peak.name ⇒Name (Peak Name) 
Group peak.group ⇒Group (Peak Group) 
Link Count peak.linkCount Number of substances 

assigned in one peak 
Retention Time peak.retention_time ⇒Retention Time in [min] 
Retention Deviation peak.retention_deviation Deviation in [min] or [%], 

depending on parameter  
(abs or rel) 

Relative Retention Time peak.rel_retention_time  
Retention Window Width peak retention windows Width of the Retention⇒ 

Window 
Area peak.area Peak area for UV detectors in 

[min * mAU] 
Relative Area peak.rel_area Parameters: total, identified, 

group, istd, rel 
Group Area peak.groupArea Total of the peak ⇒Group 

areas 
Height peak.height Peak height, for UV detectors 

in [mAU] 
Relative Height peak.rel_height Parameters total, identified, 

group, istd, rel 
Group Height peak.groupHeight Total of the heights of the 

peak group 
Amount peak.amount ⇒Amount or concentration 
Amount Deviation peak.amount_deviation Deviation analogous to 

retention_deviation 
Concentration peak.concentration Concentration (if Amount is 

really an amount): 
amount/injection volume 

Relative Amount peak.rel_amount Parameters total, group, 
istd, rel 

Group Amount peak.groupAmount Peak ⇒Group amount 
Width peak.width Peak width (Parameters 0, 5, 

10, 50 in % of signal height 
above baseline - 0 base width 
with tangent method) 
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Variable Formula Description  
Left Width peak.left_width For the parameters, refer to 

Width 
Right Width peak.right_width For the parameters, refer to 

Width 
Peak Start Time peak.start_time In [min] 
Peak Stop Time peak.stop_time In [min] 
Signal Value at Peak Start/ 
Signal Value at Peak End 

peak.start_value 
peak.stop_value 

Signal Value at Peak Start, 
for UV detectors in [mAU] 

Baseline Value at Peak Start/ 
Baseline Value at Peak End 

peak.start_value_baseline 
peak.stop_value_baseline 

Baseline Value at Peak 
Start, for UV detectors in 
[mAU] 

Detection Code at Peak Start/ 
Detection Code at Peak End 

peak.start_detection_code 
peak.stop_detection_code 

Detection. Code at Peak 
Start/End 

Type peak.type Peak⇒ Type 
Modified peak.modified Modified peak? 
Manually Assigned peak.assigned Manually assigned peak? 
Resolution peak.resolution Resolution (parameters EP 

and USP) 
Asymmetry peak.asymmetry Peak Asymmetry, 

parameters EP and AIA 
Theoretical Plates peak.theoretical_plates Theoretical Plates 

(parameters EP and USP) 
Skewness peak.skewness Skewness 
K' peak.kValue Capacity Factor 
Retention Index peak.ri Linear ⇒Retention Index 
Kovats Index peak.ki ⇒Kovats Index  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Peak Calibration" Category  
The Peak Calibration category includes the following variables: 
 

Variable Formula Description 
Calibration Mode peak.calMode ⇒Calibration Mode 
Auto Recalibrate peak.autoRelCal Auto calibration On/Off 
Reference Inject Volume peak.reference_inject_volume Reference Injection Volume 
Calibration Type peak.calibration_type ⇒Calibration Type 
Weights peak.calibration_weight Weights 
Offset (c0) peak.offset Offset c0 
Slope (c1) peak.slope Slope c1 
Curve (c2) peak.curve Curve c2 
RF-Value (Amount/Area) peak.rf_value (1/c1) (see RF-Value 

(Amount/Area)) 
Number of Calibration Points peak.nCalpoints Number of Calibration 

Points 
Number of Disabled Calibr. 
Points 

peak.nCalDisabled Number of Disabled 
Calibration Points 

Variance peak.variance Variance 
Variance Coefficient peak.variance_coefficient Variance Coefficient 
Standard Deviation peak.standard_deviation Standard Deviation 
Relative Standard Deviation peak.rel_standard_deviation Relative Standard 

Deviation 
Correlation Coefficient peak.correlation_coefficient Correlation Coefficient 
Coefficient of Determination peak.rQuadrat Coefficient of 

Determination 
DOF-Adj. Coefficient of 
Determination 

peak.rQuadratAdj DOF-Adjusted Coefficient 
of Determination 

Calibration Point x peak.calPointX  
Calibration Point y peak.calPointY  
Calibration Point Weight peak.calPointWeight Calibration Point weighting 
Evaluation of Calibration 
Function 

peak.calPointFX  

Residual for Cal. Point x peak.calPointDist  
Calibration Point Status peak.calPointStatus  
Upper Confidence Limit peak.confUpperLimit Upper limit of the 

Confidence Interval 
Lower Confidence Limit peakconfLowerLimit Lower limit of the confidence 

limit  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Peak Table" Category  
The Peak Table category includes the following variables: 
 

Variable Formula Description  
Number peakTab.number Peak number 
Peak Name peakTab.name Peak ⇒Name 
Retention Time peakTab.retention_time ⇒Retention Time in [min] 
Retention Time Interpretation peakTab.retention_type Specification of retention 

times 
Use Prev. Retention Time peakTab.use_previous_rettime Status of corresponding 

variable in QNT File (see 
⇒Use Recent Retention 
Time) 

Window peakTab.window Time ⇒Window width 
Standard Method peakTab.standard_method See ⇒Standard 
Integration Type peakTab.integration_type ⇒Integration Type 
Calibration Type peakTab.calibration_type ⇒Calibration Type 
Peak Type peakTab.type See ⇒Type 
Left Limit peakTab.left_limit ⇒Left Limit) 
Right Limit peakTab.right_limit See ⇒Right Limit) 
Peak Group peakTab.group See ⇒Group 
Response Factor peakTab.response_factor ⇒Response Factor 
Amount peakTab.amount ⇒Amount 
Amount Dimension peakTab.amount_dimension  
C0 Value peakTab.C0 Y Offset of the 

calibration curve 
C1 Value peakTab.C1 Slope of the calibration 

curve 
C2 Value peakTab.C2 Curvature of the 

calibration  Curve  
Reference Spectrum peakTab.reference_spectrum.x ⇒Reference Spectrum, 

opens the category 
⇒Spectrum Data 

Match Criterion peakTab.spec_compare_metho
d 

⇒Match Criterion 

Check Derivative peakTab.spec_derivative ⇒Check Derivative 
Minimum Wavelength peakTab.spec_min_wavelength Lower limit of the 

compared wavelength 
range (see ⇒Minimum 
Wavelength) 
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Variable Formula Description  
Maximum Wavelength peakTab.spec_max_wavelength Upper limit of the 

compared wavelength 
range (see ⇒Maximum 
Wavelength) 

Threshold peakTab.spec_threshold ⇒Threshold value for 
spectra search 

Relative Maximum Deviation peakTab.spec_relmaxdev ⇒Relative Maximum 
Deviation during spectra 
search 

Check Number of rel. 
Extrema 

peakTab.spec_check_extrema Checking the number of 
extrema during spectra 
search (see ⇒Check 
Extrema) 

Comment peakTab.comment ⇒Comment 
Retention Index peakTab.ri Linear ⇒Retention Index 
Kovats Index peakTab.ki ⇒Kovats Index 
Mass Peak x peakTab.ms_peakx Mass of Peak x 
MS Threshold peakTab.ms_threshold Threshold for Mass 
MS Filter peakTab.ms_filter Mass Filter 
Check of mass ratios peakTab.ms_enable_rejection  
Check of MS retention times peakTab.ms_check_traces  
*x peakTab.user_x User-defined Column (x 

= column name)  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Mass Spectrometry" Category  
The Mass Spectrometry category includes the following variables: 
 
Variable Formula Description  
Background 
Subtraction Type 

ms.spec_enhanced Indicates the type of Mass Spectra 
background subtraction 

Peak Spectrum 
Bunch 

ms.nSpec_peak_top Number of averaged single spectra at peak 
maximum 

Left Background 
Subtraction Bunch 

ms.nSpec_left_BG Number of single spectra that are averaged 
for the left background spectrum 

Right Background 
Subtraction Bunch 

ms.nSpec_right_BG Number of single spectra that are averaged 
for the right background spectrum 

Left Background 
Subtraction Range 

ms.fix_left_BG Number of single spectra averaged for the 
left background spectrum at the peak 
maximum 

Right Background 
Subtraction Range 

ms.fix_right_BG Number of single spectra averaged for the 
right background spectrum at the peak 
maximum 

Select Spectrum ms.spectrum.x Opens the ⇒Mass Spectrum category 
Instrument 
Information 

ms.instrument Information about the mass spectrometer 

Instrument Method ms.method  
Tune Data ms.tune Tune data of the Xcalibur raw data file 
Status Log ms.statusLog Information about the status of the MS 

system at a specified time 
Spectra Count ms.spec_count Number of mass spectra  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 



 Report Categories 1477 

"Peak Purity and Identification" Category  
The Peak Purity and Identification category includes the following 
variables: 
 

Variable Formula Description 
Peak Purity Index peak.ppi Average PPI (Peak Purity 

Index) in nm over the entire 
peak (from a specific height) 

RSD Peak Purity Index peak.rsd_ppi Correspond. Rel.Std.Dev. 
Peak Purity Match peak.match Average Peak Purity Match 

Factor (0..1000) over the 
entire peak (from a specific 
height detection parameter) 

RSD Peak Purity Match peak.rsd_match Corresponding Relative 
Standard Deviation 

Peak Ratio Mean Value peak.ratio Average ratio value (BL-
corrected) with the "next" 
channel. 

RSD Peak Ratio peak.rsd_ratio Corresponding Rel.Std.Dev. 
value 

Peak Spectrum peak.spectrum.x Opens the ⇒Spectrum Data 
category 

Reference Spectrum Match peak.refMatch (See Match Factor) 
Number of SLS Hits peak.nSlsHits No. of reference spectra 
SLS Hit hitSpec.x Opens the ⇒Hit Spectrum 

category  
Mass of n-th MS peak peak.ms_peak_ 

mass(n) 
 

Intensity of n-th MS peak peak.ms_peak_ 
intens(n,"peak1") 

 

Position of mass peak 
maximum 

peak.ms_peak_ 
maximum(n."retTime") 

 

MS Peak Purity Match peak.ms_match(x) Averaged MS Peak Purity 
Match Factor (0..1000) over 
the entire peak (from peak 
height x%) 

RSD MS Peak Purity Match peak.ms_rsd_match(x) Corresponding relative 
standard deviation 
(Rel.Std.Dev.) 

Peak Mass Spectrum peak.msspectrum Opens the ⇒Mass 
Spectrumcategory  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Quantification Method" Category  
The Quantification Method category is only available in Summary tables 
and in individual Printer Layout cells. It includes the following variables: 
 

Variable Formula Description  
Name qnt.name QNT File name 
Directory qnt.path Directory where the QNT File 

is saved 
Datasource qnt.dsn Name of corresponding 

datasource 
Title qnt.title QNT File description 
Creation Date & Time qnt.creation_time Date and Time when the 

QNT File was created. 
Creation Operator qnt.creation_operator.x User who created the QNT 

File; opens the ⇒User 
Information category 

Last Update Date & Time qnt.update_time Date and time when the last 
update was performed. 

Last Update Operator qnt.update_operator User who performed the last 
update; opens the User 
Information category 

Last Calibration Date & Time qnt.lastCal_time Date and time when 
calibration was performed 
last. 

Last Calibration Operator qnt. lastCal_operator.x User who performed the 
last calibration; opens the 
User Information category. 

Curve Fitting Model qnt.calFuncType Model used for curve fitting. 

Dual-Column Separate 
Calibration 

qnt.separateCal Separate calibration for 
each column 

Retention Time Determination qnt.retTimeMode Interpretation of the 
retention time. 

Parent Sequence Name qnt.seq_name Directory in which QNT File is 
saved. 

Sequence Header Record qnt.sequence.x Opens the ⇒Sequence 
category  

Dead Time qnt.deadTime ⇒Dead Time 
Delay Time Value qnt.delayTimeValue Also, refer to ⇒Delay Time 
Delay Time Detector qnt.delayTimeDetector Corresponding detector 
Blank Run Subtraction qnt.blankRun Mode Status of Blank Run 

Subtraction 
Blank Run Sample Record qnt.blankRunSample.x Opens the ⇒Sample 

category  
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Variable Formula Description  
Matrix Blank Subtraction qnt.matrixBlank Subtraction status of a 

Matrix Blank Sample  
Number of Detection 
Parameters 

qnt.nDet  

Number of Peaks in the Peak 
Table 

qnt.nPeaks  

Select Peak in the Peak Table qnt.peakTabLine("OPT") ⇒Select Peak in the Peak 
Table selects peak in 
chromatogram according to 
the included option - opens 
the ⇒Peak Table category  

SST Result qnt.sst-result Total result of all single 
System Suitability Tests 

(SST) 
SST Rows qnt.sst_rows Number of lines (= number of 

single System Suitability 
Tests) on the SST page in the 
QNT Editor 

Select SST qnt.sst(n.)x Opens the category: ⇒SST. 
You can then select a 
variable for the chosen single 
System Suitability Test with 
the number n. 

Spectra Library Scr. Param. qnt.sls.x Parameter for Spectra Library 
Screening - opens the 
⇒Spectra Library Screening 
category  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"System Suitability Test" Category  
Usually, the System Suitability Test category is only available in the 

Printer Layout or in the SST Report. In addition, you can also open a 
system suitability test by selecting the Select SST variable of the 
⇒Quantification Method. In this case, the formulas start with qnt.sst(n.)x 
instead of sst.x and the variables refer to the SST referenced by the 
number n in brackets. In all other cases, the variables refer to the current 
SST. 

The System Suitability Test category includes the following variables: 
 

Variable Formula Description  
Number sst.number Number of the SST 
Name sst.name Name of the SST 
Sample Condition sst.sample_condition Sample condition for the SST 
Test Condition qnt.test_condition  
Aggregate Condition qnt.aggregate Aggregate function 
Operator qnt.operator  
Value qnt.value  
Channel qnt.channel  
Peak Condition qnt.peak  
N.A. qnt.n_a User defined test result if the 

condition cannot be evaluated. 
Fail Action sst.fail_action  
Aggregated Samples sst.agg_number_real  
Sample Condition Result  sst.sample_cond_result  
Test Results sst.results  
List of Aggregated Samples sst.agg_list  
Result List for Aggr. Samples  sst.agg_list_results  
Results of Test Condition or 
Aggregate 

sst.test_cond_result  

Result of Compare Value sst.value_result   
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"History" Category  
The History category is only available in the History Report. It includes 
the following variables: 
 

Variable Formula Description  
Object Name history.name  
Object Path history.path Data path, object path and name. 
Object Version  history.version Version of the modified object. 
Date/Time  history.time Date and Time (see Time) of the 

modification. 
Operator history.operator User - opens the ⇒User Information 

category. 
Operation  history.operation Short description of the modification. 
Comment  history.comment  
Detail Number  history.detail_number  
Detail Object history.detail_object  
Detail Column  history.detail_column  
Detail Old Value history.detail_old_value Old value of the modified field.  
Detail New Value history.detail_new_value New value of the modified field. 
Detail Comment history.detail_comment   

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Integration Table" and "Summary Table" 
Categories 
Use the variables of the Integration/Summary Table category to calculate 
various statistical values of samples and replicates. It only makes sense to 
apply these variables if the table has been sorted before. 

The category includes the following variables: 
 

Variable Formula Description  
Group Sum table.groupSum Total number of report lines 

with identical group criterion 
Group Count  table.groupCount Number of report lines with 

identical group criterion 
Group Average  table.groupAverage Average of report lines with 

identical group criterion 
Group Standard Deviation  table.groupStdev Standard deviation of report 

lines with identical group 
criterion 

Group Relative Standard 
Deviation  

table.groupRelStdev Relative standard deviation 
of report lines with identical 
group criterion  

 Note:  

On the Summary tab page, the category is named Summary Table. 
Elsewhere, it is called Integration Table. 

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Program" Category  
The Program category includes the following variables: 

Variable Formula Description  
Name pgm.name Program name 
Path pgm.path Directory where the Program is 

saved. 
Title pgm.title Program title  
Timebase pgm.timebase Name of the Timebase to 

which the program belongs. 
Creation Time pgm.creation_time Creation date/time (see  Time) 
Creation Operator pgm.creation_operator Opens the ⇒User Information 
Last Update Time pgm.update_time Date and time of the last update 
Last Update Operator pgm.update_operator Opens the User Information 

category  
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 

"Report Definition" Category 
The Report Definition category (see Report Definition File (RDF)) is 
available for some variables only in the Printer Layout; it is not available 
in tables. It includes the following variables: 
 
Variable Formula Description   
   
Name rdf.name Name of the report definition file 
Path rdf.path Path where the report definition file 

(RDF) is saved. 
Datasource pgm.dsn Datasource where the report definition 

file (RDF) is saved. 
Sheets pgm.Sheets Number of the sheets of the report 

definition file (RDF) 
Current Sheet Number pgm.CurSheetNo The current sheet number. 
Current Sheet Name pgm. CurSheetName The current sheet name.  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Device Wellness" Category  
The Device Wellness category includes the following variables: 
 

Variable Formula Description 
Background wns.Background The background signal at 

the time specified in the 
device configuration 
properties. 

Pressure wns.Pump.Pressure The pressure at the time 
specified in the device 
configuration properties.  

"Fraction" Category  

 Note:  
In the Printer Layout, the Fraction category is available only for report 
tables. 

The Fraction category includes the following variables:  
 

Variable Formula Description  
Fraction Number frac.number  
Retention Time Start frac.start_time Retention time at fraction start.  
Retention Time End frac.end_time Retention time at fraction end.  
Number of Tubes frac.nTubes  
Select Tube frac.tube("OPT").x Displays the selected fraction tube - 

opens the ⇒Fraction Tube category 
Tube List frac.tubeList("OPT", 

"<Sep.> ") 
Lists the tubes in the fraction (OPT = 
option and <Sep.> = used separator). 

Collected Volume frac.volume Volume collected in the fraction 
Channel Parameter frac.channel.x Displays the channel parameter 

selected for the fraction - opens the 
⇒Fraction Detection Parameter 
category. 

Number of Peaks frac.nPeaks("OPT") Number of all peaks within the fraction  
⇒Select Peak frac.peak("OPT").x Selects the peak from the fraction 

based on the selected parameter - 
opens the ⇒Peak Results category  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Fraction Tube" Category 
The Fraction Tube category provides different variables indicating how the 
single tubes have been filled during fraction collection. You can also open 
the Fraction Tube category via the Select Tube variable of the ⇒Fraction 
category. In this case, the formulas start with frac.tube.x instead of tube.x. 
The variables always refer to the tube indicated in parenthesis. This can be 
either First, Last, or the actual number of the tube. In all other cases, the 
variables return the value of the present tube. 

 Note:  
In the Printer Layout, the Fraction Tube category is available only for report 
tables. 

The Fraction Tube category includes the following variables: 
 

Variable Formula Description  
Tube Position tube.position Tube position (number)  
Retention Time Start tube.start_time Retention time when the system starts 

to fill the tube. 
Retention Time End tube.end_time Retention time when the system stops 

to fill the tube. 
Collected Volume tube.volume Volume collected in the tube. 
Maximum Collectable 
Volume 

tube.maxVolume Maximum tube capacity 

Number of Peaks tube.nPeaks("x") Number of 'peaks' collected in the tube 
⇒Select Peak tube.peak("OPT").x Selects the peak from the tube based 

on the selected parameter - opens the 
⇒Peak Results category  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Fraction Detection Parameters" Category 
The Fraction Detection Parameter category includes different variables that 
indicate the peak detection setting for the present fraction. This category 
can be opened only via the ⇒Fraction category.  

 Note:  
In the Printer Layout, the Fraction Detection Parameter category is 
available only for report tables. 

The Fraction Detection Parameter category includes the following 
variables:  
 

Variable Formula Description  
Detection Channel frac.channel.channel Channel for peak detection  
Channel Name frac.channel.name Name of the channel used 

for peak detection. 
Peak Start Slope frac.channel.start_slope The slope must exceed the 

Peak Start Slope value for 
the peak start to be 
recognized.  

Peak Start Curve frac.channel.start_curve Curve in [Signal]/s^2 that 
must be exceeded for a 
shoulder to be recognized 
after the peak start. 

Peak Start True Time frac.channel.start_truetime The time must be fulfilled 
for the different conditions 
for a peak start to be 
recognized. 

Peak Start Threshold frac.channel.start_threshold The signal threshold value 
must exceed the Peak Start 
Threshold value for the 
peak start to be recognized. 

Peak Max Slope frac.channel.max_slope The slope value must be 
below the Peak Max Slope 
value for the peak 
maximum to be recognized. 

Peak Max True Time frac.channel.max_truetime The time must be fulfilled 
for the different conditions 
for a peak maximum to be 
recognized. 

Peak End Slope frac.channel.end_slope The slope value must be 
below the Peak End Slope 
value for the peak end to be 
recognized. 
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Variable Formula Description  
Peak End Threshold frac.channel.end_threshold The signal threshold value 

must be below the Peak 
End Threshold value for the 
peak end to be recognized. 

Peak End Curve frac.channel.end_curve Curve in [Signal]/s^2 that 
must be exceeded for a 
shoulder to be recognized 
after the peak maximum. 

Peak End True Time frac.channel.end_truetime The time must be fulfilled 
for the different conditions 
for a peak end to be 
recognized. 

Threshold No Peak End frac.channel.threshold_no_peak_end The signal threshold value 
must be below the 
Threshold No Peak End 
value for the peak end to be 
recognized. 

Baseline Drift frac.channel.baseline_drift Start value for the baseline 
drift. This value is used to 
correct the signal value. 

Baseline Offset frac.channel.baseline_offset Start value for the baseline 
offset. This value is used to 
correct the signal value. 

Threshold Do Not 
Resolve 

frac.channel.thrs_no_resolve Threshold value for the 
slope in [Signal]/s above 
which peak detection via 
the PeakEndSlope 
parameter was disabled. 

Deriv. Step frac.channel.deriv_step Time for which the signal 
values were evaluated to 
determine the signal slope 
and the curve.   

For an overview of the different report variable categories, including links to 
a list of variables in each category, refer to ⇒Report Categories. 
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"Spectra Library Screening" Category  
The Spectra Library Screening category includes the following variables: 
 

Variable Formula Description  
Spectra Library sls.library Spectra Library 
Spectra Library sls.library  
Match Criterion sls.match ⇒Match Criterion 
Hit Threshold sls.threshold See ⇒Threshold 
Spectrum Derivative sls.derivative See ⇒Check Derivative 
Wavelength Range 
Minimum 

sls.wavelength_min See ⇒Maximum/Minimum 
Wavelength 

Wavelength Range 
Maximum 

sls.wavelength_max  

Max. Allowed Deviation sls.max_deviation ⇒Relative Maximum Deviation 
Max. Retention Time 
Deviation 

sls.max_ret_deviation See ⇒Retention Time  

Check Relative Extrema sls.rel_extrema See ⇒Check Extrema 
Max. Retention Index 
Deviation 

sls.max_ret_idx_dev See ⇒Retention Index  

Max. Kovats Index 
Deviation 

sls.max_kov_idx_dev See ⇒Kovats Index  

Spectra Library Restriction sls.restriction  
Spectra Library Restriction 
Count 

sls.restriction_count  

 
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Spectrum Data" Category  
Open the Spectrum Data category by selecting the Reference Spectrum 
variable of the ⇒Peak Table category. The Spectrum Data category 
includes the following variables: 
 

Variable Formula Description 
Lambda Min peak.spectrum.wlmin Lower limit of 

wavelength range 
Lambda Max peak.spectrum.wlmax Upper limit of 

wavelength range 
Lambda Resolution peak.spectrum.wlResolution Wavelength resolution 
Sample Rate peak.spectrum.acqStep  
Absorbance Value peak.spectrum.sig_value("max")  
Absorbance Extremum  
at [nm] 

peak.spectrum.extremum("relMax")  

 
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 

"Mass Spectrum" Category  
Open the Mass Spectrum category by selecting the Select Spectrum 
variable of the ⇒Mass Spectrometry category. The Mass Spectrum 
category includes the following variables: 
 

Variable Formula Description  
Number of Data Points mspec.mass_count  
Mass mspec.mass Mass [m/z] 
Intensity mspec.intensity Intensity [counts] 
Relative Intensity mspec.rel_intensity Relative Intensity (%) 
Minimal Mass mspec.mass_min Minimal mass [m/z] 
Maximal Mass mspec.mass_max Maximal mass [m/z] 
Mass Range mspec.mass_range Mass range [m/z] 
Spectrum Type mspec.type Spectra type 

(centroid/profile) 
Resolution mspec.resolution Resolution of the Mass 

Spectrum 
Total Ion Current mspec.TIC Number of TIC channels  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Hit Spectrum" Category  
Open the Hit Spectrum category by selecting the SLS Hit variable of the 
⇒Peak Purity and Identification category. The Hit Spectrum category 
includes the following variables for the matching reference spectrum: 
 

Variable Formula Description  
Substance Name hitSpec.name  
Match Factor hitSpec.match Match Factor 
Library Name hitSpec.lib_name Name of the Spectra 

Library 
Library Record hitSpec.specLib.x Opens the ⇒Spectra Library 

category 
Number of rel Extrema hitSpec.nExtrema  
Solvents hitSpec.solvent  
Comment hitSpec.comment Comment 
Sequence Name hitSpec.seq_name  
Sequence Header Record hitSpec. sequence.x Opens the ⇒Sample 

category  
Sample Name hitSpec.smp_name  
Sample Record hitSpec.sample.x Opens the ⇒Sample 

category 
Acquisition Time hitSpec.acqTime  
Timebase hitSpec.timebase Timebase 
Program hitSpec.program PGM File used for 

recording the library 
spectrum.  

Sample Rate hitSpec.acqStep  
Retention Time hitSpec.retention_time ⇒Retention Time 
Lambda Min hitSpec.wlMin Lower limit of wavelength 

range 
Lambda Max hitSpec.wlMax Upper limit of wavelength 

range 
Lambda Range hitSpec.wlRange Wavelength range 
Lambda Resolution hitSpec.wlResolution Wavelength resolution 
Detector Name hitSpec.detectorName  
Detector Serial No. hitSpec.detectorSerNo  
Extract Time hitSpec.extrTime  
Extract Operator hitSpec.operator Opens the ⇒User Information 

category 
Retention Index (lin) hitSpec.ri Linear ⇒Retention Index 
Kovats Index  hitSpec.ri ⇒Kovats Index  
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"Spectra Library" Category  
Open the Spectra Library category by selecting the Library Record 
variable of the ⇒Hit Spectrum category. The Spectra Library category 
includes the following variables: 
 

Variable Formula Description  
Name specLib.name Spectra library name 
Directory specLib.path Directory in which the 

spectra library is saved 
Datasource specLib.dsn Name of corresponding 

datasource 
Timebase specLib.timebase Timebase where the 

reference spectrum was 
recorded 

Title specLib.title Spectra library description 
Number of Spectra specLib.nSpectra  
Creation Date & Time specLib.creation_time (See Time) 
Creation Operator specLib.creation_operator Opens the ⇒User 

Information category 
Creation Software Version specLib.creation_version  
Last Update Date & Time specLib.update_time  
Last Update Operator specLib.update_operator Opens the User 

Information category 
Last Update Software Version specLib.update_version  

Retention Index (lin) specLib.ri Linear ⇒Retention Index 

Kovats Index (log) specLib.ki ⇒Kovats Index 
 
For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"User Information" Category  
You can open the User Information category via all Operator variables of 
the different categories except the Operator variable of the System 
Suitability Test category. For example, select the Creation Operator 
variable of the ⇒Sequence category. The User Information category 
includes the following variables (formulas according to the above 
mentioned example): 
 
Variable Formula Description  
User ID seq.creation_operator.userID ID of the user 

User Name seq.creation_operator.userName Name of the user 
Job Title seq.creation_operator.jobTitle Job title of the user  

For an overview of the different report variable categories, including links to 
the lists for the respective categories, refer to ⇒Report Categories. 
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"Select Peak" Options  
Use the Select Peak variable of the ⇒Chromatogram category to select a 
peak in the chromatogram. The Select Peak variable opens the ⇒Peak 
Results category. Enter an option in the Formula field. 

 Note:  
Instead of using the Formula field, you may as well click Parameter and 
select an option from the Select Peak drop-down list.  

The meaning of the options is as follows: 

"Formula": chm.peak(OPT, [Name, Number]) 
 
OPT = "By Number" 
(default): 

Searches the chromatogram for the peak with the indicated 
number. Example: chm.peak("By Number," 1).area determines the 
area of the first peak in the chromatogram. 

OPT = "By Name": Searches the chromatogram for the peak with the indicated name. 
Example: chm.peak("By Name," "Benzene".)amount determines 
the amount of benzene in the sample. 

OPT = "By 
Tab.Number": 

Searches the chromatogram for the peak that was identified by the 
corresponding line in the peak table. Example: chm.peak("By 
Tab.Number," 2).height searches the chromatogram for the peak 
that was identified by the second line in the peak table, and then it 
determines its height. 

OPT = "By Group": Searches the chromatogram for the first peak in a specific peak 
group. Example: chm.peak("By Group," "CKW").amount searches 
the chromatogram for the first peak in the ⇒Group (Peak Group) 
called CKW and then determines its ⇒Amount. 

OPT = "By SLS-Hit": Searches the chromatogram for a peak for which at least one SLS 
hit is available. Example: chm.peak("By SLS-Hit," 
2).hitSpec(1).name selects the second peak in the chromatogram 
for which at least one SLS hit is available. In addition, the name of 
the respective library spectrum with the best match is indicated. 

OPT = "ISTD": Searches the chromatogram for the Internal Standard peak. If 
there are several ISTD peaks, the number of the ISTD peak can be 
indicated by a second parameter. Example: chm.peak("ISTD").area 
searches the chromatogram for the first ISTD peak and calculates 
its area. chm.peak("ISTD," 2).area calculates the area of the 
second ISTD peak. 
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OPT = "Ref": Searches the chromatogram for the reference peak (Retention Time 
Interpretation as Time Distance to ... or Time Ratio to...) For 
example: chm.peak("Ref").retention_time searches for the 
reference peak and then calculates the corresponding retention 
time. 

OPT = "Condition": Searches the chromatogram for the first peak for which the 
conditions becomes true. For example: chm.peak("By 
Condition","peak.area>10.000").retention_time searches for the 
first peak with an area larger than 10.000 and returns its retention 
time. 

"Select Peak in the Peak Table" Options 
Use the Select Peak in the Peak Table variable of the ⇒Quantification 
Method category to select a peak in the peak table of the QNT Editor. This 
variable opens the ⇒Peak Table category. Enter an option in the Formula 
field. 

 Note:  
Instead of using the Formula field, you may as well click Parameter and 
select an option from the Select Peak drop-down list.  

The meaning of the options is as follows: 

"Formula": qnt.peakTabLine(OPT, [name, number]) 
OPT = "By Name": Searches the peak table for the first line with the corresponding 

name. Example: qnt.peakTabLine("By Name," 
"Benzene").amount(1) returns the value in the first amount column 
for the peak ‘Benzene’. 

OPT = "By Number" 
(default): 

Searches the peak table for the line with the corresponding number. 
Example: qnt.peakTabLine("By Number," 1).name returns the 
name of the first peak in the peak table. 

OPT = "By Group": Searches the peak table for the first line with the specified group 
entry. Example: qnt.peakTabLine("By Group," "CKW").amount(1) 
returns the value in the first amount column for the first peak in the 
group called CKW. 

OPT = "ISTD": Searches the peak table for the line with the ISTD peak. If there are 
several ISTD peaks, the corresponding number can be specified via 
the second parameter. If no number is specified, the first ISTD peak 
will be used. Example: qnt.peakTabLine("ISTD," 2).name returns 
the name of the second ISTD peak. 

OPT = "Ref": Searches the peak table for the line with the Reference Peak 
( Retention Time Interpretation as Time Distance to ... or Time 
Ratio to...) Example: qnt.peakTabLine ("Ref").name returns the 
name of the reference peak.  
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%B, %C, %D (Solvent Components) 
The solvent and thus, the ⇒Flow usually consist of different components. 
The amounts of the single partial flows (solvent components) are indicated 
in percent of the flow. The total of all partial flows is 100% 
(%A + %B + %C + %D = 100%), where %A is calculated from the 
remaining partial flows (%A = 100% - (%B + %C + %D)). Therefore, it is 
sufficient to determine the values for %B, %C, and %D. Changing the 
solvent composition during the analysis is referred to as %-Gradient. 

Also, refer to ⇒%B, %C, %D (Solvent Components). 

%-Gradient 
See (%-)Gradient.  

3D_Amp 
The 3D_Amp signal is available for an ICS-3000 ED electrochemical 
detector in integrated amperometry mode. The signal records the detector 
response (current), at time t (in milliseconds) in the Waveform period and 
time T (in minutes) of the run (retention time). As a result, the two-
dimensional view of an integrated amperometry chromatogram (retention 
time and integrated current) is extended by a third dimension (waveform 
time).  

You can display and evaluate this three-dimensional data set in the 3D 
Amperometry window. Each detector current value is entered as a data 
point in a waveform time by retention time grid, producing 3D data that 
stretches in the x, y, and z directions.  

Also, refer to  The 3D Amperometry Window. 

3D Field 
A Photodiode Array Detector (PDA) simultaneously measures the 
different absorptions in a wavelength range at the time t. The two-
dimensional view of a chromatogram (retention time and absorption height) 
is extended by another dimension (wavelength). Each recorded data point 
contains information about the detected wavelength, in addition to the 
retention time and the absorption value.  
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The resulting 3D field stretches in x, y, and z-direction.  

Dionex Photodiode Array Detectors record data points via the 3DFIELD 
signal. You may use Signal Parameters to influence signal recording in 
the same way as for any other signal. 

Recording a 3D field can produce an enormous amount of data that 
depends on the selected Sampling Rate, the detector's Optical 
Resolution, and the selected wavelength range. This not only requires 
special data compression procedures (see Data Management  Raw 
Data Compression), but also makes it impossible to control photodiode 
array detectors via conventional serial interfaces. That is why powerful 
special connectors and separate interface cards are used for the PC 
connection of the Dionex PDAs, such as the UVD 340U detector. This 
connection even allows online representation of the 3D field on a Control 
Panel. You can display and evaluate existing 3D fields in different modes 
(see: 3D Field: Presentation Modes). The PPA (Peak Purity Analysis) 
pane is available for this. 

3D Field: Presentation Modes  
The 3D Field is the relation between the retention time, wavelength, and 
absorption. Chromeleon supports two modes for presenting three-
dimensional figures: ISO plot and 3D plot presentation. Use the Decoration 
dialog box of the PPA (Peak-Purity Analysis) pane to toggle between the 
two modes. 
 
Presentation Mode Description 
ISO Plot In the area formed by the retention time and the wavelength, lines 

with equivalent absorption are displayed in the same color. The 
resolution increases with the number of drawn lines (levels). Online 
representation of the ISO plot, i.e., its real-time representation, is 
possible as well. 

3D Plot The 3D plot is a combination of perspective projection and iso-line 
plot. The iso-lines are moved to the third dimension, depending on 
the absorption degree. A grid containing all retention time and 
wavelength values is placed over the created profile.  

 Note: 
The 3D plot presentation mode requires more computing resources than 
the ISO plot presentation. Therefore, on-screen representation requires 
more time. Copying a 3D plot to the clipboard or printing is more time-
consuming, as well. 
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3D Plot 
See 3D Field: Presentation Modes 

A Groups 
See Access Groups 

Access Groups (A Groups) 
An Access Group includes various Chromeleon users. Membership in a 
specific Access Group determines which objects (server, Timebases, 

Datasources, and directories) the user can access. Each user can belong 
to several Access Groups. 

For example, the All Access Group can include users A, B, C, X, Y, and Z, 
while the Specials group can include only users A, B, and C. 

The more different Access Groups that you create, the more precisely you 
can define access rights in Chromeleon. (For more information, refer to 
Software Installation and Communication  Access Control in the 
Administrator Help section.)  

After creating an Access Group in the User Manager (CmUser program), 
the system administrator determines the objects the user can access:  

a)  In the Chromeleon Client, the system administrator specifies the 
access rights to datasources, directories, and sequences.  

b)  In the Server Configuration program, the system administrator 
specifies the rights to servers and timebases.  

To assign access rights, select the object, and then select Properties on 
the context or Edit menu. In the Properties dialog box, specify which user 
groups are granted access to the selected object. 

If a user belongs to an Access Group, certain privileges are automatically 
assigned to the user. These Privileges are defined in Privilege Groups.  

  Note: 
If the User Mode is disabled, the user has all rights but (s)he cannot 
access any section that is protected by an Access Group.  
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Account  
Each user has a separate account. When the User Mode is enabled, the 
account is checked each time the user logs on. To prevent penetration from 
the outside, the system administrator can determine in the User Manager 
(CmUser program) whether a user account shall be locked after a specified 
number of failed Logons. In addition, a user account can be locked 
completely (Account locked). In both cases, the user can restart the 
Chromeleon client only when the system administrator grants access to the 
account again. 

Acquisition On/Off 
The Acquisition on command enables data recording ( Raw Data) from 
all selected Signals or channels of a Timebase. The signal parameters 
determine the type of data for signal recording.  

Also, refer to ⇒AcqOn/Off. 

Additional Functions 
The Report Publisher is an add-on module to the Chromeleon software 
and provides 124 additional functions for creating user-defined formulas in 
the Printer Layout. For more information about the formulas, select 
Additional Functions in the index of the Chromeleon online Help. 

For an application example, refer to How to …: Creating and Using 
Report Tables  Entering User-defined Formulas.  

For an overview of the available functions, refer to the following lists:  

Date and Time 
DATE  
DATEVALUE  
DAY  
DAYS360  

HOUR  
MINUTE  
MONTH  
NOW  

SECOND  
TIME  
TIMEVALUE  
TODAY  

WEEKDAY  
YEAR   
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Mathematics and Trigonometry 
ABS  
ACOS  
ACOSH  
ASIN  
ASINH  
ATAN  
ATAN2  
ATANH  
CEILING  

COS  
COSH  
EVEN  
EXP  
FACT  
FLOOR  
INT  
LN  
LOG  

LOG10  
MOD  
ODD  
PI  
PRODUCT 
RAND  
ROUND  
ROUNDDOWN  
ROUNDUP  

SIN  
SINH  
SQRT  
SIGN  
SUM  
SUMIF  
SUMSQ  
TAN  
TANH  

Statistics 
AVERAGE  
COUNT  
COUNTA  

COUNTIF  
MAX  
MIN  

STDEV  
STDEVP  
VAR  

VARP   

 

Addressing 
ADDRESS  
COLUMN  
COLUMNS  

HLOOKUP  
INDEX  
INDIRECT  

LOOKUP 
MATCH  
OFFSET  

ROW  
ROWS  
VLOOKUP 

 

Text 
ASC  
CHAR  
CLEAN  
CODE  
CONCATENATE  
DBCS  
EXACT  
FIND  

FINDB  
FIXED  
LEFT  
LEFTB  
LEN  
LENB  
LOWER  
MID  

MIDB  
PROPER  
REPLACE  
REPLACEB  
REPT  
RIGHT  
RIGHTB  
SEARCH  

SEARCHB 
SUBSTITUTE  
T  
TEXT  
TRIM  
TRUNC  
UPPER  
VALUE  

 

Logic 
AND  
FALSE  

IF  
NOT  

OR  
 

TRUE 
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Information 
CHOOSE  
ERROR.TYPE  
ISBLANK  
ISERR  

ISERROR  
ISLOGICAL  
ISNA  
ISNONTEXT  

ISNUMBER  
ISREF  
ISTEXT  

N  
NA  
TYPE  

  

AIA (ALSSA) 
AIA (today called ALSSA) is the abbreviation for Analytical Instrument 
Association (ALSSA = Analytical and Life Science Systems 
Association). The AIA is an association of manufacturing and sales 
companies for chemical analysis instruments and software. Their aim is to 
develop guidelines for a standardized chromatography file format and thus, 
facilitate exchanging data between laboratory systems produced by 
different manufacturers.  

This especially refers to the independence from operating systems and the 
selected transfer type, but standardization efforts also involve operation, 
documentation, maintenance, and GLP requirements. 

The generally valid AIA (ALSSA) export format for chromatography data is 
known as ANDI (ANalytical Data Interchange/Chromatography). 

Since 1992, there are five data format categories (Category 1 through 5). 
However, only the categories 1 and 2 are widely accepted so far. 

Data formats of category 1 comply with standard raw data, unit, and scaling 
guidelines, and include information about where original data and 
corresponding methods are stored. This allows you to exactly restore a 
chromatogram from its raw data. 

In addition to amount values and names for substance identification, data 
formats of category 2 also transmit all calculated results; for example, 
based on a chromatogram. Thus, the data can be managed in a database 
or LIMS.  

Using the AIA format (ANDI) in Chromeleon  
To export data from Chromeleon, you can use the ANDI format. Select 
Export/Backup on the File menu of the Browser. Select 
ANDI/Chromatography (AIA) to open the Export ANDI/Chromatography 
(AIA) dialog box. 
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It is also possible to export and print data simultaneously. On the File menu 
in the Browser, select Batch Report. Under Export Options, select the 
Export check box. The Export Wizard: Common Options dialog box 
appears. Select the ANDI/Chromatography - AIA (*.cdf) check box, and 
then click Next>. In the Export Wizard: Options AIA Format (*.cdf) dialog 
box, define the AIA format. The Export Wizard corresponds to the Batch 
Setup command in the Printer Layout. Enable Layout Mode on the Edit 
menu, and then select Batch Report Setup on the File menu. On the AIA 
format (*.cdf) tab page, define the AIA format.  

You can also import AIA files into Chromeleon. On the File menu of the 
Browser, select Import/Restore, and then select the 
ANDI/Chromatography (AIA). In the dialog box, select the file to be 
imported. 

AIA Peak Type 
See Detection Code at Peak Start or Peak End 

Align 
Select the Align function to align two or more selected Controls in the 

Layout Mode (left, right, top, bottom) or to assign them identical 
dimensions (width, height, size). 

The Control Frame of the control that is selected first is the reference for 
the control(s) to be aligned. 

Amount  
The Amount peak table parameter defines the content of a component in a 
standard sample. For each component used for calibration, exactly one 
amount value is entered in the Amount column of the peak table in the 
QNT Editor. (For information about the editor, see Data Representation 
and Reprocessing  The QNT Editor.) 

Also, refer to ⇒Amount 
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Amount Deviation 
The Amount Deviation peak table variable specifies the difference 
between the nominal ⇒Amount included in the Amount column of the peak 
table and the value actually determined by area calculation (actual 
amount): 

Amount Deviation = Actual Amount - Nominal Amount 

By default, the difference is expressed in absolute amount units 
(= Absolute parameter). Alternatively, input is possible in percent of the 
expected amount value (= Relative parameter). 

Use this variable to check the quality of a calibration. The smaller the 
determined deviation, the closer is the corresponding calibration point to 
the calibration curve.  

APS  
The Dionex Autopurification system series is called APS. The series 
includes the APS-2000 (semipreparative) and APS-3000 (preparative) 
systems and comprises the following devices: 
 
Device/Accessory Name Description 
Pumps P680 

PP-150 
HPLC pump 
preparative HPLC pump (APS-3000 only)  

Sample and Fraction 
Manager 

SFM  Autosampler and fraction collector 

UV detectors UVD 170 UV-VIS
UVD 340 PDA 

UV Detector  
Photodiode Array Detector 

Mass Spectrometer MSQ Thermo Finnigan Mass Spectrometer  
In addition, the APS comprises the following devices:  

• SSM - Safety and Solvent Monitoring System, 
• System Safety Platform  
• Accurate Flow Splitter or Active Splitter 
• The Chromeleon software is another main part of the APS.  
 
Also, refer to Chromatography Components: Hardware and Software 

 Chromatography Instruments. 
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ARC 
ARC, which is the abbreviation for Automated Run Completion, is an 

Autopurification feature in Chromeleon. After the target compound has 
been found, Chromeleon automatically terminates the run. This saves time 
and increases the efficiency of sample processing and fraction collection. 

Area 
The Area peak result variable specifies the area between the signal curve, 
the baseline, and the perpendicular delimiters, if required. The (resolved or 
non-resolved) baseline considerably influences the size of the peak area. 

signal

rider

skimming
tangent

base-
line

non-resolved
baseline

perpen-
dicular  

Rider peaks have a separate area that is limited by a skimming tangent and 
the signal curve.  

The peak area is computed from the summation of trapezoids. The 
trapezoidal area between the two data points (T1,A1) and (T2,A2) is 

Area =  (T2-T1)*((A1+A2)/2). 
After the corresponding trapezoids of all data points have been summed 
up, the baseline is subtracted. For the (B_T1,B_A1) and (B_T2,B_A2) 
baseline points at peak start and at peak end, the baseline area is 
computed as  

Area =  (B_T2-B_T1)*((B_A1+B_A2)/2). 
The areas of the rider peaks are computed accordingly and subtracted from 
the corresponding main peaks. 

The dimension of the area depends on the used detector type. For UV 
detectors, the dimension is usually specified in mAU * min (milliabsorbance 
minutes). 
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Asymmetry 
The Asymmetry peak result variable is a measure for peak fronting or 
tailing. The peak asymmetry helps evaluating the column quality as long as 
the analysis conditions (solvent, column type, etc.) are identical. 

Theoretically, peaks correspond to a symmetrical Gauss distribution. Any 
insufficient separation deviates from this ideal. That is why you should 
analyze and eliminate any distinct asymmetry.  

The parameter has no dimension and is defined differently, depending on 
whether using the USP, EP, or AIA standard:  
 
Asymmetry Calculation  
USP/EP standard 
 
 %5

%5%5

*2 LW
LWRWA +

=
 

100 %

10 %
5 %W5 %

W10 %

RWLW

Peak Height

 
AIA standard 

%10

%10

LW
RWA =

 

 

With: 
RW5% LW5% 
RW10/%, LW10% 

Right and Left peak width in  
5% and 10% of the peak height. 

 

 
For ideal peaks, asymmetry is A = 1. However, for real tailing peaks A is 
between 1.2 and 5 (USP/EP standard). Values higher than 5 usually 
produce imprecise quantitative results.  

If the asymmetry is calculated in 10% of the peak height, this value is 
referred to as Skewness. 

Select the column in the report, select Column Properties on the context 
menu, and then select the Asymmetry variable from the Variables list. 
Click Parameter. In the Parameter Input for 'Peak Asymmetry' dialog 
box, specify whether the calculation is based on the USP/EP or AIA 
standard. 

 Note:  
EP = European Pharmacopeia, USP = United States Pharmacopeia 
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Atlas Electrolytic Suppressor (AES) 
See Suppressor  

Audit Trail 
The Audit Trail is a daily event log that is maintained independently for 
each system. It facilitates compliance with GLP (Good Laboratory 
Practice) by recording all events related to instrument operation, such as 
system events, pre-run device settings, executed command, and error 
messages. In addition, you can include the current audit trail on the 

Control Panel.  

For more information, refer to Data Management  Audit Trails. 

Auto Autoscale 
Select the Auto Autoscale option to automate the performance of the 

Autoscale function. During data acquisition, the Auto Autoscale option 
adjusts the scaling of the signal axis exactly to the size of the open 
chromatogram whenever the signal leaves the signal plot in y direction. 

Auto Plot Speed 
Select the Auto Plot Speed option to automatically increase the time axis 
on a signal plot when the end of the signal plot is reached. The time is 
increased by the period defined on the Axis/Decoration tab page. 

Autopurification 
Chromeleon supports automatic fraction collection, also referred to as 
autopurification. In the first step, individual samples are analyzed to 
determine whether fractionation is appropriate. This can depend on the 
following criteria: 
• Existence of a target compound  
• Purity of the target compound 
• Amount of the target compound 
• Additional user-defined conditions 
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It is possible to define a maximum of ten target compounds. If all conditions 
are fulfilled, the sample is fractionated. This step, too, is 
chromatographically monitored. Finally, additional chromatographic 
analyses can be performed for the individual fractions. 

This process can be automated via Post-Acquisition Steps: 

Select Create Purification Samples to create the samples for purification. 

Select Create Fraction Analysis Samples to create fractionated samples. 

The ⇒Auto Purif. Type sample variable identifies the autopurification step. 

1. Analytic = original, analytical sample 

2. Preparation = preparative sample 

3. Fraction = fraction or tubes generated from the preparative sample 

If samples of these three sample types belong together, their ⇒Auto Purif. 
Ref entries in the sample list are identical.  

 Tip:  
In order to perform autopurification, a Purification license must be installed 
on your PC. 

For information about how to perform autopurification, refer to How to …: 
 Collecting Fractions Automatically (Autopurification) and to the 

operating instructions for the Autopurification Systems series. 

AutoQ Equipment Qualification 
Dionex AutoQ combines different tools for the automatic qualification of 
both Chromeleon software and a wide range of chromatography 
instruments. Thus, AutoQ provides comprehensive functions for quick and 
easy compliance with the required qualification regulations. A key feature of 
Dionex AutoQ is that the tests are available not only for Dionex 
instruments, but for instruments from other manufacturers, also. 

Dionex AutoQ is available for the following systems: 
• Chromeleon software  

• Dionex IC modules and Summit HPLC modules 

• Agilent 1100 HPLC System modules 
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• Shimadzu LC10 and LC2010 HPLC instruments 

• Shodex RI-101 HPLC Refractive Index Detector 

• TSP HPLC modules 

• Waters HPLC devices (including the Alliance 2690/2695 Systems and 
the 996/2996 PDA's) 

For more information, refer to Validation, AutoQ, and System Wellness 
 AutoQ Equipment Qualification. 

Autosampler 
Autosamplers allow routine analyses to be automated. Depending on the 
autosampler type and model, a number of samples can be prepared and 
then processed (injected) in a Batch (automatic batch processing).  

When operating an autosampler, it is important to understand the difference 
between sample loading and sample injection. 

Loading the Sample 
The fluid input and output are directly connected. The sample is transported 
from the pump, through the autosampler, and on to the column. In a second 
cycle, the volume to be injected is drawn from a sample vial into the sample 
loop, using a syringe. 

Injecting the Sample 
To inject the sample, the needle descends into the needle port (GINA 50 
and ASI-100) or the inject port (AS and AS50). The injection valve is 
switched, directing the solvent flow through the sample loop and the needle 
port or inject port to the column. Any sample remaining in the syringe is 
directed to waste. 
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Example for a load/inject process (here: the Dionex ASI-100 
autosampler): 

Needle

NeedleLower Lower

Sample rack

Waste

Waste

Syringe

Syringe

Suction

Expulsion

Load

Inject

Pump PumpColumn Column

Needle seat

Needle seat

Injection valve

Sample
Sample

Sample rack

1

1

2

2

3

3

4

4

5

5

6

6

Sample loop Sample loop

LOAD MODE INJECT MODE

 
 
The Dionex Gina 50, ASI-100, AS, and AS50 autosamplers function on this 
basis. Apart from the standard models, versions providing temperature 
control (Gina 50T and ASI-100T) and preparative versions (ASI-100P, ASI-
100PT with temperature control) are available. In addition, the standard 
version of ASI-100 autosamplers supports derivatization and method 
programming. 

For more information, refer to Control  Dionex Autosamplers. 

Autoscale 
Each time the Autoscale command is selected, the scaling of the signal 
plot is adjusted exactly to the displayed window section; for example, the 
height of a peak. The adjustment depends on the method.  

For instance, the difference between the maximum and minimum value of 
the largest peak fills 80% of the signal axis in online mode and 100% in the 
PPA representation. 

Select Auto Autoscale to perform autoscaling automatically.  
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Autozero 
The Autozero command resets physical or Virtual Signals to zero. All 
values that are subsequently measured are interpreted and displayed in 
relation to the new zero point. This is usually indicated in the chromatogram 
by a sharp increase in the absorption value. 
 

 Tip: 
Enter the command separately for each detector if several detectors are 
switched in series. 

Also, refer to ⇒Autozero 

Average 
The Average parameter allows you to average signals. Signal averaging is 
possible for digital signals that are sent to the server PC by the detector, 
such as the Dionex UVD 170U and UVD 340U detectors, and for analog 
signals recorded via the UCI Universal Chromatography Interface.  

The Dionex UCI records each analog signal with a frequency of 100Hz. 
This corresponds to a ⇒Step of 0.01 second or a Sampling Rate of 100 
data points per second. When you increase the step or decrease the 
sampling rate, fewer data points are stored than theoretically possible.  

Also, refer to ⇒Average 

Averaged Baseline  
The Averaged Baseline is a baseline that is valid throughout the entire 
chromatogram. The baseline can be defined for single chromatograms.  

For more information, refer to How to …: Working with Chromatograms 
 Defining an Averaged Baseline. 
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Backup 
Select Backup to store data for data security. For information about how to 
back up data, refer to How to …: Creating and Managing Files and Data 

 Creating Backup Files. 

Chromeleon stores data in databases or other files organized in a 
hierarchical directory structure. There are many cross-links among the 
included objects. For problem-oriented data archiving, it is necessary to 
know how the individual objects are linked with each other. As conventional 
backup and archiving programs do not support this, Chromeleon has its 
own backup program. The Chromeleon backup program supports the 
following functions:  
• Archiving of all objects displayed in the Browser (samples, sequences, 

files, entire directory trees, etc.), together with all linked files ( Raw 
Data, audit trails (see Data Management  Audit Trails), history, 
preferred Report Definition File (RDF), etc.). 

• Selective restoration of objects stored using the Backup command 
• Compressing the stored data 
• Dividing the backup files on several media; for example, disks or ZIP 

media 
• Optionally deleting original files after the backup has been performed 

successfully 
• Generating the corresponding entries in the History 
Backup files are located outside the Datasource. That is why they are not 
stored within the directory structure of the datasources. They have no file 
history and the user management does not protect them. Select Restore 
to restore backup files that were created using the Backup command. (For 
more information, refer to How to …: Creating and Managing Files and 
Data  Restoring Backup Files.) 

 Tip  
If you have created a backup file that contains a new feature, please keep 
in mind that you cannot read this file with a Chromeleon version that does 
not support this feature. For example, this refers to: 

• Sequence Report Columns (available since Chromeleon 6.50) 
• ⇒Std. Add. Group and ⇒Ref. Amount Set sample columns (available 

since Chromeleon 6.60) 
• The Trend Plot (available since Chromeleon 6.50) 
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Bandwidth 
The bandwidth is the nm range at which the chromatogram is recorded. 
The bandwidth usually corresponds to the Optical Resolution.  

The bandwidth can be selected by averaging several single photodiode 
signals. This process is known as Diode or Wavelength Bunching. 
Averaging is performed symmetrically to the selected wavelength. Thus, at 
a bandwidth of 31 nm and a wavelength of 255 nm, for example, the 
signals of all photodiodes in the range of 240 to 270 nm are averaged. 

Also, refer to ⇒Bandwidth 

Baseline 
The line drawn from peak start to peak end for calculating the peak area is 
called baseline. 

 Note: 
In colloquial language, the chromatogram section between two peaks is 
also referred to as baseline.  

Baseline Correction of Spectra 
Automatic correction of a spectrum by a calculated baseline spectrum 
allows you to compare single spectra, even under varied conditions. 
Especially peak spectra on a gradient or of Rider Peaks can be compared 
more precisely after a large "underground portion" (due to the gradient 
portion or the larger main peak) is now removed.  

When the spectra plot (Show Spectra) is displayed, it is always corrected 
by the baseline spectrum. If you enable Baseline correction in the PPA 
(Peak Purity Analysis) view, the baseline spectrum is also subtracted for 
this view.  

Establishing a Baseline Spectrum 
Based on the peak recognition algorithm, Chromeleon establishes the start 
and end of all peaks for the Reference Channel and marks these points 
by positioning peak delimiters (ta and te). The Baseline (I) is drawn 
between the two delimiters.  
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b)

I II III

ta te  
 
This is performed for all detected wavelengths. The absorbance values at 
all wavelengths measured at the time ta and te result in the baseline 
spectrum of the peak start and peak end (II, a and b). Chromeleon 
interpolates the two spectra and calculates a separate baseline spectrum 
for each data point of a peak. By definition, the 3D field is zero outside the 
peak delimiters if baseline correction is enabled.  

Each spectrum measured at a given time t can now be corrected by a 
calculated baseline spectrum (III). 

Baseline Correction with Manual Re-Integration 
Manually shifting the peak delimiters necessarily influences the baseline 
spectrum. After each manipulation, the new baseline spectra are 
automatically re-interpolated and re-calculated.  

Depending on the changes to the peak delimiters, this will also change the 
spectrum, for example, the spectra plot.  
 

 Tips: 
Baseline correction can only be performed for the spectra of those peaks 
that are part of the integrated reference channel. 

Baseline correction near the detection limits often considerably smoothes 
the PPI and Match Curve because it eliminates the spectral baseline 
portion. 
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The PPA report is always baseline corrected. 
If you add a spectrum from the spectra plot to the spectra library using the 
Windows clipboard, the spectrum will always be baseline-corrected. 
If you add a spectrum from the PPA method to the spectra library using the 
Windows clipboard, the spectrum will always be baseline-corrected, 
independent of the settings on the General tab. (To access the General 
tab, open the PPA view and select Decoration on the View menu.) 
Baseline Correction influences only the representation of the PPA view. 

Baseline Correction of I-t Plots 
I-t plots can be corrected by subtracting a calculated baseline I-t plot from 

the 3D_Amp data. This lets you compare single I-t plots, even under 
varied conditions. For example, I-t plots of peaks on a gradient or of Rider 
Peaks can be represented more precisely because a large "background 
portion" (due to the gradient portion or the larger main peak) is now 
removed. 

 Tip: 
To apply baseline correction to 3D amperometry data, select Decoration 
on the context menu and select Baseline correction on the General tab 
page. 

Establishing a Baseline I-t Plot 
Based on the peak recognition algorithm, Chromeleon establishes the start 
and end of all peaks for the channel and marks these points by positioning 
peak delimiters (Ta and Te). The Baseline (I) is drawn between the two 
delimiters.  

Waveform
Time

Retention Time

R
espon se

nA

Ts Te T
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This is performed for all waveform times (t). The response (nA) at all 
waveform times measured at the time Ts and Te result in the baseline I-t 
plot of the peak start and peak end (II, a and b). Chromeleon interpolates 
the two I-t plots and calculates a separate baseline I-t plot for each data 
point of a peak. Each I-t plot measured at a given retention time (T) can 
now be corrected by a calculated baseline I-t plot (III). By definition, if 
baseline correction is enabled, 3D amp data is zero outside the peak 
delimiters.  

The plot below is an example of 3D amperometry data before baseline 
correction is enabled. 

  

The plot below shows the same data after enabling baseline correction. 
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Baseline Correction with Manual Re-Integration 
Manually shifting the peak delimiters necessarily influences the baseline I-t 
plot. After each manipulation, the new baseline I-t plots are automatically 
re-interpolated and re-calculated.  

Also, refer to  The 3D Amperometry Window. 

Baseline Point 
The Baseline Point detection parameter defines a baseline point at the 
indicated time. 

Also, refer to ⇒Baseline Point 
 
For information about how to apply detection parameters refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 

Baseline Value at Peak Start/End 
In contrast to the Signal Value at Peak Start/End variable, which indicates 
the actual signal value of the signal curve, the Baseline Value at Peak 
Start/End peak variable indicates the baseline signal value at the peak 
start or the peak end.  

Base Peak 
The mass peak with the highest intensity in a Mass Spectrum is called 
the base peak. It serves as a reference point for representing relative 
intensities (base peak = 100 %). 
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Batch 
Repeating a processing step several times is referred to as batch 
processing (also called batch or online batch). Processing a batch in 
chromatographic applications means that several samples are 
automatically processed or analyzed in a defined order. Distinguish 
between: 
• Online batch = batch during the chromatographic analysis 

• Offline batch = batch after the analysis 

After the chromatographic analysis of a batch, you may print or export the 
results or process them using an external program. To perform these 
actions, select Batch Report on the File menu in the Browser. The Batch 
Report uses the settings selected for the Batch Report Setup of the 

Printer Layout. A sample batch is also processed during the batch report. 
In this case, the batch is referred to as offline batch. 

For more information, refer to Samples and Sequences  Automatic 
Batch Processing. 

 Note: 
Each modification of a quantification method results in an immediate 
recalculation of all involved variables. It is not necessary to recalculate 
data, as the displayed data is always up-to-date. This is to avoid 
inconsistencies between the QNT Method and the results. 

Binary-Coded Decimal Code ("BCD") 
Autosamplers that can be controlled via binary code (BCD-enabled 

autosamplers) can communicate the autosampler position from which the 
injection was performed to Chromeleon. This requires that the autosampler 
outputs be connected to the BCD inputs on, for example, the UCI 
Universal Chromatography Interface.  

For more information about how to proceed, refer to the configuration of the 
Remote Inject Device Driver in the Server Configuration program (F1 
key). 
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Blank Run Sample 
A chromatogram for which the solvent absorption (= baseline) is recorded 
but no sample is injected is referred to as a blank run. In the sample list, 
blank samples are labeled Blank and marked by the following symbol: . 
The optional Blank parameter of the ⇒Inject command forces an injection 
for blank run samples if the Inject option is selected. However, an injection 
is not usually performed for these samples (default: Skip). Apart from this, 
blank samples are treated like normal integration samples in the 

Program. 

 Tip:  
For ICS ion chromatography systems, injection is performed with the 
Pump_InjectValve.InjectPosition command (if no AS or AS50 is 
installed). With the Pump_InjectValve.InjectPosition command, an 
injection is always performed, also for a blank run sample. This is contrary 
to the autosampler ⇒Inject command.  

Blank samples are stored with the sequence. After a baseline or Blank 
Run Subtraction has been performed, it can be undone at any time. 

Also, refer to Matrix Blank Sample 

Blank Run Subtraction 
If the Raw Data of a signal (channel) is corrected by the raw data of a 
comparable Blank Run sample, this is referred to as blank run 
subtraction. The chromatogram of the blank sample is subtracted point by 
point from the open chromatogram. However, with a Matrix Blank 
Sample, the peak areas are determined before they are subtracted from the 
corresponding peak areas of all samples in the sequence. 

 Tips: 
Perform blank run subtraction if a reproducible shift in baseline is interfering 
with peak detection; for example, with gradient elution. 
Because both the normal and the blank run sample are saved, you can 
undo or restore the subtraction at any time. 
A special interpolation procedure is used to subtract two 3D fields even if 
the recording conditions are not identical; for example, different wavelength 
range or optical resolution. However, this procedure should not be used 
except in special situations.  
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Branch  
Select Branch to branch to a different Program from the active program 
or to start a program from the Control Panel by clicking a script button on 
the panel. Also, refer to ⇒Branch 

Browser 
In the Chromeleon Browser, set up, delete, and move Datasources, 
subordinate directories, and files. The Browser displays samples, methods, 
and programs as well as further details of a Sequence. Double-click to 
open the desired file. For more information, refer to Data Management 

 The Browser. 

 Caution: 
Browser functions and structure are similar to the Windows Explorer. 
However, do not confuse the Browser with the Windows Explorer. Do not 
use the Windows Explorer for operations within Chromeleon datasources. 
Administrators can prevent these operations by selecting the Protect 
Datasource Directory option on the General tab page (via Properties on 
the datasource context menu). 

Bunch Width 
The signals of several photodiodes can be averaged or bunched to 
enhance the Signal-to-Noise Ratio of a Photodiode Array Detector. The 
bunch width describes the sample bandwidth of a bunch of photodiodes. 
Also, refer to ⇒Bunch Width. 

Bypass Mode (ASI-100) 
To reduce the cycle time for short chromatograms, the Dionex ASI-100 
autosampler features the bypass mode. The MsvToLoad command allows 
bypassing the sample loop in the chromatographic flow. In this way, you 
can start the next sample even before the analysis of the current sample is 
finished by conditioning the solvent line(s) between the injection needle and 
the motorized switching valve (MSV), as well as the sample loop before 
loading the next sample.  

For more information, refer to How to …: Creating and Modifying 
Programs  Setting the Bypass Mode Options (ASI-100). 
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c0 
See Offset (c0) 

c1 
See Slope (c1) 

c2 
See Curve (c2) 

c3 
See Cubic Coefficient (c3) 

Calibration Functions, Calibration Coefficients 
In each calibration, a mathematical ratio is established between the 
⇒Amount of a standard sample f(A) and the corresponding area value (A). 
Depending on the location of the Calibration Points, the ratio can be 
linear, a parabola, or exponential. Select the ⇒Calibration Type and by that 
determine the shape of the calibration points. The corresponding 
mathematical functions are called calibration functions. 

Linear (Lin) AxcAf 1)( =  min. 1 calib. point  

Linear with offset (LOff) AxccAf 10)( +=  min. 2 calib. points  

Quadratic (Quad) 
221)( AxcAxcAf +=  min. 2 calib. points  

Quadratic with offset (QOff) 
2210)( AxcAxccAf ++=  min. 3 calib. points 

Cubic: 
3

3
2

21)( AcAcAcAf ++=
 min. 3 calib. points 

Cubic with offset (COff): 
3

3
2

210)( AcAcAccAf +++=
 min. 4 calib. points 

Exponential (Exp) 
10)( cAxcAf =  min. 2 calib. points 
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The value of the corresponding calibration coefficient (c0, c1, c2, or c3) 
describes the slope of the straight line (linear course) or the shape of the 
curve (non-linear course). The coefficients are calculated by simply 
replacing known amount and area values in the corresponding calibration 
function (standard sample). If c0, c1, c2, and c3 are known, it is also 
possible to calculate the amounts for an unknown sample. For more 
information, refer to Theory of Calibration  Calibration (Overview) and 

 Evaluation with Various Standard Methods. 

Calibration Mode 
The calibration mode determines how a specific sample of a sequence is 
calibrated and which standards are used. Chromeleon provides six 
calibration modes. Select the calibration mode on the General tab page of 
the QNT Editor (see The QNT Editor  The General Tab Page). (For 
information about the editor, see Data Representation and Reprocessing 

 The QNT Editor.) Also, refer to ⇒Calibration Mode 

Calibration Point, Calibration Level, Replicates 
If the peak area is determined for the known amount of a standard sample, 
the point resulting from both values in an x, y-diagram is referred to as 
calibration point.  

If the corresponding peak area is determined several times for the same 
⇒Amount, different area values are received, depending on the precision. 
Thus, a larger number of calibration points is obtained. Calibration points 
based on the same concentration are referred to as replicates of the same 
concentration level.  

Calibration points of different levels are obtained when area values are 
determined for various amounts of a standard. This can be achieved by a 

Dilution Series or by varying the injection volume. Based on the 
calibration points, data system calculates the calibration coefficients of the 

Calibration Function selected by the user. 

For more information, refer to:  

Theory of Calibration  Calibration (Overview) and  Calibration 
Principle 
How to …: Calibrating  Weighting and Averaging Calibration Points  
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Calibration Type 
The Calibration Type peak table parameter describes the mathematical 
model function ( Calibration Function) based on which Chromeleon 
calculates the calibration curve by inserting the c0, c1, c2, and c3 
calibration coefficients.  

Also, refer to ⇒Calibration Type 

For more information about the calibration types, refer to Theory of 
Calibration  Calibration Types (Linear) and  Calibration Types 
(Non-linear). Also, refer to How to …: Calibrating  Weighting and 
Averaging of Calibration Points. 

Calibration Variables 
Numerical calibration values are referred to as calibration variables. They 
can be included as a separate column in any table created by Chromeleon. 
The following variables are calculated: 

⇒Calibration Type 
Coefficient of Determination 
Correlation Coefficient 
DOF-Adjusted Coefficient of Determination 
Curve c2 
Number of Calibration Points 
Number of Disabled Calibration Points 
Offset c0 
Relative Standard Deviation 
RF Value 
Slope c1 
Standard Deviation 
Variance Coefficient 
Variance 
Weights 
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Capacity Factor (k´) 
The k´ peak result variable refers to the capacity factor, that is, to the ratio 
of the net retention time to the ⇒Dead Time: 

0

0'
t

tt
k R −

=
 

Where  

k' = Capacity factor 

Rt  = Retention time 

0t  = Dead time 

To achieve a reasonable compromise between the retention time and the 
required analysis time, k´ should be a value between 1 and 5.  

The calculation can be performed only if you have entered the dead time of 
the system on the General tab page in the QNT Editor (see The QNT 
Editor  The General Tab Page. For information about the editor, see 
Data Representation and Reprocessing  The QNT Editor.) 
 

0t  May either be measured at the inert peak or calculated as the quotient 
of the dead volume and the flow.  

 If  ,00 =t is not calculated. 
 
Select the column in the report. Select Column Properties on the context 
menu, and then select the variable from the Variables list box. Click 
Parameter to define the dead time required for the calculation. 

Cascade  
Select Cascade on the Window menu to arrange the open windows one 
behind the other. This arrangement provides an overview of the currently 
open windows and allows you to quickly change to the desired window. 
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Channel 
If a detector delivers more than one Signal, for example, a multi-channel 
UV detector, the single signals are referred to as channels. 

Check Commands 
Chromeleon allows you to perform various checks: 

Syntax Check 
A syntax check is automatically performed for each Program. The syntax 
check verifies that a program complies with the program syntax. For 
example, the syntax check may detect the following: 
• Exceeded value ranges  

• Incorrect punctuation 

• Misspellings 

Errors that are detected by the syntax check are written in red letters. 

Semantics Check 
The semantics check verifies the (chromatographic) meaning of a program. 
This includes, for example, the following checks: 
• Do all partial flows sum up to 100 %? 

• Does the program contain an ⇒Inject command at the time t = 0.000? 

• Are the Inject/⇒AcqOn/Off commands listed in the correct order? 

• Is the minimum difference between the emission and the excitation 
value observed? 

• Is the last command an ⇒End command? (Absolutely necessary) 

To check the semantics of a PGM File, select Check on the context menu 
in the PGM Editor. To check the semantics of a script button, right-click on 
the button, select Properties on its context menu, and then click Check on 
the Command tab page. Detected errors are indicated in a dialog box. 
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Ready Check 
The Ready Check checks whether the connected instruments are ready 
to operate; for example, to process a sample batch. The check includes:  
• Is the instrument turned on? 

• Are all instruments connected correctly? 

• Is the lamp turned on? 

• Are all required files available? 

• Is there sufficient storage capacity? 

In the Batch dialog box, click Ready Check to perform the ready check. In 
addition, a ready check is automatically performed for each online 
command. If a problem is detected, an error message or warning is 
displayed. 

The semantics check usually includes the syntax check. The ready check 
usually includes the semantics check. 

Check Derivative 
See ⇒Check Derivative 

Chemiluminesence  
Emission of light caused by chemical reaction is referred to as 
chemiluminescence. Compared to Fluorescence and Phosphoresence, 
excitation by a light source is not required.  

Some reactions that cause increased chemiluminescence occur in 
solutions; they are used for chemical analysis. To generate 
chemiluminescence, commercialized GC detectors use, for example, 
ozone, molecular fluorine, and sodium vapor. In HPLC applications, the 
reactions of luminol, lucigenin, and oxalate esters are often used. 

Chemiluminescence detection is more sensitive than fluorescence 
detection as there is no disturbance by the diffused light of an excitation 
light source. It is often possible to use a fluorescence detector for 
chemiluminescence detection, too, by turning off the lamp. 
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Chromatogram Overlay 
See Overlay  

Chromatographic Methods 
All instructions and parameters regarding the chromatographic treatment, 
that is, the analysis and processing of a sample, are referred to as 
chromatographic methods. Depending on the included information, the 
following distinction is made: 
 
Chromatographic Method Description 

Program (part of the PGM File) Commands and instructions enabling automation of the 
analysis. 

Quantification methods (QNT) All parameters required for qualitative peak identification 
and for quantitative area determination.  

The data is either stored in the Sequence Directory or copied to this 
directory by Chromeleon. 

Chromatography Server 
See Server 

Chromeleon Xpress 
The Chromeleon Xpress program provides real-time control and monitoring 
of Dionex chromatography instruments. It is installed on a Tablet PC and 
functions as the front panel user interface for the instruments connected to 
one local Chromatography Server.  

Refer to  Welcome to Chromeleon Xpress in the Chromeleon Xpress 
User Help section for details. 
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Client 
Workstations that can start Chromeleon are called clients. The client 
provides a user interface for accessing chromatography data and 

Datasources as well as appropriately representing their contents. 

To control or monitor a chromatography system from a client PC, the client 
must be connected to the Chromatography Server. This connection is 
usually established when you open a Control Panel and connect to the 
desired Timebase. Once the connection is established, you can access 
the devices installed on the server.  

To manage database access, Chromeleon uses the capability of modern 
operating system to share resources (see Chromatography Systems: 
Hardware and Software  Operating Systems). A client can access all 
files or datasources for which sharing was issued on a different workstation. 

In addition, monitoring and controlling a system is only possible via the 
client. To do this, the client must connect to a (chromatography) Server. 

In combination with a network (see Chromatography Systems: Hardware 
and Software  Network), this allows you both to operate a system and 
to represent the system status and the course of the open chromatogram 
from any client! Due to access conflicts, it is not possible to synchronize 
system control over several clients.  

CmUser and CmSecure Programs 
See User Manager and Security Activation Tool 

Coefficient of Determination 
Use this variable to display the Coefficient of Determination, which 
reflects the deviation of the measured data points from the calibration 
curve. The coefficient of determination can have any value between 0 and 
1 (0 to 100%). A coefficient of 1 indicates that all calibration points are 
exactly on the calibration curve. Use the following formula to calculate the 
coefficient of determination: 

∑

∑

=

=

−

−
−= N

i
ii

N

i
iii

YYW

XFYW
R

1

2

1

2

2

)(*

))((*
1

 



 Glossary A-35 

With: N Number of standard samples participating in the calibration 
 i Index for standard samples 
 Wi Weight factor of the standard sample no. i 
 F(x) Model function of the calibration 
 Xi X-value of the standard sample no. i 
 Yi Y-value of the standard sample no. i 
 Y  Average of all Y-values.  

 Tip: 
For a linear calibration plot that is not forced through the origin, the 
coefficient of determination is identical to the squared Correlation 
Coefficient. In all other cases, this does not apply. 

Also, refer to DOF-Adjusted Coefficient of Determination 

Column Mode (DX-120) 
Column mode enables switching of flow from one column set to another in 
a DX-120 Ion Chromatograph equipped with the dual-column option. When 
the column is switched, the eluent flow is also switched. For example, when 
column A is selected, flow is from eluent reservoir A through column A. If a 
command switches the flow to column B, flow is then from eluent reservoir 
B through column B. Also, refer to Eluent Mode 

The ColumnAB command is used to switch the flow from one column set to 
the other. The command can be included in a Program, executed directly 
from the Commands dialog box (select Command… on the Control 
menu), or linked to a Control on the control panel. To link the command to 
a control, place an edit box or switch control on the control panel (see 

Layout Toolbar). Then, link the control to the ColumnAB object property. 
For more information, refer to How to …: Controlling Devices from the 
Control Panel  Linking a Control to a Device. 

To enable Column Mode: 

1. Open the Server Configuration. 

2. Select the DX-120 in the timebase. 

3. Double-click to open the Properties dialog box (or right-click and select 
Properties). 

4. Select the Mode tab page, and then select the Column option. 
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Column Temperature 
The Column Temperature command determines the nominal temperature 
of the column thermostat (column oven). 

After defining the nominal temperature, the thermostat is set as quickly as 
possible to the new temperature (device-dependent). A linear interpolation 
between the actual value and the nominal value is performed.  

It is also possible to enter several temperature commands ( PGM File). In 
this case, the result is a Step Profile instead of a linear interpolation 
between two values! 
 

 Tip: 
As with all instrument parameters, Chromeleon attempts to represent the 
actual temperature on the screen. It depends on the connected column 
thermostat whether this is possible. 

Comment 
Chromeleon allows you to enter a comment at different places. 
• In the ⇒Comment column of the sample list, enter any sample 

description in addition to the sample name. 

• In the Comment column of the peak table of the QNT Editor (see Data 
Representation and Reprocessing  The QNT Editor), enter any 
comments regarding the sample.  

• Comments are often needed in a Program. To enter a comment in 
the PGM File, enter a semicolon (;) in front of the comment text. The 
text is then written in green letters.  

• In the Comment column of a spectra library, enter any comment on the 
individual spectra. 

• On the General tab page of the Datasource Properties (select 
Properties on the context menu), specify that all modifications be 
logged in the History. If the Comment required option is enabled, a 
dialog box opens whenever you save a modification and prompts you 
to comment the respective change. 
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If required, Chromeleon automatically enters a comment at two places in 
the QNT Editor: 
• If you have the system create the peak table automatically (select 

Autogenerate Peaktable on the Edit menu), the Comment column of 
the peak table shows the following entry:  
- Autogenerated (if Enumerate peaks of current chromatogram is 
selected) or 
- Autogenerated. Spectrum: Reference spectrum name, Match: 
Match Factor (if Use spectra library screening results has been 
selected). 

• In the Calibration Comment column on the Calibration tab page, 
Chromeleon comments the calibration. Usually, this comment will read 
OK. However, it may also indicate a calibration error or inconsistencies 
in calibration. 

You may output the respective comments using the corresponding 
variables of the single ⇒Report Categories in the Report and in the 

Printer Layout. 

Concentration 
The Concentration peak result variable describes the quotient of the 
calculated ⇒Amount and the injection ⇒Volume. The value thus specifies 
the amount of a substance contained in a micro liter (µl) of the injected 
volume. 

 Tips: 
This variable is especially meaningful if you enter an absolute amount 
value, such as 15.00 µg, in the amount column of the peak table instead of 
a concentration value; for example, 1.0 µg/µl.  

In this case, the value is divided by the injected volume, for example, 20 µl, 
which results in comparable absolute amount values that are always 
normalized to 1 µl; for instance, 15 µg/20 µl = 0.75 µg per µl.  
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Confidence Interval/Confidence Range 
General Definition 
The confidence interval describes the range in which the true value is 
found, with a given probability. According to the respective probability, you 
can define the corresponding confidence interval of the concentration or 
amount value for each measured value.  

Calibration Curve 
If the single points of the confidence intervals are connected in a calibration 
curve, they indicate the confidence range of the curve: 

 

In the above example, the confidence interval is given at a probability of 
99%: In addition, a measured value of 25 mAU*min is indicated. The 
concentration determined by the measured value and the calibration curve 
is 6.3 µg/ml (black, uninterrupted line). Besides, the two intersections with 
the limiting curves of the confidence interval indicate that the true 
concentration value will be between 6.0 and 6.6 µg/ml (probability = 99%). 
In addition, if the measuring uncertainty of the measured value is 
±1 mAU*min, that is, between 24 and 26 mAU*min, the concentration will 
be between 5.7 and 6.9 µg/ml (probability = 99%; see the blue auxiliary 
lines). 
Moreover, you can derive the Limit of Detection  (= LOD) from the 
diagram. The LOD is the concentration of the lower limiting curve of the 
confidence interval, which corresponds to the intercept of the y-axis of the 
upper limiting curve. In the above example, the LOD would be at 0.75 µg/ml 
at a probability of 99%.  
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Confidence Interval in the Calibration Curve 
It is also possible to indicate the confidence interval graphically in the 
calibration curve. For more information, refer to How to …: Displaying 
Calibration Curves  Indicating the Confidence Interval. 

Confidence Interval in the Report  
In addition, you can indicate the limits of single confidence intervals in the 
Report using the Upper and/or Lower Confidence Limit variables of the 
⇒Peak Calibration report category. You can choose between different 
parameters, which allow you defining the values for which to indicate the 
confidence intervals. 

For more information, refer to How to …: Creating and Using Report 
Tables  Setting Parameters for Variables (e.g., for the confidence 
interval). 

Connect 
Select Connect to Timebase on the Control menu of a control panel to 
connect a user PC ( Client) to a Timebase ( Chromatography Server). 
In a  Network Installation, you use this command to connect the current 
client to any server on the network.  

Select Connect Device to connect a device to the server and thus, to 
control the device by Chromeleon (remote control). The command first 
checks whether the specified device is actually connected, and then it 
activates the instrument. The Connect command is automatically executed 
for all installed instruments whenever the program is started. 

 Note: 
For safety and GLP reasons, the instrument keyboard is locked on most 
instruments that have been connected using the Connect command. In 
Connect status, the instrument is exclusively under remote control. Input 
on the instrument is possible again only after you have executed the 
Disconnect command. 

Also, refer to ⇒Connect/Disconnect 
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Contents (Button) 
The Contents tab page in the online Help displays the table of contents. 
Click a book icon to display the topics in a chapter. Click a document icon 
to open a specific Help topic. 

Continue 
The Continue command cancels the ⇒Hold and ⇒StopFlow commands 
and continues an interrupted sample batch or an interrupted pump flow. 

Also, refer to ⇒Continue 

Control 
Elements that can be surrounded by a Control Frame by left-clicking in 

Layout Mode are referred to as Controls.  

On the Layout Toolbar, Chromeleon provides various standard controls. 
Authorized persons can use the controls in Layout Mode to create a new 

Control Panel. 

If a control is later placed on another control, it is subordinate to the first 
one. That is why certain modifications to the reference control, such as the 
font or the Autosize command, will also affect the new control.  

Press the <Shift> key to select several controls. 

Control Frame 
The control frame marks the outline of a Control. Draw the control frame 
to move, enlarge, or reduce the control in size. 

Control Panel 
In online control, the window in which control and display elements are 
combined is called the Control Panel. The control and display elements 
allow you to control and/or monitor a Timebase. The timebase to be 
controlled is typically assigned when the control panel is created. Select 
Connect to Timebase on the Control menu to change the assignment. To 
save the new assignment, select Save As from the File menu. 
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Use the design tools provided on the Layout Toolbar to adapt the control 
panel to your requirements. If you have the corresponding rights, you can 
also create a completely new control panel. To create or modify a control 
panel, enable the Layout Mode. 

Chromeleon also provides easy-to-use default panels for new users. All 
control panels are saved as PAN files (*.pan). 

Control panels are also included in Panel Tabsets.  

Also, refer to:  

How to …:  Controlling Devices from the Control Panel 

How to …:  Controlling Devices from the Panel Tabset 

Correlation Coefficient (Linear) 
The linear Correlation Coefficient indicates the "linear dependence" 
between two variables (for example, the peak area and the amount 
(concentration) of an analyte). It can range from –1 to +1 (-100% to 
+100%). 

If all data points are located on a straight line, the correlation coefficient is 
exactly +1 or -1 (or ±100%). If the data points are scattered very much, the 
coefficient approximates 0.  

Contrary to the Coefficient of Determination, the correlation coefficient 
only indicates the linear dependence between two variables. This means 
that, for example, with a quadratic calibration function, the correlation 
coefficient may be very low due to the curve shape, although all data points 
are located on or close to the calculated curve. In this case, the coefficient 
of determination will be near 1 or 100%, whereas the correlation coefficient 
will be near zero. 

The mathematical description of the correlation coefficient is as follows: 
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With: N Number of standard samples involved in the calibration, 
 i Index for standard samples,  
 Wi Weight factor of the standard sample no. i 
 Xi X-value of the standard sample no. i 
  X  Average value of all x-values 
 Yi Y-value of the standard sample no. i 

 Y  Average value of all y-values 
 

 Tip: 
For a linear calibration plot that is not forced through the origin, the 
correlation coefficient corresponds to the square root of the coefficient of 
determination. In all other cases, this does not apply. 

Use the coefficient of determination if you are using either non-linear 
calibration curves or a linear calibration curve forced through the origin. 

CR-TC 
The CR-TC (Continuously Regenerated Trap Column) removes anionic or 
cationic contaminants in the eluent or deionized water. The CR-TC is used 
with an Eluent Generator. 

Cubic Coefficient (c3) 
The Cubic Coefficient (c3) calibration variable indicates the cubic 
coefficient of the Calibration Function that has been used. The cubic 
coefficient is not equal to 0 only for the following calibration functions: 
Cubic and COff. 

Cumulated Workload 
The Cumulated Workload variable indicates the wear and tear of a pump. 
For the Dionex P 580 pump, you can display the cumulated workload in 
megajoule (MJ). For more information, refer to Practical Tips for Device 
Control  Viewing Leak Sensor and Workload Status. 
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Curve (c2) 
The Curve (c2) calibration variable indicates the curve value of the 

Calibration Function that has been used. 

The curve value is not equal to 0 only for the following calibration functions: 
Quadratic (i.e., Quad and QOff), Cubic, and COff.  

Cyclic Voltammetry 
Waveforms for integrated amperometry are usually developed using 
information gathered with an electrochemical technique called cyclic 
voltammetry, in which the current that results from oxidation or reduction 
reactions is measured against the voltage applied to the system. The 
applied voltage is changed (scanned) within preset limits.  

In cyclic voltammetry, the voltage is first scanned in one direction and then 
the scan direction is reversed so that the voltage at the end of the scan is 
the same as at the beginning. This results in a triangular Waveform as 
shown in the example below.  

  

DAC Pump(s) 
The DAC Pump(s) driver allows you to control voltage-controlled low-
pressure pumps for which a separate device driver is not available. A 
Dionex 12-Bit DAC card is required for this. (For installation instructions, 
refer to Hardware Installation  Installing the 12-Bit DAC Card ("Pump 
DA Converter") in the Administrator Help section.) 
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The solvent composition is defined in the PGM File, as a percentage at 
the respective retention time. On the DAC FlowA tab page in the Server 
Configuration program, define the voltages that correspond to the minimum 
and maximum flow of the corresponding component. 

Data Collection Rate 
The rate at which Chromeleon collects digital data points from the detector, 
expressed as points per second or Hertz (Hz), is referred to as data 
collection rate. (Refer to Data Management  Data Acquisition for more 
information). The data collection rate of detectors corresponds to the 

Sampling Rate of A/D converters.  
• In general, each peak should be defined by at least 20 data points. For 

chromatograms with co-eluting peaks or low peak-to-noise ratios, 40 
points per peak are better.  

• If you expect all of the peaks to be relatively wide, use a slow data 
collection rate.  

• If any peaks of interest are less than a few seconds wide, set a fast 
data collection rate. 

• If the data collection rate is too slow, the peak start and end will not be 
precisely determined. If the data collection rate is too fast, data files will 
occupy more disk space and take longer to process than necessary. 

Step vs. Data Collection Rate 
In addition to the data collection rate, a step value is set. The step value is 
the reciprocal value of the selected data collection rate. For example, if you 
select a data collection rate of 5 Hz, the step value is automatically set to 
0.2 s. In general, Dionex recommends using the automatically selected 
step value (see ⇒Step for exceptions). It is possible to specify a step value 
that is independent of the data collection rate. However, only advanced 
users should do this. Refer to the detector operator's manual for guidelines. 

 Tip:  
When you issue the Data Collection Rate command, the Step value is 
automatically set to the reciprocal value. Therefore, if you want to use a 
different step value, issue the Step command after the Data Collection 
Rate command. 
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Setting the Data Collection Rate for Integrated Amperometry Data 
For 2D integrated amperometry data, the data collection rate is governed 
by the Waveform period. Chromeleon generates one integrated data 
point per waveform period. The data collection rate determines the rate at 
which this data is stored. Typically, you set the data collection rate equal to 
the reciprocal of the waveform period. Thus, every integrated data point is 
stored. It is also possible to set the data collection rate to less than the 
reciprocal of the waveform:  

data collection rate ≤ 1/waveform period 

 Note:  
The data collection rate does not apply to 3D amperometry data. 3D data is 
collected at a fixed rate of 1Khz. 

Datasource  
A database that is mounted to the Chromeleon Client is referred to as a 
datasource. To mount a datasource, select Mount Datasource on the File 
menu in the Browser and then specify the format and the location of the 
database. For more information, refer to How to …: Working with Files, 
Databases, and Networks  Setting up a Datasource in the 
Administrator Help section. 

During the initial installation of Chromeleon, a local Standard Datasource 
is created on each client PC. Chromeleon data is usually stored in an 
Access database, that is, in an mdb (Microsoft Data Base) container. The 
default datasource is based on an Access database, too. The ODBC 
Capability of Chromeleon allows you to use various other formats (dBASE, 
SQL, Oracle, etc.), as well. Both Sample Data and Sequence Data are 
saved in a datasource, independently of the chosen format.  

You can save a datasource on a local hard disk or any other mass storage 
device.  

Select New Directory on the File menu in the Browser to create individual 
subdirectories under a datasource. You can then use these directories to 
save Sequences and the corresponding data and programs. 



A-46 Glossary 

Network Datasource 
If the datasource is located on a centralized network PC, all clients with the 
appropriate access rights, which have been assigned by the system 
administrator, can access the database. If the datasource is stored on a 
local hard disk, the corresponding client grants database access via the 
Windows File Sharing option.  

The Administrator Help section provides more information; refer to How 
to …: Working with Files, Databases, and Networks: 

 Setting up a Network Datasource  

 Saving Chromatography Data on the Network 

Chromeleon also allows you to lock datasources, directories, or sequences. 
For more information, refer to Data Management  The Datasource. 

Non-Availability of the Network Datasource 
In many companies and organizations, the database server shuts down 
during the daily backup. Similar to a network breakdown (see Network 
Failure Protection), the network datasource will not be available then. 
However, in case of the daily backup the time is known during which the 
datasource will not be available. To ensure data integrity, disconnect 
Chromeleon before the shutdown. When the database is available again, 
Chromeleon automatically connects to the database and writes back any 
data that were acquired during the breakdown. 

Also, refer to How to …: Working with Files, Databases, and Networks 
 Network Failure/Non-Availability in the Administrator Help section. 

 Note: 
"Old" GynkoSoft data has the required database structure. That is why 
Chromeleon is capable of handling this data as it they were "real" 
Chromeleon data. Simply connect to the data stored under Drive....  

Data Smoothing 
See Smoothing 
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DC Amperometry Mode 
DC (direct current) amperometry mode is a basic operating mode of an 
electrochemical detector. In DC mode a constant potential is applied 
between the reference and the working electrode. 

Electrochemical detection measures current resulting from the application 
of potential (voltage) across electrodes in flow-through cells. The applied 
voltage causes oxidation or reduction of analyte molecules in the sample. 
The current produced is dependent on many factors; the most important of 
these is the analyte concentration. When you apply a constant potential 
between reference and working electrode, you can observe a proportional 
current, depending on the concentration of an oxidable or reducible 
substance.  

Also, refer to Integrated Amperometry Mode  

DC Voltage 
The DC Voltage command for the ED, ED40, ED50, and ED50A 
electrochemical detectors sets the fixed potential applied to the working 
electrode, in the range of -2.04V to +2.04V. 

Dead Time 
The dead time is defined as the time required by the peak maximum of an 
unretained substance to reach the detector from the point of injection. The 
relation between the Dead Volume and the Flow Rate is as follows: 

vm fVt /0 =  
Where: 

0t  = Dead time 

mV  = Dead volume 

vf  = Flow rate 
 
Also, refer to ⇒Dead Time 
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Dead Volume 
The volume of the mobile phase between the injector and the detection cell 
is referred to as dead volume. The dead volume is calculated from the 
⇒Dead Time and the Flow Rate based on the following formula: 

vm ftV *0=  
Where: 

mV  = Dead volume 

0t  = Dead time 

vf  = Flow rate 
  

Decimal Minute 
A decimal minute (also referred to as industry minute) has 100 units instead 
of 60 seconds. 

The value "2.500" (industry minutes) means "2 minutes, 30 seconds," 
"2.100" means "2 minutes, 6 seconds," etc. 

Delay  
The general ⇒Delay command specifies the time to pause before 
executing the next command(s). The Delay command is often used for 
⇒Trigger commands. 

The AS or AS50 Delay sample prep command specifies a number of 
minutes to pause before proceeding to the next step in a sample 
preparation sequence.  

Delay Time  
The time required for a substance to travel from one location in the 
chromatography system to another is referred to as the delay time. 

In a gradient system, the delay time is the time required for a change in the 
gradient composition to migrate from where the gradient is formed to the 
head of the column. The gradient delay time is proportional to the volume 
between the point at which the gradient is formed and the head of the 
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column, and is inversely proportional to the flow rate. As an example, the 
delay time in a Dionex RFIC (Reagent-Free Ion Chromatography) system 
using a gradient pump is typically about 0.8 minute. 

Delay time is sometimes used to refer to the time related to the delay 
volume between the following system components: 
• The separator column and the detector cell 

• The first detector cell and a second detector cell 

• The detector cell and the switching valve (or the tube, depending on 
the device type) 

On the General tab page of the QNT Editor (see The QNT Editor  The 
General Tab Page), enter the ⇒Delay Time needed by a substance to 
travel from the detector cell of the first detector to the detector cell of a 
second detector. (For information about the editor, see Data 
Representation and Reprocessing  The QNT Editor.) 
On the Fraction Collection Options page of the Program Wizard (see 
Control  The Program Wizard), enter the delay time between the 
detector and the Fraction Collector. The wizard displays this page only if 
you installed the Fraction Collection driver in the Server Configuration 
program. If you use several additional detectors, enter the delay time(s) 
between the detectors on the Fraction Collection - Channel Selection 
Options page. 

  Tip: 

Enter a fixed delay time only if the flow is constant. Changing the flow rate 
also changes the actual delay time between two detectors or between the 
detector and the fraction collector. 

Delta (Signal Property) 
The ⇒Delta signal property indicates the signal slope in a second. 

This property is especially useful when creating ⇒Trigger conditions. A 
peak cannot only be recognized by the height of its absorption signal within 
a chromatogram, but also, for example, by a sharp increase of the signal.  

For information about how to express this type of trigger condition, refer to 
Practical Tips for Device Control  Trigger Commands. 
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Demo (or Virtual) Mode 
Use the Demo (or Virtual) Mode to simulate device control and data 
acquisition without the instrument being installed. To operate an instrument 
in this mode, enable demo or virtual mode in the Server Configuration 
program. With most Device Drivers you can enable demo or virtual mode 
by selecting the corresponding option on the General tab page. For some 
detectors, for example the UVD340U PDA, select the Read option to 
enable demo mode.  

Simulate data acquisition by loading a pre-recorded demo file and then 
displaying the data on the signal plot of the Control Panel. The demo file 
is "read back" as though the data were being acquired in real time. Some 
detectors also allow recording your own demo data. 

For more information about how to enable demo or virtual mode, simulate 
data acquisition, and record demo data, refer to How to …: Controlling 
Devices from the Control Panel  Using/Recording Demo Data. 

Contrary to the usual procedure, the demo mode of the UCI Universal 
Chromatography Interface does not use previously recorded signal 
courses. The UCI drivers include a Software Peak Generator, instead. 
Specify the signal properties of the chromatograms to be generated on the 
Demo tab page.  

 Tip: 
It is not possible to output MS MCA data in demo mode!  

 Note:  
Do not confuse Demo or Virtual Mode with the Chromeleon Evaluation 
Mode.  

Detect Negative Peaks 
The Detect Negative Peaks detection parameter determines whether 
negative peaks are recognized apart from positive peaks.  

Also, refer to ⇒Detect Negative Peaks 

For information about how to apply detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 
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Detection Code at Peak Start or Peak End (AIA 
Peak Type) 
These peak result variables indicate how the peak start and the peak end is 
classified. In principle, this corresponds to the ⇒Peak Type classification of 
Chromeleon. The classification described below complies with the AIA 
convention. 

The following AIA peak types are evaluated: 
 
AIA Peak Type Description Chromeleon Peak Type 
B (baseline peak) The peak starts on the 

baseline. 
BM, bM 

VD (vertical drop) The peak starts with a 
perpendicular line dropped to 
the baseline. 

MB, M 

PT (pretangent skim) The peak is interpreted as a 
rider. 

Ru or Rd 

Device Driver 
A device driver is required to control a device by Chromeleon. Each 
controllable instrument or integrated system has its own device driver that 
is activated when Chromeleon is started. The device driver translates the 
instructions (commands) into device-specific digital commands that are 
then converted into "real control commands" after the data has been 
transferred to the instrument. In the opposite direction, the signals of all 
instruments (readings, status information, etc.) are converted so that 
Chromeleon can read them and display them on the screen.  

Device drivers are also capable of monitoring regularly requested or 
automatically given device parameters in a target/actual value comparison. 
Unexpected events can be corrected or displayed in an error message. We 
can only guarantee for Dionex devices that the device driver fully supports 
all instrument functions. Support of third-party devices may be limited. If 
you can change the settings to modify the functionality of the driver (for 
example, if you can specify the shared A/D channels, relays, or remote 
inputs), this action is performed in the Server Configuration Program  

The names of the device drivers are derived from the corresponding 
instruments.  
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If a separate device driver is not available for your instrument, special 
drivers often allow at least partial control of a device. (For more information, 
refer to How to …: Configuring the Chromeleon Server  Controlling 
Devices without a Separate Device Driver in the Administrator Help 
section.) In special cases, you can use the generic device driver to create a 
user-defined device driver. (For more information, refer to Hardware 
Installation  The Generic Device Driver in the Administrator Help 
section.) 

Digital Input 
See Remote Input 

Dilution Factor 
The Dilution Factor ⇒Sample Variable is a correction factor for diluting 
consecutive calibration samples. 

Also, refer to ⇒Dil. Factor (dilution factor) 

Dilution Series 
A dilution series consists of several samples with different concentrations 
("concentration series"). The samples were generated from a common 
original sample. You may as well generate a dilution series by varying the 
injection volume. 

A dilution series is especially useful for multiple-point calibration. Instead of 
injecting standard samples of different concentrations, different volumes 
are injected from a standard sample. (The principle is: Twice the injection 
volume contains exactly twice the amount of each component). 

The corresponding amount is calculated as follows:  

Amount Am
Inj Vol
Inj Vol

Smp Wght
Dil FactorPeak Tab

unknownAmount

known Amount
= −. *

. .
. .

*
.

.( .)

 

 Tip: 
Note that the calculated amount values refer to the same standard sample. 
That is why, in the peak table, you only have to enter one ⇒Amount value 
(column 1) for each substance contained in the standard. 
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Dimension of Amounts 
This peak table parameter defines the physical dimension of the ⇒Amount 
values, i.e., either amount or concentration. 

Also, refer to ⇒Dimension of Amounts 

Diode Array Detector 
See Photodiode Array Detector  

Disconnect 
Execute the Disconnect command to separate a user PC (client) from a 

Timebase or to operate an instrument locally. Chromeleon no longer 
controls or operates the specified instrument. The instrument keyboard lock 
of the Connect command is no longer valid. 

 Note:  
Select Connect to undo the operation. 
 
Also, refer to ⇒Connect/Disconnect 

Dispense 
The Dispense command causes the ASI-100 Autosampler to dispense a 
specific quantity (volume) from the sample loop into a certain sample vial 
(⇒Position). The Duration parameter determines how long the 
autosampler takes to perform this operation. After the operation has been 
completed, the ASI-100 returns the Sampler.Ready signal to Chromeleon. 

The Dispense command causes the AS and AS50 autosamplers to 
dispense reagent from a reservoir into a specified vial. The Dispense 
command is available only if the autosampler is equipped with the sample 
preparation option. See Practical Tips for Device Control: Autosampler 
Control  Defining Sample Preparation Steps for details. 

Also, refer to ⇒Dispense 
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DOF-Adjusted Coefficient of Determination 
The DOF-Adjusted Coefficient of Determination calibration variable 
returns the coefficient of determination corrected by the degree of freedom. 
The calculation is as follows: 

r
N W Y F X

N m W Y Y
DOF adj

i i i
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N

i i
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=

=
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− −
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With: N Number of standard samples involved in the calibration 
 m Number of degrees of freedom (= coefficients to be determined according to 

the ⇒Calibration Type: LIN: m = 1; LOFF: m = 2; QUAD: m = 2;  
QUOFF: m = 3 and EXP: m = 2), 

 i Index for standard samples 
 Wi Weight factor of the standard sample no. i 
 F(x) Model function of the calibration 
 Xi X-value of the standard sample no. i 
 Yi Y-value of the standard sample no. i and 
 Y  Average of all Y-values.  
Also, refer to Coefficient of Determination 

Dongle 
A dongle is a software license device that is placed on the USB or parallel 
port (= LPT) of the PC. The free end of the dongle that can be placed on 
the LPT port is designed as a parallel interface connector, too. 

The dongle stores the serial number of the Chromeleon workstation, much 
as the PAL Plug-In Board does. Each workstation has a unique serial 
number.  

The serial number of the dongle and the Key Code stored in Chromeleon 
must match. If they do not match, Chromeleon cannot operate correctly. 

Unless there is a PAL, a dongle, or a License Server, and unless the key 
code is correct, Chromeleon can run in Evaluation Mode only. 
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 Notes:  
If a WIBU-KEY dongle is installed, WIBU-KEY software is automatically 
installed when the Chromeleon is installed. Use the WIBU-KEY software to 
correct individual settings; for example, printing errors when your printer is 
connected to the dongle. For more information, refer to the WIBU-KEY Help 
system. To run WIBU-KEY software, click Start > Settings > Control Panel: 

 
 
The Alladin Hardlock software does not provide a user interface. As it is not 
possible for you to make any settings, information about this software is not 
provided. 

The Administrator Help section provides more information; refer to: 

Software Installation and Communication  The Software License 

Hardware Installation  Entering the Software License and  Useful 
Tips for Installing Dongles. 

Draw 
The Draw command (for the ASI-100) or Suck command (for the 
GINA 50/GINA 160) induces the Autosampler to draw a specific injection 
⇒Volume from a certain sample vial (⇒Sample Position). The amount of 
time this operation is allowed to take is determined by the Duration 
parameter. 
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After the operation has been completed, the autosampler returns the 
Sampler. Ready signal (for an ASI-100) or Sucked (for a 
GINA 50/GINA 160) to Chromeleon. The time between the Draw (or Suck) 
command and the Sampler.Ready (or Sucked) response signal can vary, 
depending on the instrument type. 

Also, refer to ⇒Draw. 

Drift  
A signal change over time, e.g., caused by a temperature change in the 
laboratory, gradient elution, or detector drift, is referred to as drift. 

To show the drift in Chromeleon: Add a new report variable in the report or 
in the Printer Layout. Select Insert Chromeleon Report Variable or 
Insert Column on the context menu to open the appropriate dialog box. In 
the dialog box, select ⇒Chromatogram from the Categories list and Signal 
Value from the Variables list.  

Click Parameter to open the Parameter Input for 'Signal Value' dialog 
box and select Drift. Select the Restrict Range from check box and 
determine the range for which the drift is calculated. 

To compute the drift, a regression line is drawn through all data points. The 
slope of the regression line is the calculated drift. Therefore, to compute the 
drift, always select a baseline range in which no peaks occur. 

 Note:  

Unless the step is equidistant, all data points are weighted with their 
corresponding steps to determine the regression line. 

The drift is always indicated in [Signal]/min. 

DS3 Detection Stabilizer 
The DS3 Detection Stabilizer is a temperature-controlled chamber that 
houses a conductivity cell and an eluent heat exchanger. 

The DS3 Temperature command can be used to set the temperature of the 
DS3. The command can be executed directly from the Control Panel or 
linked to a Control.  
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To link the command to a control, place a string display, gauge slider, or 
edit box control on the control panel (see Layout Toolbar). Then, link the 
control to the object property, DS3_Temperature. For more information, 
refer to How to …: Controlling Devices from the Control Panel 

 Linking a Control to a Device. 

 Tip: 
The DS4, which is installed in the DX-120 Ion Chromatograph, is identical 
in function to the DS3. The only difference is the connections required for 
installation in the DX-120. 

Duration 

Relay On/Off 
Relay On/off indicates the closing or opening duration in seconds [s]. 
Specifying the duration is optional. The relay on and relay off times must 
not overlap for the same relay! Some Device Drivers support trigger 
contacts that are treated as two (dependent) relays, R1 and R2: Activating 
R1 deactivates R2 and vice versa. Thus, you can control a trigger contact 
using only one Relay On command. However, you can also ignore the 
second relay, R2, and control the trigger contact via the ⇒Relay On/Off 
commands of the R1 relay. 

Autosampler 
The Duration parameter indicates the minimum time that the 

Autosampler may take to perform ⇒Draw or ⇒Dispense operations. To 
prevent evaporation of the sample load, do not draw or dispense more than 
10 µl per second. Otherwise, if the Draw time is too short, gas bubbles may 
result and considerably impair measuring precision. 

Sound 
The Duration parameter defines for how long (in seconds) the tone is 
produced for the ⇒Sound command. 
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DX-LAN 
The DX-LAN is the local-area network (LAN) that connects Dionex modules 
to the PC on which Chromeleon is installed. (The Administrator Help 
section provides more information; refer to Software Installation and 
Communication  The DX-LAN.) 

Electronic Signature 
According to the "21 CFR Part 11" rules and regulations published by the 
FDA in 1997 electronic signature means the "a computer data compilation 
of any symbol or series of symbols executed, adopted, or authorized by an 
individual to be the legally binding equivalent of the individual's handwritten 
signature". 

Use the Electronic Signature feature in Chromeleon to sign and thus, to 
protect the results generated from your Raw Data. This is an important 
aspect for quality assurance and GLP. When User Mode is enabled, 
you can sign and protect Sequence reports that have been accepted as 
correct. In this way, it is possible to review and reproduce the results at any 
time later. 

Electronic signature includes three steps: 
• Submit  

• Review 

• Approve 

Typically, the user who created the report signs and submits it. Afterward, 
for example, the laboratory manager reviews the report and signs it as well. 
Finally, the quality assurance manager approves the results. 

 Tips: 
Enable User Mode. If User Mode is disabled, electronic signature will not 
be possible. Besides, electronic signature is available only for user 
databases that have been created with a User Manager (CmUser 
program) version 6.10 or higher. Update your database if an error message 
notifies you that electronic signature will not be possible. 
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If you use the sample ⇒Types Spiked and/or Unspiked, please keep in 
mind that: 

• An Electronic Signature created with Chromeleon 6.50 or earlier is 
invalid in Chromeleon 6.60 or higher. 

• An electronic signature created with Chromeleon 6.60 or later is invalid 
in Chromeleon 6.50 or earlier. 

For information about how to sign reports electronically, refer to How to …: 
Creating and Managing Files and Data  Signing Sequences 
Electronically. Also, refer to  Chromeleon User Management in the 
Administrator Help section. 

Eluent Generator 
Eluent generators can generate high-purity acid or base eluents online at 
the point of use, using only deionized water as the carrier. An eluent 
generator consists of a high-precision programmable current source (power 
supply), a DX-LAN or USB automation interface, a high-pressure gas 
removal device, and a disposable eluent generator cartridge (EluGen). 

Dionex offers the following eluent generators: 
• The EG40 and EG50 eluent generators are configured as separate 

devices in a Timebase.  
• The eluent generator installed in the ICS-2000 Ion Chromatography 

System is configured in a timebase as part of the ICS-2000. 
• Each eluent generator cartridge installed in the ICS-3000 EG is 

configured as a separate device in the timebase(s). 

Chromeleon provides the following eluent generator control functions: 
• Control of the generated eluent concentration 
• Monitoring of the ions remaining in the EluGen cartridge 
• Monitoring of the EluGen cartridge expiration date 

Also, refer to Practical Tips for Device Control: 

 Controlling the Eluent Generator Concentration 

 Monitoring the Eluent Generator Cartridge Lifetime 
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Eluent Mode (DX-120) 
Eluent mode enables switching the flow from one eluent to another in a DX-
120 Ion Chromatograph equipped with the dual-column option. In this 
mode, the column-switching valve is disabled. The selected eluent always 
flows to the column that was selected when Eluent mode was enabled. 
Also, refer to Column Mode. 

The EluentAB command is used to switch the flow from one eluent 
reservoir to the other. The command can be included in a Program, 
executed directly from the Commands dialog box (select Command… on 
the Control menu), or linked to a Control on the control panel. To link the 
command to a control, place an edit box or switch control on the Control 
Panel) (see Layout Toolbar). Then, link the control to the EluentAB 
object property. For more information, refer to How to …: Controlling 
Devices from the Control Panel  Linking a Control to a Device. 

To enable Eluent Mode: 

1. Open the Server Configuration program. 

2. Select the DX-120 in the Timebase. 

3. Double-click to open the Properties dialog box (or right-click and select 
Properties). 

4. Select the Mode tab page and select the Eluent option. 

Emergency Program 
Chromeleon differentiates between three types of errors: 
• Fatal Error (Abort - The batch aborts.) 

• Serious Error (Error - The batch continues and the error is corrected as 
far as possible.) 

• Error (Warning - The batch continues and a warning appears.) 

• Minor Error (Ignore - The batch continues. The error is only logged in 
the audit trail.) 

An emergency program can be defined for the first type of error. In this 
case, the batch does not abort but the emergency program starts 
automatically instead. 
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The retention time continues while the emergency program is active; the 
times are interpreted as offset. Data acquisition and audit trail will continue 
as well. After the emergency program has run, an End of Sample entry is 
made in the audit trail. 

For emergency program examples, refer to How to …: Creating and 
Modifying Programs  Creating an Emergency Program. 

Emission 
If a substance is fluorescent, it emits light at a specific wavelength range. 
You can measure the Fluorescence with a fluorescence detector that is 
set to the respective emission wavelength maximum. Select the 
EmWavelength parameter to enter the emission wavelength. 

 Note: 
Select the ExWavelength parameter to enter the excitation wavelength of 
the fluorescence detector (also, see Excitation).  

Evaluation Mode 
Select the Evaluation Mode to test Chromeleon in the actual working 
environment. You may temporarily operate Chromeleon in evaluation mode 
if a software license is not available. Evaluation Mode supports the 
following licenses: 
• Two class 3 Timebases  

• Server Control 

• Two Concurrent Clients 

• GLP Features License 

• PDA License 

• MS Control 

For more information, refer to Chromatography Components: Hardware 
and Software  Chromeleon Licenses. 



A-62 Glossary 

The Chromeleon server remains in evaluation mode for one hour and will 
shut down automatically after that period. 

 Tip:  
Data acquisition is not supported in Evaluation Mode. 

The Administrator Help section provides more information; refer to: 

Software Installation and Communication  The Software License 

Hardware Installation  Entering the Software License. 

 Note:  
Do not confuse the Evaluation Mode with the Demo Mode of the 
respective instruments! 

Equilibration 
Also, refer to SmartStart. 

Excitation 
Fluorescence can be generated only with light that is of higher energy 

than the emitted light. That is why the selected excitation wavelength must 
be lower than the emission wavelength. As the excitation wavelength, 
select the highest absorption maximum for which the wavelength is below 
the emission wavelength. This allows the substance that will be analyzed to 
absorb as much irradiated energy as possible. Select the ExWavelength 
parameter to enter this wavelength.  

 Note: 
Select the EmWavelength parameter to enter the emission wavelength of 
the fluorescence detector (also, see Emission).  
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F1 Key 
Press the F1 key to open context-sensitive online Help. The help text refers 
to the current cursor position. 

Filter 
Chromeleon distinguishes three types of filters:  

Data Acquisition Filters  

You can set these filters on the Control Panel if the Device Driver of the 
detector supports this option. 

Data Reprocessing Filters  

Smoothing filters are often used to improve the Signal-to-Noise Ratio. 
They allow smoothing chromatograms that have already been recorded. 
The following smoothing filters are available: 
• Moving Average (Boxcar) 

• Olympic 

• Savitzky-Golay  

• Gaussian 

Data Display Filters 

1. Audit Trail Filters: You may specify the filter level for displaying 
messages on the control panel, in the Report, and in the Printer 
Layout. This is to avoid that the Audit Trail includes messages that are 
not relevant to you and thus becomes unnecessarily long. (Refer to 
Basic Operation  Audit Trails for more information) Errors, 
warnings, and system messages are always indicated. However, 
commands and properties are only displayed from the specified level 
on.  
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The color codes are as follows:  

Errors and Warnings: Only error messages and warnings but no 
commands are displayed. 

Normal:  green (only the most important commands are 
displayed) 

Advanced:  yellow (Normal and Advanced level commands 
and properties are displayed.) 

Expert:  red (Normal, Advanced, and Expert level 
commands and properties are displayed.) 

2. Commands Filters: Similar to the Audit Trail filters, you may specify the 
filter level for displaying commands in the Commands dialog box. Select 
Normal, Advanced, or Expert on the Context menu.  

3. MS Filter: In case of Mass Spectra, you can define the ionization 
polarity and the ionization voltage for the mass spectrum plot.  

If several ionization settings are used in Full-Scan mode, you may 
enter an MS filter index on the mass spectra plot of the control panel. 
This is to display those mass spectra of the TIC signal that correspond 
to a specified group of settings. For example, index 1 refers to the first 
line in the Simultaneous acquisitions table (= TICF_1 - in the following 
example: polarity "+ve", maximum voltage 100 V): 
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Find (Button) 
The Find tab page in the online Help topics window allows you to find 
specific words, terms, or text included in the online Help. All Chromeleon 
help texts are scanned. 

Flow Gradient 
Changes to the ⇒Flow rate in a chromatogram are referred to as a flow 
gradient. This type of Gradient is quite unusual in liquid chromatography. 
However, compared to the ordinary %-Gradient, the flow gradient has the 
advantage that the solvent composition does not change in the column. 
Thus, you do not need to condition the column before starting the next 
analysis.  

The gradient can be generated manually or program-controlled. You can 
change the flow either continually ( Ramps) or immediately ( Step 
Gradient). 

 Note: 
Pumps that are serially controlled deliver a specific flow rate by commands. 
It is not possible to enter an unlimited number of these commands in very 
short intervals. Therefore, a flow gradient generated in this way has very 
small steps, which, however, are almost immeasurable. Pumps with 
voltage, frequency, or pulse width control can continually change the 
delivery rate so that there are virtually no steps. 

Flow Rate 
The Flow Rate usually indicates the total volume (in [ml/min]) delivered by 
the chromatography pump. It is the sum of all partial flows 
(%A+%B+%C+%D=100%). (For more information, refer to ⇒%B, %C, %D 
(Solvent Components).) 

Flow rates are usually in the range 0.5 to 10 ml/min. Use micro pumps 
(0.1 - 0.5 ml/min) or especially equipped pumps (as from 10 ml/min) for flow 
rates below or above these values. 
For gas chromatographs, the amount of mobile gas phase is also called 
flow rate. 
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 Tip: 
The pressure in the chromatography column is up to 400 bar (40 MPa, 
5800 psi). Solvent mixtures, for example, of methanol and water, are 
subject to volume compression. That is why the volume delivered by 

High-Pressure Gradient Systems does not correspond to the volume 
transported over the column. Of course, this does not change the number 
of the delivered and transported solvent particles. 

Also, refer to ⇒Flow 

Fluorescence 
The immediate emission of light after excitation with light energy is referred 
to as fluorescence. Fluorescence is often used as the detection principle in 
HPLC applications. The wavelength of the emitted light is longer than the 
excitation wavelength. In solutions, the fluorescence spectrum is 
independent of the excitation wavelength. 

 Note:  
You can also use a fluorescence detector to measure the 

Phosphorescence and Chemiluminescence. 

The Molecular Orbital (MO) theory provides a more exact explanation: 
Molecules are excited by the absorption of light. Absorption arises from the 
ground state, the lowest vibrational level of the lowest singlet state (S0) and 
terminates in different excited vibrational levels of the next higher singlet 
state (S1). 

1A0 ShS →+ ν  
where:  

h = Plank's constant 

Aλ
ν c  absorptionat  frequencelight   A ==

 
where: 

c = speed of light 

λ = wavelength 
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Higher vibrational levels of S1 undergo radiationless transitions to the 
lowest vibrational level of S1. Finally, fluorescence originates in the lowest 
vibrational level of S1 and terminates in different excited vibrational levels 
of S0: 

FhSS ν+→ 01  
Also, refer to the image below for clarification: 

 

 Note:  
Due to the fast relaxation in solution, the emission spectra of electronically 
excited molecules in solution is independent of the excitation wavelength 
(also for excitation of, e.g., S0→S2), according to the Kasha rule. 
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Formula for Amount Calculation 
This formula calculates the amount in an unknown sample. The 
prerequisite is that all necessary Calibration Coefficients and all peak 
areas of the sample to be analyzed have been determined. 

n

n
pppp Weight

FactorDilFactISTDFactspReyfAmount .**..*)(=
 

The ISTD factor is the ratio of the added amount of Internal Standard to 
the determined amount of internal standard: 

)(

)(

SampleISTD

TablePeakISTD

Amount
Amount

FactorISTD =
 

 
p Indicates the peak number 

pf
 

Indicates the calibration function for peak p calculated during the calibration. 
For more information, refer to How to …: Creating and Using Report 
Tables  Calculating the Peak Variable "Amount." 

py
 

Indicates the determined area of peak p (for integration type = Area) 

Resp.Fact.p Indicates the scaling factor. The scaling factor can be specific for each peak; 
for example, to compensate the differing absorption behavior.  

ISTD Fact. Indicates the correction factor for the internal/external standard method. For 
the external standard, this factor equals 1. 

Dil.Fact. Corresponds to the Dil.Fact. parameter from the sample list.  
⇒Weight Is a sample-specific factor that always refers to all peaks. 
n Indicates the sample number  

The calculation of the calibration curve is the precondition for amount 
calculation. For information about how the calibration curve is calculated, 
refer to Theory of Calibration  Evaluation with Various Standard 
Methods. 
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Formula for Amount Calculation (Rel. to ISTD) 
This function calculates the amount in an unknown sample by means of the 
ratio of the area to the Internal Standard. The prerequisite is that all peak 
areas of the sample have been determined including the area of the 
internal standard. 

n

n
p

ISTD

Peak
pp Weight

FactDilFactspRe
y
yfAmount ..*..**100 ⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
=

 
 
p Indicates the peak number. 

pf
 

Indicates the calibration function for the peak p that is calculated during the 
calibration. For more information, refer to How to …: Creating and Using 
Report Tables  Calculating the Peak Variable "Amount". 

py
 

Indicates the determined area of peak p (for integration type = Area) 

Resp.Fact.p Indicates the scaling factor: The scaling factor can be specific for each peak; 
for example, to compensate the differing absorption behavior.  

ISTD Indicates the internal standard. 
Dil.Fact. Corresponds to the Dil.Fact. parameter from the sample list. 
⇒Weight 
(Sample 
Weight Factor) 

Is a sample-specific factor that always refers to all peaks. 

n Indicates the sample number  
The calculation of the calibration curve is the precondition for amount 
calculation. For information about how the calibration curve is calculated, 
refer to Theory of Calibration  Evaluation with Various Standard 
Methods. 

Fraction Collector  
At the detector output, fractions can be collected for preparative 
chromatography as well as for the exact determination of the separated 
substances in subsequent analytical procedures. A fraction collector is 
imperative if this is routine operation.  

The fraction collector must collect the fractions depending on the incoming 
signal; that is, fraction collector control is performed using extensive 

Programs. If the absorption signal exceeds a specified threshold value, 
⇒Trigger commands are used to close a relay and move to the next 
collecting tube. 
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Install the Fraction Collection driver in the Server Configuration 
program. Using this driver considerably shortens the respective program 
and thus facilitates fraction collector control.  

In addition, install the Device Driver for the respective fraction collector in 
the server configuration program. The Fraction Collection driver is 
comparable to the Integrator Driver that is required, in addition to the 
respective pump driver, for recording the pump pressure. 

For information about how to control fraction collectors, refer to How to …: 
 Collecting Fractions. 

Front Riders to Main Peaks 
The Front Riders to Main Peaks detection parameter changes rider peaks 
on the leading edge of a peak into main peaks.  

 Tip: 
This parameter has priority over the Rider peak type indicated in the peak 
table. 

Also, refer to ⇒Front Riders to Main Peaks 

For more information about how to use detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 

Fronting Sensitivity Factor 
See Tailing Sensitivity Factor. 
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Full-Loop Injections (AS/AS50 Sample Prep 
Command) 
When performing a full-loop injection, the AS or AS50 Autosampler draws 
four times the loop volume from the sample vial and delivers it to the 
injection valve. The middle portion of the sample is positioned in the loop 
and injected. 

 Tips: 

For very small loop sizes (less than 17 µl), 2.5 times the loop volume plus 
25 µl is delivered to the valve. 

The maximum loop size for full-loop injections is 300 µl. If a larger loop size 
is used, sample can contaminate the flush bottle because the sample 
volume drawn is greater than the sample transfer line volume of 1200 µl. 
 
Full-Loop Injection Sequence 
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Full-Scale 
The Full-Scale command sets the voltage for a full-scale analog output. 
For example, if 0.1V is selected and a recorder is connected to the 
detector’s analog output, the recorder’s full-scale response will be at 0.1V. 
For the AD20 detector, the full-scale voltage is fixed at 1V. 

The voltage output of a full-scale detector response to use depends on the 
recording device to which the analog output is connected. For example, if 
the analog output is connected to a device that accepts input voltages up to 
1 V, select a voltage output of 1000 mV.  

Full-Scan 
Full-Scan is the Mass Spectrometer method for recording TIC 
chromatograms. Contrary to SIM (Selected Ion Monitoring), this method 
records the entire Mass Spectrum of each single analyte. 

In full-scan mode, you can already extract Mass Traces during data 
acquisition. (For more information, refer to How to …: Using Mass 
Spectrometers  Extracting Mass Traces Afterward.)  

Also, refer to How to …: Installing and Configuring Mass 
Spectrometers  Defining the Number of MS Channels in the 
Administrator Help section. 

Full Size 
The Full Size command undoes all previous Zoom operations. To undo 
only the last operation, select Unzoom on the context menu. 

On the signal plot, double-click the Overview Window to perform full 
sizing. 
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Gain 
The Gain signal parameter determines the factor by which the analog 
output signal of the RF2000 fluorescence spectrometer is increased or 
reduced. Thus, the Gain parameter corresponds to the Range parameter 
that is supported for other detectors.  

 Note: 
The UCI Universal Chromatography Interface ranges from -10V to +10V 
and thus covers virtually all detector output signals. It is possible to record 
signals directly, without considering the Gain parameter. If size adjustment 
is necessary anyway, adjust the size, using the Factor parameter of the 
signal configuration. (In the Server Configuration, right-click the 
fluorescence detector, and then go to the Signals tab page.) 

Gain Region 
The Gain Region in an integrated amperometry waveform is a period in 
which the detector electronics adjust the gain (the ratio of the signal output 
from the cell to the input of the analog-to-digital converter). If the signal 
from the cell falls outside the calculated upper or lower limit of the analog-
to-digital conversion value, the gain is adjusted to bring the signal back into 
range. 

Keep the following points in mind when selecting a gain region: 
• If you will be acquiring 2D data only, select a gain region that matches 

the Integration Interval.  

• Because 3D data can be reintegrated after acquisition, the actual 
integration interval is not known before the run and the gain region 
cannot be set to the integration interval. Instead, select a longer gain 
region (or more than one), making sure the region encompasses any 
period that will be used for integration.  

• Do not include the cleaning portion of a waveform in the gain region. 
The signal input in this region is very high and the analog-to-digital 
converter may become saturated, causing noisy data.  

Globally Unique Identifier 
See GUID 
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GLP ("Good Laboratory Practice") 
Good Laboratory Practice is the adherence to regulations on the 
organization and conditions of planning, performing, and monitoring 
laboratory work.  

A special focus is the complete and clear listing of the complete data in an 
analysis process. In addition, regular checks of the instruments and the 
software are required. 

GLP contributes to enhancing the quality of test data. In Germany, the GLP 
principles were introduced in 1983. In 1990, they became part of the 
chemical law (ChemG). 

Gradient 
Usually, gradients are used in HPLC/IC and GC to accelerate the 
separation of substance mixtures. Due to the different separation 
mechanisms in HPLC/IC on the one hand and GC on the other, different 
gradient types can be used. 

HPLC/IC: Two different gradient types 
A change in the composition of the mobile phase during the analysis is 
referred to as a gradient (more exactly as %-Gradient). A change in the 
flow rate is referred to as a Flow Gradient. However, this gradient type is 
quite unusual. Chromeleon lets you generate flow and %-gradients. Both 
gradient types can be performed at the same time (!). 
 

 Tips: 
Performing both gradients at the same time results in non-linear partial flow 
alterations in the total flow. For High-Pressure Gradient Systems with 
more than one pump, it will result in non-linear partial flow alterations for 
each pump. Some chromatography pumps do not support this option.  

The chromatographic conditions for high-pressure and low-pressure 
gradients are not transferable due to the different properties in solvent 
compressibility and dead volume! 
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GC: Three different gradient types 
Usually, temperature gradients are used in GC. In addition, some GCs can 
run flow or pressure gradients. With GC gradients, the flow (or the 
temperature, or the pressure) usually increases during the chromatogram. 
Changing one of the three variables automatically changes the remaining 
two according to the equitation of state for ideal gases and the Hagen-
Poiseuille law. Nevertheless, it is also possible in GC to run a temperature 
and a flow or pressure gradient simultaneously. In this case, the flow or 
pressure change that results from the temperature increase is considered 
for the flow or pressure settings.  

Independently of the gradient types described above, the gradient forms 
can be different. Distinguish Ramps and Step Gradients. For example, if 
you run a %-gradient as a ramp, the solvent composition continually 
changes until the desired composition is finally reached at the desired end. 
The composition for a step gradient is set immediately. (Nevertheless, it 
may take some time until the desired composition reaches the column, 
depending on the column, the solvent change, and the flow) 

%-Gradient 
A change in the composition of the delivered solvent mixture during the 
analysis in liquid chromatography is referred to as a gradient. Usually, the 
eluting power of the solvent is increased to accelerate the elution of the 
later eluting substances. 

To distinguish this gradient type from the Flow Gradient, which is quite 
unusual in liquid chromatography, it is also referred to as a %-gradient. The 
composition can be modified immediately ( Step Gradient) or over a 
certain period ( Ramp).  

 Tips: 
Depending on the dead volume of the pump, the time required for changing 
the mixing ratio varies. The greater the dead volume is, the later the new 
mixing ratio will be realized on the pump output and the later the solvent 
mixture will reach the column. Therefore, make sure to perform gradient 
courses in sensible intervals. 

Usually, the solvent composition at the beginning of the analysis widely 
differs from the composition at the end. Therefore, before you start the next 
analysis, make sure that the column has been sufficiently conditioned, that 
is, that the solvent composition in the column corresponds again to the 
original composition at the beginning of the analysis. 
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Gradient Curves 
The Dionex P680, GP40, GP50, and GS50 pumps let you specify linear or 
non-linear %-Gradient profiles (gradient curves). Eluent Generators can 
also deliver non-linear %-gradient profiles. For the mathematical description 
of the curve types, refer to Gradient Curves Equations. 

Curve 5 (the default) is linear. Changes in composition of the delivered 
solvent over time are constant. 

Curves 1 - 4 are convex upward. Convex curves cause rapid changes in 
solvent composition at the beginning of the gradient and slower changes at 
the end. Slope changes over time become extreme as curves go from 4 
(least convex) to 1 (most convex). 

Curves 6 - 9 are concave upward. Concave curves cause slower changes 
in solvent composition at the beginning of the gradient and rapid changes 
at the end. Slope changes over time become extreme as curves go from 6 
(least concave) to 9 (most concave). 

The figure below shows the solvent composition profiles of curves 1 
through 9, for a change from 0 - 100% B over 10 minutes. 
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 Note:   

The statements regarding curves 1 to 9 also apply to some third-party 
devices. However, the curvature may deviate.  
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Gradient Curves Equations 
The following equations describe the Gradient Curve profiles generated 
by the Dionex GP40, GP50, and GS50 gradient pumps, and by the Eluent 
Generator. 

For convex gradients: 
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where: k = 0, ¼, ½, ¾, 1 for curve numbers 1, 2, 3, 4, 5 respectively  
 
For concave gradients: 
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Where: k = ¾, ½, ¼, 0 for curve numbers 6, 7, 8, 9 respectively 
 
Ve Current eluent value 

Vf Eluent value at the previous step time 

Vt Eluent value at the next step time 
  

Te Current elapsed time  

Tf Time at the beginning of the gradient step 

Tt Time at the ending of the gradient step  
  

k Parameter that is changed to produce different curve number results  

Group (Peak Group) 
Chromeleon lets you to group single peaks in a chromatogram and then 
calibrate and integrate them as a group. Assign these peaks a common 
name in the Group peak table column in the QNT Editor (see Data 
Representation and Reprocessing  The QNT Editor). The peaks do 
not have to succeed each other directly but can be scattered at will. 

If a peak belongs to a user-defined group, the Group report peak variable 
indicates the group's name. In addition to the user-defined peak groups, 
two pre-defined groups are available: 
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1. The group of all unidentified peaks without explicit group entry (empty 
group) 

2. The group of all identified peaks without explicit group entry (empty 
group) 

Define all other groups of identified peaks on the Peak Table tab page in 
the QNT Editor. For unidentified peaks, the group defined in the 
Unidentified Peaks dialog box on the General tab page in the QNT Editor 
is indicated if the peak appears in the corresponding time interval. 

Also, refer to ⇒Group 

GUID  
Chromeleon supports sample identification by means of a unique character 
string referred to as GUID (Globally Unique IDentifier). Each character 
string is globally unique; that means that it is not used a second time, 
neither on the same datasource or Chromeleon server nor on any other 
datasource or server. 

Chromeleon uses the common 128-bit-GUID, e.g.:  

{c7b2aa95-66a3-48a5-b77d-aee437656b2a}. 

The GUID is consists of hexadecimal digits (0, 1, 2, … d, e, f). Hyphens are 
used to enhance readability. The first four blocks have a timestamp. The 
last block is the network address of the server PC. 

Also, refer to Creating and Managing Files/Creating a Sample List 
(Sequence)  Using Globally Unique Sample Identifiers. 

Height (Peak Height) 
This peak result variable refers to the peak height in the peak maximum, 
that is, at the retention time, relative to the baseline. The height dimension 
depends on the detector type. For UV detectors, the area is usually 
specified in mAU (milliabsorbance units). 

Also, refer to Relative Height 

Help 
See Online Help 
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High-Pressure Gradient System 
In a high-pressure gradient system, each partial flow is delivered via a 
separate pump into the mixing chamber against the pressure of the column. 
Differences in volume contraction and compressibility, as observed in most 
solvent mixtures, are not important during delivery but when mixing the 
solvents on the high-pressure side of the pump. 

Unlike Low-Pressure Gradient Systems, the delivered volume of each 
partial flow can be determined precisely in high-pressure gradient systems. 
The gradient profile is more precise and can be achieved with relatively 
simple pumps. However, the costs for the additional pump are 
disadvantageous. 

 Tip: 
Due to solvent compressibility and differing dead volumes, the 
chromatographic conditions of high-pressure and low-pressure gradient 
systems are not interchangeable. 

History 
The History mode (or more exactly the File History Mode or Modification 
History Mode) completely documents important changes and operations 
performed in specific objects and files. Objects include samples, 

Sequences or Datasources, Control Panels, Report Definition Files 
(RDFs), PGM Files, and/or QNT Files, and of course modified 
chromatograms.  

 Note:  
Changes in report definition files (RDFs) that are not important for GLP are 
not logged in the history; such as: 

• Changes of the view (Integration View) 

• Changes of embedded graphic objects that are not part of Chromeleon, 
e.g., charts or bitmaps 

• Enabling and/or disabling Layout Mode 

• Format changes, e.g., changes of the cell frame, cell background, or 
alignment.  
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The History mode can be enabled (or disabled) individually for each 
datasource. Enable Modification history in the Properties of a 
datasource). If the Comment required option is enabled, each user is 
prompted to enter a comment before (s)he can save the changed object. 

Select a datasource, a directory, or a single object, and then select Show 
History on the context menu to display the changes that are already 
documented. 

 Tip: 
It can take some minutes to create and display the history. 

To be able to enter and edit comments or to enable and disable the History 
Mode, the user must have the corresponding Privileges. 

For more information, refer to How to …: Working with Files, Databases, 
and Networks  Tracking File Modifications (History) in the 
Administrator Help section. 

Hit Criteria 
If there are too many hits in a spectra comparison (see How 
to …: Displaying and Using UV Spectra  Searching Single 
Reference Spectra) due to the selected comparison function (see ⇒Check 
Derivative) or ⇒Match Criterion, this list can be limited by adding the 
following selection criteria:  
  
Comparison Conditions Additional Limitations 
Standard of comparison Number of extrema 
Minimum match degree Retention time deviation 
Comparison function Solvent composition (*) 
Wavelength range PGM File name (*) 
Comparison of the largest relative maximum   

Only spectra fulfilling the corresponding criterion will be admitted into the 
selection.  

All fields accepting alphanumeric input (*), can be searched with a so-called 
regular expression, which may contain the common wildcards '?' and '*'.  
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Example:  If *y?ene is entered as the name filter, the hydrocarbons 
pyrene, chrysene and perylene would be hits, but not 
anthracene. The hit criteria can be used to comfortably 
generate sub-libraries. If using these filters, without comparing 
spectra, the hit list contains the spectra fulfilling the hit criteria. 
The partial quantity can be stored as a separate library. 

 Tip: 
Please note that a distinction is made between upper and lower case letters 
in the case of alphanumeric input. When using a capital letter in the filter 
expression, hits must also contain a capital letter at exactly the same 
position. When using lower case letters, the corresponding hit may contain 
lowercase and uppercase letters. 

Hold 
In the Hold mode, no more data is acquired, the pump continues delivery 
with the current solvent composition, and processing of the batch samples 
is stopped before the next sample. 

Also, refer to ⇒Hold 

Holmium Oxide Filter 
Recent Dionex UV/photodiode array detectors (the UVD 170U four-channel 
detector and the UVD 340U and PDA-100 Photodiode Array Detectors) 
feature holmium oxide filters. 

For the UVD 170U and UVD 340U detectors, the holmium oxide filter is 
used to calibrate UV/VIS spectra recorded with the detector due to the 
typical absorption spectrum of holmium oxide.  

For the PDA-100 detector, the holmium oxide filter is used to verify 
wavelength accuracy. 

 Note: 
It is also possible to fit older UVD170S/340S instruments with holmium 
oxide filters. Please contact Dionex Service. 
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Index (Button) 
The Index tab page provides an alphabetical index list of terms that are 
explained in the Chromeleon online Help. Enter the initial letter of the term 
of interest and click Display to display help information about this topic.  

Inhibit Integration 
The Inhibit Integration detection parameter serves to shut off certain 
chromatogram areas. 

Also, refer to ⇒Inhibit Integration. 

For information about how to apply detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 

Inject Command 
The Inject command defines the start of a chromatogram and thus the time 
when the sample is brought into the high-pressure cycle of the system. By 
definition, the time of the first Inject command is set to zero.  

In a dialog box, you define the sample vial position in the Autosampler 
(⇒Position) and the quantity of the substance (⇒Volume) to be injected. 
When a hand-operated valve is used for injection, this information is used 
for documentation purposes. 

Also, refer to ⇒Inject Command 

Injection Time 
The Inj. Time column in the sample list shows the day, month, year, hour, 
minute, and second when the sample was injected (Also, refer to Time.) 
This column cannot be edited. Chromeleon enters the injection time of the 
sample in the corresponding column of the sample list. For samples with 
the ⇒Status (sample status) "M" the time of the last injection is entered. 

The kind of entry (empty or time value) indicates whether and when the 
sample was processed. 

Also, refer to ⇒Inj. Date/Time (Time of Injection) 
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Injection Types (AS/AS50 Autosampler) 
Three types of sample injections are possible with an AS or AS50 

Autosampler: 

Full-Loop—the full loop volume is injected 

Partial-Loop—a part of the loop volume is injected 

Partial-Loop, Limited-Sample—a partial volume of the loop is injected, 
and no extra sample is aspirated from the vial. 

The injection type is selected automatically, depending on the settings of 
other variables: 
• A full-loop injection is performed when the ⇒Inj. Vol. (injection volume) 

is greater than the Loop Volume. 

• A partial-loop injection is performed when the injection volume is less 
than the loop volume and the cut volume (a volume of sample 
discarded from each end of the aspirated sample) is greater than 0. 

• A partial-loop, limited-sample injection is performed when the injection 
volume is less than the loop volume and the cut volume is 0. 

 
Injection  
Type 

Injection  
Volume* 

Cut  
Volume** 

Sample Volume  
Used 

Volume  
Injected 

Full-loop ≥ Loop 
volume 

Ignored 4 X Loop volume or  
2.5 X Loop volume + 
25 µl (whichever is 
greater) 

Loop volume 

     
Partial-loop < Loop 

volume 
1-30 µl Injection volume + 

2 X cut volume 
Injection volume 

     
Partial-loop, 
limited sample 

< Loop 
volume 

0 Injection volume Injection volume 

     
* Injection volume is entered in the Sequence. 
**Cut volume is entered in the Program.       
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 Tips: 
If the injection valve is installed externally or if an AS or an AS50 (USB) is 
in Simultaneous mode, the autosampler can perform full-loop injections 
only. 

For the best accuracy when performing partial-loop injections, specify an 
injection volume equal to half the loop volume or less. For example, if the 
loop is 100 µl, use an injection volume of 50 µl or less. 

For the best accuracy when performing partial-loop, limited sample 
injections, specify an injection volume no greater than the loop volume 
minus the air bubble volume (8 µl). For example, if the loop is 25 µl, use an 
injection volume of 17 µl or less. Note: An air bubble is drawn before and 
after the sample when it is loaded into the loop. 

Injection Volume (Volume) 
The ⇒Sample Variable Inj. Vol. is in micro liters (µl). In automatic 
operation, the installed Device Driver converts this value into a volume 
readable by the Autosampler, and then the value is sent to the 
autosampler. 

By entering different injection volumes, a Dilution Series can be created 
in case of a multiple-point calibration (see Single-Point and Multiple-Point 
Calibration). 

Also, refer to ⇒Inj. Vol. (injection volume) and ⇒Volume (command). 

Installation Qualification (IQ) 
As defined in cooperation with EURACHEM, Installation Qualification (IQ) is 
"the process of installing an instrument up to and including its response to 
the initial start of operation" [P. Bedson and M. Sargent, Accred. Qual. 
Assur. (1996) 1, 265-274]. 

An important task of Installation Qualification is to perform all formal checks 
necessary to ensure that the instrument and its individual components are 
supplied as ordered; i.e., according to the specification agreed on by the 
customer and the manufacturer. In addition, IQ checks that the instrument 
is correctly installed in the selected environment. Finally, IQ must be 
formally documented. 
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Installation Qualification is performed in accordance with this definition and 
the Dionex IQ manual.  

To start Installation Qualification for your chromatography system, select 
Instruments IQ on the Qualification menu. 

To start Installation Qualification for Chromeleon, select Chromeleon IQ on 
the Qualification menu, and then click Check Installation. Chromeleon IQ 
checks the system information and Chromeleon status, as well as all 
installed files. Examine the report for possible installation errors. 

 Note: 
Warnings may appear stating that higher versions of the system files and 
the ODBC files already existed before Chromeleon was installed. 

Select Save, Save as, or Print on the File menu to formally document 
Chromeleon IQ from the indicated report (IQReport.log - Editor dialog 
box). 

For more information about Installation Qualification, refer to Validation 
and Qualification  Chromeleon Installation Qualification in the 
Administrator Help section. 

 Tip:  
Dionex AutoQ includes three qualification procedures: Operational 
Qualification, Performance Qualification, and Installation Qualification.  

 Institutes and Institutions for Industry Standards 
Among others, the following institutes and institutions set and control 
industry standards: 

AOAC INTERNATIONAL. The Association of Official Agricultural Chemists 
is committed to be a proactive, worldwide provider and facilitator in the 
development, use, and harmonization of validated methods and laboratory 
quality assurance programs and services. 

ASTM. The American Society for Testing and Materials sets technical 
standards and rules for the industry worldwide.  
CEN. The Commité Européen de Normalisation improves the technical 
harmonization in Europe by setting standards and technical specifications.  
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DIN. The Deutsche Institut für Normierung e.V. is internationally recognized 
as normative body.  

EMEA. The European Agency for the Evaluation of Medicinal Products is 
the European counterpart of the American FDA. Especially in Europe, the 
EMEA enforces standards for the pharmaceutical industry.  

EURACHEM. Eurachem has been founded as a network of European 
organizations. Their aim is to create a system for the international 
examination of chemical measurements and to promote GLP. 

FDA. The Food and Drug Administration is an agency within the U.S. 
Department of Health and Human Services. The FDA enforces regulations 
and product standards in the US and worldwide to ensure higher safety of 
the products. 

ISO. The International Organization for Standardization contains 130 
national standardization institutes. Their task is to develop standards for the 
safer and more efficient development, manufacturing, and sales of products 
and services. 

NIST. The National Institute of Standards and Technology is an 
administrative body of the U.S. Department of Commerce. Together with 
the industry, the NIST develops new technologies and sets technological 
standards in the U.S. 

Integrated Amperometry Mode 
In addition to the DC Amperometry Mode, Dionex electrochemical 
detectors can be operated in integrated amperometry mode. Integrated 
amperometry is similar to DC amperometry in that electroactive analytes 
are oxidized or reduced at the surface of an electrode. However, instead of 
a constant potential being applied, a series of potential changes is repeated 
over time. By repeatedly pulsing between high positive and negative 
potentials, the electrode surface is continually cleaned and regenerated. 
Current is measured by integration during a portion of the repeating 
potential vs. time Waveform. 

In integrated amperometric detection (also known as IA or IPAD), current is 
integrated at two or more potentials. Pulsed amperometric detection (also 
known as PAD) is similar to integrated amperometry. However, in PAD, 
current is integrated at a single potential.  

When the Dionex ED and ED40/50/50A electrochemical detectors are 
operated in integrated amperometry mode, they can perform either IPAD or 
PAD. The applied waveform determines which technique is used. 
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Example IPAD Waveform 
In the example integrated amperometry waveform shown below, the current 
is integrated at two potentials: first, while the potential is swept across the 
metal oxide formation wave, and then again during the reverse sweep 
across the oxide reduction wave. Without the presence of analyte 
molecules, the net charge is around zero. Positive and negative cleaning 
pulses are added to the waveform following the Integration Interval. 
 

  

Example PAD Waveform 
During a PAD waveform, the current is integrated at only one potential as 
shown in the example waveform below. The potentials, labeled E1, E2, and 
E3, are applied for durations t1, t2, and t3, respectively. At t1, the E1 
potential is applied. After a delay, the signal is measured by integrating the 
current for a fixed time. At t2 and t3, positive and negative cleaning pulses 
are added to the waveform. 
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Integration Parameters 
In Chromeleon, integration parameters are referred to as Detection 
Parameters. For an overview, refer to ⇒Detection Parameters. 

Integration Interval 
In Integrated Amperometry detection, the integration interval is the time 
during the Waveform in which an integrated data point is recorded. The 
integration interval is also referred to as sampling time. 

Integration Type 
The Integration Type peak table parameter indicates which peak property 
is to be used for the calculation of quantitative results. Also, refer to 
⇒Integration Type. 

Integrator Driver  
Chromeleon does not directly process analog signals that are received via 
a Sharable Device, such as the UCI Universal Chromatography Interface. 
The Integrator Driver must be installed to allow recording these analog 
signals, for example, from gas chromatographs or pumps, via the channels 
of, for example, the UCI that assigns the individual channels of the sharable 
device. (Also, refer to Device Driver.) 

The advantage is that you do not have to rewrite all PGM Files concerned 
if you plan to connect a device to a different channel. Instead, only change 
the A/D port assignment in the integrator driver. This also allows you to 
distribute the channels of a Sharable Device to several Timebases, 
thus, eliminating the need to have, for example, one individual UCI for each 
timebase. 

The integrator driver allows you, for example, to record the pump pressure 
in order to check whether signal variations in the chromatogram are caused 
by pump pressure variations. Also, refer to Practical Tips for Device 
Control  Recording the Pump Pressure. 
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Intercept 
See Offset (c0)  

Internal Standard ("ISTD") 
An internal standard is a substance of which a known amount is added 
both to standard and unknown samples. The internal standard should have 
a similar retention time behavior as the analyzed substances, but it should 
be easily separable from them. Internal standards are used especially in 
gas chromatography but also in HPLC and IC to eliminate possible sample 
preparation errors. 

As a rule, the amount of injected internal standard is constant; that is, all 
samples receive precisely the required amount of internal standard so that 
identical amounts reach the column when injecting the same volumes. In 
the case of a Dilution Series, the internal standard must be pipetted after 
the dilution! The dilution can therefore not be simulated by variation of the 
injection volume but must be actually performed. 

 Note: 
With an appropriate Autosampler, such as the Dionex ASI-100, pipetting 
can be performed automatically. The quantitative accuracy thus reached is 
one level above the External standard method. The methods with internal 
standard also compensate minor injection inaccuracies, as the internal 
standard is equally affected by a possible loss or excess.  

Substances serving as an internal standard are labeled as such in the 
Standard column of the peak table. Depending on the type of internal 
calibration, they are labeled ISTD Int/Ext or ISTD Internal. 

Internal/External Principle 
All substances contained in a sample are calibrated as usual with known 
standard substances (including the internal standard). As the same amount 
of ISTD is contained in all samples of a sequence, a uniform value for the 
ISTD should result. If this is not the case, this is an indication for an error 
during sample processing (provided that the same amount of the internal 
standard is actually contained in all samples). The results of the remaining 
substances of this sample can then be relativized. 
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Internal Principle 
Instead of absolute areas and amounts, calculation is based on area and 
amount ratios. Calculation of all substance amounts is relative to the 
internal standard. By forming the ratio, inaccuracies in sample processing 
(from adding the ISTD) can be eliminated (const. Internal standard).  

Due to the high experimental expenses, this type of calibration is rarely 
used (the internal standard must be added with a pipette to each sample, in 
the case of a dilution series this must be after the dilution).  

Exceptions (= Variable Internal Standard) 
The method itself or the properties of the internal standard make it 
impossible to add the same amount of ISTD to all samples. To solve this 
problem, Chromeleon supports the Use sample amount as reference 
(Variable) option (see F8 box of the Standard column in the peak table).  

In this case (irrelevant whether Internal/External or Internal), the amount 
of the internal standard is entered in the ⇒ISTD Amount column of the 
sample list, not in the ⇒Amount column of the peak table. In this way, the 
amount of internal standard can be entered separately for each sample.  

Also, refer to ⇒Standard 

IQ 
See Installation Qualification (IQ) 

ISTD 
See Internal Standard ("ISTD") 

Isocratic 
A solvent flow of constant composition is called isocratic. It is irrelevant 
whether it is a pure solvent or a solvent mixture of constant composition. 

ISO Plot 
See 3D Field: Presentation Modes 
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I-t Plot 
A plot of current (I) vs. waveform time (t) for 3D_Amp data. To visualize 
this plot, imagine that a vertical slice of the 3D data is taken at retention 
time (T) and the slice is then laid flat. The left axis is the waveform period 
(ms) and the bottom axis is the current (nA). When the Waveform is 
displayed, the top axis on the plot indicates the applied voltage (mV). 

Also, refer to How to …: Analyzing 3D Amperometry Data: 
 Viewing I-t Plots in the 3D Amperometry Window. 

Jump to Another Help Topic 
As soon as the mouse pointer is pointing to a link term, it becomes a 
pointing hand. All link terms are displayed in green. 

Terms underlined by a dotted line, for example, F1 Key, are links to 
additional information in a pop-up; terms underlined by a single line are 
links to a new help topic. 

Key Code 
The range of functions available for the Chromeleon stations is determined 
during installation by a key code. 

The key code is a 12-digit or 24-digit number that makes specific functions 
and options available. Each Chromeleon station has a Dongle or a PAL 
Plug-In Board or receives its license from a License Server. A 
Chromeleon station can only be operated when the serial number coded 
there matches the key code. 

If a user expands the scope of Chromeleon functions by acquiring the 
corresponding licenses, a new key code is assigned to the user. The 
extended scope of functions is made available as soon as the new code is 
entered.  

Enter the key code as entered in the About box on the Help menu or in the 
Server Configuration program. Valid characters are numbers, letters, 

spaces, and hyphens. Input is not case-sensitive. 

The Administrator Help section provides more information; refer to: 

Software Installation and Communication  The Software License 

Hardware Installation  Entering the Software License 
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Kovats Index  
The Kovats Index serves for achieving a uniform scaling of the ⇒Retention 
Time. Define the Kovats Index on the Peak Table tab page of the QNT 
Editor (see Data Representation and Reprocessing  The QNT 
Editor). 

Also, refer to ⇒Kovats Index 

Lamp 
This command turns the lamp of an optical detector on and off. UV/VIS 
detectors often have a separate lamp for each wavelength range 
(deuterium/tungsten). To activate both lamps, the command usually has to 
be entered and performed separately for each lamp. 

However, it is also possible to turn on both lamps simultaneously or to turn 
on the second lamp automatically when the first lamp reaches a certain 
value. 

Also, refer to ⇒Lamp 

LampAge  
After you have installed a new lamp, select the LampAge command to 
reset the lamp age to 0.  

Periodically checking the lamp age allows you to determine the quality of 
the lamp and decide whether to install a new lamp. 

Also, refer to ⇒LampAge 

LampIgnitions  
After you have installed a new lamp, select the LampIgnitions command 
to reset the number of ignitions to 0. 

Periodically checking the number of lamp ignitions allows you to determine 
the quality of the lamp and decide whether to install a new lamp. 

Also, refer to ⇒LampIgnitions 
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LampIntensity  
Select the LampIntensity property to check the lamp intensity via the 
⇒Log command. Periodically checking the value allows you to check the 
quality of the lamp and decide whether to install a lamp. 

Also, refer to ⇒LampIntensity. 

Layout Mode 
For some Chromeleon elements, a special Layout Mode is available. Use 
the Layout Mode to design these elements according to your requirements. 
The Layout Mode is available for:  
• Control Panels 

• Printer Layouts (printouts) 

• Reports (screen tables) 

• History reports 

Control Panel 
Select Layout Mode on the Edit context menu to change from the online 
mode to the layout mode.  

The Layout Mode lets you create new control panels, and modify the 
appearance and functionality of existing control panels. While the Layout 
Mode is enabled, active online processes are continued but it is not 
possible to control the system. 

To add a new control to the control panel, click an icon on the Layout 
Toolbar. The layout toolbar allows you to select Control (display and 
control elements). A Control Frame surrounds selected controls; they can 
be modified in size, shape, and function. 

For more information about how to modify a control panel, refer to How 
to …: Controlling Devices from the Control Panel  Modifying a 
Control Panel. 

 Note: 
You can only create a new control panel or modify an existing one if you 
have the corresponding access rights. 
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Printer Layout  
To enable or disable Layout Mode in the Printer Layout, select or clear 
Layout Mode on the Edit menu. You can only insert, modify, and/or copy 
the different Printer Layout elements if the Layout Mode is enabled. If the 
Layout Mode is enabled, an additional text input field appears in the upper 
report section. Input is similar to MS Excel. 

Report 
To enable or disable Layout Mode in the Report, select or clear Layout 
Mode on the Table menu. If Layout Mode is enabled, an additional text 
input appears in the upper report section. Use this field to enter the desired 
values. 

History Report 
A special Layout Mode is available in the History report. If Detail columns 
are available, you can enable the Layout Mode on the Layout tab page of 
the History Report Properties dialog box. A concise report is displayed in 
which you can easily define the layout. 

Layout Toolbar 
The layout toolbar contains icons for all default Controls and display 
elements of the Control Panel that are available in the Layout Mode. 
The layout toolbar is only accessible in the Layout Mode. 

 
Click an icon and then left-click on the control panel to place the selected 
default control on the active control panel. Enable and disable the display 
of the layout toolbar by the Toolbars > Layout on the View menu. 
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The following default controls are available: 
 

 
Pointer (selecting, moving, etc.) 

 
Entry Field (Edit Field) 

 
Check Box 

 
Audit Trail 

 
Color Box 

 
Gradient Control 

 
String Display 

 
3D Field Plot 

 
Gauge Indicator  3D Amp Plot 

 
Script Button 

 
Rack Control (see Rack) 

 
Online Signal Plot 

 
Mass Spectrum 

 Group Box  Device Command Button 

 Slider  Trend Plot 

 
Lamp  Timebase Command Button 

 
Switch  Sample List 

 

Left Limit 
Peak integration is usually performed automatically. However, it is possible 
to limit or extend integration on the left, on the right or on both sides. To do 
so, enter a left and/or a right integration limit in the peak table. 

Also, refer to ⇒Left/Right Limit 

Left Width 
If a perpendicular line is dropped to the baseline from the peak maximum, 
the Width of the peak is divided in a left and a right section. The two 
sections are referred to as left width and right width and can be 
expressed as separate peak result variables. 

Chromeleon also determines the left and right peak width at 5, 10, and 50% 
of the peak height. As described in the Width topic in the glossary 
section, the height is an important factor for calculating the peak width. This 
also applies to the calculation of the left and right peak widths. 

The abbreviations for the left and right peak widths are LW and RW.  
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How to display the left peak width in the report  
• Select the column in the report. 

• Select Column Properties on the context menu 

• Select the Left Width variable in the selection box.  

• Click Parameter to determine the peak height at which to determine 
the peak width. 

License Server 
If installations include a large number of computers, a License Server is 
available to manage the Chromeleon licenses. With this type of installation, 
it would not make sense to equip all Client PCs with Dongles or PAL 
Plug-In Boards and to enter the corresponding Key Codes. 

If no PAL, dongle, or License Server is specified, Chromeleon can be 
operated in Evaluation Mode, only. 

For information about how to install the License Server, refer to Hardware 
Installation  Installing the License Server in the Administrator Help 
section. 

The Administrator Help section provides more information; refer to: 

Software Installation and Communication  The Software License  

Hardware Installation  Entering the Software License 

Limit of Detection 
The limit of detection (LOD) is the lowest concentration that is just 
distinguishable from zero ( Blank Run Sample). The LOD is reached when 
the signal-to-noise ratio is 3; that is, the signal height of a peak is 3 times 
the signal Noise. The lower the noise is during analysis, the lower are the 
detection limits. Unlike the sensitivity, the detection limit depends on the 
instruments used.  

There are three different limits: Limit of Detection (LOD), Limit of 
Determination (LODn), and Limit of Quantification (LOQ). The LODn is 
reached when the signal height is 6 times the signal noise. The LOQ is 
reached when the signal height is 10 times the signal noise. 



 Glossary A-97 

With a blank reading b <> 0, the three limits are determined as follows 
considering the standard deviation of the blank value (s): 

Limit of Detection (LOD) = b + 3s 

Limit of Determination (LODn) = b + 6s 

Limit of Quantification (LOQ) = b + 10s 

It is also possible to determine the limit of detection by means of the 
confidence range of the calibration curve (also, refer to Confidence 
Interval/Confidence Range). 

LIMS  
A Laboratory Information Management System, in short LIMS, receives 
tasks in electronic from, makes sure that they are processed, and makes 
the results available in a defined format. 

In the chromatography system, this can mean, for example, that the 
samples to be analyzed are read via bar code, grouped in a sequence, and 
then processed one after another. The results are saved in a default format, 
such as AIA. Chromeleon generates the sequence if the required 
information is supplied in a defined format. 

Chromeleon reads this data via the defined format of a Worklist. 
However, you can also use the SDK (Software Development Kit) to 
connect Chromeleon with the LIMS. 

Linked Objects 
Instead of being saved with a file, objects are often linked to the file. In 
Chromeleon, linked objects appear: 

In Sequences 
You can link a sequence to a Report Definition File (RDF) by specifying a 
Preferred Report. Select Properties… on the context menu of the 
sequence. Determine the Preferred Report on the General tab page of the 
Properties of Sequence… dialog box. The preferred report to which the 
sequence is linked is used whenever the sequence is opened.  
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In QNT Files 
QNT Files can be linked to 

• Spectra Libraries: Use the Spectra Library Screening tab page in 
the QNT Editor to specify the spectra library to be used for peak 
identification. 

• Samples for Blank Run Subtraction: Select a sample for blank run 
subtraction on the General tab page of the QNT Editor to determine 
which sample(s) shall be used for blank run subtraction. 

• Standard calibration samples from a different sequence: On the 
General tab page of the QNT Editor, select Fixed as ⇒Calibration 
Mode. To enter the desired standard (samples), change to the 
Calibration tab page and select Append Standard on the context 
menu. 

Backup 
When performing a Backup, you can determine whether linked objects 
are saved as well. Select or deselect the Include linked objects check box 
as desired.  

Dionex recommends saving the linked objects. This is to avoid that data are 
not be available in the target laboratory if data is exchanged between 
laboratories. 

Restore 
During a Restore you can select the linked objects to be restored:  
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The Restore dialog box lists the linked objects under the file to which they 
are linked. Select the linked objects to be restored.  

Lock Baseline 
By activating this parameter, it is possible to keep the baseline on the 
prescribed level.  

Also, refer to ⇒Lock Baseline 

For information about how to apply detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 
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Log 
Use the Log command to document the values of variables in the Audit 
Trail at any time. The command is also available directly in the Commands 
dialog box or can be included in the PGM File. To open this dialog box, 
select Command on the Control menu. Also, refer to ⇒Log 

Logon 
The Logon dialog ensures access to the respective program. Access is 
permitted for authorized users only who are identified via a Password in 
the logon dialog.  

In Chromeleon, access to the User Manager (CmUser program) is always 
via the logon dialog. To open a Chromeleon client, you have to logon with a 
password only if the User Mode is enabled. 

In the CmUser program, you can enable LDAP logon, also (LDAP = 
Lightweight Directory Access Protocol). In this case, password 
authentication is delegated to Windows.  

Loop Volume 
Loop Volume is the sample loop volume obtained from the value entered 
on the Plumbing Configuration screen on the AS or AS50 Autosampler 
front panel. 

Low Dispersion Injection 
Dispersion is one of the reasons for peak tailing. You can reduce dispersion 
considerably during the injection.  

In the middle of the loop, the liquid flow is faster than close to the capillary 
walls. Thus, the following injection profile appears at the loop outlet: 

 

(* Solvent in the example - can be transport liquid or any a similar liquid, 
instead.) 
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You can either cut off or inject the tailing part completely, depending on 
when the injection valve is switched back to the Load position. 

For the Dionex FAMOS and WPS-3000 micro autosamplers, Chromeleon 
supports the Low Dispersion Factor (LD Factor). This factor allows you to 
determine when the injection valve is switched back. Thus, the factor 
determines the amount of the original sample volume that is injected.  

A value of 1.0 means that the switching valve is switched back when the 
entire original sample volume was injected. This means that, in the middle 
of the capillary, the entire sample liquid is injected and that, on the capillary 
walls, sample liquid is cut-off: 

 

(* Solvent in the example - can be transport liquid or any a similar liquid, 
instead.) 

If the value is greater than 1.0, the injection valve is switched back after the 
injected volume is greater than the original sample volume. Thus, in the 
middle of the capillary, not only sample is injected. Simultaneously, the 
amount of sample that is cut off on the capillary walls is minimized. 

If the value is less than 1.0, sample liquid is cut off in the middle of the 
capillary, too. In this way, a vertical injection profile appears at the end of 
the sample plug, i.e., the tailing part is completely cut off during the 
injection. However, this process can avoid neither tailing caused by dead 
volumes or overloading of the separation column nor chemical tailing during 
the separation. Nevertheless, with the same conditions, peak tailing is 
reduced by a factor of 1.2 to 1.4, compared to common injections. 

The formula for calculating the time after which the injection valve is 
switched back to the Inject position is as follows: 

VPI FVft /**60=  
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Where:  

 It = time [s] that the valve is in Inject position 

 f = low dispersion factor 

 PV  = original sample volume in the loop [µl] 

 VF  = flow rate [µl/min] 

The time that the valve is in Inject position must be at least 10 s. If the 
calculated switching time is less than this limit, it will be redefined to 10 s. 

Low dispersion injections are possible for full-loop and partial-loop 
injections as well as in user-defined programs. In Chromeleon, the low 
dispersion factor can be any value between 0.01 and 100. For example, if 
the value is 1.3, the valve is switched back when 130 % of the value of the 
original sample plug has been injected. Meaningful values are usually 
between 0.7 and 2.0, i.e., between 70 % and 200 % of the original sample 
volume. 

Low-Pressure Gradient System 
In low-pressure gradient systems, the same pump delivers all partial flows. 

Simple systems generate the required solvent mixing ratio in the mixing 
chamber. Then, the mixture is sucked from the chamber and carried to the 
column. The solvent composition is controlled via different valve closing 
times in the feed lines of the individual components. As the mixing chamber 
volume represents a dead volume, producing the correct mixing ratio on the 
column is delayed. 

Systems that are more complex mix the individual partial flow during the 
suction period in the piston. This requires the calculation of how much 
volume can be sucked. (The value is not constant as delivery is not always 
against the same external pressure; that is, small volumes are pumped if 
the external pressure is high, larger volumes are delivered if the external 
pressure is low. Also, it is necessary to calculate the time of how long each 
valve must be opened for the individual partial flows to reach the exact 
mixing ratio. 
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Despite these mechanical and electronic procedures, the gradient profile 
produced by low-pressure gradient systems is less precise than High-
Pressure Gradient Systems, however, it is the less expensive alternative. 

 Tip: 
Due to solvent compressibility and differing dead volumes, the 
chromatographic conditions of high-pressure and low-pressure gradient 
systems are not interchangeable. 

Manipulations  
Minor changes during the integration of single chromatograms are called 
Manipulations. For information about how to perform manipulations, refer 
to: How to …: Working with Chromatograms  Manual Re-Integration. 
Select Save Manipulations or Delete Manipulations on the Edit menu to 
accept or reject these manipulations. 

Mark 
The Mark command sends a positive pulse to the detector’s analog output 
as an event marker. The pulse is 10% of the full-scale analog output. A 
mark is typically used to indicate a sample injection. 

Mass Defect 
The mass defect is the difference between the calculated mass and the 
nominal mass (integer). Combining the masses of all the components of the 
compound uses calculated mass. The masses of the elements come from 
the periodic table, with the mass of C12  being exactly 12.0000000 amu. 
Most of the other elements have masses close to their nominal elemental 
mass: 

 H1  1.007825 amu  N14  14.00307 amu 

 C12
 12.00000 amu  O16  15.99940 amu 

 C13
 13.00335 amu  F19  18.99840 amu 
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You can calculate the mass of a compound as follows: 
 
Formula Nominal Mass [amu] Actual Mass [amu] Defect [amu] 

5105 OHC  
5(12) + 10(1) + 5(16)  
= 150 

5(12.00) + 10 (1.008) + 5(15.999)  
= 150.075 

0.075 

10250 HC  
50(12) + 102(1) = 702 50(12.00) + 102(1.008) = 702.8 0.8 

 
Therefore, as you get to larger compounds containing more atoms, you will 
add all the "defects" of the individual atoms together and the difference may 
be substantial, especially if you display the mass as an integer. In the 
examples above, the first would be displayed as an integer (150 amu) 
either way. In the second example, the actual mass in integer format would 
be 703 amu; that is, a whole mass unit from the nominal mass of 702 amu. 

If you have organic compounds containing nitrogens and hydrogens and 
the only other element is carbon, the result is a positive mass defect. Since 
many hydrocarbon compounds have a lot of hydrogen, the defect can be 
very large. 

If there is also a substantial amount of oxygen, its negative mass defect 
can offset the nitrogen and hydrogen and reduce the mass defect. That is 
why the user sets the type and magnitude of the mass defect depending 
upon what kind or class of compounds he is working with. The correction 
for mass defect is generally set as x mmu per 100 amu where mmu is 
millimass unit or one thousandth of a mass unit. 

If the correction is set to 100 mmu/100 amu (it is usually set from 30 to 
120 mmu/100 amu), the correction for the examples above would be: 

Correction Factor [amu] Corrected Mass [amu] In Integer Format 
150 (0,100/100) = 0.15  150.075 - 0.15 = 149.925 150 amu 
702 (0,100/100) = 0.7  702.8 - 0.7 = 702.1 702 amu  
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Thus, the correction factor "modifies" the data so that people used to 
working with integer masses for their elements in a compound obtain the 
expected results.  

 Note:  
In Chromeleon, atomic masses are always indicated in [m/z] (= 
mass/charge number). 

Mass Spectrometer 
Mass spectrometers were originally developed as stand-alone 
instrumentation to analyze the structure of unknown, mostly organic 
compounds. When mass spectrometers are used together with 
chromatographic separation procedures, they allow the qualitative and 
quantitative analysis of complex mixtures of substances. The combination 
of GC and MS has long been part of the standard equipment in analytical 
laboratories.  

However, the combination of HPLC and MS is not yet common because it 
is more difficult to realize. Nevertheless, acceptance is steadily growing 
because  
• Decisive enhancements have been achieved during the past years. 

• In addition to the Photodiode Array Detector, the MS detector, too, 
allows qualitative statements on individual substances of a 
chromatogram in HPLC. 

Mass spectrometry includes four steps:  
• Sample loading (neutral molecules) 

• Ionization of individual molecules 

• Ion separation according to their masses 

• Ion registration in form of a Mass Spectrum 
 
Different processes can be used for ionizing and separating ions with 
different masses. The following image illustrates ionization by means of an 
electron impact and the subsequent mass separation by means of a vertical 
magnetic field: 
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The ions that are created via the electron impact are first accelerated by 
means of the cones and then separated according to their mass in the 
magnetic field. Due to the varying intensity of the magnetic field (or the 
accelerating voltage), ions of different masses are directed through the exit 
slit into the collector and registered. In this way, mass spectrometers 
perform a mass scan similar to the wavelength scanning of many 
photodiode array detectors.  
 
For information about how to record and process MS Data in Chromeleon, 
refer to How to …:  Using Mass Spectrometers. 

Mass Spectrum 
Use an MS detector ( Mass Spectrometer) to record a mass spectrum at 
any time t of a chromatogram. This extends the two-dimensional view of a 
chromatogram (retention time and intensity) by a third dimension (mass). In 
addition to the information about retention time and intensity, each of the 
recorded data points includes information about the masses detected in the 
mass spectrometer. 

Mass spectra usually include a great number of narrow peaks or needles. 
To distinguish them from the comparatively wide chromatogram peaks, 
they are called mass peaks. A mass spectra representation with many 
needles is called Centroid. A mass spectra representation that combines 
the single needles into wide peaks is called a Profile. 
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In the report, you can display the mass spectrum of a peak or the mass 
spectrum at any time of the chromatogram. You can also display the 
current mass spectrum on the control panel during data acquisition. 

In addition, you may aggregate single mass spectra to enhance their 
Signal-to-Noise Ratio (see How to …: Using Mass Spectrometers 
 Processing Mass Spectra).  

To display recorded mass spectra on the mass spectra plot, click the 
following icon on the Method toolbar: 

 

Mass spectra are generally represented via their relative intensities [%] 
against the mass. The unit of the mass is m/z (mass/charge number). The 
base peak, that is, the mass peak with the highest intensity, is the 
reference point for relative intensities. Thus, its relative intensity is always 
100 %. 
 

 
 
In the above example, the base peak is the mass peak at 733.6 m/z. The 
time when the mass spectrum was recorded is indicated, also. The mass 
spectra in the example were aggregated to the displayed total mass 
spectrum between 0.29 and 0.35 min.  

For information about how to record and process MS data, refer to How 
to …:  Using Mass Spectrometers. 
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Mass Trace 
Contrary to original TIC or SIM chromatograms that are recorded during 
data acquisition, a mass trace is an MS chromatogram for a specific mass 
area. Mass traces can be extracted from a Mass Spectrum and saved as 
a new channel. This is possible online during data acquisition but can be 
done later as well. 

For more information, refer to How to …: Using Mass Spectrometers: 

 Extracting Mass Traces Online 
 Extracting Mass Traces Afterward 

 
The Administrator Help section provides additional information; refer to 
How to …: Installing and Configuring Mass Spectrometers  Defining 
the Number of MS Channels. 

Match Criterion  
The match criterion defines the mathematical method of comparison for the 
curve shape (= standardized spectra). Also, refer to ⇒Match Criterion 

Match Factor 
The match factor is an indicator of the similarity between two curves. It 
varies from 0 (=no match) to 1000 (=perfect match).  

The match factor is calculated as soon as two spectra are compared with 
each other in a spectra search (Library Search command or on the 
Spectra Library Screening tab page of the QNT Editor (see Data 
Representation and Reprocessing  The QNT Editor).)  
This command is possible in windows or panes capable of displaying a 
spectrum. (For more information, refer to Data Representation and 
Reprocessing  Spectra Libraries and  PPA: Peak Purity Analysis.) 
The displayed spectrum is used as the basis. It is calculated by averaging 
all spectra recorded for one peak.  
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The result of the spectra search is the Hit List. It lists all spectra that have 
a certain similarity with the original spectrum. The match value in the Match 
column indicates how much they correspond. 

 Note: 
In the method PPA, the match can be indicated as a curve. Please note 
that instead of determining the similarity of two independent spectra, the 
spectra of the same peak (at different wavelengths) are compared with 
each other here (see Peak Purity Match Factor)! 

Matrix Blank Sample 
The sample matrix can considerably influence sample analysis. To consider 
this, the standard samples should have the same matrix or at least a similar 
one. If this is not the case, you can use the Standard Addition calibration 
mode to analyze samples with an interfering matrix. In addition, you can 
use matrix blank samples to eliminate the influence of the sample matrix in 
the individual samples. Select Matrix as sample type for the respective 
blank sample. Matrix blank samples are marked as follows: . For this 
sample, too, the different peak areas (or peak heights, if these were used 
for quantification) are determined. Chromeleon automatically subtracts the 
peak areas (or peak heights) of the matrix blank sample from the 
corresponding peak areas (peak heights) of all sequence samples. The 
resulting areas (heights) are then used for all further calculations; for 
example, for calibration. However, the respective peaks must have been 
identified for both the unknown sample (or standard sample) and the matrix 
blank sample. 

 Note: 
Thus, matrix blank values are treated differently from "normal" Blank Run 
Samples. For normal blank run samples, the chromatogram is subtracted 
point by point from the chromatogram of the current sample. 

If more than one matrix blank sample was recorded in the sequence, the 
respective peak areas (peak heights) are averaged and the resulting value 
is subtracted from the corresponding peak areas (peak heights) of the other 
samples. 

 Tip: 
Matrix blank samples are subtracted only if they are evaluated in the same 
QNT Method. Otherwise, they will not be considered. 
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Maximum Area Reject 
The Maximum Area Reject parameter defines the maximum peak area up 
to which a peak is rejected. Peaks with a peak area below the defined 
value are not identified. Also, refer to ⇒Maximum Area Reject 

For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 

Maximum Height Reject 
The Maximum Height Reject parameter defines the maximum peak height 
up to which a peak is rejected. Peaks with a peak height below the defined 
value are not identified. (Determination of the height is always relatively to 
the baseline.)  

Also, refer to ⇒Maximum Height Reject 

For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 

Maximum Peak Height (MaxHght) 
Positive peak identification is via the ⇒Minimum Height parameter. All 
peaks above this height value are identified. 

Also, refer to ⇒Maximum Height Reject 

For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 
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Maximum Rider Ratio 
If one or several peaks (h1 to h4) is above the Rider Threshold in a series 
of non-resolved peaks, Chromeleon determines via the Maximum Rider 
Ratio detection parameter whether it is classified as a peak or a Rider.  

 Tip: 

The ⇒Peak Type peak table classification criterion has priority! The 
criterion indicated here is valid for Peak Type = AUTO only! 

Also, refer to ⇒Maximum Rider Ratio 

For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 

Maximum Width 
The Maximum Width detection parameter defines the maximum width 
above which peaks are ignored during peak detection.  
 
Also, refer to ⇒Maximum Width 
 
For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Defining Detection Parameters. 

MCA 
If you use an aQa Mass Spectrometer for data acquisition, you may 
acquire the data in MCA (Multi Channel Analysis) mode. This mode mainly 
serves for calibrating the mass spectrometer. It may also be used for 
analyzing pure solutions of substances. Usually the solution in question is 
made available to the mass spectrometer via infusion. 

 Tip:  
The MCA mode is not available for the MSQ.  
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In MCA mode, all Mass Spectra of the single scans are added up. Only 
the resulting total mass spectra (up to four) are saved when the analysis is 
finished. The advantage is that the files require less storage capacity due to 
the reduced signal-to-noise ratio. 

 Caution: 
Signal dependence according to time is not recorded in MCA mode. 
Therefore, a "traditional" chromatogram is not available. Thus, the MCA 
mode is not suitable for chromatographic analysis. 
 
In MCA mode, the "chromatogram window" looks as follows:  

 

The data acquisition time is represented by a line at the height of the sum 
of all counts of the single mass spectra that have been added up. If, in 
addition, the mass spectrum is displayed in the respective window, it can 
also be displayed as thumbnail in the chromatogram at the end retention 
time, depending on the respective setting.  

 Tip 
MCA data acquisition is not possible in Demo Mode!  

For information about using the MCA mode, refer to How to …: Using 
Mass Spectrometers  Acquiring MS Data in MCA Mode. 
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Message 
Use the Message command to enter reminders for things to do or to 
consider when executing a Program. The message is then displayed on 
the screen. The user must confirm the message by clicking OK before the 
program is continued. Also, refer to ⇒Message 

Minimum Area 
The Minimum Area detection parameter is used as a minimum criterion 
determining the area threshold, below which peaks are ignored during peak 
detection or integration. Also, refer to ⇒Minimum Area 
 
For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Modifying Detection Parameters. 

Minimum Height 
The Minimum Height detection parameter is used as a height threshold, 
below which peaks are ignored. The peak height is measured relative to the 
baseline (a). Also, refer to ⇒Minimum Height 
 
For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Modifying Detection Parameters. 

Minimum Width 
The Minimum Width detection parameter is used as a minimum criterion, 
defining the minimum width, below which peaks are ignored during peak 
detection. Also, refer to ⇒Minimum Width 

For more information about how to use the detection parameters, refer to 
How to …: Integrating Chromatograms and Identifying Peaks 

 Modifying Detection Parameters. 
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MinLampIntensity  
Select the MinLampIntensity command to set the lower limit for the lamp 
intensity. Also, refer to ⇒MinLampIntensity 

Modem Cable (1:1 Cable) 
Modem cables are frequently used standard cables for connecting 
instruments to a PC. The cable assignment is as follows (Also, refer to 

Pin Assignment): 
 

Instrument  PC 
9-pin 

male connector 
25-pin  

male connector 
 25-pin  

female connector 
9-pin  

female connector 
1 8 ------------ 8 1 
2 3 ------------ 3 2 
3 2 ------------ 2 3 
4 20 ------------ 20 4 
5 7 ------------ 7 5 
6 6 ------------ 6 6 
7 4 ------------ 4 7 
8 5 ------------ 5 8 
9 22 ------------ 22 9 

 Notes:  
The pin mapping for connectors with identical pin number is 1:1. That is 
why modem cables are also called 1:1 RS cables. 

With the cable (3) with two 25-pin connectors, the remaining 16 pins are 
also mapped 1:1. 

Dionex part numbers 
160070:  Cable (1): 9-pin (male) - 9-pin (female) (previous LC 

Packings part no. ULT-S-COM and SW-S-COM) 
8914.0144A: Cable (2): 25-pin (male) - 9-pin (female), 5m 

8914.0128: Cable (3): 25-pin (male) - 25-pin (male), 5m  
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 Tip: 
Do not confuse non-crossover modem cables (= 1:1 RS cables) with 
crossover Null Modem Cables! 

For information about additional or other connections, refer to the 
installation instructions for the device. (Also, refer to Hardware Installation 

 Installing and Controlling Third-Party Devices in the Administrator 
Help section.) 

Moduleware 
Instrument control firmware installed on Dionex modules. Moduleware 
sends status information and data to Chromeleon and receives control 
parameters from Chromeleon. 

"Monitor Only" Mode 
Two users cannot control the same Timebase simultaneously. A user 
who connects to the local server from a control panel can control the 
instruments connected to a timebase (control mode). However, a second 
user who accesses the same timebase will automatically be assigned the 
monitor only status. This status means that the second user is allowed to 
view all current values and states on the control panel, but cannot make 
any changes (e.g., change the flow rate). A user who accesses a timebase 
from the  Network is assigned the monitor only status, also. 

Changing from Monitor Mode to Control Mode  
To change between the two modes, select or clear Monitor Only on the 
Control menu. If user A takes over control of the timebase from user B, 
user B is automatically assigned the monitor only status.  

Organizing Access Options 
If User Mode is enabled, the assigned privileges determine whether a 
user can control a timebase or simply monitor the timebase, and whether 
the user is allowed to change between monitor mode and control mode. 
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If access control is disabled, each user has all privileges at all times. 
Objects that are members of an Access Group will not be visible. 

Independently of this, access can usually be limited directly from the server 
or the timebase. Specified users can monitor and/or control the server or 
timebase from the network only if remote monitoring and/or control of a 
server or a timebase is explicitly allowed in the Server Configuration 
program (on the Access Control tab page of the Properties dialog box). 
This does not apply to users who access their local servers. 

Move to Background / Move to Front 
Use Move to Background to move a selected object to the background. 
Use Move to Front to move a selected object to the foreground. 

Multi-Tasking 
Multitasking refers to simultaneous operations of several programs on a 
PC. Unlike earlier Windows versions (3.1; 3.11), allocation of processing 
time under Windows 2000/XP is no longer between programs 
(cooperative), but is monitored and controlled externally (preemptive). This 
guarantees that each application (process) is automatically continued after 
a specific time. A single process cannot claim the entire processing time at 
the expense of other processes. 

Multi-Threading 
Multi-threading allows simultaneous execution of two or more application 
parts as separate processes. For example, if many control commands are 
communicated simultaneously to a chromatography system, 
communication requires a certain amount of time. In the past, it was not 
possible to continue working during this time, regardless of whether the 
operation took a split second or longer. Multi-threading allows simultaneous 
execution of this type of operation (Threads). This is possible because 
each operation is internally separated into many small steps that are 
executed with a time lag, without being noticed by the user.  

Thus, the user can perform other tasks; for example, (s)he can manually re-
integrate a chromatogram despite the comprehensive communication of 
control commands.  
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Name 
The user enters the Name for the substance in the peak table. The name is 
available as peak result variable. 

NeedleUp 
Use the NeedleUp command to lift the sample needle. The internal sample 
valve is switched. (Also, refer to the example for a load/inject process in the 

Autosampler section.) Also, refer to ⇒NeedleUp 

Negative Absorption 
Negative absorbance can be the result of a decreasing absorption of the 
eluent after Autozero (which usually occurs at the beginning of a run). At 
the default setting, the detector will become saturated when the actual 
transmission is 20% above the autozero level. The extent of negative 
absorbance is wavelength-dependent. It depends on: 
• the spectrum of the lamps (deuterium and tungsten), 

• the spectrum and concentration of the different eluent components 
(present in the cell), and  

• the spectrum and concentration of other substances (present in the 
cell). 

Usually, the PDA-100 can detect signal values down to about -0.1 AU 
(default). Use the NegativeAbsorptionLevel command to change the 
default and to enter the level up to which negative values can be detected. 
If the baseline becomes flat and truncated and shows no noise, increase 
the NegativeAbsorptionLevel setting. (Note that baseline noise may 
increase as the negative absorbance level increases.) 

This increases the available signal range to lower values. This is especially 
recommended when running a gradient application in which the 
absorbance of the eluent decreases by several hundred mAU.  
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Network Failure Protection (NFP)  
Often it is useful to store important data on central data server PCs. In case 
the network connection is interrupted or the central data server PC crashes, 
data acquisition should continue, of course. For this purpose, all data that 
are relevant for the Chromeleon server are stored locally on the server's 
hard disk before the sequence is started. If the network connection is 
interrupted, the Server will nevertheless continue to process these 
sequences.  

Interruption of the network connection is logged in the audit trail (see Data 
Management  Audit Trails). The server continues to process the 

Batch using the last conditions. All data are first saved locally.  

In some cases, network recovery might fail due to problems of the ODBC or 
network driver. Restart the Chromeleon server after batch processing is 
complete. In order to ensure that Windows and all other applications work 
properly again Dionex recommends rebooting your PC first.  

In addition to the network-failure protection, Power Failure Protection is 
available. 

 Tip: 
If the network fails while Chromeleon accesses an Access databases, it 
may happen that the Chromeleon datasource (mdb file) is damaged. 
Therefore, Dionex recommends using an MS SQL or Oracle server as 
central database to protect your data even if the network fails. 

Also, refer to How to …: Working with Files, Databases, and Networks 
 Network Failure/Non-Availability in the Administrator Help section. 

Nice Size 
Select Nice Size to optimize the size of one or more controls. The Control 
Frame is adjusted so that the Control including the caption is just visible. 
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(Signal) Noise 
The Signal Noise parameter indicates the signal noise within a 
chromatogram calculated by Chromeleon. The value serves as the basis 
for the Signal-to-Noise Ratio determined from the raw data at the start of 
the data acquisition. 

Determining the Signal Noise (Default) 
All datapoints recorded during the first 10 seconds of a chromatogram form 
the basis for determining the noise value. Chromeleon calculates a 
regression line using the method of least squares, then determines the 
maximum distance of two datapoints above and below the line. (When 
calculating the regression line, all datapoints are weighted with their 
corresponding step unless the step is equidistant.) Adding both values 
supplies the first noise value. 

The procedure is repeated for the last 10 seconds of a chromatogram. It 
returns a further noise value. 

The lower value is indicated under Noise and used as Sensitivity for peak 
recognition. 

Signal Noise in User-defined Range (Parameter Input) 
You can also determine the signal noise for a specific range of the 
chromatogram. In the Integration view, for example, specify this range in 
the Report Column Properties dialog box (after double-clicking the 
column to edit) or in the Add Report Column dialog box by selecting Add 
Column on the Table menu. Mark Chromatogram in the Categories list, 
and then select Signal Noise in the Variables list. Click Parameter to 
open the Parameter Input for 'Signal Noise' dialog box. Select the 
Specific Range check box and enter the desired range. 

 Tip: 
To define the determination, identification, and detection limit via the 
signal-to-noise ratio, always use the noise of the user-defined range! If you 
do not use the noise of the user-defined range, the determination, 
identification, and detection limits might be miscalculated. 
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Normalization (Overview) 
In the linear range, the response (either absorbance or current) recorded at 
a particular retention time is always proportional to the concentration of the 
substance currently in the flow cell. An objective comparison of two 
responses is therefore only possible if the concentration is identical.  

As this condition is rarely fulfilled, and as it is not possible to convert a 
response recorded at a specific concentration to another concentration, the 
height of one response must be scaled to the height of the other. This is 
called normalization. The following factors must be considered: 
• The base area portion must be considered - especially in trace analysis 

(see Baseline Correction of Spectra). 

• In UV detection, the noise portion depends on the wavelength and the 
solvent. Thus, at 200nm, not only is the lamp energy of a deuterium 
lamp considerably lower than at 250nm, but the absorption of common 
solvents is also especially high.  

• In amperometric detection, the noise intensity depends on the value of 
the applied potential. The higher the applied potential the higher the 
noise tends to be. 

• Normalization should be performed where little influence on the above 
factors is expected and where a relative response maximum of the 
substances to be compared is observed. 

Therefore, normalization can be performed by the Absolute Maximum, by 
the Relative Maximum, by a fixed Wavelength (for UV spectra), or by a 

Fixed Time (for I-t plots). 

 Note: 
Chromatograms and peaks can also be compared. They are referred to as 
normalized chromatograms, areas, or amounts. 

Normalization (Absolute Maximum) 
The absolute maximum of the response (for example, the maximum height 
of a spectrum in UV detection or the maximum current in an I-t curve) is 
determined. The response maximum is chosen as a reference point and it 
receives the absolute height 1 (=100%). 

Also, refer to Normalization (Overview) 
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Normalization (Relative Maximum) 
The relative maximum of the response is determined. This will be the 
greatest λ-peak of the spectrum or the greatest current-peak of the I-t plot. 
After normalization, this peak has the height 0.5 (50%). This prevents 
normalization with incomplete maxima on spectrum or I-t plot margins. 

%
100

50

0
λλλ min rel. max max  

 Tip: 
Note that response maxima can exceed the 100% line on the margin of the 
plot, due to the definition! 

Also, refer to Normalization (Overview) 

Normalization (Fixed Wavelength) 
Normalization with a fixed wavelength is analogous to normalization at a 
relative maximum. Instead of the relative maximum, the user can choose 
the wavelength of the absorption value, which seems suited best for 
normalization. 

 Tips: 
Note that spectrum maxima on the margin of the spectrum can exceed 
100%, due to the definition! 

If you use the wavelength of the absolute maximum for normalization, it is 
possible that this wavelength is on the margin of the spectrum. Often, this 
will be on an edge. On edges, wavelength fluctuations will have stronger 
effects. Thus, the results may be less precise. This is especially true for 
detectors that have an optical bandwidth higher than 5nm. 

Also, refer to Normalization (Overview) and Normalization (Relative 
Maximum). 
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Normalization (Fixed Time) 
Normalization at a fixed time is analogous to normalization at a relative 
maximum.  

Instead of the relative maximum, you can choose the time (in the 
Waveform period) of the response value that seems best suited for 

normalization. 

Also, refer to Normalization (Overview) and Normalization (Relative 
Maximum). 

Null Modem Cable 
Null modem cables are frequently used (crossover) standard cables for 
connecting instruments to the PC. However, the term "null modem cable" is 
not defined clearly and precisely, and thus it is used for a number of 
different cables. The cable assignment of the Dionex null modem cables is 
as follows: (Also, refer to Pin Assignment): 
 

Instrument  PC 
9-pin 

female connector 
25-pin  

female connector
 25-pin  

female connector 
9-pin  

female connector 
2 3 ------------ 2 3 
3 2 ------------ 3 2 
5 7 ------------ 7 5 
   4-5 7-8 

Instead of the pseudo handshakes (7-8 and 4-5), the following assignments are realized for 
the completely connected null modem cable: 

1  ------------  4 
4  ------------  1 
7  ------------  8 
8  ------------  7 
9  ------------  9 
S  ------------  S  

 Tip: 
Do not confuse crossover null modem cables with non-crossover Modem 
Cables (1:1 RS cables)! 
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To order null modem cables from Dionex, use the following part numbers: 

The completely connected null modem cable is available as a 9-pin to 9-
pin cable: 
• 1310.2263 null modem cable  

The following null modem cables with pseudo handshakes are available: 
9-pin to 9-pin: 
• 8914.0129 for RS cable RU, 2.5m  

• 8914.0130 for RS cable RU, 5m  

• 8914.0131 for RS cable RU, 10m  
 
25-pin - 9-pin: 
• 8914.0103A for RS cable RU, 2.5m  

• 8914.0120 for RS cable RU, 5m  

• 8914.0121 for RS cable RU, 10m  
 
If necessary, use an adapter to connect the cable to a 25-pin socket. These 
null modem cables have been slightly modified to ensure data transmission 
even with enabled hardware handshake. However, the above hardware 
handshake is not realized. 

For information about additional or other connections, refer to the 
installation instructions for the device. (Also, refer to Hardware Installation 

 Installing and Controlling Third-Party Devices in the Administrator 
Help section.) 

Number (No.) 
The Number variable is the successive number assigned to a peak during 
peak detection. The peak number can be output as peak result variable. 

If the values in this column are not successive but contain gaps, the 
missing peaks fell victim to one of the inhibition criteria; for example, 
Relative Area Threshold or Report Unidentified Peaks = OFF. 
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Number of Calibration Points 
The Number of Calibration Points calibration variable gives the number 
of values that are used for the calibration.  

The Number of Disabled Calibration Points can be displayed separately. 

Number of Disabled Calibration Points 
The Number of disabled calibration points calibration variable indicates 
the number of values that were not considered in the calibration. 

The Number of Calibration Points can be displayed separately. 

ODBC (Open DataBase Connectivity) 
ODBC is the name of a standard database interface that allows access to 
various databases, such as SQL server, dBASE, or Oracle, using an ODBC 
driver. 

Offset 
Signals or chromatograms with an assigned offset value (in %) are offset 
vertically by this value in percent of the window size. Valid entries are from 
0 to 50. 

Offset (c0) 
The Offset (c0) calibration variable returns the offset value of the used 

Calibration Function. 

As a y intercept is only available for the Linear with Offset (= LOff), 
Quadratic with Offset (= QOff), and Exponential (= Exp) functions, no 
output is possible for the Linear (= Lin) and Quadratic (= Quad) functions. 

Offset Level 
The Offset Level command (also called zero position) offsets the 
detector’s analog output signal as a percentage of the full-scale voltage. 
Offsetting the output allows an attached recording device to plot the signal 
if it becomes negative. 
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Offset Volume 
The Eluent Generator Offset Volume option specifies the delay volume 
between the pump outlet and the injection valve. Because the EG40/EG50 
is located between the pump and the injection valve, the eluent 
concentration gradient produced by the EG40/EG50 may reach the column 
more quickly than the %-Gradient produced by the pump. Chromeleon 
uses the offset volume to calculate a time delay in starting the EG40/EG50. 
The delay synchronizes EG40/EG50 and gradient pump operation. 

The default offset volume of 0 µL is used for most systems. The actual 
offset volume may be different, however, depending on the system 
configuration. To change the value, start the Server Configuration 
program and double-click the EG40/EG50 entry in the list of devices for the 

Timebase. Select the Pump Link & Cartridge tab page.  

The offset volume has no effect during isocratic operation. 

 Note:  
The Offset Volume option is not available for the ICS-2000 or ICS-3000 
eluent generator. 

Online Help 
The Chromeleon  Online Help provides on-screen help information in 
any situation. 

• Click the Help cursor icon  on the toolbar to display help 
information about a specific item on the screen. 

• Press the F1 key to display context-sensitive help information about 
a specific situation. A description of the selected menu bar, (tab) 
dialog box, or the enabled control will appear. 

• Select Index on the Help menu to open the Chromeleon online Help. 
The Chromeleon online Help provides three tabs: Contents, Index, and 
Find. The Contents tab page displays the table of contents, listing the 
different sections and topics. The Index tab allows you to search the 
alphabetical list of index entries for a specific term of interest. The Find 
tab allows you search the entire online Help text for specific words 
and/or phrases.  

• Select Using Help to open the Windows online Help. The Windows 
Help provides information about how to use an online Help system.  
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Online Transfer Agent (OTA) 
The Online Transfer Agent allows the server to transfer sequences after 
they have been processed. When the Online Transfer Agent is installed on 
your computer, you can transfer a Sequence or a Batch to the desired 
location directly after data acquisition. To do so, select Transfer on the 
Batch menu (either on a control panel or in the Browser). On the Transfer 
tab page, you can select the option to delete the sequence or batch at the 
original position after the transfer. 

 Tips:  
During batch transfer, sequences in the destination directory may be 
overwritten if they have the same name as the sequences to be transferred. 
However, it is not possible to overwrite locked data, signed data, or 
sequences containing raw data. (Example: If you appended samples to a 
sequence that was already transferred, you have to delete the existing 
sequence in the destination directory manually before you can transfer the 
extended sequence.) 

Sequences not containing raw data are overwritten; neither a warning 
appears before this operation nor are the Privileges (e.g., DeleteSEQ) 
checked.  

For installation details, refer to How to …: Starting and Monitoring the 
Server, Setting Up the Server for Network Access  Setting Up the 
Online Transfer Agent for Network Access in the Administrator Help 
section. 
 

 Tip:  
In order to use the Online Transfer Agent, the Multiple Network Control 
license must be available on your PC (see Chromatography 
Components: Hardware and Software  Chromeleon Licenses). 

 Note:   

If a transfer operation fails, the system attempts the transfer nine times in 
the following intervals: 10 min, 30 min, 1:10 h, 2:30 h, 5:10 h, and then four 
times every 6:00 hours. 
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Operational Qualification (OQ) 
According to the definition formulated together with EURACHEM, 
Operational Qualification is "the process of demonstrating that an 
instrument will function according to its operational specification in the 
selected environment." [P. Bedson and M. Sargent, Accred. Qual. Assur. 
(1996) 1, 265-274] 

The purpose of OQ is to prove and document that an analytical system 
functions according to its operating specification while your specific 
environmental conditions are taken into account. Operational Qualification 
is usually performed directly after a new device was installed. 

On the Qualification menu, Chromeleon provides the Instruments OQ 
and OQ Setup commands. Select Instruments OQ to perform operational 
qualification. Select OQ Setup to generate the templates required for 
performing operational qualification. Usually, this is only necessary after 
initial installation or when the configuration has been modified.  

The individual report pages of the Instrument OQ correspond to the 
Performance Qualification pages for instruments. However, OQ limits are 

stricter than PQ limits. 

It is also possible to perform Chromeleon Operational Qualification. To do 
so, select Chromeleon OQ on the Qualification menu. (For more 
information, refer to Validation and Qualification  Chromeleon 
Operational Qualification (OQ) in the Administrator Help section.) 
 

 Tips: 
For more information about Instrument Operational Qualification, refer to 
the Operational Qualification/Performance Qualification Operating 
Instructions that you can obtain from Dionex Service. 

For more information about Chromeleon Operation Qualification, refer to 
the Chromeleon Operational Qualification Operating Instructions. 

Dionex AutoQ includes the three qualification procedures: Installation 
Qualification, Performance Qualification, and Operational Qualification.  
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Optical Resolution (Spectral Resolution) 
The difference between two detectable wavelengths [in nm] that can only 
just be separated is referred to as the optical resolution of a photodiode 
array detector. It is determined by two factors:  
• Photodiode Resolution 

• Quality of grating required for spectral dispersion (optical bandwidth) 

The values for the optical resolution of conventional detectors are 
approximately 2 - 6 nm (Dionex UVD 340U Detector: 1.9 nm (UV range), 
Dionex PDA-100 Detector: 1.0 nm). 

 Tip: 
The optical resolution is only one criterion for the quality of a detector. For a 
meaningful comparison of different detectors, combine the optical 
resolution and signal-to-noise ratio. In this connection, it is also important 
that the ratio between the individual factors is balanced. This correlation 
becomes clear when you loot at benzene in the 230 - 265 nm range. A fine 
structure ("benzene finger") is only recognizable if the number of 
photodiodes, the imaging optics, and the Signal-to-Noise Ratio are in a 
sensible performance relation to each other. 

Optimum Integration Path 
A chromatogram that has been recorded at a fixed wavelength usually does 
not have an optimum Signal-to-Noise Ratio for all included peaks. The 
selected wavelength is often a compromise that allows you to "see" all 
substances.  

It would be ideal to detect, e.g., peak 1 at 230 nm, peak 2 at 254 nm, peak 
3 at 320 nm, etc.  

This is possible when you perform Wavelength Switching (if the 
wavelength switch points are known) or when you record a 3D Field using 
the Photodiode Array Technology and subsequently determine the 
optimum integration path. 
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Definition 
The optimum integration path is characterized by  
• An optimized signal-to-noise ratio  
• Minimum overlay of neighboring peaks and/or  
• Optimum linearity  

This means that the integration path must pass through the absorption 
maximum of a peak, without being influenced by another peak. The 
recording precision in relative maxima and minima is higher than it is in 
steep spectra edges (this is especially true for large optical bandwidths of a 
detector), Dionex recommends selecting the largest relative absorption 
maximum instead of the absolute maximum. In addition, the absolute 
maximum of UV spectra is frequently located in the low UV range, i.e., near 
200 nm. In this range, the detector sensitivity usually decreases, while 
interferences, such as solvent absorption or humidity, increase. 

When dealing with large substance quantities, as in preparative chemistry, 
total absorption should be below 2 AU. For optimum precision, select a 
relative spectra extremum for recording. 

If the complete chromatographic separation of two peaks is not possible, it 
makes sense to record each channel at a point where the other peak has 
its absorption minimum, or ideally, is inhibited entirely. 

Implementation 
Chromeleon automatically calculates the course of the optimum integration 
path and displays the path in the 3D Field. The transition between two 
wavelengths is exactly between the peak end of one peak and the peak 
start of the other peak. That is why the peak end, peak start, and switch 
time coincide for neighboring peaks.  

You can include the result, i.e. the switch times at which the Wavelength 
signal parameter changes, in a Program, using the Extract: Opt.Int.Path 
to clipboard command. 

 Tip:   

Chromeleon ignores rider peaks (⇒Type (Peak Type): Rider) when 
calculating the optimum integration path. 

For more information, refer to How to …: Analyzing the Peak Purity 
 Selecting the Optimum Integration Path.  
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OQ 
See Operational Qualification (OQ) 

Origin 
See How to …: Integrating Chromatograms and Identifying Peaks 

 Selecting the Calibration Function. 

Original Size 
See Full Size 

Overlay 
An Overlay is a chromatogram that is displayed in addition to the open 
chromatogram, i.e., overlaying the open chromatogram. Overlays are often 
used to compare chromatograms. To do so, several chromatograms can be 
overlaid at several positions in Chromeleon: 

Control Panel 
You can overlay chromatograms during data acquisition. Open a Control 
Panel and select Chromatogram Overlay on the context menu of the 
online signal plot. In addition to the currently recorded channels, a 
previously recorded chromatogram is displayed. 

QNT Editor and Report 
Select Add Overlay on the File menu in either the Report or the QNT 
Editor (see Data Representation and Reprocessing  The QNT Editor) 
to overlay chromatograms after data acquisition. 

Printer Layout 
To plot overlaid chromatograms, select Chromatogram Properties on the 
context menu of a chromatogram (in the Printer Layout) and make the 
corresponding settings on the Overlay tab page. In each plot, you can use 
a processed sample of the current sequence or of any other sequence as 
the reference chromatogram.  

Also, refer to How to …: Working with Chromatograms  Comparing 
Chromatograms. 
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Overview Window 
When zooming, an overview window is displayed in the upper right corner 
of the signal plot. The overview window displays the entire chromatogram 
and indicates the position of the enlarged section.  

P Groups 
See Privilege 

PAL Plug-In Card 
A PAL is a PC plug-in card that is either attached to another card, such as 
the A/D converter card, or inserted in the PC as a separate card.  

The Dongle stores the serial number of the Chromeleon workstation, 
much as the PAL Plug-In card does. Each workstation has a unique serial 
number. The serial number of the PAL plug-in card (or dongle) and the 

Key Code stored in Chromeleon must match. If they do not match, 
Chromeleon cannot operate correctly. Unless there is a PAL, a dongle, or a 

License Server, and unless the key code is correct, Chromeleon can run 
in Evaluation Mode only. 

The Administrator Help section provides more information; refer to:  

Software Installation and Communication  The Software License 
Hardware Installation  Entering the Software License  

Panel 
See Control Panel 

Panel Tabset 
A panel tabset provides (on one window) a set of Chromeleon Control 
Panels for controlling the individual instruments in a Timebase and for 
performing system-wide functions (for example, creating and running 
sequences). A panel tabset is designed to function as the main or only 
interface required for controlling and monitoring a timebase. 

Also, refer to Control  The Panel Tabset 
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Partial Flows 
See %B, %C, %D 

Partial-Loop Injections (AS/AS50 Autosampler) 
When performing a partial-loop injection, the AS or AS50 autosampler 
draws the volume to be injected, plus two times the cut volume (a volume 
of sample discarded from each end of the aspirated sample), from the 
sample vial. 
Partial-loop injections are possible under the following conditions: 

• The valves are installed in the autosampler or, if external, are installed 
in one of the following modules: ICS-1000/1500/2000 or ICS-3000 DC.  

• The AS or AS50 (USB) is not running in Simultaneous or Sequential 
mode. 

If the above conditions are not met, the autosampler can perform Full-
Loop Injections only. 
 
Partial-Loop Injection Sequence 
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Partial-Loop, Limited-Sample Injections (AS/AS50 
Autosampler) 
When performing a partial-loop, limited-sample injection, the AS or AS50 
autosampler draws only the volume to be injected from the sample vial. 
Partial-loop injections are possible under the following conditions: 

• The valves are installed in the autosampler or, if external, are installed 
in one of the following modules: ICS-1000/1500/2000 or ICS-3000 DC.  

• The AS or AS50 (USB) is not running in Simultaneous or Sequential 
mode. 

If the above conditions are not met, the autosampler can perform Full-
Loop Injections only. 
 
Partial-Loop, Limited-Sample Injection Sequence 
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Password 
Passwords protect access to specific software or areas thereof. 
Chromeleon requires passwords in different situations: 

A password is required to open the User Manager (CmUser program). 
The administrator assigns the password when s(he) creates the user 
database. 

When the User Mode is enabled, the user can open the Chromeleon 
client only after entering the correct password. The administrator 
associates each user with an individual password in the User Manager. 
However, after the user correctly enters the assigned password, s(he) can 
change the password at any time. 

A password is also required to sign sequences electronically (see: 
Electronic Signature). Each user has a password that allows him(her) to 

submit, review, and approve the signature according to his(her) privileges. 
This signature password, too, is assigned by the administrator in the User 
Manager program and can later be changed by the user. Electronic 
signature is possible only when User Mode is enabled. 

Peak Group Start/Peak Group End 
Select Peak Group Start and Peak Group End detection parameters to 
identify several successive peaks as a peak group. A peak group that has 
been defined in such a way is treated as one single peak.  

Also, refer to ⇒Peak Group Start/End 

For more information about the detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 

Peak Name 
Enter the name of the substance detected at the time t in the Peak Name 
column of the peak table in the QNT Editor (see Data Representation and 
Reprocessing  The QNT Editor). The peak name can be indicated as a 
separate peak variable in the report. 

Also, refer to ⇒Name (Peak Name) 
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Peak Number (No.) 
See Number (No.) 

Peak Purity 
See the following topics:  

PPA (Peak Purity Analysis) 

PPI (Peak Purity Index) 

PPA Report 

Peak Purity End Wavelength (PPWlEnd) 
In combination with the Peak Purity Start Wavelength detection 
parameter, Peak Purity End Wavelength limits the wavelength range for 
peak purity calculations. 

Also, refer to ⇒Peak Purity Start/End Wavelength. 

For information about how to apply detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 

Peak Purity Match Factor  
The Match Factor expresses the similarity of two curves. A peak purity 
match factor can be expressed for both UV spectra and mass spectra. 

The match factor for UV spectra (= UV match factor) refers to the 
correlation between the spectrum in the peak maximum and the spectra on 
the leading and trailing edges. Ideally, none of the spectra between peak 
start and peak end deviates from the spectrum in the peak maximum. They 
correspond to 100%; that is, the match value is 1000. For Mass Spectra, 
the distance between the single masses and the relative height of the 
different mass peaks is taken into account. As with UV spectra, a match 
factor of 1000 indicates a perfect match. However, the MS match factor is 
far more selective than the UV match factor. 
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 Tip:  
The calculation of the match factor becomes more inaccurate on the peak 
margins. This is due to the poorer Signal-to-Noise Ratio. Select the 
⇒Peak Purity Threshold detection parameter to limit the selection of the 
UV and mass spectra in the QNT Editor (see Data Representation and 
Reprocessing  The QNT Editor) to a sensible peak height.  

If the match factor of a peak is included in a report column, the value will be 
averaged from all match values of the peak that have been determined so 
far. The UV match factor is always baseline-corrected (see Baseline 
Correction of Spectra), as this portion usually cannot be neglected; it would 
falsify the result. 

With mass spectra, define in the QNT Editor whether background mass 
spectra shall be subtracted. If you enable background subtraction, define 
which spectra shall be subtracted. This also defines whether the match 
factor shall be output baseline-corrected. For more information, refer to 
How to …: Working with Chromatograms  Subtracting MS 
Background Spectra. 

In addition, you can include the deviation of the averaged single match 
values in the PPA Report as the Peak Purity: Relative Standard 
Deviation of the Match Factor (RSD Match). 

Peak Purity: Relative Standard Deviation of the 
Match Factor (RSD Match) 
The relative standard deviation of the Peak Purity Match Factor indicates 
its homogeneity over the entire course of the peak. 

Calculation is analogous to the Relative Standard Deviation of the PPI 
(RSD PPI). Instead of the PPI values, the corresponding match values are 
used. Divide the standard deviation by the average of all match values 
(Match Ø) and multiply the result by 100%. The result is the relative 
standard deviation of the match factor (RSD Match) in percent. 

%100*)(
∅

=
Match

SDMatchRSD
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Peak Purity Start Wavelength (PPWlStart) 
In combination with Peak Purity End Wavelength detection parameter, 
Peak Purity Start Wavelength limits the wavelength range for peak purity 
calculations.  

Also, refer to ⇒Peak Purity Start/End Wavelength. 

For information about how to apply detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 

Peak Purity Threshold (PPTrshold) 
The Peak Purity Threshold detection parameter determines the threshold 
for the signal height above which spectra comparison is performed. The 
parameter is important for the Peak Purity Analysis (PPA) and the peak 
ratio. 

Peak Purity Analysis (PPA) 
For the peak purity analysis, the parameter defines the signal height above 
the baseline from which UV or Mass Spectra shall be extracted for 
calculating the PPI (Peak Purity Index) or the Peak Purity Match Factor. 

Peak Ratio 
For the peak ratio, the parameter defines the signal height above which the 
ratio of two UV or MS channels shall be calculated.  

Also, refer to ⇒Peak Purity Threshold 

For information about how to apply detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 

Peak Shoulder 
A peak shoulder (often simply referred to as a shoulder) occurs if a second 
substance with a (usually) considerably lower concentration is found below 
a large main peak. Peak shoulders normally do not have a distinct separate 
relative signal maximum of their own. Unlike peak shoulders, Rider Peaks 
usually have a distinct relative maximum of their own. 
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Chromeleon distinguishes between peak shoulders and rider peaks when 
defining retention time. As with main peaks, the peak retention time for rider 
peaks is defined as the time of the signal maximum. In contrast to this, the 
peak retention time for peak shoulders is the time with the maximum signal 
height over the baseline. Below the shoulder, the baseline is often inclined. 
That is why this time does not necessarily correspond to the time of the 
signal maximum. Chromeleon usually skims peak shoulders in an 
exponential way: 

 

Peak Shoulder Threshold 
The Peak Shoulder Threshold parameter defines a threshold value for 
peak shoulder recognition. Also, refer to ⇒Peak Shoulder Threshold. For 
more information about how to use the detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Defining 
Detection Parameters. 

Peak Slice  
The Peak Slice detection parameter determines the width (= space of time) 
from which several successive data points are interpreted as peak or as 
noise. Also, refer to ⇒Peak Slice 

 Note:  
Always consider this parameter in combination with the ⇒Sensitivity. 
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Peak Start Time  
The Peak Start Time peak result variable refers to the peak start in 
minutes. The left peak delimiter determines the peak start.  

Peak Stop Time  
The Peak Stop Time peak result variable refers to the peak end in 
minutes. The right peak delimiter determines the peak end.  

Peak Summary 
A peak summary tabulates the peak and sample variables of any samples 
desired. The summary usually includes the samples of a sequence. 
However, you may also create a summary based on a Query. 

For more information, see Report Tables  The Peak Summary Report. 

Peak Table 
The peak table is part of the QNT Editor (see Data Representation and 
Reprocessing  The QNT Editor). The QNT Editor allows you to 
determine the parameters for peak identification and peak calibration. 

For more information, refer to The QNT Editor  Peak Table, Amount 
Table, and Peak Tracking. 

Peak Type 
See Type 

Peak Width 
See Width 
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Performance Qualification (PQ) 
Instrument and software validation is becoming increasingly important to 
analytical laboratories. Performance Qualification (PQ) is an important 
aspect of validation. PQ is defined as "the process of demonstrating that an 
instrument consistently performs according to a specification appropriate 
for its routine use" [P. Bedson and M. Sargent, Accred. Qual. Assur. (1996) 
1, 265-274.]  

The task of PQ is both to ensure and to document that your system 
functions as required by your particular (routine) operation. The frequency 
and scope of Performance Qualification are determined by the 
requirements in your laboratory. They can be specified in internal 
instructions or in an SOP. The parameters should be similar to those for 
routine operation. In addition to Performance Qualification, Operational 
Qualification and Installation Qualification are important factors for 
validating instruments and software. The term AutoQ includes the three 
qualification procedures. 

To perform Performance Qualification for your instruments, select 
Instrument PQ on the Qualification menu in the Chromeleon Browser. 
For more information, refer to Validation, AutoQ, and System Wellness 

 Instruments Operational and Performance Qualification. 

PGM File 
The PGM File (also called control file) can have several sections. That is 
why the PGM Editor (see Chromeleon (Overview)  The PGM Editor) 
provides different views: 
• The Commands view, displaying the actual Program 
• The Post-acquisition steps view, providing extraction and data 

smoothing steps that are performed after data acquisition 

The PGM File and the program can be easily created, using the Program 
Wizard. (For information about the wizard, refer to Control  The 
Program Wizard.) The user input is automatically converted into uniform 
command syntax readable by Chromeleon. In this way, even new users 
can quickly create operable programs. After creating the program, you may 
have to enter the Mass Spectrometer method and the Post acquisition 
steps on the corresponding pages of the PGM Editor. To edit the 
commands for device control, use the corresponding Device views. 
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Phosphorescence 
The temporally delayed emission of light after excitation with light energy is 
referred to as phosphorescence. The time delay observed in solutions is 
between 0.001 and 10 seconds. It is often possible to use a fluorescence 
detector to measure the phosphorescence (as well as the 

Chemiluminescence). In this case, the emitting light is measured several 
milliseconds after the excitation flash. 

 Note: 
The wavelength of the emitted light is always higher than the excitation 
wavelength. In HPLC applications, the phosphorescence spectrum is 
independent of the excitation wavelength. 

The Molecular Orbital (MO) theory provides a more exact explanation: 

Similar to Fluorescence, molecules are excited by the absorption of light. 
Absorption arises from the ground state, the lowest vibrational level of the 
lowest singlet state (S0) and terminates in different excited vibrational 
levels of the next higher singlet state (S1). 

1A0 ShS →+ ν  
where:  

h = Plank's constant 

Aλ
ν c  absorptionat  frequencelight   A ==

 
where: 

c = speed of light 

λ = wavelength 

The excited vibrational states of S1 transit via a radiationless intersystem 
crossing into the lowest triplet state (T1). The transition from the triplet state 
into the ground state is spin prohibited. Therefore, it is temporally delayed 
and phosphorescent light is emitted: 

PhST ν+→ 01  
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 Notes: 
Compared to fluorescence spectra, phosphorescence spectra are shifted to 
the red because the electronic T1 states are energetically below the S1 
states. 

Due to the fast relaxation in solution the emission spectra of electronically 
excited molecules in solution is independent of the excitation wavelength 
(also for excitation of, e.g., S0→S2), according to the Kasha rule. 

Photodiode Array Detector 
A photodiode array detector is a special multi-channel UV Detector. For 
more information, refer to 

Photodiode Array Detectors (Main Features) 

Photodiode Array Detectors (Functionality) 

Highest optical resolution and at the same time high sensitivity are decisive 
factors for the quality of a photodiode array detector. For more information, 
please refer to Optical Resolution (Spectral Resolution). 

Main Features 
Photodiode Array Detectors (PDAs) feature high sensitivity and a large 

linearity range, they are relatively independent from temperature 
fluctuations, and can be used for gradient elution (%-gradient). The 
simultaneous detection of all wavelengths at the time t is made possible by: 
• Peak Purity Analysis 
• Peak identification via the Spectra Library 
• Determination of optimum integration path for later wavelength 

alterations 
• Normalization of spectra 
• Quantification of non-resolved peaks 
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The measuring range of the PDA-100 detector is from 190 to 800 nm. The 
measuring range of the UVD 340S detector is from 200 to 355 nm in the 
UV range and from 357 to 600 nm in the visible range.  

Functionality 
Unlike conventional (1 or 2-channel) UV Detectors, multi-channel 
detectors (PDAs) send the entire spectrum of the light source (a), in 
focused form (b), through the flow cell (c). Thus, absorption not only causes 
the intensity of a single wavelength to change, but that of all wavelength 
portions of the entire spectrum. After that, the white light is dispersed 
spectrally using a grating (d). The resulting spectrum is measured by 
adjoining photodiodes (e) almost synchronously. 

a

b

c

d

e

 
Dionex detectors store this information analog to a UV channel via the 
signal 3D Field. Apart from the quality of the optics and the grating, the 
number and size of the photodiodes determine the Optical Resolution of 
the detector. 

 Tip: 
The optical resolution cannot be considered by itself, but must be seen in 
connection with the achieved signal-to-noise ratio!  

Photodiode (Pixel) Resolution 
The bandwidth of wavelengths on an individual photodiode is referred to as 
photodiode or pixel resolution. If 150 photodiodes are available in the UV 
range (200 - 350 nm), the photodiode resolution is 150 nm / 150 
photodiodes = 1 nm per photodiode. 

The Optical Resolution of the UV detector is determined by photodiode 
resolution and the optics (mirror, slit, grating, optical bandwidth). 
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Pin Assignment (RS-232) 
Most instrument connections are made with 9-pin or 25-pin Modem 
Cables or Null Modem Cables. The pin assignments are as follows (only 
the most important pins are mentioned): 
 
25-pin 9-pin Abbrev. Description 
2 3 TxD Transmitted data 
3 2 RxD Received data 
4 7 RTS Request to send 
5 8 CTS Clear to send 
6 6 DSR Data set ready 
7 5 GND Signal ground/common return 
8 1 DCD Received line signal detector 
20 4 DTR Data terminal ready  
The pin numbering (order for plug) is as follows: 

 

 

If other connectors are required, refer to Hardware Installation 
 Installing and Controlling Third-Party Devices in the Administrator 

Help section. 
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Polarity (Analog Output) 
The Polarity command allows you to change the polarity (+/-) of the analog 
output signal on a Dionex detector. For example, if components are 
appearing as negative peaks instead of as positive peaks, use this 
command to change the analog output polarity from + to -. 

Post-Acquisition Steps  
Post-acquisition steps are data reprocessing steps for extracting and 
smoothing data. They can be defined in the PGM Editor. (For information 
about the PGM Editor, refer to Control  The PGM Editor.) They can be 
performed online, after data acquisition, or offline of the chromatogram, UV 
spectrum, or Mass Spectrum. The following steps are available for data 
reprocessing: 
• Arithmetic combination of channels (arithmetic combination of 2D 

channels - see  Combining Channels via Arithmetic Operations) 

• Copy Channel (see  Copying a Channel) 

• Create Fraction Analysis Samples (see How to …: Collecting 
Fractions Automatically (Autopurification)  Creating Fraction-
Type Samples) 

• Create Purification Samples (see How to …: Collecting Fractions 
Automatically (Autopurification)  Creating Preparation-Type 
Samples) 

 Tip: 
The Create Fraction Analysis Samples and Create Purification 
Samples options are part of Autopurification. They are visible only if 
the Purification license is installed and if a connection to the server 
exists. A connection exists if a PGM File is associated with a timebase, 
the server on which this timebase resides is running, and the client is 
connected to this server. 

• Extract ED channel (for extracting an ED channel – only possible if 
3D_Amp data is available) 

• Extract MS channel (for extracting a Mass Trace - only possible if 
MS data is available; see How to …: Using Mass Spectrometers 

 Extracting Mass Traces Afterward) 
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• Extract optimum integration path (for extracting the Optimum 
Integration Path - only possible if a 3D field is available; see How to …: 
Creating and Using Spectra Libraries  Selecting the Optimum 
Integration Path) 

• Extract UV channel (for extracting a UV channel - only possible if a 3D 
field is available; the procedure is similar to selecting the optimum 
integration path) 

• Smooth data (for chromatogram Smoothing - see How to …: 
Working with Chromatograms  Performing Data Smoothing) 

For more information, refer to How to …: Creating and Modifying 
Programs  Adding Post-Acquisition Steps. 

Power Failure Protection 
When Chromeleon is started, the system recognizes whether online 

Batch processing was interrupted by a power failure.  

This is possible because the processing date and time of each sample is 
entered in the sequence editor. Chromeleon checks whether all "started" 
samples (labeled with the date and time) have been completely processed, 
i.e., whether they have reached the status F (finished). If the samples are 
not labeled Finished, the Power Failure Handling function allows you to 
define how to continue processing. Select Error Handling on the Batch 
menu and select an option: 
• Continue with the interrupted sample 
• Continue with the next sample 
• Reprocess the entire online batch 
• Abort the batch 
• Prompt the user what to do  

You can also select a PGM File that shall be started after booting the 
server (see How to …: Creating and Modifying Programs  Creating a 
Power Failure Program). 

In addition to power failure protection, Chromeleon also provides Network 
Failure Protection. 
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PPA (Peak Purity Analysis) 
Peak purity analysis (PPA) is a pane of the offline module. It consists of a 
graphical section and the PPA Report. For more information, see Data 
Representation and Reprocessing  PPA: Peak Purity Analysis. 

PPA Report 
The PPA (Peak Purity Analysis) report represents the numerical addition to 
the PPA pane. In a table, this report combines variables characteristic for 
the peak purity analysis and variables freely selectable by the user. 
Especially meaningful variables are: 
• PPI (Peak Purity Index),  

• Relative Standard Deviation (RSD PPI),  

• Peak Purity Match Factor, and  

• Relative Standard Deviation of the Match Factor (RSD Match). 

PPI (Peak Purity Index) 
The peak purity index (PPI) represents the central wavelength of a 
spectrum. In simplified terms, this is the wavelength where the areas of the 
spectrum to the left and right are identical. The PPI is thus independent of 
the concentration. 
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A pure single peak should supply the same PPI value from peak start to 
peak end for each spectrum recorded in this range. The following 
conditions must be fulfilled: 
 
• The baseline portion must be insignificant. If this is not the case, a 

Blank Run Subtraction must be performed.  
• During analysis, the solvent composition and thus the UV absorption of 

the solvent may not change significantly (special attention is required 
for gradient applications). 

• Compared to the signal height, the drift must be very small. 
• The Lambert-Beer Law must be valid for the entire range.  
 
In the ideal case of a pure peak, entering individual PPI values results in a 
rectangle curve. The height of each single rectangle corresponds to the 
value of the central wavelength. The deviation from the rectangle shape 
can be expressed mathematically by the relative standard deviation of the 
PPI value.  

PPI A

t

350

238
252

200 0

1000
[nm] [mAU]

PPI 1
PPI 2

Chromatogram

  
Significant deviations from the rectangle shape indicate peak impurity. 
However, it is not necessarily correct to deduce from the rectangular shape 
that the peak is pure. 

 Tip: 
The calculation of the PPI value becomes inaccurate near peak limits due 
to the poorer Signal-to-Noise Ratio. Using the ⇒Peak Purity Threshold 
detection parameter, the selection of spectra can be limited to a sensible 
peak height in the QNT Editor. (For information about the editor, see Data 
Representation and Reprocessing  The QNT Editor).  
 
If the Peak Purity Index (PPI) is entered in a report column, this value is 
averaged from all determined PPI values of a peak. The deviation of single 
PPI values from each other can be expressed as the Relative Standard 
Deviation (RSD PPI) in the PPA Report. 
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PPI: Relative Standard Deviation of the PPI (RSD 
PPI) 
The relative standard deviation of the PPI expresses the degree of 
deviation of the computed individual PPI values from each other. 

To determine this value, all PPI values of a peak are averaged (PPIØ) and 
are then squared (Q-Sum). 

Q Sum PPI PPI
i

n

− = − ∅
=
∑ ( )2

1  

The standard deviation (SD) is defined as the root that is extracted from the 
Q-sum divided by (n-1), with n being the number of data points.  

SD
Q Sum

n
=

−
−( )1  

The relative standard deviation of the PPI (RSD (PPI)) in percent is 
obtained by dividing the standard deviation by the average of all PPI values 
(PPIØ), and by multiplying the result by 100%. 

RSD PPI
SD

PPI
( ) *=

∅
100%

 

Preconditions 
The device settings before a sample run are referred to as Preconditions. 
The Preconditions are saved in the audit trail files and displayed in the 
Daily Audit Trail and the Sample Audit Trail after the following icon: . (For 
more information about the Audit Trails, refer to Data Management 

 Audit Trails.) 
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The device settings are listed in the Daily Audit Trail directly after the first 
message (Daily audit trail of timebase X).  

 

PQ 
See Performance Qualification (PQ) 

Pressure Limits 
Depending on solvent composition and the selected ⇒Flow, pressures of 
up to 450 bar (= 45 MPa = 6525 psi) occur on the high-pressure side of a 
chromatography system. Chromeleon is capable of monitoring the pressure 
value provided by the pump. The user can define upper and lower pressure 
limits. If one of the limits is exceeded, Chromeleon stops the flow, displays 
an error message, and stops the sample batch, as necessary. 

Also, refer to ⇒Pressure.Lower/Upper.Limits 
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PrimeSyringe (ASI-100 Autosampler) 
The PrimeSyringe command, which is supported for the ASI-100 
Autosampler, allows removing gas bubbles from the syringe without 
dismantling the syringe from the instrument. First, the syringe is filled 5 
times with washing liquid, usually isopropanol. Then, the procedure is 
repeated, using the solvent. 

For more information, refer to Practical Tips for Device Control 
 Priming the Syringe (ASI-100 Series).  

Printer Layout 
Use the Printer Layout to prepare your data for the printout. Enable 

Layout Mode on the Edit menu. When Layout Mode is enabled, you can 
add the following elements to the Printer Layout: 
• Sheets (worksheets that can also include the following elements) 

• Report Tables  

• Rows  

• Columns  

• Variables (report variables of the different ⇒Report Categories) 

• Chromatograms 

• Calibration plots (calibration curves) 

• Spectra plots (UV spectra) 

• Mass spectra plots ( Mass Spectra) 

• 3DFIELD plots ( 3D Fields) 

• 3D amperometry plots 

• Cyclic voltammetry plots 

• Trend Plots 

• Charts (graphical display of the values of the individual cells/columns) 
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The Printer Layout is stored in the Report Definition File (RDF) together 
with the (on-screen) report. The Printer Layout section of the RDF is also 
referred to as print template. Click the Printer Layout icon ( ) on the 
Method toolbar to open the Printer Layout of the selected report definition 
file. The report definition file contains sample data.  

For information about how to design a print template, refer to How to …: 
 Preparing the Printout. 

For information about how to print your results, refer to How to …: 
Preparing the Printout  Specifying the Printout. 

Privileges (User Rights) 
When the User Mode is enabled, the system administrator can assign 
user rights and thus, determine which actions a certain user group 
(= Privilege Group) is allowed to perform. The system administrator assigns 
the access rights in the User Manager (CmUser program).  

When the User Mode is enabled, the user can execute most actions in the 
Chromeleon only if (s)he has the corresponding rights (privileges). 
Chromeleon provides almost 100 different user privileges, such as 
ReadSequence, CopySample, DeleteSequence, etc. Instead of assigning 
each privilege separately to each user, privileges are combined in Privilege 
Groups (P Groups). Thus, the user's Privilege Group membership defines 
his(her) privileges. 

Each Privilege Group defines a specific range of operations. These are 
divided in the specific areas: CM-Server Control, Datasource, Sequence, 
Data Reduction, Reporting, and Miscellaneous. The scope of functions 
available for one Privilege Group increases with the number of privileges 
enabled in the individual areas. (For more information about the user 
privileges, refer to Chromeleon User Management  Privileges 
(Categories) in the Administrator Help section. 

Members of a specific Privilege Group can use all privileges assigned to 
this group. Each user can be a member of one or several Privilege 
Group(s). The users belonging to a Privilege Group are listed by name.  

The more different Privilege Groups you create, the more precisely you can 
define the assignment of privileges in Chromeleon. The privileges of all 
Privilege Groups to which the user belongs define the privileges of the 
individual user.  
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Privileges, such as DeleteSequence, are assigned globally; that is, a 
specific privilege is granted for all datasources the user can access. To 
restrict access, the system administrator can establish Access Groups in 
the User Manager in addition to the Privilege Groups.  

Program  
The control program (in short: program) is part of the PGM File and is 
displayed in the Commands view of the PGM Editor (see Control  The 
PGM Editor). It can be considered a "schedule" for the execution of 
different ⇒Control Commands. In this file, the user writes all commands to 
be executed before, during, and after analyzing a sample plus the 
corresponding execution times. In this way, it is possible to completely 
automate the analysis including any routine procedures that are performed 
before and after the analysis, for instance, column conditioning by rinsing 
the column with various solvents. 

It is also possible to use a program to monitor specific parameters or limits 
and to trigger specific reactions when these limits are not met.  

Follow the instructions of the Wizard (also see Control  The Program 
Wizard) to create the basic structure of the program. The user input is 
automatically converted into uniform command syntax readable by 
Chromeleon. In this way, even new users can quickly create operable 
programs. 

For more information, see: 

Control  The Control Program  

 The Program Syntax. 

Protocol  
The Protocol command allows you to log specific events in the Audit 
Trail while a PGM File is executed. 

Unlike simple comments that are only part of the Program, the Protocol 
text is included in the Audit Trail and thus, it is directly linked to the 
corresponding sample. Use Protocol text to comment individual samples. 

It is also possible to execute the Protocol command event-controlled.  

Also, refer to ⇒Protocol 
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Pulse Mode 
In addition to the DC Mode, some electrochemical detectors can be 
operated in the Pulse Mode. This method is also called PAD (pulsed 
amperometric detection) and is characterized by a series of potential 
changes. This method allows a continuous regeneration of the electrode 
surface (platinum or gold electrode). 

 Note: 
Instead of Pulse Mode, Dionex electrochemical detectors are operated in 
Integrated Amperometry Mode. In this mode, Dionex electrochemical 
detectors can perform PAD and IPAD (integrated amperometric detection). 
Refer to Integrated Amperometry Mode for details. 

In PAD, a distinction is made between three different potentials (E1, E2, 
E3) and the period (T1, T2, T3) for which a potential is connected to the 
electrode. T1 + T2 + T3 form a cycle that is constantly repeated. 

E1

E3

T2

T2 = Cleaning
T1` = Stabilisation (Delay) time

= Measurement time

T1

T1´ Ts

T1 = T1´ + Ts

Ts

T3

T3 = Conditioning
7000

0

t[msec]

E[mV]

E2

  
Data is recorded only during the second half of T1 (= Ts). The duration of 
Ts is either set directly or is determined by defining a delay T1´ (stabilizing 
phase). The material of the working electrode largely determines the period 
and the height of the various potentials. 

PWA 
PWA, which is the abbreviation for Purification Workflow Automation, is the 
key feature of Autopurification. The workflow is automatically adapted to 
your requirements; for example: 
• Fractionation is performed only for those samples that contain a 

sufficient amount of the desired target compound(s). 
• Purification is performed only for the compounds of interest. 
• Only specified fractions are reanalyzed, using different 

chromatographic conditions. 
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Qualification 
The purpose of instrument and data system qualification is to check the 
functionality of the instrument and Chromeleon. Before that, it is the task of 
the manufacturer to validate the instruments and Chromeleon (see 

Validation). There are several qualification steps: 
• Installation Qualification (IQ)  

• Operational Qualification (OQ; qualification in the operating 
environment) 

• Performance Qualification (PQ; qualification in routine operation) 

Chromeleon allows you to perform the single qualification steps 
automatically with the AutoQ qualification tools.  

For more information, refer to Validation, AutoQ, and System Wellness: 

 Validation and Qualification  
 AutoQ Equipment Qualification 

Quantification Method (QNT Method) 
A quantification method includes all parameters that are used for the 
evaluation of a peak or the entire chromatogram. The QNT Method serves 
as the basis of calculation for evaluating a sample and contains: 
• All data for the assignment according to the order of elution within 

defined limits (time windows) (identification) and  

• The parameters (calibration constants) that are part of the 
area/concentration (amount) conversion formulas as well as the 
calibration points required for the calculation.  

Also, refer to Data Representation and Reprocessing  The QNT 
Editor. 
The Method column of the sample list in the Browser contains the name of 
a quantification method (QNT Method). (For more information, refer to Data 
Management  The Browser and The QNT Editor  The 
Quantification Method.) 
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Query 
Chromeleon allows you to efficiently search, e.g., directories, sequences, 
samples, or comment lines, for specific names or character strings: 
• In the Browser, select Query on the context menu or select New > 

Query (using Wizard) on the File menu. A wizard appears guiding you 
through entering the desired conditions. 

• On the first page, define whether to perform the query in the currently 
open Datasource or in a different one. In addition, define whether to 
find certain sequence properties and/or sample properties, and/or other 
result properties.  

• After clicking Finish, you can enter additional conditions to limit the 
query.  

From the entered information, Chromeleon generates an SQL statement 
that can start a query within all ODBC-capable databases.  

For more information about performing a query, refer to How to …: 
Creating and Managing Files and Data  Performing a Query. 

You can save the result of a query as a new sequence, using the Save as 
command. QNT Files and PGM Files are copied; raw data is copied 
optionally. File names occurring more than once receive a consecutive 
number. The following symbol indicates the query sequence:  

QNT Editor 
The QNT Editor allows you to create and modify methods for evaluating 
chromatographic results. The Quantification Methods (QNT Methods) 
created in the QNT Editor are used for sample evaluation. The QNT Editor 
usually provides: 
• The chromatogram of the current sample 

• The calibration curve of the current peak 

• Several tab pages for parameter input 

For more information about the QNT Editor, refer to Data Representation 
and Reprocessing  The QNT Editor. Also, refer to How to …: 

 Integrating Chromatograms and Identifying Peaks. 
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QNT Method 
See Quantification Method (QNT Method) 

Rack 
Many Autosamplers and Fraction Collectors provide a choice of racks to 
meet individual capacity and vial number requirements. For optimum 
operation, you have to specify the rack installed in the autosampler in the 
Server Configuration program. For the Dionex autosamplers, Chromeleon 
lets you display the rack for the desired sequence: 

From an existing sequence 
To display the rack indicating the Status of the single samples in the 
sequence: 
• Connect the desired sequence to the corresponding timebase. 

• Select Rack on the View menu.  

When creating a sequence 
When creating a new sequence, check your entries on the rack preview of 
the Sequence Wizard: 
• Select New on the File menu, and then select Sequence (using 

Wizard) from the list. 

• After you have entered the samples in the corresponding step of the 
wizard, click the Rack Preview tab page. 

The rack of the Dionex ASI-100 Autosampler consists of three color-coded 
segments. The following segment types are available:  
 
Rack types Description 
  
Analytical: Select this option if you use the default segment. This segment can 

house up to 39 vials at 1.1 or 1.8 ml each + 1 vial at 4 ml.  
Semiprep: Select this option if you use the semipreparative segment. This 

segment can house up to 21 vials at 4 ml each. 
Mini: Select this option if you wish to analyze a large number of samples or 

if small sample volumes are available only. This segment can house 
up to 64 vials at 1.2 ml + 1 vial at 4 ml. 

Eppendorf: Select this option, if you are using the rack for Eppendorf vials. This 
segment can house up to 22 vials at 1.5 or 2 ml each + 1 vial at 4 ml.   



A-158 Glossary 

If your system comprises an autosampler with rack cooling, such as the 
ASI-100T, you can determine the controllable temperature range. Exact 
temperature control is possible from +4°C to +45°C (39.2°F to 113°F). For 
example, the ASI-100T autosampler allows you  
• to cool the rack by 18 K from ambient  

• to heat the samples by up to 35 K from ambient. 

Fraction Collector 
For fraction collectors, Trigger Commands are used during the analysis to 
define when to start collecting the next fraction. Fraction collection control 
depends on many factors and is very complex. For more information, refer 
to How to …:  Collecting Fractions. 

Ramp 
Continually changing the composition of the delivered solvent mixture over 
the desired time (for %-Gradients) or the flow (for Flow Gradients) is 
referred to as a ramp (or more precisely as a ramp gradient). Contrary to 
this, immediate changes of the solvent composition or flow are referred to 
as Step Gradient.  

To realize a ramp gradient, define one value for the beginning and another 
value for the end. Between these two values, Chromeleon automatically 
calculates the solvent composition (or flow) at the respective time (two 
ramps in the example below: 0 - 2 min and 3 - 5 min): 
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Range 
The Range parameter determines the factor by which the analog output 
signal of controllable detectors is amplified or reduced. 

 Notes: 
The Range parameter has a different meaning for the RF2000 
fluorescence detector. The Gain parameter is used, instead. 

For Mass Spectrometers, the range indicates the scaling for the online 
plot of mass traces. You can enter any value between 1 and 10. The value 
describes the tenth power of the maximum value that can be displayed. 
(For example, if Range = 6, the maximum value that can be displayed is 
1.000.000 = (1 E+6).) 

Raw Data 
Data generated by the system are referred to as raw data, whereas data 
entered by the user are referred to as user data. Raw data, such as: 
• Sample data acquired on different channels (see Signal) 

•  Audit Trails 

• Injection time (see ⇒Inj. Date/Time) 

• History 

cannot be changed by the user. 

In a narrower sense, all analog or digital values measured by a detector 
and stored digitally on the PC are referred to as raw data. Raw data only 
exists for those signals or channels that were selected by the user before 
data acquisition. 

The scope and precision of the stored raw data depends on the selected 
Sampling Rate or ⇒Step. 

 
For more information, refer to Data  Raw Data Storage and  Raw 
Data Compression.  
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Ready (Signal) 
After each autosampler operation, for example, Draw for the ASI-100 
autosamplers or Suck for the GINA 60/GINA 160 Autosamplers, a ready 
signal command (Sampler.Ready for the ASI-100 Autosamplers or 
Sucked for the GINA 50/GINA 160 Autosamplers) is sent to Chromeleon 
as confirmation. Other commands, such as Dispense, can only be 
executed after receipt of this signal.  

The time interval between the autosampler operation and the response 
Sampler.Ready (or Sucked) is the minimum value for the Duration 
command. 

To execute two commands successively, ⇒Wait is entered after the first 
command in the Program. The next command will then be executed 
immediately after the arrival of the Sampler.Ready (or Sucked) signals. 

Ready Check 
The Ready Check command verifies whether it is actually possible to 
perform automatic batch processing and/or to execute a PGM File. Before 
a batch is started, the Ready Check automatically checks whether: 
• The instruments in the chromatography system are ready to operate, 

i.e., they are turned on and connected, the detector lamp is burning, 
etc. 

• The amount of solvent is sufficient for the batch. 

• All required files exist. 

• The storage capacity is sufficient. 

If you perform the Ready Check by clicking the Ready Check button, 
information is also provided about, e.g., how long the system can run with 
the remaining solvent supply at the specified flow rate after the end of the 
batch. (The Ready Check supports this information only for the Dionex 
P680 pumps.) 

If the Ready Check detects an error (Error or Abort Error), it is not possible 
to start the batch. If the Ready Check reports a warning, the batch can be 
started nevertheless. However, Dionex recommends that you take 
appropriate action to remedy the situation. 
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As the batch list can be extended by further sequences during operation, 
the Ready Check command can also be performed during operation. 

 Tips: 
For program reasons, the system always prompts you before the Ready 
Check to confirm whether you want to accept previously made changes. 
You are even prompted for example, when these changes refer to a 
sequence that is not part of the batch to be started or checked. Decide 
whether to accept or reject the changes. Cancel the batch start or the 
Ready Check if you wish to check the changes first. 

Reconnect 
Use the Reconnect command to check the connection between the user 
PC and the timebase or the instrument and Chromeleon. If there is no 
connection, the ⇒Connect command is performed automatically.  

Recorder Calibration 
The Recorder Calibration command allows calibration of the recorder’s 
response to three detector analog output settings: 
 
AU Sets the analog output to AU, scaled from 0 to 1 V, based on the AU full-scale 

response selected by the Recorder Range command. 
Zero Sets the analog output to 0 volts. 
Full Scale Sets the analog output to the full-scale setting (1V).  

 

Recorder Range 
The Recorder Range command sets the range of a full-scale recorder 
response in the signal units appropriate for the detector. For example, for 
conductivity detectors, the Recorder Range is given in microSiemens (µS). 
This command can be used to adjust the recorder output to accommodate 
larger or smaller peak heights. 

The range to use depends on the detector readings expected for the 
application. For example, selecting a range of 20 microSiemens (µS) will 
allow you to view conductivity readings of 20 µS or less. 
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Reference Bandwidth 
The reference bandwidth can be selected separately for each channel. The 
3D field of a Photodiode Array Detector also has its own reference 
bandwidth. 

Analogous to the conventional ⇒Bandwidth of a channel, the reference 
bandwidth serves to average several photodiode signals of the 
⇒RefWavelength (Reference Wavelength).  

Also, refer to ⇒RefBandwidth (Reference Bandwidth) 

Reference Channel 

= Reference Channel for Baseline Correction 
To perform automatic Baseline Correction of Spectra a reference channel 
is required.  

Any channel, either a physical channel or a channel that was extracted 
from the 3D field and stored afterward can be used. The wavelength of the 
channel is variable; i.e., a channel recorded using Wavelength Switching 
is also valid.  

It depends on how the PPA window has been opened which channel is 
actually used as reference channel in the PPA method: 
• If you open the PPA window from the Browser by selecting the Open ... 

3DFIELD command, the channel specified in the File or context menu 
under Properties is used as reference channel.  

• If you first open the desired sample, and then access the PPA window 
from a different method, the displayed channel is used as reference 
channel. 

To include the current reference channel in the PPA chromatogram 
window, select the Draw Reference Channel check box, which is provided 
on the Chromatogram Plot tab page of the Decoration dialog box. 

The reference channel serves as a basis for integration and peak detection. 
 

 Tip: 

Do not confuse the reference channel with the ⇒RefWavelength 
(Reference Wavelength) of the signals from a photodiode array detector. 
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Reference Peak 
Reference peaks are references for calculating relative retention times for 
different substance peaks. The relative retention time can be indicated as 
absolute time difference (in minutes) or as percent quotient (retention time 
substance peak/retention time reference peak). In addition, the reference 
peaks can be used for calculating the Relative Peak Area and the 

Relative Peak Height. 

You can specify the reference peaks in the QNT File on the Peak Table tab 
page. Double-click the Ret. Time column to open the Retention Time for 
dialog box (see Retention Time Interpretation) or the corresponding 
peaks. Select either Time distance to reference peak or Time ratio to 
reference peak to select a reference peak for each substance peak via 
the selector arrow.  

The retention time is re-calculated automatically when a different reference 
peak is selected. Only peaks with absolute retention times can be selected 
as reference peaks. It is not possible to delete reference peaks from the 
peak table. 

Besides, the retention time can be entered directly in the entry field in the 
following format:  

[<Reference Peak>] <Ret. Time> [<Unit>] 

You are free to choose the order in which the fields are used. If no name is 
entered for the reference peak, the time is interpreted as absolute time, 
otherwise as relative time. 

Either min or % can be selected as unit. If no entry is made, min is used. 
The unit determines whether the time given is the difference (min) or the 
ratio (%) to the time of the reference peak. For absolute times only min is 
permitted. 

 Note: 
Even if the retention time is then specified in Absolute times, Chromeleon 
saves the selected reference peaks. 
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Reference Wavelength 
For Dionex photodiode array detectors, the reference wavelength is used to 
correct absorption values of the wavelength(s) selected for analysis. If the 
absorption of the reference wavelength changes during the analysis, 
absorption values of the analysis wavelengths are adjusted up or down 
accordingly. The selected reference wavelength should be in a quiet area 
of the spectrum where little absorption occurs. Each change in the 
absorption then indicates substantially changed conditions, for example, a 
reduction of the lamp energy (lamp drift). Each change can be used to 
correct the absorption in the remaining wavelength range even during the 
analysis (the recorded signal is reduced or amplified accordingly, as 
necessary).  

Reference wavelengths are especially useful for gradient analyses, 
because as the light intensity changes over time (due to the gradient), 
absorption values are adjusted, thus minimizing baseline drift. 

The reference wavelength is freely selectable, not only for each channel of 
the detector, but also for a 3D field. Because the absorption of the 
reference wavelength is stored, it is possible to undo a correction later. The 
reference wavelength can be changed later by extracting the absorption 
values of the "new" reference wavelength from the 3D field and using them 
for correction.  

Also, refer to ⇒RefWavelength (Reference Wavelength) 

Relative Amount  
This peak result variable refers to the amount portion of a peak relative to 
others. The peaks used as a reference are determined via the following 
options: 
 
Option Description 
All Peaks: Amount portion relative to the sum of all amount 

portions of all peaks (default setting). 
All Peaks of the same Group Amount portion relative to the sum of all amount 

portions in one group. 
The corresponding ISTD Peak Amount portion relative to the amount of the peak of 

the Internal Standard. 
The corresponding Reference Peak Amount portion relative to the amount of a 

Reference Peak.  
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 Note: 
The values of options 2 to 4 can considerably exceed 100 %. 

Select the respective column in the report, select Column Properties on 
the context menu, and select the variable in the selection box. Click 
Parameter to determine the peak to be used as reference. 

Relative Area 
The Relative Area peak variable is the portion of the peak area in the sum 
of all peak areas (total area).  

Which peak areas form the total area, is determined by selecting one of the 
following options (The values of all relative peak areas always result in 
100% for the options 1 to 3.) 
 
Option Description 
All detected Peaks The areas of all detected peaks are used for the 

calculation (default setting). 
All identified Peaks Only the areas of identified peaks are used for the 

calculation. 
All Peaks of the same Group Only the peaks of one group are used for the 

calculation. 
The corresponding ISTD Peak The area of a peak is put in relation to the area of the 

Internal Standard peak 
The corresponding Reference Peak The area of a peak is put in relation to a Reference 

Peak.  
Select a column in the report, select Column Properties on the context 
menu, and select the variable in the selection box. Click Parameter to 
select another option. 

Relative Height 
This peak variable refers to the peak height relative to the average height of 
a certain peak group or a specific peak. As with the Height variable, the 
maximum, that is, at the retention time, is measured, relative to the 
baseline. The dimension does not depend on the detector type.  
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The selection of the peak heights is possible via the following options: 
 
Option Description 
All detected peaks The relative peak height is indicated in relation to the 

average height of all detected peaks (default setting). 
All identified peaks The relative peak height is indicated in relation to the 

average height of all identified peaks. 
All Peaks of the same group The relative peak height is indicated in relation to the 

average height of all peaks in one group. 
The corresponding ISTD peak The relative peak height is indicated in relation to the 

height of the Internal Standard Peak. 
The corresponding reference peak The relative peak height is indicated in relation to the 

height of a selected Reference Peak.  
Select the column in the report, select Column Properties on the context 
menu, and then select the variable in the selection box. Click Parameter to 
select another option.  

Relative Retention Time (Rel. Ret. Time) 
The Relative Retention Time peak variable of the Peak Results category 
is the quotient of the peak ⇒Retention Time and the retention time of the 
corresponding reference peak expressed as a percentage: 
 

Relative retention 
time = ref R,

R

t
t* 100

 

Where:  

Rt  = Retention time (of the current peak) 

refR,t  = Retention time of the corresponding reference 
peak 

 
The Reference Peak is specified in the peak table of the QNT Editor (see 
Data Representation and Reprocessing  The QNT Editor). 
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Clicking the Parameter button opens the Parameter input for 'Relative 
Retention Time' dialog box. Select an option: 

Reference Peak: The relative retention time refers to the reference peak (default) 
Fixed Peak: The relative retention time refers to a user-defined peak. In this case, 

enter the name of the reference peak in the input field. Click the 
arrow, and then select a peak from the list of identified peaks.  

Relative Standard Deviation 
The Relative Standard Deviation is the standard deviation in relation to 
the size of the measured values (average); that is, the standard deviation is 
normalized. In contrast to absolute standard deviations, relative standard 
deviations can be compared (for values around 1000 a standard deviation 
of 1 is minor, for values around 10, this is a major deviation). Usually, the 
relative standard deviation is expressed in percent. 

The relative standard deviation (relStdDev) is calculated as follows from the 
absolute standard deviation (StdDev): 

relStdDev StdDev
Y

=
 

With: Y : Average value of all Y-values. 

Relay 
Relays are closing contacts that can be switched by Chromeleon. Apart 
from the physical ("real") relays on the rear panels of various Dionex 
instruments, there are also virtual relays that can only be used in 
Chromeleon. Virtual relays are primarily used for defined functions, such as 
moving a needle. Virtual relays are available if the corresponding 
instruments or functions are installed. 

Before you can use a "real" instrument relay, you must install the relay in 
the Server Configuration program; that is, the relay must be identified. 
This ID consists of the relay name and the relay number. 

 Note: 
Some device drivers support trigger contacts, which function as two 
dependent relays. When the first relay is switched on, the second is 
switched off and vice versa. 
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Relay-controlled Gradient 
Use the Relay-controlled gradient to control relay-controlled low-pressure 
pumps for which a separate device is not available. This requires the relays 
of a relay card or a UCI Universal Chromatography Interface. 

As usual, the solvent composition is defined as a percentage in the PGM 
File. Each solvent component is controlled by a separate relay. The length 
of time for which the corresponding relay is open determines how the 
solvent is mixed.  

Use the Cycle time parameter on the Solvents tab page in the Server 
Configuration program to specify the cycle duration; that is, the time period 
from when delivery of the first solvent starts until the delivery of the last 
solvent is complete. The shorter the cycle is, the more homogeneous the 
solvent. The longer the cycle is, the more precise the solvent composition. 

Relay On/Off 
The Relay On (Off) command closes (opens) a relay output (contact 
closure relay) for a defined time. Switching valves are also treated as 
contact closure relays. 

The specified relay is opened or closed for a specified time in seconds. 
Relay On opens the relay upon completing a certain period ( Duration), 
Relay Off closes the relay after completing the duration. If no duration is 
specified for Relay On (Off), the relay remains closed (open) until the next 
relay command is given. 

Also, refer to ⇒Relay On/Off 

Remote Inject 
The Remote Inject driver is required for non-controlled chromatography 
systems. Typically, non-controlled systems are GC systems or third-party 
HPLC systems for which a separate driver is not available. 

For controlled chromatography systems, the Autosampler directly 
communicates the time of injection to Chromeleon via an RS-232 cable. 
Since direct communication is not possible for non-controlled systems, the 
Remote Inject driver is used to communicate the time of injection from the 
autosampler to Chromeleon. The autosampler communicates the inject 
signal to Chromeleon via a remote input, i.e., typically via the detector. 
When the signal has been received, for example, data acquisition can be 
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started (⇒AcqOn/Off command). For GC systems, the time of injection is 
communicated in the same way. 

For example, select the following setting if the inject output of the 
autosampler is connected to the input of the UVD: 

 

Remote Input 
Several Dionex instruments and additional cards provide remote inputs that 
enable a reaction to external events, such as an injection. The remote 
inputs are suitable for input voltages between 0V and +5V (TTL level). 

As the remote input level is kept at +5V by internal card resistors (pull-up 
resistance), a simple contact closure relay can be used as an external 
signal source. This contact must be switched between GND and the 
respective remote input. If the contact is closed, the digital voltage is 
grounded. The relay itself is under a low current of approximately 1mA. 
Opening the contact restores the initial state. 

If the signal source itself is active (TTL), the polarization of the remote input 
must be correct. Ground must be connected to ground, and the digital 
output must be connected to the remote input.  
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Installation is for the instrument that supplies the remote inputs. Determine 
clear installation names and numbers for the required remote inputs.  

 Caution: 
Do not supply higher voltages (>5V) to the remote inputs, as this may result 
in a malfunction of the microprocessor system on the A/D card, in the 
destruction of the input modules, or in further damage. 

For an example, refer to Remote Inject. 

Replicate 
In the case of multiple injections from a standard or sample vial, all samples 
following the first injection are called replicates. The name Replicate is 
used independently of the injected volume (see ⇒Inj. Vol. (injection 
volume).) 

Each replicate must be added to the sample list of the sequence as an 
independent sample! Document the injection from a single vial (identical 
sample position) in the ⇒Replicate ID column by entering the same 
number and/or the same text. When a new sequence is generated using 
the Sequence Wizard, the ⇒Pos. (sample position) is automatically entered 
as replicate ID. 

Replicates of a standard sample with the same injection volume will 
produce Calibration Points on the same level. Each alteration of the 
injection volume will generate calibration points of a new level.  

Replot from Beginning 
Enable Replot from beginning to automatically replot when the signal 
leaves the right-hand border of the signal plot. The active chromatogram is 
then replotted from the beginning. One unit scales the time axis to fit the 
chromatogram into the window.  

For example, if the first time axis was 2min, after 2min the window is 
enlarged by 2min to show 4min, after 4min it is enlarged by another 2min to 
show 6min, etc. 

Report Column 
See Sequence Report Column 
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Report Definition File (RDF) 
Report Definition Files (RDFs) have two functions: They display and 
reprocess your results on the screen (Report) and prepare the printout 
(see Printer Layout). 

All settings regarding user-specific representation of chromatographic data 
in different windows are stored in the Report Definition File. Use the report 
template plus the Workspace to arrange the screen according to your 
requirements.  

If no workspace is loaded, each new window is opened based on the most 
recently used report definition file. If you have not yet stored a report 
definition file, the default Chromeleon RDF is used. The default report 
definition file (default.rdf) is located in the Reports directory. 

Each RDF contains specific information about the window sections and 
views, window representations and captions, color and size of individual 
elements, and the presentation of the sample results on-screen and in the 
printout. The information refers to the following questions: 
• Is the window content, e.g., a chromatogram, displayed in zoomed view 

or in full-scale view? 
• Which type of scaling is used for the axes? 
• Which additional objects are displayed, e.g., grid, reference 

chromatogram, units, etc.? 
• Which colors are used for the reference chromatograms, captions, 

etc.?  
• Are other window sections displayed, e.g., a spectra plot, calibration 

curve, report table, etc.? 
• Which worksheets are included in the report? How is the report 

formatted?  
• Which columns does the worksheet include? 

For more information, see Data Representation and Reprocessing 
 Report Tables (Overview). 

Report Publisher 
The Report Publisher is an add-on product to Chromeleon. With its 141 

Additional Functions, it provides considerable enhancements to the report 
templates in the Printer Layout.  
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Select About Chromeleon on the Help menu. The About Chromeleon 
dialog box allows you to check whether this add-on is available on your 
system. 

Report Publisher = On 
This setting indicates that the Report Publisher is available on your system. 
In the Printer Layout, select Layout Mode on the Edit menu to display the 
edit line. Click the desired cell and enter the 'equals' sign ('=') followed by 
the required formula. The Insert/Chart command is available on the 
context menu, also. Select this command to insert a graphical 
representation of specific cell values. 

For more information about the available options, refer to How 
to …:  Preparing the Printout. 

Report Publisher = Off 
This setting indicates that the Report Publisher is not installed on your 
system. Please contact Dionex Service if you are interested in purchasing 
the add-on product. 

Reserved Relay, Remote Input, and Signal Names 
The following names are reserved for special functions: 
 
 Description 
3DFIELD The 3DFIELD signal is composed of the absorbance values recorded at the 

time t at different wavelengths using a photodiode array detector. Each 
absorbance value is entered as a data point in a wavelength by time grid, 
producing a three-dimensional data field. The number of data points is 
determined by the optical resolution and the selected bandwidth (limits) of the 
3D field. 

3D_Amp The 3D_Amp signal is reserved for an electrochemical detector in integrated 
amperometry mode. The signal is composed of the detector response value 
(current) recorded at time (t) in the Waveform period and at time (T) in the 
run (retention time). Each detector current value is entered as a data point in 
a waveform time by retention time grid, producing a three-dimensional data 
field. 

INJECT Refers to the signal that is recognized as the INJECT signal by the system 
and that defines the start of the chromatogram. 
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Resolution 
The Resolution peak result variable is the degree of separation between 
two adjacent peaks. This resolution is a measure of the separating 
capability of the column. It is calculated based on the following formulas 
(EP and USP standards): 
USP standard: 

Rnext

Rnext

BWBW
ttR

+
−

= *2
 

EP standard: 

Rnext

Rnext

WW
tt

R
%,50%,50

*18.1
+
−

=
  

Where:  
Rt  

Retention time of the current peak 

nextt  Retention time of the peak after the current peak 

nextR BWBW ,  
Peak Widths of the two adjacent peaks 

nextR WW %,50%,50 ,
 

Widths of the two adjacent peaks at 50% of the peak height 
 
The distance between the peak maxima is divided by the arithmetic 
average of the peak widths. 

Select the column in the report, select Column Properties on the context 
menu, and select the variable in the selection box. Click Parameter to 
define whether the calculation is based on the EU (EP formula) or the US 
(USP formula) standard. 

 Note:  

EP = European Pharmacopeia  

USP = United States Pharmacopeia 

Response 
Response is the time the detector requires for reaching 98% of the full 
deflection. With a longer time interval, the Signal-to-Noise Ratio 
improves, but the resolution is reduced. 
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Response Factor 
The Response Factor peak table parameter is a peak-specific, 
multiplicative factor without dimension. Its default value is 1.000 and is 
changed for special applications. The response factor is entered in the 
corresponding column of the Amount Table in the QNT Editor (see Data 
Representation and Reprocessing  The QNT Editor).  

Also, refer to ⇒Response Factor 

Restore (File) 
The Restore command allows you to restore files that have previously 
been stored using the Backup command. For more information, refer to 
How to …: Creating and Managing Files and Data  Restoring 
Backup Files. 

To restore data, select Import/Restore on the File menu in the Browser. 

 Tip: 
Archive files have the extension *.cmb. To open, double-click the cmb file in 
the Windows Explorer.  

If you have created a backup file for a sequence that contains one or 
several Sequence Report Columns, this file cannot be restored with 
Chromeleon 6.40 or earlier. 

Retention Index  
The retention index allows you to save uniform scaling of the ⇒Retention 
Time 

Also, refer to ⇒Response Factor 

For information about how to enter the retention index, refer to How to …: 
Integrating Chromatograms and Identifying Peaks  Defining the 
Retention Index and the Kovats Index. 
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Retention Time 
The retention time is used for peak identification. The Retention Time peak 
variable refers to the elapsed time (in minutes) since the injection (also, 
refer to ⇒Dead Time). The retention time of a peak is defined by the time 
of the data point with the highest response value (the peak maximum). 
(This does not have to be the data point with the largest distance to the 
baseline.) 

In Chromeleon, the retention time is especially important at two points:  
• In the QNT Editor (see Data Representation and Reprocessing 

 The QNT Editor) as part of the peak table.  

• In the Report and in the Printer Layout on the Integration, Peak 
Analysis, and Summary sheets. 

QNT Editor 
On the Peak Table page in the QNT Editor, the retention time can be 
entered either manually by the user or automatically by the system.  

Also, refer to ⇒Response Factor 

Report 
In contrast to the QNT Editor, the actually measured retention times of the 
corresponding samples are stated in the report. This is the default setting 
for the Retention Time variable of the Peak Results category. With this 
variable, it is also possible to indicate the actual nominal retention time. 
Then, the settings of ⇒Use Recently Detected Retention Times are taken 
into account.  

However, it is also possible to include the expected retention times (from 
the peak table of the QNT Editor) using the Peak Table category. Select 
the Retention Time variable from the Peak Table report category. It is not 
always the nominal retention time that is displayed. 

Retention Time Correction 
See ⇒Use Recently Detected Retention Time 
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Retention Time Deviation (Ret. Deviation) 
The Retention Time Deviation peak result variable indicates the deviation 
of the actual retention time from the nominal ⇒Retention Time according to 
the peak table (in [minutes]). 
 
Retention time 
deviation =  

 t-t R(Ist) R(Soll)

The retention time deviation can be set via two different methods. The 
setting can be either 
• Absolute, i.e., in minutes, or 

• Relative, i.e., relative to the retention time.  

Select the column in the report, select Column Properties on the context 
menu, and then select the variable in the selection box. Click Parameter to 
determine whether the deviation is expressed as a relative or absolute 
value. 

Retention Time Interpretation 
To determine how the corresponding retention time is interpreted, double-
click the ⇒Retention Time in the peak table of the QNT Editor. (For 
information about the editor, see Data Representation and Reprocessing 

 The QNT Editor). The Retention Time for X dialog box is opened. 
• Select Absolute Times [min] (default) to interpret the retention time as 

usual (time interval between injection and peak maximum). 

Instead of this, relative time intervals to any peak in the peak table 
(reference peak) can be used: 
• Select Time distance to Reference peak [min] to indicate the 

difference to the Reference Peak in minutes. 

• Select Time ratio to Reference peak [%] to indicate the difference to 
the reference peak in % values.  

• The corresponding reference peak is displayed in the Reference peak 
field. Use the arrow to select a different reference peak.  
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The reference peak is displayed in the peak table with a light blue 
background. When the reference peak is in the center of the 
chromatogram, the difference expressed in minutes or percent can assume 
negative or positive values, or values below or above 100%. 

 Tip: 

For difference and relative retention times also, relative (time) ⇒Windows 
are interpreted as percentage values of the absolute retention time! Only 
the retention times of identified peaks are corrected! In the peak table, you 
can choose between the three options, as required. The retention time 
column is re-calculated automatically. 

Retention Time Spectrum 
The retention time of a peak is determined at the peak maximum. The 
spectrum the photodiode array detector records at this time is referred to as 
retention spectrum.  

Retention Time Window 
See Window 

Retention Window Width 
The Retention Window Width peak variable provides the width of the 
⇒Retention Window (in minutes) that was used to detect the peak. This 
variable is also available for not identified peaks. 

RF Value (Amount/Area) 
The ascending slope of the calibration curve, specified as amount/area 
value, is referred to as RF Value. This is the reciprocal value of the Slope 
c1. 

 Note: 
The RF value is sometimes called the Response Factor. Do not confuse 
this term with the Response Factor used in the peak table. 



A-178 Glossary 

Rider Peak 
In a series of non-resolved peaks, all peaks - with the exception of the 
largest peak (reference peak) - are referred to as rider peaks. 
Alternatively, they are called skimming peaks. 

Depending on the position of the rider peak (on the leading or trailing edge 
of the reference peak), a distinction is made between rider up and rider 
down. 

Use the ⇒Rider Threshold and ⇒Maximum Rider Ratio detection 
parameters to determine the peaks that are classified as rider peaks within 
a series of non-resolved peaks. 

A skimming tangent on the chromatogram plot indicates the peaks that are 
classified as rider peaks. In the result report, they are labeled Ru (Rider 
up) or Rd (Rider down).  

Rider peaks can be skimmed in different ways (see ⇒Rider Skimming). 

 Tips: 
You can move the baseline in the chromatogram with the mouse for 
tangentially skimmed riders, but you cannot for exponentially skimmed 
riders. 

Split Peak on the context menu allows splitting one rider peak into two 
peaks.  

Rider peaks are different from Peak Shoulders but the transitions can be 
smooth. Peak shoulders normally do not have a distinct separate relative 
signal maximum of their own. Unlike peak shoulders, Rider Peaks usually 
do have a distinct relative maximum of their own. 

For more information about rider peaks, refer to How to …: Integrating 
Chromatograms and Identifying Peaks/Defining Detection Parameters 

 Defining Rider Peaks. 
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Rider Skimming 
This parameter indicates how Rider Peaks are skimmed. Also, refer to 
⇒Rider Skimming 

For information about how to apply the detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 

Rider Threshold 
The Rider Threshold detection parameter determines whether individual 
peaks in a series of non-resolved peaks are classified as Rider or as 
main peak. Also, refer to ⇒Rider Threshold  

For information about how to apply the detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 

Right Mouse Button 
The most common commands and functions are available on the context 
menu. The choice is context-sensitive, i.e., the commands most likely to be 
used in the current situation are available on the menu. Right-click to open 
the context menu. 

Right Limit 
Normally, peak integration is performed automatically. It is possible to limit 
or extend integration on the left, right or on both sides with the appropriate 
peak table parameters.  

Each (minute) limit is relative to the retention time, that is, the peak is 
integrated between the retention time - left integration limit .... and .... 
retention time + right integration limit. The value 0 deactivates the limit.  

Example:  For the right and left integration limits, the value 0.5min is 
entered. The peak maximum is at the retention time of 8 
minutes. The peak is integrated from 7 minutes 30 
seconds to 8 minutes 30 seconds. 
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Example:  For the left integration limit, the value 0.5min is entered. 
For the right integration limit, the value 0 is entered. As 
before, the peak maximum is at the retention time of 8 
minutes. The peak is integrated from 7 minutes 30 
seconds. The end of the integration is then automatically 
determined.  

Right Width 
If a perpendicular line is dropped to the baseline from the peak maximum, 
the Peak Width is divided in a left and right section. The two sections are 
referred to as left width and right width and can be expressed as 
separate peak result variables. 

Chromeleon also determines the left and right peak width at 5, 10, and 50% 
of the peak height. As described in Peak Width in the Glossary, the 
selected height is very important for the calculation of the peak width. This 
also applies to the calculation of the left and right peak widths. 

The abbreviations for the left and right peak widths are LW and RW.  

Select the column in the report, select Column Properties on the context 
menu, and then select the variable in the selection box. Click Parameter to 
determine at which peak height to determine the peak width.  

Rise Time 
The rise time is a measure of how quickly the detector responds to a 
change in signal. The rise time is defined as the time it takes the output 
signal to rise from 10% of its final value to 90% of its final value. Choosing 
an appropriate rise time value can optimize performance by keeping the 

Signal-to-Noise Ratio at a minimum level.  

A longer rise time allows you to average the noise frequencies. 
Subsequently, the baseline will contain considerably less short-term noise. 
However, longer rise times may have the following effects on peaks: 
• The peak shape will become asymmetric. 

• The peak maximum will be shifted. 

• The peak height will be reduced.  
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 Note: 
The rise time should be approximately 25% of the peak width at half height 
of the narrowest peak of interest. 

For example, for a peak width of 5 seconds, calculate the rise time as: 1/4 
(5 s) = 1.25 s. As it is not possible to set the rise time to 1.25 seconds, 
select the next fastest rise time. In this case, select 1 second.  

 Tip: 
In the AD25 and PDA-100 detectors, the rise time applies to both digital 
and analog output. 

RPC (Remote Procedure Calls) 
RPC technology allows you to run separate processes of a program on 
different computers.Compared to true full-control programs, such as PC-
DUO or PC-ANYWHERE, the amount of transferred data is considerably 
lower. Processes started from a remote computer run almost without any 
time delay. It is not possible for the user to determine whether the process 
is performed on the local PC or on a remote PC. RPC requires a network 
connection between the involved computers. It is not import whether the 
computers are part of the same  Network or whether they are linked via 
a modem connection. Communication also works between different 
networks (Novell, Windows) if the networks use a common protocol for 
communication. Chromeleon generally communicates via the IPX/SPX, 
TCP/IP, or NetBEUI network protocols. The Named Pipes protocol can be 
used as well.  

Sample 
In Chromeleon, a single injection, i.e., the volume that is injected, is 
referred to as sample. Thus, different samples can be injected from the 
same vial. 

 Note:  
In laboratories, the content of a vial is usually referred to as sample.  

The order in which the samples are processed is determined in the sample 
list. The order is also called Sequence.  
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Sample Data 
Data that contributes to characterize a single Sample is stored in a 
database by Chromeleon. This includes not only the entered data (name, 
volume, etc.), but all results calculated from the Raw Data and the 
chromatographic conditions under which the sample was analyzed 
(column, temperature, solvent, instruments, etc.).  

Sample Name 
The Name ⇒Sample Variable serves to identify a Sample and also to 
label graphics and result reports. The user generally enters the sample 
name. 

When you create a sample list using the Sequence Wizard, it is possible to 
generate the sample names automatically. (For more information about the 
wizard, refer to Samples and Sequences  The Sequence Wizard.)  

Also, refer to ⇒Name (sample name) 

Sample-Oriented Operation 
Due to the object-oriented concept, emphasis is on samples and 

Sequences, not on methods or activities.  

The user selects the sample or sequence to process and automatically 
receives the corresponding view; that is, the calibration methods are 
displayed on the calibration plot, integration samples on the integration plot, 
and sequences in the sample editor, etc. For each sample or sequence, 
only the selectable or expected views, methods, or functions are available 
to the user. This saves time and reduces the number of simultaneously 
active windows. 

This context-sensitive procedure is also valid for options selectable on the 
context menu. The selection depends on the position and the time of the 
mouse click. 
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Sample Position 
The Pos. ⇒Sample Variable determines the position of the Sample in the 

Autosampler. 

If you use a controllable autosampler, the entered position is transmitted 
automatically to the autosampler. The autosampler approaches the 
corresponding sample for injection. If using a non-controlled autosampler or 
a hand-operated valve, this column only serves for documentation 
purposes. If the sample position parameter is not entered, the previous 
(current) value is used. 

Also, refer to ⇒Pos. (sample position) and ⇒Position (autosampler 
command). 

Sample Status 
The Status ⇒Sample Variable determines the current sample processing 
status. A Sample is either unprocessed (Single), due for multiple 
processing (Multiple), processed (Finished), Interrupted, currently being 
processed (Running), or being prepared (Preparing).  

Chromeleon also maintains a log of the sample status, that is, a Single 
sample is automatically assigned the status Finished as soon as 
processing is complete. A sample may also be excluded from processing 
by assigning the status Finished. 

The sample status has a special significance for the built-in Power Failure 
Protection. Upon recovery from a power failure or starting the sample batch 
after a manual interruption, Chromeleon begins processing the sample 
batch according to the selected power failure handling option.  

Also, refer to ⇒Status (sample status). 

Sample Type 
The ⇒Sample Variable Type specifies which type of Sample is used. 

Select Unknown if the sample is an unknown analysis sample. This 
sample type is indicated by the symbol: . 

Select Standard if the sample is a standard sample with known 
concentration. This sample type is indicated by the symbol: . 
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Select Validate if the sample is a Validation Sample. This sample type is 
indicated by the symbol: . 

Select Blank if the sample is a Blank Run Sample. This sample type is 
indicated by the symbol: . If a sample is corrected by the Raw Data, for 
example, of a blank run sample, this is referred to as Blank Run 
Subtraction.  

Select Matrix for a Matrix Blank Sample. This sample type is indicated by 
the symbol:  

Select Spiked for a Spiked Sample that shall be used in Standard 
Addition calibration. This sample type is indicated by the symbol: . 

Select Unspiked for an unspiked unknown sample that shall be analyzed 
with the Standard Addition method. This sample type is indicated by the 
symbol: . 

Also, refer to ⇒Type (Sample Type). 

Sample Weight Factor (Weight) 
The ⇒Sample Variable Weight has two functions. It serves to enter the 
sample weight, but it can also be used as a weight correction factor. 

Sample Weight is implemented as a multiplication factor in the Formula 
for Amount Calculation of not explicitly entered amount values (dilution 
series). It is without dimension. 

Also, refer to ⇒Weight (Sample Weight Factor) 

Sampler.Ready 
See Ready 

Sampling Rate 
The number of stored signal values per second is referred to as sampling 
rate (or Data Collection Rate). The maximum of stored values corresponds 
to the number of values generated per second and depends upon the 
device, for example, Dionex UVD 170S/340S Detectors = 100, UCI 
Universal Chromatography Interface = 100, 3D field = 10, Dionex AD25 and 
PDA-100 Detectors = 10.  
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The reciprocal value, that is, the time interval between data points, is 
referred to as ⇒Step (Dionex UV detectors = 0.01, UCI = 0.01, 3D 
field = 0.1, Dionex AD25 and PDA-100 detectors = 0.1). 

 Tip: 
For Dionex detectors that are installed via the DX-LAN, a Data Collection 
Rate command determines the data collection (sampling) rate and the step 
value is automatically set to the reciprocal value of the selected data 
collection rate. For other Dionex devices, only the step value is set and a 
separate Data Collection Rate command is not used. For more information, 
refer to Practical Tips for Device Control  Defining Step and 
Average. 

SDK (Software Development Kit) 
A Software Development Kit (SDK) is provided for Chromeleon. The kit is a 
separate product and not included in the Chromeleon distribution. The SDK 
allows you to use Chromeleon for tasks beyond its standard functionality. In 
addition, it allows programmers to access Chromeleon from their own 
software. The SDK supports almost all Chromeleon functions and some of 
its masks in the individual programs. 

For example, you can use the SDK for the following applications: 
• Open Access solutions that allow even untrained users to create 

Sequences and start Batches. 
• Special applications for which the extensive functions of Chromeleon 

are not sufficient. 
• Connecting Chromeleon to almost all LIMS or Management Software 

solutions.  

You can use the SDK together with all programming languages supporting 
the Microsoft Component Object Model, such as: 
• Visual Basic 
• MS Excel (with VBA Basic) 
• MS Access (with VBA Basic) 
• Visual C++ 
• Delphi 
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In order to successfully use the SDK, the programmer must be familiar with 
the corresponding programming language and functions and with the 
Chromeleon concept.  
If the SDK is too extensive a tool and you do not need all its functions, the 
command line allows you to use simple Chromeleon applications in 
external programs. For more information, refer to How to …: Working with 
Files, Databases, and Networks  Using Chromeleon Data in an 
External Program in the Administrator Help section. 

Security Activation Tool 
See User Manager and Security Activation Tool 

Self-Regenerating Suppressor (SRS) 
See Suppressor  

Sensitivity  
The sensitivity of a measuring method describes the concentration 
dependence of the quantity being measured that results from the method 
itself, that is, from the slope of the calibration line (or more generally: the 
calibration curve).  

Unlike the Limit of Detection, the sensitivity does not depend on the 
instruments used. Distinguish between the sensitivity of the measuring 
method and the sensitivity of the peak recognition algorithm (also, refer to 
⇒Sensitivity). 
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Sensitivity (Detection Parameter) 
The Sensitivity detection parameter determines the signal height from 
which the detected data points are interpreted as peak or as noise. It is 
always interpreted in the installed dimension; for example, in mAU. 

 Note: 

Always consider this parameter in combination with the ⇒Peak Slice 
detection parameter! 

Also, refer to ⇒Sensitivity 

For information about how to apply the detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 

Sensitivity (Signal Parameter) 
The Sensitivity parameter adjusts Chromeleon to the Signal-to-Noise 
Ratio of the detector. The RF 2000 fluorescence detector supports the 
values LOW, MED (default), and HIGH. 

Sequence  
A sequence combines Samples that belong together due to their origin or 
processing. The names of all samples that belong to one sequence are 
entered in the sample list.  

When the chromatography analysis has been started, the samples that 
shall be analyzed are processed from the top to the bottom of the sample 
list. Thus, the sample list also determines the order (= sequence) in which 
the analysis is performed. 

The sample list can contain different columns:  
• Standard columns with different ⇒Sample Variables, e.g. Name, Inj. 

Date/Time or Type, etc.) 
• Sequence Report Columns to display sample results 
• User-defined Columns that allow you to enter special values that are 

then available as additional variables in the report.  
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To create a sequence, use the Sequence Wizard (see Samples and 
Sequences  The Sequence Wizard). For more information, refer to 
How to …: Creating and Managing Files and Data  Creating a 
Sample List (Sequence). 

Also, refer to Samples and Sequences  The Sample List (Sequence) 

Sequence Data 
Data that characterizes a Sequence instead of a single sample (see 

Sample Data) is referred to as sequence data.  

This includes, for example, the date of the last change, the corresponding 
timebase or the name of the user who created the sequence. As the 
sample data, this information is stored in a database. 

Sequence Report Column  
Sequence report columns serve to display sample results in the sample list 
of a Sequence. In the Browser, these report columns already provide an 
overview of the most important sample results. For example, you can 
display the number of peaks detected for each sample and the amount and 
retention time of the main reaction product (Pyrene in the example below): 
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In addition, you can include different statistical values in the sample list and 
thus, display the sum, the average value, and the relative standard 
deviation of the corresponding results in the sequence report columns. 

 Tip:  
Sequence report columns will be lost if you save (Save and Save As 
commands), copy, move, or Backup a sequence with Chromeleon 6.40 or 
earlier. 

For more information, refer to How to …: Creating and Managing Files 
and Data  Creating a Sequence Report Column. 

(Chromatography) Server 
PCs connected to the components of a chromatography system can be 
used as chromatography servers. 

A chromatography server is automatically installed on the PC during the 
Chromeleon installation. The chromatography server controls the data 
exchange between the system and the PC. Upon starting, each server is 
capable of serving up to six controlled systems ( Timebases), which 
together may control a maximum of two Photodiode Array Detectors.  

The server receives the commands that have been entered on the 
Control Panel of a Client PC and executes them at the specified time; 

for example, by communicating them to the corresponding device driver of 
the chromatography system. The server also assumes this buffer function 
in the opposite direction. Thus, the raw data of each system is stored at the 
location specified by the client. In addition, the entire system-relevant data 
is forwarded to the client. 

You can start (load) the server manually or automatically. Select the 
required options in the Server Monitor Program. However, to ensure 
optimum functionality, you must configure the server. You can do this in the 
Chromeleon Server Configuration program on any client PC. (Also, refer 
to Software Installation and Communication  Chromeleon and 
Windows Operating Systems in the Administrator Help section.) 

If the Chromeleon server software and the Chromeleon client software are 
installed on the same PC, it is a local installation. If they are installed on 
different PC's, it is a network installation (see Chromatography 
Components: Hardware and Software  The Network). 
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 Tips: 
In case of manual data acquisition, the Raw Data is always stored in the 
PCNAME_LOCAL server directory (if not otherwise defined). In case of 

Batch processing, each user can decide where the data is stored.  

To minimize the risk of losing data, always store raw data temporarily on 
the server. You may later transfer them to a different computer for archiving 
purposes.  

Chromeleon Xpress does not include data storage. To store data , you 
must have Chromeleon Xpress/Server installed, or the analog output on the 
detector must be connected to a third-party chromatography data system. 

For more information, refer to How to …: Starting and Monitoring the 
Server, Setting up the Server for Network Access  Setting up the 
Chromeleon Server for Network Access in the Administrator Help 
section. 

Server Configuration 
The server configuration provides information about the chromatography 
devices that are installed in the Timebases, about the server that is 
connected to the timebase, and about how the single devices are 
configured. The server configuration is defined in the Server 
Configuration program. (For more information, refer to Software 
Installation and Communication  The Server Configuration Program 
in the Administrator Help section.) 

The entire information is saved in an installation file (*.CFG file). The 
current configuration is always saved in the CMSERVER.CFG file on the 
chromatography server.  

The user can create different installation files in the server configuration 
program, transfer them to any server via the Import function, and use them 
accordingly. 

This configuration can then be saved as the new Cmserver.cfg on this 
server by selecting Save Installation. 

For more information, refer to How to …:  Configuring the 
Chromeleon Server in the Administrator Help section. 
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Server Monitor Program 
The program required for configuring, starting, and monitoring the 

Chromatography Server is called the Server Monitor program. When you 
install Chromeleon, you can include the Server Monitor program in the 
Autostart group of the operating system. 

When the Server Monitor program is started, an additional icon appears on 
the Windows status bar, indicating the server status.  

For more information, refer to Software Installation and Communication 
 The Server Monitor Program in the Administrator Help section. 

Sharable Devices 
Chromeleon records signals from several devices and controls different 
instruments. The signals are sent to the Server PC via PC plug-in cards 
or the UCI Universal Chromatography Interface. To avoid requiring an 
individual card or interface be available for each device from which signals 
are recorded and to which signals are sent, the cards or the interface 
provide several channels. 

The different devices need not be part of the same Timebase. For 
example, to enable signal recording by detectors from different timebases, 
the PC plug-in cards or the interface are not assigned to one specific 
timebase. Instead, the card or interface is shared between multiple 
timebases. Therefore, the PC plug-in cards and the interfaces are called 
Sharable Devices. 

Each slot of a PC plug-in card or interface corresponds to a channel. In the 
Server Configuration program, assign a signal to each used channel: 

Install the corresponding device driver and assign the signals on the 
Signals page. The Remote Inject and the Integrator Driver are available 
for non-controlled systems (usually GC, but also non-controlled 
chromatography systems). The Integrator Driver can also be used to record 
the pump pressure. 

The advantage of this conception is that you do not have to rewrite all 
Programs concerned if you plan to connect a device to a different 

channel. Instead, just change the A/D port assignment in the respective 
driver. 
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 Tip:  
Some chromatography instruments are also "sharable." For example, the 
AS Autosampler can be shared between two timebases, as can the ICS-
3000 Detector/Chromatography (DC). Sharing of these devices is enabled 
in the Server Configuration program. 

Shared Relays and Inputs 
Relays and remote inputs of the PC plug-in cards and the UCI Universal 
Chromatography Interface are installed in the Server Configuration 
program as Sharable Devices. They are independent from the timebase 
because one PC plug-in board or one UCI is possibly shared among 
several timebases. Thus, they can be used and addressed by different 

Timebases.  

To make these relays and remote inputs visible as controls on a Control 
Panel and to allow you to activate a relay, the corresponding relay or the 
used remote input must be installed in the corresponding timebase.  

You have to install a Device Driver as you would for any other device. 
Select Add Device on the Edit or context menu. For relays and remote 
inputs, select General from the Manufacturers list box, and then select 
Shared Relays and Inputs from the Devices list box and click OK. 

After installing the device driver, double-click the driver name to enable 
configuration. Configure the relays and remote inputs on the tab pages that 
appear, i.e., the Relays tab page and the Inputs tab page. 

Each of the two tab pages indicates the current assignment of the relays 
and/or remote inputs that are currently used. If there is no entry on the list, 
either no Sharable Device component has been installed or the relays and 
remote inputs have not been assigned. Click ADD to install a new relay or 
remote input.  

Shoulder 
See Peak Shoulder 
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Signal 
The data transferred directly from an instrument (ideally a detector) to 
Chromeleon, either analog via UCI Universal Chromatography Interface 
or digitally via a USB or LAN connection or via the RS-232 or another 
interface, is referred to as physical signals. If an instrument delivers several 
signals, these are also called channels; for example, two different 
wavelengths of a UV detector. 

Calculated data, such as the arithmetic average of several channels, can 
represent a signal. This type of signal is called Virtual Signal. 

Each signal has its own signal name that is assigned during instrument 
installation. The symbolic name of each signal must be clear. Some special 
signals have pre-defined signal names assigned to them.  

The properties of a signal are determined via separate Signal 
Parameters. They can be modified manually or program-controlled ( PGM 
File) at any time. 

The measuring data of the different physical and virtual signals is stored in 
uniform raw data files.  

Signal Name 
You are free to select any signal name. However, make sure that the name 
is unique. All signals used in a timebase must have different names. 

Virtual Signals also have a signal name. This name is defined by 
Chromeleon. 

 Tip: 
The signal name is also stored within PGM Files, QNT Files, and 
sequences. Do not change the names. Otherwise, you cannot read and/or 
use older data later.  

Signal Noise 
See Noise  



A-194 Glossary 

Signal Parameters 
Each signal delivered by a detector has detector-specific parameters. You 
can modify these signal parameters either on the instrument or in 
Chromeleon, if the system is controlled by the data system. Thus, it is 
possible to change the signal parameters while the chromatogram is 
running, either manually or program-controlled by a PGM File.  

Chromeleon usually supports the following parameters for Dionex 
instruments and third-party devices that are controlled by Chromeleon 
device drivers: 
 
Signal type Parameter Signal type Parameter 
UV channel ⇒Average Fluorescence channel Average 
 ⇒Bandwidth  EmWavelength  

(see  Emission) 
 ⇒RefBandwidth 

(Reference 
Bandwidth) 

 ExWavelength  
(see  Excitation) 

 ⇒RefWavelength 
(Reference 
Wavelength) 

 Gain 

 ⇒Step  Response 
 ⇒Wavelength  Sensitivity  
   Step 
    
3D field ⇒BunchWidth Electrochemical channel Average 
 Min/Max 

Wavelength 
 Data_Collection_Rate 

 RefBandwidth  Step 
 RefWavelength   
 Step Pressure channel Average 
   Step 
MS Channel FilterIndex  

(see  Filter) 
  

 Min/Max Mass 3D_Amp Step 
 Range   
 Reset Virtual channel Average  
 Smoothing (see Virtual Signals) Formula  
 SmoothingPoints  Step 
   Type 

(Also refer to: How to …: Using Mass Spectrometers  Creating an MS Program and 
Sequence)  
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Signal-to-Noise Ratio 
The signal-to-noise ratio serves to characterize electronic components such 
as the UCI Universal Chromatography Interface or a UV or photodiode 
array detector. The lower the Noise is, the smaller the possible signal 
variations that can be recorded. As a general rule, the average of a signal 
should be at least twice (or, if possible, three times) the standard deviation 
of the signal value. 

The signal-to-noise ratio of the Dionex UVD 340U Photodiode Array 
Detector is 1500 mAU / 0.005 mAU (254 nm, 8 nm, 1 s). Measurement of 
this technical specification is within a clearly defined scope. This includes 
the wavelength information (254 nm), the bandwidth, and the ⇒Step. The 
values can be realized only with an empty flow cell and a new lamp that 
has been adequately burned in (approximately 40 h). The maximum signal 
variation (in AU) is measured at maximum light radiation through the flow 
cell. 

If establishing comparable specifications is not relevant, the signal-to-noise 
ratio can be improved by the following operations: 
• Selecting a low Sampling Rate 

• Using photodiode bunching ( Bandwidth) 

• Selecting the Optimum Integration Path 

Signal Value at Peak Start/End  
The Signal Value at Peak Start/End peak result variable indicates the 
signal value at the time of the peak start/end. The left peak delimiter 
defines the peak start. The right peak delimiter defines the peak end. 

Also, refer to How to …: Working with Chromatograms  Moving Peak 
Delimiters. 

Signature 
See Electronic Signature 



A-196 Glossary 

SIM (Selected Ion Monitoring) 
SIM is the Mass Spectrometer method used for recording an MS 
chromatogram at a specific mass. As only single ions are recorded with 
specific masses, the SIM mode is more sensitive than the Full-Scan 
mode. You can use up to 32 channels for data acquisition. These channels 
are called SIM_1 through SIM_32. In addition, one TIC channel is always 
recorded. The TIC channel summarizes the results of the single SIM 
channels. 

With SIM chromatograms, the counts of specific masses (or more precisely, 
those with a particular mass-to-charge ratio) are added up. Thus, contrary 
to TIC chromatograms, SIM chromatograms contain data of a specific 
mass. 

SIM chromatograms are always recorded during data acquisition. This is 
contrary to Mass Traces that are later extracted from Mass Spectra 
(see How to …: Using Mass Spectrometers  Extracting Mass Traces 
Afterward). If you record data in full-scan mode, you can later extract the 
desired SIM channel(s) as mass trace(s).  

 Tip:  
The device methods of the aQa mass spectrometer (1.2) and the MSQ 
(1.3) are different. Therefore, please note the following difference: During 
data acquisition with the aQa mass spectrometer, data with the same mass 
range, polarity, and ionization voltage are always recorded in one channel. 
The Surveyor MSQ records them in different channels if the scan events 
are different for this data, i.e., if they are defined with different retention 
times. For example (same mass range, polarity, and ionization voltage): 
 
Retention Time aQa Channel MSQ Channel 
0-2 min SIM_01 SIM_01 
3-5 min SIM_01 SIM_02  
Also, refer to How to …: Installing and Configuring Mass 
Spectrometers  Defining the Number of MS Channels in the 
Administrator Help section. 
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Single-Point and Multiple-Point Calibration 
If the position of the calibration curve is determined only by the 

Calibration Points of one Calibration Level, this is called single-point 
calibration. In this case, the ⇒Calibration Type linear must be chosen.  

If calibration points on different levels determine the position of the 
calibration curve, this is referred to as multiple-point calibration; for 
example, two-point, three-point, etc. calibration. The number of calibration 
levels determines possible calibration types. 

In both cases, the number of replicates is irrelevant for the number of 
calibration levels. Replicates only serve to statistically secure the 
measuring results. 

Skewness 
As is the Asymmetry peak result variable, the Skewness peak result 
variable, too, is a measure for the column quality.  

The definition of the two variables is similar, too. The Skewness peak 
result variable is frequently mentioned in chromatography literature. 
 
Skewness Calculation  

S 
%10

%10%10

*2 LW
LWRW

S
+

=
 

100 %

10 %W10 %

RWLW  
Where:   

%10LW  Left peak width in 10% of the peak 
height. 

 

%10RW  Right peak width in 10% of the peak 
height. 

 
 
Also, refer to Asymmetry. 



A-198 Glossary 

Slope c1 
The Slope c1 calibration variable indicates the c1-value of the currently 
used Calibration Function. 

SmartStart 
Before you can start analyzing your samples, you have to equilibrate the 
chromatography system. The SmartStart Wizard supports the following 
features: 
• The entire system, especially the column, is washed with the starting 

solvent until the system is free of any other liquid composition. 

• The column thermostat and the thermostatted autosampler (if installed) 
are warmed or cooled to the starting temperature. 

• In addition, Chromeleon checks the signal stability to avoid increased 
Drift or Signal Noise. 

The SmartStart Wizard assists you in defining the equilibration conditions. 
(For more information about the wizard, refer to Control  The 
SmartStart Wizard.) For an overview of how to equilibrate the HPLC 
system with Chromeleon, refer to How to …:  Equilibrating the 
Chromatography System. 

Smoothing  
Data smoothing serves to reduce signal noise and help improve 
chromatogram appearance and reproducibility of peak baselines applying 
different digital filters without altering the raw data. Chromeleon provides 
the following filter types on the context menu of the Chromatogram window: 

Moving Average (Boxcar) 
The Moving Average (or Boxcar) filter equally weights each point. Thus, 
its ability to discriminate between noise and signal is limited (also, refer to 

Signal-to-Noise Ratio). 
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Olympic  
Compared to the Moving Average filter, the Olympic filter provides better 
rejection of impulse noise (spikes). 

Savitzky-Golay  
Savitzky-Golay smoothing is useful for reducing high-frequency noise of a 
data set that is continuous (such as a chromatogram) without significantly 
degrading the underlying signal. 

For more information, refer to How to …: Working with Chromatograms 
 Performing Data Smoothing 

In addition, Chromeleon allows you to smooth MS chromatograms during 
acquisition or mass trace extraction by applying the Gaussian or Boxcar 
(= Moving Average, refer to above) filter. The Xcalibur software provides 
both filters. 

Gaussian  
The Gaussian filter applies the Gaussian distribution for chromatogram 
smoothing. 

For more information, see How to …: Using Mass Spectrometers 
 Extracting a Mass Trace. 

For more information about the different filter types and their parameters, 
refer to Integration   Data Smoothing.  

Snap to Grid 
Snap to Grid allows you to reduce, enlarge, or move the control frame.  
• Select Preferences on the File menu. 

• On the Grid tab page, to determine the mesh size of the grid.  
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SOR File (Signed Off Results) 
SOR files (Signed Off Results) are electronically signed sequences (see: 

Electronic Signature). They are indicated as follows:  

 

SOR files merely contain the tabs with the corresponding data for the 
sequence that have been selected in the respective Report Definition File 
(RDF). The data cannot be changed unless the signature is undone. 
However, to do so, the user must have the corresponding Privilege: 
UndoSubmit/Review/ApproveResults. He(she) has to re-enter his(her) 
User ID and the respective signature Password if this has been defined 
accordingly in the User Manager (CmUser program) via the File menu > 
Database Properties > Electronic Signature tab page. 

Sound 
The Sound command allows you to play WAV files. The PC must be fitted 
with a sound card to support this command. WAV files are part of the 
Windows installation and contain various acoustic signals. Numerous 
example files are supplied, for example, in the WINNT/MEDIA directory (full 
Windows installation).  

The Chromeleon command syntax for playing a WAV file is:  
 
0.000 Sound File= "Example.wav" 
 
If the command cannot be performed due to a missing sound card, a 
default sound is generated at the PC speaker. 

Also, refer to ⇒Sound 

Spectra Library 
UV spectra libraries serve for identifying unknown substances. UV spectra 
can be saved in spectra libraries and later compared to the spectrum of the 
unknown substance. Make sure that the different spectra are recorded 
using the same solvent. 

Apart from absorption values, each spectrum in a library contains various 
ID data fields that are freely editable by the user and that facilitate spectra 
searches. The following fields are available: 
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Column Description 
Name This column shows the name under which the substance is included 

in the spectra library. Select a column entry to assign a new name 
to the corresponding substance.  

  
ID This column shows the short ID that is assigned to the spectrum. 

Use this column to save several spectra under the same substance 
name in a spectra library. The Ids, such as consecutive numbers, 
then distinguish the spectra ID.  

  
#Extrema This column shows the number of extreme values in the spectrum 

determined by the system. Select a column entry to change the 
number. 

  
Solvents: This column shows the solvent in which the spectrum was recorded. 

Select a column entry to edit.  
  
Comment: Use this column to document details on the saved spectrum. 
  
WL-Range: This column indicates the wavelength range of the recorded 

spectrum.  
  
WL-Resolution: This column shows the ⇒Bandwidth with which the spectrum was 

recorded.  
  
Ret.Time: This column indicates the retention time at which the spectrum was 

extracted from a peak.  
  
Ret. Index If available, the column indicates the Retention Index of the 

substance. 
  
Kovats Index If available, the column indicates the Kovats Index of the 

substance. 
  
Acq.Step: This column indicates the Step with which the underlying 3D Field 

was recorded. 
  
Detector: This column indicates the detector with which the spectrum was 

recorded. The name is taken from the Server Configuration. 
  
Detector Serial No.: This column indicates the serial number of the detector from the 

Server Configuration. 
  
Timebase: This column indicates the name of the timebase with which the 

spectrum was recorded.  
  
Sequence: This column indicates the name and the patch of the sequence from 

which the extracted spectrum is taken. 
  
Sample Name: This column shows the name of the sample from which the 

extracted spectrum is taken. 
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Column Description 
Acq. Date/Time: This column shows the date and time at which the spectrum or the 

underlying 3D field was originally acquired. 
  
Program: This column shows the name of the PGM File that was used to 

generate the underlying chromatogram.  
  
Extract Date/Time: This column shows the data and time at which the spectrum was 

extracted and saved.  
  
Extract Operator: This column shows the name of the user who extracted the 

spectrum and saved it to the spectra library. 

Spiked Sample 
The sample matrix can considerably influence sample analysis, particularly 
in certain ion and gas chromatography applications. To account for this, a 
known amount of one or more substances is added to unknown samples. In 
this way, the concentration of these substances is increased by an exact 
known value. After spiking, the original (unknown) and the spiked sample 
are analyzed using the Standard Addition calibration mode. The unknown 
and the spiked samples must be separated and analyzed with the same 
chromatographic method. 

Spiked samples in Chromeleon have the ⇒Type (Sample Type) Spiked, 
indicated by the symbol . 

Unspiked samples have the type Unspiked, indicated by the symbol . 

When analyzing several unknown samples, assign the unknown samples to 
the associated spiked samples in the ⇒Std. Add. Group column. In this 
column, the samples are assigned to a common standard addition group. 

Dionex recommends always spiking unknown samples with the same 
amount of the same substances. In the ⇒Ref. Amount Set column, you can 
then assign the spiked samples to the same amount values in the Amount 
Table of the QNT Editor. 

For more information, refer to How to …: Calibrating  Standard 
Addition. 
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SQL (Structured Query Language) 
SQL is a computer language developed especially for queries in databases. 
Chromeleon uses an adapted SQL for Queries in the Browser (queries for 
specific samples/sequences), as well as for "Database Queries" in the 
report and in the Printer Layout.  

Standard 
The Standard column input in the peak table defines the reference peak to 
be used for calibration. The term Standard can also be used for a 
calibration sample or a standard sample. Calibration can be performed 
using an external and/or internal standard. Also, refer to ⇒Standard 

Standard Addition 
Standard Addition is used as a calibration method, mainly in ion and gas 
chromatography. Standard Addition considers matrix effects during the 
analysis. Before the analysis, a known amount of one or more substances 
is added to a known volume of an unknown sample. In this way, the 
concentrations of these substances are increased by values that are 
exactly known. Afterward, the original and the spiked sample are analyzed. 
For more reliable results, you can spike the unknown sample several times 
or with various known quantities. For analysis, the area is plotted against 
the concentration. (In gas chromatography, the area is plotted against the 
amount.) 
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The unknown concentration (amount) of the originally unspiked sample 
(sample type = Unspiked) is set to zero, i.e., the y-axis is exactly on the 
concentration of the unspiked sample For evaluation purposes, the 
calibration line (calibration curve) is shifted parallel by setting the offset to 
zero. The concentration of the unspiked sample is determined as shown in 
the picture. 

 Caution:  
Only if the calibration curve is forced through the origin (i.e., in this case, 
through the calibration point of the original, unspiked sample), the amount 
of this sample corresponds to the negative intercept on the x-axis, i.e., to 
the average of all values based on this sample. For all other calibration 
types, the calculated amount of the original, unspiked sample may deviate 
from the negative intercept on the x-axis of the calibration curve.  

The picture below illustrates this for the case in which the measured value 
of the original sample (evaluation: solid line) above the curve, i.e., the 
corresponding amount, is larger than the negative intercept on the x-axis 
(broken line): 

  
For more information, refer to How to …: Calibrating  Standard 
Addition. 
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Standard Datasource  
The standard Datasource is activated when the chromatography Server 
is booted. The datasource is used for:  

1. Saving the daily Audit Trail 

2. Saving manual Sequences  

3. Saving OQ and  PQ templates (This is the default setting, but you 
may as well define a different datasource for saving the templates.) 

4. Reading User-defined Columns during the program run. 

During initial installation of Chromeleon, a local standard datasource is 
created on each client PC. In network operation, the datasource name is 
composed of the computer name and the suffix local (<PC Name_local>). 
For a local station, i.e., for a station that is not part of a  Network, the 
computer name entered in the operating system under Start > Settings > 
Control Panel > System Network Identification is used. If no 
identification is entered, the datasource is named Default_local. 
In the Server Configuration program, you may select a different 
datasource as standard datasource (see How to …: Configuring the 
Chromeleon Server  Adding, Configuring, or Deleting Components 
in the Administrator Help section).  

To save chromatography data on the network, you can select a network 
datasource as standard datasource. The Administrator Help section 
provides more information; refer to How to …: Working with Files, 
Databases, and Networks: 

 Saving Chromatography Data on the Network  

 Defining a Network Datasource as Standard Datasource 

 Tips:  

To save the daily audit trails on a central PC, define different paths for 
different servers: 

Network Datasource:Daily Protocol\Server1 

Network Datasource:Daily Protocol\Server2 
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Standard Deviation 
The standard deviation is a measure for the deviation of single values from 
a mean value. The standard deviation of a random sample is defined as: 
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Where: 
 

SD  = Standard deviation 

n  = Number of elements for which the standard deviation is calculated. 

ix  = Elements for which the standard deviation is calculated. 
 
The square standard deviation is referred to as Variance. 

Status Bar 
In the status bar on the lower window margin, messages regarding the 
current system status are shown on the left, while the current timebase and 
the currently executed command are shown on the right.  

The display of the status bar can be enabled and disabled on the View 
menu.  

Step 
The time interval between two successively recorded data points is referred 
to as the step; the sum of all recorded data points is called raw data. The 
reciprocal value of the step value is the Sampling Rate (if the data is 
supplied by an A/D converter) or, by default, the Data Collection Rate (if 
the data is supplied by a detector).  

Also, refer to ⇒Step and  Data Collection Rate. 
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Step Gradient 
Immediate changes of the solvent composition (for %-Gradients) or the 
flow (for Flow Gradients) are referred to as step gradients. Contrary to 
this continual changes of the solvent composition or flow are referred to as 

Ramp (or more precisely as ramp gradient). In case of step gradients, the 
elution conditions change rapidly. The realization of the gradient on the 
column depends among others on the size of the dead volume between the 
pump and the column end.  

To realize a step gradient, enter two percentage values (also, refer to 
⇒%B, %C, %D)) or two flow values for the same time: 
• Enter the current value (to specify that the composition or the flow of 

the solvent mixture does not change until this time).  

• Enter the new value to which to set the solvent (or the flow) 
immediately: 

 

Stop Flow 
Use the Stop Flow command to turn off the pump flow and to interrupt data 
acquisition. A running batch is stopped, as in the hold mode.  

Also, refer to ⇒StopFlow 
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Suck 
See Draw 

Sucked 
See Ready 

Summit® HPLC System 
The Dionex HPLC product line is called Summit HPLC System. The system 
comprises the following devices:  
 
Device Name Description 
Pump P680 

P580 
HPLC gradient pumps 

Autosampler ASI-100  Temperature control option for sample thermostatting 
available (ASI-100T) 

Column 
Thermostats 

TCC-100 
STH-585 

Temperature range: 5-85°C (41°-185°F) 

Detectors UVD 170 UV-VIS 
UVD 340 PDA 
PDA-100 
RF2000 
(Shodex RI-101) 
(aQa MS,  
MSQ) 

UV Detector  
Photodiode Array Detector 

Photodiode array detector 
Fluorescence detector 
(Refractive index detector) 
( Mass Spectrometers) 

 

 Tip:  
For automatic sample preparation, 2D chromatography, and/or optimization 
of the sample throughput, the Summit x2 Dual-Gradient HPLC System is 
available from Dionex. 

Also, refer to Chromatography Components: Hardware and Software 
 Chromatography Instruments. 
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Summit® x2 Dual-Gradient HPLC System 
The Summit x2 Dual-Gradient HPLC System provides highest flexibility for 
standard HPLC and LC/MS methods and for advanced chromatographic 
techniques requiring two pumps. The system is suitable for both standard 
HPLC applications and advanced chromatographic techniques, such as 

Tandem Operation, online sample preparation, and 2D chromatography. 

Running the Summit x2 Dual-Gradient HPLC System in tandem operation 
mode allows increasing the productivity, typically by 50-100%, without the 
need to modify existing chromatographic methods. 

In addition, the Summit x2 system supports online sample preparation, e.g., 
for analyte enrichment or sample matrix elimination, and 2D 
chromatography for optimizing the chromatographic separation. 

The Summit x2 Dual-Gradient HPLC System comprises the following 
modules: 
• P680 DGP dual-gradient HPLC pump with two ternary gradient pumps 

in one enclosure 

• SOR-100 solvent rack with integrated degasser for degassing all 
channels of the dual pump 

• ASI-100 autosampler for overlapping injections 

• TCC-100 thermostatted column compartment with column switching 
valve 

• All detectors of the Summit HPLC System series, including the MSQ 
Mass Spectrometer 

 
Also, refer to Chromatography Components: Hardware and Software 

 Chromatography Instruments. 

Suppressor 
A suppressor is a device used in ion chromatography to reduce the 
background signal from the eluent while increasing the analyte response 
when using a conductivity detector. Ion chromatography requires eluents 
that contain electrolytes, which can interfere with the detection of the ionic 
analytes of interest. The suppressor uses a combination of ion exchange 
and chemical or electrolytic regeneration to neutralize or suppress the 
electrolytes in the eluent. The analyte, on the other hand, generally is 
converted to a more conductive acid or base form.  
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Dionex offers suppressor products based on several patented suppression 
technologies. These products include the Atlas Electrolytic Suppressor, the 
Self-Regenerating Suppressor, and the MicroMembrane Suppressor. For 
more information, refer to the appropriate product manual.  

For more information, refer to Practical Tips for Device Control: 

  Controlling a Suppressor 

 Setting Atlas Suppressor Currents 

 Setting SRS Suppressor Currents 

 Setting SRS-MPIC Suppressor Currents 

 Controlling an MMS Suppressor 

Syringe Type 
The volume that can be injected with an autosampler depends on the 
installed syringe type. Many autosamplers support several syringe types 
and thus allow using a different type with a larger or smaller volume. In 
addition to the default types 25, 50, 100, 250, 500, 1000, and 4000 µl, 
using special syringes is possible. If the syringe type is changed, the new 
type must be specified in the Chromeleon Server Configuration program. 
In addition, when installing a new autosampler, the currently used syringe 
type must be defined by configuring the corresponding device driver. 

 Tip: 
For the autosampler Dionex GINA 50, syringe types with the volumes 250 
µl and 1000 µl are supported. If using different syringe types, the 
reproducibility stated in the instrument’s specification cannot be 
guaranteed. 
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System Suitability Test (SST) 
As defined in cooperation with EURACHEM, System Suitability Checking 
(SSC) or System Suitability Test (SST) is "a series of tests to check the 
performance of a measuring process " [P. Bedson and M. Sargent, Accred. 
Qual. Assur. (1996) 1, 265-274]. Aim and objective of System Suitability 
Testing is to ensure the performance of the operating system and the 
system. 

SST or SSC can be applied to single measuring processes and thus may 
be part of the validation process. The System Suitability Test establishes 
for example that the operational conditions required for a specific 
measurement process are being achieved.  

 Tip: 
If you want to perform a System Suitability Test, make sure to enter the 
QNT File into the sample list before starting the analysis. Otherwise, the 
batch cannot be aborted in case of Fail Action - Abort Batch because the 
SST will not yet be performed during the batch run! 

In addition to the System Suitability Test, Operational Qualification, and 
Performance Qualification are also important for validating instruments 

and software (see Validation, AutoQ, and System Wellness 
 Validation and Qualification). 

For more information about how to perform a system suitability test in 
Chromeleon, refer to How to …: Performing Validation and Qualification 

 Defining System Suitability Tests. 

System Wellness 
System Wellness monitors the overall "health" of a chromatographic 
system. The different devices and Chromeleon provide several diagnostic 
and calibration features that help prevent unscheduled system shutdowns 
and assure reliable operation of system devices. System Wellness features 
are available for devices in the Summit HPLC product line and for several 
IC devices. 

Calibration and diagnostic commands for IC devices are available from 
Chromeleon Wellness control panels and Help topics provide instructions 
for performing the various tasks. 
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The devices in the Summit HPLC product line have been calibrated at the 
factory, e.g., the pump flow or calibration is performed automatically, e.g., 
for the UV detector via a Holmium Oxide Filter. Thus, the user does not 
need to calibrate these devices. 

For more information about System Wellness, refer to Validation, AutoQ, 
and System Wellness: 

 System Wellness for IC Devices (Overview) 

 System Wellness for HPLC Devices (Overview) 
For more information about how to perform System Wellness procedures 
for IC devices, refer to How to …: Performing Validation and 
Qualification  Ensuring System Wellness. 

Tailing/Fronting Sensitivity Factor 
This detection parameter is an implicit threshold for setting the peak end. 
The Fronting sensitivity factor refers to the peak start, respectively. 

Also, refer to ⇒Tailing/Fronting Sensitivity Factor 

For information about how to apply the detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 

Tandem Operation 
Short analysis times in the laboratory save valuable time. Running the 
Dionex Summit x2 Dual-Gradient HPLC System, which comprises a dual-
gradient pump, two columns, and a column-switching valve, in tandem 
operation mode allows increasing the sample throughput considerably, 
typically by 50 to 100 %.  

When the different analytes of a sample have been separated, it is often 
necessary to wash and reequilibrate the column for the next run. During 
this time, the autosampler, detector, and fraction collector (if installed) are 
running idle. Analyzing the next sample during the wash and reequilibration 
steps can considerably enhance the productivity of these devices. 
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The example illustrates that phases 2 and 3 could be performed for one 
sample. In parallel, phase 1 could be performed for the next sample, on the 
second pump and second column. This requires the following system 
configuration: 
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In position A, the chromatographic separation is performed on column 1. 
During this time, the wash and reequilibration steps are performed for 
column 2. When the valve is in position B, the separation is performed on 
column 2 while the washing and reequilibration steps are performed for 
column 1.  

Using this configuration, you can considerably shorten the analysis time for 
the above example when you 
• Stop the active gradient after 25 minutes. 

• Set the solvent back to the starting composition (%B = 11%). 

• Wash the remaining eluent out of the capillaries between the pump and 
the column switching valve, using this composition for 1 minute. 

• After this minute, switch the valve to direct the flow to the second 
column and inject the next sample. 

 

This considerably reduces the run cycle time and increases the system 
throughput, typically by 50 to 100%. 

For more information, refer to How to …: Creating and Modifying 
Programs  Defining Tandem Gradients (Summit x2). 
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Temperature Compensation Factor 
A temperature coefficient used in conductivity detection to stabilize 
conductivity readings. The temperature compensation factor corrects for 
changes in ambient temperatures that occur during a run and normalizes 
conductivity measurements to 25°C.  

If the cell is installed in a DS3 Detection Stabilizer or a chromatography 
oven, the default factor of 1.7% is appropriate. When operating without a 
DS3 or oven, the compensation factor can be optimized to help minimize 
the baseline drift caused by fluctuations in ambient temperature. See the 
detector operator’s manual for more information. 

Template 
Templates facilitate data input. Therefore, Chromeleon provides various 
pre-defined templates, such as report templates (DEFAULT.RDF and 
DEFLTDAD.RDF). 

Theoretical Plates 
The Theoretical Plates peak result variable is a measure for the 
separating capability of the column. Theoretical plates are calculated from 
the peak width and the corresponding retention time.  

As with asymmetry, there are different USP and EP standards: 
 
Name Calculation Comment 
Theoretical Plates 2
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Where:  
TP = Number of theoretical plates 

Rt  
= Retention time  

%50W
 

= Peak width at 50% height (half-width) 

BW  = Peak Width on the base line.  
TP does not have a dimension. If they are placed in relation to the currently 
used column (L), the result is the theoretical plate height (H): 

TP
LH =

 
However, the reciprocal value says more about the quality of the currently 
used column. It gives the number of theoretical plates per column meter. 

L
TP

H
=

1
 

Select the report column, select Column Properties on the context menu, 
and then select the variable in the selection box. Click Parameter to 
determine whether the calculation is based on the EU, US, or JP standard.  

 Note:  
EP = European Pharmacopeia; USP = United States Pharmacopeia 

TIC (Total Ion Current) 
TIC chromatograms summarize all counts at the corresponding retention 
time. Unlike SIM chromatograms, TIC chromatograms include the data of 
the entire mass range. 

The TIC channel is always recorded; it is independent of the mode used in 
the MS method (Full-Scan or SIM). In Full-Scan mode, up to four 
additional TICF_n channels can be recorded for the aQa MS (nine TICF_n 
channels for the MSQ). The data acquisition conditions (for example, the 
acceleration voltage in the Mass Spectrometer) may vary. The channels 
are called TICF_1 through TICF_4 for the aQa mass spectrometer and 
TICF_1 through TICF_9 for the MSQ spectrometer. The TIC channel 
summarizes the results of these single channels. One TIC channel is also 
recorded in SIM mode. In this case, it corresponds to the sum of the results 
of the single SIM channels. 
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From the Mass Spectrum, you can extract separate Mass Traces (or 
mass ranges) and save them as new channels (see How to …: Using 
Mass Spectrometers  Extracting a Mass Trace). In this way, you can 
limit the size of the mass range of TIC channels according to your 
requirements. 

Also, refer to How to …: Installing and Configuring Mass 
Spectrometers  Defining the Number of MS Channels in the 
Administrator Help section. 

 Note:  
TIC chromatograms represent the totals of intensity from the spectra 
headers. These headers are created at run time during data acquisition. 
Thus, the chromatograms that are later extracted using the entire mass 
range show a slightly different intensity profile. 

Time 
Chromeleon stores the time stamps as universal time (Greenwich time). 
However, the date notation is displayed according to the local settings 
chosen in the operating system (also, refer to ⇒Inj. Date/Time (Time of 
Injection)). 

Timebase 
All components combined in a chromatography system to enable the 
chromatographic separation and related in a time context with each other 
are assigned to the same timebase.  

A timebase can be a very complex system. It can consist, for example, of 
two pumps, one Autosampler, one column oven, two detectors that are 
switched in series, and one Fraction Collector). However, an isolated 
integrator or a gas chromatograph can also represent a timebase.  

Any other system that is completely independent from the first one 
represents a new timebase. Administration of different timebases is on one 
or several (Chromatography) Servers. Each server can serve up to six 
timebases. A timebase can have only one Photodiode Array Detector 
installed. A maximum of two photodiode array detectors are permitted per 
server. Specify the name of a timebase and the assignment of the devices 
in the Server Configuration program. 
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Toolbars 
Frequently used commands and features are available as icons; related 
functions are combined on toolbars directly below the menu bar. When 
starting Chromeleon, the standard toolbar is displayed. Select Toolbars on 
the View menu to enable or disable the display of individual toolbars. The 
following toolbars are available:  
• Standard (standard functions)  

 
• Online (commands for the Control Panels and PGM-Files) 

 
• Layout (commands that can be used in Layout Mode are available on 

the Layout Toolbar) 

 
• Method (for changing to other method sections, samples, or channels)  

 
• Integration (commands for chromatogram processing)  

 
• Status Bar (enables/disables the Status Bar) 

Point to an icon to display its name in the quick info box. 

Transaction Agent 
The Transaction Agent serves to protect the Chromeleon datasource files 
against access from the outside. Under no circumstances should you edit, 
rename, or move Chromeleon data in the Windows Explorer! To avoid 
unintentional operations on these files, use the Transaction Agent to 
protect the Chromeleon datasource structure against these operations in 
the Windows Explorer. Please note that the Transaction Agent is only 
available on computers running under Windows 2000 or Windows XP. 

A Chromeleon datasource consists of a database part and a file part. When 
the Transaction Agent is enabled, the standard user cannot access the file 
part. This is to avoid unauthorized access to the Chromeleon file part in the 
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Windows Explorer or via the command prompt of the operating system. The 
user of the Chromeleon client can nevertheless access this part via a virtual 
user (TargetUser). 

First, set up the Transaction Agent in the User Manager, and then enable 
this function in the Security Activation Tool (CmSecure program). For 
more information, refer to Chromeleon User Management  Setting up 
the Transaction Agent in the Administrator Help section. 

Transmission 
Transmission is 100%, when light passes through the UV detector flow cell 
without restraint. Transmission decreases with increasing absorption. For 
the UVD 340S detector, the maximum transmission value is determined via 
zero order at a reference wavelength of 630nm.  

 Tip: 
The substance mixture passing through the flow cell must not absorb in the 
reference wavelength range. If this is the case, either change the reference 
wavelength or select transmission without reference. 

Trend Plot 
Chromeleon's trending feature provides a way for specific data to be 
graphically displayed from sample to sample. In many cases, you can more 
quickly view progressive changes, compare runs, or identify items of 
interest by looking at a graphical representation of different samples, rather 
than by examining specific quantitative values of these samples in a report. 

For example, if you view graphically the background signal in a conductivity 
detector for a series of runs and the trend shows a progressive increase 
over time, it might suggest a problem with an instrument. Or, if the same 
internal standard for the same column is used for a series of experiments, 
you can view a graphic trend of the theoretical plate calculations. A general 
decrease in the plate values might suggest column degradation.  

In addition to depicting data graphically through a trend, Chromeleon can 
quickly calculate and display statistical parameters (mean, target, 1s 
standard deviation, 2s standard deviation, 3s standard deviation). When a 
trend is shown with the target and standard deviations, it enables you to 
view the data within a broader context.  
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Note that Chromeleon can depict the statistical parameters relative to ALL 
the samples selected, to only the samples in a particular view, or to user-
entered target values. Moreover, the trend plot can be included in both 

Control Panels and reports. 

On the screen report, select Show Trend from the View menu to display 
the trend plot. For information about how to add a trend plot to a control 
panel, refer to How to …:  Modifying a Control Panel. For information 
about how to add a trend plot to a report template (printer layout), see How 
to …:  Inserting a Trend or 3D Amperometry Plot. 
There are two types of trend variables: module-specific variables, such as 
pump pressure and background signal, and result variables, including 
retention time, area, peak height, etc. Depending on the data selected for 
trending, you can elect to show trends in real time, as an injection occurs, 
or post-run, after the run has been collected and processed. Here is an 
example of a trend plot: 

 

Trigger Commands 
A trigger refers to the automatic execution of a command as soon as a 
condition becomes true. The Trigger command can be included in a 

Program or a programmable button, but not in the online control. The 
following syntax is valid: 
 
Time Trigger TRIGGERNAME Condition,True,Delay,Limit,Hysteresis 
 Reaction 1  
 Reaction 2  
 Reaction ...  
Time EndTrigger  

 
Also, refer to ⇒Trigger Commands 
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TTL 
TTL (Transistor-Transistor Logic) inputs and outputs are electronic 
switching devices for controlling instruments. 

TTL Input Mode 
The TTL inputs respond to four types of device output signals. The default 
TTL signal mode, normal edge, is compatible with the output signals 
provided by Dionex modules. If the controlling device outputs a different 
signal type, select a different signal mode  

The four input signal modes are: 

Normal Edge: In normal edge operation, the negative (trailing) edge of a 
signal turns on the function and the positive (leading) edge turns off the 
function. 

Inverted Edge: The inverted edge mode works identically to the normal 
edge mode, except that the positive and negative edges are reversed in 
function. 

Normal Pulse: In normal pulse operation, the negative (trailing) edge of the 
TTL signal is the active edge and the positive (leading) edge is ignored. 

The minimum pulse width guaranteed to be detected is 50 ms. The 
maximum pulse width guaranteed to be ignored as noise or invalid is 4 ms. 
The action is undefined for pulses less than 50 ms or greater than 4 ms. 

Inverted Pulse: The inverted pulse mode operates identically to the normal 
pulse mode, except that the positive and negative edges are reversed in 
function. 

EDGE

PULSE

+5V

+5V

Off

Off

Off

Off

Normal Polarity (negative) Inverted Polarity (positive)

Inverted (positive-going)Normal (negative-going)

On

On

On

On

Default

Off

Off

Off

Off
0V

0V
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Type (Peak Type) 
The Type peak result variable classifies a peak as a main peak (M=Main) 
or a Rider (R=Rider). This variable also indicates the type of baseline 
contact (B=Baseline) and whether the peak data has been manually 
modified (*=modified).  

Also, refer to ⇒Type (Peak Type) 

UCI Universal Chromatography Interface 
The UCI Universal Chromatography Interface serves as a data acquisition 
and device control module. It provides several different interfaces and 
makes them available to the chromatography server: 
• Eight analog inputs (UCI-100) or two analog inputs (UCI-50) 

• Four serial RS-232 ports 

• Eight remote inputs 

• Eight remote outputs  

• One BCD input 

For communication between the different devices and the server's 
chromatography data system, either a USB or an Ethernet connection can 
be used. 

 Tips: 
Use the RS-232 interfaces (COM ports) via USB only (no TCP/IP)! If LAN 
connections are required, additional interface cards must be used for 
instrument control via RS-232. Dionex recommends using an instrument 
LAN for analog data acquisition (= installation of a second network interface 
card (= NIC; in the operating system, the card is often referred to as 
adapter) in the server PC). (Also, refer to Hardware Installation 

 Connecting Dionex Devices via TCP/IP in the Administrator Help 
section.) 
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Always connect instruments requiring a GSIOC cable, such as GILSON 
devices and VARIAN pumps, to the multi-serial 8-fold PCI interface card 
(Equinox 8-RS-232 Multi-COM card, Dionex part no. 5906.2095). (For more 
information about these devices, refer to Hardware Installation 

 GILSON and the  VARIAN in the Administrator Help section.) 
Otherwise, communication problems might occur with other RS-232 ports; 
for example, with the COM ports of the PC or the Dionex Universal 
Chromatography Interface (UCI). The power supply of the GSIOC adapter 
(type 605) is directly via the RS-232 interface. The RS-232 ports of the UCI 
Universal Chromatography Interface, however, are not designed for this. 

Also, refer to Software Installation and Communication  The Dionex 
Universal Chromatography Interface (UCI) in the Administrator Help 
section. 

UI20 Universal Interface 
The UI20 Universal Interface functions as a communications and control 
link between the PC and instruments that are not directly connected to the 

DX-LAN. This enables Chromeleon to collect data from any 
chromatographic detector with an analog output. The UI20 collects up to 
two analog detector voltage signals and converts them to digital data with 
20-bit resolution.  

UltiMate 3000 Micro/Capillary/Nano HPLC System 
The Dionex product line for micro, capillary, and nano HPLC applications is 
called UltiMate 3000 HPLC System. The system comprises the following 
devices:  
 
Device Name Description 
Pump LPG-3x00 Dual low-pressure gradient pump 
Autosampler WPS-3000  Well-plate micro autosampler,  

Temperature control option available  
(WPS-3000T) 

Flow Manager and Thermostatted 
Column Compartment 

FLM-3x00 Temperature range: 4-45°C  

Detector UVD-3000 UV Detector   
Also, refer to Chromatography Components: Hardware and Software 

 Chromatography Instruments. 
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Unspiked 
Refer to Spiked Sample 

Unzoom 
The Unzoom command undoes the last zoom operation.  

To unzoom on the signal plot, double-click inside the Overview Window. 

Use Recently Detected Retention Time 
This QNT Editor parameter (General sheet) defines whether the retention 
time stored in the peak table (nominal time) is used by default to identify a 
peak or whether the actual retention time of a peak in the last sample is 
used. (For information about the editor, see Data Representation and 
Reprocessing  The QNT Editor.) 
 
The parameter serves to compensate many types of drift appearances; for 
example, evaporation of volatile components in pre-mixed solvents or 
column aging. 

Also, refer to ⇒Use Recently Detected Retention Time. 

User Database 
The user database defines the user rights (= Privileges) and the 
membership of the individual users in Access Groups. The user database 
is created in the User Manager program and activated in the Security 
Activation Tool (CmSecure program). If the database is activated, User 
Mode is enabled. 

 Tip: 
Although the two terms are similar, do not confuse a user database with a 
Chromeleon Datasource (database). Although both may be, for example, 
Access databases (= mdb container), they are two completely different 
databases. 
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User-defined Columns (UDC) 
Various tables with different meanings appear throughout Chromeleon. For 
example: 
• The different tables in the Report and in the Printer Layout 

• The sample list in the Browser (For more information, refer to Data 
Management  The Browser.) 

• The peak table in the QNT Editor (see Data Representation and 
Reprocessing  The QNT Editor). 

While the appearance of the sample list and the peak table is mainly 
default, you can define the Report and the Printer Layout according to your 
own requirements. You can also define your own columns in all tables 
mentioned above. 

In the Report and the Printer Layout, use the Report Publisher to create 
new columns and thus, to display special aspects of your data. For more 
information, refer to How to …: Creating and Using Report Tables 

 Entering User-defined Formulas. 

In the sample list and in the peak table, user-defined columns  
• Allow input of user-specific data, which can then be used as additional 

variables for report generation. In addition, they allow data to be 
imported via SDK (Software Development Kit) or Worklist (WLE 
file). 

• Provide additional key words for a Query.  

• Allow you to define the fraction collection period in the PGM Wizard. 
(This is only possible if the Fraction Collection driver has been installed 
in the Server Configuration Program. This only refers to user-defined 
columns in the peak table.) 

On the Samples page of the Query Wizard, select the user-defined 
columns for the Sample field type. Click the arrow next to the Data Field 
input box to display the selection list. An asterisk ('*') in front of the column 
name marks the user-defined columns created in the sample list of the 
Browser.  

For the Results field type, it is not possible to directly access the user-
defined columns by clicking the '...' button. Thus, to use a user-defined 
column that has been created in the peak table of the QNT Editor, type the 
formula directly in the Formula field.  
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The syntax is as follows: 
  peak_tab.user_x 

where x is the name of the user-defined column. 

For more information, refer to How to …: Creating and Managing Files 
and Data  Creating User-defined Columns. 

 Tips: 
Be careful when creating user-defined columns in the sample list of the 
Browser. For columns having identical names in different Datasources or 
on different computers that may communicate with each other, make sure 
that the column definition is identical, too. If the column definitions are 
different, problems may occur when you copy sequences or Restore 
backup files. To make sure that the columns are identical in both 
datasources, select Import Columns (select the datasource, click 
Properties on the context menu and then click the User-defined Columns 
tab). This command imports all existing user-defined columns from another 
datasource to the current datasource. 

To use the new and/or changed columns in the PGM File, shut down and 
restart the Server after you have entered or changed the columns in the 
sample list. Only then can the server access the user-defined columns. 

However, access is restricted to the user-defined columns of the 
Standard Datasource. It is not possible to access user-defined columns 

for which the Value type is Time or Date and time. 

For more information about user-defined columns, refer to How to …: 
Creating and Modifying Programs  Using User-defined Columns in 
a Program. 

User Management: User Manager and Security 
Activation Tool  
Chromeleon provides two different administrator programs for user 
management: Use the User Manager (CmUser program) to create the 

User Database and to manage the users. Use the Security Activation 
Tool (CmSecure program) to enable or disable User Mode. The setup for 
both programs is located in the CmUser directory on the Chromeleon 
software CD. Please note that the programs are not automatically copied to 
the Chromeleon program directory (e.g., c:\chromel\bin). 
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The User Manager is password-protected. Only the system administrator or 
somebody with similar authority can open the program.  

 Tip: 
Dionex recommends installing the Chromeleon User Management 
applications (CmUser directory) to a suitable network location, CD-ROM, or 
USB stick to allow modifications via the network. Make sure that only 
Chromeleon administrators with administrator privileges for the CmUser 
database can access this network location. The Administrator Help section 
also contains a section describing all steps and options for user 
management (refer to  Chromeleon User Management). 

The User Manager, which is intended for User, Privilege, and Access 
Group management, allows you to perform the following actions:  
• Create and edit Access Groups 

• Create and edit Privileges (Privilege Groups or P Groups) 

• Create and edit users in Chromeleon. The system administrator can 
define the user’s name and job title, the Logon and signature 

Passwords, and the behavior if the logon failed. 

Use the Security Activation Tool (CmSecure program) to enable and 
disable User Mode on the Chromeleon client. Besides, you can use the 
CmSecure program to select the user database. The user database 
contains the status and the rights of each user. When User Mode is 
enabled, the user has to enter a password to start Chromeleon. It is only 
possible to sign sequences electronically when the User Mode is enabled 
(see Electronic Signature). 

 Caution: 
In the User Manager, select User Database Properties on the File menu 
to enable Compatibility Mode. This mode allows Clients of previous 
Chromeleon versions (Chromeleon 6.01 or earlier) to log on to the system. 

User Mode 
The Security Activation Tool (CmSecure program) allows you to enable 
and disable User Mode (= Access Control). When the User Mode is 
enabled, Chromeleon provides numerous options to limit user access to 

Servers, Timebases, Clients, and Datasources.  
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System access is password-protected. Access is only granted to users who 
are identified by the system after password input.  

Each user identified by the system is granted personal privileges. The 
system administrator assigns these privileges. Via the Access Group and 

Privilege group membership of a user, the administrator defines the 
operations the user can perform within the system. 

If access control is disabled, each user receives all rights. Datasources or 
directories that have access groups assigned cannot be accessed when 
the User Mode is disabled. With enabled User Mode, the user can access 
an object if he/she is a member of a group granting access to the 
respective object. If no access group is assigned to an object, each user 
can access the object independently of his/her access group membership. 

If the User Mode is enabled, the user can access any object that is part of 
the respective access group. The sum of all privileges granted to the user 
(depending on his Privilege Group membership) determines what the user 
is allowed to do with the object. Signing sequences electronically (see 

Electronic Signature) is possible with enabled User Mode only. 

For more information, refer to Software Installation and Communication 
 Access Control in the Administrator Help section. 

UV Cutover 
The UV Cutover command for the AD20 Absorbance Detector sets the 
wavelength above which the second order filter is inserted in the light path. 
Typically, the UV cutover wavelength is 380nm. 

UV Detector 
UV detectors (strictly speaking, UV/VIS detectors) quantify absorption of 
UV/VIS-active substances in the range from 190 to 380nm (UV range) and 
380 to 900nm (VIS range). UV detectors provide high sensitivity and a large 
linearity range. UV detectors are relatively independent from temperature 
fluctuations; they can be used for gradient elution (%-gradient). 
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Functionality 
A grating (b) disperses the light that is emitted from a light source (a) in a 
discontinued spectrum. Simultaneously, the grating serves as a filter and 
directs only the wavelengths required for detection to a beam splitter (s). A 
portion of the beam is directed through the flow cell (d) onto a photodiode 
(e), the other part is used as a reference (f). 

a

b

d e

f

s

 
  

Theory 

Depending on the absorptivity (ε) of the substance, the light beam is more 
or less attenuated when traversing the flow cell. For the absorption (E), the 
following is true: 

E = ε c d 

As the length of the cell (d) is constant and the absorptivity (ε) depends 
only on the substance itself or the absorbed wavelength, there is a direct 
connection between the substance concentration (c) and the absorption 
(E). The absorption measured in AU ("absorbance unit") is thus 
proportional to the number of particles in the beam path ("Lambert-Beer 
absorption law"). 
 

Wavelength Calibration 

The wavelength is calibrated automatically after each ⇒Lamp = On or 
⇒Connect command (detector calibration). The CheckWavelength 
command checks the currently valid wavelength calibration. The maximum 
deviation of this calibration compared to the instrument status is given in 
the Audit Trail. 

Calibration is possible only when certain conditions are met: 

1. During calibration, the baseline must be sufficiently stable. This may 
not be the case, for example, if the solvent composition has been 
modified or if there are gas bubbles in the solvent. 
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2. The solvent in the cell must not be fully absorbing in the wavelength 
range that will be calibrated. This will be the case, for example, if the 
cell is filled with 96% hexane / 4 % ethyl acetate. 

3. Before calibration, make sure that the deuterium lamp is already warm 
because its spectrum changes a lot during the first minutes after 
turning on the lamp. 

If these conditions are not met, the process will be interrupted with the 
corresponding error message. When the problem is solved, repeat the 
calibration by selecting Disconnect and Connect. 
 

Detector Calibration 
The detector is calibrated via a holmium oxide filter that is installed in the 
beam path of the deuterium lamp. The maxima are determined from the 
resulting transmission spectrum and compared to the holmium oxide values 
stated in the literature. If a difference is detected for this maximum between 
the measured and the known value, this maximum and the two adjacent 
maxima are interpolated to correct the wavelength allocation of the affected 
photodiodes. Wavelength calibration can take up to two minutes. During 
this time, data acquisition will not be possible. 
 
Also, see Photodiode Array Detector. 

UV Lamp  
This command turns the UV lamp on Dionex absorbance and PDA 
detectors on and off. For the AD20 Absorbance Detector (see UV 
Detector), the command options are Low, High, and Off. 

 Tips: 
If you switch the AD20 lamp from Off to Low or High, there is a 22-second 
pause while the UV lamp warms up. During this time, the status of the lamp 
on the Control Panel remains at Off. Once the warm-up period is 
complete, the status changes to the selected setting (Low or High). The 
Audit Trail window logs the UV_Lamp command and the warm-up time. 

Detector lamps require a considerable warm-up time for high-sensitivity and 
drift-free operation. Therefore, after turning on the lamp, wait at least 10 
minutes before you perform the ⇒Inject command. Also, avoid turning off 
the lamp(s) during a sample batch. 



 Glossary A-231 

Validation 
The process of ensuring that a system or analysis procedure supplies 
reproducible and reliable results is referred to as validation. For the user, 
this includes above all procedures regarding the planning, implementation, 
and documentation of an analytical method. Thus, validation is an integral 
part of GLP ("Good Laboratory Practice").  

The manufacturer of the instrument or data system performs validation. The 
user then performs several qualification steps (see Qualification) to check 
the functionality of the instruments and Chromeleon. 

For more information, refer to Validation, AutoQ, and System, Wellness 
 Validation and Qualification. 

Validation Sample 
Samples of known concentration that serve to verify a calibration are 
referred to as validation samples. In the sample list, they are labeled with 
the sample ⇒Type Validate and have the following symbol: . 

Verification is by regular insertion of the validation samples in the normal 
analysis. The resulting (actual) area values are converted into amounts via 
the Calibration Function and parameters and are then compared with the 
expected (nominal) values in the ⇒Amount table. The result of the 
nominal/actual comparison can be displayed as direct amount (Amount 
Deviation result variable) or as deviation in percent (Rel. Amount 
Deviation). 

Checking can also be performed visually if you display the validation 
samples (marked by colors) in the calibration curve. They will not be 
considered for calibration, though. 

Validation samples can also be injected from vials that are normally used 
for injection of standard (calibration) samples. Validation samples are not 
relevant for the calculation of the calibration function! 

For more information about validation samples, refer to How to …: 
Integrating Chromatograms and Identifying Peaks: 

 Entering the Concentration/Amount of the Validation Sample 

 Validating the Calibration Curve 
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Valley to Valley 
If the Valley to Valley detection parameter is enabled, the baseline is 
drawn from peak minimum to peak minimum (i.e., from peak end to peak 
end), below non-resolved peaks.  

Also, refer to ⇒Valley to Valley 

For information about how to apply detection parameters, refer to How 
to …: Integrating Chromatograms and Identifying Peaks  Modifying 
Detection Parameters. 

Variance 
The Variance calibration variable is the average deviation of all area values 
F from the corresponding ideal area value in a calibration. The ideal area 
value is the value at the point of intersection between the calculated 
calibration curve and the corresponding amount value.  

Amount

Area

0
c0

F(ideal)
F4

A4

F3

A3

F2

A2

F1

A1

Calibration curve

Variance

 

Variance is therefore a criterion for the measuring accuracy in the 
calibration. With an increasing value, calibration points are increasingly 
scattered. The mathematical description of the variance is as follows: 
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N: Number of standard samples involved in the calibration, 
m: Number of coefficients to determine (depending on the ⇒Calibration Type: LIN: m = 1; 

LOFF: m = 2; QUAD: m = 2; QUOFF: m = 3 and EXP: m = 2), 
i: Index for standard samples, 
F(x): Model function of the calibration, 
Xi: X-value of the standard sample no. i,  
Yi: Y-value of the standard sample no. i,  
Wi: Weight factor of the standard sample no. i, and 
∆ i: Yi - F(Xi) 
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Extracting the square root of the variance value results in the Standard 
Deviation calibration variable; that is, the square standard deviation is the 
variance. 

Variance Coefficient 
The Variance Coefficient calibration variable can be considered a type of 
normalized Variance value. It is more meaningful when comparing 
variances of different peaks with different concentrations. A variance 
coefficient near zero means that the calibration curve well approximates the 
calibration points. 

Thus, the variance coefficient indicates how well the data points correspond 
to the theoretically assumed course of the curve. Similar to the Coefficient 
of Determination and in contrast to the Correlation Coefficient it depends 
on the calibration type. The mathematical description of the variance 
coefficient is as follows: 
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N: Number of standard samples involved in the calibration, 
i: Index for standard samples, 
F(x): Model function of the calibration, 
Xi: X-value of the standard sample no. i,  
Yi: Y-value of the standard sample no. i,  
Wi: Weight factor of the standard sample no. i. 

Virtual Channel Driver (VCD) 
The Virtual Channel Driver is used to record, display, save, and export the 
system status (for example, the relay status, gradients, or pump pressure) 
or Virtual Signals (for example, UV_VIS_1/UV_VIS_2) as signals. The 
virtual channel driver allows you to calculate any arithmetic expression 
during data acquisition, and then display the result as a signal channel and 
save it. (For more information about the virtual channel driver, refer to 
Chromatography Components: Hardware and Software  Virtual 
Channel Driver.) Any combination of numeric expressions can be used as 
terms in the formula that is used for calculating the virtual signal. 
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For information about how to install the Virtual Channel Driver, refer to 
Hardware Installation  Installing the Virtual Channel Driver (VCD) in 
the Administrator Help section. 

A special program is required to record virtual channels. It is not possible to 
create these channels manually. For information about how to enter the 
corresponding commands into the program, refer to Practical Tips for 
Device Control  Virtual Channel Commands and  Program 
Examples for Virtual Channels. 

Virtual Column 
Virtual Column is a simulation tool that uses known ion chromatographic 
retention data to predict new retention data and chromatograms. The 
known retention data was acquired by Dionex using an appropriate 
experimental design and then embedded into Virtual Column.  

 Note: 
Results obtained with Virtual Column are intended to represent typical 
results for a particular column type. Because no two columns or systems 
are identical, the results you obtain in an actual analysis may differ 
somewhat from the Virtual Column predictions. 

To use Virtual Column, you first select the application parameters (analytes 
of interest, methodology, column, etc.) to be simulated. Virtual Column then 
uses the embedded data in retention models and resolution algorithms to 
determine the retention data, resolution response, and Virtual 
Chromatogram for the selected parameters.  

Virtual Column helps you to answer the following questions: 
• What is the best column to use for a particular analysis? 

• What eluent should I use for optimum separation of analytes? 

• What eluent should I use for the fastest separation of analytes? 

• How will changing the temperature of an analysis affect the separation? 

Evaluation Mode 
Virtual Column is an optional Chromeleon component. There are two 
license options: Isocratic and Linear Gradient. The Isocratic license enables 
modeling of isocratic separations only; the Linear Gradient license enables 
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modeling of isocratic and linear gradient separations. (The Linear Gradient 
license is sold only in a Virtual Column Complete package that also 
includes the Isocratic license.) 

If you have not purchased a Virtual Column license, you can use Virtual 
Column in Evaluation Mode. Most functions are available in Evaluation 
Mode, with the following exceptions: 

• In Evaluation Mode, the selection options for analytes are limited to the 
following predefined lists of analytes: 

Anions:   
Bromide, Chloride, Fluoride, Nitrate, Nitrite, Phosphate, and Sulfate 

Cations:   
Ammonium, Calcium, Lithium, Magnesium, Potassium, Sodium 

Carbohydrates:  
Fucose, Galactosamine, Galactose, Glucosamine, Glucose, Mannose  

• In Evaluation Mode, the Save, Open, and Reset All commands are not 
available. 

For details about how to use Virtual Column, refer to How to …: 
 Simulating Chromatograms. 

Virtual Signals 
Signals that are composed of or calculated from several readings at the 
time t are referred to as virtual signals; for example, the arithmetic average 
of several channels. Virtual signals often include Reserved Signal 
Names, such as, 3DFIELD. Virtual signals can be generated with the 

Virtual Channel Driver. They cannot be acquired manually; data 
acquisition is possible only in the context of a sample program.  

For information about how to enter commands, refer to Practical Tips for 
Device Control  Virtual Channel Commands. 
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Visible Lamp 
This command switches the visible lamp of Dionex absorbance (see: UV 
Detectors) and Photodiode Array Detectors on and off. For the AD20 
Absorbance Detector, the command options are Low, High, and Off. 

 Tip: 
Detector lamps require a considerable warm-up time for high-sensitivity and 
drift-free operation. Therefore, after turning on the lamp wait at least 10 
minutes before performing the ⇒Inject command. Also, avoid turning off 
the lamp(s) during a sample batch. 

Void Time 
See Dead Time 

Void Volume 
See Dead Volume 

Voltammogram 
A plot of current measured vs. voltage applied during a voltammetric run. 
Also, refer to Cyclic Voltammetry 

Volume 
See Injection Volume 

Wait 
The Wait command interrupts program execution until the specified remote 
input signal arrives. During this time, program time and data acquisition are 
stopped. Controlled pumps are kept in the Hold mode. For examples for 
using the Wait command, refer to Practical Tips for Device Control: 

 Autosampler Control and  Special Commands, Relay Control, 
and Miscellaneous. Also, refer to ⇒Wait 
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Wash 
The Wash command causes the autosampler to lower the needle into the 
needle seat and to rinse the sample loop and needle with solvent in the 
Inject state. This corresponds to the normal solvent flow following an 
⇒Inject command. 

 Tip: 

Use the Wash and ⇒NeedleUp commands to wash the sample loop and 
thus prevent crystallization of substances in the sample loop. 

Also, refer to ⇒Wash 

Waveform 
A series of steps, defined as points on a plot of potential vs. time. The 
waveform is repeated continually throughout the run. A waveform must be 
defined when using the Dionex electrochemical detector in Integrated 
Amperometry Mode.  

The waveform period is the elapsed time from the first step in the waveform 
to the last. 

In the example waveform below, the potentials are labeled E1, E2, and E3 
and are applied for durations t1, t2, and t3, respectively. The signal is 
measured at E1 by integrating the current for a fixed time (ts). 
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Wavelength 
UV Detectors and Photodiode Array Detectors are the most commonly 

used detector types in HPLC. Simple UV detectors record chromatograms 
at a defined wavelength (λ) while PDA detectors record them in a defined 
wavelength range. The wavelength and the wavelength range, respectively, 
depend on the detector and can vary between 190 to 900 nm.  

This value indicates the wavelength at which a chromatogram is measured. 

On Dionex photodiode array detectors, the wavelength is not set directly on 
the instrument, but via the PC. You can enter the wavelength also manually 
during the analysis or in the PGM File. 

For the UV-VIS, 3DFIELD, and SPECTRA signals, wavelength means the 
central wavelength, that is, the wavelength around which a field with a 
symmetrical ⇒Bandwidth forms. 

Also, refer to ⇒Wavelength 

Wavelength Calibration 
Dionex UV detectors, which are fitted with a Holmium-Oxide Filter, 
perform a wavelength calibration after each Lamp = on command (see 
⇒Lamp) or ⇒Connect command.  

Dionex AD25 and PDA-100 detectors perform a wavelength calibration at 
power-up. New wavelengths are assigned to each pixel, based on the 
emission spectrum from the deuterium lamp. 

With defined absorption maxima, wavelength calibration ensures that the 
data delivered by the detector corresponds to the expected wavelength 
values.  

Wavelength Switching 
Usually, samples contain different substances with different UV spectra and 
different absorption maxima. Wavelength switching allows the detection of 
the single peaks at their optimum wavelength. Wavelength switching 
changes the wavelength of the respective measurement when the solvent 
composition changes, resulting in a composite chromatogram of the largest 
absorbance for each substance. The switching should occur so long before 
the retention time of the respective peak that the entire peak is detected at 
one wavelength. 
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Wavelength switching also allows the simultaneous analysis of substances 
with strongly differing absorption maxima, and little or no absorption at the 
wavelength of the other maximum.  

Wavelength switching is program-controlled; that is, the switch time at 
which the wavelength of a specific channel is changed is entered in a 
control Program. The switch time and wavelength can be generated 
automatically by extracting the Optimum Integration Path from an opened 

3D Field (Extract: Opt.Int.Path to Clipboard). 

 Tip: 
Wavelength switching is also possible with fluorescence detectors. Usually, 
the excitation wavelength should be changed at exactly the same time as 
the detection wavelength. 

For information about how to perform wavelength switching, refer to 
Practical Tips for Device Control  Determining Wavelength 
Switching. 

Weight 
Also, see Sample Weight Factor (Weight) and ⇒Weight (Sample Weight 
Factor). 

Weights 
The Weights calibration variable indicates the weighting (see How to …: 
Calibrating  Weighting and Averaging Calibration Points in the 
Creating a Peak Table section) assigned to the individual Calibration 
Points when creating the calibration curve. 

Define the weighting in the ⇒Calibration Type column of the QNT Editor. 
(For information about the editor, see Data Representation and 
Reprocessing  The QNT Editor.)  
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The following options are available: 
No weight Default: Higher weighting of higher amounts and/or signal values. 
  
1/Amount (X) Nearly cancels out the weighting of higher amounts/signal values. 
  
1/Amount² (XX) Causes over-proportional weighting of smaller amounts. 
  
1/Response (Y) Nearly cancels out the weighting of higher signal values. In this case, the 

Y-values (dependent signal values) of the Calibration Points are used 
as weight factors instead of the X-values (nominal amounts). 

  
1/Response² (YY) Causes over-proportional weighting of smaller signal values. In this case, 

the Y-values (dependent signal values) of the calibration points are used 
as weight factors instead of the X-values (nominal amounts).  

If you select Average all response values of each calibration level 
before Curve Fitting (A) two more options are available: 
 
1/Rel.Std.Dev (S) Each average value is reciprocally weighted with the related relative 

(and squared) standard deviation. This means that calibration levels 
with increased scattering are weighted less than calibration levels with 
less scattering. 

  
1/Rel.Std.Dev.² (SS) Causes over-proportional weighting of calibration levels with less 

scattering. 

Width 
This peak result variable refers to the peak width extrapolated on the 
baseline. Peak tangents are drawn from the turning points of the leading 
and trailing edges. Then the points of intersection with the baseline are 
calculated. The time distance between the two points of intersection is 
defined as the base width. If the base width is used for calculating other 
parameters, the abbreviation is BW. 

Width

100 %

50 %

10 %
5 %W5 %

W10 %

W50 %

BW

Height
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Chromeleon also determines the peak width at 5, 10, and 50% of the peak 
height (abbreviations: W5%, W10% and W50%).  

 Tip: 
In contrast to the base width BW, the peak widths at 5, 10, and 50% of the 
peak height (W5%, W10%, and W50%) are not only measured up to the 
point of intersection with the two tangents, but up to the signal curve! 

Determining the peak width is only possible if the peak is resolved at least 
to half the height. 

How to display the peak width in the report  
• Select the column in the report 

• Select Column Properties on the context menu. 

• Select the Width variable in the selection box.  

• Click Parameter to determine the peak height at which to determine 
the peak width. 

Window 
The Window peak table parameter defines the tolerance interval, within 
which the peak is expected. Adding and subtracting the window value to 
the retention time (retention time +/- window value), determines the window 
size; that is, the window always has twice the width of your input. In 
addition, the value can be interpreted as absolute or relative value. 

Also, refer to ⇒Window 

Wizard 
Various input procedures such as creating a Sequence, or a Program or 
defining Query conditions are facilitated by using wizards. The system 
prompts the user to define conditions and to enter the required information. 
The wizard then adds default elements and thus completes a basic 
structure. If required, the user can extend or modify this structure according 
to individual requirements. 

Use the wizards to avoid unnecessary typing, syntax errors in command 
entries and overlooking important information and parameters.  
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Worklist 
The format for reading data (sequences) of a LIMS Chromeleon is 
referred to as Worklist (WLE file). The worklist describes the contents and 
the structure of a sequence (also, refer to Worklist Format). 

Select New on the File menu, and then select the Sequence (From LIMS 
Worklist) command to import an existing worklist.  

If importing is possible, the imported sequence is listed in the Browser. To 
prevent importing the existing worklist again, it can be deleted automatically 
by setting DeleteWorklist to Yes in the [options] section.  

If an error occurs during the import, Chromeleon reports an error describing 
the error and the error location in the worklist. The error message is also 
saved in a log file. This log file carries the worklist name and the extension 
log. The incorrect worklist file can be automatically renamed to *.err by 
setting Rename On Error to Yes in the [options] section. 

For more information, refer to Worklist Format. 

Worklist Format 
Worklists have the file extension .wle (Work List Export). The structure and 
the syntax of the Worklists are similar to the Windows INI files. There are 
various sections. Each section starts with a new line. The name of the 
section is written in brackets. There are one or several entries below the 
section name, with the syntax name = value. Comments start with a 
semicolon and finish at the end of the line. 

 Tip:  
If information, such as the injection volume, is missing in the worklist, you 
can enter it in Chromeleon as usual after the worklist has been imported. 
However, please note that the QNT and PGM Files must already be 
specified in the worklist. 



 Glossary A-243 

Example of a valid worklist (+ comments - delete the comments to use the 
worklist in Chromeleon): 
 
; Worklist generated by MegaLIMS 3.11.5622.00a 
; Wed 05/27/98, 16:25:02 
 
[options] 
Application = Chromeleon 
Delete Worklist = No 
Rename On Error = No 
 
[file names] 
; datasource, path, and name for the generated sequence  
Sequence = \labor2_local\sys58\sequences\lims4711 
; default for the program column 
pgm = pgmWash 
pgm = Stop 
; default for the QNT Method column. 
qnt = qnt0815 
qnt = noint 
; copy PGM Files from here (datasource, and path) 
pgm templates = \server1\templates\hplc 
 
; copy Quantification Methods (QNT Methods) as stated here (datasource, path, and name) 
 
[qnt files] 
qnt0815 = \server1\templates\hplc\pah\qnt0815 
noint = \server1\templates\common\noint 
 
[defaults] 
; default for injection volume 
Injection Volume = 10.0 
 
[1] 
Name=Wash 
Type=Blank Run 
Pos=1 
; use the "Wash" program instead of the default ("pgm0815") 
PGM=Wash 
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QNT=qnt0815 
; default for the user-defined column Water Contents - the marking asterisk * is omitted with 

User-defined Columns 
Water contents = 72.3 
 
[2] 
Name=Std 
Type=Standard 
Pos=99 
 
[3] 
Name=Sample1 
Pos=2 
 
[4] 
Name=Sample2 
Pos=3 
 
[5] 
Name=Sample3 
Pos=4 
 
[6] 
Name=Sample4 
Pos=5 
 
[7] 
Name=Stop 
Type=Blank Run 
Pos=1 
PGM=Stop 
QNT=Nnoint 
  
With this worklist (without the comments), a sequence named lims4711 is 
created in the datasource labor2_local in the sys58\sequences directory. 
The sequence contains a rinse sample, a standard, four unknown samples, 
and a stop program. 

All control programs are copied from the subdirectory \templates\hplc of 
the datasource Server1 (central file server). The source must contain the 
pgm0815, wash, and stop programs. 
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The evaluation method for the rinse and stop samples is copied from 
\templates\common\noint.qnt, the method for the analysis samples is 
copied from \templates\hplc\pah\qnt0815.qnt (both in the datasource 
server1). 
 
Path Information 
The entire path information of the worklist is related to the Chromeleon data 
structure. Therefore, the path name starts with the Datasource, not the 
hard disk name. Relative paths are not accepted. Path names can be 
expressed either in the internal Chromeleon syntax (Moniker), for example, 
SEQ::\labor2_local\sys58\sequences\lims4711, or in a simplified syntax (as 
above), which omits the type abbreviation and the double colon. In this 
case, a slash or a colon can be used instead of the backslash.  
 
Sequence = SEQ::\labor2_local\sys58\sequences\lims4711 
Sequence = \labor2_local\sys58\sequences\lims4711 
Sequence = Labor2_local:sys58/sequences/lims4711 
 
All of the above paths refer to the sequence lims4711 in the directory 
sys58/sequences of the datasource Labor2_local. 

Do not include type extensions (.PGM, .QNT, .SEQ) in the path information. 
 

Handling of PGM Files and QNT Files 
The program and the method columns of the sequence only include the file 
name without the path information, as the files are always located in the 
sequence. The same applies to the corresponding options (PGM= and 
QNT=) in the WLE file (see below). 

The LIMS import module creates these files by copying them to the 
sequence. There are two possibilities to specify where to find these 
templates to copy: 

• If all used files of a type are located in the same directory (the template 
directory), its path can be determined in the section [file names] via  

PGM Templates = path to template directory  or. QNT Templates= for QNT Files 

Chromeleon searches the corresponding template directory for a file 
with the specified name and copies this file to the sequence.  
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• If the copy templates are located in different directories, the path of 
each section has to be given in the section ‘[PGM File]’ or ‘[QNT Files]’. 
On the left side of the equal sign, the file name is located, and on its 
right side, the complete path of the template is indicated. 

Technically, it may be possible that the file name of the template differs 
from the name of the copied file. However, this will not be accepted. 

Both methods can be mixed. In case of doubt, the second method has 
priority. If there is an entry in the section [PGM Files], the PGM template file 
is not searched. 

If all samples use the same PGM and QNT Files, it makes no difference 
which method is used. 

Section [OPTIONS] 
The options listed in this section will influence the import function. Usually, 
no entries are required here. When testing a worklist, it may be useful to 
disable the Delete Worklist and Rename On Error commands. Thus, the 
worklist is retained instead of being deleted after importing.  

Application = Chromeleon indicates that this worklist is intended for the 
Chromeleon. If there is a different entry here, the worklist will not be 
accepted by the Chromeleon. In this case, no log file is created, and the 
worklist is neither deleted nor renamed. 

Computer Name = <Name of PC> indicates where to copy the worklist. If 
this entry does not correspond to the local computer, the worklist is not 
accepted. In this case, no log file is created, and the worklist is neither 
deleted nor renamed. 

Log Error = Yes creates a log file containing the error message in the 
event of an error. 

Log Success = Yes creates a log file documenting the successful import.  

Delete Worklist = Yes deletes the worklist when importing was successful.  

Rename On Error = Yes renames the worklist in *.err in the event of an 
error. 

Character Set = Windows indicates the character set of the worklist. Any 
generated log file is also written with this character set. Change this option 
if some special characters, such as umlauts, are not transferred correctly. 
Valid values: Windows or ANSI (system character set, that is, no 
conversion) DOS or OEM (PC character set, conversion by Windows 
function OEMToAnsi). 
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Section [FILE NAMES] 
This section determines various file names. Sequence = indicates the path 
and the name of the sequence to generate. This parameter must always be 
specified. PGM = or QNT = determines the default value for the PGM 
column or the QNT column. (The default value can be overwritten for each 
sample.)  

PGM Templates = and QNT Templates = determine the corresponding 
template directory (see above). 

Sections [PGM Files], [QNT Files] 
The sections define from where to copy the PGM and the QNT Files. 
Entries in this section take priority over a template directory. Entries have 
the following syntax: 

name = path 

On the left side of the equals sign, the file name is located, and on its right 
side the complete path of the template.  

Section [DEFAULTS] 
This section defines default values for various sample variables. Name=, 
Comment=, Pos=, Type=Unknown, Status=Single, Sample Weight=1.0, 
Dilution Factor=1.0, ISTD Amount=, Std. Add. Group=, Ref. Amount 
Set=, and Injection Volume=20.0 have the same meaning as in the 
Browser. The corresponding value range is also identical. 

Note: The default values for the PGM and the QNT Files are defined in the 
section [FILE NAMES]. 

Section [SEQUENCE] 
This section defines the properties of the sequence.  

Title = Created from worklist <Name of Worklist> determines the name 
(description) of the sequence. 

Timebase = determines the timebase on which the sequence is executed.  

Report = determines the default value for the report template (appears in 
the print dialog)  

Channel = determines the default value for the channel when printing 
(appears in the print dialog) 



A-248 Glossary 

Section [n] (Sample Data Records) 
Each sample is described by one section. The section must have the name 
[n], where n is the sample number (without leading zero). The samples 
must be numbered consecutively. With a new sequence, sample 
numbering must start with 1. Samples can be appended to existing 
sequences. In this case, sample numbering must start with the next free 
sample number in the sequence (as number of samples in the sequence 
plus one). A sample section can have the entries PGM=, QNT=, Name=, 
Comment=, Sample ID=, Replicate ID=, Pos=, 
Type=Unknown/Blank/Validation/Standard/Matrix/Spiked/Unspiked, 
Status=Single/Multiple/Finished/Interrupted, Sample Weight=1.0, 
Dilution Factor=1.0 and Injection Volume=20.0. Missing entries are 
completed by the defaults in the sections [DEFAULTS] and [FILE NAMES]. 

 Tip: 
In the worklist, omit the asterisk (*) that marks User-defined Columns in 
the Browser.  

Workspace 
The area between the menu bar or Toolbar and the Status Bar is called 
the Workspace. The Workspace displays the open windows. The 
Workspace allows you to open a specific set of windows. Normally, this is 
the most recently used view. 

Select Autosave Workspace on the Workspace menu to open the most 
recently used workspace whenever you start Chromeleon, for example, two 

Control Panels showing the status of two different chromatography 
systems. 

Of course, it is also possible to save or open any workspace view with a 
separate name. Chromeleon stores this information in WSP files. Use this 
option to save a workspace view for system control, a view for data 
processing, a view for peak purity analysis, etc.  

If you want to save the settings of an individual window (for example, the 
on-screen report and the Printer Layout) without changing the workspace, 
you can use a Report Definition File (RDF). The appearance of the 
control panel is saved in the corresponding PAN file. 

Combine single files with a workspace to create a customized 
representation of the screen. For more information, refer to Basic 
Operation  User Profiles (Workspaces).  
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Xcalibur 
Xcalibur (= XC) is the software data system of the Thermo Finnigan 
Corporation. You must install Xcalibur software to control a Thermo 
Finnigan Mass Spectrometer with Chromeleon and to view mass spectra. 
Two XC setup programs are provided on the software installation CD. For 
installation details, refer to How to …: Installing and Configuring Mass 
Spectrometers  Installing MS Components in the Administrator Help 
section. 

To install the aQa mass spectrometer and to read aQa method files, install 
Xcalibur Rev. 1.2 on your PC. 

To install the MSQ spectrometer, install Xcalibur Rev. 1.3. 

Because Xcalibur software cannot control several mass spectrometers from 
one PC, a separate server PC is required for each mass spectrometer. 

Xcalibur software allows you to define mass spectrometer programs in a 
PGM File. You can create the control file in Chromeleon, using the 

Xcalibur Editor. (For more information, refer to How to …: Using Mass 
Spectrometers  Creating a PGM File for the aQa MS and  Creating 
a PGM File for the MSQ.)  

Year 2000 Conformity 
According to the document PD2000-1:1998, which was published by the 
British Standards Institution (BSI), "year 2000 conformity shall mean that 
neither performance nor functionality is affected by dates prior to, during, 
and after the year 2000." 

In particular, this means that the following rules are adhered to: 

1. General Integrity: No value for current date will cause any interruption in 
operation. 

2. Data Integrity: Date-based functionality must behave consistently for 
dates before, during, and after year 2000. 

3. Explicit/Implicit Indication of the Century: In all interfaces and data 
storage, the century in any date must be specified either explicitly or by 
unambiguous algorithms or inferencing rules. 

4. Leap Year: Contrary to the year 1900, the year 2000 must be recognized 
as a leap year. (According to the Gregorian Calendar, the year 1900 was 
not a leap year.) 
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Chromeleon 4.20 and higher fulfill the BSI rules mentioned above. The 
Dionex hardware fulfills the BSI rules in the same way. Two instruments of 
the previous generation that are no longer available (M480 pump and GINA 
160 Autosampler) display the year 2000 as 1900. This, however, does 
not affect the functionality.  

Please do not hesitate to contact Dionex Service for the corresponding 
Year 2000 Certificate. 

Zoom 
Draw a frame around a section of a signal plot or a 3D field that you wish to 
zoom while holding down the left mouse button. To undo the last zoom 
operation, select Unzoom on the context menu. Select Full size to return 
to the original display (100% representation). 

 Tips: 
On the online signal plot, an Overview Window is displayed in the upper 
right corner in addition to the enlarged section. 

While you draw a zoom frame, you can cancel the operation by pressing 
<ESC> key or by right-clicking. Use this function to prevent a window, such 
as a 3D plot, from being redrawn if you have selected the wrong frame.  
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